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1 Advanced options reference

Advanced options customize your version of Tekla Structures. For example,
they set various file names and locations, define symbols used in drawings,
change how numbering is done, and so on.

Check and change advanced option values

Most advanced options are available in the user interface. To access the
options, click File menu --> Settings and in the Settings area select Advanced
options.

Some advanced options are not shown in the Advanced Options dialog box
and can only be set in initialization files; the documentation of the option
mentions when this is the case.

The default values given for the advanced options in the documentation are
for the Default environment. The values may be different in localized
environments. If you want to change the defaults used in your projects, add
the advanced options in an initialization file that is located in a project or firm
folder. Settings in the initialization files do not change existing selections in
models. They are used when you create a new model and when you add
values for options that have no previous value in the model.

To list all advanced option values set in the current model, including those set
in initialization files, click the Write to file button at the bottom of the
Advanced options dialog box.

Find the documentation for advanced options

To see the documentation for those advanced options that are shown in the
Advanced options dialog box, select an advanced option in the dialog box
and press F1 on your keyboard. This opens the correct help page for the
option, and often provides additional information even for those options that
have a short description directly in the dialog box.

Here in the documentation, we list the advanced options alphabetically (see
the attached listing), ignoring the initial letters XS. For example, under A you
will find the advanced option XS_AISC_WELD_MARK, under B, 
XS_BACKGROUND_COLOR,and so on. Advanced options starting with XSR are
listed under R.
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TIP Use the Advanced options search tool to find documentation by advanced
option name.

1.1 Advanced options - A

XS_AD_ANALYSIS_PLANES_ENABLED

Category: Analysis & Design

Set this advanced option to FALSE to revert to the analysis model creation
method used in Tekla Structures 2017i and earlier versions.

The default value is TRUE.

If you change the value, Tekla Structures recreates the analysis models.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_CURVED_BEAM_SPLIT_ACCURACY_MM

Category

Analysis & Design

Use to set the maximum distance between a curved member and straight
segment. Enter the value in millimeters. The default value is 25.0 mm.

This advanced option is model specific and the setting is saved in the options
database.

Advanced options reference 56 Advanced options - A

http://teklastructures.support.tekla.com/find-advanced-options


XS_AD_DRAW_BAR_DIAMETER_MM

Category: Analysis & Design

Use this advanced option to define the diameter of the analysis parts when
the analysis parts are shown in model views. Enter the value in millimeters.
The default value is 70 mm.

This advanced option is user specific and the setting is saved in options.bin
under the user folder. Redraw the model views after changing the value to
activate the new setting.

See also

XS_AD_DRAW_NODE_SCALE (page 57)

XS_AD_DRAW_NODE_SCALE

Category: Analysis & Design

Use this advanced option to scale the size of the analysis nodes when the
analysis nodes are shown in model views. The default value is 1.

This advanced option is user specific and the setting is saved in options.bin
under the user folder. Redraw the model views after changing the value to
activate the new setting.

See also

XS_AD_DRAW_BAR_DIAMETER_MM (page 56)
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XS_AD_ELEMENT_ANGLE_CHECK_ANGLE_DIFF_LIMIT

Category

Analysis & Design

Use to set a limit angle between physical part and analysis model member, in
order to test the validity of the analysis model. When the angle is greater than
the limit, a message appears and a warning is added to the log. Small
differences in angles are usual in the analysis model of a truss, for example.
The default value is 10.0.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_ENVIRONMENT

Category

Analysis & Design

This advanced option is used in analysis and design integration to set the
environment, for example, to set the cross section catalog. The default value is 
Europe.

Possible values are dependent on the analysis application that is used. For
some applications, this advanced option is not used.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_GET_MOMENT_CONNECTION_STATUS

Category

Analysis & Design

Use to specify to which value (Yes or No) the Moment connection symbols
option is set when the Get results command is used in the analysis model.
The Moment connection symbols option is available on the End conditions
tab in the user-defined attributes properties dialog box of the part, and it
defines whether the moment connection symbols are shown in drawings.

Set the advanced option to one of the following values:

• yz: if the rotations ry and rz are fixed in the analysis model, the value Yes is
used, otherwise No is used.

• xyz: if all rotations are fixed in the analysis model, the value Yes is used,
otherwise No is used.
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• z: if the rotation rz is fixed in the analysis model, the value Yes is used,
otherwise No is used.

• The advanced option is not set: The value you have set manually in the
Moment connection symbols option is used.

The default is yz.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_GET_RESULTS_DESIGN_VALUES

Category

This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to import steel and concrete design values
from Robot into Tekla Structures when you use the Get results or Get results
for selected command in the Analysis & Design Models dialog box. The
default value is TRUE. If you do not want to import the design values, set this
advanced option to FALSE.

See also

XS_AD_GET_RESULTS_FORCES (page 59)

XS_AD_GET_RESULTS_FORCES

Category

This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to import forces from Robot into Tekla
Structures when you use the Get results or Get results for selected
command in the Analysis & Design Models dialog box. The default value is 
FALSE.

See also

XS_AD_GET_RESULTS_DESIGN_VALUES (page 59)
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XS_AD_LOAD_COMBINATION_METHOD

Category: Analysis & Design

Use this advanced option to define whether a load combination is created
instead of a repeated load in STAAD.Pro export from Tekla Structures.

Set to 0 to use REPEAT LOAD, or set to 1 to use LOAD COMBINATION.

The default value is 0.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_MEMBER_NUMBER_VISUALIZATION

Category

Analysis & Design

Use to show or hide member numbers when displaying the analysis model in
a model view. The default is TRUE, which shows the numbers. To hide the
numbers, set to FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_MEMBER_RESULT_DISP_DIVISION_COUNT

Category

Analysis & Design

Use to define the analysis member points whose results are saved in the
analysis_results.db5 database. This advanced option defines into how
many parts each analysis member is divided.

Enter an integer value. The default is 0, which does not save any displacement
results.

This advanced option is model specific and the setting is saved in the options
database.

Example

To save only the displacements of member ends, set 
XS_AD_MEMBER_RESULT_DISP_DIVISION_COUNT to 1.

To save three intermediate displacement results, in addition to the end
displacements, set XS_AD_MEMBER_RESULT_DISP_DIVISION_COUNT to 4.
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See also

XS_AD_MEMBER_RESULT_MIN_DISTANCE (page 61)

XS_AD_MEMBER_RESULT_DIVISION_COUNT (page 61)

XS_AD_MEMBER_RESULT_DIVISION_COUNT

Category

Analysis & Design

Use to define the analysis member points whose results are saved in the
analysis_results.db5 database. This advanced option defines into how
many parts each analysis member is divided.

The default is 1, which saves only the results of member ends.

This advanced option is model specific and the setting is saved in the options
database.

Example

To save the results of three intermediate points (quartiles) on each member, in
addition to the end results, set XS_AD_MEMBER_RESULT_DIVISION_COUNT to 
4.

See also

XS_AD_MEMBER_RESULT_MIN_DISTANCE (page 61)

XS_AD_MEMBER_RESULT_DISP_DIVISION_COUNT (page 60)

XS_AD_MEMBER_RESULT_GRID_SIZE

Category

Analysis & Design

Use to define the grid spacing for the analysis results of plates, slabs, and
panels. Enter the value in millimeters. The default value is 500.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_MEMBER_RESULT_MIN_DISTANCE

Category

Analysis & Design
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Use to define the minimum distance between the analysis result points on
analysis members. Enter the value in millimeters.The default value is 500.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_AD_MEMBER_RESULT_DIVISION_COUNT (page 61)

XS_AD_MEMBER_RESULT_DISP_DIVISION_COUNT (page 60)

XS_AD_MEMBER_TYPE_VISUALIZATION

Category: Analysis & Design

Use colors to show different analysis part types when displaying the analysis
model in a model view. The default setting is TRUE, which shows the analysis
parts using the analysis class (page 760) colors. A setting of FALSE shows the
plate objects using the analysis class colors and the other analysis parts in
blue.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_NEAR_NODES_WARNING_LIMIT

Category

Analysis & Design

Use this advanced option to trigger a warning when analysis nodes are closer
to each other than the limit.

Enter the limit in millimeters. The default value is 0, which means that Tekla
Structures does not show warnings.

This advanced option is model specific and the setting is saved in the options
database.

Example

To have Tekla Structures show a warning for analysis nodes that are closer
than 5 mm to each other, set XS_AD_NEAR_NODES_WARNING_LIMIT to 5.

See also

XS_AD_SHORT_MEMBER_WARNING_LIMIT (page 65)

XS_AD_SHORT_RIGIDLINK_WARNING_LIMIT (page 65)
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XS_AD_NODE_NUMBER_BY_Z

Category: Analysis & Design

If you set this advanced option to TRUE, the start number of a new analysis
node is set according to the global z coordinate of the node. For example:

• If z is less than 1000.0, the node start number is 0.

• If z is between 1000.0 and 1999.0, the node start number is 1000.

• If z is between 2000.0 and 2999.0, the node start number is 2000.

The first free number above the start number is assigned to the node.

The default is FALSE.

XS_AD_NODE_NUMBER_VISUALIZATION

Category

Analysis & Design

Use to show or hide node numbers when displaying the analysis model in a
model view. The default is TRUE, which shows the numbers.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_OPTIMISATION_DISABLED

Category

Analysis & Design

Use to check profile catalog analysis values. To enable design optimization,
use the value FALSE. To disable design optimization, use the value TRUE. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PROFILE_ANALYSIS_CHECK_ALL (page 344)

Advanced options reference 63 Advanced options - A



XS_AD_OPTIMISATION_NO_WEIGHT_SORT

Category

Analysis & Design

When optimization cross section group is extracted from the profile catalog,
the group is sorted by default according to the section weight (cross section
area). Set this advanced option to TRUE to disable this sorting, in which case
the section order is the same as in the profile catalog.

If you use the value FALSE, the group is sorted according to the section
weight. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_OPTIMISATION_RECURSE_CATALOG

Category

Analysis & Design

Set this advanced option to TRUE to have Tekla Structures ignore profile
catalog rules for optimizing steel part sizes and search the entire profile
catalog. If you want to take the rules into account, set it to FALSE. The default
value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_RESULT_DATABASE_ENABLED

Category

Analysis & Design

Use to define whether the analysis results database analysis_results.db5
is created or not. The default setting is TRUE. This creates the analysis results
database.

If you decide not to create the analysis results database, set this advanced
option to FALSE. In this way the use of large models with several load
combinations is faster and less memory consuming.

This advanced option is model specific and the setting is saved in the options
database.
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XS_AD_RIGID_DIAPHRAGM_VISUALIZATION

Category

Analysis & Design

Defines whether extra sticks are drawn in visualization for rigid diaphragms.

This advanced option is model specific and the setting is saved in the options
database.

Advanced option is set to Appearance
TRUE (default)

FALSE

XS_AD_SHORT_MEMBER_WARNING_LIMIT

Category

Analysis & Design

Use this advanced option to trigger a warning when a analysis member is
shorter that the limit.

Enter the length in millimeters. Default is 50. If the limit is set to 0, no checking
is done.

This advanced option is model specific and the setting is saved in the options
database.
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XS_AD_SHORT_RIGIDLINK_WARNING_LIMIT

Category

Analysis & Design

Use this advanced option to trigger a warning when an analysis rigid link is
shorter that the limit. Enter the length in millimeters. Default is 10. If the limit
is set to 0, no checking is done.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_SOLID_AXIAL_EXPAND_MM

Category: Analysis & Design

Used in analysis model creation when checking if parts are clashing. Parts are
expanded in axial direction by the given distance to create clash also when
there is a small gap between parts. The default value is 25.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_AD_SOLID_SECONDARY_EXPAND_MM (page 66)

XS_AD_SOLID_SECONDARY_EXPAND_MM

Category: Analysis & Design

Used in analysis model creation when checking if parts are clashing and if they
should be connected in the analysis model. Secondary parts are expanded in
all directions by the given distance to create clash also when there is a gap
between parts. The default value is 75.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_AD_SOLID_AXIAL_EXPAND_MM (page 66)
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XS_AD_SUPPORT_VISUALIZATION

Category

Analysis & Design

Use to show or hide the support conditions when showing the analysis model
in a model view. The default is TRUE, which shows the support conditions.

This advanced option is model specific and the setting is saved in the options
database.

XS_AD_USE_HIGH_ACCURACY

Category

Analysis & Design

Set this advanced option to FALSE to allow for more tolerance in the creation
of the analysis model. In certain situations this will result in a more suitable
analysis model. If you do not want to allow more tolerance in the analysis
mode creation, set this advanced option to TRUE. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_ADAPTIVE_OBJECTS

Category

Modeling Properties

Use to define which adaptivity method to use. The options are:

• ENABLED: the new adaptivity method is used

• ENABLED_OLD: the old adaptivity method is used

• DISABLED: adaptivity is disabled

The default value is ENABLED.

This advanced option is model specific and the setting is saved in the options
database.

See also
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XS_ADD_SNAPPING_SYMBOL_TO_CIRCLES

Category: Drawing Properties

Set this advanced option to TRUE to have the snapping point in the center of
circles while you are snapping to the center of circles created in the model by
using polygon cuts. You may need to snap to center of circles when you need
to create dimensions, for example. The default value is FALSE.

If you change the value, you need to reopen the drawing.

This advanced option is model specific and the setting is saved in the options
database.

XS_ADJUST_GRID_LABELS

Category

Model View

Set this advanced option to FALSE to disable the dynamic moving of grid
labels when zooming in, and to keep the labels anchored to the end of the grid
line. The default value is TRUE, and the grid line labels are kept visible. When
working with very large grids having the grid labels always visible might slow
down Tekla Structures. After you change the advanced option setting, close
and re-open the view to implement the change.

XS_AISC_WELD_MARK

Category: Welds

Set this advanced option to TRUE to create AISC weld marks, to use leg length
as default fillet weld size dimensioning, and to create arrow side weld using
below line weld properties.

Set this advanced option to FALSE to create ISO weld marks, to use throat
thickness as default fillet weld size dimensioning, and to create arrow side
weld using above line weld properties. FALSE is the default value.

This advanced option also affects the spacing of intermittent welds:

• TRUE uses the Pitch value entered in the weld properties as the center-to-
center spacing of welds.

• FALSE uses the Pitch value entered in the weld properties as the spacing
between the welds.

An AISC weld mark of a staggered intermittent weld with the pitch after a
dash:
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An ISO weld mark of a staggered intermittent weld with the pitch in
parenthesis:

This advanced option is model specific and the setting is saved in the options
database.

NOTE The XS_AISC_WELD_MARK advanced option is delivered with model
folder files. If you need to deliver the model to another party, send the
full model with all files (not just the model database file *.db1) to
ensure that the weld cross section size remains the same. If the value
for this advanced option is changed, then the actual weld cross-
section size will change accordingly.

XS_ALLOW_DRAWING_TO_MANY_MULTI_DRAWINGS

Category

Numbering

Set this advanced option to TRUE to allow the same drawings to be included in
more than one multidrawing.

If you want the drawing to be included in only one multidrawing, set this value
to FALSE (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_ALLOW_INCH_MARK_IN_DIMENSIONS

Category

Dimensioning: general
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Set to TRUE to have Tekla Structures include the inch symbol in dimensions.
The default value is TRUE. If you do not want to allow inch marks, set this
advanced option to FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_ALLOW_INCH_MARK_IN_WELD_SYMBOLS

Category: Imperial Units

Set this advanced option to TRUE to have Tekla Structures include the inch
symbol (") in weld symbols. If you do not want to include the inch symbol, set it
to FALSE (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_ALLOW_REBARS_ON_TOP_OF_EACH_OTHER

Category

Concrete Detailing

If you set this advanced option to TRUE, reinforcing bars can be drawn on top
of each other. In this case you have selected Visibility of reinforcing bars in
group to bar in the middle of group or to customized, and you have two
reinforcing bar groups on top of each other, for example, on the top surface of
a slab and on the bottom surface of a slab. The default value is FALSE. This
advanced option is model specific and the setting is saved in the options
database.

XS_ALLOW_REINFORCING_LOCKED_PARTS

This advanced option must be set in an initialization (.ini) file.

Set to TRUE to create, modify, or delete reinforcement in parts that have been
locked. This is useful, for example, when different parties of a project are
responsible for modeling concrete parts and for modeling reinforcement, and
when modification of parts needs to be prevented.
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XS_ALLOW_SHEAR_PLATE_CLASH_FLANGE

Category

Components

Set this advanced option to TRUE (default) to omit the default 0.3 mm
tolerance between shear tab and secondary part web for shear tab
components. To use the tolerance, set it to FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_ALWAYS_CONFIRM_SAVE_WHEN_CLOSING_DRAWING

Category

Drawing Properties

Set this advanced option to TRUE to always display the confirmation message
"Do you want to save current drawing?".

The default value is FALSE. This means that if you close a drawing without
making any changes, Tekla Structures does not by default prompt you to save
the drawing.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_ALWAYS_CONFIRM_SAVE_WHEN_EXIT

Category

Modeling Properties

Use to define whether or not Tekla Structures prompts you to save the model
if you are closing it without making any changes.

If this advanced option is set to TRUE (default), Tekla Structures always asks
you to save the model when closing it.

If this advanced option is set to FALSE, Tekla Structures does not ask you to
save the model if there are no changes after the last save.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_ANCHOR_BOLT_PLAN_ADDITIONAL_PARTS_FILTER

Category Drawing properties

Use to add additional parts that are not usually part of a column assembly to
an anchor bolt plan, such as anchor rods or leveling plates. First define a
general arrangement drawing filter and then give that filter name as the value
for this advanced option.

This advanced option is model specific and the setting is saved in the options
database.

In the following example we will make anchor rods and leveling plates visible
in an anchor bolt plan.

1. Go to the File menu and click Settings --> Advanced options --> Drawing
Properties .

2. Enter the name of the general arrangement drawing filter for the
advanced option XS_ANCHOR_BOLT_PLAN_ADDITIONAL_PARTS_FILTER .
In this example, we will use the name SHOW_IN_ABPLAN (default).

3. On the Drawings & Reports tab, click Drawing properties > GA drawing.

4. In the general arrangement drawing properties dialog box, click Filter.

5. Click Add row.

6. Select Part as the Category, Name as the Property, Equals as the
Condition and enter*ANCHOR*LEVEL in the Value box.

7. Enter the name of the drawing filter, SHOW_IN_ABPLAN, in the Save as
box and click Save as.

8. Click Cancel to exit the dialog box.

When you create an anchor bolt plan, both the anchor rods and the leveling
plates are shown in the drawing. In the drawing below, the name of the
anchor rod is "ANCHOR ROD" and the name of the leveling plate is "LEVELING
PLATE."
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XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER

Category

Drawing Properties

Use a general arrangement drawing filter to limit the number of visible objects
to determine the parts to be included in the anchor bolt plan. First create the
base plate filter, then enter its name as the value for the advanced option.
Tekla Structures will show in the anchor bolt plan the base plates defined by
the drawing filter.

If this advanced option is set, base plate is a part that fulfills the following
rules:

• Part belongs to the same assembly as the column, which is the main part
of the assembly.

• Part passes the drawing filter specified by 
XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER.

If there is more than one part in the column assembly that fulfills the rules, the
lowest part is considered to be the base plate.

This advanced option is model specific and the setting is saved in the options
database.

Example

XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER =<the name of the
drawing filter for base plates>

XS_ANCHOR_BOLT_PLAN_BOLT_FILTER

Category

Drawing Properties

Use a general arrangement drawing filter to limit the number of visible objects
in a drawing and determine the parts to be included in the anchor bolt plan.
First create the general arrangement drawing bolt filter, then enter its name as
the value for this advanced option. Tekla Structures will show in the anchor
bolt plan the bolts included in the drawing filter.

This advanced option is model specific and the setting is saved in the options
database.

Example

XS_ANCHOR_BOLT_PLAN_BOLT_FILTER =<the name of the drawing
filter for bolts>
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XS_ANCHOR_BOLT_PLAN_COLUMN_FILTER

Category

Drawing Properties

Use a general arrangement drawing view filter to limit the number of visible
objects and determine the parts to be included in the anchor bolt plan. First
create a general arrangement drawing column filter, then enter its name as
the value for this advanced option. Tekla Structures will show in the anchor
bolt plan the columns included in the filter.

This advanced option is model specific and the setting is saved in the options
database.

Example

XS_ANCHOR_BOLT_PLAN_COLUMN_FILTER =<the name of the drawing
filter for columns>

XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE

Category

Drawing Properties

Use to specify the distance of an assembly from the view plane for the
assembly to be included in the anchor bolt plan. Enter the distance in
millimeters. The default value is 200.

This advanced option is model specific and the setting is saved in the options
database.

XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_
DIMENSIONS

Category

Drawing Properties

Use to select the direction for the dimensions in the anchor bolt plans. If set to 
TRUE, anchor bolt plan detail view dimensions are created using the
coordinate system of the main view. This advanced option is set to FALSE by

Advanced options reference 74 Advanced options - A



default, which means that the dimensions of anchor bolt plan detail views are
created according to the base plate coordinate system.

This advanced option is model specific and the setting is saved in the options
database.

XS_ANGLE_DEGREE_SIGN

Category

Drawing Properties

Use to show the degree symbol correctly in Asian languages. By default, the
value is unicode:176. The value can be changed depending on the desired
character. To add the degree symbol in an Asian language, copy the symbol
from a text file and paste it directly in the value field. Do not use a unicode
value.

This advanced option is model specific and the setting is saved in the options
database.

XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR

Category

Dimensioning: General

Use to define the size of angle symbols.

This advanced option is model specific and the setting is saved in the options
database.

Value 1 Value 3 (default) Value 5

NOTE Setting this advanced option disables the advanced option 
XS_CHECK_TRIANGLE_TEXT_SIZE.
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See also

XS_CHECK_TRIANGLE_TEXT_SIZE (page 112)

XS_ANGLE_TEXT_IN_UNFOLDING_BENDING_LINE_
DIMENSIONING

Category: Dimensioning: Unfolding

Use to set the prefix text for unfolded angles. This affects single-part drawings
that show folded parts unfolded. Enter any text, for example, A=. By default,
there is no prefix text.

This advanced option is model specific and the setting is saved in the options
database.

See also

APPL_ERROR_LOG

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

This advanced option tells the prefix of the application error log files.

Example

If you enter set APPL_ERROR_LOG=TeklaStructures, Tekla Structures
creates at least the following log files by default in
C:\TeklaStructuresModels\ folder:

• TeklaStructures_%USERNAME%.log: log data collected while the
program is running

• TeklaStructures_%USERNAME%.err: errors collected while the program
is running

XS_APPLICATIONS

Category

This advanced option must be set in an initialization (.ini) file.
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This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

This advanced option defines the folder that contains the connection, detail,
and detailing tool applications.

We recommend that you use XS_APPLICATIONS_PATH (page 77) that allows
you to define several folders.

Example
set XS_APPLICATIONS=%XS_DIR%\applications\

XS_APPLICATIONS_PATH

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

This advanced option defines the folders that contain the connection, detail,
and detailing components.

Example
set XS_APPLICATIONS_PATH=%XS_APPLICATIONS%;%XSDATADIR
%environments\common\Extensions\applications\
The order in which the elements are placed affects how the applications and
application settings are used. Tekla Structures reads the first elements first.

XS_ARC_WIDTH_OF_CLOUD

Category

Drawing Properties

Use to control the width of cloud arcs on paper (default 10 mm). You can use
the Cloud tool to highlight changes in drawings.

This advanced option is model specific and the setting is saved in the options
database.
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Example

Advanced option is set to Example of appearance in
drawing

1

10

XS_ASCII_IMPORT_CREATES_CONSTRUCTION_LINES

Category

Import

Set this advanced option to TRUE to have Tekla Structures only draw
construction lines between object points in an ASCII import. If you do not want
to do this, set it to FALSE (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_ASSEMBLY_DRAWING_VIEW_TITLE

Category

Drawing Properties

Use to define a title for an assembly drawing views in a multidrawing. The
options are:

• PART_NAME
• PART_MATERIAL
• PART_POS, ASSEMBLY_POS
• MODEL_NUMBER
• LENGTH, PROFILE
• LENGTH
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• BASE_NAME
• NAME
This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_ASSEMBLY_FAMILY_POSITION_NUMBER_FORMAT_STRING

Category

Numbering

Use to define the contents of the assembly family position number. For
example, instead of DT1-1, DT1-2, you can define the numbering as DT1-A,
DT1-B.

To get this result, set the advanced option as follows:

XS_ASSEMBLY_FAMILY_POSITION_NUMBER_FORMAT_STRING=
%ASSEMBLY_PREFIX%%ASSEMBLY_FAMILY_NUMBER%-
%ASSEMBLY_FAMILY_QUALIFIER_WITH_LETTERS%
This advanced option is model specific and the setting is saved in the options
database.

Use the following options to define the contents of family position numbers.
Use as many options as you need, and enclose each one in percent symbols
(%).

Option Description
%ASSEMBLY_PREFIX% Assembly prefix, defined in the part

properties in the property pane.
%ASSEMBLY_POS% The running assembly position

number, starting from the start
number, defined in the part
properties in the property pane.

%ASSEMBLY_FAMILY_NUMBER% Assembly family number, defined by
the start number (in part properties
in the property pane) and the final
position in that numbering series.

%ASSEMBLY_FAMILY_NUMBER_WITH_
LETTERS%

Assembly family number with letters.
The letters run automatically from A
to Z. If more letters are needed, Tekla
Structures takes a second or even a
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Option Description
third letter into use, for example AA
or AAA.

You can also define valid letters with
the advanced option 
XS_VALID_CHARS_FOR_ASSEMBLY_F
AMILY_POSITION_NUMBERS.

%ASSEMBLY_FAMILY_QUALIFIER% Assembly family qualifier, defined by
the family numbering criteria given in
the Numbering Setup dialog box.

%ASSEMBLY_FAMILY_QUALIFIER_WI
TH_LETTERS%

Assembly family qualifier with letters.
The letters run automatically from A
to Z. If more letters are needed, Tekla
Structures takes a second or even a
third letter into use, for example AA
or AAA.

You can also define valid letters with
the advanced option 
XS_VALID_CHARS_FOR_ASSEMBLY_F
AMILY_QUALIFIER.

%UDA:[uda_name]% User-defined attribute of the
assembly or assembly main part. If
the attribute is defined for the
assembly, it will be used. If it is not
defined, the main part attribute will
be used. You can also define that only
the user-defined attribute of the main
part will be used, for example 
%UDA:MAINPART.USER_FIELD_1%.

%TPL:[tpl_name]% Template attribute of the assembly or
assembly main part, for example %
TPL:PROJECT.NUMBER% .

Number of characters

You can define the number of characters by adding a period and the required
number to the end of each option. For example 
%ASSEMBLY_FAMILY_QUALIFIER_WITH_LETTERS.3% will result in three
letters for every assembly, starting from AAA.

Example

If you set the advanced option to

XS_ASSEMBLY_FAMILY_POSITION_NUMBER_FORMAT_STRING=
%ASSEMBLY_PREFIX%/%ASSEMBLY_FAMILY_NUMBER.3%-
%ASSEMBLY_FAMILY_QUALIFIER.3%
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The result will be

A/001-001.

See also

ASSEMBLY_POS (page 492)

XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_POSITION_NUMBERS (page 469)

XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_QUALIFIER (page 469)

Template attributes in drawing and report templates (page 483)

XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING

Category: Numbering

Use to base assembly numbers on drawing numbers. Use the following
switches to define the contents of assembly marks. Use as many switches as
you need, and enclose each one in percent symbols (%).

The available switches are:

Switch Description
%ASSEMBLY_MULTI_
DRAWING_NUMBER%

Multidrawing name.

%ASSEMBLY_MULTI_
DRAWING_POS%

Position of the assembly drawing
inside the multidrawing.

%ASSEMBLY_PREFIX
%

Assembly prefix in the model.

%ASSEMBLY_POS% Assembly position number in the
model.

Template fields Enter TPL: followed by the name of
any relevant template field. Enclose
each name in percent symbols (%).
For example, %TPL:PROJECT.NUMBER
%
NOTE: No template fields starting with 
DRAWING work for this advanced
option, for example, 
DRAWING.TITLE1. If you use them in
the value, Tekla Structures will replace
the whole value string with the default
value.

User-defined
attributes that are

Enter UDA: followed by the name of
any relevant user-defined attribute,
exactly as it appears in the
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Switch Description
defined in the
objects.inp file

objects.inp file. For example, 
%UDA:MY_INFO_1%

This advanced option is model specific and the setting is saved in the options
database.

Example

To put the assembly multinumbers in the format multidrawing name + part
prefix + position on multidrawing, set the advanced option as follows:

%ASSEMBLY_MULTI_DRAWING_NUMBER%%ASSEMBLY_PREFIX%
%ASSEMBLY_MULTI_DRAWING_POS%
This will create the assembly mark 10B1, where:

• 10 is the drawing number

• B is the assembly prefix

• 1 designates that it is the first assembly on the sheet.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_PART_MULTI_NUMBER_FORMAT_STRING (page 326)

XS_CAST_UNIT_MULTI_NUMBER_FORMAT_STRING (page 104)

XS_ASSEMBLY_POSITION_CODE_3D

Category

Templates and symbols

Set to TRUE to include Z orientation in assembly position codes.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_ASSEMBLY_POSITION_CODE_TOLERANCE

Category

Templates and symbols
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Tolerance distance to use when identifying grid position code for assembly.
The default value is 500.0.

This advanced option is model specific and the setting is saved in the options
database.

XS_ASSEMBLY_POSITION_NEW_FORMAT

Category

Templates and Symbols

Use to define how the assembly position code is displayed in reports. Set to 
TRUE to use a format such as B1/C2 instead of B-C/1-2. The default value is 
FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING

Category: Numbering

Use to define the contents of the assembly position number.

NOTE Do not change this advanced option after you have created single-
part, assembly, or cast unit drawings, if you are using cloning. It may
partially separate the drawings from the part they represent, causing
the drawings to be flagged as deleted and other drawings to be cloned
after the next numbering.

NOTE The advanced options 
XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING and
XS_PART_POSITION_NUMBER_FORMAT_STRING (page 326) override
the advanced option XS_SWITCH_POS_NUMBERS_FOR (page 423). 
XS_SWITCH_POS_NUMBERS_FOR has no impact on assembly and/or
part position numbers if you use 
XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING and/or 
XS_PART_POSITION_NUMBER_FORMAT_STRING.

The options are:

Option Description
%ASSEMBLY_PREFIX% Assembly prefix, defined in the part

properties dialog box.
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Option Description
%ASSEMBLY_POS% The running assembly position

number, starting from the start
number defined in the part properties
dialog box.

%ASSEMBLY_POS_WITH_LETTERS% Same as above, but with letters.

Uses letters A – Z by default, but you
can also define valid letters with the
advanced option 
XS_VALID_CHARS_FOR_ASSEMBLY_P
OSITION_NUMBERS.

%UDA:[uda_name]% User-defined attribute of the
assembly or assembly main part. If
the attribute is defined for the
assembly, it will be used. If it is not
defined, the main part attribute will
be used. You can also define that only
the user-defined attribute of the main
part will be used, for example 
%UDA:MAINPART.USER_FIELD_1%.

%TPL:[tpl_name]% Template attribute of the assembly or
assembly main part, for example %
TPL:PROJECT.NUMBER% .

This advanced option is model specific and the setting is saved in the options
database.

Number of characters in the assembly position number

You can define the number of characters by adding a period and the required
number to the end of the options %ASSEMBLY_POS_WITH_LETTERS% and 
%ASSEMBLY_POS%. For example,%ASSEMBLY_POS_WITH_LETTERS.3% will
result in three letters for every assembly, starting from AAA.

Example

If you set the advanced option to %ASSEMBLY_PREFIX%/%ASSEMBLY_POS.3%,
the result will be A/001.

See also

ASSEMBLY_POS (page 492)

XS_VALID_CHARS_FOR_ASSEMBLY_POSITION_NUMBERS (page 470)
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XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE

Category

Dimensioning: General

Use to define the height of the change symbol around the points. The default
value is 7.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES (page 264)

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL

Category

Dimensioning: General

Use to define the used associativity change symbol. The default value is 
AssociativityAnchor@1 (a cloud).

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES (page 264)

XS_ATTRIBUTE_FILE_EXCLUDE_LIST

Category

File Locations

Use this advanced option to exclude attribute files or reports from the user
interface. For this advanced option control strings are given for controlling the
access to attribute files or reports. If a control string is present anywhere in a
filename of an attribute file or a report, the file or report becomes unavailable.
Several control strings can be entered, and the values are case sensitive. Use
semicolon (;) as a separator.

The default value is 
TS_Report_Inquire;dgn_attribute_info;import_revision
• Enter the file name or a part of the file name that you want to exclude from

the user interface as the value for the advanced option. For example,
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setting the advanced option to _eng;_det removes all the attribute files
that include the string _eng or _det in their name from the user interface.

• Enter the name or a part of the name of the report you want to exclude
from the Create report dialog box. For example, setting the advanced
option to _Part hides the report ts_Report_Inquire_Part.rpt in the
dialog box.

Example:

PROJ1_;PROJ2_;_TeamA;Team_Detailing
This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_AUTOCONNECTION_TOLERANCE

Category: Components

Use to set the size of the area that Tekla Structures searches for parts to
connect with AutoConnection. Enter a value in millimeters, for example, 500.
The default value is 0, which means that the connection is created only
between colliding or adjacent parts.

This advanced option is model specific and the setting is saved in the options
database.

XS_AUTOCONNECTION_USE_UDL

Category

Components

Set this advanced option to TRUE to switch on UDL calculation in
AutoConnection. This calculates the maximum shear force allowed. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_AUTODEFAULT_UDL_PERCENT

Category

Components
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Use to set a default percentage for UDL calculation. The default value is 50.

In AutoDefaultsTekla Structures uses the percentage in the connection
properties. If no percentage is given, Tekla Structures uses this value.

In AutoConnection only the default percentage is used. You switch UDL
calculation on with the advanced option XS_AUTOCONNECTION_USE_UDL.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_AUTOCONNECTION_USE_UDL (page 86)

XS_AUTOMATIC_NEW_MODEL_NAME

Category

Modeling Properties

Set this advanced option to TRUE (default) to have Tekla Structures suggest a
name for a new model automatically in the New dialog box. The suggested
name is New model XX, where XX is a running number.

If you set this advanced option to FALSE, the name is not suggested.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_AUTOMATIC_USER_FEEDBACK_SAVING_INTERVAL

Category

Modeling Properties

Enter an integer to define the saving interval of the usage statistics
information. The saving interval means the number of commands or
interactions that the data collection observes before saving data to file. The
value of the advanced option corresponds to the number of rows in the log
file. The default value is 100.

The log file is called UserFeedbackLog.txt and it is located in the
TeklaStructuresModels folder.

See also

XS_AUTOMATIC_USER_FEEDBACK_SENDING_INTERVAL (page 87)
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XS_AUTOMATIC_USER_FEEDBACK_SENDING_INTERVAL

Category

Modeling Properties

Enter an integer to define the sending interval of usage statistics information.
The value of the advanced option corresponds to the number of rows in the
log file. The default value is 10000.

The log file is called UserFeedbackLog.txt and it is located in the
TeklaStructuresModels folder.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_AUTOMATIC_USER_FEEDBACK_SAVING_INTERVAL (page 87)

XS_AUTOSAVE_DIRECTORY

Category

File Locations

Enter the path to the folder that contains the files that Tekla Structures saves
automatically. The default value is %XS_RUNPATH%\autosave\
If you do not define a path, Tekla Structures places autosave files in the
current model folder.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

1.2 Advanced options - B

XS_BACKGROUND_COLOR1

Category: Model View

To have a gradient background color in model views, use the advanced
options XS_BACKGROUND_COLOR1 (page 88), XS_BACKGROUND_COLOR2
(page 89), XS_BACKGROUND_COLOR3 (page 89), and
XS_BACKGROUND_COLOR4 (page 89). With these advanced options you can
control the color of each corner separately in a model view.

This advanced option controls the upper-left corner of the model view.
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Define the color using RGB (Red Green Blue) values. The scale is from 0 to 1,
and separate the numbers with spaces. If you want to use the traditional
single-colored background, set the same value for all four background color
advanced options. Reopen the view for the change to take effect.

The default value is 1.0 1.0 1.0. To use the default background color, leave
the box empty.

This advanced option is user specific and the setting is saved in options.bin
under user folder.

Example

• Use 0.0 0.0 0.0 for black background.

• Use 1.0 1.0 1.0 for white background.

XS_BACKGROUND_COLOR2

Category: Model View

See XS_BACKGROUND_COLOR1 (page 88).

This advanced option controls the upper-right corner of the model view.

The default value is 1.0 1.0 1.0. To use the default background color, leave
the box empty.

XS_BACKGROUND_COLOR3

Category: Model View

See XS_BACKGROUND_COLOR1 (page 88).

This advanced option controls the bottom-left corner of the model view.

The default value is 0.80 0.79 0.85. To use the default background color,
leave the box empty.

XS_BACKGROUND_COLOR4

Category: Model View

See XS_BACKGROUND_COLOR1 (page 88).
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This advanced option controls the bottom-right corner of the model view.

The default value is 0.80 0.79 0.85. To use the default background color,
leave the box empty.

XS_BASE_LINE_WIDTH

Category

Plotting

Use this advanced option to specify the base line width for printed drawings.
Enter the value in millimeters as decimal value. The default value is 0.01. The
final line thicknesses in a printed drawing is the base line width multiplied by
the pen thickness from the Print Drawings dialog box (or in the old printing,
from the Color dialog box). For example, 25 will give a thickness of 0.25 mm.

TIP To control the accuracy of line thickness, use a small value for 
XS_BASE_LINE_WIDTH and a large number for the pen.

This advanced option also affects lines on the screen, if you set 
XS_BASE_LINE_WIDTH_AFFECTS_SCREEN to TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_BASE_LINE_WIDTH_AFFECTS_SCREEN (page 90)

XS_BASE_LINE_WIDTH_AFFECTS_SCREEN

Category

Plotting

Set this advanced option to TRUE, if you want XS_BASE_LINE_WIDTHto affect
line widths drawn on the screen.

Enter FALSE if you do not want XS_BASE_LINE_WIDTH to affect line widths on
the screen.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_BASE_LINE_WIDTH (page 90)

XS_BASICVIEW_HEIGHT

Category

Model View

Use to define the height of basic view windows. Enter the height in pixels. The
default value is 375.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Example
XS_BASICVIEW_HEIGHT=570

See also

XS_BASICVIEW_POSITION_X (page 91)

XS_BASICVIEW_POSITION_X

Category

Model View

Use to control the horizontal position of basic view windows on the screen.
Enter the value in pixels. The default value is 100.

If the advanced option XS_MDIBASICVIEWPARENT is set, the origin for the
position is the top left corner of the client area. Otherwise, the origin is the top
left corner of the whole Tekla Structures window. Moving a toolbar also affects
the size of the client area, because menus and toolbars are not part of it.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_MDIBASICVIEWPARENT (page 302)
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XS_BASICVIEW_POSITION_Y

Category

Model View

Use to control the vertical position of basic view windows on the screen. Enter
the value in pixels. The default value is 20.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_BASICVIEW_POSITION_X (page 91)

XS_BASICVIEW_WIDTH

Category

Model view

Use to define the width of basic view windows. Enter the width in pixels, for
example, 570. The default value is 375.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_BASICVIEW_POSITION_X (page 91)

XS_BEVEL_DIMENSIONS_FOR_PROFILES_ONLY

Category

Dimensioning: Parts

Use to define whether to show bevel dimensions only for profiles.

If you set the advanced option to TRUE, bevel dimensions are shown only for
profiles

If you set the advanced option to FALSE (default), bevel dimensions are shown
always.

This advanced option is model specific and the setting is saved in the options
database.
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XSBIN

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

This advanced option defines the location of the Tekla Structures bin folder.

Example
set XSBIN=%XS_DIR%\nt\bin\

XS_BLACK_DRAWING_BACKGROUND

Category

Drawing View

Set to TRUE to have a black background and colored lines in drawings. If you
want to have white background and black lines, enter FALSE (default).

NOTE This advanced option is user specific and the setting is saved in
options.bin under user folder. Restart Tekla Structures to activate
the new value. It only affects the Color mode, not Black and White or
Gray Scale mode.

See also

XS_USE_COLOR_DRAWINGS (page 441)

XS_BOLT_DUPLICATE_IGNORE

Category: Numbering

Use this advanced option to define whether duplicate bolt holes in the same
location, or within a tolerance (page 94), in a part are ignored in part
numbering, and in drawings and NC files.

The default value is FALSE.

If this advanced option is set to TRUE, the duplicate bolt holes are ignored in
part numbering, and in drawings and NC files.

You can use this advanced option when only some and possibly a different set
of the holes in otherwise identical parts will be used for bolting on site. In this
way identical parts can be used in different conditions in the structure.
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The size of the duplicate holes is not taken into consideration, only the
location, so holes of different size are considered duplicates if they are in the
same location.

If there are overlapping holes within the tolerance, the hole without a bolt is
taken into account, and the hole created by an actual bolt is ignored.

NOTE It is not recommended to change this advanced option during a
project, but if you do so, you must carry out full numbering.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_BOLT_DUPLICATE_TOLERANCE (page 94)

XS_BOLT_DUPLICATE_TOLERANCE

Category: Numbering

When XS_BOLT_DUPLICATE_IGNORE (page 93) is set to TRUE, use 
XS_BOLT_DUPLICATE_TOLERANCE to set the location tolerance that defines
which bolt holes are considered duplicates and will therefore be ignored in
part numbering.

The default value for the tolerance is 3 mm.

NOTE It is not recommended to change this advanced option during a
project, but if you do so, you must carry out full numbering.

This advanced option is model specific and the setting is saved in the options
database.

XS_BOLT_LENGTH_EPSILON

Category

Modeling Properties

Use to round bolt length.

Tekla Structures calculates bolt length using material thickness. To avoid
having several bolt lengths where material thickness only differs slightly, set
this advanced option to a positive or negative value. This value is multiplied by
two and the result is subtracted from the material thickness in bolt length
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calculation. Enter the value in millimeters (all environments). Typical values are
0.001–0.5. The default value is 0.001.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_BOLT_MARK_DIAMETER_PREFIX

Category

Marking: Bolts

Use this advanced option to specify a prefix for bolt mark diameter. The
possible values are NONE or any string.

This advanced option is model specific and the setting is saved in the options
database.

Example

For a bolt group consisting of three 20 mm diameter bolts:

• If you do not give any value, result is

3*M20

• If you set XS_BOLT_MARK_DIAMETER_PREFIX to NONE, the result is

3*20

• If you set XS_BOLT_MARK_DIAMETER_PREFIX to D, the result is

3*D20

XS_BOLT_MARK_IS_ALWAYS_VISIBLE

Category

Marking: Bolts

Set this advanced option to TRUE to show the bolt marks of bolts hidden from
views by other objects. The bolt marks are displayed with solid leader lines
and frames. If you set it to FALSE (default), the bolt marks of hidden bolts are
displayed with dashed leader lines and frames. This advanced option affects
all drawing types.

This advanced option is model specific and the setting is saved in the options
database.
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XS_BOLT_MARK_IS_ALWAYS_VISIBLE_IN_GA

Category

Marking: Bolts

Set this advanced option to TRUE to show the bolt marks of bolts hidden from
views by other objects. The bolt marks are displayed with solid leader lines
and frames. If you set it to FALSE (default), the bolt marks of hidden bolts are
displayed with dashed leader lines and frames. This advanced only affects
general arrangement drawings.

NOTE If you have set the advanced option 
XS_BOLT_MARK_IS_ALWAYS_VISIBLE to TRUE, the bolt marks are
always displayed with solid lines even if you set 
XS_BOLT_MARK_IS_ALWAYS_VISIBLE_IN_GA to FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_BOLT_MARK_STRING_FOR_SIZE

Category

Marking: bolts

Use to define the contents of the Size element in bolt marks. For example, to
have the bolt number and the hole diameter in the mark, enter 
%BOLT_NUMBER%*D%HOLE.DIAMETER%.

This advanced option is only used when there is a bolt and the hole is a
normal one.

The advanced options XS_SHOP_BOLT_MARK_STRING_FOR_SIZE and 
XS_SITE_BOLT_MARK_STRING_FOR_SIZE override this setting.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER
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• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_BOLT_MARK_STRING_FOR_SIZE (page 410)

XS_SHOP_BOLT_MARK_STRING_FOR_SIZE (page 389)

XS_BOLT_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in bolt marks in general
arrangement drawings. If you have not set the advanced options 
XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA or 
XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA, then this advanced option
is used.

This advanced option is only used when there is a bolt and the hole is a
normal one.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER
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• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA (page 390)

XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA (page 411)

XS_BOLT_POSITION_TO_MIN_AND_MAX_POINT

Category

Dimensioning: Bolts

Set this advanced option to TRUE to create minimum and maximum position
dimensions for bolts. If you do not want to create minimum and maximum
position dimensions for bolts, set it to FALSE (default).

This advanced option is model specific and the setting is saved in the options
database.

The examples below show a maximum bolt dimension of 40:

Setting Example
Before setting the advanced
option.
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Setting Example
After setting the advanced
option to TRUE.

See also

XS_BOLT_REPRESENTATION_SYMBOL_AXIS_POSITION_AS_
EXACT_SOLID

Category

Drawing Properties

If you set the advanced option 
XS_BOLT_REPRESENTATION_SYMBOL_AXIS_POSITION_AS_EXACT_SOLID to 
TRUE, all bolt axis representations set to Symbol are presented in the same
position as with Exact solid.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

Symbol representation when the advanced option is set to FALSE:

Symbol representation when the advanced option is set to TRUE:
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See also

XS_BOLT_REPRESENTATION_USE_POSITIVE_CUT_LENGTH

Category

Drawing Properties

Set this advanced option to TRUE to create bolt holes in the drawing instead of
sticks when the cut length is negative. FALSE is the default value.

This advanced option is model specific and the setting is saved in the options
database.

XS_BOLTS_PERPENDICULAR_TO_PART_PLANE_IN_NC

Category

CNC

Set this advanced option to TRUE (default) to dimension bolts perpendicular to
part plane in NC files. If you do not want to dimension the bolts, set it to 
FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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1.3 Advanced options - C

XS_CALCULATE_POLYBEAM_LENGTH_ALONG_REFERENCE_
LINE

Category

Dimensioning: Unfolding

Use this advanced option to calculate polybeam length along the reference
line instead of the centerline. By default, Tekla Structures measures polybeam
length along the centerline of the beam, regardless of the Position in plane
values of the beam.

Set this advanced option to TRUE to calculate polybeam length along the
reference line. Set it to FALSE (default) to calculate along the centerline.

When this advanced option is set, Tekla Structures ignores all unfolding
parameters defined in the unfold_corner_ratios.inp file. However, this
only affects polybeams with straight sections. The length of polybeams with
curved chamfers is always controlled using unfold_corner_ratios.inp.

This advanced option is model specific and the setting is saved in the options
database.

NOTE The centerline option is always a safe alternative, because other
modifications do not impact on it. For example, if you calculate length
using the reference line and you have used offsets to move the beam,
the result may not be the true length of the beam.

NOTE When XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION (page 455) is
set to TRUE, this advanced option is not used, even though results
might be the same in most cases. To obtain reliable results, especially
for Net Length, we recommend that you do not set 
XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION to TRUE.

See also

XS_CALCULATE_POUR_UNITS_ON_SHARING

Category: Multi-user

By default, this advanced option is set to TRUE, which means that pour units
are automatically calculated and up to date in shared models after read in and
write out.
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If this advanced option is set to FALSE, each user has to run the Calculate
pour units command in their local version of the shared model to update the
pour units.

This advanced option is model specific and the setting is saved in the options
database.

XS_CAST_UNIT_FAMILY_POSITION_NUMBER_FORMAT_
STRING

Category

Numbering

Use to define the contents of the cast unit family position number. For
example, instead of DT1-1, DT1-2, you can define the numbering as DT1-A,
DT1-B.

To get this result, set the advanced option as follows:

%CAST_UNIT_PREFIX%%CAST_UNIT_FAMILY_NUMBER%-
%CAST_UNIT_FAMILY_QUALIFIER_WITH_LETTERS%
Use the following options to define the contents of family position numbers.
Use as many options as you need, and enclose each one in percent symbols
(%).

Option Description
%CAST_UNIT_PREFIX% Cast unit prefix, defined in the part

properties in the property pane.
%CAST_UNIT_POS% The running cast unit position

number, starting from the start
number defined in the part properties
in the property pane.

%CAST_UNIT_FAMILY_NUMBER% Cast unit family number, defined by
the start number (in part properties
in the property pane) and the final
position in that numbering series.

%CAST_UNIT_FAMILY_NUMBER_WITH
_LETTERS%

Cast unit family number with letters.
The letters run automatically from A
to Z. If more letters are needed, Tekla
Structures takes a second or even a
third letter into use, for example AA
or AAA.

You can also define valid letters with
the advanced option 
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Option Description
XS_VALID_CHARS_FOR_ASSEMBLY_F
AMILY_POSITION_NUMBERS.

%CAST_UNIT_FAMILY_QUALIFIER% Cast unit family qualifier, defined by
the family numbering criteria given in
the Numbering Setup dialog box.

%CAST_UNIT_FAMILY_QUALIFIER_W
ITH_LETTERS%

Cast unit family qualifier with letters.
The letters run automatically from A
to Z. If more letters are needed, Tekla
Structures takes a second or even a
third letter into use, for example AA
or AAA.

You can also define valid letters with
the advanced option 
XS_VALID_CHARS_FOR_ASSEMBLY_F
AMILY_QUALIFIER.

%UDA:[uda_name]% User-defined attribute of the cast unit
or cast unit main part. If the attribute
is defined for the cast unit, it will be
used. If it is not defined, the main part
attribute will be used. You can also
define that only the user-defined
attribute of the main part will be
used, for example 
%UDA:MAINPART.USER_FIELD_1%.

%TPL:[tpl_name]% Template attribute of the cast unit or
cast unit main part, for example %
TPL:PROJECT.NUMBER%.

This advanced option is model specific and the setting is saved in the options
database.

Number of characters

You can define the number of characters by adding a period and the required
number to the end of each option. For example 
%CAST_UNIT_FAMILY_QUALIFIER_WITH_LETTERS.3% will result in three
letters for every cast unit, starting from AAA.

Example

If you set the advanced option to

%CAST_UNIT_PREFIX%/%CAST_UNIT_FAMILY_NUMBER.3%-
%CAST_UNIT_FAMILY_QUALIFIER.3%
The result will be

A/001-001.
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See also

CAST_UNIT_POS (page 500)

XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_QUALIFIER (page 469)

XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_POSITION_NUMBERS (page 469)

XS_CAST_UNIT_MULTI_NUMBER_FORMAT_STRING

Category: Numbering

Use to base cast unit numbers on drawing numbers. Use the following
switches to define the contents of cast unit marks. Use as many switches as
you need, and enclose each one in percent symbols (%).

The available switches are:

Switch Description
%CAST_UNIT_MULTI
_DRAWING_NUMBER%

Multidrawing name.

%CAST_UNIT_MULTI
_DRAWING_POS%

Position of the cast unit drawing
inside the multidrawing.

%CAST_UNIT_PREFI
X%

Cast unit prefix in the model.

%CAST_UNIT_POS% Cast unit position number in the
model.

Template fields Enter TPL: followed by the name of
any relevant template field. Enclose
each name in percent symbols (%).
For example, %TPL:PROJECT.NUMBER
%
NOTE: No template fields starting with 
DRAWING work for this advanced
option, for example, 
DRAWING.TITLE1. If you use them in
the value, Tekla Structures will replace
the whole value string with the default
value.

User-defined
attributes that are
defined in the
objects.inp file

Enter UDA: followed by the name of
any relevant user-defined attribute,
exactly as it appears in the
objects.inp file. For example, 
%UDA:MY_INFO_1%

This advanced option is model specific and the setting is saved in the options
database.
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Example

To put the cast unit multinumbers in the format multidrawing name + part
prefix + position on multidrawing, set the advanced option as follows:

%CAST_UNIT_MULTI_DRAWING_NUMBER%%CAST_UNIT_PREFIX%
%CAST_UNIT_MULTI_DRAWING_POS%
This will create the cast unit mark 10B1, where:

• 10 is the drawing number

• B is the cast unit prefix

• 1 designates that it is the first cast unit on the sheet.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_PART_MULTI_NUMBER_FORMAT_STRING (page 326)

XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING (page 81)

XS_CAST_UNIT_POSITION_NUMBER_FORMAT_STRING

Category: Numbering

Use to define the contents of the cast unit position number.

NOTE Do not change this advanced option after you have created single-
part, assembly, or cast unit drawings, if you are using cloning. It may
partially separate the drawings from the part they represent, causing
the drawings to be flagged as deleted and other drawings to be cloned
after the next numbering.

The options are:

Option Description
%CAST_UNIT_PREFIX% Cast unit prefix, defined in the part

properties dialog box.
%CAST_UNIT_POS% The running cast unit position

number, starting from the start
number defined in the part properties
dialog box.

%CAST_UNIT_POS_WITH_LETTERS% Same as above, but with letters.

Uses letters A – Z by default, but you
can also define valid letters with the
advanced option 
XS_VALID_CHARS_FOR_ASSEMBLY_P
OSITION_NUMBERS
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Option Description
%UDA:[uda_name]% User-defined attribute of the cast unit

or cast unit main part. If the attribute
is defined for the cast unit, it will be
used. If it is not defined, the main part
attribute will be used. You can also
define that only the user-defined
attribute of the main part will be
used, for example 
%UDA:MAINPART.USER_FIELD_1%.

%TPL:[tpl_name]% Template attribute of the cast unit or
cast unit main part, for example %
TPL:PROJECT.NUMBER%.

This advanced option is model specific and the setting is saved in the options
database.

Number of characters

You can define the number of characters by adding a period and the required
number to the end of the options %CAST_UNIT_POS% and 
%CAST_UNIT_POS_WITH_LETTERS%. For example, 
%CAST_UNIT_POS_WITH_LETTERS.3% will result in three letters for every cast
unit, starting from AAA.

Example

If you set the advanced option to %CAST_UNIT_PREFIX%/
%CAST_UNIT_POS.3%, the result will be A/001.

See also

CAST_UNIT_POS (page 500)

XS_CENTER_LINE_TYPE

Category: Drawing Properties

Drawing Properties

Use this advanced option to change the line type of the part center lines in
drawings. Enter an integer value from 1 to 7. To see the center line type
change, close the drawing and open it again.

You can select whether to show the center line in Part properties (page 704).
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Value Description
1 Solid line
2 - 7 Dotted lines.

The default value is 4 (dash-and-dot line).

If you enter a value that is lower than 1 or higher than 7, Tekla Structures uses
the default value 4.

TIP To see what the line types look like, see the Hidden lines > Type options
on the Appearance tab in Part Properties.

For a list of default line types, see .

This advanced option is model specific and the setting is saved in the options
database.

XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING

Category

Marking: Bolts

Sets the format of the element Center-to-center distance in bolt marks,
when the bolts are in the same part, for example, in a column or beam flange.
Use to define gage information in the bolt mark in the following way:

• Use the switch %VALUE% for the numeric value of a gage.

• You can add text and the option in any order, for example, %VALUE% GAGE
or GAGE %VALUE%.

• If %VALUE% is missing, Tekla Structures adds the center-to-center distance
to the end of the string.

• If this advanced option is not set, only %VALUE% is used.

• If Tekla Structures cannot calculate the gage, nothing is added in the mark.

• The default value value is GAGE = %VALUE% .

This advanced option is model specific and the setting is saved in the options
database.

Example

There is a symmetrical bolt group in a beam flange. The value for gage is 10.
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In the Advanced Options dialog box In bolt mark
GAGE
= %VALUE% GAGE = 10

XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING

Category

Marking: Bolts

Sets the format of the element Center-to-center distance in bolt marks
where there are two parts.

The default value is C/C = %VALUE%.

This advanced option is model specific and the setting is saved in the options
database.

Example

There is a symmetrical bolt group in two clip angles. The center-to-center
distance is 10.

In the Advanced Options dialog box In bolt mark
c/c = %VALUE% c/c = 10

See also

XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING (page 107)

XS_CHAMFER_ACCURACY_FACTOR

Category: Speed and accuracy

Use this advanced option to define the number of points used for chamfers.
Use lower values to increase the number of points used to construct the
chamfer, thus making the curved chamfer smoother. Use larger values to
decrease the number of points used to construct the chamfer, thus making
the curved chamfer less smoother.

The default value is 4.0.

Restart Tekla Structures after changing the value to activate the new setting.

In the example below, the value is 16.
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In the example below, the value is 1.

The minimum value is 0.1.

Click the links below to find out more:

Round chamfers does not appear round in model

Chamfer accuracy for polybeams and contour plates

XS_CHAMFER_DISPLAY_LENGTH_FACTOR

Category

Model view

Use to adjust chamfer length. Tekla Structures calculates plate chamfer length
from the plate side length using the following formula: 
XS_CHAMFER_DISPLAY_LENGTH_FACTOR * plate side length. By default
this factor is 0.08.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED

Category

Drawing Properties

Use to define whether dimensions have fixed placing when you drag them
away from their original locations. When set to TRUE, dimension placing uses
fixed placing routine instead of free placing. FALSE keeps the placing free.

The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CHANGE_DRAGGED_MARKS_TO_FIXED

Category

Drawing Properties

Use to define whether part, bolt and reinforcement marks have fixed placing
when you drag them away from their original locations. When set to TRUE,
mark placing uses fixed placing routine instead of free placing.

The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CHANGE_DRAGGED_NOTES_TO_FIXED

Category

Drawing Properties

Use to define whether associative notes have fixed placing when you drag
them away from their original locations. When set to TRUE, associative notes
placing uses fixed placing routine instead of free placing. FALSE keeps the
placing free.

The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_CHANGE_DRAGGED_TEXTS_TO_FIXED

Category

Drawing Properties

Use to define whether texts have fixed placing when you drag them away from
their original locations. When set to TRUE, text uses fixed placing routine
instead of free placing. The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CHANGE_DRAGGED_VIEWS_TO_FIXED

Category

Drawing Properties

Use to define whether views have fixed placing when you drag them away
from their original locations. When set to TRUE, view placing uses fixed placing
routine instead of free placing. If you set this advanced option to FALSE, fixed
placing is not used. The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CHANGE_MARK_ASTERISK_TO

Category

Marking: parts

Use to specify a symbol to replace the asterisk character (*) in bolt marks and
the size elements of part marks. The default value is asterisk (*).

This advanced option is model specific and the setting is saved in the options
database.

NOTE You cannot use this advanced option to change the asterisk character
in profile strings (e.g. PL10*100).

Example
XS_CHANGE_MARK_ASTERISK_TO=X
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XS_CHANGE_WORKAREA_WHEN_MODIFYING_VIEW_DEPTH

Category

Model view

Makes working with reference files easier. Objects such as parts and reference
files outside the work area are not visible, even when they are within the view
depth range.

Set to TRUE (default) to automatically adjust the work area when you change
the view depth.

XS_CHECK_BOLT_EDGE_DISTANCE_ALWAYS

Category

Modeling Properties

Use this advanced option to select whether to check the bolt edge distance.
Set to TRUE to always check the bolt edge distance and to FALSE to check it
only when there are bolts in the object (the check is not done if there is only a
hole).

The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CHECK_FLAT_LENGTH_ALSO

Category

Plate Work

Set this advanced option to TRUE (default) to check plate length and plate
width, and then compare those with the possible dimensions for flat bars in
fltprops.inp.

If you set this advanced option to FALSE, Tekla Structures only checks the
plate width.

This advanced option is model specific and the setting is saved in the options
database.

See also
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XS_CHECK_TRIANGLE_TEXT_SIZE

Category

Dimensioning: General

Set this advanced option to TRUE to size the triangle to fit text in bevel
dimensions. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

To define the angle symbol size, use the advanced option 
XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR.

NOTE Using advanced option 
XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR will disable advanced
option XS_CHECK_TRIANGLE_TEXT_SIZE.

See also

XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR (page 75)

XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS

Category

Speed and Accuracy

Use this advanced option to define the chord tolerance for round tubes
smaller than or equal to the limit set by the advanced option 
XS_CHORD_TOLERANCE_SMALL_TUBE_SIZE_LIMIT. Enter the value in
millimeters. The default value is 1.0.

Re-open the model to activate the new value.

NOTE Do not change the chord tolerance settings during a project. Changing
them automatically recreates the tubular sections in the model when
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you restart Tekla Structures, resulting in slightly different solid objects,
which may affect numbering.

See also

XS_CHORD_TOLERANCE_SMALL_TUBE_SIZE_LIMIT (page 115)

XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS (page 114)

XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS

Category

Speed and Accuracy

Use this advanced option to define the chord tolerance for round tubes larger
than the limit set by the advanced option 
XS_CHORD_TOLERANCE_SMALL_TUBE_SIZE_LIMIT. Enter the value in
millimeters. The default value is 1.0.

Re-open the model to activate the new value.

Chord tolerance

Chord tolerance is the maximum difference between a straight segment used
to display a tubular section in model views and the actual tubular section:

NOTE Do not change the chord tolerance settings during a project. Changing
them automatically recreates the tubular sections in the model when
you restart Tekla Structures, resulting in slightly different solid objects,
which may affect numbering.

See also

XS_CHORD_TOLERANCE_SMALL_TUBE_SIZE_LIMIT (page 115)

XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS (page 113)
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XS_CHORD_TOLERANCE_SMALL_TUBE_SIZE_LIMIT

Category

Speed and Accuracy

Use this advanced option to define the limit that determines whether a tube is
considered small when calculating the chord tolerance. The value is compared
to the diameter of the profile. Enter the value in millimeters. The default value
is 50.0.

Re-open the model to activate the new value.

NOTE Do not change the chord tolerance settings during a project. Changing
them automatically recreates the tubular sections in the model when
you restart Tekla Structures, resulting in slightly different solid objects,
which may affect numbering.

See also

XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS (page 114)

XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS (page 113)

XS_CIS_DEP1_DATABASE_NAME

Category

Export

Use to define the name of the temporary database used in CIMsteel transfers.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_CIS_DEP1_DATABASE_PASSW

Category

Export

Use to define the password for the temporary database used in CIMsteel
transfers.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.
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XS_CIS_DEP1_DATABASE_PATH

Category

Export

Use to define a path to the temporary database that Tekla Structures creates
while converting a model from/to CIMsteel STEP format.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_CIS_DEP1_EXPRESS_FILE

Category

This advanced option must be set in an initialization (.ini) file.

Use this advanced option to specify the name of the EXPRESS file located in
the system folder. The EXPRESS file describes the CIMsteel DEP1 logical
product model. It is used when you convert a Tekla Structures model to/from
CIMsteel DEP1 STEP format.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CLASH_CHECK_BETWEEN_PARTS

Category

Modeling Properties

Set to FALSE to detect clashes only between Tekla Structures objects and
reference model objects and to TRUE to detect clashes also between Tekla
Structures objects. The default is TRUE.

See also

XS_CLASH_CHECK_BETWEEN_REFERENCES (page 116)

XS_CLASH_CHECK_INSIDE_REFERENCE_MODELS (page 117)

XS_CLASH_CHECK_BETWEEN_REINFORCING_BARS (page 117)
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XS_CLASH_CHECK_BETWEEN_REFERENCES

Category

Modeling Properties

Use to define whether or not Tekla Structures should run the clash check also
between reference models.

Set to TRUE if you want to perform clash check also between two reference
models. The default value is FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_CLASH_CHECK_BETWEEN_PARTS (page 116)

XS_CLASH_CHECK_INSIDE_REFERENCE_MODELS (page 117)

XS_CLASH_CHECK_BETWEEN_REINFORCING_BARS (page 117)

XS_CLASH_CHECK_BETWEEN_REINFORCING_BARS

Category

Modeling Properties

Set this advanced option to TRUE to detect clashes between Tekla Structures
reinforcing bars, and between reinforcing bars and other Tekla Structures
objects (steel parts, bolts, embeds, and reference objects). Set to FALSE to
detect clashes between reinforcing bars and other Tekla Structures objects
except between reinforcing bars. The default is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CLASH_CHECK_BETWEEN_PARTS (page 116)

XS_CLASH_CHECK_BETWEEN_REFERENCES (page 116)

XS_CLASH_CHECK_INSIDE_REFERENCE_MODELS (page 117)
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XS_CLASH_CHECK_INSIDE_REFERENCE_MODELS

Category

Modeling Properties

Use this advanced option for defining whether internal clashes are checked in
reference models.

The default value FALSE means that clashes between reference model objects
within one reference model are ignored. Clashes between reference model
objects belonging to different models are detected. The value TRUE means
that clashes between reference model objects within one reference model are
checked.

Note that this advanced option is taken into account only if the 
XS_CLASH_CHECK_BETWEEN_REFERENCES advanced option is set to TRUE.

See also

XS_CLASH_CHECK_BETWEEN_REFERENCES (page 116)

XS_CLEAR_MODEL_HISTORY

Category

Speed and Accuracy

If you use model history log files, set this advanced option to TRUE to clear
history data from the log file each time you open and save the model. The
default value is FALSE.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

See also

XS_COLLECT_MODEL_HISTORY (page 120)

XS_CLONING_TEMPLATE_DIRECTORY

Category: File Locations

Enter a path to the folder that contains cloning templates used by the Master
Drawing Catalog. You can have several paths separated by semicolon. This
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advanced option is set to %XSDATADIR%\environments\common
\cloning_templates by default.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_CLOUD_SHARING_PROXY

NOTE We recommend you to set this advanced option in File menu -->
Sharing --> Sharing settings --> Tekla Model Sharing cache.

Use this advanced option to set up a cache server that is used with the Tekla
Model Sharing sharing service.

If needed, the advanced option can be set in initialization files. Set 
XS_CLOUD_SHARING_PROXY to name of the server;port in initialization
files.

This advanced option is user-specific.

XS_CNC_CUT_PLANE_HEIGHT

Category

CNC

Set this advanced option to a value between 0.3 and 1.0 if you get the
following warning in the dstv_nc.log file for some NC files:

Error: Can't find intersection between solid and nc plane.
Please try to adjust XS_CNC_CUT_PLANE_HEIGHT (0.3 .. 1.0)
You may get these warnings when you try to create NC files for folded parts.
These NC files are not correct. For example, the external contours of the part
may be entirely missing from the NC file. You will notice this, if you view a DXF
file created from the NC file.

To use this advanced option, follow these steps:

1. Set this advanced option using a value bigger than 0.3. Start with smaller
values first. The internal default value is 0.3.

2. Create the NC files for the problematic part.

3. Check the file dstv_nc.log, and if there is still warning for this part,
repeat steps 1 to 4 with another value.

Advanced options reference 119 Advanced options - C



4. After creating the NC files without any error messages in the
dstv_nc.log, remove the advanced option from the user.ini file as
this advanced option may cause problems for some other parts.

This advanced option is model specific and the setting is saved in the options
database.

XS_CNC_HOLE_DIAMETER_ROUNDING

Category

CNC

Defines the rounding factor of holes for NC files. NC files are accurate to 0.01
mm.

Use to round bolt diameters with very small differences in diameter to the
same value. You may need to use different diameters because bolts can have
different tolerance values in a Tekla Structures model. You can input more
decimals into bolt tolerance values in the component dialog boxes than in the
general bolt dialog box.

The rounding routine is used only when you create NC files.

Set the rounding factor the same value (in mm) as the drill tolerance of the
machine tool. The default value is 0.00001.

Tekla Structures divides the original hole diameter by the rounding factor,
then rounds the result to the nearest integer, then multiplies it by the
rounding factor. As a result, bolt diameters with very small differences in
diameter are now rounded to the same value.

This advanced option is model specific and the setting is saved in the options
database.

Example

Here the rounding factor is 1.5875 (1/16 inch), which results in the following:

• Diameter 26.99 mm (1” 1/16 from component dialog box) => 26.99/1.5875
=> 17.00 => 17 => 17*1.5875 => 26.99 mm

• Diameter 27.00 mm (1” 1/16 from bolt dialog box) => 27.00/1.5875 => 17.01
=> 17 => 17*1.5875 => 26.99 mm

XS_COLLECT_MODEL_HISTORY

Category

Speed and Accuracy
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Tekla Structures is able to collect model history data on various objects, for
example, parts in the inquire object dialog, reinforcing bars, and components
in reports, etc. Set this advanced option to TRUE (default) to collect the data. If
you do not want to collect the model history, set it to FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CLEAR_MODEL_HISTORY (page 118)

XS_COMBINED_BOLT_DIM_CHARACTER

Category

Dimensioning: Bolts

Use to set the character in bolt dimensions. The default value is asterisk (*).

This advanced option is model specific and the setting is saved in the options
database.

XS_COMPANY_SETTINGS_DIRECTORY

Category

This advanced option must be set in an initialization (.ini) file.

Use this advanced option to define a folder where the initialization file
company.ini is located. This file contains enterprise-level settings. You can
define the folder, for example, in an options.ini file located under the
model, firm or project folder.

XS_COMPLEX_PART_MEMBERS_DO_NOT_HAVE_TO_BE_MAIN_
PARTS

Category

Dimensioning: Parts

Use in complex part/ assembly dimensioning to have Tekla Structures
dimension other than main parts as one. The default value is FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is

Advanced options reference 121 Advanced options - C



in use, you can change the value, which is then the same for all users in the
current model.

XS_COMPONENT_CATALOG_ALLOW_SYSTEM_EDIT

Category: Modeling Properties

Set this advanced option to TRUE to be able to edit the Applications &
components catalog definition files that are located in the XS_SYSTEM folders.

Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_COMPONENT_CATALOG_DO_REPORT_LEGACY_FILE_
ISSUES

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

Set the advanced option to TRUE to enable the reporting of legacy component
catalog issues to the message log in the Applications and Components
catalog.

Restart Tekla Structures after changing the value to activate the new setting.

XS_COMPONENT_CATALOG_COMPACT_THUMBNAIL_SIZE

Category: Modeling Properties

Use to adjust the size of thumbnails to between 16 and 96 pixels in the
compact view. The default is 40.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_COMPONENT_CATALOG_THUMBNAIL_SIZE (page 122)
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XS_COMPONENT_CATALOG_THUMBNAIL_SIZE

Category: Modeling Properties

Use to adjust the size of thumbnails to between 16 and 96 pixels in the normal
view. The default is 96 pixels.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_COMPONENT_CATALOG_COMPACT_THUMBNAIL_SIZE (page 122)

XS_CONCRETE_PART_NUMBERING_PREFIX

Category

Numbering

Use to define a numbering prefix for concrete parts. The default value is 
Concrete.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CONCRETE_PART_NUMBERING_START_NUMBER (page 123)

XS_CONCRETE_PART_NUMBERING_START_NUMBER

Category

Numbering

Use to define a start number for concrete parts. The default value is 1.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CONCRETE_PART_NUMBERING_PREFIX (page 123)
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XS_CONNECTING_SIDE_MARK_SYMBOL

Category

Marking: Parts

Use to change the symbol for a connecting side mark in single-part, cast unit,
and assembly drawings. By default the side mark symbol is number 34 in the
symbol file. To change the symbol, set this advanced option to a different
symbol number.

In general arrangement drawings, use
XS_GA_CONNECTING_SIDE_MARK_SYMBOL (page 252).

This advanced option is model specific and the setting is saved in the options
database.

XS_CONNECT_CONNECTION_PARTS_IN_AUTOCONNECTION

Category: Components

Set this advanced option to FALSE (default) if you do not want to connect the
parts created by the connection in Autoconnection. If you set it to TRUE, the
parts created by the connection are connected in Autoconnection.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CONNECT_PLATE_PROFILES_IN_AUTOCONNECTION

Category

Components

Set to TRUE to enable AutoConnection for built-up members. If you set this
advanced option to FALSE, Tekla Structures does not consider plates as
members when you use AutoConnection. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_CONNECT_UPLOAD_MODEL_FOLDER

Category

File Locations

Use this advanced option to define a Trimble Connect project folder where the
current Tekla Structures model is uploaded as a read-only .tekla reference
model. The .tekla reference model works as the counterpart of the Tekla
Structures model in the linked Trimble Connect project. Uploading the Tekla
Structures model as a .tekla reference model allows you to use ToDos and
other Trimble Connect commands with the model.

Enter a path to the folder in the attached Trimble Connect project into which
you want upload the current Tekla Structures model. By default, the folder
path is Structural\Tekla models.

If you are working with a model that has been shared with Tekla Model
Sharing, use the (page 436) advanced option to define when the shared model
will be uploaded to the Trimble Connect project folder.

This advanced option is model specific and the setting is saved in the options
database.

XS_CONSIDER_NEIGHBOUR_PARTS_IN_HIDDEN

Category

Drawing Properties

Set this advanced option to TRUE (default) to draw parts behind neighbor
using hidden lines. If you want to show parts behind neighboring parts using a
visible line type, set this advanced option to FALSE.

Setting Example of appearance in
drawing

Set to TRUE (default). Parts
behind neighbor parts are
drawn with hidden lines.
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Setting Example of appearance in
drawing

Set to FALSE. Parts behind
neighbor parts are drawn with
the visible line type.

This advanced option is model specific and the setting is saved in the options
database.

XS_CONSIDER_REBAR_HOOK_LOCATION_IN_CAST_UNIT_
NUMBERING

This advanced option must be set in an initialization (.ini) file.

Use this advanced option to define whether the location of the reinforcing bar
hooks are taken into account in cast unit numbering or not.

The default value is FALSE.

When this advanced option is set to TRUE, cast units that are otherwise
identical will receive different numbers if the hooks in otherwise identical bars
point to different directions, or if the stirrup hooks are in different corners, for
example.

Restart Tekla Structures after changing the value to activate the new setting.

XS_CONSIDER_REBAR_NAME_IN_NUMBERING

Category

Concrete Detailing

Set to FALSE to have Tekla Structures only take part names into account when
numbering, not reinforcing bar names. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_CONTOUR_PLATE_POINT_ON_SAME_LINE_LIMIT

Category

Modeling Properties

Cleans away system component provided contour plate profile points in cases
where points are on an almost straight line if the provided (middle) points
deviate from the line at most as much as the value of this advanced option.
The point is then so close to the line between the previous and next point that
it is redundant and can be removed. Enter a decimal value. The default is 1.0
mm.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CONTOUR_PLATE_POINT_ON_SAME_LINE_LIMIT_FOR_CLOSE_POINTS
(page 127)

XS_CONTOUR_PLATE_POINT_ON_SAME_LINE_LIMIT_FOR_
CLOSE_POINTS

Category

Modeling Properties

Cleans away system component provided contour plate profile points in cases
where points are on an almost straight line if the provided (middle) points
deviate from the line at most as much as the value of this advanced option.
The point is then so close to the line between the previous and next point that
it is redundant and can be removed. This advanced option is used if section
point distances between two consecutive points are smaller than 10.0 mm.
The default value for this advanced option is 0.1 mm.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CONTOUR_PLATE_POINT_ON_SAME_LINE_LIMIT (page 127)
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XS_CONVERSION_ARBITRARY_PROFILE_MAPPING_BY_NAME_
MUST_MATCH_DIMENSIONS

Category: Modeling Properties

Set this advanced option to TRUE to require that the dimensions match the
arbitrary profile mapping when mapping profile name to profile name in IFC
object conversion. FALSE is the default value.

This advanced option is model specific and the setting is saved in the options
database.

XS_CONVERT_OLD_FORCE_UNITS_TO_SI_FROM

Category

Components

Use to define how to convert part and connection attribute tables when you
open a Tekla Structures catalog prior to version 7.0.

You can use the following units: kg/T/N/daN/kN/lbf/kip, or a numerical value.

This advanced option is model specific and the setting is saved in the options
database.

Example

To convert force units from kip to SI, set this advanced option to kip.

XS_CONVERT_OLD_MOMENT_UNITS_TO_SI_FROM

Category

This advanced option must be set in an initialization (.ini) file.

Use to define how to convert part and connection attribute tables when you
open a Tekla Structures catalog prior to version 7.0.

You can use the following units: kgm/Tm/Nm/daNm/kNm/lbf-in/lbf-ft/kip-in/
kip-ft, or a numerical value.

Example

To convert moment units from kip-ft to SI, set this advanced option to kip-ft.
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XS_COPY_REVISIONS_IN_AUTOMATIC_CLONING

Category

Drawing Properties

Set the advanced option XS_COPY_REVISIONS_IN_AUTOMATIC_CLONING to 
TRUE to copy the revisions and user-defined attributes to the automatically
cloned drawings. TRUE is the default value.

This advanced option is model specific and the setting is saved in the options
database.

XS_COUNT_ALL_PARTS_IN_NSFS_REPEATED_PART_MARK

Category

Marking: Parts

Use this advanced option to determine how the quantity of parts with merged
part marks is shown. Set this advanced option to TRUE to count all parts. By
default, this advanced option is set to FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

When there are four or more identical stiffeners on both sides of a beam web,
the mark is

• 4x1002BS if XS_COUNT_ALL_PARTS_IN_NSFS_REPEATED_PART_MARK is
set to TRUE.

• 2x1002BS if XS_COUNT_ALL_PARTS_IN_NSFS_REPEATED_PART_MARK is
set to FALSE.

See also

XS_COUNT_BOTH_PARTS_IN_NSFS_PART_MARK (page 129)

XS_COUNT_BOTH_PARTS_IN_NSFS_PART_MARK

Category

Marking: Parts
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Use this advanced option to determine how the quantity of parts with merged
part marks is shown. Set this advanced option to TRUE to count both parts. If
you do not want to do this, set it to FALSE (default).

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

When there are two identical stiffeners on both sides of a beam web, the mark
is

• 2x1002BS if XS_COUNT_BOTH_PARTS_IN_NSFS_PART_MARK=TRUE.

• 1002BS if XS_COUNT_BOTH_PARTS_IN_NSFS_PART_MARK=FALSE.

See also

XS_COUNT_ALL_PARTS_IN_NSFS_REPEATED_PART_MARK (page 129)

XS_CREATE_ALSO_BIG_HTML_REPORT_PICTURES

Category

Concrete Detailing

Set to TRUE to create an additional set of pictures to the report folder. The
pictures are three times larger in size compared to the ones in the HTML
report. The default is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_CREATE_DRAWING_PREVIEW_AUTOMATICALLY

Category

Drawing Properties

Set this advanced option to TRUE to take a snapshot of a drawing each time
the drawing is saved. The snapshot is saved in the \drawing folder under the
current model folder. The snapshot is used as the default preview image for
the drawing in the Master Drawing Catalog. If you set this advanced option
to FALSE, the snapshot is not taken. The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_CREATE_MISSING_MARKS_IN_INTELLIGENT_CLONING

Category

Marking: General

Use to create all marks to a cloned drawing where new parts have been
added.

To create the marks, set the advanced option to TRUE. The default is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CREATE_ROUND_HOLE_DIMENSIONS

Category

Dimensioning: Parts

Enter TRUE (default) to dimension the round hole center point in drawings.

Setting Example of appearance in drawings
TRUE

FALSE

You get the automatic dimension to hole center only if the cut part profile is
round.
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This advanced option does not apply to automatic general arrangement
drawing dimensions.

This advanced option is model specific and the setting is saved in the options
database.

XS_CREATE_CONNECTION_WHEN_COPYING_DRAWING_VIEWS

Category

Drawing Properties

Set to TRUE to link copied views to the original drawing. This means, for
example, that when you delete a drawing from which you copied a view, Tekla
Structures also deletes the copied view. The default value is FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Useful links

For more information about using
XS_CREATE_CONNECTION_WHEN_COPYING_DRAWING_VIEWS, see the following
Support Article in Tekla User Assistance: What does the XS_
CREATE_CONNECTION_WHEN_COPYING_DRAWING_VIEWS advanced option
do?

XS_DRAWING_CREATE_SNAPSHOT_ON_DRAWING_CREATION

Category: Drawing Properties

Set this advanced option to TRUE to create a snapshot of a drawing at the
same time that you create the drawing. If you set this option to TRUE, you no
longer need to open a drawing to save it to create the snapshot. The default
values is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_CREATE_VIEW_FROM_MODEL_OLD_WAY

Category

Drawing View
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Use this advanced option to specify which values Tekla Structures uses for
drawing view boundaries in general arrangement drawings. This only affects
views created from the model.

If you set this advanced option to FALSE (default), the drawing view
boundaries values are based on the current work area x and y coordinates of
a model view.

When this advanced option is set to TRUE, the drawing view boundary values
are based on the entire model view, ignoring the work area settings.

In both cases depth values are based on the model view display depth values.

This advanced option is model specific and the setting is saved in the options
database.

XS_CS_CHAMFER_DIVIDE_ANGLE

Category: Speed and accuracy

Use this advanced option to change the angles dividing a cross section
chamfer. The default value is 30.0 degrees.

NOTE A very small value will cause profile roundings not to be visible.

Using this advanced option affects the rounding radius for parts that
have high accuracy (for example parts in drawings and in DWG
export).

Example
XS_CS_CHAMFER_DIVIDE_ANGLE=10.0

See also

XS_SOLID_USE_HIGHER_ACCURACY (page 417)
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XS_CURVED_AXIS_PLACE

Category

Profiles

By default, Tekla Structures calculates the length of curved parts along the
center axis. Use this advanced option to define the position of this axis as a
ratio.

Tekla Structures calculates the location of the axis using the formula h=H/
2.0*ratio. The default value is zero (0). Define the ratio as 1.0 to calculate
length along the upper flange. Define the ratio as -1.0 to define the length
along the lower flange.

This value is used in reports and drawing templates.

XS_CUSTOM_COMPONENT_DECIMALS

Category

Speed and Accuracy

Use this advanced option to adjust the number of decimals for custom
components. This setting only works with parametric variables whose Value
type is Text. Other parameter types follow the normal accuracy settings.

The default value is 3.

XS_CUT_SYMBOL_FONT

Category

Drawing Properties

Use to define the font for section symbol text. The default value is Arial. If you
do not specify a font, Tekla Structures uses the default font defined for 
XS_DEFAULT_FONT.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DEFAULT_FONT (page 137)
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XS_CYCLIC_SOLVER_MAX_LOOPS

Category

Modeling properties

Use to define how many cycles Tekla Structures makes to solve the
dependencies in custom components. Enter a number for the amount of cycle
loops. The default is 2.

This advanced option is model specific and the setting is saved in the options
database.

1.4 Advanced options - D

DAK_BMPPATH

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

Use to point to the folder for bitmap files used in

• custom components

• user-defined attributes (objects.inp file)

• profile catalog

• some system components

You can use semicolon-separated lists of folder paths, see an example below.
This advanced option is by default defined in the teklastructures.ini file
and it points to the folder ..\ProgramData\Trimble\Tekla Structures
\<version>\Bitmaps
If you want to use another folder, add DAK_BMPPATH to the options.ini file
under the model folder with the new path that points to the folder where your
own bitmaps are located.

Example
DAK_BMPPATH=%XSDATADIR%\Bitmaps\
DAK_BMPPATH=%XSDATADIR%\Bitmaps\;H:\Tekla\bitmap\
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XSDATADIR

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. It can also be set locally, see your environment ini
file (env_<environment_name>.ini). Generally, there is no need to modify
system-specific settings. Do not modify them if you are not an administrator.

XSDATADIR is defined in the teklastructures.ini file. It points to a
location where the installation installs the environment files and folders.

Example

By default, this advanced option is set as follows: set
XSDATADIR=C:\ProgramData\Trimble\Tekla Structures\<version>\

XS_DEFAULT_BREP_PATH

This advanced option must be set in an initialization (.ini) file.

Use to define the location of the default shapes that are available in the Shape
Catalog dialog box when you create a new model. By default, this advanced
option is set to point to the common environment, and the definition files of the
default shapes are read from the \Shapes and \ShapeGeometries folders
under the \profil folder.

The shapes that you use from this location when you create items in a model
are copied to the model folder.

Example

To have Tekla Structures read the default shapes from the German
environment, set this advanced option as follows:

set XS_DEFAULT_BREP_PATH=%XSDATADIR%\environments\germany\
or

set XS_DEFAULT_BREP_PATH=C:\ProgramData\Trimble\Tekla
Structures\<version>\environments\germany\
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XS_DEFAULT_ENVIRONMENT

This advanced option must be set in an initialization (.ini) file.

Use together with XS_DEFAULT_LICENSE (page 138) and XS_DEFAULT_ROLE
(page 140) for bypassing the login dialog. Set these advanced options in a
separate initialization file, and point to that file using the -I (capital i)
parameter in the Tekla Structures shortcut. The parameter is used to point to
a file which needs to be read before other initialization files.

WARNING If roles are used in your environment, both 
XS_DEFAULT_ENVIRONMENT and XS_DEFAULT_ROLE should be
set for the startup to work correctly. XS_DEFAULT_LICENSE is
optional.

Example
set XS_DEFAULT_ENVIRONMENT=C:\ProgramData\Trimble\Tekla
Structures\<version>\Environments\germany\env_Germany.ini

XS_DEFAULT_FONT

Category: Model view

Use to specify the default font in the model and drawings, for example, when
creating grids, dimensions, and mark texts. Enter the name of any Windows
font, for example, Arial Narrow. The default value is Segoe UI semibold.

If any of the following advanced options are not set, or if font conversion is
needed in drawings, Tekla Structures uses XS_DEFAULT_FONT:

• XS_CUT_SYMBOL_FONT
• XS_DIMENSION_FONT
• XS_GRID_TEXT_FONT
• XS_MARK_FONT
• XS_VIEW_TITLE_FONT
• XS_WELD_FONT
For example, if XS_MARK_FONT has no value set and you open an old model
with a newer version of Tekla Structures, XS_DEFAULT_FONT is used when
converting marks to the new model database.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DEFAULT_FONT_SIZE (page 138)
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XS_CUT_SYMBOL_FONT (page 134)

XS_DIMENSION_FONT (page 150)

XS_GRID_TEXT_FONT (page 257)

XS_MARK_FONT (page 290)

XS_VIEW_TITLE_FONT (page 475)

XS_WELD_FONT (page 478)

XS_DEFAULT_FONT_SIZE

Category

Model View

Use to set the default font size when modeling. The default value is 12.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DEFAULT_HEIGHT_FOR_CALCULATED_DRAWING_SIZE

Category

Drawing Properties

Use to change the default height for the calculated drawing size. Enter the
value in millimeters. The default value is 287.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DEFAULT_LICENSE

This advanced option must be set in an initialization (.ini) file.

Use to set the default license for a user role. The advanced option can be used
either in a role-specific initialization file (role_*.ini) for setting the default
license for a selected role, or in a separate initialization file together with 
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XS_DEFAULT_ROLE and XS_DEFAULT_ENVIRONMENT for bypassing the login
dialog.

WARNING If roles are used in your environment, both 
XS_DEFAULT_ENVIRONMENT and XS_DEFAULT_ROLE should be
set for the startup to work correctly. XS_DEFAULT_LICENSE must
be set if there are more than one license type available.

Possible values are:

• FULL
• TeklaStructures_Primary
• STEEL_DETAILING
• REBAR_DETAILING
• PRECAST_CONCRETE_DETAILING
• CONSTRUCTION_MODELING
• DRAFTER
• ENGINEERING
• PROJECT_VIEWER
• PRODUCTION_PLANNER
• EDUCATIONAL
• DEVELOPER

XS_DEFAULT_MODEL_TEMPLATE

Category

This advanced option must be set in an initialization (.ini) file.

Use to define the model template which is used as the default in File menu -->
New when you create a new model.

Define a value for the advanced option in the role initialization files, available
in your environment folders. Store the default model template to the folder
defined by the advanced option XS_MODEL_TEMPLATE_DIRECTORY (page 309).

If this advanced option is not set, the model template that was used last is
displayed in File menu --> New.

Example
set XS_DEFAULT_MODEL_TEMPLATE=EngineeringTemplate
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XS_DEFAULT_ROLE

This advanced option must be set in an initialization (.ini) file.

Use together with XS_DEFAULT_LICENSE (page 138) and XS_DEFAULT_
ENVIRONMENT (page 136) for bypassing the login dialog. Set these advanced
options in a separate initialization file, and point to that file using the -I (capital
i) parameter in the Tekla Structures shortcut. The parameter is used to point
to a file which needs to be read before other initialization files.

WARNING If roles are used in your environment, both 
XS_DEFAULT_ENVIRONMENT and XS_DEFAULT_ROLE should be
set for the startup to work correctly. XS_DEFAULT_LICENSE is
optional.

Example
set XS_DEFAULT_ROLE=C:\ProgramData\Trimble\Tekla Structures
\<version>\Environments\USA\Role_Imperial_Steel_Detailing.ini

XS_DEFAULT_WIDTH_FOR_CALCULATED_DRAWING_SIZE

Category

Drawing Properties

Use to change the default width for the calculated drawing size. Enter the
value in millimeters. The default is 410.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DELETE_UNNECESSARY_DG_FILES

Category

Drawing Properties

Set the advanced option to TRUE (default) to delete unnecessary drawing files.
If you do not want to do this, set it to FALSE. This advanced option deletes the
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dg files older than seven days, which is the default value for the advanced
option XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD (page 141)

XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD

Category

Drawing Properties

Defines the time frame after which unnecessary drawing files are deleted.
Enter the required time frame in days. The advanced option is set to 7 by
default.

WARNING We recommend that you do not modify the value of this
advanced option unless you are an experienced Tekla Structures
user.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DELETE_UNNECESSARY_DG_FILES (page 140)

XS_DELETE_UNNECESSARY_INT_ARRAYS

Category: Speed and Accuracy

Set to TRUE to also clean the int arrays when you go to the File menu and click
Diagnose and repair --> Repair model . The default value is FALSE.

Create a backup copy of the model before you use this advanced option.

WARNING This setting reduces the model size in some cases but should be
used with caution. if you have this advanced option enabled and
run repair database, it deletes from the database all the integer
and double arrays that are no longer used. If someone starts
using integer arrays in a new location in the database, they would
have to know about this functionality and update it so that those
references would be found and no information would be lost.
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XS_DELETE_UNNECESSARY_REFMODEL_FILES_SAFETY_PERIOD

Category : Multi-user

Defines the time frame after which unnecessary reference model files are
deleted. Enter the required time frame in days. This advanced option is set to 
7 by default. To use this advanced option, you need to set the advanced
optionXS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT (page 365) to clean
up the unnecessary reference models.

• In multiuser model, files are kept until safety period has passed.

• In shared model, files are kept until write out.

WARNING We recommend that you do not modify the value of this
advanced option unless you are an experienced Tekla Structures
user.

This advanced option has no effect on shared models.

This advanced option is model specific and the setting is saved in the options
database.

XS_DETAIL_BOUNDARY_RADIUS

Category

Drawing Properties

Use to define a fixed size for circle-shaped detail boundaries in detail views.

Enter a numeric value in millimeters for the radius. By default, no size is set.

This advanced option is model specific and the setting is saved in the options
database.

XS_DETAIL_MARK_REFERENCE_SYMBOL

Category

Drawing Properties

If you have set Symbol to Custom on the Detail mark tab page of the Detail
symbol properties dialog box, Tekla Structures uses the value that you have
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set to this advanced option. For example, if you enter xsteel@3, Tekla
Structures uses the symbol number 3 in symbol file xsteel.sym.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DETAIL_SYMBOL_REFERENCE

Category

Drawing Properties

Sets the reference text for symbols that show a detail from another drawing.
The text can include:

• free text

• user-defined attributes

• template attributes

In the Advanced options dialog box, use single % characters around the user-
defined and template attributes. %DRAWING_TITLE% is the default value. 
%TITLE% gives the same result. This advanced option gets the drawing name
entered in the drawing properties dialog box. If you enter TITLE1 - TITLE3,
Tekla Structures gets the drawing title from the drawing properties dialog box.
You can also use the format DR_TITLE1 - DR_TITLE3.
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This advanced option is model specific and the setting is saved in the options
database.

XS_DETAIL_VIEW_REFERENCE

Category

Drawing Properties

Set the reference text for detail view labels. You can enter free text, user-
defined, attributes, and template attributes

Use single % characters around the user-defined and template attributes. 
%DRAWING_TITLE% is the default value. %TITLE% gives the same result. This
advanced option gets the drawing name entered in the drawing properties
dialog box. If you enter TITLE1 - TITLE3, Tekla Structures gets the drawing
title from the drawing properties dialog box. You can also use the format 
DR_TITLE1 - DR_TITLE3.
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This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DETAIL_SYMBOL_REFERENCE (page 143)

XS_DGN_EXPORT_PART_AS

Category

This advanced option must be set in an initialization (.ini) file.

Use to specify how Tekla Structures exports solid objects to DGN format.

• Set to CELL to export solid objects as cells containing the solid faces as a
DGN shape.

• Set to SOLID to export solid objects as DGN solid objects defined by
boundary elements.

The default value is CELL.

XS_DGN_EXPORT_USE_LOCAL_ID

Category

Export

Set this advanced option to TRUE to enable the use of local ID numbers in 3D
DGN export. Every exported part gets a unique ID number starting from 1. The

Advanced options reference 145 Advanced options - D



ID is saved as a user-defined attribute, and the same ID will be used in
consequent exports. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DIALOG_ENABLE_STATE

This advanced option must be set in an initialization (.ini) file.

Use this advanced option to remove selections from dialog box check boxes. 
TRUE is the default value.

XS_DIMENSION_ALL_BOLT_GROUPS_SEPARATELY

Category

Dimensioning: Bolts
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Set this advanced option to TRUE to prevent Tekla Structures from combining
bolt group dimensions. To combine bolt group dimensions, set it to FALSE
(default).

This advanced option is model specific and the setting is saved in the options
database.

XS_DIMENSION_DECIMAL_SEPARATOR

Category

Dimensioning: General

Use to define the character to be used as a decimal separator in dimensions
and level marks. The default value is a full stop (.).

XS_DIMENSION_DECIMAL_SEPARATOR = <separator character>.

This advanced option is model specific and the setting is saved in the options
database.

NOTE With this advanced option, you can change the separators in
dimension objects in drawings only, not in part marks or templates.

Example

In the following example, the dimension mark contains a comma when the
dimension settings in the Dimension Properties dialog box are as follows,
and the advanced option is set to XS_DIMENSION_DECIMAL_SEPARATOR=,
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In the following example, the separator was first a period and was then
changed to a comma.

XS_DIMENSION_DIGIT_GROUPING_CHARACTER

Category

Dimensioning: General

Use to specify which separator character to use in large dimension values. If
you enter a comma (,), 154321 would become 154,321. If you do not specify a
character, Tekla Structures uses a space in dimensions when you set grouping
toYes in Dimension properties > General > Use grouping. By default, no
value is set.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DIMENSION_DIGIT_GROUPING_COUNT (page 148)

Dimension and dimensioning properties (page 652)

XS_DIMENSION_DIGIT_GROUPING_COUNT

Category

Dimensioning: general

Use to specify the number of digits after which a separator character will be
inserted in dimension values. If you set this advanced option to 3 (default),
154321 becomes 154 321.

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_DIMENSION_DIGIT_GROUPING_CHARACTER (page 148)

Dimension and dimensioning properties (page 652)

XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR

Category

Dimensioning: General

Use to adjust the length of the dimension extension lines that are facing away
from the dimension points. Define the length as a factor for the dimension
text size. The default is 1.0 (text height * 1.0).

This option is used only when the option Short extension line is set to Yes or
On grid lines only in the Dimension Properties dialog box.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR (page 149)

XS_DIMENSION_EXTENSION_LINE_ORIGIN_OFFSET

Category

Dimensioning: General

Use to specify the distance between the extension line origin and the start of
the extension line (extension line origin offset). The default value is 1.

This advanced option is model specific and the setting is saved in the options
database.

In the following example, extension line origin offset is defined:
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XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR

Category

Dimensioning: General

Use to adjust the length of the dimension extension lines that are facing
towards the dimension points. Define the length as a factor for the dimension
text size. The default is 1.5 (text height * 1.5).

This option is used only when the option Short extension line is set to Yes or
On grid lines only in the Dimension Properties dialog box.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR (page 149)

XS_DIMENSION_FONT

Category

Drawing Properties

Use to specify the font for dimension text. The default value is Arial. If you do
not specify a font, Tekla Structures uses the default font defined for 
XS_DEFAULT_FONT instead.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DEFAULT_FONT (page 137)

XS_DIMENSION_GROUPING_COUNT_SEPARATOR

Category

Dimensioning: General
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Use to define the symbol that is displayed between the quantity and the
automatic tag text in grouped dimensions. The default is x.

This advanced option is model specific and the setting is saved in the options
database.

Note that the advanced option 
XS_DIMENSION_GROUPING_COUNT_SEPARATOR is intended for grouped
dimensions that are defined in the integrated dimension settings (page 673).
For other dimension marks, use the advanced option
XS_DIMENSION_MARK_MULTIPLIER (page 152).

See also

XS_DIMENSION_LINE_TEXT_EPS

This advanced option has been removed, please use the advanced option XS_
TEXT_ORIENTATION_EPSILON (page 427) instead.

XS_DIMENSION_MARK_CONNECTOR

Category

Dimensioning: General

Use this advanced option to change the character that is used in dimension
tags when the dimension tag displays the properties of the different objects
dimensioned, for example, different part positions, and one dimension line is
used. A plus sign is used by default.

This advanced option is model specific and the setting is saved in the options
database.

See also

Add tags to dimensions
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XS_DIMENSION_MARK_CREATE_MIDDLE_TAG_ALWAYS

This advanced option must be set in an initialization (.ini) file.

Since Tekla Structures version 2017, the dimension middle tag functionality
has been extended to show by default object information also when the
dimension start and end are pointing to different objects. In previous versions,
the middle tag content was only shown when the start and end were pointing
to the same object. The previous functionality can be taken into use by setting
this advanced option to FALSE.

XS_DIMENSION_MARK_MULTIPLIER

Category

Dimensioning: General

Use this advanced option to change the multiplication sign when there are
several parts that have the same mark content, for example, HEA400 + 2 x
HEA300. This advanced option has effect only if you have selected Include
part count in tag in the Dimension Properties dialog box. x is the default
value.

This advanced option is model specific and the setting is saved in the options
database.

XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY

Category

Dimensioning: Parts

Use for defining the content of the part mark placed next to the dimension
line label in assembly drawings. Give any combination of the switches.
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The available switches are:

• PROFILE
• MATERIAL
• SIZE
• LENGTH
• COMMENT
• WPDIST (distance between work points)

• GR_L (gross length of the part)

TIP If you want to display the part mark content in the same order as the
switches, set XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION
to TRUE.

This advanced option is role-specific. When you change the value, it changes
from system- to model-specific, and its value is the same for all users in the
current model.

Example
XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY=PROFILE_AND_LENGTH
.

XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY=PROFILE_AND_GR_L

See also

XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE (page 153)

XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION (page 154)

XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE

Category

Dimensioning: Parts

Use to define the content of the part mark that is placed next to the dimension
line label in single-part drawings. Give any combination of the switches.

The available switches are:

• PROFILE
• MATERIAL
• SIZE
• LENGTH
• COMMENT
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• WPDIST (distance between work points)

• GR_L (gross length of the part)

TIP If you want to display the part mark content in the same order as the
switches, set XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION
to TRUE.

This advanced option is model specific and the setting is saved in the options
database.

Example
XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE=PROFILE_AND_MATERIAL
XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE=PROFILE_AND_GR_L

See also

XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY (page 152)

XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION (page 154)

XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION

Category

Dimensioning: Parts

Use for controlling the order of the switches in 
XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY and 
XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE and thus the order of the
part mark content in assembly and single drawings.

When set to TRUE, you can freely select the order of the switches in 
XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY and 
XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE, and the part mark
content follows the order of the switches. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY (page 152)

XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE (page 153)
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XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_CENTER

Category

Dimensioning: General

Use this advanced option to define the symbol Tekla Structures uses in center
plate side marks. The default value is 1. Tekla Structures uses the symbols
defined in dimension_marks.sym file located usually in the folder ..\Tekla
Structures\<version>\environments\common\symbols\.

This advanced option is model specific and the setting is saved in the options
database.

XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_LEFT

Category

Dimensioning: General

Use this advanced option to define the symbol Tekla Structures uses in left
plate side marks. The default value is 0. Tekla Structures uses the symbols
defined in dimension_marks.sym file located usually in the folder ..\Tekla
Structures\<version>\environments\common\symbols\.

This advanced option is model specific and the setting is saved in the options
database.

XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_RIGHT

Category

Dimensioning: General

Use this advanced option to define the symbol Tekla Structures uses in right
plate side marks. The default value is 2. Tekla Structures uses the symbols
defined in dimension_marks.sym file located usually in the folder ..\Tekla
Structures\<version>\environments\common\symbols\.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DIMENSION_SKEWED_BOLTS_IN_PART_PLANE_IN_SINGLE_
DRAWINGS

Category

Dimensioning: Bolts

Set this advanced option to TRUE to dimension bolts perpendicular to the part
plane in single-part drawings. If you do not want to do this, set it to FALSE. The
default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DIR

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option points to the folder for Tekla Structures data, source,
and binary files.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

XS_DISABLE_ADVANCED_OPTIONS

Category

This advanced option must be set in an initialization (.ini) file.

You can disable the Advanced Options dialog box so that the advanced
options can be edited only in the initialization files.

To disable the dialog box, set this advanced option to TRUE. If you do not want
to disable the dialog box, set it to FALSE. The default value is FALSE.

See also

XS_DISABLE_ANALYSIS_AND_DESIGN

Category

Analysis & Design

Advanced options reference 156 Advanced options - D



Set to TRUE to disable the following analysis and design tools from the Tekla
Structures user interface:

• The following command from the Analysis menu and the related icons
from the Loads and Analysis toolbar:

• Analysis & Design Models

• The following tabs from the part properties dialog boxes:

• Analysis

• Loading

• Composite

• Spanning

• Start releases

• End releases

• Design

• The two Analysis tabs from the parts’ user-defined attributes dialog boxes

The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISABLE_CANCEL_DIALOG_FOR_SAVE_NUMBERING_SAVE

Category

Numbering

Use to revert to the old numbering functionality that offers no option to cancel
numbering before the second save is made. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DISABLE_CIS2

Category: Analysis & Design

Use to hide or display the CIMSteel command.

To hide the CIMSteel command in the Export and Import menus in the File
menu, set the XS_DISABLE_CIS2 advanced option to TRUE. The default value
is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISABLE_CLASSIFIER_FOR_MODIFIED_PARTS

Category

Drawing Properties

Use to disable the Detailed object level settings check for modified parts.
When you change part properties in a model after you have defined the
Detailed object level settings, part presentation and mark content are updated
in general arrangement drawings unless you have set this advanced option to 
TRUE.

To disable the check for modified parts, set the advanced option to TRUE.

To enable the check for modified parts, set the advanced option to FALSE. The
default value is FALSE.

NOTE Drawings are not updated if the change does not affect numbering.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISABLE_DRAWING_PLOT_DATE

Category

Drawing Properties

Set this advanced option to TRUE to disable the print date information in
drawings. Disabling the print date helps to avoid possible conflicts when
working with multi-user models in situations where a user modifies drawings
while another user prints the same drawings. Set to FALSE to have the print
date information.
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By default, the advanced option is set to TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DISABLE_PARTIAL_REFRESH

Category

Model View

Set this advanced option to TRUE to disable partial refreshing of OpenGL
windows. This advanced option is for older ATI graphics cards. If you do not
want to disable the partial refresh, set the advanced option to FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISABLE_REBAR_MODELING

Category

Analysis & Design

If you set this advanced option to TRUE, Tekla Structures removes reinforcing
bar modeling module, even if you have a license for this module. This license is
always included, except in the Viewer configuration. The default is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISABLE_TEMPLATE_DOUBLE_CLICK

Category: Drawing Properties

By default, you are allowed to edit drawing templates and table layouts. It is
possible to prevent the template and table layout editing by setting the
advanced option XS_DISABLE_TEMPLATE_DOUBLE_CLICK to TRUE. When you
do this:

• You cannot start editing templates or table layouts by double-clicking a
template in a drawing. Instead, the Drawing properties dialog box will be
displayed.
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• You cannot start editing templates or table layout by right-clicking a
template in a drawing and selecting the corresponding commands.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISABLE_VIEW_CENTERING_ASSEMBLY

Category

Drawing View

Use to left-align and/or top-align assembly drawing views. You can use values 
HOR (left-align), VER (top-align), TRUE (left-align and top-align), or FALSE (no
alignment). Leaving out the value gives the same result as FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DISABLE_VIEW_CENTERING_GA

Category

Drawing View

Use to left-align or top-align GA drawing views. You can use values HOR (left-
align), VER (top-align), or both. For creating centered views, leave this
advanced option empty

This advanced option is model specific and the setting is saved in the options
database.

XS_DISABLE_VIEW_CENTERING_MULTI

Category

Drawing View

Use to left-align or top-align multidrawing views. You can use values HOR (left-
align), VER (top-align), or both.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DISABLE_VIEW_CENTERING_SINGLE

Category

Drawing View

Use to left-align or top-align single-part drawing views. You can use values HOR
(left-align), VER (top-align), or both.

This advanced option is model specific and the setting is saved in the options
database.

XS_DISPLAY_DIMENSIONS_WHEN_CREATING_OBJECTS

Category

Model View

Use for defining whether dimensions and dimension lines are displayed when
model objects are created.

When set to TRUE (default), Tekla Structures displays the dimensions and
dimension lines.

Dimensions and dimension lines are displayed when you create a new model
object and pick the start point and the intermediate or end points for the
object.

If you set this advanced option to FALSE, the dimensions are not displayed.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_OBJECTS

Category: Model View

Use for defining whether dimensions and dimension lines are displayed when
you select a column or a beam.

When this advanced option is set to TRUE (default), Tekla Structures displays
the dimensions and dimension lines.

Dimensions and dimension lines are displayed when you select a single object,
or when you select multiple objects by picking them. The dimensions are not
displayed if a command is running, or if you select multiple objects with area
selection.

When this advanced option is set to FALSE, the dimensions and dimension
lines are not displayed.

Advanced options reference 161 Advanced options - D



This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

NOTE When direct modification is switched on, the standard object
dimensions and dimension lines are always hidden, regardless of
these settings. Only the direct modification dimensions are then
shown. This makes it easier to know which dimensions can be edited.

See also

XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_REBARS (page 162)

XS_DISPLAY_DIMENSIONS_WHEN_CREATING_OBJECTS (page 161)

XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_REBARS

Category: Model View

Use for defining whether dimensions and dimension lines are displayed when
you select a reinforcing bar, bar group, or rebar set.

When this advanced option is set to TRUE (default), Tekla Structures displays
the leg dimensions, total bar length (Σ), and dimension lines. For bar groups,
including rebar sets, the dimensions of the first bar and the last bar are
displayed. If you select individual bars in rebar sets, the dimensions of all the
selected rebar set bars are displayed. Dimensions are not displayed for curved
or circular bars, or for hooks.

For single reinforcing bars and bar groups, these dimensions are only
displayed when direct modification is switched off. When direct modification is
switched on, these dimensions are always hidden, and the direct modification
dimensions are shown instead. This makes it easier to know which dimensions
can be edited.

Dimensions and dimension lines are displayed when you select a single object,
or when you select multiple objects by picking them. The dimensions are not
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displayed if a command is running, or if you select multiple objects with area
selection.

When this advanced option is set to FALSE, the dimensions and dimension
lines are not displayed.

This advanced option is user specific and the setting is saved in options.bin
under user folder.

TIP To quickly switch between the values TRUE and FALSE, go the Concrete
tab on the ribbon and click Rebar display options --> Rebar dimension
visibility , or use the keyboard shortcut Alt+6.

See also

XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_OBJECTS (page 161)

XS_DISPLAY_FILLET_EDGES

Category: Model View

Use this advanced option to show or hide fillet edges in model views. The
default value is TRUE, which shows the fillet edges. If you do not want to show
the fillet edges, set this advanced option to FALSE.

NOTE This advanced option does not work in DirectX views. In DirectX views,
the fillet edges are never shown.

Fillet edges are lines that define the boundary between flat faces and curved
faces in the model. Examples of model objects containing fillet edges are
profiles with curved fillets, slabs or contour plates with curved chamfers, and
curved polybeams.
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The fillet edges in certain profiles are shown in model views only when you
show parts with high accuracy.

This advanced option is user specific, and the setting is saved in options.bin
under the user folder. Reopen the model to activate the new value.

See also

XS_SOLID_USE_HIGHER_ACCURACY (page 417)

XS_DISPLAY_ZERO_INCHES

Category: Imperial units

Set this advanced option to TRUE to display zero inches. The default value is 
FALSE.

Using this advanced option affects the results you get with the inquire tool,
and the dimensions in the model and drawings.

Example:

TRUE: 2'-0"

FALSE: 2'

This advanced option is model specific and the setting is saved in the options
database.
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XS_DISTANT_OBJECT_FINDER_TOLERANCE

Category

Model View

Use to set the minimum distance from the nearest part for the reporting of
distant objects. The object must be located outside this distance for it to be
listed by the Find Distant Objects tool.

The distance is measured from the nearest part. Enter the value in meters. The
default value is 100.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE

Category: Model View

Set this advanced option to TRUE to only clip point clouds and reference
models with the Clip plane command. Native Tekla Structures objects are not
clipped. FALSE is the default value.

Redraw the model views after changing the value.

This advanced option is user specific and the setting is saved in options.bin
under the user folder.

XS_DO_NOT_CREATE_ASSEMBLY_DRAWINGS_FOR_CONCRETE_
PARTS

Category

Drawing Properties

Use to control the creation of single-part and assembly drawings from
concrete parts.

To enable the creation of drawings, set the advanced option to FALSE.

To disable the creation of drawings, set the advanced option to TRUE (default).

This advanced option is model specific and the setting is saved in the options
database.
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XS_DO_NOT_CREATE_ASSEMBLY_DRAWINGS_FOR_LOOSE_
PARTS

Category

Drawing Properties

Use this advanced option for defining whether assembly drawings are created
for assemblies that contain only one part.

When you set this advanced option to TRUE, Tekla Structures does not create
assembly drawings for single-part assemblies. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DO_NOT_CREATE_BOLT_MARKS_IN_ALL_INCLUDED_
SINGLE_VIEWS

Category

Single Part View in Assembly Drawing

Use to prevent the creating of bolt marks in included single views.

Enter TRUE to exclude the bolt marks, FALSE to create the bolt marks. The
default is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DO_NOT_CREATE_PART_MARKS_IN_ALL_INCLUDED_
SINGLE_VIEWS

Category

Single Part View in Assembly Drawing

Use to prevent the creating of part marks in included single part views.

Enter TRUE to exclude the part marks and FALSE to create the part marks. The
default is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_DO_NOT_CREATE_PROFILE_DIMENSIONS_FOR_CONCRETE

Contents

Drawing Properties

Set this advanced option to TRUE to prevent Tekla Structures from
automatically displaying the profile dimensions of concrete parts in cast unit
drawings. If you want to display the profile dimensions, set it to FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DO_NOT_DISPLAY_CHAMFERS

Category: Model View

Set this advanced option to TRUE to draw polygon plates without chamfer
lines. If you want to display the chamfer lines, set this advanced option to 
FALSE. The default value is FALSE.

This advanced option works with XS_DRAW_CHAMFERS_HANDLES (page 183)
set to CHAMFERS or to CHAMFERS_AND_HANDLES.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DO_NOT_DRAW_COLUMN_MARKS_AT_45_DEGREES_IN_
GA_DRAWING

Category

Marking: Parts

Tekla Structures places column mark texts in general arrangement drawing
plan views by default at an angle of 45 degrees in respect to the position of the
column. To place the marks horizontally, set this advanced option to TRUE. If
you set this advanced option to FALSE, the mark texts are placed at the angle
of 45 degrees. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

Example

In the following example, the advanced option is set to TRUE.
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In the following example, the advanced option is set to FALSE.

XS_DO_NOT_EXTEND_DIMENSION_LINES_THROUGH_ALL_
HOLES

Category

Dimensioning: Bolts

Set this advanced option to TRUE (default) to prevent dimension lines from
extending through all holes in a bolt group. If you wish to extend the
dimension lines, set this advanced option to FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DO_NOT_PLOT_DIMENSION_POINT_CIRCLES

Category: Dimensioning: General

Set to TRUE to prevent Tekla Structures from printing red dimension point
invalidity symbols when you print from Document manager. Dimension point
invalidity symbols are always printed if you have a drawing open. The default
value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE

Category

This advanced option must be set in an initialization (.ini) file.

With standard settings Tekla Structures overwrites the step profile settings
and replaces them with the default values every time when Tekla Structures is
started. To prevent Tekla Structures from losing the step profile settings, set
the advanced option XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE to TRUE in
the teklastructures.ini file.

If you are using catalog step profiles and have set 
XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE to TRUE and you update Tekla
Structures, do the following:

1. Set XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE to FALSE in
teklastructures.ini file.

2. Update Tekla Structures.

3. Start Tekla Structures.

4. Set XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE to TRUE in
teklastructures.ini file.

5. Run Steps.exe.

6. Restart Tekla Structures.

See also

Ship Ladder (page 1933)
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XS_DO_NOT_REMOVE_END_ABSOLUTE_DIMENSIONS

Category

Dimensioning: Parts

When you use absolute dimensions, Tekla Structures removes the last
absolute vertical dimension. To prevent this, set this advanced option to TRUE
(default). If you do not want to do this, set this advanced option to FALSE.

Note that XS_DO_NOT_REMOVE_END_ABSOLUTE_DIMENSIONS only works
when the dimensioning type isIntegrated dimensions.

This advanced option is model specific and the setting is saved in the options
database.

Setting Example of appearance in drawings
TRUE

FALSE
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XS_DO_NOT_USE_FOLDED_GUSSET_PLATE
This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to use part-adds to create bent plates in
gusset connections. If you set it to FALSE, Tekla Structures creates bent gusset
plates using the Polybeam command instead of the Part-add command.

XS_DO_NOT_USE_GLOBAL_PLATE_SIDE

Category

Components

By default, connections 141, 146, 147, 149, 181, 184, 185, 186 and 187 create
all shear tabs on the same side of the main part if the main part has several
connections (global positioning). Set this advanced option to TRUE to position
each shear tab according to which end of the main part the connection that
creates it is closest to (local positioning). The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DONT_SHOW_POLYBEAM_MID_EDGES

Category

Drawing Properties

Set this advanced option to TRUE to hide polybeam fold and bend lines in
drawings. If set it to FALSE (default), the fold and bend lines are shown.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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Example

Advanced
option is set to

Example Description

TRUE Polybeam fold and
bend lines are not
shown in the handrail.

FALSE Polybeam fold and
bend lines are shown
in the handrail.
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XS_DRAW_ALL_SECTION_EDGES_IN_DRAWINGS

Category

Drawing Properties

Set this advanced option to TRUE to draw the edges of a cut part in the
drawing and to FALSE to leave the edges open. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SECTION_LINE_COLOR (page 380)

XS_DRAW_ANGLE_AND_RADIUS_INFO_IN_UNFOLDING

Category

Dimensioning: Unfolding

Set this advanced option to TRUE to show the angle and radius information on
the dimension line. The default for this advanced option is that the
information is shown. To hide this information, set it to FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BENDING_END_LINE_DIMENSIONS_IN_
UNFOLDING

Category: Dimensioning: Unfolding

Set this advanced option to TRUE to create bending end line dimensions when
creating unfolded single-part drawings. The default value is FALSE.
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Note that two different dimensions are created if the advanced option 
XS_DRAW_BENDING_LINE_DIMENSIONS_IN_UNFOLDING is set to TRUE as well.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BENDING_END_LINES_IN_UNFOLDING (page 174)

XS_DRAW_BENDING_END_LINES_IN_UNFOLDING

Category: Dimensioning: Unfolding

Set this advanced option to TRUE to draw bending end lines when creating
unfolded single part drawing of a bent plate or a polybeam. For polybeams,
the lines will be drawn only if the polybeam has circular shape chamfers. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BENDING_END_LINE_DIMENSIONS_IN_UNFOLDING (page 173)

XS_DRAW_BENDING_LINE_DIMENSIONS_IN_UNFOLDING

Category

Dimensioning: Unfolding

Set this advanced option to TRUE to create bending line dimensions in a
drawing.

If you do not want to create these dimensions, set this advanced option to 
FALSE. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BOLT_HIDDEN_LINES

Category: Drawing properties
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Use the following advanced options to show or hide bolts that are hidden from
view by other parts, in single part, assembly, and general arrangement
drawings. The default values are shown here:

• XS_DRAW_BOLT_HIDDEN_LINES_IN_SINGLE_DRAWINGS=AS_PART
• XS_DRAW_BOLT_HIDDEN_LINES_IN_ASSEMBLY_DRAWINGS=AS_PART
• XS_DRAW_BOLT_HIDDEN_LINES_IN_GA_DRAWINGS=FALSE
Possible values are:

• AS_PART: uses part’s hidden line visibility settings.

• TRUE: always shows hidden bolts.

• FALSE: does not show hidden bolts.

NOTE Tekla Structures sets the way the bolt hidden lines are shown when
the bolt is added to a drawing, usually when you create the drawing or
a drawing view. The hidden lines setting of the bolts cannot be
changed afterwards.

One way to change the setting in an old drawing is to create a new
drawing view using the desired bolt hidden lines settings.

Example

The following examples show how these advanced options can be used
together with drawing property settings.

To Do this
Set the hidden
lines to be always
invisible in
assembly drawings

1. In the Assembly Drawing Properties dialog
box, click Bolts.

2. On the Content tab, select solid from the
Solid/Symbol list.

3. Click OK.

4. Go to File menu --> Settings --> Advanced
options --> Drawing Properties , and set 
XS_DRAW_BOLT_HIDDEN_LINES_IN_ASSEMBL
Y_DRAWINGS to FALSE.

5. Create the drawing.
Set the hidden
lines to be visible
as the assembly
drawing part
properties allow

1. In the Assembly Drawing Properties dialog
box, click Bolts.

2. On the Content tab, select solid from the
Solid/Symbol list.

3. Click OK.

4. Click Part in the drawing properties dialog box.
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To Do this
5. On the Content tab, remove the check mark

from the Hidden line on/off check box.

6. Go to File menu --> Settings --> Advanced
options --> Drawing Properties , and set 
XS_DRAW_BOLT_HIDDEN_LINES_IN_ASSEMBL
Y_DRAWINGS to AS_PART.

7. Create the drawing.

See also

XS_DRAW_BOLT_OWN_HIDDEN_LINES (page 178)

XS_DRAW_BOLT_HIDDEN_LINES_IN_ASSEMBLY_DRAWINGS

Category

Drawing Properties

Use this advanced option to show or hide bolts that are hidden from view by
other parts in assembly drawings.

The possible values are:

• AS_PART: uses part’s hidden line visibility settings.

• TRUE: always shows hidden bolts.

• FALSE: does not show hidden bolts.

The default value is AS_PART.

NOTE This setting only affects bolts with solid or exact solid representation.
Bolts with symbol representation are always visible. Changing the
advanced option does not affect existing drawings, but you need to
recreate them.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAW_BOLT_HIDDEN_LINES (page 174).
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XS_DRAW_BOLT_HIDDEN_LINES_IN_GA_DRAWINGS

Category

Drawing Properties

Use this advanced option to show or hide bolts that are hidden from view by
other parts in general arrangement drawings.

The possible values are:

• AS_PART: uses part’s hidden line visibility settings.

• TRUE: always shows hidden bolts.

• FALSE: does not show hidden bolts.

The default value is FALSE.

NOTE This setting only affects bolts with solid or exact solid representation.
Bolts with symbol representation are always visible. Changing the
advanced option does not affect existing drawings, but you need to
recreate them.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAW_BOLT_HIDDEN_LINES (page 174).

XS_DRAW_BOLT_HIDDEN_LINES_IN_SINGLE_DRAWINGS

Category

Drawing Properties

Use this advanced option to show or hide bolts that are hidden from view by
other parts in single part drawings.

The possible values are:

• AS_PART: uses part’s hidden line visibility settings.

• TRUE: always shows hidden bolts.

• FALSE: does not show hidden bolts.

The default value is AS_PART.

NOTE This setting only affects bolts with solid or exact solid representation.
Bolts with symbol representation are always visible. Changing the
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advanced option does not affect existing drawings, but you need to
recreate them.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BOLT_HIDDEN_LINES (page 174).

XS_DRAW_BOLT_OWN_HIDDEN_LINES

Category

Drawing properties

Use the following advanced options show or hide own hidden lines in bolts in
single part, assembly, and general arrangement drawings. The own hidden lines
are the lines of the object representation covered up by the object itself.

The default values are shown here:

• XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_SINGLE_DRAWINGS=AS_PART
• XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_ASSEMBLY_DRAWINGS=AS_PART
• XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_GA_DRAWINGS=FALSE
Possible values are:

• AS_PART: used the visibility settings of the part’s own hidden lines.

• TRUE: always shows bolts’ hidden lines.

• FALSE: does not show bolts’ hidden lines.

See also

XS_DRAW_BOLT_HIDDEN_LINES (page 174)

XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_ASSEMBLY_
DRAWINGS

Category

Drawing Properties

To show or hide the hidden lines of the bolts based on the own hidden line
settings of the part that hides the bolts, enter AS_PART. To always show
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hidden lines of the hidden bolts, enter TRUE. To never show the hidden lines,
enter FALSE. The default value is AS_PART.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAW_BOLT_OWN_HIDDEN_LINES (page 178)

XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_GA_DRAWINGS

Category

Drawing Properties

To show or hide the hidden lines of the bolts based on the own hidden line
settings of the part that hides the bolts, enter AS_PART. To always show
hidden lines of the hidden bolts, enter TRUE. To never show hidden lines of
the hidden bolts, enter FALSE. The default value is FALSE.

NOTE This setting only affects bolts with solid or exact solid representation.
Bolts with symbol representation are always visible. Changing the
advanced option does not affect existing drawings, but you need to
recreate them.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAW_BOLT_OWN_HIDDEN_LINES (page 178)

XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_SINGLE_DRAWINGS

Category

Drawing Properties

To show or hide the hidden lines of the bolts based on the own hidden line
settings of the part that hides the bolts, enter AS_PART. To always show
hidden lines of the hidden bolts, enter TRUE. To never show hidden lines of
the hidden bolts, enter FALSE. The default value is AS_PART.
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NOTE This setting only affects bolts with solid or exact solid representation.
Bolts with symbol representation are always visible. Changing the
advanced option does not affect existing drawings, but you need to
recreate them.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BOLT_OWN_HIDDEN_LINES (page 178)

XS_DRAW_BOLTS_PERPENDICULAR_TO_PART_IN_SINGLE_
DRAWINGS

Category

Dimensioning: Bolts

Set this advanced option to TRUE to draw bolts perpendicular to the part plane
in single part drawings. If you do not want to do this, set it to FALSE. This only
applies to bolt symbol types symbol and symbol3.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAW_BOLTS_THROUGH_NEIGHBOUR_PARTS

Category

Drawing Properties

Set this advanced option to TRUE to draw the bolt parts that coincide with
neighboring parts. If you do not want to draw these bolt parts, set it to FALSE.
The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

The following example shows how the drawing looks like when you set this
advanced option to FALSE.
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In the following example, the advanced option is set to TRUE.
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XS_DRAW_CAST_PHASE_INTERNAL_LINES

Category: Concrete detailing

Use to show or hide edge lines of (precast) concrete cast units in drawings. Set
to TRUE (default) to show overlapping edge lines between adjacent cast units
that are in the same phase.

NOTE If you are working with cast-in-place concrete parts and 
XS_ENABLE_POUR_MANAGEMENT is set to TRUE, the advanced options 
XS_DRAW_CAST_UNIT_INTERNAL_LINES and 
XS_DRAW_CAST_PHASE_INTERNAL_LINES do not have an effect.

If XS_ENABLE_POUR_MANAGEMENT is set to FALSE, both cast-in-place
and precast concrete parts are treated in the same way and are
affected by the advanced options 

Advanced options reference 182 Advanced options - D



XS_DRAW_CAST_UNIT_INTERNAL_LINES and 
XS_DRAW_CAST_PHASE_INTERNAL_LINES.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAW_CAST_UNIT_INTERNAL_LINES (page 183)

XS_DRAW_CAST_UNIT_INTERNAL_LINES

Category: Concrete Detailing

Use to show or hide concrete part lines inside (precast) cast units in drawings.
Set to TRUE to show overlapping part lines inside cast units.

The default value is FALSE.

NOTE If you are working with cast-in-place concrete parts and 
XS_ENABLE_POUR_MANAGEMENT is set to TRUE, the advanced options 
XS_DRAW_CAST_UNIT_INTERNAL_LINES and 
XS_DRAW_CAST_PHASE_INTERNAL_LINES do not have an effect.

If XS_ENABLE_POUR_MANAGEMENT is set to FALSE, both cast-in-place
and precast concrete parts are treated in the same way and are
affected by the advanced options 
XS_DRAW_CAST_UNIT_INTERNAL_LINES and 
XS_DRAW_CAST_PHASE_INTERNAL_LINES.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_CAST_PHASE_INTERNAL_LINES (page 182)

XS_DRAW_CHAMFERS_HANDLES

Category: Model view

Use to define whether to show the handles or the chamfers for contour plates,
concrete slabs, and polybeams. The options are:
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• HANDLES: handles are shown. Makes the selection of handles easier. This is
the default value.

• CHAMFERS: chamfers are shown. Use this option, for example, when you
want to check the status of polybeam chamfers.

• CHAMFERS_AND_HANDLES shows both the chamfers and handles.

See also

XS_DO_NOT_DISPLAY_CHAMFERS (page 167)

XS_DRAW_CROSS_AXIS

Category

Drawing properties

Set to N to have Tekla Structures hide the axis cross in beam cross sections.

Leave the value out to display the axis cross in beam cross sections.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DRAW_CUT_FACES_WITH_OBJECT_COLOR

Category: Model View

Set to FALSE (default) to have cut faces shown in gray, and to TRUE to show
the cut faces with the same color as the other object faces.

Redraw the model view after changing the value for the change to take effect.

This advanced option is user-specific and the setting is saved in options.bin
under user folder.

XS_DRAW_HIDDEN_FACES

Category: Drawing Properties

Set this advanced option to TRUE to draw hidden part faces in drawings. The
default value is FALSE. This advanced option hides the hatches on the hidden
part faces, for example.

This advanced option is model specific and the setting is saved in the options
database.

Example of using the value TRUE:

Example of using the value FALSE:
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TIP To hide hidden faces of rebars, use the advanced option XS_DRAW_
REBAR_HIDDEN_FACES (page 187).

XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_
PARTS

Category

Drawing Properties

Set to TRUE to show horizontal view shortening symbols automatically. The
default value is FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Limitations

• Shortening symbols are not shown in general arrangement drawings.

• Shortening symbols are not shown in rectangular hollow sections or
channel sections.

See also

XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS (page 192)

XS_SHORTENING_SYMBOL_WITH_ZIGZAG (page 396)

XS_SHORTENING_SYMBOL_COLOR (page 395)

XS_SHORTENING_SYMBOL_LINE_TYPE (page 395)
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XS_DRAW_INSIDE_ANGLE_IN_UNFOLDING

Category

Dimensioning: Unfolding

Set this advanced option to TRUE to display the interior angle instead of the
exterior angle in angle text. If set this advanced option to FALSE (default), the
exterior angle is displayed.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_LONG_HOLE_DIMENSIONS

Category

Dimensioning: Bolts

Set this advanced option to TRUE to dimension slotted holes to the center
points of the curve. If you set this advanced option to FALSE (default), the
slotted holes are dimensioned to the center points of the holes.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAW_MESH_OUTLINE_SYMBOL
_FROM_BOTTOM_LEFT_TO_TOP_RIGHT

Category

Concrete Detailing

Use to define the outline representation of reinforcement meshes in drawings.
When you set this advanced option to TRUE (default), the outline
representation symbol of the mesh is always from bottom left to top right.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DRAW_REBAR_HIDDEN_FACES

Category: Drawing Properties

Use this advanced option to control the display of the rebar hidden faces in
drawings. To show the hidden faces of the rebars, set this advanced option to 
TRUE. FALSE is the default value.

This advanced option is model specific and the setting is saved in the options
database.

In the first image below, XS_DRAW_REBAR_HIDDEN_FACES has been set to 
TRUE.

In the image below, XS_DRAW_REBAR_HIDDEN_FACES has been set to FALSE.
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This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_HIDDEN_FACES (page 185)

XS_DRAW_REBAR_SELF_INTERSECTING_LEGS_WITH_OFFSET

Category: Drawing Properties

When set to TRUE, this advanced option displays rebars in drawings with
overlap in all representations. Note that FALSE has no impact on the filled
line representation. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAW_REBAR_SELF_INTERSECTING_LEGS_WITH_OFFSET set to TRUE:
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XS_DRAW_REBAR_SELF_INTERSECTING_LEGS_WITH_OFFSET set to FALSE:

See also

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 714)
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XS_DRAW_ROOT_OPENING_EVEN_WHEN_ZERO

Category

Welds

Set this advanced option to TRUE to show zero root openings. The default is 
TRUE. If you set this advanced option to FALSE, the zero root openings are not
shown.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS

Category

Marking: Parts

Use this advanced option to define if a leader line is drawn when the leader
line is shorter than defined with the advanced option 
XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH. When
you set this option to FALSE, the leader line is not drawn. Set to TRUE (default)
to always draw leader lines in part marks.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH
(page 191)

XS_DRAW_SHORT_LEADER_LINES
_OF_PART_MARKS_MINIMUM_LENGTH

Category

Marking: Parts

Use this advanced option to define the minimum length of a leader line that
Tekla Structures draws. If the leader line is shorter that the minimum length
and the advanced option XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS
is set to FALSE, the leader line is not drawn. The default value is 0.0. If the
advanced option 
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XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH is set
to TRUE, the part mark leader lines are always drawn.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS (page 191)

XS_DRAW_SKEWED_ELEVATIONS

Category

Dimensioning: Parts

Set this advanced option to TRUE to display skewed elevation dimensions.

If you set it to FALSE (default), skewed elevation dimensions are not displayed
in drawings.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_
PARTS

Category

Drawing Properties

Set this advanced option to TRUE to show vertical view shortening symbols
automatically. The default value is FALSE.
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This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Limitations

• Shortening symbols are not shown in general arrangement drawings.

• Shortening symbols are not shown in rectangular hollow sections or
channel sections.

See also

XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS (page 186)

XS_SHORTENING_SYMBOL_WITH_ZIGZAG (page 396)

XS_SHORTENING_SYMBOL_COLOR (page 395)

XS_SHORTENING_SYMBOL_LINE_TYPE (page 395)

XS_DRAWING_ALLOW_NEW_SECTIONS_IN_REDIMENSIONING

Category

Drawing Properties

Use to define whether new views or sections are created during
redimensioning of existing drawings. The default is FALSE, which means that
no views or sections are created.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
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in use, you can change the value, which is then the same for all users in the
current model.

XS_DRAWING_ALLOW_SNAPPING_TO_DISTANT_POINTS

Category

Drawing Properties

Set this advanced option to TRUE to allow the cursor to snap to object end
points in a drawing even if the cursor is not near the end point. This means
that if the cursor is anywhere on the object, the cursor will snap to the object
end points. If you do not want to allow this, set this advanced option to FALSE.
Then the cursor will snap only to the snap points near the cursor.

The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DRAWING_ASSEMBLY_HATCH_SCHEMA

Category

Hatching

Use to indicate the name of the schema file to use for assembly drawings.

Example

To use the default schema file, enter assembly.htc.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_CAST_UNIT_HATCH_SCHEMA

Category

Hatching

Use to determine the name of the schema file used for cast unit drawings.

This advanced option is model specific and the setting is saved in the options
database.
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Example

To use the default schema file, enter cast_unit.htc.

XS_DRAWING_CHANGE_HIGHLIGHT_COLOR

Category

Drawing Properties

Use to change the highlight color of the automatic change symbols. The color
options are RED, DARK RED, ORANGE, DARK YELLOW, GREEN, DARK GREEN,
BLUE, DARK BLUE, BLACK, GREY, DARK GREY, CYAN, DARK CYAN and MAGENTA.
You can also enter colors as numerical values.

NOTE If you use the default color 190, the symbols are displayed on the
screen but they will not appear in the printed drawings.

This advanced option is model specific and the setting is saved in the options
database.

Example

Set the advanced
option to

Color on screen Color in printed
drawings

190(default) not visible

MAGENTA magenta

RED red

GREEN green
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Set the advanced
option to

Color on screen Color in printed
drawings

BLUE blue

BLACK black

GREY grey

XS_DRAWING_CLONING_IGNORE_CHECK

Category: Drawing Properties

Set to TRUE to have Tekla Structures clone a drawing even though all the parts
of the original drawing have been deleted and the position number is the
same as in the original drawing. The default is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

Example

You have drawing A[A.1] in your Document manager. You number the model
so that the assembly A.1 changes to A.2. In Document manager, the A[A.1]
drawing is marked with an x and with the status message "All parts deleted."
Then you number the model again, so that the assembly in the model changes
from A.2 back to A.1. To clone, set the advanced option 
XS_DRAWING_CLONING_IGNORE_CHECK to TRUE, select the A[A.1] drawing
(marked with x) from Document manager and assembly A.1 from the model,
and click Clone.
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XS_DRAWING_COMBINE_ADDED_DIMENSIONS

Category

Drawing Properties

Use to control whether added dimensions are merged to existing ones in
updated or cloned drawings. If set to FALSE, added dimensions are not
merged to existing ones. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_CUT_VIEW_COMPARISON_CRITERIA

Category

Drawing View

Use to specify the criteria used when comparing section views. If section views
are different, they will be visible and will receive a unique section mark. By
default, section views are compared based on the boundaries of the parts
(EXTREMA) and the orientation of the parts in the view (ORIENTATION). The
advanced option may contain a combination of the following options
separated by a comma:

• POSITION compares position numbers of all the parts in the view
(including non-dimensioned parts).

• EXTREMA compares the boundaries of the parts in the view.

• ORIENTATION compares the orientation of the parts in the view.

• SHOWALL considers all section views different and displays them with
unique section marks.

• EXACT uses more rigid rules when comparing section views. Use in
combination with the options EXTREMA or ORIENTATION.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAWING_CUT_VIEW_COMPARISON_CRITERIA (page 197)
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XS_DRAWING_FILTER_UDAS_WITHOUT_TYPE_CHECK

Category

Drawing Properties

Set this advanced option to FALSE (default) to use only user-defined attributes
that have been defined for the object in the object.inp in drawing view
filtering.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_GA_HATCH_SCHEMA

Category

Hatching

Use to determine the name of the schema file used for general arrangement
drawings.

This advanced option is model specific and the setting is saved in the options
database.

Example

To use the default schema file, enter general.htc.

XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH

Category

Drawing Properties

Use to specify a fixed size for the grid label frames. This is useful, for example,
when you want all the grid label frames to be the same size no matter whether
there are one or two digits in the frame. If you set this advanced option to zero
(0), the width of the grid label frame depends on the width of the grid label.
Enter the desired value in millimeters.

A fixed width of 18 is suggested for 5 characters (XX.XX) when the text height is
3/16. Change the fixed width to 14 for 4 characters (XX.X), 12 for 3 characters
(X.X), and to 10 for 2 characters (XX). If you use a different text height than
3/16, fixed width values need to be adjusted accordingly. This advanced option
overrides the automatic frame width calculation for grid labels.

If you do not set this advanced option, Tekla Structures adjusts the grid label
frames to text within each frame.

Example of grid label frames when the frame size is not fixed:
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Example of grid label frames when the frame size is fixed:

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR

Category

Drawing Properties

Use to change the thickness of the grid label frame in drawings. You may want
to emphasize the grid label frames so that they are shown with a thicker line
than the rest of the grid.

Example
XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR=1
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NOTE Each color has a certain line thickness. The thickness of the grid label
frame on the printed black-and-white drawings depends on the color
that has been defined for the grid label in the grid properties and on
the value of this advanced option. .

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_HISTORY_LOG_TYPE

Category

Drawing Properties

Use to define the contents of the drawing history log file
drawing_history.log. You can use the following options individually or in
any combination.

• ALL
• NEW
• DELETED (default)

• MODIFIED

Example

Separate the options using the _ character, for example, NEW_DELETED.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_IGNORE_ZERO_LEVELS_IN_PART_MARKS

Category

Marking: Parts

Use to control whether zero levels (+0.000) are shown or hidden in part marks.
By default the advanced option is set to FALSE, so zero levels are shown in
part marks. Set to TRUE to hide the zero levels in part marks.

For example, you can use this advanced option for hiding connection side
marks at the specified distance from the view plane.
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TIP To list level information in part marks, go to the Part mark properties
dialog box and insert the element User-defined attribute and enter one
of the following template attributes:

• ASSEMBLY_BOTTOM_LEVEL
• ASSEMBLY_TOP_LEVEL
• CAST_UNIT_BOTTOM_LEVEL
• CAST_UNIT_TOP_LEVEL

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_DRAWING_PART_REFERENCE_LINE_TYPE

Category:Drawing Properties

Use to set the reference line type in drawings. You can use the following
switches:

• POINT_LINE creates a line between the part’s creation points.

• DEFINITION_LINE creates a line between the part’s definition points
(creation points + end offsets ).

• CORNER_REFERENCE_LINE creates a line between the part’s corner points.

POINT_LINE DEFINITION_LINE CORNER_
REFERENCE_LINE

This advanced option is model specific and the setting is saved in the options
database.
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XS_DRAWING_PART_SYMBOL_REPRESENTATION_TYPE

Category

Drawing Properties

Use this advanced option for adjusting the symbol representation of parts in
drawings. Value 0 (default) means by reference line, and value 1 means by
center line. This affects the part representation options Symbol and Symbol
with partial profile in the part properties dialog box.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAWING_PLOT_FILE_DIRECTORY

Category Printing

Use this advanced option to define the folder where Printer Catalog creates
the plot files if the file name field is empty in the Print Drawings dialog box.
By default, .\PlotFiles is used.

Note that Printer Catalog is used only when you have set the advanced
option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings -->
Advanced options --> Printing .

This advanced option also defines the folder where new DWG/DXF drawing
export creates dwg/dxf files if the file location field is empty in the Export
drawings to DWG/DXF dialog box. By default, .\ is used.

NOTE This advanced option overrides the folder defined in the Printer
Catalog and in the new Export drawings to DWG/DXF dialog box.

XS_DRAWING_PLOT_FILE_NAME

This advanced option must be set in an initialization (.ini) file.

Use this advanced option to define print filenames for drawings, if the
filename is missing from the Print Drawings dialog box. This advanced option
is used if you have not entered a value for some of the following advanced
options: XS_DRAWING_PLOT_FILE_NAME_A, 
XS_DRAWING_PLOT_FILE_NAME_C, XS_DRAWING_PLOT_FILE_NAME_G, 
XS_DRAWING_PLOT_FILE_NAME_W, or XS_DRAWING_PLOT_FILE_NAME_M.

Enter any combination of text and options:
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NAME
NAME.-
NAME.
DRAWING_NAME
DRAWING_NAME.
DRAWING_NAME.-
REVISION
DRAWING_REVISION
REV_MARK
REVISION_MARK
DRAWING_REVISION_MARK
REV
TITLE
DRAWING_TITLE
UDA:<drawing user-defined attribute>
TPL:<template attribute>
<variable>?- <text>
The question mark (?) can be used for querying if a <variable> is set, and if it
does, the <text> after the question mark until the last % will be printed. See
the second example below.

This advanced option is model specific and the setting is saved in the options
database.

Examples
%DRAWING_NAME.% - %DRAWING_TITLE%%DRAWING_REVISION? - Rev %
%REVISION_MARK%
%NAME% - %TITLE%%UDA:DRAWING_USERFIELD_1? - %
%UDA:DRAWING_USERFIELD_1%%DRAWING_REVISION? - Rev%
%DRAWING_REVISION%
If you define %DRAWING_NAME.% - %DRAWING_TITLE%
%DRAWING_REVISION? - Rev %%REVISION_MARK%, a .pdf file with a name
P1 - PLATE - Rev A.pdf will be created from a single part drawing, for
example, where

DRAWING_NAME. = P1, this is the part position without punctuation.

DRAWING_TITLE = PLATE, this is the name that you have entered in the Name
box in drawing properties.

DRAWING_REVISION = empty, if there are no revisions, or a numeric value 1, 2,
3, etc according to the revision selected in Rev.No. in the Revision Handling
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dialog box. The actual value is not written in the plot file name, but the text
after the question mark (?).

- Rev is the text to be printed, if DRAWING_REVISION gives a value. If 
DRAWING_REVISION does not give a value, the text - Rev will not be printed.
In this case, the plot file name will not have REVISION_MARK either because
the drawing has not been revised.

REVISION_MARK = A, because A has been defined as the revision mark in the
Revision Handling dialog box.

See also

XS_DRAWING_PLOT_FILE_NAME_A

Category

Printing

Use to define print filenames for assembly drawings.

Enter any combination of text and options:

NAME
NAME.-
NAME.
DRAWING_NAME
DRAWING_NAME.
DRAWING_NAME.-
REVISION
DRAWING_REVISION
REV_MARK
REVISION_MARK
DRAWING_REVISION_MARK
REV
TITLE
DRAWING_TITLE
UDA:<drawing user-defined attribute>
TPL:<template attribute>
<variable>?- <text>
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The question mark (?) can be used for querying if a <variable> is set, and if it
does, the <text> after the question mark will be printed. See the second
example below.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example
%DRAWING_NAME.% - %DRAWING_TITLE%%DRAWING_REVISION? - Rev %
%REVISION_MARK%
%NAME% - %TITLE%%UDA:DRAWING_USERFIELD_1? - %
%UDA:DRAWING_USERFIELD_1%%DRAWING_REVISION? - Rev%
%DRAWING_REVISION%

See also

XS_DRAWING_PLOT_FILE_NAME_W

Category

Printing

Use to define print filenames for single part drawings. Enter any combination
of text and options: NAME, NAME.-, NAME., DRAWING_NAME, DRAWING_NAME., 
DRAWING_NAME.-, REVISION, DRAWING_REVISION, REV_MARK, 
REVISION_MARK, DRAWING_REVISION_MARK, REV, TITLE, DRAWING_TITLE, 
UDA:<drawing user-defined attribute>, TPL:<template
attribute>, <variable>?- <text>
The question mark (?) can be used for querying if a <variable> is set, and if it
does, the <text> after the question mark will be printed. See the second
example below.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Examples
%DRAWING_NAME.% - %DRAWING_TITLE%%DRAWING_REVISION? - Rev %
%REVISION_MARK%
%NAME% - %TITLE%%UDA:DRAWING_USERFIELD_1? - %
%UDA:DRAWING_USERFIELD_1%%DRAWING_REVISION? - Rev%
%DRAWING_REVISION%

Advanced options reference 205 Advanced options - D



See also

XS_DRAWING_PLOT_FILE_NAME_G

Category

Printing

Use to define print filenames for general arrangement drawings.

Enter any combination of text and options:

NAME
NAME.-
NAME.
DRAWING_NAME
DRAWING_NAME.
DRAWING_NAME.-
REVISION
DRAWING_REVISION
REV_MARK
REVISION_MARK
DRAWING_REVISION_MARK
REV
TITLE
DRAWING_TITLE
UDA:<drawing user-defined attribute>
TPL:<template attribute>
<variable>?- <text>
The question mark (?) can be used for querying if a <variable> is set, and if it
does, the <text> after the question mark will be printed. See the second
example below.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.
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Example
%DRAWING_NAME.% - %DRAWING_TITLE%%DRAWING_REVISION? - Rev %
%REVISION_MARK%
%NAME% - %TITLE%%UDA:DRAWING_USERFIELD_1? - %
%UDA:DRAWING_USERFIELD_1%%DRAWING_REVISION? - Rev%
%DRAWING_REVISION%

See also

XS_DRAWING_PLOT_FILE_NAME_M

Category

Printing

Use to define print filenames for multidrawings.

Enter any combination of text and options:

NAME
NAME.-
NAME.
DRAWING_NAME
DRAWING_NAME.
DRAWING_NAME.-
REVISION
DRAWING_REVISION
REV_MARK
REVISION_MARK
DRAWING_REVISION_MARK
REV
TITLE
DRAWING_TITLE
UDA:<drawing user-defined attribute>
TPL:<template attribute>
<variable>?- <text>
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The question mark (?) can be used for querying if a <variable> is set, and if it
does, the <text> after the question mark will be printed. See the second
example below.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example
%DRAWING_NAME.% - %DRAWING_TITLE%%DRAWING_REVISION? - Rev %
%REVISION_MARK%
%NAME% - %TITLE%%UDA:DRAWING_USERFIELD_1? - %
%UDA:DRAWING_USERFIELD_1%%DRAWING_REVISION? - Rev%
%DRAWING_REVISION%

See also

XS_DRAWING_PLOT_FILE_NAME_C

Category

Printing

Use to define print filenames for cast unit drawings.

Enter any combination of text and options:

NAME
NAME.-
NAME.
DRAWING_NAME
DRAWING_NAME.
DRAWING_NAME.-
REVISION
DRAWING_REVISION
REV_MARK
REVISION_MARK
DRAWING_REVISION_MARK
REV
TITLE
DRAWING_TITLE
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UDA:<drawing user-defined attribute>
TPL:<template attribute>
<variable>?- <text>
The question mark (?) can be used for querying if a <variable> is set, and if it
does, the <text> after the question mark will be printed. See the second
example below.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example
%DRAWING_NAME.% - %DRAWING_TITLE%%DRAWING_REVISION? - Rev %
%REVISION_MARK%
%NAME% - %TITLE%%UDA:DRAWING_USERFIELD_1? - %
%UDA:DRAWING_USERFIELD_1%%DRAWING_REVISION? - Rev%
%DRAWING_REVISION%

See also

XS_DRAWING_POINT_SCALE

Category

Drawing Properties

Use to scale the points Tekla Structures uses to create reference lines. Enter
the scale as a decimal. The default value is 0.5.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_SCALE_SEPARATOR_CHAR

Category

Drawing Properties

Defines the separator character used in drawing scales. The default character
is colon (:).

This advanced option is model specific and the setting is saved in the options
database.
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XS_DRAWING_SHEET_HEIGHT

Category

Drawing View

Use to define the default height of a drawing sheet. The default value is 800.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DRAWING_SHEET_POSITION_X (page 210)

XS_DRAWING_SHEET_POSITION_X

Category

Drawing View

Use to define the initial position of the drawing sheet. This is useful when
using a dual display. The default value is 0.

You can set this in the following ways:

XS_DRAWING_SHEET_POSITION_X=50XS_DRAWING_SHEET_POSITION_Y=50XS_DRAWING_SHE
ET_HEIGHT=600XS_DRAWING_SHEET_WIDTH=900

X and Y are the coordinates of the upper left corner of the drawing view,
measured from the upper left corner of the MDI client window (the dark gray
area in the Tekla Structures window).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DRAWING_SHEET_POSITION_Y (page 210)

XS_DRAWING_SHEET_HEIGHT (page 210)

XS_DRAWING_SHEET_WIDTH (page 211)

XS_DRAWING_SHEET_POSITION_Y

Category

Drawing View

Use to define the initial position of the drawing sheet. This is useful when
using a dual display. The default value is 0.
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You can set this in the following ways:

XS_DRAWING_SHEET_POSITION_X=50 XS_DRAWING_SHEET_POSITION_Y=50 
XS_DRAWING_SHEET_HEIGHT=600 XS_DRAWING_SHEET_WIDTH=900
X and Y are the coordinates of the upper left corner of the drawing view,
measured from the upper left corner of the MDI client window (the dark gray
area in the Tekla Structures window).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DRAWING_SHEET_POSITION_X (page 210)

XS_DRAWING_SHEET_HEIGHT (page 210)

XS_DRAWING_SHEET_WIDTH (page 211)

XS_DRAWING_SHEET_WIDTH

Category

Drawing view

Use to define the default width of a drawing sheet. The default value is 1000.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DRAWING_SHEET_POSITION_X (page 210)

XS_DRAWING_SHEET_POSITION_Y (page 210)

XS_DRAWING_SHEET_HEIGHT (page 210)

XS_DRAWING_SINGLE_PART_HATCH_SCHEMA

Category

Hatching

Use to determine the name of the schema file used for single part drawings.

This advanced option is model specific and the setting is saved in the options
database.

Example

To use the default schema file, enter single.htc.
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XS_DRAWING_SNAPSHOT_CREATION

Category

Drawing Properties

If you set the this advanced option to FALSE, the snapshots are not created
automatically when you save a drawing. The default value is TRUE, which
means that snapshots are created automatically when you save a drawing.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_SOLID_MERGE_TOLERANCE

Category

Drawing View

Use to define the limit that determines whether some objects in a cast unit are
merged in the drawing view. Enter the value in millimeters. The default value is 
6.0.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

The following example shows the result of merging parts.
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In the following example, unnecessary segments of curved parts that are one
above another are removed.
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XS_DRAWING_STUD_REPRESENTATION

Category

Drawing Properties

Use this advanced option to define different representation options for bolts
and studs.

Set the advanced option to SOLID (default) to have the studs drawn as solid
objects regardless of the bolt representation setting, and to AS_BOLT to have
the studs drawn according to the settings in the Bolt properties dialog box.

This advanced option is role-specific. When you change the value, it changes
from system- to model-specific, and its value is the same for all users in the
current model.
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XS_DRAWING_TEMPLATES_LIBRARY

Category: Drawing Properties

You define the location of the drawing template library by setting this
advanced option to point to the model folder that contains the template
drawings

This advanced option is model specific and the setting is saved in the options
database. .

Example
C:\TeklaStructuresModels\CloningTemplate
(where CloningTemplate is the model name).

To use the a cloning template library and the cloning template:

1. Open the user.ini file located in the folder ..\Tekla Structures
\<version>\nt\bin in a text editor.

2. Set the advanced option XS_DRAWING_TEMPLATES_LIBRARY to point to
the model folder that contains the cloning templates (template library):

set XS_DRAWING_TEMPLATES_LIBRARY=%XS_RUNPATH%
\DrawingLibrary
For example:

set XS_DRAWING_TEMPLATES_LIBRARY=C:\TeklaStructuresModels
\CloningTemplate
(where CloningTemplate is the model name).

3. To open the Clone Drawing dialog box, click Clone in Document
manager.

4. Use the Objects and actions in cloning options to define the drawing
objects to be cloned and the actions for each cloned object.

5. Select the Clone from > Other model option. You can see that the
CloningTemplate folder is displayed in the box.

6. Click the Select template... button.

7. In the Drawing Templates dialog box, select the cloning template.

8. Leave the list open and clone the drawing by clicking Clone selected.

Advanced options reference 215 Advanced options - D



XS_DRAWING_UDAS_MODIFY_ALL_DRAWING_TYPES

Category: Drawing Properties

Use to modify the user-defined attributes of all selected drawings in
Document manager at the same time, even if the drawings are of different
types.

• To allow the modification of user-defined attributes for all drawings types
at the same time, set the advanced option to TRUE. TRUE is the default
value.

• To allow the modification of user-defined attributes only for one drawing
type at a time, set the advanced option to FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DRAWING_UPDATE_VIEW_PLACING

Category

Drawing Properties

Use to control how the view placing works. If the views do not fit on the screen
after scaling, Tekla Structures increases the sheet size using the layout
properties if autosizing is enabled ( Layout --> Drawing size --> Size
definition mode --> Autosize ). Use this advanced option together with XS_
INTELLIGENT_DRAWING_ALLOWED (page 275).

This advanced option is model specific and the setting is saved in the options
database.

Value Description
TRUE Updates the view placing. Does not affect the scale or

the sheet size.
TRUE, SCALE Updates the view placing and scales the view if the view

does not fit on the sheet. Tekla Structures scales the
views smaller using the scales in layout properties.

TRUE, SHEET Updates the view and increases the sheet size if the view
does not fit on the sheet.

TRUE, SHEET,
SCALE

Updates the view, scales the view and increases the
sheet size, if necessary.

TRUE,
CLONING_ONLY

Updates the view placing. Does not affect the scale or
the sheet size. View placing is updated only during
cloning, not during update. CLONING_ONLY is the default
value.
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Value Description
TRUE, SCALE,
CLONING_ONLY

Updates the view placing and scales the view if the view
does not fit on the sheet. Tekla Structures scales the
views smaller using the scales in layout properties. View
placing is updated only during cloning, not during
update.

TRUE, SHEET,
CLONING_ONLY

Updates the view placing and increases the sheet size if
the view does not fit on the sheet. View placing is
updated only during cloning, not during update.

TRUE, SHEET,
SCALE,
CLONING_ONLY

Updates the view placing, scales the view and increases
the sheet size, if necessary. View placing is updated only
during cloning, not during update.

FALSE Does not update the view placing or change the view
scale or sheet size.

XS_DRAWING_USE_WORKSHOP_FORM
_FOR_DOUBLE_PARTS_IN_SINGLE_PART_DRAWINGS

Category

Drawing Properties

Set this advanced option to TRUE to show haunch profiles always in workshop
form as double parts in single part drawings. TRUE is the default value. To
show the haunch profiles using the part representation selected in the part
properties dialog box, set this advanced option to FALSE. This setting affects
only part representation, not dimensioning or other part properties.

By default, a haunch (translations checked in drawing.ail) has different
length calculations and uses different part presentation in drawings than a
beam. The calculation routine checks the part name, and when the name
"HAUNCH" or translations of it is found, the haunch calculation is used.

You can add additional names for haunch profiles in drawing.ail file under
the \messages folder. Use the strings like drawing_haunch_2 or
drawing_haunch_3.

Below is an example of the workshop form representation.

Advanced options reference 217 Advanced options - D



Below is an example of the outline representation.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT

Category

Drawing properties

Use the following advanced options to define the arrow symbol used in
section and end view direction marks, for each basic view type (front, top,
back, bottom):

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT
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• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM

By default Tekla Structures uses the symbol no 66 in the xsteel.sym file
(located usually in the folder \environments\common\symbols\).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

Section view properties (page 650)

XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP

Category: Drawing properties

Use the following advanced options to define the arrow symbol used in
section and end view direction marks, for each basic view type (front, top,
back, bottom):

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM

By default Tekla Structures uses the symbol no 66 in the xsteel.sym file
(located usually in the folder \environments\common\symbols\).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

Section view properties (page 650)

XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK

Category: Drawing properties

Use the following advanced options to define the arrow symbol used in
section and end view direction marks, for each basic view type (front, top,
back, bottom):
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• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM

By default Tekla Structures uses the symbol no 66 in the xsteel.sym file
(located usually in the folder \environments\common\symbols\).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

Section view properties (page 650)

XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM

Category: Drawing properties

Use the following advanced options to define the arrow symbol used in
section and end view direction marks, for each basic view type (front, top,
back, bottom):

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK
• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM

By default Tekla Structures uses the symbol no 66 in the xsteel.sym file
(located usually in the folder \environments\common\symbols\).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

Section view properties (page 650)

XS_DRAWING_VIEW_REFERENCE_SYMBOL

Category

Drawing Properties
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Use to define the symbol that is displayed in drawing views, when you have
selected the option Custom in the Symbol list in the Detail or Section
Symbol Properties dialog box, or in the view properties dialog boxes of other
drawing views. For example, if you enter xsteel@3, Tekla Structures uses the
symbol number 3 in symbol file xsteel.sym.

This advanced option is model specific and the setting is saved in the options
database.

XS_DRIVER

Category: File Locations

The print device definitions you create in the Printer Catalog ( File menu -->
Printing --> Printer catalog ) are located in the plotdev.bin file. This file is
located in the system folder defined for the advanced option XS_SYSTEM.

The definitions in the system folder are accessible to all users. You can also
save printer definitions in the current model folder or in the project and firm
folders, and in a folder indicated by this advanced option. Tekla Structures
searches first for plotdev.bin in the model, project and firm folders, then in
the folder indicated by the advanced option XS_DRIVER.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_DSTV_CREATE_AK_BLOCK_FOR_ALL_PLATES

Category: CNC

Set to TRUE (default) to create AK blocks in DSTV files also for rectangular
plates, combined NC files and part lists.

When you set the advanced option to FALSE, Tekla Structures checks whether
an AK block needs to be created for the plate, and creates the AK block when
needed.

The DSTV standard does not require the creation of AK blocks if the part is
completely described by its length, its dimensions and its skewed cuts in the
header data. This advanced option allows you to create AK blocks for plates
even if the header data already covers all the information of the plate.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DSTV_CREATE_AK_BLOCK_FOR_ALL_PROFILES

Category

CNC

When you set the advanced option to TRUE, Tekla Structurescreates AK blocks
in DSTV files for all profiles, combined NC files and part lists. The default value
is TRUE.

When you set the advanced option to FALSE, Tekla Structures checks whether
an AK block needs to be created for the part, and creates the AK block when
needed.

The DSTV standard does not require the creation of AK blocks if the profile is
completely described by its length, its dimensions and its skewed cuts in the
header data. This advanced option allows you to create AK blocks for profiles
even if the header data already covers all the information of the profile.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_CREATE_NOTCH_ONLY_ON_BEAM_CORNERS

Category: CNC

Use this advanced option to control the rounding of notch corners. The default
is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

Examples

The following example describes the concepts of notches, notch corners,
notch corner roundings, and beam corners:
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1. The notch is at the beam corner
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2. The notch is not at the beam corner

3. Three notches, other corners are ordinary corners

4. Notch corner inner shape (or notch corner rounding) options in the NC
File Settings dialog box

The table below shows how the 
XS_DSTV_CREATE_NOTCH_ONLY_ON_BEAM_CORNERS setting (TRUE/FALSE)
and the Inner corners shape setting affect the NC file.

 XS_DSTV_CREATE_NOTCH_O
NLY_ON_BEAM_CORNERS set
to FALSE

XS_DSTV_CREATE_NOTCH_ONL
Y_ON_BEAM_CORNERS set to 
TRUE

Inner
corners
shape = 0

Inner
corners
shape = 1

XS_DSTV_DO_NOT_UNFOLD_POLYBEAM_PLATES

Category

Category: CNC

Set this advanced option to TRUE if you do not want to unfold polybeam plates
when you create DSTV files. This means that the polybeam plates will be
handled as “cut into shape” instead of “bent into shape” regardless of the

Advanced options reference 224 Advanced options - D



modeling method. For this advanced option to work, the polybeam plate must
lie in XY plane of the material.

If set this advanced option to FALSE, Tekla Structures writes the unfolded
geometry of the polybeam plates to the DSTV files. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_LIST_NET_WEIGHT

Category: CNC

When you set XS_DSTV_LIST_NET_WEIGHT to TRUE, net weight is used in MIS
list export. If you set it to FALSE, gross weight is used. FALSE is the default
value.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_LIST_SEPARATOR

Category

CNC

Use to define the separator used in DSTV lists. By default the separator is the
# character.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_NET_LENGTH

Category

CNC

Set this advanced option to TRUE to make cuts affect the part length in the NC
file header. Set this advanced option to FALSE to make only fittings affect the
length.

Using this advanced option also affects MIS values, such as KISS and EJE.

This advanced option is model specific and the setting is saved in the options
database.
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For advanced users

The AK block of the NC file always contains the correct net length. Using this
advanced option writes the net length, instead of the length, to the header
block. Some NC machines take the length information either from the header
or AK-block. Check with the workshop if you are uncertain which method to
use.

NOTE Using this advanced option may damage cutting machines if the part
contains cuts and fittings and the longest length is not at the edge of
the part (machine tries to start cutting in the middle of the part):

See also

XS_DSTV_PRINT_NET_AND_GROSS_LENGTH (page 228)

XS_DSTV_NO_SAWING_ANGLES_FOR_PLATES_NEEDED

Category

CNC

With this variable you can define whether you need to specify skew angles in
NC file header or not for plates. TRUE does not write the skew angles in the file
heading. If you want to specify skew angles, set this advanced option to 
FALSE. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See below for an example:
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XS_DSTV_NUMBER_OF_PARTS_BY_SELECTION

Category

CNC

Use to add the number of parts in the header of an NC file by the parts that
have been selected in the model.

When you set this advanced option to TRUE, and select the Create for
selected parts option in the NC Files dialog box, the number of parts in the
header of the NC file matches the number of selected parts.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_PLATE_PROFILE_WITH_WIDTH

Category

CNC

Set this advanced option to TRUE to have both the plate thickness and the
plate profile width written in the DSTV file header. Set this advanced option to 
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FALSE to have only the plate thickness written in the DSTV file header. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_PRINT_NET_AND_GROSS_LENGTH

Category

CNC

Set this advanced option to TRUE to insert two length values in NC DSTV files:

• Gross length

• Net length

If you do not want to do this, set this advanced option to FALSE. FALSE is the
default value.

Gross length

Net length

This advanced option is model specific and the setting is saved in the options
database.

NOTE Net and gross length may switch places in the NC file if the advanced
option XS_CHECK_FLAT_LENGTH_ALSO is set. Then Tekla Structures
may use the length value it finds in the fltprops.inp file instead.

See also

XS_DSTV_NET_LENGTH (page 225)

Fittings and line cuts in NC files

XS_CHECK_FLAT_LENGTH_ALSO (page 112)
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XS_DSTV_REAL_WIDTH_INTO_HEADER_PROFILE_FOR_PLATES

Category

CNC

Set to TRUE to have the real plate width instead of the nominal plate width in
the header information of DSTV files. The default is FALSE.

Here is an example of the difference between the real plate width and the
nominal plate width: A user models a plate beam using the profile PL200*10,
but then uses part or line cuts to create a 5 mm cut along the length of the
plate, for example, to create a root opening for a weld, so that the end result is
a plate which is only 195 mm wide. In this case, the real plate width would be
195 mm, and the nominal plate width 200 mm.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DSTV_USE_COUNTERSUNK_HOLES

Category: CNC

If you set XS_DSTV_USE_COUNTERSUNK_HOLES to FALSE in File menu -->
Settings --> Advanced options --> CNC, Tekla Structures will not create CSK
holes in DSTV export. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_DSTV_USE_EQUAL_ACCURACY_FOR_PLATE_PROFILE_AND_
WIDTH

Category

CNC

Set this advanced option to TRUE if you want the plate profile width value,
plate width value in header and y coordinate values in AK and IK blocks to be
rounded to the nearest millimeter. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_DSTV_USE_ONE_VERTEX_SHARP_INNER_CORNER

Category

CNC

Set this advanced option to TRUE if you do not need to add additional vertex
points in the AK block of your DSTV file, for example, when you do not define
the rounding radius in the NC settings. By default, this advanced option is set
to FALSE, which means that additional vertex points are added.

This advanced option is model specific and the setting is saved in the options
database.

Example

Results in the following DSTV file when the advanced option is set to TRUE:

Results in the following DSTV file when the advanced option is set to FALSE.

XS_DSTV_USE_REAL_DIMENSIONS_IN_HEADER

Category

CNC

Set to TRUE to have bounding box values of the height and width written to
the profile header data in the NC file. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also
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XS_DSTV_WRITE_BEHIND_FACE_FOR_PLATE

Category

CNC

Set to TRUE to write (AK + IK) contours for front (v) and back (h) faces of plates
in NC DSTV files. Set to FALSE to Tekla Structures only write the front face for
plate profiles. The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_DUPLICATE_CHECK_LIMIT_FOR_COPY_AND_MOVE

Category

Modeling Properties

Use to define the maximum number of objects that are checked for duplicates
while copying or moving objects.

If the selection contains too many objects, Tekla Structures does not check for
duplicates. Enter an integer value. The default value is 100.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DWG_EXPORT_UPDATE_TS_LINEWORK_OPTION

Category: Export

The setting Update Tekla Structures linework only is only shown in the 
Export drawings to DWG/DXF dialog box if you have set the new advanced
option XS_DWG_EXPORT_UPDATE_TS_LINEWORK_OPTION to TRUE.Update
Tekla Structures linework only updates the Tekla Structures drawing
content only and keeps other content that is created in a CAD software intact
at the same file. Blocks (groups), created by Tekla Structures will be updated.
Note that you need to have the same drawing exported already, and the layer
setup and the layer template must be the same as during the previous export.
All CAD lines that were added previously will stay in the file and only Tekla
Structures content will get updated, unless editing was done in CAD blocks
editor. The default value is FALSE.

This setting is user specific, and it is saved in the options.bin under the user
folder.
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Note that if you edit content of a block (CAD object), and then select the
Update Tekla Structures linework only option, the whole block will be re-
written, and the changes made in CAD will not be kept. To keep the changes in
CAD, you need to explode a block before editing it.

For example, you may want to use this option if you have added drawing title
blocks in the CAD after the first export of the drawing from Tekla Structures,
and want to keep these tables as they are, and update only the objects that
exported from Tekla Structures.

For more information about the DWG export, see .

XS_DWG_IMPORT_IGNORE_UNITS

Category

This advanced option must be set in an initialization (.ini) file.

If a DWG reference file is created with imperial settings, it will import to Tekla
Structures in too large scale. You can use this advanced option to prevent this.

If you want all coordinates to be meters, set this advanced option to TRUE.If
you want to take the unit from the DWG file based on the measurement and
$insunit definitions in the file header, leave the value out. By default, this
advanced option is not set to any value.

XS_DXF_FONT_CONVERSION_FILE

Category

Printing

Use this advanced option to specify a font conversion file for Tekla Structures
drawings’ DWG and DXF export and printing. The font conversion file defines
which font file will be connected to the created AutoCAD style, and optional
font width and height correction factors. You can use both True Type font files
and AutoCAD .SHX font files.

If only the file name of the font conversion file is given, the file is read from the
model folder. To use a font conversion file from another location, give the file
name with relative or full path. If XS_DXF_FONT_CONVERSION_FILE is not set,
Tekla Structures will try to use the default font conversion file
(dxf_fonts.cnv) from the folder defined by DXK_FONTPATH. DXK_FONTPATH
is defined in teklastructures.ini.

If the font conversion file is not found or if it does not contain a mapping for a
certain font, the font name used in Tekla Structures is used to form the name
of the text style in AutoCAD. Spaces are replaced with underscores and
lowercase letters are replaced with uppercase ones. For example, font name
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Arial Narrow in Tekla Structures will become a style named ARIAL_NARROW in
AutoCAD.

In addition to the font-specific width and height correction factors defined in
the font conversion file, there are general variables 
XS_DXF_TEXT_HEIGHT_FACTOR and XS_DXF_TEXT_WIDTH_FACTOR, which
apply to all exported texts regardless of the font. If both font specific factors
and general variables are used, they are multiplied.

Syntax used in font mapping:

Font name in Tekla Structures = Font file name in AutoCAD [*
width correction factor [* height correction factor]]
Examples of font mappings in a .cnv file:

Arial Narrow = ARIALN.TTF
Arial Narrow Bold Italic = ARIALNBI.TTF * 0.5 * 1.0

NOTE • The names in the font conversion file are case sensitive.

• The font conversion file is used for drawings in DWG and DXF
export and printing only, it does not affect drawings DWG and DXF
import or model import or export.

See also

DXK_FONTPATH (page 234)

XS_DXF_TEXT_HEIGHT_FACTOR (page 233)

XS_DXF_TEXT_WIDTH_FACTOR (page 234)

XS_DXF_FONT_NAME

Category

Printing

Use to specify a font other than the default for 2D DXF files. By default, this
advanced option is not set to any value.

This advanced option is model specific and the setting is saved in the options
database.

XS_DXF_TEXT_HEIGHT_FACTOR

Category

Printing
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Use to set a scale factor for 2D DXF text height. Enter the factor as a decimal.
The default value is 1.0.

This advanced option is model specific and the setting is saved in the options
database.

XS_DXF_TEXT_WIDTH_FACTOR

Category

Printing

Use to set the scale factor for 2D-DXF text width. Enter the factor as a decimal.
The default value is 1.0.

This advanced option is model specific and the setting is saved in the options
database.

DXK_FONTPATH

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. It can also be set locally, see your environment ini
file (env_<environment_name>.ini). Generally, there is no need to modify
system-specific settings. Do not modify them if you are not an administrator.

Use to point to the folder containing Tekla Structures graphic fonts. The
Template editor, for example, uses graphic fonts. DXK_FONTPATH is defined in
teklastructures.ini.

Always end the path with the backslash character.

Example
set DXK_FONTPATH=%XSDATADIR%\environments\common\fonts\

See also

DXK_SYMBOLPATH

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. It can also be set locally, see your environment ini
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file (env_<environment_name>.ini). Generally, there is no need to modify
system-specific settings. Do not modify them if you are not an administrator.

This advanced option points to one or several folders containing Tekla
Structures symbol libraries. These folders also contain the DWG files used in
snap symbols and handles. The order of folders in DXK_SYMBOLPATH is
significant: If there are duplicate files, the first one found is used. All files are
read from all defined folders.

The DXK_SYMBOLPATH is defined in the environment initialization file
env_<environment_name>.ini, located in ..\Trimble\Tekla
Structures\<version>\<environments>\<your_environment\ and in
the Tekla Structures initialization file teklastructures.ini located in
the ..\Tekla Structures\<version>\nt\bin\ folder.

Separate different folder paths with a semicolon (;). Always end a folder path
with a backslash character.

Example

Example with one folder:

DXK_SYMBOLPATH=C:\ProgramData\Trimble\Tekla Structures
\<version>\environments\common\symbols\
Example with several folders:

DXK_SYMBOLPATH=%XS_FIRM%;%XSDATADIR%\environments\uk\General
\symbols\;%XSDATADIR%\environments\common\symbols\
In the latter example, Tekla Structures first checks your own symbol files in
your firm folder, then the symbol files in the UK environment symbols folder,
and last the symbol files in the common environment symbols folder. If a
duplicate file exists, the one that Tekla Structures finds first is used.

Using a firm folder for images and symbols

You can define a firm folder where Tekla Structures always searches for the
images and symbols. When you store the images and symbols in this folder,
you do not have to move them from folder to folder when you install a new
version of Tekla Structures. Installing a new version does not replace the files
in the firm folder. For more information about defining the firm folder for
images and symbols, see .

1.5 Advanced options - E
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XS_ENABLE_FAST_CUSTOM_PROPERTY_LOADING

This advanced option must be set in startup .ini files

To switch off the functionality of loading custom properties from the extension
folder ..common\extensions\custom\properties\, set the advanced
option XS_ENABLE_FAST_CUSTOM_PROPERTY_LOADING to FALSE in a
startup .ini file using the following command:

set XS_ENABLE_FAST_CUSTOM_PROPERTY_LOADING=FALSE
When you do this, the custom properties are loaded from all folders and
subfolders in ..common\extensions, and from the locations defined in 
XS_EXTENSION_DIRECTORY. This may cause performance issues and loading
failures when custom properties are used.

Loading custom properties from ..common\extensions\custom
\properties\ speeds up the loading process and solves loading problems
caused by other software components in other extension folders.

XS_ENABLE_INNER_CONTOURS_IN_CUT_PARTS

Category

Speed and Accuracy

Set this advanced option to TRUE to have Tekla Structures create a part cut
according to the inner and outer surfaces of the cutting part.

When the advanced option is set to FALSE, Tekla Structures creates the cut
according to the outer surface of the cutting part. This is the default.

This advanced option is model specific and the setting is saved in the options
database.

Example

Here a beam has been cut with a round tube.
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Advanced option set to TRUE

Advanced option set to FALSE

XS_ENABLE_MIDDLE_BUTTON_DOUBLE_CLICK_ZOOM_
ORIGINAL

Category

This advanced option must be set in an initialization (.ini) file.

When you set this advanced option to TRUE and double-click the middle
mouse button, Tekla Structures zooms the open drawing to its original size.

Example
XS_ENABLE_MIDDLE_BUTTON_DOUBLE_CLICK_ZOOM_ORIGINAL=TRUE

XS_ENABLE_PHASE_OPTION_IN_NUMBERING

Category: Numbering

When this advanced option is set to FALSE (which is the default value), the
Assembly phase check box is disabled in the Numbering Setup dialog box.
This means that changing an object's phase does not affect numbering or
trigger change alerts.

If this advanced option is set to TRUE, the Assembly phase check box is
enabled in the Numbering Setup dialog box. This is the recommended setting
for Tekla Model Sharing users.

If you select the Assembly phase check box, only the assembly phase of each
assembly is compared in numbering. This means that otherwise identical
objects with different assembly phase get the same part position number.
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Note! Even if you do not select the Assembly phase check box, but you
change the phase of an object when 
XS_ENABLE_PHASE_OPTION_IN_NUMBERING is set to TRUE:

• A question mark (?) is added to the object's position number indicating that
numbering is needed.

• After renumbering, the Document manager indicates that the drawings
need updating.

• In shared models, the Changes list shows the changed parts and
assemblies.

This happens even if you are using the Project Viewer configuration.

This advanced option is model specific and the setting is saved in the options
database.

See also

General numbering settings (page 601)

XS_ENABLE_POUR_MANAGEMENT

Category: Concrete Detailing

Set this advanced option to TRUE to enable pour management in the currently
open model and to show cast-in-place concrete structures as continuous. The
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commands that show and create pour objects and pour breaks in the model
and drawings are only available when pour management is enabled.

The default value for new models in the Concrete contractor role is TRUE. In
the other standard roles, the default value for new models is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

WARNING If pour management is enabled in the model, do not disable it
using XS_ENABLE_POUR_MANAGEMENT, especially in the middle of
the project. This may cause problems if you have drawings
containing pour objects, and if you are sharing your model. The
pour objects and pour breaks in the model and in the drawings
may get invalid, and you may lose pour-related modeling work.

XS_ENABLE_PRECAST_CONTINUOUS_CONCRETE

This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to show precast concrete structures as
continuous in model views. Showing precast concrete structures as
continuous means that, within each cast unit, the concrete parts with the same
material grade and the cast unit type Precast are shown as merged so that
the part outlines between touching or overlapping parts are not visible.

Note that you also need to set XS_ENABLE_POUR_MANAGEMENT (page 238) to 
TRUE in the Advanced Options dialog box.

The default value of XS_ENABLE_PRECAST_CONTINUOUS_CONCRETE is FALSE,
which means that the outlines of precast concrete parts within each cast unit
are visible.

Restart Tekla Structures after changing the value to activate the new setting.

When XS_ENABLE_PRECAST_CONTINUOUS_CONCRETE is set to TRUE, you can
adjust how the precast concrete structures appear in each model view by
using the following display settings of cast-in-place concrete structures in View
Properties --> Display:

• Ensure that Cast in place is set to Parts.

• In the Cast in place parts list, select either Merged or Separated to hide
or show the touching or overlapping part outlines.
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XS_ENABLE_PULLOUT_PLACEHOLDERS

Category: Concrete Detailing

Set this advanced option to TRUE to add placeholders instead of dimensions in
pull-out pictures. This advanced option adds the option Placeholders in the
Pullout picture dialog box.

The following example shows how the placeholders are used:

This advanced option is model specific and the setting is saved in the options
database.
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XS_ENABLE_REBAR_MARK_LEADER_LINE_BASE_POINT_
OPTIMIZATION

Category

Concrete Detailing

Use to select an optimal place for the base point of the reinforcing bar mark
leader line . If set to TRUE, Tekla Structures selects an optimal place for the
base point. The base point only points to one reinforcing bar. The default
value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_EQUAL_SHAPE_DIMENSIONS_TO_BOTH_ENDS_LIMIT

Category

Dimensioning: Parts

Shape dimensions are automatically shown on both ends of a beam, even if
the dimensions are the same. You can change this by entering a value in
millimeters for this advanced option.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

If you set this advanced option to 300, and a part is 300 mm shorter in one
direction, Tekla Structures only displays the dimension in the longer direction.
Use millimeters in all environments.

XS_ERASE_UDA_VALUE_WITH_ATTRIBUTE_IMPORT_NULL_
AND_BLANK

Category

This advanced option must be set in an initialization (.ini) file.

Set to TRUE to erase the values of selected user-defined attributes in attribute
import.

To select which values of user-defined attributes are erased, enter any of the
following values at the end of the file to be imported, in the same order as the
user-defined attributes are entered in the file:
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• NULL
• null
• No value (two consecutive delimiters)

Example

If the content of the input file is the following:

ID; USER_FIELD_1; USER_FIELD_2; USER_FIELD_3; USER_FIELD_4;
12345;NULL;null;;4

The result is:

User-defined attribute values for 1-3 are erased in the attribute import. User-
defined attribute 4 has the value 4 in the attribute import.

NOTE Space and tab are not recommended as delimiters in the input file
when this functionality is used.

XS_EXCLUDED_PARTS_IN_ORIENTATIONAL_NUMBERING

Category: Numbering

The advanced option XS_EXCLUDED_PARTS_IN_ORIENTATIONAL_NUMBERING
can be used in conjunction with the orientation numbering setting. Similar
parts will be numbered the same even if their orientation is different and the
orientation setting has been selected in the Numbering Setup dialog box. You
can enter the desired part names separated by spaces. Wildcards are also
allowed. This advanced option is model specific and the setting is saved in the
options database.

XS_EXPORT_CODEPAGE

Category

Export

Tekla Structures sets the codepage automatically so that exported files are
displayed correctly. If the proper codepage cannot be found, the codepage is
set to ansi_1252 by default. You can set the codepage manually by using this
advanced option, which overrides the automatic selection of codepage in
export. By default, this advanced option is not set to any value.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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To set the advanced option to the required codepage, use one of the following
values:

• ascii
• iso8859-1
• iso8859-2
• iso8859-3
• iso8859-4
• iso8859-5
• iso8859-6
• iso8859-7
• iso8859-8
• iso8859-9
• dos437
• dos850
• dos852
• dos855
• dos857
• dos860
• dos861
• dos863
• dos864
• dos865
• dos869
• dos932
• mac-roman
• big5
• ksc5601
• johab
• dos866
• ansi_1250
• ansi_1251
• ansi_1252
• gb2312
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• ansi_1253
• ansi_1254
• ansi_1255
• ansi_1256
• ansi_1257
• ansi_874
• ansi_932
• ansi_936
• ansi_949
• ansi_950
• ansi_1361
• ansi_1200
• ansi_1258

XS_EXPORT_DGN_COORDINATE_SCALE

Category

Export

Use this advanced option to set the coordinate scale to use in DGN exports.

DGN coordinate scale does not actually scale the model, but changes the
model precision. If you set this advanced option to 100, the accuracy is 1/100
mm.

This advanced option is model specific and the setting is saved in the options
database.

XS_EXPORT_DGN_FILENAME

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option has been removed.

Use to indicate the output file name in DGN exports. The default is
model.dgn.
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XS_EXPORT_DGN_INCLUDE_CUTS

Category

Export

Use this advanced option to define the cuts to include in DGN exports. You can
use the following values:

Value Use to
FALSE Exclude all cuts.
TRUE Include all cuts (default value).
CLASH Include all cuts but skip hole cut

ends.
CLASH_NOR
MAL_PLATE
S

Same as TRUE for contour plates and 
CLASH for all other parts.

This advanced option is model specific and the setting is saved in the options
database.

XS_EXPORT_DGN_INCLUDE_INNER_CONTOUR

Category

Export

Use to include or exclude inner contours of tubes in DGN exports. The options
are:

• TRUE to include inner contours (default)

• FALSE (default) to exclude inner contours

This advanced option is model specific and the setting is saved in the options
database.

XS_EXPORT_DGN_ROUND_SEGMENTS

Category

Export
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Use to define the number of segments Tekla Structures uses to display round
tubes. Tekla Structures uses this value for large tubes (larger than 100 mm)
and 80% of this value for small tubes. The default value is 40.

This advanced option is model specific and the setting is saved in the options
database.

XS_EXPORT_DGN_USE_CLASS_AS_COLOR

Category

Export

Set the color for exported parts by the part class (like Color by class in the
model).

By default the export uses the current colors of the Tekla Structures view
(FALSE). Set this advanced option to TRUE when you have defined some other
color setting than Color by class in the Object Representation dialog box,
but still want to export with Color by class.

This advanced option is model specific and the setting is saved in the options
database.

XS_EXPORT_DGN_USE_VOLUMETRIC

Category

Export

Set this advanced option to TRUE to define plates with profile type plate or
polygon plate to DGN type attribute 92 (0x05C in DGN cell header) and all
other beams to DGN type attribute 91 (0x05B in DGN cell header) in DGN
export. If you set it to FALSE, all beams get 91 as the type attribute in DGN
export. The default value is FALSE.

When this advanced option is set to TRUE, mapping to Microstation is
successful and the attribute report in Tekla Structures is correct.

This advanced option is model specific and the setting is saved in the options
database.

XS_EXPORT_DRAWING_TRY_TO_KEEP_LOCATION

If you set the advanced option 
XS_EXPORT_DRAWING_TRY_TO_KEEP_LOCATION to TRUE (default), Tekla
Structures tries to keep the DWG origin in the same position in the export as
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the drawing view origin. This can only be done in plan views and elevation
views. If the drawing has more than one plan view or elevation view, Tekla
Structures places the DWG origin in the bottom-left corner of the drawing
frame.

If you set this advanced option to FALSE, the origin (0,0) is set to the bottom-
left corner of the drawing frame.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

For more information about the drawing export, see .

XS_EXPORT_FILLMODE

Category

Export

Use to control how fills are exported to DWG and DXF formats.

This advanced option is model specific and the setting is saved in the options
database.

Value Description Appearance in
exported
DWG/DXF

Appearance in
Tekla Structures

HATCH Fills are drawn as
hatches in the
exported DWG/
DXF. This is the
default value.

BORDER Only the border
lines of fills are
drawn in the
exported DWG/
DXF.

FILL Fills are drawn as
filled triangles in
the exported
DWG/DXF.

NONE Fills are not drawn
in the exported
DWG/DXF.
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XS_EXPORT_LINE_TYPE_DEFINITION_FILE

Category

Export

Enter the name of the line type definition file that contains the line type
definitions and is used in line type mapping.

The file name extension of the line type definition file is .lin. The advanced
option is set to point to the file TeklaStructures.lin by default.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_EXPORT_STEEL2000_PRIMARY_IDS

Category

Drawing Properties

Set to TRUE to have Tekla Structures include main part IDs in MIS export files.
IDs appear on separate rows in the file. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_EXTENSION_DIRECTORY

This advanced option must be set in an initialization (.ini) file.

Use the advanced option XS_EXTENSION_DIRECTORY for defining additional
installation folders for extensions, or customer tools developed on top of
Open API.

Before the additional installation folders, the default folder %XSDATADIR%
\environments\common\extensions is used in installation.
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XS_EXTERNAL_EXCEL_DESIGN_PATH

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. It can also be set locally, see your environment ini
file (env_<environment_name>.ini). Generally, there is no need to modify
system-specific settings. Do not modify them if you are not an administrator.

Points to the location of the Excel spreadsheet used in connection design. If
you want to change the location, set the advanced option in the user.ini file.

1.6 Advanced options - F

XS_FILTER_SEPARATOR_CHAR

Category

Modeling properties

Enter the separator to be used between filter strings, for example, in the view
filter. You can use any character. By default Tekla Structures uses a space.

Example

To use a semi-colon as a separator, set this advanced option as follows:

XS_FILTER_SEPARATOR_CHAR=;
This advanced option is model specific and the setting is saved in the options
database.

XS_FIRM

Category

File Locations

NOTE This advanced option is system-specific and only meant for
administrators.

Set the advanced options XS_PROJECT and XS_FIRM along with XS_SYSTEM to
point to the folders Tekla Structures searches for property files. Tekla
Structures always saves properties in the current model\attributes folder.
You can then copy or move them to the XS_FIRM or the XS_PROJECT folder if
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the same settings are needed in other models. You can also create user-
defined sub-folders under the XS_FIRM and the XS_PROJECT folders, and
copy or move property files from the model\attributes folder to these sub-
folders.

For shared models, you can use a sub-folder in a Trimble Connect project as
the firm folder. For more information, see .

Note that you can define one path only, not a list of paths.

WARNING Changing an advanced option value in .ini files located outside
the model folder does not affect the existing models. You can
only update advanced options in the Advanced Options dialog
box or in the options.ini file located in model folder; not from
an options.ini file located in folders defined for the advanced
options XS_FIRM or XS_PROJECT. The .ini files are read also
when you open an existing model, but only new advanced
options that do not exist in options_model.db or
options_drawings.db are inserted, for example, such options
that are not yet in the Advanced Options dialog box but have
been added in the software.

See also

XS_FIX_FRAME_OF_FIXED_MODELVIEW

Category

Drawing Properties

This advanced option prevents the changing of the view size and location
especially in general arrangement drawings.

Set to TRUE to fix the frames of views that have Placing set to Fixed in View
Properties. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_FLAT_PREFIX

Category

Plate Work

Use this advanced option to set the flat bar prefix for output, reports, and
marks. If Tekla Structures finds a matching flat bar in the fltprops.inp file,
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the plate name will consist of the prefix you enter here, followed by the
thickness X width, for example FLAT5X100. The default value is FLAT.

By default PL and PLT profiles get the prefix FL or FLT if a matching plate is
found in the fltprops.inp.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

NOTE In Imperial version, if XS_FLAT_PREFIX is not included in
profitab.inp as similar profile as PL (valid parametric profile name),
the profile is shown with metric units.

XS_FLAT_THICKNESS_TOLERANCE

Category

Plate Work

Use to set the checking tolerance for flat bars. Tekla Structures uses this value
to check plate thickness to determine whether to convert it to a flat bar. Enter
a decimal value. The default value is 0.1 mm.

This advanced option is model specific and the setting is saved in the options
database.

XS_FLAT_TOLERANCE

Category

Plate Work

Tekla Structures uses this value to check plate width to determine whether to
convert it to a flat bar. Enter a decimal value. The default value is 0.1 mm.

This advanced option is model specific and the setting is saved in the options
database.

Advanced options reference 251 Advanced options - F



FLEXLM_TIMEOUT

Category

This advanced option must be set in an initialization (.ini) file.

This is a Windows environment variable used by Tekla Structures. This variable
reduces the delay in starting Tekla Structures. Enter the value in
microseconds. For Tekla Structures, the maximum value of this variable is 100
000.

Example
set FLEXLM_TIMEOUT=100000

XS_FRACTION_HEIGHT_FACTOR

Category

Imperial Units

Use this advanced option to control the total height of fractions. The default
value in the US environment Imperial role is 1.3.

This advanced option is model specific and the setting is saved in the options
database.

XS_FS_POSTFIX_FOR_MERGED_PART_MARK

Category

Marking: Parts

Use to define the far side postfix in merged part marks. This postfix is visible
for identical parts on far side. FS is the default value.

This advanced option is model specific and the setting is saved in the options
database.

See also

1.7 Advanced options - G
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XS_GA_CONNECTING_SIDE_MARK_SYMBOL

This advanced option must be set in an initialization (.ini) file.

Use to change the symbol for a connecting side mark in general arrangement
drawings. By default the side mark symbol is number 34 in the symbol file. To
change the symbol, set this advanced option to a different symbol number.

Restart Tekla Structures after changing the value to activate the new setting.

See also

XS_CONNECTING_SIDE_MARK_SYMBOL (page 123)

XS_GA_DRAWING_VIEW_TITLE

Category

Drawing Properties

Use to define a title for a general arrangement drawing view in a multidrawing.
By default the value is defined as follows:

Drawing %DRAWING_BASE_NAME%.

This advanced option is model specific and the setting is saved in the options
database.

XS_GAGE_OF_OUTSTANDING_LEG_STRING

Category

Marking: Bolts

Use to display the gage of outstanding leg (GOL) information in bolt marks
(element Gage of outstanding leg) in the following ways:

• If there is no %VALUE% in the string then Tekla Structures adds the GOL
value to the end of the string.

• You can enter any combination of text together with option %VALUE%. For
example, %VALUE% GOL or GOL%VALUE%.

• If you do not set this advanced option, Tekla Structures only uses %VALUE%.

• If Tekla Structures cannot calculate the value, nothing is added to the mark.

• The default value is GOL%VALUE%.

This advanced option is model specific and the setting is saved in the options
database.
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Example

Here, the value for the gage of outstanding leg is 5½.

In the Advanced Options dialog
box

In bolt mark

%VALUE% GOL 5½ GOL
GOSL %VALUE% GOSL 5½
GOL = GOL = 5½
 5½

XS_GA_HIDDEN_NORTH_MARK_SYMBOL

Category

Marking: Parts

By default, the symbol for hidden North marks in general arrangement
drawings is number 32 in the symbol file. To change the symbol, set this
advanced option to a different symbol number.

See also

Show orientation marks (north marks)

XS_GA_NORTH_MARK_SCALE

Category

Marking: Parts

By default, Tekla Structures draws North marks in general arrangement
drawings using a scale of 1:1. Use this advanced option to specify a different
scale. You can also create a larger symbol for North marks in the Symbol
Editor.

This advanced option is model specific and the setting is saved in the options
database.

XS_GA_NORTH_MARK_SYMBOL

Category

Marking: parts
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By default, the symbol for North marks in general arrangement drawings is
number 32 in the symbol file. To change the symbol, set this advanced option
to a different symbol number.

This advanced option is model specific and the setting is saved in the options
database.

See also

Show orientation marks (north marks)

XS_GA_OMITTED_DIAMETER_TYPE

Category

Marking: bolts

Use to omit marks for specific diameter types in general arrangement
drawings. The options are HOLE or BOLT.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_OMITTED_BOLT_TYPE (page 320)

XS_GET_ASSEMBLY_LEVELS_FROM_ASSEMBLY_MAIN_PART

Category

Marking: Parts

Set this advanced option to TRUE to get assembly levels from the assembly
main part. Set it to FALSE to get the levels from the whole assembly. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_GET_CAST_UNIT_LEVELS_FROM_CAST_UNIT_MAIN_PART

Category

Marking: Parts
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Set this advanced option to TRUE to get cast unit levels from the cast unit main
part. Set it to FALSE to get the levels from the whole cast unit. The default
value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_GOL_SYMMETRY_DISTANCE

Marking: Bolts

Gauge of outstanding leg (GOL) is the center to center distance of the holes
between two angles usually connected on the web of the beam/column. It is
equal to gauge of leg angles plus the web thickness. Outstanding leg is the leg
of the angle perpendicular to the paper viewing from the web. Use this
advanced option to set the tolerance in part symmetry checking when
calculating the gauge of outstanding leg. The default value is 0.01.

This advanced option is model specific and the setting is saved in the options
database.

See also

Bolt mark elements (page 697)

XS_GRID_DIMENSION_OVERALL_LENGTH

Category

Dimensioning: General

Set a length to add a dimension line spanning the entire grid next to existing
grid dimensions. The default value is 1.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_GRID_COLOR_FOR_WORK_PLANE

Category: Model View

Use to change the color of the work plane grid in the model. Define the color
of the grid using RGB values:

<value for red> <value for green> <value for blue>.
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Separate the values with spaces. Define the values on a scale of 0 to 1. The
default values are 0.7 0.0 0.3.

Reopen the model view to activate the new value.

This advanced option is user specific and the setting is saved in options.bin
under user folder.

XS_GRID_PLANES_VISIBLE_WITH_USERPLANES

Category

Model View

Use to show or hide the grid planes.

Set to TRUE to show the grid planes. Set to FALSE (default) to hide the grid
planes.

Reopen the view for the change to take effect.

NOTE The grid planes can be shown only if the construction planes are
visible. To display the construction planes, select the Construction
planes check box in the Display dialog box.

XS_GRID_TEXT_FONT

Category

Drawing Properties

Use to set the font for grid text. The default values is Arial. If you do not specify
a font, Tekla Structures uses the default font defined for XS_DEFAULT_FONT.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DEFAULT_FONT (page 137)

1.8 Advanced options - H
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XS_HANDLE_SCALE

Category: Model view

Use to modify the handle size in model views. Enter a decimal value.

• The default value is 1.3.

• A value larger than 1.3 makes the handles larger and easier to see.

• A value smaller than 1.3 decreases the handles.

Close the model view and re-open it to implement the change.

This advanced option is user specific, and the setting is saved in options.bin
under the user folder.

XS_HATCH_OVERLAPPING_FACES_IN_DX

Category: Model View

Use this advanced option to control whether hatching is shown for
overlapping surfaces in the DirectX rendered model views.

By default, this advanced option is set to TRUE.

If you change the value, you need to reopen the view to activate the new
value.

XS_HATCH_PATTERN_LINE_LIMIT

Category: Hatching

Set this advanced option to a numerical value to control the maximum
number of line segments created by a hatch pattern. The default value is 0,
which means that there is no limit.

This advanced option is model specific and the setting is saved in the options
database.

XS_HATCH_SCALE_LIMIT

Category

Hatching
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Defines the smallest possible size of the drawn hatch pattern. If the scale of a
single hatch pattern is smaller than the defined value, the pattern is changed
to a solid face. The default value is 0.001.

This advanced option is model specific and the setting is saved in the options
database.

XS_HATCH_SEGMENT_BUFFER_SIZE

Category

Hatching

Tekla Structures includes a hatch buffer to speed up opening drawings
containing hatch. This advanced option defines the size of the buffer.

The default value is 1000000. If you use extremely complicated hatches, you
may get better performance with a larger value. For small hatches, use a
smaller value.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_HATCH_SPECIAL_COLOR_ACI

Category

Export

Use this advanced option to set the autocad color index for the Special color
in hatches in drawing export. The default values is 120.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_HATCH_SPECIAL_COLOR_R

Category

Hatching

Use to define a hatch color that is not converted to black when printed. This
color will be printed as color or grayscale, depending on the selected printer
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settings. The hatch color is defined using RGB (Red Green Blue) values on a
scale of 0 to 255. The default for all of the related advanced options is 230.

Define the color using the following advanced options:

XS_HATCH_SPECIAL_COLOR_R
XS_HATCH_SPECIAL_COLOR_G
XS_HATCH_SPECIAL_COLOR_B
The smaller the values, the darker the shade.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_HATCH_SPECIAL_COLOR_G

Category

Hatching

See XS_HATCH_SPECIAL_COLOR_R (page 259)

XS_HATCH_SPECIAL_COLOR_B

Category

Hatching

See XS_HATCH_SPECIAL_COLOR_R (page 259)

XS_HELP_PATH

Category

This advanced option is available only in the
lang_<CurrentLanguage>.ini files.

This advanced option specifies the location of the help files in chm (Microsoft
Compiled HTML Help) format. These help files are used for some components.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.
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Example
set XS_HELP_PATH=%XSDATADIR%\help\enu

XS_HIDDEN_LINES_CHECK_TOLERANCE

Category

Drawing Properties

Defines the distance within which Tekla Structures treats part lines inside cast
units as overlapping lines. The default value is 0.01.

This advanced option is model specific and the setting is saved in the options
database.

XS_HIDDEN_NORTH_MARK_SYMBOL

Category

Marking: parts

By default hidden North mark symbol is number 32 in the symbol file. To
change the symbol, set this advanced option to a different symbol number.

This advanced option is model specific and the setting is saved in the options
database.

See also

Show orientation marks (north marks)

XS_HIDDEN_REMOVE_DOUBLE_LINES

Category

Drawing Properties

To have Tekla Structures draw double lines when displaying models with Exact
representation and creating drawings and 2D DXF files, set this advanced
option to FALSE.

The default value is TRUE, which means that Tekla Structures does not draw
double lines, to minimize file size.

This advanced option is model specific and the setting is saved in the options
database.
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XS_HIDDEN_USE_BOLT_PLANES

Category

CategoryDrawing Properties

Set this advanced option to TRUE to hide lines behind a bolt nut (with Exact
part representation). To show the lines, set it to FALSE (default).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

TRUE:

FALSE:
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XS_HIDE_OTHER_PARTS_IN_ASSEMBLY_AND_CAST_UNIT_
VIEWS

Category

Model View

Defines whether parts that do not belong to assemblies and cast units are
shown or hidden in assembly and cast unit views. The default value TRUE
hides the parts that do not belong to the selected assembly or cast unit. If you
set this advanced option to FALSE, the parts are not hidden.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Advanced options reference 263 Advanced options - H



XS_HIDE_WORKAREA

Category: Model View

Set this advanced option to TRUE to hide the work area or to FALSE to display
the work area in model views. The default is FALSE. Redraw the views for the
change to take effect.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Example

Setting Appearance in model
FALSE

TRUE

TIP To temporarily hide the green work area box, hold down the Ctrl and
Shift keys simultaneously, right-click and select Redraw View. To make
the box visible again, right-click and select Redraw View again.
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XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES

Category

Dimensioning: General

Use to define whether changed dimension text and moved dimension points
are highlighted in associative drawings.

When set to TRUE (default), Tekla Structures highlights the changed dimension
text and the moved dimension points in updated associative drawings.

Tekla Structures highlights the changes in the following ways:

• A change symbol (by default a cloud) is drawn around the old point, the
new point and the dimension values. It is displayed only when you select
the dimension.

• An arrow is drawn from the old point to the new point.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_HIGHLIGHT_MARK_CONTENT_CHANGES (page 265)

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL (page 85)

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE (page 84)

XS_HIGHLIGHT_MARK_CONTENT_CHANGES

Category

Marking: General

Use to define whether changed mark contents are highlighted in associative
drawings.

When set to TRUE (default), Tekla Structures highlights the mark contents that
have been changed in updated associative drawings by drawing a change
symbol (by default a cloud) around the changed mark content.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES (page 264)

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL (page 85)

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE (page 84)
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XS_HOLE_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in hole marks. The default
value is %BOLT_NUMBER%*D%HOLE.DIAMETER%.

This advanced option is only used when there is a hole, no bolt (and the hole is
a normal one).

The advanced options XS_SHOP_HOLE_MARK_STRING_FOR_SIZE and 
XS_SITE_HOLE_MARK_STRING_FOR_SIZE override this setting.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_HOLE_MARK_STRING_FOR_SIZE (page 412)
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XS_SHOP_HOLE_MARK_STRING_FOR_SIZE (page 391)

XS_HOLE_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in bolt marks in general
arrangement drawings. If you have not set the advanced options 
XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA or 
XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA, then this advanced option
is used.

This advanced option is only used when there is a hole, no bolt (and the hole is
a normal one).

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME
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• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA (page 392)

XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA (page 413)

1.9 Advanced options - I

XS_IGNORE_CUT_VALUE_IN_TEMPLATE

This advanced option must be set in an initialization (.ini) file.

By default, when a Template Editor template output value field does not fit
into a cell, three asterisks (***) will indicate that the value is cut. For example,
when a template has a value field length limited to 10 characters and the
output value is 11 characters or more, *** will be displayed at the end of the
value.

If you do not want to display the asterisks, set 
XS_IGNORE_CUT_VALUE_IN_TEMPLATE to TRUE.

XS_IGNORE_CROSSBAR_LOCATION_IN_REBAR_MESH_
NUMBERING

Category: Numbering

Use this advanced option to define whether the location of the crossing bars
(e.g. above or below the main bars) is ignored in the numbering of
reinforcement meshes.

The default value is FALSE.

If XS_IGNORE_CROSSBAR_LOCATION_IN_REBAR_MESH_NUMBERING is set to 
FALSE, the location of the crossing bars affects numbering, and the otherwise
identical meshes receive different numbers if the crossing bars are on the
different sides of the main bars.

If XS_IGNORE_CROSSBAR_LOCATION_IN_REBAR_MESH_NUMBERING is set to 
TRUE, crossing bars can be on either side of the main bars, and the otherwise
identical meshes still receive the same number.
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This advanced option is model specific and the setting is saved in the options
database.

NOTE We do not recommend that you change this setting during a project. If
you do so, you must carry out full numbering (File --> Diagnose &
repair --> Diagnose and repair numbering: all).

XS_IGNORE_SUBASSEMBLY_HIERARCHY_IN_DIMENSIONING

Category

Dimensioning: Parts

Use to define whether sub-assembly parts are dimensioned as secondary
parts of the main assembly.

When set to TRUE, Tekla Structures ignores sub-assemblies, and parts inside
the sub-assemblies are dimensioned as if they were parts in the main
assembly. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_IMPERIAL

Category

Imperial Units

Set this advanced option to TRUE to have output in imperial units only. If you
do not want to do this, set it to FALSE (default).

This affects only the following elements of bolt marks:

• Gage of outstanding leg (GOL)

• Center-to-center distance

This advanced option is model specific and the setting is saved in the options
database.

XS_IMPERIAL_DATE

Category

Imperial units
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Set this advanced option to TRUE to use the date format mm/dd/yyyy. Set it to 
FALSE (default) to use the date format dd.mm.yyyy.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_IMPERIAL_INPUT

Category

Imperial Units

Set this advanced option to TRUE to allow input in imperial units only. To
disable the advanced option, set it to FALSE (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_IMPERIAL_TIME

Category

Imperial Units

Set this advanced option to TRUE to use the time format hh:mm:ss am/pm.

Set to FALSE to use the time format hh:mm:ss.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_IMPERIAL_TRIANGLES

Category

Imperial Units

Set this advanced option to TRUE to also show triangle ratios in inches.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_IMPORT_DWG_TEXT_AS_POLYGON

Category: Drawing Properties

This advanced option can be used when adding DWG files to drawings. If you
have problems with fonts in DWG files, set this advanced option to TRUE, and
Tekla Structures will import fonts as polygons, instead of fonts. By default, the
option is set to FALSE.

This advanced option is user specific, and the setting is saved in options.bin
under the user folder.

XS_IMPORT_MODEL_LOG

Category

Import

Set to TRUE to create a log every time you use an import model.

Set to APPEND to append a log entry to the previous log.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_INCH_SIGN_ALWAYS

Category

Imperial Units

By default, Tekla Structures does not put an inch symbol (") in dimensions
which contain only inches. Set this advanced option to TRUE to show inch
symbols in all dimensions. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_INCLUDE_DWG_ATTRIBUTES_IN_REPORTS_AND_INQUIRE

Category

Speed and Accuracy
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DWG-specific attributes are now available in reports and inquiries only if this
advanced option is set to TRUE. This advanced option is by default set to 
FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_INHERIT_CONCRETE_PART_NUMBERING_SETTINGS_FROM
_CAST_UNIT

Category: Numbering

Use this advanced option to define whether to set concrete part numbering
according to cast unit numbering settings. If you set this advanced option to 
TRUE (default), the part number prefix for concrete parts includes the cast unit
prefix and the start number. If you set the advanced option to FALSE, the cast
unit prefix and the start number are not included.

For example, the cast unit prefix is C and the start number is 100. When the
advanced option is TRUE, the concrete part prefix is Concrete_C-100. When
the advanced option is FALSE, the prefix is only Concrete.

This setting affects concrete parts: Strip and pad footings, concrete beams and
columns, concrete walls and slabs, and concrete polybeams.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_CONCRETE_PART_NUMBERING_PREFIX (page 123)

XS_CONCRETE_PART_NUMBERING_START_NUMBER (page 123)

XS_INP
This advanced option is system specific and is read from
teklastructures.ini. It can also be set locally, see your environment ini
file (env_<environment_name>.ini). Generally, there is no need to modify
system-specific settings. Do not modify them if you are not an administrator.

Several system files are read from this folder, such as definitions for
parametric profiles (.clb), IFC property set configurations (.xml), line type
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mappings (.lin), global UDA definitions (objects.inp), and access rights
(privileges.inp).

The default location is XSDATADIR%\environments\common\inp\. You can
use semicolon-separated lists of folder paths.

XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS

Category

Drawing Properties

Enter TRUE in the Value field to prevent drawing views from being deleted
when associated objects are removed from the model. FALSE is the default.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

For general arrangement drawings use the advanced option 
XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS_IN_GA.

See also

XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS_IN_GA (page 273)

XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS_IN_
GA

Category

Drawing Properties

Enter TRUE (default) to prevent drawing views from being deleted when
associated objects are removed from the model.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS (page 273)
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XS_INTELLIGENCE_MAX_PART_COUNT

Category

Drawing Properties

Enter an integer to define how many parts are taken into account when
searching for associated objects. The advanced option is set to 20 by default.

This advanced option is model specific and the setting is saved in the options
database.

XS_INTELLIGENCE_MAX_PLANE_COUNT

Category

Drawing Properties

Enter an integer to define how many planes are taken into account when
searching for associated objects. The advanced option is set to 1000 by
default.

This advanced option is model specific and the setting is saved in the options
database.

XS_INTELLIGENCE_MAX_RULE_COUNT

Category

Drawing Properties

Use to decrease the number of associative rules that are used for one
measurement point. A smaller value, for example 10 (default), is usually
enough. A smaller value may also increase performance and decrease the
database size.

This advanced option also controls the maximum number of shown rules in
the dimension associativity rule list.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

WARNING Use this advanced option only in cases where there are
performance issues with associative drawings. Using this
advanced option may cause losing of associativity in some cases
when objects are deleted from the model.
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XS_INTELLIGENT_CLONING_ADD_DIMENSIONS

Category

Drawing Properties

Set to TRUE to create dimensions for additional parts using automatic
dimensioning during cloning, and to FALSE to prevent this. The default is 
TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_INTELLIGENT_DRAWING_ALLOWED

Category

Drawing Properties

Clear the value or set it to FALSE to prevent Tekla Structures from
automatically moving dimensions, marks, etc. according to model changes. 
TRUE is the default value.

This advanced option is model specific and the setting is saved in the options
database.

To control how the drawing view placing works when the model changes, set
this advanced option to TRUE and use it together with the advanced option . 
XS_DRAWING_UPDATE_VIEW_PLACING.

NOTE This setting affects all drawings. To prevent Tekla Structures from
automatically updating general arrangement drawings, use the
advanced option XS_INTELLIGENT_DRAWING_ALLOWED_IN_GA.

See also

XS_INTELLIGENT_DRAWING_ALLOWED_IN_GA (page 275)

XS_DRAWING_UPDATE_VIEW_PLACING (page 216)

XS_INTELLIGENT_DRAWING_ALLOWED_IN_GA

Category

Drawing Properties

Clear the value or set the advanced option to FALSE to prevent Tekla
Structures from automatically moving dimensions, marks, etc. according to
model changes.
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This advanced option is model specific and the setting is saved in the options
database.

NOTE This setting affects only general arrangement drawings. To prevent
Tekla Structures from automatically updating all types of drawings,
use the advanced option XS_INTELLIGENT_DRAWING_ALLOWED.

See also

XS_INTELLIGENT_DRAWING_ALLOWED (page 275)

XS_INTELLIGENT_MESSAGES_ALLOWED

Category

Drawing Properties

Set this advanced option to TRUE to display message when a drawing is
opened if a model object to which one or more drawing objects are linked is
deleted from the model.

If you do not want to display the message, set this advanced option to FALSE
(default).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_INTELLIGENT_UPDATE_ADD_DIMENSIONS

Category

Drawing Properties

Set to TRUE to add dimensions for new parts, bolts and reinforcing bars when
updating drawings and to FALSE to prevent this. The default is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_INVALID_POUR_BREAK_COLOR

This advanced option must be set in an initialization (.ini) file.

Use this advanced option to change the color of invalid pour breaks in model
views. Enter number as the value using the class numbers in the part
properties in the property pane to indicate the color. For example, if you set

Advanced options reference 276 Advanced options - I



this advanced option to 6, Tekla Structures will color all invalid pour breaks
yellow. The default value is 58 (red).

See also

IS_POUR_BREAK_VALID (page 536)

XS_I_PROFILE_CENTER

Category

Dimensioning: Parts

Set to NONE to prevent Tekla Structures from using the center line of I profiles
to dimension front views. By default, no value is set.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_ISO_LEG_LENGTH_AS_WELDSIZE

Category: Welds

When XS_AISC_WELD_MARK (page 68) is set to FALSE, set 
XS_ISO_LEG_LENGTH_AS_WELDSIZE to:

• TRUE to use the weld size as the leg length (z) of the fillet welds.

• FALSE to use the weld size as the throat thickness (a) of the fillet welds.

NOTE The weld prefix overrides the setting of the advanced option 
XS_ISO_LEG_LENGTH_AS_WELDSIZE. If you have set the prefix of a
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weld to a, the weld size determines the design throat thickness. When
the weld prefix is z, the weld size determines the leg length.

If the last character of the weld prefix is s, Tekla Structures creates the
solid weld object so that a equals weld size.

This advanced option is model specific and the setting is saved in the options
database.

After changing this setting, modify existing welds or their properties to activate
the new setting and to update the weld solids.

1.10 Advanced options - J

XS_JOINT_NUMBER_FORMAT

Category

Marking: General

The connection numbers are visible in drawings, when you set the
Connection mark field to Number in the Connection mark properties
dialog box. Use this advanced option to define the connection number format.
For example, you can use it to define prefix text.

This advanced option is model specific and the setting is saved in the options
database.

Example

In XS_JOINT_NUMBER_FORMAT=J%3.3d:

• J is the prefix.

The rest of the string defines the number format.

• The first number defines the minimum field width.

• The second number defines the minimum quantity of numbers to display.

• % and d (integer value) indicate the format.

XS_JOINTS_USE_NOTCH1

Category

Components
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Set to 1 to have connections use standard notch routines. This is the default
value.

Set to 0 to have connections use simple notch routines.

This advanced option is model specific and the setting is saved in the options
database.

1.11 Advanced options - K

XS_KEEP_AUTOSAVE_FILES_ON_EXIT_WHEN_NOT_SAVING

Category

Modeling Properties

Tekla Structures deletes autosave files when you close a model to save disk
space. If this advanced option is set to TRUE, Tekla Structures does not delete
these files, even if you exit Tekla Structures without saving the model. The
default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_KEYIN_ABSOLUTE_PREFIX

Category: Modeling Properties

Defines the character used in absolute snapping. Enter any allowed ASCII
character. The default value is $.

If you have set Tekla Structures to use absolute snapping by default using the
advanced option XS_KEYIN_DEFAULT_MODE, you do not need to use a snap
character for absolute snapping.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_KEYIN_DEFAULT_MODE (page 279)

XS_KEYIN_RELATIVE_PREFIX (page 280)

XS_KEYIN_GLOBAL_PREFIX (page 280)
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XS_KEYIN_DEFAULT_MODE

Category: Modeling Properties

Defines the snapping mode Tekla Structures uses by default. Set to RELATIVE
(default), ABSOLUTE, or GLOBAL.

In the relative snapping mode, the coordinates you enter in the Enter a
Numeric Location dialog box as such without any prefix are relative to the
last position picked.

In the absolute snapping mode, the coordinates are based on the origin of the
work plane.

In the global snapping mode, the coordinates are based on the global origin
and the global x and y directions.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_KEYIN_RELATIVE_PREFIX (page 280)

XS_KEYIN_ABSOLUTE_PREFIX (page 279)

XS_KEYIN_GLOBAL_PREFIX (page 280)

XS_KEYIN_GLOBAL_PREFIX

Category: Modeling Properties

Defines the character used in global snapping. The default value is !.

If you have set Tekla Structures to use global snapping by default using the
advanced option XS_KEYIN_DEFAULT_MODE, you do not need to use a snap
character for global snapping.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_KEYIN_DEFAULT_MODE (page 279)

XS_KEYIN_RELATIVE_PREFIX (page 280)

XS_KEYIN_ABSOLUTE_PREFIX (page 279)
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XS_KEYIN_RELATIVE_PREFIX

Category: Modeling Properties

Defines the character used in relative snapping. Enter any allowed ASCII
character. The default value is @.

If you have set Tekla Structures to use relative snapping by default using the
advanced option XS_KEYIN_DEFAULT_MODE, you do not need to use a snap
character for relative snapping.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_KEYIN_DEFAULT_MODE (page 279)

XS_KEYIN_ABSOLUTE_PREFIX (page 279)

XS_KEYIN_GLOBAL_PREFIX (page 280)

XS_KNOCK_OFF_DIMENSION_PRECISION

Category

Dimensioning: General

Set this advanced option to 16 or 32 to set the precision of the knock-off
dimensions to 1/16 or 1/32. Otherwise the precision is the one that is set in
the drawing level dimensioning dialog box. The default value is zero. Other
values are ignored, and knock off dimension precision is the same as for other
dimensions.

1.12 Advanced options - L

XS_LANGUAGE

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

This advanced option sets the Tekla Structures default language. The default
language is displayed first when you go to the File menu and click Settings -->
Change language .
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XS_LEADER_LINE_TO_DRAGGED_DIMENSION_TEXT

Category: Dimensioning: General

When you set this advanced option to TRUE, a leader line is drawn when a
dimension text is dragged away from the dimension line. When you set it to 
FALSE, the leader line is not drawn. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_LINE_WIDTH

Category

Model View

Use to change the width of lines in model views. Enter the value in pixels.

This advanced option is model specific and the setting is saved in the options
database.

XS_LICENSE_SERVER_HOST

This advanced option must be set in an initialization (.ini) file.

With this advanced option the administrator can predefine the license server
for the user, so that the user does not need to type the license server port and
hostname in the licensing dialog box at the first start of the Tekla Structures
software.

You can add this advanced option in a customized .ini file and use it in
startup shortcuts for starting teklastructures.exe with the initialization
that you have customized, for example.

Enter the advanced option value in one of the following formats:
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port@host
port@ip-address

XS_LOAD_MODELING_CODE

This advanced option must be set in an initialization (.ini) file. For more
information about initialization files, see .

Use this advanced option for defining the set of load group types. Load
combinations are generated according to rules that are specific to the load
modeling code. The default value is EuroCode.

Possible values are: EuroCode, AISC, UBC, IBC, ACI, BS, CM66 (F), and 
BAEL91 (F).

Example
set XS_LOAD_MODELING_CODE=EuroCode

XS_LOG_FILE_NAME

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

This advanced option defines the name of the Tekla Structures log file. The
default value is TeklaStructures.log.

See also

XS_LOG_LEVEL

Category: Speed and Accuracy

Use this advanced option to define which messages Tekla Structures writes to
the log files. Set the level of the log output to one of the following options:

• DEBUG: all log messages are written

• INFO: all log messages except debug messages are written

• WARNING: all log messages except debug and info messages are written
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• ERROR: only error and assert messages are written

The default value is INFO. Providing any value other than one of the above
results in log level INFO.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

XS_LOG_TIMER

Category: Speed and Accuracy

Set this advanced option to TRUE to save loading and opening times in the
session history log. The default value is FALSE. Using this advanced option you
can get a quick performance overview directly from the log.

Examples of log entries:

Plug-ins loaded in 1233ms.

Plug-in dialogs loaded in 1235ms.

Opening model...

.Inp files loaded in 355ms.

Model db read in 3467ms.

Searchtree intialized in 10400ms.

Model opened in 354258743ms.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_LOGPATH

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option points to the folder that contains the Tekla Structures
log file.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.
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XS_LONGHOLE_MARK_STRING_FOR_SIZE

Category

Marking: bolts

Use to define the contents of the Size element in slotted hole marks. For
example, enter %BOLT_NUMBER%*D%HOLE.DIAMETER%(%HOLE.DIAMETER
+LONG_HOLE_X%x%HOLE.DIAMETER+LONG_HOLE_Y%).

This advanced option is only used when there is a longhole.

The advanced options XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE and 
XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE override this setting.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE (page 414)

XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE (page 393)

Advanced options reference 285 Advanced options - L



XS_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in longhole marks in general
arrangement drawings. If you have not set the advanced options 
XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA or 
XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA, then this advanced
option is used.

This advanced option is only used when there is a longhole.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA (page 394)

XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA (page 415)
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1.13 Advanced options - M

XS_MACRO_DIRECTORY

Category: File Locations

Specifies a global and a local folder for recorded macro files. Macro files are
usually language and environment dependent and will not run in any other
environment or language. This advanced option is system-specific.

Use a semicolon (;) as a separator. Do not define more than two macro
folders.

First define the global folder, and then the local folder, for example:

set XS_MACRO_DIRECTORY=%XSDATADIR%environments\common\macros;%XSDATADIR
%environments\uk\General\user-macros

This advanced option is by default set to ..\ProgramData\Trimble\Tekla
Structures\<version>\environments\common\macros.

NOTE Do not change the global folder. If necessary, you may change the
local folder.

When you click the Access advanced features button in Applications &
components , you can select whether to create a global or local macro by
selecting New macro --> Local or > Global. The option Local is not displayed,
if you have not specified the folder.

NOTE The macro folder must contain subfolders modeling and drawings.

XS_MACRO_ENABLE_TIMESTAMP

Category

Category: Modeling Properties

Set this advanced option to TRUE to examine the time spent on different tasks
while recording macros. This advanced option is system-specific.

The default value is FALSE. If you change the value, you need to reopen the
model to activate the new setting.

The timestamps are in the .cs file of the macro in question, which is located
in ../environments/common/macros folder. The macro is saved in the
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drawings or modeling folders, depending on in which mode the macro was
recorded.

XS_MACRO_LOG

Category

This advanced option must be set in an initialization (.ini) file.

By default Tekla Structures macro output is displayed in the terminal window.
Set this advanced option to a file name to save this output to a file.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_MACRO_REFERENCES

Category

Modeling Properties

This advanced option defines a path to an additional library that is used when
a macro is compiled. The default path
is ;System.Windows.Forms;Tekla.Technology.Scripting;Tekla.Stru
ctures;Tekla.Structures.Model;Tekla.Structures.Drawing;MacroS
elector;System.Drawing;System.Data;System.Xml;Tekla.DataShari
ng.CacheServiceClient;Tekla.DataSharing.SharedPublic.

This advanced option is system-specific.

XS_MAGNETIC_PLANE_OFFSET

Category

Components

Use to adjust the magnetic distance of magnetic planes. By default the
distance is 0.2 mm.
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Setting this advanced option does not affect magnetic construction lines.

This advanced option is model specific and the setting is saved in the options
database.

XS_MARK_ALL_BOLT_GROUPS_SEPARATELY

Category

Marking: Bolts

Set this advanced option to TRUE to prevent Tekla Structures from combining
bolt group marks. By default Tekla Structures combines bolt group marks
(FALSE).

This advanced option is model specific and the setting is saved in the options
database.

Example

In the image below, this advanced option is set to TRUE.

In the image below, FALSE is used.
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XS_MARK_ELEMENT_SPACE_FACTOR

Category

Marking: General

By default Tekla Structures leaves a space 0.3*text height between mark
elements. Use this advanced option to change the default value.

This advanced option is model specific and the setting is saved in the options
database.

Example

In the example below, the default value 0.3 was changed to 1.

XS_MARK_FONT

Category

Drawing Properties
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You can set the mark text font (for part marks etc.) by giving the name of the
font to this advanced option. The default value is Arial. If no font is given, Tekla
Structures uses the default font defined for XS_DEFAULT_FONT.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DEFAULT_FONT (page 137)

XS_MARK_INTELLIGENT_POST_FREEPLACE_NEARBY

Category:Marking: General

If you set the advanced option XS_MARK_INTELLIGENT_
POST_FREEPLACE_NEARBY to TRUE (default), Tekla Structures first places the
marks in drawings avoiding crossing leader lines, and after that runs the place
nearby command, which ensures that the mark locations follow the protection
settings. If you set this advanced option to FALSE, the crossing mark check is
performed, but the place nearby command is not run, so some of the
protection settings may not be followed.

Note that you need to set the advanced option 
XS_TRY_TO_KEEP_LOCATION_IN_FREEPLACING to TRUE (Default) for the
advanced option XS_MARK_INTELLIGENT_POST_FREEPLACE_NEARBY to
work.

This advanced option is model specific and the setting is saved in the options
database.

See also

Placement properties for marks, dimensions, notes, texts and symbols
(page 726)

XS_MARK_INTELLIGENT_PLACING (page 311)

XS_TRY_TO_KEEP_LOCATION_IN_FREEPLACING (page 428)

XS_MARK_LEADER_LINE_ARROW_HEIGHT

Category

Marking: General

Height of arrow head in mark leader line. 1 is the default value. For example,
the standard AutoCAD leader lide arrow height is 0.67.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
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in use, you can change the value, which is then the same for all users in the
current model.

XS_MARK_LEADER_LINE_ARROW_LENGTH

Category

Marking: general

Length of arrow head in mark leader line. The default is 2.5.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_MARK_LEADER_LINE_EXTENSION_LENGTH

Category

Marking: General

Use to define the length of the leader line extension. The extension is placed
before the start of a text string. Give the length in millimeters. The default
value is 0.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDICULAR

Category: Marking: General

Use this advanced option to control the length of the perpendicular leader
lines of rebar group marks. The default value is 0.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.
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See also

Mark properties - Content, General, Merging and Appearance tabs (page 678)

XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME

Category

Marking: General

Use to define the leader line position of a leader line pointing to a mark:

• without a mark frame (mark frame deleted from the General page of the
mark properties dialog box)

• without a mark frame but with a mark element frame (mark frame deleted
from the General page, and element frame selected on the Content page
of the mark properties dialog box).

The default value is 0.

TIP You may want to keep the default value 0 for the advanced option 
XS_MARK_LEADER_LINE_EXTENSION_LENGTH, when using 
XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

Position Appearance Set the advanced
option to

Nearest corner. 0
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Position Appearance Set the advanced
option to

In the middle of the text area. 1

1/3 from the top of the text
area.

2

In the middle of the first row
of text.

3

The leader line connects to
the frame around the mark
element (not to the frame
around the whole mark). The
mark frame has been deleted
in the mark properties.

4

See also

XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_RECTANGULAR_FRAME
(page 295)

XS_MARK_LEADER_LINE_EXTENSION_LENGTH (page 292)
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XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_
RECTANGULAR_FRAME

Category

Marking: General

Use to define the leader line position for a leader line with a rectangular
frame. The default value is 0.

This advanced option is model specific and the setting is saved in the options
database.

Example

Position Appearance Set the advanced
option to

Nearest corner. 0

In the middle of the
text area.

1

1/3 from the top of
the text area.

2
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Position Appearance Set the advanced
option to

In the middle of the
firs row of text.

3

See also

XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME (page 293)

XS_MARK_LINE_SPACE_FACTOR

Category

Marking: General

By default Tekla Structures leaves a space of 0.3*text height between the lines
in multi-line marks, for example, part, bolt, and connection marks. Use this
advanced option to change the default value.

This advanced option is model specific and the setting is saved in the options
database.

In the example below, the value was changed from 0.3 to 1.
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XS_MARK_PLACING_ANGLE_CLOSE_TO_45_DEGREES

Category: Marking: General

To place marks with leader lines in a 45-degree angle if allowed by the
protection settings, ensure that the advanced option 
XS_MARK_PLACING_ANGLE_CLOSE_TO_45_DEGREES is set to TRUE. TRUE is
the default value.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_MARK_INTELLIGENT_PLACING (page 311)

XS_MARK_TEXT_FRAME_BOX_HEIGHT_FACTOR

Category

Marking: General
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By default Tekla Structures leaves a space of 0.5*text height between the text
and the frame around the text. Use this advanced option to change the default
value.

This advanced option is model specific and the setting is saved in the options
database.

In the example below, the value was changed from 0.5 to 2.

XS_MATERIAL_SYMBOL_REPRESENTATION_FILE

Category

Drawing properties

Enter the folder path and filename of the file containing the user-defined
material symbols, for example material_symbol_table.txt.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_MAX_ANGLE_BETWEEN_SKEWED_END_PLATE_AND_BEAM_
END

Category

Drawing Properties

Use to produce section views and dimensions of slightly skewed end plates. An
end plate can be sloping or skewed to such a small degree that it is
unnecessary to bevel cut the end of the main part. If the end plate is not
dimensioned in the section view, you need to set a limit for the end plate
angle.

Tekla Structures dimensions any end plate skewed less than this value in
section views. Larger angle dimensions do not appear in the section view. Set
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the angle between the skewed end plate and beam in degrees. The default
angle is 0.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_MAX_ANGLE_TOLERANCE_BETWEEN_COMPLEX_MAIN_
PARTS

Category

Dimensioning: Parts

Use to define the maximum angle range (0...1) within which Tekla Structures
will dimension non-parallel parts as one. The default value is 0.01.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_MAX_AUTOMATIC_RADIUS_DIMENSION

Category

Dimensioning: Parts

Defines the maximum radius when you use automatic radius in single part
drawings. The default value is 5000. Tekla Structures will display radii smaller
than the value you enter in drawings.

This advanced option is model specific and the setting is saved in the options
database.

XS_MAX_DECIMALS_IN_PROFILE_NAME

Category

Profiles

Use this advanced option to control the number of decimals in profile names
in NC file headers. The default value is 1.
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NOTE This advanced option only affect plates created directly in the model.
The advanced option XS_PLATE_ROUNDING_DECIMALS (page 329)
affects plates created by components.

This advanced option works on plates only if you set the advanced option XS_
USE_NEW_PLATE_DESIGNATION (page 451) to TRUE on the Plate Work page in
the Advanced Options dialog box.

XS_MAX_DEVIATION_FOR_CURVED_PART_EDGES

Category

Concrete Detailing

When you camber a part, Tekla Structures calculates all the part vertices to be
on a circle arc, but all span edges between two vertices are approximations of
the arc. Use this advanced option to limit the maximum distance by which the
edge can deviate from the arc.

Define the value in millimeters. The default is 2.0. The minimum value is 0.1.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_WARP_MAX_ANGLE_BETWEEN_CS (page 477)

XS_MAX_FRACTIONS_IN_MODEL_DIMENSION

Category

Imperial Units

Defines the measuring accuracy in models in the US environment Imperial
role. For example, this accuracy affects the imperial measurements shown
with the Measure tool. You can enter any number, but you should use
numbers such as 8, 16, 32, 64, 128 and 256. The default value is 16.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

To use the accuracy of 1/32, set this advanced option to 32.
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XS_MAXIMUM_NUMBER_OF_PLANES_TO_NAME

Category

Modeling Properties

Use to define how many planes Tekla Structures names when the planes are
used, for example, in defining distance variables. The default value is 400.

When the maximum number of planes is reached, Tekla Structures stops
naming the planes and uses the name Undefined plane for the rest of the
planes.

This advanced option is model specific and the setting is saved in the options
database.

XS_MAX_MERGE_DISTANCE_IN_HORIZONTAL

Category

Marking: Parts

Defines the maximum horizontal distance within which identical
reinforcement get merged marks. This advanced option only affects merging
of reinforcing bar marks pointing to individual reinforcing bars, not marks
pointing to a group of reinforcing bars, or marks within a group of reinforcing
bars. The default value is 600 mm.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_MAX_MERGE_DISTANCE_IN_VERTICAL (page 301)

XS_MAX_MERGE_DISTANCE_IN_VERTICAL

Category

Marking: Parts

Defines the maximum vertical distance within which identical reinforcement
get merged marks. This advanced option only affects merging of reinforcing
bar marks pointing to individual reinforcing bars, not marks pointing to a
group of reinforcing bars, or marks within a group of reinforcing bars.The
default value is 600 mm.

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_MAX_MERGE_DISTANCE_IN_HORIZONTAL (page 301)

XS_MAX_SPACE_BETWEEN_COMPLEX_ASSEMBLY_PARALLEL_
PARTS

Category

Dimensioning: Parts

Use to define the maximum distance allowed between parallel parts for Tekla
Structures to dimension them as one. The default value is 1000.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_MDIBASICVIEWPARENT

Category

Model View

Set this advanced option to TRUE (default) to allow connection or default view
windows to be moved within the Tekla Structures window.

Set this advanced option to FALSE to allow connection or default view
windows to be moved anywhere on the Windows desktop.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_MDIVIEWPARENT (page 302)

XS_MDIVIEWPARENT

Category

Model View

Set this advanced option to TRUE to allow view windows to be moved only
within the Tekla Structures window.
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Set this advanced option to FALSE to allow view windows to be moved
anywhere on the Windows desktop. This gives you more workspace on the
screen, because view windows move to the front when you click on them and
open dialog boxes remain behind the views. It also allows you to enlarge Tekla
Structures windows to fill the entire desktop.

The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

NOTE This advanced option also affects drawing windows. Use the advanced
options XS_MDIZOOMPARENT and XS_MDIBASICVIEWPARENT to
control connection and default views and zoom views .

See also

XS_MDIZOOMPARENT (page 303)

XS_MDIBASICVIEWPARENT (page 302)

XS_MDIZOOMPARENT

Category

Model View

Set this advanced option to TRUE to allow zoom windows to be moved only
within the Tekla Structures window.

Set this advanced option to FALSE (default) to allow zoom windows of views to
be moved anywhere on the Windows desktop.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_MESSAGES

Category

This advanced option must be set in an initialization (.ini) file.

Use to define the location of the message files. All message files have the file
name extension ail.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

We recommend that you use XS_MESSAGES_PATH (page 304) that allows you
to define several message file locations.
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See also

XS_MESSAGES_PATH

This advanced option must be set in an initialization (.ini) file.

Use to define the locations of the extension message files. All message files
have the file name extension ail.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

XS_MIN_DISTANCE_FOR_CONNECTING_SIDE_MARK

Category

Marking: General

Use this advanced option to set the minimum distance of the connecting part
from the main part so that when the distance is larger than the value you
enter, Tekla Structures draws a connecting side mark to show that there is a
part farther away from the main part that is connected to the part. When the
distance is smaller than the value you enter, no mark is drawn. The default
value is 300 mm.
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This advanced option is model specific and the setting is saved in the options
database.

See also

XS_MIN_MERGE_PART_COUNT

Category

Marking: Parts

Use to define the minimum number of identical parts whose marks to merge.
The default value is 2.

This advanced option is model specific and the setting is saved in the options
database.

See also
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XS_MIN_NUMBER_OF_ASSEMBLY_MULTI_CHARACTERS

Category: Numbering

Use to set the minimum number of characters in assembly multinumbers.

This advanced option is model specific and the setting is saved in the options
database.

Example

If you set this advanced option to 3, the multinumber format is 101AAA.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_VALID_CHARS_FOR_ASSEMBLY_MULTI_NUMBERS (page 470)

XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING (page 81)

XS_MIN_NUMBER_OF_PART_MULTI_CHARACTERS (page 306)

XS_MIN_NUMBER_OF_PART_MULTI_CHARACTERS

Category: Numbering

Use to define the minimum number of characters in part multinumbers.

This advanced option is model specific and the setting is saved in the options
database.

Example

If you set this advanced option to 3, the multinumber format is 101aaa.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_VALID_CHARS_FOR_PART_MULTI_NUMBERS (page 470)

XS_PART_MULTI_NUMBER_FORMAT_STRING (page 326)

XS_MIN_NUMBER_OF_ASSEMBLY_MULTI_CHARACTERS (page 305)

XS_MIN_WELD_LINE_LENGTH

Category: Welds

Defines the minimum length of the weld mark reference line. If symbols and
other data exceed the minimum length of weld mark reference line, weld mark
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reference line extends to contain all symbols and data. Enter the value in
millimeters.

This advanced option is model specific and the setting is saved in the options
database.

XS_MIS_FILE_DIRECTORY

Category: CNC

Points to the folder where NC and MIS files are created. The default is the
current model folder.

This advanced option is model specific and the setting is saved in the options
database.

The following table shows where the NC files are created with different values
entered in the File location box in the NC File Settings dialog box, and 
XS_MIS_FILE_DIRECTORY is set to C:\NC:

Path in File location NC files are created in
empty C:\NC\ModelName
.\ C:\NC\ModelName
.\MyFiles C:\NC\ModelName\MyFiles

XS_MIS_SEQUENCE

Category

Export

Use to enable sequences in EJE and KISS file type MIS exports.

Define which part property is used as the sequence information. The options
are:

• CLASS
• PHASE_NUMBER (default)

• PHASE_NAME
• UDA:USER_PHASE

NOTE The maximum lengths of the sequence information fields are 10 and 4
characters in KISS and EJE file types, respectively. Do not use long
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names for phase names or user phases, if you are using this
information as MIS Sequence.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_MODEL_BACKUP_DIRECTORY

Category: File Locations

Enter the path to the folder that contains the backup copies of Tekla
Structures model files. The default value is ..\TeklaStructuresModels\
\backup\.

The backup folder cannot be located directly under the actual model folder,
because it would cause an infinite loop. If you define the backup folder to be in
the model folder, Tekla Structures will ignore the path and use the default
folder instead.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_MODEL_IMPORT_LOCK_OBJECTS

Category: Import

Set this advanced option to TRUE to lock all the imported objects. When you
do this, the user-defined attribute Locked is automatically set to Yes in the
user-defined attributes dialog box of the imported objects. TRUE is the default
value.

This advanced option is model specific and the setting is saved in the options
database.

XS_MODEL_PREFIX_INFLUENCES_MULTI_NUMBERING_FOR

Category: Numbering

Use to define whether part and assembly number prefixes affect the
numbering of parts and assemblies in multidrawings. The options are NONE, 
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ASSEMBLIES, PARTS and ASSEMBLIES_AND_PARTS. The value field is empty
by default.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_USE_MODEL_PREFIX_IN_MULTI_NUMBERS_FOR (page 450)

XS_MODEL_TEMPLATE_DIRECTORY

Category: File Locations

Enter the path to the folder where Tekla Structures saves model templates.
Enter only one folder path. Only the templates saved in this folder are listed in
the Model template list in the New dialog box.

For example, you can set this advanced option to point to the same location as
XS_FIRM (page 249).

By default, the model template folder is saved in your environment folder,
under ..ProgramData\Trimble\Tekla Structures\<version>
\environments\<your environment>\. The exact folder location may vary
depending on your environment and role.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_MULTIDRAWING_KEEP_OBSOLETE_DRAWINGS

Category

Drawing Properties

Use this advanced option for controlling the views and multinumbers of
deleted assemblies in multidrawings. Set this advanced option to TRUE to
preserve the views of deleted parts and assemblies and to reserve the
multinumbers of the deleted parts and assemblies. Set it to FALSE to reuse
the multinumbers of the deleted assemblies and to delete the views. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_MULTIDRAWING_REMOVE_VIEW_LABEL_GAP

Category

Drawing Properties

Set this advanced option to TRUE to remove unnecessary space between the
drawing view label and the drawing view in multidrawings. If you do not want
to do this, use FALSE (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_MULTI_DRAWING_VIEW_PLACING_TRIAL_NUMBER

Category

This advanced option must be set in an initialization (.ini) file.

Use to define the number of attempts to place the drawing views into a
multidrawing. Enter an integer between 1 and 500. The advanced option is set
to 500 by default.

XS_MULTI_DRAWING_VIEW_TITLE

Category

Drawing properties

Use to define a title for a multidrawing view in a multidrawing. Arbitrary
strings and switches (BASE_NAME and NAME) can be used for defining the title.

By default the title is defined as follows:

Drawing %DRAWING_BASE_NAME%

This advanced option is model specific and the setting is saved in the options
database.

XS_MULTI_NUMBERING_INCLUDE_ASSEMBLY_PARTS

Category: Numbering

Set this advanced option to TRUE to include single parts in multinumbering. If
this advanced option is set to FALSE, single parts get multinumbers only if
they are included in an assembly drawing.
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The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_MULTIPLIER_SEPARATOR_FOR_MERGED_PART_MARK

Category

Marking: Parts

Use to define the separator in merged part marks. The default value is x.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_MULTIUSER_SAVE_REOPEN_DISABLE_COMPACTION

This advanced option must be set in an initialization (.ini) file. We
recommend that you use the options.ini file in the model folder.

Use this advanced option only if you frequently get the error The command
could not be completed, restart Tekla Structures and try
again. during saving a multi-user model. Set the value to TRUE to prevent the
error, and reopen the model. The default value is FALSE.

1.14 Advanced options - N

XS_MARK_INTELLIGENT_PLACING

Category: Marking: General

Marks are automatically placed according to the mark placing algorithm if the
advanced option XS_MARK_INTELLIGENT_PLACING is set to TRUE (default).
The mark placement algorithm tries to avoid crossing leader lines, and also
places marks otherwise more clearly.
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If you select all four corner points in the Part Mark Placing dialog box, the
automatic mark placement will be used, and Tekla Structures attempts to find
the closest quarter with empty space.

The new algorithm applies to all marks and associative notes, except weld
marks.

If XS_MARK_INTELLIGENT_PLACING is set to FALSE, you can still arrange
marks and notes using the following commands:

• You can arrange the selected marks and notes so that you avoid crossing
leader lines by using the Arrange marks command on the ribbon. The
result also depends on the defined protection settings and search margins.

• With another ribbon command Align marks --> Auto-align marks you can
align the selected marks and associative notes that are close by stacking
the marks and placing them evenly.

• You can also align selected marks around a point using the command Align
marks --> Align to a point. This command tries to avoid crossing leader
lines.

• These commands can also be started from Quick Launch.

This advanced option is model specific and the setting is saved in the options
database.

See also

Placement properties for marks, dimensions, notes, texts and symbols
(page 726)

XS_NEIGHBOUR_PART_SKEW_LIMIT

Category

Drawing Properties

Tekla Structures considers neighboring parts as skewed if the product of the
vector multiplication (part axis) (any of the coordinate axis) is less than 1-
XS_NEIGHBOUR_PART_SKEW_LIMIT. Enter the limit as a floating value, for
example 0.1 (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_NO_AUTO_DISPLAY_VIEWS

Category

Model View
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Set this advance option to TRUE to prevent Tekla Structures from displaying
views automatically when you start the program. Set it to FALSE (default) to
display the views automatically.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_NO_BOLT_ANGLE_DIMENSIONS

Category

Dimensioning: Bolts

To create angle dimensions for bolts, set this advanced option to FALSE. To
not create angle dimensions for bolts, select TRUE (default).

This advanced option is model specific and the setting is saved in the options
database.

XS_NO_CHAMFERS_IN_EXACT_MODE

Category

Model view

Set this advanced option to TRUE to prevent Tekla Structures from creating
chamfers in exact mode. To create the chamfers in exact mode, set it to 
FALSE.

By default chamfers are created. This advanced option only affects wire frame
views.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS

Category

Single Part View in Assembly Drawing

Set this advanced option to TRUE (default) to prevent Tekla Structures from
creating end views when you create an assembly drawing and choose to
include single-part drawings. If you do not want to do this, set it to FALSE.
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If you do not enter a value, Tekla Structures creates end views based on the
properties of the single-part drawings.

This advanced option is model specific and the setting is saved in the options
database.

XS_NO_RELATIVE_SHAPE_DIMENSIONS

Category

Dimensioning: Parts

Set this advanced option to TRUE to force shape dimensions to be the same as
the dimension type you select.

By default, automatic shape dimensions are always relative regardless of the
selected dimension type.

This advanced option does not affect single-part drawings. To affect single part
drawings, use the advanced option 
XS_SINGLE_NO_RELATIVE_SHAPE_DIMENSIONS.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_NO_RELATIVE_SHAPE_DIMENSIONS (page 405)

XS_NO_UNFOLDING_LINES_TO_DRAWINGS

Category

Dimensioning: Unfolding

Use to define whether unfolding lines are shown in drawings. When you set
the advanced option to TRUE, the unfolding lines are not shown. The default is 
FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_NO_SINGLE_PART_DRAWINGS_FOR

Category

Single Part View in Assembly Drawing
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Set as follows to prevent Tekla Structures producing single part drawings for
assemblies containing one part:

XS_NO_SINGLE_PART_DRAWINGS_FOR=LOOSE_PARTS
This advanced option is model specific and the setting is saved in the options
database.

XS_NORTH_MARK_SCALE

Category

Marking: Parts

Use this advanced option to define the scale of the north mark symbol. By
default, North marks have a scale of 1:1. You can also create a larger symbol
for north marks in the Symbol editor.

This advanced option is model specific and the setting is saved in the options
database.

XS_NORTH_MARK_SYMBOL

Category: Marking: Parts

By default the north mark symbol is number 32 in the symbol file 
xsteel.sym. Use this advanced option to change the symbol.

This advanced option is model specific and the setting is saved in the options
database.

See also

Show orientation marks (north marks)

XS_NSFS_POSTFIX_FOR_MERGED_PART_MARK

Category

Marking: Parts
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Use to define the postfix in merged part marks. This postfix is visible for
identical parts on both side of a main part. The default value is BS.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_NSFS_TEXT_POSITION_IN_PART_MARK

Category

Marking: parts

Defines which element the NS, FS or BS text follows in merged part marks.

The default is 23, which means that the text is located after part position. If the
type that is defined by the advanced option cannot be found in the mark at all,
the text is located at end of the mark. To force the text to always appear at the
end of the mark, use -1.

This advanced option is model specific and the setting is saved in the options
database.

For more information about the automatic merging of the part marks, see .

The following list contains the corresponding integer values and elements in
the mark:

TEXT = 1

LINE FEED = 2

SYMBOL = 3

FRAME START = 4

FRAME END = 5

MATERIAL = 10

USER DEFINED ATTRIBUTE = 16

ASSEMBLY_POSITION = 22

PART_POSITION = 23

PROFILE = 24

NAME = 25

LENGTH = 26

CAMBER = 27

SIZE = 28

FITTINGS (NS/FS) = 29
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CLASS = 38

BACK_SPACE = 46

GAGE OF OUTSTANDING LEG = 48

CENTER TO CENTER DISTANCE = 49

FACE_DIRECTION = 57

END OF Mark = -1

Example
XS_NSFS_TEXT_POSITION_IN_PART_MARK=22
The value 22 means after assembly position.

NOTE NS, FS and BS text itself comes from two separate places depending
on if the marks are merged or not. For ordinary marks, the text comes
from a file called by_number.ail (NS: by_number_msg_no_675, FS:
by_number_msg_no_676). For merged marks, the text comes from the
following advanced options:

• BS: XS_GET_NSFS_POSTFIX_FOR_MERGED_PART_MARK
• NS: XS_GET_NS_POSTFIX_FOR_MERGED_PART_MARK
• FS: XS_GET_FS_POSTFIX_FOR_MERGED_PART_MARK

XS_NS_POSTFIX_FOR_MERGED_PART_MARK

Category

Marking: Parts

Use to define the near side postfix in merged part marks. This postfix is visible
for identical parts on near side. The default value is NS.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_NUMBERING_RESULTS_DIALOG_DISPLAY_TIME

Category

Numbering
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Use to set the time frame within which Tekla Structures makes the second
save when numbering when you have selected the Synchronize with master
model (save-numbering-save) option in the Numbering setup dialog box.

Enter the desired time in seconds. The advanced option is set to 1500 by
default.

This advanced option is model specific and the setting is saved in the options
database.

See also

1.15 Advanced options - O

XS_OBJECT_SELECTION_CONFIRMATION

Category

Modeling Properties

Enter the time in milliseconds after which Tekla Structures prompts you to
cancel object selection. You can cancel the object selection process if the
selection takes longer than the defined time.

The default value is 5000.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_OBJECTLOCK_DEFAULT

Category

Modeling Properties

Set the default lock status for new assemblies or cast units when they are
created. Additionally, when you start to share the model in Tekla Model
Sharing, the default lock status is set for all assemblies and cast units that do
not yet have any lock status. The locked status is shown in the Locked value in
the Object locks dialog box. The value options are ORGANIZATION or NO.

This advanced option is system specific.
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XS_OMIT_MARKS_OF_HIDDEN_PARTS_IN_GA_DRAWINGS

Category

Marking: Parts

Set this advanced option to TRUE to hide part marks of parts hidden by other
parts from views in general arrangement drawings. The default value is FALSE.

If you have stiffeners on either side of a beam, one will be hidden by the beam
in front of it. Set this advanced option to TRUE to prevent Tekla Structures
from displaying the part mark of the hidden part.

This advanced option is model specific and the setting is saved in the options
database.

XS_OMIT_MARKS_OF_PARTS_OUT_OF_VIEW_PLANE_LIMIT_
ANGLE

Category

Marking: General

Use to hide the part marks for parts outside the current view plane by defining
the limit for inclusion as an angle. The default value is 20.0.

You also need to set Parts out of view plane option in the view level Part
mark properties dialog box to Not visible to hide parts from the views that
are outside the angle you specify here.

This advanced option is model specific and the setting is saved in the options
database.

See also

Mark properties - Content, General, Merging and Appearance tabs (page 678)

XS_OMITTED_BOLT_ASSEMBLY_TYPE

Category: Marking: Bolts

Use this advanced option to filter out the given type of bolt marks when the
Ignore size setting is set to a value in drawing bolt mark properties. The
options are:

• SITE (default)

• SHOP
• SITE_AND_SHOP.
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The default value SITE filters out only site bolt marks for bolts that meet the
Ignore size value, whereas workshop bolt marks of all sizes are shown in
drawings.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_OMITTED_BOLT_TYPE (page 320)

XS_OMITTED_BOLT_TYPE

Category: Marking: Bolts

Use this advanced option to define which bolt standards to omit from
drawings when a size has been defined for the Ignore size setting in drawing
bolt mark properties. Enter the name of the bolt standard, for example, 7990.
You can also use wildcards, such as * or ?. By default, no value is given, which
means that no bolt standards are omitted.

Example: First define a value to Ignore size. To filter away all the marks of
bolts of that size, and the marks of bolts of the bolt standards A325N, A325X
and A325SC, set this advanced option to A325*.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_OMITTED_BOLT_ASSEMBLY_TYPE (page 319)

XS_OMITTED_DIAMETER_TYPE (page 320)

XS_GA_OMITTED_DIAMETER_TYPE (page 255)

XS_OMITTED_DIAMETER_TYPE

Category

Marking: Bolts

Use to define the bolt diameter type of the marks to omit in drawings. The
options are HOLE or BOLT.

This advanced option is used together with the drawing bolt mark property
setting Ignore size. For example, to filter out all bolt marks of bolts that have a
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hole diameter 22, enter 22 as the value for Ignore size, and set this advanced
option to HOLE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_OMITTED_BOLT_TYPE (page 320)

XS_OMITTED_PART_NAME_IN_AUTOCONNECTION

Category

Components

Use to filter out specific part types when you use
AutoConnection.AutoConnection cannot handle brace connections when large
quantities of parts are selected.

This advanced option is model specific and the setting is saved in the options
database.

Example

If you want to use this advanced option to filter out brace parts, set it to 
brace. Tekla Structures does not select any parts with names containing the
string “brace”.

TIP You can also do this by setting the Selection Filter to select all parts
except for those named “brace*”.

XS_OMITTED_WELD_TYPE

Category

Welds

Use to define which weld types to omit in drawings. Enter the number of the
weld type you want to omit. The default value is 10 (fillet weld). For more
information about the weld types and the corresponding numbers, see List of
weld types.

In addition to this advanced option there are two other settings that Tekla
Structures uses to determine the welds that are shown in the drawing: 
XS_WELD_FILTER_TYPE tells if Tekla Structures should filter welds that are
exactly (EXACT) the size or of the same size or smaller (MIN) than the value
given in the Weld size limit box in the object or mark properties on the
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drawing view level. Tekla Structures always shows welds that have reference
text.

This advanced option is model specific and the setting is saved in the options
database.

Example

If you set XS_OMITTED_WELD_TYPE to 10, XS_WELD_FILTER_TYPE to EXACT,
and Weld size limit to 5, Tekla Structures shows all other welds except those
that are 5 mm, and those of type fillet weld (10). In this case, if you do not set 
XS_WELD_FILTER_TYPE, Tekla Structures shows all welds that are bigger than
5 mm except fillet welds.

See also

XS_WELD_FILTER_TYPE (page 478)

XS_OPEN_DRAWINGS_MAXIMIZED

Category

Drawing View

Set to TRUE to maximize drawings when you open them. The default is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_ORIENTATION_MARK_DIRECTION

Category

Marking: parts

Use to define the direction of orientation marks. The options are NORTH-EAST, 
NORTH-WEST, SOUTH-EAST and SOUTH-WEST. NORTH-EAST is the default
value.

This advanced option is model specific and the setting is saved in the options
database.

See also

Show orientation marks (north marks)

XS_NORTH_MARK_SYMBOL (page 315)
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XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS

Category

Marking: parts

Use to indicate the position of orientation marks for beams. Enter a value
indicating the distance from the end of the part to the orientation mark. The
default value is 300.0 mm. You can enter any value in the range 1.0 to 3000.0.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS_IN_GA

Category

Marking: Parts

Indicates the position of beam orientation marks in GA drawings. Enter a value
indicating the distance from the end of the part to the orientation mark. The
default value is 300.0 mm.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS (page 322)

XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS

Category

Marking: parts

Use to define the placing of orientation marks for columns. The value assigned
to this advanced option is the distance from the end of the part to the
orientation mark. The default value for columns is 300.0 mm. Possible values
range from 1.0 to 3000.0.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also
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XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS_IN_GA

Category

Marking: Parts

Defines the position of column orientation marks in GA drawings. The value
assigned to this advanced option is the distance from the end of the part to
the orientation mark. The default value is 300.0 mm.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also

XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS (page 323)

1.16 Advanced options - P

XS_PARAMETRIC_PROFILE_SEPARATOR

Category

Profiles

Use this advanced option to define an additional character to separate
dimensions in the name of parametric profiles. Tekla Structures always
recognizes the standard separator characters X, *, -, and /. The default value is
an asterisk (*).

For example, when you inquire a part with a sketched profile, the character
specified by this advanced option is used as the separator.

Example
XS_PARAMETRIC_PROFILE_SEPARATOR=E
Acceptable profile names with this setting are:

1. PL500*800

2. PL500X800

3. PL500E800

Any combination of these is also accepted: 
ProfileName500*500-500*500E500 (the profile ProfileName should be
defined).

Advanced options reference 324 Advanced options - P



Limitations

• Only one character is accepted as a value for this advanced option.

• You cannot use slash (/) in the US imperial environment.

See also

XS_USER_DEFINED_PARAMETRIC_PROFILE_SEPARATORS (page 468)

XS_PART_DIMENSION_PLANES_TABLE

Category

Dimensioning: Parts

Use to indicate the path to the user-defined part dimension planes table. This
table defines the planes in which dimensions are created. For example, you
might want Tekla Structures to dimension round bars to the middle of the
profile rather than the reference line.

You can also use a file name as a value. If the value is a file name, Tekla
Structures searches for the file in the model, project, firm and profile folders
(in this order).

This is a system-specific advanced option.

Example
XS_PART_DIMENSION_PLANES_TABLE=%XS_PROFDB%
\dim_planes_table.txt

See also

XS_PART_MERGE_MAX_DISTANCE

Category

Marking: Parts

Use to define the maximum distance within which identical parts get merged
marks. Units are in millimeters. The default value is 1200.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

See also
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XS_PART_MULTI_NUMBER_FORMAT_STRING

Category: Numbering

Use to define multinumbers for single parts. Use the following options to
define the contents of part marks. Use as many switches as you need, and
enclose each one in percent symbols (%).

The available options are:

Option Description
%PART_MULTI_DRAW
ING_NUMBER%

Multidrawing name.

%PART_MULTI_DRAW
ING_POS%

Position of the single-part drawing
inside the multidrawing.

%PART_PREFIX% Part prefix in the model.
%PART_POS% Part position number in the model.
Template fields Enter TPL: followed by the name of

any relevant template field. Enclose
each name in percent symbols (%).
For example, %TPL:PROJECT.NUMBER
%

User-defined
attributes that are
defined in the
objects.inp file

Enter UDA: followed by the name of
any relevant user-defined attribute,
exactly as it appears in the
objects.inp file. For example, 
%UDA:MY_INFO_1%

This advanced option is model specific and the setting is saved in the options
database.

Example

To put the part multinumbers in the format part prefix + position on
multidrawing + multidrawing name, set the advanced option as follows:

%PART_PREFIX%%PART_MULTI_DRAWING_POS%
%PART_MULTI_DRAWING_NUMBER%

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING (page 81)

XS_CAST_UNIT_MULTI_NUMBER_FORMAT_STRING (page 104)
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XS_PART_POSITION_NUMBER_FORMAT_STRING

Category: Numbering

Use to have Tekla Structures use only letters in part numbers.

NOTE The advanced options XS_ASSEMBLY_POSITION_NUMBER_FORMAT_
STRING (page 83) and XS_PART_POSITION_NUMBER_FORMAT_STRING
override the advanced option XS_SWITCH_POS_NUMBERS_FOR
(page 423). XS_SWITCH_POS_NUMBERS_FOR has no impact on
assembly and/or part position numbers if you use 
XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING and/or 
XS_PART_POSITION_NUMBER_FORMAT_STRING.

Enter any combination of the following options:

Option Description
%PART_PREFIX% Part prefix, defined in the part

properties in the property pane.
%PART_POS% Part position number, defined by the

start number (from part properties in
the property pane) and the final
position in that numbering series.

%PART_POS_WITH_LETTERS% Same as above, but with letters.

Uses letters A – Z by default, but you
can also define valid letters with the
advanced option 
XS_VALID_CHARS_FOR_PART_POSIT
ION_NUMBERS.

The position number/ letter switch can also include a suffix defining the
minimum number of digits (or letters), for example: %PART_POS.3%. This
example results in a first part number of 001, second 002 etc.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_VALID_CHARS_FOR_PART_POSITION_NUMBERS (page 471)

XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR

Category

Dimensioning: Parts
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Set this advanced option to TRUE to dimension the position of parts to the
edge that is nearest to the neighbor part. The default is FALSE.

In the image below, the neighbor parts in the model are blue, and the plate
creation points are shown.

For more information about using advanced options when adding dimensions
to plates, see .

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_PART_POSITION_TO_LEADING_EDGE

Category

Dimensioning: Parts

Set this advanced option to TRUE (default) to dimension the position of beams
to the leading edge. If you do not want to do this, set it to FALSE. For this
advanced option to take effect, disable the advanced option 
XS_USE_PLATE_SIDE_POSITIONING.
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For column assemblies, you must also set the advanced option 
XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO to TRUE.

For more information about using advanced options when adding dimensions
to plates, see Add dimensions to plates.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO (page 329)

XS_USE_PLATE_SIDE_POSITIONING (page 459)

XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO

Category

Dimensioning: Parts

To dimension part position to the leading edge for column assemblies, set this
advanced option to TRUE. If you do not want to do this, set it to FALSE. The
default value is TRUE.

You must also set the advanced option
XS_PART_POSITION_TO_LEADING_EDGE (page 328) to TRUE.

For more information about using advanced options when adding dimensions
to plates, see Add dimensions to plates.

This advanced option is model specific and the setting is saved in the options
database.

XS_PIXEL_TOLERANCE

Category

Model View

Use to define the snap zone of objects. Each object has a snap zone, which
defines how close you need to pick to hit a position. When you pick within the
snap zone of an object, Tekla Structures automatically snaps to the closest
pickable point on that object. Enter the value in pixels. The default value is 10.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_PLATE_ROUNDING_DECIMALS

Category

Plate Work

Use to define the maximum number of decimals in plate profile name created
by components. The default is 1.

Note that unnecessary zeroes are always left off, for example 10.501:

• with 2 decimals is 10.5

• with 3 decimals is 10.501

This advanced option is model specific and the setting is saved in the options
database.

The advanced option XS_MAX_DECIMALS_IN_PROFILE_NAME controls
decimals of plates that are modeled directly in the model.

See also

XS_MAX_DECIMALS_IN_PROFILE_NAME (page 299)

XS_PLOT_ORIGIN_MOVE_X

Category

This advanced option must be set in an initialization (.ini) file.

Offsets the print origin in the x direction. Use if a drawing does not fit to the
paper or is printed to a wrong location. Enter the value in millimeters as an
integer. This advanced option affects all printers. By default, this advanced
option is not set to any value.

NOTE If you set these advanced options in your initialization files, you will
override the Printer Catalog dialog box.

See also

XS_PLOT_ORIGIN_MOVE_Y (page 330)

XS_PLOT_ORIGIN_MOVE_Y

Category

This advanced option must be set in an initialization (.ini) file.

Offsets the print origin in the y direction. Use if a drawing does not fit to the
paper or is printed to a wrong location. Enter the value in millimeters as an
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integer. This advanced option affects all printers. By default, this advanced
option is not set to any value.

NOTE If you set these advanced options in your initialization files, you will
override the Printer Catalog dialog box.

See also

XS_PLOT_ORIGIN_MOVE_X (page 330)

XS_PLOT_VIEW_FRAMES

Category

Printing

To show drawing view frames in printed and exported drawings, set 
XS_PLOT_VIEW_FRAMES to TRUE. FALSE is the default value.

This advanced option is model specific and the setting is saved in the options
database.

PML_ASSEMBLY_MARKS_IN_USE

Category

Export

Set this advanced option to TRUE to have Tekla Structures use assembly marks
in PML exports. By default this advanced option is set to FALSE, which means
that Tekla Structures uses part marks.

This advanced option is model specific and the setting is saved in the options
database.

PML_CARDINAL_POINT_NOT_IN_USE

Category

Export

Set this advanced option to TRUE to prevent Tekla Structures from using
cardinal points in PML exports. This means that all parts will be defined by
their center lines, and their position may differ from that in the Tekla
Structures model. By default this advanced option is set to FALSE, which
means that cardinal points are used in PML export. The default value is FALSE.
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XS_PML_EXPORT_INCLUDE_GLOBAL_ID

Category

Export

Set this advanced option to TRUE to revert to the FrameWorksPlus ID number
in PML exports. If you do not want to export the ID number, set it to FALSE.
The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SDNF_IMPORT_STORE_MEMBER_NUMBER (page 379)

Export to CAD

XS_PML_EXPORT_USE_ADDITIONAL_CUT_DIST

Category

Export

Some earlier versions of Tekla Structures added 1 mm in length to fitted part
ends in PML exports. Set this advanced option to TRUE to force recent versions
to add the length. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_POINT_CLOUD_CACHE_FOLDER

Category: File Locations

Use this advanced option to define the folder where point cloud data is stored.
By default, the folder is %LocalAppData%\Trimble\Tekla Structures
\PointClouds, for example, C:\Users\<user>\AppData\Local\Trimble
\Tekla Structures\PointClouds.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_POINT_CLOUDS_WEB_CACHE

Category: File Locations

Use this advanced option to define the point cloud web streaming cache. By
default, the folder is %LocalAppData%\Trimble\Trimble Connect
\Import, for example, C:\Users\<user>\AppData\Local\Trimble
\Trimble Connect\Import.

XS_POLYBEAM_CHORD_TOLERANCE

Category: Speed and Accuracy

Use this advanced option to define the chord tolerance for curved polybeam
segments. Enter the value in millimeters. The default is 1.0.

Re-open the model to activate the new value.

NOTE Do not change the chord tolerance settings during a project. Changing
them automatically recreates the curved polybeams when you re-
open the model, resulting in slightly different solid objects, which may
affect numbering, or the concrete covers of rebar sets, for example.

The advanced option XS_POLYBEAM_MAX_ANGLE_BETWEEN_CS works as
limiting factor to XS_POLYBEAM_CHORD_TOLERANCE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_POLYBEAM_MAX_ANGLE_BETWEEN_CS (page 333)

XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS (page 114)

XS_POLYBEAM_MAX_ANGLE_BETWEEN_CS

Category

Speed and Accuracy

Use this advanced option to define the maximum angle between adjacent
cross sections in curved polybeam sections. Enter the value in degrees. The
default is 30.0.

This advanced option is model specific and the setting is saved in the options
database.
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XS_POLYBEAM_CURVATURE_TOLERANCE

Category

Modeling Properties

Use to define the tolerance used in detecting the curvature between three
points in a polybeam. The default is 2.0e-6.

This advanced option defines the difference in dot products between two unit
vectors formed by two consecutive polybeam arc chamfer handles. If the dot
product differs less than this value, the curve is considered to be a straight
line, and the arc chamfer is omitted.

Generally, you need to change the default value only if you are working with
long, thin or very complex polybeams. Change the default value in the
following situations:

• If the polybeam is only very slightly curved and it looks like a straight
polybeam in the model, you need to give a smaller value, such as 2.0e-10.
A larger value makes polybeams with only a slight curvature straight.

• If the value is unnecessarily small (smaller than default value for simple
polybeams), there might be performance issues.

• If the tolerance is set to a value that is too small (< e-11), the polybeam
may break.

XS_POLYGON_CUT_EXTRA_THICKNESS

Category

Modeling properties

Use this advanced option to define the cut depth of a polygon cut, for
example, to cut thick surface treatment. The default value for the cut thickness
is 5.0 mm.

XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR

Category

Plate Work

This advanced option is used to artificially manipulate which side of a plate is
considered as the 'longest'.

The longest side of polygon plates always faces downwards in drawings, which
can affect plates with perpendicular edges.
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This information can then be used, for example, in changing the rotation of a
plate in drawings, or when choosing which side of a plate is to be considered
the 'Length' and 'Width'.

This advanced option is used for plates with perpendicular sides in drawings.
This advanced option rotates plates if there is some edge which is
perpendicular to the current one and it is not adjacent edge.

The default value is 1.5.

In the example above, when you set 
XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR to 1, all sides are
multiplied by 1, and view restriction box is drawn according to the longest
side. The result is that the Length = 2715.02, and Width = 1046.94.

If you set this advanced option to 10, perpendicular corner edges A’ and B’ are
multiplied by 10. If the result is larger than the longest side C’, the view
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restriction box is drawn using the sides A’ and B’. The result would be Length =
2353.55, and Width = 1353.55.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR (page 336)

XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR

Category

Plate Work

This advanced option is used to artificially manipulate which side of a plate is
considered as the 'longest'.

In drawings, this advanced option is also used to control the rotation if right-
angled plates. The longest side of polygon plates always faces downwards in
drawings, which can affect right-angled plates.

This information can then be used, for example, in changing the rotation of a
plate in drawings, or when choosing which side of a plate is to be considered
the 'Length' and 'Width'.

This advanced option is used for plates that have two consecutive edges
perpendicular to each other. When this advanced option is set to a factor,
Tekla Structures multiplies the length of the side next to the right angle by that
factor, making it the longest side. In reports, this side will be then considered
the 'Length', and the corresponding perpendicular distance the 'Width'.
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Tekla Structures still uses and displays the real dimensions of the plate.

In the example above, when you set 
XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR to 1, all sides are
multiplied by 1, and the view restriction box is drawn according to the longest
side. The result is Length = 2715.02, and Width = 1173.35.

If you set this advanced option to 10, only square corner edges A and B are
multiplied by 10. If the result is larger than the largest side C, the view
restriction box is drawn using the sides A and B. The result would be Length =
2353.55, and Width = 1353.55.

The default value for this advanced option is 2.0.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR (page 334)
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XS_POP_MARK_COLOR

Category

Drawing Properties

Use to define the color of a customized pop-mark symbol that is displayed in a
drawing. Enter an integer. The default value is 1 (white). Other possible values
are:

Value Pop mark color
0 Black
2 Red
3 Green
4 Blue
5 Cyan
6 Yellow
7 Magenta

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_POP_MARK_SYMBOL (page 339)

XS_POP_MARK_HEIGHT (page 338)

XS_POP_MARK_HEIGHT

Category

Drawing Properties

Use to define the height of a customized pop-mark symbol that is displayed in
a drawing. Enter a decimal value in millimeters. The default is 2.0.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_POP_MARK_SYMBOL (page 339)

XS_POP_MARK_COLOR (page 338)
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XS_POP_MARK_SYMBOL

Category

Drawing Properties

Use to define the customized pop-mark symbol to be used for pop-marks in
drawings. The default is xsteel@0, which means that you are using symbol
number 0 in the symbol file xsteel.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_POP_MARK_HEIGHT (page 338)

XS_POP_MARK_COLOR (page 338)

XS_POSITION_DIMENSIONS_FOR_HOLES
_IN_SINGLE_SECONDARY_PARTS_IN_ASSEMBLY_DRAWING

Category

Dimensioning: Bolts

To create position dimensions for holes in single secondary parts in assembly
drawing, set this advanced option to TRUE. To not create position dimensions
for holes, set it to FALSE. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_POUR_BREAK_COLOR

Category: Concrete Detailing

Use this advanced option to change the color of pour breaks in model views.
Enter number as the value using the class numbers in the part property pane
to indicate the color. For example, if you set this advanced option to 6, Tekla
Structures will color all pour breaks yellow. The default value is 59.
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In the exported IFC models, pour breaks are black.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_POUR_OBJECT_COLOR (page 340)

XS_INVALID_POUR_BREAK_COLOR (page 276)

XS_POUR_BREAK_SYMBOL

Category

Drawing Properties

Pour breaks are represented by a symbol in the drawings, see the image
below. The symbol scale and the spacing between the symbols follows the
drawing view scale automatically.

If you want to change the pour break symbol, enter a new value for this
advanced option. The default value is PourBreaks@0. The symbol value starts
with the symbol library file name and ends with the number of the symbol.
The default library may contain many different pour break symbols. If you
wish to use a symbol file that is not located under your environment folders,
enter the complete path to the symbol file location and the symbol file name.

This advanced option is model specific and the setting is saved in the options
database.

XS_POUR_OBJECT_COLOR

Category: Concrete Detailing

Use this advanced option to change the default color of pour objects in model
views. Enter number as the value using the class numbers in the part property
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pane to indicate the color. For example, if you set this advanced option to 6,
Tekla Structures will color all pour objects yellow.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_POUR_BREAK_COLOR (page 339)

XS_PRINT_MULTISHEET_BORDER

Category

Drawing Properties

Use to define the borders that are left out from the smaller sheets when
printing a drawing on multiple small sheets.

For example, to leave a 3 mm horizontal and a 5 mm vertical border, set the
advanced option to 3,5.

XS_PRINT_REPORT_FONT

Category

Templates and Symbols

Define the font for printed reports. Tekla Structures uses this advanced option
if you do not specify another font for printed reports in the Print dialog box.
The default value is Arial Narrow. If you do not enter a font, Tekla
Structures uses the default font defined for XS_DEFAULT_FONT.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_PRINT_REPORT_LINE_WIDTH_LANDSCAPE

Category

Templates and symbols

Use to specify the number of characters per row in reports printed in
landscape orientation. The default value is 132.

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_PRINT_REPORT_LINE_WIDTH_PORTRAIT (page 342)

XS_PRINT_REPORT_PAGE_HEIGHT_LANDSCAPE (page 342)

XS_PRINT_REPORT_PAGE_HEIGHT_PORTRAIT (page 342)

XS_PRINT_REPORT_LINE_WIDTH_PORTRAIT

Category

Templates and symbols

Use to specify the number of characters per row in reports printed in portrait
orientation. the default value is 80.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PRINT_REPORT_LINE_WIDTH_LANDSCAPE (page 341)

XS_PRINT_REPORT_PAGE_HEIGHT_LANDSCAPE (page 342)

XS_PRINT_REPORT_PAGE_HEIGHT_PORTRAIT (page 342)

XS_PRINT_REPORT_PAGE_HEIGHT_LANDSCAPE

Category

Templates and symbols

Use to specify the number of rows in printed reports with landscape
orientation. The default value is 42.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PRINT_REPORT_LINE_WIDTH_LANDSCAPE (page 341)

XS_PRINT_REPORT_LINE_WIDTH_PORTRAIT (page 342)

XS_PRINT_REPORT_PAGE_HEIGHT_PORTRAIT (page 342)
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XS_PRINT_REPORT_PAGE_HEIGHT_PORTRAIT

Category

Templates and symbols

Use to specify the number of rows in printed reports with portrait orientation.
The default value is 62.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PRINT_REPORT_LINE_WIDTH_LANDSCAPE (page 341)

XS_PRINT_REPORT_LINE_WIDTH_PORTRAIT (page 342)

XS_PRINT_REPORT_PAGE_HEIGHT_LANDSCAPE (page 342)

XS_PRODUCT_IDENTIFIER

Category: Drawing View

To make it clear with which software a project has been modeled (old XSteel,
other detailing systems or Tekla Structures) and reinforce the Tekla Structures
brand, you can add a Tekla Structures product identifier to the side of every
drawing. The product identifier will help promote the image of your company
as a forward thinking company that uses the latest and most advanced
technologies and techniques.

You can use the following values to change the position of the product
identifier or turn it off: DX and DY offset, FALSE, and TRUE (default).

• If you do not want to use the product identifier, set this advanced option to 
FALSE.

• If you want to move the identifier, enter millimeter values separated by a
comma (,) for both the X and Y directions.

For example, -5,10 will move the text 5 millimeters to the left and 10
millimeters up.

This advanced option is model specific and the setting is saved in the options
database.
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XS_PROFDB

Category

File Locations

Use to point to the profile folder which Tekla Structures searches for profile,
material, device, and bolt catalogs.

You can store several catalogs in different locations, so it is important to know
which catalog you are using.

This is a system-specific advanced option.

See also

XS_PROFILE_ANALYSIS_CHECK_ALL

Category: Analysis & Design

In the Modify Profile Catalog dialog box, you can enter analysis values for
each profile. When you run the structural analysis, the analysis applications
that use the COM link calculate the analysis values and compare them to the
values in the Tekla Structures profile catalog. If the analysis application finds
the values in the profile catalog, it uses the catalog values.

To check the profile catalog for analysis values for all profiles, enter TRUE for
the following advanced options before you run the analysis:

• XS_PROFILE_ANALYSIS_CHECK_ALL
• XS_AD_OPTIMISATION_DISABLED
The default value is FALSE.
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This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

If the profile catalog value differs significantly from the value the analysis
application calculates, Tekla Structures writes a warning in the analysis log file.
Use the advanced option XS_PROFILE_ANALYSIS_VALUE_DIFF_LIMIT to
define the warning limit.

See also

XS_PROFILE_ANALYSIS_VALUE_DIFF_LIMIT (page 345)

XS_AD_OPTIMISATION_DISABLED (page 63)

XS_PROFILE_ANALYSIS_VALUE_DIFF_LIMIT

Category

Analysis & Design

Sets the warning limit as a percentage when checking profile catalog analysis
values. The default value is 5.5 (%).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_PROFILE_ANALYSIS_CHECK_ALL (page 344)

XS_PROFILE_DISPLAY_INCH_MARK_AFTER_FRACTIONS_IN_
REPORTS

Category

Imperial Units

Use to define the location of the inch mark in profile lengths in reports.

To display the inch mark after the fractions (for example, PL1"X18 1/2"), enter 
TRUE. To display the inch mark before the fractions (for example,
PL1"X18"1/2), enter FALSE.

The inch mark is displayed after the fractions by default (TRUE).

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XSR_SHOW_INCH_MARK_IN_PROFILE_NAMES (page 397)
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XS_PROJECT

Category

File Locations

NOTE This advanced option is only meant for administrators.

Set the advanced options XS_PROJECT and XS_FIRM, along with XS_SYSTEM,
to point to the folders Tekla Structures searches for properties files. Tekla
Structures always saves properties in the current model\attributes folder.
You can then copy or move them to the XS_FIRM or the XS_PROJECT folders if
the same settings are needed in other models. You can also create user-
defined sub-folders under the XS_FIRM and the XS_PROJECT folders, and
copy or move property files from the model\attributes folder to these sub-
folders.

For shared models, you can use a sub-folder in a Trimble Connect project as
the project folder. For more information, see -

This advanced option is model specific and the setting is saved in the options
database.

WARNING Changing an advanced option value in .ini files located outside
the model folder does not affect the existing models. You can
only update advanced options in the Advanced Options dialog
box or in the options.ini file located in model folder; not from
an options.ini file located in folders defined for the advanced
options XS_FIRM or XS_PROJECT. The .ini files are read also
when you open an existing model, but only new advanced
options that do not exist in options_model.db or
options_drawings.db are inserted, for example, such options
that are not yet in the Advanced Options dialog box but have
been added in the software.

See also

XS_PROTECT_SYMBOLS

Category

Drawing Properties
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Set this advanced option to TRUE to prevent Tekla Structures from drawing
objects on top of symbols. If you set it to FALSE, symbols are not protected.
The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

1.17 Advanced options - R

XS_RADIUS_TEXT_IN_UNFOLDING_BENDING_LINE_
DIMENSIONING

Category: Dimensioning: unfolding

Use to set prefix text for radii. Enter any text, for example, R=. By default there
is no prefix for radius in bending line dimensioning

This advanced option is model specific and the setting is saved in the options
database.

XSR_BOLT_LENGTH_USE_ONLY_INCHES

Category

Templates and symbols

Set this advanced option to TRUE to prevent the advanced option 
XSR_USE_ZERO_FEET_VALUE from affecting bolt length in bolt marks. If you
want XSR_USE_ZERO_FEET_VALUE to affect bolt length in bolt marks, set it to 
FALSE. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XSR_USE_ZERO_FEET_VALUE (page 376)

XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE

Category

Concrete Detailing
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Use to increase the size of the reinforcing bar bend symbols in drawings (in
drawing units) in order to see them more clearly. The default value is 1.

The value set for this advanced option is multiplied by the view scale. If the
resulting value is bigger than the default size (diameter of the reinforcing bar),
then it will be used as the symbol size. Otherwise the default value is used.
This means that to make the symbol as small as possible, leave the value out
or use zero (0).

This advanced option can be used together with the advanced option 
XS_REBAR_END_SYMBOL_MIN_SIZE, which is used for increasing the size of
the reinforcing bar end symbols.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBAR_END_SYMBOL_MIN_SIZE (page 349)

XS_REBAR_COMBINE_BENDINGS_IN_EVALUATOR

Category: Concrete Detailing

Use this advanced option to control how multiple sequential bendings in
reinforcing bars are handled in Rebar shape manager.

When this advanced option is set to TRUE (which is the default value), multiple
sequential bendings that form an arc are combined into one or more bendings
(90 degrees or less) with the arc radius. This makes it possible to define bar
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bending shapes containing a large radius bending no matter how many
individual bendings appear in the original bar geometry.

When the advanced option is set to TRUE, you can use the Curve tolerance
setting in Rebar shape manager to define whether bendings are combined.

If you set the advanced option to FALSE, or if Curve tolerance is set to 0,
bendings are not combined, but they appear as multiple bendings.

This advanced option is model specific and the setting is saved in the options
database.

XS_REBAR_DIMENSION_LINE_SYMBOL

Category

This advanced option must be set in an initialization (.ini) file. Add this
advanced option in the options.ini file under model folder.

Use this advanced option to change the reinforcing bar group dimension
(distribution) line symbol. You can create the dimension line by right-clicking
the reinforcing bar group and selecting Create dimension line. The default
value is xsteel@16, wherexsteel is the name of the symbol file and 16 is the
running number of the symbol.

See also

XS_REBAR_END_SYMBOL_MIN_SIZE

Category

Concrete Detailing
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Use to increase the size of the reinforcing bar end symbols in drawings (in
drawing units) in order to see them more clearly. Works for 45 or 135 degree
symbols. The default value is 2.

The value set for this advanced option is multiplied by the view scale. If the
resulting value is bigger than the default size (diameter of the reinforcing bar),
then it will be used as the symbol size. Otherwise the default value is used.
This means that to make the symbol as small as possible, leave the value out
or use zero (0).

This advanced option can be used together with the advanced option 
XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE, which is used for increasing the
size of the reinforcing bar bend symbols.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBAR_REVERSE_END_SYMBOLS (page 354)

XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE (page 347)
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XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_STEP_
LENGTH

Category

Concrete Detailing

Use to define the step length while searching for an optimal place for the
rebar mark leader line base point along the reinforcing bar. Enter the value in
millimeters using decimals. The default value is 20.0.

This advanced option is model specific and the setting is saved in the options
database.

XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_
TOLERANCE

Category

Concrete Detailing

Use to define how far the other reinforcing bars must be from the base point
so that Tekla Structures can place the base point. Enter the value in
millimeters using decimals. The default value is 10.0.

This advanced option is model specific and the setting is saved in the options
database.

XS_REBAR_MINIMUM_LEG_DEVIATION

Category: Concrete Detailing

Use this advanced option to define whether rounding settings are applied to
certain reinforcing bar legs or not.

Tekla Structures compares each bar leg to a straight line. If the deviation of a
leg from the line is less than the value of this advanced option, the leg is
considered to be a part of a curved bar segment and the leg length is not
rounded.

If the deviation is more than the value of this advanced option, Tekla
Structures considers the leg to be a straight bar segment and then rounds the
leg length according to the rounding settings.

Enter the value in millimeters. The default value is 10.

This advanced option is model specific and the setting is saved in the options
database.
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XS_REBAR_POSITION_NUMBER_FORMAT_STRING

Category: Numbering

Use to define the contents of the reinforcing bar position numbers. You can
also change or remove the separator and affect how many numbers are used
to represent the reinforcing bar position number. If you change the value, you
need to renumber the model.

Use the following options or a combination of them:

Option Description
%PART_PREFIX% The prefix of the position number of the part

that contains the reinforcing bar.
%PART_START_NUMBER% The start number of the position number of the

part that contains the reinforcing bar.
%REBAR_PREFIX% The prefix of the position number of the

reinforcing bar.
%REBAR_SERIAL_NUMBER% The position number without the prefix of the

reinforcing bar.
%REBAR_POS% This is no longer used. Use 

%REBAR_SERIAL_NUMBER% instead.
%REBAR_SIZE% The size of the reinforcing bar with the possible

size prefix.

For example, in the US environments the size
prefix is #.

%REBAR_SIZE_NUMBER% The size of the reinforcing bar without the size
prefix.

%CAST_UNIT_PREFIX% The prefix of the position number of the cast
unit that contains the reinforcing bar.

%CAST_UNIT_START_NUMB
ER%

The start number of the position number of the
cast unit that contains the reinforcing bar.

This advanced option is model specific and the setting is saved in the options
database.

Example

The Prefix in the Reinforcing Bar Properties dialog box is set to R, the Start
No is set to 1, and the Size is set to #6.

• If you set the advanced option to %REBAR_SIZE%%REBAR_PREFIX%
%REBAR_SERIAL_NUMBER.3%, the result for the first reinforcing bar will be 
#6R001.
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• If you set the advanced option to %REBAR_SIZE_NUMBER%%REBAR_PREFIX
%%REBAR_SERIAL_NUMBER.3% and number the model, the result for the
first reinforcing bar is 6R001.

XS_REBAR_PULLOUT_ANGLE_TEXT_FRAME

Category

Concrete Detailing

Use to turn off the text frame around the angle text in pull-out pictures. By
default, this advanced option is set to FALSE, and no frame is drawn. If you set
this advanced option to TRUE, the frame is drawn.

If you have set XS_REBAR_PULLOUT_ANGLE_TEXT_UNDERLINE to TRUE, then
the advanced option XS_REBAR_PULLOUT_ANGLE_TEXT_FRAME is ignored.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBAR_PULLOUT_ANGLE_TEXT_UNDERLINE (page 353)

XS_REBAR_PULLOUT_ANGLE_TEXT_UNDERLINE

Category

Concrete Detailing

Set this advanced option to TRUE to draw an line under the angle text in pull-
outs. If you set it to TRUE, then the advanced option 
XS_REBAR_PULLOUT_ANGLE_TEXT_FRAME is ignored. By default, this
advanced option is set to FALSE, and no underline is drawn.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBAR_PULLOUT_ANGLE_TEXT_FRAME (page 353)

XS_REBAR_RECOGNITION_HOOKS_CONSIDERATION

Category

Concrete Detailing
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Set to FALSE to have Tekla Structures ignore hooks when it checks the shape
of reinforcing bars, and to have Tekla Structures assign the same bending type
to bars with and without hooks.

Set to TRUE to have Tekla Structures take the hooks into account and to treat
bars with or without hooks, or with different hooks, as different.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBAR_REVERSE_END_SYMBOLS

Category: Concrete Detailing

Use to reverse the reinforcing bar end symbols to a different direction. When
this advanced option is set to TRUE, the end symbol is drawn at 135 degree
angle (used commonly in Norway). If you use single line visualization and no
symbol at straight end, use the value TRUEANDEXTEND. If you use TRUE for
these kinds of reinforcing bars, they will be drawn too short. The default value
is FALSE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.
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See also

XS_REBAR_END_SYMBOL_MIN_SIZE (page 349)

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 714)

XS_REBARSET_BUFFER_SIZE

Category: Speed and Accuracy

This advanced option defines the size of the memory cache used to store
rebar set bars. When you increase the size, more rebar set bars can be kept in
memory. This means that the rebar set bars are not regenerated so
frequently, which will improve the performance. For optimum performance,
the size should be greater or equal to the number of rebar set bars in the
model.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_REBARSET_COLOR_BARGROUPS

Category: Concrete Detailing

Set this advanced option to TRUE to show bar groups within a rebar set using
different colors in model views. For example:

When you set this advanced option to TRUE, the reinforcing bars in rebar sets
will not be colored by class.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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After changing the setting of this advanced option in the Advanced Options
dialog box, redraw the model views.

TIP To quickly switch between the values TRUE and FALSE, go to the
Concrete tab on the ribbon and click Rebar display options --> Color
rebar groups , or use the keyboard shortcut Alt+7.

XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_
CROSSING_REBARS

Category: Concrete Detailing

Use this advanced option to define the tolerance for the angle between
consecutive part faces when the rebar set bars are created. If the angle
between a part face and the extension of the previous part face is less than
the value of this advanced option, a rebar set leg face is created at the part
face.

This advanced option applies to the rebar sets when they are created using
the Create crossing rebars command. The default value is 45 (degrees).

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_LONGITUDINAL_REBARS
(page 356)

XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_
LONGITUDINAL_REBARS

Category: Concrete Detailing

Use this advanced option to define the tolerance for the angle between
consecutive part faces when the rebar set bars are created. If the angle
between a part face and the extension of the previous part face is less than
the value of this advanced option, a rebar set leg face is created at the part
face.

This advanced option applies to the rebar sets when they are created using
the Create longitudinal rebars command. The default value is 45 (degrees).

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_CROSSING_REBARS
(page 356)

XS_REBARSET_ENABLE_BAR_GROUPING_WHEN_SPACING_
DIFFERS

Category: Concrete Detailing

Use this advanced option to define whether spacing affects how reinforcing
bars are grouped in rebar sets. This advanced option only applies to the bar
groups of type Normal. Adjacent tapered bar groups with different spacing
are not grouped.

The default value is TRUE, which means that similar bars in adjacent spacing
zones in a rebar set are grouped even when the spacing differs.

If this advanced option is set to FALSE, each spacing zone in a rebar set
automatically creates a separate group.

This advanced option is model specific and the setting is saved in the options
database.

After changing the setting of this advanced option, you need to update the
existing rebar sets in the model. Click Concrete --> Rebar set --> Regenerate
rebar sets to activate the new setting.

XS_REBARSET_REBAR_LAYER_FORMAT_STRING

Category: Concrete Detailing

Use this advanced option to define the contents of the template attribute
LAYER (page 540).

The default value is %LAYER_PREFIX%%LAYER_NUMBER%, for example T2 for
the second layer of top bars.

This advanced option is model specific and the setting is saved in the options
database.

See also

LAYER_PREFIX (page 541)

LAYER_NUMBER (page 540)
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XS_REBARSET_SHOW_END_DETAIL_MODIFIERS

Category: Concrete Detailing

Set this advanced option to TRUE to show the rebar set end detail modifiers
when you select rebar set bars in the model.

If this advanced option is set to FALSE, end detail modifiers are not shown
when you select rebar set bars.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

TIP To quickly switch between the values TRUE and FALSE, go to the
Concrete tab on the ribbon and click Rebar display options --> End
detail modifier visibility , or use the keyboard shortcut Alt+5.

See also

XS_REBARSET_SHOW_PROPERTY_MODIFIERS (page 359)

XS_REBARSET_SHOW_SPLITTERS (page 360)

XS_REBARSET_SHOW_GUIDELINES (page 358)

XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_COMPONENTS (page 359)

XS_REBARSET_SHOW_GUIDELINES

Category: Concrete Detailing

Set this advanced option to TRUE to show the rebar set guidelines when you
select rebar set bars in the model.

If this advanced option is set to FALSE, rebar set guidelines are not shown
when you select rebar set bars.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

TIP To quickly switch between the values TRUE and FALSE, go to the
Concrete tab on the ribbon and click Rebar display options -->
Guideline visibility , or use the keyboard shortcut Alt+2.

See also

XS_REBARSET_SHOW_PROPERTY_MODIFIERS (page 359)

XS_REBARSET_SHOW_END_DETAIL_MODIFIERS (page 357)
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XS_REBARSET_SHOW_SPLITTERS (page 360)

XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_COMPONENTS (page 359)

XS_REBARSET_SHOW_LEGFACES

Category: Concrete Detailing

Set this advanced option to TRUE to show the rebar set leg faces when you
select rebar set bars in the model.

If this advanced option is set to FALSE, leg faces are not shown when you
select rebar set bars.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

TIP To quickly switch between the values TRUE and FALSE, go to the
Concrete tab on the ribbon and click Rebar display options --> Leg
face visibility , or use the keyboard shortcut Alt+1.

XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_
COMPONENTS

Category: Concrete Detailing

Use this advanced option to control whether the rebar set modifiers that are
created by components are shown or hidden in model views when you select
rebar set bars.

The default value is FALSE, which means that the modifiers are hidden.

Note that if you explode a component that has modifiers, the modifiers will be
shown even if this advanced option is set to FALSE.

This advanced option does not affect the custom component views.

This advanced option is model specific and the setting is saved in the options
database.
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XS_REBARSET_SHOW_PROPERTY_MODIFIERS

Category: Concrete Detailing

Set this advanced option to TRUE to show the rebar set property modifiers
when you select rebar set bars in the model.

If this advanced option is set to FALSE, property modifiers are not shown
when you select rebar set bars.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

TIP To quickly switch between the values TRUE and FALSE, go to the
Concrete tab on the ribbon and click Rebar display options -->
Property modifier visibility , or use the keyboard shortcut Alt+3.

See also

XS_REBARSET_SHOW_END_DETAIL_MODIFIERS (page 357)

XS_REBARSET_SHOW_SPLITTERS (page 360)

XS_REBARSET_SHOW_GUIDELINES (page 358)

XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_COMPONENTS (page 359)

XS_REBARSET_SHOW_SPLITTERS

Category: Concrete Detailing

Set this advanced option to TRUE to show the rebar set splitters when you
select rebar set bars in the model.

If this advanced option is set to FALSE, splitters are not shown when you
select rebar set bars.

The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

TIP To quickly switch between the values TRUE and FALSE, go to the
Concrete tab on the ribbon and click Rebar display options --> Splitter
visibility , or use the keyboard shortcut Alt+4.

See also

XS_REBARSET_SHOW_PROPERTY_MODIFIERS (page 359)

XS_REBARSET_SHOW_END_DETAIL_MODIFIERS (page 357)
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XS_REBARSET_SHOW_GUIDELINES (page 358)

XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_COMPONENTS (page 359)

XS_REBARSET_TAPERED_GROUP_POSITION_NUMBER_
FORMAT_STRING

Category: Numbering

Use this advanced option to define the contents of the reinforcement position
numbers (GROUP_POS (page 527)) in tapered bar groups within rebar sets.
You can also change or remove the separator and affect how many numbers
are used to represent the position number. If you change the value, you need
to renumber the model.

Use the following options or a combination of them:

Option Description
%PART_PREFIX% The prefix of the position number of the part

that contains the reinforcing bar.
%PART_START_NUMBER% The start number of the position number of the

part that contains the reinforcing bar.
%REBAR_PREFIX% The prefix of the position number of the

reinforcing bar.
%REBAR_SERIAL_NUMBER% The position number without the prefix of the

reinforcing bar.
%REBAR_POS% This is no longer used. Use 

%REBAR_SERIAL_NUMBER% instead.
%REBAR_SIZE% The size of the reinforcing bar with the possible

size prefix.

For example, in the US environments the size
prefix is #.

%REBAR_SIZE_NUMBER% The size of the reinforcing bar without the size
prefix.

%CAST_UNIT_PREFIX% The prefix of the position number of the cast
unit that contains the reinforcing bar.

%CAST_UNIT_START_NUMB
ER%

The start number of the position number of the
cast unit that contains the reinforcing bar.

The default value is %REBAR_PREFIX%%REBAR_SERIAL_NUMBER%.

This advanced option is model specific and the setting is saved in the options
database.
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Example

The Prefix in the rebar set properties is set to R, the Start number is set to 1,
and the Size is set to #6.

• If you set the advanced option to %REBAR_SIZE%%REBAR_PREFIX%
%REBAR_SERIAL_NUMBER.3%, the result for the first reinforcing bar will be 
#6R001.

• If you set the advanced option to %REBAR_SIZE_NUMBER%%REBAR_PREFIX
%%REBAR_SERIAL_NUMBER.3% and number the model, the result for the
first reinforcing bar is 6R001.

See also

XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_FORMAT_STRING
(page 362)

XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_
FORMAT_STRING

Category: Numbering

Use this advanced option to define the contents of the reinforcement position
numbers (REBAR_POS (page 561)) of single bars in tapered bar groups within
rebar sets. You can also change or remove the separator and affect how many
numbers are used to represent the position number. If you change the value,
you need to renumber the model.

Use the following options or a combination of them:

Option Description
%PART_PREFIX% The prefix of the position number of the part

that contains the reinforcing bar.
%PART_START_NUMBER% The start number of the position number of the

part that contains the reinforcing bar.
%REBAR_PREFIX% The prefix of the position number of the

reinforcing bar.
%REBAR_SERIAL_NUMBER% The position number without the prefix of the

reinforcing bar.
%REBAR_POS% This is no longer used. Use 

%REBAR_SERIAL_NUMBER% instead.
%REBAR_SIZE% The size of the reinforcing bar with the possible

size prefix.

For example, in the US environments the size
prefix is #.
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Option Description
%REBAR_SIZE_NUMBER% The size of the reinforcing bar without the size

prefix.
%CAST_UNIT_PREFIX% The prefix of the position number of the cast

unit that contains the reinforcing bar.
%CAST_UNIT_START_NUMB
ER%

The start number of the position number of the
cast unit that contains the reinforcing bar.

%SUB_ID% The running index number of the reinforcing
bar in a tapered bar group within a rebar set.

%SUB_ID_WITH_LETTERS% Same as above, but with letters.

Uses letters A–Z by default, but you can also
define the valid letters with the advanced
option XS_VALID_CHARS_FOR_REBAR_SUB_ID_
WITH_LETTERS (page 471).

The default value is %REBAR_PREFIX%%REBAR_SERIAL_NUMBER%.%SUB_ID%.

This advanced option is model specific and the setting is saved in the options
database.

Example

The Prefix in the rebar set properties is set to R, the Start number is set to 1,
and the Size is set to #6.

• If you set the advanced option to %REBAR_SIZE%%REBAR_PREFIX%
%REBAR_SERIAL_NUMBER.3%, the result for the first reinforcing bar will be 
#6R001.

• If you set the advanced option to %REBAR_SIZE_NUMBER%%REBAR_PREFIX
%%REBAR_SERIAL_NUMBER.3% and number the model, the result for the
first reinforcing bar is 6R001.

See also

XS_REBARSET_TAPERED_GROUP_POSITION_NUMBER_FORMAT_STRING
(page 361)

XS_REBARSET_USE_GROUP_NUMBER_FOR_BARS_IN_
TAPERED_GROUPS

Category: Numbering

Use this advanced option to define whether reinforcing bars in tapered bar
groups within rebar sets are numbered using their group numbers, or as
individual bars.
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The default value is TRUE, which means that each bar in a tapered bar group is
numbered using the group number.

If this advanced option is set to FALSE, bars in tapered bar groups are
numbered as individual bars.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_REBARSET_TAPERED_GROUP_POSITION_NUMBER_FORMAT_STRING
(page 361)

XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_FORMAT_STRING
(page 362)

XS_REBAR_USE_ALWAYS_METHOD_A_FOR_90_DEGREE_HOOK_
DIMENSIONS

Category

This advanced option must be set in an initialization (.ini) file.

When set to TRUE, the SHLB/EHLB hook properties will have the same values
as the SHLA/EHLA properties in case the hook angle is approximately 95
degrees or less.

XS_RECREATE_MARKS_IN_INTELLIGENT_CLONING

Category

Marking: General

Set this advanced option to ALL to recreate all marks during intelligent cloning.
If you leave the value out, marks are not recreated. By default, no value is set.

This advanced option is model specific and the setting is saved in the options
database.

XS_RECREATE_UNMODIFIED_DRAWINGS

Category: Drawing Properties

Use to define whether drawings are recreated when you update an assembly,
single or cast unit drawing that has not been modified. Drawings are
automatically recreated unless they have been edited and then saved, or they
have been issued using the Issue functionality in Document manager.
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• To prevent the recreation of the unmodified drawings, set the advanced
option FALSE.

• To allow the recreation of the unmodified drawings, set the advanced
option to TRUE. This is the default value.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_REFERENCE_CACHE

Category

File Locations

Use to define the default location of the cache file that is created from the
source file when you load a reference model for the first time. The advanced
option is set to C:\TeklaStructuresModels\\RefCacheFolders by
default. You can also replace the path with XS_RUNPATH as follows: 
%XS_RUNPATH%\RefCacheFolders.

TIP • You may sometimes want to change the default location of the cache
file when you are working with multi-user models to reduce network
traffic and disk usage in the server or to speed up the cache
operation (if the local drive is faster than the server drive).

• When you are using different versions of Tekla Structures for
different projects and you experience problems with reference
models, empty the folder where the reference cache is created. The
cache file is recreated the next time you open the reference model.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT

Category: Modeling Properties

Use the XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT advanced option to
clean up old reference model revisions automatically. The cleanup is done
when the reference file is updated. Use 
XS_DELETE_UNNECESSARY_REFMODEL_FILES_SAFETY_PERIOD (page 142)
to set the time frame for deletion. Tekla Structures deletes the reference
models that have been imported at some point but are no longer used, and
are not displayed in the Reference Models list. The data related to these
reference models is deleted from the current data storage in folder <current
model>\datastorage\ref. The original imported reference model is not
deleted from its actual folder, for example, from .\Reference models.
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You can use the following values:

• 0: The cleanup is disabled. This is the default value.

• Any positive number.

For example, value 3 keeps two old revisions of the reference model, in
addition to the current version.

This advanced option is model specific and the setting is saved in the options
database.

XS_REFERENCE_USE_RENDERED_CLIPPING

Category

Import

Set to TRUE to have Tekla Structures show only the center line of reference
objects outside the work area in model views. This can be useful, for example,
when viewing cylindrical DGN structures, such as piping. If you do not want to
show only center line, set it to FALSE. The default value is TRUE. I

Tekla Structures then shows the objects as follows:

• Objects entirely inside work area are rendered.

• Objects entirely outside work area are hidden.

• Objects partly inside the work area are rendered inside work area, and
wireframe outside work area.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS

Category: Import

Set the advanced option XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS to 

TRUE to refresh locked reference models with the Refresh button . This
advanced option is by default set to FALSE.

This advanced option is system specific.
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XS_REMEMBER_LAST_PLOT_DIALOG_VALUES

Category

This advanced option must be set in an initialization (.ini) file.

If you set this advanced option to TRUE, Tekla Structures remembers the latest
settings that were used in the Print Drawings dialog box when you open the
dialog box the next time. If you do not want to do this, enter false. The
default value is TRUE.

XS_REMOVE_VOID_FROM_BOLT_MATERIAL_THICKNESS

Category: Modeling Properties

Set this advanced option to TRUE to remove the gap between two bolted
material thicknesses, resulting in a shorter bolt length. This is required by, for
example, mast builders. The default value is FALSE.

In the example below, the advanced option is set to TRUE. The value "X" will be
removed from the bolt length.

This advanced option is model specific and the setting is saved in the options
database.

XS_RENDERED_CURSOR_LINE_WIDTH

Category

Model View
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Use to set cursor line width in model views.

• Possible values are 1, 2, or 4. Any other value is handled as 1.

• The default value is 2.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Cursor line width of 1 Cursor line width of 4

XS_RENDERED_FIELD_OF_VIEW

Category

Model View

Use to adjust the field of view setting in perspective views. This can be useful,
for example, when using the Fly command in a tight space. The bigger the
value, the more distance there is between the parts.

The default value is 60.0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Example

Field of view Example
60.0
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Field of view Example
90.0

120.0

XS_RENDERED_GL_FOG_END_VALUE

Category

Model View

Note that this advanced option works only in views that use OpenGL
rendering.

In model views, the distant objects appear progressively darker than the close
ones. Use the advanced options XS_RENDERED_GL_FOG_START_VALUE and 
XS_RENDERED_GL_FOG_END_VALUE to control the shade of objects.

Use values from 0.0 to 1.0 to control the shade of objects. The higher the
value, the darker the distant objects. Value 0 disables the fog effect. The
default value for XS_RENDERED_GL_FOG_END_VALUE is 0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_RENDERED_GL_FOG_START_VALUE (page 369)
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XS_RENDERED_GL_FOG_START_VALUE

Category

Model View

Note that this advanced option works only if you use the default OpenGL
rendering instead of the DirectX rendering.

In model views, the distant objects appear progressively darker than the close
ones. Use the advanced options XS_RENDERED_GL_FOG_START_VALUE and 
XS_RENDERED_GL_FOG_END_VALUE to control the shade of objects.

Use values from 0.0 to 1.0 to control the shade of objects. The higher the
value, the darker the distant objects. Value 0 disables the fog effect. The
default value for XS_RENDERED_GL_FOG_START_VALUE is 0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_RENDERED_GL_FOG_END_VALUE (page 369)

XS_RENDERED_PIXEL_TOLERANCE_SCALE

Category

Model View

Tekla Structures uses pixel tolerance to differentiate between clicking and
dragging the mouse when zooming. Use this advanced option to define the
pixel tolerance.

The default value is 0.7. If the mouse moves less than the specified value
while the left mouse button is pressed down, it is treated as a click.

This is a system-specific advanced option.

XS_REPORT_BOLTS_WITH_SUPPORTING_MEMBER

Category: Templates and symbols

You can set the site bolts to the supporting member in reports and KSS by
setting the advanced option XS_REPORT_BOLTS_WITH_SUPPORTING_MEMBER
to TRUE. Using this advanced option you can show the field bolts in the BOM
of the supporting member. The default value is FALSE.

In the following BOM example, the advanced option is set to TRUE:
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In the following BOM example, the advanced option is set to FALSE:

In the following KSS file example, the advanced option is set to TRUE:

In the following KSS file example, the advanced option is set to FALSE:
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This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_REPORT_OUTPUT_DIRECTORY

Category

File locations

Points to the folder where Tekla Structures saves reports. If the full path
appears in the report file name field, Tekla Structures ignores this setting. The
default value is .\Reports.
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XS_RESTORE_ENABLES

Category

This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to be able to save and load check box values
in dialog boxes. FALSE is the default value.

XS_ROTATE_CUT_VIEWS

Category

Drawing View

Use to specify the rotation of section views.

BY_SYMBOL_MAIN_VIEW (default) uses the orientation of the view that
contains the section symbol. This only applies to section views that Tekla
Structures creates automatically. Manually-created views have the same
rotation as the view they are created from.

BY_MAIN_VIEW uses the same orientation as the main view.
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This advanced option is model specific and the setting is saved in the options
database.

XS_RUN_AT_STARTUP

Category: File Locations

Tekla Structures will automatically launch any executable (.exe) files that are
located in the folders defined for this advanced option. You can enter several
folders separated by a semicolon (;). By default, this advanced option is set
to ..\Tekla Structures\<version>\nt\bin\applications\Tekla
\ApplicationStartup.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_RUNPATH

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.
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This advanced option points to the folder where Tekla Structures searches for
models by default. When you open the New dialog box, the default model
folder is displayed in the Save in list.

NOTE This advanced option does not affect the Open dialog box.

This advanced option is model specific and the setting is saved in the options
database.

Example
set XS_RUNPATH=C:\TeklaStructuresModels\

XSR_USE_NO_FEET_SEPARATOR

Category

Templates and Symbols

Set this advanced option to TRUE to use a space instead of the feet separator
in drawing tables and reports, for example, 2 4''1/4. To use the feet separator,
use the value FALSE. The default value is FALSE.

You also need to set XSR_USE_NO_FEET_SYMBOL.

This advanced option is model specific and the setting is saved in the options
database.

See also

XSR_USE_NO_FEET_SYMBOL (page 375)

XSR_USE_NO_FEET_SYMBOL

Category

Templates and Symbols

Set this advanced option to TRUE to omit the feet symbol in drawing tables
and reports, for example, 2-4''1/4. If you do not want to omit the feet symbol,
use the value FALSE. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XSR_USE_NO_INCH_SYMBOL

Category

Templates and Symbols

Set this advanced option to TRUE to omit the inch symbol in drawing tables
and reports, for example, 2-4 ¼. If you do not want to omit the inch symbol,
use the value FALSE. The default value is FALSE.

You also need to set XSR_USE_NO_FEET_SYMBOL and 
XSR_USE_NO_FEET_SEPARATOR.

This advanced option is model specific and the setting is saved in the options
database.

See also

XSR_USE_NO_FEET_SEPARATOR (page 375)

XSR_USE_NO_FEET_SYMBOL (page 375)

XSR_USE_ZERO_FEET_VALUE

Category

Templates and Symbols

Set this advanced option to TRUE to force Tekla Structures to show zero feet
for values less one foot, for example, 0'-6''3/4. If you do not want to show zero
feet values, use the value FALSE. The default value is FALSE.

NOTE Setting this advanced option affects also the following:

• Length values in part and bolt marks

• Length values in templates (template attribute LENGTH)

This advanced option is model specific and the setting is saved in the options
database.

See also

XSR_BOLT_LENGTH_USE_ONLY_INCHES (page 347)

XSR_USE_ZERO_INCH_FOR_FRACTIONS

Category

Templates and Symbols
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Set this advanced option to TRUE to show zero inches for values only
containing fractions, for example, 2'-3/4 or 0''1/4. If you do not want to do this,
use the value FALSE. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XSR_USE_ZERO_INCH_VALUE

Category

Templates and Symbols

Set this advanced option to TRUE to show zero inches for values only
containing feet and fractions, for example, 2'-0''3/4 or 1/4. If you do not want
to do this, use the value FALSE. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

1.18 Advanced options - S

XS_SAVE_WITH_COMMENT

Category

Multi-user

Set this advanced option to TRUE (default) to enable the saving of model
revision comments in multi-user models.

XS_SCALE_COPIED_OR_MOVED_OBJECTS_IN_DRAWINGS

Category

Drawing Properties

Use to define the scaling of objects that are copied or moved between drawing
views that have different scales.

• To scale the objects according to the view scales, set the advanced option
to TRUE.
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• To keep the object sizes constant, set the advanced option to FALSE
(default).

This advanced option is model specific and the setting is saved in the options
database.

XS_SCALE_MARKS_TO_FIT_LIMIT

Category

Marking: Parts

Tekla Structures fits part marks near the part they belong to by scaling the text
height. Set the minimum scale with this advanced option.

The default value is 1.0. This means that if you do not set the advanced option,
Tekla Structures does not scale marks. Tekla Structures scales the text height
in steps so that first it tries the scale of 0.9. If the mark does not fit, Tekla
Structures scales the mark by 0.8, and so on.

Note that part mark's leader line type has to be either Try along part or
Always along part.

This advanced option is model specific and the setting is saved in the options
database.

Example
XS_SCALE_MARKS_TO_FIT_LIMIT=0.5

XS_SCREW_DIAMOND_WITHOUT_PHI

Category

Marking: Bolts

Set this advanced option to TRUE to prevent Tekla Structures from placing a
phi symbol outside the frame of bolt marks (diamond type only). The default
value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_SDNF_CONVERT_PL_PROFILE_TO_PLATE

Category

Export
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Set this advanced option to TRUE to have SDNF exports convert plate profiles
(PL) to contour plates. Works with SDNF versions 2.0 and 3.0. If you do not
want to use this setting, Set it to FALSE.The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_SDNF_EXPORT_INCLUDE_GLOBAL_ID

Category

Export

Set this advanced option to TRUE to revert to the FrameWorksPlus ID number
in SDNF exports. The default value is FALSE.

This advanced option only affects version 2.0 SDNF export, but not version 3.0
export.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SDNF_IMPORT_STORE_MEMBER_NUMBER (page 379)

XS_SDNF_IMPORT_MIRROR_SWAP_OFFSETS

Category

Import

Set this advanced option to TRUE to swap the end point offsets and start point
offsets when an imported part is mirrored already in the SDNF software. If you
set this advanced option to FALSE, the end point and start point offsets are
not swapped. The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_SDNF_IMPORT_STORE_MEMBER_NUMBER

Category

Import

Set this advanced option to TRUE to have Tekla Structures store the
FrameWorksPlus ID number in SDNF imports. Tekla Structures stores the ID
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number in the user-defined attribute SDNF_MEMBER_NUMBER. If you do not
want to do this, set the option to FALSE. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

For information on exporting the ID number, click the links below.

See also

XS_SDNF_EXPORT_INCLUDE_GLOBAL_ID (page 379)

XS_PML_EXPORT_INCLUDE_GLOBAL_ID (page 332)

XS_SECONDARY_PART_HARDSTAMP

Category

CNC

Set to TRUE to include hard stamps for main parts and any kind of secondary
parts in DSTV files. Set to FALSE to create hard stamps only for main parts.
The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_SECTION_LINE_COLOR

Category: Hatching

Use to add extra lines in different colors around automatic hatching in section
views. Enter the numeric value of the color. See below for the colors and their
numeric values.
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In the image above, the advanced option has been set to 0:

In the next example, the value 160 is used:
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This advanced option is model specific and the setting is saved in the options
database.

NOTE To show lines around hatching, and to be able to add extra lines in
different colors, you may need to set advanced option 
XS_DRAW_ALL_SECTION_EDGES_IN_DRAWINGS to TRUE in the
initialization files.

See also

XS_DRAW_ALL_SECTION_EDGES_IN_DRAWINGS (page 172)

XS_SECTION_SYMBOL_LEFT_ARROW_SYMBOL

Category

Drawing Properties

Use to define the custom arrow symbol Tekla Structures uses in section
symbols at the left end of sections. To use the custom arrow symbol, select
Custom from the Left symbol list in the Section symbol properties dialog
box.

By default, Tekla Structures uses the symbol no 1 in the sections.sym file
(located usually in the folder \environments\common\symbols\). If you
want to change the symbol, enter the symbol file name first, then the @ sign
and then the number of the symbol, for example sections@1.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SECTION_SYMBOL_RIGHT_ARROW_SYMBOL (page 383)
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XS_SECTION_SYMBOL_REFERENCE

Category

Drawing Properties

Sets the reference text for symbols that show a section in another drawing.
The text can include:

• free text

• user-defined attributes

• template attributes

In the Advanced options dialog box, use single % characters around the user-
defined and template attributes. %DRAWING_TITLE% is the default value. 
%TITLE% gives the same result. This advanced option gets the drawing name
entered in the drawing properties dialog box. If you enter TITLE1 - TITLE3,
Tekla Structures gets the drawing title from the drawing properties dialog box.
You can also use the format DR_TITLE1 - DR_TITLE3.

This advanced option is model specific and the setting is saved in the options
database.

XS_SECTION_SYMBOL_RIGHT_ARROW_SYMBOL

Category

Drawing properties

Use to define the custom arrow symbol Tekla Structures uses in section
symbols at the right end of sections. To use the custom arrow symbol, select
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Custom from the Right symbol list in the Section symbol properties dialog
box

By default Tekla Structures uses the symbol no 0 in the sections.sym file
(located usually in the folder \environments\common\symbols\). Enter the
symbol file name first, then the @ sign and then the number of the symbol, for
example sections@0.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SECTION_SYMBOL_LEFT_ARROW_SYMBOL (page 382)

XS_SECTION_VIEW_REFERENCE

Category

Drawing Properties

Sets the reference text for section view labels. The text can include:

• free text

• user-defined attributes

• template attributes

In the Advanced options dialog box, use single % characters around the user-
defined and template attributes. %DRAWING_TITLE% is the default value. 
%TITLE% gives the same result. This advanced option gets the drawing name
entered in the drawing properties dialog box. If you enter TITLE1 - TITLE3,
Tekla Structures gets the drawing title from the drawing properties dialog box.
You can also use the format DR_TITLE1 - DR_TITLE3.
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This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SECTION_SYMBOL_REFERENCE (page 383)

XS_SET_FIXEDMAINVIEW_UDA_TO_AFFECT_NUMBERING

Category: Numbering

To activate the Show top-in-form face for non-concrete material, use the
advanced option XS_SET_FIXEDMAINVIEW_UDA_TO_AFFECT_NUMBERING.
The allowed options are STEEL, TIMBER and MISC. You can also combine the
options, use a comma (,) as a separator.

This advanced option affects numbering. If parts have different options
selected for Fixed drawing main view, they get different assembly position
numbers.

To show the top-in-form face in drawings and set which view is used in
drawings as the main (front) view, go to the user-defined properties of a non-
concrete part and select the Fixed drawing main view option that you want.
The options are Top, Back, Bottom, Start, End and Front.

This advanced option is model specific and the setting is saved in the options
database.
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XS_SET_HATCH_ORIGIN_INTO_VIEW_ORIGIN

Category: Hatching

Hatches are drawn consistently between parts and set to origin, if you set the
advanced option XS_SET_HATCH_ORIGIN_INTO_VIEW_ORIGIN to TRUE and
the scaling and rotation of hatches to zero (0). The default value is FALSE.

For automatic hatches, the scale and rotation are set in the .htc file, for
example, CONCRETE,0,hardware_LINES,,120, where the value 0 (or empty)
sets auto scale and rotation to false.

For manual hatches, the scale and rotation are set on the Fill tab of parts
properties or shape properties dialog boxes, where you need to set the Scale
option to Custom and select the Keep ratio of x and y check box.

In the example below, the parts that belong to the same cast unit are hatched
consistently.

This advanced option is model specific and the setting is saved in the options
database.

XS_SET_MAX_POINT_CLOUD_POINT_COUNT

Category: Model View

Use this advanced option to set the default maximum value for the points in a
view in point clouds. The default value is 10 000 000 (10 million).

Advanced options reference 386 Advanced options - S



If you discover speed issues, set the count smaller. When the count is smaller,
the point cloud appears less dense. If you use a higher value, the dense point
cloud may provide more surface kind of appearance due to smaller point
distance.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

Restart Tekla Structures after changing the value to activate the new setting.

XS_SHARING_INFO_URL

Category: Multi-user

Use this advanced option to set the Tekla Model Sharing management server
address.

This advanced option is system-specific. Generally, there is no need to modify
system-specific settings. Do not modify them if you are not an administrator.

XS_SHARING_JOIN_SHOW_AVAILABLE_UPDATES

NOTE We recommend you to set this advanced option in File menu -->
Sharing --> Sharing settings. Select the Show available updates
when joining the model option.

Use this advanced option to show a list of all the available baselines and
updates which to join in Tekla Model Sharing. The list is shown when a user
joins a model.

If needed, the advanced option can be set in initialization files. Set 
XS_SHARING_JOIN_SHOW_AVAILABLE_UPDATES to TRUE in initialization files
to enable the list.

This advanced option is user-specific.
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XS_SHARING_READIN_SHOW_AVAILABLE_VERSIONS

NOTE We recommend you to set this advanced option in File menu -->
Sharing --> Sharing settings. Select the Show available updates
when reading in the changes option.

Use this advanced option to show a list of available updates when a user reads
in the model changes in Tekla Model Sharing.

If needed, the advanced option can be set in initialization files. Set 
XS_SHARING_READIN_SHOW_AVAILABLE_VERSIONS to TRUE in initialization
files to enable the list.

This advanced option is user-specific.

XS_SHARING_READIN_SHOW_CHANGEMANAGER

NOTE We recommend you to set this advanced option in File menu -->
Sharing --> Sharing settings. Select the Show changes after read in
option.

Use this advanced option to show a list model changes at the bottom pane
after you have read in the model changes in Tekla Model Sharing.

If needed, the advanced option can be set in initialization files. Set 
XS_SHARING_READIN_SHOW_CHANGEMANAGER to TRUE in initialization files.

This advanced option is user-specific.

XS_SHARING_READIN_SHOW_CHANGEMANAGER_
CONFLICTSONLY

NOTE We recommend you to set this advanced option in File menu -->
Sharing --> Sharing settings. Select the Show changes after read in
and Only when conflicts exist options.

Use this advanced option to show a list model changes at the bottom pane
after you have read in the model changes in Tekla Model Sharing and when
there are conflicts.

If needed, the advanced option can be set in initialization files. Set 
XS_SHARING_READIN_SHOW_CHANGEMANAGER and 
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XS_SHARING_READIN_SHOW_CHANGEMANAGER_CONFLICTSONLY to TRUE in
initialization files.

This advanced option is user-specific.

XS_SHARING_TEMP

Category: Multi-user

Use this advanced option to define the temporary folder for Tekla Model
Sharing packet management. The default is the Windows temporary folder.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_SHOP_BOLT_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in bolt marks (workshop). The
default value is %BOLT_NUMBER%*D%HOLE.DIAMETER% - M%DIAMETER%x
%LENGTH%.

This advanced option is only used when there is a bolt and the hole is a
normal one.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)
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• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in bolt marks for workshop
bolts in general arrangement drawings.

This advanced option is only used when there is a bolt and the hole is a
normal one.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL
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• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA (page 392)

XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA (page 394)

XS_SHOP_HOLE_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in hole marks (workshop). For
example, to show bolt number and hole diameter, enter %BOLT_NUMBER%*D
%HOLE.DIAMETER%.

This advanced option is only used when there is a hole, no bolt (and the hole is
a normal one).

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL
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• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in hole marks for workshop
bolts in general arrangement drawings.

This advanced option is only used when there is a hole, no bolt (and the hole is
a normal one).

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK
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• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA (page 390)

XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA (page 394)

XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in slotted hole marks
(workshop). The default value is %BOLT_NUMBER%*D%HOLE.DIAMETER%
(%HOLE.DIAMETER+LONG_HOLE_X%x%HOLE.DIAMETER+LONG_HOLE_Y%) - M
%DIAMETER%x%LENGTH%.

This advanced option is only used when there is a longhole.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK
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• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in longhole marks for workshop
bolts in general arrangement drawings.

This advanced option is only used when there is a longhole.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME
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• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHORTENING_SYMBOL_COLOR

Category

Drawing Properties

Use this advanced option to set the color of the view shortening symbol. Enter
an integer value. Default is the same as the part color. See below for integers
for different colors.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHORTENING_SYMBOL_LINE_TYPE

Category

Drawing Properties

Use this advanced option to set the line type of the view shortening symbol.
Enter an integer value. Default is a solid line. See below for integer values for
different line types.

Advanced options reference 395 Advanced options - S



This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SHORTENING_SYMBOL_WITH_ZIGZAG

Category

Drawing Properties

Use this advanced option to set the shortening symbol line shape. If you do
not want to use zigzag, set this advanced option to FALSE. TRUE is the default.

This advanced option is model specific and the setting is saved in the options
database.

TIP You can control the appearance of the view shortening symbol with the
advanced options XS_SHORTENING_SYMBOL_COLOR (page 395) and XS_
SHORTENING_SYMBOL_LINE_TYPE (page 395).

To use a view shortening symbol instead of the empty area, set the
advanced options XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_
TO_PARTS (page 192) and XS_DRAW_HORIZONTAL_VIEW_SHORTENING_
SYMBOLS_TO_PARTS (page 186) to TRUE.

See also

XS_SHOW_HARDWARE_DASHED_LINE_IN_PIXEL_SCALE

Category: Drawing Properties

Set XS_SHOW_HARDWARE_DASHED_LINE_IN_PIXEL_SCALE to FALSE to
activate the functionality, where dashed hardware line scale is the same as in
printed and exported drawings, and the dashed hardware lines work in the
same way as the custom lines.

Dashed hardware line types are scaled by pixels by default (TRUE), which
means that they look the same in all zoom levels.
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Dashed hardware lines are the first couple of lines in the line list:

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XSR_SHOW_INCH_MARK_IN_PROFILE_NAMES

Category

Templates and Symbols

Use to show or hide the inch symbol in the profile name in reports and
templates. When you set the advanced option to TRUE, the profile appears like
this: PL2 1/2"X20". When you set the advanced option to FALSE, the profile
appears like this: PL2 1/2X20. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PROFILE_DISPLAY_INCH_MARK_AFTER_FRACTIONS_IN_REPORTS (page 345)
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XS_SHOW_NOTIFICATION_REPORT

Category: Modeling Properties

Set to TRUE to run and display a notification report from the whole model
when you open a model.

You can use the notification report to, for example:

• List assignments on all objects (drawings, parts and assemblies).

• Report how many assemblies there are in the model, how many assembly
drawings have been created, and how many of them have been approved
and how many have been issued for production.

The report template used is named notification_report, and you can edit
it in Template Editor. Notification report reports anything you want, not just
assignments. You need to edit the report template to report the things you
need. For example, some environments do not have all attributes available,
like ASSIGNED_TO or ASSIGNED_BY, for parts and assemblies.

If you do not want to display the notification report upon opening a model, set
the advanced option to FALSE, which is the default value.

This advanced option is model specific and the setting is saved in the options
database.

Example of a list of drawing assignments:

XS_SHOW_PERFORM_NUMBERING_MESSAGE

Category

Numbering
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Use to show or hide the Perform numbering button in the warning message
Tekla Structures displays if you try to create a drawing without numbering or
when numbering is not up to date.

• By default, this advanced option is set to TRUE and the numbering button
is shown.

• To hide the button, set this advanced option to FALSE.

Consider hiding the numbering button in the multi-user mode, because
unnecessary or unplanned numbering may take a while in large models or
break project numbering. This can occur if Synchronize with master model
(save-numbering-save) check box is not selected in the Numbering setup
dialog box.

This advanced option is model specific and the setting is saved in the options
database.

XS_SHOW_PROGRESS_BAR_FOR_PROJECT_STATUS_
VISUALIZATION

Category

Model View

Use for defining whether the progress bar for project status visualization is
displayed or not.

To display the progress bar, set this advanced option to TRUE (default). If you
do not want to display the progress bar, set this advanced option to FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_SHOW_REVISION_MARK_ON_DRAWING_LIST

Category: Drawing Properties

Set this advanced option to TRUE to have Tekla Structures include the
Revision mark in Document manager instead of the Revision number. The
default value is FALSE. This means that the revision number is shown.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_SHOW_SHADOW_FOR_ORTHO_IN_DX

Category: Model View

Use this advanced option to control whether shadows are shown in the
DirectX rendered model views when the orthogonal projection is on. Shadows
are more noticeable in the perspective projection than in the orthogonal
projection.

By default, this advanced option is set to FALSE.

If you change the value, you need to reopen the view to activate the new
value.

XS_SHOW_SHADOW_FOR_PERSPECTIVE_IN_DX

Category: Model View

Use this advanced option to control whether shadows are shown in the
DirectX rendered model views when the perspective projection is on. Shadows
are more noticeable in the perspective projection than in the orthogonal
projection.

By default, this advanced option is set to TRUE.

If you change the value, you need to reopen the view to activate the new
value.

XS_SHOW_SITE_STUDS_IN_ASSEMBLY_DRAWINGS

Category

Drawing Properties

Set this advanced option to TRUE (default) to show site studs in assembly
drawings. If you set it to FALSE, the site studs are not shown.

This advanced option is model specific and the setting is saved in the options
database.

XS_SHOW_STUDS_IN_WORKSHOP_DRAWINGS

Category

Drawing Properties
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Set this advanced option to TRUE to show workshop studs in single-part
drawings. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_SHOW_TEMPLATE_LOG_MESSAGES

Category

Templates and Symbols

Set this advanced option to TRUE to show error messages related to template
attributes in the log file. Set it to FALSE to hide these messages. By default this
advanced option is set to FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_SINGLE_CENTERED_SCREW

Category

Single Part View in Assembly Drawing

Use to control the dimensioning of centrally-located bolts in single-part views
included in assembly drawings. Possible values are:

• 0 = Dimensions the centered bolts spread.

• 5 = Dimensions the bolts to the main part center-lines.

• 6 = Overrides bolt overrides the Secondary part bolt internal dimensions
setting for centered bolts. This only applies to bolts located centrally on the
part.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_CLOSE_DIMENSIONS

Category

Single part view in assembly drawing

Use to close dimensions in single-part views included in an assembly drawing.
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• 0 = Does not close dimensions

• 1 = Closes dimensions in the x direction and leaves others open. This is the
default value.

• 2 = Closes all dimensions

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_CLOSE_SHORT_DIMENSIONS

Category

Single Part View in Assembly Drawing

Use to close short dimensions in single-part views included in assembly
drawings. The default value is 1. If you do not want to close short dimensions,
enter 0.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_COMBINE_DISTANCE

Category

Single Part View in Assembly Drawing

Use to set a distance for combining dimensions in single-part views included in
assembly drawings. Enter a decimal value, for example 400.0.

By default, this advanced option is not set to any value.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_COMBINE_MIN_DISTANCE

Category

Single Part View in Assembly Drawing
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Use to set a minimum distance for combining dimensions in single-part views
included in assembly drawings. Enter a decimal value, for example 200.0.

By default, this advanced option is not set to any value.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_COMBINE_WAY

Category

Single Part view in assembly drawing

Use to combine dimensions in single-part views included in assembly
drawings. The options correspond to the combining order on the General tab
of the Dimensioning Properties dialog box. By default, this advanced option
is not set to any value.

• Option 0 prevents dimensions from being combined.

• Option 1 combines part position dimensions with part internal dimensions,
and bolt group internal dimensions with bolt edge distances. Bolt position
dimensions are not combined with bolt internal dimensions.

• Option 2 combines the part position dimension with part internal
dimensions and bolt group internal dimensions. Bolt internal dimensions
are combined with bolt position dimensions. Edge distances are shown
separately.

• Option 3 combines bolt internal dimensions and position dimensions in
the same dimension line.

• Option 4 combines bolt group position dimensions with part position
dimensions. Part and bolt internal dimensions are not combined with this
option, but bolt internal dimensions are combined with bolt edge
distances.

• Option 5 combines internal dimensions and the position dimension of bolt
groups where there are several bolt groups.

• Option 4.5 uses a combination of option 5 for the main part and a
combination of option 4 for the secondary parts.

This advanced option is model specific and the setting is saved in the options
database.

See also
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XS_SINGLE_DIMENSION_TYPE

Category

Single Part View in Assembly Drawing

Use to set a dimension type for single-part views included in assembly
drawings. The options are:

• 1 = Relative, point to point dimensions. This is the default value.

• 2 = Absolute, dimensions from a common start point.

• 3 = Relative and absolute, a combination of point to point and common
start point.

• 4 = US absolute, dimensions from a common start point, which include a
running dimension mark (RD).

• 16 = US absolute 2, similar to US absolute, but it changes short dimensions
to relative.

• 35 = Absolute plus short relatives, which is similar to Absolute, but it
changes short dimensions to relative. Also called internal absolute. This
option may show both dimensions, but it does not show relative
dimensions when dimensions are long. This option shows the absolute
dimensions inside the dimension lines.

• 99 = Absolute plus all relatives above the absolutes, which is similar to
Relative and absolute, but it places the relative dimensions above the
absolute.

This advanced option is model specific and the setting is saved in the options
database.

XS_SINGLE_DRAW_PART_AS

Category

Single Part View in Assembly Drawing

Use to define how parts appear (their representation type) in single-part views
included in assembly drawings. The options are:

• 1 (default) solid

• 4 workshop solid (round tubes open)

• 2 symbol form

This advanced option is model specific and the setting is saved in the options
database.
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XS_SINGLE_EXCLUDE

Category

Single Part View in Assembly Drawing

Use to exclude single-part views from assembly drawings. The options are:

• NONE includes all single part views.

• MAIN_SHAFT includes single part views of all parts, except assembly main
parts.

• ALL_SHAFTS includes single part views of all parts, except those with
another object welded to them (i.e. main parts).

• AUTO (default) includes single part views of all parts, except the longest
main part in the assembly.

• ALL_BUT_MAIN_PART includes single part views of assembly main parts
only.

• STANDARD includes single-part views of all parts, except standard parts.
You can add STANDARD after any of the existing values, for example 
MAIN_SHAFT_AND_STANDARD creates single-part drawing from all but main
part or standard parts.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_FORWARD_OFFSET

Category

Single Part View in Assembly Drawing

Use to set the distance Tekla Structures uses to search for the base point of a
dimension in single-part views included in an assembly drawing. If Tekla
Structures does not find a base point (corner) within the defined forward
offset search distance, it uses an edge point. Enter the value as a decimal, for
example 250.0.

This advanced option is model specific and the setting is saved in the options
database.

See also
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XS_SINGLE_NO_RELATIVE_SHAPE_DIMENSIONS

Category

Dimensioning: Parts

Set this advanced option to TRUE (default) to force shape dimensions to be the
same as the dimension type you select. If you do not want to do this, set it to 
FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_NO_RELATIVE_SHAPE_DIMENSIONS (page 314)

XS_SINGLE_NO_SHORTEN

Category

Single part view in assembly drawing

Set this advanced option to TRUE to display single-part views in drawings
without shortening parts. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_SINGLE_ORIENTATION_MARK

Category: Single Part View in Assembly Drawing

You can display orientation symbols in single-part views included in assembly
drawings. To show the orientation symbols in single-part views:

1. Click File menu --> Settings --> Advanced options and go to the Single
Part View in Assembly Drawing category.

2. Enter TRUE as the value.

3. In assembly drawing properties, click Layout and go to the Other tab.

4. Set the option Single-part attributes to Current attributes. Tekla
Structures takes the orientation mark settings from the current single-part
drawing properties. If you select other attributes, the visibility of the
orientation symbols is set according to the selected attribute file.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_SINGLE_PART_DRAWING_VIEW_TITLE

Category

Drawing Properties

Use to define a title for single-part drawing views in multidrawings. You can
use any of the following to define the title:

• PART_NAME
• PART_MATERIAL
• PART_POS
• ASSEMBLY_POS
• MODEL_NUMBER
• LENGTH, PROFILE
• LENGTH
• BASE_NAME
• NAME
This advanced option is model specific and the setting is saved in the options
database.

XS_SINGLE_PART_EXTREMA

Category

Single Part View in Assembly Drawing

Use to display overall dimensions in single-part views included in assembly
drawings. Enter one of the following values:

• 0 = None

• 2 = Once

• 3 = All

This advanced option is model specific and the setting is saved in the options
database.

XS_SINGLE_PART_SHAPE

Category

Single Part View in Assembly Drawing
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Use to show or hide shape dimensions in single part views.

Set to 1 (default) to show shape dimensions in single-part views.

Set to 0 to hide shape dimensions in single-part views.

Tekla Structures automatically creates radius dimensions for curved chamfers
in single-part drawings when you use shape dimensions.

This advanced option is model specific and the setting is saved in the options
database.

XS_SINGLE_SCALE

Category

Single Part view in Assembly Drawing

Use to set the scale of single-part views included in assembly drawings. Enter a
decimal value. By default, this advanced option is not set to any value.

This advanced option is model specific and the setting is saved in the options
database.

Example

To have Tekla Structures use the scale 1/10, enter 10.0.

This advanced option is related to the advanced option 
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_SCALE (page 447).

XS_SINGLE_SCREW_INTERNAL

Category

Single Part View in Assembly Drawing

Use to show or hide internal bolt dimensions in single part views included in
assembly drawings.

Set to 1 to show internal bolt dimensions.

Set to 0 to hide internal bolt dimensions.

By default, this advanced option is not set to any value.

This advanced option is model specific and the setting is saved in the options
database.

See also

Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 671)
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XS_SINGLE_SCREW_POSITIONS

Category

Single Part View in Assembly Drawing

Use to include position dimensions for bolts in single-part views included in
assembly drawings. Enter one of the following values:

• 0 = Off

• 1 = On

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SINGLE_USE_WORKING_POINTS

Category

Single Part View in Assembly Drawing

Use to include dimensions from work points in single-part views included in
assembly drawings. Enter one of the following values:

• 0 = None (default)

• 1 = Main part

• 2 = Working points

• 3 = Both

This advanced option is model specific and the setting is saved in the options
database.

XS_SINGLE_X_DIMENSION_TYPE

Category

Single Part View in Assembly Drawing

Use to set the dimension type for single-part views included in assembly
drawings. These are otherwise like straight dimensions set with the advanced
option XS_SINGLE_X_DIMENSION_TYPE but they override the straight setting
for horizontal dimensions.

• 0 = Tekla Structures uses straight dimension settings

• 1 = Relative, point to point dimensions. This is the default value.

Advanced options reference 409 Advanced options - S



• 2 = Absolute, dimensions from a common start point.

• 3 = Relative and absolute, a combination of point to point and common
start point.

• 4 = US absolute, dimensions from a common start point, which include a
running dimension mark (RD).

• 16 = US absolute 2, similar to US absolute, but it changes short dimensions
to relative.

• 35 = Absolute plus short relatives, which is similar to Absolute, but it
changes short dimensions to relative. Also called internal absolute. This
option may show both dimensions, but it does not show relative
dimensions when dimensions are long. This option shows the absolute
dimensions inside the dimension lines.

• 99 = Absolute plus all relatives above the absolutes, which is similar to
Relative and absolute, but it places the relative dimensions above the
absolute.

This advanced option is model specific and the setting is saved in the options
database.

XS_SITE_BOLT_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in bolt marks (site). The default
value is %BOLT_NUMBER%*D%HOLE.DIAMETER%.

This advanced option is only used when there is a bolt and the hole is a
normal one.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y
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• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in bolt marks for site bolts in
general arrangement drawings.

This advanced option is only used when there is a bolt and the hole is a
normal one.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)
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• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA (page 413)

XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA (page 415)

XS_SITE_HOLE_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in hole marks (site). For
example, to show bolt number and hole diameter in the mark, enter 
%BOLT_NUMBER%*D%HOLE.DIAMETER%.

This advanced option is only used when there is a hole, no bolt (and the hole is
a normal one).

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)
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• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in hole marks for site bolts in
general arrangement drawings.

This advanced option is only used when there is a hole, no bolt (and the hole is
a normal one).

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL
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• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA (page 411)

XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA (page 415)

XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE

Category

Marking: Bolts

Use to define the contents of the Size element in slotted hole marks (site). The
default value is %BOLT_NUMBER%*D%HOLE.DIAMETER%(%HOLE.DIAMETER
+LONG_HOLE_X%x%HOLE.DIAMETER+LONG_HOLE_Y%).

This advanced option is only used when there is a longhole.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL
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• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME

• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA

Category

Marking: Bolts

Use to define the contents of the size element in longhole marks for site bolts
in general arrangement drawings.

This advanced option is only used when there is a longhole.

You can use any combination of text and the following options as the value for
this advanced option. Enclose each option in % characters.

Note that if you are defining this advanced in an .ini file, use double percent
signs around the switches %%BOLT_NUMBER%%*D%%HOLE.DIAMETER%%.

To use special characters enter a backslash (\) followed by an ASCII number.
You can use the options in any order, and make calculations.

• BOLT_NUMBER

• DIAMETER

• LENGTH

• HOLE.DIAMETER

• LONG_HOLE_X

• LONG_HOLE_Y

• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)

• BOLT_STANDARD

• BOLT_MATERIAL

• BOLT_ASSEMBLY_TYPE

• BOLT_COUNTERSUNK

• BOLT_SHORT_NAME
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• BOLT_FULL_NAME

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA (page 413)

XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA (page 411)

XS_SNAPSHOT_DIRECTORY

Category: File Locations

Use this advanced option to define the folder where Tekla Structures stores
screenshots when you go to the View tab (Views in drawings) and click
Screenshot --> Screenshot . If you do not define a path, Tekla Structures
stores screenshots in the current model folder. The default value
is .\screenshots\.

If the defined folder does not exist, Tekla Structures automatically creates it
when you take a screenshot.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Example
c:\temp\

XS_SOLID_BUFFER_SIZE

Category: Speed and accuracy

Use this advanced option to define the size of the solid object buffer. The
buffer size setting depends on your environment.

Tekla Structures creates a buffer in system RAM to store the solid
representation of parts it creates during certain processes. For example, Tekla
Structures creates solid objects when numbering a model. When this buffer
fills up, Tekla Structures erases the contents in order to continue using the
buffer.

When you increase the buffer size, Tekla Structures keeps more solid objects
in the memory, and does not have to recreate them so often. Increasing this
value also increases the memory used by the processes. Decreasing this value
decreases the memory requirements, but also the performance as Tekla
Structures has to recreate solid objects more often.
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Testing various settings is the best way to optimize the solid object buffer size.
Remember that opening Tekla Structures windows uses some RAM, and that
other programs also use RAM for various processes.

For optimum performance for large models under restricted memory
conditions, consider having the solid cache size in between 0.2 - 5 * the
number of parts in your model. To find out the number of parts in the model,
go to the Edit tab and click Inquire --> Model size .

In 64-bit machines you do not usually have to change the default value. If the
amount of memory is large, keep the buffer size at least as large as the
number of parts in the model.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_SOLID_USE_HIGHER_ACCURACY

This advanced option must be set in an initialization (.ini) file.

NOTE This advanced option increases the number of faces in solid objects, which
slows down Tekla Structures. We recommend using this advanced option only
when needed.

When you set this advanced option to TRUE in the options.ini file in the
model folder:

• When you have set part representation to Exact in the Display dialog box,
parts are shown with roundings. Also weld polygons include profile
roundings.

• When the advanced option XS_DISPLAY_FILLET_EDGES (page 163) is set to
TRUE, lines are shown between the roundings and straight segments of
parts.

• Part volume, area and net weight is and are closer to real manufactured
values.

Set this advanced option to TRUE in the options.ini file in model folder. The
default value is FALSE.

Limitations

• Do not activate this advanced option when you create NC/DSTV files,
because it can lead to inaccuracies in the exported data.

• Do not activate this advanced option when you create single part or
assembly drawings, because it can lead to unnecessary dimension line
creation.

• In components, some stiffeners might bite into flanges of columns or
beams.
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• Some bolt edge distances are not correctly calculated.

See also

XS_CS_CHAMFER_DIVIDE_ANGLE (page 133)

XS_STACKED_FRACTION_TYPE

Category

Imperial units

Use to define the appearance of fractions. You can use stacked fractions in
drawings, text, marks etc., but not in templates. The options are (from left to
right in the illustration):

• NOT_STACKED
• DASH
• SLASH
• WITHOUT_SLASH
If you do not want to use stacked fractions, set this advanced option to 
NOT_STACKED, (default) or use a backslash character ( \ ) before the slash
character ( / ) in the text (e.g. 1\ /16).

This advanced option is model specific and the setting is saved in the options
database.

XS_STANDARD_GUSSET_WIDTH_TOLERANCE

Category

Components

Use to define the tolerance between the actual and standard widths of gusset
plates created using modeling tools or connections. Tekla Structures uses a
standard plate file to define the default plate width including the tolerance
value. Enter the value in millimeters, for example 1.0.

Components that use this advanced option are:

• Welded gusset (10)

• Bolted gusset (11)

• Tube gusset (20)
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• Corner tube gusset (56)

• Corner bolted gusset (57)

• Wraparound gusset (58)

• Hollow brace wraparound gusset (59)

• Wraparound gusset cross (60)

• Gusseted cross (62)

• Corner wrapped gusset (63)

This advanced option is model specific and the setting is saved in the options
database.

XS_STANDARD_STIFFENER_WIDTH_TOLERANCE

Category: Components

Use to define the tolerance between the actual and standard widths of
stiffener plates created by Stiffened shear plate (17), Haunch (40), Beam
with stiffeners (129), Column with shear plate (131), Bolted moment
connection (134), Beam to beam stub (135), Clip angle (141), Bent plate
(151), Moment connection (181), Column with stiffeners W (182), Column
with stiffeners (186), Column with stiffeners S (187), Stiffeners (1003), Web
stiffened base plate (1016), and Multiple stiffeners (1064).

Enter the value in millimeters. Do not use the value 0. The advanced option is
set to 10 by default.

This advanced option is model specific and the setting is saved in the options
database.

XS_STD_LOCALE

Category

This advanced option is system specific and should be set in the
lang_<CurrentLanguage>.ini files.

Use this advanced option to be able to open drawings in a situation where you
have English Tekla Structures and multi-byte locale Windows operating
system. Set it to one of the following values in the teklastructures.ini file,
depending on the locale of your operating system:

• set XS_STD_LOCALE=japanese
• set XS_STD_LOCALE=chinese-traditional
• set XS_STD_LOCALE=chinese-simplified
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• set XS_STD_LOCALE=russian_us.1251
• set XS_STD_LOCALE=korean_korea.949
If you set XS_STD_LOCALE to any other value, or leave the value out, English
locale is used by default.

NOTE For more information on locales, see https://msdn.microsoft.com/en-
us/library/ms903928.aspx.

XS_STD_PART_MODEL

Category

Numbering

To use standard parts in numbering, enter the standard part model folder
path. A standard-part model contains only standard parts with specific part
prefixes. As Tekla Structures carries out the numbering, it compares all of the
parts in the current model to the standard-part model. The numbering applies
any part position numbers (only the part prefix) found in the standard-part
model to all identical parts found in the current model.To not use standard
parts, leave the value out.

This advanced option is model specific and the setting is saved in the options
database.

Example
XS_STD_PART_MODEL=C:\TeklaStructuresModels\StandardParts\

See also

General numbering settings (page 601)

XS_STEEL1_TS_PAGE_9_EXTENSION

Category

This advanced option must be set in an initialization (.ini) file.

Used for localizing the contents of Component page 9. By default standard
component settings are used. For example, in the USA environment, you can
use the value _usimp.
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XS_STEEL1_TS_PAGE_10_EXTENSION

Category

This advanced option must be set in an initialization (.ini) file.

Used for localizing the contents of Component page 10 (catalog steps in stair
components). By default standard component settings are used.

Step profiles are coming from steps.dat file, which is environment specific.
To get a profile visible in the catalogue step/step profile list in the Stairs
component dialog box, the names of the profiles have to be listed also in the
environment-specific .inp file in the \TeklaStructures\<version>
\applications\stee11 folder. There are different files for each
environment: ts_page_10_australasia.inp, ts_page_10_austria.inp,
ts_page_10_china.inp, and so on. For example, in the USA environment,
you can use the value _usimp for this advanced option.

Affected stair components and options:

• Stairs (S71): Stair setup tab: Catalogue step

• Stairs (S82): Parameters tab: Step profile

For Stairs S71, the Step type must be set to Catalogue step, to be able to
select the step profile from the Catalogue step list.

XS_STORE_MULTIPLE_BAK_FILES

Category

File Locations

Set this advanced option to TRUE to store multiple versions of the backup copy
of the model database. The default value is FALSE.

A new copy of the .bak backup file is created each time the model is saved.
The name of each backup file includes the date and time the file was created.
Old or unnecessary files need to be deleted manually.
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XS_SUPERSCRIPT_HEIGHT_FACTOR

Category

Dimensioning: General

Use this advanced option to set the scale factor for the text height in
superscripts used in dimensions. The default is 0.7.

This advanced option is model specific and the setting is saved in the options
database.

Examples

Example number The advanced option is set to
0.7

1.5

0.5

XS_SUPERSCRIPT_USED_IN_DRAWING_TEXTS

Category

Dimensioning: General

Set to TRUE to enable the showing of superscript in texts in drawings, and to 
FALSE to disable it. The default is TRUE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_SWITCH_MULTI_NUMBERS_FOR

Category: Numbering

Use to define the order in which multidrawing numbers, and part or assembly
numbers appear in multi-numbers. The options are: NONE, ASSEMBLIES, 
PARTS and ASSEMBLIES_AND_PARTS. The default value is 
ASSEMBLIES_AND_PARTS.

This advanced option is model specific and the setting is saved in the options
database.

Example

If this advanced option is set to PARTS, the presentation of multinumbers for
parts is 101a, not a101.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_SWITCH_POS_NUMBERS_FOR

Category

Numbering

Changes the prefix you define for Tekla Structures assembly and/or part
marks to a suffix (for example, A1 becomes 1A). The options are NONE, PARTS, 
ASSEMBLIES, and ASSEMBLIES_AND_PARTS. The default value is 
ASSEMBLIES_AND_PARTS.

NOTE The advanced options XS_ASSEMBLY_POSITION_NUMBER_FORMAT_
STRING (page 83) and XS_PART_POSITION_NUMBER_FORMAT_STRING
(page 326) override the advanced option 
XS_SWITCH_POS_NUMBERS_FOR. XS_SWITCH_POS_NUMBERS_FOR has
no impact on assembly and/or part position numbers if you use 
XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING and/or 
XS_PART_POSITION_NUMBER_FORMAT_STRING.

This advanced option is model specific and the setting is saved in the options
database.
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SYMEDHOME

Category

Templates and symbols

Points to the location of the symbol editor message file. The default value is 
%XSBIN%.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_SYSTEM

Category: File locations

NOTE This advanced option is only meant for administrators.

It points to the location of the Tekla Structures system folder. The system
folder is used for storing files that define default settings. These include the
standard, data (.dat), property files, drawing files, template files, and report
files, for example.

Specifying more than one system folder

You can specify more than one system folder, and this way define specific
settings for each role. Use the role options defined in the
env_<environment>.ini file to point to the roles when specifying the
system folders in XS_SYSTEM. For example, XS_STEEL (\Steel), 
XS_CONCRETE (\Concrete), XS_ENGINEERING (\Engineering) and 
XS_PRECAST (\Precast) each point to the folders that contain the settings
specific to that role. An example for steel role option in the
env_<environment>.ini file could be as follows:

set XS_STEEL=%XSDATADIR%\environments\Steel\master_drawings\;%XSDATADIR%
\environments\Steel\model_filters\;%XSDATADIR%\environments\Steel
\model_settings\

To specify several system folders in XS_SYSTEM, enter the options pointing to
the role options and separate them by semicolons.

Example

set XS_SYSTEM=%XS_STEEL%;%XS_ENGINEERING%;%XS_CONTRACTOR%;%XS_GENERAL
%;%XSDATADIR%\environments\common\system\

Tekla Structures searches the folders from right to left. If files with identical
names exist in several folders, the one that is read last will be used. In the
example above, the files found from XS_STEEL will be used instead of the files
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with identical names in common\system\ or in any other folder mentioned
before the last folder.

This is a system-specific advanced option and cannot be changed.

1.19 Advanced options - T

TEMPLATE_FONT_CONVERSION_FILE

Category Templates and Symbols

Points to the location of the Tekla Structures system font (Template Editor
font) conversion file template_fonts.cnv. By default the path is
%DXK_FONTPATH%\template_fonts.cnv meaning, for example,
C:\ProgramData\Trimble\Tekla Structures\<version>\
\environments\common\fonts\\template_fonts.cnv. This file is used
for mapping Tekla Structures system fonts (fixfont, romsim, romsim8, romco)
to Windows fonts in DWG/DXF export.

The syntax: <Template Editor font>= windows font [* width
correction factor]
For example: romco = Times New Roman * 0.5
There is another conversion file, dxf_fonts.cnv, that converts the True Type
fonts to SHX fonts, for more information, see .

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

XS_TEMPLATE_DIRECTORY

Category: File locations

Points to the folder containing template (*.tpl) and report (*.rpt) files.

This advanced option is model specific and the setting is saved in the options
database.

You can use semicolon-separated lists of folder paths.
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XS_TEMPLATE_DIRECTORY_SYSTEM

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from environment files.
Generally, there is no need to modify system-specific settings. Do not modify
them if you are not an administrator.

This advanced option is used in env_<environment_name>.ini
environment initialization files to define the location of environment-specific
templates (.tpl) and reports (.rpt). You can use semicolon-separated lists of
folder paths.

Other users than administrators can define local folders using the advanced
options XS_FIRM, XS_PROJECT and XS_TEMPLATE_DIRECTORY.

Example
set XS_TEMPLATE_DIRECTORY_SYSTEM=%XSDATADIR%\environments\uk
\general\template\

See also

XS_TEMPLATE_DIRECTORY (page 425)

XS_FIRM (page 249)

XS_PROJECT (page 346)

XS_TEMPLATE_MARK_SUB_DIRECTORY

Category

File Locations

Use this advanced option to change the name of the subfolder where Tekla
Structures searches the templates that you use in marks. When you are
adding a template in a mark, the available templates are displayed in the
Mark content - template dialog box.

By default, mark is the value for this advanced option. You can create another
folder with another name and save your mark templates there, and enter the
name of that folder as the value for this advanced option.

This advanced option is model specific and the setting is saved in the options
database.

Example

Example of using another folder:

XS_TEMPLATE_MARK_SUB_DIRECTORY=my_mark_tpl
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The mark templates are in this example case searched from the following
folders in the following order:

%XS_TEMPLATE_DIRECTORY%\my_mark_tpl
ModelDir\my_mark_tpl
%XS_PROJECT%\my_mark_tpl
%XS_FIRM%\my_mark_tpl
%XS_TEMPLATE_DIRECTORY_SYSTEM%\my_mark_tpl
%XS_SYSTEM%\my_mark_tpl

See also

XS_TEXT_ORIENTATION_EPSILON

Category

Drawing Properties

Use to define the point where text or dimension mark text that is positioned
almost vertically is turned so that it is faced the other way around.

The default is 0.1, which is 5.72958 degrees. For example, if you want the text
to change (flip) at 100 degrees (or 10 off 90), you need to set this advanced
option to to .175.

This advanced option is model specific and the setting is saved in the options
database.

Example

See also
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XS_THICKNESS_PARAMETER_IS_CROSS_SECTION_THICKNESS

Category

Profiles

Use to define the method to measure the thickness of parts (flanges, plates,
walls and so on). When set to FALSE, the thickness parameter of the profile
defines the actual thickness. When set to TRUE, the thickness parameter
defines the cross section thickness (which is not same as the actual thickness if
the part is sloped).

The default value is FALSE. We recommend that you use this value.

The change applies to the following profile types:

• SPD

• EPD

• I

• RHS

• PD

• P

XS_TPLED_INI

Category

File Locations

Defines the location of the tpled.ini file.

This is a system-specific advanced option.

Example
..\ProgramData\Trimble\Tekla Structures\<version>\
\environments\default\template\settings\

XS_TRY_TO_KEEP_LOCATION_IN_FREEPLACING

Category

Drawing Properties

Use to fine-tune the functionality of the Arrange Drawing Objects command
in drawings.
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This advanced option is set to TRUE by default, meaning that the Arrange
Drawing Objects command tries to find a new location for the selected object
as close to the current location as possible. If the current location is free, the
object is not moved at all.

When this advanced option is set to FALSE, the Arrange Drawing Objects
command works the same way as Ignore Current Locations.

This advanced option is model specific and the setting is saved in the options
database.

XS_TUBE_UNWRAP_LIMIT_THICKNESS

Category

Drawing Properties

Use this advanced option to define how Tekla Structures draws tubes.

Set to a decimal value. Tekla Structures individually draws the inner and outer
surfaces of tubes that are thicker than this value.

This advanced option is model specific and the setting is saved in the options
database.

NOTE If the advanced option XS_TUBE_UNWRAP_WITH_CUT_HOLES is set to 
TRUE, this advanced option has no effect.

See also

XS_TUBE_UNWRAP_WITH_CUT_HOLES (page 430)

XS_TUBE_UNWRAP_PAPER_THICKNESS

Category

Drawing Properties

This advanced option lengthens unfolded tubes by the following multiplication
factor:

factor = 1.0+2*XS_TUBE_UNWRAP_PAPER_THICKNESS/diameter

The default value is 0.0.

NOTE If the advanced option XS_TUBE_UNWRAP_WITH_CUT_HOLES is set to 
TRUE, this advanced option has no effect.

This advanced option is model specific and the setting is saved in the options
database.
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Example

Tube d=219

When you set the advanced option to 0, the unwrapped length of the tube
(1.0*PI*diameter) = 688.

When the advanced option is set to 10, the length of the unfolded tube =
factor * diameter* PI = (1.0 + 2*10/219) * 219 * 3.14 = 751

See also

XS_TUBE_UNWRAP_WITH_CUT_HOLES (page 430)

XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC

Category

CNC

To use the plate profile type B in the NC file header data for unwrapped round
tubes, set this advanced option to TRUE. To use RO for round tubes, set it to 
FALSE. The default value is TRUE.

This advanced option only works for straight tubes, not for polybeam tubes.

This advanced option is model specific and the setting is saved in the options
database.

WARNING Use this advanced option only when you have set the advanced
option XS_TUBE_UNWRAP_WITH_CUT_HOLES to TRUE.

See also

XS_TUBE_UNWRAP_WITH_CUT_HOLES (page 430)

XS_TUBE_UNWRAP_WITH_CUT_HOLES

Category

Drawing Properties

Set to TRUE to include cut holes in workshop drawings or NC files of
unwrapped CHS (circular hollow section) profiles.

This advanced option is set to TRUE by default. If you set it to FALSE, then the
previously existing unwrapping method is applied.
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This advanced option is model specific and the setting is saved in the options
database.

NOTE If you set this advanced option to TRUE, the advanced options 
XS_TUBE_UNWRAP_LIMIT_THICKNESS and 
XS_TUBE_UNWRAP_PAPER_THICKNESS have no effect.

Note also that using this advanced option does not affect conical tube
profiles.

See also

XS_TUBE_UNWRAP_LIMIT_THICKNESS (page 429)

XS_TUBE_UNWRAP_PAPER_THICKNESS (page 429)

XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC (page 430)

1.20 Advanced options - U
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XS_UEL_IMPORT_FOLDER

This advanced option must be set in an initialization (.ini) file. It is system-
specific.

You can collect all the .uel files exported from your custom components and
sketched profiles in folders, and then automatically import them to new
models. Use this advanced option to point to the folders which contain
the .uel files. Note that you must still manually export the desired custom
components and sketched profiles to these folders.

You can point to several folders if you separate the folders with a semicolon.
For example:

set XS_UEL_IMPORT_FOLDER=%XSDATADIR%\environments\default
\components_sketches\;%XSDATADIR%\environments\common\components_sketches
\concrete\;%XSDATADIR%\environments\common\components_sketches\steel
\;%XSDATADIR%\environments\common\components_sketches\

When this advanced option is set (preferably in the user.ini file), and you
create a new model, Tekla Structures automatically imports the .uel files to
the model.

NOTE To take the custom components and related sketched profiles in use
in existing models, import the .uel files through the Applications &
components catalog. If the .uel files only contain sketched profiles,
import them through the profile catalog.

XS_UNDERLINE_AFTER_POSITION_NUMBER_IN_HARDSTAMP

Category

CNC

Set the advanced option to TRUE to have an underscore (_) after the part
position (without an assembly position) in a hardstamp.

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_UNFOLDING_ANGLE_DIM_FORMAT

Category

Dimensioning: Unfolding
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Use to define the format of angle text by entering an integer 0 - 7. The default
value is 1. Enter one of the following values:

• 0 = ###

• 1 = ###[.#]

• 2 = ###.#

• 3 = ###[.##]

• 4 = ###.##

• 5 = ###[.###]

• 6 = ###.###

• 7 = ### #/#

This advanced option is model specific and the setting is saved in the options
database.

XS_UNFOLDING_DONT_USE_NEUTRAL_AXIS_FOR_RADIUS

Category

Dimensioning: Unfolding

Set this advanced option to FALSE to use the neutral axis of the part to
calculate the bending radius in unfolded views. Set this advanced option to 
TRUE to calculate the bending radius from the inner surface of the part. The
default value is TRUE.. This advanced option only affects curved polybeams.

This advanced option is model specific and the setting is saved in the options
database.

Note that this advanced option does not work if
XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION (page 455) is set to TRUE.

NOTE The settings in the unfold_corner_ratios.inp override this
advanced option.

XS_UNFOLDING_ANGLE_DIM_PRECISION

Category

Dimensioning: unfolding

Use to define the precision of angle text. Enter an integer 1 - 10. The default
value is 10. Enter one of the following values:

• 1 = 0.00
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• 2 = 0.50

• 3 = 0.33

• 4 = 0.25

• 5 = 1/8

• 6 = 1/16

• 7 = 1/32

• 8 = 1/10

• 9 = 1/100

• 10 = 1/1000

Values 1 - 4 are intended for defining precision with rounding. For example,
with precision 0.33 the actual dimension 50.40 is shown as 50.33. Values 5 - 7
are used for imperial units only. Values 8 - 10 are used for defining precision
without rounding.

This advanced option is model specific and the setting is saved in the options
database.

XS_UNFOLDING_PLANE_EPSILON

Category

Dimensioning: Unfolding

Use to specify the limit for checking if all section points are on the same plane.
If the points are on the same plane, the part can be unfolded. Enter the value
in millimeters.The default value is 0.01 mm.

This advanced option is model specific and the setting is saved in the options
database.

XS_UNIQUE_NUMBERS

Category

Numbering

Set this advanced option to TRUE to have Tekla Structures create unique
position numbers for all parts when numbering, even if they are equal. The
default value is FALSE.

See also

XS_UNIQUE_ASSEMBLY_NUMBERS (page 435)
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XS_UNIQUE_ASSEMBLY_NUMBERS

Category

Numbering

Set to TRUE if you want Tekla Structures to create unique position numbers for
all assemblies when numbering, even if they are identical.

The default value is FALSE.

Parts are still numbered the same way as before.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_UNIQUE_NUMBERS (page 434)

XS_UPDATE_MARK_PLACING_IN_DRAWING

Category

Marking: Parts

Updates the position of updated marks in specific drawing types. Use the
letters in the following table to specify the drawing types.

Letter Drawing type
W Single-part drawings
A Assembly drawings
M Multidrawings
G General arrangement

drawings
C Cast unit drawings

The default value is AMW, which means that the mark position is updated in
assembly drawings, multidrawings and single-part drawings.

This advanced option is model specific and the setting is saved in the options
database.

Example

To update the position of updated part marks in single-part, assembly, multi-,
and general arrangement drawings:

XS_UPDATE_MARK_PLACING_IN_DRAWING=WAMG
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XS_UPDATE_MARKS_IN_FROZEN_DRAWINGS

Category

Marking: General

Set this advanced option to TRUE to automatically update marks in frozen
drawings and create new marks if new parts have been added. If you set it to 
FALSE, Tekla Structures only updates parts and bolts. The default value is 
TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_UPLOAD_SHARED_MODEL_TO_CONNECT

Category

Multi-user

Use this advanced option to select when a Tekla Structures model that has
been shared with Tekla Model Sharing is uploaded to a folder in the attached
Trimble Connect folder. The shared model will be uploaded to this folder as a
read-only .tekla reference model that you can use in Tekla Structures and
Trimble Connect.

The options are:

• BASELINE (default) = The shared model is automatically uploaded to the
set Trimble Connect project folder each time a user creates a new baseline.

• WRITEOUT = The shared model is automatically uploaded to the set Trimble
Connect project folder after each successful write out.

• <NO VALUE> = The shared model is never uploaded to the set Trimble
Connect project folder.

Note that the path to the Trimble Connect project folder is set with the 
XS_CONNECT_UPLOAD_MODEL_FOLDER (page 124) advanced option.

This advanced option is model specific and the setting is saved in the options
database.

XS_UPSIDE_DOWN_TEXT_ALLOWED

Category: Concrete detailing

Set this advanced option to TRUE to have the text reading direction indicate
the part installation direction. If there are similar asymmetric parts with
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different orientation, some part marks may be placed upside down. When you
set the advanced option to FALSE (default), none of the part marks are created
upside down, so the text reading direction does not indicate the installation
direction. If you set it to

• CONCRETE, only concrete marks and texts are upside down

• STEEL, only steel marks and texts are upside down

• TIMBER, only timber marks and texts are upside down

You can also use combinations of values separated by a comma, for example, 
CONCRETE,STEEL.

Example of the mark orientation when the advanced option is set to TRUE.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

For more information about indicating part orientation with marks, for
example, see .
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XS_USABSOLUTE_TO_RELATIVE_LIMIT

Category

Dimensioning: General

Use to affect the distance within which the first and last US Absolute
dimension lines appear as relative. By default, this advanced option is not set
to any value.

Example
XS_USABSOLUTE_TO_RELATIVE_LIMIT=1000
In this example, Tekla Structures will change first and last dimension lines
shorter than 1000 mm to Relative dimensions. Dimension lines greater or
equal to 1000 mm will remain US Absolute dimensions.

This advanced option is model specific and the setting is saved in the options
database.

XS_USABSOLUTE2_TO_RELATIVE_LENGTH_FACTOR

Category

Dimensioning: General

Tekla Structures multiplies the space required by US Absolute2 dimension text
by this value. If the result is larger than the actual dimension, Tekla Structures
changes the dimension type to relative. The default value is 1.5.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_ANTI_ALIASING_IN_DX

Category: Model View

Use this advanced option to control whether antialiasing is used in the DirectX
rendered model views. Antialiasing makes the edge lines smoother but with
low resolution screens it can make the lines look thicker.

By default, this advanced option is set to TRUE.
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XS_USE_ASSEMBLY_EXTREMA_IN_MARK_PLACING

Category - Marking: General

Use this advanced option to place part marks on top of the assembly instead
of on top of the main part. First create a drawing view filter and enter the
name of the filter as the value. This advanced option can only be used for
main parts of assemblies or cast units, not for secondary parts.

The example below uses part names as the filtering criteria.

When you (re)create the drawing, the mark place changes from this:
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To this:

The supported mark placing types are shown below.

XS_USE_ASSEMBLY_NUMBER_FOR

Category: Numbering

Use this advanced option if you want the assembly/cast unit number to be
also the main part number for the corresponding assembly/cast unit. Use one
of the following options:

• Leave this option blank for each part in the assembly to get a part number,
regardless of whether the assembly contains only one main part or several
parts. Click the link to see an example of one part only or of multiple parts.
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• Set to MAIN_PART to always assign the assembly or cast unit number to the
main part of an assembly or cast unit. All other parts, if any, will use part
number. Click the link to see an example of one part only or of multiple
parts.

• Set to LOOSE_PART to assign the assembly or cast unit number to the main
part of an assembly or cast unit that has no other parts. If the assembly or
cast unit has several parts, the main part will receive a part number. Click
the link to see an example of one part only or of multiple parts.

The assembly prefix replaces the part prefix.

NOTE Do not use the same prefix for parts and assemblies.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_USE_BOLT_DISTANCE_IN_NOTCH_CALCULATIONS
This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to use automatic notch height calculation
according to bolt distance. This affects connections 129 and 184.

XS_USE_COLOR_DRAWINGS

Category

Drawing View

Changes the default color mode in drawings when the Tekla Structures is
started. If you set this advanced option to FALSE or leave the value out,
drawings are black and white. Set it to GRAY to have gray scale drawings. Set it
to any other value, for example, COLOR, TRUE or 1, to use colors in drawings. 
TRUE is the default value.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also
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XS_USE_CONVEX_PROTECT_AREA

Category

Drawing Properties

Set this advanced option to TRUE to automatically calculate the protection
area more accurately along the faces of parts, so that part marks can be
placed inside the profile also for curved hollow sections. To protect the area
the object covers, enter FALSE. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_CROSS_FOR_OPENING_SYMBOL

Category

Drawing Properties

Use XS_USE_CROSS_FOR_OPENING_SYMBOL to select how the openings/
recesses are shown and the symbols to be used.

The default value is TRUE, which means that a cross is used as the opening/
recess symbol.

This advanced option is model specific and the setting is saved in the options
database.

Value Description
TRUE
This is the
default.

Crosses are used as symbols for openings as follows:

If the recess is on the front face of the part, recess
symbol and bounding lines are shown as unbroken
lines as follows:

If the recess is on the back face of the part, recess
symbol and bounding lines are shown as dashed
lines as follows:
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Value Description

FALSE Shadows are used as symbols for openings as
follows:

If the recess is on the front face of the part, there is
no recess symbol, and bounding lines are shown as
unbroken lines as follows:

If the recess is on the back face of the part, there is
no recess symbol, and bounding lines are shown as
dashed lines as follows:

XS_USE_DASHED_HIDDEN_LINES

Category: Model View

Use this advanced option to control whether the part hidden lines are visible
in the DirectX rendered model views. The default value is TRUE.

When XS_USE_DASHED_HIDDEN_LINES is set to TRUE, Tekla Structures shows
in transparent DirectX rendered model views the part edge lines that are
hidden behind another part. Additionally, Tekla Structures performance
increases.

When XS_USE_DASHED_HIDDEN_LINES is set to FALSE, Tekla Structures does
not show the hidden lines, and the performance effect is removed.

Restart Tekla Structures to activate the new value.
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XS_USE_DRAWING_NAME_AS_PLOT_FILE_NAME

Category

This advanced option must be set in an initialization (.ini) file.

Set this advanced option to TRUE to prevent Tekla Structures from converting
the dot in the drawing name to an underscore in the plot file name when
printing, for example B.1 to B_1. The default value is FALSE.

XS_USE_DYNAMIC_ROW_WIDTH_IN_TEMPLATES

Category

This advanced option is available only in initialization files.

This advanced option does not work in report templates.

Set this advanced option to TRUE to fit the template row width dynamically
according to the content, for example, drawing frames according to the
different drawing sizes. The content must always be located on the right. If you
set this advanced option to FALSE, automating fitting of the templates rows is
not in use.

The default value is FALSE.
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NOTE This functionality is not available in drawing part mark templates.

XS_USE_DRAWING_NAME_AS_PLOT_TITLE

Category

Printing
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Set this advanced option to TRUE when you want to use the drawing name as
the print title, for example, when printing to a .pdf file or to a Windows
printer. To use the general Tekla Structures print title, such as "Tekla
Structures drawing - A [T.100]", set it to FALSE. The default value is TRUE.

As a result, the Windows printer dialog box, and the pdf file name will contain
the drawing print file name you define with the advanced options listed below.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_DRAWING_PLOT_FILE_NAME_A (page 204)

XS_DRAWING_PLOT_FILE_NAME_C (page 208)

XS_DRAWING_PLOT_FILE_NAME_W (page 205)

XS_DRAWING_PLOT_FILE_NAME_G (page 206)

XS_DRAWING_PLOT_FILE_NAME_M (page 207)

XS_USE_EIGHT_COLORS_IN_MODELING_VIEWS

Set this advanced option in the user.ini file located in ..\Users\<user>
\AppData\Local\Trimble\Tekla Structures\<version>
\UserSettings.

Set to TRUE to disable additional colors in model views. The default value is 
FALSE.

XS_USE_EXACT_SOLID_FOR_CLASH_CHECK

Category

Speed and Accuracy

If you set this advanced option to FALSE (default), normal solid accuracy is
used in clash checking. If you need to use high solid accuracy in clash checking,
set this advanced option to TRUE. This advanced option is model specific.

WARNING Using high accuracy, that is, setting this advanced option to TRUE,
slows down the clash checking process, and there is a higher risk
of solid errors.
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XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_
DRAWINGS

Category

Single Part View in Assembly Drawing

You can specify whether to create new views or to use views from existing
single part drawings in assembly drawings. When this advanced option is set
to TRUE, existing single part drawing views will be used in assembly drawings.
When set to FALSE, or if there is no existing single part drawing for a given
part, a new view will be created according to the Single-part attributes
setting ( Assembly drawing properties --> Layout --> Other ). The default
value is FALSE.

NOTE This setting only works with assembly drawings, not with
multidrawings

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_EXISTING_SINGLE_PART_DRAWINGS_SCALE

Category: Single Part View in Assembly Drawing

If you do not want to maintain the scale of the existing single part drawing
included in an assembly drawing, set the advanced option 
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_SCALE to FALSE. When you do
this, the scale of the included single part drawing will follow the scale of the
assembly drawing, or advanced option XS_SINGLE_SCALE (page 408) if it is
set.

Tekla Structures maintains the original scale in a single part drawing in an
assembly drawing when you set the layout to include single part drawings, and
set the option 
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_DRAWINGS
(page 446) is set to TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_FLAT_DESIGNATION

Category

Plate Work
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Set this advanced option to TRUE to use flat bar designation. To turn the
advanced option off, set it to FALSE. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_LINECLIP

Category: Printing

Set this advanced option to TRUE to clip continuous lines at objects in drawing
printouts (paper or .pdf). Set to FALSE to display continuous lines, for
example, to run the line through text or drawing marks. The default value is 
TRUE.

XS_USE_LINECLIP is set to TRUE:

XS_USE_LINECLIP is set to FALSE:

Note that this setting only affects drawings printed using the old printing
functionality (XS_USE_OLD_PLOT_DIALOG=TRUE), and it does not completely
match what you see in drawings in Tekla Structures. If 
XS_USE_OLD_PLOT_DIALOG is set to FALSE (default), then XS_USE_LINECLIP
has currently no effect, and the lines are clipped in the same way in drawings
and in printouts.

This is how the line clipping is displayed in drawings currently:

This is how it is printed:
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This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_USE_LONG_POINTS_IN_DIMENSIONING

Category

Dimensioning: Parts

Sometimes there may be a need to dimension the parts in assembly or single-
part drawings so that copes or notches are not taken into account, for
example, to estimate the space needed for transportation.

If you set this advanced option to TRUE, the overall dimensions are calculated
to long points. If you set it to FALSE, the overall dimensions are calculated to
cope points. FALSE is the default.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

In the example below, the upper dimension (the red one) shows the result
when this advanced option is set to TRUE, and the lower one when it is set to 
FALSE (the green one).

WARNING Using this advanced option will not affect the length of the part in
the BOM, reports, or CNC.
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XS_USE_MODEL_PREFIX_IN_MULTI_NUMBERS_FOR

Category: Numbering

Use to allow the prefixes used in part and assembly numbering to be used in
multidrawing numbers. Enter any of the following options: NONE, ASSEMBLIES, 
PARTS, and ASSEMBLIES_AND_PARTS. The default value is 
ASSEMBLIES_AND_PARTS.

This advanced option is model specific and the setting is saved in the options
database.

Example

If you set this advanced option to PARTS, the multinumbers for parts appear
as 101Pa.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_MODEL_PREFIX_INFLUENCES_MULTI_NUMBERING_FOR (page 308)

XS_USE_MULTI_NUMBERING_FOR

Category: Numbering

Use to define if multinumbering affects assemblies, parts, or both. Part and
assembly numbering must be based on drawing numbers to use
multinumbering.

The options are:

• NONE: No assemblies or parts will get multi-numbered, even if linked to
multidrawings.

• ASSEMBLIES: Assemblies will get multinumbered, but parts will not. This is
the default US Imperial Steel setting.

• PARTS: Only parts will get multinumbered. Common if you are creating
drawings for assemblies one per sheet, and handling parts on large
collection sheets grouped by plates, or angles, for example.

• ASSEMBLIES_AND_PARTS: Both assemblies and parts will get
multinumbering, but how is determined by workflow and other settings.

The default value is ASSEMBLIES_AND_PARTS.

WARNING Do not change the value during a project.

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_MULTI_NUMBERING_INCLUDE_ASSEMBLY_PARTS (page 310)

XS_USE_MULTI_NUMBERING_WHEN_COPYING_DRAWING_VIEWS (page 451)

XS_USE_NUMERIC_MULTI_NUMBERS_FOR (page 453)

XS_MODEL_PREFIX_INFLUENCES_MULTI_NUMBERING_FOR (page 308)

XS_USE_MODEL_PREFIX_IN_MULTI_NUMBERS_FOR (page 450)

XS_SWITCH_MULTI_NUMBERS_FOR (page 423)

XS_PART_MULTI_NUMBER_FORMAT_STRING (page 326)

XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING (page 81)

XS_CAST_UNIT_MULTI_NUMBER_FORMAT_STRING (page 104)

XS_VALID_CHARS_FOR_PART_MULTI_NUMBERS (page 470)

XS_VALID_CHARS_FOR_ASSEMBLY_MULTI_NUMBERS (page 470)

XS_MIN_NUMBER_OF_PART_MULTI_CHARACTERS (page 306)

XS_MIN_NUMBER_OF_ASSEMBLY_MULTI_CHARACTERS (page 305)

XS_USE_MULTI_NUMBERING_WHEN_COPYING_DRAWING_
VIEWS

Category: Numbering

Set this advanced option to TRUE to use multinumbering when copying
drawing views. If you do not want to use multinumbering, set it to FALSE. The
default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_USE_NEW_PLATE_DESIGNATION

Category

Plate Work

Use this advanced option to control if the width and length are switched in
parts if the width is greater than the length. The options are:

• Option is not used: set value to blank or FALSE.
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• Option is used only for steel parts: set value to FOR_STEEL_PARTS_ONLY.

• Option is used for all parts: set value to TRUE. This option is also used if
value is set to anything else that does not match the other options above.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

Example

A beam has the profile BL15*240 and the distance between beam endpoints is
changed to 215 mm:

• If XS_USE_NEW_PLATE_DESIGNATION is used, the length of the beam is
fixed at 240, and the beam profile changes to BL15*215.

• If XS_USE_NEW_PLATE_DESIGNATION is not used, the length of the beam
is 215 and the profile remains BL15*240.

XS_USE_NEW_WELD_PLACING

Category

Welds

If you have set welds visible in the drawing, this advanced option affects in
which drawing view (front, back, top, or bottom) Tekla Structures draws the
welds.

• When the advanced option is set to TRUE, Tekla Structures draws welds in
the view that has the best visibility to the secondary part (default).

• When the advanced option is set to FALSE, Tekla Structures selects the
view according to the main part.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_NEW_USNOTCH

Category

Components

Use to indicate whether to locate the horizontal cut of a notch above or below
the flange of the main beam. The default value is TRUE. If you do not want to
use the US style notch, set this advanced options to FALSE.
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Used with the following notching options:

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_NUMBER_SELECTED_FOR_DRAWING_CREATION_AND_
UPDATE

Category: Numbering

If the numbering is not up to date when you create a drawing, Tekla Structures
asks you to number the model.

Set this advanced option to TRUE to number only the assemblies and parts
that have the same numbering series as the selected part (or the main part of
the selected drawing).

When set to TRUE, this advanced option does the same as if you clicked
Drawings & reports --> Number series of selected objects . TRUE is the
default value.

If you set this advanced option to FALSE, Tekla Structures numbers the whole
model, which is the same as clicking Drawings & reports --> Numbering -->
Number modified objects .

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_NUMERIC_MULTI_NUMBERS_FOR

Category: Numbering

Use to define which objects have numeric multi-numbers. The options are:

• ASSEMBLIES
• PARTS
• ASSEMBLIES_AND_PARTS
• NONE
This advanced option is model specific and the setting is saved in the options
database.
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Example

If you set this advanced option to PARTS, Tekla Structures displays the part
multinumber as e.g. 101/1, instead of 101/a.

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_USE_OLD_DRAWING_CREATION_SETTINGS

This advanced option must be set in an initialization (.ini) file.

Set the advanced option XS_USE_OLD_DRAWING_CREATION_SETTINGS to 
TRUE to use old drawing functionality and old drawing view property dialog
boxes and subdialog boxes. In this old approach, drawing object properties
can be defined on both drawing and view level, not individually for each view,
like in the new view-level approach. View-level dimensioning rules are not
supported.

By default, this advanced option is not in use.

Where to change the value depends on your company or project size, and on
which level you need to unify certain enterprise-level settings. You can set this
advanced option to TRUE in the options.ini file under the current model
folder, in company's own company.ini file, your company's own role.ini
file, or the options.ini file in firm or project folders , for example.

Note that Trimble Solutions no longer maintains the old functionality and
dialog boxes. In practice, this means that new features, like custom
presentations or automatic view-level properties will not be available in the old
dialog boxes.

XS_USE_OLD_DRAWING_EXPORT

This advanced option must be set in an initialization (.ini) file.

If you want to use the old DWG/DXF export, set the advanced option 
XS_USE_OLD_DRAWING_EXPORT to TRUE in an .ini file. This advanced option
is by default set to FALSE .

For instructions on using the old export, see .
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XS_USE_OLD_DRAWING_LIST_DIALOG

Category: Drawing Properties

Document manager is enabled by default instead of Drawing list. All
commands and buttons that would have launched Drawing list in earlier
Tekla Structures versions will from version 2018i onwards launch Document
manager. If you want to enable the old Drawing list instead, set this
advanced option to TRUE. If you do this, Document manager will be disabled.

This advanced option is user specific and the setting is saved in options.bin
under user folder.

For details about Document manager, see .

For details about Drawing list, see .

XS_USE_OLD_PLOT_DIALOG

Category

Printing

Set this advanced option to TRUE to use Printer Catalog and Tekla Structures
own printer instances in printing.

The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION

Category

Dimensioning: Unfolding

Set this advanced option to TRUE to calculate polybeam length using the
legacy method where lengths of straight parts are added together, without
taking the unfolding into account. If you set it to FALSE (default) and use the
new method, the polybeam length is defined by unfolding the polybeam first
and then calculating the length. This way of calculating gives a more accurate
value for the polybeam length.

This advanced option is model specific and the setting is saved in the options
database.
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NOTE Using this advanced option is not recommended, because the length
may not be reported correctly in all cases, especially for polybeams
with curved chamfers.

NOTE When you switch on this advanced option, other ways to calculate
polybeam length are not used by Tekla Structures, for example, 
XS_CALCULATE_POLYBEAM_LENGTH_ALONG_REFERENCE_LINE, 
XS_DONT_USE_NEUTRAL_AXIS_FOR_RADIUS or the unfold parameter
settings in file unfold_corner_ratios.inp.

See also

XS_CALCULATE_POLYBEAM_LENGTH_ALONG_REFERENCE_LINE (page 101)

XS_USE_ONLY_INCHES_IN_SHEET_SIZES

Category

Imperial Units

Set this advanced option to TRUE to have sheet sizes in layouts and drawing
lists in inches. To have the sheet sizes in feet and inches, set it to FALSE
(default).

In order for this advanced option to work, set the advanced options 
XS_IMPERIAL and XS_IMPERIAL_INPUT to TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_ONLY_INCHES_IN_WELD_LENGTH

Category

Imperial units

Set this advanced option to TRUE to only display inches in weld length
symbols. If you do not want to do this, set this advanced option to FALSE. This
advanced option only works when the imperial units are in use. The default
value is TRUE.

When you only display inches means that instead of showing 1ft 2inch it
shows 14inch, for example.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_USE_ONLY_NOMINAL_REBAR_DIAMETER

Category

Concrete Detailing

Nominal diameter is the diameter used for calculating the cross section area
of the reinforcing bar. Actual diameter takes into account the ribs, and tells the
smallest hole diameter where the bar fits.

Values used for nominal and actual diameter are defined in
rebar_database.inp, which is located in the environment folders in
\<environment>\profil.

Set the advanced option to TRUE to use nominal diameter. To use the actual
diameter set this advanced option to FALSE. The default value is FALSE.

When the advanced option is set to FALSE, and you open a model created
earlier than Tekla Structures version 18, the center line of the reinforcing bars
stays in place and the concrete cover is reduced. All bending dimensions of the
reinforcing bar increase. To solve this problem, either set the advanced option
to TRUE or modify the concrete covers of all reinforcing bars to the correct
value.

When reinforcing bars are exported to Unitechnik, you can select to export
either nominal or actual diameters. For other exports (for example, BVBS), the
nominal diameter is always used in the exported definitions regardless of this
advanced option.

WARNING Do not change this option during a project.

Changing the advanced option also changes the modeled
reinforcing bars. This means that if the actual diameter will be
used, the reinforcing bar looks thicker in the model. To
accommodate for the thicker reinforcing bar, Tekla Structures will
automatically change also concrete cover thickness. When you
change the option, Tekla Structures changes the concrete cover
values after next restart.

This advanced option is role specific. When the type SYSTEM(ROLE) is in use,
the default value is used. When the type MODEL(ROLE) or DRAWING(ROLE) is
in use, you can change the value, which is then the same for all users in the
current model.

XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES

Category

Drawing Properties
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Use XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES to select whether to use
an opening symbol in openings located at part borders.

Value Description
TRUE Opening symbol is used in the

openings located at the border of
the part. The symbol used
depends on the setting of the
advanced option 
XS_USE_CROSS_FOR_OPENING_S
YMBOL

FALSE
This is the default.

No opening symbol is used for
openings at the border of the
part.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_CROSS_FOR_OPENING_SYMBOL (page 442)

XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES

Category

Drawing Properties

Advanced options reference 458 Advanced options - U



Use XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES to select whether to use
the opening symbol in openings located in part corners.

Value Description
TRUE Opening symbol is used in the

openings located in the corner of
the part. The symbol used
depends on the setting of the
advanced option 
XS_USE_CROSS_FOR_OPENING_S
YMBOL.

FALSE
This is the default.

No opening symbol is used for
openings in the corner of the part.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_CROSS_FOR_OPENING_SYMBOL (page 442)

XS_USE_PLATE_SIDE_POSITIONING

Category

Dimensioning: Parts

Set this advanced option to TRUE to make the position dimension of plates
dependent on the position of the plates in the model. When a plate is
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positioned underneath the work plane, Tekla Structures will place the position
dimension on the top face of the plate. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_POINT_AS_SEPARATOR_IN_PROFILE_NAME

Category

Profiles

Set this advanced option to TRUE to use the period character (.) as the
separator in parametric profile names, instead of using it as a decimal
separator. This increases the number of separators available in the US
imperial environment. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_RECESS_SYMBOL_FOR_BORDER_AND_CORNER_
RECESSES

Category: Drawing properties

Use XS_USE_RECESS_SYMBOL_FOR_BORDER_AND_CORNER_RECESSES to
select whether to use the recess symbol in corner and border recesses. TRUE
is the default value.

This advanced option is model specific and the setting is saved in the options
database.

Value Description
TRUE Recess symbol is used in the recesses

located at the border or in the corner
of the part. The symbol used depends
on the setting of the advanced option 
XS_USE_CROSS_FOR_OPENING_SYMB
OL
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Value Description
FALSE No recess symbol is used for recesses

at the borders or in the corners of the
part.

See also

XS_USE_CROSS_FOR_OPENING_SYMBOL (page 442)

XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES (page 457)

XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES (page 458)

XS_USE_REPAIR_NUMBERING_INSTEAD_OF_NUMBERING

Category: Numbering

If this advanced option is set to TRUE, Tekla Structures automatically repairs
numbering instead of only running numbering.

When this advanced option is set to TRUE:

• Using the Number modified objects command does the same as using
the Diagnose and repair numbering: All command

• Using the Number series of selected objects command does the same as
using the Diagnose and repair numbering: Series of selected objects
command

The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_ROUND_MAIN_PART_COORDINATES_FOR_
SECONDARY_PART_ANGLE

Category

Dimensioning: Parts
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Set to TRUE to have the secondary part skewed dimensions and angle
dimension use one of the main part directions if the main part profile is round
or round tube. The default value is TRUE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_SCREW_POINT_ELEVATION_DIM

Category

Dimensioning: Bolts

Set this advanced option to TRUE to display the elevation dimensions of a
column to the working points of a neighboring part. If you set it to FALSE, the
elevation dimensions are displayed at the ends of the column. The default
value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

Example

An example, where the value is TRUE:
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An example, where the value is FALSE:

XS_USE_SMALLER_GUSSET_PLATE

Category

Components

Set this advanced option to TRUE to minimize the size of rectangular gusset
plates created by gusset connections. You can create smaller gusset plates by
using a single bracing and secondary bolts dimensioned to the middle of the
secondary part. Tekla Structures generates a triangular gusset plate when the
main part is located between diagonals. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_SMART_PAN

Category: Drawing View

Set this advanced option to TRUE to enable optimized zooming and panning in
drawings. This advanced option is by default set to FALSE, because using
optimization sometimes results in unwanted checkerboard effect.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Restart Tekla Structures after changing the value to activate the new setting.
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XS_USE_SMOOTH_LINES

Category

Model View

Set this advanced option to TRUE to use anti-aliasing to minimize jagged edges
in model views. Before using this advanced option, check that your display
adapter supports anti-aliasing. This advanced option is supported only for
OpenGL rendering.

The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_USE_SOFTWARE_RENDERING

Category

Model view

Set this advanced option to TRUE to bypass your graphic adapter in model
views. Use this advanced option if you have problems with your display (for
example, lines are not drawn correctly). The default value is FALSE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_USE_SPECIAL_FILLER_PLATE_THICKNESS

Category

Profiles

Set this advanced option to TRUE to have shim plate thicknesses comply with
Japanese standards. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_TUBE_INNER_LENGTH_IN_DIMENSIONING

Category

Dimensioning: Parts
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Set to TRUE to dimension the overall length of tube profiles along the inner
surface instead of outer surface. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_UP_DOWN_SIGN_INDICATOR_FOR_ANGLE_IN_UNFOLDING

Category: Dimensioning: Unfolding

Set this advanced option to TRUE to show Up and Down text instead of
positive and negative angle values in unfolded single-part drawings for angle
dimensions. FALSE is the default value.

Setting this advanced option to TRUE will omit the text specified for the
advanced option 
XS_ANGLE_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_DRAW_BENDING_END_LINE_DIMENSIONS_IN_UNFOLDING (page 173)

XS_DRAW_BENDING_END_LINES_IN_UNFOLDING (page 174)

XS_USE_USABSOLUTE_ARROW_TYPE_FOR_ABSOLUTE_
DIMENSIONS

Category

Dimensioning: General

Set this advanced option to TRUE to use the arrow shape US Absolute also for
normal absolute dimensions. FALSE is the default value.
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You can select the arrow shape from the US Absolute dimensions list on the
Appearance tab in the dimension properties dialog box.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT

Category

Concrete Detailing

Set this advanced option to TRUE to calculate the length and weight of the
reinforcing bars in Rebar Shape Manager using formulas in the fields L and 
WEIGHT.

If you set this advanced option to FALSE, the length and the weight are
automatically calculated according to the center line of the reinforcing bars.
The default value is FALSE.

To read the length and weight from Rebar Shape Manager, you also have to
set XS_USE_USER_DEFINED_REBARSHAPERULES to TRUE.

NOTE This setting only affects reports. If you set this advanced option to 
TRUE and you have not defined the formulas for length and weight in
Rebar Shape Manager, the values in the reports show zero (0).

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USE_USER_DEFINED_REBARSHAPERULES (page 466)

XS_USE_USER_DEFINED_REBARSHAPERULES

Category

Concrete Detailing

Use this advanced option to define whether reinforcing bar bending shapes
are recognized according to the bending shape definitions created with Rebar
Shape Manager and saved in the RebarShapeRules.xml file.

This advanced option is set to TRUE by default, meaning that the bending
shape recognition uses the reinforcing bar shapes saved in the
RebarShapeRules.xml file.

If you set this advanced option to FALSE, the Rebar Shape Manager
definitions are not used, and the definitions in

Advanced options reference 466 Advanced options - U



rebar_schedule_config.inp are used instead. We recommend that you
set this advanced option to TRUE and use Rebar Shape Manager.

This advanced option is model specific and the setting is saved in the options
database.

XS_USE_VERTICAL_PLACING_FOR_COLUMNS_IN

Category: Drawing Properties

Use to place columns vertically in single part, assembly and cast unit drawings.
Use the following options to specify the types of drawings where the columns
should be placed vertically:

• ASSEMBLY_DRAWINGS - in assembly drawings and cast unit drawings only

• SINGLE_PART_DRAWINGS - in single part drawings only

• ASSEMBLY_AND_SINGLE_PART_DRAWINGS - in single part, assembly and
cast unit drawings

This advanced option is model specific and the setting is saved in the options
database.

XSUSERDATADIR

Category

This advanced option must be set in an initialization (.ini) file.

This advanced option is system specific and is read from
teklastructures.ini. Generally, there is no need to modify system-specific
settings. Do not modify them if you are not an administrator.

Example
set XSUSERDATADIR=%LOCALAPPDATA%\Tekla Structures\<version
number>. This means, for example in Windows 7, C:\Users\<user>
\AppData\Local\Trimble\Tekla Structures\<version>
\UserSettings.

XS_USER_DEFINED_BOLT_SYMBOL_TABLE

Category

Marking: Bolts
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Defines the location of the user-defined bolt symbol table file. For example,
enter bolt_symbol_table.txt.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_USER_DEFINED_PARAMETRIC_PROFILE_SEPARATORS

Category

Profiles

Use this advanced option to define additional separators to separate
dimensions in the names of parametric profiles. The separators can consist of
multiple characters.

Separate the values with commas, for example GA,ABC.

WARNING Follow these rules in naming:

• Use uppercase letters in separator names.

• Do not enter digits, commas, or special characters in
separator names.

• Do not start separator names with a dash (-) or full stop (.).

• Do not start separator names with an inch separator (", ', /)
when using imperial units.

In addition to these characters, Tekla Structures always recognizes the
standard separator characters X, *, -, and /, and also the character defined by
the advanced option XS_PARAMETRIC_PROFILE_SEPARATOR (page 324).

XS_USER_SETTINGS_DIRECTORY

Category

This advanced option must be set in an initialization (.ini) file. It is system-
specific.

This advanced option is set as a Windows environment variable in the
Windows system properties.

The path to the folder that contains the user.ini file and the options.bin
file.

The default value is %XSUSERDATADIR%\UserSettings\
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See also

XSUSERDATADIR (page 467)

1.21 Advanced options - V

XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_POSITION_
NUMBERS

Category

Numbering

Specifies valid letters for assembly family position numbers. You must specify
all the valid letters in this advanced option. By default, the letters A- Z are
valid.

For example, you might not want to use D, because it is easy to mix up with O
and 0. In this case you would enter letters A - Z but leave out D.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_ASSEMBLY_FAMILY_POSITION_NUMBER_FORMAT_STRING (page 79)

XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_QUALIFIER

Category

Numbering

Specifies valid letters for the assembly family number qualifier. You must
specify all the valid letters in this advanced option. By default, the letters A - Z
are valid.

For example, you might not want to use D, because it is easy to mix it up with
O and 0. In this case you would enter letters A - Z but leave out D.

This advanced option is model specific and the setting is saved in the options
database.

Example
XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_QUALIFIER=GHJKL
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See also

XS_ASSEMBLY_FAMILY_POSITION_NUMBER_FORMAT_STRING (page 79)

XS_VALID_CHARS_FOR_ASSEMBLY_MULTI_NUMBERS

Category: Numbering

Use to specify the valid letters for assembly multinumbers. You must specify
all the valid letters in this advanced option. By default, letters A - Z are valid.

This advanced option is model specific and the setting is saved in the options
database.

Example
XS_VALID_CHARS_FOR_ASSEMBLY_MULTI_NUMBERS=ABEG

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING (page 81)

XS_MIN_NUMBER_OF_ASSEMBLY_MULTI_CHARACTERS (page 305)

XS_VALID_CHARS_FOR_PART_MULTI_NUMBERS (page 470)

XS_VALID_CHARS_FOR_ASSEMBLY_POSITION_NUMBERS

Category

Numbering

Specifies valid characters for assembly position numbers. Enter all the valid
letters, for example, ABEG. By default, letters A - Z are valid.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING (page 83)
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XS_VALID_CHARS_FOR_PART_MULTI_NUMBERS

Category: Numbering

Use to specify the valid letters for part multinumbers. You must specify all the
valid letters in this advanced option. By default, letters a - z are valid.

This advanced option is model specific and the setting is saved in the options
database.

Example
XS_VALID_CHARS_FOR_PART_MULTI_NUMBERS=abeg

See also

XS_USE_MULTI_NUMBERING_FOR (page 450)

XS_PART_MULTI_NUMBER_FORMAT_STRING (page 326)

XS_MIN_NUMBER_OF_PART_MULTI_CHARACTERS (page 306)

XS_VALID_CHARS_FOR_ASSEMBLY_MULTI_NUMBERS (page 470)

XS_VALID_CHARS_FOR_PART_POSITION_NUMBERS

Category

Numbering

Use to specify the valid characters for part position numbers. Enter all the
valid letters. For example, ABEG. By default letters A - Z are valid.

This advanced option is model specific and the setting is saved in the options
database.

See also

XS_PART_POSITION_NUMBER_FORMAT_STRING (page 326)

XS_VALID_CHARS_FOR_REBAR_SUB_ID_WITH_LETTERS

Category: Numbering

Use this advanced option to specify the valid letters for the reinforcing bar
identifiers when they are shown by SUB_ID_WITH_LETTERS (page 572). Enter
all the valid letters, for example, ABEG. By default, letters A–Z are valid.

This advanced option is model specific and the setting is saved in the options
database.
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See also

XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_FORMAT_STRING
(page 362)

XS_VIEW_DIM_LINE_COLOR

Category

Model View

Use to change the dimension line color in model views. Define the color using
RGB values:

<value for red> <value for green> <value for blue>.

Separate the values with spaces. Define the values on a scale of 0 to 1. The
default values are 1.0 0.0 1.0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Example

RGB value Color
1.0 1.0 1.0 White
1.0 0.0 0.0 Red
0.0 1.0 0.0 Green
0.0 0.0 1.0 Blue
1.0 1.0 0.0 Yellow

XS_VIEW_DIM_TEXT_COLOR

Category

Model View

Use to change the dimension text color in model views. Define the color using
RGB values:

<value for red> <value for green> <value for blue>.

Separate the values with spaces. Define the values on a scale of 0 to 1. The
default values are 0.0 0.0 0.0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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Example

RGB value Color
1.0 1.0 1.0 White
1.0 0.0 0.0 Red
0.0 1.0 0.0 Green
0.0 0.0 1.0 Blue
1.0 1.0 0.0 Yellow

XS_VIEW_FAST_BOLT_COLOR

Category

Model View

Use to define the color of bolts in model views when you are using the
representation option Fast. Define the color using RGB (Red Green Blue)
values. The scale is from 0 to 1. Separate the numbers with spaces. The
default color is white 1.0 1.0 1.0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

Example

To change the color to black, enter 0.0 0.0 0.0.

XS_VIEW_FREE_MEASURE_PLANE

Category

Model View

Use to define the plane where the results of free measure are shown. You can
have the distances displayed in the local and/or global coordinate system.

The possible values are VIEW, WORK and BOTH. The default value is VIEW.

NOTE If you set the advanced option to BOTH, only one value is shown if the
values are identical.

Example

In the following example, the advanced option has been set to BOTH:
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XS_VIEW_HEIGHT

Set this advanced option in the user.ini file located in ..\Users\<user>
\AppData\Local\Trimble\Tekla Structures\<version>
\UserSettings.

Use to define the default height of model views. Enter the value in pixels.

See also

XS_VIEW_WIDTH (page 476)

XS_VIEW_PART_LABEL_COLOR

Category

Model View

Use to change the part label color in model views. Define the color using RGB
values:

<value for red> <value for green> <value for blue>.

Separate the values with spaces. Define the values on a scale of 0 to 1. The
default is black 0.0 0.0 0.0.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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Example

RGB value Color
1.0 1.0 1.0 White
1.0 0.0 0.0 Red
0.0 1.0 0.0 Green
0.0 0.0 1.0 Blue
1.0 1.0 0.0 Yellow

XS_VIEW_POSITION_X

Category

Model View

Use to define the default horizontal position of view windows. Origin is in the
top left corner of the Tekla Structures or client window. Enter the position in
pixels.The default value is 10.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_VIEW_POSITION_Y

Category

Model view

Use to define the default vertical position of view windows. Origin is in the top
left corner of the Tekla Structures or client window. Enter the position in
pixels. The default value is 10.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_VIEW_TITLE_FONT

Category

Drawing View

Use to specify the font for view direction marks. The default value is Arial. If
this advanced option is not set, Tekla Structures uses the font specified for 
XS_DEFAULT_FONT.

Advanced options reference 475 Advanced options - V



TIP If you want to change the view label font, go to View Properties -->
Mark Contents and change the font.

See also

XS_DEFAULT_FONT (page 137)

XS_VIEW_WIDTH

Set this advanced option in the user.ini file located in ..\Users\<user>
\AppData\Local\Trimble\Tekla Structures\<version>
\UserSettings.

Use to define the default width of model views. Enter the value in pixels.

See also

XS_VIEW_HEIGHT (page 474)

XS_VISUALIZE_VIEW_IN_ANOTHER_VIEWS

Category

Drawing View

Set this advanced option to TRUE if you want to highlight the view boundary of
the selected view in another view. If you do not want to highlight the view
boundary in another view, set this advanced option to FALSE. The default
value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_VISUALIZE_VIEW_IN_FATHER_VIEW_ONLY

Category

Drawing View

Set this advanced option to TRUE if you want to visualize the section view and
detail view boundary boxes only in the view where the section mark or the
detail mark is located. If you set this advanced option to FALSE, the view
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boundary boxes are visualized in all of the views where this is possible and the
boundary box fits inside the view to some extent. The default value is TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

XS_VISUALIZE_VIEW_IN_ANOTHER_VIEWS (page 476)

XS_VISUALIZE_VIEW_NEIGHBOUR_PART_EXTENSION

Category

Drawing View

Set this advanced option to TRUE to show neighbor part extensions in drawing
views. If you set this advanced option to FALSE, the neighbor part extensions
are not shown. The default value is TRUE.

When you select a view, the view extension for neighbor parts for that view is
also shown in other views.

NOTE If neighbor parts are hidden by setting Neighbor parts to None in the
Neighbor Part Properties dialox box, neighbor part extensions are
not displayed even if you set this advanced option to TRUE.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

See also

1.22 Advanced options - W

XS_WARP_MAX_ANGLE_BETWEEN_CS

Category

Concrete Detailing
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Use to define the maximum angle between adjacent polygonal parts of the
warped shape.

Enter the value in degrees. You get best results if you use values between 0.5 -
10.0. The default value eis 0.5.

This advanced option is model specific and the setting is saved in the options
database.

XS_WARP_MAX_DEVIATION

Category

Concrete Detailing

Use to define the maximum difference between real warped shape and the
polygonal warped shape in the model.

Enter the value in millimeters. You get best results if you use values between
5.0 -100.0. The default value is 10.0.

This advanced option is model specific and the setting is saved in the options
database.

XS_WELD_FILTER_TYPE

Category

Welds

Use to define how Tekla Structures filters weld types.

• EXACT: Tekla Structures filters the welds equal to the default size in the
Welding properties dialog box

• MIN: Tekla Structures filters all welds equal to or smaller than the default
size in the Welding properties dialog box. This is the default value.

This advanced option is model specific and the setting is saved in the options
database.

See also

Model weld mark visibility and appearance properties in drawings (page 689)
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XS_WELD_FONT

Category

Drawing Properties

Use to specify the font for weld text. The default value is Arial. If this advanced
option is not set, Tekla Structures uses the default font defined for 
XS_DEFAULT_FONT.

See also

XS_DEFAULT_FONT (page 137)

XS_WELDING_LENGTH_TOLERANCE

Category

Welds

Use to specify the minimum edge length Tekla Structures should take into
account when searching for a location for a weld. The default value is 30 mm.

This advanced option is model specific and the setting is saved in the options
database.

XS_WELDING_TOUCH_TOLERANCE

Category

Welds

Use to define the maximum possible gap between two parts welded together.
The default value is 30 mm.

This advanced option is model specific and the setting is saved in the options
database.

XS_WELD_LENGTH_CC_SEPARATOR_CHAR

Category: Welds

Use this advanced option to set the separator character used in the weld mark
between the weld length and the pitch (center-to-center spacing) of weld
segments. Enter @ to define the separator character according to the AISC

Advanced options reference 479 Advanced options - W



standard (3@12). Enter - to define the separator character according to the ISO
standard (100-300). The default value is -.

This advanced option is model specific and the setting is saved in the options
database.

See also

Drawing weld mark properties (page 686)

XS_WELD_NUMBER_FORMAT

Category

Marking: General

Use to define the weld number format.

This advanced option is model specific and the setting is saved in the options
database.

Example

In XS_WELD_NUMBER_FORMAT=W%3.3d:

• W is the prefix. The rest of the string defines the number format.

• The first number defines the minimum field width.

• The second number defines the minimum quantity of numbers to display.

• % and d (integer value) indicate the format.

See also

XS_JOINT_NUMBER_FORMAT (page 278)

XS_WORKING_POINTS_VALID_ALSO_OUTSIDE_PART

Category

Dimensioning: Parts

Set this advanced option to TRUE to also draw reference dimensions for points
outside part end points. The default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.
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XS_ZERO_POINT_SYMBOL_OLD_WAY

Category

Dimensioning: General

Set this advanced option to TRUE to use RD marks containing a circle rather
than the text RD to indicate the zero point of dimensions when you use US
Absolute dimension types. By default, RD marks contain the text RD. The
default value is FALSE.

This advanced option is model specific and the setting is saved in the options
database.

1.23 Advanced options - Z

XS_ZOOM_STEP_RATIO

Category

Model View

Use to configure the Zoom in and Zoom out commands. The default value is 
0.25. Increase this value to zoom more with a single mouse click.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.

XS_ZOOM_STEP_RATIO_IN_MOUSEWHEEL_MODE

Category

Model View

Set the zoom ratio when you are scrolling using the middle mouse button.
Enter a decimal value. Increase the value to zoom more with a single mouse
click. The default value is 0.05

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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XS_ZOOM_STEP_RATIO_IN_SCROLL_MODE

Category

Model View

Set the zoom ratio when scrolling and holding down the wheel. Enter a
decimal value. Increase the value to zoom more with a single mouse click. The
default value is 0.01.

This advanced option is user specific and the setting is saved in options.bin
under user folder. Restart Tekla Structures to activate the new value.
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2 Template attributes in drawing
and report templates

You can use template attributes in drawing and report templates. When you
open a drawing or create a report, Tekla Structures uses the attributes and
formulas to calculate and display information from the model database. This
could, for example, include assembly weight or cover area.

The template attributes available in a template row definition depend on the
content type of the row. Content types are object types in the product
database.

Descriptions of template attributes are listed in alphabetical order, click the
letter in the table of contents to show all the attributes beginning with that
letter.

2.1 Template attributes - A

ACN
Shows control numbers.

For more information on control numbers, see and .

ACTIVE_DESIGN_CODE
Shows the active design code of material.

Template attributes in drawing and report
templates
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ADDED_TO_POUR_UNIT
Shows whether an object is added to a pour unit, and how it was added.

Use with the following content types:

• ASSEMBLY
• BOLT
• CAST_UNIT (only precast, not cast-in-place cast units)

• MESH
• REBAR
• SINGLE_REBAR
• SINGLE_STRAND
• STRAND
• STUD
The possible values are:

• 0: The object is not added to any pour unit, or has been modified after the
pour units were calculated the last time.

• 1: The object was manually added to the pour unit using the Add to pour
unit command.

• 2: The object was automatically added to the pour unit using the Calculate
pour units command.

ADDRESS
Shows the address entered in the Project properties in File menu --> Project
properties.

ALIAS_NAME1 ... 3
Alias name of the material.

Use for part and main part material attributes in ASSEMBLY and PART content
types.
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ANALYSIS_MODEL_NAME

Shows the name of the analysis model in which the rigid link is included.

Use with the ANALYSIS_RIGID_LINK content type.

ANG_S, ANG_T, ANG_U, ANG_V
Show bending angles of reinforcing bars based on the mappings in the
rebar_schedule_config.inp file, located in the ..\ProgramData
\Trimble\Tekla Structures\<version>\environments
\<environment>\system folder. These mappings are environment-specific
by default. You can modify them to suit your company or project needs.

See also

ANG_U_MAX, ANG_U_MIN, ANG_V_MAX, ANG_V_MIN (page 485)

DIM_A ... DIM_G, DIM_H1, DIM_H2, DIM_I, DIM_J, DIM_K1, DIM_K2, DIM_L,
DIM_O, DIM_R, DIM_R_ALL, DIM_TD, DIM_WEIGHT, DIM_X, DIM_Y (page 520)

ANG_U_MAX, ANG_U_MIN, ANG_V_MAX, ANG_V_MIN
Shows the minimum and maximum bending angles of reinforcing bars or
meshes in tapered cross sections. See the example below:

APPROVED_BY

The Approved by information of the revision from the Revision Handling
dialog box.
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AREA
Shows the following information:

• For plate type catalog profiles, any parametric profiles and any catalog
profiles with Cover area property not defined, shows the total net area of
all surfaces.

• For other types of catalog profiles with Cover area property defined,
shows the gross total surface area.

The area is calculated using the extreme length and profile cover area per
meter (value defined in the profile catalog). The cross area on profile ends,
cuts and fittings are not taken into account.

See also

AREA_GROSS (page 487)

AREA_NET (page 487)

AREA_FORM_TOP, AREA_FORM_BOTTOM, AREA_FORM_SIDE
Shows the area of faces whose normal vector points to the following
directions:

• top of form (AREA_FORM_TOP)

• bottom of form (AREA_FORM_BOTTOM)

• form sides (AREA_FORM_SIDE)

For assemblies and cast units, the main part local up direction dictates the
form up/bottom/sides directions. Faces which are inclined less than 5 degrees
are counted in the top and bottom areas. Faces which are skew => 85 degrees
are counted in the side areas. Faces which are exactly 45 degrees against main
global or local axes, are not counted to any direction.

Steel embeds are ignored when calculating the AREA_FORM_... values of cast
units.
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AREA_FORM_TOP =
42 sq.ft.
AREA_FORM_BOTTOM
= 42 sq.ft.
AREA_FORM_SIDE =
2*(2*7 + 3*6) +
2*(2*6 + 2*6) =
64 + 48 = 112
sq.ft.

AREA_GROSS
For profiles this field shows the same result as AREA (page 485). For plates it
shows the square area (extreme length multiplied by extreme width) needed
to include the entire plate. For other objects it shows a zero.

AREA_NET
For parts this field shows the net surface area that forms the actual area of the
fabricated part. For other objects it shows a zero.

AREA_PER_TONS
Shows AREA/WEIGHT x 1000.

AREA_PGX, AREA_NGX, AREA_PGY, AREA_NGY, AREA_PGZ,
AREA_NGZ
Shows the area of faces whose normal vector points to the positive or negative
direction of the following global axes:

Attribute Direction
AREA_PGX Positive direction of global X-axis
AREA_NGX Negative direction of global X-axis
AREA_PGY Positive direction of global Y-axis
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Attribute Direction
AREA_NGY Negative direction of global Y-axis
AREA_PGZ Positive direction of global Z-axis
AREA_NGZ Negative direction of global Z-axis

Also faces whose normal vector is located in less than 45 degree angle to
global axis are also included in the area. Faces exactly in 45 degree angle are
not included in any global direction.

AREA_PLAN
For parts this field shows the total upper surface area (perpendicular to the
global Z-axis).

ASSEMBLY content type

• Shows the total upper surface area (perpendicular to the global Z-axis) of
the parts included in an assembly.

AREA_PROJECTION_GXY_GROSS,
AREA_PROJECTION_GXZ_GROSS,
AREA_PROJECTION_GYZ_GROSS
Shows the area of the "shadow" of a part, assembly, or cast unit at the
following global planes:

• XY-plane

• XZ-plane

• YZ-plane

Restrictions

• Areas are calculated always in net areas (holes are taken into account) even
when gross is requested.

• Overlapping faces are counted twice.

AREA_PROJECTION_GXY_NET, AREA_PROJECTION_GXZ_NET,
AREA_PROJECTION_GYZ_NET
Shows the net area of the "shadow" of a part, assembly, or cast unit at the
following global planes:

• XY-plane
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• XZ-plane

• YZ-plane

AREA_PROJECTION_XY_GROSS,
AREA_PROJECTION_XZ_GROSS, AREA_PROJECTION_YZ_GROSS
Shows the area of the "shadow" of a part, assembly, or cast unit at its local
planes:

• XY-plane

• XZ-plane

• YZ-plane

AREA_PROJECTION_XY_NET, AREA_PROJECTION_XZ_NET,
AREA_PROJECTION_YZ_NET
Shows the net area of the "shadow" of a part, assembly, or cast unit at its local
planes:

• XY-plane

• XZ-plane

• YZ-plane

AREA_PX, AREA_NX, AREA_PY, AREA_NY, AREA_PZ, AREA_NZ
Shows the area of faces whose normal vector points to the positive or negative
direction of the following local axes:

Attribute Direction
AREA_PX Positive direction of local X-axis
AREA_NX Negative direction of local X-axis
AREA_PY Positive direction of local Y-axis
AREA_NY Negative direction of local Y-axis
AREA_PZ Positive direction of local Z-axis
AREA_NZ Negative direction of local Z-axis
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ASSEMBLY.LOCK_PERMISSION

Shows the effective permission for the assembly. Options are ALL or NONE.

See also

ASSEMBLY.OBJECT_LOCKED (page 490)

ASSEMBLY.OWNER_ORGANIZATION (page 490)

ASSEMBLY.OBJECT_LOCKED

Shows the value of the object lock. The value options are Yes, No, and
Organization.

The object lock status can be modified in the Object locks dialog box.

See also

ASSEMBLY.OWNER_ORGANIZATION (page 490)

ASSEMBLY.LOCK_PERMISSION (page 489)

ASSEMBLY.OWNER_ORGANIZATION

Shows the name of the organization that owns the assembly lock. The
organization is based on the Windows account.

See also

ASSEMBLY.OBJECT_LOCKED (page 490)

ASSEMBLY.LOCK_PERMISSION (page 489)

ASSEMBLY_BOTTOM_LEVEL
Shows the bottom level of an assembly. Bottom level takes the unit and
accuracy from the MarkDimensionFormat.dim file.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE This attribute returns the value as text, so you cannot use formulae with this
attribute. Use ASSEMBLY_BOTTOM_LEVEL_UNFORMATTED (page 491) instead.

See also

XS_DRAWING_IGNORE_ZERO_LEVELS_IN_PART_MARKS (page 200)
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ASSEMBLY_BOTTOM_LEVEL_GLOBAL

Shows the bottom level of an assembly by global axis. The bottom level takes
the unit and accuracy from the MarkDimensionFormat.dim file.

You can use this attribute as a user-defined attribute in part marks and
associative notes, and also in reports and templates.

See also

ASSEMBLY_BOTTOM_LEVEL_GLOBAL_UNFORMATTED

Shows the bottom level of an assembly by global axis. Unformatted level
returns the bottom levels as a length in mm so you can format them and
include them into formulas in templates.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

ASSEMBLY_BOTTOM_LEVEL_UNFORMATTED

Shows the unformatted bottom level of an assembly. Unformatted level
returns the bottom levels as a length in mm so you can format them and
include them into formulas in templates.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE Unlike the BOTTOM_LEVEL attribute, the 
BOTTOM_LEVEL_UNFORMATTED attribute cannot be formatted through
the MarkDimensionFormat.dim file.

See also

ASSEMBLY_DEFAULT_PREFIX

Shows the default value for the assembly prefix defined in the part properties
dialog box.
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ASSEMBLY_PLWEIGHT
Shows the weight of plates attached to an assembly. For other objects it shows
a zero.

ASSEMBLY_POS
Shows the assembly position number. For parts it shows the assembly
position number of the assembly that contains the part. For bolts the field is
blank.

ASSEMBLY_POSITION_CODE
Shows the assembly position code. The code identifies the grid position. The
position of the objects is calculated based on the closest grid.

Assembl
y

Code

A/1 <A/2
A/2 A-B/1
A/3 <A-B/1-2
A/4 A/2
A/6 A-B/1-2
A/7 B/2
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TOLERANCE LINE

The position code consists of grid line labels in the x and y directions
(alternatively in the z direction). If an assembly begins or ends outside the first
or last grid line, a < or > character is included in the position code. For
example, if an assembly begins outside the A grid line, this field shows:

<A/2

If an assembly is completely within a tolerance distance (by default 500 mm) of
grid line A, the position code is the label of that grid line: A.

If the assembly is partially or entirely outside the tolerance distance, the code
is a combination of grid labels: A-B.

To change the default tolerance distance, set the advanced option 
XS_ASSEMBLY_POSITION_CODE_TOLERANCE=750 (for example).

To include the Z orientation in the code, set the advanced option 
XS_ASSEMBLY_POSITION_CODE_3D to TRUE. The code would be similar to:
<A-B/1-2/1-+1000

Tekla Structures selects the grid to use as follows:

1. Tekla Structures checks the location of the assembly.
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2. If it is located inside several grids, Tekla Structures checks whether the
assembly is parallel to grid lines or the plane.

3. If there are several parallel grids, Tekla Structures selects the closest.

ASSEMBLY_PREFIX
Shows the assembly prefix, defined in the part properties dialog box.

ASSEMBLY_SERIAL_NUMBER
Shows the assembly number without prefix and separator.

ASSEMBLY_START_NUMBER

Shows the assembly start number.

See also

ASSEMBLY_TOP_LEVEL
Shows the top level of an assembly. Top level takes the unit and accuracy from
the MarkDimensionFormat.dim file.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE This attribute returns the value as text, so you cannot use formulae with this
attribute. Use ASSEMBLY_TOP_LEVEL_UNFORMATTED (page 495) instead.

See also

XS_DRAWING_IGNORE_ZERO_LEVELS_IN_PART_MARKS (page 200)

ASSEMBLY_TOP_LEVEL_GLOBAL

Shows the top level of an assembly by global axis. The top level takes the unit
and accuracy from the MarkDimensionFormat.dim file.

You can use this attribute as a user-defined attribute in part marks and
associative notes, and also in reports and templates.
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See also

ASSEMBLY_TOP_LEVEL_GLOBAL_UNFORMATTED

Shows the top level of an assembly by global axis. Unformatted level returns
the top levels as a length in mm so you can format them and include them into
formulas in templates.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

ASSEMBLY_TOP_LEVEL_UNFORMATTED
Shows the unformatted top level of an assembly. Unformatted level returns
the top levels as a length in mm so you can format them and include them into
formulas in templates.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE Unlike the ASSEMBLY_TOP_LEVEL attribute, the 
ASSEMBLY_TOP_LEVEL_UNFORMATTED attribute cannot be formatted through
the MarkDimensionFormat.dim file.

ATTACHED_TO

Shows whether a surface is attached to a part or to a pour.

The attribute returns 0 if the surface is attached to a part, and 1 if the surface
is attached to a pour.

axial1, axial2

Shows the values entered in the Tension, T box on the End codes tab in the
user-defined attributes dialog box of the part. axial1 shows the value in the
Start box and axial2 in the End box.

2.2 Template attributes - B
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BOLT_COUNTERSUNK

Use to check or show if a bolt is countersunk. The attribute returns the value 1
for countersunk bolts, otherwise it returns 0.

See also

HEAD_TYPE (page 529)

BOLT_EDGE_DISTANCE
Shows the edge distance of a bolt.

BOLT_EDGE_DISTANCE_MIN
Shows the edge distance multiplied by the coefficient set in the modeling
settings in File menu --> Settings --> Options --> Components .

BOLT_FULL_NAME

Shows the name of a bolt defined in the bolt catalog, without the standard.

For objects other than bolts, the field shows a blank.

See also

BOLT_SHORT_NAME (page 496)

BOLT_MATERIAL_LENGTH
For bolts this field shows the total thickness of the connected material.

BOLT_NPARTS
For bolts this field shows the number of connected parts.
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BOLT_SHORT_NAME

Shows the name of the washer, bolt, nut or screw in a short format.

See also

BOLT_FULL_NAME (page 496)

BOLT_STANDARD
As for TYPE (page 576).

BOLT_THREAD_LENGTH

Shows the length of the threaded part of the bolt shaft.

BOTTOM_LEVEL

Shows the bottom level of a single part, cast unit, assembly, part of a
connection or a pour object.

Bottom level takes the unit and accuracy from the
MarkDimensionFormat.dim file.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE This attribute returns the value as text, so you cannot use formulae
with this attribute. Use BOTTOM_LEVEL_UNFORMATTED (page 498)
instead.

BOTTOM_LEVEL_GLOBAL

Shows the bottom level of a single part, cast unit, assembly, part of a
connection or a pour object by global axis. BOTTOM_LEVEL_GLOBAL takes the
unit and accuracy from MarkDimensionFormat.dim.

You can use this attribute as a user-defined attribute in part marks and
associative notes, and also in reports and templates.
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BOTTOM_LEVEL_GLOBAL_UNFORMATTED

Shows the bottom level of a single part, cast unit, assembly, part of a
connection or a pour object. BOTTOM_LEVEL_GLOBAL_UNFORMATTED returns
the bottom levels as a length in mm so you can format them and include them
into formulas in templates. This attribute gives level information by the global
axis.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

BOTTOM_LEVEL_UNFORMATTED

Shows the unformatted bottom level of a single part, cast unit, assembly, part
of a connection or a pour object. BOTTOM_LEVEL_UNFORMATTED returns the
bottom levels as a length in mm so you can format them and include them
into formulas in templates.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE Unlike the BOTTOM_LEVEL attribute, the 
BOTTOM_LEVEL_UNFORMATTED attribute cannot be formatted through
the MarkDimensionFormat.dim file.

BOUNDING_BOX_xxx

The following template attributes give the bounding box of the objects as X, Y
or Z minimum or maximum distances from the absolute zero (0,0,0):

• BOUNDING_BOX_MIN_X
• BOUNDING_BOX_MAX_X
• BOUNDING_BOX_MIN_Y
• BOUNDING_BOX_MAX_Y
• BOUNDING_BOX_MIN_Z
• BOUNDING_BOX_MAX_Z
These attributes are available for parts, assemblies, cast units, reference
models and reference objects.
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BUILDER
Shows the builder’s name defined in the Project properties in File menu -->
Project properties.

2.3 Template attributes - C

cambering

Shows the value entered in the Camber box on the Parameters tab in the
user-defined attributes dialog box of the part.

See also

CANTILEVER
Shows the length of a protruding part of a profile. Below is an example of a
welded box profile:

See also

PROFILE (page 556)

CAST_UNIT_BOTTOM_LEVEL
Shows the bottom level of a cast unit.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

See also

XS_DRAWING_IGNORE_ZERO_LEVELS_IN_PART_MARKS (page 200)
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CAST_UNIT_HEIGHT_ONLY_CONCRETE_PARTS

Shows the height of a cast unit including all concrete parts.

CAST_UNIT_HEIGHT_ONLY_PARTS

Shows the height of a cast unit, including all concrete parts, steel parts and
parts made of miscellaneous material.

CAST_UNIT_HEIGHT_TOTAL

Shows the total height of a cast unit, including all concrete parts, steel parts
and parts made of miscellaneous material, reinforcing bars, surface
treatments and bolts.

CAST_UNIT_LENGTH_ONLY_CONCRETE_PARTS

Shows the length of a cast unit including all concrete parts.

CAST_UNIT_LENGTH_ONLY_PARTS

Shows the total length of a cast unit, including all concrete parts, steel parts
and parts made of miscellaneous material.

CAST_UNIT_LENGTH_TOTAL

Shows the total length of a cast unit, including all concrete parts, steel parts
and parts made of miscellaneous material, reinforcing bars, surface
treatments and bolts.
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CAST_UNIT_POS
Shows the position of a cast unit. The position consists of a prefix and a
number.

CAST_UNIT_POSITION_CODE
Shows the position code of a cast unit. The code identifies the grid position.
For more information, see ASSEMBLY_POSITION_CODE (page 492).

CAST_UNIT_PREFIX
Shows the cast unit prefix, defined in the part properties dialog box.

CAST_UNIT_REBAR_WEIGHT

Shows the weight of reinforcing bars in a cast unit.

CAST_UNIT_SERIAL_NUMBER
Shows the cast unit number without prefix and separator.

CAST_UNIT_TOP_LEVEL
Shows the top level of a cast unit.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

See also

XS_DRAWING_IGNORE_ZERO_LEVELS_IN_PART_MARKS (page 200)

CAST_UNIT_TYPE

Returns the type of the cast unit as text (Precast or Cast in place).
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CAST_UNIT_VERTICAL_POSITION_CODE

Outputs the grid level height of a cast unit, for example +7200. The center of
gravity point is used to determine the grid level for the cast unit. If the center
of gravity is more than 100 mm away from the grid level, then two grid levels
will be output separated with dash: the lower and higher grid levels, for
example, +3600-+7200.

See also

ASSEMBLY_POSITION_CODE (page 492)

CAST_UNIT_WIDTH_ONLY_CONCRETE_PARTS

Shows the width of a cast unit including all concrete parts.

CAST_UNIT_WIDTH_ONLY_PARTS

Shows the total width of a cast unit, including all concrete parts, steel parts
and parts made of miscellaneous material.

CAST_UNIT_WIDTH_TOTAL

Shows the total width of a cast unit, including all concrete parts, steel parts
and parts made of miscellaneous material, reinforcing bars, surface
treatments and bolts.

CATALOG_NAME
Shows the name of a mesh catalog.

CC
Shows the center-to-center spacing of evenly-distributed reinforcing bars or a
mesh.

Template attributes in drawing and report
templates

502 Template attributes - C



CC_CROSS
Shows the center-to-center spacing of crossing bars in a reinforcement mesh.

CC_EXACT
Shows the center-to-center spacing of a reinforcing bar group or a mesh.

CC_EXACT_CROSS
Shows all center-to-center spacings of crossing bars in a reinforcement mesh.

CC_EXACT_LONG
Shows all center-to-center spacings of longitudinal bars in a reinforcement
mesh.

CC_LONG
Shows the center-to-center spacing of longitudinal bars in a reinforcement
mesh.

CC_MAX
Shows the largest center-to-center spacing in reinforcing bar groups or
meshes with varied spacing.

CC_MAX_CROSS
Shows the largest center-to-center spacing of crossing bars in reinforcement
meshes with varied spacing.
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CC_MAX_LONG
Shows the largest center-to-center spacing of longitudinal bars in
reinforcement meshes with varied spacing.

CC_MIN
Shows the smallest center-to-center spacing in reinforcing bar groups or
meshes with varied spacing.

CC_MIN_CROSS
Shows the smallest center-to-center spacing of crossing bars in reinforcement
meshes with varied spacing.

CC_MIN_LONG
Shows the smallest center-to-center spacing of longitudinal bars in
reinforcement meshes with varied spacing.

CHANGES

The CHANGES attribute tells the changes occurred in a drawing, for example, if
the drawing is changed while it is issued, or if part have been modified. This
attribute can be used for adding Document manager information about
changes in drawing reports. Also Document manager has a column Changes
for this information.

Below is an example of the changes column in Document manager.
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CHECKED_BY

This attribute gets the value entered in the Checked By box on the Status tab
in the user-defined attributes dialog box of the part or in the assembly
properties dialog box. Also shows the value that you have entered in the
Checked By field in the Revision Handling dialog box.

CHECKED_DATE

Shows the value entered in the Date Checked box on the Status tab in the
user-defined attributes dialog box of the part or in the assembly properties
dialog box.

CLASS
Only use to set rules in the Template Editor. It shows the string ASSEMBLY for
assemblies, PART for parts, and BOLT for bolts, holes, nuts etc. For drawings it
shows DRAWING, and for revisions it shows REVISION.

CLASS_ATTR
Shows the class number of parts, reinforcement, and surfaces.

For assemblies and cast units, MAINPART.CLASS_ATTR shows the class
number of the main part.

For bolts, welds, and connections, CLASS_ATTR can be used for showing the
class number of bolted, welded, or connected parts. For example, to show the
class number of the bolt main part or the first secondary part, use 
MAIN_PART.CLASS_ATTR or SECONDARY_1.CLASS_ATTR.

CODE
Shows the abbreviation code of a surface treatment, for example, TS1 for Tile
surface 1.

Surface treatment codes and names are defined in the
product_finishes.dat file.
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See also

SURFACING_NAME (page 572)

COG_X, COG_Y, COG_Z
Shows the coordinates of the center of gravity of assemblies, parts, or welds:

• For parts, assemblies, and cast units the attributes COG_X, COG_Y, and
COG_Z return values in global coordinate system.

• For welds the attributes COG_X, COG_Y, and COG_Z return values in local
coordinate system (current work plane grid).

These attributes cannot be used in headers or footers.

comment
User-defined attribute Comment, defined in the object’s user-defined
attributes dialog box. For more information on the user-defined attributes in
templates and reports, see .

CONCRETE_COVER_FROM_PLANE

Shows the distance from the part surface to the reinforcing bar, perpendicular
to the bar plane.

This is the first value entered in the From plane box in the Single rebar or
Rebar group properties (page 604).

See also

CONCRETE_COVER_ON_PLANE (page 506)

CONCRETE_COVER_START, CONCRETE_COVER_END (page 507)

CONCRETE_COVER_ON_PLANE

Shows the distance from the part surface to the reinforcing bar on the bar
plane.

This is the first value entered in the On plane box in the Single rebar or
Rebar group properties (page 604).

To show the minimum or maximum value entered in the On plane box, use
the following template attributes:
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• CONCRETE_COVER_ON_PLANE_MIN
• CONCRETE_COVER_ON_PLANE_MAX

See also

CONCRETE_COVER_FROM_PLANE (page 506)

CONCRETE_COVER_START, CONCRETE_COVER_END (page 507)

CONCRETE_COVER_START, CONCRETE_COVER_END

CONCRETE_COVER_START shows the concrete cover thickness at the first end
of the reinforcing bar. CONCRETE_COVER_END shows the concrete cover
thickness at the second end of the reinforcing bar.

These are the values entered in the Start and End boxes in the Single rebar
or Rebar group properties (page 604) when the Cover thickness option is
selected.

See also

CONCRETE_COVER_ON_PLANE (page 506)

CONCRETE_COVER_FROM_PLANE (page 506)

LEG_LENGTH_START, LEG_LENGTH_END (page 541)

CONN_CODE_END1, CONN_CODE_END2

Shows the values entered in the Connection code box on the End conditions
tab in the user-defined attributes dialog box of the part. CONN_CODE_END1
shows the value in the Start box and CONN_CODE_END2 in the End box.

CONNECTED_ASSEMBLIES
For bolts this field shows a string containing the position numbers of
assemblies of connected parts (e.g. A17 A18 A23). In ASSEMBLY_BOLT lists
Tekla Structures does not show the position number of the current assembly.
Only use this field as an inquiry command for single bolts. For objects other
than bolts the field is blank.
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CONNECTED_PARTS
Shows a string containing the position numbers of connected parts (e.g. P102 -
> P17 P18 P23) for bolts. If the list type is ASSEMBLY_BOLT, the first position
number is a member of the current assembly. Only use as an inquiry
command for single bolts. For objects other than bolts the field is blank.

CONNECTION_CODE
Shows the connection code defined in the connection properties dialog box.
Only for use in connection lists.

CONNECTION_DSTV
Shows the DSTV code of the connection in connection lists. This field blank if
the connection is not a DSTV connection. Only for use in connection lists.

CONNECTION_ERROR
Shows the error flag of a connection in connection lists. Only for use in
connection lists.

The values returned are:

• 1=green connection symbol

• 2=yellow connection symbol

• 3=red connection symbol

• 4=connection did not pass design check

CONNECTION_GROUP
Shows the class of the component, available on the General tab in the
component dialog box. Only for use in connection lists.

CONNECTION_NUMBER
Shows the number of a connection.
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CONNECTION_RUNNING_NUMBER
Shows the running number of a connection. All connections are automatically
numbered with a running number.

CONTENTTYPE
Shows the content type of the current row.

See also

COUNTRY

Shows the country entered in the Project properties in File --> Project
properties .

COVER_AREA
Shows the total cover area of the part profile, or of the main part profile in the
assembly or cast unit.

See also

PROFILE (page 556)

CRANK_xxx

Use the following template attributes to show rebar set bar crank information
defined by using a rebar set splitter or end detail modifier.

(1) = Location of the splitter
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Template attribute Description
CRANK_SIDE_START
CRANK_SIDE_END

Shows to which side of the splitter the crank is
created at the start or end of the bar: Left or 
Right.

CRANK_ROTATE_START
CRANK_ROTATE_END

Shows to which angle the crank is rotated at the
start or end of the bar.

CRANK_STRLEN_START
CRANK_STRLEN_END

Shows the length of the straight segment of the
crank at the start or end of the bar.

This is (2) in the image above.
CRANK_LENTYPE_START
CRANK_LENTYPE_END

Shows the type of the cranked length at the start
or end of the bar: Diagonal ratio, Diagonal
distance, Horizontal ratio, Horizontal
distance.

CRANK_RATIO_START
CRANK_RATIO_END

Shows the multiplier of the bar diameter that is
used to define the cranked length at the start or
end of the bar.

CRANK_DIST_START
CRANK_DIST_END

Shows the length of the cranked segment at the
start or end of the bar.

If the cranked length type is Horizontal
distance, this is (3) in the image above.

If the cranked length type is Diagonal
distance, this is (4) in the image above.

CRANK_OFFSET_START
CRANK_OFFSET_END

Shows the offset distance of the straight segment
of the crank at the start or end of the bar.

This is (5) in the image above.

See also

Splitter properties (page 622)

CREATED_BY

This attribute gets the name of the revision creator.

CROSS_SECTION_AREA
Shows the area (mm2) of a cross section.

See also

PROFILE (page 556)
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CURRENT_PHASE
Shows the current phase. Used for filtering parts. You can also use selection
filters.

CURVED_SEGMENTS

Returns the number of segments of a curved beam.

CUSTOM.ELEMENT_WEIGHT

This custom template attribute sums up net weights of all cast unit and
subassembly parts, but ignores all subassemblies whose main part's 
MATERIAL_TYPE is STEEL.

The same weight is wanted to be reported

1. early in the project when only sample elements are detailed but the great
majority of the elements is not

2. in the final stage of the project when all elements have been fully detailed

The CAST_UNIT.WEIGHT attribute also takes into account the weight of all
embedded subassemblies, such as lifting anchors and cable loops. This is not
wanted as the reinforcement and embed weights are already included into a
little bit exaggerated concrete density.

CUSTOM.HC_xxx

The following part-specific opening and area calculations are available for
Hollowcore slabs. The calculations can be output with custom reports.

The report property names are:

• CUSTOM.HC_GROSS_AREA: This is the gross area calculated by formula
L*B , where L is the max length of the slab and B is the width of the original
hollow core slab section before any narrow cutting of the slab.

• CUSTOM.HC_INSUL_CUT_L: This is the total linear length of insulation
cutting measured along insulation edges where the edge of insulation is
not overlapping with exterior edges of the slab.
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• CUSTOM.HC_NET_AREA: This is the net area of the hollow core slab. The net
area is excluding all openings penetrating.

• CUSTOM.HC_OPENINGS_L: This is the total perimeter length of all openings
in the slab. The perimeter is measured along the “shape boundary” of the
opening.

• CUSTOM.HC_RECESSES_L: This is the total perimeter of recesses (not fully
penetrating the slab thickness). The perimeter is measured along the
“shape boundary” of the recess.

• CUSTOM.HC_SAWINGS_END_L: This is the total linear length of skew end
sawings in the slab. Please note that the straight ends are not counted to
the total sawing length.

• CUSTOM.HC_SAWINGS_END_N: This is the total number of individual sawing
lines.

• CUSTOM.HC_SAWINGS_SIDE: This is the total length of sawing parallel to
center axis of the slab.

In Template Editor these attributes are located in the CUSTOM subfolder in the
Attribute dialog box.

CUSTOM.MESH_xxx

The following attributes are available for reinforcement meshes:

• CUSTOM.MESH_LENGTH_NET (distance)

• CUSTOM.MESH_WIDTH_NET (distance)

• CUSTOM.MESH_SIZE_NET (text)

All these attributes are calculated based on the mesh wires considering all
cuts. The net length is always the longer dimension of the mesh and the net
width is the shorter. The net size is always expressed based on net length and
net width including the text for sizes and spacings.

The calculations can be output with custom reports. In Template Editor they
are located in the CUSTOM subfolder in the Attributes dialog box.

We recommend that you use these attributes instead of any other mesh
attributes for size calculations.

Tekla Structures length inquiry gives the whole length, whereas the 
MESH_LENGTH_NET gives the length of the mesh itself.
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Tekla Structures size inquiry gives the size so that it gives the height first and
the width last, whereas MESH_SIZE_NET reports the width first and the height
last: 20/8-100/200-5950/2950 .

CUSTOM.REBAR_SHAPE_COUPLERS
The CUSTOM.REBAR_SHAPE_COUPLERS custom template attribute shows in
pull-out pictures the reinforcing bar geometry, bending dimensions, and the
graphical symbols representing the couplers at the bar ends. The coupler data
is taken from the user-defined attributes from the rebar coupler components
Rebar coupler, Rebar end anchor and Split rebar and add coupler.
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Note that the CUSTOM.REBAR_SHAPE_COUPLERS attribute is available only in
graphical fields when the content type is REBAR.

In Tekla Structures, ensure that a drawing layout contains the desired table. By
default, the rebar_with_couplers table is available in the Drawing layout
properties.

The drawing needs to contain at least some reinforcing bars as otherwise the
table does not have anything to show.

Customize the symbols for couplers and end anchors

You can customize how the symbols for couplers and end anchors are shown.

1. You can define the mapping between the model properties and the actual
symbol for various types of couplers or end anchors.

The mapping is handled in the RebarCoupler.Symbols.dat file, located
by default in ..\ProgramData\Trimble\Tekla Structures
\<version>\environments\common\system. The file can be placed
under the model folder or under any of the common system folders
defined by the advanced options XS_PROJECT, XS_FIRM, and XS_SYSTEM.
For instructions on how to control the mapping, see the
RebarCoupler.Symbols.dat file.

You can give both the symbol file name and symbol number in the
configuration file RebarCoupler.Symbols.dat. If the symbol file name
is not given, the default file (CouplerSymbols.sym) will be used. For
more details, see sample files included in the environments.

2. You can create your own symbols that are drawn at the reinforcing bar
ends.

All symbols to be used are in the symbol file CouplerSymbols.sym,
located by default in ..\ProgramData\Trimble\Tekla Structures
\<version>\environments\common\symbols. You can create and add
new symbols in Symbol Editor.
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See also

Rebar coupler and anchor tools (page 3326)

CUSTOM.WALL_xxx

The following part-specific opening and area calculations are available for
Sandwich wall. The calculations can be output with custom reports.

• CUSTOM.WALL_CORNER_AREA: This is the façade area of the turning corner
in the wall. The turning corner part has to be at the very end of the corner
to get the total length. The corner part needs to be defined in the same
way as explained in the Including turning corners in area calculation
section below.

• CUSTOM.WALL_GROSS_AREA: This is the gross area of the wall.

• CUSTOM.WALL_NET_AREA: This is the net area of the wall. All openings
inside the wall and/or at exterior boundaries of the wall are excluded.

• CUSTOM.WALL_OPENINGS_AREA: This is the total area of all openings inside
the wall and/or at exterior boundaries of the wall.

• CUSTOM.WALL_OPENINGS_N: This is the total number of openings inside
the wall and/or at exterior boundaries of the wall.

In Template Editor these attributes are located in the CUSTOM subfolder in the
Attribute dialog box.

The examples below show the gross and net areas of sandwich walls:

• Gross area: Calculation formula: (HxL), excluding possible lifting loops or
other non-concrete materials. Area of turning corner shall be included in
calculation.
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• Net area: Calculation formula: HxL - ΣA i

Including turning corners in area calculation

To include turning corners in area calculation, ensure that you have the name
of the turning corner part (L2 in the image above) listed in the
SandwichWallCornerPartNames.dat file. This file lists all valid corner part
names. When a report using any of these custom wall fields is generated for
the first time, the file is searched in the normal file search order, starting from
the model folder and then continuing the search from the folders defined for
the advanced options XS_PROJECT, XS_FIRM, and XS_SYSTEM. The first file
found will be loaded.

NOTE The SandwichWallCornerPartNames.dat file is not re-loaded even
if another model is opened and thus it may happen that the report is
based on a file from another model.

2.4 Template attributes - D
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DATE
Used to be DATE. Shows the current date. If the advanced option
XS_IMPERIAL_DATE (page 269) is set, the date format is mm/dd/yyyy.
Otherwise the format is dd.mm.yyyy.

REVISION content type:

In drawing templates this field shows the last revision date. In REVISION lists
it also shows the revision history.

DATE_APPROVED

In templates shows the approval date of the drawing entered in the Revision
Handling dialog box.

DATE_CHECKED

This attribute shows the date when a drawing was checked. This attribute can
be included in templates. The attribute field is located in the Revision
Handling dialog box.

DATE_CREATE
Shows the creation date of the drawing. If the advanced option XS_IMPERIAL_
DATE (page 269) is set, the format of the date is mm/dd/yyyy. Otherwise the
format is dd.mm.yyyy.

In drawing templates this field shows the last revision date. In REVISION lists
it also shows the revision history.

DATE_END
Shows the completion date of a project from the Project properties in File
menu --> Project properties.

DATE_ISSUE
Shows the issue date of the drawing. Use with DRAWING content type.
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DATE_LAST
In drawing templates this field shows the date of the last revision. In 
REVISION lists it also shows the entire revision history.

DATE_MODIFY
Shows the date of the last changes to the drawing. If the advanced option XS_
IMPERIAL_DATE (page 269) is set, the date format is mm/dd/yyyy. Otherwise
the format is dd.mm.yyyy.

Use in part, cast unit and assembly lists.

DATE_PLOT
Shows the date the drawing was last printed. If the advanced option XS_
IMPERIAL_DATE (page 269) is set, the date format is mm/dd/yyyy. Otherwise
the format is dd.mm.yyyy.

Use in drawing tables and drawing reports. You can also use this template
attribute in part, assembly and cast unit lists with DRAWING.DATE_PLOT value
field formula.

NOTE If you have set the advanced option XS_DISABLE_DRAWING_PLOT_DATE
(page 158) to TRUE, the drawing plot date is not stored to the database. When
you set it to FALSE, the drawing plot date is stored.

DATE_START
Shows the starting date of the project entered in the Project properties in
File menu --> Project properties.

DELIVERY

This attribute shows the value entered in the Delivery box in the Revision
Handling dialog box.
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DESCRIPTION

Shows the description entered in the Description box in File --> Project
properties .

Shows the revision Description entered in the Revision Handling dialog box
for a drawing.

DESIGNER
Shows the name of the designer in the Project properties in File menu -->
Project properties.

DesignGroup

Shows the values entered in the Design Group (opimisation) box on the
Analysis tab in the user-defined attributes dialog box of the part.

See also

Analysis part properties (page 750)

DIAMETER
Shows the bolt, nut, screw, washer, stud shank, hole or part profile diameter,
depending on the content type you use.

WASHER content type:

• The inner diameter of the washer.

NUT content type:

• The inner diameter of the nut.

SCREW content type:

• The screw diameter.

STUD content type:

• The diameter of the stud shank.

See also

PROFILE (page 556)
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DIAMETER_1, DIAMETER_2
Shows the diameters of a tapered profile. Below diameters of parametric
profile PD:

See also

PROFILE (page 556)

DIAMETER_X
Shows the length of the slotted hole in the X direction (hole size + tolerance +
LONG_HOLE_X).

Use with BOLT, HOLE, NUT and WASHER content types.

DIAMETER_Y
Shows the length of the slotted hole in the Y direction (hole size + tolerance +
LONG_HOLE_Y).

Use with BOLT, HOLE, NUT and WASHER content types.

DIM_A ... DIM_G, DIM_H1, DIM_H2, DIM_I, DIM_J, DIM_K1,
DIM_K2, DIM_L, DIM_O, DIM_R, DIM_R_ALL, DIM_TD,
DIM_WEIGHT, DIM_X, DIM_Y
Show dimensions of bent reinforcing bars based on the mappings in the
rebar_schedule_config.inp file, located in the system folder defined with
the advanced option XS_SYSTEM. These mappings are environment-specific by
default. You can modify them to suit your company or project needs.

DIM_TD shows the diameter of the bending cylinder, DIM_R shows the radius. 
DIM_R_ALL shows multiple radiuses.

TIP When you use DIM_R_ALL in a value field, use Text as Datatype and 
DistanceList as Meaning.

See also
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ANG_S, ANG_T, ANG_U, ANG_V (page 485)

DIM_A_MAX ... DIM_G_MAX, DIM_H1_MAX, DIM_H2_MAX,
DIM_I_MAX, DIM_J_MAX, DIM_K1_MAX, DIM_K2_MAX,
DIM_O_MAX, DIM_R_MAX, DIM_TD_MAX, DIM_X_MAX,
DIM_Y_MAX
Shows the maximum dimensions of bent reinforcing bars in tapered cross
sections. For more information, see .

DIM_A_MIN ... DIM_G_MIN, DIM_H1_MIN, DIM_H2_MIN,
DIM_I_MIN, DIM_J_MIN, DIM_K1_MIN, DIM_K2_MIN,
DIM_O_MIN, DIM_R_MIN, DIM_TD_MIN, DIM_X_MIN,
DIM_Y_MIN
Shows the minimum dimensions of bent reinforcing bars in tapered cross
sections. For more information, see .

DRAWING_USERFIELD_1 ... _8

Shows the value of the user-defined attribute of the drawing that you can
define in the User field 1, User field 2, and so on, boxes on the Parameters
tab in the user-defined attributes dialog box of the drawing.

DR_DEFAULT_HOLE_SIZE
Shows the default bolt hole size that you define in drawing properties. This
attribute is for template purposes only.

The default bolt hole size (Ignore size) in the bolt mark properties defines the
default size of bolt holes. This setting defines the size of bolt holes that do not
have bolt marks in drawings.
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DR_DEFAULT_WELD_SIZE
Shows the default weld size that you define in drawing properties. This
attribute is for template purposes only. It can be found under Drawing
content type in Template Editor.

The default weld size (Weld size limit) in weld properties defines the
minimum size of welds to show in drawings.

See also

XS_WELD_FILTER_TYPE (page 478)

XS_OMITTED_WELD_TYPE (page 321)

DR_PART_POS
Shows the position number of the drawing main part. Can be used in drawing
templates and drawing reports.

DR_PART_POS returns attribute PART_POS in all other drawing types, except
for the assembly and cast unit drawings, where it returns ASSEMBLY_POS
attribute value.

2.5 Template attributes - E

ECCENTRICITY_X, ECCENTRICITY_Y
Shows the eccentricity dimensions of a profile. Below the eccentricity x
dimension of the RCXX profile:

See also

PROFILE (page 556)
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EDGE_FOLD, EDGE_FOLD_1, EDGE_FOLD_2
Shows the edge fold dimensions of a profile. Edge fold dimension 1 and 2
concern unsymmetrical profiles. See the example of a CC profile below:

EDGE_FOLD_1

EDGE_FOLD_2

See also

PROFILE (page 556)

END_X, END_Y, END_Z
Shows the coordinates of the end points used to create a part.

END1_ANGLE_Z
Shows the end angle of the first end of a profile in the local z-direction, for
parts with cross-section profiles.

END1_ANGLE_Y
Shows the end angle of the first end of a profile in the local y-direction, for
parts with cross-section profiles.

END2_ANGLE_Z
Shows the end angle of the second end of a profile in the local z-direction, for
parts with cross-section profiles.
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END2_ANGLE_Y
Shows the end angle of the second end of the profile in the local y-direction,
for parts with cross-section profiles.

END1_CODE, END2_CODE
Shows the shape information of the first and second ends of a profile, for
parts with cross-section profiles. The options are:

• 0 = no operation

• 1 = fitting

• 2 = cut

• 3 = fitting and cut

END1_SKEW, END2_SKEW
Shows 1 (INTEGER) if the corresponding end of a part has a skewed cut or
fitting and 0 if the end is straight.

ERECTIONSTATUS

Shows the value selected in the Erection Status list on the Status tab in the
user-defined attributes dialog box of the part.

EXTRA_LENGTH

Shows the bolt extra length.

2.6 Template attributes - F

fabricator

Shows the value entered in the Fabricator name box on the Parameters tab
in the user-defined attributes dialog box of the part.

Template attributes in drawing and report
templates

524 Template attributes - F



FATHER_ID
Shows the ID of the part that a reinforcement mesh belongs to.

Note that part IDs are temporary, and may change when you reopen a model,
or use the read in command in Tekla Model Sharing, for example.

FINISH
Shows the final properties of a part defined in the properties dialog box (for
example, in the beam properties dialog box). For all other objects the field is
blank.

FLANGE_LENGTH_B
Shows the total length of the lower flange of an I profile. Use when you need
to show welded profiles as plates.

FLANGE_LENGTH_U
Shows the total length of the upper flange of an I profile. Use when you need
to show welded profiles as plates.

FLANGE_SLOPE_RATIO
Shows the slope ratio of a flange.

See also

PROFILE (page 556)

FLANGE_THICKNESS
Shows the thickness of a flange.

See also

PROFILE (page 556)
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FLANGE_THICKNESS_1, FLANGE_THICKNESS_2
Shows the flange thicknesses of unsymmetrical profiles, such as in
unsymmetrical RCDL profile:

See also

PROFILE (page 556)

FLANGE_THICKNESS_B
Shows the thickness of the lower flange of an I profile. Use when you need to
show welded profiles as plates.

See also

PROFILE (page 556)

FLANGE_THICKNESS_U
Shows the thickness of the upper flange of an I profile. Use when you need to
show welded profiles as plates.

See also

PROFILE (page 556)

FLANGE_WIDTH
Shows the width of a flange.

See also

PROFILE (page 556)
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FLANGE_WIDTH_1, FLANGE_WIDTH_2
Shows the flange widths of unsymmetrical profiles.

See also

PROFILE (page 556)

FLANGE_WIDTH_B
Shows the width of the lower flange of an I profile. Use when you need to
show welded profiles as plates.

See also

PROFILE (page 556)

FLANGE_WIDTH_U
Shows the width of the upper flange of an I profile. Use when you need to
show welded profiles as plates.

See also

PROFILE (page 556)

FOLD_ANGLE
Shows the fold angle of a profile.

See also

PROFILE (page 556)

2.7 Template attributes - G
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GROUP_POS

Shows the position number of a tapered reinforcing bar group in a rebar set
as defined by XS_REBARSET_TAPERED_GROUP_POSITION_NUMBER_FORMAT_
STRING (page 361).

If XS_REBARSET_TAPERED_GROUP_POSITION_NUMBER_FORMAT_STRING
(page 361) is not set, XS_REBAR_POSITION_NUMBER_FORMAT_STRING
(page 352) defines the GROUP_POS format.

See also

REBAR_POS (page 561)

GROUP_TYPE
Shows the group type of a reinforcing bar:

• Normal = 0

• Tapered = 1

• Tapered 2 = 2

• Tapered curved = 3

• Tapered N = 4

• Spiral = 5

GRADE
Shows the grade of the object. Use with BOLT, NUT, MESH, REBAR, and STUD
content types.

GUID
Shows GUID, which is a globally unique identifier.

NOTE The report property GUID adds the prefix “ID” to the value. For example, 
ID56497C3E-0000-06F6-3134-343736353635.

2.8 Template attributes - H
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HAS_CONNECTIONS

Use to check whether a part contains connections. The attribute returns 1 if
the part contains connections, otherwise it returns 0.

HAS_HOLES

Use to check whether a part contains bolt holes. The attribute returns 1 if the
part contains bolt holes, otherwise it returns 0.

This attribute does not take cuts into account.

HEAD_DIAMETER
Shows the diameter of the stud head.

HEAD_THICKNESS
Shows the thickness (height) of the stud head.

HEAD_TYPE

Shows the type of the bolt head.

Bolt head type Description Image
1 Hex-headed

2 Round- or cup-headed

3 Flat-headed or countersunk

See also

BOLT_COUNTERSUNK (page 496)

Template attributes in drawing and report
templates

529 Template attributes - H



HEIGHT
Shows the height of an object.

DRAWING content type:

• The height of the drawing.

ASSEMBLY content type:

• The height of the assembly main part for assemblies, parts, and bolts.

PART content type:

• The height of single-part or assembly drawings. Use in part and assembly
lists.

See also

PROFILE (page 556)

HEIGHT_1 ... 4
Shows the height dimensions of unsymmetrical profiles, such as in RCDX
profile below:

See also

PROFILE (page 556)

HIERARCHY_LEVEL

Shows the hierarchical level of an assembly. The possible values are:

• 0: The assembly is on the highest level of the hierarchy.

• 1: The assembly is on the highest level in a nested assembly.

• 2: The assembly does not have any nested assemblies within it.

• Any other number: The assembly is a nested assembly within an another
assembly. The number defines the level of the assembly in the assembly
hierarchy.
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HISTORY

Use to retrieve information on the model history. You can use this template
attribute with content types PART, SURFACING, REBAR, CONNECTION, and 
DRAWING.

The following attributes can be used with the HISTORY attribute:

• CREATED
• CREATED_BY
• MODIFIED
• MODIFIED_BY
• MODIFIED_ACTION
• TOUCHED
• TOUCHED_BY
• TOUCHED_ACTION
• OWNER

Example

To find out which user has created an object in the model, use the
combination HISTORY.CREATED_BY.

Offline usage history is stored according to the Windows domain user account.
Note that in Tekla Model Sharing models, when you write out your changes to
the sharing service, the changes are stored using your Trimble Identity.

Limitations

• You need to turn on the collection of model history. Set
XS_COLLECT_MODEL_HISTORY (page 120) to TRUE.

• Information cannot be retrieved for deleted objects.

• Changes in user-defined attributes do not affect this template attribute.

HOLE.DIAMETER

The HOLE.DIAMETER attribute returns the diameter of the holes in drawings. It
only takes account the visible holes.
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HOLE_TOLERANCE
Only use in bolt lists. Shows the bolt tolerance. Shows a zero in all other lists.

HOOK_START, HOOK_END

Shows 1 if there is a hook at the start or end of a reinforcing bar, and 0 if there
is no hook.

HOOK_START_ANGLE, HOOK_END_ANGLE

Shows the angle of the hook at the start or end of a reinforcing bar.

HOOK_START_LENGTH, HOOK_END_LENGTH

Shows the length of the straight part of the hook at the start or end of a
reinforcing bar.

HOOK_START_RADIUS, HOOK_END_RADIUS

Shows the internal bending radius of the hook at the start or end of a
reinforcing bar.

2.9 Template attributes - I

ID
Shows the identification number of an object. Use with all content types.

Note that object IDs are temporary, and may change when you reopen a
model, or use the read in command in Tekla Model Sharing, for example.
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IFC_BUILDING

Shows the value entered in the IFC building name box on the IFC export tab
in the user-defined attributes dialog box of the part.

See also

IFC_BUILDING_STOREY

Shows the value entered in the IFC building storey name box on the IFC
export tab in the user-defined attributes dialog box of the part.

See also

IFC_ENTITY

Shows the value selected in the IFC entity list on the IFC export tab in the
user-defined attributes dialog box of the part.

See also

IFC_SITE

Shows the value entered in the IFC site name box on the IFC export tab in
the user-defined attributes dialog box of the part.

See also

INFO1, INFO2
Shows the corresponding values in the Project properties in File menu -->
Project properties.

Shows the Info 1 and Info 2 texts of the revision entered in the Revision
Handling dialog box.
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INNER_DIAMETER
Shows the inner diameter of an object in the bolt catalog, for example,
washers or nuts.

Use with BOLT, HOLE, NUT, and WASHER content types.

INSTALL_ACTUAL

Shows the value selected in the Erection Actual field on the Status tab in the
user-defined attributes dialog box of the part or in the assembly properties
dialog box.

INSTALL_PLAN

Shows the value selected in the Erection Scheduled field on the Status tab in
the user-defined attributes dialog box of the part or in the assembly
properties dialog box.

IS_BENT_PLATE
Use to check whether an object is a bent plate. You can use this attribute in
filtering, for example. The attribute returns 1 if the object is a bent plate,
otherwise it returns 0.

IS_CONCEPTUAL

Use to check whether reinforcement is conceptual. The attribute returns TRUE
if the reinforcement is conceptual, otherwise it returns FALSE.

IS_CURVED

Use to check whether a reinforcing bar is curved. You can use this attribute in
filtering, for example. The attribute returns 1 if the bar is curved or has a
shape similar to a curved bar. Otherwise the attribute returns 0.
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IS_FROZEN

The IS_FROZEN attribute tells if the drawing is frozen. This attribute can be
used for adding Document manager information about frozen drawings in
drawing reports. The report returns the value 1 if the drawing is frozen, and 0
if it is not frozen.

Document manager has a column  Freeze for this information.

In the image below, you can see that some of the drawings are frozen (a flag

 in the  Freeze column).

IS_ISSUED

The IS_ISSUED attribute tells if the drawing is issued. Issuing prevents the
recreation of the drawing during drawing update. This attribute can be used
for adding Document manager information about issuing in drawing reports.
The report returns the value 1 if the drawing is issued, and 0 if it is not issued.
Also the Document manager has a column Issue for this information.

In the image below, you can see that some of the drawings have been issued,

and there is a flag  in the  Issue column. One of the issued drawings

has changed, which is indicated by the flag 
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IS_ITEM

Use to check whether an object is an item. The attribute returns 1 if the object
is an item, otherwise it returns 0.

IS_LOCKED

The IS_LOCKED attribute tells if the drawing is locked. This attribute can be
used for adding Document manager information about locking in drawing
reports. The report returns the value 1 if the drawing is locked, and 0 if it is not

locked. Also Document manager has a column Lock for this information.

In the image below, you can see that two of the drawings are locked (a flag

 in the Lock column).

IS_LOFTED_PART
Use to check whether an object is a lofted plate or lofted slab. You can use this
attribute in filtering, for example. The attribute returns 1 if the object is a
lofted part, otherwise it returns 0.

IS_POLYBEAM

Use to check whether a part is a polybeam. The attribute returns 1 if the part
is a polybeam, otherwise it returns 0.
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IS_POUR_BREAK_VALID

Use to check whether a pour break is valid, and to find invalid pour breaks. An
invalid pour break does not split a pour object completely into two. The
attribute returns the value 1 if the pour break is valid and 0 if the pour break is
invalid.

See also

XS_INVALID_POUR_BREAK_COLOR (page 276)

IS_READY_FOR_ISSUE

The IS_READY_FOR_ISSUE attribute tells if the drawing has been marked
ready for issuing in Document manager. This attribute can be used for
adding Document manager information about drawings marked for issuing
in drawing reports. The report returns the value 1 if the drawing is marked
ready for issuing, and 0 if it is not marked ready for issuing.

The Document manager has a column Ready for issuing for this
information. If the drawing has been marked, there is a check mark in the
column.

To include in the report who has marked the drawing ready for issuing, use
the attribute READY_FOR_ISSUE_BY (page 559). This information is shown in
the Ready for issuing by column in Document manager.

IS_REBARSET_BAR

Use to check whether a reinforcing bar belongs to a rebar set. The attribute
returns 1 if the bar belongs to a rebar set, otherwise it returns 0.

Template attributes in drawing and report
templates

537 Template attributes - I



IS_SPIRAL_BEAM
Use to check whether an object is a spiral beam. You can use this attribute in
filtering, for example. The attribute returns 1 if the object is a spiral beam,
otherwise it returns 0.

2.10 Template attributes - L

LAP_xxx

Use the following template attributes to show lapping information defined by
using a rebar set splitter.

Template attribute Description
LAP_SIDE_START
LAP_SIDE_END

Shows the side of the lap splice from
the splitter at the start or end of the
bar: Left, Right, or Middle.

LAP_PLACEMENT_START
LAP_PLACEMENT_END

Shows whether the lapping bars are
parallel to each other or on top of
each other at the start or end of the
bar.

LAP_LENGTH_START
LAP_LENGTH_END

Shows the length of the lap splice at
the start or end of the bar.

See also

Splitter properties (page 622)

LAST
The last revision number of a drawing (as an integer).

LAST_APPROVED_BY

The Approved by information of the latest delivery of a drawing from the
Revision Handling dialog box.
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LAST_CHECKED_BY

The Checked by information of the latest revision from the Revision
Handling dialog box.

LAST_CREATED_BY

The Created by information of the latest revision from the Revision Handling
dialog box.

LAST_DATE_APPROVED

The approval Date of the latest revision of a drawing from the Revision
Handling dialog box.

LAST_DATE_CHECKED

The Checked by Date of the latest revision of a drawing from the Revision
Handling dialog box.

LAST_DATE_CREATE

In drawing templates this field shows the date of the last revision. In 
REVISION lists it also shows the entire revision history.

LAST_DELIVERY

The Delivery information of the latest revision from the Revision Handling
dialog box.

LAST_DESCRIPTION

The Description of the latest revision from the Revision Handling dialog box.
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LAST_INFO1

The Info 1 text of the latest revision of the drawing from the Revision
Handling dialog box.

LAST_INFO2

The Info 2 text of the latest revision of the drawing from the Revision
Handling dialog box.

LAST_MARK
In drawing templates this field shows the last revision mark. In REVISION lists,
it also shows the entire revision history.

LAST_TEXT1...3
In drawing templates this field shows the text for the last revision. In 
REVISION lists it also shows the revision history.

LAYER

Shows the layer information of rebar set bars as defined by
XS_REBARSET_REBAR_LAYER_FORMAT_STRING (page 357).

See also

LAYER_PREFIX (page 541)

LAYER_NUMBER (page 540)

LAYER_NUMBER

Shows the order number of a rebar set bar layer.

You can define layer numbers for entire rebar sets (page 611) or individual
leg faces (page 615), or for individual rebar set bars using the user-defined
attributes of property modifiers (page 616).

Layer numbering starts from 1. The smaller the layer number, the closer to the
concrete surface the bar layer is.
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See also

LAYER_PREFIX (page 541)

LAYER (page 540)

LAYER_PREFIX

Shows the prefix used for a layer of rebar set bars.

You can define the default layer prefixes of a model in the Options dialog box.
You can also define bar layer prefixes for individual rebar sets (page 611)
using their user-defined attributes, or for individual rebar set bars using the
user-defined attributes of property modifiers (page 616).

See also

LAYER_NUMBER (page 540)

LAYER (page 540)

LEG_LENGTH_START, LEG_LENGTH_END

LEG_LENGTH_START shows the length of the first leg of the reinforcing bar. 
LEG_LENGTH_END shows the length of the last leg of the reinforcing bar.

These are the values entered in the Start and End boxes in the Single rebar
or Rebar group properties (page 604) when the Leg length option is
selected.

See also

CONCRETE_COVER_START, CONCRETE_COVER_END (page 507)

LENGTH
Shows the length of an object. Use with the following content types:

• ANALYSIS_RIGID_LINK

• ANTIMATERIAL

• ASSEMBLY

• BOLT

• CAST_UNIT

• CHAMFER

• MESH
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• PART

• REBAR

• SIMILAR_ASSEMBLY

• SIMILAR_CAST_UNIT

• SIMILAR_PART

• SINGLE_REBAR

• SINGLE_STRAND

• STRAND

• STUD

• WELD

Takes the cuts, fittings, and end offsets of the parts, assemblies, and cast units
into account.

LENGTH_GROSS
Shows the length of assemblies, parts, and bolts before cuts are made.

LENGTH_MAX
Shows the maximum length of a reinforcing bar in a reinforcing bar group.

LENGTH_MIN
Shows the minimum length of a reinforcing bar in a reinforcing bar group.

LOCATION

Shows the location entered in the Project properties in File --> Project
properties.

LOCKED_BY

The LOCKED_BY attribute tells who has locked a drawing. If the user who has
locked the drawing has logged in with Trimble Identity, the account name is
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given, otherwise the user name is given. This attribute can be used for adding
Document manager information about who locked the drawing in drawing
reports. Also the Document manager has a column Locked by for this

information. The  Lock column has a flag when a drawing is locked.

LONG_HOLE_X
Shows the value from the Slotted hole X box in the bolt properties. See also
DIAMETER_X (page 520).

LONG_HOLE_Y
Shows the value from the Slotted hole Y box in the bolt properties. See also
DIAMETER_Y (page 520).

LOT_NUMBER
Shows the lot number to which the assembly belongs.

LOT_NAME
Shows the name of the lot to which the assembly belongs.

2.11 Template attributes - M

MAIN_PART
Shows 1 to indicate the main parts of assemblies and 0 for all other objects.
Can be used for sorting.

To show a main part of an assembly on top of part lists:

1. In the Template Editor, add value field MAIN_PART to PART row.

2. Set the Order to Descending and (if needed) hide the field in output, in
the Value Field Properties dialog box.
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3. Drag the MAIN_PART field to be first in sort order in the Content
browser.

MAJOR_AXIS_LENGTH_1 ... 2
Shows the major axis length dimensions of a tapered profile. Below d1 is the
major axis length 1and d2 is the major axis length 2 in parametric profile EPD.

See also

PROFILE (page 556)

MARK
In drawing templates this field shows the last revision mark. In the REVISION
lists it also shows the revision history. The revision mark of the revision
entered in the Revision Handling dialog box.

MATERIAL
Shows the material name for parts. Shows the material of the assembly main
part for assemblies. Shows the grade entered in the Bolt assembly catalog
dialog box for bolts.

MATERIAL_TYPE
Shows the material type of assemblies or parts.

The material catalog contains the following predefined material types:

• STEEL

• CONCRETE

• REINFORCING BAR

• TIMBER

• MISCELLANEOUS
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MESH_POS
Shows the position of a mesh as defined by the advanced option XS_REBAR_
POSITION_NUMBER_FORMAT_STRING (page 352).

MINOR_AXIS_LENGTH_1 ... 2
Shows the minor axis length dimensions of a tapered profile. Below r1 is the
minor axis length 1and r2 is the minor axis length 2 in parametric profile EPD.

See also

PROFILE (page 556)

MODEL
Shows the name of the model.

MODEL_PATH

You can use the template attribute MODEL_PATH in all content types to find the
path to the current model, for example C:\TeklaStructuresModels\New
Model 1\.

MODEL_TOTAL
Shows the number of similar objects in a model (i.e. those with the same
position number).

MODULUS_OF_ELASTICITY
Shows the modulus of elasticity of a material from the material catalog.
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MOMENT_OF_INERTIA_X
Shows the moment of inertia around the x-x reference axis of a cross section.
Moment of inertia is also known as the second moment of area.

See also

PROFILE (page 556)

MOMENT_OF_INERTIA_Y
Shows the moment of inertia around the y-y reference axis of a cross section.
Moment of inertia is also known as the second moment of area.

See also

PROFILE (page 556)

moment1, moment2

Shows the values entered in the Moment, M box on the End codes tab in the
user-defined attributes dialog box of the part. moment1 shows the value in the
Start box and moment2 in the End box.

MORTAR_VOLUME
Shows the mortar volume used in surface treatment.

2.12 Template attributes - N

NAME
The name of the object. If the object does not have a name, it is searched from
the next level.

Depending on the content type, shows:
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Content type Description
ASSEMBLY The assembly mainpart, project, phase

or drawing name.
BOLT Bolt name from the bolt catalog.

Nut, washer, phase, or project name.
CAST UNIT Project, mainpart, phase or drawing

name
CONNECTION The connection name that appears in

the title bar of the corresponding
connection properties dialog box.

Project name.
DRAWING The entire drawing name, including the

drawing type (A, W, C, G, M).

Project name.
HOLE Bolt, nut, washer, phase, or project

name.
MESH The mesh name, or project name.
NUT The nut name, or bolt, washer, project

or phase name.
PART Name entered in the part properties

dialog box for parts.

Phase, assembly main part, drawing or
project name.

REBAR The reinforcing bar name.

Phase or project name.
STUD The stud name.

Project or phase name.
SURFACING Surface treatment name defined in the

product_finishes.dat file

Project name.
WASHER The washer name from the bolt catalog.

Bolt, nut, project or phase name.

NAME_BASE
Shows the drawing name.
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NEUTRAL_AXIS_LOCATION_ELASTIC_X
Shows the location of elastic neutral axis.

See also

PROFILE (page 556)

NEUTRAL_AXIS_LOCATION_ELASTIC_Y
Shows the location of elastic neutral axis.

See also

PROFILE (page 556)

NEUTRAL_AXIS_LOCATION_PLASTIC_X
Shows the location of plastic neutral axis.

See also

PROFILE (page 556)

NEUTRAL_AXIS_LOCATION_PLASTIC_Y
Shows the location of plastic neutral axis.

See also

PROFILE (page 556)

NORMALIZED_WARPING_CONSTANT
Shows the warping constant of a profile.

See also

PROFILE (page 556)
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NUMBER, NUMBER#1, NUMBER #2
NUMBER shows the revision number in Rev. No box in the Revision Handling
dialog box.

NUMBER#1 shows the total number of objects on a list. Shows the total
number of parts and bolts for one assembly for list types ASSEMBLY, 
ASSEMBLY_BOLT, ASSEMBLY_PART and ASSEMBLY_ALL, if the object is part of
an assembly on the list.

NUMBER#2 shows the project number as text.

NUMBER_IN_DRAWING

The attribute NUMBER_IN_DRAWING shows the number of all rebars in a
drawing that have the same position number. The neighbor part rebars are
ignored. Therefore, use NUMBER_IN_DRAWING in main reinforcement marks
only, and not in marks of the visible neighbor reinforcement.

If you include the attribute NUMBER_IN_DRAWING in a reinforcement mark
element, you get number of all rebars in the drawing that have the same
position number. For meshes, NUMBER_IN_DRAWING returns the number of
similar meshes.

Note that NUMBER_IN_DRAWING works in associative notes and reinforcement
marks, but it does not work in filtering.

See also

NUMBER_VISIBLE (page 550)

NUMBER_IN_PHASE(X)

Returns the quantity of assemblies in phase X. The result is the same as the 
NUMBER template attribute but by phase.

You can also use the template attribute PHASE and the function GetValue
instead of a number in the template attribute.

Example
GetValue("NUMBER_IN_PHASE(GetValue("PHASE"))")
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NUMBER_OF_BARS_IN_GROUP

Shows the number of the reinforcing bars in a bar group.

Use with the row content type SINGLE_REBAR as follows:

REBAR.NUMBER_OF_BARS_IN_GROUP

See also

WEIGHT_TOTAL_IN_GROUP (page 584)

NUMBER_OF_TILE_TYPES

Returns the number of tiles in a tile pattern. For example, the Basketweave
pattern is made up of eight tiles, so the template attribute returns 8 for a tile
surface treatment whose pattern type is Basketweave.

NUMBER_VISIBLE

When added in the reinforcing bar group mark, shows the number of visible
reinforcing bars in the view. This is a context-specific template attribute.

2.13 Template attributes - O

OBJECT
Shows project information entered in the Object box in File menu --> Project
properties.

OBJECT_DESCRIPTION
Shows the object type and ID. Below examples:

• PART 780*380 Id: 227

• ASSEMBLY Id: 144
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• MESH Id: 946

Note that object IDs are temporary, and may change when you reopen a
model, or use the read in command in Tekla Model Sharing, for example.

OBJECT_LOCKED
Shows the status of the user-defined attribute Locked.

See also

ASSEMBLY.OBJECT_LOCKED (page 490)

ASSEMBLY.OWNER_ORGANIZATION (page 490)

ASSEMBLY.LOCK_PERMISSION (page 489)

XS_OBJECTLOCK_DEFAULT (page 318)
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ORIGIN_X, ORIGIN_Y, ORIGIN_Z

It is possible to inquire the global coordinates of a connection's origin through
templates. The fields are named ORIGIN_X, ORIGIN_Y and ORIGIN_Z.

OBJECT_TYPE
The type of object. The message files contain the translations of these strings
(numbers 576 - 587).

The object types are:

• POINT

• PART

• JOINT

• FITTING

• SCREW

• ANTI-MATERIAL

• CUT
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• WELDING

• ASSEMBLY

• DRAWING

• PROJECT

• OBJECT

OWNER
Shows the object owner in format domain/user.

2.14 Template attributes - P

PAGE
The current page number.

PART_POS
The position number of parts. Shows a blank cell for all other objects.

Shows the mark of assembly main part for assemblies, parts, and bolts. For all
other objects the field is blank.

PART_PREFIX
Shows the part prefix, defined in the part properties.

For more information on numbering series, see .

PART_SERIAL_NUMBER
Shows the part number without the prefix and separator.
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PART_START_NUMBER

Shows the part start number.

See also

PCS
Shows the number of bars in a reinforcing bar group.

PERIMETER

The template attribute PERIMETER gives the perimeter of concrete slabs or
polygon plates. In Template Editor, the content type of this template attribute
is PART.PERIMETER. It can be used both in textual templates and in graphical
templates.

PERIMETER can also be used for calculating formwork area, and for take-offs.

PHASE
The number of the phase to which the object belongs.

To show the phase name, use the PHASE.NAME field.

PLASTIC_MODULUS_X
Shows the plastic modulus of x-x reference axis of a cross section. Also known
as the first moment of area.

See also

PROFILE (page 556)

PLASTIC_MODULUS_Y
Shows the plastic modulus of y-y reference axis of a cross section. Also known
as the first moment of area.

See also

PROFILE (page 556)
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PLATE_DENSITY
Shows the material density of a plate (kg/m3).

PLATE_THICKNESS

Shows the thickness of a plate (mm) if the profile has the Plate thickness
property defined in the profile catalog. For example, it works for circular and
rectangular hollow sections, and for some CC profiles which do not have
separate thicknesses for flanges and web. This attribute does not work for
plate profiles, because there is no Plate thickness that you can define in
profile properties.

See also

PROFILE (page 556)

PLOTFILE
Shows the name of the drawing dg file. Only for use in drawing tables and
drawing reports.

See also

XS_DRAWING_PLOT_FILE_NAME_A (page 204)

XS_DRAWING_PLOT_FILE_NAME_C (page 208)

XS_DRAWING_PLOT_FILE_NAME_W (page 205)

XS_DRAWING_PLOT_FILE_NAME_G (page 206)

XS_DRAWING_PLOT_FILE_NAME_M (page 207)

POISSONS_RATIO
Shows the Poisson’s ratio (analysis property) of material.
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POLAR_RADIUS_OF_GYRATION
Shows the polar radius of gyration (analysis property) of a profile.

See also

PROFILE (page 556)

POSTAL_BOX

Shows the postal box entered in the Project properties in File --> Project
properties.

POSTAL_CODE

Shows the postal code entered in the Project properties in File --> Project
properties.

PRELIM_MARK
Shows the user-defined attribute Preliminary mark.

For more information on preliminary numbers, see .

PROFILE
Shows the part profile name, or the main part profile name in an assembly or
cast unit. You can also show profile attributes in templates and reports:

In the Template editor, open the Select attribute dialog box and select
PROFILE.* attributes for the selected content type:
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For example, MAINPART.PROFILE.HEIGHT with ASSEMBLY content type, shows
the height of the main part profile in the assembly.

PROFILE_DENSITY
Shows the profile density of material (kg/m3).

PROFILE_TYPE
The profile type of the part. The default types in Tekla Structures conform to
DSTV-NC documentation. They are defined (message numbers 588 - 599) in
the message file by_number.ail in the folder ..\Tekla Structures
\<version>\messages. The table below shows the relationship between

Template attributes in drawing and report
templates

557 Template attributes - P



messages, profiles in Tekla Structures, and the DSTV-NC profile types defined
in messages.

Tekla Structures
profiles

Message number Shows DSTV-NC
profile type

I-profiles 588 I
L-profiles 589 L
U-profiles 591 U
Plates 592 B
Round bars 593 RU
Round tubes 594 RO
Rectangular tubes 595 M
CC-profiles 596 C
T-profiles 597 T
Polygon plates 598 B
Bent plates 599 B
Z-profiles and all
the other types of
profile

590 Z

PROFILE_WEIGHT
The weight of a part. For profiles Tekla Structures calculates the weight using
the weight per unit length and weight/m values in the profile catalog. If the
weight/m is not defined in the profile catalog, this field works in the same way
as WEIGHT_NET (page 582), but uses the plate density value (Property weight
for plates) from the material catalog instead of profile density.

PROFILE_WEIGHT_NET
The net weight of a part. For profiles Tekla Structures calculates the weight
using the length and weight/m values in the profile catalog. Line cuts do not
affect the length value, which is calculated using the fitted centerline. For all
other objects this field works in the same way as WEIGHT_NET (page 582).
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PROJECT_COMMENT

Shows the value entered in the Project Comment box in the user-defined
attributes dialog box of the project in File menu --> Project properties -->
User-defined attributes.

PROJECT_USERFIELD_1 ... 8

Shows the value of the user-defined attribute of the project that you can
define in the User field 1 , User field 2 and so on boxes on the Parameters
tab in the user-defined attributes dialog box of the project ( File menu -->
Project properties --> User-defined attributes ).

2.15 Template attributes - R

RADIUS

The Radius value of a curved beam.

RADIUS_OF_GYRATION_X
Shows the radius of gyration x (analysis property) of a profile.

See also

PROFILE (page 556)

RADIUS_OF_GYRATION_Y
Shows the radius of gyration y (analysis property) of a profile.

See also

PROFILE (page 556)
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READY_FOR_ISSUE_BY

The READY_FOR_ISSUE_BY attribute tells who has marked a drawing ready for
issuing. This attribute can be used for adding Document manager
information about who marked the drawing ready for issuing in drawing
reports, which can be checked from the Ready for issuing by column.

To include in a report the information whether the drawing has been marked
ready for issuing, use the attribute IS_READY_FOR_ISSUE (page 537).

REBAR_MESH_LEFT_OVERHANG_CROSS

Shows the extensions of the crossing bars over the outermost longitudinal
bars on the left.

See also

Custom reinforcement mesh properties (page 608)

REBAR_MESH_LEFT_OVERHANG_LONG

Shows the extensions of the longitudinal bars over the outermost crossing
bars on the left.

See also

Custom reinforcement mesh properties (page 608)

REBAR_MESH_RIGHT_OVERHANG_CROSS

Shows the extensions of the crossing bars over the outermost longitudinal
bars on the left.

See also

Custom reinforcement mesh properties (page 608)

REBAR_MESH_RIGHT_OVERHANG_LONG

Shows the extensions of the longitudinal bars over the outermost crossing
bars on the right.
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See also

Custom reinforcement mesh properties (page 608)

REBAR_POS
Shows the position number of a reinforcing bar as defined by XS_REBAR_
POSITION_NUMBER_FORMAT_STRING (page 352).

For reinforcing bars in tapered bar groups in rebar sets, the REBAR_POS
format is defined by XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_
FORMAT_STRING (page 362), and if that is not set, then by XS_REBAR_
POSITION_NUMBER_FORMAT_STRING (page 352).

See also

GROUP_POS (page 527)

REFERENCE_ASSEMBLY

Lists assembly level information on reference models in reports and
templates.

The following attributes are bound to the content type in
contentattributes_global.lst:
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The following user-defined attributes are bound to the content type in
contentattributes_userdefined.lst:
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See also

REFERENCE_MODEL

Lists reference models in reports.

REFERENCE_MODEL_OBJECT

Lists reference model objects in reports.

REGION

Shows the region entered in the Project properties in File --> Project
properties.
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ROUNDING_RADIUS, ROUNDING_RADIUS_1 ... 2
Shows different rounding radii of profiles. Below as an example rounding
radius 1 and 2 for a specific I profile:

See also

PROFILE (page 556)

ROW_IN_PAGE
Produces an incremental number starting from 1 at the beginning of each new
page. Use in reports and templates.

Example

Can be used together with the PAGE field to include page or row information in
the drawing template. Set Type to Text and enter the following field definition
in the Text field properties:

=%PAGE% %/% %ROW_IN_PAGE% 

2.16 Template attributes - S

SCALE1...5
Use these fields to show the different scales of drawing views. Decimal values
are rounded to the nearest integer. Only for use in drawing tables.

SCHED_FAB_DATE

Shows the value selected in the Fabrication Scheduled field on the Status
tab in the user-defined attributes dialog box of the part.
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SCREW_HOLE_DIAMETER_X

Shows the length of a screw hole in the x direction (hole diameter +
LONG_HOLE_X (page 543)).

SCREW_HOLE_DIAMETER_Y

Shows the length of a screw hole in the y direction (hole diameter +
LONG_HOLE_Y (page 543)).

SECTION_MODULUS_X, SECTION_MODULUS_Y
Shows section modulus (analysis property) of a profile.

See also

PROFILE (page 556)

SHAPE
Shows the environment-specific bending type of a reinforcing bar.

SHAPE_INTERNAL

Shows the internal bending type of Tekla Structures for a reinforcing bar, for
example, 2_1.

See also

SHEAR_CENTER_LOCATION
Shows the shear center location (analysis property) of a profile.

See also

PROFILE (page 556)
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shear1, shear2

Shows the values entered in the Shear, V box on the End codes tab in the
user-defined attributes dialog box of the part. shear1 shows the value in the
Start box and shear2 in the End box.

SHOP_ISSUE

Shows the value selected in the Plans Actual field on the Status tab in the
user-defined attributes dialog box of the part or in the assembly properties
dialog box.

SHOPSTATUS

Shows the value selected in the Fabrication Status list on the Status tab in
the user-defined attributes dialog box of the part or in the assembly
properties dialog box.

SIMILAR_TO_MAIN_PART
Returns 1 if the position number of the given part is the same as the position
number of the main part in the assembly.

To show a main part of an assembly on top of part lists:

1. In the Template Editor, add value field SIMILAR_TO_MAIN_PART to PART
row.

2. Set the Order to Descending and (if needed) hide the field in output, in
the Value Field Properties dialog box.

3. Drag the SIMILAR_TO_MAIN_PART field to be first in sort order in the
Content browser.

SITE_WORKSHOP
For bolts this field shows the assembly type information in a string (Site or
Shop). The message files (466 and 467) contain translations of these strings.

For studs this field shows the assembly type information in a string (Site or
Shop).
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SIZE
Shows the size of the drawing (e.g. 210x297). Only for use in drawing
templates and drawing reports.

SORT_OF_E_x_Cw_PER_G_x_J
Shows sqrt(ECw/GJ) analysis property of a profile.

See also

PROFILE (page 556)

SPIRAL_ROTATION_ANGLE

Shows the total +/- angle of the rotation of a spiral beam.

For example: (+)720.00 = 2 full rounds of rotation in counterclockwise.

SPIRAL_ROTATION_AXIS_xxx

• SPIRAL_ROTATION_AXIS_BASE_POINT_X
• SPIRAL_ROTATION_AXIS_BASE_POINT_Y
• SPIRAL_ROTATION_AXIS_BASE_POINT_Z
• SPIRAL_ROTATION_AXIS_BASE_POINT_X_PROJECT
• SPIRAL_ROTATION_AXIS_BASE_POINT_Y_PROJECT
• SPIRAL_ROTATION_AXIS_BASE_POINT_Z_PROJECT
• SPIRAL_ROTATION_AXIS_BASE_POINT_X_BASEPOINT
• SPIRAL_ROTATION_AXIS_BASE_POINT_Y_BASEPOINT
• SPIRAL_ROTATION_AXIS_BASE_POINT_Z_BASEPOINT
• SPIRAL_ROTATION_AXIS_BASE_POINT_X_IN_WORK_PLANE
• SPIRAL_ROTATION_AXIS_BASE_POINT_Y_IN_WORK_PLANE
• SPIRAL_ROTATION_AXIS_BASE_POINT_Z_IN_WORK_PLANE
• SPIRAL_ROTATION_AXIS_UP_POINT_X
• SPIRAL_ROTATION_AXIS_UP_POINT_Y
• SPIRAL_ROTATION_AXIS_UP_POINT_Z
• SPIRAL_ROTATION_AXIS_UP_POINT_X_PROJECT
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• SPIRAL_ROTATION_AXIS_UP_POINT_Y_PROJECT
• SPIRAL_ROTATION_AXIS_UP_POINT_Z_PROJECT
• SPIRAL_ROTATION_AXIS_UP_POINT_X_BASEPOINT
• SPIRAL_ROTATION_AXIS_UP_POINT_Y_BASEPOINT
• SPIRAL_ROTATION_AXIS_UP_POINT_Z_BASEPOINT
• SPIRAL_ROTATION_AXIS_UP_POINT_X_IN_WORK_PLANE
• SPIRAL_ROTATION_AXIS_UP_POINT_Y_IN_WORK_PLANE
• SPIRAL_ROTATION_AXIS_UP_POINT_Z_IN_WORK_PLANE
Shows the spiral beam center axis using 2 points. The rotation axis direction is
calculated from those points.

SPIRAL_TOTAL_RISE

Shows the distance between the spiral beam start point and end point along
the coordinate system z axis.

SPIRAL_TWIST_END

Shows the twist +/- angle of the spiral beam profile at the end of the part. The
default is 0.00

SPIRAL_TWIST_START

Shows the twist +/- angle of the spiral beam profile at the start of the part. The
default is 0.00

SUPPLEMENT_PART_WEIGHT
Shows the weight of supplementary parts. SUPPLEMENT_PART_WEIGHT = the
weight of the whole assembly less the weight of the main part.

See also WEIGHT (page 581).
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START_X
Shows the coordinates of the creation points of parts.

START_Y
See START_X (page 568).

START_Z
See START_X (page 568).

STATICAL_MOMENT_Qf
Shows the statical moment of the flange.

See also

PROFILE (page 556)

STATICAL_MOMENT_Qw
Shows the statical moment of the web.

See also

PROFILE (page 556)

STIFFENER_DIMENSION
Shows the stiffener dimension of a profile.

See also

STIFFENER_DIMENSION_1 ... 3 (page 569)

PROFILE (page 556)
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STIFFENER_DIMENSION_1 ... 3
Shows the stiffener dimensions of a profile. Below f1 is stiffener dimension 1,
f2 is stiffener dimension 2, and f3 is stiffener dimension 3 in parametric profile
EZ.

See also

PROFILE (page 556)

STRAND_DEBONDED_STRANDS_1...5

Shows a list of debonded strands. Strand numbers are separated by spaces.

STRAND_DEBONDED_STRANDS_1 corresponds to row 1 on the Debonding tab
in the Strand Pattern Properties dialog box, STRAND_DEBONDED_STRANDS_2
to row 2, and so on.

STRAND_DEBOND_LEN_FROM_END_1...5

Shows the debonding length from the end of the strands.

STRAND_DEBOND_LEN_FROM_END_1 corresponds to row 1 on the Debonding
tab in the Strand Pattern Properties dialog box, 
STRAND_DEBOND_LEN_FROM_END_2 to row 2, and so on.

STRAND_DEBOND_LEN_FROM_START_1...5

Shows the debonding length from the start of the strands.

STRAND_DEBOND_LEN_FROM_START_1 corresponds to row 1 on the
Debonding tab in the Strand Pattern Properties dialog box, 
STRAND_DEBOND_LEN_FROM_START_2 to row 2, and so on.
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STRAND_DEBOND_LEN_MIDDLE_TO_END_1...5

Shows the debonding length from the middle to the end of the strands.

STRAND_DEBOND_LEN_MIDDLE_TO_END_1 corresponds to row 1 on the
Debonding tab in the Strand Pattern Properties dialog box, 
STRAND_DEBOND_LEN_MIDDLE_TO_END_2 to row 2, and so on.

STRAND_DEBOND_LEN_MIDDLE_TO_START_1...5

Shows the debonding length from the middle to the start of the strands.

STRAND_DEBOND_LEN_MIDDLE_TO_START_1 corresponds to row 1 on the
Debonding tab in the Strand Pattern Properties dialog box, 
STRAND_DEBOND_LEN_MIDDLE_TO_START_2 to row 2, and so on.

STRAND_N_PATTERN
Shows the number of different cross-sections in a strand pattern.

STRAND_N_STRAND
Shows the number of strands.

STRAND_POS
Shows the position (prefix and running number) of a strand.

STRAND_PULL_FORCE
Shows the pull force of a strand.

STRAND_UNBONDED
Shows the sequence numbers of debonded strands, separated by spaces or
commas.
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SUB_ID

Shows the running index number of a reinforcing bar in a bar group.

See also

SUB_ID_WITH_LETTERS (page 572)

XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_FORMAT_STRING
(page 362)

SUB_ID_LAST

Shows the running index number of the last reinforcing bar in a bar group.

Use with the SINGLE_REBAR content type.

See also

SUB_ID (page 571)

SUB_ID_WITH_LETTERS (page 572)

SUB_ID_WITH_LETTERS

Shows the running index number of a reinforcing bar in a bar group using
letters.

Only available as a format string attribute, not as a template attribute.

See also

SUB_ID (page 571)

XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_FORMAT_STRING
(page 362)

SUBTYPE
Shows the subtype of a profile.

See also

PROFILE (page 556)
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SURFACING_NAME
Shows the name of a surface treatment, for example, Tile surface 1.

Surface treatment codes and names are defined in the
product_finishes.dat file.

See also

CODE (page 505)

2.17 Template attributes - T

TANGENT_OF_PRINCIPAL_AXIS_ANGLE
Shows the tangent of principal axis angle (analysis property) of a profile.

See also

PROFILE (page 556)

TEXT1...3
In drawing templates this field shows the text for the last revision. In 
REVISION lists it also shows the revision history.

THERMAL_DILATATION
Shows the thermal dilatation coefficient of material.

THICKNESS

Shows the thickness of a tile in a tile pattern.

THREAD_IN_MATERIAL
Shows 1 if the thread of the screw can be inside the material to be connected
and 0 if not.
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TILE_NUMBER
Shows the number of tiles used in surface treatment (approximate value).

TILE_VOLUME
Shows the volume of tiles used in surface treatment, without the mortar
volume. See also MORTAR_VOLUME (page 546).

TIME
Shows the current time (hh:mm:ss).

TITLE
Shows the user-defined drawing name. Can also be used for parts and
assemblies. For example, you could create a report of assemblies listing which
assembly drawings had been created.

TITLE1...3
In reports this field shows the user-defined titles entered in the Report dialog
box. In drawing templates this field shows the drawing attributes.

TOP_LEVEL

Shows the top level of a single part, cast unit, assembly, part of a connection
or a pour object.

Top level takes the unit and accuracy from MarkDimensionFormat.dim.

The datum level only affects the TOP_LEVEL attribute when Location by is set
to Model origin or to the project base point that is in the model origin.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE This attribute returns the value as text, so you cannot use formulae
with this attribute. Use TOP_LEVEL_UNFORMATTED (page 575)
instead.
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TOP_LEVEL_GLOBAL

Shows the top level of a single part, cast unit, assembly, part of a connection
or a pour object by global axis. TOP_LEVEL_GLOBAL takes the unit and
accuracy from MarkDimensionFormat.dim.

You can use this attribute as a user-defined attribute in part marks and
associative notes, and also in reports and templates.

TOP_LEVEL_GLOBAL_UNFORMATTED

Shows the top level of a single part, cast unit, assembly, part of a connection
or a pour object. TOP_LEVEL_GLOBAL_UNFORMATTED returns the top levels as
a length in mm so you can format them and include them into formulas in
templates. This attribute gives level information by the global axis.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

TOP_LEVEL_UNFORMATTED

Shows the top level of a single part, cast unit, assembly, part of a connection
or a pour object. TOP_LEVEL_UNFORMATTED returns the top levels as a length
in mm so you can format them and include them into formulas in templates.

The datum level only affects the attribute TOP_LEVEL_UNFORMATTED when
Location by is set to Model origin or to the project base point that is in model
origin.

You can use this attribute as a user-defined attribute also in part marks and
associative notes.

NOTE Unlike the TOP_LEVEL attribute, the TOP_LEVEL_UNFORMATTED
attribute cannot be formatted through the
MarkDimensionFormat.dim file.
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TORSIONAL_CONSTANT
Shows the torsional constant (analysis property) of a profile.

See also

PROFILE (page 556)

TOWN

Shows the city entered in the Project properties in File --> Project
properties.

TYPE
Shows the object type or standard:

Content type Description
ANALYSIS_RIGID_LINK Shows whether the analysis rigid link was created

automatically (auto), or added manually by a user
(user).

BOLT Shows the bolt standard as it appears in the Bolt
assembly catalog dialog box (for example, 7968).

DRAWING Shows the drawing type: A, W, C, G or M.
MESH Shows the mesh type: Rectangle, Polygon, or Bent.
NUT Shows the nut standard.
SURFACE Shows the surface type: Formwork or Concrete

finish.
SURFACING Shows the surface treatment type: Concrete finish,

Special mix, Tile surface, or Steel finish.
WASHER Shows the washer standard.

For all other objects the field is blank.

TYPE1
For bolts, shows the bolt standard and the standard of each possible washer
or nut as they appear in the Bolt assembly catalog dialog box (for example, 
7968/2041/2041/2041/2067/2067). For objects other than bolts, the field is
blank.
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See also

TYPE2 (page 577)

TYPE3 (page 577)

TYPE4 (page 577)

TYPE2
For bolts, shows 1 for existing and 0 for non-existing washers and nuts (for
example, 10011). For objects other than bolts, the field is blank.

See also

TYPE1 (page 576)

TYPE3 (page 577)

TYPE4 (page 577)

TYPE3
The same as TYPE2, but shows X for existing and o for non-existing washers
and nuts (for example, XooXX). For objects other than bolts, the field is blank.

See also

TYPE1 (page 576)

TYPE2 (page 577)

TYPE4 (page 577)

TYPE4
The same as TYPE1, but only shows the standard of the existing bolt elements.
For objects other than bolts, the field is blank.

See also

TYPE1 (page 576)

TYPE2 (page 577)

TYPE3 (page 577)

2.18 Template attributes - U
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USAGE

Shows if a reinforcing bar is a main bar, or a tie or stirrup. The attribute
returns Main bar for main bars, and Tie or stirrup for ties and stirrups. If
the type of use cannot be defined, the attribute returns a blank value.

See also

USAGE_VALUE (page 578)

USAGE_VALUE

Shows if a reinforcing bar is a main bar, or a tie or stirrup. The attribute
returns 1 for main bars, and 2 for ties and stirrups. If the type of use cannot be
defined, the attribute returns 0.

See also

USAGE (page 578)

USER_PHASE

Shows the value entered in the User Phase box in the user-defined attributes
of the part.

USER_FIELD_1 ... _8
Shows the value of the user-defined attribute User field 1, User field 2 etc.

See also

For more information on the user-defined attributes in templates and reports,
see .

For more information on user-defined attributes, see and .

2.19 Template attributes - V
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VOLUME
Shows the object volume, for example, the volume of an assembly or of a cast
unit. Takes holes and cuts into account.

VOLUME_GROSS
Shows the object gross volume. Does not take into account holes and cuts.

VOLUME_NET
Shows the object volume taking into account holes and cuts.

VOLUME_NET_ONLY_CONCRETE_PARTS

Shows the volume by the solid of concrete parts in the cast unit. If a part uses
a profile where cross section area is defined manually, it is ignored in
calculation ( cf. VOLUME_ONLY_CONCRETE_PARTS)

VOLUME_ONLY_CONCRETE_PARTS

This attribute gets cast unit volume values only for concrete parts. Reinforcing
bars or embeds are not taken into account.

VOLUME_ONLY_POUR_OBJECT

Shows the volume of the concrete (=pour object) in a pour unit. Takes holes
and cuts into account.

See also

WEIGHT_ONLY_POUR_OBJECT (page 583)

2.20 Template attributes - W
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WARPING_CONSTANT
Shows the warping constant (analysis property) of a profile.

See also

PROFILE (page 556)

WARPING_STATICAL_MOMENT
Shows the warping statical moment (analysis property) of a profile.

See also

PROFILE (page 556)

WEB_HEIGHT
See WEB_WIDTH (page 580).

WEB_LENGTH
The gross length of the web of an I profile. Use to show welded profiles as
plates.

WEB_THICKNESS
The thickness of the web of an I profile. Use to show welded profiles as plates.

See also

PROFILE (page 556)

WEB_THICKNESS_1, WEB_THICKNESS_2
The additional thickness values of the web of a profile.

See also

PROFILE (page 556)
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WEB_WIDTH
The width of the web of an I profile. Use to show welded profiles as plates.

WEIGHT
Shows the weight of the object.

The calculation formula depends on the object type:

• For parts with cross-sections defined in the profile catalog, the weight is
calculated from the cross section area in the profile catalog (on the list of
Properties on the Analysis tab), length (LENGTH) and density of material
(property weight for profiles in the material catalog). The result is the same
as calculating WEIGHT_GROSS.

• For other profiles with no cross sections defined (typically parametric
profiles), shows the net weight calculated using the profile volume and
density of material. Fittings, cuts, weld preparations, and part adds affect
volume calculation.

• For parts with surface treatment, shows both the weight of the part and
the surface treatment.

• For reinforcement, shows the weight of one bar in the group. 
WEIGHT_TOTAL shows the weight of all bars in the group.

• For assemblies, shows the sum of the part weights for each assembly.

• For surface treatment, shows the weight of the surface treatment.

• For bolts, shows the weight of the bolt element in the corresponding
content type rows:

• BOLT: shows the weight of the bolt.

• NUT: shows the weight of the nut.

• WASHER: shows the weight of the washer.

WEIGHT_GROSS
Shows the gross weight, which is the total weight of material needed to
fabricate the part. The calculation formula depends on the part:

• If the part has cross-sections defined in the profile catalog, the weight is
calculated from part length (LENGTH), the cross section area in the profile
catalog, and the density of material.

• If the part is a folded or contour plate without a cross section area, the
weight is calculated from plate overall height, overall length and density of
material (property weight for plates in the material catalog).
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• For other profiles without cross sections (typically parametric profiles), the
gross weight is calculated the same way as the WEIGHT_NET, but cuts are
not taken into account and the plate density value is used instead of profile
density.

• For assemblies, shows the combined gross weight of parts included in an
assembly. For bolts it shows the bolt weight.

WEIGHT_M
Shows the property weight of a profile (defined in the material catalog). For
parametric profiles, shows the weight of the profile divided by the length. For
standard profiles, shows the Weight per unit length from the Analysis
properties in the profile catalog.

WEIGHT_MAX
Shows the maximum weight of a single reinforcing bar or strand in a
reinforcing bar group.

WEIGHT_MIN
Shows the minimum weight of a single reinforcing bar or strand in a
reinforcing bar group.

WEIGHT_NET
Shows the weight of the fabricated part, assembly or cast unit. The calculation
formula depends on the object:

• For parts, returns the net weight, which is the actual weight of the
fabricated part. Rounding of the profile corners are not taken into account.

• For bolts, returns the bolt weight, and for other objects a zero.

• For assemblies, returns the sum of part weights.

The calculation is based on part volume and density of material. The density
value used in the calculation depends on the profile cross-sections:

• If cross-sections are defined in the profile catalog, density is the value of
Property: Profile Density in the material catalog.

• If there are no cross-sections, density is the value of Property: Plate
Density in the material catalog.
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NOTE For parts, the net weight is not the actual weight of the fabricated parts. The
profile cross section is calculated using straight angles, so the roundings in
the corners are not taken into account (unless you are using the advanced
option XS_SOLID_USE_HIGHER_ACCURACY). This causes significant difference
between the calculated and the actual weight especially when big cross
sections are used.

WEIGHT_NET_ONLY_CONCRETE_PARTS

Shows the weight of a cast unit. It calculates the weight by the solid of the
concrete parts in the cast unit. If a part uses a profile where cross section area
is defined manually, it is ignored in calculation ( cf. 
WEIGHT_ONLY_CONCRETE_PARTS).

WEIGHT_ONLY_CONCRETE_PARTS

This attribute gets the cast unit weight only for concrete parts only.

WEIGHT_ONLY_POUR_OBJECT

Shows the weight of the concrete (=pour object) in a pour unit. Takes holes
and cuts into account. Reinforcing bars or embeds are not taken into account.

Pour object weight is calculated according to the pour object solid and the
density of the material.

See also

VOLUME_ONLY_POUR_OBJECT (page 579)
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WEIGHT_ONLY_REBARS

Shows the weight of all reinforcement in a pour unit, including reinforcing
bars, meshes, and strands. Does not include the weight of reinforcement
belonging to precast cast units inside the pour unit.

See also

WEIGHT_ONLY_POUR_OBJECT (page 583)

WEIGHT_PER_UNIT_LENGTH
Shows the weight per unit length (analysis property) of a profile.

See also

PROFILE (page 556)

WEIGHT_TOTAL
Shows the total weight of all reinforcing bars or of all strands in a reinforcing
bar group. This template attribute is available in content type REBAR in
graphical and textual templates.

WEIGHT_TOTAL_IN_GROUP

Shows the total weight of the reinforcing bars in a bar group.

Use with the row content type SINGLE_REBAR as follows:

REBAR.WEIGHT_TOTAL_IN_GROUP

See also

NUMBER_OF_BARS_IN_GROUP (page 549)

WELD_ACTUAL_LENGTH1, WELD_ACTUAL_LENGTH2

Shows the actual weld length in the model, or the sum of actual weld lengths,
for welds above and below line.

The actual weld length is the distance between the weld seam start point and
end point along the weld seam.
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See also

WELD_LENGTH1 ... 2 (page 587)

WELD_ADDITIONAL_SIZE1, WELD_ADDITIONAL_SIZE2

Use these attributes to show the additional weld size. The additional weld size
can be set for compound weld types  and .
WELD_ADDITIONAL_SIZE1 shows the additional size value for the welds above
line, and WELD_ADDITIONAL_SIZE2 for the welds below line.

These attributes can be used in report templates.

WELD_ANGLE1, WELD_ANGLE2
Shows weld angle for welds above and below line.

WELD_ASSEMBLYTYPE
Shows the assembly type of a weld (Site or Shop). Only use in welding lists.

WELD_DEFAULT
Shows the default weld size according to the drawing attributes. Only use in
drawing tables.

WELD_CROSSSECTION_AREA1, WELD_CROSSSECTION_AREA2

Shows the theoretical cross section area for supported solid weld objects
above and below line. For unsupported weld types, shows 0.00.

WELD_EDGE_AROUND

Returns the value selected in the Edge/Around list in the Weld properties:
Edge if only one edge of a face is welded and Around if the entire perimeter is
welded.
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WELD_EFFECTIVE_THROAT, WELD_EFFECTIVE_THROAT2

Use these attributes to show the weld effective throat. 
WELD_EFFECTIVE_THROAT shows the value for the welds above line, and 
WELD_EFFECTIVE_THROAT2 for the welds below line.

WELD_ELECTRODE_CLASSIFICATION

Shows the weld electrode classification, selected in the Electrode
classification list in the Weld properties.

WELD_ELECTRODE_COEFFICIENT

Shows the value entered in the Electrode coefficient box in the Weld
properties.

WELD_ELECTRODE_STRENGTH

Shows the value entered in the Electrode strength box in the Weld
properties.

WELD_ERRORLIST
Shows error codes for a weld if there are issues related to the weld.

The error codes are:

Error code Description
E1 Weld is not in the correct location.
E2 Welded parts are not touching each other.
E3 Weld is not on the edge of a part.
E4 Weld has a cross section type that is not supported.
E5 Weld properties are incorrect.
E6 There are issues related to the weld preparation of parts.
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WELD_FATHER_CODE
Shows the connection running number of the connection where the weld is
located. The field is blank if the weld is not next to a connection. Use only in
welding lists.

WELD_FATHER_NUMBER
Shows the connection number of the connection where the weld is located.
The field is blank if the weld is not next to a connection. Use only in welding
lists.

WELD_FILLTYPE1, WELD_FILLTYPE2
Shows the weld contour (None, Flush, Convex, Concave) for welds above and
below line.

WELD_FINISH1, WELD_FINISH2
Shows the weld finish for welds above and below line.

WELD_INCREMENT_AMOUNT1, WELD_INCREMENT_
AMOUNT2

Shows the amount of increments for intermittent welds above and below line.

WELD_INTERMITTENT_TYPE

Shows the shape of a weld (Continuous, Chain intermittent, or Staggered
intermittent).
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WELD_LENGTH1 ... 2

Shows the weld length value entered in the Length box in the weld properties. 
WELD_LENGTH1 shows the length of the weld above the line and 
WELD_LENGTH2 below the line.

See also

WELD_ACTUAL_LENGTH1, WELD_ACTUAL_LENGTH2 (page 584)

WELD_NDT_INSPECTION

Shows the non-destructive testing and inspection level of a weld, selected in
the NDT inspection list in the Weld properties.

WELD_NUMBER

Shows the weld number.

See also

Weld numbering settings (page 602)

WELD_PERIOD1 ... 2

Shows the value entered in the Pitch box in the weld properties. 
WELD_PERIOD1 shows the value for the welds above line, and WELD_PERIOD2
for the welds below line.

WELD_POSITION

Shows the weld position, selected in the Position list in the Weld properties.

WELD_POSITION_X

Shows the position of the weld in the x axis.
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WELD_POSITION_Y

Shows the position of the weld in the y axis.

WELD_POSITION_Z

Shows the position of the weld in the z axis.

WELD_PROCESS_TYPE

Shows the welding process type of a weld, selected in the Process type list in
the Weld properties.

WELD_ROOT_FACE_THICKNESS,
WELD_ROOT_FACE_THICKNESS2
Shows the root face thickness of a weld above or below line and is used only in
welding lists.

WELD_ROOT_OPENING, WELD_ROOT_OPENING2

Shows the root opening (space between the welded parts) for welds above
and below line.

WELD_SIZE1, WELD_SIZE2
Shows weld size for welds above and below line.

WELD_SIZE_PREFIX_ABOVE

Shows the weld size prefix, entered in the Prefix box in the Above line section
in the Weld properties.
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WELD_SIZE_PREFIX_BELOW

Shows the weld size prefix, entered in the Prefix box in the Below line section
in the Weld properties.

WELD_TEXT
Shows the reference text of a weld.

WELD_TYPE1, WELD_TYPE2
Shows weld type for above and below line. See the .

WELD_VOLUME

Shows the volume of a solid weld object. If the solid weld object fails, shows
0.00. For unsupported weld types, shows 0.00.

WIDTH
The width of a part or assembly.

For drawings, shows the width of the drawing.

See also

PROFILE (page 556)
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WIDTH_1, WIDTH_2
Shows special width values of some profiles. Below parametric profile
rectangular hollow section with subtype h1*b1-h2*b2*t, where b1 is width 1
and b2 is width 2.

See also

PROFILE (page 556)

2.21 Template attributes - X

xs_shorten

Shows the value entered in the Shorten box on the Parameters tab in the
user-defined attributes dialog box of the part.
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3 Settings reference

This section contains detailed information on different settings.

TIP In most parts of the user interface, you can press F1 on your keyboard to view
information related to the part of the user interface you are viewing. In the
ribbon, hover the mouse pointer over the tool to view a tooltip and press Ctrl+F1
when the tooltip is displayed to see more information about the tool.

Use the table of contents to browse through these reference pages.

3.1 Modeling settings
This section provides more information about some of the settings you can
modify in Tekla Structures.

Click the links below to find out more:

• Part position settings (page 592)

• Numbering settings (page 601)

• Reinforcement settings (page 604)

Part position settings
This section provides more information about specific part position settings.
These settings can be modified in the Position and End offset sections in the
part property pane, or by using the contextual toolbar.

Click the links below to find out more:

Part position on the work plane (page 593)

Part rotation (page 594)

Part position depth (page 595)
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Part vertical position (page 596)

Part horizontal position (page 598)

Part end offsets (page 599)

Part position on the work plane
Use the On plane setting in the part properties to view and change the part’s
position on the work plane. The position is always relative to part's reference
line.

Alternatively, you can use the contextual toolbar to modify the part's position.

Option Description Example
Middle The reference line is in

the middle of the part.

Right The part is positioned
underneath the
reference line.

Left The part is positioned
above the reference line.

Examples

Position Example
Middle 300
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Position Example
Right 300

Left 300

Part rotation
Use the Rotation setting in the part properties to view and change the
rotation of a part around its axis on the work plane.

You can also define the angle of rotation. Tekla Structures measures positive
values clockwise around the local x axis.

Alternatively, you can use the contextual toolbar to modify the part's position.

Option Description Example
Front The work plane is

parallel to the front
plane of the part.

Top The work plane is
parallel to the top plane
of the part.
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Option Description Example
Back The work plane is

parallel to the back
plane of the part.

Below The work plane is
parallel to the bottom
plane of the part.

Part position depth
Use the At depth setting in the part properties to view and change the
position depth of the part. The position is always relative to the part reference
line between the part handles.

Alternatively, you can use the contextual toolbar to modify the part's position.

Option Description Example
Middle The part is positioned in

the middle of the
reference line.

Front The part is positioned
above the reference line.
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Option Description Example
Behind The part is positioned

underneath the
reference line.

Examples

Position Example
Middle 400

Front 400

Behind 400

Part vertical position
Use the Vertical setting in the part properties to view and change the vertical
position of the part. The position is always relative to the part’s reference
point.

Settings reference 596 Modeling settings



Alternatively, you can use the contextual toolbar to modify the part's position.

Option Description Example
Middle The reference point is in

the middle of the part.

Down The part is positioned
underneath the
reference point.

Up The part is positioned
above the reference
point.

Examples

Position Example
Middle 200
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Position Example
Down 200

Up 200

Part horizontal position
Use the Horizontal setting in the part properties to view and change the
horizontal position of the part. The position is always relative to the part’s
reference point.

Alternatively, you can use the contextual toolbar to modify the part's position.

Option Description Example
Middle The reference point is in

the middle of the part.

Left The part is positioned on
the left side of the
reference point.
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Option Description Example
Right The part is positioned on

the right side of the
reference point.

Examples

Position Example
Middle 150

Left 150

Right 150

Part end offsets
Use the Dx, Dy and Dz settings in the part properties to move the ends of a
part, relative to its reference line. You can enter positive and negative values.

Settings reference 599 Modeling settings



Alternatively, you can use the contextual toolbar to modify the part's position.

Option Description
Dx Changes the length of the part by

moving the part end point along the
reference line.

Dy Moves the part end perpendicular to
the reference line.

Dz Moves the part end in the z direction
of the work plane.

Examples

Position Example
Dx

End point: 200

Dx

End point: -200

Dy

End point: 300

Dy

End point: -300

Dz

End point: 400
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Position Example
Dz

End point: -400

Numbering settings
This section provides more information about specific numbering settings.

Click the links below to find out more:

• General numbering settings (page 601)

• Weld numbering settings (page 602)

• Control number settings (page 603)

General numbering settings
Use the Numbering Setup dialog box to view and modify some general
numbering settings.

Setting Description
Renumber all All parts get a new number. All information on previous

numbers is lost.
Re-use old numbers Tekla Structures reuses the numbers of parts that have

been deleted. These numbers may be used to number
new or modified parts.

Check for standard
parts

If a separate standard-part model has been set up,
Tekla Structures compares the parts in the current
model to those in the standard-part model.

If the part to be numbered is identical to a part in the
standard-part model, Tekla Structures uses the same
part number as in the standard-part model.

Compare to old The part gets the same number as a previously
numbered similar part.

Take new number The part gets a new number even if a similar numbered
part already exists.

Keep number if
possible

Modified parts maintain their previous numbers if
possible. Even if a part or assembly becomes identical
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Setting Description
with another part or assembly, the original position
number is maintained.

For example, you might have two different assemblies,
B/1 and B/2, in the model. Later on you modify B/2 so
that it becomes identical with B/1. If the Keep number
if possible option is used, B/2 will maintain its original
position number when you renumber the model.

Synchronize with
master model (save-
numbering-save)

Use this setting when working in multi-user mode. Tekla
Structures locks the master model and performs a save,
numbering, and save sequence, so that all other users
can continue working during the operation.

Automatic cloning If the main part of a drawing is modified and therefore
gets a new assembly position, the existing drawing is
automatically assigned to another part of the position.

If the modified part moves to an assembly position that
does not have a drawing, the original drawing is
automatically cloned to reflect the changes in the
modified part.

Holes The location, size, and number of holes affects
numbering.

Part name The part name affects numbering.
Beam orientation The orientation of beams affects numbering of

assemblies.
Column orientation The orientation of columns affects numbering of

assemblies.
Assembly name The assembly name affects numbering.
Assembly phase Only enabled when XS_ENABLE_PHASE_OPTION_IN_

NUMBERING (page 237) is set to TRUE.

The assembly phase affects numbering.
Reinforcing bars Reinforcing bars affect numbering.
Embedded objects Sub-assemblies affect the numbering of cast units.
Surface treatment Surface treatments affect the numbering of assemblies.
Welds Welds affect the numbering of assemblies.
Tolerance Parts get the same number if their dimensions differ

less than the value entered in this box.
Assembly position sort
order

See .
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Weld numbering settings
Use the Weld Numbering dialog box to view and modify the weld numbering
settings. The weld number is displayed in drawings and weld reports.

Option Description
Start number The number from which the numbering

starts. Tekla Structures automatically
suggests the following free number as
the start number.

Apply for Defines which objects are affected by
the change.

All welds changes the number of all
welds in the model.

Selected welds changes the number of
the selected welds without affecting
others.

Renumber also welds that have a
number

Tekla Structures replaces existing weld
numbers.

Re-use numbers of deleted welds If some welds have been removed, Tekla
Structures uses their numbers when
numbering other welds.

See also

Control number settings
Use the Create control numbers (S9) dialog box to view and modify the
control number settings.

Option Description
Numbering Defines which parts get control

numbers.

All creates consecutive numbers for all
parts.

By numbering series creates control
numbers for parts in a specific
numbering series.

Assembly/Cast unit numbering series Defines the prefix and start number of
the numbering series for which to
create control numbers.

Needed only with the By numbering
series option.
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Option Description
Start number of control numbers The number from which the numbering

starts.
Step value Defines the interval between two

control numbers.
Renumber Defines how to treat parts that already

have control numbers.

Yes replaces the existing control
numbers.

No keeps the existing control numbers.
First direction Defines in what order to assign control

numbers.Second direction
Third direction
Write UDA to Defines where to save the control

numbers.

Assembly saves the control numbers to
the user-defined attributes of
assemblies or cast units.

Main part saves the control numbers to
the user-defined attributes of assembly
or cast unit main parts.

The control number appears on the
Parameters tab.

Reinforcement settings
This section provides more information about the various reinforcement
settings you can modify in Tekla Structures.

Click the links below to find out more:

Reinforcing bar and bar group properties (page 604)

Reinforcement mesh properties (page 607)

Rebar set properties (page 611)

Reinforcement strand properties (page 624)
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Reinforcing bar and bar group properties

Use the Single rebar and Rebar group properties to view and modify the
properties of reinforcing bars and reinforcing bar groups. The file name
extension of the property file is:

• .rbr for bars

• .rbg for groups

• .rci for circular groups

• .rcu for curved groups

General, Hooks, Cover thickness, More

The following properties are available for single reinforcing bars and
reinforcing bar groups:

Option Description
Name User-definable name of the bar.

Tekla Structures uses bar names in reports and drawing
lists, and to identify bars of the same type.

Grade Steel grade of the bar. Size-grade-radius
combinations are
predefined in the rebar
catalog. Click the ...
button to open the
Select rebar dialog box.
The dialog box shows
the available bar sizes
for the chosen grade.
You can also select
whether the bar is a
main bar, or a stirrup or
tie.

Size Diameter of the bar.

Depending on the
environment, the nominal
diameter of the bar, or a mark
that defines the diameter.

Bending radius Internal radius of the bends in
the bar.

You can enter a separate value
for each bar bend. Separate
the values with spaces.

Bending radius complies with
the design code you are using.
Main bars, stirrups, ties, and
hooks usually have their own
minimum internal bending
radii, which are proportional to
the diameter of the reinforcing
bar. The actual bending radius
is normally chosen to suit the
size of the mandrels on the
bar-bending machine.

Class Use to group reinforcement.

For example, you can display bars of different classes in
different colors.
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Option Description
Numbering Mark series of the reinforcing bar.
Hook type Shape of the hook. The rebar catalog

(rebar_database.inp)
contains the predefined
minimum bending
radius and minimum
hook length for all
standard hooks.

See .

Angle Angle of a custom hook.
Radius Internal bending radius of a

standard hook or custom hook.
Length Length of the straight part of a

standard or custom hook.

Cover thickness
on plane

Distances from the part
surfaces to the bar on the
same plane as the bar.

See .

Cover thickness
from plane

Distance from the part surface
to the bar, or to the bar end,
perpendicular to the bar plane.

Start Concrete cover thickness or leg
length at the first end of the
bar.

End Concrete cover thickness or leg
length at the second end of the
bar.

UDAs You can create user-defined attributes to add information
about reinforcement. Attributes can consist of numbers,
text, or lists.

You can use the values of user-defined attributes in
reports and drawings.

You can also change the name of the fields, and add new
ones, by editing the objects.inp file. See .

Rebar group type, Distribution, Creation

The following properties are available for:

• reinforcing bar groups, including tapered groups

• curved reinforcing bar groups

• circular reinforcing bar groups

Option Description  
Rebar group
type

What is the type of the
group.

See .

Number of
cross sections
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Option Description  
Creation
method

How the bars are spaced. See .

Number of
reinforcing bars
Target spacing
value
Exact spacing
value
Exact spacing
values
Exclude Which bars are omitted

from the group.
See .

Reinforcement mesh properties

Use the Rebar mesh properties to view and modify the properties of
reinforcement meshes. The file name extension of a reinforcement mesh
properties file is .rbm.

Option Description
Numbering Mark series of the mesh.
Name User-definable name of the mesh.

Tekla Structures uses mesh names in reports and
drawing lists.

Class Use to group reinforcement.

For example, you can display bars of different classes
in different colors.

Mesh type Shape of the mesh. Select Polygon, Rectangle, or
Bent.

Cross bar location Define whether the crossing bars are located above or
below the longitudinal bars.

Cut by father part
cuts

Define whether the polygon or part cuts in the part
also cut the mesh.

Mesh To create a Standard mesh, click the ... button and
select a mesh from the mesh catalog.

The properties of standard meshes are defined in the
mesh_database.inp file.

To create a custom mesh, select the Custom mesh
option and define the properties (page 608).
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Option Description
Grade Steel grade of the bars in the mesh.

Available for custom meshes.
Bending radius Internal radius of the bends in the bar.

Available for bent meshes.
Hooks See .

Available for bent meshes.
Cover thickness on
plane

Distance from the part surface to the main bars on the
same plane as the bars.

Cover thickness
from plane

Distance from the part surface to the bar, or bar end,
perpendicular to the bar plane.

Start Thickness of concrete cover or leg length from the
mesh starting point.

Available for rectangular and bent meshes.
End Thickness of concrete cover or leg length at the end

point of the bar.

Available for bent meshes.
UDAs You can create user-defined attributes to add

information about reinforcement. Attributes can
consist of numbers, text, or lists.

You can use the values of user-defined attributes in
reports and drawings.

You can also change the name of the fields, and add
new ones, by editing the objects.inp file. See .

Custom reinforcement mesh properties
Use the Rebar mesh properties to view and modify the properties of
customized reinforcement meshes. The file name extension of a
reinforcement mesh properties file is .rbm.
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You can define the following properties for the customized reinforcement
meshes:

1. Longitudinal distance

2. Cross distance

3. Longitudinal left overhang

4. Longitudinal right overhang

5. Cross left overhang

6. Cross right overhang

7. Length

8. Width

Option Description
Spacing method Define how the mesh bars are distributed.

• Same distance for all: Use to create meshes with
evenly-spaced bars.

Tekla Structures distributes as many bars as possible
for the length of Length or Width, using the
Distances and Left overhang values.

The Right overhang is calculated automatically, and it
cannot be zero.
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Option Description
• Multiple varying distances: Use to create meshes

with unevenly-spaced bars.

Tekla Structures calculates the Width and Length
based on the Distances, the Left overhang and the
Right overhang values.

If you do not change any of the values, the spacing
method changes back to Same distance for all.

Distances Spacing values of longitudinal or crossing bars.

If you select the Multiple varying distances spacing
method, enter all spacing values, separated by spaces.
You can use multiplication to repeat spacing values. For
example:

2*150 200 3*400 200 2*150
You can create meshes with unevenly-spaced bars. You
can also define a different bar size or multiple different
bar sizes for the longitudinal bars and the crossing bars.

Multiple bar sizes enable pattern creation. For example, if
you enter bar diameters 20 2*6 in the longitudinal
direction, Tekla Structures creates a pattern with one size
20 bar and two size 6 bars. This pattern can be repeated
in the mesh along the longitudinal direction.

Left overhang Extensions of crossing bars over the outermost
longitudinal bars.

Extensions of longitudinal bars over the outermost
crossing bars.

Right overhang

Diameters Diameter or size of the longitudinal or crossing bars.

You can define multiple diameters for the bars in both
directions. Enter all the diameter values, separated by
spaces. You can use multiplication to repeat diameter
values. For example, 12 2*6 in longitudinal direction and
6 20 2*12 in crossing direction.

Width Length of crossing bars.
Length Length of longitudinal bars.
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Option Description
Grade Steel grade of the bars in the mesh.

See also

Reinforcement mesh properties (page 607)

Rebar set properties
Use the property pane or the contextual toolbar to view and modify the
properties of the rebar sets. The file name extension of the property file
is .rst.

Attributes

Option Description
Numbering Numbering series of the bars.
Name User-definable name of the bars.

Tekla Structures uses bar names in reports and drawing lists,
and to identify bars of the same type.

Grade Steel grade of the bars. Grade-size-radius
combinations are predefined
in the rebar catalog. Click
the ... button in the property
pane to open the Select
rebar dialog box. The dialog
box shows the available bar
sizes for the chosen grade.
You can also select whether
the bars are main bars, or
stirrups or ties.

Size Diameter of the bars.

Depending on the
environment, the nominal
diameter of the bars, or a
mark that defines the
diameter.

Bending
radius

Internal radius of the bends in
the bars.

Bending radius complies with
the design code you are
using. Main bars, stirrups,
ties, and hooks usually have
their own minimum internal
bending radii, which are
proportional to the diameter
of the reinforcing bar. The
actual bending radius is
normally chosen to suit the
size of the mandrels on the
bar-bending machine.

Automatic values are shown
in square brackets, for
example [120.00].
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Option Description
Class Used to group reinforcement.

For example, you can display bars of different classes in
different colors.

Layer
number

Defines the order of the bar layers. The smaller the layer
number, the closer to the concrete surface the bar layer is.
You can use both positive and negative numbers.

If you do not define the layer numbers, Tekla Structures
arranges the bar layers according to their creation order. The
bar layer that is created first is closest to the concrete
surface.

You can also adjust the layer order by using these options on
the contextual toolbar:

Note that if you copy properties from one rebar set to
another, the layer number is not copied.

Spacing properties

The file name extension of the spacing zone property file is .rst.zones.

Option Description
Start offset The offsets at the start and end of a rebar set.

By default, Tekla Structures calculates the offset values
according to the concrete cover settings and bar diameter.
Automatic values are shown in square brackets, for example
[32.00].

You can define whether an offset value is an Exact value or a
Minimum value. If you select Minimum, the actual offset
value can be bigger, depending on the spacing properties. In
model views, both the actual and minimum values are shown,
for example 50.00 (> 32.00), where the minimum value is in
parentheses.

Note that the automatic offset values may change if the
outermost rebar set bars are split by splitters and the split
bars would end up in the concrete cover area.

End offset

Length The length of each spacing
zone as an absolute value in
the current length units
(Absolute), or as a
percentage of the total length
of all spacing zones
(Relative).

Only two of the three
properties, Length, Number
of spaces, and Spacing, can
be set to Absolute or Exact
at the same time.

At least one of the spacing
properties needs to be
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Option Description
Number of
spaces

flexible and yield to create a
practical spacing
combination. In model views,
the yielding value is shown in
red.

Defines to how many spaces a
spacing zone is divided.

You can define a flexible
number, which Tekla
Structures aims at (Target), or
a fixed number of spaces
(Exact).

Spacing The spacing value of each
spacing zone.

You can define a flexible
number, which Tekla
Structures aims at (Target), or
a fixed number of spaces
(Exact).

Advanced: Rounding

Option Description
Straight bars Define whether the lengths of straight

bars, first and last legs, and
intermediate legs are rounded, and
whether the bar lengths are rounded
up, down, or to the nearest suitable
number according to the rounding
accuracy.

First and last legs
Intermediate legs

Rounding up at splitters At splitter locations, define how much
the bar lengths can be rounded up.

Advanced: Step tapering

Option Description
Type Define whether the bars are step

tapered, and how the tapering steps
are created.

The options are None, Distance, and
Number of bars.
If you select the Number of bars
option, enter the number of bars in
one tapering step.

Straight bars If you select the Distance option,
enter the tapering step values for
straight bars, first and last legs, and
intermediate legs.

First and last legs
Intermediate legs
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More

Click the User-defined attributes button to open the user-defined attributes
of the rebar sets. The file name extension of the user-defined attribute file
is .rst.more.

You can use user-defined attributes to define or override settings, such as bar
layer prefix and number, or length adjustment settings.

See also

Secondary guideline properties (page 614)

Leg face properties (page 615)

Property modifier properties (page 616)

End detail modifier properties (page 618)

Splitter properties (page 622)

Secondary guideline properties
Use the property pane or the contextual toolbar to view and modify the
properties of the rebar set secondary guidelines.

Spacing properties

If you want a secondary guideline to have similar spacing properties as the
primary guideline, select Yes from the Inherit from primary list in the
property pane. You can then modify the Start offset and End offset values if
needed. The spacing values and zone lengths are automatically scaled by the
ratio of the secondary guideline length to the primary guideline length.

If you want to define the secondary guideline spacing properties
independently from the primary guideline, select No from the Inherit from
primary list, and then modify the following spacing properties as needed:

Option Description
Start offset The offsets at the start and end of a rebar set.

By default, Tekla Structures calculates the offset values
according to the concrete cover settings and bar diameter.
Automatic values are shown in square brackets, for example
[32.00].

You can define whether an offset value is an Exact value or a
Minimum value. If you select Minimum, the actual offset
value can be bigger, depending on the spacing properties. In
model views, both the actual and minimum values are shown,
for example 50.00 (> 32.00), where the minimum value is in
parentheses.

Note that the automatic offset values may change if the
outermost rebar set bars are split by splitters and the split
bars would end up in the concrete cover area.

End offset
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Option Description
Length The length of each spacing

zone as an absolute value in
the current length units
(Absolute), or as a
percentage of the total length
of all spacing zones
(Relative).

Only two of the three
properties, Length, Number
of spaces, and Spacing, can
be set to Absolute or Exact
at the same time.

At least one of the spacing
properties needs to be
flexible and yield to create a
practical spacing
combination. In model views,
the yielding value is shown in
red.

Number of
spaces

Defines to how many spaces a
spacing zone is divided.

You can define a flexible
number, which Tekla
Structures aims at (Target), or
a fixed number of spaces
(Exact).

Spacing The spacing value of each
spacing zone.

You can define a flexible
number, which Tekla
Structures aims at (Target), or
a fixed number of spaces
(Exact).

See also

Rebar set properties (page 611)

Leg face properties
Use the property pane or the contextual toolbar to view and modify the
properties of the rebar set leg faces.

Attributes

Option Description
Layer number Defines the order of the bar layers. The smaller the

layer number, the closer to the concrete surface
the bar layer is. You can use both positive and
negative values.

By default, Tekla Structures arranges the bar layers
according to their creation order. The bar layer
that is created first is closest to the concrete
surface.

You can also adjust the layer order by using these
options on the contextual toolbar:
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Option Description

Note that if you copy properties from one leg face
to another, the layer number is not copied.

Additional offset Distance between the leg face and the bars.

A negative value moves the bars outside the
concrete.

Flip bar side Shows if the bars are flipped over to the other side
of the leg face (Yes) or not (No). The default value
is No.

See also

Rebar set properties (page 611)

Property modifier properties
Use the property pane or the contextual toolbar to view and modify the
properties of the rebar set property modifiers. The file name extension of the
property file is .rst_pm.

General

Option Description
Bars affected Select how many bars can be modified in the same

location:

• 1/1 = all bars are modified in the same cross
section.

• 1/2 = every second bar is modified in the same
cross section.

• 1/3 = every third bar is modified in the same
cross section.

• 1/4 = every fourth bar is modified in the same
cross section.

First affected bar Define which is the first bar to be modified,
starting from the first end of the modifier.

Enter a positive number, or use the arrow buttons
to change the number.

Grouping Select whether and how the bars that are affected
by the property modifier are grouped. The options
are:

• Automatic: Bars are grouped according to
automatic rules.
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Option Description
• Manual: Bars are grouped regardless of their

geometry or arrangement.

Note that this option does not group bars from
different sides of splitters.

• No grouping: Bars are not grouped, but they
are individual bars. Use this option for
overriding automatic and manual grouping.

Attributes

Option Description
Numbering Numbering series of the bars.
Name User-definable name of the bars.

Tekla Structures uses bar names in reports and drawing lists,
and to identify bars of the same type.

Grade Steel grade of the bars. Grade-size-radius
combinations are predefined
in the rebar catalog. Click
the ... button in the property
pane to open the Select
rebar dialog box. The dialog
box shows the available bar
sizes for the chosen grade.
You can also select whether
the bars are main bars, or
stirrups or ties.

Size Diameter of the bars.

Depending on the
environment, the nominal
diameter of the bars, or a
mark that defines the
diameter.

Bending
radius

Internal radius of the bends in
the bars.

Bending radius complies with
the design code you are
using. Main bars, stirrups,
ties, and hooks usually have
their own minimum internal
bending radii, which are
proportional to the diameter
of the reinforcing bar. The
actual bending radius is
normally chosen to suit the
size of the mandrels on the
bar-bending machine.

Automatic values are shown
in square brackets, for
example [120.00].

Class Used to group reinforcement.

For example, you can display bars of different classes in
different colors.
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Advanced: Rounding

Option Description
Straight bars Define whether the lengths of straight

bars, first and last legs, and
intermediate legs are rounded, and
whether the bar lengths are rounded
up, down, or to the nearest suitable
number according to the rounding
accuracy.

First and last legs
Intermediate legs

Rounding up at splitters At splitter locations, define how much
the bar lengths can be rounded up.

Advanced: Step tapering

Option Description
Type Define whether the bars are step

tapered, and how the tapering steps
are created.

The options are None, Distance, and
Number of bars.
If you select the Number of bars
option, enter the number of bars in
one tapering step.

Straight bars If you select the Distance option,
enter the tapering step values for
straight bars, first and last legs, and
intermediate legs.

First and last legs
Intermediate legs

More

Click the User-defined attributes button to open the user-defined attributes
of the rebar set property modifiers. The file name extension of the user-
defined attribute file is .rst_pm.more.

You can use user-defined attributes to define or override settings, such as bar
layer prefix and number, or length adjustment settings.

See also

Rebar set properties (page 611)

End detail modifier properties
Use the property pane or the contextual toolbar to view and modify the
properties of the rebar set end detail modifiers. The file name extension of the
property file is .rst_edm.
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General

Option Description
Bars affected Select how many bars can be modified in the same

location:

• 1/1 = all bars are modified in the same cross
section.

• 1/2 = every second bar is modified in the same
cross section.

• 1/3 = every third bar is modified in the same
cross section.

• 1/4 = every fourth bar is modified in the same
cross section.

First affected bar Define which is the first bar to be modified,
starting from the first end of the modifier.

Enter a positive number, or use the arrow buttons
to change the number.

End type Select Hook or Cranking.

If you select the empty option, no hooks or cranks
are created, but you can define length
adjustments, end preparations, and user-defined
attributes.

Hook

These properties are available when End type is Hook.

Option Description
Hook type Shape of the hook. The rebar catalog

(rebar_database.inp)
contains the predefined
minimum bending radius and
minimum hook length for all
standard hooks.

See .

Angle Angle of a custom hook.
Radius Internal bending radius of a

standard hook or custom
hook.

Length Length of the straight part of
a standard or custom hook.

Hook
rotation

Rotation angle of a hook out
of the bar plane. Use to create
3D bars.

For example:
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Cranking

These properties are available when End type is Cranking.

(1) = Location of the end detail modifier

Option Description
Cranking type Select No cranking, Standard cranking, or

Custom cranking.

Use the No cranking option to override other end
detail modifiers that create cranks.

With standard cranking, the crank dimensions are
read from the rebar catalog
(rebar_database.inp).

Crank straight length With custom cranking, enter the length of the
straight segment of the crank.

This is (2) in the image above.
Cranked length With custom cranking, select whether the length of

the cranked segment is defined in the diagonal (4)
or horizontal (3) direction:

 or 

Then select and enter the needed distance or a
multiplier of the bar diameter.

Cranked offset With custom cranking, enter the offset distance of
the straight segment of the crank.

This is (5) in the image above.

The default value is 2 * actual bar diameter.
Crank rotation Defines to which angle the crank is rotated.

Length adjustment

Option Description
Adjustment type Select whether and how the bar length is adjusted

(extended or shortened).

• No adjustment: Bar length is not adjusted.
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Option Description
• End offset: Bar length is adjusted according to

the specified end offset.

Use this option to keep the leg faces on the
concrete faces and adaptive to the concrete
faces, but still to extend or shorten the bar
ends.

• Leg length: Bar length is adjusted according to
the specified leg length.

Length Depending on the adjustment type, the length of
the end offset or leg.

With end offset, enter a positive value to extend
the bars, or a negative value to shorten the bars.

With leg length, enter a positive value to set the leg
length.

Align bar ends When the lengths of straight bars are rounded
and/or step tapered, select whether the bar ends
nearest to the end detail modifier are aligned or
not.

If you select No, the rounding and step tapering
happens at the tapered edge of the rebar set, and
if both edges are tapered, at the edge that has a
larger angle.

End preparations

Option Description
Method Select the end method of the bars. The options

are:

• Coupler

• Coupler female

• Coupler male

• Threaded

• Anchor
Type Select the end method type. The options are:

• Standard

• Position

• Bridging

• Transition

• Bolt
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Option Description
• Weldable

Product Product name of the end detail. Can be shown in
reports.

Code Product code of the end detail. Can be shown in
reports.

Thread type Enter the type of the threading.
Threaded length Length of the threading from the bar end.
Extra fabrication
length

Additional length needed with some threading
methods. Can be shown in reports, but does not
affect the total length of the bar.

More

Click the User-defined attributes button to open the user-defined attributes
of the rebar set end detail modifiers. The file name extension of the user-
defined attribute file is .rst_edm.more.

See also

Rebar set properties (page 611)

Splitter properties
Use the property pane or the contextual toolbar to view and modify the
properties of the rebar set splitters. The file name extension of the property
file is .rst_sm.

Some of the following settings depend on the splitter direction. An arrowhead

symbol  close to the midpoint of each splitter indicates the direction and
the left and right sides of the splitter. The arrow points from the start towards
the end of the splitter.

General

Option Description
Bars affected Select how many bars can be modified in the same

location:

• 1/1 = all bars are modified in the same cross
section.

• 1/2 = every second bar is modified in the same
cross section.

• 1/3 = every third bar is modified in the same
cross section.

• 1/4 = every fourth bar is modified in the same
cross section.
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Option Description
First affected bar Define which is the first bar to be modified,

starting from the first end of the modifier.

Enter a positive number, or use the arrow buttons
to change the number.

Split type Select Lapping or Cranking.
Split offset Defines how far from the splitter the split is

created.

Positive values move the split to the right side and
negative values to the left side of the splitter.

Lapping

These properties are available when Split type is Lapping.

Option Description
Lapping type Select Standard lapping or Custom lapping.
Lap length With custom lapping, enter the length of the lap

splice.

With standard lapping, the lap length is read from
the rebar catalog (rebar_database.inp).

Lap side Select the side of the lap splice from the splitter:

• Lap left

• Lap right

• Lap middle
Lap placement Select whether the lapping bars are parallel to

each other, or on top of each other.

Cranking

These properties are available when Split type is Cranking.

(1) = Location of the splitter
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Option Description
Cranking type Select Standard cranking or Custom cranking.

With standard cranking, the crank dimensions are
read from the rebar catalog
(rebar_database.inp).

Crank straight length With custom cranking, enter the length of the
straight segment of the crank.

This is (2) in the image above.
Cranked length With custom cranking, select whether the length of

the cranked segment is defined in the diagonal (4)
or horizontal (3) direction:

 or 

Then select and enter the needed distance or a
multiplier of the bar diameter.

Cranked offset With custom cranking, enter the offset distance of
the straight segment of the crank.

This is (5) in the image above.

The default value is 2 * actual bar diameter.
Crank side Select to which side of the splitter the crank is

created, Left or Right.
Crank rotation Defines to which angle the crank is rotated.

Staggering

Option Description
Stagger type Select whether and to which direction the splices

are staggered. The options are:

• No stagger

• Stagger left

• Stagger right

• Stagger middle
Stagger offset The offset of the adjacent bars if they are

staggered.

See also

Rebar set properties (page 611)
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Reinforcement strand properties

Use the Strand pattern properties to view and modify the properties of
strands. The file name extension of the properties file is .rbs.

Option Description
General
Numbering Mark series of the strand.
Name User-definable name of the strand.

Tekla Structures uses strand names in reports and
drawing lists, and to identify strands of the same
type.

Grade Steel grade of the strand.
Size Diameter of the strand.

Depending on the environment, the nominal
diameter of the strand, or a mark that defines the
diameter.

Bending radius Internal radius of the bends in the strand.

You can enter a separate value for each bend.
Separate the values with spaces.

Class Use to group reinforcement.

For example, you can display strands of different
classes in different colors.

Pull per strand Pre-stress load per strand (kN).
Number of cross
sections

Number of cross sections of the strand pattern.

For example:

• Number of cross sections along strand profile =
1:

• Number of cross sections along strand profile =
2:

• Number of cross sections along strand profile =
3:
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Option Description

• Number of cross sections along strand profile =
4:

In this double-tee beam, the number of cross
sections is 4:

Debonding
Debonded strands Enter the strand number. The strand number is the

selection order number of the strand.
From start

Middle to start

Middle to end

From end

Enter the length of the debonding.

If you select the Symmetry check box, values from
From start and Middle to start are copied to From
end and Middle to end.

Symmetry Define whether the end and start lengths are
symmetrical.

More
UDAs You can create user-defined attributes to add

information about reinforcement. Attributes can
consist of numbers, text, or lists.

You can use the values of user-defined attributes in
reports and drawings.

To set values for user-defined attributes, click the
User-defined attributes button.

You can also change the name of the fields, and add
new ones, by editing the objects.inp file. See .
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3.2 Licensing tools settings
This section contains detailed reference information about the user interface
of the following licensing tools:

• Tekla License Administration Tool options and settings (page 627)

• Tekla License Borrow Tool options and settings (page 629)

• LMTOOLS options and settings used in Tekla licensing (page 631)

Tekla License Administration Tool options and settings
Tekla License Administration Tool displays information about entitled licenses,
activated licenses and license use. You can also activate, deactivate, and repair
licenses in the tool.

Entitled licenses

The Entitled licenses area on the Licenses tab displays information on the
licenses your are entitled to. Here you can also activate licenses.

Column Description
Activate Used for activating licenses. Displays the number of

licenses to be activated.
Quantity The number of total licenses of the configuration.
Order ID The order ID of the license.

The order ID helps to identify which licenses are
linked to each other and which license needs to be
deactivated before a new license can be activated.

Activation ID The activation ID of the license.
Description The abbreviation of the configuration.
Configuration The name of the configuration.
Version The version number of the configuration.
Type Indicates whether the license is for domestic or

enterprise use.
Start Date The date when the license came into effect.
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Column Description
Expiration Date The date when the license expires. If the license is

permanent, the word Permanent is shown instead of
the expiration date.

Activated Licenses

The Activated Licenses area on the Licenses tab displays information about
activated licenses. Here you can also deactivate licenses.

Column Description

Click the  button to view the following information:

• Fulfillment ID: A unique transaction id which is
used in mapping license activations and
deactivations together.

• Borrow Info: On which computer the license is
borrowed and when the borrowing period ends.

• Start Date: When the license starts to work.

• Borrowed: Number of borrowed licenses.
Deactivate Deactivate licenses.
Trust Status The Host (H), Time (T) and Restore (R) Trust Status.

Green symbol indicates that the information is trusted.
Red symbol indicates that the information is not
trusted. If any of these are not trusted, the license
cannot be used.

Host indicates whether the server has been moved
from one computer to another or whether the
computer hardware has radically changed.

Time indicates whether the system clock has been
tampered with.

Restore indicates whether the license is obtained
from a backup copy.

Enabled Indicates whether the license is enabled or disabled.
For example, a license may be disabled if there is a
disconnection during the activation or deactivation. A
disabled license cannot be used.

Quantity The number of activated licenses of the configuration.
Borrowed The number of borrowed licenses.
Configuration The name of the configuration.
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Column Description
Version The version number of the configuration.
Expiration Date The date when the license expires. If the license is

permanent, the word Permanent is shown instead of
the expiration date.

Type Indicates whether the license is for domestic or
enterprise use.

Activation ID The activation ID of the license.
Order ID The order ID of the license.

The order ID helps to identify which licenses are linked
to each other and which license needs to be
deactivated before a new license can be activated.

License server statistics

The License server statistics area on the Statistics tab displays information
about license use.

Column Description
Configuration The name of the configuration.
Description The abbreviation of the configuration.
Total The number of activated licenses.
In Use The number of licenses in use.
Borrowed The number of borrowed licenses.
Free The number of free licenses.

Tekla License Borrow Tool options and settings
Tekla License Borrow Tool displays information about licenses that are
available for borrowing and the licenses that have been borrowed. You can
also borrow and return licenses
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The Products area displays information on licenses, and allows you to set the
expiration date for the license borrowing:

Option/
Setting

Description

Borrow Until Select an expiration date for a borrowed license. One month is
the maximum.

Configuration The name of the configuration that you are borrowing.
Version The version number of the configuration.
Activation ID
In Use

Indicates whether the activation ID is used for borrowing. The
box is selected only if you are using a customized and exported
product ID file.

Start Date The date when the license came into effect.
Expiration
Date

The date when the license expires.

The Borrowed Licenses area displays information on borrowed licenses, and
allows you to return borrowed licenses.

Option/
Setting

Description

Return Used for returning licenses.
Trust Status The Host (H), Time (T) and Restore (R) Trust Status. Green symbol

indicates that information is trusted. Red symbol indicates that
information is not trusted. If any of these are not trusted, the
license cannot be used.

• Host indicates whether the server has been moved from one
computer to another or the computer hardware has radically
changed.

• Time indicates whether the system clock has been tampered
with.

• Restore indicates whether the license is obtained from a
backup copy.
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Option/
Setting

Description

Enabled Indicates whether the license is enabled or disabled. For
example, a license may be disabled if there is a disconnection
during the borrowing. A disabled license cannot be used.

Configuration The name of the configuration.
Version The version number of the configuration.
Borrow Until The date when the borrowing expires.
Borrowed
From

The license server from where the license is borrowed.

LMTOOLS options and settings used in Tekla licensing
LMTOOLS is a graphical user interface that allows you to administer the
license server. This utility is provided by Flexera Software.

NOTE If you are using FlexNet Manager by Flexera Software for managing
licenses, do not use LMTOOLS.

In addition to Tekla licenses, you can also manage licenses of other software
that are using FlexNet or FLEXIm. You can also run LMTOOLS on client
computers to check the status of the licenses on the license server.

Go to Tekla Licensing --> LMTOOLS through the Start menu or Start screen,
depending on your Windows operating system.

Service/License File tab

Option/Setting Description
Configuration using
License File

Not used.

Configuration using
Services

You must always have Configuration using
Services and Tekla Licensing Service selected on
the Service/License File tab when you manage
Tekla licenses. These options are selected by
default during the installation of the Tekla license
server. If you need to configure the license server
manually, see .

LMTOOLS ignores
license path
environment variables

Not used.
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System Settings tab

The System Settings tab displays common device and operating system
information about the computer on which you are running LMTOOLS. All the
relevant information on licensing is available. For example, you can check the
hostname of your server computer.

Option/Setting Description
Hostid Settings Computer/Hostname

Username

CPU ID

IP Address

Etnernet Address

Disk Volume Serial Number

FLEXID
Time Settings System Time Zone

GMT Time

Difference from UTC

MSDOS Time

Local Time

Windows Directory
Save HOSTID info to a
file

Save the hostid information to a text file.

Utilities tab

You can affect the information that is displayed in the status list on the Server
Status tab by defining values on the Utilities tab. By default, the status list
displays information about all the license servers you are connected to.

Option/Setting Description
File Name

Browse

Find Version

Find out the version of FlexNet Licensing linked
with a file. Useful for diagnosing errors. Browse
for the file and click Find Version.

Vendor Name

Path

Add Vendor Path

Override Path

List All Vendor Paths

An example of the vendor name and path:

Vendor Name: tekla
Path: 27007@myserver (port and license server
computer name/hostname)

The Vendor Name that is used for Tekla license
server is tekla (all letters lowercase).
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Option/Setting Description
Add a licensing service to be listed in the status
list on the Server Status tab, enter the vendor
information in the Vendor Name and Path boxes
and click Add Vendor Path.

If you want the status list to only display
information on certain license servers, enter the
vendor information in the Vendor Name and
Path boxes and then click Override Path to
replace the existing license servers displayed in
the status list.

The List All Vendor Paths button lists all the
licensing services that are displayed in more
detail in the status list on the Server Status tab.

Start/Stop/Reread tab

On the Start/Stop/Reread tab, you can stop and start the license server, and
adjust some setting related to stopping the server.

NOTE When you perform actions concerning the Tekla license server, Tekla
Licensing Service must be active in the FlexNet license services
installed on this computer list. You can select Tekla Licensing Service
from the services list on the Service/License File tab.

Option/Setting Description
FlexNet license services
installed on this
computer

Lists all FlexNet license services available on the
license server computer.

Always ensure that Tekla Licensing Service is
active in the FlexNet license services installed
on this computer list when you perform actions
concerning the Tekla license server.

• Activate Tekla Licensing Service by selecting it
from the services list on the Service/License
File tab.

Start Server Starts the license server that is active in the
FlexNet license services installed on this
computer list.

Stop Server Stops the license server that is active in the
FlexNet license services installed on this
computer list. When you click the button, the
status bar displays the message Stopping the
Server, and it takes a couple of seconds to stop
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Option/Setting Description
the license server. The message does not change
when the server is stopped.

If Stop Server does not stop the server, select
the Force Server Shutdown check box and click
Stop Server again.

ReRead License File Updates the license server without stopping and
starting it. You need to use this button, when you
manually notify the license server about license
changes.

For more information, see .
Advanced settings
Restrict lmdown to work
only from node where
lmgrd is running.

When this option is selected, you can stop the
server only on the server computer. No-one can
accidentally stop the license server on a client
computer.

We recommend that you use this option.
Disable lmdown utility,
use task manager.

When this option is selected, you cannot stop the
server in LMTOOLS. The server can only be
stopped in Windows Task Manager.

Disable ’lmremove’ of
license file.

Not in use in Tekla licensing.

Server Status tab

The Server Status tab displays the status of the license server and the
licenses. Here you can check how many licenses are in use or borrowed, who
is currently using licenses on the server and on which computers licenses have
been borrowed.

If you want to check the status of the Tekla license server and licenses only,
enter tekla in the Individual Daemon box and click Perform Status
Enquiry.

Below is an example of license server information:

1. The license server port@hostname
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2. The license server is up and running

3. License server with Tekla identity is up and running

4. A default value for TeklaServer displayed in every status check

Below is an example of license information:

1. Indications the configuration for which license information is displayed. In
this case, Full Detailing.

2. The number of activated licenses on the license server

3. The number of the licenses in use; checked out from the license server or
borrowed

4. A borrowed license

5. On which computer the license was borrowed

6. Tekla license version

7. Time when the license was borrowed

8. Licenses checked out from the license server

9. On which computer and display the user has checked the license out. In
this case, the user is user4, the computer and display names are
computer7.

10. The license server hostname/port from where the license is checked out

11. Time when the Tekla Structures session was started

12. Usage of licenses of other configurations. In this case, Precast Concrete
Detailing.

Server Diags tab

The Server Diags tab displays more information about the license servers and
licenses, and provides diagnostics. For more information about the licenses
and their status, see Tekla License Administration Tool options and settings
(page 627).

NOTE If you have problems with the license server, send a copy of the
tekla.lic, tekla.opt, and tekla_debug.log files to your local
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Tekla Structures support. The information on the Server Diags tab is
not detailed enough to solve some of the problems.

• To display the diagnostics, click Perform Diagnostics.

Below is an example of the LMTOOLS license server and license diagnostics:

1. The license server port@hostname

2. Common information for all Tekla license server installations

3. On which configuration the information is displayed. In this case it is
Viewer.

4. Tekla license version

5. The license server hostname

6. The expiration date of the license. In this case, the license is permanent.

Config services tab

The values on the Config Services tab are filled in automatically during the
installation of the Tekla license server. However, if you encounter problems
during the installation and the license server does not start automatically, you
need to configure the settings manually on the Config Services tab.

For more information about the data you should add/select on this tab, see .

NOTE Whenever you make modifications or perform any actions in
LMTOOLS concerning the Tekla license server, you need to have Tekla
Licensing Service selected in the Service Name list.
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Borrowing tab

WARNING Use Tekla License Borrow Tool for borrowing Tekla licenses. Do
not use the Borrowing tab of LMTOOLS with Tekla licenses.

3.3 Drawing settings reference
There are a lot of settings in Tekla Structures that you mainly control in the
properties dialog boxes. There are also some additional settings files that you
need to modify in a text editor.

Click the links below to find out more:

• General arrangement drawing properties (page 637)

• Single-part, assembly and cast unit drawing properties (page 641)

• Layout properties (page 643)

• View properties in drawings (page 645)

• Section view properties (page 650)

• Dimension and dimensioning properties (page 652)

• Mark properties (page 678)

• Mark elements (page 693)

• Pour object and pour break properties in drawings (page 723)

• Part and neighbor part properties in drawings (page 704)

• Bolt content and appearance properties in drawings (page 710)

• Surface treatment visibility and content properties in drawings (page 711)

• Surface treatment hatch pattern properties (surfacing.htc) (page 712)

• Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 714)

• Reinforcement settings for drawings (rebar_config.inp) (page 717)

• Placement properties for marks, dimensions, notes, texts and symbols
(page 726)

• Model weld properties in drawings (page 728)

• Drawing sketch object properties (page 729)

• Drawing grid properties (page 731)

• : Orientation settings
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General arrangement drawing properties
On the Drawings & reports tab, click Drawing properties --> GA drawing .
You can modify the properties after creating the drawing by double-clicking
the drawing background.

The options in the general arrangement drawing properties dialog box are
described below.

Option Description For more information
Name The name of the drawing. This

name is shown in Document
manager, and can be
included in drawing and
report templates.

The maximum length of the
drawing name is 32
characters.

 

Title 1, Title
2, Title 3

Titles are shown in the
Document manager and in
drawing and report
templates.

Use detailed
object level
settings

Set to Yes to use the detailed
object level settings created in
the Object level settings for
drawing dialog box.

Layout... Select the drawing layout and
define drawing sizes. You can
also select whether you want
to list hidden objects in
templates.

View... Define view properties: scale,
neighbor part view extension,
reflected view, opening and
recess symbol, datum point
elevation, part shortening,
view label, and anchor bolt
plan settings.

View properties in drawings
(page 645)

Detail view... Define detail view properties:
view label, detail boundary
and detail mark settings.

Dimension... Define dimension properties:
dimension type, units,
precision, format, placing, and
appearance.

Dimension and dimensioning
properties (page 652)
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Option Description For more information
Dimensionin
g...

Define dimensioning
properties: grid dimension
and part dimension settings.

Dimension and dimensioning
properties (page 652)

Dimensioning properties -
Parts tab (GA drawings)
(page 676)

Dimensioning properties -
Grid tab (GA drawings)
(page 675)

Part mark...

Bolt mark...

Neighbor
part mark...

Surface
treatment
mark...

Weld mark...

Reinforceme
nt marks...

Neighbor
reinforceme
nt marks...

Connection
mark...

Pour object
mark...

Define mark properties:
included elements and
element settings, and mark
visibility, mark frame, mark
leader line and placing
settings.

Mark properties (page 678)

Part and neighbor part
properties in drawings
(page 704)

Drawing weld mark
properties (page 686)

Mark properties - Content,
General, Merging and
Appearance tabs (page 678)

Model weld mark visibility and
appearance properties in
drawings (page 689)

Mark elements (page 693)

Part... Define part properties: part
representation, hidden line,
center line and reference line
visibility, additional mark
visibility, part appearance,
and fill settings.

Part and neighbor part
properties in drawings
(page 704)

Bolt... Define bolt properties: bolt
representation, bolt symbol
content, bolt visibility, and
bolt appearance settings.

Bolt content and appearance
properties in drawings
(page 710)

Neighbor
part...

Define neighbor part
properties: visibility, part
representation, hidden line,
center line and reference line
visibility, additional mark
visibility, and part appearance
settings. You can also define

Part and neighbor part
properties in drawings
(page 704)
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Option Description For more information
bolt representation and bolt
symbol content settings for
neighbor parts.

Surface
treatment...

Define surface treatment
properties: surface treatment
visibility, pattern visibility,
hidden lines visibility and
surface treatment
representation settings.

Surface treatment visibility
and content properties in
drawings (page 711)

Weld... Define welding properties:
weld visibility, weld size limit
and weld appearance
settings.

Model weld properties in
drawings (page 728)

Reinforceme
nt...

Define reinforcement and
mesh properties: bar and
mesh representation and
visibility, bar and mesh
symbol, and bar and mesh
appearance settings.

Reinforcement/Neighbor
reinforcement and mesh
properties in drawings
(page 714)

Neighbor
reinforceme
nt...

Define neighbor
reinforcement and mesh
properties: bar and mesh
representation and visibility,
bar and mesh symbol, and
bar and mesh appearance
settings.

Reinforcement/Neighbor
reinforcement and mesh
properties in drawings
(page 714)

Reference
objects...

Define reference object
visibility and appearance
settings.

Grid... Define grid visibility and
appearance settings.

Drawing grid properties
(page 731)

Protection... Define protected areas to
prevent text, marks or
dimensions from being
placed there.

Filter... and
Neighbor
part filter...

Create and modify part filters/
neighbor part filters on
drawing level.

User-defined
attributes...

Add customized information
to a drawing, such as
information related to
workflow, and comments.
This information can be
displayed in Document
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Option Description For more information
manager, and you can use it
in report and drawing
templates and marks, and as
switches when customizing
print file names.

The user-defined attributes
and tabs shown in this dialog
box are defined in the
objects.inp file.

The availability of the various
user-defined attributes
depends on your
environment, role and
configuration.

Single-part, assembly and cast unit drawing properties
On the Drawings & reports tab, click Drawing properties and select the
drawing type. You can modify the properties after creating the drawing by
double-clicking the drawing background.

The options in single-part, assembly and cast unit drawing properties dialog
box are described below.

Option Description For more information
Name Define the name of the

drawing that is shown in the
Document manager, and
that can be included in
drawing and report
templates.

The maximum length of the
drawing name is 32
characters.

 

Cast unit
definition
method

By cast unit position: A
drawing will be created from
each cast unit. If there are
identical cast units, one of
them will serve as the base
cast unit for the drawing. This
is the most common method
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Option Description For more information
for creating cast unit
drawings.

By cast unit ID: Each part in
the model has a unique GUID.
You can create drawings by
using the cast unit GUIDs. The
GUID determines the marking
of the drawing. You can
create several drawings from
identical cast units.

Title 1, Title
2, Title 3

Define titles that are shown in
Document manager and that
can be included in drawing
and report templates.

Sheet
number

Used for creating several
drawings of the same part as
multiple drawing sheets. The
number of sheets is not
limited.

Layout Select the drawing layout, and
define drawing sizes,
autoscale, projection type,
view alignment and part
expansion settings. You can
also select whether you want
to list hidden objects in
templates.

View
creation

Define the drawing views to
be created. From here you
can move on to modifying the
view properties for each view.

View properties in drawings
(page 645)

Section view Define section view
properties.

Section view properties
(page 650)

Detail view Define the start number or
letter of the detail view and
detail symbol label.

User-defined
attributes

Add customized information
to a drawing, such as
information related to
workflow, and comments.
This information can be
displayed in the Document
manager, and you can use it
in report and drawing
templates and marks, and as
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Option Description For more information
switches when customizing
print file names.

The user-defined attributes
and tabs shown in this dialog
box are defined in the
objects.inp file.

The availability of the various
user-defined attributes
depends on your
environment, role and
configuration.

Layout properties
On the Drawings & reports tab, click Drawing properties and select the
drawing type. Then click Layout. You can modify the properties after creating
the drawing by double-clicking the drawing background.

All options in all layout property panels and dialog boxes are described below.
All the described options are not available for all drawing types.

Option Description
Drawing size tab
Layout Define the layout that you want to use.
Edit Open the Layout editor to customize drawing

layouts.
List hidden objects in
templates

Select Yes to list hidden objects in templates. No
removes all information about the hidden parts,
also from the total weight.

Size definition mode Select Autosize if you want to let Tekla Structures
find appropriate sizes and table sets for drawings.
Select Specified size to specify the exact size for
the drawing. The drawing size should always be
smaller than the actual paper size to accommodate
printer margins.

Drawing size If you selected Specified size, define the drawing
size here.

Scale tab
Autoscale Set Autoscale to Yes to let Tekla Structures

automatically select the suitable scale for the
drawing view.
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Option Description
Main view scales

Section view scales

When you use autoscaling, enter the denominators
of main view and section view scales and separate
them with spaces.

For example, enter "5 10 15 20" for the scales 1/5,
1/10, 1/15, and 1/20

Scale change mode When you use autoscaling, set the scale change
mode which defines the relationship between the
scales of main and section views within a drawing:

main = section: The scales of the main and section
view are equal.

main < section: Main view scales are smaller than
section view scales.

main <= section: Main view scales are smaller
than or equal to section view scales

Preferred size Enter the preferred size of the drawing, if you use
both autosizing and autoscaling. Tekla Structures
tries to find a drawing size where the drawing
contents fit by first trying to use the exact scale
and the smallest drawing size. If the contents do
not fit, Tekla Structures increases the drawing size
until it reaches the preferred size.

Other tab
Projection type Define how Tekla Structures places the projections

of a part in cast unit, single-part, and assembly
drawings. Projection type affects the order of the
views in the drawing. The options are:

First angle, also referred to as the European
projection.

Third angle, also referred to as the American
projection.

Align section views
with main view

Align end views with
main view

Set to Yes to place the views next to the main view.

If you select No, Tekla Structures places the section
and end views in any available location.

Expand shortened
parts to fit

Set to Yes to stretch shortened views to fill up
empty areas of the drawing.

Include single-parts Set to Yes to include in assembly drawings the
single-part drawings of the individual parts that
make the assembly. Setting this to Yes, activates
the Single-part attributes option.
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Option Description
Single-part attributes Define the desired single-part drawing properties

to be used in the single-part view. To do this, set
Include single-parts to Yes.

View properties in drawings
Use the View Properties dialog box to view and modify the drawing view
properties.

The table below describes all view level properties for all drawing types.

Option Description
Views tab when View creation is selected from the options tree in drawing
properties:
View type on/off Defines the main views, section views

and 3D views that you want to create.

• If you select Off, Tekla Structures
does not create the view, but
dimensions the parts in the
available views. If you set all four
main views off, Tekla Structures
will still create a front view.

• If you select On, Tekla Structures
always creates the view, even if it
was not necessary in order to
show the dimensions. For section
views, Tekla Structures creates
one additional section view
showing the middle of the main
part. For end views, Tekla
Structures creates end view from
one end of the main part.

• If you select Auto, Tekla Structures
creates the view if it is necessary
in order to show the dimensions.
For section views, Tekla Structures
creates the necessary number of
views to show all the dimensions.
For end views, Tekla Structures
also creates another end view
from the other end of the main
part, if there are dimensions at
that end.
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Option Description
View label Shows the view label set in view

properties. If the label is defined in
view properties, you can change it
here. You can always change the label
of the main views.

View properties Shows the current view properties for
the selected view. You can select
another view properties file from the
list and modify the view properties by
clicking View properties.

Attributes tab when View creation is selected from the options tree in
drawing properties:
Coordinate system Sets the coordinate system of the

drawing views. The options are: local,
model, oriented, horizontal brace,
vertical brace, and fixed.

For more information, see .
Rotate coordinate systemAround
X,Around Y and Around Z

Rotates the view around the x, y, or z
axis of the parts using the entered
values.

For more information, see .
Unfolded Yes shows and dimensions the bend

lines in the drawing.

For more information, see .
Undeformed Yes undeforms deformed parts and

shows the developed (undeformed)
shape of the deformed parts in
drawings.

For more information, see .
Recreate the drawing Yes recreates the drawing.
Attributes 1 and Attributes 2 tabs in view properties (Attributes and
Shortening tabs in general arrangement drawings) :
Scale Sets the view scale.
Reflected view Displays load bearing structures, such

as columns and beams on a lower
floor.

Yes displays structures with a
continuous line, and No displays
them with a dashed line.

Rotation around \n (in 3D views) Modify the view angle of 3D views.
Enter the values for the angles in y
and x directions. Rotation in a
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Option Description
drawing view is around the local axis.
Value 0.0 for both equals the front
view.

Size Fit by parts Tekla Structures fits the
view contents in the drawing view
frame without leaving any
unnecessary space.

Define as distances The x and y
boxes define the view size along the x
and y axes of the view. The depth
boxes define the depth of the view
relative to, and perpendicular to the
view plane.

View extension for neighbor parts Sets the distance from the drawing
view to display neighboring parts.

For more information, see .
Place Set the placing for the drawing view

to be fixed or free:

• Fixed: Maintain the views in the
same location during updates.

• Free: Let Tekla Structures find a
suitable place for the view during
updates.

For more information, see .
Undeformed Yes undeforms deformed parts and

shows the developed (undeformed)
shape of the deformed parts in
drawing views.

For more information, see .
Shortening If parts are very long and do not

include any details, you can shorten
them:

• Cut parts: Yes activates
shortening. You can also select to
cut Only in x direction or Only in
y direction.

• Minimum cut part length defines
the minimum length of the
shortened part to show.

• Space between cut parts defines
the distance between cut parts.
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Option Description
• Cut skew parts: Yes cuts skew

parts.

For more information, see .
Show openings/recess symbol Yes shows symbols in openings and

recesses.

For more information, see .
Location by Select model origin, project base

point or any base point defined
coordinate system. Location by uses
the project base point as the default
value.

• Base point data can be used to set
the coordinate system for the
view. The base point can be used
instead of datum offset.

• When the base point is set, level
attributes and template attributes
in marks provide values in the
specific base-point-defined
coordinate system.

• If you change the project base
point Z or the elevation value, the
level value will change accordingly
when a drawing is opened.

• This setting affects level marks
and attributes that end with 
_BASEPOINT.

Datum point for elevations Specified uses the entered value.

View plane measures reference
points relative to the view plane.

For more information, see .
Show pours in drawing Yes shows pours in drawings. For

more information, see .
Dimension creation method in this
view

Clones the dimensions separately for
the selected view only. Using this
option affects the creation of the
dimensions during cloning and re-
dimensioning of existing drawings.

For more information, see .
Labels tab:
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Option Description
Text Defines the view label text. Enter text

in fields A1-A5, or click the ... buttons
and select the label mark contents
and appearance.

For more information about view
labels, see

Symbol Defines a symbol to be used in the
view label, and the color, size, and line
length of the symbol.

Label position Defines the vertical and horizontal
position of the view label:

• For Vertical, select Above or
Below.

• : Select one of the following for
Horizontal:

Left aligned to view frame

Center aligned to view frame

Right aligned to view frame

Left aligned to view restriction
box

Center aligned to view
restriction box

Right aligned to view restriction
box

View direction marks Shows or hides the view direction
marks and defines the mark height.

Other options in the view properties options tree:
Dimensioning Define view-level dimensions settings

for each view separately.

For more information on
dimensioning settings, see , and .

Filter Define drawing view filters.

For more information, see .
Neighbor part filter Define drawing view filters for

neighbor parts.

For more information, see .
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Option Description
Protection Define protected areas to prevent

text, marks or dimensions from being
placed there.

For more information, see .
Marks Define view-level mark properties.

For more information, see Mark
properties - Content, General,
Merging and Appearance tabs
(page 678).

Objects Define view-level properties for the
following objects:

Parts and neighbor parts (page 704)

Bolts (page 710)

Surface treatment (page 711)

Welds (page 728)

Reinforcement and neighbor
reinforcement (page 714)

Reference objects

Grid (page 731)

Pour objects and pour breaks
Anchor bolt plan (general arrangement drawings only)
Show as anchor bolt plan Yes shows the general arrangement

drawing as an anchor bolt plan.

For more information, see
Enlarged part view scale Defines the scale used in the enlarged

part views.
Create detail views Yes creates separate detail views.

If you select No, Tekla Structures
dimensions the anchor bolts in the
enlarged view. Tekla Structures
groups similar detail views so that
similar details are drawn only once.

Detail view scale Defines the scale used in the anchor
bolt plan detail views.
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Section view properties
When you create automatic section views, Tekla Structures creates section
views and section marks using the current view and mark properties. You can
modify the section view properties in an open drawing.

Option Description
Attributes tab
Fit by parts The Fit by parts setting works as an

alternative to Section depth and
Distance for combining cuts, and it
shows the whole part in the sections.

Section depth Defines the positive and negative
distances of the section view when
views are not combined.

Distance for combining cuts Defines the distance range for
combining cut views.

Direction Define the view direction of the
section. The options are:

• Right section

• Middle section

• Left sectionLeft section

The available values are left or right.
Cutting line tab
Line Length and offset of the cutting line.
Properties Color of the cutting line.
Section mark tab
Text Defines the text on the section mark.

Click the ... buttons next to the text
boxes to open the Mark Contents
dialog box.

Symbol: Color Color of the section mark symbol.
Left symbol, Right symbol Left and right section mark symbol.
Size Size of the section mark left and right

symbol.
x/y Offset of the section mark left and

right symbol.
Start number or letter of section
view and symbol label

Defines the letter or number used in
the section view label or in the section
symbol label.

You can enter any number starting
from 1 or any letter A - Z or a - z (also
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Option Description
shown in uppercase in the label). If
you use letter, and the entered string
is longer than one letter, only the first
letter is shown in the view label and
section symbol label. If you use
numbers, all entered numbers are
shown. The start number changes
only if you change it in the drawing
properties before creating a drawing,
and if you change the option in an
existing drawing and recreate the
drawing, in which case section view
and symbol labels for all
automatically included section views
and all new section views will change.

See also

View properties in drawings (page 645)

Dimension and dimensioning properties
Dimension properties define what the dimensions look like and which formats,
units etc. are used. Dimensioning properties define what is being dimensioned
and how.

Click the following links to find out more about dimension properties:

• Dimension properties - General tab (page 653)

• Dimension properties - Units, precision and format (page 656)

• Dimension properties - Appearance tab (page 658)

• Dimension properties - Marks and Tags tabs (page 659)

Click the following links to find out more about dimensioning properties
in view-level dimensioning:

•

• Dimensioning properties - General tab (Integrated dimensioning)
(page 662)

• Dimensioning properties - Part dimensions tab (Integrated dimensioning)
(page 669)

• Dimensioning properties - Position dimensions tab (Integrated
dimensioning) (page 666)
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• Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 671)

• Dimensioning properties - Dimension grouping tab (Integrated
dimensioning) (page 673)

• Dimensioning properties - Sub-assemblies tab (Integrated dimensioning)
(page 674)

• Dimensioning properties - Reinforcement dimensions tab (Integrated
dimensioning) (page 675)

Click the following links to find out more about dimensioning properties
in GA drawings:

• Dimensioning properties - Grid tab (GA drawings) (page 675)

• Dimensioning properties - Parts tab (GA drawings) (page 676)

Dimension properties - General tab
Use the General tab in the Dimension Properties dialog box to view and
modify the format, type, unit, precision, extension line, grouping and placing
settings of the dimensions.

The drawing level View Properties dialog box and object level Dimension
Properties dialog box contents differ. All options in both dialog boxes are
described below.

• To open the drawing level Dimension Properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Dimension .

• To open the object level Dimension Properties, double-click a dimension
in an open drawing.

• To open Dimension Properties dialog box for general arrangement
drawings before creating a drawing: On the Drawings & reports tab, click
Drawing properties --> GA drawing , and then click Dimension...

Option Description
Dimension types
Straight Sets the dimension type for straight

dimensions.
Relative: Point to point dimensions.

Absolute: Dimensions from a
common start point.
Relative and absolute: Combination
of point to point and common start
point.
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Option Description
US absolute: Dimensions from a
common start point, which include a
running dimension mark (RD).
US absolute 2: Similar to US
absolute, but it changes short
dimensions to relative.
Absolute plus short relatives:
Similar to Absolute, but it changes
short dimensions to relative. Also
called internal absolute. This option
may show both dimensions, but it
does not show relative dimensions
when dimensions are long. This
option shows the absolute
dimensions inside the dimension
lines.
Absolute plus all relatives above
the absolutes: Similar to Relative
and absolute, but it places the
relative dimensions above the
absolute.
Elevation: Creates an elevation
dimension at a picked point. This type
is only available in the dimension
properties of manual dimensions in
drawing mode.

In x direction As above, but overrides the straight
setting for horizontal dimensions. If
you use the blank option, Tekla
Structures uses the Straight option
settings. The x direction usually
means dimensions parallel to the
drawing x axis.

Angle Defines the appearance of angle
dimensions.
Shows the angle dimensions in
degrees on side.
Shows the angle dimensions in
degrees at angle vertex.
Shows the angle dimensions using a
triangle.

You can also set the Triangle base
length to control the base dimension
shown for bevel dimensions.
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Option Description
Shows the angle dimensions using a
triangle with degrees.

Triangle base length The base length of a triangle.
Curved Defines whether to use angle units or

distance units for curved dimensions.
Short extension line Defines whether Tekla Structures

should create extension lines all of
the same length or use the short
extension line automatically if the
dimension line falls on a grid line.

If you want to exaggerate dimensions,
you need to set this option to No.

Dimension format
Units Defines the units (page 656) used in

dimensioning.
Precision Defines dimension precision

(page 656): rounding, imperial units.
Format Defines the dimension format

(page 656): the number of decimals
and their appearance.

Use grouping Defines whether long dimension
values are grouped.

Combine equal dimensions Combines equal dimensions. The
choices are Off, 3*60 or 3*60=180.

The accuracy of combining equal
dimensions is 0.1.

Minimum number to combine Defines the minimum number of
dimensions to combine.

Dimension grouping
Update grouping when model
changes

Yes updates dimension grouping
automatically when the model
changes.

Placing
Dimension lines spacing Defines the space between parallel

dimension lines.

In manually created dimensions, this
setting works only if dimension
Placing is set to free, see below.

Short dimensions Defines the text location of short
dimensions: between or outside the
dimension lines.
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Option Description
Place... Opens the Dimension Placing dialog

box.

Placing is the method used for
placing dimensions. The choices are:

• free lets Tekla Structures to
decide the location and direction
of the dimension based on the
Direction settings.

• fixed allows you to place the
dimension at any point.

Search margin is the empty margin
that you want to have around the
dimension.

Minimum distance is the closest
distance Tekla Structures uses to
search for an empty space for a
dimension.

Direction defines the side of the
dimensioned object on which Tekla
Structures places the dimensions.

See also

Dimension properties - Units, precision and format (page 656)

XS_DIMENSION_DECIMAL_SEPARATOR (page 147)

XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR (page 75)

Dimension properties - Units, precision and format
Use the General tab of the Dimension properties dialog box to view and
modify options related to dimension format, unit and precision.

The integer values are provided for situations when you need to use the value
as a value for an advanced option.

Option Integer value Notes
Format  
### 0  
###[.#] 1  
###.# 2  
###[.##] 3  
###.## 4  
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Option Integer value Notes
###[.###] 5  
###.### 6  
### #/# 7  

## # /##.## # 8 This option is available
only for straight
dimensions.

Precision  
0.00 1 For defining precision

with rounding. For
example, with precision
0.33 the actual
dimension 50.40 is
shown as 50.33.

0.50 2
0.33 3
0.25 4

1/8 5 For imperial units
1/16 6
1/32 7
1/10 8 For defining precision

without rounding1/100 9
1/1000 10
Units
automatic Uses the units defined in

the model
mm millimeters
cm centimeters
m meters
foot - inch feet and inches

Inches are converted
into integer feet, and the
remaining inches are
shown in inches.

cm / m centimeters and meters

Dimensions under 100
cm are shown in
centimeters, and
dimensions above 100
cm are shown in meters.
Millimeters are shown as
superscript.

inch inches
feet feet
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See also

Dimension properties - General tab (page 653)

Dimension properties - Appearance tab
Use the Appearance tab in the Dimension Properties dialog box to view and
modify the settings affecting the dimension appearance.

• To open the drawing level Dimension Properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Dimension.

• To open the object level Dimension Properties dialog box, double-click a
dimension in an open drawing.

• To open Dimension Properties dialog box for general arrangement
drawings before creating a drawing: On the Drawings & reports tab, click
Drawing properties --> GA drawing, and then click Dimension.

Option Description
Text
Color The color of the dimension mark text.

This controls the line weight in
printed drawings.

Height Controls the height of the text used in
the dimension marks in the drawing.

Font Controls which font is used in the
dimension mark.

Frame Defines a frame for the dimension
mark.

Place Defines how the dimension mark is
placed relative to the dimension line.

Line, Arrow
Color Controls the color of the dimension

line. The color controls the line weight
in printed drawings.

Background mask Select Opaque to hide the area of the
drawing that is covered by the
dimension mark.

Select Transparent to show the
drawing content in the dimension
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Option Description
mark background so that drawing
linework is visible.

Arrow shape Controls the type of mark used with
the dimension line.

You can also create arrow types of
your own, see .
Sets the height and the length of the
arrowhead.

US Absolute dimensions Controls the type of mark used with
the dimension line in US Absolute
dimensions.

Level dimensions Controls the type of mark used with
the dimension line in level
dimensions.

See also

Dimension properties - General tab (page 653)

Dimension properties - Marks and Tags tabs
Use the Marks and Tags tabs in the Dimension Properties dialog box to view
and modify the contents of dimension marks and tags in an open drawing.

• To open the drawing level Dimension Properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Dimension .

• To open the object level Dimension Properties, double-click a dimension
in an open drawing.

• To open General - Dimension Properties dialog box for general
arrangement drawings before creating a drawing: On the Drawings &
reports tab, click Drawing properties --> GA drawing , and then click
Dimensioning...

Option Description
Marks tab
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Option Description
Prefix Displays the defined value before the

numeric value of the dimension.
Enter text or click ... to select
elements.

The prefix value cannot be plain
numbers, and cannot end with a
number.

Visibility of numeric value Defines whether the numeric value of
the dimension is visible or hidden.

If you hide the numeric value of the
dimension, the prefix and postfix text
will still be shown.

Postfix Displays the defined value after the
numeric value of the dimension.
Enter text or click ... to select
elements.

The postfix cannot be plain numbers,
and the it cannot start with a number
when the numeric value of the
dimension is visible.

... buttons Define dimension mark contents by
adding elements. You can also modify
the mark appearance.

Frame around elements: Type and
Color define the element frame type
and color individually for each
element.

< Add frame allows you to add
frames around elements. Font: Color,
Height and Font define the font type,
color, and height used in element
texts individually for each element.
Clicking Select... gives more font
choices.

Units: Units and Format allow you to
set the unit and format for length
elements. Unit settings can be
modified only when a length element
is selected.

You can also use template attributes
in the User-defined attribute
element. In marks, you cannot use
template attributes such as 
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Option Description
MODEL_TOTAL that refer to the whole
model. Marks only check the
information from the object in the
drawing and not from the whole
model.

Plate side marks Specified creates plate side marks to
plate dimension using the specified
color, size and offset. Offset means
the distance of the mark from the
dimension line.

The option Automatic is available
only in intelligent drawings, that is
when the advanced option 
XS_INTELLIGENT_DRAWING_ALLOWE
D is set to TRUE.

Exaggeration Specified exaggerates narrow
dimensions.

Select the Direction: Left / Down,
Right / Up or Both.

Set the Origin, Width, Position and
Height.

Tags tab
Tags area Add tags to dimensions: You can

enter text in the tag box or add
elements by clicking the ...

When you click the ... button next to a
tag box, a dialog box for the particular
tag is displayed and you can define
dimension tag contents by adding
elements. You can also modify the tag
element appearance.

• Rotation --> Perpendicular to
dimension line rotates the tag.

• Rotation --> Parallel to
dimension line does not rotate
the tag. This is the default value.

• Frame around elements: Type
and Color define the element
frame type and color individually
for each element.

• < Add frame allows you to add
frames around elements. Font:
Color, Height and Font define the
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Option Description
font type, color, and height used in
element texts individually for each
element. Clicking Select... gives
more font choices.

• Units: Units and Format allow
you to set the unit and format for
length elements. Unit settings can
be modified only when a length
element is selected.

• You can also use template
attributes in the User-defined
attribute element.

In tags, you cannot use template
attributes such as MODEL_TOTAL
that refer to the whole model.
Tags only check the information
from the object in the drawing,
and not from the whole model.

Include part count in the tag Select the tag positions for which you
want to include the part count in the
tag.

Exclude parts according to filter Select a drawing view filter that
removes desired content from the
tag.

Curved Dimension Tag Type Select a tag type for a curved
reinforcing bar dimension line. The
tag type controls how the tags are
aligned to the dimension.
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Dimensioning properties - General tab (Integrated dimensioning)

Use the General tab in the Dimension Properties dialog box to view and
modify the general settings of the dimensions. This dialog box is displayed if
you use Integrated dimensions dimensioning type in dimensioning.

Option Description
Dimensioning type Standard is used for almost all

dimensioning.

Truss meets the specific
requirements needed to dimension
truss drawings. It dimensions the
position and length of the diagonals.
The dimensioning is done only if the
diagonals are secondary parts that
are welded to upper and lower
chords, which are main parts and not
welded to any parts. If the truss
welding is done some other way,
standard dimensioning is used.

Minimize Yes minimizes the number of views
that Tekla Structures creates.

Also check the settings in the drawing
View Properties dialog box.

Combine dimensions Combines several single dimensions
into one dimension line.

In Options, select the combination
level. The larger the number, the
more Tekla Structures combines
dimensions.

Option 4.5 uses a combination of
option 5 for main part and option 4
for secondary parts.

The Distance means the distance
within which Tekla Structures
combines internal dimensions.

If the distance between two details is
less than the defined Min distance,
Tekla Structures combines the
dimensions.

Close dimensions Close dimensions completes
dimension lines to include the entire
part.

No does not close dimensions
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Option Description
In X only closes dimensions in the x
direction and leaves others open

All closes all dimensions

This setting is not relevant to profile
shape dimensions.

Close dimensions: Short
dimensions

Yes closes short dimensions.

With No, the open dimension is the
middle one rather than the short end
dimension.

When you leave short dimensions
open, Tekla Structures leaves out the
longer dimension line in dimension
lines that contain two dimensions. If
dimension lines contain three
dimensions, Tekla Structures leaves
out the middle one. This option does
not affect dimension lines with more
than three dimensions.

Placing: Forward offset Forward offset defines the distance
Tekla Structures uses to search for
the base point of a dimension. If Tekla
Structures does not find a base point
(corner) within the Forward offset
search distance, it uses an edge point.

The Centered bolt setting affects on
how the dimension is displayed.

Necessary internal dimensioning:
Recognizable distance

Recognizable distance defines the
limit for dimensioning asymmetry in
secondary parts. In some cases, it is
important to look at the asymmetrical
relationship of parts, so that an
asymmetric secondary part is
correctly connected to a main part.
You can use Recognizable distance
to have asymmetry reflected in
dimensioning. If the asymmetry is
smaller than the distance you enter
here, Tekla Structures represents it
using a dimension.
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Option Description
Part mark on dimension line None creates no part mark on the

dimension line.

On assembly overall dimension
creates a part mark on the assembly
overall dimension line.

Between extreme bolts creates a
part mark on the dimension line
between the outermost bolts.

Main dimension position Defines the side on which Tekla
Structures places the Assembly
overall dimensions, Main part work
points, and Knock off dimensions.

Auto treats the main dimensions in
the same way as other dimensions.

Above places the main dimensions
above the part (or to the left for
vertical parts).

Below places the main dimensions
below the part.

Above places the skew position
dimensions of the main part below
the part and Below places them
above.

Grid dimensions Creates grid dimensions. The values
are: None, Individual spans, Overall
or Individual spans and overall.

Grid dimension position Sets the grid dimension position. The
values are:

Main view - above

Main view - below

Top view - above

Top view - below

Bottom view - above

Bottom view - below

Back view - above

Back view - below

All views - above

All views - below.
Dimension properties
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Option Description
Straight dimensions Sets the dimension type for straight

dimensions using the settings in the
properties file you select.

In X direction Otherwise same settings as in straight
dimensions but overrides the straight
setting for horizontal dimensions. If
you use the blank option, Tekla
Structures uses the Straight
dimensions option settings. The x
direction usually means dimensions
parallel to the drawing x axis.

Arrow shape: US Absolute
dimensions

Controls the type of mark used with
the dimension line in US Absolute
dimensions.

US Absolute dimensions are
dimension types US Absolute and US
Absolute 2 that can be defined in
Dimension properties (page 653). If
the advanced option XS_USE_
USABSOLUTE_ARROW_TYPE_FOR_
ABSOLUTE_DIMENSIONS (page 465) is
set to TRUE, the arrow shape is
overridden for other types of
absolute dimensions as well.

Arrow shape: Level dimensions Controls the type of mark used with
the dimension line in level
dimensions.

Angle and radius dimensions Sets the dimension type for angle
dimensions using the settings in the
properties file you select.

Check dimensions Sets the dimension type for check
dimensions using the settings in the
properties file you select.

See also

XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY (page 152)

XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE (page 153)

XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION (page 154)
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Dimensioning properties - Position dimensions tab (Integrated
dimensioning)
Use the Position dimensions tab in the Dimensioning Properties dialog box
to view and modify the settings for the position dimensions in single-part,
assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type
in dimensioning.

Option Description
Position bolts to

Position parts to

Controls from where Tekla Structures
creates the part/bolt position
dimensions.

None creates no position dimensions.

Main part creates the dimensions
from the main part reference line.

Working points creates the
dimensions between the work points,
such as the intersections of main and
neighbor part reference lines.

Embedded objects Creates position dimensions for
locating embedded objects in cast
unit drawings. The embedded objects
are custom components attached to
the cast unit.

As secondary objects dimensions
embedded objects in cast unit
drawings the same way as secondary
parts.

By reference point dimensions
embedded objects to their reference
point, which is the origin of the
custom component.

Secondary part Creates dimensions to bolt holes or
edges of the secondary part.

None creates no position dimensions
for secondary parts.

By bolt dimensions bolt hole
locations in the secondary parts.
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Option Description
By part dimensions edges of
secondary parts.

By both dimensions bolt hole
locations and edges of the secondary
part.

Secondary part dimension
direction

Aligns dimensions with the main or
neighboring part. Only for skewed clip
angles or shear plates.

Position from Sets the start point for running
dimensions. Only for skewed clip
angles or shear plates bolted to a
neighboring part.

Reversed direction for running
dimensions

Yes changes the direction of running
dimensions. With this option, you can
set the zero point to the end of a
member rather than to the start.

Main part bolt position On creates dimensions to the bolt
hole locations in the main part.

Main part skew position Yes creates horizontal and vertical
check dimensions representing the
skew position of a brace. Created
between the work points of the main
part.

Skew check dimensions are located in
the front view. Their location depends
on the Main dimension position
setting selected on the General tab.
When the main dimensions are above
the part, the skew dimensions are
below, and vice versa.

Skew position Defines how Tekla Structures
dimensions skewed secondary part
positions.

None creates no dimensions for
skewed secondary part positions.

angle creates an angle dimension for
the secondary part.

Dimensions creates dimensions for
the skewed position of the secondary
part.

Both creates both the angle and the
dimensions.
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Option Description
Centered part Controls the dimensions of centrally-

placed parts. These settings have an
effect only if position dimensions are
created.

Internal dimensions the centered
parts overall size.

Position dimensions the part to the
main part center lines.

None creates no centered part
dimensions.

Centered bolt Controls the dimensions of centrally-
placed bolt groups.

Internal dimensions the centered
bolts spread.

Position dimensions the bolts to the
main part center-lines.

Centered bolt overrides the
Secondary part bolt internal option
for centered bolts. This only applies
to bolts located centrally on the part.

Elevation dimensions On creates elevation dimensions.
Combine equal dimensions Combines equal dimensions. The

choices are Off, 3*60 or 3*60=180.

The accuracy of combining equal
dimensions is 0.1.

Minimum number to combine Defines the minimum number of
dimensions to combine.

See also

XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR (page 327)

XS_WORKING_POINTS_VALID_ALSO_OUTSIDE_PART (page 480)

Dimensioning properties - Part dimensions tab (Integrated
dimensioning)
Use the options on the Part dimensions tab of the Dimensioning Properties
dialog box to view and modify part dimensioning settings for single-part,
assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type.
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Option Description
Internal Creates internal dimensions for

secondary parts connected to the
main part.

None creates dimensions for
secondary parts.

Necessary creates only the
dimensions that are necessary for
assembling the parts.

All creates all dimensions for the
secondary parts.

Main part overall dimensions Once creates one overall dimension
for the main part.

All creates overall dimensions for
main parts in all views.

None creates no overall dimensions
for the main part.

The Assembly part overall
dimensions settings have some
effect on these options.

Assembly part overall dimensions Length only creates overall
dimensions for an entire assembly or
cast unit in the x direction only.

All dimensions creates overall
dimensions for an assembly or cast
unit in all directions.

Off creates no overall dimensions for
an assembly or a cast unit.

Main part work points On creates a check dimension
between the outermost work points.

Main part shape (Shape
dimensions)

On creates dimensions to show the
shape of a main part.

By default, Tekla Structures
automatically draws shape
dimensions on both ends of a beam,
even if the ends are symmetrical.
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Option Description
Main part radius dimensions
(Radius dimensions)

On creates radius dimensions for
curved chamfers and round holes in
the main part.

This option is available only if you
have set Main part shape
dimensions to On.

Note that this option does not create
radius dimensions for curved beams
or polybeams with chamfers.

Bevel dimensions On creates linear dimensions of a
bevel.

Bevel angle Creates an angle dimension and
defines which side of the bevel to
dimension. The choices are None,
Angle of cut and Angle of beam.

Knock off dimensions On creates check dimensions from
the edge of the main part to the work
point.

Preferred dim side Sets the preferred view (front or side)
for part dimensions.

From the nearest floor level to part On creates dimensions indicating the
distance from the closest floor level to
the bottom and/or top of the parts.

From grid to part centerline On creates dimensions showing the
offset of a part from the grid to the
part center line.

From grid to part ends On creates dimensions showing the
offset of a part from the grid to the
near or far end of the part.

See also

XS_SINGLE_PART_SHAPE (page 407)

XS_EQUAL_SHAPE_DIMENSIONS_TO_BOTH_ENDS_LIMIT (page 241)

XS_CREATE_ROUND_HOLE_DIMENSIONS (page 131)
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Dimensioning properties - Bolt dimensions tab (Integrated
dimensioning)
Use the options on the Bolt dimensions tab of the Dimensioning Properties
dialog box to select which bolt dimensions to create and how in single-part,
assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type.

Option Description
Main part bolt internal dimensions Creates internal dimensions for bolt

groups in the main part.

None creates none of the internal
bolt dimensions.

Internal creates bolt group internal
dimensions (distances between bolts).

All creates edge distance and bolt
group internal dimensions. Edge
distance is the dimension from the
outermost bolt to the part edge.

Main part bolt internal dimensions:
Skewed bolt group

Indicates whether the dimensions are
parallel to the part or the bolt group.

The choices are No dimensions, In
part direction, and In bolt group
direction.

Secondary part bolt internal
dimensions

Creates internal dimensions for bolt
groups in the secondary part.

The choices are None, Necessary,
Internal, and All.

Secondary part bolt internal
dimensions: Skewed bolt group

Aligns the bolt dimensions with the
secondary part or bolt group.

The choices are In part direction, No
dimensions, and In bolt group
direction

Distance between extreme bolts:
Extreme bolts

Creates check dimension between the
outermost bolts.

The choices are None, Main part,
and Assembly.

Distance between extreme bolts:
Extreme bolts to work points

Creates check dimensions from the
outermost bolts to the work points.

Yes creates the check dimensions.
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Option Description
Preferred dim side Sets the preferred view (front or side)

for bolt dimensions.

Combine bolt dimensions Sets the format of the combined bolt
group internal dimensions.

You can combine bolt group internal
dimensions and display them in the
format 3*60 or 3*60=180, or have
single dimensions.

Minimum number to combine Defines the minimum number of
dimensions to combine.

See also

XS_COMBINED_BOLT_DIM_CHARACTER (page 121)

Dimensioning properties - Dimension grouping tab (Integrated
dimensioning)
Use the Dimension grouping tab in Dimensioning Properties dialog box to
view and modify settings for dimension grouping in single-part, assembly and
cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type
in dimensioning.

Option Description
Activate dimension grouping Selects the objects for grouping.
Parts Groups according to parts.
Bolts Groups according to bolts.
Components Groups according to components.
Cuts/Shapes Groups according to cuts or shapes.
Automatic tagging Defines how to display information in

a dimension line.
Display tags Displays tags.
Include part count in the tag Includes part count in the tag.
Do not display marks\nfor the
grouped items

Does not display part marks for
grouped items.

Available elements Elements available to define identical
conditions.
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Option Description
Add > Adds items to Selected elements list.
Remove Removes items from Selected

elements list.
Move up Moves the element higher in the list.
Move down Moves the element lower in the list.
Update grouping\nwhen model
\nchanges

Yes updates dimension grouping
automatically when the model
changes.

Dimensioning properties - Sub-assemblies tab (Integrated
dimensioning)
Use the options on the Sub-assemblies tab of the Assembly - Dimensioning
Properties dialog box to view and modify which dimensions to create and
how for sub-assemblies.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type
in dimensioning.

Option Description
Dimension parts inside sub-
assemblies

Defines whether to dimension parts
inside sub-assemblies.

Yes creates internal dimensions for
parts inside sub-assemblies.

No does not create internal
dimensions for parts inside sub-
assemblies.

Measure sub-assembly position
from

Defines the position from which the
sub-assembly is measured.

None does not measure the sub-
assembly position.

Bolt measures the position of the
sub-assembly from the bolts. If bolts
are not included in the sub-assembly,
or if it is not possible to measure the
position from bolts, Tekla Structures
measures the sub-assembly position
from the reference point.
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Option Description
Extrema points measures the
position of the sub-assembly from the
bounding box of the sub-assembly.

Reference point measures the
position of the sub-assembly from the
reference point.

Dimensioning properties - Reinforcement dimensions tab (Integrated
dimensioning)
Use the Reinforcement dimensions tab in the Dimensioning Properties
dialog box to view and modify the setting affecting the creation of
reinforcement dimensions and how they are displayed.

This dialog box with this tab is displayed if you use Integrated dimensions
dimensioning type in dimensioning cast unit drawings.

Option Description
Dimensions for reinforcing bar
groups

On creates dimensions for reinforcing
bar groups. This also activates the
other selections on this tab.

Dimension mark settings Sets the mark type, which can be
dimension line, dimension mark,
tagged dimension mark, or variants of
these typical styles.

The Default environment contains
three predefined settings files: 
rebar_dimension_line, 
rebar_dimension_mark, and 
rebar_tagged_dimension_mark
Clicking the ... button opens the
dimension properties, and you can
view the settings file and also change
the settings, if needed.

Dimensioning properties - Grid tab (GA drawings)
Use the Grid tab in the General - Dimensioning Properties dialog box to view
and modify settings for grid and overall dimensions in general arrangement
drawings.
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To open this dialog box:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and click Dimensioning....

• In an open GA drawing, double-click the drawing background, and click
Dimensioning...

Option Description
Grid line dimensions On creates grid dimension lines.
Overall dimension On creates the overall dimensions.
Dimension positioning: Horizontal Positions the vertical grid and overall

dimension lines to the Left or Right
side of the drawing or on Both sides.

Dimension positioning: Vertical Positions the horizontal grid and
overall dimension lines Above or
Below the drawing or Both.

Dimensioning properties - Parts tab (GA drawings)
Use the Parts tab in the General - Dimensioning Properties dialog box to
view and modify settings for part dimensions in general arrangement
drawings.

To open this dialog box:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and click Dimensioning...

• In an open GA drawing, double-click the drawing background, and click
Dimensioning...

Option Description
Maximum leader line length:
Outside dimensions

Controls how close the dimension
lines are positioned to the parts they
are dimensioning. Defines that the
outside dimension lines take the
maximum leader line length from the
grid line.

Maximum leader line length: Inside
dimensions

Controls how close the dimension
lines are positioned to the parts they
are dimensioning. Defines that the
inside dimension lines take the
maximum leader line length from the
part reference point.
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Option Description
Include parts not entirely in view On dimensions the parts partly

outside the view. Off will not
dimension these parts.

Maximum number of outside
dimensions

Specifies the maximum number of
dimension lines allowed outside the
grid. When you dimension different
objects on different dimension lines,
using this setting helps you to create
cleaner drawings.

Once the desired maximum is
reached, Tekla Structures creates the
dimensions inside the grid.

Object group dimensioning rules Specifies different object groups to be
dimensioned on different dimension
lines.

Object group The object group to be dimensioned.
Positioning No dimensions does not create

dimensions for the parts.

Inside grid creates dimensions next
to or near the parts being
dimensioned. All part dimensions are
placed inside the grid when the parts
are inside the grid. The dimension will
still be outside, even if you have
selected Inside grid because of
where the parts are in the end bay
and the end being dimensioned to is
next to the outside.

Outside grid creates dimensions to
parts and positions them outside the
grid.

Either creates dimensions to parts
and positions them either inside or
outside the grid depending on the
part position and the setting of the
Maximum number of outside
dimensions option.

You must use the Either option if you
define the Maximum number of
outside dimensions, so that Tekla
Structures can position dimensions
inside the grid when the maximum
number of dimensions is reached
outside the grid.
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Option Description
Horizontal position Left side positions all dimensions to

horizontal parts to the left of the grid.

Right side positions all dimensions to
horizontal parts to the right of the
grid.

Distributed to both sides positions
all dimensions to horizontal parts to
the grid nearest the part they are
dimensioning.

Vertical position Above positions all dimensions to
vertical parts above the grid.

Below positions all dimensions to
vertical parts below the grid.

Distributed to both sides positions
all dimensions to vertical parts to the
grid nearest the part they are
dimensioning.

Mark properties
You can adjust the mark appearance and contents before creating a drawing
and also in an open drawing.

Click the links below to find out more:

• Mark appearance and merging properties (page 678)

• Leader line types (page 685)

• Positioning properties of view label, section and detail marks (page 686)

• Drawing weld mark properties (page 686)

• Model weld mark visibility and appearance properties in drawings
(page 689)

• Level mark properties (page 692)

• Mark elements (page 693)

Mark properties - Content, General, Merging and Appearance tabs
Use the General, Merging and Content tabs in the properties of different
types of marks to view and modify the settings affecting the mark content and
appearance. For some marks, there is a separate Appearance tab.
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Note that all the listed settings are not available for all marks.

To open mark properties:

• On the Drawings & reports tab, click Drawing properties, select the
drawing type, and go to mark properties directly by clicking the button of
the respective mark (GA drawings) or through view properties.

• In an open drawing, double-click the drawing background, and go to mark
properties directly by clicking the button of the respective mark (GA
drawings) or through view properties.

• In an open drawing, double-click the drawing view frame and click the
desired mark in the options tree on the left.

• In an open drawing, go to Drawing --> Properties and select a mark type.

• Double-click a mark in an open drawing.

Setting Description
Content tab:
Available elements

Elements in mark

Available elements lists the elements that are
available for the current mark.

Elements in mark lists the elements that you have
selected to include in the mark.

For more information about mark elements, see
Mark elements (page 693).

For a list of elements that are common to all
marks, see Common elements in marks
(page 694).

< Add frame Add frames around individual elements in side the
mark.

Frame around
elements: Type and
Color

Defines the element frame type and color for one
or several elements. To select all elements in the
Elements in mark list to apply the same
modification to all of them, hold down Shift on the
keyboard, and click the last element in the list.

Font: Color, Height and
Font

Defines the font type, color, and height used in
element texts in one or several elements. To select
all elements in the Elements in mark list to apply
the same modification to all of them, hold down
Shift and click the last element in the list.

Clicking Select... gives more font choices.
Units: Units and
Format

Change the units and format of the length, height,
spacing or diameter element that you have
selected from the Elements in mark list.

General or Appearance tab:
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Setting Description
In main parts

In secondary parts

In sub-assembly main
parts

In sub-assembly
secondary parts

These settings are for bolt marks.

Visible displays bolt marks.

Not visible does not display bolt marks.

Visibility in view distributed distributes the marks in the view.
Tekla Structures only creates marks that are not
visible in the other views.

always always creates marks in the view,
irrespective the settings in other views.

preferred acts as distributed, but the preferred
view has a higher priority.

Select distributed to one view only in a drawing. If
you set other views to distributed, the marks are
located only in the view that has the setting
Visibility in view set to preferred.

none creates no marks.
Parts out of view plane This setting is available only in view level

properties.

Visible displays marks outside of the view in the
drawing.

Not visible displays no marks outside the view.
Ignore size This setting is for bolt marks.

Filters standard-sized bolt marks out of drawings,
which means that Tekla Structures does not
display bolt marks of the defined size in drawings.

There are some advanced options that can be used
in addition to the Ignore size setting so that you
first give the ignored size and then set the
advanced option:

XS_OMITTED_DIAMETER_TYPE (page 320) defines if
the ignored size is the size of the bolt (value BOLT)
or the hole (value HOLE).

XS_OMITTED_BOLT_TYPE (page 320) can be used
for filtering out ignored bolt marks on the basis of
the bolt standard. Enter the name of the bolt
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Setting Description
standard as the value, for example, 7990. You can
also use wildcards, such as * or ?.

XS_OMITTED_BOLT_ASSEMBLY_TYPE (page 319)
can be used for filtering out ignored bolt marks on
the basis of the bolt type. The values are SITE, 
SHOP, and SITE_AND_SHOP.

Merge marks This setting is for part marks and surface
treatment marks.

On merges marks.

For more information about part marks merging
distance and other merging principles, see . By
default, the maximum merging distance is 1200
mm from the part.

Frame around mark:
Type and Color

Define the frame to be used around marks, and
the color of the frame.

Background mask Select Opaque to hide the part of the drawing that
is covered by the mark.

Select Transparent to show the part of the
drawing that is covered by the mark, so that line
work is visible, for example.
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Setting Description
Leader line: Rebar
group mark, Merged
marks, Type, Arrow and
Use hidden lines for
hidden parts.

Define the leader line type and line arrow type, and
select to hide leader lines for hidden parts.

If you are merging marks, or adding rebar group
marks, select one of the following options:

: One leader line to group creates one
leader line for a group of objects.

: One leader line per row merges the
marks and creates one leader line for a row of
objects.

: Parallel leader lines merges the marks
and creates parallel leader lines.

: Leader lines to one point merges the
marks and draws all leader lines to one point.

: Perpendicular leader lines allows you to
create marks with perpendicular leader lines to
rebar groups. Creates marks with leader lines to
each rebar in a group plane

: Leader line to first and last allows you to
create marks with perpendicular leader lines to
rebar groups. Creates marks to first and last rebar
in a group.

You can control the length of the perpendicular
leader lines with the advanced option 
XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDI
CULAR (page 292) ( File --> Settings -->
Advanced options --> Marking: General ). The
default value is 0 mm.

Rotation Define the part mark rotation.
Alignment Select one of the alignment options:

Left

Center

Right

Leader line

The Leader line option is available in following
mark types: bolt marks, connection marks, part
marks, neighbor part marks, pour object marks,
reinforcement marks, neighbor reinforcement
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Setting Description
marks, merged reinforcement marks and surface
treatment marks.

Place... Clicking the Place... button opens the placing
dialog box.

Placing: free allowsTekla Structures to search for
the first suitable location for the mark.

Placing: fixed allows you to place the mark in any
location.

When you use the option fixed, the mark stays
where it is even though you update the drawing,
whereas with free, Tekla Structures tries to find the
optimal place for the annotation object.

Search margin is the empty margin that you want
to leave around the mark.

Minimum distance is the minimum distance of
the mark from the part.

Maximum distance is the maximum distance of
the mark from the part.

Note that if you use a high Search margin and
Minimum distance values, the mark placement
does not work properly.

Quarter defines the areas where Tekla Structures
searches for a position to place the mark.

(1) Search margin

(2) Minimum distance

(3) Maximum distance

For more information about placing annotation
objects, see Arrange annotation objects.
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Setting Image Description
Merging tab

Use the Merging tab in Reinforcement mark properties to view and modify
the settings affecting the merging of the reinforcement marks in cast unit
drawings.

For more information about merged reinforcement marks, see Elements in
merged reinforcement marks (page 700), and .
Identical marks in
same cast unit

One leader line to
group creates one
leader line for a group of
reinforcing bars.
One leader line per
row merges the marks
and creates one leader
line for a row of
reinforcing bars.
Parallel leader lines
merges the marks and
creates parallel leader
lines.
Leader lines to one
point merges the marks
and draws all leader
lines to one point.
No merge does not
merge marks. Tekla
Structures creates an
individual leader line for
each mark.

If you select No merge,
you still need to define
the mark content for the
marks that Tekla
Structures automatically
merges on the Merging
tab.

Preferred direction of
merge

Merge vertical merges
the marks in the vertical
direction of the drawing.
Merge horizontal
merges the marks in the
horizontal direction of
the drawing.
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Leader line types
You can use leader lines with text, symbols, associative notes and marks to
make it clearer to which item it is related to.

Option Description Click the links below to find
out more

Texts

Symbols

Level marks

Part marks

Revision marks

Surface treatment
marks

Reinforcement
marks

Associative notes
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Positioning properties of view label, section and detail marks
Use the Position tab in the Mark Contents dialog box in view properties to
set the positioning options for view labels marks, section marks and detail
marks.

Option Description
Show on For section marks.

Defines if the section marks are
shown at both ends of the cut line or
at the left or right end.

Text position Defines the position of the mark text
in relation to the line or in relation to
the symbol or symbol center line.

Horizontal offset sets the horizontal
offset of the mark text from the line.

Vertical offset sets the vertical offset
of the mark text from the line.

Text rotation For section marks.

Defines the rotation of the mark text.
Alignment For view label marks.

Defines if the view label mark is
aligned to the center, right, or left.

Drawing weld mark properties
In Weld Mark Properties dialog box you can view and modify the properties
of a weld mark that has been manually added in a drawing.

To open the weld mark properties, do one of the following in an open drawing:

• Double-click a manually created weld.

• Hold down Shift and click Weld mark on the Annotations tab.

• On the Drawing tab, click Properties --> Weld mark.

Option Description
Prefix a= design throat thickness, s= penetration throat

thickness, or z= leg length
Size The size of the weld. If you select a partial

penetration weld as the weld type, you can enter
two sizes.
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Option Description
Type The type of the weld.

For a list of available weld types and their
descriptions, see List of weld types.

You can customize some of the weld type symbols,
see Customize weld type symbols for more
information.

Angle The angle of weld preparation, bevels, or groove.

Tekla Structures displays the angle between the
weld type symbol and the fill type contour symbol.

Contour The fill type contour of a weld can be:

• None

• Flush 

• Convex 

• Concave 
Finish Tekla Structures displays the finish symbol above

the weld type symbol in drawings. The options are:

• G (Grind)

• M (Machine)

• C (Chip)

• (Flush finished weld)

• (Smooth blended weld face)
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Option Description
Length The length of a regular weld depends on the length

of the connection between the welded parts. You
can set the exact length of a polygon weld by, for
example, defining the start and end points of the
weld.

Pitch The center-to-center spacing of welds for non-
continuous welds. Pitch is shown in the weld mark
if the value is greater than 0.0.

To create a non-continuous weld, define the
center-to-center spacing and the pitch of the
welds. Tekla Structures calculates the distance
between the welds as the pitch minus the length of
the weld.

By default, Tekla Structures uses the – character to
separate weld length and pitch, for example, 50–
100. To change the separator to @, for example,
set the advanced option
XS_WELD_LENGTH_CC_SEPARATOR_CHAR
(page 479) to @.

Effective throat The weld size used in weld strength calculation.
Root opening The space between the welded parts.
Reference text Additional information to appear in the weld

symbol. For example, information about the weld
specification or process.

Edge/Around Indicates whether only one edge or the entire
perimeter of a face should be welded.

A circle in the weld symbol in drawings indicates
the Around option has been used.

Workshop/Site Indicates where the weld should be made.
Stitch weld Set this option to Yes to create a staggered,

intermittent weld.

Stitch welds are staggered on both sides of the
welded part. Tekla Structures shows the weld type
symbols as staggered in weld symbols.

If you set this option to No, a non- staggered
intermittent weld is created. To show the pitch in a
weld mark, set Pitch to a value greater than 0.0.

Placing Search margin is the empty margin that you want
to leave around the mark.

Minimum distance is the minimum distance of
the mark from the part.
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Option Description
Quarter defines the areas Tekla Structures
searches for a space to place the weld marks.

Placing is the method used to place welds marks:

• free lets Tekla Structures decide the location
and direction of the mark.

• fixed allows you to place the weld at any point.

See also

Model weld mark visibility and appearance properties in drawings
You can select which model weld marks are visible in drawings, and define the
content that is displayed in weld marks. In assembly drawings, you can define
the visibility of welds in sub-assemblies.

Use options in Weld mark properties (or General - Welding Mark Properties
in general arrangement drawings) to set the visibility and contents of model
weld marks.

Single-part and assembly drawings

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

3. Click Weld mark in the options tree.

General arrangement drawing

1. Click Drawings & reports --> Drawing properties --> GA drawing .

2. Click Weld mark.

Option Description
Weld number Yes shows the weld number.

Tekla Structures assigns a number to
each weld when the weld is created.
You can select whether to show or
hide the weld number.

Welds

Welds in sub-assemblies (assembly
drawings)

None displays no welds in the
drawing.
Site displays only site welds in the
drawing.
Workshop displays only workshop
welds in the drawing.
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Option Description
Both displays both site welds and
workshop welds in the drawing.

Welds in hidden parts Select how to show the weld marks
for welds in hidden parts:

• None: If the part is hidden, the
weld mark is not drawn.

• Site: If the part is hidden, weld
marks for site welds are drawn
only.

• Workshop: If the part is hidden,
weld marks for workshop welds
are drawn only.

• Both: Weld marks are always
drawn for hidden parts.

Weld size limit Enter a weld size to filter welds of that
size out of the drawing. This is useful
when you only want to show non-
typical welds in a drawing.

To set whether the weld size limit is
an exact or minimum value, use the
advanced option 
XS_WELD_FILTER_TYPE
(page 478).

To filter out a standard weld types,
use the advanced option XS_
OMITTED_WELD_TYPE (page 321).

Above line, Below line and Other If there is no check mark in the
Visible column next to the following
properties, the properties are not
displayed in the weld mark. These
settings are set separately to above
line and below line:

Prefix

Size

Type

Angle

Contour

Finish

Length

Pitch
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Option Description
Effective throat

Root opening
Reference text

Edge/Around

Workshop/Site

These settings are common to above
line and below line. If there is no
check mark in the Visible column
next these properties, they are not
displayed in the weld mark.

Place... Placing:

• free allows Tekla Structures to
search for the first suitable
location for the mark, dimension,
weld or another annotation object.
fixed allows you to place the
mark, dimension, weld or another
annotation object in any location.

• When you use the option fixed,
the annotation object stays where
it is even though you update the
drawing, whereas with free, Tekla
Structures tries to find the optimal
place for the annotation object.

Search margin is the empty margin
that you want to leave around the
mark.

Quarter defines the areas Tekla
Structures searches for a space for
placing the mark.

Minimum distance is the minimum
distance of the mark from the part.

Note that if you use high Search
margin and Minimum distance
values, the mark placement may not
work properly.

Color Sets the color of the text.
Height Sets the height of the text.
Font Sets the font of the text. Click Select...

to show more options.
Type Sets the type of the line.
Color Sets the color of the line.

Settings reference 691 Drawing settings reference



Option Description
Background mask Select Opaque to hide the part of the

drawing that is covered by the mark.

Select Transparent to show the part
of the drawing that is covered by the
mark, so that line work is visible, for
example.

Level mark properties
Use the options in the Level Mark Properties dialog box to view and modify
level mark contents and appearance.

To open the dialog box in an open drawing, go to the Drawing tab, and click
Properties --> Level mark .

Option Description
General tab
Prefix Displays text before the mark.
Prefix for positive level + displays a + character in front of the value.
Visibility of numeric
value

Defines if the numeric values are visible or hidden.

Postfix Displays text after the mark.
Level mark format:
Precision

Defines the precision of the level mark dimension.

Level mark format:
Format

Defines the format of the level mark dimension.

Level mark format: Use
grouping

Defines whether to use different grouping options
to represent the level mark dimensions.

Level mark format:
Units

Defines the units used in level mark dimensions.
The available values are automatic, mm, cm, m,
foot - inch, inch and feet.

Placing Search margin is the farthest distance Tekla
Structures uses when searching for an empty
space for the level mark.

Minimum distance is the closest distance Tekla
Structures uses to search for an empty space for a
level mark.

Quarter defines the areas Tekla Structures
searches for a space to place the level marks.

Placing is the method used to place level marks:
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Option Description
• free lets Tekla Structures decide the location of

the level mark.

• fixed allows you to place the level mark at any
point.

Appearance tab
Text: Color, Height,
Font, Angle

Defines the text color, height, font and angle.

Frame: Type, Leader
line, Color

Defines the frame to be used around marks, the
type of the leader line, and the color of the frame.

Frame: Background
mask

Select Opaque to hide the part of the drawing that
is covered by the level mark.

Select Transparent to show the part of the
drawing that is covered by the mark.

Arrow: Type Defines the type of the arrow.

Defines the height and the length of the
arrowhead.

Mark elements
The elements and options selected on the mark properties Content tab define
the contents of the marks in drawings.

To add marks to a drawing automatically using the drawing properties, see .

To add part marks manually in an open drawing, see .

To add marks manually in reinforcement, see

Click the links below to find out more:

• Common elements in marks (page 694)

• Part mark elements (page 695)

• Bolt mark elements (page 697)

• Reinforcement and neighbor reinforcement mark elements (page 698)

• Reinforcement and neighbor reinforcement mesh mark elements
(page 699)

• Pour object mark elements (page 702)
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• Elements in merged reinforcement marks (page 700)

• Connection mark elements (page 701)

• Surface treatment mark elements (page 702)

• Section and detail mark elements (page 703)

• View, section view and detail view label mark elements (page 704)

Common elements in marks
There are some mark elements that can be used in most of the mark types.

Element Description
User-defined attribute Available for building object marks.

Adds a user-defined attribute to the
mark. You can also use template
fields for user-defined attributes.

In marks, you cannot use template
attributes such as MODEL_TOTAL that
refer to the whole model. Marks only
check the information from the object
in the drawing and not from the
whole model.

For more information about adding
user-defined attributes in marks, see
Add attributes in automatic marks.

Text Opens a dialog box where you can
enter text in the mark. The maximum
number of characters is 255.

Symbol Opens a dialog box where you can
change the symbol file in use and
select a symbol from the Tekla
Structures symbol file to add to the
mark.

< > Adds spaces between mark elements.
<--' Adds a line feed between the

elements to create multi-row marks.
The default space between the lines
depends on the text height and can
be changed with the advanced option 
XS_MARK_ELEMENT_SPACE_FACTOR
(page 290).

<-- Adds a backspace between the
desired elements to remove the
default space between them. The
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Element Description
default space between the elements
depends on the text height and can
be changed with the advanced option 
XS_MARK_ELEMENT_SPACE_FACTOR
(page 290).

Template Available for building object marks.

Adds in the mark a custom graphical
template created with Template
Editor. Opens a dialog box where you
can select the template.

For more information about adding
templates in marks, see Add
templates in automatic marks.

Part mark elements
You can define part mark contents independently for main and secondary
parts and for sub-assembly main and secondary parts.

The following table lists all elements specific to part marks and neighbor part
marks. Some of the available elements are not listed here, because they are
common to many types of marks, and listed separately (page 694).

Element Description
Assembly position Adds the prefix and position number

of the assembly.
Part position Adds the prefix and position number

of the part.
Profile Adds the profile name of part,

assembly, or cast unit main part.
Material Adds the material of part, assembly,

or cast unit main part.
Name Adds the name of part, assembly, or

cast unit main part.
Class Adds the class of part, assembly, or

cast unit main part.
Finish Adds the finish of part, assembly, or

cast unit main part.
Size Adds the size of the part or the

assembly or cast unit main part.
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Element Description
Length Adds the length of the part or

assembly, or of the cast unit main
part.

You can change the unit and format
of the length.

Camber Adds the camber of the part or the
assembly or cast unit main part (if this
user-defined part attribute is set).

Fittings (NS/FS) Displays the near side/far side marks
in the part mark. (only available in
front views).

Face direction Displays main compass direction
(North, East, South, West) of the face,
where the mark is added. The
direction can only be shown if

• the face is vertical

• the direction is the same for all
assemblies with the same
assembly position number

In other cases, the element produces
no text to mark.

Furthermore, face direction is not
shown for columns in general
arrangement drawings, if you have
set Mark always to center of
column in GA drawings to Yes in
File menu --> Settings --> Options --
> Orientation marks .

Gage of outstanding leg Adds the hole gage.

You can control the format of this
option with the advance option XS_
GAGE_OF_OUTSTANDING_LEG_
STRING (page 253).

Center-to-center distance Adds center-to-center distance in the
mark.

You can control the format of this
option with the advanced options XS_
CENTER_TO_CENTER_DISTANCE_IN_
ONE_PART_STRING (page 107) and 
XS_CENTER_TO_CENTER_DISTANCE_
IN_TWO_PARTS_STRING
(page 108).
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Element Description
Rotation angle Adds the rotation angle of a spiral

beam in the mark. For other parts this
element gives an empty value.

Bolt mark elements
You can define bolt mark options independently for site and shop bolts.

Below is a list of the elements specific to bolt marks. Some of the available
elements are not listed here, because they are common to many types of
marks, and listed separately (page 694).

Element Description
Bolt length Adds the length of the bolt.

You can change the unit and format
of the length.

Bolt diameter Adds the bolt diameter.

You can change the unit and format
of the diameter.

Hole diameter Adds the hole diameter.

You can change the unit and format
of the diameter.

Material Adds the bolt material grade.
Standard Adds the bolt standard.
Short name Adds the bolt’s short name. This can

be the commercial name of a specific
bolt, for example.

Full name Adds the complete name of the bolt.
This name is visible in the dialog box
list.

Assembly type Adds the bolt assembly type.
Number of bolts Adds the quantity of bolts.
Slot length (x)

Slot length (y)

Adds the slot length in the x or y
direction.

You can change the unit and format
of the length.

Slot length Adds the slot length.

You can change the unit and format
of the length.
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Element Description
Slot height Adds the slot height.

You can change the unit and format
of the height.

Size Adds the hole size.

You can change the unit and format
of the size.

Countersunk Adds countersink in the countersunk
bolt marks.

Gage of outstanding leg Adds hole gage.

You can control the format of this
element with the advanced option 
XS_GAGE_OF_OUTSTANDING_LEG_
STRING (page 253).

Center-to-center distance Adds center-to-center distance.

You can control the format of this
element with the advanced options 
XS_CENTER_TO_CENTER_DISTANCE_
IN_ONE_PART_STRING (page 107)
and XS_CENTER_TO_CENTER_
DISTANCE_IN_TWO_PARTS_STRING
(page 108).

Reinforcement and neighbor reinforcement mark elements
You can define mark contents separately for single reinforcing bars, bar
groups, and reinforcement meshes.

Below is a list of the elements you can include in all reinforcement and
neighbor reinforcements marks. Some of the available elements are not listed
here, because they are common to many types of marks, and listed separately
(page 694).

Element Description
Name Adds the name of the bar or mesh.
Grade Adds the material grade of the bar or

mesh.
Diameter Adds the nominal diameter of the

bar.
Class Adds the class of the bar or mesh.
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Element Description
Length Adds the total length of the bar.

You can change the unit and format
of the length.

Number Adds the quantity of the bars.
Position Adds the reinforcement position

number.
Shape Adds the shape of the bar or mesh.
Weight Adds the weight of the bar or mesh.
cc Adds the center-to-center spacing of

the bars. The options are:

• cc adds the spacing value if
spacing does not vary

• cc min adds the smallest spacing
value of the bar group if spacing
varies

• cc max adds the largest spacing
value of the bar group if spacing
varies

• cc exact lists all spacing values of
the bar group

• cc target lists all reinforcing bar
target spacing values

You can change the unit and format
of the cc options.

Pullout picture Adds a pull-out picture of a bar to the
mark.

For more information about pull-out
pictures, see Add pull-out pictures in
automatic reinforcement marks

See also

Elements in merged reinforcement marks (page 700)

Reinforcement and neighbor reinforcement mesh mark elements
You can define mark contents separately for reinforcement meshes.

The following elements are specific to the reinforcement and neighbor
reinforcement mesh marks, other elements are the same as for reinforcement
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marks (page 698). Some of the available elements are not listed here, because
they are common to many types of marks, and listed separately (page 694).

Element Description
Size Adds the nominal diameters of the

mesh bars, dimensions of the mesh,
and the spacings of the bars in the
longitudinal and crossing directions.

Mesh length Adds the length of the reinforcement
mesh.

Mesh width Adds the width of the reinforcement
mesh.

cc You can define cc individually for the
longitudinal and crossing bars in the
mesh.

Adds the center-to-center spacing of
the bars. The options are:

• cc longitudinal/cc crossing adds
the spacing value if spacing does
not vary

• cc min longitudinal/cc min
crossing adds the smallest
spacing value of the bar group if
spacing varies

• cc max longitudinal/cc max
crossing adds the largest spacing
value of the bar group if spacing
varies

• cc exact longitudinal/cc exact
crossing lists all spacing values of
the bar group

• cc target lists all reinforcing bar
target spacing values

Diameter longitudinal Adds the diameter or size of the
longitudinal bars.

Diameter cross Adds the diameter or size of the
crossing bars.

Elements in merged reinforcement marks
Some extra elements are available for merged reinforcement marks, in
addition to basic reinforcement marks.
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Element Description
Block prefix Adds text or a value to the beginning

of each repeated block. Opens a
dialog box where you can enter the
prefix.

You can use the following variables as
block prefixes:

%NUMBER% includes the number of
marks merged to the mark.

%NUMBER_IN_PLANE% includes the
number of marks merged in the plane
of the drawing to the mark.

%NUMBER_OUT_OF_PLANE% includes
the number of marks merged in the
depth direction of the drawing to the
mark.

Single mark content Adds the content of the single
reinforcement mark selected on the
Content tab to the mark.

Distances between groups Adds the center-to-center distances
between reinforcing bars or bar
groups included in a merged mark.

Symbol separating blocks in mark Adds a symbol between the blocks in
the merged mark. Opens a dialog box
where you can define the symbol.

The elements that appear before this
element on the mark content list
generate a block.

See also

Reinforcement and neighbor reinforcement mark elements (page 698)

Connection mark elements
In connection marks, you can show the connection code, name, number, and
running number, the group they belong to, potential errors, and the related
DSTV code.

Below is a list of elements specific to connection marks. Some of the available
elements are not listed here, because they are common to many types of
marks, and listed separately (page 694).
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Element Description
Code Adds the connection code. This is a

user-defined code you give for the
connection in the connection dialog
box. The code can be either a text
string or a number.

Name Adds the connection name, for
example, Tube_splice.

DSTV code Adds the DSTV code.
Connection number Adds the number of the connection.
Running number Adds the connection running number.

All connections are automatically
numbered with a running number.

Group Adds the connection group.
Connection error Adds the connection error. The

numbers correspond to the
connection symbol colors:

• 1 = green

• 2 = yellow

• 3 = red symbol

Pour object mark elements
Pour objects have some mark elements of their own, in addition to common
mark elements (Text, Symbol, User-defined attribute, Template).

Element Description
Material Adds the defined pour material.
Pour number Adds the identifier that groups the pour objects in

the same group, for example, to be poured at the
same time.

Pour type Adds a property of the pour based on the name of
a part.

Concrete mixture Adds the defined concrete mixture.

See also

Common elements in marks (page 694)
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Surface treatment mark elements
In surface treatment marks, you can show the name, material, Tekla
Structures-specific name, and the code of the surface treatment.

Here is a list of elements specific to surface treatment marks. Some of the
available elements are not listed here, because they are common to many
types of marks, and listed separately (page 694).

Element Description
Name Adds the name defined in the Name

box in the surface treatment
properties in a model.

Material Adds the surface treatment material.
Class Adds the class of the surface

treatment.
Code Adds the code of the surface

treatment option selected from the
Subtype list in the in the surface
treatment properties in a model.

For example, if the subtype is MF
Magnesium Float, the code is MF.

Surface treatment name Adds the full name of the surface
treatment option selected from the
Subtype list in the in the surface
treatment properties in a model.

For example, if the subtype is MF
Magnesium Float, the full name is
Magnesium Float.

Section and detail mark elements
In section and detail marks, you can show the name of the section/detail, the
name of the current drawing, and the name of the source drawing.

Below is a list of elements specific to section and detail marks. Some of the
available elements are not listed here, because they are common to many
types of marks, and listed separately (page 694).

Element Description
Section name/Detail name Adds the name of the section or the

detail (A, B, C, and so on).
Drawing name Adds the name of the current

drawing.
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Element Description
Source drawing name Adds the name of the drawing where

the view is.
Source drawing name when moved Adds the name of the drawing where

the view is. This is shown only if the
view is not in the same drawing as the
section/detail mark.

See also

Positioning properties of view label, section and detail marks (page 686)

View, section view and detail view label mark elements
In view labels, you can show the name of the view, section or detail, the view
scale, drawing name, and source drawing name.

Below is a list of the elements specific to view, section view and detail view
label marks. Some of the available elements are not listed here, because they
are common to many types of marks, and listed separately (page 694).

Element Description
View name/Section name/Detail
name

Adds the name of the view, section or
the detail.

Scale Adds the scale of the view.
Drawing name Adds the name of the current

drawing.
Source drawing name Adds the name of the drawing where

the view has originally been created.
Source drawing name when moved Adds the name of the drawing where

the view has originally been created.
This is shown only when the view has
been moved from its original drawing.

See also

Positioning properties of view label, section and detail marks (page 686)

Part and neighbor part properties in drawings
Use the options in part properties or neighbor part properties to check and
change the part or neighbor part properties. In neighbor part properties, you
can also control the visibility and appearance of neighbor part bolts.
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To go to part or neighbor part properties:

• On the Drawings & reports tab, click Drawing properties , select the
drawing type and go to part or neighbor part properties.

• In an open drawing, double-click the drawing view frame, select View
creation, select a view, click View properties and click Part... or Neighbor
part... In GA drawings, just double-click the view frame and click Part... or
Neighbor part...

• In an open drawing, double-click the drawing background, and go to part or
neighbor part properties.

• Double-click a part or neighbor part in an open drawing.

All part properties do not contain all of the settings listed below.

Content tab:

Option Description
Representation Outline shows parts as solid objects.

Exact shows parts as solid objects.
This choice also draws the fillet edges
and chamfers in the profile cross
sections. For some profiles, Outline
shows them as well.

Symbol draws parts as lines.

Symbol with partial profile shows a
partial profile of the part. You can
also adjust the length of the partial
profile (Length), and the offset of the
partial profile from the middle point
of the part (Offset from middle
point).

Workshop form draws round tube
profiles as wrap-around templates.
Note that Workshop form can only
be used in single part drawings.

Bounding box draws parts as boxes
surrounding the actual profiles.

Bounding box is a good option to use
with complex items with an extrema
box containing many polygons
slowing down drawings, because

Settings reference 705 Drawing settings reference



Option Description
Bounding box makes drawings
faster.

Base box shows parts as boxes and
uses the h and b values from the
profile catalog as box dimensions.

Symbol offset Defines the distance of the end points
of reference lines and center lines
from the end points of the object.

Inner contours Shows the inner contours of a tube.
Hidden lines If the Hidden lines check box is

selected, Tekla Structures shows
hidden lines in secondary and
neighbor parts.

If the Own hidden lines check box is
selected, Tekla Structures shows
hidden lines in main parts.

Center line Select whether you want to show
center lines.

Select the Main part: Beam, Plate or
Polygon check box to show center
lines in main parts.

Select the Sec part: Beam, Plate or
Polygon check box to show center
lines in secondary parts.

Note that the center line is only
shown for assembly primary parts
and not for secondary parts when
looking from the cross section
direction. If the part is viewed from
the side, the center line is also shown
for secondary parts.

Reference lines Select wether you want to show
reference lines.

Select the Main part: Beam, Plate or
Polygon check box to show reference
lines in main parts.

Select the Sec part: Beam, Plate or
Polygon check box to show reference
lines in secondary parts.
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Option Description
Additional marks Select the following check boxes to

show additional marks in drawings:

• Orientation marks shows
orientation marks.

• Connecting side marks shows
connecting side marks.

• Pop-marks shows pop-marks
defined in NC settings.

• Edge chamfers shows edge
chamfers.

• Fillet edges shows fillet edges.
Bolt representation (neighbor parts) Select bolt representation. The

options are solid, exact solid
Symbol, Symbol2 , Symbol3, DIN
symbol, and User-defined symbol.

DIN symbol corresponds to German
standards (DIN). The only DIN
symbols you can control are:

• Symbol 24 for normal workshop
bolts

• Symbol 25 for normal site bolts

• Symbol 26 for front countersunk
site bolts

• Symbol 27 for back countersunk
site bolts

• Symbol 28 for front countersunk
workshop bolts

• Symbol 29 for back countersunk
workshop bolts

• Symbol 30 for front countersunk
holes

• Symbol 31 for back countersunk
holes

User-defined symbol is a symbol
that has been created in Symbol
Editor.

Symbol content (neighbor parts) Select whether to include hole or axis
in the symbol.

Neighbor parts have a Visibility tab:
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Option Description
Neighbor parts None does not show neighbor parts.

Connected parts shows all parts
connected to the model object.

Connecting parts shows only the
parts the model object is connected
to.

All componentscombines the
Connected parts and the
Connecting parts options.

By extreme shows all parts within
the boundaries of the main and
secondary part.

Main/Secondary parts Main parts shows only neighbor
parts that make the main part of an
assembly or a cast unit.

Secondary parts shows only
neighbor parts that are secondary
parts of an assembly or a cast unit.

Both shows both main and secondary
parts.

Skew parts Yes shows skew parts as neighbor
parts in the drawing, No does not.

Bolts Yes shows the bolts in the neighbor
parts, No does not.

The Appearance tab is similar in all of the properties of all kinds of building
objects (parts, neighbor parts, bolts, welds, surface treatments, reinforcement,
and meshes).

Option Description
Visible lines Sets the Color and Type of the visible

lines.
Hidden lines, Center line Sets the Color and Type of the

hidden lines.

Sets the Color of the center lines.
Reference lines Sets the Color and Type of the

reference lines.
Text: Color Sets the Color of the text.
Text: Height Sets the Height of the text.
Text: Font Sets the Font of the text. Click

Select... to show more options.
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Option Description
Line: Type Sets the Type of the line.
Line: Color Sets the Color of the line.
Bolts: Color Sets the color of the bolts in neighbor

parts.

Both parts and neighbor parts have a Fill tab. To add a fill for outer part faces,
use the Part faces area, and to add a fill to cross sections in section views, use
the Sections area.

Setting Description
Type Defines the fill type. Clicking the

button next to the list opens a
preview of the hatch patterns.

Automatic selects the fill type
automatically from the hatch pattern
schema files.

None uses no fill.
Color Defines the color for the fill.

You can select a predefined color or
use Special color that is not
converted to black in printouts.

Background Defines the background color for the
fill.

Background color selection is
disabled for hardware hatches.

Background color can be set for
automatic hatches, but it has effect
only if automatic hatch is not defined
for the material in the hatch pattern
schema file.

Scale Automatic scales and rotates the fill
automatically.

Custom allows you to select scaling
and rotation manually.

Scaling in direction x and Scaling in
direction y define the scales in x and
y direction.
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Setting Description
Keep ratio of x and y retains the
relative proportions in the hatch
pattern.

Angle rotates the fill. Angle 0.0 is for
horizontal and 90.0 for vertical.

Bolt content and appearance properties in drawings
Use the options in bolt properties to check or change the bolt content and
appearance.

To go to bolt properties:

• On the Drawings & reports tab, click Drawing properties , select the
drawing type and go to bolt properties.

• In an open drawing, double-click the drawing background, and go to bolt
properties.

• Double-click a bolt in an open drawing.

All bolt properties dialog boxes do not contain all of the settings listed below.

Option Description
Solid/Symbol The options are solid, exact solid,

Symbol, Symbol2, Symbol3, DIN
symbol, and User-defined symbol.

DIN symbolcorresponds to German
standards (DIN). The only DIN
symbols you can control are:

• Symbol 24 for normal workshop
bolts

• Symbol 25 for normal site bolts

• Symbol 26 for front countersunk
site bolts

• Symbol 27 for back countersunk
site bolts

• Symbol 28 for front countersunk
workshop bolts

• Symbol 29 for back countersunk
workshop bolts

• Symbol 30 for front countersunk
holes
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Option Description
• Symbol 31 for back countersunk

holes

User-defined symbol is a symbol
that has been created in Symbol
Editor.

Symbol content Indicates whether to include the Hole
and Axis symbols in the drawing.

Visibility of bolts Control the visibility of bolts in main
parts, secondary parts and sub-
assemblies separately. Visible shows
bolt group holes in main parts or
secondary parts. Not visible hides
them. In assembly drawings you can
also define whether to show or hide
bolt group holes in sub-assemblies.

Color Change the bolt color.

See also

XS_DRAW_BOLT_OWN_HIDDEN_LINES (page 178)

XS_DRAW_BOLT_HIDDEN_LINES (page 174)

Part and neighbor part properties in drawings (page 704)

Surface treatment visibility and content properties in
drawings
Use the options in surface treatment properties to check or change the
surface treatments drawing properties.

Option Description
Visibility Visible shows the surface treatment.

Not visible does not show the
surface treatment.

Representation Defines the appearance of the
surface treatment. The available
options are Outline, Exact,
Workshop form, Symbol, Bounding
box, and Base box.

Show pattern Defines whether the hatch pattern is
shown.
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Option Description
Hidden lines Defines whether hidden lines in

secondary and neighboring parts are
shown.

Own hidden lines Defines whether hidden lines in main
parts are shown.

Surface treatment hatch pattern properties (surfacing.htc)
You can change the properties of the hatch patterns for each surface
treatment type separately.

The properties of the hatch patterns are defined in the surfacing.htc file,
located by default in ..\Tekla Structures\<version>\environments
\common\system . In addition to this file, the surface treatment code file 
product_finishes.dat is needed. It is located in the same folder.

If you create your own surface treatment hatch patterns in your company, you
can store surfacing.htc and product_finishes.dat in the firm folder
defined by the advanced option XS_FIRM.

Note:

NOTE When you edit a schema file, you must reopen the model to apply the
changes.

The syntax of surfacing.htc file is:

Surfacing Type, Surfacing Code, Hatch name, Scale, [Color],
[Automatic Scaling and Rotation]
Example:

1,MF,ANSI31,0.7
1,SMF,ANSI32,0.7
1,WT,ANSI33,0.7
1,HT,ANSI34,0.7
1,LSB,AR-SAND,0.7
2,SM1,CROSS,1.0
2,SM2,CHECKERED,1.0
3,TS3,FBBRICKC,1.0
4,FP,ANSI31,1.0
4,UP,ANSI32,1.0

Settings reference 712 Drawing settings reference



Option Description
Surface treatment type • 1 = concrete finish

• 2 = special mix

• 3 = tile surface

• 4 = steel finish
Surface treatment code This is the abbreviation used in

drawings and reports, for example,
MF for Magnesium Float. The
product_finishes.dat file
contains a full list of surface
treatment codes.

Hatch name You can check the hatch pattern
names and related hatch patterns by
going to the Fill tab in part properties,
selecting a hatch pattern from the
Type list and clicking the ... button
next to the list. The selected hatch
pattern is marked with a red frame.

Scale Scale is a numeric value that Tekla
Structures uses to scale hatches.

Color (optional) 0=black (default)

1=white

2=red

3=green

4=blue

5=cyan

6=yellow

7=magenta

120= Special (use this color for gray
shade)

The hatch color defines the line width
for the printer. If you do not define a
color for a hatch in the
surfacing.htc file, Tekla Structures
uses the color defined on the
Appearance tab in surface treatment
properties. The Visible lines color
and type is used for the front of the
surface treatment, and the Hidden
lines for the back.
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Option Description
Automatic Scaling and
Rotation (optional)

1=true

0=false (default)

See also

XS_FIRM (page 249)

Reinforcement/Neighbor reinforcement and mesh
properties in drawings
Use the options in the Reinforcement or Neighbor Reinforcement
properties to check and modify the reinforcement and mesh visibility,
appearance and content.

Option Description
Visibility of all reinforcing bars

Visibility of all meshes

Visible shows the bars or meshes.

Not visible does not show the bars
or meshes

Representation single line draws a single line with
radiused bends.

single line with filled ends draws a
single line for parallel bars and filled
ends for perpendicular bars.

double lines draws an outline of the
bar with radiused bends.

double lines with filled ends draws
an outline of the bar with radiused
bends and filled bar ends.

filled line draws a solid bar with
radiused bends.

stick draws a single line without
radiused bends.

outline shows the shape of the mesh
using an outline rectangle or polygon,
and a diagonal line. Applies only to
reinforcement meshes.

outline (ignore holes) ignores holes
and draws over them. Applies only to
reinforcement meshes.
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Option Description
Visibility of reinforcing bars in
group

Visibility of longitudinal wires

Visibility of crossing bars

all shows all bars in a group or mesh.

first bar shows only the first bar in
the group or mesh.

last bar shows only the last bar in the
group or mesh.

first and last shows the first and last
bar in the group or mesh.

bar in the middle of group shows
one bar in the middle of the group or
mesh.

two bars in the middle of group
shows two bars in the middle of the
group or mesh.

customized indicates that you have
specified the location of the only
visible reinforcing bar. Applies only to
bar groups and meshes.

Hide lines behind parts Hides the lines behind the part. This is
useful, for example, with lifting
anchors where the reinforcing bar is
partly outside the part.

Hide lines behind other rebars Hides the lines behind other
reinforcement bar lines.

Symbol at straight end

Reinforcing bar end symbols are
always drawn in solid line type,
regardless of the selected
reinforcement line type.

Applies only to reinforcing bars.
Symbol at hooked end

Applies only to reinforcing bars.

Reinforcing bar end symbols are
always drawn in solid line type,
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Option Description
regardless of the selected
reinforcement line type.

Mesh symbol Defines the mesh symbol to be used.
The mesh symbol appears in the
middle of the diagonal line.

Symbol 1

Symbol 2

Symbol 3

Mesh symbol size Defines the size of the mesh symbol.
Visible lines Defines the color and type of the

visible lines.

Reinforcing bar end symbols are
always drawn in solid line type,
regardless of the selected
reinforcement line type.

Hidden lines Defines the color and type of the
hidden lines.

Additional ways of modifying reinforcement

In addition to the settings in reinforcement properties, you can modify the
reinforcement in any of the following ways:

• Increase the size of the bend and end symbols (in drawing units) using the
advanced options XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE
(page 347) and XS_REBAR_END_SYMBOL_MIN_SIZE (page 349) in File
menu --> Settings --> Advanced options --> Concrete Detailing .

• Use the advanced option XS_REBAR_REVERSE_END_SYMBOLS
(page 354) in File menu --> Settings --> Advanced options --> Concrete
Detailing to change the end symbols to a different direction.

• Modify the reinforcing bar bending schedule, rounding of bar dimensions,
symbols for meshes, strands, and unbonding, and appearance of
reinforcement pull-outs in the rebar_config.inp (page 717) file.
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See also

Part and neighbor part properties in drawings (page 704)

Reinforcement settings for drawings (rebar_config.inp)

Tekla Structures uses the settings in the rebar_config.inp file in the system
folder (XS_SYSTEM (page 424)), firm folder or in the project folder to define the
following reinforcement-related issues in drawings:

• Selected area-specific reinforcing bar bending schedule

• Rounding of bar dimensions

• Available symbols for meshes, strands, and unbonding

• Appearance of reinforcement pull-outs

The entries in the rebar_config.inp are listed and described below:

Entry Description
MergeOneFormat No longer used. Define these properties in the

drawing properties.MergeTwoOrMoreFormats
MergeAndFormat
LeaderLinetype
DimensionMarkSpacingSep
arator

="/"
Affects the separator in reinforcement marks.

ExactDimensionMarkSpaci
ngSeparator

=" + "
Separator between different exact spacing
values in reinforcement marks.

ExactDimensionMarkPcsSe
parator

="*"
Separator between the number of bars and
their exact spacing value in reinforcement
mark.

BendingAngleTolerance Set a tolerance value for the angle. Angles that
differ from the set tolerance value less than
the tolerance are recognized and lead to a
correct bending shape.

Enter the tolerance value as a radians, not as
a degree. The default value is 0.001 radians,
which is 0.0573 in degrees. This applies to all
bending shapes.
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Entry Description
BentRebarTolerance Set a tolerance value. Depending on the value,

slightly curved reinforcing bars get straight
shape.

If reinforcing bar diameter is 20 mm and
radius is 200 m then value 20/200000 =
0.0001.

This variable defines correct curved
reinforcing bar in case of long reinforcing bars
to get a correct shape for the bar. This option
is used in comparing the relation of the
reinforcing bar diameter and radius. If the
relation is smaller than 
BentRebarTolerance, the reinforcing bar is
of bend_type_1, otherwise it is of
bend_type_34.

PullOutBendingRadiusAsM
ultiplier

Set to 1 to show the pullout bending radii
using multiplier instead of mm.

GroupBarMark No longer in use.
MarkingDimAttributes No longer in use.
ScheduleCountry Defines which bending schedule is used.

Affects bending shapes in templates and
reports. The available schedules are FIN, SWE,
UK, US.

When you number the model, the bending
shape for the bar is given according to this
information. For example, in the Default
environment, the bending shapes are letters
A, B, C, and so on.
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Entry Description
ScheduleDimensionRoundi
ngDirection
ScheduleTotalLengthRoun
dingDirection

Options:

• "UP": rounds bar dimensions up

• "DOWN": rounds bar dimensions down

• "NEAREST": rounds bar dimensions either
up or down

ScheduleDimensionRoundi
ngAccuracy

Sets the rounding accuracy for bar
dimensions. Default is 1 mm.

Tekla Structures rounds individual bar
dimensions up or down according to the
option you select for 
ScheduleDimensionRoundingDirection.

ScheduleTotalLengthRoun
dingAccuracy

Sets the rounding accuracy for the total bar
length. Default is 10 mm.

Tekla Structures rounds individual bar
dimensions up or down according to the
option you select for 
ScheduleTotalLengthRoundingDirection
.

BentSymbolFile Points to the symbol file that contains the
available reinforcing bar bent symbols. By
default, points to the file bent.sym, which in
the default environment is located in the
folder ..\ProgramData\Trimble\Tekla
Structures\<version>\\environments
\common\symbols.

MeshSymbolFile Points to the mesh symbol file that contains
the available mesh symbols. Affects the
available reinforcement mesh symbols in
drawings.

By default, points to the mesh.sym file in
the ...\Tekla Structures\<version>\
\environments\common\symbols folder.

StrandSymbolFile Points to the strand symbol file that contains
the available strand symbols. Affects
drawings.

By default, points to the strand.sym file in
the ...\Tekla Structures\<version>
\environments\common\symbols folder.

UnbondingSymbolFile Points to the unbonding symbol file that
contains the available unbonding symbols.

RebarMeshSize Template for rebar mesh size.
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Entry Description
PullOutDimensionFormat Defines the format for displaying the

dimensions.

The format follows the dimension properties
format.

Options:

• 0 = ###

• 1 = ###[.#]

• 2 = ###.#

• 3 = ###[.##]

• 4 = ###.##

• 5 = ###[.###]

• 6 = ###.###

• 7 = ### #/#

• 8 = ###/##.###

PullOutDimensionPrecisi
on

Sets the level of precision. The precision is
calculated using the following formula: 1/
value = precision.

In metric systems, you may want to use the
values 1, 10, and 100, and in imperial systems,
the values 2, 4, 8, 16 and 32, for example.

PullOutDimensionUnit Defines the units to use.

Options:

• 0 = auto

• 1 = mm

• 2 = cm

• 3 = m

• 4 = inch

• 5 = foot and inch
PullOutColor Sets the color for the pull-outs in

reinforcement marks.

Options:

• 1 = black

• 2 = red

• 3 = bright green

• 4 = blue
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Entry Description
• 5 = cyan

• 6 = yellow

• 7 = magenta
PullOutVisibleLineType Sets the line type for reinforcing bar shape in

pull-outs.

Options:

1 = 

2 = 

3 = 

4 = 

5 = 

6 = 

7 = 
PullOutRepresentation Sets the representation type.

Options:

• 0 = single

• 1 = double

• 2 = filled

• 3 = stick
PullOutAngleColor Sets the color for the angle in pull-outs.

Options:

• 1 = black

• 2 = red

• 3 = green

• 4 = blue

• 5 = cyan

• 6 = yellow

• 7 = magenta

• 8 = brown

• 9 = green
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Entry Description
• 10 = dark blue

• 11 = forest green

• 12 = orange

• 13 = gray

PullOutAngleLineType Sets the line type for angle lines in pull-outs.

Options:

• 1 = 

• 2 = 

• 3 = 

• 4 = 

• 5 = 

• 6 = 

• 7 = 
PullOutLeaderLineMinLen
gth

Sets a minimum length for the small leader
lines that point to the dimension text. The
default value is 10 mm. To switch leader lines
off completely, use a large value.

PullOutShowDuplicateDim
s

Defines whether duplicate dimensions are
showed multiple times for one bar.

Options:

• 0 = duplicate dimensions are not shown
(default)

• 1 = equal and parallel dimensions are
shown, but similar hook dimensions are
not shown

• 2 = equal and parallel dimensions are not
shown, but both hook dimensions are
shown
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Entry Description
• 3 = all dimensions are shown

• 4 = hook dimensions are not shown

• 5 = hook dimensions, or equal and parallel
dimensions are not shown

PullOutShowUSHookDims Defines if the US/NA style of dimension will be
shown for hooks over 90 degrees.

Options:

• 0 = shows European hook dimension (= leg
length, default)

• 1 = shows US hook dimension (= straight
length) for hooks >90 degrees

See the image below for the difference
between the US/NA (A) and European (B) hook
dimension.

See also

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 714)

Pour object and pour break properties in drawings
Use the options in Pour Object Properties and Pour Break Properties in
general arrangement drawings to control the visibility of the pour objects and
pour breaks in drawings.

Pour object properties

To open Pour Object Properties:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and then click Pour object...

• In an open drawing, double-click the drawing background and click Pour
object...

• In an open drawing, double-click a pour object.
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Option Description
Content tab - Hidden lines
Hidden lines on/off Select the check box to display pour

object hidden lines.
Own hidden lines on/off Select the check box to display own

hidden lines.
Content tab - Additional marks
Edge chamfers on/off Select on to display edge chamfers.
Fillet edges on/off Select on to display fillet edges.
Appearance tab - Visible lines
Color Select the color of the visible pour

object lines.
Type Select the type of the visible pour

object lines.
Appearance tab - Hidden lines
Color Select the color of the hidden pour

object lines.
Type Select the type of the hidden pour

object lines.
Fill tab

To add a fill for outer pour faces, use the Pour faces area, and to add a fill for
cross sections in section views, use the Sections area.
Type Defines the fill type. Clicking the

button next to the list opens a
preview of the hatch patterns.

Automatic selects the fill type
automatically from the hatch pattern
schema files.

None uses no fill.
Color Defines the color for the fill.

You can select a predefined color or
use Special color that is not
converted to black in printouts.

Background Defines the background color for the
fill.

Background color selection is
disabled for hardware hatches.

Background color can be set for
automatic hatches, but it has effect
only if automatic hatch is not defined
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Option Description
for the material in the hatch pattern
schema file.

Scale Automatic scales and rotates the fill
automatically.

Custom allows you to select scaling
and rotation manually.

Scaling in direction x and Scaling in
direction y define the scales in x and
y direction.

Keep ratio of x and y retains the
relative proportions in the hatch
pattern.

Angle rotates the fill. For example,
Angle 0.0 is for horizontal and Angle
90.0 for vertical.

Pour break properties

To open Pour Break Properties:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and then click Pour breaks...

• In an open drawing, double-click the drawing background and click Pour
breaks...

• In an open drawing, double-click a pour break.

Option Description
Content tab
Visibility Defines if the pour breaks are visible

(Visible) or not (Not visible).
Hidden lines Select the check box to display pour

break hidden lines.
Appearance tab - Visible lines
Color Select the color of the visible pour

break lines.
Type Select the type of the visible pour

break lines.
Appearance tab - Hidden lines
Color Select the color of the hidden pour

break lines.
Type Select the type of the hidden pour

break lines.
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Placement properties for marks, dimensions, notes, texts
and symbols
Use the settings in the Placing dialog boxes for dimensions, marks, notes,
texts annotation objects and dimensions to control how the annotation
objects are placed in a drawing.

You can set automatic placement properties for dimensions and marks before
you create a drawing. In an open drawing, you can modify the placement
properties of marks, notes, texts, symbols and dimensions.

To open the Placing properties in an open drawing:

• In an open drawing, on the Drawing tab, click Properties and then click
Text, Note, Symbol, Dimension or one of the mark types. After that, click
the Place... button.

• In an open drawing, double-click a text, mark, symbol, note or dimension.
After that, click the Place... button.

Option Description
Search margin Defines the empty margin that you

want to have around the the
annotation objects.

Note that if you use a high Search
margin value, the mark placement
does not work properly.

Minimum distance Defines the minimum distance of the
mark, weld mark, dimension or
another annotation object from the
part.

Note that if you use a high Minimum
distance value, the mark placement
does not work properly.

Maximum distance Defines the maximum distance of the
mark, dimension or another
annotation object from the part.

Quarter For marks and manually added
annotation objects.

Defines the areas Tekla Structures
searches for a space to place the
annotation object.

Weld placement depends on the
welding direction. Welds can only be
placed in certain sectors, so the
Quarter options are not available.
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Option Description
However, this option is available for
manually added welds in the final
drawing.

Placing free allows Tekla Structures to search
for the first suitable location for the
mark, dimension, weld or another
annotation object. fixed allows you to
place the mark, dimension, weld or
another annotation object in any
location.

When you use the option fixed, the
annotation object stays where it is
even though you update the drawing,
whereas with free, Tekla Structures
tries to find the optimal place for the
annotation object.

Direction Available only for manual dimensions.

Defines the side of the dimensioned
object where Tekla Structures places
dimensions. This setting affects the
free setting.

The following image illustrates the search margin, minimum distance and
maximum distance of a mark:

(1) Search margin

(2) Minimum distance

(3) Maximum distance

See also

XS_CHANGE_DRAGGED_MARKS_TO_FIXED (page 110)

XS_CHANGE_DRAGGED_NOTES_TO_FIXED (page 110)

XS_CHANGE_DRAGGED_TEXTS_TO_FIXED (page 110)

XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED (page 109)
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Model weld properties in drawings
You can select which model welds are visible in drawings and drawing views,
and set the weld color and line type.

• To set the automatic welding properties in single-part and assembly
drawings: On the Drawings & reports tab, click Drawing properties and
select the drawing type. Click View creation in the options tree on the left,
select the view and the properties that you want to change, and click View
properties. Now click Weld... in the options tree and adjust the settings as
required.

• To set the automatic welding properties in general arrangement drawing:
On the Drawings & reports tab, click Drawing properties and select the
drawing type. Click Weld... and adjust the settings as required.

• To modify the welding properties on drawing level in a general
arrangement drawing: Double-click the drawing background and click
Weld...

• To modify the welding properties on view level: Double-click the drawing
view frame and click Weld... in the View Properties dialog box.

Option Description
Content tab - Visibility
Welds

Welds in sub-
assemblies

Not visible does not display any welds in the
selected view/drawing.

Site weld visible displays only site welds in the
view/drawing.

Workshop weld visible displays only workshop
welds in the view/drawing

Both visible displays both site welds and
workshop welds in the view/drawing.

Weld size limit Enter a weld size limit to filter welds of that size
and bigger out of the drawing. This is useful when
you only want to show non-typical welds in a
drawing.

To set whether the weld size is an exact or
minimum value, use the advanced option
XS_WELD_FILTER_TYPE (page 478).

To filter out a standard weld type, use the
advanced option XS_OMITTED_WELD_TYPE
(page 321).

Content tab: Representation
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Option Description
Representation Select Path or Outline.

You can also select whether to show Hidden lines
or Own hidden lines.

Weld solids are shown in drawings in the following
cases:

• Weld solids are shown in drawings for those
weld types that have real solid support. Welds
that have no real solid support are shown in the
model with a hexagonal placeholder, and in
drawings weld solids are not shown.

• Welds that have custom cross-sections are also
supported.

Appearance tab: Visible lines
Color Sets the color of the weld lines.
Type Sets the type of the weld lines.
Appearance tab: Hidden lines
Color Sets the color of the hidden lines.
Type Sets the type of the hidden lines.

See also

Model weld mark visibility and appearance properties in drawings (page 689)

Drawing sketch object properties
You can draw different kinds of sketch objects (graphical objects) in your
drawings (lines, rectangles, polylines, polygons, arcs, circles) and use the
sketch objects for highlighting particular spots of interest, for example. Use
the properties dialog boxes of different sketch objects to check and change
the appearance of the shapes.

To open the properties dialog box of a sketch object, go to the Drawing tab,
hold down Shift and click the sketch object command. When you have added
a sketch object in a drawing, you can open its properties by double-clicking the
object.

The settings you have in the dialog box vary depending on the sketch object
type.

Setting Description
Behind model objects When set to Yes, places the graphical

object behind model objects.
Line: Type Defines the line type of the object.
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Setting Description
Line: Color Defines the color of the object lines.
Line: Bulge or Bulge for all lines Values 0 - 1.The bulge factor defines

the curvature of the curved segments
of objects using the calculation:

Arc height = Line length * Bulge factor

Changing the bulge factor of a
polyline or polygon modifies all the
segments of that object.

Line: Radius Defines the radius of arcs and circles.
Arrow: Position

Arrow: Type

Arrow: 
Defines the arrow height.

Arrow: 
Defines the arrow length.

Fill: Type Defines the fill type to be used in the
object. Clicking Select... shows the
available hatch types.

Fill: Color Defines the color of the fill.
Fill: Background Defines the background color of the

fill.
Scaling in direction x

Scaling in direction y

Keep ratio of x and y

Defines the fill scales in the x and y
direction.

Angle Rotates the fill. Angle 0.0 is for
horizontal and 90.0 for vertical.

Offset Moves the fill pattern inside the
object to in the x and y direction by
the specified value.
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Drawing grid properties
Use the grid properties to view and modify the grid settings in drawings.

• To set the automatic grid properties in single-part and assembly drawings:
On the Drawings & reports tab, click Drawing properties and select the
drawing type. Click View creation in the options tree on the left, select the
view and the properties that you want to change, and click View
properties. Now click Grid... in the options tree and adjust the settings as
required.

• To set the automatic grid properties on drawing level in general
arrangement drawing: On the Drawings & reports tab, click Drawing
properties and select the drawing type. Click Grid... and adjust the settings
as required.

• To modify the grid properties on drawing level in a general arrangement
drawing: Double-click the drawing background, click Grid... and adjust the
settings as required.

• To modify the grid properties on view level: Double-click the drawing view
frame and click Grid... in the View Properties dialog box, and adjust the
settings as required.

Option Description
Grid Visible shows the grids.

Not visible does not show the grids.

Visible in all views shows the grids in
all drawing views. This option is not
available for general arrangement
drawings.

Only grid labels visible shows only
the grid label and a short section of
the grid line. The length of the
displayed grid line depends on the
value entered in the Text placingbox.
In the drawing level, this option is
only available for general
arrangement drawings. On the view
and object level this option is
available for all types of drawings.

Text placing Sets the side to show the grid labels
and the length of the grid line
extension (the distance between the
end of the grid line and the text).
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Option Description
Text: Color, Height, Font and Frame Defines the grid label text color,

height, font and frame.

Other ways to adjust grids

Additionally, for example XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH
(page 198), XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR
(page 199) and XS_GRID_TEXT_FONT (page 257) allow you to adjust the
grid labels further.

3.4 Report settings
Use the Report dialog box to check or change the report settings.

Option Description
Report: Report templates Lists all the available report

templates.
Report:Titles in reports Optional report titles.

You can enter up to three report
titles. All the titles are not used in
every standard report. Title1, for
example, is used to show phase
information in the Assembly_list
report.

Report: Browse Use to change the folder where the
report will be stored. By default,
reports are stored in the current
model folder.

Show Shows the selected report.
Print Prints the selected report.
Create from all Creates a report from all objects in

the model using the selected
template.

Create from selected Creates a report from the objects you
have selected using the selected
template.
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Option Description
Options: Show report Defines how Tekla Structures displays

reports.

On dialog displays the report in a
new window.

With associated viewer displays the
report in the associated program. For
example, you can have Tekla
Structures open all HTML reports in a
web browser.

Options: Show created report Defines whether or not the report is
automatically shown on the screen
after it has been created.

3.5 Analysis and design settings
This section provides information about the various analysis and design
settings you can modify in Tekla Structures.

Click the links below to find out more:

Load group properties (page 733)

Load properties (page 735)

Load combination properties (page 741)

Analysis model properties (page 744)

Analysis part properties (page 750)

Analysis node properties (page 765)

Analysis rigid link properties (page 766)

Analysis bar position properties (page 767)

Analysis area position properties (page 768)

Analysis area edge properties (page 768)

Load group properties
Use the Load Groups dialog box to view, define, and modify the load group
properties and to work with load groups.
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Option Description
Current The @ character identifies the current load group.

When you create loads in the model, Tekla Structures
adds them to the current load group. You can only
define one load group as current.

To change the current load group, select a load group
and click Set current.

Name Unique name of the load group.

Use load group names to define the visibility and
selectability of loads. For example, you can select,
modify, or hide loads based on their load group.

Type The type of a load group is the type of action that
causes the loads.

Actions causing loads are building code specific and
depend on the load modeling code selected in File
menu --> Settings --> Options --> Load modeling -->
Current code.

Most building codes use some or all of the following
actions and load group types:

• Permanent, dead, and/or prestressing loads

• Live, imposed, traffic, and/or crane loads

• Snow loads

• Wind loads

• Temperature loads

• Accidental and/or earthquake loads

• Imperfection loads
Direction The direction of a load group is the global direction of

the action that causes the loads. Individual loads in a
load group retain their own magnitudes in the global
or local x, y, and z directions.

The load group direction affects which loads Tekla
Structures combines in a load combination:

• z direction groups are combined with both x and y
direction groups.

• x or y direction groups are not combined with each
other.

Compatible A number that identifies all the load groups that are
compatible with each other.

Incompatible A number that identifies all the load groups that are
incompatible with each other.
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Option Description
Color The color that Tekla Structures uses to show the loads

in the group.

Load properties
This section provides information about the properties of specific loads.

Use the load properties dialog boxes to view, define, and modify the load
properties. Each load type has its own properties dialog box.

Click the links below to find out more:

Point load properties (page 735)

Line load properties (page 736)

Area load properties (page 736)

Uniform load properties (page 737)

Temperature load properties (page 737)

Wind load properties (page 738)

Load panel settings (page 739)

Point load properties
Use the Point Load Properties dialog box to view and modify the properties
of a point load or a bending moment. The file name extension of a point load
properties file is .lm1.

Option Description
Load group name The load group to which the load belongs.

To view load group properties or to create a new load
group, click Load groups.

Magnitude tab Load magnitudes in the x, y, and z directions of the
work plane.

Load attachment Indicates if the load is attached to a part.
Load-bearing parts Parts to which the load is applied, or not applied, on

the basis of part names or selection filters.
Bounding box of the
load

Dimensions of the bounding box in the x, y, and z
directions.

Load panel tab See Load panel settings (page 739).
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Line load properties
Use the Line Load Properties dialog box to view and modify the properties of
a line load or a torsional moment. The file name extension of a line load
properties file is .lm2.

Option Description
Load group name The load group to which the load belongs.

To view load group properties or to create a new load
group, click Load groups.

Magnitude tab Load magnitudes in the x, y, and z directions of the
work plane.

Load form Defines how the load magnitude varies along the
loaded length.

Load attachment Indicates if the load is attached to a part.
Load-bearing parts Parts to which the load is applied, or not applied, on

the basis of part names or selection filters.
Bounding box of the
load

Dimensions of the bounding box in the x, y, and z
directions.

Distances Offsets from the load end points, used to shorten or
lengthen the loaded length.

To shorten the loaded length, enter positive values for
a and b. To lengthen the loaded length, enter negative
values.

Load panel tab See Load panel settings (page 739).

Area load properties
Use the Area Load Properties dialog box to view and modify the properties of
an area load. The file name extension of an area load properties file is .lm3.

Option Description
Load group name The load group to which the load belongs.

To view load group properties or to create a new load
group, click Load groups.

Magnitude tab Load magnitudes in the x, y, and z directions of the
work plane.

Load form Defines the shape of the loaded area.
Load attachment Indicates if the load is attached to a part.
Load-bearing parts Parts to which the load is applied, or not applied, on

the basis of part names or selection filters.
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Option Description
Bounding box of the
load

Dimensions of the bounding box in the x, y, and z
directions.

Distances Offset used to enlarge or reduce the loaded area.

To enlarge the loaded area, enter a positive value for
a. To reduce the loaded area, enter a negative value.

Load panel tab See Load panel settings (page 739).

Uniform load properties
Use the Uniform Load Properties dialog box to view and modify the
properties of a uniform load. The file name extension of a uniform load
properties file is .lm4.

Option Description
Load group name The load group to which the load belongs.

To view load group properties or to create a new load
group, click Load groups.

Magnitude tab Load magnitudes in the x, y, and z directions of the
work plane.

Load attachment Indicates if the load is attached to a part.
Load-bearing parts Parts to which the load is applied, or not applied, on

the basis of part names or selection filters.
Bounding box of the
load

Dimensions of the bounding box in the x, y, and z
directions.

Distances Offset used to enlarge or reduce the loaded area.
Load panel tab See Load panel settings (page 739).

Temperature load properties
Use the Temperature Load Properties dialog box to view and modify the
properties of a temperature load or a strain. The file name extension of a
temperature load properties file is .lm6.

Option Description
Load group name The load group to which the load belongs.

To view load group properties or to create a new load
group, click Load groups.

Temperature change for
axial elongation

Temperature change in the part.
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Option Description
Temperature
differential from side to
side

Difference in temperature between the left side and
the right side of a part.

Temperature
differential from top to
bottom

Difference in temperature between the top surface
and the bottom surface of a part.

Initial axial elongation Axial strain of a part.

A positive value indicates elongation, a negative value
indicates shrinkage.

Load attachment Indicates if the load is attached to a part.
Load-bearing parts Parts to which the load is applied, or not applied, on

the basis of part names or selection filters.
Bounding box of the
load

Dimensions of the bounding box in the x, y, and z
directions.

Wind load properties
Use the Wind Load Generator (28) dialog box to view and modify the
properties of wind loads.

Option Description
Wind load direction The main direction of the wind.

The options are:

• Global X

• Global -X

• Global Y

• Global -Y

• Global X, -X, Y, -Y (for all directions)
Nominal wind pressure The nominal value of wind pressure.
Top level The highest level of the wind loads.
Bottom level The lowest level of the wind loads.
Ground level The level of the ground around the building.
Part names Parts to which the load is applied, or not applied.

See also Define load-bearing parts by name.
Front The external exposure factors for the windward,

leeward, and side walls.

A positive value indicates pressure, a negative value
indicates suction.

Left side
Back
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Option Description
Right side
Internal The internal exposure factor.
Z profile tab The distribution of wind load along the height of the

building, in terms of pressure factors. Starts from the
ground level.

Global X, Global Y,
Global -X, Global -Y tabs

A tab for each wind direction, where you can define
zones for concentrated corner loads on each wall.

Each zone is the height of the wall. Define the width of
the zone using either dimensions or proportions. You
can define up to five zones for each wall.

Walls are numbered according to the order you pick
points to indicate the shape of the building on the
bottom level.

Load panel settings
Use the options on the Load panel tab in a load properties dialog box to
modify the way Tekla Structures distributes the load.

Option Description
Spanning Defines the directions in which Tekla Structures

distributes the load.

• Single distributes the load only in the direction of
the primary axis.

• Double distributes the load along the primary and
secondary axes.

Primary axis direction Defines the direction of the primary axis using one of
the following methods:

• A value (1) in the x, y, or z box distributes the load
in the corresponding global direction.

• Values in multiple boxes distribute the load
between the corresponding global directions. The
values are the components of the direction vector.

• Clicking Parallel to part, or Perpendicular to
part, and then selecting a part in the model aligns
the primary axis direction with the part.

If Spanning is Double, you need to define the primary
axis direction to be able to manually define the
primary axis weight.
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Option Description
To check the primary axis direction of a selected load
in a model view, click Show direction on selected
loads. Tekla Structures indicates the primary direction
using a red line.

Automatic primary axis
weight

Defines whether Tekla Structures automatically
weights the directions in load distribution.

The options are:

• Yes: Tekla Structures automatically calculates the
load portions for the primary and secondary
directions in proportion to the third power of the
span lengths in these two directions. This means
that the shorter the span, the bigger the
proportion of the load.

• No: You can enter the weight for the primary
direction in the Weight box. Tekla Structures
calculates the weight for the secondary direction
by subtracting this value from 1.

Load dispersion angle The angle by which the load is projected onto the
surrounding parts.

Use continuous
structure load
distribution

Use for uniform loads on continuous slabs. Defines
the distribution of support reactions in the first and
last spans.

The options are:

• Yes: The distribution of support reactions is 3/8
and 5/8.

• No: The distribution of support reactions is 1/2 and
1/2.
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Load combination properties
This section provides information about the settings that control the load
combination process.

Click the links below to find out more:

• Load modeling code options (page 741)

• Load combination factors (page 741)

• Load combination types (page 742)

Load modeling code options
These are the load modeling codes available in Tekla Structures in File menu
--> Settings --> Options --> Load modeling --> Current code:

Option Description
Eurocode European code
British British code
AISC (US) American Institute of Steel Construction, US code
UBC (US) Uniform building code, US code
CM66 (F) French code for steel structures
BAEL91 (F) French code for concrete structures
IBC (US) International building code, US code
ACI American Concrete Institute’s publication 318

Each of the available codes has a separate tab in the Options dialog box. The
Options dialog box lists the partial safety factors in limit states and other
combination factors for the code, based on load group types. For the
Eurocode, you can also set the reliability class factor and the formula to be
used in load combination.

See also

Load combination factors (page 741)

Load combination factors
In the load combination process, Tekla Structures uses partial safety factors
and, for example, reduction factors on load groups to create load
combinations.

The partial safety factors needed in the limit state design are:

• Unfavorable partial safety factor in the ultimate limit state (γsup)

• Favorable partial safety factor in the ultimate limit state (γinf)
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• Unfavorable partial safety factor in the serviceability limit state (γsup)

• Favorable partial safety factor in the serviceability limit state (γinf)

Depending on the codes you use, you may need to use other combination
factors. For example, the Eurocode contains three reduction factors (ψ0, ψ1, ψ2).
Reduction factors exclude the impractical effects of simultaneous loads.

You can use values for load combination factors that are building code specific
or user-defined.

See also

Load combination types
You can perform several load combination types which vary according to the
building code you use.

Use the Load Combination Generation dialog box, or the Load Combination
dialog box, to select the load combination types you want to create. The
options are:

Combination type Description Applies to
Ultimate limit state
(ULS)

Combines load groups that occur
persistently and transiently. Uses the
partial safety factors of the ultimate
limit state when combining loads.

Eurocode,
British, AISC
(US)

Serviceability limit state
(SLS)

Combines load groups that occur
quasi-permanently. Uses the partial
safety factors of the serviceability
limit state when combining loads.

Eurocode, AISC
(US)

Serviceability limit state
– Rare (SLS RC)

Combines load groups that occur
quasi-permanently and rarely. Uses
the partial safety factors of the
serviceability limit state when
combining loads.

Eurocode

Serviceability limit state
– Quasi-permanent (SLS
QP)

Combines load groups that occur
quasi-permanently. Uses the partial
safety factors of the serviceability
limit state when combining loads.

Eurocode

Normal loads Combines load groups and uses
factors according to the French codes
CM66 or BAEL91.

CM66, BAEL91
Extreme loads CM66
Displacement loads CM66
Accidental loads CM66,

Eurocode
Ultimate loads BAEL91
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Combination type Description Applies to
Ultimate accidental
loads

BAEL91

Earthquake loads Combines load groups and uses
factors according to the Eurocode.

Eurocode

Loads for public
structures

Combines load groups according to
the US IBC code (International
Building Code).

IBC (US)

Loads for public
structures with drifted
snow

IBC (US)

Loads for non public
structures

IBC (US)

Loads for non public
structures with drifted
snow

IBC (US)

Loads for public non
concrete and masonry
structures

Combines load groups according to
the US UBC code (Uniform Building
Code).

UBC (US)

Loads for public non
concrete and masonry
structures with drifted
snow

UBC (US)

Loads for non concrete
and masonry structures

UBC (US)

Loads for non concrete
and masonry structures
with drifted snow

UBC (US)

Loads for public
concrete and masonry
structures

UBC (US)

Loads for public
concrete and masonry
structures with drifted
snow

UBC (US)

Loads for concrete and
masonry structures

UBC (US)

Loads for concrete and
masonry structures
with drifted snow

UBC (US)

ACI Table 1 - ACI Table 8 Combines load groups according to
the ACI code (American Concrete
Institute’s publication 318).

ACI

See also
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Analysis model properties
Use the Analysis Model Properties dialog box to define, view, and modify the
properties of an analysis model. These properties apply to all parts in an
analysis model.

Analysis model tab

Option Description
Analysis application The analysis application or format used in the analysis

of the analysis model.

To use the same application or format by default for
other new analysis models, select the Set as the
default check box.

See also .
Analysis model name A unique name for the analysis model. User-definable.

For example, you can use a name that describes the
portion of the physical model that you want to
analyze.

To define the export folder for the analysis model,
click Browse for export folder.

Analysis model filter Defines which objects to include in the analysis model,
based on the list of available selection filters.

See also .
Bracing member filter Defines which of the included objects are considered

to be braces. The analysis nodes of braces can move
more freely than the ones of primary analysis parts
when the analysis model is created.

Secondary member
filter

Defines which of the included objects are considered
to be secondary analysis parts. The nodes of
secondary analysis parts can move more freely than
the ones of primary analysis parts when the analysis
model is created.

Analysis model content Defines which objects are included in the analysis
model.

The options are:
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Option Description
• Selected parts and loads

Only includes selected parts and loads, and parts
created by components, when they match the
analysis model filter.

To later add or remove parts and loads, use the
Add selected objects or Remove selected
objects button in the Analysis & Design Models
dialog box.

• Full model

Includes all main parts and loads, except for parts
whose analysis class (page 760) is Ignore. Tekla
Structures automatically adds physical objects to
the analysis model when they are created and
when they match the analysis model filter.

• Floor model by selected parts and loads

Only includes selected columns, slabs, floor beams,
and loads when they match the analysis model
filter. Tekla Structures replaces columns in the
physical model with supports.

See also Analysis model content.
Use rigid links Use to allow or prevent rigid links in the analysis

model.

The options are:

• Enabled

Rigid links are created if they are needed to
connect analysis parts.

• Disabled, with keep axis: Default

No rigid links are created. The Keep axis position
settings of the analysis parts are not changed.

• Disabled, with keep axis: No

No rigid links are created. The Keep axis position
settings of the connected analysis parts are
changed to No.

If you use Tekla Structural Designer as the analysis
application, you can use the Enabled option for
concrete parts. The Disabled, with keep axis:
Default option is automatically used for steel parts.

Analysis model rules Click to create rules to define how Tekla Structures
handles individual parts in the analysis model, and
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Option Description
how parts are connected with each other in the
analysis.

Curved beams Defines whether beams are analyzed as curved beam
or as straight segments. Select either:

• Split into straight segments

• Use curved member

Use the advanced option XS_AD_CURVED_BEAM_
SPLIT_ACCURACY_MM (page 56) in File menu -->
Settings --> Advanced Options --> Analysis & Design
to define how closely straight segments follow the
curved beam.

Consider twin profiles Defines whether twin profiles are considered as one
part (Enabled) or as two parts (Disabled) in the
analysis.

Member axis location Defines the location of each analysis part in relation to
the corresponding physical part.

The options are:

• Neutral axis

The neutral axis is the analysis axis for all parts.
The location of the analysis axis changes if the
profile of the part changes.

• Reference axis (eccentricity by neutral axis)

The part reference line is the analysis axis for all
parts. The location of the neutral axis defines axis
eccentricity.

• Reference axis

The part reference line is the analysis axis for all
parts.

• Model default

The analysis axis of each part is defined
individually according to the analysis part
properties.

To define the axis location of specific parts, use the
Position tab in the appropriate analysis part
properties dialog box.

If you select Neutral axis, Tekla Structures takes the
part location and end offsets into account when it
creates nodes. If you select either of the Reference
axis options, Tekla Structures creates nodes at part
reference points.
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Option Description
Member end release
method by connection

Defines whether the support conditions of parts (No)
or connections (Yes) are used.

Automatic update Defines if the analysis model is updated according to
the changes in the physical model.

The options are:

• Yes - Physical model changes are considered

• No - Physical model changes are ignored
Model merging with
analysis application

Only use with SAP2000 when changes occur in the
Tekla Structures physical or analysis model that has
already been exported to the analysis application.

Defines whether the changed analysis model is
merged with the previously exported model in the
analysis application.

The options are:

• Disabled

Models are not merged. Additions made in the
analysis application to the previously exported
model are lost. A new model is created every time
you export the analysis model to the analysis
application.

• Enabled

Models are merged. Additions made in the analysis
application to the previously exported model are
retained when you re-export the analysis model to
the analysis application. The model in the analysis
application is updated with the changes from Tekla
Structures.

Analysis tab

Option Description
Analysis method Defines whether second order stresses are taken into

consideration.

The options are:

• 1st order

Linear analysis method.

• P-Delta

A simplified second order analysis method. This
method gives accurate results when deflections are
small.
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Option Description
• Non-linear

Non-linear analysis method.
Maximum number of
iterations

Tekla Structures repeats second order iteration until it
reaches one of these values.

Accuracy of the
iteration
Modal analysis model Select Yes to create a modal analysis model and to

use modal analysis properties instead of static load
combinations.

Job tab

Defines the job information in STAAD.Pro reports.

Output tab

Defines the contents of the STAAD.Pro analysis results file.

Seismic tab

Use the Seismic tab to define which building code to follow in the seismic
analysis and the properties required by the seismic analysis. These properties
vary depending on the code you select.

Option Description
Type The building code to use to generate seismic loads.

The options are:

• None: Seismic analysis not run.

• UBC 1997: Uniform Building Code 1997

• UBC 1994: Uniform Building Code 1994

• IBC 2000: International Building Code 2000

• IS 1893-2002: Indian Standard. Criteria for
Earthquake Resistant Design of Structures

• IBC 2003: International Building Code 2003

• IBC 2006: International Building Code 2006

• IBC 2006 (ZIP): International Building Code 2006,
with an option to add a ZIP code in the properties

• IBC 2006 (Longitude/Latitude): International
Building Code 2006, with an option to add
longitude and latitude information in the
properties

• AIJ: Japanese code
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Option Description
• Response spectrum: Response spectrum

specification
Seismic properties Depending on the code you select, you can define

various seismic properties.

Seismic masses tab

The loads and load groups included in the seismic analysis.

Modal analysis tab

Use the Modal analysis tab to define the properties required by the modal
analysis.

Option Description
Count of modes The number of natural mode shapes in the structure.
Max frequency The maximum natural resonant frequency of the

structure.
Modal analysis masses The loads and load groups included in the modal

analysis.

Design tabs

Use the Design tabs for steel, concrete, and timber to define the codes and
methods to use in structural design. The design options available vary
depending on the material.

Option Description
Design code Design codes for different materials.

The design code options available vary depending on
the analysis application you use.

Design method The material-specific principle used to compare
stresses and material capacities.

The options are:

• None

Tekla Structures only runs a structural analysis and
creates data on stresses, forces, and
displacements.

Available for steel, concrete, and timber.

• Check design

Tekla Structures checks whether the structures
fulfill the criteria in the design code (whether cross
sections are adequate).

Available for steel and timber.
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Option Description
• Calculate required area

Tekla Structures defines the required area of
reinforcement.

Available for concrete.
Design properties The design code and method specific design

properties of the analysis model that apply to all parts
in the analysis model.

When you select a design code and method for a
material, Tekla Structures lists the design properties in
the lower part of the Design tab.

To change the value of a particular property, click on
an entry in the Value column.

The units depend on the settings in File menu -->
Settings --> Options --> Units and decimals .

To change the design properties of a specific part, use
the Design tab in the appropriate analysis part
properties dialog box.

Analysis part properties
Use the options in a part’s analysis properties dialog box (for example, Beam
Analysis Properties) to define how Tekla Structures handles the part in the
analysis. The settings you have available in the dialog box vary depending on
the part type and analysis class. The table below lists all settings regardless of
the part type and the analysis class.

Analysis tab

Use the Analysis tab to define the analysis properties of a part.

Option Description
Class Defines how the part is handled in the analysis.

The selected Class defines which analysis properties
are available. For example, plates have different
properties from columns.

Filter

(Rigid diaphragm
properties)

Only available when the Class is Contour plate - Rigid
diaphragm or Slab - Rigid diaphragm.

Defines the filter used when filtering objects for a rigid
diaphragm.

Nodes that belong to a part matching the filter will be
connected to the rigid diaphragm. For example, you
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Option Description
can use a column filter to connect only column nodes
to rigid diaphragms.

Built-up section mode Indicates the role of the part in a built-up section that
consists of a main part and one or more sub-parts. In
the analysis, sub-parts are merged to the main part.

The options are:

• Automatic

• Not part of built-up section

Disconnects the part from a built-up section.

• Main part of built-up section

Always use to define the main part of a built-up
section.

• Sub-part of built-up section

• Beam sub-part of built-up section

Defines that the part is a part of the built-up
section when the main part of the built-up section
is a beam.

• Column sub-part of built-up section

Defines that the part is a part of the built-up
section when the main part of the built-up section
is a column.

Design group Defines to which design group the part belongs. Used
in optimization.

Automatic update Defines if the analysis part is updated according to the
changes in the physical model.

The options are:

• Yes - Physical model changes are considered

• No - Physical model changes are ignored

Start releases tab, End releases tab

Use the Start releases and End releases tabs to define the support
conditions and the degrees of freedom for the part ends.

The Start releases tab relates to the first part end (yellow handle), the End
releases tab to the second part end (magenta handle).
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Option Description
Start or End Defines which of the predefined or user-defined

combinations for end conditions is used for part start
or end.

These are the predefined options:

 (Not available with Tekla Structural Designer)

 (Not available with Tekla Structural Designer)

They automatically set the support condition and
degrees of freedom.

You can modify a predefined combination to suit your
needs. If you do that, Tekla Structures indicates it with
this option:

Support condition Not available with Tekla Structural Designer.

Defines the support condition.

The options are:

• Connected

Part end is connected to an intermediate analysis
node (another part).

Indicate degrees of freedom for the node.

• Supported
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Option Description
Part end is the ultimate support for a
superstructure (for example, the foot of a column
in a frame).

Indicate degrees of freedom for the support.
Rotation Only available if Support condition is Supported.

Defines whether the support is rotated.

The options are:

• Not rotated

• Rotated

If you select Rotated, you can define the rotation
around the local x or y axis, or you can set the rotation
by the current work plane by clicking Set rotation by
current work plane.

Ux

Uy

Uz

Define the translational degrees of freedom
(displacements) in the global x, y, and z directions.

The options are:

• Free

• Fixed

• Spring

If you select Spring, enter the translational spring
constant. The units depend on the settings in File
menu --> Settings --> Options --> Units and
decimals .

Rx

Ry

Rz

Define the rotational degrees of freedom (rotations) in
the global x, y, and z directions.

The options are:

• Pinned

• Fixed

• Spring

• Partial release

If you select Spring, enter the rotational spring
constant. The units depend on the settings in File
menu --> Settings --> Options --> Units and
decimals .

Use Partial release to specify if the degree of
connectivity is between fixed and pinned. Enter a
value between 0 (fixed) and 1 (pinned).
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Composite tab

Use the Composite tab with STAAD.Pro to define the analysis properties of
the slab in a composite beam.

Option Description
Composite beam Defines whether the composition is a:

• Non-composite beam

• Composite beam

• Automatic composite beam
Material Defines the material of the slab.
Thickness Defines the thickness of the slab.
Effective slab width Defines if the effective slab width is calculated

automatically or based on the values you enter.

You can define different values for the left and right
side of the beam.

Automatic values are calculated in relation to the span
length.

Spanning tab

Use the Spanning tab to define the analysis and load distribution properties
of a one-way or two-way slab system.

Option Description
Spanning Defines in which directions the part carries loads.

The options are:

• Single spanning plate carries loads in the direction
of the primary axis. Beams or columns parallel to
the spanning direction are not connected to the
part, and will not carry loads from the part.

• Double spanning part carries loads along the
primary and secondary axes. Beams or columns in
both directions will carry loads from the part.

Primary axis direction Defines the direction of the primary axis in one of the
following ways:

• Enter 1 in the box (x, y, or z) which is parallel to the
primary axis direction.

• Enter values in multiple boxes to define the
components of a direction vector.

• Click Parallel to part, and then select a part in the
model that is parallel to the direction.
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Option Description
• Click Perpendicular to part, and then select a part

in the model that is perpendicular to the direction.

To check the primary spanning direction of a selected
part in a model view, click Show direction on
selected members. Tekla Structures indicates the
primary direction using a red line.

Loading tab

Use the Loading tab to include a part as loads in analysis models.

Option Description
Generate self weight
load

Analysis models include the part weight, for example a
deck, as a load even if the part is not otherwise
included in the analysis models.

If the part is included in an analysis model, so is its
self-weight. The option No works only with the
analysis classes Ignore and Rigid diaphragm.

List boxes for additional
loads

Enter slab live load or additional self-weight (screed,
services) using three additional loads with a load
group name and magnitude. The directions of these
loads follow the direction of the load group to which
they belong.

Part names Use this filter to ensure that the area load from the
slab is transferred to the correct parts, for example,
beams supporting the slab. Typically, you would enter
the beam name as the filter value.

Use continuous
structure load
distribution

Use to assign most of the load to the middle supports
on continuous structures.
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Design tab

Use the Design tab in the analysis part properties dialog box to view and
modify the design properties of an individual part in an analysis model. Design
properties are properties which can vary, according to the design code and the
material of the part (for example, design settings, factors, and limits).

Position tab

Use the Position tab to define the location and offsets of an analysis part.

Option Description
Axis Defines the location of the analysis part in relation to

the corresponding physical part.

The location of the analysis axis of a part defines
where the part meets with other parts and where
Tekla Structures creates nodes in analysis models.

The options are:

If you select Neutral axis, Tekla Structures takes the
part location and end offsets into account when it
creates nodes. If you select either of the Reference
axis options, Tekla Structures creates nodes at part
reference points.

Keep axis position Defines whether the axis position is kept or changed
according to changes in the physical model.

The options are:
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Option Description
• No

The axis is free to move when snapping end
positions to nearby objects. Use this option for
secondary members.

• Partial - keep in major direction

The axis is free to move partially, but the member
is not moved in the major (stronger) direction of
the part profile.

• Partial - keep in minor direction

The axis is free to move partially, but the member
is not moved in the minor (weaker) direction of the
part profile.

• Yes

The axis is not moved, but the end positions can
move along the axis (thus extending or shortening
the member).

• Yes - Keep end positions also

The axis and the end positions of the member are
not changed.

Connectivity Defines whether the member snaps or connects with
rigid links to other members.

The options are:

• Automatic

The member snaps or connects with rigid links to
other members.

• Manual

The member does not snap or connect with rigid
links to other members. Automatic connectivity to
other members is created only if the member
position matches the other member exactly.

Axis modifier X

Axis modifier Y

Axis modifier Z

Define whether the member location is bound to
global coordinates, grid line, or neither.

The options are:

• None

The member location is not bound.

• Fixed coordinate

The member location is bound to the coordinate
you enter in the X, Y, or Z box.
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Option Description
• Nearest grid

The member is bound to the nearest grid line (the
snap zone is 1000 mm).

Offset Use to move the analysis part in the global x, y, and z
directions.

Longitudinal offset
mode

Defines whether the longitudinal end offsets Dx of the
physical part are used from the physical part
properties.

The options are:

• Offsets are not considered

• Only extensions are considered

• Offsets are always considered

Bar attributes tab

Use the Bar attributes tab in a frame object’s (beam, column, or brace)
analysis properties dialog box to define the properties of its analysis bars.

You can use the options on this tab when the analysis class of the analysis part
is Beam, Column, or Secondary.

Option Description
Start offset

End offset

Calculate offsets to account for longitudinal
eccentricity at the member end (resulting in a bending
moment).

These offsets have no effect on the topology on the
analysis model. The offset value is only passed as a
member attribute to the analysis.

Replacement profile
name

Select a profile from the profile catalog. You can use
different analysis profiles at the start and end of parts
if the analysis application you use supports it.

To use different profiles at part ends, enter two
profiles separated by a pipe character, for example:
HEA120|HEA140
If the part is a built-up section in an analysis model,
the name of the built-up section can be entered here.
Any name can be entered, but if the name matches an
existing catalog profile name, the physical properties
of the section will be the same as the catalog profile
properties.

Curved beam mode Defines whether a beam is analyzed as a curved beam
or as straight segments.

The options are:
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Option Description
• Use model default

• Use curved member

• Split into straight segments

If you select Use model default, Tekla Structures uses
the option selected from the Curved beams list in the
Analysis Model Properties dialog box.

Use the advanced option
XS_AD_CURVED_BEAM_SPLIT_ACCURACY_MM
(page 56) in File menu --> Settings --> Advanced
Options --> Analysis & Design to define how closely
straight segments follow the curved beam.

No. of split nodes Use to create additional nodes or analyze a beam as
straight segments, for example, a curved beam.

Enter the number of nodes.
Split distances To define additional nodes in the member, enter

distances from the part starting point to the node.

Enter distances, separated by spaces, for example:

1000 1500 3000
Bar start number Defines the start number for analysis bars.
Member start number Defines the start number for analysis members.

Area attributes tab

Use the Area attributes tab in a plate’s (contour plate, concrete slab, or
concrete panel) analysis properties dialog box to define the properties of its
analysis elements.

You can use the options on this tab when the analysis class of the analysis part
is Contour plate, Slab, or Wall.

Option Description
Element type The shape of the elements.
Rotation of local XY Defines the rotation of the local xy plane.
Element size x and y: The approximate dimensions of the elements,

in the local x and y direction of the plate. For
triangular elements, the approximate dimensions of
the bounding box around each element.

Holes: The approximate size of the elements around
openings.

Area start number Defines the start number for the plate.
Simple area (ignore cuts
etc)

Select Yes to create a simpler analysis model of the
plate, where cuts and openings are not considered.
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Option Description
Smallest hole size to
consider

Use to ignore small openings in the plate in the
analysis.

Enter the size of the bounding box around the
opening.

Supported Not available with Tekla Structural Designer.

Use to define supports for a contour plate, concrete
slab, or concrete panel.

You can create supports for the bottom edge of a
panel, for all edge nodes of a slab or plate, or for all
nodes of a beam. For panels, the bottom edge can be
inclined.

The options are:

• No

No supports are created.

• Simply (translations)

Only translations are fixed.

• Fully

Both translations and rotations are fixed.

See also

Analysis class options and colors (page 760)

Analysis axis options (page 763)

Analysis class options and colors
Use the options in the Class list on the Analysis tab in a part’s analysis
properties dialog box to define how Tekla Structures handles the part in the
analysis.

The option you select in the Class list determines which tabs are available in
the analysis part properties (page 750) dialog box.

When the advanced option XS_AD_MEMBER_TYPE_VISUALIZATION (page 62) is
set to TRUE (which is the default value), you can show the analysis class of
parts using the following colors in the analysis model. You can also indicate
the analysis classes using different colors in the physical model.

The analysis application you use may not support all of the following options.
For example, the Truss options are not available with Tekla Structural
Designer.
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Option Description Color
Beam Line object of two nodes.

Part can take any load, including temperature.

Blue

Beam - Truss Part can only take axial forces, not bending or
torsion moments, or shear forces.

Bright
green

Beam - Truss-
Compression
only

Part can only take compressive axial forces, not
moments or shear forces. If this part goes into
tension, it is ignored in the analysis.

Yellow

Beam - Truss-
Tension only

Part can only take tensile axial forces, not
moments or shear forces. If this part goes into
compression, it is ignored in the analysis.

Pink

Beam - Ignore Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Part not
shown in
the model

Column Vertical line object of two nodes. Modeled from
bottom to top.

Part can take any load, including temperature.

Blue

Column - Truss Part can only take axial forces, not bending or
torsion moments, or shear forces.

Bright
green

Column - Truss-
Compression
only

Part can only take compressive axial forces, not
moments or shear forces. If this part goes into
tension, it is ignored in the analysis.

Yellow

Column - Truss-
Tension only

Part can only take tensile axial forces, not
moments or shear forces. If this part goes into
compression, it is ignored in the analysis.

Pink

Column - Ignore Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Part not
shown in
the model

Bracing Line object of two nodes.

Part can take any load, including temperature.

For parts whose analysis class is Bracing, Keep
axis position is off by default.

Green

Bracing - Truss Part can only take axial forces, not bending or
torsion moments, or shear forces.

Bright
green

Bracing - Truss-
Compression
only

Part can only take compressive axial forces, not
moments or shear forces. If this part goes into
tension, it is ignored in the analysis.

Yellow
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Option Description Color
Bracing - Truss-
Tension only

Part can only take tensile axial forces, not
moments or shear forces. If this part goes into
compression, it is ignored in the analysis.

Pink

Bracing - Ignore Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Part not
shown in
the model

Secondary Line object of two nodes.

Part can take any load, including temperature.

For parts whose analysis class is Secondary, Keep
axis position is off by default. Secondary parts
snap to nearest nodes instead of part end nodes.

Orange

Secondary -
Ignore

Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Part not
shown in
the model

Wall - Shell Part can take any load, except temperature. Aqua
Wall - Plate Same as Wall - Shell but plate elements are used

in the analysis application.
Aqua

Wall - Shear
wall

Part can take lateral forces and vertical forces. Aqua

Wall - Ignore Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Aqua

Slab - Shell Part can take any load, except temperature. Aqua
Slab - Plate Same as Slab - Shell but plate, membrane, or mat

foundation elements are used in the analysis
application.

Aqua
Slab -
Membrane
Slab - Mat
foundation
Slab - Rigid
diaphragm

Only applies to parts parallel to a global xy plane.

Filter: Nodes that belong to a part matching the
filter will be connected with rigid links which
together affect displacement. For example, you can
use a column filter to connect only column nodes
to rigid diaphragms.

Lilac

Settings reference 762 Analysis and design settings



Option Description Color
Slab - Ignore Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Part not
shown in
the model

Contour plate -
Shell

Part can take any load, except temperature. Aqua

Contour plate -
Plate

Same as Contour plate - Shell but plate or
membrane elements are used in the analysis
application.

Aqua

Contour plate -
Membrane

Aqua

Contour plate -
Rigid
diaphragm

Only applies to parts parallel to a global xy plane.

Filter: Nodes that belong to a part matching the
filter will be connected with rigid links which
together affect displacement. For example, you can
use a column filter to connect only column nodes
to rigid diaphragms.

Lilac

Contour plate -
Ignore

Part is ignored in the analysis.

Self-weight load is taken into account if you have
set Generate self weight load to Yes on the
Loading tab.

Part not
shown in
the model

Analysis axis options
Use the options in the Axis list on the Position tab in a part’s analysis
properties dialog box to define the location of the analysis part in relation to
the physical part.

Option Description Use for
Neutral axis The neutral axis is the analysis axis

for this part. The location of the
analysis axis changes if the profile of
the part changes.

 

Reference axis
(eccentricity by neutral
axis)

The part reference line is the analysis
axis for this part. The location of the
neutral axis defines the axis
eccentricity.

 

Reference axis The part reference line is the analysis
axis for this part.

 

Top left The analysis axis is located in the top
left corner of the part.

Beam objects
(beams,
columns,
braces)

Settings reference 763 Analysis and design settings



Option Description Use for
Top center The analysis axis is located in the top

center point of the part cross section.
Beam objects

Top right The analysis axis is located in the top
right corner of the part.

Beam objects

Middle left The analysis axis is located in the
middle of the left side of the part.

Beam objects

Middle center The analysis axis is located in the
center point of the part cross section.

Beam objects

Middle right The analysis axis is located in the
middle of the right side of the part.

Beam objects

Bottom left The analysis axis is located in the
bottom left corner of the part.

Beam objects

Bottom center The analysis axis is located in the
bottom center point of the part cross
section.

Beam objects

Bottom right The analysis axis is located in the
bottom right corner of the part.

Beam objects

Top plane The analysis axis is bound to the top
plane.

Plate objects
(plates, slabs,
panels)

Middle plane The analysis axis is bound to the
middle plane.

Plate objects

Bottom plane The analysis axis is bound to the
bottom plane.

Plate objects

Left plane The analysis axis is bound to the left
plane.

Plate objects

Right plane The analysis axis is bound to the right
plane.

Plate objects

Middle plane (of left/
right)

The analysis axis is bound to the
middle plane of left/right.

Plate objects

Tekla Structures uses the options above for each part when you select Model
default from the Member axis location list in the Analysis Model
Properties dialog box.

If you select Neutral axis, Tekla Structures takes the part location and end
offsets into account when it creates nodes. If you select either of the
Reference axis options, Tekla Structures creates nodes at part reference
points.

See also

Analysis part properties (page 750)

Analysis model properties (page 744)
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Analysis node properties
Use the Analysis node properties dialog box to view and modify the
properties of a node in an analysis model.

To access the dialog box, double-click an analysis node.

Option Description
Supports Defines which support conditions are used for the

node.

The options are:

• Get supports from part(s)

The support conditions of a corresponding part
end are used for the node.

• User-defined node supports

You can define the support conditions for the
node.

If you select User-defined node supports, you can
select one of the following options:

These options automatically set the degrees of
freedom for the node.

You can modify a predefined combination to suit your
needs. If you do that, Tekla Structures indicates it with
this option:

Rotation If you selected User-defined node supports, you can
define the rotation of the node.

The options are:

• Not rotated

• Rotated

If you select Rotated, you can define the rotation, or
you can set the rotation by the current work plane by
clicking Set rotation by current work plane.
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Option Description
Ux

Uy

Uz

Rx

Ry

Rz

Define the translational (U) and rotational (R) degrees
of freedom (displacements and rotations) of the node
in the global x, y, and z directions.

The options are:

• Free

• Fixed

• Spring

If you select Spring, enter the spring constant. The
units depend on the settings in File menu --> Settings
--> Options --> Units and decimals .

See also

Analysis rigid link properties
Use the Analysis rigid link properties dialog box to view and modify the end
conditions of a rigid link.

To access the dialog box, double-click a rigid link.

Option Description
Releases Defines which releases are used for a rigid link start or

end.

The options are:

• Automatic releases (by rules)

• User-defined releases
Start or End Defines which of the predefined or user-defined

combinations for releases is used for a rigid link start
or end.

These are the predefined options:

These options automatically set the degrees of
freedom.
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Option Description
You can modify a predefined combination to suit your
needs. If you do that, Tekla Structures indicates it with
this option:

Ux

Uy

Uz

Define the translational degrees of freedom
(displacements) in the global x, y, and z directions.

The options are:

• Free

• Fixed

• Spring

If you select Spring, enter the translational spring
constant. The units depend on the settings in File
menu --> Settings --> Options --> Units and
decimals .

Rx

Ry

Rz

Define the rotational degrees of freedom (rotations) in
the global x, y, and z directions.

The options are:

• Pinned

• Fixed

• Spring

• Partial release

If you select Spring, enter the rotational spring
constant. The units depend on the settings in File
menu --> Settings --> Options --> Units and
decimals .

Use Partial release to specify if the degree of
connectivity is between fixed and pinned. Enter a
value between 0 (fixed) and 1 (pinned).

Local Y direction Defines the local y direction of the rigid link. The
options are the global x, y, and z directions.

The local x direction is always the direction of the rigid
link.

See also
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Analysis bar position properties
Use the Analysis Bar Position Properties dialog box to view and modify the
position of an analysis bar.

To access the dialog box, select an analysis bar, and then double-click a handle
at an end of the analysis bar.

Option Description
Offset mode Defines whether the automatic (Automatic offset) or

user-defined (Manual offset) offset values are used
for the analysis bar end.

Offset Defines the offset values in the global x, y, and z
directions.

See also

Analysis area position properties
Use the Analysis Area Position Properties dialog box to view and modify the
position of an analysis area.

To access the dialog box, select an analysis area, and then double-click a
handle at an analysis area corner.

Option Description
Offset mode Defines whether the automatic (Automatic offset) or

user-defined (Manual offset) offset values are used
for the analysis bar end.

Offset Defines the offset values in the global x, y, and z
directions.

See also
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Analysis area edge properties
Use the Analysis Area Edge Properties dialog box to view and modify the
position and connectivity of an analysis area edge.

To access the dialog box, select an analysis area, and then double-click a
handle at the mid-point of an analysis area edge.

Option Description
Offset mode Defines whether the automatic (Automatic offset) or

user-defined (Manual offset) offset values are used
for the analysis bar end.

Offset Defines the offset values in the global x, y, and z
directions.

Releases Defines which of the predefined or user-defined
combinations for releases is used for the analysis area
edge.

These are the predefined options:

These options automatically set the degrees of
freedom.

You can modify a predefined combination to suit your
needs. If you do that, Tekla Structures indicates it with
this option:

Ux

Uy

Uz

Define the translational degrees of freedom
(displacements) in the global x, y, and z directions.

The options are:

• Free

• Fixed

• Spring

If you select Spring, enter the translational spring
constant. The units depend on the settings in File
menu --> Settings --> Options --> Units and
decimals .
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Option Description
Rx

Ry

Rz

Define the rotational degrees of freedom (rotations) of
a member end in the global x, y, and z directions.

The options are:

• Pinned

• Fixed

• Spring

• Partial release

If you select Spring, enter the rotational spring
constant. The units depend on the settings in File
menu --> Settings --> Options --> Units and
decimals .

Use Partial release to specify if the degree of
connectivity is between fixed and pinned. Enter a
value between 0 (fixed) and 1 (pinned).

See also
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4 Predefined parametric profiles
available in Tekla Structures

The below predefined parametric profiles are available in Tekla Structures.

The profiles are listed in the same order as they appear in the profile catalog
in the default environment.

To change how the profiles are grouped in the profile catalog, modify the
profile catalog rules.

4.1 I profiles

HIh-s-t*b (symmetric)

HIh-s-t1*b1-t2*b2

HIh1-h2-s-t*b

HIh1-h2-s-t1*b1-t2*b2

Predefined parametric profiles available in Tekla
Structures

771 I profiles



4.2 I beams (steel)

I_BLT_Ah-b1-s1-t1*h2-b2-s2-t2

I_BLT_B h*b1*t1*s-b2*t2

I_HEMh*b*c*s*t

I_VAR_Ah1-ht*b1-bt*s*t

4.3 L profiles

Lh*b*t

Predefined parametric profiles available in Tekla
Structures

772 L profiles



4.4 Z profiles

BENTZ h*b*d*t[-a]

Z h*b*t

Z_VAR_A h1*b1*b2-s-h2*b3

Z_VAR_B h1*b1*b2-s-h2*b3

Z_VAR_C h1*b1*b2-s-h2*b3

Predefined parametric profiles available in Tekla
Structures

773 Z profiles



4.5 U profiles

Uh*b*t

4.6 C profiles

Ch*b*t

C_BUILTh*b*s*t

C_VAR_Ah1*b1-s-h2*b2

C_VAR_Bh1*b1-s-h2*b2

Predefined parametric profiles available in Tekla
Structures

774 C profiles



C_VAR_Ch1*b1-s-h2*b2

C_VAR_Dh-b-d-c-s

4.7 T profiles

Th-s-t-b

4.8 Welded box profiles

HK h-s-t*b-c

HKh-s-t1*b1-t2*b2-c

4.9 Welded beam profiles

B_WLD_A h*b*s*t

Predefined parametric profiles available in Tekla
Structures

775 T profiles



B_WLD_B h*b*s*t

B_WLD_C h*s

B_WLD_D h*b*s*t

B_WLD_E h*b*s*t

B_WLD_F h*b*s*[t]

B_WLD_G h*b*s*t*a

Predefined parametric profiles available in Tekla
Structures

776 Welded beam profiles



B_WLD_H h*bo*bu*s*to*tu

B_WLD_I h*bo*s*to*bu*tu*a

B_WLD_J h1*h2*b*s*t

B_WLD_K h1*h2*b*s*t

B_WLD_L h*wt*wb*s*tt*tb

B_WLD_M h1*p1*p2*p3*p4

Predefined parametric profiles available in Tekla
Structures

777 Welded beam profiles



B_WLD_N
p1*p2*p3*p4*p5*p6*p7*p8*p9

B_WLD_O
b1*h1*b4*h5*b7*h6*P1*P2

B_WLD_P
W*H*FT*WT*TPT*TPW*BPT*BPW

4.10 Box profiles

B_BUILTh*b*s*t

Predefined parametric profiles available in Tekla
Structures

778 Box profiles



B_VAR_Ah1-h2*t

B_VAR_Bh1-h2*t

B_VAR_Ch1-h2*t

4.11 WQ profiles

HQh-s-t1*t2*b2

HQh*s-t1*b1-t2*b2-c

4.12 Rectangular sections

PLh*b

h=height

b=thickness

(smaller=b)

Predefined parametric profiles available in Tekla
Structures

779 WQ profiles



4.13 Circular sections

Dd

ELDd1*r1*d2*r2

4.14 Rectangular hollow sections

Ph*t (symmetric)

Ph*b*t

Ph1*b1-h2*b2*t

Predefined parametric profiles available in Tekla
Structures

780 Circular sections



4.15 Circular hollow sections

PDd

PDd1*d2*t

EPDd1*r1*d2*r2*t

4.16 Cold rolled profiles

ZZh-t-e-b (symmetric)

ZZh-t-e1-b1-e2-b2

CCh-t-e-b (symmetric)

CCh-t-e1-b1-e2-b2

Predefined parametric profiles available in Tekla
Structures

781 Cold rolled profiles



CW h-t-e-b-f-h1 (symmetric)

CW h-t-e1*b1-f1-f2-e2*b2

CUh-t-h1-b-e (symmetric)

CUh-t-h1-b1-h2-b2-e

EBh-t-e-b-a

EBh-t-e1-b1-e2-b2-a

Reference points: 1=right

2=left

3=top

BFh-s-b-h1

SPDd*t

SPDd2*d2*t

Predefined parametric profiles available in Tekla
Structures

782 Cold rolled profiles



ESPD d1-d2*t

ECh-t-e-b-a

ECh-t-e1-b1-e2-b2-a

EDh-t-b-e-h1-h2-f1-f2-a

EEh-t-e-b-f1-f3-h1-f2-a

EFh-t-e-b1-b2-f1-f2/h1-a

Predefined parametric profiles available in Tekla
Structures

783 Cold rolled profiles



EZh-t-e-b-f1-f3-h1-f2-a

EWh-t-e-b1-b2-f1-f2-h2-h1-a

4.17 Folded plates

FFLAa-b-t

FPANBh-b-t

FPANB_-b-t

FPANBAh-b-t

FPANBA_h-b-t

FPANBBh-c-d-t

Predefined parametric profiles available in Tekla
Structures

784 Folded plates



FPANCVb-c-d-t

FPANGh-b-c-t

FPANGAh-b-c-t

FPANJa-b-c-t

FPANJa-b-c-t

FPAN a-b-c-t-g

FPANVVa-b-c-t-g

Predefined parametric profiles available in Tekla
Structures

785 Folded plates



FP_Ah-b-c-d-g

FP_AAh*b2*t*a

FP_Bh-b-c-d-g-i

FP_BBh-b-d

FP_Cb-h-c

FP_CCh-b-a-d-s

Predefined parametric profiles available in Tekla
Structures

786 Folded plates



FP_Db-h-c-d-f-g-i-j-s

FP_Eb-h-c-d-f-g-s

FP_Fb-h-c-d-f-g-s

FP_Gb-h-c-d-f-g-s

FP_Hb-h-c-d-f-s

FP_Ib-h-c-d-f-s

Predefined parametric profiles available in Tekla
Structures

787 Folded plates



FP_Jb-h-c-d-a

FP_Kb-h-c-d

FP_Lb-h-c-d-f-s

FP_Mb-h-c-d-s

FP_Nb-h-c-d

FP_Ob-h-c-d-s

Predefined parametric profiles available in Tekla
Structures

788 Folded plates



FP_Pa1*a2*h-b1*b2-Alpha1-Alpha2-
Beta1-Beta2-s

FP_Qb-h-c-d-s

FP_Rb-h-c-d

FP_Sb-h-c-s

FP_Tb-h-a-d-s

FP_Ub-h-a-d-s

Predefined parametric profiles available in Tekla
Structures

789 Folded plates



FP_Vb-h-s-c

FP_Wb-h-a-d-s

FP_WWh-b-a-c-s

FP_Yh-b-c-d

FP_Zd-h-b-s-a-f

Predefined parametric profiles available in Tekla
Structures

790 Hat profiles



4.18 Hat profiles

HAT h*a*c*t

HATCa-b-c-b1-h-b3-b4-b5-s

HATAb1*h1*h2*h3*h4*h5*h6*b2*t*f
*a*h*b

HATBb*b1*b2*h*h1*h2*h3*h4*t*f*a

Predefined parametric profiles available in Tekla
Structures

791 I beams (concrete)



4.19 I beams (concrete)

HIIh1*b1*t1-h2-s-b2*t2[-sft[-sfb]]

IIh*b1*t1-s-b2*t2[-sft[-sfb]]

SIIh1*b1*t1-h2-s-b2*t2[-sft[-sfb]]

4.20 Ledger beams (concrete)

RCLs*h-b*t

Predefined parametric profiles available in Tekla
Structures

792 Ledger beams (concrete)



RCDLs*h-b*t

RCDLs*h-b*t1*t2

RCDXs*h-b*h2*h1

RCDXs*h-b*h4*h3*h2*h1

RCDXs*h-b*h4*h3*h2*h1-ex

RCXXs*h-b*t*h1-h2-ex

RCXs*h-b*h2*h1

4.21 T profiles (concrete)

HTTh*b-s-t-b2-h2

TCh-b-t-s

Predefined parametric profiles available in Tekla
Structures

793 T profiles (concrete)



TRIh*b-b2*t1-h3-t2

TTh*b-s-t-b2

TTTh*b-bl-br-hw-bwmin-bwmax

T_VAR_Ah1*h2*s*b1*t1-sft

T_VAR_Bh-b-c-d

Predefined parametric profiles available in Tekla
Structures

794 Irregular beams (concrete)



4.22 Irregular beams (concrete)

IRR_Ab-h-g-c-d

IRR_Bh-b-c-d-f-g

IRR_Ch-b-c-d

IRR_Db1*b2-h1*h2

IRR_Eh-b-c-d-h2-h3-h4

Predefined parametric profiles available in Tekla
Structures

795 Irregular beams (concrete)



IRR_Fa*b

IRR_Gh*b*h2*b2

IRR_Hh*b*h2*b2

IRR_Ih*b*b2

IRR_Jh*b*b2

OCTB*b1-H*h1

REC_Ah-b

REC_Bh-b-b1

Predefined parametric profiles available in Tekla
Structures

796 Irregular beams (concrete)



REC_Ch-b-b1

REC_Dh-b-b2

REC_Eh-b

REC_Fh-b

REC_Gh-b

REC_Hh-b

REC_I a-b*h

TRI_Ah-b

Predefined parametric profiles available in Tekla
Structures

797 Irregular beams (concrete)



TRI_Ba1

TRI_Cb-h

TRI_Dh*b

TRI_Eb*h*h2*b2

4.23 Panels

PNL_Ah*b

PNL_Bh*b

Predefined parametric profiles available in Tekla
Structures

798 Panels



PNL_Ch*b-a-ht*bt

PNL_Dh*b-a-ht*bt

PNL_Eh*b-a-ht*bt

PNL_Fh*b-a-ht*bt

PNL_Gh*b

PNL_Hh*b-a-ht

Predefined parametric profiles available in Tekla
Structures

799 Panels



PNL_Ih*b-a-ht*bt

PNL_Jh*b-a-ht*bt

PNL_Kh*b

PNL_Lh-b-c-f

PNL_Mh-b-c-f-d

PNL_Nh-b-d-f-g-j

PNL_Oh-b-d-f-g-i-t

Predefined parametric profiles available in Tekla
Structures

800 Variable cross sections



4.24 Variable cross sections

HEXRECTh-b-br-hr

HXGONb

OBLINCLh1-h2-h3-h4-b

OBLRIDh1*b1*b2-h2-h3-l2-l1

OBLVAR_Ah1*b1*b2-h2

OBLVAR_Bh1-h2-b

OBLVAR_Ch-b-a-i-j-k-m-n

Predefined parametric profiles available in Tekla
Structures

801 Variable cross sections



OBLVAR_Dh-c-b

OBLVAR_Eh-b-a-c-d-i-j-k-l-m-p-o

OCTAGONb-b2

PRMDASh*b-he*be

PL_Vh*b-he*be

PRMDh*b-h2*b2

ROUNDRECTd-Rb*Rh-t*ye-ze

Predefined parametric profiles available in Tekla
Structures

802 Others



4.25 Others

BLKSd1-d2

CAPd

HEMISPHERd

NUT_Md

RCRWh*b-b2*b3-b4-t1*t2-t3*t4

Predefined parametric profiles available in Tekla
Structures

803 Others



SKh*b-h2-t-b2-b3

SPHEREd

STBb-h-h1-b1-b2-d

STEPh-b*h1-b1-s

Predefined parametric profiles available in Tekla
Structures

804 Others



5 Steel components reference

This section contains information on the use of steel components that ship
with Tekla Structures.

If you know which component you need, you can press F1 in the component
dialog box to quickly access the correct help page. Some components use
locally installed help files in a legacy format, which you can only access by
pressing F1 in the component dialog box.

More components are available in Tekla Warehouse for you to download and
install.

You can also modify many of the existing components and create your own
custom components, see .

5.1 Shear tab connections
This section introduces components that can used in shear tab connections.

• Welded shear plate (43) (page 806)

• Shear plate (103) (page 822)

• Two sided shear plate (118) (page 835)

• Column with shear plate (131) (page 846)

• Bolted moment connection (134) (page 869)

• Shear plate simple (146) (page 895)

• Welded to top flange (147) (page 939)

• Welded to top flange S (149) (page 965)

• Moment connection (181) (page 992)

• Full depth (184) (page 1019)

• Full depth S (185) (page 1046)
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• JP Full depth special (185) (page 1077)

• Shear plate tube column (189) (page 1092)

Welded shear plate (43)
Welded shear plate (43) connects two beams using a shear tab welded to the
secondary beam web and bolted to a stiffener plate welded to the main part
web.

Objects created

• Shear tab

• Stiffener

• Shim plate

• Bolts

• Welds

Use for

Situation Description
Shear tab welded to the secondary
beam and bolted to a stiffener
welded to the main part.

Limitations

This connection cannot be used for connections between beams and columns.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.
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Part identification key

 Description
1 Stiffener
2 Shear tab

Picture tab
Use the Picture tab to define the plate positions.

Dimensions

 Description Default
1 Edge distance between the stiffener and the

main part flange.
0
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 Description Default
2 Shear tab top and bottom edge distance. By default, the

shear tab position
and dimensions are
defined by the bolt
group edge
distances. The
default position for
the shear tab top
and bottom edges
can be overwritten
with the top and
bottom edge
distances.

3 Distance between the stiffener edge and
secondary part end.

 

4 Gap between the main part web and the
shear tab.

10 mm
Changing the value
moves the bolt
group
correspondingly.

5 Edge distance between the shear tab and
stiffener bottom.

 

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stiffener Thickness, width and height

of the stiffener.
By default, the height
is defined by the bolt
group vertical edge
distances.

If you do not enter a
width, the stiffener
width will be defined
based on the flange
width. The default
value for the stiffener
thickness is the web
thickness.

Steel components reference 808 Shear tab connections



Option Description Default
Plate Thickness and width of the

shear tab.

The height is defined by the
bolt group edge distances.
You can also modify the
height with shear tab top and
bottom distances on the
Picture tab.

The default value for
the end plate
thickness is half of the
screw diameter.

Filler Thickness of the shim plate.  

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the shear tab position, stiffener type and
chamfers, and shim plate assembly.

Sheart tab position

Option Description
Default

Near side

AutoDefaults can change this option.
Automatic

Near side
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Option Description
Near side

Both sides

Far side

Stiffener creation

Option Description
Default

Determined by shear tab

AutoDefaults can change this option.

Full

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

  
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 • Top: From the upper edge of the secondary part to the

uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

Select how to measure the dimensions for vertical bolt group
position.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Steel components reference 817 Shear tab connections



Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Shear plate (103)
Shear plate (103) connects a beam to a beam or to a column with a shear tab.
The shear tab is welded to the main part and bolted to the secondary beam.

Objects created

• Shear tab

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab connected to a beam.

Shear tab connected to a beam.

The secondary beam is skewed.
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Situation Description
Shear tab connected to a beam.

The secondary beam is sloped and skewed.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.

Part identification key

 Part
1 Shear tab

Picture tab
Use the Picture tab to control the position of the shear tab.

Shear tab dimensions
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 Description
1 Cut of the secondary part.

Cutting the secondary part creates a gap between the main part and
the secondary part.

The cut is defined from the main part web.
2 Distance from the top edge of the secondary beam to the top edge of

the shear plate.
3 Distance from the bottom edge of the secondary beam to the bottom

edge of the shear tab.

Shear tab position

Option Description
Default

The shear tab is on the left side of the
secondary beam web.

AutoDefaults can change this option.
The shear tab is on the left side of the
secondary beam web.

The shear tab is on the right side of
the secondary beam web.

Beam flange cut

Option Description
Default

Square

AutoDefaults can change this option.
Cuts the end of the flange bevel.

Cuts the end of the flange square.

Parts tab
Use the Parts tab to control the shear tab properties.
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Shear plate

Part Description
Plate Shear tab thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.
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Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.
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Option Description
Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.
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Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Steel components reference 829 Shear tab connections



Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for horizontal bolt group position.
5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

Steel components reference 831 Shear tab connections



 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1
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Option Description
Bolting direction 2

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Two sided shear plate (118)
Two sided shear plate (118) connects two beams to a beam or a column with
shear tabs. The shear tabs are welded to the main beam or column, and
bolted to the secondary beams.

Objects created

• Shear tabs (2)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Simple shear tabs connected to a beam.

Simple shear tabs connected to a beam.

The other secondary beam is sloped.

Simple shear tabs connected to a column
web.

Limitations

The upper edges on the shear tabs should be on the same level.

Selection order

1. Select the main part (beam or column).
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2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 Shear tab

Picture tab
Use the Picture tab to control the position of the shear tabs.

Shear tab dimensions

 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

The cut is defined from the main part web.
2 Distance from the bottom edge of the

secondary beam to the bottom edge of the
shear tab.
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 Description Default
3 Distance from the top edge of the first

secondary beam to the top edge of the shear
plate. The top edges of the shear tabs are
aligned to the same level.

50 mm

Shear tab position

Option Description
Default

The shear tab is on the left side of the
secondary beam web.

AutoDefaults can change this option.
The shear tab is on the left side of the
secondary beam web.

The shear tab is on the right side of
the secondary beam web.

Beam flange cut

Option Description
Default

Square

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.

Square

Cuts the end of the flange square.

Parts tab
Use the Parts tab to control the shear tab properties.

Part Description
Plate Shear tab thickness and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
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Option Option Description
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Define the horizontal bolt edge distance.
5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Steel components reference 843 Shear tab connections



Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with shear plate (131)
Column with shear plate (131) connects a beam to a column with a single
shear tab or double shear tabs. The shear tab is welded to the main part web
and stiffeners, and bolted to the secondary part web. The secondary beam can
be leveled or sloped.

Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Welds

• Bolts

• Cuts

Use for

Option Description
Two shear tabs and four stiffeners.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.
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Dimensions

Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

10 mm

2 Height of the chamfered part of the shear
tab.

50 mm

3 Distance from the edge of the main part to
the corner of the shear tab.

20 mm

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

20 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
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Option Description
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Notch

Define the notch dimensions.

AutoDefaults can change this option.
Notch

Define the notch dimensions.

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab shape

Option Description
Default

Shear tab corner is chamfered.

AutoDefaults can change this option.

Automatic

Shear tab corner is chamfered.

Shear tab corner is chamfered.

Shear tab corner is not chamfered.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.
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Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.
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Option Description
Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates
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Option Description
Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Stiffener positions
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 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
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Option Description
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.
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Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Steel components reference 864 Shear tab connections



Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
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Option Description
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
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Option Description
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
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Option Description
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design type tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bolted moment connection (134)
Bolted moment connection (134) connects a beam to a column web or
flange. The shear tab is welded to the main part web or flange, and bolted to
the secondary part web. The secondary part can be leveled or sloped and/or
skewed.

Objects created

• Shear tab (1 or 2)

• Flange plates (2)

• Shim plates

• Stiffeners (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam connected to column web.
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Situation Description
Beam connected to column flange.

Selection order

1. Select the main part (column ).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Upper flange plate
3 Lower flange plate
4 Shim plate
4 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and web cuts.

Dimensions

 Description
1 Shear tab edge distance from the main part flange edge.
2 Cut of the secondary part.

Cutting the secondary part creates a gap between the main part and
the secondary part.

3 Distance from the shim plate edge to the flange plate edge.
4 Distance from the edge of the secondary part to the edge of the flange

plate.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
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Option Description
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam bevel cut

 Description
1 Bevel of the beam end cut.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Shear plate tab
Use the Shear plate tab to control the size, position, number, orientation and
shape of the shear tab.
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Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
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Option Description
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Flange plate tab
Use the Flange plate tab to control the size, position, number, orientation and
shape of the flange plates and shim plates.

Plates

Part Description Default
Upper flange plate Upper flange plate

thickness.
20 mm

Lower flange plate Lower flange plate
thickness.

20 mm

Upper deck fill Upper deck shim plate
thickness and width.

10 mm

Lower deck fill Lower deck shim plate
thickness and width.

0

Upper loose fill Upper shim plate
thickness.

 

Lower loose fill Lower shim plate
thickness.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Flange plate chamfers

Description
1 Horizontal dimension of the flange

plate chamfer.
2 Vertical dimension of the flange plate

chamfer.
3 Vertical and horizontal dimension of

the flange plate chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer
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Option Description
Concave arc chamfer

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.
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Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.
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Stiffener positions

 Description
1 Size of the gap between the near side stiffener and the

beam web edge.
2 Size of the gap between the top near side stiffener and

the beam flange edge.
3 Size of the gap between the bottom near side stiffener

and the beam flange edge.
4 Size of the gap between the top far side stiffener and

the beam flange edge.
5 Size of the gap between the bottom far side stiffener

and the beam flange edge.
6 Size of the gap between the far side stiffener and the

beam web edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm
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Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear bolts tab
Use the Shear bolts tab to control the properties of the bolts that connect the
shear tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.
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 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Flange bolts tab
Use the Flange bolts tab to control the properties of the bolts that connect
the flange plate to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the flange plate.
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 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

8 Flange plate edge distance from the main part web.
9 Select the offset origin part for the bolt group.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Slots in deck fill plates and loose fill plates

Option Description
Slots in deck fill plates, Slots in
loose fill plates

Select whether slottes holes are
created in deck fill and loose fill
plates.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Shear plate simple (146)
Shear plate simple (146) connects a beam to a beam, or a beam to a column
with a single square shear tab or double shear tabs. The shear tab is welded to
the main part web and flanges, and bolted to the secondary beam web. The
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secondary beam can be leveled or sloped and/or skewed. A stiffener plate on
the opposite side of the main beam web is optional.

Objects created

• Shear tab (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Seat angles

• Welds

• Bolts

• Cuts

Use for

Situation Description
Simple shear tab connected to a beam.

Simple shear tab connected to a beam.

Some bolts have been deleted.
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Situation Description
Simple shear tab connected to a beam.

The secondary part is skewed.

Simple shear tab connected to a beam.

The secondary part is sloped and skewed. The
bolts and shear tab are parallel with the
secondary part.

Simple shear tab connected to a beam with
haunches and a stiffener plate.

Simple shear tab connected to a beam.

The secondary part is sloped and skewed.
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Situation Description
Simple shear tab connected to a column flange.

Simple shear tab connected to a column flange/
edge.

Simple shear tab connected to a column flange
with seat angle options.

Simple shear tab connected to a column flange.

Some bolts have been deleted.

Selection order

1. Select the main part (column or beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Part identification key

 Part
1 Shear tab
2 Haunch plate

Picture tab
Use the Picture tab to control the beam end, flange, and web cuts.

Dimensions
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 Description Default
1 Size of the strip made to the secondary part

flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
2 The beam gap dimension adjusts the gap

between the main part web and the
secondary beam web.

The dimension is measured either square to
the main part or in the same direction as the
secondary part. This option applies in square
and skewed framing conditions.

The dimension is only used when the Beam
end cut option is set to default or
automatic.

20 mm

Square to the main part

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
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Option Description
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.
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Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Parts

Option Description
Tab plate Shear tab plate thickness, width and height.
Plate washer Plate washer thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Shear tab position

Define the number and the side of shear tabs in single shear tab connections.

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tab and secondary part

   
1 Gap between the secondary part web

and the shear tab.
0
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Shear tab position (sloped)

Define the position of shear tabs. The secondary part is sloped.

Option Description
Default

Shear tab edges reach the same level
in the main part.

AutoDefaults can change this option.
Shear tab edges reach the same level
in the main part.

Shear tabs have the same length.

Shear tab edge distance

Description
1 Distance between the main part web and the edge of the shear tabs.

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.
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Shear tab chamfers

Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
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Option Description
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Plate washer

Define plate washers for bolts and select the plate washer side.

Option Description
Default

No plate washer

AutoDefaults can change this option.

No plate washer

One plate washer
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Option Description
Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one shear tab or both
shear tabs.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.
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Option Description
No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flanges and the stiffener.
2 Size of the gap between the main part web and the stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Stiffener chamfers
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Creates notches on both sides of the secondary
beam. The cuts are square to the secondary beam.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
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Option Description
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Steel components reference 916 Shear tab connections



Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.
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 Description
1 Dimension for horizontal bolt group position.

When the secondary beam is sloped or skewed, define whether the
horizontal dimension is measured from the bolt group to the edge of
the secondary part, or from the bolt group to the main part web.

• Sloped, to the secondary part

• Skewed, to the secondary part

• Sloped, to the main part

• Skewed, to the main part

The default is that the horizontal dimension is measured from the bolt
group to the edge of the secondary part.

Ensure that the Beam end cut on the Picture tab is set to square

.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.
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 Description
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

When the secondary beam is sloped, define whether the vertical
dimension is measured from the bolt group to the edge of the
secondary part, or from the bolt group to the edge of the main part.

• Vertical sloped dimension, to the secondary part

• Vertical dimension, to the secondary part

• Vertical dimension, to the main part

• Vertical dimension, to the center line of the main part

The default is that the vertical dimension is measured from the bolt
group the edge of the secondary part (sloped dimension).

Ensure that the Beam end cut on the Picture tab is set to square

.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Weld access hole dimensions
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 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access hole types

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Steel components reference 925 Shear tab connections



Option Description Default
Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
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Option for top flange Option for bottom
flange

Description

Flange is not cut.

Flange is cut.

Weld backing bar creation

Option for bottom backing bar Description
Default

Backing bars are created inside the
flanges.

AutoDefaults can change this option.
No backing bars are created.

Backing bars are created inside the
flanges.

Backing bars are created outside the
flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Angle box tab
Use the Angle box tab to add a seat angle.

Seat angle

The purpose of seat angles is to carry loads from the secondary part. Seat
angles can be positioned to top, bottom or both flanges of the secondary part.
The seat angle can be stiffened, and bolted or welded to the main and
secondary parts.

Option Description
Stiffeners Stiffener thickness, width and height.
Profile Seat angle profile by selecting it from

the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.

No seat angle is created.

Seat angle is created at the top of the
flange.

Seat angle is created at the bottom of
the flange.

Seat angles are created on both sides
of the flange.
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Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.

Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.

Welded

Seat angle is welded to
the main part and to the
secondary part.

Seat angle stiffener type

Option Description
Default

Rectangular stiffener plate

AutoDefaults can change this option.
Rectangular stiffener plate
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Option Description
Triangular stiffener plate

The line connecting the ends of the
seat angle legs defines the stiffener
plate shape.

Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally 90
degrees.

To stiffen the rotated seat angle,
select the Middle stiffeners option in
the Middle stiffener position list.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
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Option Description
reach furthest from the seat angle
corner.

Seat angle side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Seat angle middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
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Option Description
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.

Seat angle offset

 Description
1 Seat angle horizontal offset from the center line of the main

part.

Seat angle gap

 Description
1 Top gap and bottom gap between the seat angle and the secondary

part.
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Seat angle chamfers

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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BoxPBolts tab
Use the BoxPBolts tab to control properties of the bolts that connect the seat
angle to the main part.

Seat angle bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Edge distance is the distance from the center of a bolt to the edge of

the part.

Bolt edge distance.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary beam.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

• Top refers to the bolt group that connects the top seat angle to the main
part.

• Bottom refers to the bolt group that connects the bottom seat angle to the
main part.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

BoxSBolts tab
Use the BoxSBolts tab to control the properties of the bolts that connect the
seat angle to the secondary part.

Seat angle bolt group dimensions

 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the secondary beam.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

• Top refers to the bolt group that connects the top seat angle to the
secondary part.

• Bottom refers to the bolt group that connects the bottom seat angle to the
secondary part.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded to top flange (147)
Welded to top flange (147) connects two beams with a single shear tab or
double shear tabs. The shear tabs are welded to the main beam web and the
top flange, and bolted to secondary beam web. The secondary beam can be
leveled or sloped.

Objects created

• Shear tab (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Seat angles (optional)

• Bolts

• Welds
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• Cuts

Use for

Situation Description
Partial depth shear tab connected to the top flange
of a beam. Stiffener is created.

Partial depth shear tab connected to the top flange
of a beam. The secondary part is sloped. Stiffener
is created.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20

2 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.
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Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Horizontal dimension of the shear tab exterior chamfer.
4 Vertical dimension of the shear tab exterior chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Chamfer dimensions
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.
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Option Description
Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flanges and the stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.
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Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
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Description
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.
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Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
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Option Description
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the main part.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
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Option Description
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Option Description
Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for bottom backing bar Description
Default

Backing bars are created inside the
flanges.

AutoDefaults can change this option.
No backing bars are created.

Backing bars are created inside the
flanges.

Backing bars are created outside the
flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Steel components reference 963 Shear tab connections



Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded to top flange S (149)
Welded to top flange S (149) connects two beams with a single shear tab or
double shear tab. The shear tabs are welded to the main beam web and the
top flange, and bolted to secondary beam web. The secondary beam can be
leveled or sloped.

Objects created

• Shear tab (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Partial depth shear tab connected to the
top flange of a beam.
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Situation Description
Partial depth shear tab connected to the
top flange of a beam. Stiffener is created.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Dimensions

Description Default
1 Shear tab edge distance from the main part

flange edge.
0

2 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20

3 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
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Option Description
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab
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Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flanges and the stiffener.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.
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Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the main part.

Bolt group dimensions

Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
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Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2
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Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
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 Description
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and
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Option Description Default
Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
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Option for top flange Option for bottom
flange

Description

Flange is not cut.

Flange is cut.

Weld backing bars

Option for bottom backing bar Description
Default

Backing bars are created inside the
flanges.

AutoDefaults can change this option.
No backing bars are created.

Backing bars are created inside the
flanges.

Backing bars are created outside the
flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the links below to find out more:

General tab

Design tab
Click the links below to find out more:

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Moment connection (181)
Moment connection (181) connects a beam to a column or to a beam with a
single shear tab or double shear tabs. The shear tab is welded to the main part
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and bolted to the secondary part web. The secondary beam can be leveled or
sloped. Top and bottom flange plates may be welded to the secondary beam
and site-welded to the main column.

Objects created

• Shear tab (1 or 2)

• Top flange plate

• Bottom flange plate

• Stiffeners (4) (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Moment connection welded to a column
flange. The secondary part is sloped.

Moment connection welded to a column
flange. Beam weld preparation and weld
access hole options.
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Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Top flange plate
3 Bottom flange plate
4 Top stiffener plate
5 Bottom stiffener plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.
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Dimensions

Description
1 Site welding distance from the edge of the top flange plate to the main

part flange.
2 Site welding distance from the edge of the bottom flange plate to the

main part web.
3 Distance from the edge of the shear tab to the top edge of the

secondary part.
4 Chamfer dimension of the shear tab.
5 Distance from the main part flange to the edge of the secondary part.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
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Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Plates

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description
Top plate Top plate thickness, width and height.
Bottom plate Bottom plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab dimensions

 Description
1 Distance from the edge of the main part flange to the edge of the top

and bottom plate.
2 Distance from the flange of the secondary part to the edge of the top

and bottom plate.
3 Width of the chamfered end of the top and bottom plate.
4 Chamfering dimension of the top and bottom plate.

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Steel components reference 997 Shear tab connections



Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Steel components reference 999 Shear tab connections



Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.
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Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.
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Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.
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Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control the weld access holes, beam end
preparations, and flange cuts.

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Steel components reference 1012 Shear tab connections



 Description
5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Option Description
Default

Round weld access hole

AutoDefaults can change
this option.
Round weld access hole

Square weld access hole

Round weld access hole
with a radius that you
can define in

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Beam end alignment

Option Description
Default

Beam end is not aligned.

Secondary part flange is not aligned
with the top and bottom plates.

AutoDefaults can change this option.
Beam end is not aligned.

Beam end is aligned.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.
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Option for top flange Option for bottom
flange

Description

Flange is cut.

Doubler plates tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.
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Option Description
Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.
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Option Description
Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.

General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.

Steel components reference 1017 Shear tab connections



Description
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.

Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Full depth (184)
Full depth (184) connects two beams with a full depth shear tab. The shear
tab is welded to the main beam web and flanges, and bolted to the secondary
beam web. The secondary beam can be leveled or sloped. A stiffener plate on
the opposite side of the main beam web and the haunch plates welded to the
secondary beam flanges are optional.

Objects created

• Shear tab (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Full depth shear tab.

Full depth connection with a stiffener plate.
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Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.
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Dimensions

 Description Default
1 Cut of the secondary part.

The cut is defined from the main part web.

20 mm

2 Shear tab edge distance from the main part
flange edge.

3 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

10 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
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Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab plate

Option Description
Tab plate Shear tab thickness and width.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs
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 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.
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Stiffener gap

 Description
1 Size of the gap between the main part flange and the stiffener.
2 Distance from the edge of the main part flange to the edge of the

stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.
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 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  
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Option Description Default
Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.
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Option Description
Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.
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Option for top backing
bar

Option for bottom
backing bar

Description

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the links below to find out more:

General tab
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Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds tab

Click the link below to find out more:

Full depth S (185)
Full depth S (185) connects two beams with a full depth shear tab. The shear
tab is welded to the main beam web and flanges, and bolted to the secondary
beam web. The secondary beam can be leveled or sloped. A stiffener plate on
the opposite side of the main beam web and the haunch plates welded to the
secondary beam flanges are optional.

Objects created

• Shear tabs (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Full depth shear tab.

Full depth shear tab.

The secondary part is sloped.

Full depth shear tab.

The secondary part is sloped and skewed.
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Situation Description
Full depth shear tab.

The secondary part is offset. Some bolts
have been deleted.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and web cuts.

Dimensions

 Description Default
1 Shear tab edge distance from the main part

flange edge.
0

2 Shear tab edge distance from the main part
flange edge.

0

3 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the shear
tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Concave arc chamfer

Inner shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Radius and the vertical dimensions of the shear tab inner chamfer.

Chamfer type

Option Option Description
Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer
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Option Option Description
Convex arc chamfer

Concave arc chamfer

Inner chamfer type

Option Description
Default

Concave arc chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Concave arc chamfer

Convex arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
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Option Description
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.
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Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap
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 Description
1 Size of the gap between the main part flange and the stiffener.
2 Distance from the edge of the main part flange to the edge of the

stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Convex arc chamfer

Concave arc chamfer

Opposite web stiffener offset

Define the opposite web stiffener offset from the shear tab center line.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.
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Option Description
Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Steel components reference 1062 Shear tab connections



Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
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Option Description
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.
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Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest

bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4
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Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Option Description
Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.
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Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab
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Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

JP Full depth special (185)
JP Full depth special (185) connects two beams with a full depth shear tab.
The shear tab is welded to the main beam web and flanges, and bolted to the
secondary beam web. The secondary beam can be leveled or sloped. A
stiffener plate can be created on the opposite side of the main beam web.

Objects created

• Shear tabs (1 or 2)

• Stiffener (optional)

• Bolts

• Welds

Use for

Situation Description
Full depth shear tab.
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Situation Description
Full depth shear tab.

The secondary part is sloped.

Full depth shear tab.

The secondary part is sloped and skewed.

Full depth shear tab.

The secondary part is offset. Some bolts
have been deleted.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Shear tab
2 Stiffener

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and web cuts.

Dimensions

  
1 Shear tab edge distance from the main part flange edge.
2 Shear tab edge distance from the main part flange edge.
3 Cut of the secondary part.

Cutting the secondary part creates a gap between the
main part and the secondary part.
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4 Size of the strip made to the secondary part flange.

The cut of the flange is defined from the shear tab edge.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.
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Option Description
Shear tab cut

Enter the dimension to the secondary
part flange cut.

Shear tab shape

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Bevel cut

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Shear tab position

Option Description
Default

Near side shear tab

AutoDefaults can change this option.
Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Near side shear tab

Near side and far side shear tab

Far side shear tab

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square
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Shear tab chamfers

 Description
1 Vertical dimension of the shear tab chamfer.
2 Horizontal dimension of the shear tab chamfer.
3 Shear tab chamfer radius.
4 Select the chamfer type.

Inner shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Shear tab chamfer radius.
4 Select the chamfer type.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.
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Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
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Option Description
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.
3 Select the chamfer type.
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Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt

group position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center
line of the secondary part.

• Below: From the lower edge of the secondary part to
the lowest bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run
from left to right and from top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Shear plate tube column (189)
Shear plate tube column (189) connects a beam to a tube column with a
shear tab. The shear tab goes through the tube column.

Objects created

• Shear tab (1 or 2)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab through a tube column with two
secondary parts.

Shear tab through a tube column with two
secondary parts. Shear tab extends to the top of
the column.
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Situation Description
Shear tab through a tube column with two
secondary parts and bolt alignment options.

The secondary parts can be leveled and/or
sloped.

Shear tab through a tube column with two
secondary parts.

A third secondary part has been added after the
connection was created.

Shear tab through a tube column with one
secondary part.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the component.
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Part identification key

 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab and to define how
the beam ends are cut.

Dimensions

 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm
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 Description Default
2 Distance from the edge of the main part to

the top corner of the shear tab.
5 mm

3 Distance from the edge of the main part to
the bottom corner of the shear tab.

5 mm

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Automatic

If the secondary beam is
sloped less than 10
degrees, the beam end
is cut square. Otherwise,
the beam end is cut
bevel.
Square

Cuts the end of the
secondary beam square.
Bevel

Cuts the end of the
secondary beam parallel
to the edge of the main
part.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.
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Shear tab plate

Option Description
Shear plate Plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab dimensions

Description
1 Horizontal size of the cut created for the shear tab.

Equal size is created on both sides of the shear tab.
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Description
2 Vertical size of the cut created for the shear tab.

Equal size is created at the top and bottom of the shear tab.
3 Distance from the center line of the shear tab to the center line of the

main part.

Default value 0 places the shear tab at the center line of the main part.
4 Corner radius of the cut created for the shear tab.
5 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Concave arc chamfer

Shear tab cut

When the component is created near the column top, the upper edge of the
shear tab can be extended to the top of the column.

Option Description
Default

Line

AutoDefaults can change this option.
Line

Column top

The upper edge of the shear tab is
extended to the top of the main part.
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Shear tab shape

Option Description
Default

Perpendicular to the main part

AutoDefaults can change this option.
Perpendicular to the main part

Automatic

Shear tab edges are aligned in the
direction of the right secondary part.

Shear tab edges are aligned in the
direction of the left secondary part.

The edges of the shear tab are
connected at the intersection of the
secondary part edges.
Defined by both edges

Shear tab orientation

Define the shear tab orientation for both secondary parts.

Option Option Description
Default

Sloped

AutoDefaults can change
this option.
Automatic

Sloped or square

If the secondary part is
sloped less than 10
degrees, a square shear
tab is created.
Otherwise, the shear tab
is sloped in the direction
of the secondary part.
Sloped

Square
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Option Option Description
Sloped with square end
cut

Shear tab top corner shape

Define the shape of the shear tab top corner for both secondary parts.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Bevel

Square

Shear tab bottom corner shape

Define the shape of the shear tab bottom corner for both secondary parts.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Bevel

Square

Shear tab position

Option Description
Default

Near side

AutoDefaults can change this option.
Automatic

The shear tab is created to the near
side when the angle between the
main part and the secondary part is
less than 90 degrees.
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Option Description
Near side

Both sides

Far side

1stSecBolts and 2ndSecBolts tabs
Use the 1stSecBolts tab and the 2ndSecBolts tab to control the properties of
the bolts that connect the shear tab to the first and the second secondary
part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

5.2 Clip angle connections
This section introduces clip angle connection components available in Tekla
Structures.

Click the links below to find out more:

• Clip angle (116) (page 1104)

• Two sided clip angle (117) (page 1115)

• Clip angle (141) (page 1127)

• Two sided clip angle (143) (page 1173)

Clip angle (116)
Clip angle (116) connects a beam to a beam or a column with a clip angle.

Objects created

• Clip angle (1 or 2)

• Bolts

• Cuts
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Use for

Situation Description
Clip angle connection to a beam web.

Clip angle connection to a beam web.

The secondary beam is sloped.

Clip angle connection to a column flange.

Clip angle connection to a column flange.

The secondary beam is sloped.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Clip angle

Picture tab
Use the Picture tab to control the clip angle dimensions and the clip angle
position.

Dimensions

 Description Default
1 Cut length for the secondary part.  
2 Clip angle upper edge distance from the top

of the secondary beam.

The upper edge position of the angle modifies
the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.
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 Description Default
3 Clip angle lower edge distance from the

bottom of the secondary beam.

The lower edge position of the angle modifies
the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

4 Gap between the main part and the clip
angle.

 

5 Height of the clip angle.  

Clip angle position

Option Description
Default

Near and far side clip angles are
created.

AutoDefaults can change this option.
Near side clip angle is created.

Near side and far side clip angles are
created.

Far side clip angle is created.

Parts tab
Use the Parts tab to control the properties of the clip angle.

Clip angle

Part Description
L profile Define the clip angle profile

by selecting it from the
profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Notch tab
Use the Notch tab to create notches for the secondary beam and to control
the notch properties.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.
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Option Option Description

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.
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Option Description
Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties. The vertical position of bolts
in the main part must be aligned with the vertical position of bolts in the
secondary part. Vertical bolts cannot be staggered.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

Steel components reference 1111 Clip angle connections



 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Steel components reference 1112 Clip angle connections



Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group dimensions

 Description
1 Bolt edge distance.
2 Location where the bolts should be attached.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Two sided clip angle (117)
Two sided clip angle (117) connects two beams to a beam or a column using
clip angles. The clip angles are bolted to the secondary beams and to the main
part.

Objects created

• Clip angles (2 or 4)

• Bolts

• Cuts

Use for

Situation Description
Clip angle connection to a beam web.

Clip angle connection to a beam web.

Two secondary beams with different heights.

Clip angle connection to a beam web.

The other secondary beam is sloped.
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Situation Description
Clip angle connection to a column web.

Selection order

1. Select the main part (beam or column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 Clip angle

Picture tab
Use the Picture tab to control the dimensions and the position of the clip
angle.
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Dimensions

 Description Default
1 Cut length for the secondary part. 2.25 mm
2 Clip angle upper edge distance from the top

of the secondary beam.

The upper edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

3 Gap between the main part and the clip
angle.

 

Clip angle position

Option Description
Default

Near side and far side clip angles are
created.

AutoDefaults can change this option.
Near side clip angles are created.

Near side and far side clip angles are
created.

Far side clip angles are created.
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Parts tab
Use the Parts tab to control the clip angle properties.

Clip angle

Part Description
L profile, L profile 2 Define the clip angle profile by

selecting it from the profile
catalog.

Angle 1 length, Angle 2
length

Define the length of the clip angle
both on the first secondary part
and the second secondary part
side.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Move cleats to smaller web

Define the position of the cleats.

Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Steel components reference 1119 Clip angle connections



Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
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Option Option Description
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group dimensions
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 Description
1 Bolt edge distance.
2 Location where the bolts should be attached.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Clip angle (141)
Clip angle (141) connects two beams, or a beam to a column, using bolted or
welded clip angles. The secondary beam can be leveled or sloped. Welded
haunch plates and seat angles are optional.

Objects created

• Clip angles (1 or 2)

• Stiffeners (optional)

• Top and bottom haunch plate (optional)

• Seat angle (optional)

• Seat stiffeners (optional)

• Bolts

• Plate washers (optional)

• Welds

• Cuts

Use for

Situation Description
Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Welded/bolted, bolted/bolted, welded/welded
options.
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Situation Description
Clip angle connection to beam web.

Single-sided/double-sided clip.

Clip angle connection to column flange or web.

Single-sided/double-sided clip.

The secondary part is sloped. The secondary
part end can be cut square or bevel.

Clip angle connection to beam web.

Single-sided/double-sided clip.

The secondary part is sloped. There are several
notching options.

Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Weld preparation and weld access holes for
moment connection.
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Situation Description
Clip angle connection to beam web.

Single-sided/double sided clip.

Option for weld preparation.

Clip angle connection to column flange.

Bottom flange is blocked or stripped for
erection.

Clip angle connection to column.

Seat angle option. Top/Bottom/Both.

Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Haunch option. Top/Bottom/Both.
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Situation Description
Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Secondary part is rotated.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Clip angles
2 Haunch plate
3 Seat angle
4 Seat stiffener
5 Web stiffeners

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Picture tab
Use the Picture tab to control the clip angle dimensions and to define how the
beam end is cut.

Dimensions

 Description Default
1 Cut length for the secondary part.

The cut is defined from the clip angle edge.

20 mm

2 Clip angle upper edge distance from the top
of the secondary beam.

The upper edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

3 Clip angle lower edge distance from the
bottom of the secondary beam.

The lower edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.
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 Description Default
4 Size of the strip made to the secondary part

flange.

The cutting point of the flange is defined
from the clip angle edge.

The flange is
automatically stripped
when the clip angle
crosses the flange.

10 mm
5 Define the gap between the main part and

the clip angle.
0

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the clip angle crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the clip angle if the
clip angle crosses the flange.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
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Option Description
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Parts tab
Use the Parts tab to control the size, position and orientation of the clip
angles.

Profile NS/FS

Option Description Default
Profile NS Near side clip angle

profile by selecting it
from the profile catalog.

Angle size is defined by
the bolt diameter.

The default name is
ANGLE.

Profile FS Far side clip angle profile
by selecting it from the
profile catalog.

Angle size determined
by the bolt diameter.

The default name is
ANGLE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Clip angle position

Define the number of clip angles and the side of the clip angle in single clip
angle connections.

Option Description
Default

Near side and far side clip angles are
created.

AutoDefaults can change this option.

Automatic

If the main part is a tube profile, two
clip angles are created. Otherwise a
near side clip angle is created.

Near side clip angle is created.

Near side and far side clip angles are
created.

Far side clip angle is created.

Wrapped angle. Far side clip angle is
created.

Wrapped angle. Near side clip angle is
created.

Clip angle orientation

These options switch the unequal legs of the far side and the near side clip
angles.
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Option for near side Option for far side Description
Default

Not switched

AutoDefaults can change
this option.

Not switched

The clip angle is placed
on a connection so that
the longer leg is
connected to the
secondary part.
Switched

The clip angle legs are
switched so that the
longer leg is connected
to the main part.

Bolt spacing and weld gap

Option Description
1 Bolt spacing.
2 Weld gap.

Option Description
Default

Bolt spacing without weld gap

AutoDefaults can change this option.
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Option Description
Bolt spacing without weld gap

Bolt spacing with weld gap

Bolt spacing with weld gap that you
can define

Center of the bolt gage line

Option Description
Default

Center of the bolt gage line from the
center line of the secondary part.

AutoDefaults can change this option.

Center of the bolt gage line from the
center line of the secondary part.

Center of the bolt gage line from the
back of the secondary part web.

You can use this option when the
secondary part has a C or U profile.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.
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Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Steel components reference 1137 Clip angle connections



Option Description
Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.
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Option Description
Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Option Description
Size of the gap between the flanges
and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
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 Description
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer
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Option Description
Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Steel components reference 1144 Clip angle connections



Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control bolts and welds that connect the clip angle to the
main part and to the secondary part.
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Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest

bolt.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

Staggering of bolts on clip angle

Option Description
Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

The bolts that connect the clip angle to the secondary part
are on the same horizontal level as the bolts that connect
the clip angle to the main part.
Bolts on the main part are staggered.

The bolts that connect the clip angle to the main part are
moved downwards by half the bolt vertical spacing value.
Bolts on the secondary part are staggered.

The bolts that connect the clip angle to the secondary part
are moved downwards by half the bolt vertical spacing
value.
Bolts on the secondary part are staggered.

The bolts that connect the clip angle to the sloped
secondary part are parallel to the secondary part.

Steel components reference 1149 Clip angle connections



Bolt group dimensions

 Description
1 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Bolt edge distance.
5 Location where the bolts should be attached.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Attachment type

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.

Automatic

When the main part is a tube profile, the clip angles are
welded to the main part and bolted to the secondary
part. Otherwise the clip angles are bolted to both parts.

Both parts are bolted.

Main part is welded and secondary is part bolted.

Main part is bolted and secondary part is welded.

Both parts are welded.
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Option Description
Main part is not bolted.

Secondary part is not welded.

Secondary part is not bolted.

Both parts are bolted and welded.

Number of clip angle welds

Define the number of welds that connect the clip angle to the main part
and/or the secondary part.

Option Description
Default

Three welds are created to the clip angle.

AutoDefaults can change this option.
Three welds are created to the clip angle.

One weld is created to the clip angle.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Plate washers tab
Use the Plate washers tab to define the plate washer properties to the main
part and to the secondary parts.

Option Description
Plate washer Plate washer thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Plate washer

Define plate washers for bolts and select the plate washer side.

Option Description
Default

No plate washer

AutoDefaults can change this option.

No plate washer

One plate washer
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Option Description
Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one clip angle or both clip
angles.

Select whether the plate washers are
placed symmetrically or
asymmetrically.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.
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Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
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 Description
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

R = 35
r = 10
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Option Description Default

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.
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Option for top flange Option for bottom
flange

Description

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Angle box tab
Use the Angle box tab to add a seat angle.

Seat angle

The purpose of seat angles is to carry loads from the secondary part. Seat
angles can be positioned to top, bottom or both flanges of the secondary part.
The seat angle can be stiffened, and bolted or welded to the main and
secondary parts.

Option Description
Stiffeners Stiffener thickness, width and height.
Top angle, Bottom angle Selea the seat angle profile by

selecting it from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.

No seat angle is created.

Seat angle is created at the top of the
flange.

Seat angle is created at the bottom of
the flange.

Seat angles are created on both sides
of the flange.
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Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.

Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.

Welded

Seat angle is welded to
the main part and to the
secondary part.

Stiffener type

Option Description
Default

Rectangular stiffener plate

AutoDefaults can change this option.
Rectangular stiffener plate
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Option Description
Triangular stiffener plate

The line connecting the ends of the
seat angle legs defines the stiffener
plate shape.

Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally 90
degrees.

To stiffen the rotated seat angle,
select the Middle stiffeners option in
the Middle stiffener position list.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
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Option Description
reach furthest from the seat angle
corner.

Side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
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Option Description
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.

Seat angle offset

 Description
1 Seat angle horizontal offset from the center line of the main

part.

Gap

 Description
1 Top gap and bottom gap between the seat angle and the secondary

part.
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Chamfer dimensions

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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BoxPBolts tab
Use the BoxPBolts tab to control properties of the bolts that connect the seat
angle to the main part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the main part.
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Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
main part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

BoxSBolts tab
Use the BoxSBolts tab to control properties of the bolts that connect the seat
angle to the secondary part.

Bolt group dimensions
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 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the secondary
part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab
Click the link below to find out more:

General tab
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Design type tab
Click the link below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Two sided clip angle (143)
Two sided clip angle (143) connects two beams, or a beam to a column, using
single or double clip angles. The secondary beam can be leveled or sloped.
Welded haunch plates and a seat angle are optional.

Objects created

• Clip angles (2)

• Haunch plates (optional)

• Seat angle (optional)

• Weld backing bars (optional)

• Bolts

• Plate washers (optional)

• Welds

• Cuts
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Use for

Situation Description
Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts. Bolted/bolted, welded/
bolted, welded/welded options.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts. Bolted/bolted, welded/
bolted, welded/welded options.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts.

Haunch option. Top/Bottom/Both
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Situation Description
Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts at different heights.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts.

Weld preparation and weld access holes for
moment connection.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts.

Safety connection.
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Situation Description
Clip angle connection.

Automatic notching of secondary part to
provide bolt clearance.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts rotated.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts, one sloped.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Steel components reference 1176 Clip angle connections



Part identification key

 Part
1 Clip angles
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the clip angle dimensions and to define how the
beam end is cut.

Dimensions

 Description Default
1 Cut length for the secondary part.

The cut is defined from the clip angle edge.

 

2 Define the gap between the main part and
the clip angle.

0
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 Description Default
3 Clip angle upper edge distance from the top

of the secondary beam.

The upper edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

4 Clip angle lower edge distance from the
bottom of the secondary beam.

The lower edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

Option Description
Sort secondaries by
profile height

Select whether the secondary parts are sorted
by their profile height.

When set to Yes, the highest secondary part is
always regarded as the first secondary part,
regardless of the selection order.

 Description Default
1 Size of the strip made to the secondary part

flange.

The cutting point of the flange is defined
from the clip angle edge.

The flange is
automatically stripped
when the clip angle
crosses the flange.
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Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Automatic

If the secondary beam is
sloped less than 10
degrees, the beam end
is cut square. Otherwise,
the beam end is cut
bevel.
Square

Cuts the end of the
secondary beam square.
Bevel

Cuts the end of the
secondary beam parallel
to the edge of the main
part.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the clip angle crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the clip angle if the
clip angle crosses the flange.
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Parts tab
Use the Parts tab to control the size, position and orientation of the clip
angles.

Profile NS/FS

Option Description Default
Profile NS

Profile 2 NS

Near side clip angle
profile for the first and
the second secondary
parts by selecting it from
the profile catalog.

Angle size is defined by
the bolt diameter.

The default name is
ANGLE.

Profile FS

Profile 2 FS

Far side clip angle profile
for the first and the
second secondary parts
by selecting it from the
profile catalog.

Angle size is determined
by the bolt diameter.

The default name is
ANGLE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Clip angle position

Option for the second
secondary part

Option for the first
secondary part

Description

Default

Near side and far side
clip angles are created.

AutoDefaults can change
this option.
Automatic

If the main part is a tube
profile, two clip angles
are created. Otherwise a
near side clip angle is
created.
Near side clip angle is
created.

Near side and far side
clip angles are created.

Far side clip angle is
created.

Near side clip angle orientation

These options switch the unequal legs of the near side clip angles.

Option for the second
secondary part

Option for the first
secondary part

Description

Default

Not switched

AutoDefaults can change
this option.
Not switched

The clip angle is placed
on a connection so that
the longer leg is
connected to the
secondary part.
Switched

The clip angle legs are
switched so that the
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Option for the second
secondary part

Option for the first
secondary part

Description

longer leg is connected
to the main part.

Far side clip angle orientation

These options switch the unequal legs of the far side clip angles.

Option for the second
secondary part

Option for the first
secondary part

Description

Default

Not switched

AutoDefaults can change
this option.
Not switched

The clip angle is placed
on a connection so that
the longer leg is
connected to the
secondary part.
Switched

The clip angle legs are
switched so that the
longer leg is connected
to the main part.

Bolt spacing and weld gap

Optio
n

Description

1 Bolt spacing.
2 Weld gap.

Option Description
Default

Bolt spacing without weld gap

AutoDefaults can change this option.
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Option Description
Bolt spacing without weld gap

Bolt spacing with weld gap

Bolt spacing with weld gap that you
can define.

Center of the bolt gage line

Option Description
Default

Center of the bolt gage line from the
center line of the secondary part.

AutoDefaults can change this option.

Center of the bolt gage line from the
center line of the secondary part.

Center of the bolt gage line from the
back of the secondary part web.

You can use this option when the
secondary part has a C or U profile.

Safety connections

In Side 2 horizontal offset, enter a value to the field to move the clip angles in
horizontal direction on the side of the second secondary beam. Enter the
Vertical cut/offset and Horizontal cut dimensions.

Safety connection type

Define whether the created connection is a standard connection or a safety
connection.
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Option Description
Default

No safety connection is created.

AutoDefaults can change this option.
No safety connection is created.

Clip angles are moved down to create
safety connection.

Enter the dimension in the Vertical
cut/offset field.
Clip angles are notched to create
safety connection.

Enter the notch dimensions in the
Vertical cut/offset and Horizontal
cut fields.

Safety connection location

Define the location of the safety connection.

Option Description
Default

On the first secondary beam

AutoDefaults can change this option.
On the first secondary beam

On the first secondary beam

On the second secondary beam

On the second secondary beam

On the first secondary beam
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Option Description
On the second secondary beam

On the first secondary beam and the
second secondary

On the second secondary beam and
the first secondary beam

Safety connection staggering

Define how the clip angles are staggered.

Option Description
Default

Staggered

AutoDefaults can change this option.
Staggered

Clip angle height is not modified, but
the clip angles are moved to create
safety connection.
Flush

Clip angle height is modified to create
safety connection, but the bottoms of
the angles are flush with each other.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate creation

Option for the second
secondary beam

Option for the first
secondary beam

Description

Default

Top and bottom haunch
plates are created, if
needed.

AutoDefaults can change
this option.
Automatic

Top or bottom haunch
plate or both are
created, if needed.

Top and bottom haunch
plates are always
created.

To create a single plate,
enter 0 in the thickness
(t) field for the haunch
plate you do not need
(top or bottom plate).
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Option for the second
secondary beam

Option for the first
secondary beam

Description

Haunch plates are not
created.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.
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Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
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Option Description
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal

flange cuts.
10 mm

2 Dimensions for the vertical
flange cuts.

The gap between the notch edge
and the beam flange is equal to the
main part web rounding. The notch
height is rounded up to the nearest
5 mm.

Bolts tab
Use the Bolts tab to control the bolt group dimensions.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Number of rows of bolts through the main part.

Staggering of bolts on clip angle

Option for
second

secondary

Option for first
secondary

Description

Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

The bolts that connect the clip angle to
the secondary part are on the same
horizontal level as the bolts that
connect the clip angle to the main part.
Bolts on the main part are staggered.

The bolts that connect the clip angle to
the main part are moved downwards
by half the bolt vertical spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the clip angle to
the secondary part are moved
downwards by half the bolt vertical
spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the clip angle to
the sloped secondary part are parallel
to the secondary part.
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Attachment type

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile, the clip angles are
welded to the main part and bolted to the secondary part.
Otherwise the clip angles are bolted to both parts.
Both parts are bolted.

Main part is welded and secondary part is bolted.

Main part is bolted and secondary part is welded.

Both parts are welded.

Main part is not bolted.

Secondary part is not welded.

Secondary part is not bolted.

Both parts are bolted and welded.
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Bolt group dimensions

 Description
1 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Bolt edge distance.
5 Location where the bolts should be attached.
6 Angle leg length.
7 Location where the bolts should be attached: Site / Workshop.

Bolt settings tab
Use the Bolt settings tab to control the bolts and welds that connect the clip
angle to the main part and to the secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Same bolt length for all

Set this option to Yes to have the same bolt length for all bolts. The longest
bolt defines how long the shorter bolts are with extra length.

Use different settings for secondary parts

Set to Yes to define different settings for the second secondary part. The
default is that the same settings are used for both secondary parts.

Number of clip angle welds

Define the number of welds that connect the clip angle to the main part
and/or the secondary part.

Option Description
Default

Three welds are created to the clip angle.

AutoDefaults can change this option.
Three welds are created to the clip angle.

One weld is created to the clip angle.
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Plate washers tab
Use the Plate washers tab to define the plate washer properties to the main
part and to the secondary parts.

Option Description
Plate washer Plate washer thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Plate washer

Define plate washers for bolts and select the plate washer side.

Option Description
Default

No plate washer

AutoDefaults can change this option.

No plate washer
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Option Description
One plate washer

Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one clip angle or both clip
angles.

Option Description
Select whether the plate washers are
placed symmetrically or
asymmetrically.
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Angle box tab
Use the Angle box tab to add a seat angle.

Seat angle

The purpose of seat angles is to carry loads from the secondary part. Seat
angles can be positioned to top, bottom or both flanges of the secondary part.
The seat angle can be stiffened, and bolted or welded to the main and
secondary parts.

Option Description
Stiffeners Stiffener thickness, width and height.
Top angle NS, Bottom angle NS, Top
angle FS, Bottom angle FS

Select the seat angle profile by
selecting it from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Top seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.
No seat angle is created.
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Option Description
Seat angle is created at the top of the
second secondary part flange.

Seat angle is created at the top of the
first secondary part flange.

Seat angles are created at the top of
both flanges.

Bottom seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.
No seat angle is created.

Seat angle is created at the bottom of
the second secondary part flange

Seat angle is created at the bottom of
the second secondary part flange.

Seat angles are created at the bottom
of both flanges.

Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.
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Option for top seat
angle

Option for bottom seat
angle

Description

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.
Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.
Welded

Seat angle is welded to
the main part and to the
secondary part.

Stiffener type

Option Description
Default

Rectangular stiffener plate

AutoDefaults can change this option.
Rectangular stiffener plate

Triangular stiffener plate

The line connecting the ends of the
seat angle legs defines the stiffener
plate shape.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.
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Option Description
The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the seat angle
corner.

Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally 90
degrees.

To stiffen the rotated seat angle,
select the Middle stiffeners option in
the Middle stiffener position list.

Middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.
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Option Description
Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.

Side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Seat angle offset
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 Description
1 Seat angle horizontal offset from the center line of the main

part.

Chamfer dimensions

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Gap

 Description
1 Top gap and bottom gap between the seat angle and the secondary

part.

BoxPBolts tab
Use the BoxPBolts tab to control properties of the bolts that connect the seat
angle to the main part.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the main part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
main part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

BoxSBolts tab
Use the BoxSBolts tab to control properties of the bolts that connect the seat
angle to the secondary part.

Bolt group dimension

 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
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 Description
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the secondary
part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.
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Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the links below to find out more:

General tab

Design type tab
Click the links below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:
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5.3 Bent plate connections
This section introduces bent plate connection components available in Tekla
Structures.

Click the links below to find out more:

• Bent plate (190) (page 1218)

Bent plate (190)
Bent plate (190) connects two beams or a beam and a column using one or
two bolted or welded bent plates. The secondary beam can be leveled or
sloped and/or skewed. Welded haunch plates are optional.

Objects created

• Bent plate (1 or 2)

• Stiffeners (optional)

• Top and bottom haunch plate (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Bent plate connecting two beams.

The secondary part is skewed.
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Situation Description
Bent plate connected to a column flange.

The secondary part is skewed.

Bent plate connecting two beams.

The secondary part is skewed.

Bent plate connecting two beams.

The secondary part is skewed. The plate can be
placed to various locations.

Bent plate connecting two beams.

The secondary part is skewed and sloped.
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Situation Description
Bent plate connected to a column web.

The secondary part is skewed.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam). The connection is created automatically
when the secondary part is selected.

Part identification key

 Part
1 Bent plate
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the bent plate and to define how
the beam end is cut.
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Dimensions

 Description Default
1 Cut length for the secondary part.

The cutting point is defined from the bent
plate edge.

20 mm

2 Bent plate upper edge distance from the top
of the secondary part.

The upper edge position of the plate
modifies the bent plate height.

Positive value moves the top position closer
to the beam center and thus decreases the
bent plate size. Negative value increases the
bent plate size.

If no value is entered,
bolts and bolt edge
distances define the size
of the plate.

3 Bent plate lower edge distance from the
bottom of the secondary part.

The lower edge position of the plate
modifies the bent plate height.

Positive value moves the bottom position
closer to the beam center and thus
decreases the plate size. Negative values
increase the plate size.

If no value is entered,
bolts and bolt edge
distances define the size
of the plate.

4 Size of the strip made to the secondary part
flange.

The cutting point of the flange is defined
from the bent plate edge.

The flange is
automatically stripped

Steel components reference 1221 Bent plate connections



 Description Default
when the bent plate
crosses the flange.

10 mm
5 Gap between the main part and the bent

plate.
0

Beam end cut

Define how the beam end is cut. The secondary part is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary part slopes less than
10 degrees, a square cut is created.
Otherwise, a bevel cut is made to the
end of the secondary part.
Square

Creates a square cut to the end of the
secondary part.
Bevel

Cuts the end of the secondary part
parallel to the edge of the main part.

Plates tab
Use the Plates tab to control the thickness, position and attachment of the
bent plate. The dimensions on the Picture tab and the Bolts tab also affect
the size of the bent plate.

Bent plate NS/FS

Option Description
Bent plate Bent plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bent plate position

Option Description
Default

Near side and far side bent plate

AutoDefaults can change this option.

Automatic

Near side and far side bent plates are
created automatically.

Near side switched

Creates a near side bent plate with a
leg pointing to the far side.

Far side switched

Creates a far side bent plate with a
leg pointing to the near side.

Far side

Near side
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Option Description
Near side and far side

Main and secondary part attachment type

Option Description
Default

Bent plate is bolted to the main part.

AutoDefaults can change this option.

Automatic

Bolted

Bolted

Welded

Bolted and welded

Attachment point control

Define whether the bent plate is attached to the web or to the flange of the
main part.
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Bolt spacing and weld gap

Option Description
Default

Define the bolt spacing. Weld gap is
not created.

AutoDefaults can change this option.

Define the bolt spacing. Weld gap is
not created.

Define the bolt spacing. Weld gap is
created.

Define the bolt spacing and the weld
gap.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
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Option Description
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Steel components reference 1227 Bent plate connections



Option Description
Line chamfered stiffener plates

Stiffener gap

Option Description
Size of the gap between the flanges
and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.
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Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Steel components reference 1229 Bent plate connections



Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the bent
plate to the main part and to the secondary part.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

3 Number of bolts.
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 Description
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

Staggering of bolts on bent plate

Option Description
Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

The bolts that connect the bent plate
to the secondary part are on the
same horizontal level as the bolts that
connect the bent plate to the main
part.
Bolts on the main part are staggered.

The bolts that connect the bent plate
to the main part are moved
downwards by half the bolt vertical
spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the bent plate
to the secondary part are moved
downwards by half the bolt vertical
spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the bent plate
to the sloped secondary part are
parallel to the secondary part.
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Bolt group dimensions

 Description
1 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Bolt edge distance.
5 Location where the bolts should be attached.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.
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Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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5.4 End plate connections and details
This section introduces components that can be used in end plate connection
and details.

• Column - 2 beams (14) (page 1247)

• Two sided end plate (24) (page 1261)

• End plate (29) (page 1274)

• Cranked beam (41) (page 1289)

• Column splice (42) (page 1302)

• End plate (101) (page 1311)

• End plate with compensating flange plates (111) (page 1322)

• Two-sided end plate with compensating flange plates (112) (page 1333)

• Two sided end plate (115) (page 1345)

• Stub connection (119) (page 1357)

• Two sided end plate (142) (page 1368)

• End plate (144) (page 1398)

• End plate detail (1002) (page 1430)

Column - 2 beams (14)
Column - 2 beams (14) connects two beams to a column. The beam ends rest
on the column. The secondary beams can be horizontal or sloped.

Objects created

• End plates

• Cap plates

• Bolts

• Welds
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Use for

Situation Description
Connection between a column and two beams.

Connection between a column and a beam.

You can use the component with only one
secondary beam but then the settings are more
difficult to define, and there are fewer situations
where the component can be used.

If you use the component with only one secondary
beam, enter a negative value for the gap between
end plates.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.
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Part identification key

 Part
1 Column
2 Beam
3 Beam

Picture tab
Use the Picture tab to control the plate sizes.

Plate 1, 2, 3, 4

Plates 1 and 2 are the end plates on the beams. Plates 3 and 4 are the cap
plates between the columns and the beams.

Option Description
Plate 1, 2, 3, 4 Plate thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Steel components reference 1249 End plate connections and details



Option Description Default
Material Material grade. The default material is defined

in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Plate 3 + 4

Define the type of the connection between the column and beams.

Option Description Example
2 plates Two plates are created.

The column is
chamfered twice.

Folded plate A folded plate is created.
The plate can be
unfolded on a workshop
drawing. The column is
chamfered twice.

1 plate One plate is created. The
plate is always oriented
horizontally. The column
is fitted perpendicularly.
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Option Description Example
Plate perp to column One plate is created. The

column is fitted
perpendicularly, even if
the column is positioned
in a skewed direction.

Plate distances

 Description Default
1 Plate distance from the beam edge. 5 mm
2 Gap between the end plates.

If you use the component with only one
secondary beam, enter a negative value.

 

3 Plate distance from the column edges.  
4 Plate distance from the column center.  

End plates

Select how the end plates are positioned.
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Gap size

Define the limit value for the gap between the end plate and the beam, or for
the gap between the cap plate and the column. Use this when the beam or the
column is slightly curved or sloped to decide if the end angle is so small that
the end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end is fitted to the end plate or to
the cap plate.

The default value is 5 mm.

Bolts 1 - 2 tab
Use the Bolts 1 - 2 tab to control the bolts that connect the end plates.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolts 3/Bolts 4 tabs
Use the Bolts 3 and Bolts 4 tabs to control the bolts that connect the first
secondary beam or the second secondary beam to the column.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Two-sided end plate (24)
Two-sided end plate (24) connects two beams to a column or to a beam
using a bolted end plate. One bolt group goes through all the three parts. This
connection is created and used in the same way as End plate (29) connection.

Objects created

• End plate

• Seat (plate or angle)

• Shim plates

• Stiffeners

• Welds

• Bolts

• Cuts

Use for

Situation Description
Beam-to-column end plate connection.

Beam-to-beam end plate connection.
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Situation Description
End plate connection with shim plates and a seat
angle.

Limitations

Do not use this connection when connecting a beam to a column flange.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate for the first secondary beam
2 Shim plate for the first secondary beam
3 Seat (plate or angle) for the first secondary beam
4 Shim plate for the second secondary beam
5 End plate for the second secondary beam
6 Seat (plate or angle) for the second secondary beam

Steel components reference 1263 End plate connections and details



Picture tab
Use the Picture tab to control the position of the end plate.

End plate position

 Description
1 Gap between the main part and the end plate or the shim plate of the

second secondary beam.
2

3

End plate edge distance from the top or bottom of the second
secondary beam.

4 Gap between the main part and the end plate or the shim plate of the
first secondary beam.

5

6

End plate edge distance from the top or the bottom of the first
secondary beam.

Parts tab
Use the Parts tab to define the properties of the parts created.

Plate

Option Description Default
End plate End plate thickness,

width and height.

The width and height are
defined by the bolt
group edge distances.
The height can also be
entered as a plate edge

half of the bolt
diameter
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Option Description Default
distance from the upper
and lower edge of the
secondary beam.

Seat Define whether a seat is
created under the end
plate.

The seat is created only
if the seat thickness is
entered.

Adding a seat plate
moves the end plate by
default 20 mm below
the secondary beam
bottom.

width = end plate
width
height = secondary
beam height

L seat Define whether a seat
angle is created under
the end plate. The length
of the angle is defined
by the seat width.

If you enter a seat angle
profile, the seat will be
an angle instead of a
plate even if you have
entered the plate
thickness.

Adding a seat angle does
not move the end plate
in the same way as the
seat plate. To avoid
collision between the
angle and the secondary
beam, modify the end
plate or enter a gap
between the end plate
and the seat angle.

width = end plate
width

Fitting plate Shim plate thickness.

The plate is created only
if the plate thickness is
entered.

width and height =
defined by the bolt
group and the shim
plate edge
distances

Number or fitting pl. Define how many shim
plates are created.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the shim plate and end plate positions.

End plate dimensions
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 Description Default
1

4

Vertical bolt edge distance for the shim plates.

The number and spacing of bolts affect the
size of the shim plates.

1.5*bolt diameter

2

3

Gap between the end plate and the seat (plate
or angle).

0 mm

5

6

Horizontal bolt edge distance for the shim
plates.

 

Shim plate and end plate positions

Define the position of the shim plates and the end plate in the second
secondary beam. The plates move in relation to the plates in the first
secondary beam. By default, the plates in the second secondary beam are
positioned so that holes are placed symmetrically. You may need to move the
plates, for example, when connecting skew or curved secondary beams.

 Description
1 Define how much the plates are moved in vertical direction.
2 Define how much the plates are moved in horizontal direction.

Gap size

Define the limit value for the gap between the end plate and the secondary or
main beam. Use this gap when the beam is slightly curved or sloped to decide
if the end angle is so small that the beam end can be straight.
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If the actual gap is smaller than this value, the beam end is left straight.

If the actual gap is larger than this value, the beam end is fitted to the end
plate.

Notch tab
Use the Notch tab to modify the horizontal and vertical cuts.

Cut dimensions

 Description Default
1 Dimensions for the horizontal

flange cuts.
10 mm

2 Dimensions for the vertical
flange cuts.

The gap between the notch edge
and the beam flange is equal to the
main part web rounding. The notch
height is rounded up to the nearest
5 mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts used.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

End plate (29)
End plate (29) connects a beam to a column or two beams to each other using
a bolted end plate. Stiffeners, seats and shim plates are optional.

Objects created

• End plate

• Seat angle or seat plate (optional)

• Shim plates (optional)

• Stiffeners (optional)

• Bent plate (optional)

• Welds

• Bolts

• Cuts
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Use for

Situation Description
Beam-to-column end plate connection.

Beam-to-beam end plate connection.

End plate connection with a shim plate and a
seat angle.
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Situation Description
End plate connection with stiffeners.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.

Part identification key

 Part
1 Shim plate
2 End plate
3 Seat (plate or angle)
4 Stiffener

Picture tab
Use the Picture tab to control the position of the end plate.
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End plate position

 Description Default
1 End plate top position from the top of the

secondary beam.

If no value is entered, bolts and bolt edge
distances define the size of the end plate.
If you give both values, the position
distance override the bolt edge distance
values.

10 mm

2 End plate bottom position from the
bottom of the secondary beam.

 

3 Gap between the shim plate and the main
part.

If the shim plate does not exist, the
defined gap is created between the end
plate and the main part.

0 mm

Parts tab
Use the Parts tab to define the properties of the parts.

Plate

Part Description Default
End plate End plate thickness,

width and height.

The width and height are
defined by the bolt

half of the bolt
diameter
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Part Description Default
group edge distances.
The height can also be
entered as a plate edge
distance from the upper
and lower edge of the
secondary beam.

Seat Define whether a seat is
created under the end
plate.

The seat is created only
if the seat thickness is
entered.

Adding a seat plate
moves the end plate by
default 20 mm below
the secondary beam
bottom.

width = end plate
width
height = secondary
beam height

L seat Define whether a seat
angle is created under
the end plate. The length
of the angle is defined
by the seat width.

If you enter a seat angle
profile, the seat will be
an angle instead of a

width = end plate
width

Steel components reference 1278 End plate connections and details



Part Description Default
plate even if you have
entered the plate
thickness.

Adding a seat angle does
not drag the end plate in
the same way as the
seat plate. To avoid
collision between the
angle and the secondary
beam, modify the end
plate or enter a gap
between the end plate
and the seat angle.

Fitting Plate Shim plate thickness.

The plate is created only
if the plate thickness is
entered.

width = defined by
the bolt group and
the shim plate edge
distances

Number of fitting pl.
(DEF=1)

Define how many shim
plates are created.

Folded Plate Bent plate thickness,
width and height.

The plate is created only
if the plate thickness is
entered.

Bent plate can also be
used with ordinary shim
plates.

width = determined
from the bolt group
inner bolts

Stiffeners Define whether
stiffeners are created to
the column when a
beam is connected to
the column flange.

If you enter one of the
dimensions, stiffeners
are created.

thickness = 20 mm
width = width of the
column flange
height = height of
the column web

Upper horiz stiff Define whether
horizontal stiffeners are
created to the beam.

If you enter one of the
dimensions, stiffeners
are created.

thickness = 20 mm
width = width of the
beam flange
height = 300 mm

Lower horiz stiff
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the stiffener position and orientation.

Material of folded plate

Select the material of the bent plate. The default material is defined in the
Folded plate box on the Components tab in File menu --> Settings -->
Options.

.
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Stiffener positions

 Description Default
1

4

Distance between the beam horizontal
stiffener and the beam end.

 

2

3

Distance between the beam horizontal
stiffener and the beam flange.

0.25*beam height

5 Distance between the stiffener and the
main part flange.

 

6

7

Distance between the main part stiffener
and the beam flange.

 

Bent shim plate and seat length
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 Description Default
1 Length of the horizontal part of the bent

shim plate.
 

2 Distance between the end plate and the
seat.

When using seat angles, change either this
value or the size of the end plate to avoid
collision between the secondary beam and
the angle.

20 mm

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.
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 Description
1 Vertical bolt edge distance in the shim plate.

The size of the shim plate is defined by the bolt group and the edge
distances. Vertical and horizontal edge distance define the distance
symmetrically. Positive dimension increases the shim plate size.

2 Horizontal bolt edge distance in the shim plate.

The size of the shim plate is defined by the bolt group and the edge
distances. Vertical and horizontal edge distance define the distance
symmetrically. Positive dimension increases the shim plate size.

Gap size to end plate

Define the limit value for the gap between the end plate and the secondary or
main part. Use this gap when the beam is slightly curved or sloped to decide if
the end angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the beam end is left straight.

If the actual gap is larger than this value, the beam end is fitted to the end
plate.

Bolts tab
Use the Bolts tab to control the properties of the bolts.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to modify the horizontal and vertical cuts.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab
Click the link below to find out more:

General tab

Design tab
Design tab

Analysis tab
Analysis tab

Welds

Click the link below to find out more:

Cranked beam (41)
Cranked beam (41) connects two beam ends. The beam ends are fitted to an
angle which is an average of the beam end angles. A plate can be created
between the connected parts.
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Objects created

• End plates

• Haunch plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Beam ends are fitted.

Beam ends are fitted. Tubular profiles
are used.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 End plate
2 Haunch plate
3 Stiffener

Picture tab
Use the Picture tab to define the geometry of the connection.

Dimensions

 Description
1 Define the gap between the parts.

The gap is created on both sides of the end plate.
2 Define the end plate edge distance from the top of the

secondary part.
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 Description
3 Define the end plate edge distance from the bottom of the

main part.
4 Define the end plate edge distance to the left and right

edge of the secondary part.

Parts tab
Use the Parts tab to define the properties of the end plates, haunch plates,
and stiffeners.

Parts

Part Description
Plate Thickness, width and height of the end plate.
Sec plate Thickness, width and height of the secondary

end plate.
Haunch prof Select the haunch profile from the profile

catalog.
Vert haunch pl Thickness of the vertical haunch plate.
Horiz haunch pl Thickness and width of the horizontal

haunch plate.
Haunch prof 2 Select the second haunch plate profile from

the profile catalog.
Vert haunch pl 2 Thickness of the second vertical haunch

plate.
Horiz haunch pl 2 Thickness and width of the second horizontal

haunch plate.
Column stiffener Thickness, width and height of the column

stiffener.
Beam stiffener Thickness, width and height of the column

stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the plate positions and dimensions.

Plate positions and dimensions

 Description
1 Gap between the end plates.

You can define the gap either as a distance or as an angle.
2 Select whether the gap is defined as a distance or as an

angle (degrees).

By default, the gap is created as a distance.
3 Haunch plate height
4 Gap between the stiffeners and beam flanges
5 Stiffener edge distance to the haunch edge
6 Haunch plate length
7 Haunch plate chamfer size
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Parallel haunch end cuts

If you have selected the haunch profile from the profile catalog, you can select
that the haunch ends are cut parallel.

Chamfer dimensions

  
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Dimension for vertical bolt group position.
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 Description
4 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

5 Dimension for horizontal bolt group position.
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 Description
6 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Chamfers tab
Use the Chamfers tab to define the chamfer types and dimensions for the
haunch plate chamfers.

Chamfers

You can define each chamfer separately.

Holes tab
Use the Holes tab to define the holes created in the end plates.
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Hole dimensions

You can define the holes separately for the main part end plate and the
secondary part end plate. The main part end plate values are used as default
values for the secondary part end plate.

Option Description
Define the hole group dimensions in
the rafter.

Define the hole group dimensions in
the haunch.
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Bolt standard

Select the bolt standard.

Bolt type

Select the bolt type to define the location where the bolts should be attached.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Column splice (42)
Colunm splice (42) connects two columns (or beams) using splice plates
bolted to the flanges and webs of both parts. Shim plates are also created
when the dimensions of the columns differ.

Objects created

• Web plates

• Flange plates

• Shim plates (optional)

• Bolts
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Use for

Situation Description
Splice plates bolted to the flanges and
webs of both parts.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam or column).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Web plate
2 Flange plate
3 Shim plate

Picture tab
Use the Picture tab to define the plate positions.
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Dimensions

 Description Default
1 Gap between the main part and the

secondary part.
0 mm

2 Shim plate thickness 10 mm
3 Web plate dimensions on the main part

and the secondary part.
 

Part tab
Use the Parts tab to define the properties of the plates.

Plates

Option Description
Web plates Thickness, width and height of the

web plates.
Flange plates Thickness, width and height of the

flange plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the lifting hole creation, dimensions, and
web plate creation.

Lifting hole creation

Option Description
Default

Lifting hole is not created.

AutoDefaults can change this option.

Lifting hole is not created.
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Option Description
Lifting hole is created.

Lifting hole dimensions

 Description
1 Diameter of the lifting hole.
2 Horizontal dimension for the lifting hole offset from the web

plate center line.
3 Vertical dimension from the lifting hole center to the part

edge.

Web plates

Option Description
Default

Both web plates are created.

AutoDefaults can change this option.
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Option Description
Both web plates are created.

Right side web plate is created.

Left side web plate is created.

Web bolts tab
Use the Web bolts tab to define the bolt group dimensions and bolt
properties.

Bolt group dimensions

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select the bolt type.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Flange bolts tab
Use the Flange bolts tab to define the bolt group dimensions and bolt
properties.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the

Yes
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Option Description Default
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab
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End plate (101)
End plate (101) connects a beam to another beam or to a column using an
end plate. The end plate is welded to the secondary beam and bolted to the
main part (beam or column).

Objects created

• End plate

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam to beam connection with a bolted end plate.

Beam to column connection with a bolted end plate.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.
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Part identification key

 Part
1 End plate

Picture tab
Use the Picture tab to control the position of the end plate.

End plate position

 Description Default
1 Gap between the main part and the end

plate.
2 mm

2 End plate edge distance to the secondary
part flange.

 

End plate tab
Use the End plate tab to control the properties of the end plate.

Plate

Part Description
End plate Define the end plate thickness and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Option Description
End plate edge type Define how the end plate is cut. The

default is Rolled/Sawn.
Adapt to secondary part slope Select whether to align the end plate

with the secondary part slope.

Notch tab
Use the Notch tab to create notches for the secondary beam and to control
the notch properties.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.
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Option Option Description

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.
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Option Description
Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center

line of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

End plate with compensating flange plates (111)
End plate with compensating flange plates (111) connects a beam to
another beam using an end plate with compensating flange plates. The end
plate is welded to the secondary beam and bolted to the main beam.

Objects created

• End plate

• Compensating flange plates

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Connection with an end plate and compensating
flanges.

Connection with an end plate and compensating
flange plates.

The secondary beam is sloped.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 End plate
2 Compensating flange plate
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Picture tab
Use the Picture tab to control the position of the plates.

Dimensions

 Description
1 Gap between the main beam and the end plate.
2 Distance from the inner edge of the flange plate to the secondary

beam flange.
3 Distance from the outer edge of the flange plate to the secondary

beam flange.
4 End plate edge distance to the main beam flange.

Description
1 Horizontal chamfer dimension of the flange plate.
2 Flange plate dimension that remains when a chamfer is created.
3 Inner chamfer dimension of the flange plate.

Parts tab
Use the Parts tab to control the plate properties.
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Plate

Part Description
End plate Define the end plate

thickness and height.
Compensating flange
plate

Define the flange plate
thickness, width, and
height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Notch tab
Use the Notch tab to create notches for the secondary beam and to control
the notch properties.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.
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Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
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Option Option Description
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
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Option Description
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.

Steel components reference 1330 End plate connections and details



Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Two-sided end plate with compensating flange plates (112)
Two-sided end plate with compensating flange plates (112) connects a
beam to two beams using end plates with compensating flange plates. The
end plates are welded to the secondary beams and bolted to the main beam.

Objects created

• End plates

• Compensating flange plates

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Connection with end plates and compensating
flange plates.

Connection with end plates and compensating
flange plates.

Secondary beams are sloped.

Selection order

1. Select the main part (beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate
2 Compensating flange plate
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Picture tab
Use the Picture tab to control the position of the end plates and
compensating flange plates.

Dimensions

 Description
1 Gap between the main beam and the end plate.
2 End plate edge distance to the secondary beam flange.
3 Distance from the inner edge of the flange plate to the secondary

beam flange.
4 Distance from the outer edge of the flange plate to the secondary

beam flange.

 Description
1 Inner chamfer dimension of the flange plate.
2 Horizontal chamfer dimension of the flange plate.
3 Flange plate dimension that remains when a chamfer is created.

Parts tab
Use the Parts tab to control the plate properties.
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Plate

Part Description Default
End plate, Second end
plate

Define the end plate thickness
and height.

If you have defined the gap
between the main beam and the
end plate on the Picture tab, the
length entered on the Parts tab
is not taken into account.

If the secondary
part width is less
than 200mm, the
thickness of the
end plate is 8mm.
Otherwise, it is
10mm.

Compensating flange
plate, Second
compensating flange
plate

Define the flange plate
thickness, width, and height.

The same values are used for
the top and the bottom plates.

Width = The
default value is
based on rounding
(beam flange width
- beam web
thickness) / 2.0.

Height = 150mm
more than the
notch length

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Move plates 2 in y-direction

You can move the flange plates and the end plate on the second secondary
beam side in the y-direction. By default, the plates on the second secondary
side are positioned so that the holes are symmetric. To use this option, set the
horizontal bolt group position to the Middle position and define the horizontal
bolt group dimension on the Bolts tab. Moving the plates is useful especially
when the secondary beams are skewed or curved.
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Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
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Option Option Description
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
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Option Option Description
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

Steel components reference 1341 End plate connections and details



 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2
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Option Description
Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Two sided end plate (115)
Two sided end plate (115) connects two beams to a beam or a column using
end plates. The end plates are welded to the secondary beams and bolted to
the main part (beam or column).

Objects created

• End plates (2)

• Bolts

• Welds

• Cuts

Use for

Situation Description
End plates with two secondary beams. Automatic
notching for bolt clearance.
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Situation Description
End plates with two secondary beams at different
heights.

End plates with two secondary beams.

A square and a skewed secondary beam.

End plates with two secondary beams. Safety
connection.

End plates with two sloped secondary beams.
Various notching options.

Selection order

1. Select the main part (beam or column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).
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4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate

Picture tab
Use the Picture tab to control the position of the end plates.

Dimensions

 Description Default
1 Gap between the main part and the end

plate.
2 mm

2 End plate edge distance to the secondary
beam flange.

50 mm

End plates tab
Use the End plates tab to control the properties of the end plates.
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Plate

Part Description
End plate, 2nd End plate Define the end plate thickness and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Move plates 2 in y-direction

You can move the end plate on the second secondary beam side in the y-
direction. By default, the plates on the second secondary side are positioned
so that the holes are symmetric. To use this option, set the horizontal bolt
group position to the Middle position and define the horizontal bolt group
dimension on the Bolts tab. Moving the plates is useful especially when the
secondary beams are skewed or curved.
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End plate Edge Type

Define how the end plate is cut. The default is Rolled/Sawn.

Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch
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Option Option Description
Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
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Option Description
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolts properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stub connection (119)
Stub connection (119) creates a connection between an H(I) type of column
and a beam. The beam can be of any type. The connection can create eight
stiffener plates and four haunch plates. The end plates are bolted to each
other, and the other plates are welded.

Objects created

• End plates

• Haunch plates

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
Stub connection with bolted end
plates and haunch plates.

The secondary part can be skewed or
sloped. Top and bottom haunch
plates can be created.

1 Secondary part web not directed to
the center of the column (top view).

2 Secondary part web not
perpendicular to the column
horizontally (top view).

3 Secondary part web not
perpendicular to the column vertically
(side view).

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).
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Part identification key

 Description
1 Stiffener plates
2 End plates
3 Haunch plates

Picture tab
Use the Picture tab to define end plate and stiffener dimensions.

Dimensions
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 Description Default
1 Distance from the column to the first end plate.

If the secondary part web is not perpendicular to
the column horizontally, this is the minimum
distance from the column to the first end plate.

100 mm

2 Distance between the end plates. 0 mm
3 Gap between the end plate and the beam web.  

 Descriptioin Default
1 Distance between the exterior face of the beam and

the exterior face of the front stiffener.
0 mm

2 Angle between the bottom front stiffener and the
horizon.

(This angle is valid only in the regular case).

0 degrees

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Top plate

Bottom plate

Middle plate

Thickness of the top, bottom and
middle plate.

Upper haunches

Lower haunches

Thickness of the upper and lower
haunches.

End plate 1 Thickness, width and height of the
end plate.
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Option Description
End plate 2 Thickness of the end plate.
Top stiffener

Bottom stiffener

Middle stiffener

Thickness of the top, bottom and
middle stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the stiffener creation, position and
chamfers.

Stiffener creation

Option Description
Default

Full

Creates a full stiffener of the same
height as the web of the main part.

AutoDefaults can change this option.
Full

Creates a full stiffener of the same
height as the web of the main part.
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Option Description
Full, both sides of the main part

Creates a full stiffener of the same
height as the web of the main part.

Stiffener gap

 Description
1 Distance between the stiffener and the column web
2 Distance between the stiffener and the column flange

Stiffener positions

 Description
1 Size of the gap between the top stiffener and the beam flange

edge.
2 Size of the gap between the bottom stiffener and the beam

flange edge.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to define the bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

2 Dimension for vertical bolt group position.
3 Dimension for horizontal bolt group position.
4 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

6 Number of bolts.
7 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

8 Define which bolts are deleted from the bolt group.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Two sided end plate (142)
Two sided end plate (142) connects two beams to a beam or to a column
using bolted end plates. One bolt group goes through all the three parts.

Objects created

• End plates

• Shim plates

• Compensating flange plates (optional)

• Haunch plates (optional)

• Holes

• Bolts

• Welds

• Cuts
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Use for

Situation Description
End plate connection with two secondary parts.

Automatic notching for bolt clearance.

End plate connection with two secondary parts
and with a haunch plate.

Automatic notching for bolt clearance.

End plate connection with two secondary parts
at different heights.

End plate connection with two secondary parts.

The secondary parts can be square and/or
skewed.
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Situation Description
End plate connection with two secondary parts.

Safety connection.

End plate connection with two secondary parts.

The secondary parts can be leveled and/or
sloped.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate for the first secondary part
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 Part
2 Shim plate for the first secondary part
3 End plate for the second secondary part
4 Shim plate for the second secondary part
5 Compensating flange plate for the first secondary part
6 Compensating flange plate for the second secondary part

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the positions of the end plates and
compensating flange plates.

Plate positions

 Description
1 End plate upper edge distance from the top of the first secondary

beam.
2 End plate lower edge distance from the bottom of the first secondary

beam.
3 End plate lower edge distance from the bottom of the second

secondary beam.
4 End plate upper edge distance from the top of the second secondary

beam.
5 Gap between the shim plates and the main part.

Gap for each side individually. If the shim plates are not used, the
defined gap is created between the end plate and the main part.

6 Upper compensation flange plate edge distance from the top of the
first secondary beam.
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 Description
7 Lower compensation flange plate edge distance from the top of the

first secondary beam.
8 Upper compensation flange plate edge distance from the top of the

second secondary beam.
9 Lower compensation flange plate edge distance from the top of the

first secondary beam.

Compensation flange plate arrangements

Option Description
Default

Compensation flange plates are not
created.

AutoDefaults can change this option.

Compensation flange plates are not
created.

Compensation flange plates are
created.

Egde distance from the top of the
secondary part.

Compensation flange plates are
created.

Edge distance from the top of the
main part.
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Compensating flange plate shapes

 Description
1 Compensating flange plate dimension that remains when a

chamfer is created.
2 Horizontal chamfer dimension of the compensating flange

plate.
3 Inner chamfer dimension of the compensating flange plate.

Sort secondaries by profile height

When you create a Two sided end plate (142) connection, the larger of the
two profiles is usually selected as the first secondary beam. If the profile is
later changed and the second secondary beam becomes larger than the first
secondary beam, the order of secondary beams can be redefined.

• Yes switches the secondary beams so that the largest beam automatically
becomes the first secondary beam.

• No does not change the order of secondary beams if the profile size is
changed.

Plates 1 tab
Use the Plates 1 tab to control the size of the end plate, shim plates and
compensating flange plates for the first secondary beam.

Plates

Option Description Default
End plate End plate thickness,

width and height.
thickness = 10 mm
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Option Description Default
Fitting Plate 1

Fitting Plate 2

Fitting Plate 3

Shim plate thickness.

The plate is created only
if the plate thickness is
given.

You can define up to
three different shim
plates.

0

Number of fitting pl. 1
(DEF=1)

Number of fitting pl. 2
(DEF=1)

Number of fitting pl. 3
(DEF=1)

Number of shim plates
for each thickness.

By default, 1 plate is
created.

Comp. flange pl Compensation flange
plate thickness, width
and height.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.
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 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.
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Option Description
Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.

Shim plate position

Option Description
Default

Shim plates are outside the main
part.

AutoDefaults can change this option.
Shim plates are outside the main
part.

Shim plates are inside the main part.

Gap size
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Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Safety connections

In two-sided connections the safety connection options improve safety during
erection. Safety connection options move the end plate or create different
notches so that some of the bolts are in single shear instead of double shear.
This allows the first secondary beam to be connected while the crane moves
to get the next beam.

Option Description
Default

End plate with no notches.

AutoDefaults can change this option.

End plate with no notches.

One end plate is moved up to create a
safety connection.

One end plate is moved down to
create a safety connection.

One opposite upper corner of each
end plate is notched to create a safety
connection

One opposite upper corner of each
end plate is notched to create a safety
connection.
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Option Description
Diagonal opposite corners of each
end plate are notched to create a
safety connection.

Diagonal opposite corners of each
end plate are notched to create a
safety connection.

Safety connection location

Option Description
Default

Affects both the near side and the far
side end plates.

AutoDefaults can change this option.
Affects both the near side and the far
side end plates.

Affects only the near side end plate.

Affects only the far side end plate.

Safety connection cut type

Option Description
Default

Square cut. This selection affects only
safety connections that are created
with cuts. It does not affect safety
connections that shorten the plate.

AutoDefaults can change this option.
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Option Description
Square cut

Line cut

Concave arc cut

Safety connection cut dimensions

Option Description
Vertical cut/offset Define the height of the notch or the

vertical offset of the end plate.
Horizontal cut Define the width of the notch in the

end plate.
Radius Define the radius of the concave arc

cut.

Plates 2 tab
Use the Plates 2 tab to control the size of the end plate, shim plates and
compensating flange plates for the second secondary beam.

Plates

Option Description Default
End plate End plate thickness,

width and height.
thickness = 10 mm

Fitting Plate 1

Fitting Plate 2

Fitting Plate 3

Shim plate thickness.

The plate is created only
if the plate thickness is
given.

You can define up to
three different shim
plates.

0
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Option Description Default
Number of fitting pl. 1
(DEF=1)

Number of fitting pl. 2
(DEF=1)

Number of fitting pl. 3
(DEF=1)

Number of shim plates
for each thickness.

By default, 1 plate is
created.

Comp. flange pl Compensation flange
plate thickness, width
and height.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.
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 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.
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Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.

Shim plate position

Option Description
Default

Shim plates are outside the main
part.

AutoDefaults can change this option.
Shim plates are outside the main
part.

Shim plates are inside the main part.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Shim plate and end plate positions

Define the position of the shim plates and the end plate in the second
secondary beam. The plates move in relation to the plates in the first
secondary beam. By default, the plates in the second secondary beam are
positioned so that holes are placed symmetrically. You may need to move the
plates, for example, when connecting skew or curved secondary beams.
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 Description
1 Define how much the plates are moved in vertical direction.
2 Define how much the plates are moved in horizontal direction.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate, Top plate 2 Top haunch plate thickness, width

and height.
Bottom plate, Bottom plate 2 Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Haunch plate creation

Option for the second
secondary beam

Option for the first
secondary beam

Description

Default

Top and bottom haunch
plates are created, if
needed.

AutoDefaults can change
this option.
Automatic

Top or bottom haunch
plate or both are
created, if needed.

Top and bottom haunch
plates are always
created.

To create a single plate,
enter 0 in the thickness
(t) field for the haunch
plate you do not need
(top or bottom plate).
Haunch plates are not
created.

Haunch plate chamfers
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Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal

flange cuts.
10 mm

2 Dimensions for the vertical
flange cuts.

The gap between the notch edge
and the beam flange is equal to the
main part web rounding. The notch
height is rounded up to the nearest
5 mm.

Bolts tab
Use the Bolts tab to control the properties of bolts that connect the end plates
to the main part.
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Bolt group dimensions

Bolt group dimensions affect the size of the end plates.

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

Steel components reference 1390 End plate connections and details



 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for horizontal bolt group position.
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 Description
7 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Holes tab
Use the Holes tab to control the galvanizing holes in the end plates.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option for the first
secondary beam

Option for the second
secondary beam

Description

Default

No holes

AutoDefaults can change
this option.

Steel components reference 1395 End plate connections and details



Option for the first
secondary beam

Option for the second
secondary beam

Description

No holes

1 hole

2 holes

4 holes

Hole positions

Hole positions in the end plate of the first secondary beam.
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Hole positions in the end plate of the second secondary beam.

 Description
1 Horizontal distance between the secondary beam center and the

upper hole.
2 Horizontal distance between the secondary beam center and the

lower hole.
3 Vertical distance between the secondary beam center and the

upper hole.
4 Vertical distance between the secondary beam center and the

lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.
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General tab
Click the link below to find out more:

General tab

Design type tab
Click the link below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

End plate (144)
End plate (144) connects a beam to a column or two beams to each other
using a bolted end plate. The secondary part can be leveled or sloped.

Objects created

• End plate

• Bent plate

• Shim plates (optional)

• Stiffeners (optional)

• Haunch plates (optional)

• Holes

• Bolts

• Seat angles

• Welds

• Cuts
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Use for

Situation Description
Beam-to-beam end plate connection.

The secondary part can either be leveled or
sloped, or squared or skewed.

There are several notching options.

Beam-to-beam end plate connection.

Extended plate with or without haunch plates.

End plate connection to a column flange or web.

The secondary part can either be leveled or
sloped, or squared or skewed.
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Situation Description
Full depth end plate connection to a column
flange or web.

The secondary part can either be leveled or
sloped, or squared or skewed.

End plate connection to a column web.

Extended plate with haunch plates.

End plate connection to a column flange with
column stiffener.

Column end plate connection.

The secondary part is rotated.
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Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically.

Part identification key

 Part
1 End plate
2 Shim plate
3 Stiffener
4 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Example: Add an end plate using End plate (144)
In this example, you will connect a beam to a column using an end plate
connection. End plate (144) connects two beams, or a beam to a column,
using a bolted end plate.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Type 144 in the search box.

3. Double-click End plate (144) to open the component properties.

4. Click Apply to add the component using the default properties.

5. Select the main part (column).

6. Select the secondary part (beam). 
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Tekla Structures automatically adds the connection when you select the
beam.

Picture tab
Use the Picture tab to control the position of the end plate.

End plate position

 Description Default
1 End plate upper edge distance from the top

of the secondary beam.

A positive value moves the top position
closer to the beam center and thus
decreases the plate size. Negative values
increase the plate size.

10 mm

2 End plate lower edge distance from the
bottom of the secondary beam.

 

Steel components reference 1402 End plate connections and details



 Description Default
3 Gap between the shim plate and the main

part.

If the shim plate is not used, the defined
gap is created between the end plate and
the main part.

0

Plates tab
Use the Plates tab to control the size of the end plate, bent plate, and shim
plates.

Plates

Option Description Default
End plate End plate thickness, width and

height.

The width and height are
defined by the bolt group
edge distances.

thickness = 10 mm

Folded Plate Bent plate thickness, width
and height.

The plate is created only if the
plate thickness is given.

thickness = 0
width = bolt
horizontal spacing
value - (1.5*the
bolt diameter)
height = 200 mm

Fitting plate 1, 2,
3

Shim plate thickness.

The plate is created only if the
plate thickness is given.

You can define up to three
different shim plates.

0

Number of fitting
plates

Number of shim plates for
each thickness.

By default, 1 plate is
created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bent shim plate length

Define the horizontal length of the bent shim plate. The default is 10*bent
plate thickness.

Shim plate position

Option Description
Default

Shim plates are created outside the
main part.

AutoDefaults can change this option.

Shim plates are created outside the
main part.

Shim plates are created inside the
main part.
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Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.
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Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.

 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim plate. 30 mm

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
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Option Description
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Steel components reference 1408 End plate connections and details



Option Description
Line chamfered stiffener plates

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions
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Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.
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Option Description
Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.
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Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
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Option Description
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.
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Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the end
plate to the main part.

Bolt group dimensions

Bolt group dimensions affect the size of the end plate.

 Description
1 Dimension for horizontal bolt group position.

Steel components reference 1418 End plate connections and details



 Description
2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

8 Distance from the bottom of the beam to the lowest bolt.
9 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes tab
Use the Holes tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.
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Option Description
No holes

1 hole

2 holes

4 holes
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Hole positions

 Description
1 Horizontal distance between the secondary beam center and the upper

hole.
2 Horizontal distance between the secondary beam center and the lower

hole.
3 Vertical distance between the secondary beam center and the upper

hole.
4 Vertical distance between the secondary beam center and the lower

hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

Angle box tab
Use the Angle box tab to add a seat angle. The purpose of seat angles is to
carry loads from the secondary beam.

Seat angle

Option Description
Top angle, Bottom angle Seat angle thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Seat angle position

Seat angles can be located on the top, bottom or both flanges of the
secondary part.

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.

No seat angle is created.
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Option Description
A seat angle is created at the top of
the flange of the beam.

A seat angle is created at the bottom
of the flange of the beam.

Seat angles are created on both sides
of the flange of the beam.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary beam.

AutoDefaults can change this option.
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Option Description
The longer leg of the seat angle is
connected to the secondary beam.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the angle seat
corner.

General tab
Click the link below to find out more:

General tab

Design type tab
Click the link below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab
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Welds
Click the link below to find out more:

End plate detail (1002)
End plate detail (1002) creates an end plate that is welded to a beam end.

Objects created

• End plate

Use for

Situation Description
End plate at a beam end.

Selection order

1. Select the main part (beam).

2. Pick a position.

The detail is created automatically when the point is picked.

Picture tab
Use the Picture tab to control the end plate distances from the beam edges.
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Positive values move the end plate closer to the beam axis and thus decrease
the plate size. Negative values increase the plate size.

The default distances from the upper and the lower edge are 10 mm.

The default distances from the right and the left edge are 0mm.

For rectangular tube profiles all the distances are 3 mm by default.

Parts tab
Use the Parts tab to control the end plate properties.

Option Description
End plate Define the end plate thickness, width and height.

By default, the thickness is 1.5*beam web thickness
rounded up to the next plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

5.5 Welded connections
This section introduces welded connection components available in Tekla
Structures.

• Offshore (9) (page 1432)

• Fitting (13) (page 1439)

• Round tube (23) (page 1443)

• Welded column (31) (page 1446)

• Weld preparation (44) (page 1450)

• New notch (49) (page 1453)

• Welded column with stiffeners (128) (page 1458)

• Beam prep (183) (page 1478)

• Cap plate detail (page 1494)

• Pipe doubler plate (page 1499)

• Ring plate (page 1506)
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Offshore (9)
Offshore (9) connects a beam to another beam with welds. The component is
designed to be used in offshore industry for creating notches and complex
weld access holes, and to control the notch properties.

Objects created

• Notches

• Welds

Use for

Situation Description
Connection between two beams.

Profile limitations

You can create three different notch types:

• Free

• Heerema

• HSM

When creating a Free notch type, the main and the secondary beam do not
always have to have the same size. You can set them up according to your
needs and create the connection.

When creating Heerema and HSM notch types, the beam size depends on the
selected Heerema and HSM settings.

For all Free and Heerema types, and most HSM types, skewed secondary
beams are allowed. Sloped secondary beams are only supported by some
specific HSM types. See the table below for examples.
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Notch
type

Example

Free

HSM

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Beam
2 Beam
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Picture 1 tab
Use the Picture 1 tab to create notches in the direction of the web.

Notch type

Select the notch type and enter the notch values, if needed.

Option Description
Free Enter the notch dimensions.
Heerema When you select this option, the predefined Heerema

options are listed below.

The predefined values are entered automatically in the
user-defined attributes of the secondary beam.

HSM When you select this option, the predefined HSM options
are listed below.

The predefined values are entered automatically in the
user-defined attributes of the secondary beam.

No and
clean up
UDA

No notch is created.

The user-defined attributes have no values.

Notches

 Description
1 Define the top flange notch for the secondary beam.
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 Description
2 Define the bottom flange notch for the secondary

beam.
3 Define a gap between the main beam web and the

secondary beam end.

4 Define the bottom rounding and a possible weld access
hole for the secondary beam.

5 Define the top rounding and a possible weld access
hole for the secondary beam.

6 Create a cut that follows the sloped flange of the
secondary beam.

Fitting

Select the type of the fitting.

Picture 2 tab
Use the Picture 2 tab to create notches in the direction of the flange. The
options on this tab can only be used if the notch type is set to Free on the
Picture 1 tab. If you select a special type of notch (Heerema, HSM) on the
Picture 1 tab, then the predefined values are entered automatically in the
user-defined attributes.
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Notches

 Description
Define the bevel angle for the top flange (optional).

Define the top flange bevel.

Define the bottom flange bevel.

Define the bevel angle for the bottom flange (optional).

Weld description tab
Use the Weld description tab to control weld descriptions for the top, web
and bottom welds.
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 Description
Top weld

Web weld

Bottom weld

Use the boxes on the Weld description tab to define a name for the weld
comment. Enter the text WELD_COMMENT in the UDA field. The descriptions in
the Top, Web and Bottom boxes correspond to each weld.

Double-click a weld in the model and go to the user-defined attributes of the
weld. The text is entered in the Weld Comment box.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Fitting (13)
Fitting (13) connects a beam to a beam using welds.

Objects created

• Stiffeners (2) (optional)

• Welds
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Use for

Situation Description
Fitting connection without stiffeners.

Fitting connection with upper and
lower stiffener.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.
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Part identification key

 Part
1 Upper stiffener
2 Lower stiffener

Picture tab
Use the Picture tab to control the fitting dimensions.

Dimensions

 Description
1 Stiffener horizontal distance from the secondary beam edge.
2 Stiffener vertical distance from the secondary beam edge.
3 Distance between the main beam and the secondary beam.

Option Description
Max gap allowed to end plate Enter the tolerance value for fitting

the secondary part.

Use this option when the secondary
part is skewed. The gap is calculated
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Option Description
using the skew angle and the height
of the secondary profile.

If the gap is within the tolerance
value, the secondary part is fitted in
the main part coordinate system.
When the defined maximum gap is
greater than the actual gap in the
model, the secondary part is fitted in
the secondary part coordinate
system.

Weldings Select whether welds are created.

Welds are created when you select
Yes. The default is that welds are not
created.

Parts tab
Use the Parts tab to control the stiffener properties.

Stiffener

Part Description
Upper stiffeners Thickness, width, and height of the

upper stiffener.
Lower stiffeners Thickness, width, and height of the

lower stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Round tube (23)
Round tube (23) connects two round tube profiles with a fitting and welds.

Objects created

• Fitting

• Welds

Use for

Situation Description
Connection between two round
tubes.

Fitting and welds are created.
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Selection order

1. Select the main part (first round tube).

2. Select the secondary part (second round tube).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Round tube
2 Round tube

Picture tab
Use the Picture tab to control the dimensions of the secondary round tube
fitting and the gap between the round tubes.

Part dimensions

 Description Default
1 Pop mark offset.

You can define the offset if you have set
the Position of pop mark option to At
minimum angle, At maximum angle, or
Both.

100 mm

2 Pop mark diameter.

You can define the diameter if you have
set the Position of pop mark option to At
minimum angle, At maximum angle, or
Both.

10 mm
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 Description Default
3 Gap between the main and the secondary

round tube.
 

Secondary part fitting

Option Description
Default

The secondary round tube is cut with
the main round tube.

AutoDefaults can change this option.
The secondary round tube is cut with
the main round tube.

The secondary round tube is fitted to
the center line of the main round
tube and then cut.

Position of pop mark

Select the position of the pop mark.

Parameters tab
Use the Parameters tab to control whether welds are created and to define
the rotation angle and cut tolerance.

Option Description
Weldings Define whether welds are created

between the round tubes.
Rotation angle of cut part Define the rotation angle of the cut in

the main round tube.

In some cases it is necessary to rotate
the cut part in the main round tube to
make sure the cut is shown correctly.
The default is that the cut part is not
rotated.

Cut tolerance of sec Define the cut tolerance of the
secondary round tube.
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General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the links below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded column (31)
Welded column (31) connects a beam to a column flange using fittings and
welds. Stiffeners are created between the column flanges.

Objects created

• Stiffeners

• Fittings

• Welds
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Use for

Situation Description
Beam welded to a column.
Four stiffeners are created.

Sloped beam welded to a
column. Four stiffeners are
created.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
Stiffener

Picture tab
Use the Picture tab to control the dimensions and stiffener positions.

Dimensions

 Description
1 Distance between the stiffener and the column flange.
2 Distance between the column flange and the edge of the beam.

You can define the distance if the Fit secondary option is set to
Default or Yes.
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Fit secondary

Define whether the secondary beam can be fitted to the column.

Parts tab
Use the Parts tab to control the stiffener properties.

Stiffeners

Part Description Default
Stiffeners Thickness, width, and

height of the stiffeners.
Thickness = 16 mm
Width = If the width is
not defined, it is based
on the flange width.

Height = Column web
height

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer dimensions
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Description
1 Vertical chamfer dimension.

You can define the vertical dimension for line chamfers.
2 Horizontal chamfer dimension.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Weld preparation (44)
Connects two beams of I profile with welds. You can shape the secondary
beam end with rat holes and other weld preparations. The only allowed beam
profile is I-profile.

Objects created

• Welds

• Fitting

• Cuts to shape the beam end

Use for

Situation Description
Beam welded to a beam web.
Rat hole at the bottom.

Before you start

Create two beams.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to define the connection geometry.
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Dimensions

 Description Default
1 Vertical tolerance.

Tolerance between the main part web and
the secondary part flange.

0.2*secondary part
flange thickness

2 Flange horizontal tolerance.

Horizontal tolerance between the secondary
part and the main part upper flange.

3 mm

3 Web upper vertical tolerance.

Vertical distance between the secondary part
upper edge and the top of the web.

 

4 Web lower vertical tolerance.

Vertical distance between the secondary part
lower edge and the bottom of the web.

 

5 Flange horizontal tolerance

Horizontal tolerance between the secondary
part and the main part lower flange.

3 mm

6 Web horizontal tolerance.

Tolerance between the webs of the beams.

0 mm
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Parameters tab

Beam end shape

 Description
1 Weld access hole radius.
2 Flange straight distance.
3 Web chamfer

Dimensions of the chamfers in the secondary part web.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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New notch (49)
New notch (49) welds a beam to another beam. You can define how to cut the
beam end. The connection also creates horizontal stiffeners, if needed.

Objects created

• Cuts to shape beam end

• Welds

• Stiffeners (4) optional

Use for

Situation Description
A beam welded to a beam. Bottom of the
secondary beam web notched.

Before you start

Create two beams.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam to be cut).

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to define the connection geometry.
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Dimensions

 Description Default
1 Horizontal tolerance between the main part

and the secondary part upper flanges.
0 mm

2 Lower flange horizontal tolerance between
the main part and the secondary part lower
flanges.

0 mm

3 Web horizontal tolerance between the main
part web and the secondary part web.

0 mm

4 Web upper vertical tolerance.

Vertical distance between the secondary
part upper edge and the top of the web.

 

5 Web lower vertical tolerance.

Vertical distance between the secondary
part lower edge and the bottom of the web.

 

Secondary beam flange notch dimensions
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 Description
1 Notch dimension of the secondary beam top or bottom flange, if the

secondary beam is rotated as in the picture below.

2 Notch dimension of the secondary beam top or bottom flange, if the
secondary beam is rotated as in the picture below.

Parts tab

Option Description Default
Upper/lower stiffeners Stiffener thickness,

width and height.
The default thickness is
equal to the beam’s
upper / lower flange
thickness.

The default width is
0.5*(upper / lower
flange width-web
thickness).

The default length
(height) is 300 mm.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab

Stiffener position dimensions

 Description Default
1 Upper stiffener horizontal distance from the

beam end.
0 mm

2 Lower stiffener horizontal distance from the
beam end.

0 mm

3 Upper stiffener vertical distance from the
upper flange.

Secondary
beam height /
4

4 Lower stiffener vertical distance from the
lower flange.

Secondary
beam height /
4
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Secondary beam chamfer dimensions

 Description Default
1 Upper web chamfer dimension. 0 mm
2 Lower web chamfer dimension. 0 mm
3 Upper flange chamfer dimension. 0 mm
4 Lower flange chamfer dimension. 0 mm

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Steel components reference 1458 Welded connections



Welded column with stiffeners (128)
Creates a welded beam to column connection. By default, creates the
necessary notches in the secondary beam flanges and web. The secondary
beam can be level or sloped. Stiffener plates on the opposite side of the
column web are optional.

Objects created

• Stiffeners (optional)

• Weld backing bars (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Welded to the column with
weld prep and stiffener
options.

Steel components reference 1459 Welded connections



Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to control the gaps and shape of the secondary beam end
cut.

Dimensions
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 Description Default
1 Cutting point of the secondary beam. The

cutting point is defined as a gap between the
main and the secondary part.

General / gap (0.0625”)

2 mm

2 Chamfer type.

Options: No, Line, Cope, or Arc.

No chamfer

3 Width of the secondary flange chamfer. Equal to the fillet radius
of the main part profile.

4 Height of the secondary flange chamfer. Equal to the fillet radius
of the main part profile.

NOTE This information relates only to the U.S. imperial environment. 
GENERAL defaults can be found in the joints.def file in the system
folder and can be modified as required.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Part Description
Top NS Define the top near side stiffener thickness, width and height.
Top FS Define the top far side stiffener thickness, width and height.
Bottom NS Define the bottom near side stiffener thickness, width and

height.
Bottom FS Define the bottom far side stiffener thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.
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Option Description
Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener positions
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 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm
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Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.
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Option for top backing
bar

Option for bottom
backing bar

Description

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.
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Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.
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Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.
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Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are created on both
sides.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the near
side.

Doubler plate is created on the far
side.
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Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to
the edge of the part.

3 Edge distance of the doubler plate in relation to the bottom
of the secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value
for each space between holes. For example, if there are 3
holes, enter 2 values.

6 Hole diameter.
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Weld hole size

 
1 Slot length.
2 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Beam prep (183)
Creates a welded beam to column connection. The end of the beam can be
prepared. Web doubler plate in the column is optional. Welds are defined in a
separate dialog box that you can access by clicking the Welds button.

Objects created

• Web doubler plate (optional)
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• Weld backing bars (optional)

• Welds

• Cuts

Use for

Situation Description
Beam to column web. Web doubler
plate on the opposite side of
column web.

Sloping beam to column flange.
Weld backing bars.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to set the gap between the main part and the secondary
part, and select the beam end cut type.

Dimensions

 Description
1 Weld gap

Beam end cut

Define how the beam end is cut. The secondary part is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary part slopes less than
10 degrees, a square cut is created.
Otherwise, a bevel cut is made to the
end of the secondary part.
Square

Creates a square cut to the end of the
secondary part.
Bevel

Cuts the end of the secondary part
parallel to the edge of the main part.
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Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.
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Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.
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Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
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 Description
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

R = 35
r = 10
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Option Description Default

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.
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Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Doubler plates

Option Description
Default

Doubler plates are created on both
sides.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the near
side.

Doubler plate is created on the far
side.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates
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Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.

General settings

Description
1 Edge distance from the column

flange.
2 Doubler plate edge distance.

Edge distance is the distance from the
center of a hole to the edge of the
part.

3 Edge distance of the doubler plate in
relation to the bottom of the
secondary part.
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Description
4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing
values. Enter a value for each space
between holes. For example, if there
are 3 holes, enter 2 values.

6 Hole diameter.

Weld hole size

Option Description
1 Slot length.
2 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Cap plate detail
Cap plate detail creates a cap plate to a column or a beam, or to a polybeam.

Objects created

• Cap plate

Use for

Situation Description
Cap plate with one chamfered corner
created on an I profile column.

Cap plate created on a pipe profile
column.
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Situation Description
One cap plate created on a pipe
profile column and another cap plate
created on an I profile column.

Selection order

1. Select the main part (beam, column, or polybeam).

2. Pick the position of the cap plate.

You can pick a position on the column center line, side, or anywhere. The
cap plate is always centered.

The cap plate is created automatically when you pick the position.

Part identification key

 Part
1 Cap plate

Picture tab
Use the Picture tab to control the shape and the dimensions the cap plate.
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Cap plate shape

Option Description
Default

Rectangular

AutoDefaults can change this option.

Rectangular

Circular

Rectangular cap plate dimensions
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Description Default
1 Horizontal chamfer dimension.

This option is not available if you have
selected No chamfer in the chamfer options.

20 mm

2 Vertical chamfer dimension.

This option is not available if you have
selected No chamfer in the chamfer options.

20 mm

3 Horizontal edge distance of the cap plate.

This option is used only when the plate width
on the Parts tab is empty.

0 mm

4 Horizontal offset of the cap plate.

This option is used only when the plate
height on the Parts tab has a value.

0 mm

5 Vertical edge distance of the cap plate.

This option is used only when the plate
height on the Parts tab is empty.

10 mm

6 Vertical offset of the cap plate.

This option is used only when the plate
height on the Parts tab has a value.

0 mm

Rectangular cap plate chamfers

You can define the chamfers for each corner of the cap plate.

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Circular cap plate dimensions

 Description
1 Cap plate edge distance.

Parts tab
Use the Parts tab to control the properties of the cap plate.

Part

Part Description Default
Cap plate Thickness, width, and

height of the cap plate.
Thickness = 1.5*(profile
web or plate thickness)

Width = profile width or
profile diameter or
height (option 'h'), first
one that is not 0.

Height = profile height or
profile diameter or 200
mm, first one that is not
0.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
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Option Description Default
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

General tab

Click the link below to find out more:

General tab

Welds

Click the link below to find out more:

Pipe doubler plate
Pipe doubler plate creates a doubler plate between the main part and the
secondary part. The main part has to be a round profile.

Objects created

• Doubler plate

• Welds

Use for

Situation Description
Rectangular doubler plate connecting
a column and a beam.

Steel components reference 1499 Welded connections



Situation Description
Circular doubler plate connecting a
column and a beam.

The secondary part is skewed.

Rectangular doubler plate connecting
a column and a beam.

The secondary part is off-axis.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Doubler plate
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Picture tab
Use the Picture tab to control the type, position, and dimensions of the
doubler plate.

Doubler plate type

Option Description
Select the doubler plate type:

• Rectangular

• Circular

Clearance type

Option Description
Default

Clearance between the doubler plate
and the secondary part.

AutoDefaults can change this option.
Clearance between the doubler plate
and the secondary part.

Clearance between the main part and
the secondary part.
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Clearance dimension

Description
1 Clearance between the doubler plate and the secondary part.
2 Clearance between the main part and the secondary part.

Cut clearance

Description
1 Cut clearance between the doubler plate and the secondary part.

Rectangular doubler plate dimensions
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Description Default
1 Offset between the column and the

doubler plate.
0 mm

2 Measuring type for the doubler plate:

• Angle (degrees)

Define the angle of the doubler plate
in degrees.

• Dimension

Define the arc length of the doubler
plate.

• Edge

Define the arc length of the doubler
plate edge.

Angle

3 Angle of the doubler plate.

The angle can be extended up to 360
degrees to go around the main part.

Angle +10 degrees

4 Dimension value of the doubler plate.

The dimension can be extended up to
360 degrees to go around the main part.

length equivalent
to the formula
angle +10 degrees

5 Edge value of the doubler plate.

The edge value can be extended up to
360 degrees to go around the main part.

length equivalent
to the formula
angle +10 degrees

Corner rounding dimension for rectangular plate
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Description
1 Corner rounding dimension for a rectangular doubler plate.

Corners are not created with value 0.

Doubler plate extension for rectangular plate

Description
1 Vertical dimension from the secondary part top edge to doubler plate

top edge.
2 Vertical dimension from the secondary part bottom edge to the

doubler plate bottom edge.

Circular doubler plate dimensions

Description
1 Offset between the column and the doubler plate.
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Circular doubler plate diameter

Description
1 Diameter of the circular doubler plate.

Parts tab
Use the Parts tab to control the position of the doubler plate.

Part

Part Description
Doubler plate Thickness of the doubler plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Ring plate
Ring plate creates a ring plate. The ring plate can be circular, elliptical, or
angular. Ring plate creates welds between the column and the ring plate.

Objects created

• Ring plate

• Welds

Use for

Situation Description
Circular ring plate on a tube column.

Angular ring plate on a tube column.
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Selection order

1. Select the main part (column).

2. Pick a position for the connection.

The connection is created automatically when the position is picked.

Part identification key

 Part
1 Ring plate

Picture tab
Use the Picture tab to control the shape and the dimensions of the ring plate
in the Ring plate connection.

Ring plate type

Option Description Default
Ring plate Select the ring plate

type:

• Default

• Circular

• Elliptical

• Angular

Circular

Ring plate measuring type

Option Description Default
Ring plate measuring
type

Select how the ring plate
dimension is measured:

• Default

• Plate dimension

Plate dimension
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Option Description Default
• Plate absolute

dimension

Cut direction

Option Description
Default

The cut is created along the main
part.

AutoDefaults can change this option.

The cut is created along the main
part.

The cut is created perpendicular on
the plate.

Ring plate offset dimensions

Description
1 Ring plate offset from the picked point.
2 Ring plate clearance from the outer edge of the main part.
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Ring plate offset measuring

Option Description
Default

The offset dimension is measured
from the center line of the ring plate.

AutoDefaults can change this option.
The offset dimension is measured
from the center line of the ring plate.
The offset dimension is measured
from the bottom edge of the ring
plate.
The dimension is measured from the
top edge of the ring plate.

Create assembly

Option Description Default
Create assembly Define how the parts are

included in an assembly:

• Default

• Yes - All parts are in
one single assembly.

• No - Parts are not
included in one
single assembly.

Yes

Circular ring plate dimensions
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 Description Default
1 Plate dimension

Define the minimum width of the ring
plate.

200mm

Description Default
1 Plate absolute dimension

Define the absolute width of the ring
plate from the center point.

Minimum width +
clearance + part
height/2

Elliptical ring plate dimensions

Description Default
1 Ring plate vertical width. 200mm
2 Ring plate horizontal width. 200mm
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Description Default
1 Absolute vertical width of the ring plate

from the center point.
Vertical width +
clearance + part
height/2

2 Absolute horizontal width of the ring plate
from the center point.

Horizontal width +
clearance + part
height/2

Angular ring plate dimensions

You can define the radius for each corner.
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Description Default
1 Horizontal distance between corner radius

R1 and the picked point.
150mm

2 Horizontal distance between corner radius
R2 and the picked point.

150mm

3 Vertical distance between the plate top
outer edge and the plate inner edge.

200mm

4 Horizontal distance between the plate
right side edge and the plate inner center.

200mm

5 Vertical distance between corner radius R3
and the picked point.

150mm

6 Horizontal distance between corner radius
R4 and the picked point.

150mm

7 Vertical distance between the plate
bottom outer edge and the plate inner
center.

200mm

8 Horizontal distance between corner radius
R5 and the picked point.

150mm

9 Horizontal distance between corner radius
R6 and the picked point.

150mm

10 Horizontal distance between the plate left
side edge and the plate inner edge.

200mm

11 Vertical distance between corner radius R7
and the picked point.

150mm

12 Vertical distance between corner radius R8
and the picked point.

150mm
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Description Default
1 Horizontal distance between corner

radius R1 and the picked point.
150mm

2 Horizontal distance between corner
radius R2 and the picked point.

150mm

3 Absolute vertical distance between the
plate top outer edge and the center point.

Vertical width +
clearance + part
height/2

4 Absolute horizontal distance between the
plate right side edge and the center point.

Horizontal width +
clearance + part
height/2

5 Vertical distance between corner radius
R3 and the picked point.

150mm

6 Horizontal distance between corner
radius R4 and the picked point.

150mm

7 Absolute vertical distance between the
plate bottom outer edge and the center
point.

Vertical width +
clearance + part
height/2

8 Horizontal distance between corner
radius R5 and the picked point.

150mm

9 Horizontal distance between corner
radius R6 and the picked point.

150mm

10 Absolute horizontal distance between the
plate left side edge and the center point.

Horizontal width +
clearance + part
height/2
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Description Default
11 Vertical distance between corner radius

R7 and the picked point.
150mm

12 Vertical distance between corner radius
R8 and the picked point.

150mm

Corner shape

Option Description
Default

Two radius dimensions

AutoDefaults can change this option.

Two radius dimensions

One radius dimension

Ring plate

Option (circular) Option
(elliptical)

Option (angular) Description

Default

One ring plate

AutoDefaults can
change this
option.
One ring plate

Two half ring
plates
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Option (circular) Option
(elliptical)

Option (angular) Description

Four quarter ring
plates

Parts tab
Use the Parts tab to control the properties of the ring plate.

Part

Part Description Default
Ring plate Thickness of the ring

plate.
10mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfers tab
Use the Chamfers tab to control the chamfer properties of the ring plate.

Chamfer dimensions

For circular and elliptical ring plates, chamfering is created uniformly around
the outer perimeter of the ring plate. For angular ring plates, chamfers are
created in each corner.
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

General tab

Click the link below to find out more:

General tab

Welds

Click the link below to find out more:

5.6 Seated connections
This section introduces components that can be used in seated connections.

• Seating (39) (page 1516)

• Angle profile box (170) (page 1528)

Seating (39)
Seating (39) connects a column head to one or two beams using an end plate.
The end plate is welded to the column head and bolted to the lower flange of
the secondary part.

Objects created

• End plate

• Stiffeners

• Bolts
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• Washer plates (optional)

Use for

Situation Description
Seating connection with end plate and
stiffeners.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to control the end plate and stiffener size and position.

 Description
1 Distance between the first and the second secondary part.
2 Distance between the end plate the secondary parts.
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 Description
3 End plate distance from the main part edge.

Positive values move end plate edges closer to the column axis and
thus decrease the plate size. Negative values increase the plate size.

The default value is 10 mm.
4 A gap between stiffener plates and secondary beam flange. The default

value is 0 mm.
5 Position of the stiffeners.

By default, stiffeners are placed to the same plane as column flanges.
Positive offset values move stiffeners to the right and negative to the
left.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Square

AutoDefaults can change this option.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Parts tab
Use the Parts tab to control the end plate, stiffener and washer plate
properties.

Define the end plate, stiffener and washer plate thickness, width and height.

Option Description
End plate By default, width is defined by the bolt group horizontal edge

distances, and height is defined by the plate edge distances
from the left and right edge of the column.

The default value for end plate thickness is 0.5*the screw
diameter.
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Option Description
Stiffeners By default, height is equal to the distance between secondary

beam flanges.

If width is not given, stiffener width is defined based on the
flange width. The default value for the stiffener thickness is
1.5*secondary beam web thickness rounded upwards
to: 8, 10, 12, 16, 20, 25, 30, 35, 40, 45, and so on.

Washer
plates

Washer plates are small rectangular plates used as washers
between the bolt head and the secondary beam flange.

If no thickness is defined, plates are not created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the chamfer dimensions, and type and the
end plate and stiffener orientation.
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 Description
1 Chamfer type and dimensions.

If you select the No chamfer  option, a clash can occur between the
stiffener and the I-profile rounding.

Additionally, you can define the chamfer dimensions vertically and
horizontally. If you select an arc chamfer, the horizontal dimension is the
radius, and the vertical dimension has no effect.

2 Select whether stiffeners are perpendicular or parallel to the secondary
beam flange.

3 Gap size to end plate.

Define the limit value for the gap between the end plate and the
secondary or main part. Use this gap when the beam is slightly curved
or sloped to decide if the end angle is so small that the beam end can be
straight.
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 Description
If the actual gap is smaller than this value, the beam end is left straight.

If the actual gap is larger than this value, the beam end is fitted to the
end plate.

4 Select the end plate orientation.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

  
1 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

2 Dimension for vertical bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for horizontal bolt group position.
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7 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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• Right: From the right edge of the secondary part to the rightmost

bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes tab
Use the Holes tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.
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Option Description
No holes

1 hole

2 holes

4 holes

Hole positions

 Description
1 Horizontal distance between the secondary beam center

and the upper hole.
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 Description
2 Horizontal distance between the secondary beam center

and the lower hole.
3 Vertical distance between the secondary beam center and

the upper hole.
4 Vertical distance between the secondary beam center and

the lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Angle profile box (170)
Angle profile box (170) connects a beam to a column with a seat angle. The
angles can be placed at the top or bottom, or at both top and bottom flange of
the secondary beam. Stiffener plates can be welded to the seat angles. Web
stiffening plates can also be added to the secondary beam.

Objects created

• Clip angles (1 or 2)

• Seat stiffeners (optional)

• Web stiffeners (optional)
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• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam seat with
stiffeners.

Beam seat top and
bottom with stiffeners.
Various bolting options.
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Situation Description
Beam seat. Multiple
stiffener options.

Beam seat. Offset
secondary member.

Selection order

1. Select the main part (column).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Clip angle
2 Seat stiffener
3 Web stiffener
4 Bottom seat plate

Picture tab
Use the Picture tab to control the clearances between the angles and the
main and secondary part.

Dimensions
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1 Gap between the main part and the

secondary part.
GENERAL / beamedge
(0.5”) 
20 mm

2 Gap between angle profile and the main part. 0
3 Gap between angle profile and the secondary

part.
0

4 Distance of the secondary beam web stiffener
from the face of the main part.

 

NOTE This information is relevant only to the imperial environment.
GENERAL defaults can be found in the joints.def file in the system
folder and can be modified as required.

Parts tab
Use Parts tab to define the stiffeners, clip angle or bottom plate.

Parts

Option Description
Upper stiffener

Lower stiffener

Stiffener thickness, width and height.

The default values for the height and width are
based on the selected profile or bottom plate
dimensions. The default stiffener thickness is 10
mm. The default value in the joints.def file is
GENERAL/shearplatethk (0.375”).

Bottom plate Enter values for thickness and width to create a
seat plate instead of a seat angle.
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Option Description
Profile Select the seat angle profile from the profile

catalog.

The default angle profile is L150*100*10 or
L4X4X3/8. The default value in the joints.def
file is GENERAL / lsize.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the seat angle positions. Seat angles carry
loads from the secondary part. Seat angles can be positioned to top, bottom
or both flanges of the secondary part. The seat angle can be stiffened, and
bolted or welded to the main and secondary parts.

Notching

When you create the connection to the main part web, the secondary beam
can be fitted to the web and notched by the main part flanges.

Option Description
Default

Fitted and notched

AutoDefaults can change this option.
Fitted and notched

The secondary part is fitted and
notched.
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Option Description
Fitted

The secondary part is fitted, but not
notched.
Notched

The secondary part is notched, but
not fitted.
None

The secondary part is not fitted or
notched.

Seat position

Option Description
Default

Bottom

AutoDefaults can change this option.

Top

Creates a seat at the top of the
secondary part.

Bottom

Creates a seat at the bottom of the
secondary part.

Both

Creates two seats: one at the top and
another at the bottom of the
secondary part.

Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted
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Option for top seat
angle

Option for bottom seat
angle

Description

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.

Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.

Welded

Seat angle is welded to
the main part and to the
secondary part.

Seat angle offset

 Description
1 Seat angle horizontal offset from the center line of the main

part.
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Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally by
90 degrees.

To stiffen the rotated angle, select the
Middle option in the Middle
stiffener position list.
Uses a bottom plate as the seat
instead of the angle profile.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the seat angle
corner.
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Stiffener type

Option Option Description
Default

Rectangular stiffener
plate

AutoDefaults can change
this option.
Rectangular stiffener
plate

Triangular stiffener plate

The line connecting the
ends of the seat angle
legs defines the stiffener
plate shape.

Side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
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Option Description
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.

Chamfer dimensions
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 Description Default
1 Horizontal dimension of the stiffener plate

chamfer.
Equal to angle profile
rounding.

2 Vertical dimension of the stiffener plate
chamfer.

Equal to angle profile
rounding.

3 Vertical dimension of the stiffener plate
shape cut line.

 

4 Horizontal dimension of the stiffener plate
shape cut line.

 

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Pbolts tab
Use the Pbolts tab to control the properties of the bolts connecting the clip
angle to the main part.
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 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the
secondary beam.

2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary
beam.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run from
left to right and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Sbolts tab
Use the Sbolts tab to control the properties of the bolts connecting the clip
angle to the secondary part.

Steel components reference 1542 Seated connections



 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the
secondary beam.

2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the
secondary beam.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run
from left to right and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

SBoltsDown tab
Use the SBoltsDown tab to control the properties of the bolts connecting the
bottom seat angle to the secondary part.

Secondary bolt group dimensions

 Description
1 Horizontal bolt group position from the end of the secondary beam.
2 Bolt edge distance.
3 Number of bolts.
4 Bolt spacing. Use a space to separate bolt spacing values. Enter a value

for each space between bolts. For example, if there are 3 bolts, enter 2
values.
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 Description
5 Vertical bolt group position. Reference point is from the bottom of the

secondary beam.
6 Deletes bolts from the bolt group. Enter the bolt numbers of the bolts

to delete, separated by a space. Bolt numbers run left to right and top
down.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

joints.def: 
GENERAL / boltdia
16 mm (0.75”)

Bolt standard The bolt standard to be
used inside the
component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance The gap between the
bolt and the hole.

 

Thread in mat Defines whether or not
the thread may be
within the bolted parts
when using bolts with a
shaft. This has no effect
when using full-threaded
bolts.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes with the following options.

Option Description Default
1 Slotted hole X dimension

or allowance for
oversized holes.

0, which results in a
round hole.

2 Slotted hole Y
dimension.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted

holes.

Oversized creates
oversized or tapped
holes.

 

Rotate Slots When the hole type is
Slotted, this option
rotates the slotted holes.

 

Slots in Member(s) in which
slotted holes are
created. The options
depend on the
component.

 

Staggering of bolts

Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.
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Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Steel components reference 1548 Seated connections



Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
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Option Description
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
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Option Description
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
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Option Description
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Stiffeners tab
Use the Stiffeners tab to control the properties of the near side and far side
stiffeners created in the secondary part web.

Option Description
Stiffener NS

Stiffener FS

Stiffener thickness, width and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener creation

Option Description
Default

Stiffeners are not created.

AutoDefaults can change this option.

Stiffeners are not created.

Stiffeners are created.
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Stiffener position

 Description
1 Stiffener edge distance from the main part flange.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Steel components reference 1555 Opening connections



5.7 Opening connections
This section introduces components that can be used in steel openings.

Click the links below to find out more:

• Create hole around part (92) (page 1556)

• Rebar hole (page 1561)

• Notch (76) (page 1564)

Create hole around part (92)
Create hole around part (92) cuts a hole to a part using another part. The
part that cuts the hole is perpendicular to the part that is cut.

Objects created

• Cuts

Use for

Situation Description
Steel column creates a cut
through a plate.
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Situation Description
Concrete column creates a cut
through a plate.

Concrete column creates a cut
in a plate.

Selection order

1. Select the main part (column).

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to control the gap dimensions and whether the
dimensions are the same on both sides of the gap.

Gap side

Define whether the gap dimensions are the same on both sides of the gap.
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Option Description
Gap dimensions are the same on
both sides.

Gap dimensions are different on each
side.

Gap dimensions

 Description
1 Gap between the column and the secondary part in the vertical

direction.
2 Gap between the column and the secondary part in the horizontal

direction.
3 Gap between the column and the secondary part in the horizontal

direction.

To define this dimension, select the option that the gap is different on
each side.
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 Description
4 Gap between the column and the secondary part in the vertical

direction.

To define this dimension, select the option that the gap is different on
each side.

Part cut

Option Description
A cut is always created through the whole main
part.

Define the depth of the cut from the edge of the
secondary part.

Parameters tab
Use the Parameters tab to control the cut properties and type of the cut.

Cut properties

Option Description
Max. rectangle size Define the maximum size of a

rectangle cut.
Cut perpendicular to
main part

Define whether the cut is
perpendicular to the main
part.

This option works for
rectangular cuts.

Cut part name Define a name for the cut part.

Steel components reference 1559 Opening connections



Cut type

Option Description
Default

Creates an exact or a rectangular cut.

AutoDefaults can change this option.

Rectangular

Creates a rectangular cut using the
coordinates of the cutting part edges.

Exact

Creates a cut along the edges of the cutting
part. The cutting part has to be perpendicular
to the part it cuts.

You can use this option for I, round and tube
profiles.

Automatic

This option selects the cut type depending on
the cut size defined in Max. rectangle size.

If the size of the cutting part is larger than the
size defined in Max. rectangle size, an exact
cut is created. Otherwise, a rectangular cut is
created.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Rebar hole
Rebar hole creates holes for reinforcing bars in a steel column, beam, or
contour plate.

Objects created

• Holes

• Cuts

Use for

Situation Description
Holes created for reinforcing bars in a
steel beam.

Selection order

1. Select the main part (column, beam, or contour plate).

2. Select the secondary part (reinforcing bar group).

3. Click the middle mouse button to create the holes for the reinforcing bars.
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Part identification key

 Part
1 Hole for reinforcing bar

Parameters tab
Use the Parameters tab to control the properties of the reinforcing bar holes.

Reinforcing bar hole properties

Option Description Default
Bolt standard Select the bolt standard:

• 6914

• 7968

• 7990

• ASS 1

• ASS 2

• UNDEFINED_BOLT

6914

Rounding type Select the rounding type:

• None

The rounding value is the
reinforcing bar diameter +
hole tolerance.

• Round off

The rounding value is the
nearest integer number
divisible by the rounding
precision value.

No default value

Example dimensions:

• Reinforcing bar
diameter = 21.6 mm

• Hole tolerance = 3
mm

• Rounding precision =
2 mm

• None, rounding =
24.6 mm
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Option Description Default
• Round up

The rounding value is the next
integer number divisible by
the rounding precision value.

• Round down

The rounding value is the
previous integer number
divisible by the rounding
precision value.

• Round by table

Define the reinforcing bar
diameter, hole diameter, and
the slotted hole extension.

• Round off, rounding
= 24 mm

• Round up, rounding
= 26 mm

• Round by own,
rounding = 24 mm

Hole tolerance Define the hole tolerance.

When you select Round by table
as the rounding type, you cannot
define the hole tolerance.

0 mm

Rounding
precision

Define the rounding precision.

When you select Round by table
as the rounding type, you cannot
define the rounding precision.

1 mm

Dimension table Define the reinforcing bar
diameter, hole diameter, and
slotted hole extension.

To define the dimensions in the
table, select the Round by table
option as the rounding type.

Rebar hole uses an existing bolt
size and adjusts the hole
tolerance value until the desired
Hole diameter is reached.

Use the + and the - buttons to
add and delete rows from the
table.

 

Advanced tab
Use the Advanced tab to control the hole type, vertical offset, and angle range
dimension.
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Hole type

Option Description Default
Hole type Select the hole type:

• Bolt hole

• Part cut

• Bolt hole + part cut

Bolt hole

Vertical offset

Option Description
Default

The hole is not offset.
The hole is offset upward to directly
support the reinforcing bar to keep
the bar in the correct vertical position.

The hole can be offset if the hole is a
circular hole.

Angle range dimension

 Description Default
1 Angle range dimension.

A round hole is created within the
defined range. Holes that go beyond the
range are transformed into slotted holes.

5 mm

Notch (76)
Notch (76) creates a notch to the secondary beam.

Objects created

• Cuts
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Use for

Situation Description
Secondary beam is notched.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Notch tab
Use the Notch tab to create notches to the secondary beams and to control
the notch properties.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.
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Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.
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Option Description
Creates the cut above the main beam flange.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as
far back as you define.

AutoDefaults can change this option.
Creates cuts to the flange with default values
unless you define other values.
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Option Description
Creates cuts to the flange according to the value
you define to make it flush with the web.

Creates cuts to the flange according to the values
you define.

Creates chamfers in the flange.

If you do not enter a horizontal dimension, a
chamfer of 45 degrees is created.
The flange is not cut.

Cut dimensions

Define the vertical flange cut dimensions.

Parameters tab
Use the Parameters tab to define the notch type and the clearance between
the parts.

Option Description
Fitting type Select the type of notch created

between the main part and the
secondary part.

Clearance Define the clearance value for the gap
created between the parts.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab
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5.8 Bracing
This section introduces components that can be used in steel bracing
structures.

• Tensioner (7) (page 1569)

• Tensioner brace (13) (page 1588)

• Tensioner brace and compression bar (13) (page 1597)

• Turnbuckle bracing (S3) (page 1610)

• Turnbuckle connection (126) (page 1618)

• Generation of purlins (50) (page 1622)

• Gusset+ T (page 1635)

Tensioner (7)
Tensioner (7) connects a column or a beam to a brace with a forked plate or a
flat plate. Optionally, a gusset plate can be created.

Objects created

• Gusset plate (optional)

• Forked or flat plate

• Tensioner (optional)

• End plate (optional)

• Bolts

• Welds
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Use for

Situation Description
Forked plate is welded to a bracing
rod and bolted to a gusset plate.

The gusset plate is welded to the
main part.

Simplified tensioner in the bracing
rod.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part(s) (brace).

3. Click the middle mouse button to create the component.
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Part identification key

 Part
1 Connection plate (forked plate)
2 Bracing rod
3 Gusset plate

Plate tab
Use the Plate tab to control the gusset plate dimensions and shape.

Plate

Part Description Default
Gusset plate Define the gusset plate

thickness, width and
height.

12 mm
100 mm
180 mm
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Gusset plate shape and dimensions
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 Description Default
1 Horizontal top dimension from the column

web.
2 Horizontal bolt edge distance. 50 mm
3 Height of the gusset plate. 80 mm
4 Bottom vertical bolt edge distance. 50 mm
5 Bottom vertical chamfer dimension. 20 mm
6 Bottom horizontal chamfer dimension. 20 mm
7 Bolt edge distance to the bracing rod. 110 mm
8 Bolt edge distance of the chamfer (radius).  
9 Gusset plate shape.

Select the plate shape and define the plate
dimensions.

10 Select the chamfer shape.

Define the horizontal and vertical chamfer
dimensions.

Fork tab
Use the Fork tab to control the size, position, number, orientation and shape
of the forked plate.

Forked plate

Part Description
Forked plate Select the shape for the forked plate:

• Part 1 shape creates a plate with a
circular part.

• Part 2 shape creates a simple
plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Forked plate dimensions

 Description
1 Horizontal bolt edge distance.
2 Chamfer radius of the forked plate.
3 Width of the extension part.
4 Width of the forked plate.
5 Width of the forked plate.
6 Length of the circular part of the forked plate.
7 Chamfer width of the forked plate.
8 Finger thickness of the forked plate.
9 Gap between the fingers of the forked plate.
10 Finger length in the forked plate.
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Parameters tab
Use the Parameters tab to control the overlap of the gusset plate and the
size, position, number and shape of the end plate.

Gusset plate overlap

 Description
1 Define how much the gusset plate overlaps with the main part flange.

If you do not enter any value, the gusset plate reaches the main part
web.

End plate

  
1 Define the end plate thickness, width, and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

End plate shape

Option Description
Select the end plate shape.

Define the end plate offset from the
bracing rod.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

3 Define the bolt offset from the center line of the bracing rod.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Tensioner tab
Use the Tensioner tab to add a tensioner, to control the bracing levels and
bracing offsets.
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Part

Part Description Default
Tensioner T Define the tensioner

profile by selecting it
from the profile catalog.

D40

Part B If you have created a
tensioner, define the
extra windbracing
profile by selecting it
from the profile catalog.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Tensioner

Option Description Example
Tensioner is not created.

Tensioner is created.
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Option Description Example
Tensioner is created.

Stopper part is added to
the bracing. Used for
compression tubes.
Tensioner is created.

Stopper part is placed
inside the compression
tube.

Opening in forked plate

Option Description Example
Select whether an
opening is created in the
forked plate. The
opening is always
square.

You can define the
opening if both the
tensioner and extra
windbracing are created.

 

Define the gap for the
opening.

The default value is 1
mm.
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Gusset plate

Option Description
Select whether a gusset plate is
created.

If you do not select a gusset plate,
only the forked plate will be created.

Bracing dimensions

 Description Example/Default
1 Bolt edge distance from the main part flange

when there is no gusset plate.

The default value is 30 mm .

2 Bracing rod overlap.

3 Length of the extra windbracing between the
forked plate and the tensioner.

The default value is 300
mm.

4 Length of the tensioner. The default value is 40
mm.
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 Description Example/Default
5 Bracing overlap in the tensioner. The default value is 0

mm.
6 Extra windbracing overlap in the tensioner. The default value is 0

mm.

Bracing position

Option Description
Position of the bracing on the main
part flange.

This option is useful especially if there
is no gusset plate.

Plate position

Option Description
Select the position of the forked plate
on the main part web.
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Forked plate position on bracing

Option Descripton Example
Select the position of the
forked plate on the
bracing.

This option is useful
especially with flat
plates.

Cut part B in fork

Define whether the forked part is cut if the bracing rod goes through the
forked part. The forked part cut adapts to the bracing rod size.
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Tensioner T add to secondary

Select whether the tensioner is added to the secondary part or handled as a
loose part and welded to the bracing rod.

• Yes adds the tensioner to the bracing rod.

• No welds the tensioner to the bracing rod as a loose part.

Extra tensioners tab
Use the Extra tensioners tab to add extra tensioners. Two different tensioner
types can be defined.

Extra tensioners

If there is one bracing, define the tensioner on the Tensioner tab. If there are
more bracings, define the tensioners for the second, third, etc. bracing on the
Extra tensioners tab. Define the bracing numbers in the Apply on tensioner
number box.
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The tensioners whose numbers are not entered are created with the
properties defined on the Tensioner tab.
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For instructions on tensioner bracing dimensions, Cut part B in fork and
Tensioner T add to secondary, see the instructions on the Tensioner tab.

Parts

Part Description
Tensioner T Define the tensioner profile by selecting it from the

profile catalog.
Part B If you have created a tensioner, define the extra

windbracing profile by selecting it from the profile
catalog.

Steel components reference 1586 Bracing



Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

UDA tab
Use the UDA tab to add information in the user-defined attributes (UDAs) of
the parts.

You can define UDAs for the plate and the fork. UDAs can be displayed in
drawings and reports.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Tensioner brace (13)
Tensioner brace (13) creates one or two bracing crosses between two
columns or beams. It is also possible to add connections between columns or
beams and the bracing crosses. You can define which connections are used.

Objects created

• Bracing cross (1 or 2)

• Connections between columns or beams and bracing crosses

• Connections in bracing crosses

Use for

Situation Description
One or two bracing crosses between
two columns.

NOTE To use Tensioner brace (13) you need to set the Up direction on the
General tab to a fixed direction: -x,+x,-y,+y,-z, or +z.

The Auto option does not work.

Selection order

1. Select the first main part (column or beam).

2. Select the second main part (column or beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

  
1 Diagonal bracing
2 Connection between the main part and the bracing
3 Connection in the bracing cross

Picture tab
Use the Picture tab to control the bracing levels and bracing offsets.

Bracing levels

 Description
1 Bottom level of the lower bracing cross.
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 Description
2 Top level of the lower bracing cross.
3 Bottom level of the upper bracing cross.
4 Top level of the upper bracing cross.

Bracing reference

For both main parts, define the reference side of the bracing levels. The
reference side can be set for both in the horizontal and the vertical direction.

Example:

Bracing offset

Define the offset perpendicular to the bracing. You can move the created plate
or part by entering a value in the x-, y, or z-direction.

Example:
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Levels tab
Use the Levels tab to control the bracing direction when the columns are not
parallel.

Option Description
Direction Select the

direction of the
bracing.

Start point of the main
part as the reference
point.

End point of the main
part as the reference
point.

Calculation
of levels

Select the
reference line
used for
positioning the
bracing when
the main parts
are not parallel.

Offset from the start
point in part 1,
perpendicular to the
line through the start
points.

Offset from the start
point in part 1, in local
x-direction.

Steel components reference 1591 Bracing



Option Description
Offset from the start
point in part 2, in local
x-direction.

Reference line through
the start and end
points of the main
parts, offset from the
start of the reference
line.

Offset from the start
point in part 1, in z-
direction.

Offset from the start
point in part 2, in z-
direction.
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Parts tab
Use the Parts tab to control the properties, bracing position, and rotation.
Additionally, you can define bracing splitting and shortening values.

Option Description
Windbracing Define the bracing profile by selecting it from the profile

catalog.
Windbracing
rotation

Select the rotation for the first and the second bracing
element.

This option is useful when the bracing elements are
crossing and they are connected in the crossing.

Windbracing
translation

Select the offset of the first and the second bracing
element from the reference points.

This option is useful when the bracing elements are
positioned so that the first bracing is alongside the
second bracing. Typically, the first bracing element is set
to Forwards and the second bracing element to
Backwards.

Splitting the
diagonal bracing

Select whether the
diagonal bracing
elements are split or
connected with a
component.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connect diagonals
with joint number
box.

Bracing is not split.

Possible component
for connecting the
diagonal bracing:
Seating (30).

First diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).
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Option Description
Second diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Both diagonal
bracing elements
are split.

Possible component
for connecting the
diagonal bracing:
Central gusset
(169).

Connecting
bracing crosses

Select whether the
gusset plates of two
bracing crosses above
each other are
connected.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connection number
box.

Bracing crosses are
connected with a
gusset connection.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Bracing crosses are
not connected.
Separate
connection is
created for each
diagonal bracing.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).
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Option Description
Distance
between
windbracings

Define the distance between bracing elements.

If the bracing elements are crossing each other, this value
typically defines the gusset plate thickness.

Shorten
windbracings

Define how much the bracing are shortened.

The entered value is written in the user-defined attributes
of the bracing. The value is used in drawings.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Joints tab
Use the Joints tab to define the components used for connecting the columns
or beams and the bracing crosses.

Option Description
Creation of joints Select whether connections are created between

the bracing elements.

No: Only the bracing elements are created.

Yes: Components are added between the
bracing elements.

Connection number

Connect diagonals with
joint number

Type the component number that is used for
connecting the bracing or the diagonal bracing
cross, and the component application number.
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Option Description
Userjoint application
number

Joint direction

Select the connection direction for the diagonal
bracing cross.

• Default component for the bracing is Bolted
gusset (11).

• Default component for the diagonal bracing
cross is Seating (30).

Example:

Configuration file Configuration setting for the connection.

For example, if you type CS_M13, it means that a
setting named CS_M13 must be available for the
used connection.

Tensioner position Define the tensioner position if the Tensioner
(7) connection is used.

Example of Tensioner (7) position in both the
Up and the Down position.
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Joints dir tab
Use the Joints dir tab to control the up directions of the connections used
between the main parts and the diagonal bracing.

In the example below, Seating (30) has been defined as the connecting
component on the Joints tab:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tensioner brace and compression bar (13)
Tensioner brace and compression bar (13) creates one or two bracing
crosses between two columns or beams. It is possible to add compression
bars between the main parts. You can add connections between the main
parts and the bracing crosses, and between the main parts and the
compression bars.

Because you can use other components inside Tensioner brace and
compression bar (13) to create the connections between parts, the
component has a hierarchical component structure. Tensioner brace and
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compression bar (13) is on the highest level in the component hierarchy (level
0) and the connections are on a lower level (level 1) in the component
hierarchy.

Objects created

• Bracing (1 or 2)

• Compression bars (optional)

• Connections between main parts and bracing

• Connections between main parts and compression bars

• Connections in bracing crosses

Use for

Situation Description
Two bracing crosses and three
compression bars with connections.
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Situation Description
One bracing with connections.

Tapered main parts (mast
construction) and two bracing crosses
with connections.

Selection order

1. Select the first main part (column or beam).

2. Select the second main part (column or beam).

The component is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to control the bracing levels.

Bracing levels

 Description
1 Top level of the upper bracing.

If no value is entered, the top bracing is not created.
2 Bottom level of the upper bracing.

If no value is entered, the top bracing is not created.
3 Top level of the lower bracing.
4 Bottom level of the lower bracing.

Bracing reference

For both main parts, define the reference of the bracing levels. The reference
can be set for both the horizontal and the vertical direction.

For example:
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Bracing offset

Define the offset perpendicular to the bracing. You can move the created plate
or part by entering a value in the x-, y, or z-direction.

In the example below, the main parts have unequal dimensions and the
reference is set to Middle. To create the bracing crosses horizontally, an offset
must be entered for the biggest part. The needed offset is the height
difference between IPE200 and IPE300, divided by 2 = 50mm.

Bracing direction

Option Description
Direction Select the

direction of the
bracing.

Start point of the main
part as the reference
point.
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Option Description
End point of the main
part as the reference
point.

Calculation
of levels

Select the
reference line
used for
positioning the
bracing when
the main parts
are not parallel.

Offset from the start
point in part 1,
perpendicular to the
line through the start
points.

Offset from the start
point in part 1, in local
x-direction.

Offset from the start
point in part 2, in local
x-direction.
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Option Description
Reference line through
the start and end
points of the main
parts, offset from the
start of the reference
line.

Offset from the start
point in part 1, in z-
direction.

Offset from the start
point in part 2, in z-
direction.

Freely defined values.
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Parts tab
Use the Parts tab to control the properties, bracing position, and rotation.
Additionally, you can define bracing splitting and shortening values.

Option Description
Windbracing Define the bracing profile by selecting it from the profile

catalog.

Windbracing
position in plane

Set the position in plane for the first and the second
bracing element.

Windbracing
rotation

Select the rotation for the first and the second bracing
element.

This option is useful when the bracing elements are
crossing and they are connected in the crossing.

Windbracing
translation

Select the offset of the first and the second bracing
element from the reference points.

This option is useful when the bracing elements are
positioned so that the first bracing is alongside the
second bracing. Typically, the first bracing element is set
to Forwards and the second bracing element to
Backwards.

Splitting the
diagonal bracing

Select whether the
diagonal bracing
elements are split or
connected with a
component.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connect diagonals
with joint number
box.

Bracing is not split.

Possible component
for connecting the
diagonal bracing:
Seating (30).
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Option Description
First diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Second diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Both diagonal
bracing elements
are split.

Possible component
for connecting the
diagonal bracing:
Central gusset
(169).

Connecting
bracing crosses

Select whether the
gusset plates of two
bracing crosses above
each other are
connected.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connection number
box.

Bracing crosses are
connected with a
gusset connection.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).
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Option Description

Bracing crosses are
not connected.
Separate
connection is
created for each
diagonal bracing.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Distance
between
windbracings

Define the distance between bracing elements.

If the bracing elements are crossing each other, this value
typically defines the gusset plate thickness.

Shorten
windbracings

Define how much the bracing are shortened.

The entered value is written in the user-defined attributes
of the bracing. The value is used in drawings.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Compression bar tab
Use the Compression bar tab to define the compression bar properties.

Option Description
Compression
bar

Define the compression bar thickness, width and height.

Create bar Select whether the compression bar is created.

You can define up to three compression bars.
Y offsets

X offsets

Define the horizontal and vertical offset of the bracing.

Reference is the level defined on the Picture tab.

For example:

Position in
plane

Rotation

Position in
depth

Select the orientation of the compression bars.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Joints tab
Use the Joints tab to define the components used for connecting the main
parts and the diagonal bracing elements and the compression bars.

Option Description
Creation of joints Select whether connections are created between

the bracing elements.

No: Only the bracing elements are created.

Yes: Components are added between the
bracing elements.

Connect to Select whether the bracing elements are
connected to the main parts or the compression
bars.

For example:
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Option Description

Connection number

Connect diagonals with
joint number

Userjoint application
number

Joint direction

Type the component number that is used for
connecting the bracing, the diagonal bracing
cross, or the compression bar, and the
component application number. Select the
connection direction for the diagonal bracing
cross.

• Default component for the bracing is Bolted
gusset (11).

• Default component for the diagonal bracing
cross is Seating (30).

• Default component for the compression bar
is End plate (144).

Configuration file for the
joint

Configuration setting for the connection.

For example, if you type CS_M13, it means that a
setting named CS_M13 must be available for the
used connection.

Tensioner position Define the tensioner position if the Tensioner
(7) connection is used.

Joints dir tab
Use the Joints dir tab to control the up directions of the connections used
between the main parts and the diagonal bracing, and the up direction of the
connections used between the main parts and the compression bars.
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In the example below, Seating (30) has been defined as the connecting
component on the Joints tab:

UDA tab
Use the UDA tab to add information in the user-defined attributes (UDAs) of
the parts.

Option Description
Part Select to which part the related information can be saved.
UDA name Enter the name of the user-defined attribute.
Type Select the UDA type.

Use String for text, Integer for numbers, Float for numbers
with decimals and Option for selecting an item in a list.

Value Enter the value that is saved to the user-defined attribute.
Use text and/or numbers, depending on the defined UDA
type.

Turnbuckle bracing (S3)
Turnbuckle bracing (S3) creates a turnbuckle assembly, rods, and end
connections.

Objects created

• Turnbuckle

• Rod

• Fastener plate

• Gusset plate
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• Bolts

Use for

Situation Description
Turnbuckle connection

Selection order

1. Pick the first point.

2. Pick the second point.

3. Select the first part.

4. Select the second part.

The connection is created automatically when the second part is selected.

Part identification key

 Description
1 Turnbuckle
2 Rod
3 Fastener plate/Gusset plate

Picture tab
Use the Picture tab to define the turnbuckle dimensions.
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Dimensions

 Description Default
1 Offset between the first picked position and

the actual generation point.
0 mm

2 Distance from the first bolt to the center line
of the first part.

First part collision
point + 100 mm

3 Distance from the first bolt to the end of the
first rod. Used with battledores or clevises.

100 mm

4 Fixed length of the rod. The length of the
second rod is automatically calculated.

400 mm

5 Distance from the first bolt to the end of the
second rod. Used with battledores or
clevises.

100 mm

6 Distance from the first bolt to the center line
of the second part.

Second part
collision point +
100 mm

7 Offset between the first picked position and
the actual generation point.

0 mm

Rod depth offset

Define the fastener/gusset plate offset from the part center line. By default,
the fastener plate/gusset plate is located in line with the part center line.
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Turnbuckle tab
Use the Turnbuckle tab to define the turnbuckle dimensions, thread type and
cuts, and whether the turnbuckle is created as an assembly or as single parts.

Parts

Option Description
Rod Select the rod profile from the profile

catalog.
Turnbuckle Select whether to create a turnbuckle.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Dimensions

 Description Default
1 Outer diameter of the turnbuckle Diameter of the rod

+ 2 x turnbuckle
thickness

2 Length of the turnbuckle 50 mm
3 Length of the turnbuckle opening Length of the

turnbuckle – 20 mm
4 Width of the turnbuckle opening Rod thickness – 1
5 Length of the thread cut 100 mm
6 Gap between the rods 100 mm

Thread type

Define the direction of the threads at the turnbuckle.

Option Description
RH – LH (right hand – left hand)

Tekla Structures stores RH as a user-
defined attribute to the first rod and
LH as a user-defined attribute to the
second rod.
LH – RH (left hand – right hand)

Tekla Structures stores LH as a user-
defined attribute to the first rod and
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Option Description
RH as a user-defined attribute to the
second rod.

Create thread cuts

Option Description
Threads are not cut.

Threads are cut.

Assembly / single part turnbuckle

Option Description
Assembly

Single parts

Connection tab
Use the Connection tab to define the plate properties and the connection
type.

Parts

Option Description
Fastener plate Thickness, width and height of the

fastener plate.
Gusset plate Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Connection type

Select the connection type: Battledore, Clevis, Bolted gusset, or Tube
gusset.

Option Description Default
Battledore side Select whether the battledore and

gusset are generated in front of or
behind the rod generation plane.

Front

Battledore
dimensions

1 Distance from the bolt to the
edge of the fastener plate.

2 Distance from the bolt to the
gusset plate edge.

3 Clearance between the gusset
corner and the rod.

1 60 mm
2 2.5 x bolt
diameter

3 (Fastener plate
width – Rod
diameter) / 2

Clevis pin size Clevis pin size is the value stored
as a free attribute to the clevis.
Used only with clevis.

Bolt diameter + 4
mm

Connection setting User-defined attribute file for the
bolted gusset or tube gusset
connection.
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Bolts tab
Use the Bolts tab to define the bolt properties.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Turnbuckle connection (126)
Turnbuckle connection (126) creates a turnbuckle assembly. The parts that
are connected must be parallel. Tekla Structures creates the connection
objects symmetrically.

Objects created

• Turnbuckle

Use for

Situation Description
Turnbuckle connection
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Selection order

1. Select the main part.

2. Select the secondary part.

Note that the parts must be parallel.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Turnbuckle

Picture tab
Use the Picture tab to define the dimensions of the turnbuckle.

Dimensions

 Description Default
1 Length of the turnbuckle 50 mm
2 Length of the turnbuckle opening Length of the

turnbuckle – 20
mm

3 Outer diameter of the turnbuckle Diameter of the
rod + 2 x
turnbuckle
thickness
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 Description Default
4 Width of the turnbuckle opening Rod thickness -

1
5 Length of the thread cut 100 mm
6 Distance between the thread cuts Half of the

turnbuckle
length

Parts tab
Use the Parts tab to define whether the turnbuckle is created as a profile or as
a custom component.

Create as

Use this option to select whether to create the turnbuckle as a profile or as a
custom component.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

If you select to create the turnbuckle as a custom component, select the
custom component from the Applications & components catalog and define
the custom settings, up direction, rotation, and length.

Parameters tab
Use the Parameters tab to define the thread type, cuts and size, and whether
the turnbuckle is created as an assembly or as single parts.

Thread type

Define the direction of the threads at the turnbuckle.
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Option Description
Default

RH – LH (right hand – left hand)

Tekla Structures stores RH as a user-
defined attribute to the first rod and
LH as a user-defined attribute to the
second rod.

AutoDefaults can change this option.
RH – LH (right hand – left hand)

Tekla Structures stores RH as a user-
defined attribute to the first rod and
LH as a user-defined attribute to the
second rod.
LH – RH (left hand – right hand)

Tekla Structures stores LH as a user-
defined attribute to the first rod and
RH as a user-defined attribute to the
second rod.

Create thread cuts

Option Description
Default

Threads are cut.

AutoDefaults can change this option.
Threads are cut.

Threads are not cut.

Thread size

When you have selected that threads are not cut, you can select the size of the
thread and create the thread 1 mm smaller.

Option Description
Default

Thread size is not changed.

AutoDefaults can change this option.
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Option Description
Thread size is not changed.

Thread is created 1 mm smaller.

Assembly / single part turnbuckle

Option Description
Default

Assembly

AutoDefaults can change this option.
Assembly

Single parts

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Generation of purlins (50)
Generation of purlins (50) creates multiple profiles that can be used as wall
or roof purlins, panels, or timber or concrete parts.

Objects created

• Purlins
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Use for

Situation Description
Purlins

Wall panel

Selection order

1. Pick the start point of the purlins.

2. Select the parts that divide up the purlins.

3. Click the middle mouse button to create the purlins.

NOTE The placement of the purlins is defined by the input parts.
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Part identification key

 Part
1 Purlin

Picture tab
Use the Picture tab to control the number of purlins, distances between the
purlins and purlin overhang lengths.

Purlin dimensions

 Description
1 Define the edge distance from the picked point to the first

purlin.
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 Description
2 Define the number of purlins.
3 Define the distance between the purlins.

The distances are calculated from center-to-center.
4 Define the edge distance from the last purlin to the part

end point.

The distance depends on the option Purlin distance
according to.

5 Define the type and length for purlin overhangs in the
purlin start.

6 Define how the purlins are split and the size of the gap
between the purlins.

7 Define the type and length for purlin overhangs in the
purlin end.

Purlin distances

Define how the distances between purlins are calculated.

Option Description
Exact number of
purlins

Define the purlin start point with an edge distance

.

The remaining length is divided according to the

values in .

For example:

Fill to the end Define the purlin start point with an edge distance in

. The remaining length is divided according to the

values in , considering the edge distance in .
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Option Description
Purlin profile Intermediate distances

Define the distances between the purlins. This is
suitable especially for concrete floors.

For example, define the distances on the Picture tab
and the purlin profile properties on the Parts tab:

Divide equally Purlin distances are equally divided by the length of
profiles.

Purlin type This option is recommended for vertical profiles,
such as concrete walls or panels.

The height of the part that is set in the purlin profile
properties on the Parts tab can be overridden by the
levels defined in the Top level purlin panels option
on the Parts tab.

For example:

The width of the panel that is set in the purlin profile
properties on the Parts tab can be overridden by
the Plate thickness option on the Parts tab. If the
Plate thickness option is empty, then the plate
thickness in the profile properties is used.
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Option Description
For example:

Level

Define the purlin level compared to the main part.

Option Description
Reference point of main part

Centerline of main part
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Option Description
Bottom face of main part

Top face of main part

Purlin direction

Define which direction is used for the new purlins.

Purlin overlap

Select whether purlins can overlap (Yes) or not (No). Setting purlins to overlap
helps in root sheeting, for example.

Note that if you set the overlap to No and the distance between the purlins is
smaller than the width of the purlins, only one of the purlins is created.

Length of purlins

Define how the purlins are split. You can select both a pattern for the purlins
and define how many gaps a purlin will cover.
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Option Description
Select a pattern for the purlins from the list.
The patterns with red purlins control the
first purlin in odd or even purlin rows.

Enter the number of gaps that a purlin
covers in the length boxes.

For example:
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Parts tab
Use the Parts tab to control the purlin properties and purlin positioning.

Purlin profile

Option Description
Purlin Define the purlin thickness, width and

height.

The default value is PL100*100.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Purlin position

Option Description
Purlins Define the number of purlins per type. Multiple purlin

types can be defined. Separate the numbers with a
space. For example 1*1 4*2 results in 1 purlin of type
#1 and 4 purlins of type #2.

Inverse Invert the local direction of the purlin. This is useful
especially for asymmetrical profiles.

You can define the inversion separately for each purlin
type.

The options are:

0= direction is inverted

1= direction is not inverted
On plane In the first box, define the purlin position in the

horizontal plane.

You can define the position separately for each purlin
type.

The options are:

0 = middle

1 = left

2 = right

In the second box, enter a value to define a horizontal
offset.
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Option Description
Rotation In the first box, enter the rotation of the purlin.

You can define the rotation separately for each purlin
type.

The options are:

0= back

1= below

2= front

3= top

In the second box, enter an angle for other rotation
angles.

At depth In the first box, define the purlin position in the vertical
plane.

You can define the position separately for each purlin
type.

The options are:

0 = middle

1 = front

2 = behind

In the second box, enter a value to define a vertical
offset.

Purlin panel
levels

Enter one or more values to define elevations. This is
useful especially for panels.

Separate the numbers with a space. Use this option
only if you have set the Purlin distance according to
option to Purlin type on the Picture tab.

Elevation

Define the reference for the purlin elevations, for example, for wall panels. The
elevations are set in the Top level purlin panels option.

Option Description
Elevation is in between the parts.
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Option Description
Elevation is on the top side of the bottom part.

Elevation is on the bottom side of the top part.

Panel thickness

Define the thickness of the panels. This works only with parametric profiles,
such as AS_PNL. Use this option only if you have set the Purlin distance
according to option to Purlin type on the Picture tab.

The defined panel thickness overrides the width set in the purlin profile
properties.

 Description Default
Plate
thickn
ess

For example: 100 mm

Use extra purlin positioning

Set the Use extra purlin positioning option to Yes to change the position and
rotation of each even or odd purlin.
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Joints tab
Use the Joints tab to define the components used for connecting the beams
and the purlins.

Option Description
Creation of joints Select whether connections

are created.

No: Only the purlins are
created.

Yes: Components are added
between the purlins and the
beams.

Connection type Select the connection type
from the list. You can select
a suitable custom
component or a connection,
or you can select one of the
predefined connections.

You can define the
connections for the start
connection (1), middle
connection with two parts
(2), middle connection with
one part (3), and the end
connection (4).

Component name / number If you have selected a
custom component or a
connection as the
connection type, select the
custom component or
connection from
theApplications &
components catalog.
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Option Description
Configuration file Select the configuration

settings for the connection.
Direction, Class The values you define are

shown on the General tab
of the selected connection.

UDA tab
Use the UDA tab to add information in the user-defined attributes (UDAs) of
the parts. You can define up to 5 UDA names.

Option Description
UDA name Enter the name of the user-defined attribute.

For example, to add a comment UDA, open the
objects.inp file in a text editor and search for
comment. The following attribute is shown:

attribute("comment", "j_comment", string,
"%s", no, none, "0.0", "0.0")
The first text between the quotation marks is the UDA
name, comment. The entered name is case sensitive.

Type Select the UDA type.

Use String for text, Integer for numbers, Float for
numbers with decimals and Option for selecting an
item in a list. You can find the UDA type in the
objects.inp file.

Value Enter a value for the UDA. Use text and/or numbers,
depending on the defined UDA type.

Gusset+ T
Gusset+T connects a beam or a brace to another beam by welding a T profile
to the end of the beam and bolting this profile to a shear plate gusset on the
main part. The main part is typically an H or I profile, and the secondary part is
typically a square or round hollow profile, though channels and other profiles
can also be used.

Objects created

• Stiffener

• Gusset plate

• Cut T profile (brace connection)

• Built up T profile (brace connection)
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• Welds

• Bolts

Use for

Situation Description
T profile welded to beam and bolted
to gusset plate on main part.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Gusset plate
2 Brace connection (T profile)
3 Stiffener
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Picture tab
Use the Picture tab to control the gap and gusset plate dimensions and the
shape of the gusset plate.

Gap dimension

 Description Default
1 Gap dimension. 10 mm

Gap dimension options

Option Description
Default

Gap between the edge of the main
part flange and the nearest corner of
the gusset plate.

AutoDefaults can change this option.

Gap between the edge of the main
part flange and the nearest corner of
the gusset plate.

Gap between the face of the main
part web and the nearest corner of
the gusset plate.
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Option Description
Gap between the edge of the main
part flange and the nearest bolt.

Gap between the face of the main
part web and the nearest bolt.

Gusset plate shape

You can further modify the gusset plate shape by defining the dimensions on
the Picture and the Gusset tab.

Option Description
Default

Regular trapezoidal gusset plate.

AutoDefaults can change this option.
Regular trapezoidal gusset plate.

You can use all the gap and straight portion settings on the
Gusset tab page to modify this gusset plate.

If the gusset plate extends above the upper flange, or below
the lower flange, use the extended gusset plate chamfer
dimensions instead of the straight edge dimensions of the
gusset plate flange.
Square corner on the upper side of the gusset plate.

You can use all the gap options to modify this gusset plate.
The lower flange straight edge can also be used.
Partial depth gusset plate.

Define the height and straight edge explained in Gusset
plate dimensions.

If the gusset plate extends above the upper flange, use the
extended gusset plate chamfer dimensions.
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Gusset plate dimensions

 Description Default
1 Partial gusset plate height on the web.  
2 Partial gusset plate straight edge. 20 mm

Gusset tab
Use the Gusset tab to control the position and dimensions of the gusset plate
and stiffener creation.

Gusset and stiffener

Option Description Default
Gusset Gusset plate thickness 6 mm
Stiffener Stiffener thickness Gusset plate

thickness

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Gusset and stiffener dimensions

 Description Default
1 Distance of the gusset plate/stiffener from

the edge of the flange.
2 Gap between the upper flange and the

gusset plate/stiffener.
3 Gap between the lower flange and the

gusset plate/stiffener.
4 Gap between the web and the gusset plate/

stiffener.
5 Straight portion of the gusset plate from the

flange before it begins to slope to the brace.
6 Size of the gusset plate/stiffener chamfer.  
7 Chamfer shape for the gusset plate/stiffener

corners.
Line chamfer

Chamfer type and size

 Description Default
1 Chamfer size for the gusset plate when the

gusset plate extends above or below the
main part flange.

5
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 Description Default
2 Chamfer type for the extended gusset

plate.
Concave arc chamfer

 Description Default
1 Chamfer size for the square corner on the

upper side of the gusset plate.
20

2 Chamfer type for the square corner. Concave arc chamfer

Gusset position

Option Description
Default

Gusset plate above the Cut T profile.

AutoDefaults can change this option.
Gusset plate above the Cut T profile.

Gusset plate below the Cut T profile.

Stiffener creation

Option Description
Default

No stiffener.

AutoDefaults can change this option.
Stiffener perpendicular to the main
part.

Stiffener aligned with the gusset.

No stiffener.

Brace connection tab
Use the Brace connection tab to define how the brace is connected to the
gusset plate.
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Profile properties

Option Description Default
Cut T Cut T profile thickness,

width and height by
selecting the profile
from the profile catalog.

Gusset plate
thickness

Flange Flange thickness for the
Built up T profile.

Note that you must first
define the profile type to
be Built up T.

6 mm

Web Web thickness for the
Built up T profile.

Note that you must first
define the profile type to
be Built up T.

6 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Brace connection profile

 Description Default
1 Type of the T profile to be used in the brace

connection.

When you select Built up T, also define the
gap between the gusset plate and the Built
up T profile.

2 Gap between the gusset plate edge and the
flange of the Built up T profile.

10 mm

Bolts tab
Use the Bolts tab to control the properties of bolts that connect the gusset
plate to the T profile.
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Bolt group dimensions

 Description Default
1 Minimum T profile extension for the top

and bottom of the brace connection.
10 mm

2 Bolt edge distance. 40 mm
3 Number of bolts. 2
4 Bolt spacing.

Use a space to separate bolt spacing values.
Enter a value for each space between bolts.
For example, if there are 3 bolts, enter 2
values.

60 mm

5 Bolt edge distance. 40 mm
6 Number of bolts. 1
7 Bolt spacing.

Use a space to separate bolt spacing values.
Enter a value for each space between bolts.
For example, if there are 3 bolts, enter 2
values.

60 mm

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Main part welds / Cut T welds tabs

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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5.9 Tubes
This section introduces components that can be used in steel tube
connections.

Click the links below to find out more:

• Tube splice (6) (page 1647)

• Tube gusset (20) (page 1655)

• Squeezed tube bolted (102) (page 1683)

• Squeezed tube (103) (page 1695)

• Tube-Chamfer (page 1702)

• Tube-CrossingSaddle (page 1705)

• Tube-MitreSaddle+Hole (page 1707)

• Tube-Saddle+Hole (page 1709)

• Tube-SlottedHole (page 1713)

Tube splice (6)
Tube splice (6) connects two rectangular hollow core sections or round tubes
with splice plates. End plates are created at both ends of the connection.
Connection plates create cuts into the connected parts.

Objects created

• Splice plates

• Connection plates

• End plates

• Welds

• Bolts

• Cuts
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Use for

Situation Description
Tube splice connection to rectangular
hollow core sections.

Tube splice connection to round
tubes.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (column or beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Splice plate
2 Connection plate
3 End plate

Picture tab
Use the Picture tab to control the positions of the plates.
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Plate position

 Description Default
1 Distance between the splice plate and the

end plate.
10 mm

2 Connection plate cut depth.

The cut depth affects the size of the
connection plate.

150 mm

3 Distance between the connection plates. 20 mm

Cut creation

Define whether connection plates create cuts to the parts they connect, and
whether end plates are cut.

Option Description
Default

Connection plate does not create a
cut.

AutoDefaults can change this option.
Connection plate does not create a
cut.

Connection plate creates a
rectangular cut.

Define the horizontal and vertical cut
dimensions.
Connection plate creates a round cut.

Define the horizontal and vertical cut
dimensions, and the radius of the cut.
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Option Description
Default

End plate is not cut.

AutoDefaults can change this option.

End plate is not cut.

End plate is cut.

Parts tab
Use the Parts tab to control the size, position, material, name and finish of the
plates.

Plate

Opttion Description
Splice plate Splice plate thickness.
Connection plate Connection plate thickness.
End plate End plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the splice
plates and the connection plates.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2
values.

5 Dimension for the bolt group position from the center line of the
connected parts.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

End plates tab
Use the End plates tab to control the shape and the dimensions of the end
plate.
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End plate shape

Option Description
Square

Default

Square

Round

End plate chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.
3 Select the chamfer type.

End plate dimensions

Define the dimensions of the square end plate.

 Description
1 Horizontal dimension from the edge of the end plate to the flange of the

column or the beam.
2 Vertical dimension from the edge of the end plate to the flange of the

column or the beam.

End plate dimensions

Define the dimension of the round end plate.
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 Description
1 Dimension from the edge of the end plate to the outer edge of the

column or the beam.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tube gusset (20)
Tube gusset (20) connects 1 to 10 hollow braces to a beam or a column using
a gusset plate. The braces need to have a rectangular hollow section (RHS) or a
tube profile. The connection bolts the braces to the gusset plate using a
connection plate and an optional tongue plate. The hollow braces can be
sealed with end plates.

Objects created

• Gusset plate

• Connection plates

• Clip angles

• End plates (seal plates)
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• Tongue plates

• Cover plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Gusset plate is welded to column
flange.

Brace is welded to connection plate.
The end of the brace is notched to
accommodate the bolts in the
connection between the connection
plate and the gusset plate.

Gusset plate is welded to column
flange.

Brace is bolted to gusset plate using a
tongue plate.
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Situation Description
Gusset plate is connected to column
flange with clip angles.

Brace is bolted to gusset plate using a
tongue plate. The braces are sealed
with end plates, and stiffeners are
created.

Gusset plate is connected to column
flange with a connection plate.

Cross plates and cover plates are
created.

Before you start

Create a beam or a column and 1 to 10 braces with RHS or tube profile.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the connection.
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NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Part identification key

 Part
1 Gusset
2 Stiffener 1
3 Tongue plate
4 Cover plate

Created on the Brace conn tab.
5 Clip angle
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 Part
6 Connection plate

Created on the Brace conn tab.
7 End plates (seal plates)
8 Stiffener 2
9 Cover plate

Created on the Cross plates tab.
10 Cross plate

Picture tab
Use the Picture tab to control the gusset plate dimensions and positioning.

Dimensions

 Description Default
1 Distance between the clip angle or

connection plate upper edge and the
gusset plate upper edge.

 

2 Corner angle of the gusset plate (in
degrees).

This value affects the gusset plate shape.

 

3 Length of the edge of the gusset plate that
is perpendicular to the uppermost brace.

This value affects the gusset plate shape.
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 Description Default
4 Brace length on the connection plate.

Enter a negative value to prevent the
connection plate from being inside the
brace.

150 mm

5 Distance between the gusset plate and the
brace.

If the braces are sealed with end plates,
the distance is between the gusset plate
and the end plate.

20 mm

6 Length of the edges of the gusset plate
perpendicular to the braces.

This value affects the gusset plate shape.

 

7 Length of the edge of the gusset plate that
is perpendicular to the lowest brace.

This value affects the gusset plate shape.

 

8 Distance between the main part and the
first picked brace.

 

9 Distance between the braces.  
10 Distance between the clip angle or the

connection plate lower edge and the
gusset plate lower edge.

 

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.

Option Description
Default

Gusset plate is parallel to the main
part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.
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Gusset plate dimensions

Option Description
Default

Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

AutoDefaults can change this option.
Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

Gusset plate runs through the main
part.

Define the gusset plate extension
dimension.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
and clip angle properties and orientation.

Plates

Option Description Default
Gusset Gusset plate thickness,

width and height.
Connection plates Connection plate

thickness and width.
no connection plate
is created

L profile Clip angle profile by
selecting it from the
profile catalog.

L100*100*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions.

 Description Default
1 Distance between the connection plate and

the inner flange of the main part.
 

2 Horizontal distance between the gusset plate
edge and the flange of the main part.

 

3 Horizontal dimension of the chamfer. 10 mm
4 Vertical dimension of the chamfer. 10 mm

Define the chamfer type.
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Option Description
Default

Line chamfer

AutoDefaults can change this option.
Convex arc chamfer

Concave arc chamfer

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Cut options

If you use beam-column-beam connections and want the gusset plate to
create a cut, you can define how the cut runs through the main part.

Option Description
Default

Cut is created according to the gusset
plate orientation.

AutoDefaults can change this option.

Straight cut.

Steel components reference 1665 Tubes



Brace conn tab
Use the Brace conn tab to control connection plate, tongue plate, and end
plate properties .

Brace connection

Option Description Default
Connection plate Thickness, width and

height of the connection
plate.

thickness = 20 mm

End plates Thickness, width and
height of the end plate.

thickness = 5 mm

Middle end plate Thickness and height of
the middle end plate.

no middle end plate
is created

Tongue plate Thickness and height of
the tongue plate.

no tongue plate is
created

Cover plate Thickness, width and
height of the cover plate.

no cover plate is
created

Stiffener Thickness, width and
height of the stiffener.

no stiffener is
created

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace connection types

Define how the brace is connected to the connection plate.

Steel components reference 1666 Tubes



Option Description
Default

Brace is welded

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

If needed, you can create a cut in the bracing.

Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.

Gusset and connection plate distance

Define the distance between the gusset plate and the connection plate.

Round cut in bracing

If needed, you can create a round cut in the bracing. Enter the radius value.

NOTE The following examples show only some of the available options. You
will find more options on the Brace conn tab.
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Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Connection plate is cut.

Connection plate is cut, but the part
of the connection plate created inside
the bracing is not deleted.
If you cut the connection plate, you
can define the size of the gap
between the brace and the
connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.

Option Description
Default

One connection plate.

AutoDefaults can change this option.
Two connection plates and a middle
end plate at the ends of the
connection plates.
If a middle end plate is created, you
can define the width of the end plate.

Select the middle end plate position.
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Connection plate stiffeners

Option Description
To create stiffeners, define the
stiffener thickness.

By default, one stiffener is created.
When you select to create two
connection plates, you can also select
to create one stiffener on the left or
one on the right, or one stiffener on
both the left and the right side.

Define the inner and outer chamfers
of the stiffeners.

Connection plate chamfer

Define whether the connection plate is chamfered.

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
Chamfers are created.

If you create chamfers, define the
vertical and horizontal chamfer
dimensions.

End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.

Option Description
Default

Square end plate.

AutoDefaults can change this option.
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Option Description
Round end plate.

End plate edge distance from the
brace outer edge.

End plate chamfer

Define the end plate chamfer type and horizontal and vertical dimensions.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description Default
Stiffener 1

Stiffener 2

Stiffener thickness. no stiffener is
created

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate edge.
2 Length of stiffener.

You can fit the stiffeners to the main part. By default, the stiffeners are not
fitted.
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Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew part.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Gusset conn tab
Use the Gusset conn tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.

Bolt group dimensions on gusset plate

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal bolt group

position.
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 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

NOTE The following examples show only some of the available options. You
will find more options on the Gusset conn tab.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.

Main part is welded and secondary is
part bolted.

Both parts are bolted.
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Option Description
Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

Option Description
Default

Bolts are not created in the gusset
plate.

AutoDefaults can change this option.
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Brace bolts 1/Brace bolts 2/Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions on connection plates
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Distance between the brace and the connection plate edge.
5 Select how to measure the dimensions for vertical bolt group position.
6 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the

Yes
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Option Description Default
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt type

Select the bolt type to define the location where the bolts should be attached.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Cross plates tab
Use the Cross plates tab to control the cross plate and the cover plate
properties and position.

Cross plates

Option Description Default
Cross plate Thickness, width and

height of the cover plate.
no cross plate is
created

Cover plate Thickness, width and
height of the cover plate.

no cover plate is
created

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Dimension for the horizontal bolt group position.
5 Vertical dimension of the chamfer.
6 Horizontal dimension of the chamfer.

Cross and cover plate position

Define the position of the cross plate and the cover plate.

Option Description
Default

Cover plate is created on both sides
of the cross plate.

AutoDefaults can change this option.
Cover plate is created on top of the
cross plate.
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Option Description
Cover plate is created on the bottom
of the cross plate.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Squeezed tube bolted (102)
Squeezed tube bolted (102) creates a squeezed part between the main part
and a tubular profile. The main part must be an I or H profile. The squeezed
part can either be a tube that is squeezed at one end and then welded to a
plate, or a contour plate.

Objects created

• Squeezed tube, or reducing contour plate

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
A tubular profile is welded to a bracing which is
bolted to a gusset plate. The gusset plate is
welded to the main part.

A simplified tensioner profile.

Selection order

1. Select the main part (I or H profile).

2. Select the secondary part (tubular profile).

The squeezed part is created automatically.

Part identification key

 Part
1 Main part (I profile)
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 Part
2 Tubular profile

Picture tab
Use the Picture tab to control the bracing levels and offsets.

 Description Default
1 Width of the squeezed part extension. Depends on main part:

main part width -
web thickness / 2.

Example:
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 Description Default
2 Width of the squeezed part. 120 mm
3 Select the type of the reducing part.

Plate:

Squeezed tube:

 

4 Horizontal edge offset.

Example:

0 mm

5 Select how the height of the squeezed part
extension is calculated.

 

Parts tab
Use the Parts tab to control the dimensions of the squeezed part and the
stiffener properties.
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Squeezed part

Define the dimensions and properties of the squeezed part extension.

Option Description
Squeezed part Thickness, width and height of the

squeezed part extension.

Example:

Use the second row to define the
width of the squeezed part. The width
defined on the Parts tab overrides
the width defined on the Picture tab.

Parts add Select whether the squeezed parts
are handled as loose parts, meaning
that they are not attached to any
other profile in the component, or
whether they are added to the
secondary part.

• Yes

Squeezed parts are part added to
the tubular profile.

• No

Squeezed parts remain loose
parts.
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Stiffeners

Option Description
Stiffeners are Select whether the stiffeners are created as

stiffeners or as plates.

• Stiffeners

Define the stiffener dimensions on the
Stiffeners tab.

• Plate stiffeners

Define the dimensions using the
Stiffener plate boxes.

Stiffener plate Define the thickness and width of the
stiffener plate.

NOTE You cannot define the plate height.
The height is equal to squeezed part
height defined on the Picture tab.

Define the stiffener plate height above and
below the tubular profile center line. These
values only take effect if you have set the
Stiffeners are option to Plate stiffeners.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties.

Stiffener 1, Stiffener 2

NOTE The options on this tab work only if you have set the Stiffeners are
option to Stiffeners on the Parts tab.

Stiffener 1 is the stiffener on the side of the squeezed tube. Stiffener 2 is the
stiffener on the other side of the web.

Define the thickness, width and height of the stiffeners.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener gap

Define the size of the gap between the beam flange and the stiffener.

Chamfer dimensions

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.
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Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener side

Define the side of the stiffeners.

On the left side of the squeezed part:
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On the right side of the squeezed part:

Bolts tab
Use the Bolts tab to control the bolts.

Bolt group dimensions
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 Description Default
1 Bolt vertical offset from the center line. 0 mm
2 Number of bolts in vertical direction. 2
3 Bolt spacing.

Use a space to separate bolt spacing values.
Enter a value for each space between bolts.
For example, if there are 3 bolts, enter 2
values.

 

4 Bolt edge distance.

Edge distance is the distance from the center
of a bolt to the edge of the part.

55 mm

5 Number of bolts in horizontal direction. 1

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

Steel components reference 1694 Tubes



To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Squeezed tube (103)
Squeezed tube (103) creates a squeezed part between two tube profiles. The
squeezed part can be either a tube that is squeezed at one end and then
welded to a plate, or a contour plate. It is also possible to define a connection
where no squeezed tubes or contour plates are created, but the profiles are
connected with cuts, fittings, and welds.

Objects created

• Squeezed tube and/or contour plate
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Use for

Situation Description
Tube that is squeezed at one
end and welded to a plate.

Tube that is squeezed at one
end and welded to a plate.

Contour plate.

Selection order

1. Select the main part.

2. Select the secondary part.

The squeezed part is created.

Picture tab
Use the Picture tab to define the shape and dimensions of the squeezed part,
and whether the profiles are connected with a squeezed part or with cuts,
fittings, or welds.

Squeezed part

The first five options create squeezed tubes and contour plates.

The last six options do not create new parts but line cuts, fittings and welds.

Option Description Example
Default

Main and secondary parts are
tube profiles.

A plate is used as a connecting
profile, with one wide end and one
parallel end.
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Option Description Example
A squeezed part and a contour
plate are created.

The tube profile reduces to a
contour plate. You can define the
length of the squeezed part using
dimension b.

Use dimension t to define the gap
between the plate and the main
part.
Same as the Default option.

Use dimensions a and b to define
the length of the wide part and the
parallel part of the plate.

Use dimension t to define the gap
between the plate and the main
part.
Use dimensions a and b to define
the plate length. The plate widens
along its length.

Use dimension t to define the gap
between the plate and the main
part.
Use dimensions a and b to define
the plate length. The widening
starts at the squeezed part and
continues along the contour plate.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is adapted to
the main part using a fitting and a
line cut.

Use dimension c to define an
offset from the centerline of the
main part (default value = 15 mm).

Use dimension t to define the gap
between the plate and the main
part.
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Option Description Example
No new parts are created.

The secondary part is adapted to
the main part using a fitting and
two line cuts.

Use dimension d to define the
distance to the center of the main
part.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is shortened
with a fitting.

Optionally, the secondary part can
be welded to the main part.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is shortened
with a line cut.

Optionally, the secondary part can
be welded to the main part.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is shortened
with a line cut.

Optionally, the secondary part can
be welded to the main part.

Use dimension t to define the gap
between the plate and the main
part.
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Option Description Example
No new parts are created.

The secondary part is shortened
with a line cut.

Optionally, the secondary part can
be welded to main part.

Use dimension t to define the gap
between the plate and the main
part.

Parts tab
Use the Parts tab to define the thickness and width of the squeezed part end.

Option Description
Squeezed part Thickness and width of the squeezed

part end.

The front end of the squeezed part
has the same profile as the secondary
part.

The squeezed part end and the
contour plate are of the same size.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Parameters tab
Use the Parameters tab to define whether the secondary part is welded to
the main part, whether the secondary part, the squeezed part and the contour
plate are handled as a single part, and how the squeezed part is flattened.

Option Description
B squeezed part Define how the squeezed part is

flattened.

The options are:

• ((De – t) * pi + t ) / 2 (default)

• (De * pi) / 2

De = secondary tube profile

Welding

Define whether the secondary part is welded to the main part.

Option Description
Default

Secondary part is welded to the main
part.

AutoDefaults can change this option.
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Option Description
Secondary part is welded to the main
part.

Secondary part is not welded to the
main part.

Part add

Define whether the secondary part, the squeezed part and the contour plate
are handled as a single part.

Option Description
Default

Secondary part, the squeezed part
and the contour plate are not
handled as a single part.

AutoDefaults can change this option.

Secondary part, the squeezed part
and the contour plate are not
handled as a single part.
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Option Description
Secondary part, the squeezed part
and the contour plate are handled as
a single part.

The squeezed part gets the profile
properties from the secondary part.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tube-Chamfer
Tube-Chamfer connects a round tube to a plate or to a round tube. If the
main part is tube, the secondary tube needs to be of equal diameter. The
tubes are chamfered.

Objects created

• Cuts

• Welds
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Use for

Situation Description
Tube-to-tube connection.

Tube-to-plate connection.

Limitations

• No support for polybeams or contour plates.

• No support for non-plate profiles on the main part (for example, H/I beam
or square tube)

Selection order

1. Select the main part (round tube or plate).

2. Select the secondary part (round tube of equal diameter).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the chamfers.
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Connection options

Option Description
Chamfer

Fits the secondary tube to a plate, or
the main and secondary tubes along
the median angle plane.

Offshore Chamfer

Creates back bevel during the tube
NC file creation. No actual back bevel
is created in the model.

NOTE Offshore Chamfer information is used only in NC data, and no actual
back bevels are created in the model.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.

For a tube-to-tube chamfer this
option creates a bevel to both tubes,
adding up to the defined angle.

Root opening above The gap between the parts. The gap is
created in the model.

Shrinkage The shrinkage considered during NC
processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Welding tab

Click the link below to find out more:
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tube-CrossingSaddle
Tube-CrossingSaddle connects a round tube to a round tube. The connection
creates a saddle cut to the secondary tube.

Objects created

• Cuts

• Welds

Use for

Situation Description
Crossing saddle connection.

Limitations

• No support for polybeams or contour plates.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (round tube).

The connection is created automatically when the secondary part is
selected.
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Parameters tab
Use the Parameters tab to control the saddle cuts.

Connection options

Option Description
Crossing Saddle

Creates a crossing saddle to the
secondary part.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.

The bevel is created to the secondary
part.

Root opening above The gap between the parts. The gap is
created in the model.

Shrinkage The shrinkage considered during NC
processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Welding tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Tube-MitreSaddle+Hole
Tube-MitreSaddle+Hole connects a round tube to a round tube of equal
diameter. The connection creates mitre holes to the main part and mitre cuts
to the secondary part.

Objects created

• Cuts

• Welds

Use for

Situation Description
Mitre saddle and hole connection.

Limitations

• No support for polybeams.
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• Parts are only cut, not fitted. Short parts or parts at a steep angle may not
show correct results.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (round tube of equal diameter).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the mitre holes and cuts.

Connection options

Option Description
Saddle + Hole

Creates a mitre cut (double mitre) to
the secondary part, and a mitre hole
to the main part.

Saddle Only

Creates a mitre cut to the secondary
part. No mitre hole is created to the
main part.

Hole Only

Creates a mitre hole to the main part.
No mitre saddle is created to the
secondary part.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.
Root opening above The gap between the parts. The gap is

created in the model.
Shrinkage The shrinkage considered during NC

processing of the tube. The shrinkage
value has no effect on the model.
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Option Description
Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Weldings tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tube-Saddle+Hole
Tube-Saddle+Hole connects a round tube to a round tube of equal or smaller
diameter. The connection creates holes to the main part and saddles to the
secondary part.

Objects created

• Cuts

• Welds
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Use for

Situation Description
Saddle connection.

Limitations

• No support for polybeams.

• The parts are only cut, not fitted.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (round tube of equal or smaller diameter).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the saddles and holes.
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Connection options

Option Description
Saddle

Creates a standard saddle on the
secondary part, fitting it to the main
part.

Weld preparations are created to the
secondary part during NC processing.
Set-on Saddle+Hole

Creates a standard saddle on the
secondary part, fitting it to the main
part. Creates also a hole in the main
part which matches the inner
diameter of the secondary part.

Weld preparations are created to the
secondary part during NC processing.
Set-in Saddle+ Hole

Creates a saddle on the secondary
part, fitting it to the inner surface of
the main part. Creates also a hole in
the main part which matches the
outer diameter of the secondary part.

Weld preparations are created to the
hole on the main part during NC
processing.
Set-on Hole Only

Creates a hole in the main part which
matches the inner diameter of the
secondary tube. The secondary part is
not modified in any way.

No weld preparations are created
during NC processing.
Set-in Hole Only

Creates a hole in the main part which
matches the outer diameter of the
secondary part. The secondary part is
not modified in any way.

Weld preparations are created to the
hole on the main part during NC
processing.
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Option Description
Edge Saddle

Creates a partial saddle on the
secondary part to a main part which
only partially overlaps with the
secondary part.

Weld preparations are created to the
secondary part during NC processing.
Offshore Saddle

Creates back bevel during the tube
NC file creation. No actual back bevel
is created in the model.

NOTE Offshore Saddle information is used only in NC data, and no actual
back bevels are created in the model.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.
Root opening above The gap between the parts. The gap is

created in the model.
Shrinkage The shrinkage considered during NC

processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Welding tab

Click the link below to find out more:
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tube-SlottedHole
Tube-SlottedHole connects a plate to a round tube. This connection creates a
slotted hole to the main part.

Objects created

• Cuts

• Welds

Use for

Situation Description
Slotted hole with a plate.

Limitations

• No support for polybeams or contour plates.

• The hole is created only to one side of the main part. Tube-SlottedHole
cannot be used for creating penetrating slots.

• Connections are not created for plates which are not parallel to the main
axis of the tube.

Selection order

1. Select the main part (round tube).
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2. Select the secondary part (plate).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the slotted holes.

Connection options

Option Description
Slotted Hole

Creates a slotted hole to the main
part.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.

The bevel is created to the slotted
hole.

Root opening above The gap between the plate and the
tube. The gap is created in the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Weldings tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

5.10 Platework
This section introduces components that can be used in steel platework.

Click the links below to find out more:

• Rectangle to circle (17) (page 1715)

• Triangles generation (19) (page 1722)

• Unfold surface (21) (page 1731)

Rectangle to circle (17)
Rectangle to circle (17) creates a reducing piece between a rectangular
profile and a circular or an elliptical profile. The reducing piece consists of
several triangular plates.

Objects created

• Reducing piece

Use for

Situation Description
Reducing piece between rectangular
and circular profile.
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Selection order

1. Select the main part (rectangular profile).

2. Select the secondary part (circular or elliptical profile).

3. Click the middle mouse button to create the reducing piece.

Part identification key

 Part
1 Circular profile
2 Reducing piece
3 Rectangular profile

Picture tab
Use the Picture tab to define the number of parts which the reducing piece
consists of, and the offset for the rectangular and circular profile end.

Option Description
Define the offset for the rectangular
and the circular profile end.

The options are:

• Offset

Fixed distance.

• % x t

Percentage of the plate thickness.
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Option Description

Number of cuts

Define the number of parts which the reducing piece consists of.

By default, there is one cut in the reducing piece.

Option Description
Default

One cut

AutoDefaults can change this option.

No cuts

One cut

Two cuts
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Option Description
Four cuts

Manual creation of reducing piece

You can create the reducing piece without existing profiles by picking three
points at each end of the reducing piece. The picked points define the size of
the reducing piece. You can define the shape of the manually created reducing
piece on the Parameters tab.

Option Description
Picking order of the points:

• center point

• horizontal distance

• vertical distance

Parts tab
Use the Parts tab to define the thickness of the triangular plates in the
reducing piece and the reducing piece position.

Triangle

Option Description
Triangle Triangular plate thickness.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Position in depth

Select the position of the plate segments. The default is Middle.

Parameters tab
Use the Parameters tab to define the shape of the reducing piece end, to
increase or decrease the number of triangular plates, and to define whether
the triangular plates are welded.

Secondary segments

Define the number of the triangular plates in the reducing piece.

The more triangular plates are created, the more accurate is the shape of the
reducing piece.
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3 x 4 plates

6 x 4 plates

First/second shape

Define the shape of the reducing piece end if you have manually created the
reducing piece by picking points in the order shown on the Picture tab.

By default, the shape of the reducing piece end is circular.

First shape Second shape Description
Default

Circle

AutoDefaults can change
this option.
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First shape Second shape Description
Circle

Ellipse

This option works only if
the main or secondary
part has a rectangular
profile.

Rectangle

Welding of the plates

Define whether the triangular plates are welded.

Select the Welding option if you later need to show the unfolded assembly of
triangular plates in an assembly drawing.

Option Description
Plates are not welded.
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Option Description
Plates are welded.

Welds

Click the link below to find out more:

Triangles generation (19)
Triangles generation (19) creates triangular plates, or profiles, for double-
curved surfaces, for example, for spiral stair stringers. A double-curved
surface is created by placing multiple flat triangular plates side by side. The
triangular plates are welded together to enable unfolding of the plates. If
needed, you can unfold the triangular plates using Unfold surface (21).

Object created

• Triangular plates

Use for

Situation Description
Curved surfaces consisting of
triangular plates.
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Situation Description

Before you start

Create points in the model which define the shape of the curved surface. A
minimum of 8 points are needed.

Alternatively, you can define the coordinates of the points in an ASCII file, and
use the file to create the triangular plates. In ASCII files, the values are
separated by spaces, and the decimals in the values are separated by periods,
for example:

0.0 0.0 0.0 6000.0 0.0 -0.0
1620.7 -2010.1 500.0 6995.1 -3159.4 500.0

ASCII file example

The ASCII file for the coordinates of the points has a specific structure. A pair
of coordinates is defined on each row with x-, y- and z-values.

The coordinates need to be placed at even distances from each other.
Therefore, the first row contains a range of numbers that help to place the
coordinates evenly.

The coordinate pairs are defined on the next rows. The first three values
define the local offset (x-,y-, z-) from the first point, and the last three values
define the offset from the second point.
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Selection order

1. Pick the points in the order shown on the Picture tab.

2. Click the middle mouse button to create the curved surface.

Part identification key

 Part
1 Triangular plate

Picture tab
Use the Picture tab to define whether the plates are created according to the
picked points in the model or according to the coordinates defined in an ASCII
file, and to set the global displacement.

Plate definition

Option Description
With picked points Shape of the triangular plate by picking the points

that you have previously created.
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Option Description
Read points in ASCII file Shape of the triangular plate by giving the

coordinates in an ASCII file.

Offset

Use Global displacement to define an offset for the created plates or profiles
in x, y and/or z direction.

Parameters tab
Use the Parameters tab to define the ASCII file, whether plates or profiles are
created, and how extra points are handled.

Option Description
File name Enter the name of the ASCII file where you have

defined the coordinates for the points.

The file is searched from the model folder.
Create plates profiles Define whether plates or profiles are created.

By default, plates are created.

You can define the plate properties on the Plate tab
and the profile properties on the Profile tab.
Plates are created:
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Option Description
 Profiles are created:

Plates and profiles are created:

Number of extra
points

Define whether extra points are automatically
created between the picked points, or set
coordinates, to smoothen the plates.
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Option Description
Number of extra points: 0

Number of extra points: 3

Method to calculate
extra points

If the curved plates form an arc, define whether the
arc is taken into account for extra point calculation.
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Option Description
The 1st order option does not take the arc into
account for extra point calculation.

The 3rd order option takes the arc into account, and
the extra points are placed in the same arc as the
original points.

The Cardinal spline total length option uses
Cardinal spline interpolation over all points.
The Cardinal spline in middle option uses Cardinal
spline interpolation only for middle points.

Smoothness spline
0-1

Define the smoothing spline.

Coplane distance Define the coplane distance.
Create points Define whether points are placed on every

coordinate.
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Option Description
Points are placed on every coordinate:

No points:

Close curve Define whether the contour is closed.
Contour is closed:

Contour is not closed:

Plate tab
Use the Plate tab to define the plate properties and position.

Option Description
Plate Triangular plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  

Offset

Define the position of the triangular plates relative to the picked points or the
coordinates.

Join plates

Define whether the triangular plates are attached to each other.

Select the Welding option if you later need to unfold the triangular plates. The
triangular plates form an assembly which can be flattened by using Unfold
surface (21).

Profile tab
Use the Profile tab to define the profile properties and position.

Profile

Option Description
Profile Define the profile by selecting it from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Profile orientation

Use Position in plane, Rotation and Position in depth options to define the
orientation of the profile.
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Chamfers tab
Use the Chamfers tab to define chamfers for the created triangular plates.

  
Select the chamfer shape.

X, Y Enter the x and y direction
coordinates.

Position Select the relative position for each
vertex.

Picked points are the input points of
the component.

Extra points are points that the
component creates. Enter the
number of extra points on the
Parameters tab to define the
fragmentation of the result surface.

Angle conditions Set the angle interval for each vertex.

For example, if you set > 0 and < 90,
all angles are between 0 and 90.

Unfold surface (21)
Unfold surface (21) unfolds welded plates. The unfolded plates are created to
a location that you have defined. Use Unfold surface (21) to unfold triangular
plates created with, for example, Triangles generation (19). You can also
create assembly drawings from the unfolded plates.

Objects created

• Unfolded plates
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Use for

Situation Description
Unfolded triangular plates

Limitations

• Unfold surface (21) only works with contour plates. Do not use Unfold
surface (21) to unfold beams or polybeams.

• We recommend that you use the same position-in-depth settings for all
plates.

• In some cases, an error can occur when unfolding complex surfaces that
have holes. You can use the Do not refine edges option on the Big plate
tab to prevent this.

• Unfold surface (21) preserves anti-material cuts, line cuts, and bolts. Edge
chamfers are not preserved.

• The plates should be neighbors with no gaps between them.

• The plates must be welded as neighbors. Welds must not have zero size.

NOTE If the weld size between the triangular plates is set to 0.0, Unfold
surface (21) unfolds only one triangular plate, not all the welded
triangular plates.

If needed, you can create breaks in the unfolded shape using the weld sizes.
For example, if the default weld size is 5.0, but one weld gets size 0.0, a break
is created to the unfolded plate.

Option Description
1 Unfolded form
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Option Description
2 Unfolded form

Selection order

1. Select a location for the unfolded plate.

2. Select a triangular plate.

The unfolded plate is created to a location you have defined.

Plates tab
Use the Plates tab to define the thickness of the unfolded plate and whether
the properties of the triangular plates are used in the unfolded plate.

Option Description
Replace Thickness of the unfolded plate.

If you do not enter any value, the
thickness of the triangular plates is
used.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Option Description
Zero welds Select whether to ignore the plates that are connected

by zero welds or not.
Unfolding by Select how the plates should be unfolded:

• By Geometry - in the order in which the original
plates were created.
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Option Description
• By Welds - in the way the pieces of original plates

were welded together.
Profile Select the second column of the check boxes if you

want to use the properties of the triangular plates in
the unfolded plate.

If you are unfolding a plate created with Rectangle to
circle (17), and want to maintain the assembly
position numbers defined in Rectangle to circle (17),
clear the second check box next to the Profile option.

Name
Material
Class

Big plate tab
Use the Big plate tab to define the type and the accuracy of the unfolded
plate.

Option Description
Merge points Define the accuracy of the unfolded plate by

adding or removing points.

Select whether the points in the resulting unfolded
plate are merged or not.

Merge limit If you want to merge points, define the limit for
the merging. The points that are closer to each
other than the set limit are merged.

• Points are not merged.
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Option Description
• Points are merged, and the merge limit is

15.00.

Attach with Select how the final plates are connected.

Unfolded plate type and offset

Option Description
Type One plate

One plate is created.

Plates

Plates are welded together.
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Option Description

Both

Both one plate and a plate with welds
are created.

If you select Both, you can define the
distance between the plates using the
Offset option.

Offset

Define the distance between the unfolded plates.

Do not refine edges

This option prevents errors that may sometimes occur when unfolding
complex surfaces that have holes.
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Parameters tab
Use the Parameters tab to define the weld reference text in an assembly
drawing.

Text in drawings

Option Description
Prefix First part of the text that is shown in

assembly drawings, for example,
Angle=.

Format Format in which the size of the
unfolding is displayed.

Postfix Last part of the text that is shown in
assembly drawings, for example,
degrees.

UDA tab
Use the UDA tab to copy the original numbering and user-defined attributes
(UDAs) from the original plates to the unfolded plate.

Option Description
Set following
parameters

Copy the properties of the original plates to the UDAs
of the unfolded plate. Enter the name of the UDA for
each property that you want to copy.

Copy following UDAs Define which UDAs are always copied from the
original plates to the unfolded plate.

Surrounding rectangle tab
Use the Surrounding rectangle tab to calculate the length and width of the
smallest rectangle around the unfolded area or the big plate.
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The example image below shows the dimensions with green arrows.

Option Description
Calculate
surrounding
rectangle

Select one of the following:

• No (default).

Surrounding rectangle is not created. You cannot
enter any user-defined attribute (UDA) value or
plate properties.

• Yes

Enter the UDAs for length and width.

The rectangle is created with the dimensions
defined in the UDAs.

• Yes and create construction lines

Enter the UDAs for length and width.

The shape of the surrounding rectangle is shown
with construction lines.

Plates are unfolded by keeping the original
smaller plates (mostly triangles), and with one big
plate. Two rectangles are created: one around the
original plates and one around the big plate.
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Option Description

• Yes and create plate

Enter the UDAs for length and width, and the
plate properties and the offset.

The rectangle is created as a plate. The
rectangular plate has the same thickness as the
unfolded plate (defined on the Plates tab).

Check on the UDA tab that you have entered the
UDAs needed for the rectangular plate.

UDA to put length

UDA to put width

Enter the user-defined attributes (UDA) for length
and width that are used in the surrounding
rectangle.

The calculated length and width cannot be saved if
you do not enter the UDAs. Note that you have to
enter both UDAs to save the calculated dimensions.
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Option Description
Rectangular plate The rectangular plate has the same thickness, part

position number, material, name and class as the
unfolded plate.

Define the UDAs for the plate on the UDA tab.
Offset Define the perpendicular offset to the unfolded

plate. By default, the offset is zero.

Rectangular plate properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

5.11 Frames
This section introduces components that can be used in steel frames.

Click the links below to find out more:

• Truss (S78) (page 1740)

• Opening Frame (page 1750)

Truss (S78)
Truss (S78) creates a truss between selected points. Truss (S78) does not
create any connections to existing parts.

Objects created

• Top chord
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• Bottom chord

• Diagonals

• Verticals between diagonals

• Cap plates

Use for

Situation Description
Truss with top chord, tilted bottom
chord, cap plates, diagonals and
verticals.

Truss with top chord, bottom chord,
cap plates, diagonals and verticals.

Truss with top chord, bottom chord,
cap plates, diagonals and verticals.

Selection order

1. Pick the start point of the truss.
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2. Pick the end point of the truss.

The truss is created automatically when the end point is picked.

Part identification key

 Part
1 Top chord
2 Bottom chord
3 Vertical
4 Diagonal

Picture tab
Use the Picture tab to control the gap created between diagonals, the
eccentricity of the diagonals, and the dimensions of the parts.

Gap dimensions
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 Description Default
1 Gap between the diagonals at the top

chord.
20 mm

2 Gap between the diagonals at the bottom
chord.

20 mm

Eccentricity dimensions

 Description Default
1 Eccentricity of the diagonal intersection at

the top chord.
20 mm

2 Eccentricity of the diagonal intersection at
the bottom chord.

20 mm
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Part dimensions

 Description Default
1 Define how the top and bottom chords are

connected.

• Apex haunch (106)

Use with top and bottom chord I profiles.

• Joining plates (14)

• Welded

• Continuous

Creates a continuous top or bottom
chord.

Welded

2 Select an attribute file for the connection. standard
3 Horizontal distance between the start/end

point of the truss and the first/last diagonal.
200 mm

4 Vertical distance between the start/end
point of the truss and the bottom level of
the bottom chord.

1000 mm

5 Top chord extension from the start/end
point of the truss.

0 mm

6 Bottom chord extension from the first and
the last diagonal/vertical to the chord end.

240 mm
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 Description Default
7 Define how the chords, diagonals and

verticals are connected.

• Gusset plate (11)

• Round tube (23)

Used with round tube profiles.

• Welded

Welded

8 Vertical distance between the truss apex
and the bottom level of the bottom chord.

2000 mm

9 Horizontal distance between the top chord
extension and the truss apex.

entire truss
length/2

Parts tab
Use the Parts tab to control the profiles for chords, diagonals and verticals.

Profiles

You can define the profiles for the top and bottom chords, and up to seven
profile types for the diagonals and verticals.

Use the Diagonals and the Verticals fields to define how the different profiles
are created.

Option Description Default
Top Chord Define the top chord

profile by selecting it
from the profile catalog.

CFRHS100*4

Bottom Chord Define the bottom chord
profile by selecting it
from the profile catalog.

CFRHS100*4

Profile 1 -

Profile 7

Define a profile by
selecting it from the
profile catalog.

CFRHS80*4

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Diagonals and verticals creation for left (1) and right (2) side

Opti
ons

Description

Diag
onal
s

Define how the diagonals are created using the above profiles.

• The diagonals are created by multiplying the number of diagonals
with the type of profile, number*profile.

For example, 2*3 creates two diagonals of the type Profile 3.

For example, 1*2 is the same as 2, and creates one diagonal of the
type Profile 2.

• The number of diagonals results from the pattern. For example, 2
2*3 1 creates 4 diagonals.

• The diagonals are created from the start/end point towards the
truss center.

If you have set the Truss type to Single pitch truss on the
Parameters tab, the second Diagonals row is ignored. The
diagonals are created from the start point to the end point of the
truss.

Verti
cals

Define how verticals are created using the above profiles.

The verticals are positioned between the diagonals, and the maximum
number of verticals results from the number of diagonals.

Twin profiles

Define whether the top or the bottom chord is created using twin profiles.
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Top and bottom chord type

Option Description
Short legs up

Default
Short legs down
Long legs up
Long legs down

Diagonal and vertical type

Option Description
Short leg up

Default
Short leg down
Long leg up
Long leg down

Clearance

Define the gap between the twin profiles.

Parameters tab
Use the Parameters tab to control the truss assembly, and the diagonals and
verticals creation.

Assembly main part

Define which part is the main part in the truss assembly.

• Left Top Chord

Additional welds are created between the truss and the left top chord.

• Right Top Chord

Additional welds are created between the truss and the right top chord.

• Left Bottom Chord

Additional welds are created between the truss and the left bottom chord.

• Right Bottom Chord

Additional welds are created between the truss and the right bottom
chord.

• None

The assembly main part is controlled by the bolts/welds that the Truss
(S78) creates and the connections used between the parts. If all bolts/welds
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are set to Site, then each part (top/bottom chords, verticals, diagonals)
forms an individual assembly.

Verticals at truss end

Define whether a vertical is created to the truss ends.

Option for start point Option for end point Description
Default

No vertical is created to
the end.

AutoDefaults can change
this option.
No vertical is created to
the end.

Vertical is created to the
end.

Middle verticals

Define whether the verticals are created between diagonals.

Option Description
Default

No middle verticals are created.

AutoDefaults can change this option.
No middle verticals are created.

Verticals are created between the
diagonals.

Verticals are created between the
diagonals. Verticals and diagonals
form an N-type truss.
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Extension for verticals and diagonals

 Description Default
1 Extension for diagonals and verticals in

the top chord.
0 mm

2 Extension for diagonals and verticals in
the bottom chord.

0 mm

Truss type

Option Description
Default

Single pitch truss

AutoDefaults can change this option.
Single pitch truss

Top chord is horizontal. Bottom chord
can be sloped.
Ridge truss

If the apex and the start/end point of
the truss are of equal height, the
chords are horizontal.
Upside-down ridge truss

If the apex and the start/end point of
the truss are of equal height, the
chords are horizontal.

Truss style

Option Description
Default

WWW

AutoDefaults can change this option.
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Option Description
WWW

The first diagonal begins from the top
chord.
AAA

The first diagonal begins from the
bottom chord.

Cap plate tab
Use the Cap Plate tab to control the cap plate creation.

Connection 1002 properties for cap plate

Cap plates are created using the End plate detail (1002) component that has
a given set of properties. You can name the properties sets.

Top and bottom chord cap plates

Define whether a cap plate is created.

Option for left side cap
plates

Option for right side
cap plates

Description

Default

No cap plate is created.

AutoDefaults can change
this option.
No cap plate is created.

Cap plate is created.

Opening Frame
Opening Frame creates an open frame for wall, roof, or floor openings. The
frame is created between beams or columns.

Objects created

• Top frame

• Bottom frame

• Vertical posts

• Additional component (optional)
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Use for

Situation Description
Open frame between two columns
with top frame, bottom frame, and
two pairs of vertical posts.

Open frame between two skew
columns with top frame, bottom
frame, and two pairs of vertical posts.

Before you start

Create two columns or beams.

Selection order

1. Select the main part.

2. Select the secondary part.

3. Pick the start point of the opening frame.

4. Pick the end point of the opening frame.
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Part identification key

 Part
1 Top frame
2 Vertical post
3 Bottom frame

Picture tab
Use the Picture tab to control the frame position, offsets, and spacings.

Frame distance

 Description Default
1 Distance between the top and the bottom

frames.
1200 mm

Frame horizontal offset
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 Description Default
1 Horizontal offset of the frame from the

start/end point.
0 mm

Frame vertical offset

 Description Default
1 Vertical offset of the frame from the

start/end point.
0 mm

Frame position

Option Description
Default

Top

AutoDefaults can change this option.

Top
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Option Description
Bottom

Middle

Frame mirroring

Mirror the frame in relation to the start point and the end point.

When the frame is mirrored, also part rotation and additional connections
follow the mirroring.

Option Description
Default

Frame is not mirrored.

AutoDefaults can change this option.

Frame is not mirrored.

Frame is mirrored.
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Created parts

Option Description Default
Frames to create Define whether top,

bottom, or both frames
are created.

Both

Pairs vertical posts Define how many pairs
of vertical posts are
created.

3

Spacing pairs (S1, S2,
Sn)

Spacing between the
pairs.

The spacing is measured
from the first vertical
post inner side of the
first pair to the first
vertical post inner side
of the second pair.

• If the spacing value
between the posts
exceeds the bottom
frame length, then
only top and bottom
frames are created,
and a warning
message is displayed.

• If the number of
spacings is greater
than the number of
the entered spacing
values, the missing
spacing values are
the same as the last
spacing value.

For example, if Pairs
vertical posts = 4
and Spacing pairs =
100 200, the spacing
values are 100 200
200.

1800 mm

Spacing vertical posts
(W1, W2, Wn)

Spacing between the
vertical posts in the
pairs.

The spacing is measured
from the first vertical
post inner side to the

500 mm
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Option Description Default
second vertical post
inner side.

If the number of
spacings is greater than
the number of the
entered spacing values,
the missing spacing
values are the same as
the last spacing value.

Create welds Define whether welds
are created.

The options are:

• Posts-Frames (5)

Welds are created
only for posts on
frames.

• Columns-Frames
(1-4)

Welds are created
only for frames on
column.

• All

All welds are created.

• No

No welds are
created.

Posts-Frames(5)

Parts tab
Use the Parts tab to define the part properties.

Dimensions

Option Description Default
Top Frame Top frame profile by

selecting it from the
profile catalog.

L100*50*5

Bottom Frame Bottom frame profile by
selecting it from the
profile catalog.

L100*50*5
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Option Description Default
Vertical Posts Vertical post profiles by

selecting them from the
profile catalog.

L100*50*5

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Twin profiles

Option Description Default
Twin profiles • No

Top frame, bottom
frame, or vertical
posts are created
using single profiles.

• Yes

Top frame, bottom
frame, or vertical
posts are created
using twin profiles.
The twin profile is
composed of the
profile that you
selected from the
profile catalog.

No

Type

Define the profile rotation for single profiles or for twin profiles.
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Options for single profile:

Option Description
Type 1
Type 2
Type 3

Type 4

Type 5
Type 6
Type 7

Type 8

Options for twin profile:

Option Description
Type 1
Type 2
Type 3

Type 4

Clearance

Option Description Default
Clearance Clearance between the

twin profiles.

You can define the
clearance only if the
Twin Profile field is set
to Yes.

0 mm

Position

Option Description Default
On plane Part position on work

plane.
Middle

Rotation Define how much the
part is rotated around its
axis on the work plane.

You can define the
rotation only for twin
profiles. Define the

Front
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Option Description Default
rotation for single
profiles in the Type field.

At depth Part position, in terms of
depth, perpendicular to
the work plane.

Middle

Connections tab
Use the Connections tab to define the properties of connection components
that are created between the parts.

Connection properties

NOTE With twin profiles the connection is created between only one part of
the twin profile, and thus the connection is not well supported. If you
use connections to connect twin profiles, a warning message is
displayed.

Option Description Default
Connection number Define a connection that

connects the parts by
selecting it from the
component catalog.

If the field is empty or
set to 0, welds are
created instead.

 

Attribute file Select an attribute file
for the connection.

standard

Welds tab

Click the link below to find out more:

5.12 Stairs
This section introduces components that can be used in steel stairs.

• Stairs (S71) (page 1760)

• Wooden steps pan (S72) (page 1780)

• Polybeam pan (S73) (page 1794)

• Handrail 1 (74) (page 1809)
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• Z pan (S74) (page 1814)

• Stanchions (S76) (page 1849)

• Railings (S77) (page 1856)

• Multiple beam railing (S84) (page 1887)

• Stringer to channel (127) (page 1892)

• Stair base detail (1038) (page 1900)

• Stair base detail (1039) (page 1907)

• Stair base detail (1043) (page 1913)

• Ladder (S35) (page 1924)

• Ship Ladder (page 1933)

• Wall Rails (page 1953)

Stairs (S71)
Stairs (S71) creates straight stairs with optional top and bottom landings. The
stairs consist of stringers, possible landings and the actual steps.

Objects created

• Stringers

• Steps

• Landings (optional)

• Brackets

• Plates (optional)

• Cuts (optional)

• Bolts

• Welds
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Use for

Situation Description
Stairs with horizontal top and bottom
landings.

U pan profile steps with brackets.

Brackets are welded to the stringers
and bolted to the steps.

Stairs with stringers notched to the
supporting beam.

Steps are catalogue steps.

You may also use your own custom
components as steps.

Before you start

If the stringers are notched, create the supporting beams before creating the
stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.
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2. Pick another point to indicate the nosing point of the last step.

Note that the order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.

Part identification key
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 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the landing types, and the shape and the
location of the stringers in relation to the points you pick when creating the
stairs.

Top landing types

Option Description
Default

Horizontal

AutoDefaults can change this option.

Horizontal

Notched

The stringer top is on the supporting part. Vertical
and horizontal plates are welded at the end of the
stringer.

Bottom landing types

Option Description
Default

Horizontal

AutoDefaults can change this option.
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Option Description
Vertical

Creates a vertical landing where the lower point is
on the top plane of the last step.

Horizontal

Creates a horizontal landing where the lower point
is on the top plane of the last step.

Vertical lowered point

Creates a vertical landing where the lower point is
at the top of steel or on the floor level.

Horizontal lowered point

Creates a horizontal landing where the lower point
is at the top of steel or on the floor level.

Notched

Creates a notch to the bottom of the stringer. A
vertical plate is welded at the end of the stringer.
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Stair dimensions

 Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the upper
point to the top of steel of the top landing.

If the top landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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 Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,

where Z is the vertical
distance between the 2
picked points.

4 Select the direction of the nosing
dimension of the steps:

• Vertical

• Horizontal

• Perpendicular

Define the nosing dimension of the steps.
This dimension depends on the direction
you have selected.

Vertical

0 mm

5 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the vertical distance from the
lower point to the top of steel of the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the horizontal distance from the
lower picked point to the most distant
face of the bottom landing.

• Notched bottom landing.

Define the horizontal distance from the
lower point to the stringer vertical cut.
By default, the cut is made at the
supporting part edge.

150 mm
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 Description Default
6 Define the vertical dimension from the

lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the
bottom landing type is either vertical or
horizontal lowered point.

Equal with vertical spacing
between steps

7 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm

8

11

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the lowest
point of the bottom landing.

600 mm

9 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

10 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

12 Define the dimension to shorten the steps
equally on both sides.

0 mm

13 Define the width of the steps. 1000 mm
14 Define the horizontal gap between the

upper supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm
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 Description Default
15 Define the vertical gap between the upper

supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

16 Define this dimension based on the
selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

0 mm

17 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal

18 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact, or
to Equal and the spacing distance is not
defined, Stairs (S71) creates the number
of steps you have defined.
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Stair set up tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.

Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.
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 Part Description Default
4 Lower V plate Created only if the

bottom of the stringer
is on the supporting
beam.

6 mm
The default name is PLATE.

5 Catalogue step Created only if Step
type is set to
Catalogue step. In this
case, the U-pan steps,
brackets, and bolts
defined on the other
tabs are ignored.

First profile from the
Catalogue step list, defined
in the steps.dat text file in
the system (page 424) folder.
The list changes according to
the selected environment.

The default name is STEP.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Stair setup settings

Option Description
Step type • Steps: The steps are created from the steel pan that is

defined on the Steps tab.

• Catalogue step: The steps are created from the profile
defined in the Catalogue step option. The options on
the Steps and Bracket tabs are not used.
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Option Description
Create
assembly

Select which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Steps rotation Rotation of the step around its axis. The default is Top.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Bolt Type Select the bolt type for catalogue steps.

If you select the Workshop option, the bolts are shown in
workshop assembly drawings in the list of workshop bolts.

Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.

Steps tab
Use the Steps tab to control the shape and the size of U pan steps. Instead of
a U pan, you can create the steps by using a catalog profile, or a custom part
or component.
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U-pan step dimensions

 Description Default
1, 2,
10,
11

Define the chamfer
values on both sides of
the step.

Select the chamfer type
to set the shape of the
front and back corner of
the step.

15 mm

3 Define the angle of the
step relative to the
horizontal line.

The angle can be positive
or negative.

0 degrees

4, 12 Define the height of the
step.

100 mm

5, 13 Define the length of the
horizontal portion of the
U pan.

50 mm

Steel components reference 1772 Stairs



 Description Default
6, 7 Define the angle of the

vertical portion of the
step relative to the
vertical line.

The angle can be positive
or negative.

0 degrees

8 Define the thickness of
the U pan step material.

10 mm

9 Define the width of the
step.

Bracket length * 1/0.7

Step type

Option Description
Default

U pan legs up

AutoDefaults can change this option.

U pan legs up

U pan legs down

Custom

Define the custom profile options.

Custom profile

Option Description Default
Step profile Select a profile

from the profile
catalog.

You can select a
step profile when
the Step type is set
to custom and the
Part name/Joint

PL100*80
The default name is STEP.
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Option Description Default
no. option has not
been set.

Part name/
Joint no.

Select a custom
part or a
connection from
the Applications &
components
catalog.

 

Attribute file Select the attribute
file.

standard

Vertical
position

Select the vertical
depth position of a
step that is created
as a custom part.

If you are using a
custom connection,
this option is not
used.

Middle

Horizontal
position

Select the
horizontal on plane
position of a step
that is created as
custom part.

If you are using a
custom connection,
this option is not
used.

Middle

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bracket tab
Use the Bracket tab to set up brackets, and the connection between the
brackets and the steps, and the brackets and the stringers. The brackets
support the angle profiles under the steps.

Bracket

Part Description Default
L
profile

To create an L
profile, select a
profile from the
profile catalog.

BLL80*80*10
The default name is L_Profile.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Bracket dimensions

 Description
1 Define the length of the bracket.

The default length is calculated according to the bracket-to-step or
bracket-to-stringer bolt dimensions, depending on which are bigger.

2 Define the bracket offset dimension from the center line of the step.

The default is 0 mm.

Bracket-to-step connection

Define the properties of the bolts that connect the bracket to the step.

 Description
1 Define the basic bolt basic properties:

• Bolt size defines the bolt diameter. Available sizes are defined in the
bolt assembly catalog.
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 Description
• Bolt standard defines the bolt standard to be used inside the

component. Available standards are defined in the bolt assembly
catalog.

• Tolerance defines the gap between the bolt and the hole.

• Thread in mat defines whether the thread may be within the bolted
parts when bolts are used with a shaft. This has no effect when full-
threaded bolts are used.

2 Select whether brackets are created or not.
3 Define the bolt group dimensions.
4 Select the connection type between the steps and the brackets:

• Bolted

Bolted is the default.

• Welded

• No connection

• Plate bracket

Bracket angle leg is not created.

• Holes only

5 Select the bolt direction.
6 Define the slotted hole properties:

• Slotted holes no. defines the number of slotted holes.

• Hole type creates either Slotted holes, or Oversized or tapped holes.

• Rotate slots rotates slots when the hole type is slotted.

• Slots in defines in which parts the slotted holes are created.
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 Description
7 Define the exact length of the bolts.

You can define the length of the bolts if the Step type is set to on the
Steps tab.

8 Define the slotted hole dimensions.

Bracket-to-stringer connection

Define the properties of the bolts that connect the bracket to the stringer.

 Description
1 Define the basic bolt properties:

• Bolt size defines the bolt diameter. Available sizes are defined in
the bolt assembly catalog.

• Bolt standard defines the bolt standard to be used inside the
component. Available standards are defined in the bolt assembly
catalog.

• Tolerance defines the gap between the bolt and the hole.

• Thread in mat defines whether the thread may be within the
bolted parts when bolts are used with a shaft. This has no effect
when full-threaded bolts are used.

2 Define the bolt group dimensions.
3 Define the bolt assembl.

The selected check boxes define which component objects (bolt,
washers, and nuts) are used in the bolt assembly. If you want to
create a hole only, clear all the check boxes. To modify the bolt
assembly in an existing component, select the Effect in modify
check box and click Modify.

4 Define the slotted hole properties.

• Slotted holes no. defines the number of slotted holes.
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 Description
• Hole type creates either Slotted holes, or Oversized or tapped

holes.

• Rotate slots rotates slots when the hole type is slotted.

• Slots in defines in which parts the slotted holes are created.
5 Define the slotted hole dimensions.
6 Select the connection type between the stringer and the brackets:

• Bolted

Bolted is the default.

• Welded

• No connection

7 Select the bolt direction.
8 Set the bracket position of a plate bracket:

• Below the step

Below the step is the default.

• Between the step and the stringer

You can use this option when you have set the connection type
between the steps and the brackets to the plate bracket option

.

Welds

Click the link below to find out more:
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Wooden steps pan (S72)
Wooden steps pan (S72) creates straight stairs with optional top and bottom
landings. The stairs consist of stringers, possible landings and the actual steps.

Objects created

• Stringers

• Steps

• Landings (optional)

• Brackets

• Plates to the stringer ends (optional)

• Bolts

• Welds

Use for

Situation Description
Stairs with wooden steps. Vertical
bottom landing type.

Stairs with C-shaped stringers.
Horizontal bottom landing type.
Wooden steps are bolted to steel
brackets.
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Situation Description
Stairs with stringers notched to the
supporting beam.

Before you start

If the stringers are notched to bear on the supporting beams, create the
supporting beams before creating the stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.

2. Pick another point to indicate the nosing point of the last step.

The order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.
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Part identification key

 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the stringer geometry and the nosing points of
the steps.

Top landing type

Option Description
Default
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Option Description
Horizontal landing

Notched

The stringer top is on the supporting
part. Vertical and horizontal plates
are welded at the end of the stringer.

Bottom landing type

Option Description
Default

Vertical

Creates a vertical landing where the
lower picked point is on the top plane
of the last step.

Horizontal

Creates a horizontal landing where
the lower picked point is on the top
plane of the last step.
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Option Description
Vertical lowered point

The picked point is at the top of steel
or finish floor.

Horizontal lowered point

The picked point is at the top of steel
or finish floor.

Notched

Creates a notch to the bottom of the
stringer to bear on the supporting
part. A vertical plate is welded at the
end of the stringer.
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Stair dimensions

Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the
upper point to the top of steel of the top
landing.

If the upper landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps
from the bottom to the top, with the
height calculated as close to 200 mm as
possible.

(Z*220)/(Z+220) mm,
where Z is the
vertical distance
between the 2
picked points.

4 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point

Define the vertical distance between
the lower picked point and the top of
steel of the bottom landing.

• Vertical or vertical lowered point

Define the horizontal distance between
the lower picked point and the most
distant face of the bottom landing.

• No bottom landing is selected

Define the horizontal distance from the
lower picked point to the stringer
vertical cut. By default, the cut is made
at the supporting part edge.

150 mm

5 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the
bottom landing type is either vertical or
horizontal lowered point.

equal with vertical
spacing between
steps

6 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm
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Description Default
7

10

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the
lowest point of the bottom landing.

600 mm

8 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

9 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

11 Define the width of the steps. 0 mm
12 Define the dimension to shorten the steps

equally on both sides.
1000 mm

13 Define the horizontal gap between the
upper supporting part and the stringer
cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

14 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

15 Define this dimension based on the
selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

0 mm
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Description Default
• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

16 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the
upper point to the lower point. In all other
cases the steps are spaced from the lower
point to the upper point.

Equal

17 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact,
or to Equal and the spacing distance is not
defined, Wooden steps pan (S72) creates
the number of steps you have defined.

Calculated from the
vertical distance
between the 2
picked points and
the spacing between
steps (3)

Stair setup tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.
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Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer in on the
supporting beam.

6 mm
The default name is PLATE.

4 Lower V plate Created only if the
bottom of the stringer
in on the supporting
beam.

6 mm
The default name is PLATE.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Stair setup settings

Option Description
Create
assembly

Define which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Steps rotation Rotation of the step around its axis. The default is Top.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.
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Bolts tab
Use the Bolts tab to control the properties of the bolt group that connects the
wooden steps to the brackets.

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm

Bolting direction

Use to change the direction of bolts.

Option Description
Default.

Bolted from the bracket to the step.
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Option Description
Bolted from the step to the bracket.

Bolt basic properties

 Description Default
Bolt size Bolt diameter. 20 mm
Bolt standard The bolt standard to be

used inside the
component.

7990

Tolerance The gap between the
bolt and the hole.

2 mm

Thread in mat Defines whether or not
the thread may be
within the bolted parts
when using bolts with a
shaft. This has no effect
when using full-threaded
bolts.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Wooden pan tab
Use the Wooden pan tab to define the step profile and the properties of the
folded plate brackets.
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Step bracket and profile

Part Description Default
Step
bracket

To create a step
bracket, select a
profile from the
profile catalog.

PL10*150

Step
profile

To create steps,
select a profile from
the profile catalog.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Bracket dimensions
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Description Default
Define the offset dimension that moves the
folded bracket plates relative to the center
line of the stringer.

0 mm

Define the thickness of the steps that will be
placed on the folded brackets. The actual
steps will not be created, only the brackets
height will be resized.

0 mm

Define the angle for the bracket to be folded,
in degrees.

0

Welds

Click the link below to find out more:

Polybeam pan (S73)
Polybeam pan (S73) creates straight stairs with optional top and bottom
landings. The stairs consist of stringers, possible landings, and the actual steps
created with plates.

Objects created

• Stringers

• Steps

• Landings (optional)

• Cuts to notch the stringer (optional)

• Plates (optional)

• Bolts

• Welds

Steel components reference 1794 Stairs



Use for

Situation Description
Polybeam pan stairs.

Top of the stringer is
created as horizontal
landing.

Bottom of the
stringer is notched
to bear on the
supporting beam.

The same option is
also available for the
top of the stringer.

Before you start

If the stringers are notched to bear on the supporting beams, create the
supporting beams before creating the stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.
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2. Pick another point to indicate the nosing point of the last step.

Note that the order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.

Part identification key

Steel components reference 1796 Stairs



 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the stringer geometry and the nosing points of
the steps.

Top landing type

Option Description
Default

Horizontal landing

Notched

The stringer top is on the supporting
part. Vertical and horizontal plates
are welded at the end of the stringer.

Bottom landing type

Option Description
Default
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Option Description
Vertical

Creates a vertical landing where the
lower picked point is on the top plane
of the last step.

Horizontal

Creates a horizontal landing where
the lower picked point is on the top
plane of the last step.

Vertical lowered point

The picked point is at the top of steel
or finish floor.

Horizontal lowered point

The picked point is at top of steel or
finish floor.

Notched

Created a notch to the bottom of the
stringer to bear on the supporting
part. A vertical plate is welded at the
end of the stringer.
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Stair dimensions

 Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the upper
point to the top of steel of the top landing.

If the top landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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 Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,

where Z is the vertical
distance between the 2
picked points.

4 Select the direction of the nosing
dimension of the steps:

• Vertical

• Horizontal

• Perpendicular

Vertical

5 Define the nosing dimension of the steps.
This dimension depends on the direction
you have selected.

0 mm

6 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing

Define the vertical distance from the
lower point to the top of steel of the
bottom landing.

• Vertical or vertical lowered point
bottom landing

Define the horizontal distance from the
lower picked point to the most distant
face of the bottom landing.

• Notched bottom landing

Define the horizontal distance from the
lower point to the stringer vertical cut.
By default, the cut is made at the
supporting part edge.

150 mm

7 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the

Equal with vertical spacing
between steps
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 Description Default
bottom landing type is either vertical or
horizontal lowered point.

8 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm

9

12

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the lowest
point of the bottom landing.

600 mm

10 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

11 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

13 Define the dimension to shorten the steps
equally on both sides.

0 mm

14 Define the width of the steps. 1000 mm
15 Define the horizontal gap between the

upper supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

16 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm
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 Description Default
17 Define this dimension based on the

selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

0 mm

18 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal

19 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact, or
to Equal and the spacing distance is not
defined, Polybeam pan (S73) creates the
number of steps you have defined.

Calculated from the
vertical distance between
the picked points and the
spacing between the
steps

Stair setup tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.
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Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer in on the
supporting beam.

6 mm
The default name is PLATE.

4 Lower V plate Created only if the
bottom of the stringer
in on the supporting
beam.

6 mm
The default name is PLATE.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Stair setup settings

Option Description
Create
assembly

Define which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Steps rotation Rotation of the step around its axis. The default is Top.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.
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Bolts tab
Use the Bolts tab to control the properties of the bolt group that connects the
steps to the stringers.

Bolt group dimensions

Note that if you define the vertical dimensions of the step on the Polybeam
pan tab, the dimensions defined on the Polybeam pan tab are used.

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm

Bolting direction

Option Description
Default.

Bolted from the step to the bracket.

AutoDefaults can change this option.
Bolted from the step to the bracket.
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Option Description
Bolted from the bracket to the step.

Bolt basic properties

 Description Default
Bolt size Bolt diameter. 20 mm
Bolt standard The bolt standard to be

used inside the
component.

7990

Tolerance The gap between the
bolt and the hole.

2 mm

Thread in mat Defines whether or not
the thread may be
within the bolted parts
when using bolts with a
shaft. This has no effect
when using full-threaded
bolts.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Polybeam pan tab
Use the Polybeam pan tab to define the step profile properties and
dimensions.

Plate

Part Description Default
Plate profile To create a plate

profile, select a profile
from the profile
catalog.

PL10*150

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Step profile dimensions

 Description Default
1 Define the height of the

vertical part of the step.
Vertical dimension value defined on
the Bolts tab.

2 Define the symmetrical
chamfer for the back corner of
the all step plates.

0 mm

Steel components reference 1808 Stairs



Welds

Click the link below to find out more:

Handrail 1 (74)
Handrail 1 (74) connects a column to a beam using a cover plate and an end
plate.

Objects created

• Cover plate

• End plate

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam to column connection.

Selection order

1. Select the main part (beam).

2. Select the secondary part (column).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Cover plate
2 End plate

Picture tab
Use the Picture tab to control the plate dimensions.

Plate dimensions

 Description
1 Horizontal dimension of the cover plate.
2 Distance between the upper edge of the cover plate and the beam

flange.
3 Vertical dimension of the cover plate.
4 Bolt edge distance.

Parts tab
Use the Parts tab to control the plate properties.
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Plate

Option Description
Cover plate Cover plate thickness.
End plate End plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for horizontal bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Z pan (S74)
Z pan (S74) creates straight stairs with optional top and bottom landings. The
stairs consist of stringers, possible landings, and the actual steps. The steps
can be connected to stringers with horizontal brackets, vertical brackets, or
with bent plate brackets.

Objects created

• Stringers

• Steps

• Landings (optional)

• Brackets

• Bolts

• Welds

Use for

Situation Description
Stairs with Z-pan steps.
Horizontal top and
bottom landings.

Steps are connected to
stringers with bolted
horizontal brackets.
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Situation Description
Stairs with bent plate
brackets.

Steps are connected to
stringers with bent plate
brackets.

Stairs with stringers
notched to the supporting
beam.

Steps are connected to
stringers with vertical and
horizontal brackets.

Stairs with 90 degree
bends at the top and
bottom of the treads.

Steps are connected to
stringers with vertical and
horizontal brackets.

Red nose profile at the
front edge of the steps.

Before you start

If the stringers are notched to bear on the supporting beams, create the
supporting beams before creating the stairs.
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Selection order

1. Pick a point to indicate the nosing point of the first step.

2. Pick another point to indicate the nosing point of the last step.

Note that the order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.

Part identification key
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 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the stringer geometry and the nosing points of
the steps.

Top landing type

Option Description
Default

Horizontal landing

Notched

The stringer top is on the supporting
part. Vertical and horizontal plates
are welded at the end of the stringer.

Bottom landing type

Option Description
Default
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Option Description
Vertical

Creates a vertical landing where the
lower picked point is on the top plane
of the last step.

Horizontal

Creates a horizontal landing where
the lower picked point is on the top
plane of the last step.

Vertical lowered point

The picked point is at the top of steel
or finish floor.

Horizontal lowered point

The picked point is at top of steel or
finish floor.

Notched

Creates a notch to the bottom of the
stringer to bear on the supporting
part. A vertical plate is welded at the
end of the stringer.
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Stair dimensions

 Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the upper
point to the top of steel of the top landing.

If the top landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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 Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,

where Z is the vertical
distance between the 2
picked points.

4 Select the direction of the nosing
dimension of the steps:

• Vertical

• Horizontal

• Perpendicular

Vertical

5 Define the nosing dimension of the steps.
This dimension depends on the direction
you have selected.

0 mm

6 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing

Define the vertical distance from the
lower point to the top of steel of the
bottom landing.

• Vertical or vertical lowered point
bottom landing

Define the horizontal distance from the
lower picked point to the most distant
face of the bottom landing.

• Notched bottom landing

Define the horizontal distance from the
lower point to the stringer vertical cut.
By default, the cut is made at the
supporting part edge.

150 mm

7 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the

Equal with vertical spacing
between steps
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 Description Default
bottom landing type is either vertical or
horizontal lowered point.

8 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm

9

12

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the lowest
point of the bottom landing.

600 mm

10 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

11 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

13 Define the dimension to shorten the steps
equally on both sides.

0 mm

14 Define the width of the steps. 1000 mm
15 Define the horizontal gap between the

upper supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

16 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm
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 Description Default
17 Define this dimension based on the

selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

0 mm

18 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal

19 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact, or
to Equal and the spacing distance is not
defined, Z pan (S74) creates the number of
steps you have defined.

Calculated from the
vertical distance between
the picked points and the
spacing between the
steps

Stair setup tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.
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Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer in on the
supporting beam.

6 mm
The default name is PLATE.

4 Lower V plate Created only if the
bottom of the stringer
in on the supporting
beam.

6 mm
The default name is PLATE.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Stair setup settings

Option Description
Create
assembly

Define which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.

Bracket Select how the steps are connected to the stringers:

• Default

• Horizontal bracket

Steel components reference 1824 Stairs



Option Description
• Horizontal and vertical brackets

• Bent plate bracket

Z pan tab
Use the Z pan tab to control the size and shape of the Z pan steps.

Profiles

Profile Description Default
Step profile Step profile is calculated

from the thickness you
enter for the Z pan plate
when defining the Z pan
dimensions.

Select an appropriate
material for the step
profile. In the US imperial
environment, Tekla
Structures saves the
selected material in the
Gage material user-
defined attribute of the
step profile. You can use
this information in
reports and in the bill of
material of drawings.

 

Nose profile Created only if Nosing
piece is set to Create
nose.

To create the nose profile,
select the profile from the
profile catalog.

PL160*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Z pan dimensions

 Description Default
1

2

Define the chamfer dimensions
for the front edge.

15 mm
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 Description Default
3 Define the length of the front

part of the step according to the
selected front edge type.

40 mm

4 Define back wall slope width
between the nosing point
vertical line and the Z pan back
wall (concrete level lip set-off
point).

100 mm

5 Define the height of the inner
step dimension where the
concrete will be poured.

100 mm

6

7

Define the width and height of
the bottom step.

height = 200 mm
width = 0 mm

8 Define the horizontal dimension
for the Z pans that have a
skewed front edge.

60 mm

9 Define the thickness of the Z pan
plate.

10 mm

10

11

Define the lip dimensions of the
back wall of the step.

You can define these
dimensions if Back wall type is
set to Lip.

15 mm

12 Define the horizontal length of
the top step.

This is the horizontal distance
between the top nosing point
and the end of the top step
horizontal section.

300 mm

13 Define the height of the top
step.

This is the vertical distance
between the top nosing point
and the end of the top step
horizontal end.

100 mm

14 Define the bottom line clearance
for the steps that prevent the
bottom portion of the Z pan
from overlapping the bottom
end of the stringer.

20 mm
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Chamfer type

Select the shape of the step front edge.

Option Description
None

Line

Rounding

Arc

Back wall type

Select the Z pan back wall type.

Option Description
Default

Lip

Straight

Front edge type

Select how a pan connects to the pan below.
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Option Description Example
Default

Rectangular front edge.

AutoDefaults can change
this option.

Skewed front edge.

Pan overlaps the lower
one and continues in the
same angle as the back
wall.

Rectangular front edge.

Pans do not overlap
each other.

Rectangular front edge.

Pan overlaps the lower
one and continues in the
same angle as the back
wall.

Rectangular front edge.

Pan overlaps the lower
one and continues at a
30-degree angle.

Nosing piece

Select whether the nosing piece is created on top of the step.

Option Description
Default

No nose.

AutoDefaults can change this option.
No nose.

Create nose.
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Horizontal part

Select whether the bottom pan has a horizontal part. Enter the vertical
distance from the bottom of the pan to the top level of the Z pan (concrete
slab thickness) in Z pan dimensions.

Option Description
Default

Create horizontal part.

AutoDefaults can change this option.

Create horizontal part.

No horizontal part.

Horizontal bracket tab
Use the Horizontal bracket tab to control the properties and attachment of
the horizontal brackets. The horizontal brackets are angle profiles underneath
the treads.

Preconditions

Before you can set the properties of the horizontal brackets, set the following
option:

• On the Stair set-up tab, set Bracket to Horizontal bracket or Horizontal
and vertical brackets.

L profile
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Part Description Default
L profile Created only if brackets are

created.

Select the profile from the
profile catalog.

BLL80*80*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Bracket dimensions

  
1 Define the length of the bracket.

The default length is calculated according to bracket-to-step or
bracket-to-stringer bolt dimensions, depending on which one is
bigger.
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2 Define the dimension to offset the bracket from the center line of

the thread.

The default in 0 mm.

Bracket-to-step connection

Define the properties of the bolts that connect the brackets to the steps.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For

100 mm
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Description Default
example, if there are 3
bolts, enter 2 values.

Bracket-to-step connection type

Option Description
Default.

Bolted.

Welded.

No connection.

No bracket angle leg.

The bracket is a plate instead of an
angle.

Holes only.

Bolting direction

Option Description
Default.

Bolted from the bracket to the step.
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Option Description
Bolted from the step to the bracket.

Bracket-to-stringer connection

Define the properties of the bolts that connect the brackets to the stringers.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For

100 mm
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Description Default
example, if there are 3
bolts, enter 2 values.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bracket-to-stringer connection type

Option Description
Default.

Bolted.

AutoDefaults can change this option.

Bolted.

Welded.

No connection.
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Bolting direction

Option Description
Default.

Bolted from the bracket to the
stringer.

AutoDefaults can change this option.
Bolted from the bracket to the
stringer.

Bolted from the stringer to the
bracket.

Bracket position

Define the position of the plate-type bracket. The bracket can be positioned
below the step, or between the step and the stringer.

You can define the bracket position if the bracket is a created as a plate
instead of an angle.

Option Description
Default

Below the step.

AutoDefaults can change this option.
Below the step.

Between the stringer and step.

Vertical bracket tab
Use the Vertical bracket tab to control the properties and attachment of the
vertical brackets. The vertical brackets are angle profiles underneath the
treads and they support the vertical portion of the stair treads.
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Preconditions

Before you can set the properties of the vertical brackets, set the following
options:

• On the Stair set up tab, set Bracket to Horizontal and vertical brackets.

• On the Z pan tab, set the Back wall type to Straight.

L profile

Part Description Default
L profile Created only if brackets are

created.

Select the profile from the
profile catalog.

BLL80*80*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
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Option Description Default
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Bracket dimensions

 Description Default
1 Define the height of the

bracket.
Default height is calculated according
to bracket-to-step or bracket-to-
stringer bolt dimensions, depending
on which one is bigger.

2 Define the dimension to
offset the bracket from
the Z pan edge.

25 mm

Bracket-to-step connection

Define the properties of the bolts that connect the brackets to the steps.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm
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Bracket-to-step connection type

Option Description
Default.

Bolted.

Welded.

No connection.

No bracket angle leg.

The bracket is a plate instead of an
angle.

Holes only.

Bolting direction

Option Description
Default.

Bolted from the bracket to the step.

Bolted from the step to the bracket.
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Bracket-to-stringer connection

Define the properties of the bolts that connect the brackets to the stringers.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm
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Bracket-to-stringer connection type

Option Description
Default.

Bolted.

AutoDefaults can change this option.

Bolted.

Welded.

No connection.

Bolting direction

Option Description
Default.

Bolted from the bracket to the
stringer.

AutoDefaults can change this option.
Bolted from the bracket to the
stringer.

Bolted from the stringer to the
bracket.

Bracket position

Define the position of the plate-type bracket. The bracket can be positioned
below the step, or between the step and the stringer.

You can define the bracket position if the bracket is a created as a plate
instead of an angle.
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Option Description
Default

Below the step.

AutoDefaults can change this option.
Below the step.

Between the stringer and step.

Bent plate bracket tab
Use the Bent plate bracket tab to control the dimensions and other
properties of the bent plate bracket. You can use the bent plate bracket for
connecting the Z pan steps to the stringers instead of horizontal or vertical
brackets.

Preconditions

To create the bent plate bracket, set the following options:

• On the Stair setup tab, set Bracket to Bent plate bracket.

• On the Z pan tab, set Front edge type to the following option:

Bent plate profile

Part Description Default
Bent plate
profile

Created if Bracket is set to
Bent plate bracket on the
Stair setup tab.

BPL80*10
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Create top step bent plate bracket

Select whether to create the bent bracket for the top step.

Option Description
Default

Bent plate bracket is not created.

AutoDefaults can change this option.
Bent plate bracket is not created.

Bent plate bracket is created.

Create bottom step bent plate bracket

Select whether to create the bent bracket for the bottom step.

Option Description
Default

Bent plate bracket is not created.

AutoDefaults can change this option.
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Option Description
Bent plate bracket is not created.

Bent plate bracket is created.

Bent bracket dimensions

 Description Default
1 Define the horizontal distance

from the step corner to the
bent plate edge.

200 mm

2 Define the vertical distance
from the step corner to the
bent plate edge.

100 mm

3 Define the radius of the round
bending.

1 / 3 * vertical
dimension

Welds

Click the link below to find out more:

Stanchions (S76)
Stanchions (S76) creates stanchions on one or more horizontal or skew stair
stringers. Stanchions can also be used on concrete slabs.
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Objects created

• First stanchion

• Middle stanchions

• Last stanchion

Use for

Situation Description
Stanchions bolted on a stringer.

Limitations

NOTE If you modify Stanchions (S76), all connected components are
deleted. For example, modifying the stanchions deletes stairs, railings,
and other components connected to the stanchions.

Before you start

Create stringers, beams, or slabs or other parts to connect the stanchions.

Selection order

1. Pick the start point.

2. Pick the end point.

3. Select the lower landing (optional).

4. Select the stringer.

5. Select the upper landing (optional).

Click the middle mouse button to create the component.
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Part identification key

 Part
1 First stanchion
2 Middle stanchions
3 Last stanchion

Picture tab
Use the Picture tab to control the stanchion creation.

Stair parts selection

By default, the Use all option is used.

• Use selected: the stanchions are created only to the selected parts.

• Use all: if you have created one or more stringers using a stair component,
select this option.

All the stringers which are part of the stair component and have the same
direction are selected.
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Part positions

 Description Default
1 Additional height to the stanchion.  
2 Height of the floor level. 1300 mm
3 Stanchion bottom point vertical offset. 0 mm
4 Stanchion bottom point horizontal offset. 0 mm
5 Distance between the second selected

point and the last stanchion.
300 mm

6 Distance between the last two stanchions. 0 mm
7 Space between the stanchions.

Use the value 8 to define the spacing type.

1000 mm

8 Stanchion spacing type.

• Maximum

The spacing value in the box 7 defines
the maximum space between the
stanchions. As many equally spaced
middle stanchions as needed are
created. The space between the
stanchions is less or equal to the
maximum distance.

• Exact

The space between the middle
stanchions is exactly the spacing value
in the box 7. Enter the spacing values

Maximum
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 Description Default
using the following formats: 6*950 or
1000 800 800 1000 800.

9 Distance between the first two stanchions. 0 mm
10 Distance between the first selected point

and the first stanchion.
300 mm

11 Nosing dimension of the steps.  
12 Stanchion height from the floor level. 1300 mm

Nosing direction

Define the nosing direction.

Option Description
Default

Vertical

AutoDefaults can change this option.

Vertical

Horizontal

Perpendicular

Parts tab
Use the Parts tab to control the stanchion profiles.

Stanchion profile

Option Description
First Stanchion Define the first stanchion profile by

selecting it from the profile catalog.

First stanchion is always created.

The default name is STANCHION.
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Option Description
Middle Stanchion Define the middle stanchion profile

by selecting it from the profile
catalog.

Middle stanchion is always created.

The default name is STANCHION.
Last Stanchion Define the last stanchion profile by

selecting it from the profile catalog.

Last stanchion is always created.

The default name is STANCHION.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Stanchion profile rotation

Define the stanchion profile rotation and position.

Option Description Default
Profile rotation Stanchion profile

rotation and position.
Rotation = Front
Position = Middle

Rotation value Stanchion profile
rotation angle (in

Rotation angle = 0
Offset = 0 mm
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Option Description Default
degrees) and the plane
offset.

Stanchion profile rotation type

Define the rotation combinations for consecutive stanchions.

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Type 5

Parameters tab
Use the Parameters tab to control how the stanchions are connected to the
stairs.

Connection properties

Option Description
Connection setting type Define whether pre-defined or

custom settings are used for
connecting the stanchions to the
stairs.

By default, the pre-defined settings
are used.

Stanchion connection type Connection type for stanchions.

By default, the weld default
connection type is used.

This field is active only if you have set
the Connection setting type to Pre-
defined settings.

Connection number Define a connection that connects
stanchions to the stairs by selecting it
from the component catalog.
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Option Description
Connection properties Select an attribute file for the

connection.
Direction Connection direction.
Stanchion product name Enter the product name.

Railings (S77)
Railings (S77) creates railings connected to two or more stanchions. The
railings can be handrails in stairs or guardrails in a horizontal beam or slab.

Objects created

• Top rail

• Middle rails (horizontal or vertical)

• Bottom rail

• Panels

• Bends

Use for

Situation Description
Horizontal railings
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Situation Description
Horizontal railings connected to four
stanchions

Vertical railings connected to four
stanchions

Guardrail with vertical railings

Before you start

Create the stanchions using, for example, Stanchions (S76).

Selection order

1. Select the first stanchion.

2. If the stanchions are created with Stanchions (S76), and on the Picture
tab the Stanchion selection is set to Use all or Default, the railings are
created when you click the middle mouse button.

OR

1. Select the first stanchion.

Steel components reference 1857 Stairs



2. If the stanchions are created separately, or on the Picture tab the
Stanchion selection is set to Use selected, select the second, third, and
so on, stanchion.

The order in which the stanchions are selected defines the positioning of
the railings. The two first selected stanchions define the left and right
directions of the railings.

3. Click the middle mouse button to create the railings.

Part identification key

 Part
1 Top rail
2 Vertical rails
3 Middle rails
4 Bottom rail

Picture tab
Use the Picture tab to control the railings and the closures.

Stanchion selection

By default, the Use all option is used.

• Use selected: the railings are created only to the selected stanchions.

• Use all: select this option when the stanchions are created with
Stanchions (S76).
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Part positions

 Description Default
1 Horizontal length of the closure in the top rail

and where the bending is created in the
closure.

When you use the closure type 4 and enter a
negative value in this box, the top and
bottom rails are shortened.

150 mm

2 Horizontal length of the closure in the
bottom rail.

When you use the closure type 4 and the
value in the 1 box is 0, you can shorten the
bottom rails by entering a positive value in
this box.

150 mm

3 Vertical length of the closure.

Available for closure types 2 and 3.

half the value of 5

4 Full horizontal length of the closure from the
first or the last stanchion.

300 mm

5 Distance between the top and the bottom
rails.

If the middle rails are positioned evenly
between the top and bottom rails, the
spacing between them is adjusted if the
distance between the top and the bottom
rails is modified.

800 mm
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 Description Default
6 Height of the railing from the floor level.

If you modify the floor level, the height of the
railing is modified as well.

defined by the
height of the
stanchion

7 Length of the stanchion extension over the
railing.

Use this option if the Top rail to stanchion
fitting is set to Stanchion partcut on the
Parameters tab.

0 mm

8 Floor level from the bottom of the stanchion.

If you modify the floor level, the height of the
railing is modified as well.

0 mm

Railing offset

 Description
1 Vertical distance between the middle rails and the stanchion center.
2 Vertical distance between the top or the bottom rail and the

stanchion center.

Left and right closure

Option Description
Default

Type 1

AutoDefaults can change
this option.

Type 1
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Option Description
Type 2

Type 3

Type 4

Parameters tab
Use the Parameters tab to control the cuts, fitting, and gaps between the
railing parts.

Continuity profile

Option Description
Top Continuity profile Define the continuity profile by

selecting it from the profile catalog.

The top continuity profile is created if
the length of the continuous profile is
more than 0 and Top rail parts gap is
set to Yes.

The default name is RAIL.
Middle Continuity profile Define the continuity profile by

selecting it from the profile catalog.

The middle continuity profile is
created if the length of the
continuous profile is more than 0 and
Midd. rail parts gap is set to Yes.

The default name is RAIL.
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Option Description
Bottom Continuity profile Define the continuity profile by

selecting it from the profile catalog.

The bottom continuity profile is
created if the length of the
continuous profile is more than 0 and
Bott. rail parts gap is set to Yes.

The default name is RAIL.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Rail length

Option Description Default
Top rail max. length Maximum length of the

top rail.
3000 mm

Middle rail max. length Maximum length of the
middle rail.

3000 mm

Bottom rail max.
length

Maximum length of the
bottom rail.

3000 mm
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Rail fittings

Option Description
Top rail to stanchion fitting Fitting type between the top rail and

the stanchions.

By default, no fitting is created.

•

No fitting is created.

•

Stanchions are fitted to rail, using
the fitting distance defined in Top
rail to stanchion fitting
distance.

•

Stanchions are cut by a horizontal
plane, using the fitting distance
defined in Top rail to stanchion
fitting distance.

•

Stanchions are cut by the rails,
using the tolerance defined in Top
stanchion cut tolerance.
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Option Description
•

Rails are cut by the stanchions,
using the tolerance defined in Top
stanchion cut tolerance.

Top rail to stanchion fitting
distance

Fitting distance between the top rail
center line and the stanchion.

Top stanchion cut tolerance Cut tolerance between the top rail
and the stanchions.

Option Description
Other rail to stanchion fitting Fitting type between the middle or

bottom rail and the stanchions.

By default, no cuts are created.

•

No cut is created.

•

Stanchions are cut by the rails,
using the tolerance in Other
stanchion cut tolerance.

•

Rails are cut by the stanchions,
using the tolerance in Other
stanchion cut tolerance.
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Option Description
•

Stanchions are cut by the rails
through a slotted hole, using the
tolerance in Other stanchion cut
tolerance.

•

Rails are fitted to the stanchions,
using the tolerance in Other
stanchion cut tolerance.

Other stanchion cut tolerance Part cut tolerance between the
middle or the bottom rail and the
stanchions.

Rail cuts

Option Description
Top rail cuts Define how the top rail is cut.

By default, the At max stanchion
option is used.

• At max stanchion

Starting from the first stanchion,
without the closures, the Top rail
max. length is measured along
the rail and the cut is made at the
last stanchion included in the
measured distance.

• At max length

Starting from the first point of the
rail, including the closure, the Top
rail max. length is measured
along the rail and the cut is made
at the maximum length.

• Every stanchion

A cut is made to the rail at each
stanchion.

Steel components reference 1865 Stairs



Option Description
• At max length no closure

Starting from the first stanchion,
without the closures, the Top rail
max. length is measured along
the rail and the cut is made at the
maximum length.

Middle rail cuts Define how the middle rail is cut.

By default, the At max stanchion
option is used.

Bottom rail cuts Define how the bottom rail is cut.

By default, the At max stanchion
option is used.

Chamfer dimensions

 Description
1 Horizontal chamfer dimension for the stanchions.
2 Vertical chamfer dimension for the stanchions.

Gap

Option Description
Top rail parts gap

Midd. rail parts gap

Bott. rail parts gap

Select whether a gap is created
between the rail parts.

By default, no gap is created.
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Gap between parts

 Description
1 Size of the gap between two consecutive rail parts.
2 Length of the continuous profile.

Assembly

Option Description
Create assembly Select which part of the railing is the

main part of the assembly.

By default, no assembly is created.

•

No assembly is created. This is
also the default option.

•

The first stanchion is the main part
of the assembly.

•

The last stanchion is the main part
of the assembly.
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Option Description
•

The first rail part after the first
stanchion is the main part of the
assembly.

If you have created continuous
profiles for all the rails, multiple
assemblies are created.

Rails tab
Use the Rails tab to control the profiles, bending cuts, and connections for the
top and the bottom rails.

Rail and closure profiles

Option Description
Top rail profile Define the top rail profile by selecting

it from the profile catalog.

Top rail is always created.
Bottom rail profile Define the bottom rail profile by

selecting it from the profile catalog.

Bottom rail is always created.
Start closure Define the start closure by selecting it

from the profile catalog.

By default, the Start closure profile is
the same as the Top rail profile.

End closure Define the end closure by selecting it
from the profile catalog.

By default, the End closure profile is
the same as the Top rail profile.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Closure bending cuts

Option Description
Default

No cut

AutoDefaults can change this option.
No cut

No cut is created near the corner.

Both side cuts

The rail corner is cut at the left and
the right side.

The dimensions for the cut are
defined on the Bends tab.
Middle corner cut

The rail corner is cut in the middle.

Mitre corner cut

The rail corner is cut by a plane on
the bisecting line.
Left side cut

The rail corner is cut at the left side.

The dimensions for the cut are
defined on the Bends tab.
Right side cut

The rail corner is cut at the right side.

The dimensions for the cut are
defined on the Bends tab.
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Cut position of the rails

Define the cut position for the top and the bottom rails and for the closure
types 1 and 4.

Option Description
Default

Closure near side cut

AutoDefaults can change this option.
Closure near side cut

The rail passes through the first or
the last stanchion and is cut at its
surface.

The closure is cut at the near side
surface of the stanchion, without
intersecting it.
Middle stanchion cut

The rail passes through the first or
the last stanchion and is cut at its
middle line.

The closure is cut at the middle line of
the stanchion, intersecting it.
Closure far side cut

The rail is cut at the surface of the
stanchion, without intersecting it.

The closure is cut at the other far side
surface of the stanchion, intersecting
it.

Cut position for the other bending

Define the cut position for the other bendings than the corners of the
closures.

Option Description
Default

No cut is created.

AutoDefaults can change this option.
No cut is created.
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Option Description
Both side cuts

The rail bending is cut at the left and
the right side.

The dimensions for the cut are
defined on the Bends tab.
Middle corner cut

The rail bending is cut in the middle.

Mitre corner cut

The rail bending is cut by a plane on
the bisecting line.

Connection properties

Option Description
Connection number Define the number of the component

that connects the top and the bottom
rails to the stanchions by selecting if
from the component catalog.

You cannot use a custom component.
Attribute file Select an attribute file for the

component.
Seam dir. Define the component direction for a

custom seam.

Top rail position / Bottom rail position

Define the horizontal railing position.

By default, the Middle option is used.

Top rail rotation / Bottom rail rotation

Define the profile rotation for all horizontal rails.

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Type 7

Type 8

Middle Rails tab
Use the Middle Rails tab to control the horizontal middle rails.

Rail profile

Option Description
1

2

3

4

Define the middle rail profile by
selecting it from the profile catalog.

By default, the size of middle rail
profile is the same as the size of the
top rail profile.

The default name is MIDDLE RAIL.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Middle rail type

Option Description
Middle rail profiles Number of rails and the rail profile

used for middle rails.

For example, 3*2 creates three
horizontal middle rails, with the
profile defined in profile 2.

For example, 2*2 1 creates two
horizontal middle rails, with the
profile defined in profile 2 and one or
more rails (depending of the number
of rails needed), with the profile
defined in profile 1.

For example, 3 creates horizontal
middle rails with the profile defined in
profile 3. The number of rails is
defined by the number set for the
horizontal or vertical middle rails.

By default, only rails with profile from
profile 1 are created.

Option Description
Default

Creates horizontal middle rails.

AutoDefaults can change this option.

Creates horizontal middle rails.
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Option Description
Creates vertical middle rails (pickets)
defined on the Vertical Rails tab.

Creates panels.

Middle rail position

Define the horizontal railing position.

By default, the Middle option is used.

Middle rail rotation

Define the profile rotation for all horizontal rails.

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Type 5

Type 6

Type 7
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Option Description
Type 8

Cut position for the bending

Option Description
Default

No cut

AutoDefaults can change this option.
No cut

No cut is created.

Both side cuts

The rail bending is cut at the left and
right side.

The dimensions for the cut are
defined on the Bends tab.
Middle corner cut

The rail bending is cut in the middle.

Mitre corner cut

The rail bending is cut by a plane on
the bisecting line.

Horizontal middle rail extension

Option Description
Default

No extension

AutoDefaults can change
this option.
No extension

The middle rail ends at
the inside stanchion
surface, without
intersecting the
stanchion.
Pass through stanchion

The middle rail ends at
the outside stanchion
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Option Description
surface, intersecting the
stanchion.
Horizontal extension

The middle rails are
extended inside the
closure by a horizontal
value. If the railing is
skew, the extension is
bent according to the
closure dimensions.

The rail can be
shortened by entering a
negative value in the box
3.
Horizontal and skew
extension

The middle rails are
extended by two
horizontal dimensions. 3
is for the horizontal rail
length and 4 is for the
skew rail length.

Closure bend cuts

This section is not active if you have set the middle rail type to vertical middle
rails.
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 Description
1 Number of horizontal middle rails.
2 Spacing between the horizontal middle rails.
3 Length of the middle rail horizontal extension inside the closure.

The rail can be shortened by entering a negative value.

Use this box when the horizontal middle rail extension is set to
horizontal extension.

4 Length of the middle rail horizontal and skew extension.

The middle rails are extended by two horizontal dimensions. 3 is for
the horizontal rail length and 4 is for the skew rail length.

Use this box when the horizontal middle rail extension is set to
horizontal and skew extension.

Connection properties

Option Description
Connection number Define the number of the component

that connects the middle rails to the
stanchions by selecting it from the
component catalog.

You can also use a custom
component.

Attribute file Select an attribute file for the
component.

Seam dir. Define the component direction for a
custom seam.

Grab rail

Grab rail can be a single middle rail that is vertically and horizontally offset
from the top rail. You can use a system or a custom component to connect the
rail to stanchions. You can also select the end of the grab rail. If the grab rail
comes from a skew stringer, you can extend the grab rail with skew and
horizontal dimensions.
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To create a grab rail:

1. On the Picture tab, offset the middle rails from the stanchions.

2. On the Rails tab, set the profile for top and bottom rails to 0 so that those
rails are not created.

3. On the Middle Rails tab, set the number of horizontal rails to 1 and adjust
the spacing for the handrail.
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4. If you want to extend the end of the grab rail and have a horizontal part,
select the horizontal and skew extension option on the Middle Rails tab,
and enter the skew and horizontal distances.

5. Create the custom seam.

Pick the points on the outer extension of the main and secondary parts.

 Description
1 Main part
2 Secondary part
3 First picked point
4 Second picked point

6. Save the standard properties for the custom seam.

7. On the Middle Rails tab, use the custom seam name and properties and
set the component direction.
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Vertical Rails tab
Use the Vertical Rails tab to control the vertical rails (pickets). The options on
the Vertical Rails tab are active only if you have set the middle rail type to
vertical middle rails on the Middle Rails tab.

Pickets

Option Description
Default

Pickets are not created
inside the closure.

AutoDefaults can change
this option.
Pickets are not created
inside the closure.

Pickets are created
inside the closure when
you use the closure type
1 or 4.

Connection type between the pickets and the top and bottom rails

Option Description
Default

None

AutoDefaults can change this option.
None

The pickets are created from the top
rail center to the bottom rail center.
Fitted

The pickets are fitted at the creation
points by a plane that follows the
slope of the horizontal rails.
Part cut

The pickets are cut on both sides by
the horizontal rail profiles.
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Option Description
Connection

The pickets are connected to the top
and bottom rail with a system
connection.

Picket spacing

Option Description
1 Picket spacing between two consecutive stanchions.
2 Spacing type.

By default, the equal spacing option is used.

• Exact

The space between two consecutive pickets is exactly the spacing
value 1. As many pickets as possible are positioned between two
consecutive stanchions. The pickets are positioned centered
between the stanchions so that the space between the first
stanchion and the first pickets and the second stanchion and the
last pickets is equal.

• Equal

The spacing value 1 defines the maximum spacing. The pickets
are placed evenly between the stanchions.
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Chamfer dimensions

 Description
1 Horizontal chamfer dimension for the pickets.
2 Vertical chamfer dimension for the pickets.

Profile rotation

Define the profile rotation for all vertical rails.

Option Description
Default

Type 1

Type 2

Type 3

Type 4

Type 5

Type 6

Type 7

Type 8
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Connection properties

Option Description
Vertical rail top joint Define the number of the component

that connects the pickets to the top
rail by selecting it from the
component catalog.

You cannot use a custom component.

Select also an attribute file for the
component.

Vertical rail bottom joint Define the number of the connection
that connects the pickets to the
bottom rail by selecting it from the
component catalog.

You cannot use a custom component.

Select also an attribute file for the
component.

Panels tab
Use the Panels tab to create panels between the stanchions. No other vertical
or horizontal rails are created when the panels are created. The options on the
Panels tab are active only if you have set the middle rail type to panels on the
Middle Rails tab. You can use custom seams to create the middle panels and
custom details to create the closure panels.

Panel properties

Option Description
Part name/Joint no. Define the number of the custom

component used in panel creation by
selecting it from the component
catalog.

Attribute file Select an attribute file for the custom
component.

Seam dir. Define the seam direction.

Panel type

For custom details the numbers in the images correspond to the following
parts:

Number Part
1 First stanchion, which is the main part

of the detail.
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Number Part
2 Point at the top of the first stanchion,

which is the first input point of the
detail.

3 Point at the bottom of the first
stanchion, which is the second input
point of the detail.

For custom seams the numbers in the images correspond to the following
parts:

Number Part
1 First stanchion, which is the main part

of the seam.
2 Second stanchion, which is the

secondary part of the seam.
3 Point at the top of the first stanchion,

which is the first input point of the
seam.

4 Point at the bottom of the first
stanchion, which is the second input
point of the seam.

Option Description
Left closure panel

Use a custom detail to create the
panel.

The panel connects to one stanchion
only.

First panel

Use a custom seam to create the
panel.

The panel can be of different size
than the rest of the panels.

Last panel

Use a custom seam to create the
panel.

The panel can be of different size
than the rest of the panels.
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Option Description
Right closure panel

Use a custom detail to create the
panel.

The panel connects to one stanchion
only.

Regular horizontal panel

Use a custom seam to create the
panel.

Regular skew panel

Use a custom seam to create the
panel.

Horizontal panel, skew junction
(bottom)

Use a custom seam to create the
panel.

Horizontal panel, skew junction (top)

Use a custom seam to create the
panel.

Bends tab
Use the Bends tab to set the bending cut position on the rails and the profiles
for the bent rails parts.
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Bend profile

Option Description
Bend Define the bend rail profile by

selecting it from the profile catalog.

Created only if you have set the
closure bend cuts to both side cut, left
side cut, or right side cut on the Rails
tab.

90 degree Define the rail profile by selecting it
from the profile catalog.

Created only if you have set the cut
position for the bending to both side
cut on the Rails or Middle Rails tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Bend dimensions

Option Description Default
1 Bending radius for the rail parts. 50 mm
2 Cut distance along the rails on the right

side of the bending.
75 mm

3 Cut distance along the rails on the left
side of the bending.

75 mm

Welds
Click the link below to find out more:

Multiple beam railing (S84)
Multiple beam railing (S84) creates stanchions and railings connected on one
or more beams.

Objects created

• Handrail (top rail)

• Knee rail (bottom rail)

• Stanchions

• Toe plates

• Welds
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Use for

Situation Description
Railing created on multiple beams.

Selection order

1. Pick the first position for the railing.

2. Pick the second position for the railing.

3. Select the first beam.

4. Select the second beam, and the subsequent beams if needed.

5. Click the middle mouse button to create the railing.

Part identification key

 Description
1 Railing

Top rail and bottom rail are created.
2 Toe plate
3 Stanchion

Picture tab
Use the Picture tab define the railing dimensions.
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Railing dimensions

 Description
1 Full horizontal length of the closure from the first or the

last stanchion.
2 Horizontal length of the closure in the top rail and where

the bending is created in the closure.
3 Horizontal distance between the stanchions.
4 Distance between the top rail and the beam.
5 Full horizontal length of the closure from the first or the

last stanchion.
6 Bending angle
7 Toe plate start/end distance from the start/end of the

railing.
8 Horizontal length of the closure in the bottom rail and

where the bending is created in the closure.
9 Horizontal distance to the first stanchion from the first

input point.

This is the position of the first stanchion from the first
input point.

10 Distance between the beam and bottom rail.
11 Vertical distance between the beam center and stanchion

center.

Steel components reference 1889 Stairs



Parts tab
Use the Parts tab control the railing part properties.

Parts

Option Description
Stanchion profile Select the stanchion profile from the profile

catalog.
Hand rail profile Select the hand rail profile from the profile

catalog.
Knee rail profile Select the knee rail profile from the profile

catalog.
Toe plate Thickness and height of the toe plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define whether stanchions and toe plates are
created, and the positions of stanchions, railings, and railing cuts.

Option Description
Stanchion product name Enter the stanchion name.
Bend product name Enter the bend name.
Toe plate max length Define the maximum length of the

toe plate.
Create assembly Select whether to create an assembly

of the parts.
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Stanchion creation

Option Description
Stanchions are not created.

Stanchions are created.

Railing cut positions

Select the railing cut position and define the cut dimension.

Option Description
Railing is cut at the second stanchion.

Railing is cut at the first stanchion.

Railing is cut at each stanchion.

Stanchion and railing position

Option Description
Stanchions and railings are created
on the left side of the beams.

Stanchions and railings are created
on the right side of the beams.
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Toe plate creation

Option Description
Toe plates are not created.

Toe plates are created.

Welds

Click the link below to find out more:

Stringer to channel (127)
Stringer to channel (127) connects a stringer to a channel with an angle
profile. The angle profile is welded to the stringer and bolted to the channel. A
vertical plate is welded to the end of the stringer.

Objects created

• Angle plate

• Vertical plate (optional)

• Bolts

• Welds

• Cuts to shape the end of the stringer

Use for

Situation Description
The angle profile is bolted to the
channel and welded to the stringer.
The stringer is cut horizontally to the
top level of the channel.

Steel components reference 1892 Stairs



Situation Description
No horizontal cut in the stringer.

A vertical plate is created to the end
of the stringer.

Limitations

Stringer to channel (127) works only if the connecting profile is an angle.

Before you start

Create a stringer and a channel.

Selection order

1. Select the main part (a channel).

2. Select the secondary part (a stringer).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Angle profile
2 Vertical plate

Picture tab
Use the Picture tab to define the position of the angle profile and the vertical
plate, and whether the stringer is cut.

Stringer cut

Option Description
Option 1

Default
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Option Description
Option 2

The stringer is cut horizontally to the
top level of the channel.

Option 3

No horizontal cut in the stringer.

 Description Default
1 Position of the vertical plate.

Define the vertical distance from the
stringer top edge to the vertical plate top.

0

2 Position of the angle profile.

Define the vertical distance from the
channel top to the angle profile top.

Option 1 or 2:

• metric: 65 mm
• imperial: 2"1/2
Option 3:

• 0
3 Location of the stringer cut.

Define the vertical distance from the
channel top edge to the plane where the
stringer is cut horizontally and the bottom
of the vertical plate is positioned.

• metric: 12 mm
• imperial: 1/2"
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 Description Default
4 Location of the stringer cut.

Define the horizontal distance from the
channel web to the stringer.

• metric: 12 mm
• imperial: 1/2"

Parts tab
Use the Parts tab to control the properties of the vertical plate and the angle
profile.

Vertical plate and angle profile

Option Description Default
Vertical plate Vertical plate thickness.

If you set the value to 0,
no vertical plate is
created.

metric: 10 mm
imperial: 3/8"
The default name is
PROFILE.

Angle Define the angle profile
by selecting it from the
profile catalog.

If you do not select an L
profile, the connection
will not be created.

metric: L75*6
imperial: L3X3X1/4
The default name is
ANGLE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Parameters tab
Use the Parameters tab to control the leg orientation and the position of the
angle profile.

Angle profile leg orientation

If the legs of the angle profile are of uneven length, you can switch their
position.

Option Description
Default

The longer leg of the angle profile is
connected to the channel.

AutoDefaults can change this option.

The longer leg of the angle profile is
connected to the channel.

The longer leg of the angle profile is
connected to the stringer.

Angle profile position

Option Description
Default

Angle profile is on the outer surface
of the channel.

AutoDefaults can change this option.

Angle profile is on the outer surface
of the channel.

Angle profile is on the inner surface
the channel.
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Bolts tab
Use the Bolts tab to control the bolts that connect the angle profile to the
channel.

Bolt group dimensions

 Description Default
1 Vertical distance from the top of the

channel to the center of the top bolt.
metric: 75 mm
imperial: 3"

2 Number of bolts. 2
3 Bolt spacing.

Use a space to separate bolt spacing
values. Enter a value for each space
between bolts. For example, if there are 3
bolts, enter 2 values.

metric: 75 mm
imperial: 3"

4 Vertical distance from the bottom of the
angle profile to the center of the bottom
bolt.

metric: 40 mm
imperial: 1"1/2

5 Horizontal distance from the stringer edge
to the center line of the bolts.

metric: 40 mm
imperial: 1"1/2

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stair base detail (1038)
Stair base detail (1038) creates a bolted horizontal plate and an optional
vertical plate at a picked point on a stringer. The plates are welded to the
stringer.

Objects created

• Horizontal plate

• Vertical plate (optional)

• Bolts

• Welds
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• Cuts to shape the end of the stringer

Use for

Situation Description
Stair base detail with horizontal and vertical
plates.

Stair base detail with horizontal and vertical
plates.

Stair base detail with horizontal plates.

Limitations

Stair base detail (1038) works only if the Up direction is set to +z on the
General tab. It does not work if the Up direction is set to auto.

Before you start

Create a stringer.

Selection order

1. Select the stringer.
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2. Pick a point on the stringer.

The detail is created automatically.

Part identification key

 Part
1 Horizontal plate
2 Vertical plate

Picture tab
Use the Picture tab to control the horizontal and vertical plate positions.

Plate positions

 Description Default
1 Plate position.

Define the horizontal distance from the
picked point to the inner face of the vertical
plate.

metric: 31 mm
imperial: 1"1/4
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 Description Default
2 Plate position.

Define the vertical distance from the picked
point to the top face of the horizontal plate.

0 mm

3 Horizontal plate offset relative to the
component’s up direction.

0 mm

Vertical plate creation

Option Description
Default.

Vertical plate is created.

Vertical plate is created.

No vertical plate is created.

Parts tab
Use the Parts tab to control the horizontal and vertical plate properties.

Horizontal plate/Vertical plate

Option Description
Horizontal plate

Vertical plate

Plate thickness, width and height.

The default name is PLATE.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolts tab
Use the Bolts tab to control the bolt properties in the horizontal plate. You can
select to create bolts or studs. By default, bolts are created.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stair base detail (1039)
Stair base detail (1039) creates a bolted horizontal plate at the picked point
on the stringer. The plate is welded to the stringer.

Objects created

• Horizontal plate

• Bolts

• Welds

• Cuts to shape the end of the stringer

Use for

Situation Description
Stair base detail with a horizontal
plate.
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Situation Description
Stair base detail with a horizontal
plate.

Before you start

Create a stringer.

Selection order

1. Select the stringer.

2. Pick a point on the stringer.

The detail is created automatically.

Part identification key

 Part
1 Horizontal plate

Picture tab
Use the Picture tab to control the horizontal plate position.
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Horizontal plate position

 Description
1 Plate position.

Define the vertical distance from the picked point to the top face of
the horizontal plate.

2 Horizontal plate offset in the z direction, relative to the component’s
up-direction.

3 Horizontal plate offset in the y direction, relative to the component’s
up-direction.

Parts tab
Use the Parts tab to control the horizontal plate properties.

Horizontal plate

Option Description
Horizontal plate Plate thickness, width and height.

The default name is PLATE.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolts tab
Use the Bolts tab to control the bolt properties in the horizontal plate. You can
select to create bolts or studs. By default, bolts are created.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stair base detail (1043)
Stair base detail (1043) creates a bolted clip angle and an optional vertical
plate (nose plate) at a picked point on a stringer. The clip angle is bolted and
the vertical plate is welded to the stringer.

Objects created

• Clip angle

• Vertical plate (optional)

• Bolts

• Welds

• Cuts to shape the end of the stringer

Use for

Situation Description
Stair base detail with a clip angle and a vertical
plate.
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Situation Description
Stair base detail with a clip angle and a vertical
plate.

Stair base detail with a clip angle.

Limitations

Stair base detail (1043) works only if the Up direction is set to +z on the
General tab. It does not work if the Up direction is set to auto.

Before you start

Create a stringer.

Selection order

1. Select the stringer.

2. Pick a point on the stringer.

The detail is created automatically.

Part identification key
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 Part
1 Clip angle
2 Vertical plate

Picture tab
Use the Picture tab to control the clip angle and the vertical plate positions.

Clip angle position

 Description Default
1 Plate position.

Define the horizontal distance from the
picked point to the inner face of the vertical
plate.

metric: 31 mm
imperial: 1"1/4

2 Clip angle vertical position.

Define the vertical distance from the picked
point to the bottom of the clip angle.

metric: 170 mm
imperial: 6"11/16

3 Height of the stringer cut. metric: 12 mm
imperial: 1/2"

4 Clip angle horizontal position.

Define the horizontal distance from the clip
angle center line to the inner face of the
vertical plate.

metric: 73 mm
imperial: 2"7/8
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Vertical plate creation

Option Description
Default

Vertical plate is created.

AutoDefaults can change this option.

Vertical plate is created.

No vertical plate is created.

Parts tab
Use the Parts tab to control the vertical plate and the clip angle properties.

Vertical plate and angle cleat profile

Option Description
Vertical plate Plate thickness, width and height.

The default name is PLATE.
Angle cleat profile Clip angle profile by selecting it from

the profile catalog.

The default name is CLEAT.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the vertical plate and the clip angle
positions.

Vertical plate position

 Description
1 Dimension from the top of the vertical plate to the front edge of the

stringer.
2 Dimension from the edges of the vertical plate to the edges of the

stringer.

Clip angle location

Select on which side of the stringer the clip angle is created.
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Option Description
Default

Clip angle is created on the left side of
the stringer.

AutoDefaults can change this option.
Clip angle is created on the right side
of the stringer.

Clip angle is created on the left side of
the stringer.

Clip angle position

If the legs of the clip angle are of uneven length, you can switch their position.

Option Description
Default

The shorter leg of the clip angle is
connected to the stringer.

AutoDefaults can change this option.
The shorter leg of the clip angle is
connected to the stringer.

The longer leg of the clip angle is
connected to the stringer.

PBolts tab
Use the PBolts tab to control how the clip angle is attached to the base.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Clip angle attachment

Select how the clip angle is attached to the base.

Option Description
Default

Holes are created.

AutoDefaults can change this option.

Holes are created.

Bolts and holes are created.

No holes or bolts are created.
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Create as

Use this option to switch between holes and custom components. Note that
you cannot use this option if you have selected that both bolts and holes are
created, or that no holes or bolts are created.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

SBolts tab
Use the SBolts tab to control how the clip angle is attached to the stringer.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Clip angle attachment

Select how the clip angle is attached to the stringer.

Option Description
Default

No bolts are created.

AutoDefaults can change this option.
No bolts are created.

Bolts are created.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Ladder (S35)
Ladder (S35) creates a vertical step through a ladder, with an option for a
safety cage.

Objects created

• Stringers

• Hoops

• Rungs

• Vertical bars
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Use for

Situation Description
Ladder with safety cage and vertical
step.

Selection order

1. Pick a point to indicate the top point of the ladder.

2. Pick a point to indicate the elevation of the ladder.

The ladder is created automatically when you pick the second point.

Part identification key

 Description
1 Stringer
2 Rung
3 Cage

Picture tab
Use the Picture tab to define the ladder geometry and dimensions.
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Ladder dimensions

 Description Default
1 Direction from which the ladder is

accessed.

The options are: left, right, or normal
(default).

 

2 Hoop circle offset from the stringer
center line.

760 mm

3 Shape of the cage and how it connects to
the ladder.

The options are: U type 1 (default), U
type 2, and O type.

 

4 Cage connection options

The first option is used only for U type 1.
Both options are used for U type 2.

First option: 75
Second option: 40

5 Maximum spacing of hoops.

The hoops are evenly spaced below the
stringer flare. Only one hoop is placed on
the flared stringer.

900 mm

6 Position (z-coordinate) of the lowest
hoop bottom edge.

If the value is greater than the floor to
floor dimension, only the top hoop is

2500 mm

Steel components reference 1926 Stairs



 Description Default
placed with no bars. If the value is
greater than the floor to floor dimension
plus stringer projection, then no hoops
are placed.

7 Lowest hoop extra diameter dimension.  
8 Inside diameter of the hoops.

Stringer flare is taken from the diameter
of the hoops.

750 mm

9 Stringer projection

Height from the upper top of steel to the
flared stringer top edge.

1100

10 Kicker height above the upper top of
steel at which the ladder stringer flare.

200

11 Thickness of the top floor above the top
of steel.

The top rung is placed level with the top
of flooring thickness.

0

12 Maximum spacing of rungs.

Rungs are evenly spaced between the
top and bottom floors.

300 mm

13 Distance between the rungs. Select
either equal or exact distance.

Equal

14 Thickness of the bottom floor above the
lower top of steel. Bottom rung spacing
is taken from the lower top of steel plus
bottom floor.

0

15 Width of the ladder. 450 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stringers Select the stringer profile from the

profile catalog.
The default value is
flat 10*65
(“PLT10*65”).

Rungs Select the rung profile from the
profile catalog.

The default value is
round bar 20
(“D20”).
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Option Description Default
Top Hoops Select the top hoop profile from

the profile catalog.
The default value is
flat 10*50
(“PLT10*50”).

Middle Hoops Select the middle hoop profile
from the profile catalog.

The default value is
flat 10*50
(“PLT10*50”).

Bottom Hoop Select the bottom hoop profile
from the profile catalog.

The default value is
flat 10*50
(“PLT10*50”).

Vertical Bars Select the vertical bar profile from
the profile catalog.

The default value is
flat 10*50
(“PLT10*50”).

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the ladder properties and position.

Ladder position

Option Description Default
Vertical position Vertical position (page 596) of the

ladder
Middle

Vertical offset Vertical offset of the ladder 0.0
Horizontal
position

Horizontal position (page 598)of
the ladder

Middle
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Option Description Default
Horizontal offset Horizontal offset of the ladder 0.0
Class Class of the ladder 1
Create assembly Select whether to create an

assembly or not.
Assembly is
created.

Ladder rotation

Define how the ladder is rotated. The default value is front.

Stringer rotation

Define how the stringers are rotated. The default value is top.
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Rung rotation

Option Description
Rungs are rotated by 45 degrees.

This is the default option.

Rungs are not rotated.
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Cage creation

Option Description
Cage is created.

This is the default option.

Cage is not created.

Hoop angle

  
1 Define the hoop angle.

Vertical bar spacing angle

 Description Default
1 Define the angle between the vertical

bars in the round section of the hoop.
30 degrees
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Rung stringer part cut

Select whether stringers are cut to avoid clashing.

Option Description
Stringers are not cut.

This is the default option.

Stringers are cut.

Define the clearance value for the cut.

Stringers are cut.

Rungs are bolted to the stringers.

Define the clearance value for the cut.
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Option Description
Define the depth of the cut into the
stringer.

Rung offset

 Description
1 Define the horizontal offset of rungs from the stringer center

line.

Ship Ladder
Ship Ladder creates stairs for ships and oil platforms.

Objects created

• Stanchions

• Stringers

• Steps

• Handrails and elbows

• Middle rails

• Platform

• Platform support

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Type 1

Ship ladder with stringers, steps,
stanchions, and handrails.
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Situation Description
Type 2

Ship ladder with stringers, steps,
stanchions, platform, and handrails
with middle rails.
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Situation Description
Type 3

Ship ladder with stringers, steps,
stanchions, platform, handrails with
middle rails.

Type 4

Ship ladder with stringers, steps,
stanchions, and handrails.
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Limitations

Ship Ladder uses catalog step profiles to define the step type on the Parts
tab.

To have an updated step profile list on the Parts tab, you need to run the
Steps.exe program when you use the Ship Ladder modeling tool for the first
time in your environment, or when you change your Tekla Structures
environment.

WARNING With standard settings Tekla Structures overwrites the step
profile settings and replaces them with the default values every
time when Tekla Structures is started. To prevent Tekla
Structures loosing the step profile settings, set
XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = TRUE in
teklastructures.ini file.

If you are using catalog step profiles and have set
XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = TRUE and you
update Tekla Structures, do the following:

1. Set XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = FALSE
in teklastructures.ini file.

2. Update Tekla Structures.

3. Start Tekla Structures.

4. Set XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = TRUE in
teklastructures.ini file.

5. Run Steps.exe.

6. Restart Tekla Structures

Selection order

1. Pick a point to indicate the bottom level of the stairs.

2. Pick a point to indicate the top level of the stairs.

3. Click the middle mouse button to create the component.

Points that indicate the bottom level and top level are usually nosing line
start/end points.
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Part identification key

 Part
1 Elbow
2 Handrail
3 Platform support
4 Plate
5 Stringer
6 Stanchion
7 Step
8 Platform
9 Middle rail

Picture tab
Use the Picture tab to control the type of the stairs, the dimensions of the
parts created, horizontal offset, and horizontal distance between stringers.
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Dimensions

 Description Default
1 Vertical distance between up stringer

bottom and handrail bottom.
1000 mm

2 First stanchion offset along handrail,
measured from the handrail bottom.

200 mm

3 Maximum distance between middle
stanchions.

1000 mm

4 Distance between stringer and handrail. 800 mm
5 Last stanchion offset along handrail,

measured from the stringer top.
200 mm

6 • For Type 1, 2 and 4:

Define the distance between up nosing
line top point and horizontal stringer
end.

• For Type 3:

Define the distance between up nosing
line top points.

1000 mm
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 Description Default
7 Horizontal offset for the first stanchion,

measured from horizontal stringer start.

This option is not active for Type 4.

200 mm

8 Distance between the first and the last
horizontal stanchions.

This option is not active for Type 1 or Type
4.

600 mm

9 Number of middle rails.

This option is not active for Type 1 or Type
4.

3

10 Middle rail spacing.

Use a space to separate middle rail spacing
values. Enter a value for each space
between middle rails. For example, if there
are 3 middle rails, enter 2 values.

This option is not active for Type 1 or Type
4.

Value of option 3
divided by number
of spaces.

11 Vertical distance between handrail top and
platform top.

This option is not active if for Type 4.

1000 mm

12 Vertical distance between platform top and
down stringer bottom.

This option is active only for Type 3.

2000 mm

13 Vertical distance between handrail bottom
and down stringer bottom.

This option is active only for Type 3.

1000 mm

14 Horizontal distance between up nosing line
end and down nosing line end.

This option is active only for Type 3.

The up stringer and
down stringers have
the same
inclination.

Step and assembly creation

Option Description
Create top step Define whether the top step is

created.
Create assembly Define which parts form an assembly.

The options are:

• No

No assembly is created.
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Option Description
• All

All parts are included in an
assembly.

• Stingers/Rails

Parts form several assemblies:

• Each of the stringer assemblies
includes up, horizontal and
down stringers.

• Each of the rail assemblies
includes up, horizontal and
down handrails, middle rails,
stanchions and plates.

• The platform, each platform
support and each step form its
own assembly.

Detail A and Detail C

Use Detail A to connect the up stringer end to an end detail.

Use Detail C to connect the down stringer end to an end detail.

 Description Default
1 Define whether the stringers are connected

to an end detail.
None

2 Define the detail by selecting it from the
component catalog.

 

3 Select an attribute file for the detail. standard
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Ship ladder options

 Description Default
1 Handrail elbow radius.

This option is not active for Type 4.

100 mm

2 Define how to measure the dimension for
the horizontal offset of the ship ladder.

The options are:

• Left

To the left from the line defined by the
picked points.

• Middle

The line defined by the picked points is
the center line.

• Right

To the right from the line defined by the
picked points.

Middle
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 Description Default
3 Horizontal offset.

This option is not active for Default or
Middle.

0 mm

4 Horizontal distance between stringers. 1000 mm

Handrail elbow bending cuts

This option is not active for Type 4.

Option Description
Default

Bent elbow

AutoDefaults can change this option.
Bent elbow

Separate elbow part is between rails.

Fitting

Rails are fitted.

Bent rail

Rail is bent.

Separate rails

Rails are not fitted.

Parts tab
Use the Parts tab to control the properties of the created parts.

Part properties

Option Description Default
Elbow

Handrail

Middle rail

Stanchion

Define the elbow profile
by selecting it from the
profile catalog.

PD40*2

Plate in Detail B Thickness of the plate. 5 mm
Support Thickness of the

platform support.
5 mm

Step Select whether to use
catalogue steps or
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Option Description Default
profiles or to create the
steps.

Select the step from the
list of catalogue steps or
from the profile catalog.

If you change your Tekla
Structures environment,
update the step list.

Stringer Define the stringer
profile by selecting it
from the profile catalog.

C200*100*5

Platform Thickness of the
platform.

50 mm

Bracket Define the bracket
profile by selecting it
from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Platform tab
Use the Platform tab to control the platform offset and support.
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Platform offset

 Description Default
1 Platform horizontal offset from the top

step.

If the top step is not created, the platform
horizontal offset is defined from the up
nosing line top point.

0 mm
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Platform offset and support

 Description Default
1 Platform support vertical offset from the

platform bottom.
0 mm

2 Platform horizontal offset from the stringer. 0 mm
3 Width of the platform support. 50 mm

Platform support creation

NOTE The top of the platform is always on the same level as the top of the
stringer.

Option Description
Default

Platform support is created.

AutoDefaults can change this option.
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Option Description
Platform support is created.

Platform support is not created.

Steps tab
Use the Steps tab to control the step spacing and offset.

Step spacing
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 Description Default
1 Vertical spacing between the steps.

The spacing depends on the step spacing
type.

300 mm

1 Step spacing type.

The steps are spaced from the second
picked point to the first picked point

Equal represents the maximum distance
between the steps.

Exact represents the exact distance
between the steps.

Equal

Step offset

 Description Default
1 Step offset from the stringers. 0 mm
2 Type of the step offset. Horizontal (H)

Rails tab
Use the Rails tab to control the handrail and middle rail properties.

Middle rail and Handrail

Option Description Default
Middle rail to
stanchion

Handrail to stanchion

Define how the middle
rails or handrails are
connected to the
stanchions.

Middle rails =
Connection
Handrails = Weld

Connection number Define a connection that
connects the rails to
stanchion by selecting it
from the component
catalog.

Round tube (23)

Connection properties Select an attribute file
for the connection.

standard
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Handrail options

Option Description Default
Handrail max. length Maximum length of the

handrail.
3000 mm

Handrail cuts Define how the
handrails are cut.

• At max. stanchion

Starting from the
handrail end, the
Handrail max.
length is measured
along the handrail
and the cut is made
at the last stanchion
included in the
measured distance.

• At max. length

Starting from the
handrail end, the
Handrail max.
length is measured
along the rail and the
cut is made at the
maximum length.

• Every stanchion

A cut is made to the
handrail at each
stanchion.

At max. stanchion

Detail B tab
Use the Detail B tab to control the bolt properties on a plate that connects
stanchions to stringers.
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Vertical offset

 Description
1 Plate vertical offset.
2 Define how to measure the dimension for the plate vertical offset.

• Top

From the top of the plate to the stanchion center.

• Middle

From the horizontal center line of the plate to the stanchion center.

• Below

From the bottom of the plate to the stanchion center.
3 Plate width.
4 Distance between top bolt and plate top.
5 Distance between the bolts.
6 Distance between bottom bolt and plate bottom.

Horizontal offset
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 Description
1 Define how to measure the dimension for the horizontal plate offset.

• Left

• From the left of the plate to the stanchion center.

• Middle

From the horizontal center line of the plate to the stanchion
center.

• Right

• From the right of the plate to the stanchion center.
2 Horizontal plate offset.

Bolting direction

Option Description
Default

From plate to stringer

AutoDefaults can change this option.
From stringer to plate

From plate to stringer

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Welds tab

Click the link below to find out more:

Wall Rails
Wall rails creates a horizontal or a sloped handrail with supporting elements.
The handrail is connected to a wall.

Objects created

• Rail

• Elbows

• Endings

• Bracket arm

• Bracket base

• Bolts

• Welds
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Use for

Situation Description
Rail with elbows, endings, and
brackets.

Rail on one side of a ladder, with
elbows, endings, and brackets.

Straight rail with brackets.

Selection order

1. Pick the start point

2. Pick the end point.

The rail is created automatically.
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Part identification key

 Part
1 Rail
2 Right elbow
3 Left elbow
4 Right ending
5 Left ending
6 Bracket arm
7 Bracket base

General tab
Use the General tab to control the assembly creation, rail dimensions and the
rail offset.

Assembly creation

Option Description Default
Create Assembly Define which parts form

an assembly.

The options are:

• All

All parts are included
in an assembly,
including brackets.

Rail is the assembly
main part.

All
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Option Description Default
• Rail

Rail and elbows form
an assembly.

The sloped part of
the rail is the
assembly main part.

• No

No assembly is
created.

Rail dimensions

 Description Default
1 Vertical distance between the rail and the

start/end point.
0 mm

2 Horizontal distance from the rail’s
rightmost/leftmost edge to the start/end
point.

If you have created endings, the distance is
measured from the endings’ outmost edge.

0 mm

3 Vertical distance between the rail and the
noseline.

0 mm

Rail ending dimensions

Define whether the vertical distance between the start/end point and the rail
is measured from the top or the middle of the rail.
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Option Description
Default

From top

AutoDefaults can change this option.
From top

From middle

Rail offset

 Description Default
1 Rail horizontal offset from the start/end

point.
0 mm

Endings tab
Use the Endings tab to control the rail ending types and dimensions.

Ending types

Option Option Description
Default

No ending

AutoDefaults can change
this option.
No ending
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Option Option Description
Separate bent elbow
part between rails.

Rail is bent.

Rail and ending are
fitted.

End detail

Option Description Default
End detail Define a detail that is

created to the ending by
selecting it from the
component catalog.

None

Attribute Select an attribute file
for the end detail.

standard

NOTE Some details do not work correctly with the bent rail. In that case you
need to

• select another type of detail

• use some other elbow or ending type than bent rail.

• select the Internal bracket type.
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Ending dimensions

 Description Default
1 Length of the straight part of the ending. 100 mm
2 Inner radius of the bent ending. 30 mm
3 Bent angle by entering a value between +90

and +180 degrees or -90 and -180 degrees.
90 degrees

4 Length of the bending.

Rail orientation

Define the orientation of the handrail.
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Bent angle examples
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Elbows tab
Use the Elbows tab to control the elbow types and dimensions.

Elbow types

Option Option Description
Default

No elbow

AutoDefaults can change
this option.
No elbow

Separate bent elbow
part between rails.

Rail is bent.

Rails are fitted.

Rails are not fitted.

NOTE If you select some other option than No elbow, you need to enter a
value for the horizontal distance from the rail’s rightmost/leftmost
edge to the start/end point on the General tab. Otherwise the rail is
not created correctly.

Radius and length of bending
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 Description Default
1 Inner radius of the bent elbow. 30 mm
2 Length of the bending.

Brackets tab
Use the Brackets tab to control the bracket types and dimensions.

Bracket options

Option Description Default
Bracket type Define how brackets are

created.

The options are:

• Internal

Brackets are created
according to the
profile selected on
the Parts tab.

• Detail

Brackets are created
according to the
selected bracket
detail.

• No

No brackets are
created.

Internal

Bracket base Define whether the
bracket base is created
or not.

Yes

Bracket detail Define a system or a
custom detail that is
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Option Description Default
used as a bracket by
selecting it from the
component catalog.

This field is active only if
you have set the
Bracket type to Detail.

Attribute Select an attribute file
for the detail.

standard

Connect bracket detail
to

Define the part to which
the bracket detail is
connected.

Bracket arm

Bracket direction

Option Description
Default

Brackets on the left side

AutoDefaults can change this option.
Brackets on the left side

Brackets on the right side

Bracket positioning

 Description Default
1 Distance between the start/end point of

the rail and the bracket.
100 mm

2 Number of brackets. 0
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 Description Default
3 Bracket spacing.

Use a space to separate bracket spacing
values.

0 mm

4 Distance between the start/end point of
the rail and the bracket.

100 mm

5 Number of brackets. 0
6 Bracket spacing.

Spacing depends on the selected bracket
spacing type.

0 mm

7 Spacing type.

If you select Maximum, the component
creates the mininum amount of brackets
needed without exceeding the entered
spacing value. The amount of brackets is
then equally distributed along the rail.

Exact

Bracket dimensions

 Description Default
1 Bracket arm width.

The dimension is measured from the
bracket base.

120 mm

2 Bracket base thickness. 50 mm
3 Bent inner radius of the bracket arm. 10 mm
4 Bracket arm vertical length.

The dimension is measured from the bent
radius.

5 mm
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Hole placement in bracket base

 Description Default
1 Radius of the circle on which the bracket

holes are placed.
17 mm

Bolts tab
Use the Bolts tab to control the bolts that connect the bracket base to a wall.

Bolting direction

Option Description
Default

From bracket to wall

AutoDefaults can change this option.

From bracket to wall
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Option Description
From wall to bracket

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Parts tab
Use the Parts tab to control dimensions of the created parts.

Part guide

Select a part from the list. The selected part is displayed.
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Part dimensions

Option Description Default
Rail Define a profile by

selecting it from the
profile catalog.

CHS40*3

Right elbow Define a profile by
selecting it from the
profile catalog.

Not created

Left elbow Define a profile by
selecting it from the
profile catalog.

Not created

Right ending Define a profile by
selecting it from the
profile catalog.

Not created

Left ending Define a profile by
selecting it from the
profile catalog.

Not created

Bracket arm Define a profile by
selecting it from the
profile catalog.

D12

Bracket base Define a profile by
selecting it from the
profile catalog.

D60

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Welds tab

Click the link below to find out more:

5.13 Stiffeners and gussets
This section introduces components that can be used in steel stiffeners and
gussets.

• Beam with stiffener (129) (page 1970)

• Gusset stiffeners (171) (page 1994)

• Column with stiffeners W (182) (page 1998)

• Column with stiffeners (186) (page 2030)

• Column with stiffeners S (187) (page 2058)

• Column with stiffeners (188) (page 2085)

• Stiffeners (1003) (page 2116)

• Standard gusset (1065) (page 2120)

Beam with stiffener (129)
Beam with stiffener (129) connects a beam to another beam with a bolted
and welded shear tab. The connection can be used at the back of a U-profile.
The secondary beam can be leveled or sloped and/or skewed.

Objects created

• Shear tabs (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Welds

• Bolts

• Cuts
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Use for

Situation Description
Full depth shear tab.

Full depth shear tab. The secondary part is
sloped and/or skewed.

Shear tab with a beam stiffener.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Dimensions
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 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

10 mm

2 Shear tab edge distance from the main part
flange edge.

0

3 Distance from the corner of the shear tab to
the edge of the main part flange.

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
5 Distance from the edge of the main part to

the corner of the shear tab.
20 mm

6 Distance from the bottom edge of the main
part to the bottom edge of the shear tab.

10 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
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Option Description
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.
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Beam bottom flange cut

Option Description
Default

Notch

Define the notch dimensions.

AutoDefaults can change this option.
Notch

Define the notch dimensions.

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab

Option Description
Tab plate Shear plate tab thickness and width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
4 Vertical dimension from the bottom edge of the shear tab to the lower

shear tab corner.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Inner shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Radius and the vertical dimensions of the shear tab inner chamfer.

Chamfer type

Option Option Description
Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer

Convex arc chamfer

Steel components reference 1977 Stiffeners and gussets



Option Option Description
Concave arc chamfer

Inner chamfer type

Option Description
Default

Concave arc chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square
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Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
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Option Description
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flange and the stiffener.
2 Distance from the edge of the main part flange to the edge of the

stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Steel components reference 1984 Stiffeners and gussets



Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

Steel components reference 1986 Stiffeners and gussets



To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.
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Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.

Steel components reference 1988 Stiffeners and gussets



Option Description
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.
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Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Gusset stiffeners (171)
Gusset stiffeners (171) creates 2 or 3 (default) stiffener plates and welds
them to an existing gusset plate and a beam or a column. You can also create
chamfers to the gusset plate and stiffeners.

Objects created

• Stiffener plates

• Welds

• Cuts
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Use for

Situation Description
3 stiffeners welded to column flange and gusset
plate.

Gusset stiffener that is not perpendicular to an I-
beam.

Gusset stiffener for a pipe or bar. Notice that the
stiffener does not have to be located on the
centerline of the pipe or bar.

Chamfered gusset stiffener.

Before you start

Create a gusset plate, and a beam or a column. Use I, C, tube, or RHS profiles.

TIP To create a gusset plate, use the Standard gusset (1065) component or
the plate command that creates a contour plate.

Selection order

1. Select the main part (gusset plate).

2. Select the secondary part (beam or column).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Upper stiffener
2 Middle stiffener
3 Lower stiffener

Picture tab
Use the Picture tab to define the location, shape, and dimensions of the
stiffener plates.

Option Description
Define the horizontal and vertical
dimensions of the stiffener plates.

Define the middle stiffener offset
from the gusset center line.

Stiffener shapes Select the stiffener shape.
Flip stiffener directions Select Yes to flip the stiffener

direction.

Parts tab
Use the Parts tab to define the stiffener properties.
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 Description
Upper stiffener, Lower
stiffener, Middle
stiffener

Define the thickness, width and height of the
stiffener.

By default, 3 stiffeners are created. To remove a
stiffener, enter 0 as the thickness for that
stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer tab
Use the Chamfer tab to define the chamfer shapes and dimensions for the
stiffeners and gusset plate.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with stiffeners W (182)
Column with stiffeners W (182) connects a column to a beam with a shear
tab. The shear tab is welded to the main part and bolted to the secondary part
web. The secondary beam can be leveled or sloped.

Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Web doubler plate (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Shaped shear tab with column stiffeners.

Shaped shear tab with column stiffeners.

The secondary part is sloped.

Shaped shear tab with column stiffeners.

Bolts are aligned with the secondary part.

Steel components reference 1999 Stiffeners and gussets



Situation Description
Shaped shear tab with column stiffeners.

Bolts can be deleted.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Picture tab
Use the Picture tab to control the position of the shear tab corner and to
define how the beam end is cut.

Dimensions

 Description Default
1 Shear tab edge distance from the main part

flange edge.
2 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm

3 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.

Steel components reference 2004 Stiffeners and gussets



Option Description
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs
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 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.
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Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap and chamfer size

 Description
1 Size of the gap between the flanges and the stiffener.
2 Distance from the edge of the flange to the edge of the stiffener.
3 Vertical dimension of the stiffener line chamfer.
4 Horizontal dimension of the stiffener chamfer or radius of arc type

chamfer.

Define the chamfer shape.
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Option Description
Default

No chamfers

AutoDefaults can change this option.
No chamfers

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
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 Description
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Haunch
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar
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Option Description
Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Doubler plate
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with stiffeners (186)
Column with stiffeners (186) connects a beam to a column with a square
shear tab. The shear tab is welded to the main part web and stiffeners, and
bolted to the secondary part web. The secondary beam can be leveled or
sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab with column stiffeners.

Shear tab with column stiffeners.

The secondary part is sloped.
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Situation Description
Shear tab with column stiffeners.

The secondary part is skewed.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Example: Add a beam-to-column connection using the Column with
stiffeners (186) connection
In this example, you will connect a beam to a column using a beam-to-column
connection.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Enter 186 in the search box.

3. Select Column with stiffeners (186).

4. Select the main part (column).

5. Select the secondary part (beam). 

Tekla Structures automatically adds the connection when you select the
beam.

Picture tab
Use the Picture tab to control how the secondary beam end is cut.
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Dimensions

Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20

2 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
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Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.

No chamfer
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Option Option Description
Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab
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Option Description
Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
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Option Description
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.
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Option Description
Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap
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Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm
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Description Default
2 Horizontal dimension of the

chamfer.
10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.
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Option Description
Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Column with stiffeners S (187)
Column with stiffeners S (187) connects a column to a beam with a shaped
shear tab. The shear tab is welded to the main part web and stiffeners, and
bolted to the secondary part web. The secondary beam can be leveled or
sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam connected to column web.

Shear tab with bottom haunch plate and four
stiffeners.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control the position of the shear tab corner and to
define how the beam end is cut.

Dimensions

 Description Default
1 Shear tab edge distance from the main

part flange edge.
0

2 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm

3 Size of the strip made to the secondary
part flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
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Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.
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Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
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 Description
3 Vertical and the horizontal dimension of the shear tab chamfer.

Chamfer type

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.
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Option Description
Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
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Option Description
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding
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Option Description
Line chamfered stiffener plates

Stiffener gap and chamfer size

 Description
1 Size of the gap between the flanges and the stiffener.
2 Distance from the edge of the flange to the edge of the stiffener.
3 Vertical dimension of the stiffener line chamfer.
4 Horizontal dimension of the stiffener chamfer or radius of arc type

chamfer.

Define the chamfer shape.

Option Description
Default

No chamfers

AutoDefaults can change this option.
No chamfers

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm
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Description Default
2 Horizontal dimension of the

chamfer.
10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.
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Option Description
Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2
values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with stiffeners (188)
Column with stiffeners (188) connects a column to a beam with a square
shear tab. The shear tab is welded to the main part web and stiffeners, and
bolted to the secondary part web. The secondary beam can be level or sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab to column flange with column
stiffeners.

Shear tab to column flange with column
stiffeners.

Weld preparation and weld access holes for
moment connection.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to control how the beam end is cut.

Dimensions
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 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

The cut is defined from the main part web
or the main part flange.

20 mm

2 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Secondary part cut

Define whether the secondary part cut is calculated from the main part web or
main part flange.

Option Description
Default

From the main part web

AutoDefaults can change this option.

From the main part flange

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
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Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Option Description
Concave arc chamfer

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 
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Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0
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Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.
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Option Description
Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap
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Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

Description Default
1 Vertical dimension of the

chamfer.
10 mm
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Description Default
2 Horizontal dimension of the

chamfer.
10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.
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Option Description
Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in
the fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge
of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2
values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and
from top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.
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Option for top backing
bar

Option for bottom
backing bar

Description

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the field below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.
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Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.
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Option Description
Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.
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Option Description
Doubler plates are cut in the area that
connects the main part web and
flange.

General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.

Steel components reference 2115 Stiffeners and gussets



Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stiffeners (1003)
Stiffeners (1003) creates stiffeners to I-profiles.

Objects created

• Stiffeners
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Use for

Situation Description
Stiffeners at a beam end.

Selection order

1. Select the main part (beam).

2. Pick a position.

The detail is created automatically when the position is picked.

Picture tab
Use the Picture tab to control the stiffener plate position.

 Description
1 Define the gap between the stiffener plates and beam

flanges.

The default size of the gap between the stiffener plates
and beam flanges is 0 mm.
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 Description
2 Define the stiffener plate distance from the beam flange.

Parts tab
Use the Parts tab to control the stiffener properties.

Option Description
Left stiffener

Right stiffener

Define the stiffener thickness, width
and height.

By default, the thickness is 1.5*beam
web thickness rounded up to the
next plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the stiffener angle and chamfers.
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Option Description
Position of the stiffeners.

You can enter horizontal angles in
degrees for the right and the left
stiffener.

Chamfer type and dimensions.

If you select the No Chamfer 
option, a clash can occur between the
stiffener and the I-profile rounding.

Additionally, you can define the
chamfer dimensions vertically and
horizontally. If you select an arc
chamfer, the horizontal dimension is
the radius and the vertical dimension
has no effect.
Set the stiffener polygon rotation of
the right and the left stiffener.

The value you enter determines the
number of points by which the start
point of the polygon is moved in the
direction shown by the arrows.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

General tab
Click the link below to find out more:

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Steel components reference 2120 Stiffeners and gussets



Standard gusset (1065)
Standard gusset (1065) creates a gusset plate and welds it to the beam or
column web. A stiffener is automatically created on each end of the gusset
plate.

Objects created

• Gusset plate

• Stiffener plates (2)

• Bolts

To create braces and connect them to the gusset plate, use Gusset tube in
points (S47), Crushed tube in bolts (S48), or Gusset tube in bolts (S49).

Use for

Situation Description
Gusset plate welded to the beam web

Before you start

Create a beam or a column (H, W, or C profile).

Note that the gusset plate is created using the properties you define on the
Parts tab.

Selection order

1. Select the main part (beam or column).

2. Pick a point on the main part to indicate the location of the connection.

The connection is created automatically when the you pick the point.

Part identification key
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1 Gusset plate
2 Stiffener

Picture tab
Use the Picture tab to define the gusset plate and stiffener dimensions.

Part dimensions

 Description
1 Define the corner cut size of the gusset plate.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Define the gusset plate offset from the beam or column web.
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 Description
6 Define the corner cut size of the stiffener.
7 Define the stiffener offset from the beam or column web.

Parts tab
Use the Parts tab define the gusset plate and stiffener properties.

Part Description
Gusset plate, Front
stiffener, Back
stiffener

Define the thickness, width and height of the gusset
plate and the stiffeners.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parts tab to define the position of the gusset.

Option Description
Define the horizontal gusset location
using a reference point.
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Option Description
Define the vertical gusset location
using a reference point.

Select the gusset location.

Bolts tab
Use the Bolts tab to define the bolt properties.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolt group

Select whether several or a single bolt group is created.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

5.14 Base plates
This section introduces base plate components available in Tekla Structures.

Click the links below to find out more:

• U.S. Base plate connection (71) (page 2126)

• Round joining plates (124) (page 2148)

• Base plate (1004) (page 2155)
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• Stiffened base plate (1014) (page 2181)

• Web stiffened base plate (1016) (page 2209)

• Simple base plate 2 (1031) (page 2232)

• Base plate (1042) (page 2247)

• U.S. Base plate (1047) (page 2272)

• Circular base plates (1052) (page 2301)

• Base plate (1053) (page 2320)

• Box column base plate (1066) (page 2328)

U.S. Base plate connection (71)
U.S. Base plate connection (71) creates a base plate that connects a column
to a beam.

Objects created

• Base plate

• Stiffeners (can only be added if the column has a W, I, or a TS profile)

• Beam stiffener

• Bolts

• Welds

Use for

Situation Description
Base plate is connected to the beam.

Beam and column stiffeners are used.
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Situation Description
Beam cantilever is connected to a
column with a base plate.

Beam cantilever is connected to a
sloped column with a base plate.

Beam cantilever is connected to a
column with a base plate.

Beam stiffeners are used.
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Situation Description
Beam cantilever is connected to the
column with a base plate.

Beam and column stiffener are used.

Before you start

Create a beam and a column.

Selection order

1. Select the main part (beam).

2. Select the secondary part (column).

The connection is created automatically.

Part identification key

 Part
1 Beam stiffener
2 Stiffeners 1, 2, 4, 5
3 Base plate
4 Stiffeners 3, 6, 7, 8
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Picture tab
Use the Picture tab to control the stiffener chamfering and the base plate
chamfers.

Stiffener chamfering

 Description
1 Top chamfer width for stiffeners 1, 2, 4, 5.
2 Top chamfer height for stiffeners 1, 2, 4, 5.
3 Bottom chamfer height for stiffeners 1, 2, 4, 5.
4 Bottom chamfer width for stiffeners 1, 2, 4, 5.
5 Top chamfer width for stiffeners 3, 6, 7, 8.
6 Top chamfer height for stiffeners 3, 6, 7, 8.
7 Bottom chamfer height for stiffeners 3, 6, 7, 8.
8 Bottom chamfer width for stiffeners 3, 6, 7, 8.
9 Weld gap.

Base plate chamfering
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 Description
1 Width of base plate chamfer 1.
2 Height of base plate chamfer 1.
3 Height of base plate chamfer 2.
4 Width of base plate chamfer 2.
5 Width of base plate chamfer 3.
6 Height of base plate chamfer 3.
7 Height of base plate chamfer 4.
8 Width of base plate chamfer 4.

Parts tab
Use the Parts tab to control the dimensions of the base plate, stiffeners, and
beam stiffener.

Plate

Option Description Default
Plate Base plate thickness,

width and height.
Thickness = 20 mm
Width depends on the
column profile.

Height depends on the
column profile.

The default name is
BASEPLATE.

Stiffeners 1,2,4,5 Stiffener 1, 2, 4, 5
thickness, width and
height.

Stiffeners 3,6,7,8 Stiffener 3, 6, 7, 8
thickness, width and
height.

Beam Stiff Beam stiffener
thickness, width and
height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the square cut corners, plate offset and
bolt properties.

Plate properties

Option Description
Square cut corners (1-4) Cuts made on the corners of the base

plate.

If you enter a number corresponding
to one of the corners of the base
plate, the corner has a square cut
instead of a diagonal chamfer. You
can enter the numbers for one or all
the corners.

Plate aligned with Define whether the plate is aligned
with the column or the connection
symbol.
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Base plate offset

 Description
1 Base plate horizontal offset from the column center.
2 Base plate vertical offset from the column center.

Base plate with holes or bolts

Option Description
Default

Bolts are created.

AutoDefaults can change this option.
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Option Description
Bolts are created.

Holes are created.

Bolt group rotation

You can define the bolt group rotation around its center. To rotate the bolt
group, enter the rotation angle (in degrees).

Positive angle rotates the bolts in a counter-clockwise direction and negative
angle in a clockwise direction.

 Description
1 Bolt group rotation angle.
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Bolt properties

Option Description
Eliminate bolt numbers Define which bolts are deleted from

the bolt group.

Enter the bolt numbers of the bolts to
be deleted and separate the numbers
with a space. Bolt numbers run from
left to right and from top to down.

Eliminate external bolts Define whether external bolts are
deleted.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.
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Option Description
• Base + Column sets the base

plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Stiffeners tab
Use the Stiffeners tab to control stiffener positions and offsets.

Stiffener positions (1-8)

Option Description
Stiffener Positions (1-8) Placement of the stiffeners.

Only the stiffeners whose numbers
are entered in the field are attached
to the column.

Stiffener offset

Stiffener offset allows the stiffeners to be moved. Enter a negative value to
move the stiffener in the opposite direction.

 Description
1 Stiffener 1 offset.
2 Stiffener 2 offset.
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 Description
3 Stiffener 3 offset.
4 Stiffener 4 offset.
5 Stiffener 5 offset.
6 Stiffener 6 offset.
7 Stiffener 7 offset.
8 Stiffener 8 offset.

Beam Stiff tab
Use the Beam Stiff tab to control the beam stiffener alignment, stiffener side,
chamfer dimensions and types.

Left stiffener

Option Description
Default

Left stiffeners are created.

AutoDefaults can change this option.

Left stiffeners are created.

Left stiffeners are not created.
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Center stiffener

Option Description
Default

Center stiffeners are created.

AutoDefaults can change this option.

Center stiffeners are created.

Center stiffeners are not created.

Right stiffener

Option Description
Default

Right stiffeners are created.

AutoDefaults can change this option.
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Option Description
Right stiffeners are created.

Right stiffeners are not created.

Stiffener alignment

Options Description
Default

Stiffeners are aligned with the beam.

AutoDefaults can change this option.

Stiffeners are aligned with the beam.
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Options Description
Stiffeners are aligned with the
column.

Stiffener creation

Option Description
Default

Stiffeners are created on both sides.

AutoDefaults can change this option.

Stiffeners are created on both sides.

Stiffeners are created on far side.
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Option Description
Stiffeners are created on near side.

Stiffeners are not created.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.
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Top and bottom chamfer type

Option for top chamfer Option for bottom
chamfer

Description

Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener offset

Stiffeners can be moved from the center of the beam horizontally or vertically.
Enter a negative value to move the stiffeners in the opposite direction.
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 Description
1 Left stiffener vertical offset.
2 Center stiffener vertical offset.
3 Right stiffener vertical offset.
4 Left stiffener horizontal offset.
5 Center stiffener horizontal offset.
6 Right stiffener horizontal offset.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab
Click the link below to find out more:

General tab

Steel components reference 2147 Base plates



Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Round joining plates (124)
Round joining plates (124) connects two beams or two columns with bolted
base plates. Stiffeners can also be created.

Objects created

• Base plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Round end plates connecting two
beams. Stiffeners are created.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Base plate
2 Tube stiffener

Picture tab

Joining plates

Parts tab
Use the Parts tab to control the base plate and stiffener properties.

Parts

Option Description
Base plate Thickness and width of the base

plate.
Tube stiffeners 1, Tube stiffeners 2 Thickness, width and height of the

tube stiffeners.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the shape and position of the base plate,
the number of stiffeners, and the chamfer dimensions.

Stiffeners

Option Description
Quantity of stiffeners Define how many stiffeners are

created.
Define the stiffener chamfer
dimensions:

1. Chamfers the stiffener corner
where it meets only the column.

2. Chamfers the stiffener corner at
the outer edge of the base plate.

3. Chamfers the stiffener corner at
the intersection of the column
and the base plate.
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Option Description
Define the weld gap between the
parts and the base plates.

Base plate shape

Option Description
Round base plate

Square base plate

Plate type

Select the plate type.
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Base plate direction

Option Description
Creates the base plates perpendicular
to the main part.

Creates the base plates perpendicular
to the secondary part.

Creates the base plates at an angle
which bisects the angle of the main
and secondary parts.

Creates the base plates parallel with
the connection symbol.

Overlap

 Description
1 Distance between the part flange and the plate flange.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is the same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties, the diameter of the inner
plate, and the bolt angle.
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 Description Default
1 Diameter of the bolt circle  
2 Base plate 1 inner diameter

Creates a centered hole in base plate 1

Main part
diameter plus
tolerance

3 Base plate 2 inner diameter

Creates a centered hole in base plate 2

Secondary part
diameter plus
tolerance

4 Bolt angle (in degrees)  

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Base plate (1004)
Base plate (1004) creates a base plate that is connected to a column end.
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Objects created

• Base plate

• Shim plates (optional)

• Leveling plate (optional)

• Grout (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Additional component (optional)

• Welds

Use for

Situation Description
Simple base plate detail

Base plate detail with a shear key

Base plate detail with

• Straight anchor rods

• Extra plates connecting the
anchors
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Situation Description
Base plate detail with

• Anchor rods with hooks

• Leveling plate below the base
plate

• Grout and hole for grouting

• Cast plate

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Shim plate
3 Leveling plate
4 Grout
5 Cast plate
6 Shear key
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 Part
7 Anchor rod
8 Extra plate 1
9 Extra plate 2

Example: Add a base plate and anchor rods using Base plate (1004)
In this example, you will add a base plate detail and anchor rods to a column.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Enter base plate in the search box. 

To view the thumbnail images of the components in the search results

click .

3. Select Base plate (1004).

4. Select the column.

5. Pick a position at the base of the column. 

Tekla Structures automatically adds the base plate when you pick the
position.

6. Next, modify the anchor rod dimensions.

a. Switch on the Select components switch  to more easily select
components.

b. Double-click the component symbol in the model to open the Base
plate (1004) component dialog box.

c. Go to the Anchor rods tab.

d. Change the dimensions of the anchor rods.

e. To change only this base plate, select ignore other types from the
list in the top part of the dialog box. 

f. Click Modify. 

Steel components reference 2158 Base plates



Picture tab
Use the Picture tab to control the position of the base plate and the length
and position of the shear key.

Dimensions

 Description
1 Distance from the flange to the edge of the base plate.

Enter a negative value to make the base plate larger.
2 Weld gap.
3 Height of the shear key.
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Shear key offset

 Description
1 Shear key vertical offset from the column center.
2 Shear key horizontal offset from the column center.

Parts tab
Use the Parts tab to control the dimensions of the base plate, shear key,
leveling plate, and shim plates.

Plate

Option Description Default
Plate Base plate thickness. thickness = 0.5*bolt

diameter rounded up
to the next plate
thickness
The default name is
BASEPLATE.

Leveling Plate Leveling plate thickness,
width and height.

thickness = 1/4

Leveling plate hole
diameter

Leveling plate hole
diameter.

Leveling plate hole
tolerance

Leveling plate hole
tolerance.
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Option Description Default
Fitting plate Shim plate thickness,

width and height.

Define up to three
different shim plates.

 

Number of fitting pl. Number of shim plates
for each thickness.

1

Additional beam Shear key profile by
selecting it from the
profile catalog.

HEA 300 (in Default
environment)

Additional beam
rotation

Select the shear key
rotation type and define
the rotation angle.

 

Additional beam
welded to

Define to which plate
the shear key is welded.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the base plate.
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 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the detail.

AutoDefaults can change this option.

Holes are based on the bolt group of
the detail.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or left side of the detail.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the detail.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance.
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Parameters tab
Use the Parameters tab to control the component and the grout hole.

Grout hole

Define whether a grout hole is created in the base plate. The hole is also
created in the leveling plate and shim plates, if they exist in the detail.

Option Description
Default

Grout hole is not created.

AutoDefaults can change this option.

Grout hole is not created.

Grout hole is created.

Two grout holes are created.

Grout hole dimensions

If the base plate has two grout holes, define the dimensions for both holes.
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 Description
1 Location of the grout hole from the center of the column in the

direction of the web.
2 Grout hole diameter.
3 Location of the grout hole from the center of the column in the

direction of the flange.

Gap size

Define the limit value for the gap between the base plate and the column. Use
this when the column is slightly inclined.

If the actual gap is smaller than this value, the end of the column is left
straight.

If the actual gap is larger than this value, the end of the column is fitted to the
base plate.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
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question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center

line of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.
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Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
above or below the detail creation
point. This also affects the shim
plates.

Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rods types

Option Description
Default

Type 1

AutoDefaults can change
this option.
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Option Description
Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

a

U-shape anchor rod

Radius of the hook

 

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1
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Option Description
Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.
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Create

 Description
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 Define the first extra

profile by selecting it
from the profile catalog.

PL10*100

Extra profile 2 Define the second extra
profile by selecting it
from the profile catalog.
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Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm
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Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Type 3
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front
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Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Stiffened base plate (1014)
Stiffened base plate (1014) creates a base plate that is connected to a
column end.

Objects created

• Base plate

• Stiffeners

• Shim plates (optional)

• Leveling plate (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Base plate with stiffeners

Base plate with stiffeners on the
flange

Base plate with stiffeners on the
flange

Base plate with stiffeners on the
flange

Base plate with stiffeners on the
flange
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Situation Description
Base plate with stiffeners on the web

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Shim plate
3 Leveling plate
4 Shear key
5 Stiffener

Picture tab
Use the Picture tab to control the position of the base plate and the length
and position of the shear key.
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Dimensions

 Description Default
1 Distance from the flange to the edge of the

base plate.

Enter a negative value to make the base
plate larger.

2 Weld gap.
3 Height of the shear key. Equal to the column

width

Shear key offset

 Description
1 Distance of the stiffener from the edge of the column flange.
2 Shear key vertical offset from the column center.
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 Description
3 Shear key horizontal offset from the column center.

Parts tab
Use the Parts tab to control the dimensions of the base plate, web plates,
flange plates, shear key, leveling plate, and shim plate(s).

Plate

Option Description Default
Plate Base plate thickness. BASEPLATE
Web plates Web plate thickness. 10 mm
Flange plate 4 Flange plate thickness. 10 mm
Leveling plate Leveling plate thickness,

width and height.
Leveling plate hole
diameter

Leveling plate hole
diameter.

Fitting plate Shim plate thickness,
width and height.

Define up to three
different shim plates.

Number of fitting pl. Number of shim plates
for each thickness.

1

Additional beam Shear key profile by
selecting it from the
profile catalog.

HEA 300 (in Default
environment)

Additional beam
rotation

Select the shear key
rotation type and define
the rotation angle.

 

Horizontal plates Horizontal plate
thickness.

L profile, flange Profile for L profile,
flange by selecting it
from the profile catalog.

L profile, web Profile for L profile, web
by selecting it from the
profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the base plate.

 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm
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Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the detail.

AutoDefaults can change this option.

Holes are based on the bolt group of
the detail.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or left side of the detail.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the detail.

Tolerance for slots

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance.

Base plate mounting grooves

Option Description
Default

Mounting grooves are not created.

AutoDefaults can change this option.

Mounting grooves are not created.
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Option Description
Mounting grooves are created
horizontally.

Mounting grooves are created
vertically for the first and last row of
the bolts. For other rows of bolts, the
mounting grooves are created
horizontally.

Tolerance for mounting grooves

Define the tolerance for the mounting grooves in the base plates. The width of
the groove is the bolt diameter + the tolerance. If you do not enter a value, the
bolt tolerance value is used.

Parameters tab
Use the Parameters tab to control the component and the grout hole.

Grout hole

Define whether a grout hole is created in the base plate. The hole is also
created in the leveling plate and shim plates, if they exist in the detail.

Option Description
Default

Grout hole is not created.

AutoDefaults can change this option.

Grout hole is not created.

Grout hole is created.
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Option Description
Two grout holes are created.

Grout hole dimensions

 Description
1 Location of the grout hole from the center of the column in the

direction of the web.
2 Grout hole diameter.
3 Location of the grout hole from the center of the column in the

direction of the flange.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.
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Optioon Description
Component Define a system or a custom

component by selecting it from the
Applications & components catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stiffeners
Use the Stiffeners tab to control the web plate stiffeners and the flange plate
stiffeners.
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Web plate stiffener dimensions

 Description Default
1 Height of the web plate stiffener. 200 mm
2 Bottom width of the web plate stiffener. 100 mm

Web plate stiffener chamfer dimensions

 Description
1 Top horizontal chamfer dimension.
2 Top vertical chamfer dimension.
3 Bottom horizontal chamfer dimension.
4 Bottom vertical chamfer dimension.

Web plate stiffener position

You can create stiffeners to different positions using the web plate stiffener
position options.

Option Description
Default

Type 2

AutoDefaults can change this option.
Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Type 7

Flange plate stiffener dimensions

 Description Default
1 Height of the flange plate stiffener. 200 mm
2 Bottom width of the flange plate stiffener. 100 mm

Flange plate stiffener chamfer dimensions

 Description
1 Top horizontal chamfer dimension.
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 Description
2 The top vertical chamfer dimension.
3 Bottom horizontal chamfer dimension.
4 Bottom vertical chamfer dimension.

Flange plate stiffener position

You can create stiffeners to different positions using the flange plate stiffener
position options.

Option Description
Default

Type 2

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Stiffener dimensions

If you have created the stiffeners using other than the default stiffener
position options, you can separately define the plate dimensions for different
positions.

 Description
1 Width of the stiffener.
2 Height of the stiffener.
3 Width of the stiffener.
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Stiffener plate width

If you have selected type 5 as the web plate stiffener position or type 4 as the
flange plate stiffener position, you can define the stiffener width.

 Description Default
1 Width of the stiffener. 200 mm

Stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
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Option Description
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
above or below the detail creation
point. This also affects the shim
plates.

Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.
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Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the

base plate.
50 mm

5 Distance between the cast plate and
the base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rods types

Option Description  
Default

Type 1

AutoDefaults can
change this option.

 

Type 1  

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor bar
length
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Option Description  
a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor
rod below the extra
plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.
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Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create
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 Description
1 Create the nut profile.

You can select to create two nuts at the top of the anchor
rods.

2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 First extra profile by

selecting it from the
profile catalog.

PL10*100

Extra profile 2 Second extra profile by
selecting it from the
profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Class Part class number.  

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Type 3

Type 4

Type 5

Type 6
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Length of extra profile 2

 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Height of circular extra
profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Web stiffened base plate (1016)
Web stiffened base plate (1016) creates a base plate with vertical, horizontal,
and sloping web stiffeners.

Objects created

• Base plate

• Stiffeners

• Shim plates (optional)

• Leveling plate (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods
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• Anchor rods

• Bolts

• Welds

• Additional component (optional)

Use for

Situation Description
Web
stiffened
base plate

Web
stiffened
base plate
with a
leveling
plate, a
shim plate,
horizontal
stiffener
and a shear
key
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Before you start

Create a column or a beam.

Selection order

1. Select the main part (column or beam).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Shim plate
3 Leveling plate
4 Shear key
5 Upper horizontal stiffener
6 Upper flange stiffener
7 Lower flange stiffener

Picture tab
Use the Picture tab to control the position of the base plate and the shear key
offset.
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Dimensions

 Description
1 Distance from the flange to the edge of the base plate.
2 Weld gap.
3 Height of the shear key.

Shear key offset

 Description
1 Shear key vertical offset from the main part center.
2 Shear key horizontal offset from the main part center.
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Parts tab
Use the Parts tab to control the dimensions of the base plate, upper and
lower flange stiffener, shear key, leveling plate, upper horizontal stiffener, and
shim plates.

Plate

 Description Default
Plate Base plate thickness.

The dimensions on the
Picture and Bolts tab
determine the base
plate width and length.

 

Upper fl. stiffener Upper flange stiffener
thickness, width and
height.

Thickness = thickness
of the main part
flange
Height = determined
by the size of the
main part
Width = inner side
flange distance

Lower fl. stiffener Lower flange stiffener
thickness, width and
height.

Thickness = thickness
of the main part
flange
Height = determined
by the size of the
main part
Width = inner side
flange distance

Additional beam Select the shear key
profile from the profile
catalog.

 

Additional beam
rotation

Select the shear key
rotation type and define
the rotation angle.

 

Additional beam
welded to

Define to which plate the
shear key is welded.

 

Leveling plate Leveling plate thickness,
width and height.

 

Leveling plate hole
diameter

Leveling plate hole
diameter.

 

Upper horizontal stiff Upper horizontal
stiffener thickness, width
and height.

Thickness = 0 mm
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 Description Default
Fitting plate Shim plate thickness,

width and height.

Define up to three
different shim plates.

 

Number of fitting pl. Number of shim plates
for each thickness.

1

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the component used inside Web stiffened
base plate (1016).

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.
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Part Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base set the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Stiffeners tab
Use the Stiffeners tab to control the stiffener angle, position and selection.
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Stiffener angle and position

 Description Default
1 Stiffener angle. 60 degrees
2 Height of the stiffener.  
3 Distance of the stiffener from the column

edge.
 

4 Gap between the upper horizontal stiffener
and the main part flange.

Stiffener plate dimension

 Description
1 Size of the chamfer.
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Stiffener selection 1

Option Description
Default

Stiffeners are sloped.

AutoDefaults can change this option.
Stiffeners are sloped.

Stiffeners are vertical.

Stiffener selection 2

Option Description
Default

Stiffeners are sloped.

AutoDefaults can change this option.
Stiffeners are sloped.

Flanges are cut and stiffeners are
created.

If you have selected the vertical
stiffeners, you cannot create sloped
stiffeners or cut flanges.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.
Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and height.
Cast plate Cast plate thickness, width and height.
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Option Description
Grout Grout thickness.

Grouting helps you to model columns to the
top of concrete parts and place the base plate
correctly. It also makes it easier to dimension
the detail in GA drawings.

By default, no grouting is created.

Select whether the grouting is created above or
below the detail creation point. This also
affects the shim plates.

Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.
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Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rods types

Option Description
Default

Type 1

AutoDefaults can change
this option.

Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length
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Option Description
a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.
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Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create
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 Description
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 First extra profile by

selecting it from the
profile catalog.

PL10*100

Extra profile 2 Second extra profile by
selecting it from the
profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Type 3

Type 4

Type 5

Type 6
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Length of extra profile 2

 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Simple base plate 2 (1031)
Simple base plate 2 (1031) creates a base plate that is connected to a column
or beam end.

Objects created

• Base plate

• Stiffeners (for W profiles only)

• Shear key

• Leveling plate

• Welds
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Use for

Situation Description
• Base plate created at column end

Selection order

1. Select the main part (column or beam).

2. Pick a position.

The detail is created automatically.

Part identification key

 Description
1 Base plate
2 Stiffeners
3 Shear key

Picture tab
Use the Picture tab to define the plate position and corner cuts.
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Dimensions

 Description
1 Base plate offset from the bottom edge of the column.
2 Distance from the component input point to the base plate

bottom.

You can offset the base plate from the point picked for creating
the component.

3 Shear key height

Base plate corner cut

 Description
1 Horizontal corner cut dimension.
2 Vertical corner cut dimension.

Parts tab
Use the Parts tab to define the plate properties.
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Parts

Option Description
Base plate Thickness, width, and height of the

base plate.
Stiffeners Thickness, width, and height of the

stiffeners.
Key profile Select the shear key profile from the

profile catalog.
Leveling plate Thickness of the leveling plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the base plate corner shape, condensation
holes, shear key creation, and leveling plate extra length.

Option Description
Plate wrap around Define whether the base plate is

automatically wrapped around the
column and bolts, bolts, or column.

• Around bolts and column
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Option Description
• Around bolts

• Around column

Condensation holes sides 1-4 Define where the condensation holes
are located by entering the corner
numbers.

Semi-circular holes are placed at the
bottom of columns and some circular
profiles.

Condensation holes diameter Define the diameter of the
condesation holes.

Base plate corner shape

 Description
1 Define which plate corners are reshaped.

You can enter the corner numbers in any order. Corners are not
reshaped if you do not enter any numbers.

2 Define the horizontal offset of the plate from the bolt center
line.

This offset works when Plate wrap around is set to Automatic.
3 Define the vertical offset of the plate from the bolt center line.

This offset works when Plate wrap around is set to Automatic.
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Shear key offset and rotation

 Description
1 Define the horizontal offset of the shear key.
2 Define the vertical offset of the shear key.
3 Define the rotation of the shear key around the column center

line.

Shear key creation

Option Description
Default

Shear key is not created.

AutoDefaults can change this option.

Shear key is created.

Shear key is not created.
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Leveling plate size

 Description
1 Define the leveling plate extra length.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

2 Dimension for vertical bolt group position.
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 Description
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Select how to measure the dimensions for horizontal bolt
group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

6 Dimension for horizontal bolt group position.

Bolt group rotation

 Description
1 Define the bolt group rotation around the column center line,

measured from the column web.

Bolt deletion

Option Description
Edge tolerance for deleting bolts Define the minumum bolt edge

distance for deleting bolts. The
distance is measured from the bolt
center to the edge of the plate.

Eliminate bolts Define which bolts are deleted.

Enter the bolt numbers from the first
bolt in the first row to the last bolt in
the last row, for example, 1 3 10.
Enter A or a to delete all bolts.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stiffeners tab
Use the Stiffeners tab to define the stiffener dimensions and chamfering.
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Stiffener offset

  
1 Stiffener offset from the base plate.
2 Stiffener offset from the column.

Stiffener positions

 Description
1 Stiffener position on the base plate edge.
2 Define on which sides the stiffeners are created.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

Line chamfer

Convex chamfer
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Option Description
Concave chamfer

No chamfer

Grouting holes tab
Use the Grouting holes tab to define the grout hole dimensions.

Grout holes

You can define whether to delete some or all of the grout holes in Elim holes.

Grout hole dimensions

 Description
1 Location of the grout hole from the center of the column in the

direction of the web.
2 Grout hole diameter.
3 Location of the grout hole from the center of the column in the

direction of the flange.
4 Number of grout holes
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 Description
5 Grout hole spacing

Use a space to separate the spacing values. Enter a value for
each space between holes. For example, if there are 3 bolts,
enter 2 values.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Base plate (1042)
Base plate (1042) creates a base plate that is connected to a column end.

Objects created

• Base plate

• Bolts

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Column base detail

Column base plate at the face of the flange

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.
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Part identification key

 Part
1 Base plate

Picture tab
Use the Picture tab to control the position of the base plate.
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Dimensions

 Description
1 Distance from the flange of the main part to the edge of the base plate.
2 Weld gap.

Parts tab
Use the Parts tab to control the dimensions of the base plate.

Plate

Option Description Default
Plate Thickness, width, and

height of the base plate.
Thickness = 30 mm
Width =500 mm
Heigh t =500 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Parameters tab
Use the Parameters tab to control the weld dimensions, grout hole diameter
and position, plate type, design check and shear force value.

Design check

Option Description
Design Define whether design check is

turned on or off.
Bearing Define whether the detail and its

components bear the entered shear
force.

Factored Axial Dead Load (kN) Define the factored axial dead load, if
design check is turned on.

Minimum Fcu (N/mm^2) Define the minimum Fcu, if design
check is turned on.

Shear force

 Description
1 Shear force value.

If the design check is turned on, enter a positive value. If there is no
shear force, enter 0.
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Weld dimensions

 Description
1 Weld dimension on the column flange.
2 Weld dimension on the column web.

Weld types

Option Description
Default

Fully welded

AutoDefaults can change this option.

Fully welded
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Option Description
Partially welded

Grout hole diameter and offset

 Description
1 Grout hole horizontal offset from the column center.
2 Grout hole diameter.
3 Grout hole vertical offset from the column center.

Base plate with grout hole

Option Description
Default

Grout hole is not created.

AutoDefaults can change this option.
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Option Description
Grout hole is not created.

Grout hole is created.

Base plate mounting grooves

Option Description
Default

Mounting grooves are not created.

AutoDefaults can change this option.

Mounting grooves are not created.

Mounting grooves are created
horizontally.
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Option Description
Mounting grooves are created
vertically for the first and last row of
the bolts. For other rows of bolts, the
mounting grooves are created
horizontally.

Tolerance for mounting grooves

Define the tolerance for the mounting grooves in the base plates. The width of
the groove is the bolt diameter + the tolerance. If you do not enter a value, the
bolt tolerance value is used.

Base plate with holes or bolts

Option Description
Default

Holes are created.

AutoDefaults can change this option.

Holes are created.
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Option Description
Bolts are created.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.
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Option Description
• Column + Base sets the column

as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
above or below the detail creation
point. This also affects the shim
plates.
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Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
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 Description Default
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rod types

Option Description  
Default

Type 1

AutoDefaults can change
this option.

 

Type 1  

a

Radius of the hook

b

Width of the hook

a = 2 x anchorbar
diameter
b = 1/5 of anchorbar
length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2 x nut size
e = 4 x nut size
plus thickness of
extra plate
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Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2
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Cast plate hole tolerance

Option Description Default
Cast plate holes
tolerance

Define the tolerance of
the cast plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create

 Description
1 Create the nut profile.

You can select to create two nuts at the top of the anchor rods.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.
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Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 First extra profile by

selecting it from the
profile catalog.

PL10 x 100

Extra profile 2 Second extra profile by
selecting it from the
profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Edge distance of extra profile 1
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 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Type 3
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchorbar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front
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Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

7 Dimension for vertical bolt group position.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

U.S. Base plate (1047)
U.S. Base plate (1047) creates a base plate at the selected point on a column.

Objects created

• Base plate

• Stiffeners (can only be added if the column has a W, I, or a TS profile)

• Shim plates (optional)

• Leveling plate (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds
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• Additional component (optional)

Use for

Situation Descripti
on

Column
base
plate
with a
grout
hole.

Column
base
plate
with a
grout
hole and
a shear
key.
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Situation Descripti
on

Column
base
plate
with a
grout
hole, a
shear key
and
stiffeners
.

Offset
column
base
plate
with a
shear key
and a
grout
hole.
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Situation Descripti
on

Column
base
plate
with
holes and
chamfer.

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Stiffeners 1, 2, 4, 5
3 Stiffeners 3, 6, 7, 8

Picture tab
Use the Picture tab to control stiffener chamfering, base plate chamfers, and
the location and size of the grout hole.
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Stiffener chamfering

 Description
1 Top chamfer width for stiffeners 1, 2, 4, 5.
2 Top chamfer height for stiffeners 1, 2, 4, 5.
3 Bottom chamfer height for stiffeners 1, 2, 4, 5
4 Bottom chamfer width for stiffeners 1, 2, 4, 5.
5 Top chamfer width for stiffeners 3, 6, 7, 8.
6 Top chamfer height for stiffeners 3, 6, 7, 8.
7 Bottom chamfer height for stiffeners 3, 6, 7, 8.
8 Bottom chamfer width for stiffeners 3, 6, 7, 8,
9 Weld gap.
10 Select the chamfer type.

Base plate chamfering

 Description
1 Width of base plate chamfer 1.
2 Height of base plate chamfer 1.
3 Height of base plate chamfer 2.
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 Description
4 Width of base plate chamfer 2.
5 Width of base plate chamfer 3.
6 Height of base plate chamfer 3.
7 Height of base plate chamfer 4.
8 Width of base plate chamfer 4.
9 Grout hole horizontal distance from the column center.
10 Grout hole vertical distance from the column center.
11 Diameter of the grout hole.

Parts tab
Use the Parts tab to control the dimensions of the base plate, stiffeners,
leveling plate, and shim plates.

Plate

Option Description Default
Plate Base plate thickness,

width and height.

You can add a comment
about the part.

Thickness = 20 mm
Width depends on the
largest cross-sectional
dimension of the
column.

Height depends on the
largest cross-sectional
dimension of the
column.

Stiffeners 1,2,4,5 Stiffener 1, 2, 4, 5
thickness, width and
height.

Thickness depends on
the column flange
thickness.

Width depends on the
distance between the
edge of the plate and
the edge of the column.

Height = 1.75*width
Stiffeners 3,6,7,8 Stiffener 3, 6, 7, 8

thickness, width and
height.

Thickness depends on
the column flange
thickness.

Width depends on the
distance between the

Steel components reference 2277 Base plates



Option Description Default
edge of the plate and
the edge of the column.

Height = 1.75*width
Key profile Shear key profile by

selecting it from the
profile catalog.

 

Leveling plate Leveling plate thickness,
width, and height.

You can add a comment
about the part.

 

Fitting plate Shim plate thickness,
width and height.

Define up to three
different shim plates.

 

Number of fitting pl. Number of shim plates
for each thickness.

1

Leveling plate hole
diameter

Leveling plate hole
diameter.

 

Key profile welded to Define to which plate the
shear key is welded.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Steel components reference 2278 Base plates



Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the base plate.

 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim plate. 30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the detail.

AutoDefaults can change this option.

Holes are based on the bolt group of
the detail.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the detail.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the detail.
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Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance.

Base plate mounting grooves

Option Description
Default

Mounting grooves are not created.

AutoDefaults can change this option.

Mounting grooves are not created.

Mounting grooves are created
horizontally.

Mounting grooves are created
vertically for the first and last row of
the bolts. For other rows of bolts, the
mounting grooves are created
horizontally.

Tolerance for mounting grooves

Define the tolerance for the mounting grooves in the base plates. The width of
the groove is the bolt diameter + the tolerance. If you do not enter a value, the
bolt tolerance value is used.

Parameters tab
Use the Parameters tab to control the plate properties and option, shear key
offset, rotation and length, bolt properties and rotation of the base plate.

Plate properties
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Option Description
Square cut corners (1-4) Cuts made on the corners of the base

plate.

If you enter a number corresponding
to one of the corners of the base
plate, the corner has a square cut
instead of a diagonal chamfer. You
can enter the numbers for one or all
the corners.

Cut cast plate Define whether base plate corner
cuts are applied to the cast plate.

Select Yes to apply the cuts.

Bolt properties

Option Description
Eliminate bolt numbers Define which bolts are deleted from

the bolt group.

Enter the bolt numbers of the bolts to
be deleted and separate the numbers
with a space. Bolt numbers run from
left to right and from top to down. If
there are more than 10 bolts, enclose
the bolt numbers in quotes (for
example, to delete bolt numbers 13
and 15, enter "13" "15").

Eliminate external bolts Define whether external bolts are
deleted.

Base plate with holes or bolts

Option Description
Default

Holes are created.

AutoDefaults can change this option.

Holes are created.
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Option Description
Bolts are created.

Base plate offset

 Description
1 Base plate horizontal offset from the column center.

Enter a negative value to move the base plate in the opposite
direction

2 Base plate vertical offset from the column center.

Enter a negative value to move the base plate in the opposite
direction

Shear key offset and rotation
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 Description
1 Shear key vertical offset.

Enter a negative value to move the shear key in the opposite direction.
2 Shear key rotation angle (in degrees).

Positive angle rotates the shear key in a counter-clockwise direction
and negative angle in a clockwise direction.

3 Shear key horizontal offset.

Enter a negative value to move the shear key in the opposite direction.

Shear key length

 Description
1 Shear key length to attach the shear key to the base plate.

To attach a shear key to the base plate, define the shear key length
and the key profile on the Parts tab.

Bolt group rotation

You can define the bolt group rotation around its center. To rotate the bolt
group, enter the rotation angle (in degrees).

Positive angle rotates the bolts in a counter-clockwise direction and negative
angle in a clockwise direction.

 Description
1 Bolt group rotation angle.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Stiffeners tab
Use the Stiffeners tab to control stiffener positions and offsets.

Stiffener positions (1-8)

Option Description
Stiffener Positions (1-8) Placement of the stiffeners.

Only the stiffeners whose numbers
are entered in the field are attached
to the column.

Stiffener offset

Stiffener offset allows the stiffeners to be moved. Enter a negative value to
move the stiffener in the opposite direction.
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 Description
1 Stiffener 1 offset.
2 Stiffener 2 offset.
3 Stiffener 3 offset.
4 Stiffener 4 offset.
5 Stiffener 5 offset.
6 Stiffener 6 offset.
7 Stiffener 7 offset.
8 Stiffener 8 offset.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
above or below the detail creation
point. This also affects the shim
plates.
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Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions
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 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rod types

Option Description  
Default

Type 1

AutoDefaults can change
this option.

 

Type 1  

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate
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Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2
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Cast plate hole tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Field Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create

 Description
1 Create the nut profile.

You can select to create two nuts at the top of the anchor rods.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.
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Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 Define the first extra

profile by selecting it
from the profile catalog.

PL10*100

Extra profile 2 Define the second extra
profile by selecting it
from the profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Edge distance of extra profile 1
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 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Type 3
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front
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Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Create welds

Circular base plates (1052)
Circular base plates (1052) creates a base plate that is connected to a circular
column.

Objects created

• Circular base plate

• Tube stiffeners

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Descript
ion

Circular
base
plate

Circular
base
plate

Square
base
plate

Before you start

Create a circular column.
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Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Stiffener
2 Base plate

Picture tab
Use the Picture tab to control the geometry of Circular base plates (1052).

Dimensions
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 Description Default
1 Width of the top part of the tube stiffener. 20 mm
2 Weld gap. 0 mm
3 Height of the end part of the tube stiffener. 30 mm

Parts tab
Use the Parts tab to control the dimensions of the circular base plate and the
tube stiffeners.

Plate

Option Description Default
Circular base plate Circular base plate

thickness and width.
Thickness = 30 mm
Width depends on the
tube diameter.

Tube stiffeners Tube stiffener thickness,
width and height.

Thickness = 10 mm
Height = 200 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the shape of the base plate, diameter of
the inner plate, bolt angle, the overlap, and chamfer dimension.
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Base plate shape

Option Description
Default

Round base plate

AutoDefaults can change this option.

Round base plate

Square base plate
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Inner plate diameter and bolt angle

 Description
1 Base plate inner diameter.
2 Bolt angle (in degrees).

Cast plate shape

Option Description
Default

Square cast plate

AutoDefaults can change this option.

Square cast plate
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Option Description
Round cast plate

Base plate position

Option Description
Default

Base plate is perpendicular to the
column.

AutoDefaults can change this option.

Base plate is perpendicular to the
column.

Base plate is not perpendicular to the
column.
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Overlap

 Description Default
1 Distance between the column flange and

the plate flange.
0 mm

Chamfer dimension

 Description Default
1 Chamfer dimension. 10 mm

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.
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Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt positions

 Description
1 Number of bolts.
2 Spacing between bolts.
3 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to down.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Steel components reference 2310 Base plates



Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.
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Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
above or below the detail creation
point. This also affects the shim
plates.

Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the

base plate.
50 mm

5 Distance between the cast plate and
the base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rod types

Option Description
Default

Type 1

AutoDefaults can change
this option.
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Option Description
Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3
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Option Description
Type 4

Bolting direction

NOTE You can define the bolting direction when you create the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate hole tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Plate washer placing

Option Description
Plate washers placed along circle Select whether the plate washers are

placed along the circle.

Placing the washers along the circle
distributes the loads evenly.
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Create

 Description
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 Select the first extra

profile from the profile
catalog.

PL10*100

Extra profile 2 Select the second extra
profile from the profile
catalog.
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Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of nut size or
anchor bar diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

Analysis tab
Click the link below to find out more:

Welds
Click the link below to find out more:

Base plate (1053)
Base plate (1053) creates a base plate for tower legs. The base plate is
horizontal even if the column is sloped.

Objects created

• Base plate

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Horizontal base plate connected to
sloped tower leg

Before you start

Create a column or a beam.

Selection order

1. Select the main part (column or beam).

2. Pick a position.

The detail is created automatically.

Part identification key

Num
ber

Part

1 Base plate

Picture tab
Use the Picture tab to control the position of the base plate.
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Dimensions

 Description Default
1 Horizontal distance between the reference

point and the bolt.
150 mm

2 Vertical distance between the reference
point and upper edge of the base plate.

300 mm

3 Vertical distance between the reference
point and the lower edge of the base plate.

200 mm

4 Horizontal distance between the reference
point and the left edge of the base plate.

200 mm

5 Horizontal distance between the reference
point and the right edge of the base plate.

300 mm

6 Vertical distance between the reference
point and the bolt.

150 mm

Parts tab
Use the Parts tab to control the dimensions of the base plate.

Plate

Option Description Default
Plate Thickness, width, and

height of the base plate.
Thickness = 10 mm
Width = 250 mm
Height =250 mm
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the position of the reference point and the
bolt locations.

Reference point

Define the plate dimensions and bolt locations using a reference point. The
point is located at the column end angle.

The picked point locates either on the top (P2) or the bottom of the base plate
(P1).

Weld gap

 Description
1 Gap between the base plate and the column.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Number of bolts in the horizontal dimension.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Number of bolts in the vertical dimension.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Create as

Use this option to switch between bolts and custom components.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Box column base plate (1066)
Box column base plate (1066) creates a base plate for a square or a circular
column that is embedded in concrete.

Objects created

• Base plate

• Ribs

• Flow holes

• Bolts

• Welds

Use for

Situation Description
Base plate with a square column
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Situation Description
Base plate with a square column

Base plate with a circular column

Base plate with a circular column

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.
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Part identification key

Number Part
1 Base plate
2 Rib

Picture tab
Use the Picture tab to control the position of the base plate.

Dimensions

 Description Default
1 Distance from the edge of the column to the

edge of the base plate.
50 mm
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Parts tab
Use the Parts tab to control the dimensions of the base plate, long rib, and
short rib.

Plate

Option Description Default
Base plate Base plate thickness.
Long rib Long rib thickness. 9 mm
Short rib Short rib thickness. 9 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tabs
Use the Parameters tab to control the base plate and rib dimensions.
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Base plate and rib dimensions

 Description
1 Width of base plate.
2 Length of long rib.
3 Length of short ribs.
4 Height of base plate.

Rib creation

Option Description
Default

No ribs are created.

AutoDefaults can change this option.
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Option Description
No ribs are created.

Ribs are created.

Base plate creation

Option Description
Default

Rectangular base plate

AutoDefaults can change this option.

Automatic
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Option Description
Round base plate

Rectangular base plate

Flow holes tab
Use the Flow holes tab to control the distance between the base plate and the
column.

Flow hole properties

 Description
1 Rounding of the column flow hole.
2 Weld gap.
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 Description
3 Width of the column flow hole.
4 Height of the column flow hole.

Flow hole creation

Option Description
Default

Flow holes are created.

AutoDefaults can change this option.

Flow holes are not created.

Flow holes are created.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt positions

 Description
1 Vertical bolt spacing dimension.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Horizontal bolt spacing dimension.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Create as

Use this option to switch between bolts and custom components.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.

Height of ribs tab
Use the Height of ribs tab to control the height of the short and the long ribs.

Height of ribs

 Description Default
1 Height of the long rib. 200 mm
2 Height of the short ribs. 200 mm

Short rib chamfer

Option Description
Default

Line chamfer is created.

AutoDefaults can change this option.
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Option Description
Chamfer is not created.

Line chamfer is created.

Arc chamfer is created.

Chamfer dimensions

 Description Default
1 Chamfer height. 15 mm
2 Chamfer width. 15 mm
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds tab

Click the link below to find out more:

5.15 Built-up Components
This section introduces built-up components available in Tekla Structures.

Click the links below to find out more:

• Beams (page 2340)

• Columns (page 2356)

• Frames (page 2363)

• Connections and details (page 2369)

• Tapered component properties (page 2397)

Beams
Use these componentss to automatically create built-up beams:

Component Image Description
Box girder (S13)
(page 2341)

Creates a built-up beam
using four plates welded
together.
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Component Image Description
Cross profile
(S32)
(page 2343)

Creates a built-up beam
using an I profile and two
T profiles welded to the I
profile web.

Cross plate
profile (S33)
(page 2345)

Creates a built-up beam
from seven plates
welded together.

Tapered beam
(S98)
(page 2347)

Creates a tapered or
straight built-up beam
with I shape.

Tapered beam 2
(S45)
(page 2350)

Creates a tapered or
straight built-up beam
with I shape. Flange and
web plates can be
spliced.

PEB Tapered
Section (S94)
(page 2354)

Creates a simple built-up
beam or column
between two picked
points. The shape can be
straight or tapered.

Box girder (S13)
Box girder (S13) creates a built-up beam with box cross section.
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Use for

Straight built-up beams.

Do not use for

Tapered built-up beams.

Before you start

Ensure that you have two points to pick.

Picking order

1. Starting point for the beam.

2. End point for the beam.

Picture tab
Use the Picture tab to define the plate dimensions.

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Parameters tab
Use the Parameters tab to define the part names, classes and finishes, and
the location and length of the beam.
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Use the following fields to change part properties and length and location of
beams:

Field Description
Name  
Class
Finish
Move end 1 Moves the end of the beam you pick

first. Negative values shorten the
beam, positive values lengthen it.

Move end 2 Moves the end of the beam you pick
second. Negative values shorten the
beam, positive values lengthen it.

Position in plane See Part horizontal position
(page 598).Position in plane offset

Rotation See Part rotation (page 594).
Rotation offset
Position in depth See Part position depth (page 595).
Position in depth offset

Welds

Click the link below to find out more:

Cross profile (S32)
Cross profile (S32) creates a built-up beam using an I profile and two T
profiles welded to the I profile web.

Use for

Straight built-up beams.
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Do not use for

Tapered built-up beams.

Before you start

Check that you have two points to pick.

Selection order

1. Starting point for the beam.

2. End point for the beam.

Picture tab
Use the Picture tab to define the dimensions of profiles.

Use eccentricity to adjust the location of horizontal parts relative to vertical
parts.

By default the eccentricity is zero. So T profiles or plates are connected to the
middle of the I profile web or vertical plate.

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Parameters tab
Use the Parameters tab to define the part names, classes and finishes, and
the location and length of the beam.

Use the following fields to change part properties and length and location of
beams:

Field Description
Name  
Class
Finish
Move end 1 Moves the end of the beam you pick

first. Negative values shorten the
beam, positive values lengthen it.

Move end 2 Moves the end of the beam you pick
second. Negative values shorten the
beam, positive values lengthen it.

Position in plane See Part horizontal position
(page 598).Position in plane offset

Rotation See Part rotation (page 594).
Rotation offset
Position in depth See Part position depth (page 595).
Position in depth offset

Welds

Click the link below to find out more:

Cross plate profile (S33)
Cross plate profile (S33) creates a built-up beam using seven plates welded
together.
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Use for

Straight built-up beams.

Do not use for

Tapered built-up beams.

Before you start

Ensure that you have two points to pick.

Picking order

1. Starting point for the beam.

2. End point for the beam.

Picture tab
Use the Picture tab define the dimensions of the plates.

Use eccentricity to adjust the location of horizontal parts relative to vertical
parts.

By default the eccentricity is zero. So T profiles or plates are connected to the
middle of the I profile web or vertical plate.

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Parameters tab
Use the Parameters tab to define the part names, classes and finishes, and
the location and length of the beam.

Use the following fields to change part properties and length and location of
beams:

Field Description
Name  
Class
Finish
Move end 1 Moves the end of the beam you pick

first. Negative values shorten the
beam, positive values lengthen it.

Move end 2 Moves the end of the beam you pick
second. Negative values shorten the
beam, positive values lengthen it.

Position in plane See Part horizontal position
(page 598).Position in plane offset

Rotation See Part rotation (page 594).
Rotation offset
Position in depth See Part position depth (page 595).
Position in depth offset

Welds

Click the link below to find out more:

Tapered beam (S98)
Tapered beam (S98) creates a tapered or straight built-up beam with I shape.

Parts created

• Web plate

• Top flange plate

• Bottom flange plate
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Use for

Situation More information
Creates a simple
built-up beam
between two picked
points.

Before you start

Ensure that you have two points to pick.

Selection order

1. Pick a start and end point to indicate beam length:

Picture tab
Use the Picture tab to define the height of the web or the entire beam, sloping
rise and run values.

Height of the web or the entire beam, depending on the option in the Height
type field on the Parameters tab.

Parts tab
Use the Parts tab to define the properties of the plates.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.
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Option Description Default
Pos_No Define a prefix and a

starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Parameters tab
Use the Parameters tab to define the height type, type of reference point,
type of cut, end plate thickness, and the position of the web plate.

Property Description
Height type Affects the height values entered in the

Picture tab.
Type of
reference point

Location of the end of the beam, relative
to a point you pick:

Top profile, end of endpl

Top profile, end of webpl

Top webpl, end of endp

Top webpl, end of webpl
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Property Description

Type of cut Shape of beam ends:

• Vertical in global system

• Perpend to top flange

• In Z of current plane: depends on
the position of the work plane

Position of web
plate

Adjusts the location of web plate. See
also Part position depth (page 595).

Thickness of
endplate

Set-back distance of beam ends.

Welds

Click the link below to find out more:

Tapered beam 2 (S45)
Tapered beam 2 (S45) creates a built-up beam with I shape. The beam can be
tapered or straight. You can control the size of the spliced material.

Parts created

• Web plates

• Top flange plates

• Bottom flange plates
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Use for

Situation More information
A simple, straight beam
built up from two flange
plates and a web plate.

A tapered beam built-up
from several spliced plates.

The points you pick
determine beam length.
You can adjust the length
on the Picture tab.

Before you start

Ensure that you have two points to pick.

Picking order

1. Pick a start and end point to indicate beam length:

Picture tab
Use the Picture tab to define the beam dimensions and location, relative to
the points picked.
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Field Description More information
1 Distance from the first point

picked to the end of the beam.
Negative value lengthen the
beam, positive values shorten
it.

 

2 Beam depth at the first end. The height of the
web or the entire
beam, depending
on the option
Depth measure
(page 2398).

3 Length of top flange plates. For example, to
have four one-
meter sections,
enter 4*1000.

Leave blank to
create the flange
or web from a
single plate.

4 Length of web plates.
5 Length of bottom flange.

6 Gap between the top flange
plates.

 

7 How much the beam slopes
from the horizontal.

Enter a
percentage.

8 Gap between the bottom flange
plates.

 

9 Distance from the last point
picked to the end of the beam.
Negative value lengthen the
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Field Description More information
beam, positive values shorten
it.

10 Beam depth at the second end. The height of the
web or the entire
beam, depending
on the option
Depth measure
(page 2398).

See also

Use the following options to define beam location and dimensions:

Option See also
Beam position to picked point
(page 2397)

Web plate orientation (page 2398)

Beam end alignment (page 2398)

Depth measure (page 2398)

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Finish Describes how the part
surface has been
treated.

 

Welds

Click the link below to find out more:

PEB Tapered Section (S94)
PEB Tapered Section (S94) creates a simple built-up beam or column
between two picked points. The shape can be straight or tapered.

Objects created

• Web plate

• Flange plates (2)

• Welds

Use for

Situation Description
Tapered built-up column.
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Situation Description
Straight built-up beam.

Selection order

1. Pick the starting point of the beam/column.

2. Pick the end point of the beam/colum.

Distance between the picked points is the beam or column lenght. You can
modify the other dimensions in the component dialog box.

Picture tab
Use the Picture tab to define the rotation and dimensions.

Parts tab
Use the Parts tab to define the part properties.

Option Description  
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Class Enter a number to group
the parts that the
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Option Description  
component creates. By
default, the class
number affects the color
in which the part is
shown in model views.

Welds

Click the link below to find out more:

Columns
Use these components to automatically create built-up columns:

Component Image Description
Tapered column
(S99)
(page 2356)

Creates a single built-up
column, which can be
straight or tapered.

Tapered column
2 (S44)
(page 2359)

Creates a built-up
column, which can be
straight or tapered.
Flange and web plates
can be spliced.

PEB Tapered
Section (S94)
(page 2354)

Creates a simple built-up
beam or column
between two picked
points. The shape can be
straight or tapered.

Tapered column (S99)
Tapered column (S99) creates a single built-up column, which can be straight
or tapered.

Parts created

• Vertical web plate

• Vertical outside flange plate

• Inclined inside flange plate
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• Top plate

• Flange stiffeners (2)

• Horizontal stiffeners (2)

Use for

Situation More information
A tapered built-up column with a stiffened
corner.

Flange stiffeners:

A straight built-up column.

Before you start

Ensure that you have a point to pick.

Picking order

1. Pick a point to indicate the location of column:
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Picture tab
Use the Picture tab to define the column dimensions.

Field Description
1 Extra length for top plate.
2 Extra length for outer flange.
3 Length of horizontal stiffener.
4 Top level of horizontal stiffener.
5 Bottom level of column.
6 Roof slope as a percentage, for example 10.
7 Distance from the top corner to the top of the

stiffener.
8 Distance from the top of the stiffener to the inner

corner of the web plate.
9 Web plate width at bottom.

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t b h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Parameters tab
Use the Parameters tab to define the plate size, distances and other
properties.

Field Description
Outer flange
profile

Profile size of plates. The file
std_flange_plates.dat defines the
available plate profiles.Inner flange

profile
Top plate
profile
Horizontal
stiffener
profile
Outer flange
splice
distance

If the plate is longer than the maximum
plate length (defined in
std_flange_plates.dat), Tekla
Structures creates a splice.Inner flange

splice
distance
Horizontal
stiffener
chamfer

Dimension of internal chamfer in
horizontal stiffener. (Default is 15.)

Orientation Rotates the column web relative to the
work plane.

Welds

Click the link below to find out more:

Tapered column 2 (S44)
Tapered column 2 (S44) creates a welded built-up column, which can be
tapered or straight. You can control the taper and the size of the spliced
material.
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Parts created

• Web plates

• Top flange plates

• Bottom flange plates

Use for

Situation Example
A simple straight column built up
from two flange plates and a web
plate.

A more complex tapered column,
with several plates forming the web,
top, and bottom flanges.

Before you start

Ensure that you have a point to pick.

Picking order

1. Pick the position of the column.

Picture tab
Use the Picture tab to define the column dimensions and location relative to
picked points.
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Field Description More information
1 Distance from the first point

picked to the end of the beam.
Negative value lengthen the
beam, positive values shorten
it.

 

2 Beam depth at the first end. The height of the
web or the entire
beam, depending
on the option
Depth measure
(page 2398).

3 Length of top flange plates. For example, to
have four one-
meter sections,
enter 4*1000.

Leave blank to
create the flange
or web from a
single plate.

4 Length of web plates.
5 Length of bottom flange.

6 Gap between the top flange
plates.

 

7 How much the beam slopes
from the horizontal.

Enter a
percentage.

8 Gap between the bottom flange
plates.

 

9 Distance from the last point
picked to the end of the beam.
Negative value lengthen the
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Field Description More information
beam, positive values shorten
it.

10 Beam depth at the second end. The height of the
web or the entire
beam, depending
on the option
Depth measure
(page 2398).

See also

Use the following options to define beam location and dimensions:

Option See also
Beam position to picked point
(page 2397)

Web plate orientation (page 2398)

Beam end alignment (page 2398)

Depth measure (page 2398)

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Finish Describes how the part
surface has been
treated.

 

Welds

Click the link below to find out more:

Frames
Use the following components to automatically create built-up frames, beams,
and columns:

Component Image Description
Tapered frame
comonor (S53)
(page 2363)

Creates a built-up frame
or parts of it. You can
control the taper and the
size of the spliced
material.

PEB Frame (S92)
(page 2366)

Creates a pre-
engineered building
frame to the selected
point. This component
uses existing
components to create
built-up columns and
rafters, base plates, knee
connection, splice
connections, and apex
connection.

Tapered frame comonor (S53)
Tapered frame comonor (S53) creates a built-up frame or parts of it. You can
control the taper and the size of the spliced material.
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Parts created

• Built-up columns with base plate and end plate (2)

• Built-up beams with end plates (2)

• Built-up beams with end plates (2)

Use for

Situation More information
Built-up frame.

1 Beam 1

2 Beam 2

Use the following options:

• Frame options to Column and beams

• Symmetry to Yes

Sloped built-up frame.

Use the following options:

• Frame options to Column and beams

• Symmetry to Yes

Only half of the frame.

Use the following options:

• Frame options to Column and first beam

• Symmetry to No

Built-up column with base plate and end plate.

Use the following options:

• Frame options to Column

• Symmetry to No
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Situation More information
Built-up beam (1) with end plates.

Use the following options:

• Frame options to First beam

• Symmetry to No
Built-up beam (2) with end plates.

Use the following options:

• Frame options to Second beam

• Symmetry to No

Limitations

Creates frame only in global x direction. Y direction is not possible.

Before you start

Ensure that you have a point to pick.

Picking order

1. Pick the position of the column.

2. Tekla Structures creates the frame.

Picture tab
Use the Picture tab to define the column dimensions and location relative to
the picked points.

Parts tab
Use the Parts tab to define the plate properties.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Column tab
Use the Column tab to define the column dimensions.

Column 2 tab
Use the Column 2 tab to define the base plate bolts.

Column 3 tab
Use the Column 3 tab to define the end plate bolts between column and
beam 1.

Beam 1 tab
Use the Beam 1 tab to define the beam 1 dimensions.

Beam 1_2 tab
Use the Beam 1_2 tab to define the end plate bolts between beam 1 and
beam 2.

Beam 2 tab
Use the Beam 2 tab to define the beam 2 dimensions.

Beam 2_2 tab
Use the Beam 2_2 tab to define the end plate bolts at the hip between beam 2
and beam 2.

Welds

Click the link below to find out more:

PEB Frame (S92)
PEB Frame (S92) creates a pre-engineered building frame to the selected
point. This component uses existing components to create built-up columns
and rafters, base plates, knee connection, splice connections, and apex
connection.

Objects created

• Built-up rafter (1 to 4 segments)

• Apex connection
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• Splice connections

• Knee connections (2)

• Built-up columns (1 to 4 segments)

• Base plate details (2)

Use for

Situation Description
Frame consisting of spliced columns
and spliced rafters.

Apex connection between two rafters
at the apex of a portal frame.

The first splice between the first
segment and the second segment of
rafter.

The second splice between the
second and the third segment of
rafter.
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Situation Description
Knee connection between the second
segment of column and the first
segment of rafter.

Column splice between the first and
the second segment of column.

Column base plate detail.

Selection order

1. Pick the point in which to insert the frame.

Picture tab
Use the Picture tab to define the frame dimensions.
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Parameters tab
Use the Parameters tab to define properties.

Connections and details
Use the following components to automatically create connections and details
for built-up beams and columns:

Component Image Description
Tapered beam
to column (197)
(page 2369)

Creates a connection
between a tapered beam
and a tapered column.

Tapered column
to beam (199)
(page 2372)

Creates a connection
between a tapered beam
and a tapered column.

Tapered beam
to beam (200)
(page 2374)

Creates a connection
between tapered beams.

Tapered column
base plate
(1068)
(page 2377)

Creates a base plate
detail to a tapered
column.

PEB Knee Joint
(S93)
(page 2395)

Creates a knee
connection between
rafter and column. The
end plate connection can
be located horizontally,
vertically, or
perpendicular to the
rafter.
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Tapered beam to column (197)
Tapered beam to column (197) creates a connection between a tapered
beam and a tapered column.

Parts created

• Plate to the top of the column

• Stiffeners (2 or 4)

• Plate to the beam flange (optional)

Use for

Situation Example
Connection created using two stiffeners and flange
and column plates. Plates are connected with four
bolts, but you can use any number.

Connection created using four stiffeners and a
column end plate. Does not create a separate plate
for the beam flange.

Before you start

• Create the tapered beam.

• Create the tapered column.

Selection order

1. Select the flange of the beam.

2. Select the web of the column.

Picture tab
Use Picture tab to define the dimenions of end plates and stiffeners, and
location of stiffereners.
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Parts tab
Use the Parts tab to define the properties of the column plate, the beam
plate, and the stiffeners.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Parameters tab
Use the Parameters tab to define whether column flange is fitted.

Option Description
Column flange fitted to be level with the
end plate.

Column flange perpendicular to column
axis.

Bolts tab
Use the Bolts tab to define the bolt properties.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tapered column to beam (199)
Tapered column to beam (199) creates a connection between a tapered
beam and a tapered column. All parts are optional.

To omit a part, set its thickness to 0 on the Parts tab.

Parts created

• End plates: to top of column and beam flange (optional)

• Web stiffeners (8) (optional)

• Triangular beam flange stiffener (optional)

• Triangular flange stiffeners (2) (optional)

• Beam web stiffeners (2) (optional)

Use for

Situation Example
Connection created using all possible parts.

Plates are connected using four bolts, but you can
use any number.

1 Beam flange stiffener

2 Beam web stiffeners

3 Web stiffeners

4 End plates

5 Flange stiffeners

Before you start

• Create the tapered beam.

• Create the tapered column.
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Selection order

1. Select the web of the beam.

2. Select the web of the column.

Picture tab
Use the Picture tab to define the dimensions of end plates and stiffeners, and
the location of stiffeners.

Parts tab
Use the Parts tab to define the properties of the column plate, the beam
plate, and the stiffeners.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Parameters tab
Use the Parameters tab to define whether the column flange and the corner
are fitted.

Column flange

Option Description
Column flange fitted to be level with the
end plate.
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Option Description
Column flange perpendicular to column
axis.

Corner

Option Description
Corner is fitted.

Corner is not fitted.

Bolts tab
Use the Bolts tab to define the bolt properties, number of bolts, and spacing.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tapered beam to beam (200)
Tapered beam to beam (200) creates a connection between tapered beams.

To omit a part, set its thickness to 0 on the Parts tab.

Parts created

• End plates (2)

• Flange stiffeners (4) (optional)

• Web stiffeners (8) (optional)
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Use for

Situation More information
This example is created with
all stiffeners and end plates.

Plates are connected with
eight bolts, but you can use
any number.

Before you start

Create the following parts:

• Tapered beam

• Another tapered beam

Selection order

1. Select the web of the first beam.

2. Select the web of the second beam.

Picture tab
Use the Picture tab to define the dimensions of end plates and stiffeners, the
location of stiffeners, and whether the beam flange is fitted.

Beam flange

Option Description
Beam flanges fitted to be level with the
end plates.

Beam flange perpendicular to beam
axis.
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Parts tab
Use the Parts tab to define the properties of end plates, web stiffeners, and
flange stiffeners.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Chamfer tab
Use the Chamfer tab to define the flange stiffener and the web stiffener.

Bolts tab
Use the Bolts tab to define the bolt properties, number of bolts, and the
spacing.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Tapered column base plate (1068)
Tapered column base plate (1068) creates a base plate detail to a tapered
column.

Parts created

• End plate

• Web stiffeners (4)

• Flange stiffeners (2) (optional)

• Anchor rods

• Extra plates connecting the anchor rods

• Bolts

• Welds

Use for

Situation Example
The detail uses four
web stiffeners.
Flange stiffeners are
not created.

The end plate is
connected using
four bolts, but you
can use any number.

The detail uses four
web stiffeners and
two flange stiffeners.

Before you start

Create a tapered column.

Selection order

1. Select the tapered column.

2. Pick a point to indicate the location of base plate.

Steel components reference 2377 Built-up Components



Part identification key

 Description
1 End plate
2 Web stiffener
3 Flange stiffener

Picture tab
Use the Picture tab to define the dimensions of the base plate and stiffeners,
the location of web stiffeners, and whether the column flange is fitted.

Dimensions

 Description
1 End plate edge distance to the column flange.
2 Web stiffener edge distance.
3 Flange stiffener height.
4 Flange stiffener width.
5 Web stiffener height.
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Flange stiffener shape

Option Description
Default

Line shape

AutoDefaults can change this option.
Line shape

Square shape

No stiffener

Flange cut

 Description Default
1 Define the flange cut from the base plate

edge.
2 mm

Flange stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.
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Flange stiffener chamfer type

Option Description
Default

No chamfers

AutoDefaults can change this option.
No chamfers

Line chamfer

Convex arc chamfer

Concave arc chamfer

Column flange

Option Description
Column flange fitted to be level with the
base plate.

Column flange is perpendicular to
column axis.

End plate offset

 Description
1 End plate offset from the main part bottom edge.
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Parts tab
Use the Parts tab to define the properties of the end plate, web stiffeners, and
flange stiffeners.

Parts

Option Description
End plate Thickness and width of the end plate.
Web stiffener Thickness and width of the web

stiffener.
Flange stiffener Thickness of the flange stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to define the bolt properties, number of bolts, and spacing.

Bolt group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange
or two.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Parameters tab
Use the Parameters tab to define a component.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is the same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Anchor rods tab
Use the Anchor rods tab to define the properties of the rod, nut, washer, cast
plate, and grout.
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Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
above or below the detail creation
point. This also affects the shim
plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description
1 Size or the length of the nut.
2 Size or the thickness of the washer.
3 Length of the anchor rod.
4 Length of the anchor rod above the base plate.
5 Distance between the cast plate and the base plate.
6 Length of the upper thread.

Anchor rod types

Option Description  
Default

Type 1

AutoDefaults can change
this option.

Type 1
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Option Description  
a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4
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Bolting direction

You can define the bolting direction if you have created the base plate with
bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.
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Create

  
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description
Extra profile 1 First extra profile by selecting it from

the profile catalog.
Extra profile 2 Second extra profile by selecting it

from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description
1 Edge distance of extra profile 1.

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.
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Option Description
Type 1

Type 2

Type 3

Edge distance of extra profile 2

Option Description Default
1 Distance of extra profile

2 from the axis of the
anchor bar.

Half of the nut
size or anchor bar
diameter
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Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Type 3

Type 4
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Option Description
Type 5

Type 6

Length of extra profile 2

 Description
1 Length of extra profile 2 from the axis of the anchor bar.

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.
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Option Description
Type 1

Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Height of circular extra
profile 1.

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

PEB Knee Joint (S93)
PEB Knee Joint (S93) creates a knee connection between a rafter and a
column. The end plate connection can be located horizontally, vertically, or
perpendicular to the rafter.

Objects created

• End plates

• Web stiffener

• Flange stiffeners (2)

• Inner stiffeners (4)

• Outer stiffeners (4)

• Diagonal stiffeners or web plate

• Welds

Use for

Situation Description
Vertical knee connection with
triangular flange stiffeners
and inner and outer stiffeners.
Web strengthened with
diagonal stiffeners.

Horizontal knee connection
with inner and outer
stiffeners. Web strengthened
with diagonal stiffeners.
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Selection order

1. Select the column.

2. Select the rafter.

3. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define the joint dimensions and the connection type.

Connection type

Select how the connection is created from the Connection type:

• Horizontal

• Perpendicular

• Vertical

Parts tab
Use the Parts tab to define the properties of plates and stiffeners.

Option Description Default
t, b, h Define the thickness,

width, and height of the
part.

 

Pos_No Define a prefix and a
starting number for the
part position number.

Enter the assembly
position number on the
second row.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Define the material
grade.

The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Define a name that is
shown in drawings and
reports.

 

Bolts tab
Use the Bolts tab to define the bolt properties, number of bolts, and spacing.

Welds

Click the link below to find out more:
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Tapered component properties
This section describes the options that appear in many of the tapered
component dialog boxes. In the table below, the Option column shows the
default option. To see all available options, click the link in the See also
column.

Option Description See also
Position of the
beam, relative to the
point picked.

Beam position to
picked point
(page 2397)

Orientation of the
web plates.

Web plate
orientation
(page 2398)

Alignment of beam
end cut.

Beam end
alignment
(page 2398)

How the depth of
the beam is
measured.

Depth measure
(page 2398)

Option to fit the
flanges of a tapered
column (1068).

Column fitting
option (1068)
(page 2399)

Option to fit the
flanges of a tapered
column (197).

Column fitting
option (197)
(page 2399)

Option to fit the
flanges of a tapered
column (199).

Column fitting
option (199)
(page 2399)

Option to fit corner
of tapered beam.

Corner fitting
option (199)
(page 2400)

Option to fit the
flanges of tapered
beams (200).

Column fitting
option (200)
(page 2400)
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Beam position to picked point
Use the following options to move the beam relative to the point picked.
Separate options may be available for both beam ends:

Option Description
Moves the beam so that the point is
located at the top of the top flange.

Moves the beam so that the point is
located at the bottom of the top flange.

Moves the beam so that the point is
located in the middle of beam cross-
section.

Web plate orientation
Use one of the following options to set the orientation of web plates for built-
up sections:

Option Description
Web plates cut perpendicular to the top
flange.

Web plates cut vertically.

Beam end alignment
Use one of the following options to cut the beam end:

Option Description
Cut is vertical or horizontal.

Cut is perpendicular to top flange.

Cut is relative to the current position of
the work plane.
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Depth measure
Use one of the following options to define beam depth:

Option Description
Depth calculated from outer surfaces of
top and bottom flanges.

Depth is the depth of the web.

Column fitting option (1068)
Use one of the following options to define how the column flange is cut in the
Tapered column base plate (1068) (page 2377) detail:

Option Description
Column flange fitted to be level with the
base plate.

Column flange is perpendicular to
column axis.

Column fitting option (197)
This option defines how the column flange is cut in the Tapered beam (S98)
(page 2347) connection.

Option Description
Column flange fitted to be level with the
end plate.

Column flange perpendicular to column
axis.
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Column fitting option (199)
This option defines how the column flange is cut in the Tapered column to
beam (199) (page 2372) connection.

Option Description
Column flange fitted to be level with the
end plate.

Column flange perpendicular to column
axis.

Corner fitting option (199)
This option defines how the corner is cut in the Tapered column to beam (199)
(page 2372) connection.

Option Description
Corner is fitted.

Corner is not fitted.

Column fitting option (200)
This option defines how the column flange is cut in the Tapered beam to beam
(200) (page 2374) connection.

Option Description
Beam flanges fitted to be level with the
end plates.

Beam flange perpendicular to beam
axis.
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5.16 Bracing components
You can use bracing components to automatically create complete bracing
connections. You can also use bracing elements (such as gusset plates and
stiffeners) that you can combine with other components to create your own
bracing connections

See also

Simple gusset plate connections (page 2403)

Corner bracing connections (page 2526)

Windbracing connections (page 2650)

Bracing connection elements (page 2656)

Glossary of parts
Bracing components create some or all of the following parts:

Part Image
Gusset plate

Connection plate

Cover plate
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Part Image
Tongue plate

A tongue plate
slots into a hollow
profile brace.

Clip angle

Shear tab

Seal plate

Seal plates seal
the ends of
hollow braces. In
this example they
are used with
chamfered
connection
plates.
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Part Image
Tee

Tees are formed
from T or cut I
profiles, or two
plates. Tees seal
hollow braces
and connect them
to another part
(e.g. a gusset
plate)
Stiffener

Simple gusset plate connections
Simple gusset plate connections automatically connect braces to a single main
part, using a gusset plate. Braces either connect directly to the gusset plate, or
use connection material. Tekla Structures includes the following simple gusset
plate connections:

Component Image Description
Welded gusset (10)
(page 2405)

Welds braces to a gusset
plate.

Bolted gusset (11)
(page 2413)

Bolts braces to a gusset
plate. Optional clip
angles or shear tabs.

Steel components reference 2403 Bracing components



Component Image Description
Bracing cross (19)
(page 2437)

Bolts twin-profile braces
to an existing gusset
plate.

Tube gusset (20)
(page 1655)

Bolts braces to a gusset
plate using connection
plates and optional
tongue plates. Seals
braces.

Tube crossing (22)
(page 2444)

Bolts braces to an
existing gusset plate
using connection plates
and optional tongue
plates. Seals braces.

Std bracing connection
(67) (page 2456)

Bolts 1 or 2 braces to a
gusset plate using
connection plates. Seals
hollow braces.

Wrapped cross (61)
(page 2464)

Bolts braces to an
existing gusset plate,
using connection plates
and clip angles.

Gusseted cross (62)
(page 2476)

Bolts braces to a gusset
plate using clip angles
and connection plates.
Welds or bolts the
gusset plate to the beam
or column.

Portal bracing (105)
(page 2498)

Connects up to three
hollow braces to a beam,
using a gusset plate and
tees.
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Component Image Description
Bolted gusset (196)
(page 2507)

Bolts braces to a gusset
plate. Optional clip
angles or shear tabs.

Welded gusset (10)
Welded gusset (10) connects 1 to 10 braces to a beam or column using a
gusset plate that is welded to the web or flange of the beam or column. Braces
are welded to the gusset plate.

Objects created

• Gusset plate

• Seal plates (hollow braces)

• Stiffeners

• Welds

• Cuts

Use for

Situation Description
Brace profile: T

Gusset plate is welded to the column
flange. Braces are welded to the
gusset plate.
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Situation Description
Brace profile: T

Gusset plate is welded to the column
web. Braces are welded to the gusset
plate.

Before you start

Create a beam or a column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
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NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.

Gusset plate dimensions

 Description
1 Define the gap distance between the gusset plate edge

and the main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the brace length on the gusset plate.
5 Define the distance between the braces.
6 Define the distance between the main part and the brace.

Gusset tab
Use the Gusset tab to define the gusset plate properties.

Gusset plate

Part Description
Gusset Thickness, width and height of the gusset plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.
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Option Description
The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions.

 Description
1 Distance between the gusset plate and the inner flange

of the main part.
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 Description
2 Horizontal distance between the gusset plate edge and

the flange of the main part.
3 Horizontal dimension of the chamfer.
4 Vertical dimension of the chamfer.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Brace conn tab
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Seal plate

Part Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.

Define the plate distance from the brace
outer edge.

Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Stiffeners

Part Description
Stiffener 1, Stiffener
2

Define the stiffener thickness.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener length

  
1 Distance between the stiffener edge and the gusset

plate edge.
2 Length of the stiffener.
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Stiffener dimensions

  
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bolted gusset (11)
Bolted gusset (11) connects 1 to 10 braces to a beam or column using a
gusset plate, which is bolted or welded to the beam or column. The braces are
bolted to the gusset plate. Clip angles can be created either at the ends of the
braces, or on each side.
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Objects created

• Gusset plate

• Clip angles or shear tabs (optional) that connect the gusset plate to the
beam or column

• Clip angles (optional) that connect the brace to the gusset plate

• Connection plates

• Seal plates (hollow braces)

• Stiffeners (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Brace profile: RHS

Gusset plate is bolted to the beam flange
using a clip angle. Braces are slotted around
the gusset plate and attached to it using bolts
and clip angles.

Brace profile: Tube

Gusset plate is welded to the beam web.
Brace is notched around the gusset plate and
pinned to it.

Brace profile: T

Gusset plate is welded to the beam flange.
Brace is bolted to the gusset plate.
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Situation Description
Brace profile: L

Gusset plate is welded to the column flange.
Brace is bolted to the gusset plate.

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Clip angle
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NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.

Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the distance between the braces.
5 Define the distance between the main part and the brace.
6 Define the distance between the clip angle or connection

plate edge and the gusset plate edge.

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.
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Option Description
Default

Gusset plate is parallel to the main
part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.

Gusset plate dimensions

Option Description
Default

Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

AutoDefaults can change this option.
Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

Gusset plate runs through the main
part.

Define the gusset plate extension
dimension.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
and clip angle properties and orientation.

Plates

Option Description
Gusset Thickness, width and height of the gusset plate.
Connection
plates

Thickness and width of the connection plate.

L profile Select the clip angle profile from the profile catalog.

Steel components reference 2417 Bracing components



Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate position on the column or beam

Option Description
Select the gusset position.

The default option is parallel to the
brace.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions, and the angle limit for
parallel bracing.
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 Description
1 Distance between the connection plate and the inner

flange of the main part.
2 Horizontal distance between the gusset plate edge and

the flange of the main part.
3 Horizontal dimension of the chamfer.
4 Vertical dimension of the chamfer.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Brace conn
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Seal plate

Part Description
Seal plate Thickness of the seal plate.

Steel components reference 2421 Bracing components



Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.
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Option Description
Select the brace notch shape.

Define the radius for the round
shape.

Define the plate distance from the
brace outer edge.

Select whether to create bevel cuts at
the brace ends or whether to create a
square brace end.

Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Parts

Part Description
Stiffener 1, Stiffener 2 Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener length

  
1 Define the distance between the stiffener edge and the

gusset plate edge.
2 Define the length of stiffener.

Stiffener dimensions

  
1 Define the width of the stiffener.
2 Define the length of the stiffener base.
3 Define the length of the skew part of the stiffener.
4 Define the distance from the stiffener center line.
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5 Define the vertical distance between the stiffener base

and the skew part.

Gusset bolts tab
Use the Gusset bolts tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.

Bolt group dimensions on gusset plate

  
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt
to the edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if
there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt

group position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal

bolt group position.
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 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Bolt group position

Gusset horizontal position and offset options only affect the following
situation, where the gusset is connected to the column flange. When the
position is middle, the bolt group offset is calculated from the center line of
the column, for example.

Gusset vertical position and offset options affect the bolt group connecting the
gusset directly to the flange and also the bolt groups connecting the gusset to
the clip angle or connection plate.

NOTE The following examples show only some of the available options. You
will find more options on the Gusset bolts tab.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.
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Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile, the clip angles
are welded to the main part and bolted to the
secondary part. Otherwise the clip angles are bolted to
both parts.
Main part is bolted and secondary part is welded.

Main part is welded and secondary is part bolted.

Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

Option Description
Default

Bolts are not created in the gusset plate.

AutoDefaults can change this option.
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1
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Option Description
Bolting direction 2

Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if there
are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Select how to measure the dimensions for vertical bolt
group position.

5 Dimension for vertical bolt group position.
6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run
from left to right and from top to bottom.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option Option

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
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Option Description
Bolting direction 1

Bolting direction 2

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Part

Option Description
L profile Select the clip angle profile from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Define the edge distance between the clip angle and the
brace.

5 Select how to measure the dimensions for vertical bolt group
position.

6 Dimension for vertical bolt group position.
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Clip angle position

Option Description
Select the clip angle position.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Bracing cross (19)
Bracing cross (19) bolts one or more twin-profile braces to an existing gusset
plate.

TIP To create a gusset plate, use the Standard gusset (1065) (page 2120)
component, or create a countour plate.

Objects created

• Bolts

• Cuts

• Welds

Use for

Situation Description
Brace profile: L

Braces are bolted directly to the
gusset plate.

Brace profile: W

Braces are notched around the gusset
plate and bolted to the gusset plate.

Before you start

Create a gusset plate, and 1 to 10 braces.
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Selection order

1. Select the main part (gusset plate).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab define the flange cut dimension.

 Description
1 Define the length of the flange cut.

Parameters tab
Use the Parameters tab to cut the brace flange.

Option Description
Fit secondary Select whether the secondary part is

fitted.

Selecting Yes fits the secondary part
according to the bolt distances.
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Option Description
Cut other side flanges Select whether to create a triangular

cut on the opposite side of the flange.

1. Vertical cut dimension.

2. Cut angle.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.
4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tube crossing (22)
Tube crossing (22) bolts one or more braces to an existing gusset plate,
directly, or using connection plates. Seals braces.

To create a gusset plate, use the Standard gusset (1065) (page 2120)
component or the command for creating a contour plate.

Objects created

• Connection plates

• End plates

• Tongue plates

• Cover plates

• Bolts

• Welds
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Use for

Situation Description
Brace profile: RHS, W

RHS brace is bolted to the gusset
plate using a tongue plate. W profile
braces are bolted directly to the
gusset plate.

Before you start

Create a gusset plate, and 1 to 10 braces.

Selection order

1. Select the main part (gusset plate).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the connection.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Part identification key

 Description
1 Connection plate
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 Description
2 End plate

Picture tab
Use the Picture tab to define the plate and brace dimensions.

Dimensions

 Description
1 Define the length of the edge of the connection plate.
2 Define the brace length on the connection plate.
3 Define the end plate edge distance from the gusset plate.

Brace conn tab
Use the Brace conn tab to control the connection plate, end plate, tongue
plate, and cover plate properties.

Brace connection

Option Description
Connection plate Thickness, width and height of the

connection plate.
End plates Thickness, width and height of the end

plate.
Tongue plate Thickness of the tongue plate.
Cover plate Thickness, width and height of the cover

plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace connection types

Define how the brace is connected to the connection plate.

Option Descripion
Default

Brace is welded

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

If needed, you can create a cut in the bracing.
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Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.

Gusset and connection plate distance

Define the distance between the gusset plate and the connection plate.

Round cut in bracing

If needed, you can create a round cut in the bracing. Enter the radius value.

NOTE The following examples show only some of the available options. You
will find more options on the Brace conn tab.

Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Connection plate is cut.

Connection plate is cut, but the part
of the connection plate created inside
the bracing is not deleted.
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Option Description
If you cut the connection plate, you
can define the size of the gap
between the brace and the
connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.

Option Description
Default

One connection plate.

AutoDefaults can change this option.
Two connection plates and a middle
end plate at the ends of the
connection plates.
If a middle end plate is created, you
can define the width of the end plate.

Select the middle end plate position.

Connection plate chamfer

Define whether the connection plate is chamfered.

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
Chamfers are created.

If you create chamfers, define the
vertical and horizontal chamfer
dimensions.

End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.
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Option Description
Default

Square end plate.

AutoDefaults can change this option.
Round end plate.

End plate edge distance from the
brace outer edge.

End plate chamfer

Define the end plate chamfer type and horizontal and vertical dimensions.

Brace bolts 1 tab
Use the Brace bolts 1 tab to control the bolts that connect the braces to the
gusset plate.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Select how to measure the dimensions for vertical bolt
group position.

5 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Rib plates tab
Use the Rib plates tab to control the cross plate and the cover plate
properties and position.

Plates

Option Description
Cross plate Thickness, width and height of the

cross plate.
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Option Description
Cover plate Thickness, width and height of the

cover plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt group dimensions

  
1 Number of bolts.
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2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for the horizontal bolt group position.
5 Vertical dimension of the chamfer.
6 Horizontal dimension of the chamfer.

Cross and cover plate position

Option Description
Default

Cover plate is created on both sides
of the cross plate.

AutoDefaults can change this option.
Cover plate is created on both sides
of the cross plate.

Cover plate is created on the bottom
of the cross plate.

Cover plate is created on top of the
cross plate.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Std bracing connection (67)
Std bracing connection (67) connects 1 or 2 braces to a beam or column
using a gusset plate and connection plates. Seals hollow and tube profile
braces. You can define different properties for the upper and lower brace
connections.

Objects created

• Gusset plate

• Connection plates

• Seal plates

• Bolts

• Welds

Use for

Situation Description
Brace profile: RHS

Gusset plate is welded to the column
web. Brace is bolted to the gusset
plate using chamfered connection
plates.

Before you start

Create a beam or column, and 1 or 2 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Click the middle mouse button to create the component.
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Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Seal plate

Picture tab
Use the Picture tab to define the main part edge dimension to the bolt group.

Dimensions

 Description
1 Define the main part edge dimension to the bolt group.
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Parts tab
Use the Parts tab to define the plate properties. You can define the plate
properties for both braces.

Plates

Option Description
Connection plate Thickness, width and height of the

connection plate.
Seal plate Thickness, width and height of the

seal plate.
Seal plate profile Select the seal plate profile from the

profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the gusset plate chamfer dimensions.
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Chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Brace bolts 1 tab
Use the Brace bolts 1 tab to define the bolt properties for the first brace.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Steel components reference 2460 Bracing components



Brace bolts 2 tab
Use the Brace bolts 2 tab to define the bolt properties for the second brace.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Gusset tab
Use the Gusset tab to define the gusset plate dimensions and properties.

Plate

Part Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Gusset dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

3 Horizontal chamfer dimension.
4 Vertical chamfer dimension.
5 Upper angle of the slotted hole created in the gusset

plate.
6 Lower angle of the slotted hole created in the gusset plate.

Gusset plate position

Select the gusset plate position.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Wrapped cross (61)
Wrapped cross (61) bolts one or more braces to an existing gusset plate,
using connection plates and clip angles.

Objects created

• Connection plates

• Clip angles

• Shear tabs

• Shim plates

• Bolts

• Welds

Use for

Situation Description
Brace profile: W

Braces are bolted to the gusset plate
using clip angles and connection
plates.

Before you start

Create a gusset plate, and 1 to 10 braces.
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Selection order

1. Select the main part (gusset).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary part (third brace).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Connection plate
2 Clip angle

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to define the gap dimension between the gusset plate and
the brace.
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 Description
1 Define the dimension between the gusset plate and the brace.

Brace conn tab
Use the Brace conn tab to define the connection plate, clip angle, and filler
plate properties. Select whether twin profiles are used for the angle
connection.

Parts

 Description
Connection plate Thickness and width of the connection plate.
Conn. plate profile Select the connection plate profile from the profile

catalog.
Upper clip angle Select the clip angle profile from the profile catalog.
Lower clip angle Select the clip angle profile from the profile catalog.
Filler plate Thickness of the filler plate.
Upper shear tab Thickness, width, and height of the upper shear tab.
Lower shear tab Height of the lower shear tab.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created.

Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Clip angle creation

Define whether the braces are attached to the gusset plate using clip angles or
shear tabs, and specify the number of clip angles to create. The default option
is to create two clip angles below the brace web.
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Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.
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Option Description
Select the connection type (weld or
bolt) between the gusset plate and
the L profile.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension

Shim plates tab
Use the Shim plates tab to define shim plate properties.

Plates

Option Description
Shim plate 1, Shim plate 2,
Shim plate 3

Thickness, width and height of the shim plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position and number

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 De
1 Define the gap between the brace and connection plate.
2 Define how many shim plates are created at the top and

bottom flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the
top flange, and you want to use Shim plate 1 twice and Shim
plate 2 once, enter 1 1 2. The first number you enter is the
shim plate closest to the brace flange.

Brace bolts tab
Use the Brace bolts tab to control the bolts that connect the braces to the
gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center
line of the secondary part.
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 Description
• Below: From the lower edge of the secondary part to the

lowest bolt.

6 Select the bolt type.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Dimension for vertical bolt group position.
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Vertical bolt position

Option Description
Bolt position from the L profile edge.

Bolt position from the secondary part
center line.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Create welds

Gusseted cross (62)
Gusseted cross bolts 1 to 10 braces to a beam or column using a gusset plate.
The gusset plate is welded or bolted to the beam or column. Braces are bolted
to the gusset plate using clip angles and connection plates.

Objects created

• Gusset plate

• Clip angles

• Connection plates

• Filler plates

• Shim plates

• Stiffeners

• Bolts

• Cuts

• Welds

Use for

Situation Description
Brace profile: W

Gusset plate is welded to the beam.
Different connection materials are
used for each brace.
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Situation Description
Brace profile: W

Gusset plate is welded to the beam.
Braces are bolted to the gusset plate
using connection plates and clip
angles.

Brace profile: W

Gusset plate is welded to the beam.
Different connection materials are
used for each brace.

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.
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Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the distance between the braces.
5 Define the distance between the main part and the brace.
6 Define the distance between the clip angle or connection

plate edge and the gusset plate edge.
7 Define the gap distance between the gusset plate edge and

the brace.

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.
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Option Description
Default

Gusset plate is parallel to the main part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.

Gusset plate is parallel to the brace, without a
base plate.

Gusset plate dimensions

Option Description
Default

Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

AutoDefaults can change this option.
Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

Gusset plate runs through the main
part.

Define the gusset plate extension
dimension.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
connection plate, and clip angle properties and orientation.

Plates

Option Description
Gusset Thickness, width and height of the gusset plate.
Connection plates Thickness and width of the connection plate.
L profile Select the clip angle profile from the profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions, and the angle limit for
parallel bracing.

  
1 Distance between the connection plate and the inner flange of

the main part.
2 Horizontal distance between the gusset plate edge and the

flange of the main part.
3 Horizontal dimension of the chamfer.
4 Vertical dimension of the chamfer.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.
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 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Brace conn tab
Use the Brace conn tab to define the connection plate, clip angle, and filler
plate properties. Select whether twin profiles are used for the angle
connection.

Parts

Part Description
Connect plate Thickness and width of the

connection plate.
Connection profile Select the profile from the profile

catalog.
L prof1 to gus. pl., L prof2 to gus.pl. Select the clip angle profile from the

profile catalog.
Filler plate Thickness and height of the filler

plate.
Plate1 to gus.pl Thickness, width and height of the

plate.
Plate2 to gus.pl Height of the plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in

Steel components reference 2484 Bracing components



Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created.

Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Select the filler plate creation side.

You can use this option when you have
selected to create two connection plates.

Clip angle creation

Define whether the braces are attached to the gusset plate using clip angles or
shear tabs, and specify the number of clip angles to create. The default option
is to create two clip angles below the brace web.
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Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.
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Option Description
Select the connection type (weld or
bolt) between the gusset plate and
the L profile.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension

Shim plates tab
Use the Shim plates tab to define shim plate properties.

Plates

Option Description
Shim plate 1, Shim plate 2, Shim
plate 3

Thickness, width and height of the
shim plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position and number

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 Description
1 Define the gap between the brace and connection plate.
2 Define how many shim plates are created at the top and

bottom flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the
top flange, and you want to use Shim plate 1 twice and Shim
plate 2 once, enter 1 1 2. The first number you enter is the
shim plate closest to the brace flange.

Gusset conn tab
Use the Gusset conn tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal bolt

group position.

 Description
1 Location where the bolts should be attached.

Steel components reference 2489 Bracing components



 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

Main part is bolted and secondary part is
welded.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile, the clip
angles are welded to the main part and bolted
to the secondary part. Otherwise the clip
angles are bolted to both parts.
Main part is bolted and secondary part is
welded.

Main part is welded and secondary is part
bolted.

Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

 Description
Default

Bolts are not created in the gusset plate.

AutoDefaults can change this option.
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 Description
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Parts

Part Description
Stiffener 1, Stiffener 2 Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener length
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1 Define the distance between the stiffener edge and the

gusset plate edge.
2 Define the length of stiffener.

Stiffener dimensions

 Description
1 Define the width of the stiffener.
2 Define the length of the stiffener base.
3 Define the length of the skew part of the stiffener.
4 Define the distance from the stiffener center line.
5 Define the vertical distance between the stiffener base and

the skew part.

Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.
6 Select the bolt type.

Vertical bolt position

Option Description
Bolt position from the L profile edge.

Bolt position from the secondary part
center line.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Option Option Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Portal bracing (105)
Portal bracing (105) connects up to 3 hollow braces to a beam or column
using a gusset plate and tees.

Objects created

• Gusset plate

• Tees

• Bolts

• Welds

Use for

Situation Description
Brace profile: Tube

Gusset plate is welded to the beam.
Braces are bolted to the gusset plate
using tees.

Brace profile: RHS

Gusset plate is welded to the column.
Braces are bolted to the gusset plate
using tees.
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Limitations

The braces must be in the same plane.

Before you start

Create a beam, and up to three braces all in the same plane.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary part (third brace).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Tee

Picture tab
Use the Picture tab to define the tee dimension from the gusset plate edge.
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 Description
1 Define the tee edge dimension.

Parts tab
Use the Parts tab to define the properties of the gusset plate, and the tees at
the ends of the braces. You can define the tees separately for each brace.

Parts

Option Description
Gusset Thickness, width and height of the gusset plate.
Tee flange To have Tekla Structures use two plates to create

the tee, leave the tee profile on the Parts tab
empty. You must enter the thickness, width, and
height dimensions for the tee flange and web
instead.

Define the thickness, width and height of the tee
flange.

Tee web To have Tekla Structures use two plates to create
the tee, leave the tee profile on the Parts tab
empty. You must enter the thickness, width, and
height dimensions for the tee flange and web
instead.

Define the thickness, width and height of the tee
web.
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Option Description
Tee profile Select the tee profile from the profile catalog.

You can use a T profile or an I profile.

If you use an I profile, the component creates the
tee by cutting the I profile. You must specify where
to cut the I profile, using the tee depth option on
the Parameters tab.

Parameters tab
Use the Parameters tab to define the tee dimensions, clearances, gusset plate
position and chamfers.

Option Description
Min. cut angle (0-90 deg) Define the minimum cut angle.
Define welds for each Tee Select whether to use welds for each

tee.
Define bolts for each Tee Select whether to use bolts for each

tee.

Gusset position

Select the gusset position on the brace.

Tee position

Select the tee position on the gusset.
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Gusset chamfer

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Chamfers are created.

Tee dimensions

Define the tee dimensions for each brace.

 Description
1 Tee length
2 Tee depth

Bolt group alignment

Select whether bolt groups are aligned.
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Gusset position on the main part

Option Description
Default

Gusset is positioned according to the
defined distances.

AutoDefaults can change this option.

Gusset is positioned according to the
defined distances.

Gusset is centered to the center of
the bolt group.

Gusset is centered to the center of
the connection origin.
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Bolts 1 / Bolts 2 / Bolts 3 tabs
Use the Bolts 1, Bolts 2 and Bolts 3 tabs to control the bolts that connect the
first, the second, and the third brace to the gusset plate.

Bolt group dimensions

 Description
1 Plate edge distance to the main part web.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bolted gusset (196)
Bolted gusset (196) connects 1 to 10 braces to a beam or column using a
gusset plate, which is bolted or welded to the beam or column. The braces are
bolted to the gusset plate. Clip angles can be created either at the ends of the
braces, or on each side.

Objects created

• Gusset plate

• Clip angles or shear tabs (optional) that connect the gusset plate to the
beam or column

• Clip angles (optional) that connect the brace to the gusset plate

• Connection plates

• Seal plates (hollow braces)

• Stiffeners (optional)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Brace profile: RHS

Gusset plate is bolted to the beam
flange using a clip angle. Braces are
slotted around the gusset plate and
attached to it using bolts and clip
angles.

Brace profile: Tube

Gusset plate is welded to the beam
web. Brace is notched around the
gusset plate and pinned to it.

Brace profile: T

Gusset plate is welded to the beam
flange. Brace is bolted to the gusset
plate.

Brace profile: L

Gusset plate is welded to the column
flange. Brace is bolted to the gusset
plate.

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).
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2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

Part identification key

  
1 Gusset plate
2 Clip angle

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and the

main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the distance between the braces.
5 Define the distance between the main part and the brace.
6 Define the distance between the clip angle or connection plate

edge and the gusset plate edge.

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.

Option Desription
Default

Gusset plate is parallel to the main
part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.
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Gusset plate chamfer

Define the gusset plate chamfer type and dimensions, and the angle limit for
parallel bracing.

 Description
1 Distance between the connection plate and the inner flange

of the main part.
2 Horizontal distance between the gusset plate edge and the

flange of the main part.
3 Horizontal dimension of the chamfer.
4 Vertical dimension of the chamfer.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
clip angle properties and orientation, and angle limit for parallel bracing.
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Plates

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and width of the

connection plate.
L profile Select the clip angle profile from the

profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
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Option Description
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.
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Option Description
The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.
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Gusset plate position on the column or beam

Option Description
Select the gusset position.

The default option is parallel to the
brace.

Brace conn tab
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Seal plate

Option Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.

Define the plate distance from the
brace outer edge.

Select whether to create bevel cuts at
the brace ends or whether to create a
square brace end.

Gusset bolts tab
Use the Gusset bolts tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.
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Bolt group dimensions

  
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt
to the edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if
there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt

group position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal

bolt group position.

  
1 Location where the bolts should be attached.
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2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Clip angle attachment type

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.

Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

Option Description
Default

Bolts are not created in the gusset
plate.

AutoDefaults can change this option.
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Option Description
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if there
are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Select how to measure the dimensions for vertical bolt
group position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Attributes for Tube crossing (22)

With hollow secondary parts, Bolted gusset (196) automatically removes
connection objects created between the gusset plate and the hollow
secondary part, and then uses the Tube crossing (22) connection between the
gusset plate and the hollow secondary part.

To define which property file that Tube crossing (22) uses, go to the Brace
bolts 2 tab, and enter the property file name in the Attributes for Tube
crossing (22) box.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Part

Option Description
L profile Select the clip angle profile from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Define the edge distance between the clip angle and the brace.
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 Description
5 Select how to measure the dimensions for vertical bolt group

position.
6 Dimension for vertical bolt group position.

Clip angle position

Option Description
Select the clip angle position.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds
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Corner bracing connections
Use corner bracing connections to automatically connect bracing where two
parts meet to form a corner, for example:

• Beam and column

• Column and base plate

• Beam and extended end plate

• Two beams and a column

Tekla Structures includes the following corner bracing connections:

Component Image Description
Corner tube
gusset (56)
(page 2528)

Bolts braces to a gusset
plate using connection
plates and optional tongue
plates. Seals hollow braces.

Corner bolted
gusset (57)
(page 2544)

Bolts braces to a gusset
plate. Welds the gusset
plate to one or both of the
parts that form the corner.
Seals hollow braces.

Wraparound
gusset (58)
(page 2559)

Bolts or welds braces to a
gusset plate. Option to
wrap the gusset plate
around a third part, usually
a column. Option to use
connection material to
connect the gusset plate to
the main parts.

Hollow brace
wraparound
gusset (59)
(page 2584)

Bolts or welds hollow
braces to a gusset plate.
Option to wrap the gusset
plate around a third part,
usually a column. Option to
use connection material to
connect the gusset plate to
the main parts.

Wraparound
gusset cross
(60) (page 2605)

Bolts or welds braces to a
gusset plate. Option to use
clip angles. Option to wrap
the gusset plate around a
third part, usually a column.
Option to use connection
material to connect the
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Component Image Description
gusset plate to the main
parts.

Corner
wrapped gusset
(63) (page 2627)

Bolts braces to a gusset
plate using clip angles and
connection plates. Welds
the gusset plate to one of
the main parts.

Bent gusset
(140)
(page 2646)

Connects braces in different
planes to one or more
beams or columns that are
in different planes.Creates a
gusset plate that is bent
along two different bending
lines. Seals hollow braces.

Heavy brace
(165)
(page 2648)

Bolts a single brace to a
gusset plate where two
parts meet to form a
corner. Rib plates
strengthen the connection.

Corner tube gusset (56)
Corner tube gusset (56) connects 1 to 10 hollow braces to the corner where
two parts meet, using a gusset plate. Bolts braces to the gusset plate using a
connection plate or tongue plate slotted into the brace. Option to create extra
connection plates. Seals braces.

Objects created

• Gusset plate

• Connection plates

• Seal plates

• Tongue plates (optional)

• Cover plates (optional)

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
Brace profile: RHS

Framing type: Column and extended
end plate

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using tongue plates.

Brace profile: RHS

Framing type: Column and beam

Gusset plate is welded to the column
flange. Braces are bolted to the
gusset plate using tongue plates, and
connection and cover plates.

Before you start

Create two parts that form a corner, and 1 to 10 braces.

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner (Tekla Structures connects
the gusset plate to this part).

6. Click the middle mouse button to create the connection.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Seal plate

Picture tab
Use the Picture tab to define the gusset plate position and shape.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part (first part that forms the corner) .
2 Define the edge distance between the connection plate and

the last secondary part.
3 Define the distance between the connection plates.
4 Define the edge distance between the connection plate and

the main part.
5 Define the gap distance between the gusset plate edge and

the secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the length of the edge of the connection plate.
9 Define the brace length on the connection plate.
10 Define the edge distance between the seal plate and gusset

plate.

Steel components reference 2531 Bracing components



Gusset tab
Use the Gusset tab to control the gusset plate properties.

Gusset plate

Option Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
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Option Description
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Steel components reference 2533 Bracing components



Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Gusset plate fitting

Option Description
Select whether the gusset is fitted to
the last selected secondary part.

Gusset welding

Weld 1 is used to weld the gusset part to the main part and weld 4 is used for
welding the gusset to the last secondary part.

Option Description
Default

Gusset plate is welded to the main part.

AutoDefaults can change this option.
Gusset plate is welded to the main part.
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Option Description
Gusset plate is welded to the secondary part.

Gusset plate is welded to the main part and
the secondary part.

Brace conn tab
Use the Brace conn tab to control connection plate, seal plate, tongue plate,
and cover plate properties.

Plates

Option Description
Connection plate Thickness, width and height of the

connection plate.
Seal plates Thickness, width and height of the

seal plate.
Tongue plate Thickness of the tongue plate.
Cover plate Thickness, width and height of the

cover plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Brace connection types

Define how the brace is connected to the connection plate.

Option Description
Default

Brace is welded.

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.

Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Round cut

Enter the radius value.
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Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Brace is notched.

Connection plate is cut.

Connection plate is cut, but the part of the
connection plate created inside the
bracing is not deleted.
If you cut the connection plate, you can
define the size of the gap between the
brace and the connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.

Option Description
Default

One connection plate

AutoDefaults can change this option.
One connection plate

Two connection plates

Connection plate chamfer

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
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Option Description
No chamfers are created.

Chamfers are created.

If you create chamfers, define the vertical
and horizontal chamfer dimensions.

End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.

Option Description
Default

Square end plate.

AutoDefaults can change this option.
Square end plate.

Round end plate.

End plate edge distance

Option Description
End plate edge distance from the
brace outer edge.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description
Stiffener 1

Stiffener 2

Thickness of the stiffener.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate

edge.
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 Description
2 Length of stiffener.

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.

Bolt group dimensions on connection plates
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Gusset side and brace side bolt type

Select the bolt type to define the location where the bolts should be attached.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Corner bolted gusset (57)
Corner bolted gusset (57) connects 1 to 10 braces to the corner where two
parts meet, using a gusset plate. Welds the gusset plate to the first selected
part that forms the corner. Creates optional clip angles, either at the ends of
the braces, or on each side. Seals RHS or tube braces.

Objects created

• Gusset plate

• Clip angles (optional)

• Stiffeners

• Brace bolts

• Angle bolts

• Welds
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Use for

Situation Description
Brace profile: RHS

Framing type: Column and extended
end plate

Gusset plate is welded to an extended
end plate. Braces are pinned to the
gusset plate.

Brace profile: T, L

Framing type: Column and extended
end plate

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate.

Before you start

Create two parts to form a corner, and 1 to 10 braces.

Selection order

1. Select the main part (the first part that forms the corner).

The gusset plate is connected to this part.

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. Click the middle mouse button to create the connection.
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NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Part identification key

 Description
1 Gusset plate

Picture tab
Use the Picture tab to define the gusset plate position and shape.

Dimensions
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 Description
1 Define the gap distance between the gusset plate edge and the

main part (first part that forms the corner).
2 Define the edge distance between the last secondary part and

the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the main

part.
5 Define the gap distance between the gusset plate edge and the

secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.

Gusset tab
Use the Gusset tab to control the gusset plate properties.

Gusset plate

Option Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Steel components reference 2547 Bracing components



NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.
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Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension

2. Horizontal notch dimension.

3. Notch angle.

Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut
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Option Description
Round cut

Enter the radius value.

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Gusset plate fitting

Option Description
Select whether the gusset is fitted to
the last selected secondary part.
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Gusset welding

Option Description
Default

Gusset plate is welded to the
secondary part.

AutoDefaults can change this option.
Gusset plate is welded to the
secondary part.
Gusset plate is welded to the main
part.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description
Stiffener 1

Stiffener 2

Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate

edge.
2 Length of stiffener.

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.

Steel components reference 2552 Bracing components



Brace bolts 1 / Brace bolts 2 tabs
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and subsequent braces to the gusset plate.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
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perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Angle bolts tab
Use the Angle bolts tab to define the clip angles and to control the bolts that
connect the clip angle to the gusset plate.

Part

Part Description
L profile Select the clip angle profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Clip angle edge distance to the brace edge.
5 Select how to measure the dimensions for horizontal bolt

group position.
6 Dimension for horizontal bolt group position.

Clip angle position

Option Description
Select the clip angle position.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Wraparound gusset (58)
Wraparound gusset (58) connects 1 to 10 braces to the corner where two or
three parts meet, usually two beams and a column, using a gusset plate. The
gusset plate can be wrapped around the third part, usually a column. Bolts or
welds the brace web to the gusset plate using connection plates, and bolts or
welds the brace flange to the gusset plate using clip angles. Either connects
the gusset plate directly to the two beams, or uses clip angles or shear tabs, or
connection plates. The brace profile can be C or W.

Objects created

• Gusset plate

• Clip angles

• Shear tabs

• Connection plates

• Shim plates

• Bolts

• Cuts

• Welds

Use for

Situation Description
Brace profile: W

Framing type: Beam and column

Gusset plate is bolted to the column
flange using a clip angle. Braces are
bolted to the gusset plate using a
connection plate and clip angles.

Before you start

Create 2 or 3 parts that form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Selection order

1. Select the main part (the first part that forms the corner).

Steel components reference 2559 Bracing components



2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. If needed, select the column to wrap the gusset plate around the column
where two beams and the column meet.

7. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle

Picture tab
Use the Picture tab to define the shape of the gusset plate, location of the
braces and clip angles, and the work point location.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the edge distance between the last secondary part and

the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the

main part.
5 Define the gap distance between the gusset plate edge and

the secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the gap distance between the gusset plate edge and

the brace.
9 Define the gusset plate edge distance in relation to the work

point.
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 Description
10 Define the gusset plate edge distance to the flange of the

third part.
11 Define the clip angle edge distance in relation to the work

point.
12 Define the clip angle edge distance to the flange of the third

part.

Work point position

Option Description
Select the work point position. The
default position is the point where the
two main parts intersect.

Tekla Structures uses the work point
of a component to calculate check
dimensions and part position
dimensions in drawings.

Gusset tab
Use the Gusset tab to define gusset plate, connection plate and clip angle
properties.

Parts

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and height of the

connection plates.
Upper clip angle

Lower clip angle

Select the clip angle profile from the
profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is connected to the main
part with a clip angle.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Erection clearance

You can define the clearance for both the main part and the last secondary
part connection plates or clip angles.
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Gap dimensions

Option Description
Define the gap dimension between
the gusset plate and the connection
plates or the clip angles.

Connection plate cut through dimensions

 Description
1 Connection plate cut through length
2 Chamfer radius
3 Horizontal chamfer dimension
4 Vertical chamfer dimension

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.
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Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Notch angle

Option Description
Default

Square notch
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Option Description
If the gusset plate clashes with the
column, the gusset plate is notched to
wrap around the column.

AutoDefaults can change this option.
Square notch

Bevel notch

Notch chamfer type

Option Description
Default

Bevel chamfer

AutoDefaults can change this option.
No chamfer

Notched edges are parallel to the
edges of the gusset plate.
Bevel chamfer

Rounded chamfer calculated as a
quarter of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.
Rounded chamfer calculated as a
three quarters of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.

The center point of the circle is the
corner of the notch.
Corner of the gusset plate is beveled.

Corner of the gusset plate is not
notched or chamfered.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer
2 Vertical dimension of the chamfer

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Brace conn tab
Use the Brace conn tab to control the properties of connection plates, clip
angles, filler plates, and shear tabs, and the angle connection profile.
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Plates

Option Description
Connection plate Thickness and width of the

connection plate.

Select the connection plate profile.
Upper clip angle

Lower clip angle

Select the clip angle profile.

Filler plate Thickness, width and height of the
filler plate.

Upper shear tab Thickness, width and height of the
upper shear tab.

Lower shear tab Height of the lower shear tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created.
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Option Description
Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Clip angle creation

Option Description
Define whether the braces are
attached to the gusset plate using clip
angles or shear tabs, and specify the
number of clip angles to create.

The default option is to create two
clip angles below the brace web.

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.
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Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.

Select the connection type (weld or
bolt) between the gusset plate and
the L profile.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension

Shim plates
Use the Shim plates tab tab to define shim plate properties.

Plates

Option Description
Shim plate 1

Shim plate 2

Shim plate 3

Thickness, width and height of the
shim plates.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 Description
1 Define the gap between the brace and connection plate.
2 Define how many shim plates are created at the top and bottom

flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the top
flange, and you want to use Shim plate 1 twice and Shim plate
1 once, enter 1 1 2. The first number you enter is the shim plate
closest to the brace flange.
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Gusset bolts 1 / Gusset conn 2 tab
Use the Gusset bolts 1 and Gusset conn 2 tabs to control the bolt group
properties for bolts that connect the gusset plate to the main part and the
secondary part, and to control the clip angle attachment.

Bolt group dimensions

  
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Vertical bolt group dimension in relation to the work point.

Work point is the intersection point between the center lines
of the main part and the last secondary part.

Steel components reference 2572 Bracing components



 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the

Yes
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Option Description Default
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.

Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the braces to the gusset plate.

Bolt group dimensions

 Option
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Option
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.
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 Option
• Below: From the lower edge of the secondary part to the

lowest bolt.

6 Select the bolt type.

Angle bolt group dimensions

 Option
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Option Option

Vertical bolt position

Option Description
Bolt position from the L profile edge.

Bolt position from the secondary part
center line.

Clip angle extensions

  
Select whether clip angles are
extended, and the extension sides.

Define the bolt group dimensions of the clip angle extensions.
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Bolt spacing to the bolts in the clip angle extension.
5 Location where the bolts should be attached.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Beam cut tab
Use the Beam cut tab to control weld access holes, beam end preparations,
and flange cuts.

Weld access hole dimensions
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 Option
1 Dimension for the top and the bottom weld access holes.
2 Gap between the secondary part web and the main part.
3 Gap between the secondary part bottom flange and the main

part.

Weld access holes

Option Option Description
Default

Round weld access hole

AutoDefaults can change
this option.
Round weld access hole

Square weld access hole

Diagonal weld access
hole

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds
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Hollow brace wraparound gusset (59)
Hollow brace wraparound gusset (59) connects 1 to 10 braces to the corner
where 2 or 3 parts meet, using a gusset plate. The gusset plate can be
wrapped around the third part, usually a column. Bolts or welds the brace web
to the gusset plate using connection plates, and bolts or welds the brace
flange to the gusset plate using clip angles. Either connects the gusset plate
directly to the existing parts, or uses clip angles or connection plates. Seals
braces.

Objects created

• Gusset plate

• Connection plates (optional)

• Clip angles (optional)

• Seal plates

• Tongue plates

• Cover plate

• Bolts

• Welds

Use for

Situation Description
Brace profile: RHS

Framing type: Beam and column

Gusset plate is bolted to the column
flange using a clip angle. Braces are
bolted to the gusset plate using a
tongue plate.

Brace profile: RHS

Framing type: Beam and column

Gusset plate is bolted to the column
flange using a clip angle. Braces are
welded to the connection plate. The
end of the brace is notched to
accommodate the bolts in the
connection between the connection
plate and the gusset plate.
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Before you start

Create 2 or 3 parts that form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner (Tekla Structures connects
the gusset plate to this part).

6. If needed, select the column to wrap the gusset plate around the column
where two beams and the column meet.

7. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle
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 Description
4 Seal plate

Picture tab
Use the Picture tab to define the shape of the gusset plate, location of the
braces and clip angles, and the work point location.

Dimensions

 Description
1 Define the gap distance between the gusset plate edge and the

main part.
2 Define the edge distance between the last secondary part and

the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the main

part.
5 Define the gap distance between the gusset plate edge and the

secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
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 Description
8 Define the gap distance between the gusset plate edge and the

seal plate.
9 Define the length of the edge of the connection plate.
10 Define the brace dimension on the connection plate.
11 Define the gusset plate edge distance in relation to the work

point.
12 Define the gusset plate edge distance to the flange of the third

part.
13 Define the clip angle edge distance in relation to the work

point.
14 Define the clip angle edge distance to the flange of the third

part.

Work point position

Option Description
Select the work point position. The
default position is the point where the
two main parts intersect.

Tekla Structures uses the work point
of a component to calculate check
dimensions and part position
dimensions in drawings.

Gusset tab
Use the Gusset tab to define the gusset plate, connection plate and clip angle
properties.

Parts

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and height of the

connection plates.

Steel components reference 2588 Bracing components



Option Description
Upper clip angle

Lower clip angle

Select the clip angle profile from the
profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is connected to the main
part with a clip angle.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.
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Connection plate cut through dimensions

 Description
1 Connection plate cut through length
2 Chamfer radius
3 Horizontal chamfer dimension
4 Vertical chamfer dimension

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Erection clearance

You can define the clearance for both the main part and the last secondary
part connection plates or clip angles.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.
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Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Notch angle

Option Description
Default

Square notch

If the gusset plate clashes with the
column, the gusset plate is notched to
wrap around the column.

AutoDefaults can change this option.
Square notch
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Option Description
Bevel notch

Notch chamfer type

Option Description
Default

Bevel chamfer

AutoDefaults can change this option.
No chamfer

Notched edges are parallel to the
edges of the gusset plate.
Bevel chamfer

Rounded chamfer calculated as a
quarter of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.
Rounded chamfer calculated as a
three quarters of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.

The center point of the circle is the
corner of the notch.
Corner of the gusset plate is beveled.

Corner of the gusset plate is not
notched or chamfered.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer
2 Vertical dimension of the chamfer
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Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Brace conn tab
Use the Brace conn tab to control the connection plate, seal plate, tongue
plate, and cover plate properties.

Parts

Option Description
Connection plate Thickness, width and height of the

connection plate.
Seal plates Thickness and height of the seal

plates.
Tongue plate Thickness and height of the tongue

plate.
Cover plate Thickness, width and height of the

cover plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Brace connection types

Define how the brace is connected to the connection plate.

Option Description
Default

Brace is welded.

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.
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Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Round cut

Enter the radius value.

Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Brace is notched.

Connection plate is cut.

If you cut the connection plate, you
can define the size of the gap
between the brace and the
connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.
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Option Description
Default

One connection plate.

AutoDefaults can change this option.
One connection plate.

Two connection plates

Connection plate chamfer

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
No chamfers are created.

Chamfers are created.

If you create chamfers, define the vertical
and horizontal chamfer dimensions.

End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.

Option Description
Default

Square end plate.

AutoDefaults can change this option.
Square end plate.

Round end plate.
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End plate edge distance

Option Description
End plate edge distance from the
brace outer edge.

Gusset conn 1 / Gusset conn 2 tab
Use the Gusset conn 1 and Gusset conn 2 tabs to control the bolt group
properties for bolts that connect the gusset plate to the main part and
secondary parts, and to control the clip angle attachment.

Bolt group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Vertical bolt group dimension in relation to the work point.

  
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.
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Option Description
Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.
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Bolt group dimensions on connection plates

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Option Option

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the

Yes
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Option Description Default
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Gusset side and brace side bolt type

Select the bolt type to define the location where the bolts should be attached.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Wraparound gusset cross (60)
Wraparound gusset cross (60) connects 1 to 10 braces to a gusset plate
where 2 or 3 parts meet to form a corner, using clip angles and connection
plates. The gusset plate can be wrapped around the third part, usually a
column. Connects the gusset plate to the parts using clip angles or connection
plates, or welds it directly to the first selected part. Clip angles can be created,
either at the ends of the braces, or on each side. Seals hollow braces. The
braces can have L, W, WT, RHS, and tube profiles.
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Objects created

• Gusset plate

• Connection plates

• Clip angles (optional)

• Seal plates (hollow braces)

• Welds

Use for

Situation Description
Brace profile: W

Framing profile: Column and 2 beams

Gusset plate is bolted to the beams
using clip angles. Braces are notched
and bolted to the gusset plate.

Brace profile: RHS

Framing profile: Column and beam

Gusset plate is bolted to the column
using a clip angle. Brace is pinned to
the gusset plate.

Brace profile: L

Framing profile: Two beams with
different elevations

Gusset plate is notched and bolted to
both beams using clip angles. Brace is
bolted to the gusset plate.
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Situation Description
Brace profile: RHS

Framing profile: Column and column
base plate

Gusset plate is bolted to the column
and the base plate using clip angles.
Brace is pinned to the gusset plate.

Before you start

Create 2 or 3 parts that meet to form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. f needed, select the column to wrap the gusset plate around the column
where two beams and the column meet.

7. Click the middle mouse button to create the component.
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Part identification key

 Description
1 Gusset plate
2 Clip angle

Picture tab
Use the Picture tab to define the shape of the gusset plate, location of the
braces and clip angles, and the work point location.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the edge distance between the last secondary part

and the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the

main part.
5 Define the gap distance between the gusset plate edge and

the secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the gusset plate edge distance in relation to the work

point.
9 Define the gusset plate edge distance to the flange of the

third part.
10 Define the clip angle edge distance in relation to the work

point.
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 Description
11 Define the clip angle edge distance to the flange of the third

part.

Work point position

Option Description
Select the work point position. The
default position is the point where the
two main parts intersect.

Tekla Structures uses the work point
of a component to calculate check
dimensions and part position
dimensions in drawings.

Gusset tab
Use the Gusset tab to define the gusset plate, connection plate and clip angle
properties.

Parts

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and width of the

connection plates.
Upper clip angle

Lower clip angle

Select the clip angle profile from the
profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is connected to the main
part with a clip angle.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.
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Connection plate cut through dimensions

 Description
1 Connection plate cut through length
2 Chamfer radius
3 Horizontal chamfer dimension
4 Vertical chamfer dimension

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Erection clearance

You can define the clearance for both the main part and the last secondary
part connection plates or clip angles.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.
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Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Notch angle

Option Description
Default

Square notch

If the gusset plate clashes with the
column, the gusset plate is notched to
wrap around the column.

AutoDefaults can change this option.
Square notch
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Option Description
Bevel notch

Notch chamfer type

Option Description
Default

Bevel chamfer

AutoDefaults can change this option.
No chamfer

Notched edges are parallel to the
edges of the gusset plate.
Bevel chamfer

Rounded chamfer calculated as a
quarter of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.
Rounded chamfer calculated as a
three quarters of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.

The center point of the circle is the
corner of the notch.
Corner of the gusset plate is beveled.

Corner of the gusset plate is not
notched or chamfered.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer
2 Vertical dimension of the chamfer
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Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Brace conn tab
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Part

Option Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Steel components reference 2615 Bracing components



Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.

Select whether the secondary parts
(except the last secondary part) are
fitted.

Seal plate edge distance from the
brace outer edge.
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Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Round cut

Enter the radius value.

Gusset conn 1 / Gusset conn 2 tabs
Use the Gusset conn 1 and Gusset conn 2 tabs to control the bolt group
properties for bolts that connect the gusset plate to the main and secondary
parts, and to control the clip angle attachment.

Bolts group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Vertical bolt group dimension in relation to the work point.

 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.
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Option Description
Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.
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Part

Option Description
L profile Select the clip angle profile from the

profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Define the edge distance between the clip angle and the
brace.

5 Select how to measure the dimensions for vertical bolt group
position.

6 Dimension for vertical bolt group position.

Clip angle position

Option Description
Select the clip angle position.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Corner wrapped gusset (63)
Corner wrapped gusset (63) bolts 1 to 10 braces to a gusset plate where two
parts form a corner, using clip angles and connection plates. Welds the gusset
plate to one of the parts that form the corner.

Objects created

• Gusset plate

• Connection plate between the gusset plate and the brace web

• Shear tab between the gusset plate and the brace flange

• Clip angles

• Shim plates

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
Brace profile: W

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using clip angles on the
flanges and connection plates on the
webs.

Brace profile: W

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using clip angles on the
flanges.

Brace profile: W

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using connection plates
on the webs.

Before you start

Create two parts that form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component. For more information, see .
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Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and the

main part.
2 Define the edge distance between the main part and the clip

angle.
3 Define the edge distance between the clip angle and the last

secondary part.
4 Define the edge distance between the clip angles.
5 Define the gap distance between the gusset plate edge and the

second part.
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the distance between the gusset plate and the brace.

Gusset tab
Use the Gusset tab to control the gusset plate properties.
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Gusset plate

Option Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.
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Option Description
Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.
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Option Description
Select the gusset plate egde shape
between the main part and the first
secondary part.

Gusset plate fitting

Option Description
Select whether the gusset is fitted to
the last selected secondary part.

Gusset welding

Option Description
Default

Gusset plate is welded to the main part.

AutoDefaults can change this option.
Gusset plate is welded to the main part.

Gusset plate is welded to the secondary
part.

Brace conn tab
Use the Brace conn tab to control connection plate, clip angle, filler plate, and
shear tab properties.
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Plates

Option Description
Connection plate Thickness and width of the connection plate.

Select the connection plate profile.
Upper clip angle

Lower clip angle

Select the clip angle profile.

Filler plate Thickness of the filler plate.
Upper shear tab Thickness, width and height of the upper shear

tab.
Lower shear tab Height of the lower shear tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created.
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Option Description
Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Select the filler plate creation side.

You can use this option when you
have selected to create two
connection plates.

Clip angle creation

Define whether the braces are attached to the gusset plate using clip angles or
shear tabs, and specify the number of clip angles to create. The default option
is to create two clip angles below the brace web.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.

Select the connection type (weld or
bolt) between the gusset plate and
the clip angle.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension
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Shim plates tab
Use the Shim plates tab to define shim plate properties.

Plates

Option Description
Shim plate 1

Shim plate 2

Shim plate 2

Thickness, width and height of the
shim plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 Description
1 Define the gap between the brace and connection plate.

Steel components reference 2637 Bracing components



 Description
2 Define how many shim plates are created at the top and bottom

flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the top
flange, and you want to use Shim plate 1 twice and Shim plate
1 once, enter 1 1 2. The first number you enter is the shim plate
closest to the brace flange.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description
Stiffener 1

Stiffener 2

Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate

edge.
2 Length of stiffener.

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.
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Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

6 Select the bolt type.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2
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Option Description
Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Angle bolts 1 / Angle bolts 2 tabs
Use the Angle bolts tabs to control the bolts that connect the clip angles.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option

Vertical bolt position

Option Description
Bolt position from the clip angle edge.
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Option Description
Bolt position from the secondary part
center line.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.
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Option Description Default
Rotate Slots When the hole type is Slotted,

this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Bent gusset (140)
Connects braces in different planes to one or more beams or columns that are
in different planes. Creates a gusset plate that is bent along two bending lines.
Seals tube or hollow profile braces.

Profiles

Braces: L

Parts created

• Gusset plate

• Seal plates
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Use for

Situation Description
 

Do not use for

Beams or columns that are in the same plane.

Before you start

Create one or more beams and columns, and 1 to 10 braces.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents See also
Picture Dimensions that define

gusset plate shape,
clearance between
braces, cut options for
ends of braces.

Modifying gusset plate
shape (page 2660)

Gusset Gusset plate properties,
brace notch properties,
weld options.

Option to cut corner of
gusset plate for single
brace connections.

Defining gusset plate
properties (page 2659)

Defining the bend line in
skewed connections
(140) (page 2664)

Brace conn Bolt group properties of
the bolts connecting the
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Tab Contents See also
gusset plate to the first
beam or column picked.

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Bracebolts1 Bolt group properties for
the bolts that connect
the first brace picked to
the gusset plate.

 

Bracebolts2

Bracebolts3

Bolt group properties for
the bolts that connect
the second and
subsequent braces
picked to the gusset
plate.

 

Plates Options to create filler
plates and to bolt braces
to both gusset plate and
the first or second beam
or column picked.

 

Analysis Information used in
structural analysis.

Selection order

1. Beam or column in the first plane

2. First brace

3. Second and subsequent braces in the first plane

4. Braces in planes 2 and 3

5. The beam or column in the second plane

6. Click the middle mouse button to create the component

Heavy brace (165)
Connects a single brace to a gusset plate where 2 parts meet to form a corner.

Profiles

Columns and beams: H, RHS, tube

Braces: W
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Parts created

• Gusset plate

• Connection plates

• Rib plates

• Filler plates

• Stiffeners

Use for

Situation Description
Column or beam profile: RHS, tube, I

Brace profile: H

Framing type: Column and beam

Connection method:

• Gusset plate welded column

• Brace web bolted to gusset using
connection plate.

1 Rib plates

Do not use for

Sloped or skewed beams

Before you start

Create 2 parts that meet to form a corner, and one brace.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents See also
Picture Dimensions of gusset

and rib plate, clearance
between plate and
brace.

 

Parts Properties of stiffeners
and gusset, flange, web,
rib, flange filler and web
filler plates.

Defining plate sizes in
marketsizes.dat (165,
Japan) (page 2672)
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Tab Contents See also
Gusset Gusset plate chamfers,

gap between gusset and
brace.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Ribs Dimensions that define
the size and location of
rib plates, option to
create ribs of equal
length.

Defining rib plate
dimensions (165)
(page 2673)

Stiffeners Dimensions of stiffener
plates.

 

Web bolts Bolt group properties for
the bolts fastening the
web connection plate to
the gusset plate.

 

Flange bolts Bolt group properties for
the bolts fastening the
flange connection plate
to the gusset plate.

 

Analysis Information used in
structural analysis.

Selection order

1. First part that forms the corner

2. First brace

3. Second and subsequent braces

4. Second part that forms the corner

5. Click the middle mouse button to create the component
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Windbracing connections
Use the following components to automatically create windbracing:

Component Image Description
Windbracing (1)
(page 2651)

Connects a single brace to a
beam or column, using a
connection plate, round
plates, a threaded rod, and
nuts.

Windbrace
connection
(110)
(page 2653)

Bolts braces to a gusset
plate. Welds or bolts the
gusset plate to the main
part. Braces can be:

• Located in the same work
plane as the beam or
column, or skewed

• On the same side of the
beam or column, or on
each side

Windbracing (1)
Connects a single hollow brace to a beam or column, using a connection plate,
threaded rod, and nuts. Welds round plates to the connection plate and bolts
it to the beam or column.

WARNING Tekla Structures creates the threaded rod using the Detailing --> Attach
Part command. This means that the rod and brace are treated as a
single part when you use commands like Delete, Move or Copy.

Profiles

Brace: RHS, tube

Parts created

• Connection plate

• Round plates (2)

• Filler plate

• Threaded rod

• Nuts on rod (2)
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Use for

Situation Description
Column or beam profile: H

Brace profile: RHS

Before you start

Create a beam or column and one brace.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents See also
Picture Dimensions that define

the size and position of
the connection and
round plates.

 

Parts Properties of all plates,
nuts, and washers.

Defining part thickness
(1) (page 2675)

Brace conn Properties of the hole in
the beam or column and
the slot in the
connection plate,
position of round plates,
rod dimensions.

Defining hole type (1)
(page 2675)

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Bolts Bolt group properties for
the bolts that fasten the
connection plate to the
beam or column.
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Tab Contents See also
Analysis Information used in

structural analysis.

Selection order

1. Beam or column

2. Brace

Windbrace connection (110)
Connects 1 to 10 braces to a beam or column by bolting them to a gusset
plate, and welding or bolting the gusset plate to the beam or column. The
braces can be:

• Located in the same work plane as the beam or column, or skewed

• On the same side of the beam or column, or on each side

Profiles

Braces: L

Parts created

• One gusset plate, if the braces are located on the same side of the beam or
column

OR

• One gusset plate on each side of the beam or column, if the braces are
located on either side of the beam or column. The plates are welded in the
shop to create a folded gusset plate.
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Use for

Situation Description
Two gusset plates (welded in the shop
to form a folded plate)

Brace profile: L

Connection method:

Braces bolted directly to gusset plate

Column or beam profile: L

Brace profile: L

Connection method:

• Gusset plate welded column

• Braces web bolted to gusset plate.
No stiffeners.

Before you start

Create a beam or column and 1 to 10 braces.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents See also
Picture Dimensions that define

gusset plate shape;
brace clearances and cut
options for ends of
braces.

Modifying gusset plate
shape (page 2660)

Gusset Gusset plate properties,
brace notch properties,
weld options.

Modifying gusset plate
shape (page 2660)

Defining gusset plate
type (page 2661)
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Tab Contents See also
Defining gusset plate
position on the brace
(page 2663)

Creating tongue plates
(20, 22, 56) (page 2666)

Creating an orientation
hole in the gusset plate
(110) (page 2664)

Dimensioning holes in
drawings (110, 140)
(page 2675)

Gusset conn Bolt group properties of
the bolts connecting the
gusset plate to the beam
or column.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Bracebolts1 Bolt group properties for
the bolts that connect
the braces to the upper,
or only gusset plate.

 

Bracebolts2 Bolt group properties for
the bolts that connect
the braces to the lower
gusset plate.

 

Brace conn Option to create filler
plates between the
braces and the gusset
plate; option to bolt the
braces to the beam or
column, as well as the
gusset plate.

Double-bolting braces
(110) (page 2668)

Analysis Information used in
structural analysis.

Selection order

1. Beam or column

2. First brace

3. Second and subsequent braces

4. Click the middle mouse button to create the component
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Bracing connection elements
Use the following components to create individual bracing elements, such as
stiffeners and gusset plates. You can then use these elements to connect
bracing to one or more parts, or in custom components.

Component Image Description
Crushed tube in points
(S46) (page 2656)

Creates a tube brace
between two points
using a tube crushed
between bolts.

Gusset tube in points
(S47) (page 2657)

Creates a tube brace
between two points that
you pick, using a circular
hollow section with 2
Tees at each end.

Crushed tube in bolts
(S48) (page 2658)

Creates a tube brace
using a tube crushed
between two existing
bolts.

Gusset tube in bolts
(S49) (page 2659)

Creates a tube brace
between two bolts, with
tees at both ends.

Crushed tube in points (S46)
Creates a brace between two points that you pick, using a circular hollow
section. Creates bolt groups at each end of the brace.

WARNING You cannot modify the individual objects that this component creates.

Parts created

Tube brace

Before you start

Create 2 points.
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WARNING To adjust the rotation of the tees, change the work plane before
you create the connection.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents
Picture Dimensions that define the location

of the bolts.
Parts Properties of the tube brace.
Tube pos. Options that affect the position, plane

and class of the tube.
Bolts Bolt group properties.

Selection order

1. Start point of the tube

2. End point of the tube

3. Click the middle mouse button to create the component

Gusset tube in points (S47)
Creates a brace between two points that you pick, using a circular hollow
section with 2 Tees at each end. Seals tube.

WARNING You cannot modify the individual objects that this component creates.

Parts created

• Tube

• Tees (4)

• End plate (2)

Before you start

Create two points. See .

WARNING To adjust the rotation of the tees, change the work plane before
you create the connection.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:
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Tab Contents
Picture  
Parts Properties of the tube, end plate, and

tees
Tube pos. Options that affect the position, plane

and class of the tube.
Bolts Bolt group properties.

Selection order

1. Start point of the tube

2. End point of the tube

3. Click the middle mouse button to create the component

Crushed tube in bolts (S48)
Creates a brace using a crushed tube between two existing bolts.

WARNING You cannot modify the individual objects that this component creates.

Parts created

Tube

Before you start

Create two bolts, either manually or using a detailing component (Standard
gusset (1065) (page 2120)).

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents
Picture Dimensions that define the crushed

end of the tube.
Parts Properties of the tube.
Parameters Options that affect the position, plane

and class of the tube.
Bolts  

Selection order

1. Work plane

2. First bolt

3. Second bolt
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4. Click the middle mouse button to create the component

Gusset tube in bolts (S49)
Creates a brace using a tube between two bolts, with a built-up T profile at
both ends. Seals tube.

WARNING You cannot modify the individual objects that this component creates.

Parts created

• Tube

• Tees (2)

• End plate

Before you start

Create 2 bolts on the plane where you want to create the brace.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents See also
Picture Dimensions that define

the end of the tube and
the tees.

 

Parts Properties of the tube,
end plate and Tees.

 

Parameters General connection
properties.

Bolts Properties of bolts.  

Selection order

1. First bolt

2. Second bolt

3. Click the middle mouse button to create the component

Defining gusset plate properties
This section explains how to define gusset plate properties for various bracing
components.

Click the links below to find out more:
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• Modifying gusset plate shape (page 2660)

• Defining gusset plate type (page 2661)

• Selecting gusset plate connection material (11) (page 2662)

• Defining wraparound gusset plates (58, 59, 60) (page 2662)

• Defining gusset plate location (67) (page 2663)

• Defining gusset plate position on the brace (page 2663)

• Defining gusset plate position on the beam or column (11) (page 2664)

• Defining the bend line in skewed connections (140) (page 2664)

• Specifying gusset plate connection material (11, 20, 62) (page 2664)

• Creating an orientation hole in the gusset plate (110) (page 2664)

NOTE Not all component dialog boxes contain all the properties listed in this
section.

Modifying gusset plate shape
To change shape of a gusset plate, you need to change its dimensions. Bracing
components automatically create gusset plates based on the dimensions in
the joints.def file.

• To only modify the dimensions of the gusset plate for the connections you
have selected, enter the new dimensions on the Picture tab.

• To modify the dimensions of the gusset plate for all connections that this
component creates, edit the dimensions in the joints.def file. Tekla
Structures uses values in the joints.def file to create this component.
See Define connection properties in the joints.def file.

Using the dialog box

To modify the shape of the gusset plate using the dialog box:
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1. Go to the Picture tab and enter values in any of the following fields (this
image is from Corner bolted gusset (57)):

1 Enter angles here.
2 Enter dimensions here.

2. Click the Apply button to change any connections you have open.

Defining gusset plate type
To define the type of gusset plate to use, go to the Gusset tab. The default
option is:

Optimizing plate weight

To optimize plate weight, select this option:
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Picking order affects brace position

Optional. When you select the option to optimize plate weight, you can also
choose to have the picking order affect the position of the braces. The default
option is ’No’:

To place the first brace picked closest to the first beam or column picked,
select this option:

Selecting gusset plate connection material (11)
To select the connection material to use to connect the gusset plate to the
beam or column, go to the Gusset tab. The default option is to weld the gusset
plate directly to the beam or column:

There are also options to use clip angles or shear tabs.

Defining wraparound gusset plates (58, 59, 60)
If the gusset plate clashes with the column, Tekla Structures notches the
gusset plate to wrap around the column. To specify the angle of the notch, go
to the Gusset tab. The default is:

Notch chamfer type

To specify the chamfer type to use for the notch, go to the Gusset tab. The
options are:

Option Description
No chamfer. Notch edges parallel to the
edges of the gusset plate.

Default.
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Option Description
Creates a rounded chamfer calculated as a
quarter of a circle. Enter the diameter of the
circle as the horizontal dimension of the
chamfer. See Defining chamfer dimensions.
Creates a rounded chamfer calculated as a
three-quarters of a circle. Enter the diameter
of the circle as the horizontal dimension of
the chamfer. See Defining chamfer
dimensions. The center point of the circle is
the corner of the notch.
Bevels the corner of the gusset plate.

Does not notch or chamfer the corner of the
gusset plate.

Defining chamfer dimensions

To define the size of the notch chamfer, or the diameter of the circle used to
calculate rounded chamfers, go to the Gusset tab and enter these dimensions:

Defining gusset plate location (67)
To specify the location of the gusset plate relative to the beam or column web,
go to the Gusset tab. The default location is above the beam or column web:

Defining gusset plate position on the brace
To indicate where to locate the gusset plate on the brace, go to the Gusset
tab. The default option is ’Middle’:

Fine-tuning position

To fine-tune the position of a gusset plate, enter values for the following
properties:
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Property Description
Moves the gusset plate in the y direction.

Moves the gusset plate towards the
connection.

Defining gusset plate position on the beam or column (11)
To indicate where to locate the gusset plate on the beam or column, go to the
Gusset tab. The default option is parallel to the brace:

Defining the bend line in skewed connections (140)
To define the bend line in skewed connections, enter the following dimensions
on the Gusset tab.

Specifying gusset plate connection material (11, 20, 62)
To specify what type of connection material to use to connect the gusset plate
to the beam or column, go to the Gusset tab. The default option is to connect
the gusset plate to directly to the flange of the beam or column:

You can also choose to use clip angles or fastener plates in various
configurations.

Creating an orientation hole in the gusset plate (110)
You may need to create an orientation hole in the gusset plate to indicate the
position of the plate when the connection is assembled in the shop, or during
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erection. To create an orientation hole in the gusset plate, go to the Gusset
tab:

The default option is no orientation hole:

To create the hole in the left or right of the gusset plate:

• Select one of the options in the listbox

• Enter the dimensions of the hole:

Defining brace connection properties
Click the links below to find out more:

• Defining the brace connection (page 2665)

• Creating tongue plates (20, 22, 56) (page 2666)

• Notching brace flange (11, 57) (page 2667)

• Notching brace flange (60) (page 2667)

• Notching the brace (22, 59) (page 2668)

• Cutting braces (60) (page 2668)

• Double-bolting braces (110) (page 2668)

• Using clip angles to connect braces (11, 57) (page 2669)

• Creating clip angles or shear tabs (58, 61, 62, 63) (page 2669)
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Defining the brace connection
Several component dialog boxes contain a Brace conn tab, where you can
specify the options to use to connect the brace to the gusset plate. Some of
the options are:

Option Description
How many
connection plates
to use.

You can use one or two connection plates
to connect the brace to the gusset plate.
The default option is 1 plate:

If there are two connection plates, Tekla
Structures creates an end plate to the
ends of the connection plates.

You can specify the width of the end
plate.

Notch the brace
or cut the
connection plate?

The default option is to notch the brace:

If you choose to cut the plate, you can
specify the gap between the brace and
the plate:

How to connect
the brace to the
connection plate.

The default option is to weld the brace:

You can also bolt the brace, or weld it and
notch it around the nuts connecting it to
the gusset plate:
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Creating tongue plates (20, 22, 56)
To connect the brace to the gusset plate using a tongue plate and cover plate,
go the Brace conn tab.

By default, a tongue plate is not created:

To create a tongue plate, select this option:

Notching brace flange (11, 57)
Some components give you the option to notch the brace flange. You may
want to do this:

• if the gusset plate collides with the brace flange

• to create slots in hollow braces. See Creating slots in hollow braces (11, 57)

• to connect hollow braces using clip angles. See Using clip angles to connect
braces (11, 57) (page 2669)

To notch the flange or create a slot, go to the Gusset tab. The default option is
not to notch:

Creating slots in hollow braces (11, 57)

To create a slot in a hollow brace, go to the Gusset tab:

1. Define the position of the gusset plate as ’Middle’. This is the default
option. See Defining gusset plate position on the brace (page 2663).

2. Select this option to create a slot in the brace and fasten the gusset plate
to it using a bolt:

Notching brace flange (60)
Some components give you the option to notch the brace flange. You may
want to do this:

• if the gusset plate collides with the brace flange

• to create slots in hollow braces
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To notch the flange or create a slot, go to the Brace conn tab. The default
option is not to notch:

Creating slots in hollow braces (60)

To create a slot in a hollow brace, go to the Brace conn tab:

1. Define the position of the gusset plate as ’Middle’. This is the default
option. See Defining gusset plate position on the brace (page 2663).

2. Select this option to create a slot in the brace and fasten the gusset plate
to it using a bolt:

Notching the brace (22, 59)
To define the depth of the notch in the brace, go to the Picture tab:

Depth of the notch in the
brace

TIP To prevent the connection plate from penetrating the hollow brace, enter a
negative value for the depth of the notch.

Cutting braces (60)
To indicate whether to cut the braces, go to the Brace conn tab. The default is
to cut the braces:
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Double-bolting braces (110)
By default braces are bolted to the gusset plate. To also bolt braces to the first
or second beam or column picked, go to the Brace conn tab. The options are:

Option Description
Only bolts braces to the gusset plate.

Bolts the first brace picked to both the
gusset plate and the first beam or column
picked.

Bolts the first and subsequent braces
picked to both the gusset plate and the
first beam or column picked.

Using clip angles to connect braces (11, 57)
To attach the braces to the gusset plate using clip angles:

1. First, create a slot in the brace. To do this, go to the Gusset tab. The
default option is:

To create a slot in the brace:

• Define the position of the gusset plate as ’Middle’. See Defining chamfer
dimensions.

• Select this option to create the slot and fasten the gusset plate to the brace
using a bolt:

• Go to the Angle bolts tab. The default option is not to create clip angles:
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Creating clip angles or shear tabs (58, 61, 62, 63)
To attach the braces to the gusset plate using clip angles or shear tabs, and
specify the number of clip angles to create, go to the Brace conn tab. The
default option is to create two clip angles below the brace web:

Defining minor plate properties
As well as gusset plates, many bracing components create minor plates,
including connection, filler, and shim plates. This section explains how to
define the properties of some of these minor plates.

Click the links below to find out more:

• Defining the number of connection plates (58, 61, 62, 63) (page 2670)

• Defining connection plate width (59) (page 2670)

• Creating filler plates (58, 61, 62, 63) (page 2671)

• Creating filler plates (165) (page 2671)

• Creating shim plates (58, 61, 62, 63) (page 2672)

• Defining plate sizes in marketsizes.dat (165, Japan) (page 2672)

• Defining rib plate dimensions (165) (page 2673)

• Omitting stiffener plates (1065) (page 2673)

• Creating rib plates (22, Japan) (page 2673)

Defining the number of connection plates (58, 61, 62, 63)
To define the position and number of connection plates to create between the
brace web and the gusset plate, go to the Brace conn tab. The default option
is one plate:
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Defining connection plate width (59)
To define the width of the connection plate go to the Picture tab and indicate
the distance from the edge of the brace to the edge of the connection plate:

This dimension defines
the width of the
connection plate.

Creating filler plates (58, 61, 62, 63)
To create a filler plate between the connection plate and the brace web, go to
the Brace conn tab. The default option is no filler plate:

To create a filler plate, select this option:

Creating filler plates (165)
If required, Heavy brace (165) automatically creates filler plates between the
connection plate and the:

• brace flange

• brace web

The thickness of the filler plates depends on the gap between the connection
plate and the brace flange or web, as follows:

Gap
(mm)

Flange filler
plate

thickness

Web filler

plate
thickness

1 No plate No plate
2 2.3 1.6
3 3.2 1.6
4 4.5 2.3
5 4.5 2.3
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Gap
(mm)

Flange filler
plate

thickness

Web filler

plate
thickness

6 6.0 3.2
7 6.0 3.2
8 9.0 4.5
9 9.0 4.5
10 9 4.5

Creating shim plates (58, 61, 62, 63)
To create and define shim plates, go to the Brace conn tab. The options are:

 Description
1 Clearance. Enter 1 mm or more to create shim plates.
2 Enter number of shim plates to create.
3 Select No to omit shim plates.

Defining plate sizes in marketsizes.dat (165, Japan)
In the Japanese environment, Heavy brace gusset (165) takes the default
thickness values for several plates from the marketsizes.dat file, located in
the ../profil/ folder. This file lists the standard plate thicknesses available
in specific material grades. Edit this file using any standard text editor, such as
Notepad.

NOTE Enter a value in the t field on the Parts tab to override the default value for
any plate.

Example

In this example, the marketsizes.dat file lists the standard plate thicknesses
available in material grade SS400. The DEFAULT line lists the thicknesses
available in all other material grades.
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# Market size (thickness) table
# Specify the material as given in Tekla

Structures material database
# and after that the market sizes separated by

commas
SS400,1.6,2.3,3.2,4.5,6,9,12,16,19,22,25,28,32

,38
DEFAULT,6,9,12,16,19,22,25,28,32,38

marketsizes.dat file

Defining rib plate dimensions (165)
Tekla Structures automatically calculates the following dimensions from the
length of the rib plate and bolt group properties.

These dimensions are automatically calculated from the length of the rib plate
and the bolt group properties:

To define the remaining dimensions, go to the Ribs tab.

Omitting stiffener plates (1065)
This component automatically creates stiffener plates at each end of the
gusset plate. To omit one or both stiffener plates, go to the Parts tab and
delete the values in the Front stiffener or Back stiffener fields.
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Creating rib plates (22, Japan)
To create this type of connection:

 Description
1 Cross plate
2 Cover plate

Go to the Rib plates tab and enter properties in the Cross plate and Cover
plate fields.

Defining bolt and hole properties
Click the links below to find out more:

• Brace bolt properties (11, 57) (page 2674)

• Defining part thickness (1) (page 2675)

• Defining hole type (1) (page 2675)

• Dimensioning holes in drawings (110, 140) (page 2675)

• Position of gusset bolts (11) (page 2675)

Brace bolt properties (11, 57)
To define the minimum distance from the connection plate bolts to the
intersection point of the column and brace centerlines, go to the Bracebolts
tabs:

The gap is measured parallel to each brace. If a brace is perpendicular to the
column, the gap is measured from the column centerline to the nearest bolts:
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Defining part thickness (1)
To define the thickness of the filler plate, washer, and nuts that this
component creates, go to the Parts tab and enter the following dimensions:

Enter the thickness of the following parts:

 Description
1 Filler plate
2 Washer
3 Nut
4 Extra nut

Defining hole type (1)
To define the type of hole to create in the beam or column for the rod, go to
the Brace conn tab and select one of the options in the Create hole in
primary field:

• Partcut cuts a hole for the rod

• Bolt creates a bolt hole

• Partcut+bolthole cuts a hole for the rod and creates a bolt hole

Dimensioning holes in drawings (110, 140)
If a component creates a gusset plate that is skewed so that the gusset hole is
not perpendicular to the gusset plate, hole dimensions in drawings may be
wrong. To fix this, go to the Gusset tab and set the Create extra bolt holes to
the gusset field to Yes. This creates an extra bolt hole that is perpendicular to
the gusset plate.

Steel components reference 2675 Bracing components



Position of gusset bolts (11)
To find the right position for the gusset bolt group, go to the Gusset bolts tab.
The position options are for the horizontal (1) and vertical (2) direction:

Horizontal position

Gusset horizontal position and offset options (1) only affect the following
situation, where the gusset is connected to the column flange. When the
position is Middle, the bolt group offset is calculated from the center line of
the column, for example.

Vertical position

Gusset vertical position and offset options (2) affect the bolt group connecting
the gusset directly to the flange and also the bolt groups connecting the
gusset to the clip angle or connection plate.
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Defining other properties
Click the links below to find out more:

• Specifying work point location (58, 59, 60) (page 2677)

• Defining Tees (105) (page 2677)

Specifying work point location (58, 59, 60)
Tekla Structures uses the work point of a component to calculate check
dimensions and part position dimensions in drawings.

To change the position of the work point, go to the Picture tab. The default
position is the point where the two main parts intersect:

Defining Tees (105)
There are several ways to create the tees at the end of the braces:

• On the Parts tab, specify a T profile to use.

• On the Parts tab, specify an I profile to use. The component creates the tee
by cutting the I profile. You must specify where to cut the I profile, using
the Tee depth field on the Parameters tab.

• To have Tekla Structures use two plates to create the tee, leave the Tee
profile field on the Parts tab blank. You must enter t,b, and h dimensions
for the tee flange and web.

NOTE You can define the Tees for each brace separately.

5.17 Tower components
You can use tower components to automatically create:

• Complete towers, and tower elements such as legs and bracing

• Brace to tower leg connections

• Brace to brace connections

See also

Tower elements (page 2678)

Brace to tower leg connections (page 2684)
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Brace to brace connections (page 2690)

Editing tools (page 2697)

Tower elements
Tekla Structures includes the following components that you can use to
automatically create a complete tower, or structural elements, such as tower
legs or bracing:

Component Icon Description
Tower
generation
(S43)
(page 2678)

Creates a complete tower.

Tower member
(S63)
(page 2680)

Creates tower legs.

Transmission
tower cross arm
(S65)
(page 2681)

Creates cross arms using
bent, angle-profile cleats.

Tower diagonal
(S66)
(page 2682)

Creates bracing panels.

Tower generation (S43)
Creates a complete tower, with a square or rectangular base.

Profiles

Tower legs: L

Bracing: L, flat, U, twin

Parts created

• Tower legs (4)
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• Bracing panels (you define the quantity)

Use for

Situation Description
 

Before you start

Check the current work plane, as it affects the position of the tower. For more
information, read Position of the tower (S43, S63) (page 2702)

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Quantity of bracing panels,

dimensions that define the
location of cross braces on
the tower legs.

Defining bracing panels
(S43, S66) (page 2708)

Parts Part properties, profiles for
legs and bracing.

 

Leg Parameters Quantity of profiles in each
leg, lift length, option to tile
profiles

Defining tower legs (S63)
(page 2705)

Tower Parameters Options that define the
type of bracing to create,
class numbers of bracing.

Defining bracing panels
(S43, S66) (page 2708)

Steel components reference 2679 Tower components



Tab Contents See also
Twin Profiles Options to use twin

profiles for bracing.
 

Model Points  Creating construction
points (S43, S66)
(page 2702)

Joints Components that connect
braces to tower legs.

Defining bracing
connections (S43, S66)
(page 2708)

Picking order

Pick a point to indicate the position of the tower leg at the bottom left corner
of the base of the tower.

Tower member (S63)
Creates the 4 legs of a tower, using angle profiles. The legs form a square or
rectangular base.

Parts created

Legs (4)

Use for

Situation Description
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Before you start

Check the current work plane, as it affects the position of the tower. For more
information, read Position of the tower (S43, S63) (page 2702)

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Properties of angle

profiles, quantity of
profiles in each leg, lift
length, option to tile
profiles.

Defining tower legs
(S63) (page 2705)

Creating sloping
legs (S63)
(page 2706)

Parts  
Parameters Gaps between angle

profiles
Pattern of angle
profiles (S63)
(page 2706)

Picking order

Pick a point to indicate the lower left corner of the tower.

Transmission tower cross arm (S65)
Creates cross arms using bent, angle-profile cleats.

Parts created

Bent, angle-profile cleats

Use for

Situation

Do not use for

Twin-profile cross arms.
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Before you start

Create 5 points. The 5th point must be in the center of the pattern, vertically:

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

the shape and size of the
upper and lower cross
arms.

 

Parts Part properties of the
cross arms.

 

Parameters Layout of profiles Layout of profiles (S65)
(page 2707)

Picking order

The picking order depends on the location of the 5th point:

Tower diagonal (S66)
Creates bracing panels between 2 or 4 existing columns.

Profiles

Bracing: L, flat, U, twin

Parts created

• Horizontal braces

• Diagonal braces
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Use for

Situation Description
 

Before you start

Create 2 or 4 tower legs.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

the location of diagonal
braces, quantity of
bracing panels.

Defining bracing panels
(S43, S66) (page 2708)

Parts Part properties of the
horizontal and diagonal
braces.

 

Parameters Options that define the
type of bracing to create.

Defining bracing panels
(S43, S66) (page 2708)

Twin Profiles Option to create twin-
profile braces, position
of twin profiles.

 

Model Points Option to create
construction points,
construction point
properties.

Creating construction
points (S43, S66)
(page 2702)
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Tab Contents See also
Joints Components to use to

connect braces to tower
legs.

Defining bracing
connections (S43, S66)
(page 2708)

Picking order

1. Pick the tower legs clockwise, starting with the top left leg:

2. Click the middle mouse button to create the component

Brace to tower leg connections
Tekla Structures includes the following components to connect one or more
braces to tower legs:

Component Icon Description
Tower 1
diagonal (87)
(page 2685)

Bolts 1 diagonal brace to a
tower leg.

Tower 2
diagonal (89)
(page 2686)

Bolts 2 diagonal braces to a
tower leg.

Leg - 2 and 3
diagonals (177)
(page 2688)

Bolts 2 diagonal braces and
1 horizontal brace
(optional) to a tower leg.
No gusset plate.

Leg - 1 diagonal
(178)
(page 2689)

Bolts 1 diagonal brace
directly to the outside or
inside face of a tower leg.
No gusset plate.
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Tower 1 diagonal (87)
Bolts 1 diagonal brace to a tower leg.

Profiles

Brace and tower leg: L

Parts created

-

Use for

Situation

Before you start

Create a tower leg and a brace.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:
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Tab Contents See also
Picture Option to create bolts,

Location of bolts.
About bolt gage lines
(page 2714)

Creating bolts (89)
(page 2717)

Parts Option to cut vertical leg
of brace, dimensions of
cut.

Cutting braces (87, 89)
(page 2709)

Bolts Bolt properties  
General Connection properties,

AutoDefaults and
AutoConnection rule
groups.

Extra cuts Option to cut horizontal
leg of brace, dimensions
of cut.

 

Check   
Analysis Information used in

structural analysis

Selection order

1. Tower leg

2. Brace

Tower 2 diagonal (89)
Bolts 2 diagonal braces to a tower leg.

Parts created

-

Use for

Situation More information
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Do not use for

Braces that clash.

Before you start

Create a tower leg and 2 diagonal braces.

Defining properties

Use the following tabs in the component dialog box to define the properties of
this component:

Tab Contents See also
Picture Bolt gages that define

the location of bolts that
connect all parts.

About bolt gage lines
(page 2714)

Creating bolts (89)
(page 2717)

Picture2 Bolt gages that define
the location of bolts in
the bolt groups that
connect:

• 1st brace to the
tower leg

• 2nd brace to the
tower leg

 

Parts Dimensions that define
the cuts in the vertical
legs of the diagonal
braces.

Cutting braces (87, 89)
(page 2709)

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Cuts d.1 Dimensions that define
the cuts in the horizontal
leg of the first brace
picked.

Cutting braces (87, 89)
(page 2709)

Cuts d.2 Dimensions that define
the cuts in the horizontal
leg of the second brace
picked.

 

Bolts Bolt properties.  
Check   
Analysis Information used in

structural analysis
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Selection order

1. Tower leg

2. First brace

3. Second brace

4. Click the middle mouse button to create the component

Leg - 2 and 3 diagonals (177)
Bolts 2 diagonal braces and 1 horizontal brace (optional) to a tower leg. Does
not create a gusset plate.

Profiles

Tower leg and braces: L

Parts created

Filler plates (optional)

Use for

Situation

Before you start

Create the following parts

• Tower leg

• 1 diagonal brace to the outside of the tower leg

• 1 diagonal brace to the inside of the tower leg

• 1 horizontal brace (optional)

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Steel components reference 2688 Tower components



Tab Contents See also
Picture Edge distances,

dimensions that define
the cut in the diagonal
brace on the inside of
the tower leg and the
horizontal brace.

Creating your own
defaults (177)
(page 2711)

Parameters Edge distances that
define the location of
bolt groups.

Creating your own
defaults (177)
(page 2711)

Bolts Bolt properties,
dimensions that define
the location of bolts, and
bolt pattern of bolt
groups.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Plates Option to create filler
plates, filler plate
properties.

Defining filler plates
(177) (page 2720)

Design Option to use UDL with
AutoDefaults, reaction
forces.

Analysis Information used in
structural analysis

Selection order

1. Tower leg

2. Diagonal brace on the inside of the tower leg

3. Diagonal brace on the outside of the tower leg

4. Horizontal brace (optional)

5. Click the middle mouse button to create the component

Leg - 1 diagonal (178)
Bolts 1 diagonal brace directly to the outside or inside face of a tower leg.

Profiles

Brace and tower leg: L
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Parts created

-

Use for

Situation More information
 

Before you start

Create a tower leg and a diagonal brace.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

how the brace is cut.
 

Parameters Bolt gage lines that
define the positions of
bolts.

About bolt gage lines
(page 2714)

Bolts Quantity of bolts, bolt
properties.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Design Option to use UDL with
AutoDefaults, reaction
forces.

Analysis Information used in
structural analysis

Selection order

1. Tower leg

2. Diagonal brace
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Brace to brace connections

Component Icon Description
Bolted gusset
brace (167)
(page 2691)

Bolts 2 diagonal braces to 2
horizontal braces, using a
gusset plate.

Bolted bridge
brace (169)
(page 2692)

Bolts 2 horizontal braces
and 1 diagonal brace to a
bridge plate or angle
profile.

Bolted Brace
(181)
(page 2694)

Bolts 1 diagonal brace to 1
or 2 horizontal braces.

Bolted Plate
Brace (182)
(page 2696)

Bolts 1 diagonal brace to 1
or 2 horizontal braces,
using a plate.

Bolted gusset brace (167)
Bolts 2 diagonal braces to 2 horizontal braces, using a gusset plate.

Parts created

Gusset plate

Use for

Situation Description
Rectangular gusset plate.
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Situation Description
Braces connect to different faces of
chamfered gusset plate.

Before you start

Create 2 diagonal braces and 2 horizontal braces.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

bolt locations.
About bolt gage lines
(page 2714)

Parts Properties of gusset
plate.

 

Parameters Properties of bolts in
horizontal braces, option
to chamfer gusset plate.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Analysis Information used in
structural analysis

Selection order

1. First diagonal brace

2. Second diagonal brace

3. First horizontal brace

4. Second horizontal brace

5. Click the middle mouse button to create the component
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Bolted bridge brace (169)
Bolts 2 horizontal braces and 1 diagonal brace to a bridge plate or angle
profile. Cuts the diagonal brace.

Parts created

Bridge plate or angle profile

Use for

Situation More information
 

Twin-profile diagonal braces

Angle profile used as a bridge

Do not use for

Braces on different planes, or braces that clash.

NOTE Bolted bridge brace (69) does not cut the horizontal braces.

Before you start

Create 2 horizontal braces and 1 diagonal brace (single or twin profile).
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Defining properties

Use the following tabs in the component dialog box to define the properties of
the component:

Tab Contents
Picture Dimensions that define bolt locations

and the clearance between the bridge
and horizontal braces.

Parts Part properties of the bridge.
Parameters Properties of bolts in horizontal

braces, bridge cut options.

Picking order

1. First horizontal brace

2. Second horizontal brace

3. Diagonal brace

4. If the diagonal brace is a twin profile, pick the second profile.

5. Click the middle mouse button to create the component.

 Description
1 First horizontal brace
2 Second horizontal brace
3 Diagonal brace

Bolted Brace (181)
Bolts 1 diagonal brace to 1 or 2 horizontal braces.

Parts created

-
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Use for

Situation

Do not use for

Braces that are not in the same plane.

Before you start

Create 1 diagonal brace and 1 or 2 horizontal braces. The braces can be built-
up beams.

Defining properties

Use the following tabs in the component dialog box to define the properties of
this component:

Tab Contents See also
Picture Dimensions that define

the position of bolts.
Clearance between
braces.

Defining bolt gage lines
(87) (page 2715)

Cutting braces (181, 182)
(page 2710)

Parameters Bolt and cut options for
horizontal braces.

Picking order

1. First horizontal brace

2. Diagonal brace

3. Second horizontal brace (optional)
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 Description
1 First horizontal brace
2 Diagonal brace
3 Second horizontal brace (optional)

Bolted Plate Brace (182)
Bolts 1 diagonal brace to 1 or 2 horizontal braces, using a plate. Connects the
diagonal brace to the inside or outside face of the horizontal brace.

Parts created

• Plate

• Filler plate(s)

Use for

Situation

Do not use for

Braces that are not in the same plane.

Before you start

Create 1 diagonal brace, and 1 or 2 horizontal braces.
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Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

the location of bolts,
clearance between
horizontal braces.

About bolt gage lines
(page 2714)

Cutting braces (181, 182)
(page 2710)

Parts The properties of the
plate and optional filler
plate.

 

Parameters Shape of cut in braces,
bolt options, plate
options.

Defining filler plates
(182) (page 2721)

Creating bolts (182)
(page 2718)

Picking order

1. Horizontal brace to which to bolt the diagonal brace

2. Diagonal brace

3. Second horizontal brace (optional)

4. Click the middle mouse button to create the component

 Description
1 Horizontal brace to which to bolt the diagonal brace
2 Diagonal brace
3 Second horizontal brace (optional)

Editing tools
Use the following components to modify tower bracing:

Component Icon Description
Open/Close
angle ends

Simulates the opening or
closing of one end of an
angle profile.
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Component Icon Description
(1050)
(page 2698)
Open/Close
angle (1051)
(page 2699)

Simulates the opening or
closing of an inner portion
of an angle profile.

Autoposition
(S67)
(page 2701)

Adjusts the position of
braces connected to a
tower leg. Cuts braces.

Open/Close angle ends (1050)
Simulates the opening or closing of one end of an angle profile by cutting and
bending the profile.

NOTE Use this component to create detail drawings that indicate where to open or
close angle profiles used in tower bracing. In the shop, the angle profile is
machined, not cut.

Parts created

-

Use for

Situation More information
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Do not use for

To open or close the inner portion of an angle profile, use Open/Close angle
(1051) (page 2699).

Before you start

• Create an angle profile

• Create a point to locate the component

• Set the work plane parallel to the outer face of the leg of the angle profile
that you want to bend:

Defining properties

Use the following tab in the Open/Close angle ends (1050) dialog box to
define the properties of the component:

Tab Contents More information
Parameters Which leg to open or

close, location of cut,
bend angle.

Adjusting length of
leg to open or close
(1050, 1051)
(page 2703)

Picking order

1. Angle profile

2. A point on the angle profile

Open/Close angle (1051)
Simulates the opening or closing of an inner portion of an angle profile by
cutting and bending the profile.

NOTE Use this component to create detail drawings that indicate where to open or
close angle profiles used in tower bracing. In the shop, the angle profile is
machined, not cut.
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Parts created

-

Use for

Situation More information
 

 

Do not use for

To open or close one end of an angle profile, use Open/Close angle ends
(1050) (page 2698).

Before you start

• Create a point to locate the component

• Set the work plane parallel to the outer face of the leg of the angle profile
that you want to bend:

Defining properties

Use the following tabs in the component dialog box to define the properties of
the component:

Steel components reference 2700 Tower components



Tab Contents More information
Parameters Which leg to open or

close, location of cut,
bend angle.

Adjusting length of
leg to open or close
(1050, 1051)
(page 2703)

Picking order

1. Angle profile

2. A point on the angle profile

Autoposition (S67)
Adjusts the position of 1 or 2 braces connected to a tower leg. Cuts braces.

WARNING Use Autoposition (S67) when you have completed all other work on a
model. Changing the model may override the adjustments you make
using this component.

Parts created

-

Before you start

Create 1 or 2 braces and connect them to a tower leg.

Defining properties

Use the following tab in the component dialog box to adjust the braces and
create cuts:

Tab Contents See also
Picture  Moving and cutting

braces (S67)
(page 2712)

Picking order

1. Tower leg

2. First brace

3. Second brace (optional)

4. Click the middle mouse button
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Defining general properties
Click the links below to find out more:

• Position of the tower (S43, S63) (page 2702)

• Creating construction points (S43, S66) (page 2702)

• Adjusting length of leg to open or close (1050, 1051) (page 2703)

Position of the tower (S43, S63)
Tekla Structures creates the tower along the z axis of the current work plane. If
the tower has a rectangular base, the longest side of the base runs parallel to
the x axis:

 Description
1 Base of tower
2 Top of tower

Creating construction points (S43, S66)
Construction points are points that you can pick to attach components to parts.
For example, you might create construction points on tower legs to use to
connect bracing to the legs.

To create construction points on tower legs or braces, go to the Model Points
tab. For each type of brace:

• Select the location of the points (1). For example, select Before to create
points on the outer face of a brace;
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• Enter the distance between the points, followed by the quantity of points
(2). For example, enter 400*4 to create 4 points, 400 mm apart.

Adjusting length of leg to open or close (1050, 1051)
To adjust the length of leg to open or close, go to the Parameters tab and
enter one of the following dimensions:

Field Description
External length of the portion
to be opened/closed

Measured from the point
you pick to create the
component towards the
start of the part reference
line

Internal length of the portion
to be opened/closed

Measured from the point
you pick to create the
component towards the end
of the part reference line

Defining tower leg properties
This section explains how to define the properties of tower legs.

Click the links below to find out more:

• Defining tower legs (S43) (page 2703)

• Defining tower legs (S63) (page 2705)

• Layout of profiles (S65) (page 2707)

Defining tower legs (S43)
Tower legs are constructed using angle profiles.

• Creating sloping legs (S43) (page 2703)

• Type and quantity of angle profiles (S43) (page 2704)
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Creating sloping legs (S43)

To define the slope of the tower legs, go to the Leg Parameters tab and enter
the x and y dimensions of the base and top of the tower:

 Description
1 Base y
2 Top y
3 Top x
4 Base x

Type and quantity of angle profiles (S43)

To specify the angle profiles to use for the tower legs:

1. Go to the Parts tab and enter the profiles you want to use in the Profile 1,
Profile 2, etc. fields. You can specify up to 8 profile types.
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2. Go to the Profiles to be used field on the Leg Parameters tab and enter
the quantity of each profile type to use for the legs. Here we are using 6
lifts of Profile 1 to create the tower leg:

Defining tower legs (S63)
Tower legs are constructed using angle profiles.

• Type and quantity of angle profiles (S63) (page 2705)

• Creating sloping legs (S63) (page 2706)

• Pattern of angle profiles (S63) (page 2706)

• Splicing legs (S63) (page 2707)

Type and quantity of angle profiles (S63)

To define the type and quantity of angle profiles to use:

1. Go to the Picture tab. Use fields 1 to 8 to define the angle profiles you
want to use.

2. In the Profiles for part field, enter the quantity of each profile type to use
for each leg. For example, enter 6*1 to create tower legs each made up of
6 lifts with the profile type you defined in field 1.
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3. On the illustration, enter the quantity and length of the lifts that make up
each leg. Enter 6*6000 to create tower legs using 6 lifts, each 6000 long:

4. To tile specific leg lifts, enter the numbers of the lifts to tile in the Parts to
be tiled field, counting from the bottom of the leg. For example, enter 3 5
to tile lifts 3 and 5.

Creating sloping legs (S63)

To create sloping tower legs, go to the illustration on the Parts tab and enter
the x and y dimensions of the base and top sections of the tower:

 Description
1 Dimensions of top of tower
2 Dimensions of base of tower
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Pattern of angle profiles (S63)

To define the quantity of angle profiles that form each leg, in cross section, use
the graphic option on the Parts tab. The default option is one angle profile:

Splicing legs (S63)

To enable the erector to splice tower legs, go to the Parameters tab and set
the cut back distance between the angle profiles:

Layout of profiles (S65)
The options are:

Option Layout
Inside

Outside

Defining tower bracing properties
This section explains how to define the properties of tower bracing.

Click the links below to find out more:
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• Defining bracing panels (S43, S66) (page 2708)

• Defining bracing connections (S43, S66) (page 2708)

• Cutting braces (87, 89) (page 2709)

• Cutting braces (177) (page 2710)

• Cutting braces (181, 182) (page 2710)

• Creating your own defaults (177) (page 2711)

• Moving and cutting braces (S67) (page 2712)

Defining bracing panels (S43, S66)
To define the quantity of bracing panels to create between each pair of tower
legs, enter a number in the Number of Diagonals field on the Picture tab.

To define the layout of the bracing panels, go to the Tower Parameters tab
and select an option in the Type of Diagonal dropdown list. The default layout
is cross bracing:

You can also create diagonal bracing, in various layouts.

Defining bracing connections (S43, S66)
To specify the components to use to connect braces to the tower legs, go to
the Joints tab. You can use different components to connect the left and right
diagonal braces, and the horizontal braces.

WARNING You cannot use custom components to connect the braces to the tower
legs.

To define each connection, on the Joints tab:

• Select a component from the dropdown list,

or

• To select a component that is not on the dropdown list,, select Custom and
enter the component number.

You can also use a predefined set of properties for the component:

1. Enter the number of the component to use (1). Here we are using Fitting
(13).
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2. Indicate the predefined set of properties to use (2).

Cutting braces (87, 89)
To define the cuts in the legs of the braces, go to:

• Horizontal legs: Parts tab

• Vertical legs: Extra cuts tab (87), Cuts d.1 and Cuts d.2 tab (89)

These tab pages contain options to cut the legs of the braces, and the
dimensions of the cut. This is how they appear on the Parts tab:
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 Description
1 Incremental value for the angle of the cut. If you enter 2, the actual angle

can be 2, 4, 8, etc
2 Cut dimensions
3 Clearance to heel of tower leg
4 Cut options
5 Clearance between main profile leg and diagonal 2

NOTE Use the Always cut option to cut the braces and create the clearance to the
heel of the tower leg. This option overrides the bolt edge distances on the
Picture tab.

Cutting braces (177)
Leg - 2 & 3 diagonals (177) automatically cuts the braces according to the bolt
edge distances specified for each brace on the Picture tab.

Cutting braces (181, 182)
Tekla Structures automatically:

• Miters the end of the horizontal brace, or braces and

• Cuts the end of the diagonal brace, according to the bolt edge distance.

To specify these dimensions, go to the Picture tab:

 Description
1 Clearance between horizontal braces
2 Bolt edge distance

To define the shape of the cut, use the following fields:

• Switch for shape of horiz. braces cut on the Parameters tab (181).
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• Switch to manage brace cut shape on the Parameters tab (182).

Creating your own defaults (177)
Default values for all the properties in the Parameters tab, except clearance,
plus the bolt end distances of the diagonals can be specified in text files called
tower_joint_clearance_N.txt, where N is the bolt diameter. For example,
tower_joint_clearance_16.txt, tower_joint_clearance_24.txt, etc.

This file can be created in the current model folder or system folder.

If the text file for a particular bolt diameter is not found, the connection will
calculate its own default values.

The format of this text file is:

Format 1: <L-profile> <C> <D1> <D2> <D3> <D4> <E> | <C> <D1> <D2> <D3>
<D4> <E>

Format 2: <L-profile> <C> <D1> <D2> <D3> <D4> <E>

Format 3: <L-profile> <H> | <B>

Format 4: <L-profile> <H>

Where

• <L-profile> = L-profile name; eg, L200*200*20, L200/15.

• <C> = distance from the edge of the part to the nearest bolt.

• <D1> = distance from the heel of the part.

• <D2> = distance from the outside-border of the part.

• <D3> = distance from the heel of the part, away from the part.

• <D4> = distance from the cut-end of the part, if any.

• <E> = distance between bolts.

• <H> = see the section below on Format 3 & 4.

• <B> = see the section below on Format 3 & 4.

• The first set of values in Format 1 is for the first flange (h) of the part, and
the second set for the second flange (b).

• In Format 2, h and b have the same values.

• In Format 3, the first set of <C> <D1> ... <D4> <E> values are assigned with
the value of <H>, and the second assigned with <B>.

• In Format 4, both sets of values are assigned with the value of <H>.

Note that

• Lines starting with a ';' or ' ' are skipped.

• <L-profile> must start on the first position of the line.
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• There must be at least one blank space between <L-profile> and the first
value.

• The component finds only the first occurrence of the specified L-profile.

Examples
L40*5 20
L50*50*5 25 | 25
L80*10 30 30 30 30 30 30
L200/15 40 45 40 40 40 35
L200/20 40 45 40 40 40 35
RSA45*45*5 20 25 20 20 20 20
RSA100*100*8 30 45 40 40 40 35
RSA75*150*15 30 35 30 30 30 25 | 35 40 35 35 35 30
RSA150*75*15 35 40 35 35 35 30 | 30 35 30 30 30 25
RSA200*200*20 40 45 40 40 40 35

Moving and cutting braces (S67)
To move the ends of braces:

 Description
1 Define the bolt gage lines for the braces
2 Define the bolt gage line for the tower leg
3 Move points
4 Indicate which brace(s) to move
5 Enter the distance to move the point(s) where the gage lines intersect

To cut the braces:
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 Description
1 Enter the distance from the end of the brace(s) to the edge of the tower

leg
2 Select Yes to cut the brace(s)

To move bolt groups:

 Description
1 Enter the distance from the first bolt in the group to the end of the brace

Defining bolt properties
This section explains how to define the properties of bolts in tower
components.

Click the links below to find out more:

• About bolt gage lines (page 2714)

• Editing default gage lines (page 2716)

• Creating bolts (87) (page 2717)

• Creating bolts (89) (page 2717)

• Creating bolts (178) (page 2718)

• Creating bolts (181) (page 2718)

• Creating bolts (182) (page 2718)

• Bolt location (87, 89) (page 2718)
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About bolt gage lines
Several components use gage lines that you can use to:

• Define the location of bolts on a brace

• Adjust the position of individual bolts

• Remove bolts

For example, Leg 1 - diagonal (178) uses gage lines.

Gage lines specify several dimensions:

 Description
1 Distance between bolts, horizontally
2 Distance from the center of the bolt to the edge of the brace
3 Distance between bolts, vertically

To use a default set of gage lines:

• Ensure that the gauge_lines.dat file is in the profile folder of the
environment your are using,

• Leave all the fields blank on the Parameters tab.

TIP To learn how to change the default gage lines, see Editing default gage lines
(page 2716).
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Components using gauge_lines.dat

The following components use the gauge_lines.dat file:
• Tower Generation Macro (S43)

• Tower diagonal (S66)

• Auto position (S67)

• Batten plates (S85)

• Windbrace connection (110)

• Bent gusset (140)

• L splice (175)

• Parallel L profiles (176)

• Leg - 1 Diagonal (178)

See also

Bolt location (87, 89) (page 2718)

Defining bolt gage lines (87)

To define bolt gage lines for Tower 1 diagonal (87), go to the Picture tab and
enter the following dimensions:

 Description
1 Location of gage lines
2 Location of gage lines

To learn how to create bolts, see Bolt location (87, 89) (page 2718).
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Defining bolt gage lines (89)

To define bolt gage lines for each bolt group in Tower 2 diagonal (89), go to
the following tabs:

Bolt group Tab
Connects all parts Picture
Connects first and second brace
picked to the tower leg

Picture 2

For example, on the Picture tab, enter the following dimensions:

 Description
1 Location of gage lines
2 Gage line 1(second brace picked)
3 Bolt edge distances
4 Gage line 1 (first brace picked)

To learn how to create bolts, see Bolt location (87, 89) (page 2718).
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Editing default gage lines
To change the default gage lines for all components that use them, edit the file
gauge_lines. dat, with any text editor (e.g. Notepad). The file is located in
the system folder.

Creating bolts (87)
This component creates a single bolt group that connects the brace to the
tower leg. To create bolts, you need to:

• Define the bolt gage lines and edge distances. See About bolt gage lines
(page 2714)

• Create bolts, and specify the location of individual bolts. See Bolt location
(87, 89) (page 2718)

WARNING This component does not create any bolts by default. So you must define
the bolts to use.

Creating bolts (89)
This component creates several bolt groups:

 Description
1 Bolt group that connects all parts
2 Bolt group that connects the first brace picked to the tower leg
3 Bolt group that connects the second brace picked to the tower leg.

(component 89 only)
4 Tower leg

For each bolt group, you need to:
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• Define the bolt gage lines and edge distances. See About bolt gage lines
(page 2714)

• Create bolts, and specify the location of individual bolts. See Bolt location
(87, 89) (page 2718)

WARNING This component does not create any bolts by default. So you must define
the bolts to use.

Creating bolts (178)
To create bolts, go to the Parameters tab and define the bolt gage lines. See
About bolt gage lines (page 2714).

WARNING This component does not create any bolts by default, so you must define
the bolts to use.

Creating bolts (181)
By default, this component creates one bolt at the intersection of the main
bolt gages of the horizontal brace and the diagonal brace. To create a second
bolt:

1. Go to the Picture tab and define the main and secondary bolt gages for
the braces:

2. Go to the Parameters tab. Select one of the options in the Switch for
common bolt dropdown list. The default option is None.

Creating bolts (182)
By default, Tekla Structures creates the following bolts:

• One bolt where the main bolt gages of the braces intersect, which connects
all the braces to the plate.

To create a second bolt, go to the Parameters tab. Select one of the
options in the Switch for common bolt dropdown list. The default option
is None.

• A bolt on the main bolt gage line of each brace, which connects the brace
to the plate.
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Bolt location (87, 89)
Use the fields at the bottom of the Picture tab pages to create bolts in each
bolt group, use the fields at the bottom of the Picture tab page(s):

Bolt group Tab
Connects all parts Picture
Connects first and second brace
picked to the tower leg

Picture 2

• Enter 0 to create a bolt on the intersection of gage lines

• Enter 1 or more to move the bolt along the gage line, away from the end of
the brace, on either the first or second diagonal brace picked:

 Description
1 First brace picked
2 Second brace picked (component 89 only)
3 Creates bolt at intersection of gage lines
4 Moves bolt 30 mm along the gage line, away from the end of the brace

TIP To move a bolt towards the edge of the brace, enter a negative number, e.g. -10.

Defining connection material
This section explains how to define the properties of connection material in
tower components.

Click the links below to find out more:

• Defining filler plates (177) (page 2720)
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• Defining filler plates (182) (page 2721)

Defining filler plates (177)
If necessary, Leg - 2 & 3 diagonals (177) automatically creates filler plates in
the gaps between the braces and the tower leg.

 Description
 Plate 1: Between the first diagonal brace picked and the horizontal

brace
 Plate 2: Between the second diagonal brace picked and the tower leg
 Plate 3: Between the horizontal brace and the tower leg
 Plate 4: Between the first horizontal brace picked and the tower leg
1 Horizontal brace
2 First diagonal brace picked
3 Second diagonal brace picked
4 Tower leg
5 Effect in modify

To specify the properties of each filler plate, use the fields on the Plates tab.

To remove a filler plate, go to the illustration and clear the checkbox against it:
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 Description
1 To remove a plate, clear its checkbox. Here we are removing plates 1 and

2

Defining filler plates (182)
If the diagonal brace connects to the inside of the horizontal brace, Tekla
Structures creates one or more filler plates to fill the gap between the diagonal
brace and the plate:

 Description
1 Diagonal brace
2 Filler plate
3 Plate

To replace the filler plate with a ring or square washer, go to the Parameters
tab and select an option in the Switch to manage what kind of filler plate
list box.

5.18 Connection Map
This section introduces example illustrations of different connections, grouped
according to their usage.

Click the links below to find out more:

• Beam to beam framing connections (page 2722)

• Beam to column framing connections (page 2740)

• Splice connections (page 2762)

• Joist connections (page 2769)

• Vertical member to beam (page 2772)
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• Bracing connections (page 2776)

• Welded connections (page 2784)

• Details (page 2788)

Beam to beam framing connections

Shear tabs

Example Description
Full depth shear tab - secondary
beam cut short of main part.

Use Beam with stiffener (129).

Full depth shear tab - secondary part
sloped and/or skewed.

Use Beam with stiffener (129).
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Example Description
Simple shear tab to beam.

Use Shear plate simple (146).

Simple shear tab to beam - bolt
elimination option.

Use Shear plate simple (146).

Simple shear tab to beam - skewed
secondary part.

Use Shear plate simple (146).
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Example Description
Simple shear tab to beam - sloped
(and skewed) secondary part. Bolts
and plate oriented with secondary
part.

Use Shear plate simple (146).

Simple shear tab to beam - sloped
and skewed secondary part. Valley
condition.

Use Shear plate simple (146).

Simple shear tab to beam - sloped
and skewed secondary part. Valley
condition.

Use Shear plate simple (146).
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Example Description
Partial depth shear tab to top flange
of beam - square or skewed, stiffener
option.

Use Welded to top flange (147).

Partial depth shear tab to top flange
of beam. Sloped/ square or skewed.

Use Welded to top flange (147).

Partial depth shear tab to top flange
of beam, secondary beam cut short of
main part. Square, sloped, skewed.

Use Welded to top flange S (149).
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Example Description
Full depth shear tab. Square, sloped,
skewed.

Use Full depth (184).

Full depth shear tab. Secondary beam
cut short of main part.

Use Full depth S (185).

Full depth shear tab. Secondary beam
cut short of main part. Sloped
secondary.

Use Full depth S (185).
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Example Description
Full depth shear tab. Secondary beam
cut short of main part. Sloped and
skewed secondary (hip & valley).

Use Full depth S (185).

Full depth shear tab. Secondary beam
cut short of main part. Secondary
offset. Bolt elimination option.

Use Full depth S (185).
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Clip angles

Example Description
Clip angle connection – single-sided
clip/double-sided clip.

Use Clip angle (141).

Clip angle connection – single-sided
clip/double-sided clip. Sloped
secondary part. Various notching
options.

Use Clip angle (141).

Clip angle connection – single-sided
clip/double-sided clip. Weld
preparation option.

Use Clip angle (141).
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Example Description
Clip angle connection – single-sided
clip/double-sided clip. Sloped
secondary part.

Use Clip angle (141).

Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts. Bolted/bolted, welded/bolted,
welded/welded options.

Use Two sided clip angle (143).

Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts at differing heights.

Use Two sided clip angle (143).
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Example Description
Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts. Safety connection.

Use Two sided clip angle (143).

Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts. One sloped.

Use Two sided clip angle (143).
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End plates

Example Description
End plate connection - level or sloped,
square or skewed secondary part.
Various notching options.

Use End plate (144).

End plate connection – extended
plate with or without haunches.

Use End plate (144).

End plate connection – two secondary
parts. Automatic notch for bolt
clearance.

Use Two sided end plate (142).
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Example Description
End plate connection – two secondary
parts at differing heights.

Use Two sided end plate (142).

End plate connection – two secondary
parts. Square and /or skewed.

Use Two sided end plate (142).

End plate connection – two secondary
parts. Safety connection.

Use Two sided end plate (142).
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Example Description
End plate connection – two secondary
parts. Level and/or sloped.

Use Two sided end plate (142).

Bent plate

Example Description
Bent plate connection – skewed or
square secondary part, plate near
side and far side.

Use Bent plate (190).
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Example Description
Bent plate connection – skewed or
square secondary part, plate one
side.

Use Bent plate (190).

Bent plate connection – skewed or
square secondary part, plate one
side. Various plate placing options.

Use Bent plate (190).

Bent plate connection – skewed and
sloped (hip & valley).

Use Bent plate (190).

Steel components reference 2734 Connection Map



Bearing type

Example Description
Beam to beam bearing connection.
Options for 1,2,3, or 4 bolts.

Use Seating (30).

Beam to beam bearing connection.
Spacer option.

Use Seating (30).

Beam to beam bearing connection.
Brace support.

Use Seating (30).
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Example Description
Beam to beam bearing connection
with stub column. Square, sloped and
skewed conditions.

Use Cross (4).

Beam to beam bearing clamp type
connection.

Use Seating with nail (36).

Beam to beam bearing purlin
connection to single purlin.

Use Purlin connections (93).
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Example Description
Beam to beam bearing purlin
connection to two purlins.

Use Purlin connections (93).

Beam to beam bearing notched
seating connection. Square and
skewed conditions.

Use Notched seating (9).

Beam to beam bearing tube steel rails
to main part. Cope or hole bolt access
options.

Use Tube rail (113).
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Example Description
Beam to beam bearing notched seat
with angle.

Use Rail joint (70).

Beam to beam bearing rafter
connection to two secondary parts.
Notching required.

Use Rail joint (70).

Beam to beam bearing rafter
connection to two secondary parts.
Plate. Notching required.

Use Rail joint (70).
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Example Description
Beam to beam bearing rafter
connection to two secondary parts.
Sloped/level notching required.

Use Rail joint (70).

Beam to beam full bearing rafter
connection to two secondary parts.
Plate.

Use Cold rolled overlap (1).

Beam to beam full bearing rafter
connection to two secondary parts.
Angle.

Use Cold rolled overlap (1).
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Example Description
Beam to beam full bearing rafter
connection to two secondary parts.
Knee brace option.

Use Cold rolled overlap (1).

Beam to column framing connections

Shear tabs

Example Description
Simple shear tab to column flange.

Use Shear plate simple (146).
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Example Description
Simple shear tab to edge/column
flange.

Use Shear plate simple (146).

Simple shear tab to column flange
with seat angle options.

Use Shear plate simple (146).

Simple shear tab to column flange.
Bolt elimination options.

Use Shear plate simple (146).
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Example Description
Shaped shear tab with column
stiffeners.

Use Column with stiffeners W (182).

Shaped shear tab with column
stiffeners. Sloped secondary.

Use Column with stiffeners W (182).

Shaped shear tab with column
stiffeners. Bolts aligned with
secondary part.

Use Column with stiffeners W (182).
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Example Description
Shaped shear tab with column
stiffeners. Bolt elimination option.

Use Column with stiffeners W (182).

Shear tab with column stiffeners.

Use Column with stiffeners (186).

Shear tab with column stiffeners.
Sloped secondary.

Use Column with stiffeners (186).
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Example Description
Shear tab with column stiffeners.
Skewed secondary.

Use Column with stiffeners (186).

Shear tab to column flange with
column stiffeners.

Use Column with stiffeners (188).

Shear tab to column flange with
column stiffeners. Weld preparation
and weld access holes for moment
connection option.

Use Column with stiffeners (188).
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Example Description
Bolted moment connection to column
flange with column stiffeners.

Use Bolted moment connection
(134).

Bolted moment connection to column
web.

Use Bolted moment connection
(134).

Bolted moment connection to column
web. Sloped secondary part.

Use Bolted moment connection
(134).
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Example Description
Welded moment connection to
column flange. Beam weld
preparation and weld access hole
options.

Use Moment connection (181).

Welded moment connection to
column flange. Sloped.

Use Moment connection (181).

Shear tab through tube column.

Use Shear plate tube column (189).
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Example Description
Shear tab through tube column. Two
secondary parts.

Use Shear plate tube column (189).

Shear tab through tube column. Two
secondary parts. Plate extended to
top of column option.

Use Shear plate tube column (189).

Shear tab through tube column. Two
secondary parts, level and/or sloped.
Bolt alignment options.

Use Shear plate tube column (189).
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Example Description
Shear tab through tube column. Third
secondary part after connection
applied to original two secondary
parts.

Use Shear plate tube column (189).

Clip angles

Example Description
Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Welded/bolted, bolted/
bolted, welded/welded options.

Use Clip angle (141).
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Example Description
Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Sloped secondary part.
Square or bevel cut secondary
options.

Use Clip angle (141).

Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Weld preparation and weld
access holes for moment connection.

Use Clip angle (141).

Clip angle connection to column knife
connection. Bottom flange blocked or
stripped for erection.

Use Clip angle (141).
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Example Description
Clip angle connection to column. Seat
angle option. Top/Bottom/Both.

Use Clip angle (141).

Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Haunch extension option.
Top/Bottom/Both.

Use Clip angle (141).

Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Rotated secondary part.

Use Clip angle (141).
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Example Description
Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts. Bolted/bolted, welded/bolted,
welded/welded options.

Use Two sided clip angle (143).

Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts. Haunch extension option. Top/
Bottom/Both.

Use Two sided clip angle (143).

Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts. Weld preparation and weld
access holes for moment connection.

Use Two sided clip angle (143).
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Example Description
Clip angle connection. Automatic
notching of secondary part to provide
bolt clearance.

Use Two sided clip angle (143).

Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts rotated.

Use Two sided clip angle (143).
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End plates

Example Description
End plate connection to column
flange or web. Level or sloped, square
or skewed secondary part.

Use End plate (144).

Full depth end plate connection to
column flange or web. Level or
sloped, square or skewed secondary
part.

Use End plate (144).

End plate connection to column web.
Extended plate with haunches option.

Use End plate (144).
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Example Description
End plate connection to column
flange. Column stiffener option.

Use End plate (144).

End plate connection to column.
Secondary part rotated.

Use End plate (144).

End plate connection. Two secondary
parts. Automatic notching for bolt
clearance. Haunch option.

Use Two sided end plate (142).

Steel components reference 2754 Connection Map



Bent plate

Example Description
Bent plate connection to column
flange. Skewed or square secondary
part. Plate near side\far side\both
sides.

Use Bent plate (190).

Bent plate connection to column web.
Skewed or square secondary part.
Plate near side\far side\both sides.

Use Bent plate (190).
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Welded tee

Example Description
Welded tee to column.

Use Welded tee (32).

Seated connection

Example Description
Beam seat with stiffeners.

Use Rail joint (170).
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Example Description
Beam seat top and bottom with
stiffeners. Various bolting options.

Use Rail joint (170).

Beam seat. Multiple stiffener options.

Use Rail joint (170).

Beam seat. Offset secondary part.

Use Rail joint (170).
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Bearing type cap plate

Example Description
Beam cantilever over column with cap
plate.

Use U.S. Base plate joint (71).

Beam cantilever over column with cap
plate. Sloped secondary part.

Use U.S. Base plate joint (71).

Beam cantilever over column with cap
plate. Beam stiffener option.

Use U.S. Base plate joint (71).
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Example Description
Beam cantilever over column with cap
plate. Column stiffener option.

Use U.S. Base plate joint (71).

Two beams to column cap plate.
Beam stiffener options.

Use Seating (39).

Beam column cap plate. Tube steel
rails to main part. Cope or hole bolt
access options.

Use Column tube seating (100).
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Example Description
Wind column to beam connection.

Use Wind column (5).

Wind column to beam connection.
Plate offset option.

Use Wind column (5).
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Girt to column

Example Description
Single girt to column. Angle
connection.

Use Rail joint (70).

Two girts to column. Angle
connection.

Use Rail joint (70).

Beam to column outrigger
connection. Main and secondary part
stiffener options.

Use Stub (28).
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Example Description
Two girts to column. WT connection.

Use U.S. seat joint 3 (74).

Splice connections

Beam to beam

Example Description
Clip angle splice connection. Bolted/
bolted, welded/bolted, welded/
welded options.

Use Two sided clip angle (143).
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Example Description
Clip angle splice connection. One
sided. Bolted/bolted, welded/bolted,
welded/welded options.

Use Two sided clip angle (143).

Clip angle splice connection. Beams in
differing planes.

Use Two sided clip angle (143).

NOTE To make a clip angle type splice connection, it is necessary to create a dummy
main part to bolt through. The secondary parts are spliced.

Make the dummy plate 1/8" thick with special properties so that it can be
filtered out when making drawings. Use the settings shown below on the
Picture tab.
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Example Description
Beam to beam web splice plate
welded to main part/ bolted to
secondary part.

Use Tab plate (33).

Beam to beam web splice plate
welded to main part/ bolted to
secondary part. Beams in differing
planes.

Use Tab plate (33).

Beam to beam web splice plate
welded to main part/ bolted to
secondary part. Parts rotated.

Use Tab plate (33).
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Example Description
Beam to beam web splice plate
bolted to both parts. Both parts in the
same plane.

Use Column splice (42).

Beam to beam end plate splice.

Use Joining plates (14).

Beam to beam end plate splice. Parts
of different depths.

Use Joining plates (14).
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Example Description
Beam to beam welded splice. Stair
stringer to landing.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Beam to beam bolted end plate
splice.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Beam to beam bolted end plate splice
with haunch.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.
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Example Description
Beam to beam bolted end plate splice
with haunch stiffener plate option.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Beam to beam welded splice, "Z" cut.

Use Offshore Z (192).

Beam to beam welded splice, "Z"
square cut.

Use Offshore Z (192).
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Column splice

Example Description
Column splice. Bolted to both parts.
Both parts in the same plane.

Use Column splice (42).

Column splice. Bolted to both parts.
Shim plates for differing profiles.

Use Column splice (42).

Column splice. Bolted to both parts.
Lifting hole option.

Use Column splice (42).
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Example Description
Column splice with division plate and
connection angles.

Use Column splice (132).

Joist connections

Joist to beam

Example Description
Joist bearing on beam.

Use Joist to beam, type 1 (160).
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Example Description
Joist bearing on beam. Top chord
extension option.

Use Joist to beam, type 1 (160).

Joist to column

Example Description
Joist bearing to column. Cap plate,
stabilizer bar or angle option. Top
chord extension option also available.

Use Joist to column, type 1 (161).
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Example Description
Two joists bearing to column. Cap
plate, stabilizer bar or angle option.

Use 2 sided joist to column (162).

Two joists bearing to column. Cap
plate, cap plate level or on slope of
joists.

Use 2 sided joist to column (162).

Joist framing to side of column.
Stabilizer bar or angle option.

Use Joist to column, type 2 (163).
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Example Description
Joist framing to side of column. Seat
angle across toes of flanges.

Use Joist to column, type 2 (163).

Joist framing to joist girders at
column.

Use Joist to beam and column (164).

Vertical member to beam
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Post and door jamb to top of beam

Example Description
Post base plate to top of beam. Main
and secondary stiffener options.

Use U.S. base plate connection (71).

Simple shear tab to post or channel
jamb.

Use Shear plate simple (146).

Clip angle to channel jamb.

Use Clip angle (141).
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Example Description
Clip angle to railing post.

Use Stringer stanchion L profile
(68).

Railing post connection plate to beam
stiffener.

Use Stringer stanchion st (69).

Railing post elbow to connection
plate.

Use Stanchion curved (84).
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Example Description
Shear tab to railing post.

Use Stanchion side profile (86).

Built–up plate railing post connection.

Use Stanchion double plate (87).
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Hangers from underside of beam

Example Description
Clip angle hanger connection.

Use Clip angle (141).

Simple shear tab hanger connection.

Use Shear plate simple (146).

Bracing connections
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Simple gusset plate connections

Example Description
Gusset plate to single brace.
Horizontal and vertical bracing.
Various bracing profiles.

Use Bolted gusset (11).

Load connection attribute < Defaults
> and select Defaults for Rule group
for best results.

Gusset plate to single brace.
Horizontal and vertical bracing.
Hollow round brace with pin bolt
option.

Use Bolted gusset (11).

Load connection attribute < Defaults
> and select Defaults for Rule group
for best results.

Gusset plate to single brace. Brace
and main part at the same elevation.

Use Bolted gusset (11).
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Example Description
Gusset plate to single brace at base
plate of column.

Use Bolted gusset (11).

Gusset plate hollow section "Birds
mouth" connection to secondary
parts.

Use Tube gusset (20).

Gusset plate hollow section tongue
plate connection to secondary parts.

Use Tube gusset (20).

Steel components reference 2778 Connection Map



Example Description
Gusset plate to twin profile brace.
Vertical or horizontal brace. Multiple
bracing members.

Use Bolted gusset (11).

Gusset plate to twin profile brace.
Twin profile main part. Welded or
bolted to main part.

Use Bolted gusset (11).

Gusset plate with connection plate.
Bolted to main part.

Use Bolted gusset (11).

Steel components reference 2779 Connection Map



Example Description
Gusset plate with connection plate.
Bolted to main part. Various gusset
plate shaping options.

Use Bolted gusset (11).

Gusset plate to hollow section brace.
Pin bolt and tension angle option.

Use Bolted gusset (11).

Gusset plate to hollow section brace.
Pin bolt and tension angle option.

Use Bolted gusset (11).
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Example Description
Gusset plate to WT section brace.
Notching option.

Use Bolted gusset (11).

Load connection attribute < Defaults
> and select Defaults for Rule group
for best results.

Gusset plate through hollow section
column to hollow section bracing at
base plate.

Use Bolted gusset (11).

Select column, then brace and brace.

Gusset plate through hollow section
column to WT bracing at base plate.

Use Bolted gusset (11).

Select column, then brace and brace.
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Example Description
Gusset plate through hollow section
column to angle bracing at base plate.
Single or twin profile.

Use Bolted gusset (11).

Select column, then brace and brace.

Wrapped gusset plate W section
bracing. Various bracing connection
options. Welded/bolted, bolted/
bolted.

Use Gusset wrapped cross (62).

Wrapped gusset plate W section
bracing. Various bracing connection
options. Welded/bolted, bolted/
bolted.

Use Gusset wrapped cross (62).
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Example Description
Wrapped gusset plate W section
bracing. Various bracing connection
options for each brace.

Use Gusset wrapped cross (62).

Wrapped gusset plate W section
bracing. Various gusset plate
connection options.

Use Gusset wrapped cross (62).

Hollow section bracing tongue plate
connection to existing gusset plate.

Use Tube crossing (22).
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Example Description
Wrapped gusset W section bracing
connection to existing gusset plate.

Use Wrapped cross (61).

Hollow section bracing WT end
connection to existing gusset plate.

Use Portal bracing (105).

Bolted brace connection to existing
gusset plate.

Use Bracing cross (19).
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Welded connections

Beam to beam

Example Description
Welded beam to beam.

Use Fitting (13).

Welded beam to beam with
horizontal stiffeners.

Use Fitting (13).
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Example Description
Welded beam to beam with primary.
Vertical stiffeners.

Use Welded beam to beam (123).

Welded beam to beam with haunch.

Use Offshore (194).

Welded beam to beam with haunch.
Various haunch options.

Use Offshore (194).
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Example Description
Welded beam to beam with haunch.
Various haunch options.

Use Offshore (194).

Welded round profile to round
profile.

Use Round tube (23).

Welded round profile to round
profile. Differing profile size and
skewed secondary part.

Use Round tube (23).
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Beam column

Example Description
Welded to column with weld
preparation and stiffener options.

Use Welded column with stiffeners
(128).

Welded to column.

Use Welded column (31).

Details

Steel components reference 2788 Connection Map



Base plates

Example Description
Column base plate with grout hole
option.

Use U.S. base plate (1047).

Column base plate with shear key
option.

Use U.S. base plate (1047).

Column base plate with stiffener
option.

Use U.S. base plate (1047).
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Example Description
Offset column base plate (shear key
and grout hole optional).

Use U.S. base plate (1047).

Column base plate bolt elimination
and interior corner chamfer option.

Use U.S. base plate (1047).

Column base plate located from face
of flange.

Use Base plate (1042).
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Example Description
Circular column base plate with
stiffener option.

Use Circular base plates (1052).

Horizontal base plate to sloped post.

Use Base plate (1053).
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Stiffeners

Example Description
Stiffener plate detail to column.

Use Stiffeners (1003).

Stiffener plate detail to beam.

Use Stiffeners (1003).

Partial depth stiffener plate detail to
beam.

Use Stiffeners (1041).
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Example Description
Partial depth stiffener plate detail to
column.

Use Stiffeners (1041).

Parallel stiffener plates.

Use Horizontal stiffener (1017).

Flange stiffener plates.

Use Stiffeners (1030).
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Example Description
Stiffened notch.

Use Stiffened notch (1006).

Stiffened notch. Notch cut bevel to
part.

Use Stiffened notch (1006).
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Manlock holes and lifting lugs

Example  
Manlock holes in column.

Use Manlock column (1032).

Manlock holes in beam.

Use Manlock beam (1033).
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Example  
Lifting lug to beam.

Use Lifting/alignment pieces (1031).

Lifting lug to beam chamfered plate.

Use Lifting/alignment pieces (1031).
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Seat details

Example Description
Plate seat with stiffeners.

Use Stub plate (1013).

Angle seat with stiffener.

Use Angle profile box (1040).

Angle seat with stiffener. Bolt to main
part and through seat options.

Use U.S. seat detail (1048).
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Example Description
Angle seat with stiffener. Bolt to main
part placed at a given distance apart.

Use U.S. seat detail (1048).

WT seat detail.

Use U.S. seat detail 2 (1049).

Rotated angle seat. Stiffener plate
option available.

Use U.S. seat detail 2 (1049).
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Cap plate and bearing plate

Example Description
Bearing plate at end of beam.

Use U.S. bearing plate (1044).

Cap plate.

Use End plate detail (1002).
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Miscellaneous

Example Description
Spacer plate between twin profiles.
Welded or bolted.

Use Twin profile connection plate
(1046).
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6 Concrete components
reference

This section contains information on the use of concrete components that ship
with Tekla Structures.

If you know which component you need, you can press F1 in the component
dialog box to quickly access the correct help page. Some components use
locally installed help files in a legacy format, which you can only access by
pressing F1 in the component dialog box.

More components are available in Tekla Warehouse for you to download and
install.

You can also modify many of the existing components and create your own
custom components, see .

6.1 Concrete Detailing
This section introduces the concrete detailing tools available in Tekla
Structures.

Click the links below to find out more:

• Seating connections (page 2803)

• Beam and column connections (page 2830)

• Panels and walls (page 2911)

• Openings (page 3152)

• Flooring (page 3155)

• Concrete stairs (page 3212)

• Foundations (page 3263)
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NOTE Precast components can only be applied to precast cast units. They
cannot be applied to cast-in-place cast units.

Seating connections
Tekla Structures includes several seating connections that you can use to
connect concrete columns and beams using anchor bolts. The seating
connection tools are:

• Seating with dowel (75) (page 2803)

• Two-sided seating with dowel (76) (page 2810)

• Seating with dowel to flange (77) (page 2818)

• Two-sided seating with dowel to flange (78) (page 2824)

Seating with dowel (75)
Seating with dowel (75) connects a column and a beam using an anchor bolt.

Parts created

• Anchor bolt

• Nut

• Washer plate

• Bearing plate

• Fittings for beam and column

• Hole for bolt

• Corbel (optional)

• Recess for nut and washer plate (optional)
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Use for

Situation Description
Connects a beam and a column using an anchor bolt.
Washer plate and nut protrude from the beam.

Connects a beam and a column using an anchor bolt
and a beveled corbel. Washer plate and nut recessed
into the beam.

Before you start

Create the following parts:

• Concrete column (round or rectangular profile)

• Concrete beam (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the second part is selected.

Picture tab
Use the Picture tab to define position of anchor bolt and bearing plate, bolt
hole dimensions, grout type, and beam clearance.

Bolt hole

Enter the following bolt hole dimensions:
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 Description
1 Hole dimension in the direction of the beam.
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Beam and column

Select one of the following options to have Tekla Structures fit the column or
the beam:

Option Description
Fits the column.

Default

Fits the beam.

The beam must be sloped.
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Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel and grout properties.

Dowel

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
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Option Description
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.
Number of bars Select 1 Dowel to create one

reinforcing bar.

Select 2 Dowels to create two
reinforcing bars. Then define the
distance between the bars in the Bar
distance field.

Grout

Select one of the following options to include and define grout:

Option Description
No grout.

Default

Bolt hole grouted. No nut or washer plate.

Bolt hole grouted. Bolt, washer plate, and
anchor bolt protruding.

Nut and washer plate

Select one of the following options to define if the nut and washer plate are
recessed into the beam:

Option Description
Nut and washer plate on the surface of
the beam.

Default

Nut and bolt plate recessed into the
beam.
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If you choose to recess the nut and washer plate into the beam, enter the
following dimensions to define the recess:

Parts tab
Use the Parts tab to define bearing pad, drainage hole, grout, bolt plate, nut,
and tube properties.

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.
Cast unit Select to add the parts to the cast unit.

Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.

Corbel tab
Use the Corbel tab to create a corbel and define its properties.
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Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:

Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.

Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .
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Option Description
Name Name that is shown in drawings and

reports.
Class Part class number.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Two-sided seating with dowel (76)
Two-sided seating with dowel (76) connects a column and two beams using
anchor bolts.

Parts created

• Anchor bolts (2)

• Nuts (2)

• Washer plates (2)

• Bearing plates (2)

• Fittings for beam and column (2)

• Holes for bolts (2)

• Corbels (optional) (2)

• Recesses for washer plate and nut (optional) (2)

Use for

Option Description
Connects two beams to a column using anchor bolts
and creates corbels. Nuts and washer plates on the
surface of the beams.
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Option Description
Connects two beams to a column using anchor bolts.
Nuts and washer plates recessed into the beams.
Second beam is sloped, and is cut to create a gap
between the beam and the column.

Before you start

Create the following parts:

• Concrete column (round or rectangular profile)

• Two concrete beams (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define dimensions and the position of the anchor bolts
relative to the beams and bearing plates.

Beam and column

Select one of the following options to define how the end of the beams are cut
and shaped:

Key Options
1 = column

2 = first beam picked

3 = second beam
picked
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Key Options

Select one of the following options to fit the beams or the column:

Option Description
Fits column.

Default

Fits beam.

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.
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Option Description
Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel properties.

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.
Number of bars Select 1 Dowel to create one

reinforcing bar.

Select 2 Dowels to create two
reinforcing bars. Then define the
distance between the bars in the Bar
distance field.

Parts tab
Use the Parts tab to define bearing pad, drainage hole, grout, bolt plate, nut,
and tube properties.
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Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.

Left beam/Right beam tab
Use the Left beam/Right beam tab to define anchor bolt, bolt hole and
recess properties.

Left beam is the first beam selected and right is the second.

You can create a clearance between beam and column if beam is sloped.

Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.

Nut and washer plate

Select one of the following options to define if the nut and washer plate are
recessed into the beam:

Option Description
Nut and washer plate on the surface of
the beam.

Default
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Option Description
Nut and bolt plate recessed into the
beam.

If you choose to recess the nut and washer plate into the beam, enter the
following dimensions to define the recess:

Grout

Select one of the following options to include and define grout:

Option Description
No grout.

Default

Bolt hole grouted. No nut or washer plate.

Bolt hole grouted. Bolt, washer plate, and
anchor bolt protruding.

Bolt hole

Enter the following bolt hole dimensions:

Field Description
1 Hole dimension in the direction of the beam.
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Field Description
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Left corbel/Right corbel tab
Use the Left corbel/Right corbel tab to create a corbel and define its
properties.
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Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:

Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.

Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .
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Option Description
Name Name that is shown in drawings and

reports.
Class Part class number.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Seating with dowel to flange (77)
Seating with dowel to flange (77) connects the flanges of a beam to a
column using anchor bolts and an optional corbel.

Parts created

• Anchor bolts (2)

• Nuts (2)

• Washer plates (2)

• Bearing plate (1)

• Fittings for beam and column

• Holes for bolts (2)

• Corbel (optional)

• Recess for nut and washer plates
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Use for

Situation More information
Connects the flanges of a beam to
a column using anchor bolts and
a beveled corbel. Nuts and
washer plates recessed.

Before you start

Create the following parts:

• Concrete column (Round or rectangular profile)

• Concrete beam with flange (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the second part is selected.

Picture tab
Use the Picture tab to define position and length of anchor bolt, and bolt hole
dimensions and position.

Bolt hole

Enter the following bolt hole dimensions:
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 Description
1 Hole dimension in the direction of the beam.
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel properties.
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Select to create the dowel as a reinforcement bar, poly-profile, or custom
component part from the Type list.

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.

Parts tab
Use the Parts tab to define bearing pad, drainage hole, bolt plate, nut and
recess properties.

Part properties

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.
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Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.

Recess

To cut a recess in the beam web, select the Yes option in the Create recess
list. Enter the following dimensions to define the recess:

Corbel tab
Use the Corbel tab to create a corbel and define its properties.

Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:
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Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.

Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .

Name Name that is shown in drawings and
reports.

Class Part class number.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Two-sided seating with dowel to flange (78)
Two-sided seating with dowel to flange (78) connects the flanges of two
beams to a column using anchor bolts and optional corbels.

Parts created

• Anchor bolts (4)

• Nuts (4)

• Washer plates (4)

• Bearing plate (2)

• Fittings for beam and column

• Holes for bolts (4)

• Corbels (2) optional

• Recesses for nut and washer plate (4)

Use for

Situation Description
Connects the flanges of two beams to a column using
anchor bolts.
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Situation Description
Connects the flanges of two beams to a column using
anchor bolts and beveled corbels.

Before you start

Create the following parts:

• Concrete column (Round or rectangular profile)

• Concrete beam with flange (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define dimensions and the position of the anchor bolts
relative to the beam and bearing plate, length of anchor bolts, and beam ends.

Beam and column

Select one of the following options to define how the end of the beams are cut
and shaped:

Key Options
1 = column

2 = first beam picked

3 = second beam
picked
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Key Options

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel properties.

Select to create the dowel as a reinforcement bar, poly-profile, or custom
component part from the Type list.

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
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Option Description
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.

Parts tab
Use the Parts tab to define bearing pad, drainage hole, bolt plate, and nut
properties.

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.

Left beam/Right beam tab
Use the Left beam/Right beam tab to define anchor bolt, bolt hole and
recess properties.

Left beam is the first beam picked and right is the second.

Bolt hole

Enter the following bolt hole dimensions:
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Field Description
1 Hole dimension in the direction of the beam.
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.
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Recess

To cut a recess in the beam web, select the Yes option in the Create recess
list. Enter the following dimensions to define the recess:

Left corbel/Right corbel tab
Use the Left corbel/Right corbel tab to create a corbel and define its
properties.

Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:

Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.
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Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .

Name Name that is shown in drawings and
reports.

Class Part class number.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Beam and column connections
This section introduces components that can be used in concrete connections.

Click the links below to find out more:

• Battering connection (13) (page 2831)

• Corbel connection (14) (page 2832)

• Column - beam (14) (page 2844)

• Corbels and recesses (82) (page 2850)

• Concrete console (110) (page 2856)
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• Concrete console (111) (page 2870)

• Concrete beam-beam (112) (page 2880)

Battering connection (13)
Battering connection (13) fits the secondary part, for example, in a custom
component either square to the main part, or at an angle.

Use for

Situation Description
Secondary is fit square to the
main part.

Secondary is fit to the main
part at an angle.
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Before you start

Create two parts.

Selection order

1. Select the main part

2. Select the secondary part.

Picture tab
Use the Picture tab to define the angle and the distance between the parts.

 Description
1 Define the angle between the parts.

If the part angle makes the gap larger than the value A, then
the part is cut at the end.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Corbel connection (14)
Corbel connection (14) connects a beam to a column using a straight,
beveled, or rounded corbel and reinforcing bars or fastening plates.

Objects created

• Corbel
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• Bearing plate

• Drainage holes in bearing plate (1 or 2) (optional)

• Reinforcing bars (1 or 2) (optional)

• Bolt plates for reinforcing bars

• Nuts for reinforcing bars

• Recesses for bolt plates and nuts

• Fastening plates (2) (optional)

• Recesses for fastening plates

Use for

Situation Description
Connects a beam to a column using a reinforcing bar
and a beveled corbel.

Connects a beam to a column using fastening plates
and a rounded corbel.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Bolt plate
2 Nut
3 Bearing plate
4 Corbel
5 Reinforcing bar

Example: Add a corbel connection using Corbel connection (14)
In this example, you will add a corbel connection between a column and a
beam.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Enter corbel in the search box.

3. Select Corbel connection (14).

4. Select the main part (column).

5. Select the secondary part (beam). 
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Tekla Structures automatically adds the corbel connection between the
column and the beam when you select the beam.

Picture tab
Use the Picture tab to control the corbel shape and dimensions, beam end
shape and dimensions, and corbel side chamfers in Corbel connection (14).

When beam sloped, adjust

If the beam in the connection is sloped, define whether the beam or the corbel
is cut.

When the beam end is cut, the corbel top stays horizontal. When the corbel is
cut, the corbel top has the same slope as the beam.

Corbel dimensions and shape
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 Description
1 Gap between the column and the beam.
2 Gap between the corbel and the beam.
3 Vertical corbel dimension.
4 Beveled corbel dimension.
5 Corbel width.

Option Description
Default

Beveled corbel

AutoDefaults can change this option.

Beveled corbel

Square corbel

Rounded corbel
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Corbel position

 Description
1 Horizontal corbel offset.
2 Height of the beam cut.
3 Gap between the corbel and extended beam.

Beam end shape

You can fit the beam end to the column, or you can create a straight beam
end.

Option Description Example
Default

Straight beam end

AutoDefaults can change
this option.

 

Straight beam end
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Option Description Example
Beam end is fit to the
column based on the
dimensions you define.

Beam can extend
symmetrically on both
sides of the column, or
with different
dimensions.

Corbel thickness

Define the distances from column edges to set the corbel thickness.

Corbel side chamfers

Define whether the corbel sides are chamfered. By default, no chamfers are
created.
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Parts tab
Use the Parts tab to control the corbel part properties and dimensions in
Corbel connection (14).

Corbel parts

Part Description
Bearing plate Bearing plate thickness.
Cast unit Select whether cast unit is formed.
Drainage hole Select whether drainage holes for

each reinforcing bar are created in
the bearing plate.

Bolt plate Bolt plate thickness.
Nut Nut thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined on
the Components tab in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box on the
Components tab in File

Concrete components reference 2839 Concrete Detailing



Option Description Default
menu --> Settings -->
Options.

Name Name that is shown in
drawings and reports.

 

Bearing plate dimensions

 Description
1 Bearing plate distance from the column edge.
2 Bearing plate distance from the corbel edges.

Nut and bolt plate dimensions

 Description
1 Nut width.
2 Bolt plate width.

Reinforcing bar tab
Use the Reinforcing bartab to control the reinforcing bar and fastening plate
properties, and the bolt plate and fastening plate recesses in Corbel
connection (14).
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Reinforcing bar properties

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Bending radius Internal radius of the bends in the

bar.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcements.

For example, you can display different
reinforcement classes in different
colors.

Number of bars Select 1 Dowel to create one
reinforcing bar.

Select 2 Dowels to create two
reinforcing bars. Then define the
distance between the bars in the Bar
distance field.

Reinforcing bar length

 Description
1 Distance between reinforcing bar center line and the column edge.
2 Vertical length of the reinforcing bar inside the corbel.
3 Length of the reinforcing bar inside the column.
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Recess for bolt plate and nut

 Description
1

5

Size of the bolt plate recess in the x direction.

Size of the bolt plate recess in the y direction.
2

4

Size of the nut recess in the y direction.

Size of the nut recess in the x direction.
3 Reinforcing bar offset.

Reinforcing bar extra length

 Description
1 Extra length of the reinforcing bar.
2 Length of the reinforcing bar inside the recess.

Connecting devices

Define the connecting devices that connect the beam and the column.

Option Description
Default

One or two reinforcing bars bent to
the same angle as the corbel bevel

Available for bevel corbels.

AutoDefaults can change this option.
One or two reinforcing bars bent to
the same angle as the corbel bevel

Available for bevel corbels.

Concrete components reference 2842 Concrete Detailing



Option Description
One or two reinforcing bars

Default for straight and rounded
corbels.
Two fastening plates

Use custom components as fastening
plates.

Recess for fastening plate

 Description
1

2

Depth of column recess.

Depth of beam recess.
3

4

Offset of column recess.

Offset of beam recess.
Column recess

Beam recess

Height and width of column and beam recess.

Using custom components as fastening plates

You can use custom components as fastening plates. Use the Column
component and Beam component sections to define the fastening plates in
the column and beam.

1. Select the following option in the Connecting devices list:
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2. In the Custom list, select Yes.

3. Click the ... button next to the Component field to open the Select
component dialog box.

4. Browse for the custom component you want to use as fastening plate.

The component you select must be a custom part and have two or more
input points.

5. Select the component and click OK.

6. To use saved custom component properties, enter the name of the saved
properties file in the Custom settings field.

7. If the direction or rotation of the fastening plate is not correct, select
another option in the Up direction or Rotation list.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Column - beam (14)
Column - beam (14) creates a connection between a concrete column and a
concrete beam or wall/panel. The orientation of the beam can be horizontal or
sloped. Note that the connection works only with precast parts.

Objects created

• Cuts

• Fittings
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Use for

Option Description
Beam end rests on the column.

Beam end rests on the column.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam/wall/panel).

Picture tab
Use the Picture tab to define cut-out shapes and cut-out dimensions of the
column and the beam.

Cut-out dimensions

Option Description
Cut-outs of the main part and the
secondary part in the horizontal
direction.

The space between the column
and the beam can be defined at
both sides. For tapered openings
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Option Description
you can define how much the
opening is reduced.

Example:

Cut-outs of the main part and the
secondary part in the vertical
direction.

The space between the column
and the beam can be defined at
both sides. For tapered openings
you can define how much the
opening is reduced.

Example:
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Option Description
Select the how the opening is
reduced.

The options are:

• From beam centerline

• From beam edges

Cut-out shape

Option Description
Cut around the secondary part

Cut-out to the top of the column

Concrete components reference 2847 Concrete Detailing



Option Description
Cut-out to the bottom of the column

Full vertical cut-out

No cut-out

Column tab
Use the Column tab to define how the top of the column is modified.

Column extension

Define the column extension. If you do not enter any values, the column is
extended to its original top level.
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 Description
1 Column extension in the vertical direction from the beam top.

This dimesion has the highest priority among the three dimensions
(1, 3, 4) for defining the column extension.

2 Select wether the top of the column is perpendicular or parallel to
the beam.

Perpendicular:

Parallel with top of beam:

3 Column extension in the vertical direction.
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 Description
4 Column extension in the vertical direction from the beam bottom.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Corbels and recesses (82)
Corbels and recesses (82) adds concrete parts or cuts to a concrete part. You
can define the position, offsets and rotation of the added parts or cuts in
several ways.

Objects created

The component can add a maximum of four parts or cuts to a concrete part.
The added parts can be welded to the main part, added as parts and cast
units, or as sub-assemblies.

Use for

• Cut-out seams from concrete walls

• Adding concrete support blocks to concrete columns or walls

Selection order

1. Select the main part.

The part or cut is created automatically.

Part 1 / Part 2 / Part 3 / Part 4 tab
Use the Part 1, Part 2, Part 3 or Part 4 tab to create one additional part or cut
to the concrete part.
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Profile

Select the profile to be added to the concrete part or used for the cut.

Select how the added part is connected to the main part.

Option Example
No part created.

Part is created.
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Option Example
Part is created and added to the main part.

Part is created and the main part is cut.
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Option Example
Main part is cut.

Part is created and cast unit is created.

Part is created and welded to the main part.
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Option Example
Part is created and welded to the main part, and
the main part is cut.

Part is created and added as sub-assembly.

Part is created and added as sub-assembly, and the
main part is cut.

Offset

Define the offset of the added part from the main part. You can set the offset
also for openings.

By default, the added parts or cuts are created between the end points of the
concrete part.
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Coordinate system

On the Part 1 tab, select Use global xy-plane to place the corbels on the
global XY plane or Use local to place the corbels on the local XY plane of the
part.

Note that setting the coordinate system on the Part 1 tab also affects the
corbels that are created on the Part 2 - 4 tabs.

Create diamond corbel around column

Select whether a diamond corbel is created around the column.

If you create the corbel, you cannot enter any values on the Part 2, Part 3 or
Part 4 tabs.

Chamfers

You can chamfer the added parts. You can define the chamfers either as
angles or as dimensions.

Positioning of the parts

Option Description
Select the side where the added parts or cuts
are created.

Select the alignment of the added parts or cuts.

You can swap the end points of the added parts
or cuts.
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Option Description
Select whether the existing cuts should be
taken into account when the added parts are
created.

Part 2 / Part 3 / Part 4 tab

You can add or cut more than one part at the same time. To do this, use the
tabs Part 2, Part 3 and Part 4.

Configuration tab
Use the Configuration tab to define the distance in material and whether
information needs to be printed.

UDA tab
Use the UDA tab to define user-defined attributes for the parts.

Use the Fabricator name, Name, Type, Nomination, Article number and
Comment user-defined attributes (UDAs) to add information for the added
parts or cuts.
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Concrete console (110)
Concrete console (110) creates a connection between a concrete column and
a concrete beam. The beam rests on a console which is attached to the
column.

Objects created

• Console

• Neoprene strip

• Steel plate between console and beam

• Anchor rods

• Tubes

• Sockets

Use for

Situation Description
Console connection between a
concrete column and a concrete
beam.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to define the shape and the dimensions of the console,
and the steel support plates and the neoprene layer.

 Description
1 Shape and dimensions of the concrete console and the steel and

neoprene parts.
2 Select how the shape of the

secondary beam is modified if
the secondary beam is sloping.
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 Description
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 Description
 

3 Console offset.

You can set the reference to be
the main part or the secondary
part. Additionally, the offset
distance can be defined.

Reference =
column centerline

If no offset value is
applied, the
console is placed
symmetrically
compared to the
column.

Reference =
column left side

Reference =
column right side

Reference = beam
centerline

Reference = beam
left side

Reference = beam
right side
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 Description
4 Vertical plate offset.

You can set the reference to be
the main part or the secondary
part. Additionally, the offset
distance can be defined.

Reference =
column centerline

Reference =
column left side

Reference =
column right side

Reference = beam
centerline

Reference = beam
left side

Reference = beam
right side

5 Define the console thickness.

Select whether the console thickness is taken from the secondary part or
the main part. The default option is that the console thickness is taken
from the secondary part.

6 Console tapering.
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 Description
7 Select whether to create a cut around the console in the secondary part.

Define the cut dimension from the edge of the cut to the edge of the
console.

Parts tab
Use the Parts tab to define properties for the console, the neoprene layer and
the optional steel plates.

Option Description
Concrete console Prefix and start number for the part position

number, material, name, class and comment for the
console.

Console to column Select how the console is attached to the concrete
column.

Default is Part Add.

The No action option means that the console is a
loose part and not attached to any other part in the
component.

Create console like Select how the console is created.

Default is Contour plate.

Contour plate = the console is created using the
Contour plate command.

Beam = the console is created using the Beam
command.

Neoprene Neoprene layer properties.

A neoprene plate for shock absorbing and sound-
damping can be created between the beam and the
console.

If a trapezium shaped neoprene block is used, the
defined thickness will be the thickness on the
column side.

Neoprene to Select to which part the neoprene layer is attached,
and how the neoprene is attached.

Default is Beam and Weld.
Holes in neoprene Select how the holes in the neoprene part are

created.

Default is By bolt.
Diameter of holes in
neoprene

Diameter of the holes in the neoprene part.

Concrete components reference 2862 Concrete Detailing



Option Description
By default, the hole size in the neoprene part is
equal to the holes in the console.

Enter a value to overwrite this default hole size.
Steel plate horizontal Horizontal steel plate size and properties.

The plate is placed under the neoprene part.
Steel plate vertical Vertical steel plate size and properties.

The plate is placed at the console side.
Add steel plate to the
column by

Select how the steel plate is attached to the column.

Default is Weld.

Connection tab
Use the Connection tab to define the properties of the anchor rods, nuts and
washers and injection tubes and to select how these parts are connected to
the console or the main part.

Option Description
Anchor rods Anchor rod profile.

Define the length and number of rods on the Anchor
rods tab.

Type of reinforcing
bars

Select the reinforcing bar type.

Anchors to Select to which part the anchor rods are attached, and
how the anchors are attached.

Default is Column and Weld.
Anchors all the
same L

Select whether the anchor rods have the same length.

Bottom section Select the profile from profile catalog.
Nut Nut profile.

Define the height of the nut on the Anchor rods tab.
Washer Washer profile.

You can define the direction and the rotation for each
washer.

Define the thickness of the washer on the Anchor
rods tab.

Weld washer and
nut to anchor

Select whether washers and nuts are welded to the
anchors.

Concrete components reference 2863 Concrete Detailing



Option Description
Tube top Tubular embed for creating a round hole for the

anchors.

The tube top starts at the bottom level of the nut.
Tube bottom Tubular embed for creating a round hole for the

anchors.

The height of the tubular profile can be modified on
the Anchor rods tab.

Tubes around
anchors to beam

Select how the tubes around the anchors are attached
to the beam.

Default is Weld.
Tubes all the same L Select whether the tubes have the same length.
Tubes aligned with Select whether the tubes are aligned with the column,

top of the beam, or bottom of the beam.
Create cuts around
tubes

Select whether cuts are created around the tubes.

Parameters tab
Use the Parameters tab to define how the column and the beam are cut
(skew/square).

Option Description
Fitting to column Select how the top of the column is fitted.

Default is Perpendicular.
Column cut-out Default.

A full-width cut-out is
created.

Column left side cut-out.
Clearance between the
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Option Description
column and the beam can be
set.

Column right side cut-out.
Clearance between the
column and the beam can be
set.

Both sides cut-out. Clearance
between the column and the
beam can be set on both
sides.

Beam end cut-out

Use this option when
the beam and the
column are not
aligned.

Square beam end

Skewed beam end
(according to main part)
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Option Description
Beam bottom cut-out

Use this option when
the beam and the
column are not
aligned.

Square beam bottom

Skewed beam bottom
(according to main part)

Column cut-out for T-
shaped secondary part

In Beam type, select the
shape of the secondary part.

• Rectangular - always
creates a rectangular
column cut-out.

• T-beam - Tekla
Structures checks the
shape of the beam and
creates a T-shaped
column cut-out.

• Automatic - Tekla
Structures automatically
checks the shape of the
secondary part, and
creates either a
rectangular or a T-shaped
column cut-out.

Automatic is the default
value.

For T-shaped cut-outs,
define the cut-out dimension
between the column and the
beam.

Secondary part width Define the maximum width
of the secondary part and
cut it to this width.

Cut extra secondary
parts

You can find and cut extra secondary parts by using
classes or name search.
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Anchor rods tab
Use the Anchor rods tab to define dimensions and position of the anchor
rods.

 Description
1 Anchor rod length, hole diameter and top offset.
2 Number of anchor rods, distances and edge distances.
3 Anchor rod distribution options.

Useful when the beam is not aligned with the column.
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 Description
4 Select the type of the hole in the beam.

Default is Circular.

If you set the type to Circular, use the two boxes on
the left to define the hole diameter.

If you set the type to Square, use the four boxes on
the left to define the dimensions of the square cut.

5 Height of the tubular profile, nut and washer.
6 Anchor rods and cuts Default.

Anchor rods are
created. Holes for
the anchors are
created.

Anchor rods are
created. No holes
are created.

Only holes are
created. No
anchors are
created.
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 Description
Only anchor rods
are created. No
holes are created.

Cut-out in the
concrete beam.
Anchor rods are
created. No holes
are created.

Cut-out in the
concrete beam
(parallel to beam).
Anchor rods are
created. No holes
are created.

Tube offset

Define the offsets for the tube profiles in both the X and Y directions.

Socket tab
Use the Socket tab to define whether socket anchors are created, how they
are connected and the dimensions and position of the socket anchors.

If you create the sockets on the Socket tab, the anchor rods on the
Connection tab are automatically considered as sockets.

Option Description
Create socket Select whether sockets are created

and which parts are included.
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Option Description
Connect socket to prim by Select how the sockets are connected

to the main part.
Connection rod-connector Select the connection method

between the rod and the connecting
profile.

Type of reinforcing bars Select the rod type.
Leg rotation Select the direction of the rod. You

can enter an angle in the box on the
right.

Legs symmetrically Select whether custom part sockets
are created symmetrically.

Connector

Dowel

Properties for the connecting profile
and the rod.

Partname component If you want to use a custom part to
create the socket, select the Custom
part option in the Create socket list.
Then browse for the component, and
use the list of options to position the
custom part.

General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Concrete console (111)
Concrete console (111) creates a connection between a concrete column and
two secondary concrete beams. The beams rest on a console which is
attached to the column.

Objects created

• Console

• Neoprene strip

• Steel plates

• Anchor rods

• Tubes

• Sockets
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Use for

Situation Description
Console connection between a
concrete column and two concrete
beams.

Console connection between a
concrete column and one concrete
beam.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define the shape and the dimensions of the console,
and the steel support plates and the neoprene layer.
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Parts tab
Use the Parts tab to define properties for the console, the neoprene layer and
the optional steel plates.

Option Description
Console width Define the prefix and a start number for the part

position number, material, name, class and
comment for the console.

Define the width on the Picture tab.

If no value is entered, the width is the same as the
width of the beam.

Console to column Select how the console is attached to the column.
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Option Description
Default is Part Add.

The No action option means that the console is a
loose part and not attached to any other part in the
component.

Create console like Select the profile type of the console.

Default is Contour plate.

Contour plate = the console is created using the
Contour plate command.

Beam = the console is created using the Beam
command.

Neoprene Neoprene layer properties.

A neoprene plate for shock absorbing and sound-
damping can be created between the beam and the
console.

If a trapezium shaped neoprene block is used, the
defined thickness will be the thickness on the
column side.

Neoprene to Select to which part the neoprene layer is attached,
and how the neoprene is attached.

Default is Beam and Weld.
Holes in neoprene Select how the holes in the neoprene part are

created.

Default is By bolt.
Diameter of holes in
neoprene

Diameter of the holes in the neoprene part.

By default, the hole size in the neoprene part is
equal to the holes in the console.

Enter a value to overwrite this default hole size.
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Option Description
Select if the neoprene layer is split for each beam
separately.

Steel plate horizontal Horizontal steel plate size and properties.

The plate is placed under the neoprene part.
Steel plate vertical Vertical steel plate size and properties.

The plate is placed at the console side.

Add steel plate to the
column by

Select how the steel plate is attached to the column.

Default is Weld.

Anchor tab
Use the Anchor tab to define the properties of the anchor rods, nuts and
washers and injection tubes, and select how these parts are connected to the
console or the main part.
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Option Description
Anchor rods Anchor rod profile.

Define the length and number of rods on the Anchor
rods tab.

Type of reinforcing
bars

Select the reinforcing bar type.

Anchors to Select to which part the anchor rods are attached, and
how the anchors are attached.

Default is Column and Weld.
Anchors all the
same L

Select whether the anchor rods have the same length.

Bottom section Select the profile from profile catalog.
Washer Washer profile.

Define the thickness of the washer on the Anchor
rods tab.

Nut Nut profile.

Define the height of the nut on the Anchor rods tab.
Weld washer and
nut to anchor

Select whether washers and nuts are welded to the
anchors.

Tube top Tubular embed for creating a round hole for the
anchors.

The tube top starts at the bottom level of the nut.
Tube bottom Tubular embed for creating a round hole for the

anchors.

The height of the tubular profile can be modified on
the Anchor rods tab.

Tubes around
anchors to beam

Select how the tubes around the anchors are attached
to the beam.

Default is Weld.
Tubes all the same L Select whether the tubes have the same length.
Tubes aligned with Select whether the tubes are aligned with the column,

top of the beam, or bottom of the beam.
Create cuts around
tubes

Select whether cuts are created around the tubes.

Anchor rods tab
Use the Anchor rods tab to define dimensions and position of the anchor
rods.
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 Description
1 Anchor rod length, hole diameter and top offset.
2 Number of anchor rods, distances and edge distances.
3 Anchor rod distribution options.

Useful when the beam is not aligned with the column.

4 Select the type of the hole in the beam.

Default is Circular.

If you set the type to Circular, use the two boxes on
the left to define the hole diameter.

If you set the type to Square, use the four boxes on
the left to define the dimensions of the square cut.

5 Height of the tubular profile, nut and washer.
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 Description
6 Anchor rods and cuts Default.

Anchor rods are
created. Holes for
the anchors are
created.

Anchor rods are
created. No holes
are created.

Only holes are
created. No
anchors are
created.

Only anchor rods
are created. No
holes are created.

Cut-out in the
concrete beam.
Anchor rods are
created. No holes
are created.
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Anchor rods beam 2 tab
Use the Anchor rods beam 2 tab to define the properties of the anchor rods,
nuts and washers and injection tubes for the second secondary beam. The
default profile for the anchor rods created for the second secondary beam is
the same as for the anchors created on the Anchor tab.

Option Description
Anchor rods Anchor rod profile.

Define the length and number of rods on the Anchor
rods tab.

Type of reinforcing
bar

Select the reinforcing bar type.

Bottom section Select the profile from the profile catalog.
Nut Nut profile.

Define the height of the nut on the Anchor rods tab.
Washer Washer profile.

Define the thickness of the washer on the Anchor
rods tab.

Tube top Tube profile.

Tubular embed for creating a round hole for the
anchors.

The tube top starts at the bottom level of the nut.
Tube bottom Tube profile.

Tubular embed for creating a round hole for the
anchors.

The height of the tubular profile can be modified on
the Anchor rods tab.
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 Description
1 Anchor rod length, hole diameter and top offset.
2 Select the type of the hole in the beam.

If you set the type to Circular (neg.vol.), use the two boxes on
the left to define the hole diameter. Circular (neg.vol.) is the
default value.

If you set the type to Circular (drilling), use the two boxes on
the left to define the hole diameter.

If you set the type to Square, use the four boxes on the left to
define the dimensions of the square cut.

Socket tab
Use the Socket tab to define whether socket anchors are created, how they
are connected and the dimensions and position of the socket anchors.

If you create the sockets on the Socket tab, the anchor rods on the Anchor
tab are automatically considered as sockets.

Option Description
Create socket Select whether sockets are created

and which parts are included.
Connect socket to prim by Select how the sockets are connected

to the main part.
Connection rod-connector Select the connection method

between the rod and the connecting
profile.

Type of reinforcing bars Select the rod type.
Leg rotation Select the direction of the sockets.

You can enter an angle in the box on
the right.

Connecting profile

Rod

Properties for the connecting profile
and the rod.

Partname component If you want to use a custom part to
create the socket, select the Custom
part option in the Create socket list.
Then browse for the component, and
use the list of options to position the
custom part.

General tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Concrete beam-beam (112)
Concrete beam - beam (112) creates a connection between a concrete beam
and one or two secondary concrete beams.

Objects created

• Neoprene

• Steel plates

• Anchor rods

• Tubes

• Sockets

Use for

Situation Description
Connection between two concrete
beams.
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Situation Description
Connection between three concrete
beams.

Selection order

1. Select the main part (beam).

2. Select one or two secondary parts (beam).

3. Click the middle mouse button to create the connection.

Part identification key

 Part
1 Beam
2 Beam

Picture tab
Use the Picture tab to control the part dimensions and the shapes of the
parts, and the recesses.
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Dimensions

 Description Example
1 Define the gap between the main

part and the secondary part on the
left and the right side.

2 Define the vertical gap between the
main part and the secondary part.
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 Description Example
3 Define the length of the neoprene.

4 Define the gap between the
neoprene and the secondary part on
the left and the right side.

5 Define the length of the steel plate.
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 Description Example
6 Define the gap between the steel

plate and the secondary part on the
left and the right side.
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 Description Example
1 Define the distance from the

centerline of the secondary parts
to the outer contour of the main
part on the left side.

2 Define the distance from the
centerline of the secondary parts
to the outer contour of the main
part on the right side.
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 Description Example
3 Define the distance from the

edge of the first secondary part
to the centerline.

4 Define the distance from the
edge of the second secondary
part to the centerline.
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 Description Example
5 Define the depth of the recess in

the main part.

6 Define the depth of the recess in
the secondary part.
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 Description Example
7 Define the width of the recess in

the first secondary part.

8 Define the width of the recess in
the second secondary part.
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 Description Example
9 Define the width of the

neoprene.

10 Define the distance from the
edge of the neoprene to the edge
of the main part.

11 Define the distance from the
edge of the neoprene to the edge
of the main part.
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 Description Example
12 Define the width of the steel

plate.

13 Define the distance from the
edge of the steel plate to the
edge of the main part.
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 Description Example
14 Define the distance from the

edge of the neoprene to the edge
of the main part.

15 Define the distance from the
edge of the recess in the main
part to the edge of the secondary
part.

Fit secondaries perpendicular to

Option Description
Default

Secondary parts are fitted perpendicular to the main
part.

AutoDefaults can change this option.
Secondary parts are fitted perpendicular to the main
part.
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Option Description
The top side of secondary parts is fitted perpendicular
to secondary parts while the bottom side of secondary
parts is fitted perpendicular to the main part.

Both the top side and the bottom side secondary parts
are fitted perpendicular to secondary parts.

Parts tab
Use the Parts tab to control the neoprene and steel plate properties and how
these parts are connected.

Neoprene and steel plate

Option Description
Neoprene Define the neoprene thickness, width and height.
Steel plate Define the steel plate thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Neoprene properties

A neoprene plate for absorbing shock and for damping sound can be used
between the main and the secondary parts.
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Option Description
Neoprene to Define to which part the neoprene is

connected. The neoprene can also be a loose
part.

In the second list, define how the neoprene is
connected to the part.

Holes in Neoprene Define how the holes in the neoprene are
created.

Diameter of Holes in
Neoprene

Define the diameter of the holes in the
neoprene.
Define whether the neoprene is fitted to fill
the cut space between the main part and the
secondary part, or whether it is created in a
rectangular shape.

Define whether the neoprene is created as
one single plate or as two plates, and the
edge distance from the neoprene to the
secondary parts.

Steel plate properties

One or two additional steel plates can be used between the main and the
secondary parts.

Option Description
Add steel plate to
the primary by

Define how the steel plate is connected to
the main part.

Negative volume
around steel plate

Define whether there is a negative volume
around the steel plate.
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Anchors tab
Use the Anchors tab to control the properties of anchor rods, nuts, washers
and the top and bottom tubes.

Option Description
Anchor rods Anchor rods can be used between the main and the

secondary parts.

Select the anchor rod profile from the profile catalog. If
you set the Type of reinforcing bars option to
Reinforcing bar, select the reinforcing bar from the
catalog.

Nut Select the nut profile from the profile catalog.
Washer Select the washer profile from the profile catalog.
Tube top, Tube
bottom

Tubes can be used between the main and the
secondary parts.

Select the profile from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Anchor rods

Type of reinforcing bars Define the type of reinforcing bars.
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Anchors to Define to which part the anchor rods
are connected. The anchor rods can
also be loose parts.

In the second list, define how the
anchor rods are connected to the
part.

Anchors all the same L Define whether the anchor rods have
the same length.

Bottom section Define the type of profile in the
bottom section.

Anchors only in secondary Select whether anchor rods are
included only in the secondary parts.

Washer

Define the position of the washer handles.

Washer plate

Define the position of the plate handles.

Define whether the washers and nuts are welded to the plates.
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Tube top and tube bottom

You can add a tubular embed for creating a round hole for the anchors. The
tube top starts at the bottom level of the nut.

Option Description
Tubes around
anchors to beam

Define how to connect the tubes to the beam.

Tubes all the same
L

Define whether the tubes have the same length.

Tubes aligned with Select whether the tubes are aligned with the main
part, or with the top or bottom of the secondary part.

Create cuts around
tubes

Select whether cuts are created around the tubes.

Anchor rods tab
Use the Anchor rods tab to control the number, dimensions and position of
the anchor rods and the dimensions of the recesses in the main and
secondary parts.

Dimensions
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 Description Example
1 Define the size of

the holes in the
beam.

2 Define the size of
the recesses in the
beam in both
directions.
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 Description Example
3 Define the type of

the holes in the
beam.

4 Define the distance
between the top of
the anchor rod and
the top of the beam.
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 Description Example
5 Define the distance

between the bottom
of the recess and the
top of the anchor
rod.

6 Define the distance
between the bottom
of the recess in the
main part and the
bottom of the recess
in the secondary
part.
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 Description Example
7 Define the distance

from the centerline
of the secondary
parts to the outer
contour of the main
part.
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 Description Example
8 Define the width of

the anchor rod
hook.
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 Description Example
9 Define the height of

the anchor.

10 Define the angle of
the anchor rod
hook.
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 Description Example
11 Define the radius of

the anchor rod hook
in the main part in
the vertical
direction.
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 Description Example
12 Define the anchor

rod edge distances
from the main part.

13 Define the number
of anchor rods.

14 Define the anchor
rod spacing.

Use a space to
separate anchor rod
spacing values. Enter
a value for each
space between
anchor rods. For
example, if there are
3 anchor rod rows,
enter 2 values.
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 Description Example
15 Define the anchor

rod edge distances
from the secondary
parts.

16 Define the number
of anchors rods.

17 Define the anchor
rod spacing.

Use a space to
separate anchor rod
spacing values. Enter
a value for each
space between
anchor rods. For
example, if there are
3 anchor rod rows,
enter 2 values.
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 Description Example
1 Define the distance

between the top side of
the top tube and the top
of the part.

2 Define the height of the
nut.
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 Description Example
3 Define the height of the

washer.

4 Define the distance
between the bottom side
of the top tube and the
bottom side of the recess.

5 Define the distance
between the top side of
the bottom tube and the
bottom side of the recess.
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 Description Example
6 Define the distance

between the bottom side
of the bottom tube and
the bottom side of the
part.

Recesses

Define whether anchors and recesses are created.

Option Description
Anchors and recesses

Anchors

Recesses

In the list below the options, select whether the position of anchor rods is
calculated in the coordinate system of the main part or the secondary part.

Socket tab
Use the Socket tab to control the socket properties and how the sockets are
connected. If you create the sockets on the Socket tab, the anchors on the
Anchors rods tab are automatically considered as sockets.
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Sockets

Option Description
Create socket Select whether sockets are created

and which parts are included.
Connect socket to prim by Select how the sockets are connected

to the main part.
Connection rod-connector Select how to connect the rod

connector.
Type of reinforcing bars Select the rod type.
Leg rotation Select the direction of the sockets.

In the second list, define the angle of
the sockets.

Connecting profile, Rod

Option Description
Connecting
profile

Select the profile from the profile catalog.

Rod Select the rod profile from the profile catalog.

If you set the Type of reinforcing bars option to
Reinforcing bar, select the reinforcing bar from the
catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
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Partname component

Option Description
Partname
component

If you use a custom component to create the socket,
browse for the component and use the list of options
to position the custom component.

Rebars in primary tab / Rebars in secondary tab
Use the Rebars in primary tab and Rebars in secondary tab to create
reinforcing bars and stirrups at the connection position. On the Rebars in
primary tab you can create longitudinal reinforcing bars and stirrups for the
main part, and on the Rebars in secondary tab you can define stirrups for the
secondary part.

Rebars in primary

Create the rebars for the main part either by defining the number of rebars, or
by setting the spacing or the exact space.

Set the rebar properties, and define the cover thickness and leg length from
the edge of the opening.
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Rebars in secondary

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Panels and walls
This section introduces components that can be used in concrete panels and
walls.

Click the links below to find out more:

• Wall to wall connection (page 2912)

• Wall groove seam detail (page 2917)

• Anchor (10) (page 2923)

• Wall wall teeth (12) (page 2937)

• Electric box in wall (84) (page 2945)

• Sandwich And Double Wall (page 2960)

• Sandwich wall horizontal seam (page 2986)

• Sandwich wall vertical seam (page 2994)
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• Sandwich wall window (page 3002)

• Wall layout tools (page 3023)

• Geometry detailing strip (page 3050)

Wall to wall connection
Wall to wall connection creates a connection between two precast walls. The
connection can contain a groove with or without additional shear teeth.
Additionally, the connection can create reinforcing bar loops or embeds that
work as connectors in the walls.

Objects created

• Groove

• Shear teeth or shear cups

• U bars

• Embeds

• Long bar

Use for

Situation Description
Wall to wall connection with groove,
shear teeth, U bars and a loose bar.

Selection order

1. Select the first wall.
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2. Select the second wall.

The connection is created automatically when the second wall is selected.

Edge shape tab
Use the Edge shape tab to select the wall framing type

Option Description
Wall framing type selection.

Wall framing type selection affects the wall edge
shape options.

You can use the connection in three different
modeling situations:

• end-to-end

• corner

With this option the first selected wall is fitted to
align with the exterior face of the second
selected wall.

• tee
Wall edge shape.

Select the edge shape of each wall.

Adjust the free space between two walls.

Wall edge dimensions.

To set the edge shape and dimensions
independently for both walls, use the Use given
dimensions option.

To make the edge shape similar in both walls, use
the Same to right side option.
Groove start and end point.

You can define the start point and the end point of
the groove. If you do not enter a value, or enter 0,
the groove is applied at full height of the wall.

Select to create part cuts or only extra part cuts,
and define the name of the cut. You can set this
separately for both walls. For part properties of
extra part cuts, select a saved settings file.
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Extra teeth tab
Use the Extra teeth tab to define the properties for additional shear teeth.

Option Description
Select whether additional shear teeth or shear
cups are created.

Teeth or cups can also be created when there
is no groove.

Dimensions of a single tooth or cup.

Location of the first tooth or cup in the first
wall and in the second wall, and the spacing
between the teeth or cups.

You can enter a list of spaces, for example
10*400, or just a single value. When you enter
a single value, the number of teeth or cups is
calculated automatically based on the height of
the connection.
Select to create part cuts or only extra part
cuts, and define the name of the cut.

Connectors tab
Use the Connectors tab to select the type of connectors created.

Connector type

The content of the Connectors tab varies depending on the type of the
selected connectors.
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Option Description
Connector type.

• No connectors. Only groove with or without shear
teeth is created.

• Connectors are created by using the selected
embed (custom part).

• Connectors are created by adding reinforcing bar
loops. Reinforcing bar loop is formed depending
on the wall framing type.

In addition, the connector can optionally create one
or more long reinforcing bars along the connection.

Embeds and loose rebar

Option Description
Location of the first connector (embed) in
the first wall and in the second wall,
location of the last rebar/embed in the
wall top edge, and the spacing between
the connectors.

You can enter a list of spaces, for
example 10*400, or just a single value,
for example 300. When you enter a
single value, the number of connectors is
calculated automatically based on the
height of the connection.

You can also define the extended length
of the loose long bar.
Select which embeds (custom parts) are
created in each wall.

If the embed has any saved attributes,
select which attributes are used.
Offset of the embed.

By default, the embed input points are in
the center of the wall.
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U bars and loose rebar

Option Description
Location of the first connector
(reinforcing bar loop) in the first wall and
in the second wall, and the spacing
between the connectors.

You can enter a list of spaces, for
example 10*400, or just a single value,
for example 300. When you enter a single
value, the number of connectors is
calculated automatically based on the
height of the connection.

You can also define the extended length
of the loose long bar.
Reinforcing bar loop dimensions.

The available dimension options depend
on the wall framing type selected on the
Edge shape tab.

Many of the dimensions have counter
parts in the first wall and in the second
wall. It is enough to enter one dimension
and by default the counter part
dimension gets the same value.

Number of bars Number of long loose bars.

If you do not want to create a loose long
bar, enter 0 as the Number of bars.

Reinforcing bar properties

Enter the properties for reinforcing bar Grade, Size, Name, Class, Prefix and
Start Number.
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Customization

If needed, you can create your own embed (custom part) and use it as a
connector.

When creating the embed, ensure that the input points are defined so that
they are compatible with Wall to wall connection. The image below shows
examples of the input points.

Thickening tab
Use the Thickening tab to create an extra thicknening to one or both walls.

Option Description
Select to which side of the wall the
thickening will be created. The final
location of the extra thickening
depends on the actual framing case
(end to end, L corner, T corner).

Enter the name and class for the
extra thickening. Leave the input box
empty to use the wall name and/or
class.
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Wall groove seam detail
Wall groove seam detail creates a groove with optional shear teeth to a
precast wall, a slab or a similar part. Additionally the connection can create
reinforcing bar loops or embeds that work as connectors in the walls.

Objects created

• Groove

• Shear teeth or shear cups

• U bars

• Embeds

• Long bar

Use for

Situation Description
Groove with shear teeth and U bars.

Selection order

1. Select the wall or slab.

2. Pick the start point of the groove.

3. Pick the end point of the groove.

Edge shape tab
Use the Edge shape tab to select the orientation of the groove.

Option Description
Groove orientation selection.

Define the orientation of the groove in relation to
the input points.

Concrete components reference 2918 Concrete Detailing



Option Description
Create fitting Select whether the part end fitting is created.

Groove edge shape.

Groove start and end point in relation to input
points.

You can define the start point and the end point of
the groove. If you do not enter a value, or enter 0,
the groove is applied at full height of the wall.

Select to create part cuts or only extra part cuts,
and define the name of the cut. For part properties
of extra part cuts, select a saved settings file.

Extra teeth tab
Use the Extra teeth tab to define the properties for additional shear teeth.

Option Description
Select whether additional shear teeth or shear
cups are created.

Teeth or cups can also be created when there
is no groove.
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Option Description
Dimensions of a single tooth or cup.

Location of the first tooth or cup in the groove,
and the spacing between the teeth or cups.

You can enter a list of spaces, for example
10*400, or just a single value. When you enter
a single value, the number of teeth or cups is
calculated automatically based on the height of
the detail.
Select to create part cuts or only extra part
cuts, and define the name of the cut.

Connectors tab
Use the Connectors tab to select the type of connectors.

Connector type

The content of the Connectors tab varies depending on the type of the
selected connectors.

Option Description
Connector type.

• No connectors. Only groove with or without
shear teeth is created.

• Connectors are created by using the
selected embed (custom part).

• Connectors are created by adding
reinforcing bar loops. Reinforcing bar loop
is formed depending on the framing type.

In addition, the connector can optionally create
one or more long reinforcing bars along the
connection.
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Embeds and loose rebar

Option Description
Location of the first connector (embed) in
the groove, location of the last rebar/
embed in the wall top edge, and the
spacing between the connectors.

You can enter a list of spaces, for
example 10*400, or just a single value,
for example 300. When you enter a
single value, the number of connectors is
calculated automatically based on the
height of the detail.

You can also define the extended length
of the loose long bar.
Select which embeds (custom parts) are
created in each groove.

If the embed has any saved attributes,
select which attributes are used.
Offset of the embed.

By default, the embed input points are in
the center of the groove.

U bars and loose rebar

Option Description
Location of the first connector
(reinforcing bar loop) in the groove,
and the spacing between the
connectors.

You can enter a list of spaces, for
example 10*400, or just a single
value, for example 300. When you
enter a single value, the number of
connectors is calculated automatically
based on the height of the detail.

You can also define the extended
length of the loose long bar.
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Option Description
Reinforcing bar loop dimensions.

The available dimension options
depend on the orientation of the
groove selected on the Edge shape
tab.

Number of bars Number of long loose bars

If you do not want to create a loose
long bar, enter 0 as the Number of
bars.

Reinforcing bar properties

Enter the properties for reinforcing bar Grade, Size, Name, Class, Prefix and
Start Number.

Customization

If needed, you can create your own custom part (embed) and use it as a
connector.

When creating the embed, ensure that the input points are defined so that
they are compatible with Wall groove seam detail. The image below shows
examples of the input points.
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Thickening tab
Use the Thickening tab to create an extra thicknening to the wall.

Option Description
Select to which side of the wall the
thickening will be created. The final
location of the extra thickening
depends on the actual framing case
(end to end, L corner, T corner).

Enter the name and class for the
extra thickening. Leave the input box
empty to use the wall name and/or
class.

Anchor (10)
Anchor (10) connects two precast concrete parts, for example, two panels or a
column to a panel. The precast concrete parts are connected with L profiles
and with embedded connection profiles that act as anchors, for example,
custom component bolt anchors or cast-in channels. The bolt anchors and the
cast-in channels can be single-sided or double-sided. Additionally, seams can
be defined between the main part and the secondary parts.
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Objects created

• Anchors (bolt anchors or cast-in channels)

• L profiles

• Bolts

Use for

Situation Description
Connection with L profiles and bolt
anchors.

Connection with L profile and cast-in
channel.

Selection order

1. Select the main part (precast concrete panel or a column).

2. Select the secondary part (precast concrete panel).

The connection is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to define the number of anchors (bolt anchors or cast-in
channel profiles), edge distances and plate embed offset.

 Description Example
1 Horizontal offset of the anchors.

The offset can be defined for both
concrete parts separately.

2 Vertical offset of the anchors.

The offset can be defined for the top
and bottom side.

 

3 Select how the anchors are
distributed.
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 Description Example
4 Select which of the anchors are

omitted.

5 Connection plate horizontal offset
from the centerline of an anchor.

This option is available only if you
have set the orientation of the
connection plate as follows on the
Conn profile tab:
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Anchors tab
Use the Anchors tab to define the properties, position and orientation of the
anchors (bolt anchors or cast-in channel profiles).

 Description Example
1 Anchor properties in the main part.

2 Select on which side the anchors are
created in the main part.
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 Description Example
3 Select whether a profile from the profile

catalog is used as an anchor, or a custom
part from the Applications &
components catalog.

 

4 Anchor properties in the secondary part.

5 Select on which side the anchors are
created in the secondary part.

 

6 Select whether a profile from the profile
catalog is used as an anchor, or a custom
part from the Applications &
components catalog.

 

7 Select the connection method of the
anchor.

• Default (same as Weld to element)

• Weld to element

• Cast unit to element

• Not add to element (bolt anchors or
cast-in channels are loose parts)

• Sub-assembly

 

8 Position and rotation of the anchors in the
main concrete part.

For the Position in plane and Position in
depth options, an offset can be defined.

 

9 Orientation of the anchors in the main
part.
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 Description Example
10 Position and rotation of the anchors in the

secondary concrete part.

For Position in plane and Position in
depth options, an offset can be defined.

 

11 Orientation of the anchors in the
secondary part.

12 Select the cut-out method of the anchors.

Default, no cut

No cut

Cut-out shape is the exact
profile contour of the bolt
anchor or the cast-in channel

Box shape cut-out
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Conn profile tab
Use the Conn profile tab to define the properties and position of the
connection L profile.

 Description Example
1 Connection profile properties.

2 Select on which side the connection
profiles are created.

3 Select whether a profile from the
profile catalog is used as a
connection profile, or a custom part
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 Description Example
from the Applications &
components catalog.

4 Position and rotation of the
connection profiles.

For the Position in plane and
Position in depth options, an offset
can be defined.

 

5 Orientation of the connection profile.

6 Connection profile cuts.

These options are available only if
you have set the orientation of the
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 Description Example
connection profile as follows on the
Conn profile tab:

7 Select the connection method of the
connection profile.

 

8 Select the connection profile type.

• Library profile (define the profile
using the L profile options).

• Folded plate (define the
dimensions using the options
below).

Bolts tab
Use the Bolts tab to define the bolt properties and offsets.
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 Description
1 Horizontal bolt distances from the L profile edges.

Default value is half of L profile flange width.
2 Vertical bolt offsets.

Reference is the L profile centerline. Default value is 0 mm.
3 Select how the bolts are added in the main part.
4 Select how the bolts are added in the secondary part.
5 Bolting direction.

Cuts tab
Use the Cuts tab to define the cuts and the seams in the main and secondary
parts.

Additionally, the main part can be extended, or the secondary part thickness
can be increased or decreased.

You can create a seam by defining a cut between the main part and the
secondary part.
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 Description Example
1 Extension of the main part.

If you need to extend the part,
enter a value. Ensure that you have
also selected a cut method from
the cut type list. If you select the
No cut option, the part is not
extended.

 

2 Seam width.

Reference is the L profile
centerline. Default value is 0 mm.

 

3 Left side cut along the secondary
part.

Reference is the part centerline.

Part thickness is decreased.

 

4 Right side cut along the secondary
part.

Reference is the part centerline.

Part thickness is decreased.
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 Description Example
5 Cut reference for the main and

secondary parts.

Main part near side

Main part centerline

Main part far side

6 Select the cut type.

Default, no cut
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 Description Example

Reference is the main part.
Secondary part will be adjusted to
the main part using a fitting.

Reference is the main part.
Secondary part will be adjusted to
the main part using a line cut.

Reference is main part. Just like
previous options, but the longest
part of the panel will be removed
using a line cut.

No cut

Default tab
Use Default tab to define part distances.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Wall wall teeth (12)
Wall wall teeth (12) connects two perpendicular concrete panels with a tooth-
shaped connection. The number of teeth can be set. Injection tubes and
connection bars can be added to the connection. The connection is created
with or without seams.

Objects created

• Tooth connection (2 or 3 teeth) between two panels

• Injection tubes

• Connection bars

Use for

Situation Description
2-teeth connection between two panels.

The height of the teeth can be modified and the
clearance between the teeth can be set.
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Situation Description
3-teeth connection between two panels with
connection bar.

Tooth connection between two panels with
connection bar and socket.

Selection order

1. Select the main part (concrete panel).

2. Select the secondary part (concrete panel).

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to define the number of teeth, the height of teeth, and
seam widths. Wall wall teeth (12) has two main connection types: A (two
teeth) and B (three teeth).
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 Description
1 Select the number and position of teeth.

Standard is A 2 teeth bottom up.

2 Horizontal seam width in the main part. For type A (2-teeth connection).
3 Secondary part tooth height.

Reference is center of the seam. For type A (2-teeth connection).
4 Main part tooth height.

Reference is center of the seam. For type A (2-teeth connection).

This value has an effect only if the secondary part tooth height (3) has no
value.

5 Vertical seam width between the teeth. For type A (2-teeth connection).
6 Horizontal seam width in the main part. For type A (2-teeth connection).
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 Description
7 Top tooth height. For type B (3 teeth connection).

Reference is center of the seam.

If there is no value, and the middle tooth height and the bottom tooth
height are defined, then the top tooth gets the residual height distance.

If none of the tooth heights are defined, then all three teeth get an equal
height: (wall height - seam width) / 3
This value has lowest priority from the three tooth height-defining
values.

Example:

Panel height is 1500mm. All three tooth heights are defined:

• Top: 400mm

• Middle: 700mm

• Bottom: 600mm

Total defined height of teeth = 1800mm. Result: top tooth gets height
1500-700-600=200mm

8 Vertical seam width between the teeth. For type B (3-teeth connection).
9 Bottom tooth height.

Reference is center of the seam. For type B (3-teeth connection).

If there is no value, and the top tooth and the middle tooth height are
defined, then the bottom tooth gets the residual height distance.

Parts tab
Use the Parts tab to define the properties and dimensions of injection tubes
and connection bars.
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Option Description
Injection tubes Injection tube properties.

You can define the placing of the injection tubes
separately for the top tooth, middle tooth and
bottom tooth.

1 Select whether an injection tube is created.

Example:

Default is No action.
Top tooth

Middle tooth

Bottom tooth

Select whether an injection tube is created in the
teeth and select the connection method.

Default is Part cut.
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Option Description
Connection bar Connection bar properties.

One connection bar can be created through the
teeth.

2 Select whether a connection bar is created and the
connection method.

Default is Yes + weld 1.
3 Depth of a connection bar from the top of the top

tooth.

Default is 0.
4 Depth of an injection tube from the top of the top

tooth.

Default is 0.
5 Depth of a connection bar from the top of the

bottom tooth.

Default is top tooth height + seam width. If both
values 5 and 7 are defined, then the value in the box
7 overwrites the value in the box 5.

6 Depth of an injection tube from the bottom of the
bottom tooth.

Default is 0.
7 Depth of a connection bar from the bottom of the

bottom tooth.

If both values 5 and 7 are defined, then the value in
the box 7 overwrites the value in the box 5.

Cut sec tab
Use the Cut sec tab to define the way the secondary concrete panel is cut.

By default the component creates a 2-teeth connection.

You can also define a fixed offset value for the cut.

If the concrete panels are not perpendicularly orientated, you can define how
the secondary part is fitted to the main part.
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Cut prim tab
Use the Cut prim tab to define the way the main concrete panel is cut.

You can also define a fixed offset value for the cut.

If the concrete panels are not perpendicularly orientated, you can define how
the main part is fitted to the secondary part.
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Socket tab
Use the Socket tab to define whether socket anchors are created, how they
are connected and the dimensions and position of the socket anchors. Sockets
are created only if you have created connection bars.

Option Description
Dimensions for socket anchor, rod profile
and connecting profile.

Create socket Select whether sockets are created and
which parts are included.

Note that a socket is created only if a
connection bar has been created on the
Parts tab.

In the examples the red profile is the
connection bar:

Connect socket Select how the sockets are connected to
the main part.

Default is By cast unit.
Connection rod-connector Select the connection method between

the rod and the connecting profile.

Default is Part add conn to rod.
Rod type Select the rod type.

Default is Poly-profile.
Leg rotation Select the direction of the rod. You can

enter an angle in the box on the right.
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Option Description
Default is Front.

Connecting profile

Rod

Bottom section

Properties for the connecting profile, rod
and bottom section.

Note that the bottom section is part-
added to the rod automatically.

Example:

Partname component If you want to use a custom part to create
the socket, select the Custom part
option in the Create socket list.

Then browse for the component, and use
the list of options to position the custom
part.

General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Electric box in wall (84)
Electric box in wall (84) creates electric boxes in walls.
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Objects created

• Electric boxes

• Tubes

Use for

Situation Description
Electric box in a wall with
top connection.

Electric box in a wall with
bottom connection.
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Situation Description
Electric box in a wall with
top and bottom
connections.

Selection order

1. Select a concrete panel.

2. Pick a position for the electric box.

3. Pick a position for the top connection.

4. Pick a position for the bottom connection.

The electric box and connections are created automatically.
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Part identification key

 Part
Electric box

Panel

Picture tab
Use the Picture tab to control the shape, number and position of the tubes
and the position of the electric boxes.

Tube direction

Option Description
Select the tube shape in the
up direction.
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Option Description
Select the tube shape in the
down direction.

Select the tube direction in
relation to the start point
(yellow) and end point
(magenta) of the wall.

Select the number of tubes
in the up direction.

Select the number of tubes
in the down direction.

Tubes to concrete / Electric parts to concrete

Select how the tubes and the electric parts are connected to the concrete part.

Option Description
As
subassembly

Add as a subassembly to the
concrete part.

By cast unit Add to the concrete part.
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Option Description
Welds Weld to the concrete part.
Not Do not connect to the concrete part.

Tube and electric box positions

Option Description
Select the position of the up
connection in the concrete part.
Select the position of the electric box
in the concrete part.
Select the position of the down
connection in the concrete part.

Parts tab
Use the Parts tab to control the tube properties at the top and bottom of the
concrete part and the position of the tube reference points.

Tube top / Tube bottom

Option Description Default
t, b, h Define the tube thickness,

width and height.
D19

Pos_No Define a prefix and a start
number for the part
position number.

ET 1
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Option Description Default
Material Define the material

grade.
PVC

Name Define a name for the
tube.

E-tube

Class Define the part class
number for the tube.

2

Comment Add a comment for the
tube.

1st reference point

Define a reference point for the tube. The reference point determines the
position of the part mark in a drawing.

Option Description Example
At top Start point is positioned

at the top of the tube.

At bottom Start point is positioned
at the bottom of the
tube.
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Option Description Example
At longest
segment

Start point is positioned
at the longest segment
of the tube.

At smallest
segment

Start point is positioned
at the smallest segment
of the tube.

Electric box tab
Use the Electric box tab to control the shape, number and dimensions of the
electric boxes and to define a possible connection piece (Tube a).

Electric box / Tube a

Option Description Default
t, b, h Electric box and the

connection piece (Tube
a) thickness, width and
height.

D19

Pos_No Prefix and a start
number for the part
position number.

ET 1

Material Material grade. PVC
Name Name for the electric

box and the connection
piece.

E-tube
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Option Description Default
Class Part class number for

the electric box and the
connection piece.

2

Comment Add a comment for the
electric box and the
connection piece.

Rotation

Control the rotation of the electric box and the connection piece.

Option Example
Front

Top

Back

Below
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Electric box shape

Option Description
Profiles / Custom part

Example custom part:

You can use a profile from the profile
catalog or select a custom component
from the Applications &
components catalog.

If you use a custom component,
browse for the component and use
the list of options to position the
custom component.

Select the shape of the electric box
and define the dimensions for the
electric box.

Select an extra shape for creating
several different types of electric
boxes.

This shape is visible in drawings and it
indicates the front and back side of
the electric box.

Number = Number of electric boxes in
horizontal or vertical direction.

1 Select the top connection pieces for
the electric box.

2 Select the left side connection pieces
for the electric box.

3 Select the right side connection pieces
for the electric box.
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Option Description
4 Select the bottom connection pieces

for the electric box.
Dimensions of the connection pieces.

Positions of the connection pieces.

Options to add the electric box to the
part.

• Create electric box

• Create electric box + cut electric
box

• Create electric box + cut bounding
box

Top conn / Bottom conn tab
Use the Top conn and Bottom conn tabs to control the shape and
dimensions of the top and bottom connection boxes, and to define a possible
connection piece (Tube a).

Top box / Bottom box / Tube a

Option Description
t, b, h Top and bottom connection box and the connection

piece (Tube a) thickness, width and height.
Pos_No Prefix and a start number for the part position number.
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Option Description
Material Material grade.
Name Name for the connection box and the connection piece.
Class Part class number for the connection box and the

connection piece.
Comment Add a comment for the connection box and the

connection piece.

Rotation

Control the rotation of the connection piece (Tube a).

Connection box shape

Top conn Bottom conn Description
Profiles / Custom part You can use a profile from

the profile catalog or select
a custom component from
the Applications &
components catalog.

If you use a custom
component, browse for
the component and use
the list of options to
position the custom
component.
Select the shape of the
connection box and define
the dimensions for the
box.

Dimensions of the
connection box.
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Top conn Bottom conn Description
Position of the connection
piece.

Options to add the
connection box to the part.

• Create connection box

• Create connection box
+ cut connection box

• Create connection box
+ cut bounding box

Select the connection
pieces for the connection
box.

Select the number of
connection boxes.

Connect

Define how to the connection box is connected.
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UDA tab
Use the UDA tab to add information in the parts’ user-defined attributes
(UDAs).

Option Description
Part Select to which part the related information can be saved:

Nothing

Tube top

Tube bottom

Tubes

Electric box

Top connection

Bottom connection

All
UDA
name

Enter the name of the
user-defined attribute.

For example, to add a
comment UDA, open the
objects.inp file in a
text editor and search for 
comment. The following
attribute is shown:

attribute("comment",
"j_comment", string,
"%s", no, none,
"0.0", "0.0")
The first text between the
quotation marks is the
UDA name, comment. The
entered name is case
sensitive.

UDA name:

• comment

• fabricator

• art_number

• type

UDA:

• Comment

• Fabricator
name

• Article
number

• Type

Type Type of the user-defined
attribute.

Use String for text, Integer for
numbers, Float for numbers with
decimals and Option for
selecting an item in a list. You can
find the UDA type in the
objects.inp file

Value Enter the value that is saved to the user-defined attribute.
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Example
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Sandwich And Double Wall
Sandwich and Double Wall creates a precast concrete wall. The wall consists
of an inner shell, foil, insulation, and outer shell.

Objects created

• Inner shell

• Foil (optional)

• Insulation (optional)

• Outer shell (optional)
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Use for

Situation Description
Sandwich wall, split shells.

Sandwich wall, brick wall on outer
shell as surface treatment.

Selection order

1. Pick the first point.

2. Pick the second point.

The wall is created automatically when the second point is picked.
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Part identification key

 Part
1 Inner shell
2 Foil
3 Insulation
4 Outer shell

Parts tab
Use the Parts tab to control the dimensions and positioning of the sandwich
wall inner shell, foil, insulation, and outer shell. The inner shell is always
created.

Numbering settings

Set Numbering settings to Enabled to show Prefix and Start number for all
parts.

Inner shell

Option Description Default
Thickness Define the thickness of

the inner shell.
150 mm
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Foil

Option Description Default
Thickness Define the thickness of

the foil.
1 mm

Create foil Define whether the foil
is created.

Yes and subassembly

Insulation

Option Description Default
Thickness Define the thickness of

the insulation.
50 mm

Create insulation Define whether the
insulation is created.

Yes and subassembly

Edge strips in split case Define different material
and class properties for
parts on the edge of the
wall.

 

Outer shell

Option Description Default
Thickness Define the thickness of

the outer shell.
1 mm

Create outer shell Define whether the
outer shell is created.

Yes + cast unit

Properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options .

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options .
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  
Cast unit type Defines if the structure

type of the part is
Precast or Cast in
place.

Set Cast unit type to
Enabled to show Cast
unit type for parts.

Precast

Positioning

You can use Standard or Advanced positioning. With advanced positioning,
there are more options for sandwich wall width and foil position.

Sandwich wall width

Option: Standard Description
No gaps between the parts. Sandwich
wall thickness is the sum of all
created parts.

Define the total wall width.

A gap is created between the outer
shell and the insulation.

Option: Advanced Description
Define the total wall width and the
gap between the inner shell and the
insulation.

Another gap is created between the
outer shell and the insulation.
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Option: Advanced Description
Define the total wall width and the
gap between the outer shell and the
insulation.

Another gap is created between the
inner shell and the insulation.

Define the total wall width and the
gap between the inner shell and the
insulation.

No gap is created between the outer
shell and the insulation.

Foil position

Option Description
By default, the foil is placed on the
outer side of the inner shell.
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Option Description
Define another foil position. Set
Positioning to Advanced.

Point offset

Option Description
Define the offset from the outer face
of the inner shell.

Define the offset from the inner face
of the inner shell.

Define the offset from the center of
the sandwich wall.
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Option Description
Define the offset from the inner face
of outer shell.

Define the offset from the outer face
of outer shell.

Parametric profile

Option Description
Parametric section Set to Enabled to define the prefix for

the parametric profiles of the
sandwich parts.

Prefix for the parametric profile Select the prefix for the parametric
profile:

• Position h*b and Position
b*h to create plate profiles
without a prefix.

If Parametric section is set to
Disabled, the parts have an h*b
prefix, for example, 2000*100.

• Position PLh*b and Position
PLb*h to create plate profiles
whose prefix starts with PL.

• Par. section h*b and Par.
section b*h require you to
enter a parametric plate profile
prefix.

Par.section prefix Define the prefix of the parametric
profile.
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Vertical section tab
Use the Vertical section tab to control the vertical level part properties. You
can define both the top and the bottom level. The levels can be set as absolute
levels, or vertically relative (displaced) to the points.

Top level

Option Description
n1, n2, n3, n4 Define the absolute top level height.
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Option Description
h1, h2, h3, h4 Define the part height from the

bottom face.
d2, d3, d4 Define the vertical displacement from

the adjacent part.

When you use relative levels, the levels of all other parts depend on the inner
shell level.

Bottom level

Option Description
m1, m2, m3, m4 Define the absolute bottom level

height.
a1, a2, a3, a4 Define the bottom offset from the

point.
b2, b3, b4 Define the vertical displacement from

the adjacent part.

When you use relative levels, the levels of all other parts depend on the inner
shell level.
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Thicken innershell

You can define a thickening for both the top and the bottom side of the inner
shell.

Option Description Example
Inner shell is not
thickened.
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Option Description Example
Inner shell is thickened
towards the outer face of
the insulation.

Define the insulation
height to prevent
collisions.

Inner shell is thickened to
the inner face of the
outer shell.

Inner shell is thickened to
the outer face of the
outer shell.

Define the outer shell
height to prevent
collisions.

Inner shell covers the
insulation and outer
shell.
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Option Description Example
Thickness Define the inner shell

thickness.

If you do not enter a value, the
inner shell thickness defined
on the Parts tab is used.

Thickening parts Select how the top and
bottom thickening parts are
added to the inner shell.

Offset options Select the offset options for
the thickening parts. Offset
can be defined for both wall
ends.

Horizontal section tab
Use the Horizontal section tab to define the wall ends and to control how the
wall parts are split in the horizontal direction.

Wall end

The wall end options are the same for both ends.
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First wall end Second wall end

Wall end offset

Option Description Example
Inner shell end is fixed.

Define the offset for the
ends of the foil,
insulation, and outer
shell.

Insulation end is fixed.

Define the offset for the
ends of the inner shell,
foil, and outer shell.

Outer shell end is fixed.

Define the offset for the
ends of the inner shell,
foil, and insulation.
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Option Description Example
Corner shape to the
inside direction.

For the outer shell angle,
define the offset from
the inner face of the
inner shell. Insulation is
along the inner shell.

Corner shape to the
inside direction.

Define the length of the
outer shell angle.

Corner shape to the
inside direction.

For the outer shell angle,
define the offset from
the inner face of the
inner shell. Insulation is
along the outer shell.

Corner shape to the
outside direction.

Define the horizontal
offset for the outer shell.
There is no gap between
the insulation and the
inner shell angle.

Corner shape to the
outside direction.

Define the horizontal
offset for the outer shell.
For the inner shell angle,
define the offset from
the outer face of the
inner shell.
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Option Description Example
Corner shape to the
outside direction.

Define the horizontal
offset for the outer shell.
For the inner shell angle,
define the length.

Angled shells are not
created.

Define horizontal offset
for the inner shell,
insulation, and outer
shell.

Corner shape

Option Description
Select the inner shell corner shape.

Select the outer shell corner shape.
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Option Description
Select the insulation corner shape.

Add corner to main shell Add the corner to the shell. The options are:

• Add to 4 Cast Unit (4 = outer shell)

• Add to 4 Sub assembly
• Add to 1 Cast Unit (1 = inner shell)

• Add to 1 Sub assembly

Vertical chamfer

Option Description
Define whether a vertical chamfer is created.

Define the horizontal and vertical chamfer
dimensions, and the part prefix and the start
number.

Horizontal offset

To use the options, set the Split Front view option to Enabled.

Option Description
Define the horizontal offset for the foil,
insulation, and outer shell. The main gap
between the inner shells is defined in the Split
Front view section of the tab.
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Option Description
Define the horizontal offset for the inner shell,
foil, and outer shell. The main gap between the
insulation parts is defined in the Split Front
view section of the tab.

Define the horizontal offset for the inner shell,
foil, and insulation. The main gap between outer
shells is defined in the Split Front view section
of the tab.

Define a 90-degree angle for the inner shell and
the vertical offset towards the angled shell from
the inner face of the outer shell. The main gap
between the inner shells is defined in the Split
Front view section of the tab.

Additional options for the 90-degree angle:

• Define the corner shapes for the inner shell.

• Define how the corner is added to the inner
shell.

• Define the part prefix and the start number.

Mirroring

Option Description
Define whether the sandwich wall is
mirrored.

Splitting parts

To split wall parts, set the Split Front view option to Enabled.
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Option Description
Parts are not split. Define the
horizontal offset for both wall ends
using the points as reference points.
Parts are split. Define the section
width and the number of sections.

First end offset is the reference for
the first section width at the first wall
end.

Second end offset is the reference for
the last section width at the second
wall end.
Parts are split. Define the section
width and the number of sections.

First end offset is the reference for
the first section width at the first wall
end.

Point (2) is the reference of the last
section width at the second wall end.
Parts are split. Define the section
width and enter the number of
sections.

Point (1) is the reference of the start
section at the first wall end.

Second end offset is the reference for
the last section width at the second
wall end.
Parts are split. Define the section
width and enter the number of
sections.

Points (1, 2) are the references for the
section width at both wall ends.

Option Description
Define the horizontal direction.

Foil tab
Use the Foil tab to control the vertical and/or horizontal splitting of the foil.
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Dimensions

Option Description
1 Define whether the foil is split:

• Foil is not split.

• Foil is split in the horizontal
direction.

• Foil is split in the vertical direction.

• Foil is split in the horizontal and
vertical direction.

2 Define the number and width of the
middle sections.

3 Define the gap between the sections.
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Option Description
4 Define the width of the first and last

section in the horizontal direction.
5 Define the height of the top and

bottom section in the vertical
direction.

6 Define which wall end is used for
distributing the insulation sections.

Point direction Define the direction of the points. The
options are horizontal or vertical.

This option affects the representation
of workshop drawings.

Insulation tab
Use the Insulation tab to control the vertical and/or horizontal splitting of the
insulation.

Dimensions
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Option Description
1 Define whether the insulation is split:

• Insulation is not split.

• Insulation is split in the horizontal
direction.

• Insulation is split in the vertical
direction.

• Insulation is split in the horizontal
and vertical direction.

2 Define the number and width of the
middle sections.

3 Define the gap between the sections.
4 Define the width of the first and last

section in the horizontal direction.
5 Define the height of the top and

bottom section in the vertical
direction.

6 Define which wall end is used for
distributing the insulation sections.
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Option Description
Point direction Define the direction of the points. The

options are horizontal or vertical.

This option affects the representation
of workshop drawings.

Outside Shell tab
Use the Outside shell tab to control the vertical and/or horizontal splitting of
the outer shell. You can also define chamfers and add a brick wall surface.

Dimensions

Option Description
Define the direction for the splitting.

 Description
1 Define whether the outer shell is split:

• Outer shell is not split.
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 Description
• Outer shell is split in the

horizontal direction.

• Outer shell is split in the vertical
direction.

• Outer shell is split in the
horizontal and vertical direction.

2 Define the number and width of the
middle sections.

3 Define the gap between the sections.
4 Define the width of the first and last

section in the horizontal direction.
5 Define the height of the top and

bottom section in the vertical
direction.

Chamfering

Option Description
Vertical chamfers Define the vertical chamfers. Select a

chamfer shape from the list and
define the chamfer dimensions.
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Option Description
Horizontal chamfers Define the horizontal chamfers. Select

a chamfer shape from the list and
define the chamfer dimensions.

Chamfer side Define the sides where the chamfers
are created.

For example:

Brick wall properties

Set the Brick wall option to Enabled to create a brick wall.
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Option Description Example
Select the brick wall type
for the outer shell and
define the brick
dimensions, mortar
height and width.

Wall edges Define whether the wall
edges are created as
loose parts or whether
they are added into an
assembly.

 

UDA tab
Use the UDA tab to define user-defined attributes for the inner shell, foil,
insulation, and outer shell. You can define multiple UDAs for each part. UDAs
can be used as filters, and they can be displayed in drawings and reports.

Option Description
UDA
name

Enter the name of the
user-defined attribute.

For example, to add a
comment UDA, open the
objects.inp file in a
text editor and search for 
comment. The following
attribute is shown:

attribute("comment",
"j_comment", string,
"%s", no, none,
"0.0", "0.0")
The first text between the
quotation marks is the
UDA name, comment. The
entered name is case
sensitive.

UDA name:

• comment

• fabricator

• art_number

• type

UDA:

• Comment

• Fabricator
name

• Article
number

• Type

Type Type of the user-defined
attribute.

Use String for text, Integer for
numbers, Float for numbers with
decimals and Option for
selecting an item in a list. You can
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Option Description
find the UDA type in the
objects.inp file

Value Enter the value that is saved to the user-defined attribute.

For example:
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Sandwich wall horizontal seam
Sandwich wall horizontal seam creates a horizontal seam between two
sandwich walls. Seam dimensions and rabbets can be defined for all layers:
inner shell, foil, insulation, and outer shell. In addition, you can define an extra
foil layer.

Objects created

• Seams

• Rabbets

• Foil

• Insulation

• Extra foil layer

Use for

Situation Description
Seams between sandwich wall shells.

Seams with additional rabbets.

Before you start

To be able to select the needed parts, activate the Select objects in

components switch.
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Selection order

1. Select the inner shell of the first sandwich wall.

2. Select the inner shell of the second sandwich wall.

The seam is created automatically when the secondary part is selected.

Part identification key

 Part
1 Concrete part (wall, column, beam, slab)
2 Point

Multiple points can be picked.

Picture tab
Use the Picture tab to control the horizontal seam properties.

Seam position

Seams can be defined for inner shells, insulation and outer shells. Draft angles
can be defined for the outer shells.

Define the seam position between the sandwich wall shells. The middle line
between the walls is used as a reference when the seam position is calculated.
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Example:

Shell classes

Define the part classes to be applied to the seams. By default, the Sandwich
Wall Horizontal Seam component creates inner shells with class 1, foil with
class 2, insulation with class 3, and outer shells with class 4. Use these classes
to apply seams.

To prevent the creation of seams between foils, insulation shells and outer
shells, leave the Insulation classes box empty.

Rabbets in insulation

You can create rabbets in the insulation layer.
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Option Description
No rabbet for the insulation layer.

One side rabbet for the top and
bottom of the insulation layer.

Rabbet depth and width can be
defined.

Mirrored one side rabbet for the top
and bottom of the insulation layer.

Rabbet depth and width can be
defined.

Two sided rabbets for the top and
bottom of the insulation layer.

Rabbet depth and width can be
defined.
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Offset

You can define offset for the seam.

Rabbets tab
Use the Rabbets tab to define rabbets in inner shells, insulation layers and
outer shells.

Rabbet side

Select to which side of the sandwich wall the rabbets are applied. You can
define the rabbets separately for both sides.

The options are:

• Top side

• Bottom side

• Both sides

Connection type

You can select a tongue or groove joint connection for both sides.

Option Option Description
Tongue joint connection,
based on the outer
geometry

Groove joint connection,
based on the center line
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Option Option Description
Tongue joint connection,
based on the center line

Groove joint connection,
based on the outer
geometry

If you create one tongue and one groove joint, it is possible to overlap the
parts. This is defined on the Picture tab with seam position values. Enter
negative values to move the parts closer together.

Extra Foils tab
Use the Extra foils tab to define an extra foil layer in the seam.
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Foil

Option Description Default
t Define the extra foil

thickness.
1 mm

Pos_No Prefix and start number
for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options .

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options .

Name Name for the extra foil. FOIL
Class Part class number for

the extra foil layer.
 

Comment Add a comment for the
extra foil layer.

 

Connection method

Option Description
No connection Select how the extra foil is attached to the sandwich

wall.

• No connection (foil is a loose part)

• Weld

• Cast unit

• As subassembly
At Inside shell Select the profile to which the extra foil is connected.

• At inside shell

• At outside shell
Position h*b Select a prefix for the foil layer.

• Position h*b and Position b*h create a profile
without a prefix.

• Position PLh*b and Position PLb*H create a
profile which start with PL prefix.

• Par. section h*b and Par. section b*h: enter a
prefix in the box below.
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Option Description
Auto Select the rotation of the foil layer.

• Auto

• Below

• Front

• Top

• Back
Foil shape Define shape of the extra foil.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Concrete components reference 2994 Concrete Detailing



Sandwich wall vertical seam
Sandwich wall vertical seam creates a vertical seam between two sandwich
walls. Seam dimensions and rabbets can be defined for all layers: inner shell,
foil, insulation, and outer shell.

Objects created

• Seam

• Rabbets

• Foil

• Insulation

Use for

Situation Description
Seams between sandwich wall shells.

Seams with additional rabbets.

Limitations

The component works only if the sandwich walls are parallel.

Before you start

To be able to select the needed parts, activate the Select objects in

components switch.

Selection order

1. Select the inner shell of the first sandwich wall.

2. Select the inner shell of the second sandwich wall.

The seam is created automatically when the secondary part is selected.
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Part identification key

 Part
1 Inner shell of the first sandwich wall
2 Inner shell of the second sandwich wall

Picture tab
Use the Picture tab to control the vertical seam properties.

Seam position

Seams can be defined for inner shells, insulation and outer shells. Draft angles
can be defined for the outer shells.

Define the seam position between the sandwich wall shells. The middle line
between the walls is used as a reference when the seam position is calculated.

Example:
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Shell classes

Define the part classes to be applied to the seams. By default, the Sandwich
Wall Vertical Seam component creates inner shells with class 1, foil with class
2, insulation with class 3 and outer shells with class 4. Use these classes to
apply seams.

For example, to prevent the creation of seams between foils, insulation shells
and outer shells, leave the Insulation classes box empty.

Asymmetrical seams

You can create asymmetrical seams and/or rabbets in the insulation layer.

Option Description
Symmetrical seams.

No rabbet for the insulation layer.
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Option Description
Symmetrical seams.

Rabbet depth can be defined for the
insulation layer.

Asymmetrical seams for the
insulation layer and outer shell.

No rabbet for the insulation layer.

Asymmetrical seams for the
insulation layer and outer shell.

Rabbet depth can be defined for the
insulation layer.

Offset / Mirror

You can define offset for the seam.

Rabbets tab
Use the Rabbets tab to define rabbets in inner shells, insulation layers and
outer shells.

Rabbet side

Select to which side of the sandwich wall the rabbets are applied.
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• Right side

Rabbets are equal on both sides, but the rabbet dimensions on the right
side are applied to both sides.

• Left side

Rabbets are equal on both sides, but the rabbet dimensions on the left side
are applied to both sides.

• Both sides

Rabbet dimensions can be defined separately for both sides.
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• Both sides mirrored

Rabbet dimensions can be defined separately for both sides, but sides are
mirrored.

Connection type

You can select a tongue or groove joint connection for both sides.

Option Option Description
Tongue joint connection,
based on the outer
geometry

Groove joint connection,
based on the center line

Tongue joint connection,
based on the center line
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Option Option Description
Groove joint connection,
based on the outer
geometry

Rabbet position

Typically the vertical seams go from the top to the bottom of the sandwich
wall. Define the seam offsets for the top and bottom sides. Offsets are applied
only to the inner and outer shells.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Sandwich wall window
Sandwich wall window creates a rectangular window opening in a sandwich
wall, or alternatively, a window and a door opening. The opening is created
through up to four parts (inner shell, foil, insulation, and outer shell). You can
select whether the foil is created. A frame can be created, as well as extra foils
and additional parts. The frame can be a wooden frame or a concrete border,
added to the inner shell.

Objects created

• Rectangular opening

• Wooden frame or concrete border

• Extra foils

• Additional parts

Use for

Situation Description
Opening in a sandwich
wall, with a wooden
frame and foil layers.
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Situation Description
Opening in a sandwich
wall, with a concrete
border in the inner
shell.

Opening in a sandwich
wall, with a door
opening.

Selection order

1. Select the inner shell of the sandwich wall.

2. Pick the first position.

3. Pick the second position.
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The second position point is needed to complete the input also if you
have selected an option for only one input point in the component dialog
box. In this case, the second point location does not matter.

The opening is created automatically when the second position is picked.

Part identification key

 Part
1 Sandwich wall element
2 First picked position
3 Second picked position

Picture tab
Use the Picture tab to control the dimensions and parts of the opening.

Dimensions

Option Dimensions
Create Window

Concrete components reference 3004 Concrete Detailing



Option Dimensions
Create Window +
Door

Set the Door
location to Right
side or Left side.

The options on the
Door side detail tab
and Door bottom
detail tab are
available when you
set the Create
option to Window +
Door.

Option Description
1 Set the points for the opening:

• 2 points

Pick two points to create the opening (points 2 and 3 in the
image).

• Point 1 B H

Pick two points to create the opening. With this option, point 2
shown in the image is the reference point. Point 3 is only
needed to complete the input. Define the width and height of
the opening.

• Point 2 B H

Pick two points to create the opening. With this option, point 3
shown in the image is the reference point. Define the width and
height of the opening.

• 2 Points H

Pick two points to create the opening (points 2 and 3 in the
image). Define the height of the opening.

2 Vertical offset from the insertion point.

When you create Window + Door, this is the vertical offset for the
window.

3 Horizontal offset from the insertion point.
4 Width of the opening.

When you create Window + Door, this is the width of the window.
5 Height of the window.
6 Width of the door.
7 Vertical offset for the door.
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Select other layers

Option Description
Insulation, Wall Parts where the opening is created.

To create the opening to the insulation and the external
layer parts, enter the class numbers.

If you do not enter any numbers, the opening is only
created to the part you selected when applying the
component.

Parts not in
cast unit

Select Yes to create the opening to the parts that do not
belong to the cast unit.

Foil You can use Sandwich wall window both for sandwich
panels with a foil and for sandwich panels without a foil
(default). If you have a sandwich panel with a foil, select Yes
and enter the class number of the foil.

The frame shape options shown on the Bottom detail,
Left detail, Right detail, and Top detail tabs depend on
whether the foil is created or not.

Bottom detail tab / Left detail tab / Right detail tab
Use the Bottom detail tab, Left detail tab, and Right detail tab to control the
size, position and shape of the opening bottom, left side, and right side, and
the frame size and properties. On the Right detail tab, you can select that the
right detail is created the same as the left detail.

Frame

Part Description Default
Frame Define the frame profile

by selecting the profile
from the profile catalog.

50*50

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Frame shape

The options for inner and outer frame are the same regardless of whether the
foil is created or not.
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Inner Outer Description
Default

Cut or extension is not
created.

AutoDefaults can change
this option. Any of the
three options is used
depending on the frame
size.

Cut or extension is not
created.

Extension is created.

If the frame is narrower
than the insulation, the
concrete part is
extended to fill the gap.

Cut is created.

If the frame is wider
than the insulation, the
concrete part is cut so
that the frame fits.
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Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is created.

This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is not created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is not created.
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Additional recess

Define the vertical and horizontal dimensions for the additional recess. By
default, the recess is not created.

Frame corner cuts

Option Description
Frame corners are not cut.

Define the horizontal and vertical
dimensions of the frame corner cuts.

Continuous slope

Select whether frame edges are sloped.

Option Description
By length

By angle

You can set the length or the angle for both sides separately.

The default is that frame edges are not sloped.
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Top detail tab
Use the Top detail tab to control the size, position, number, and shape of the
opening top side.

Part

Part Description Default
Frame Define the frame profile

by selecting the profile
from the profile catalog.

50*50

Foil2 Foil2 is the additional
foil created only on the
top side.

Define the thickness.

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Top frame shape

The options for inner and outer frame are the same regardless of whether the
foil is created or not.

Inner Outer Description
Default

Cut or extension is not
created.

AutoDefaults can change
this option. Any of the
three options is used
depending on the frame
size.
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Inner Outer Description
Cut or extension is not
created.

Extension is created.

If the frame is narrower
than the insulation, the
concrete part is
extended to fill the gap.

Cut is created.

If the frame is wider
than the insulation, the
concrete part is cut so
that the frame fits.

Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is created.
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Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is not created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is not created.

Additional recess

Define the vertical and horizontal dimensions for the additional recess. By
default, the recess is not created.
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Frame corner cuts

Option Description
Frame corners are not cut.

Horizontal and vertical dimensions of
the frame corner cuts.

Drip mold

Option Description
Drip mold is not created.

Drip mold is created. Define the mold
dimensions.

Drip mold is created. Define the mold
dimensions.

The drip mold can be created to any
of the shape options. For example, if
the shape has a bevel, the drip mold
is created at the same angle as the
bevel.

Continuous slope

Select whether frame edges are sloped.

Option Description
By length
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Option Description
By angle

You can set the length or the angle for both sides separately.

The default is that frame edges are not sloped.

Extra foils tab
Use the Extra foils tab to control the creation of extra foils on the top, bottom,
right side, and left side of the opening.

Part

Part Description Default
Extra foil Thickness of the foil. 50*50

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Extra foil dimensions
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Description
1 Define whether extra foils are created.
2 Define the inside offset.
3 Define the foil width.

Shells to cut

Option Description
All shells are cut.

The inner shell is not cut.

The inner shell and the foil are not cut.

The inner shell and the foil are not cut. An insulation
extension is created.

Define the width and the material grade of the
insulation extension.
The outer shell is cut.

Additional parts tab
Use the Additional parts tab to control the size, position, number, and
alignment of additional parts.

Parts

Select whether additional parts, custom component parts, or no additional
parts are created.

Part Description Default
Parts Define the profile of the

additional parts by
selecting the profile
from the profile catalog.

D5

Custom component
parts

Define the custom
component parts by
selecting the component
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Part Description Default
from the Applications &
components catalog.

You can also use a
configuration file to
define the properties.

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Define distances

Select whether to define the distances between the parts by entering the
distance dimensions on this tab or by using an external text file. You can use
an external file to automate the creation of additional parts when window
sizes differ.

The name of the external file is
SandwichPanelWindowAdditionalParts.dat. The file is located in
the ..\Environments\Common\system folder.

The image below shows an example of a local standard for creating additional
parts. M is a module that is 100 mm.

The SandwichPanelWindowAdditionalParts.dat configuration file that
contains the needed specifications for the example above is as follows:

BOTTOM;
0;599;1;1
600;1200;1;2;145
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1201;1800;1;3;145
TOP;
1201;1800;1;1
LEFT;
0;599;1;1
600;1200;1;2;145
1201;2100;1;3;145
RIGHT;
0;599;1;1
600;1200;1;2;145
1201;2100;1;3;145

The keywords BOTTOM, TOP, LEFT and RIGHT define the side of the window
the settings are applied to.

The syntax in the file is as follows: bmin;bmax;cm;nd;dmax;d1;d2;d3.

bmin Smallest window dimension to apply the setting.
bmax Biggest window dimension to apply the setting.
cm Creation method:

• 1 means use the number of parts for nd.

• 2 means use maximum spacing for nd.
nd Depending on the creation method (cm):

• Number of parts, when cm is 1.

• Maximum allowed distance between parts, when cm is 2.
d1 Distance from the start point to the first additional part (optional).
d2 Distance from the first additional part to the second (optional).
d3 Distance from the second additional part to the third (optional).

The additional parts are placed symmetrically, so distances d1, d2 and d3 are
also used from the end point. If the optional distances d1, d2 and d3 are not
defined, the parts are placed at equal distances.

In the image above 0;599;1;1 means that when the window width is equal or
bigger than 0, but equal or less than 599, the creation method is by number of
parts and 1 part should be created.

600;1200;2;300;145 would mean that when the window width is equal or
bigger than 600, but equal or less than 1200, the creation method is use
maximum spacing. The maximum allowed spacing between additional parts is
300 mm. The first part (and last part) distance is 145 mm. If the window width
is 1200, three more parts are needed (1200 - 2x145)/300=3.03. The spacing
between the additional parts will then be (1200 - 2x145)/4 = 227.5 mm.

Placement

Select whether additional part placement is the same or different on each
side.
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Option Description
Placement dimensions for the
bottom, left side, and right side.

If additional part placement is the
same on each side, define the bottom
dimensions only.

Placement dimensions for the top
side.

Door edge options

The options for controlling door edges are available when you set the Create
option to Window + Door on the Picture tab, and the Placement option to
Different each side on the Additional parts tab.

Option Description
Create on door side No, Same as window side, Same as door side
Create in bottom
detail

No, Same as bottom

Connections tab
Use the Connections tab to control how the wooden frame, additional parts,
extra foil, and extensions are connected to the shells.

Add

Option Description
Wooden frame to, Additional parts,
Extra foil to

Select to which part the wooden
frame, additional parts, and extra foil
are connected.

You can create the frame as an
assembly. To add window and door
frames to a shell as one subassembly,
select Subassembly for Wooden
frame to.

The Extra foil to option is shown if
you have selected to create the foil on
the Picture tab.

Concrete components reference 3018 Concrete Detailing



Connect extensions to their shells

Option Description
Inside shell extension, Outside
shell extension, Insulation shell
extension, Foil extension

Select how the extension parts are
connected to their main parts.

The Foil extension option is shown if
you have selected to create the foil on
the Picture tab.

Edge connection

Define the corner connection type for wooden frames.

Option Description
Cut both frames in a 45-degree angle.

Extend horizontal frames.

Extend vertical frames.

Door side detail tab / Door bottom detail tab
Use the Door side detail tab and Door bottom detail tab to control the size,
position, and shape of the door side and bottom, and the frame size and
properties.

Create door

The options on the Door side detail tab and Door bottom detail tab are
available when you set the Create option to Window + Door on the Picture
tab.

Same as options

• Same as on the Door side detail tab:

Select the door short side detail.

• None

• Same as window side follows the side setting of the window side.

• Same as door side follows the door side setting.

The door long side detail follows the setting of the corresponding window
side.
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• Same as bottom on the Door bottom detail tab:

Yes follows the setting of the bottom window.

Frame

Part Description Default
Frame Define the frame profile

by selecting the profile
from the profile catalog.

50*50

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Frame shape

The options for inner and outer frame are the same regardless of whether the
foil is created or not.

Inner Outer Description
Default

Cut or extension is not
created.

AutoDefaults can change
this option. Any of the
three options is used
depending on the frame
size.

Cut or extension is not
created.
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Inner Outer Description
Extension is created.

If the frame is narrower
than the insulation, the
concrete part is
extended to fill the gap.

Cut is created.

If the frame is wider
than the insulation, the
concrete part is cut so
that the frame fits.

Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is created.

This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is not created.
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Middle Description
This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is not created.

Additional recess

Define the vertical and horizontal dimensions for the additional recess. By
default, the recess is not created.

Frame corner cuts

Option Description
Frame corners are not cut.
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Option Description
Define the horizontal and vertical
dimensions of the frame corner cuts.

Door side frame extension

Option Description
Frame on the door side is created only to the
bottom level of the window.

Frame on the door side is extended to the top level
of the window.

Enter the extension distance in the box.

Continuous slope

Select whether frame edges are sloped.

Option Description
By length

By angle

You can set the length or the angle for both sides separately.

The default is that frame edges are not sloped.

Wall layout tools
Wall Layout tools is a set of components that you can use for creating and
modifying all common types of concrete walls, such as solid precast panels
from single layers to double walls and sandwich walls, and different wall
structures that are cast on the site. The wall structure may contain several
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layers, for example, structural layers, insulation, void, and surface treatments.
You can use direct modification to flexibly change the wall geometry, layer
offsets, openings, and seam lines.

Wall layout is the main component in the set and it is used for defining the
wall layout. Wall layout is available on the Concrete tab, click Panel --> Wall
layout, and in the Applications & components catalog.

The other Wall Layout tools are available in the Applications & components
catalog:

• Wall layout connector connects the walls to each other.

• Wall layout T connector connects walls to each other with T connections.
Wall layout T connector can also create a seam at the connection
location.

• Wall layout opening sets the default values for openings. Use direct
modification to create and modify openings.

• Wall layout seam divides the wall segment into two or more cast units by
adding seams. Use direct modification to create seams.

• Wall layout elementation divides the wall into elements according to
length, height, number, weight, or crane lifting capacity.

• Wall layout layer swapper is intended for swapping the casting order of
layers in a double wall. Only certain properties of the two layers are
swapped, such as name, class, numbering settings, and all UDAs. The
geometry of the layers is not swapped. If one layer is created using the
layer creation option Add as sub-assembly (shell 2), and the other layer is
defined as Add to cast unit (shell 1), these properties are also swapped.

Wall layout
Wall layout creates a single wall or multiple straight wall segments. The wall
can be a single-layer solid wall, a double wall, or a sandwich wall that has any
number of layers.

Design workflow with Wall layout tools

1. You can build a shape.

2. You can build a shape and create openings.

3. You can create wall type definitions.

4. You can create wall elementation and define detailed wall geometry.

5. You can define detailed connections, openings, embeds, and
reinforcement.
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Selection order

1. Ensure that the Direct modification  switch is active.

2. On the Concrete tab, click Panel --> Wall layout.

3. Select the appropriate command on the contextual toolbar:

• To create one or more straight wall segments, click , and then pick
two or more points.

Note that you can finish the creation to the first picked point to create
a closed wall structure.

• To create the wall layout as a closed wall, click , and then pick two
or more points.

Wall layout will automatically connect the first and the last point that
you have picked.

4. Click the middle mouse button to create the wall.

Depending on how many points you pick and how you pick the points, one or
more straight wall segments or a closed wall is created in the model. Each
created straight segment is a separate instance of the Wall layout component
that you can modify separately. When you create two or more wall segments,
an instance of the Wall layout connector component is added between each
wall segment.

In the image below, there are four wall segments in an open shape between
the picked points, 1 - 5, and three wall layout connectors at points 2, 3 and 4. If
you had created a closed wall, there would be a fifth wall segment between
points 5 and 1.
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The modeling direction of the wall layout determines which face of the wall
layout is shown in the front view of a cast unit drawing when the cast unit
drawing coordinate system is set to Fixed.

In the image below, the top-in-form face is not set by Wall layout. The image
shows an example of sandwich wall settings that you should use when the
outside shell is cast against the pallet, and the inside shell is the uppermost
shell in the casting.
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Alternatively, you can set the top-in-form face with Wall layout. Set
Walllayout.Udas.dat to have the top-in-form face property by adding the
following row:

option FixedMainView j_FixedDrawingMainView
The Walllayout.Udas.dat file can be located in the model folder or any of
the system folders.

General tab

Use the General tab to define the basic properties for the whole Wall layout
component. The properties on all other tabs are layer-specific, and apply to
the layer that you have currently selected in the layer list.

Option Description
H, Z1, Z0 You have four options for defining the height and the

global Z coordinates:

• Define the wall bottom level according to the creation
points, and the Position in depth option and value.
Define the height with the H option.

• Define the wall bottom level with the Z0 option (global
Z coordinate), and the height with the H option.

• Define the wall top level with the Z1 option (global Z
coordinate), and the height with the H option.
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Option Description
• Define the wall bottom level with the Z0 option (global

Z coordinate), and the wall top level with the Z1 option
(global Z coordinate).

You can use the H option to modify the height of
rectangular walls. If you change the wall shape so that it is
not rectangular, you cannot define height with this
option. Use direct modification instead.

Total thickness Enter the total thickness of the wall layout. Layer
thickness is calculated based on the total thickness.

Use the total thickness for double walls where the
thickness of the void layer or the CIP layer is often
flexible. This means that Wall layout can adjust the
thickness so that the total thickness is as defined.

• If there are no flexible layers in the wall layout, you
can leave the total thickness option empty. Total
thickness is not used if there are no flexible layers.

• If there is more than one flexible layer, the thickness is
divided equally between those layers.

Cast unit name Enter a name for the cast unit.
Prefix Enter a prefix for the cast unit.
Start number Enter a start number for the cast unit.
Position in plane Define the wall layout location in relation to the line

between the input points.

Enter the offset distance, if needed.
Position in depth Define the wall layout vertical location in relation to the

line between the input points.

Enter the offset distance, if needed.

Layer tab

Use the Layer tab to define the properties of a single layer. Select the layer in
the layer list, or in the preview image.

Layer list
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Layers Description Example
The layer list shows the
layers of the wall.

Use the buttons to control
the number and the order
of the layers:

•

Click  to add a new
layer.

•

Click  to remove
the selected layer.

•

Click  to
change the order of the
layers by moving the
selected layer up or
down in the list.

Use the check box in front
of the layer name to control
whether the properties of
the selected layer are
modified.

Use the leftmost check box
to control whether the
number of layers and the
order of the layers are
modified when you modify
the Wall layout
component.

The example image
below shows a preview
of the wall layers. The
image is automatically
updated when you
change the layer type.
The selected layer is
highlighted with a
magenta frame.

Layer properties

Option Description
Layer name Enter a name for the layer. This name is shown in the

layer list.

Layer names are also shown on the contextual toolbar
when you modify wall boundary offsets. You can select
which layer to modify.

Layer names are not visible in reports or drawings.
Layer type • Structure: Typically used for solid walls, double

walls, and the concrete layers of sandwich walls. Use

Concrete components reference 3029 Concrete Detailing



Option Description
this type if you want to create a cast-in-place layer
between double wall layers instead of a void.

• Insulation: Insulation layer in a sandwich wall.
Insulation gets a different density in Wall layout
elementation (100 kg/m³).

• Void: Void between double wall layers. Use this type
if you do not want to create any parts for the layer.

• Foil: Typically a very thin layer which is not detailed
in the corners.

• Surface: Surface treatment on top of a structural
layer. Typically, a surface layer is the first and/or the
last layer.

• Component: Layer is not created as a part. Instead,
an instance of the component selected in the Layer
component option is added.

Layer
elementation

Select whether the layer is split into two pieces using
seams.

Layer creation Select how the layer is created to the precast cast unit:

• Add to cast unit: All layer parts are added to a
single main cast unit.

• Add as sub-assembly: The layer part is added as a
sub-assembly to the main cast unit.

• Do not add to cast unit: The layer part is not added
to the main cast unit. It will be its own assembly or
cast unit. This option changes the concrete type
from precast to cast in place.

Layer component Select a component when you have set the layer type to
Component. Instead of creating the layer as a part, an
instance of the component is created.

You can control some of the component properties
from Wall layout properties.

Define the property names in the component
accordingly:

• P_Height - Layer height (maximum height of the
layer part)

• P_Thickness - Layer thickness

• P_Name - Layer part name

• P_Class - Layer part class

• P_Material - Layer material
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Option Description
• P_Prefix - Layer part prefix

• P_StartNo - Layer part start number

The creation points of the component are in the same
locations as when creating the layer as a part.

If the custom part or component property names are
not the same as the default names, you can define the
parameters in the xxxxx.LayerComponentInfo.xml
file where xxxx is the component name.

In this file you can also specify the mapping for other
layer properties so that the values given in the attribute
file will be overridden with the layer properties defined
in the Wall layout dialog box. For an example of the
file, see the Customize the wall layout section.

Attribute settings Select an attribute file for the layer component.

If you need specific component properties for the layer
component, you can define the properties in the
component dialog box and save them as an attribute
file.

Layer thickness Enter the layer thickness.

You can leave the layer thickness empty to let Wall
layout set the layer thickness so that the total
thickness is correct as defined on the General tab. The
void layer or the CIP layer in a double wall can often
have a flexible thickness.

Part name, Class,
Material, Pour
phase, Surface
treatment, Prefix,
Start number

Define the name, class, material, part prefix and start
number of the layer part. Define the pour phase for CIP
layers. Select the surface treatment when you have set
the layer type to Surface.

Vertical offset tab

Use the Vertical offset tab to define the vertical offsets of each layer at the
top and bottom horizontal edges of the wall layout.
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Note that you can define the offsets at any other edge by using direct
modification and seams.

Option Description
Offset Define the vertical offset at each layer.
Component name Select a component for detailing the offsets.

For example, you can use the Geometry detailing
strip component to create thickenings for sandwich
walls. You can create different settings for Geometry
detailing strip and select the appropriate settings for
each situation.

Component
attributes

Select the appropriate component settings.

You can also add detailing to an edge of a wall layout. Select the wall layout
and activate the editing by selecting Modify wall boundary offsets on the
contextual toolbar. Select the wall layout edge to which you want to add the
component. Select the detailing component and the settings that you want to

use, and click  to confirm.

UDA tab

Use the UDA tab to define the user-defined attributes of each layer part in the
wall layout.

Note that the content of the UDA tab may vary depending on your Tekla
Structures environment. You can customize the content of the UDA tab.
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Modify the wall layout

Modify the geometry of the wall layout

You can use direct modification to modify the wall layout. Before you start,

ensure that the Direct modification  switch is active. Select the wall
layout to display the contextual toolbar. To modify the wall layout, select the
appropriate command from the toolbar.

You can modify the outer edges of the wall layout by dragging the edges and
corner handles. You can also insert vertices by dragging the edge midpoint
handles, and delete vertices by selecting a corner handle or edge, and pressing
the Delete key.

In addition to the standard polygon modification, you can drag the special line
handles at the ends of the wall layout to make the wall layout shorter or
longer. You can also drag the line handle perpendicular to the wall layout by
holding down the Alt key while dragging.

As an alternative to dragging the line handle, you can drag the dimension
arrowhead. If you know how much you want to shorten or lengthen the wall
layout, select the dimension arrowhead and enter the value by which you want
the dimension to change. Note that you can use the dimension arrowheads
and line handles in a plan view whereas polygon modification is possible only
in 3D or section views.
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Modify the offset at layer edges

Use the Modify wall boundary offsets command on the contextual toolbar to
modify the offsets of the layers at the outer edges of the wall layout, or at the
edges of the openings or seams. Select the layer that you are going to modify
from the list on the toolbar.

You have three options for modifying the offset at a particular edge:

• Drag the line handle at the edge. You can only drag the line handle
perpendicular to the edge.

• Drag the dimension arrowhead and enter the measurement value.

• Select the line handle and enter a new offset value.

You can select two or more line handles by holding down the Shift key
when selecting the handles.

You can modify the top and bottom offsets at the outer edges in the Wall
layout dialog box, and the seam offsets in the Wall layout seam dialog box.
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You can define that a certain layer is not cut with the opening. First select the
opening. On the contextual toolbar, select the layer and then Do not create.

Concrete components reference 3035 Concrete Detailing



Wall layout opening
Use direct modification to add openings to wall layouts. Before you start,

ensure that the Direct modification  switch is active.

To add an opening, select the wall layout and then select the appropriate
direct modification command. You can create rectangular, polygonal and
circular openings.

NOTE You can use the Wall layout opening tool from the Applications &
components catalog to define the settings applied to the openings.
You can define the opening dimensions and select to apply detailing
by using an opening component.

Add an opening to a wall layout

Option Description
Add an opening by picking the opening length in
the wall. There are five different dimension
options to define the opening bottom and top
level. To cycle through the options, click the
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Option Description

opening dimension button  until it shows
the wanted option.

The five options are:

• Enter the distance between the bottom of
the wall and the bottom of the opening,
800.00 in this example, and the height of
the opening, 2400.00. If Position in depth
values are used, the bottom distance is
measured from the creation points.

• Enter the distance between the bottom of
the wall and the bottom of the opening, and
the distance between the bottom of the wall
and the top of the opening. If Position in
depth values are used, the bottom distance
is measured from the creation points.

• Enter the global Z coordinate of the opening
bottom level, and the height of the opening.

• Enter the height of the opening, and the
global Z coordinate of the opening top level.

• Enter the global Z coordinate of the opening
bottom level, and the global Z coordinate of
the opening top level.

You can use an architectural drawing as a
reference model where you can pick the
opening width and the location.

You can select the layer to be cut on the
contextual toolbar. This makes it easier to
model different layer geometries to walls with
multiple layers. The default option All layers
creates the opening to all layers. To change the
opening creation for a layer, click the Modify
wall boundary offsets command. Select the
layer and either Create or Do not create.
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Option Description
Add a rectangular opening by picking two
points.

Add a polygonal opening by picking three or
more points.

Add a circular opening by picking the center
point and the radius point for the opening.

When you change the layer and edge specific
offsets, you can set a single offset for the
circular opening. Circular openings enable fast
creation of HVAC reservations.

Modify an opening in a wall layout

Option Description
Modify the geometry of an opening You can modify an opening in the

same way as the outer edges of the
wall layout by using the appropriate
direct modification command. You
can:

• Drag the edges.

• Drag the corner handles.

• Insert vertices by dragging the
edge midpoint handles.
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Option Description
• Delete vertices by selecting the

corner handle or edge, and
pressing the Delete key.

In addition, you can modify the start
or the end of the opening by dragging
the line handles, or by using the
dimension arrowheads.

Move and copy an opening 1. Select an opening by selecting a
face inside the opening.

2. Start dragging the selected face.

3. To create a copy of the opening,
hold down the Ctrl key.

To move an opening without
changing the shape of the
opening, drag the face handle to
the desired location.

Delete an opening Select a face inside the opening and
press the Delete key.

Modify the opening detailing You can create an opening with or
without details. To detail an opening,
use an opening component from the
Applications & components catalog,
or a suitable custom component.
Note that you can use the Sandwich
wall window component for
rectangular openings, and for
openings that connect a window and
a door with the same top edge line.

To create a detailed opening, select
the opening and double-click to open
the Wall layout opening dialog box.

1. In Apply detailing, select Yes.

2. In Component name, do one of
the following:
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Option Description
• Select a component from the

list. Click Edit if you want to
modify some of the opening
properties.

• You can change the name and
window dimension property
names, for example, and
define the input points for the
opening. When you edit the
properties and give a new
name for a component, the
edited component is added to
the Component name list.

• If you want to use a
component that is not in the
list, click New to select a
component from the
Applications & components
catalog. You can use a custom
component that you have
created, for example.

You can also add filler parts to the
openings on the Filler parts tab.
Select a layer in the example image in
the dialog box. Then select whether
the layer is cut and a filler part
created to the layer. Select the
appropriate filler part attributes. Note
that the filler parts use contour plate
properties in Filler part attributes.

You can also activate detailing on the
contextual toolbar by selecting the
detailing component that you want to
use.

Wall layout seam
When you create a wall layout, it is at first a single precast wall. Wall layout
seam divides the wall layout into two or more precast wall pieces. In the wall
layout, the wall layout layers that have the Layer elementation option set to
Yes in the Wall layout dialog box are divided.
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Add and modify wall layout seams

Use the Modify seams  command on the contextual toolbar to add and
modify seams. Modify seams opens the Wall layout seam dialog box where
you can define the seam properties for each wall layer separately.

Select the layer in the preview image and define the properties.

Option Description
1. Define the gap dimension at the

seam.

2. Define the gap offset from the
seam input position.

Create a connection component Select Yes to create a connection
between the two layer parts at the
seam.

When you select Yes, you can define
the other component options.

Component name Select a connection component from
the Applications & components
catalog.

Component attributes Select the attribute file for the
connection.

Component primary input Select which wall piece is the first
input part for the connection, seam,
or other components created at the
seam.
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Option Description
Add a vertical seam

Use the New seam  command
to add a vertical seam. Pick a
point to create the seam.

Note that New seam is selected
automatically when you use the
Modify seams command and the
wall layout does not have any
seams yet.

Add a polyseam
Use the New polyseam 
command to add a polyseam. Pick
two or more points to create the
seam.

Polyseams can contain vertical,
horizontal, and sloping segments.
Extend the start and the end of
the polyseam to make it clearly
cross the edges of the wall it is
dividing.

Move a seam Move a vertical seam by dragging
the seam.

You can also move vertical seams
by dragging the horizontal line
handle or the dimension
arrowhead.

Move and modify a polyseam like
any other polygonal object.

Copy a seam Copy a vertical seam or a
polyseam by holding down the
Ctrl key and dragging the seam.

Delete a seam Delete a vertical seam by selecting
the seam handle and pressing the
Delete key.

Delete a polyseam by deleting all
segments of the polyseam.
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Option Description
Modify the seam properties 1. Select a vertical seam or a

segment of a polyseam.
When you select the first
seam, the current properties
of the seam are loaded into
the Wall layout seam dialog
box.

2. Select two or more seams.
Hold down the Shift key and
then select the vertical seams,
or the segments of a
polyseam.

3. When you have selected the
seams, modify the properties
in the dialog box and click
Modify.

Split the wall layout at selected seam Use the Split the wall layout at

selected seam command  to
split the wall layout into separate
components.

Wall layout connector
Use Wall layout connector to apply a connection between two wall layouts.
Wall layout connector fits the layer parts at the corners. You can control the
corner gaps by extending or shortening the layers of the walls, and by adding
connections between the connected layer parts. Wall layout connector can
also add connections between the layer parts when you are using a
connection component at the corners.

Note that if you have created several wall layouts at one go using the Wall
layout tool, wall layout connectors are automatically added between the wall
layouts. Wall layout connector is updated automatically when you change the
wall type.

If you create a wall layout and later add another next to it, you can add a
connection between them using the Wall layout connector component in the
Applications & components catalog. Select the two wall layouts to create the
connection. Ensure that you select the wall layout component instance, not a
single object created by the wall layout. The connector is created when you
select the second wall layout.
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Wall layout connector properties

Option Description
Define how the layer parts are fitted.

Click the button three times to cycle through the
three different corner set-up options.

Define whether the panel ends are square or
sloped.

You can use this option to set a typical corner
detail for double walls.

This option is also applied in a connection
component used between the layer parts.
Define how the parts forming the turning corner
are modeled.

You can select this option separately at each
layer.

When you select this option, Wall layout
connector creates an additional part that is
added to the cast unit.

The turning corner part is created with the (first)
name given in the system file
SandwichWallCornerPartNames.dat.

Click the button three times to cycle through the
three different corner set-up options.

Free space A Define the gap between the two layer parts.

The preview image shows where the gap is
located. The gap location depends on the corner
set-up.

TIP If you are using a connection component,
use property name FreeSpace in the
custom connection to control that value
from Wall layout connector directly.

End offset B Define the end offset of the longer part.

The preview image shows where the offset is
located. The offset depends on the corner set-up.
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Option Description

TIP If you are using a connection component,
use property name EndOffset in the
custom connection to control that value
from Wall layout connector directly.

Connection Select a connection component that is created
between the two layer parts.

If you do not select a connection, only fittings are
added according to the gap and the end offsets.
If you want to view the current connector
properties, select the wall layout connector or
double-click the fitting created by the connector.

Attributes If you have added a connection, select an
attribute file for it.

Connection main part If you have added a connection, set the
connection main part.

Wall layout T connector
Use Wall layout T connector to apply a T connection between two wall
layouts. Wall layout T connector can create a seam at the connection
location. Note that if you remove the connection, the seam is not
automatically removed. Modify the main part to remove the seam.

Wall layout T connector properties

Option Description
Define how the wall layout parts are fitted.

Click the button three times to cycle through the
three different corner set-up options.

Select the wall layout in the preview image and
define the connection properties.

Define whether the panel ends are square or
sloped.

This option is applied in a connection component
used between the wall layout parts.
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Option Description
Add seam Select whether to add a seam. You can also select

to only split the first layer into two parts.

No does not split the first layer part but creates a
cut that breaks the part into two solid objects.

Seam offset Enter the seam offset.
Free space Define the gap between the wall layouts.

The preview image shows where the gap is
located. The gap location depends on the corner
set-up.

Create component Select whether to use a component to connect
the wall layouts.

Component name Select a connection component that is created
between the wall layouts.

Component attributes If you have added a connection, select an
attribute file for it.

Component primary
input

If you have added a connection, set the
connection main part.

Wall layout elementation
Wall layout elementation automatically adds new seams to divide the wall
layout into two or more precast wall pieces.

Openings are taken into account when adding the seams. Openings may affect
the final seam position so that the final length or weight of the precast wall is
less than the target value.

NOTE Weight calculations are based on the wall layout geometry. Any other
additional parts in the walls are not taken into account in the
calculation. The density in weight calculation is 2500 kg/m³ for the
structural layer type and 100 kg/m³ for the insulation layer.

Option Description
Create seams • By length: Enter one or more desired lengths. If it

is not possible divide the wall using the first
length, Wall layout elementation tries to use
the next length you have entered, and so on.

• By number: Enter the number of walls you want
to create.

• By weight: Enter the desired weight of a wall
piece. The wall layout is divided so that the weight
of the precast walls is as close to the desired
weight as possible.
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Option Description
• By crane lifting weight: Divides the wall layout

so that the weight of the precast walls is as close
to the maximum lifting capacity as possible.

Max height Enter the maximum height of a wall piece.

If the value you enter is smaller than the height of
the wall, Wall layout elementation will first create
the horizontal seams with the given height and
settings. After that it creates the vertical seams using
the vertical seam settings and all other settings in the
dialog box.

Min length Enter the minimum length of a wall piece.
Max length Enter the maximum length of a wall piece.

This value is used with all creation methods.
Max weight Enter the maximum weight of a wall piece.

This value is used with all creation methods.
Max crane lifting
weight

Select the crane used for erection.

When the crane is selected, the maximum weight of
the walls is always less than the lifting capacity of the
crane.

To define a crane set-up, open the Crane properties
dialog box by clicking the  button on the right:

1. Pick the crane location in the model, or enter the
X and Y values.

2. Enter the crane lifting capacity data in the table.
Enter the distance in the from-near-to-far order.

3. Save the crane set-up.

You can use the crane name when saving the
set-up.

To modify and review the existing crane set-up,
select the crane set-up from the list in the Crane
properties dialog box. Click Preview to see the
crane location on the lifting graph visualized in the
model view.
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Option Description

Avoid openings Select whether the seams may cross the opening.

If the seams may not cross the opening, enter the
minimum distance from the opening.

Distribution
direction

Select the direction of the seams, and the start end
at the wall layout.

You can add both vertical and horizontal seams.

Vertical seam
settings

Horizontal seam
settings

Select the seam attributes used for new seams.

Ensure that the layer offsets are set properly as they
may affect the weight and length of the wall.

Create to selected
walls

Select the wall layout and click the Create to
selected walls button to insert the seams. You can
select one or multiple wall layouts.

Wall layout layer swapper
Use Wall layout layer swapper to swap the structural precast layers of one
single wall in a wall layout, typically a double wall. You can swap the order of
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some individual walls in the same wall line if they need to be cast in a different
order.

To swap layers, select Wall layout layer swapper in the Applications &
components catalog, then select a wall layout and the wall part that you want
to swap.

When you use the swapper tool, a triangular handle  is shown at each
location of the tool . You can drag these handles to modify the wall to be
swapped. To swap another wall in the layout, you can copy the swapper to
another location by holding down the Ctrl key while dragging.

You can delete the swapper instances by selecting the swapper handles and
pressing the Delete key.

Customize the wall layout

UDA tab content

You can customize the content of the UDA tab by using the
WallLayout.Udas.dat file. The WallLayout.Udas.dat file can be located
in any of the folders set in the XS_FIRM, XS_PROJECT or XS_SYSTEM advanced
options, or in the model folder.

You can use the file to control which user-defined properties of the created
layer parts can be used in the wall layout. We recommend that you only use
UDAs that are typically common for all precast walls in one wall layout.

You can define that layer UDA values are not swapped when the Wall layout
layer swapper tool is used. Add NoSwap at the end of the line (fourth field): 
string comment j_comment NoSwap.

The sample file shown below contains a full description of all the settings and
the format of the file. The lines starting with '//' are comment lines.

//
// Customized user defined attributes (UDA) for layer parts created by 
wall layout component
//
// Each row shall contain 2 or 3 fields separated by tab(s) or semicolon.
// Please note that all uda names shall be unique
//
// Field 1: The data type of the attribute. Valid values are 'distance', 
'float', 'option',
//          'integer' and 'string' compatible with the actual user 
defined attributes as
//          specified in objects.inp
// Field 2: UDA name. This is the name of the user defined attribute set 
for the layer part.
// Field 3: Label. This text is shown in the wall layout UDA tab page if 
the uda is not
//          defined in objects.inp. Label can be a translatable label or 
any text or empty text.
// Field 4: 'NoSwap' if you do not want the 'Wall layout layer swapper' 
to swap the values.
//
string  comment   j_comment NoSwap
string  USER_FIELD_1  j_user_field_1
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string  USER_FIELD_2  j_user_field_2
string  USER_FIELD_3  j_user_field_3
string  USER_FIELD_4  j_user_field_4

Layer component

If the custom part or component property names are not the same as the
default names, you can define the parameters in the
xxxxx.LayerComponentInfo.xml file where xxxx is the component name.

In this file you can also specify the mapping for other layer properties so that
the values given in the attribute file will be overridden with the layer
properties defined in the Wall layout dialog box.

An example of the file is shown below.

<?xml version="1.0" encoding="utf-8"?>
<LayerComponentInfo xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <ComponentName>CMUWall</ComponentName>
  <!--Leave the property name empty if you don't want anything to be set 
by Wall layout -->
  <HeightMaxProperty>WallHeight</HeightMaxProperty>
  <Height1Property></Height1Property>
  <Height2Property></Height2Property>
  <ThicknessProperty></ThicknessProperty>
  <NameProperty>Name</NameProperty>
  <ClassProperty></ClassProperty>
  <MaterialProperty>Material</MaterialProperty>
  <PrefixProperty>AsmPfx</PrefixProperty>
  <StartNoProperty>AsmStNo</StartNoProperty>
  <!--Do not specify anything for custom part position if you want to 
control these with saved settings only.-->
  <CustomPartPosition>
    <PlaneOffset>0</PlaneOffset>
    <DepthOffset>0</DepthOffset>
    <RotationOffset>0</RotationOffset>
    <Plane>LEFT</Plane>
    <Depth>BEHIND</Depth>
    <Rotation>FRONT</Rotation>
  </CustomPartPosition>
</LayerComponentInfo>

Geometry detailing strip
Geometry detailing strip allows modeling of wall edge thickenings, recess
patterns, wall corbels, mock joints, and facade protrusions. Note that this
component is for precast use only.

Geometry detailing strip can be used for adding detailed geometry to any
object. You can create different settings for Geometry detailing strip and
select the appropriate settings for each situation.

The tool uses irregular concrete profile catalog profiles. If these profiles are
not found in your Tekla Structures environment, download them to your
model from the Tekla Warehouse local content.
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Use for

  
Sandwich wall thickening

Recess patterns in a wall
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Selection order

1. Select the part face.

2. Pick two or more points to indicate the location.

3. Click the middle mouse button to create the geometry strip.

Geometry detailing strip properties

Option Description
Select the geometry. You can create
thickenings, recesses, and
protrusions.

Define the A, B, C and D dimensions
for the selected option.

Add to cast unit, Attach to part Select how to add the geometry to
the selected part: Attach to part or
Add to cast unit.

Cut only, Cut and part, Part only Select how the cut is modeled.
Use main part properties You can control the properties of the

created part. With the Use main part
properties option, the added part
gets the properties of the main part.
Otherwise, you can select the saved
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Option Description
standard attributes for the concrete
beam.

Note that if you change the saved
properties afterwards, you need to
modify the geometry detailing strip to
get the properties of the added part
updated.

Middle. Left, Right Select a position for the geometry.
Define the strip offset from the input
line.

Define the spacing of recesses and
protrusions. For example, enter
40*400 to create 40 recesses with a
spacing of 400, measured from the
center of the recess.

Formwork placing tools
This section introduces formwork placing tools.

Click the links below to find out more:

• Formwork placing tools - Walls

• Formwork placing tools - Walls: configuration

• Formwork placing tools - Slabs (page 3106)

• Formwork placing tools - Slabs: configuration (page 3114)

Formwork placing tools - Walls
Formwork placing tools - Walls is a set of components that helps in detailed
modeling of different wall panel formwork systems. These components are
placing tools, and therefore you need to have all relevant formwork products
such as wall panels, corner conditions, clamps, and pouring platforms
available in the Applications & components catalog.

You can get the formwork products provided by formwork suppliers from
Tekla Warehouse, for example. In addition, Formwork placing tools - Walls
requires additional configuration files that contain the necessary information
about the formwork product components. These configuration files may come
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with the formwork product catalogs provided by formwork suppliers, but you
can create the configuration files yourself as well.

Formwork placing tools - Walls contains tools to place and modify the
following formwork elements:

• formwork wall panels typically appearing as two-dimensional arrays
covering a certain area

• different kinds of corner conditions

• an array of ties between two formwork panels

• an array of clamps, locks, or brackets at the joining edge between two
formwork panels to keep the formwork together

• supporting braces for a single formwork panel

• an array of pouring platforms at the top edge of formwork panels

• fillers to fill the gaps between two formwork panels

Because Formwork placing tools - Walls consists of a set of sub-tools which
are combined in one dialog box, each tab is an individual sub-tool. Both the
Formwork placing tools - Walls and the sub-tools are available in
Applications and components catalog.

Most of the settings in the components are preset. You can control the
different settings by selecting a suitable options in the dialog box. These
preset settings are organized according to the formwork supplier and the
product families.

However, if you create your own configuration files, you can use the values in
the configuration files instead of the preset values.

You can access the Formwork placing tools - Walls in the Concrete
Contractor, General Contractor and Rebar Detailer roles in the Default
environment.

Concrete components reference 3054 Concrete Detailing



Panel tab

Use the Panel tab to model an array of formwork panels on one side or on
two sides of a cast-in-place wall.

The actual formwork panels are custom parts. In addition to the custom parts,
some additional data of the products is needed from the configuration files.

1. On the Panel tab, in the Formwork supplier and Product family list,
select the suitable options.

The options vary depending on which catalogs and tool configurations
you have in use.

2. Select the panel size in the Formwork panel list, and set the other panel
properties such as the layout, height, and fill location.

3. Click Apply and Insert new to start placing the wall panels.

Move the mouse pointer over pour objects or concrete parts to select a
suitable location.

4. Pick the start point and the end point of the formwork wall panel.

A preview of what the panels would look like after being placed is shown
and you can decide which panels should be created. You can also change
the panel layout afterwards by using direct modification.
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Option Description
Formwork supplier

Product family

Select the formwork supplier and the
product family.

Formwork panel Select the panel size.

If the total length of the panel array
does not match with the panel width,
smaller panels with the same height
are automatically placed in the array
near the fill location (start/middle/end
of the array).

Avoid panels Define which panels are avoided
during the automatic insertion.

Panel layout Override the default panel widths.

When you insert the array for the first
time, leave the value empty and
modify the panel widths by using
direct modification.
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Option Description
Select the layout of the panel array.

Enter the offset from the wall bottom
and the total height of the panel
array.

One side

Two sides

Select whether the panels are created
on one side or on both sides of the
wall.

You can modify the wall thickness.
When the walls are inserted, the
applied wall thickness is overridden
with the actual wall thickness.

Fill location Use the Fill location option to control
where the empty space for the filler is
located.

Add to pour unit Select whether the panels and all
accessories related to the panels are
added to the pour or not.

Select new pour... The initial pour is identified
automatically when the panels are
inserted. To change the selected
pour, click the Select new pour...
button and select a new pour.

Note that there is no automatic
recognition of a new pour if you
decide to move the formwork panels,
or if you add pour breaks which
change the pours.

Insert new Click the Insert new button to start
inserting new formwork panel arrays.
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Option Description
Add accessories to selected Add various accessories automatically

to the selected panels.

Select the check boxes for the
accessories you want to add. Note
that for clamps and walers you can
control separately the creation at
horizontal and/or vertical edges.

Conditions tab

A condition is a set of formwork components, such as custom parts, parts or
other items, designed for special geometries in the wall. Conditions create the
formwork at special locations in the walls, such as L, T, and X corners,
bulkhead at the end of a wall, or pilasters at pour ends or at the middle of the
wall. Each different type of a special geometry is its own condition type.

Each condition consists of two or more sub-assemblies of the formwork
components, depending on the condition type. For example, the L corner
contains the inner corner assembly (1) and the external corner assembly (2).
When inserted in the model, the location of these assemblies is controlled with
the main insertion points and the two wall thickness parameters.

Use the Conditions tab to create a condition that consists of two or more sub-
assemblies of formwork components.
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1. On the Conditions tab, select what type of condition to use by clicking the
condition icon, and set the values to be applied for the selected condition.

2. Click Apply and Insert new to start placing the conditions.

3. Move the mouse pointer on the corner edges, pilaster edges, or ends of
the pours or parts.

Formwork placing tools - Walls automatically recognizes the condition
type and wall thickness properties.

Two arrows and a preview of the condition parts to be created is shown.
The red arrow indicates the first direction and the green arrow indicates
the second direction.

In the example below, the longer panel becomes parallel to the red arrow,
and the shorter panel will be parallel to the green arrow. Depending on
the case, you may switch the arrows by moving the mouse on the other
side of the edge.
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4. Click to place the conditions.

In some cases the condition tool may not recognize the condition type
correctly. For example, if you want to insert an L corner to a location where the
other side of the wall is very short it may happen that the condition tool is
trying to insert a corner pilaster.

Option Description
Select the condition to be created.
The selection is specific for each type
of condition.

Click the condition icon to select the
condition type to be used.
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Option Description
Modify the dimensions that control
the location of condition sub-items in
relation to the insertion point.

When you insert a new condition,
these dimensions are overridden by
the calculated values based on the
actual insertion location and
condition type.

Offset from bottom Define the vertical offset for the
condition from the bottom of the
wall.

Number of stacked conditions To insert two or more vertically
stacked conditions, enter the number
of stacked conditions.

Height Height of one stack when the
conditions are stacked.

Left/right corner Select how the conditions are
inserted if you use the left-hand side
placement.

If you select Rotate, the condition
always switches the red/green axis to
a right-hand side placement.

If you select Mirror, the left-hand side
placement is allowed.

Right-hand side placement:

Left-hand side placement:
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Option Description

Filler configuration Define which filler type is used when
you place a condition which includes
a filler.

Configure Open the Condition setup dialog box
to modify the existing conditions or to
define new conditions.

Define a new condition

Defining a new condition has two phases. First, you need create the needed
sub-assemblies. Once you have all the needed sub-assemblies available, you
can define a new condition by giving it a name and defining which sub-
assemblies are used in the new condition.

To define a new condition or to modify existing condition definitions, click the
Configure button. The Condition setup dialog box opens where you can do
the needed modifications.

Option Description
Condition setup file Conditions are saved in external data

files
(xxxx.FormworkTools.Conditions
.csv).

Select the file to add, modify or delete
the defined conditions.

Save

Save as

New

Click Save or Save as to save any
changes.

Click New to create a new empty file.

Condition type In the list, select the condition type to
be modified.

The list shows the existing conditions
if there are any. If you have one or
more existing conditions of the
selected type, you can select the
current condition in the list. When the
condition is selected, the current
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Option Description
definition values are shown and can
be set or modified on the right-hand
side of the dialog box.

Click  to create a new condition.

Click  to copy the selected
condition.

Click  to delete the condition.
Formwork supplier

Product family

Condition

The condition has the supplier and
the family properties. The conditions
are available only when the supplier
and the family are matching.

The condition names need to be
unique. Decide about naming
conventions so that the names are as
descriptive as possible.
The condition can have 2-5 sub-
conditions, depending on the
condition type. One condition must
have at least one sub-condition
defined as otherwise it does not
create anything.

Click  to open a sub-assembly
wizard dialog box to create a new
sub-assembly.

Click the Test button to verify the
output of the selected sub-assembly.

To test the sub-assembly, pick a point
in the model. The tool creates a
sample wall and the sub-conditions
with right side and left side
placement.

After you have done the testing, you
can delete model objects that were
created for testing purposes.

Total height for stacking The total height of the condition can
be calculated automatically based on
the selected sub-conditions, or you
can give the height.

The total height is used as the spacing
value when two or more conditions
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Option Description
are stacked vertically. If the condition
contains some parts sticking out and
this part is overlapping in the stack,
you may need to enter the total
height manually.

Left/right corner Test and verify how the Mirror and
Rotate options affect the output of
the condition.

Test condition Test and verify the output of the
whole condition, including all sub-
conditions.

To test the condition, pick a point in
the model. The tool creates a sample
wall and two conditions with right
side and left side placement.

After you have done the testing, you
can delete the model objects that
were created for testing purposes.

Create a new corner sub-assembly

The corner sub-assemblies are created using Formwork corner sub-
assembly wizard.

Typically, the corner sub-assembly contains formwork products at one side
(inner or external) of the corner, or at some corner in a pilaster.

The outcome of the wizard is stored in an external file with a name.

To open the dialog box, click  in the Condition setup dialog box on a
condition that requires a corner sub-assembly. Alternatively, you can search
for the Formwork corner sub-assembly wizard in the Applications and
components catalog.

Before you can start creating the corner sub-assemblies, you need to have an
external or inner corner formwork in the model. When you have created the
corner formwork, you can start the wizard.
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1. Pick the first corner point.

This point will be placed exactly to the external or to the internal corner of
the concrete in the wall in the final condition placement. Note that after
you have picked the point, the wizard steps forward automatically. You
can step back to re-pick a new point.

2. Pick a point showing the direction of the first wall.

This is typically the red arrow in condition placing.

3. Select all formwork items belonging to the first wall.

In practice, these formwork items will be parallel to the first wall when
placing the sub-assembly of the condition.
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4. Pick a point showing the direction of the second wall.

This is typically the green arrow in condition placing, and perpendicular to
the first wall.

5. Select all formwork items belonging to the second wall.

Typically, these formwork items will be parallel to the second wall when
placing the sub-assembly of the condition.

6. Enter a file name to save the corner sub-assembly. Click Finish to close
the wizard.
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All corner sub-assemblies are saved in the Formwork tools folder in the
model folder.

If you want to use the conditions in other models, you can copy or move the
files and the condition setup files to any of the system folders. To ensure that
the conditions work in other models, all custom components that the
conditions use must exist in the Applications and components catalog.

Create a new panel sub-assembly

The panel sub-assemblies are created using Formwork panel sub-assembly
wizard.

The outcome of the wizard is stored in an external file with a name.

To open the dialog box, click  in the Condition setup dialog box on a
condition that requires a panel sub-assembly. Alternatively, you can search for
the Formwork panel sub-assembly wizard in the Applications and
components catalog.

Before you can start creating the panel sub-assemblies, you need to have a
formwork panel and all necessary accessories in the model. When you have
created the formwork structure, you can start the wizard.

1. Pick the center point of the panel sub-assembly.

This point will be placed exactly to the center of the concrete wall in the
final condition placement. Note that after you have picked the point, the
wizard steps forward automatically. You can step back to re-pick a new
point.
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2. Pick a point showing the direction of the wall.

3. Select all formwork items belonging to the panel sub-assembly, and click
Next.

4. Enter a file name to save the panel sub-assembly. Click Finish to close the
wizard.

All panel sub-assemblies are saved in the Formwork tools folder in the
model folder.

If you want to use the conditions in other models, you can copy or move the
files and the condition setup files to any of the system folders. To ensure that
the conditions work in other models, all custom components that the
conditions use must exist in the Applications and components catalog.
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Fillers tab

Use the Fillers tab to create filler items to fill the gaps between two formwork
panels.

Note that this functionality does not work between condition and a panel,
meaning that the gap at the end of the wall cannot be filled with this setup.

1. On the Fillers tab, select the filler in the Filler configuration list, and set
the other filler properties.

2. Click Apply and either Select single panel or Select two panels,
depending on how you want to insert the fillers.

• To insert the filler by selecting a single panel, select the formwork
panel and a point to indicate the location (left, right, top, bottom of the
panel) and the width of the filler.

• To insert the filler by selecting two adjacent panels, select the first
formwork panel, and then select the second formwork panel.
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Ties tab

Use the Ties tab to insert an array of ties between two formwork panels on
the opposite sides of the wall.

1. On the Ties tab, select the tie in the Tie type list, and set the other tie
properties.

2. To add ties manually, set Tie layout to Single tie, Left side, or Right side.

3. Click Apply and Insert new to start placing ties.

4. In the model, hover your mouse pointer over the panel and pick the
points where you want to add ties.

5. Alternatively, to add ties automatically, set Tie layout to Preset array.
Select the panel, click Apply and Add to selected. The ties are placed
automatically.

6. If you want modify ties:

a. To adjust tie position, select a tie array, and drag the handle to move
the tie to the position you want.

b. To add new ties, duplicate the existing ones. Hold down the Ctrl key,
and drag a tie to a new position.

c. To delete individual ties, select a tie and press the Delete key.

d. To change the properties, spacing and/or start distances, modify the
properties in the dialog box and click Modify.

Clamps tab

Use the Clamps tab to insert a linear array of clamps, locks, or brackets at the
joining edges between two formwork panels to keep the formwork together.
Clamp placing works in the same way as the tie placing.

1. On the Clamps tab, select the clamp in the Clamp type list, and set the
other clamp properties.

2. To add clamps manually, set Clamp layout to Single clamp. With the
Custom array option you can set the offset and spacing.

3. Click Apply and Insert new to start placing clamps.

4. In the model, hover your mouse pointer over the panel, and pick the
points where you want to add clamps.

5. Alternatively, to add clamps automatically, set Clamp layout to Preset
array. Select the panel, click Apply and Add to selected.

The Add accessories dialog box opens where you can select which
accessories are added with the clamps. Click Add accessories to
selected. The clamps and other accessories are placed automatically to
the selected panels.
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6. If you want modify clamps:

a. To adjust a clamp position, select a clamp, and drag the handle to
move the clamp to the position you want.

b. To add new clamps, duplicate the existing ones. Hold down the Ctrl
key, and drag a clamp to a new position.

c. To delete individual clamps, select a clamp and press the Delete key.

d. To change the properties, spacing and/or start distances, modify the
properties in the dialog box and click Modify.

Walers tab

Use the Walers tab to insert walers to formwork panels. Typically, a waler is
used to connect two panels on top of each other but it can also be placed in
one single panel. The waler typically consists of the waler beam and two lock
devices fixing the waler to the panel.

1. On the Walers tab, select the waler in the Waler type list, and set the
other waler properties.

2. Enter the longitudinal offset. Leave the value empty to get the waler beam
centered between the input points.

3. Click Apply and Insert new to start placing walers.

4. In the model, hover your mouse pointer over the panel and pick the first
preset point. This is the first input point of the waler beam and the
location for the first lock device.

5. Move the mouse pointer on the next panel and pick the second preset
point. This is the end point of the waler beam and the location for the
second lock device.

If you did not enter the longitudinal offset value, the waler beam is
centered between the picked points. Otherwise, the waler beam starts at
the given offset from the first picked point.

Alternatively, to add walers automatically, click Apply and Add to
selected. The Add accessories dialog box opens where you can select
which accessories are added with the walers. Click Add accessories to
selected. The walers and other accessories are placed automatically to
the selected panels.

6. If you want modify walers:

a. To adjust a waler position, select a waler, and drag the point handle
to move the waler to the position you want.

By holding down the Alt key, you can drag the point anywhere, even
to a different panel.

b. To change the longitudinal offset, drag the point handle between the
picked points.
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c. To add new walers, hold down the Ctrl key, and drag a main handle
of a waler to a new position.

Braces tab

Use the Braces tab to insert supporting braces for a single formwork panel.

1. On the Braces tab, select the brace layout in the Brace layout list, and set
the other brace properties.

To add braces manually, set Braces layout to Single brace. With the
Custom array option you can set the offset and spacing.

2. Click Apply and Insert new to start placing braces.

3. In the model, hover your mouse pointer over the panel and pick the
points where you want to add braces.

4. Alternatively, to add braces automatically, set Brace layout to Preset
array. Select the panel, click Apply and Add to selected. The Add
accessories dialog box opens where you can select which accessories are
added with the braces. Click Add accessories to selected and the braces
and other accessories are placed automatically to the selected panels.

Platforms tab

Use the Platforms tab to insert an array of pour platforms at the top edge of
formwork panels.

1. On the Platforms tab, select the platform type in the Platform type list,
and set the platform spacing and offset.

2. Click Apply and Insert new to start placing platforms.

3. In the model, hover your mouse pointer over the panel and pick the start
and end points to create a linear array of platforms along the top edge of
the panel.

4. Alternatively, to add platforms automatically, select the panel and click
Add to selected. Platforms are added automatically to the selected
panels.

Formwork placing tools - Walls: configuration
You can set up your own configuration files for Formwork placings tools -
Walls.

The configuration is done by using comma separated files (.csv), which can be
edited with Microsoft Excel or any standard text editor. Each separate
formwork sub-tool component has its own configuration file.

The configuration files can be located in any of the system folders, or in the
sub-folder called Formwork tools in the current model folder.
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Example configuration files are located in the ...\ProgramData\Trimble
\Tekla Structures\<version>\Environments\common\system\CIP
\Formwork folder.

The configuration files are typically named by the formwork supplier and/or
the product families. There can be any number of files, and the files are
identified with a specific suffix. Each of the files controls one of the sub-tools in
the component. The files contain varying number of columns.

Use the following configuration files for Formwork placings tools - Walls to
set up

• formwork panels: xxxx.FormworkTools.Panels.csv
• ties for the tie placing tool: xxxx.FormworkTools.Ties.csv
• tie spacers placed by the tie placing tool:

xxxx.FormworkTools.TieSpacers.csv
• clamps: xxxx.FormworkTools.Clamps.csv
• braces: xxxx.FormworkTools.Braces.csv
• pouring platforms: xxxx.FormworkTools.Platforms.csv
• walers: xxxx.FormworkTools.Walers.csv
• conditions (corners, pilasters and bulkheads):

xxxx.FormworkTools.Conditions.csv
• fillers: xxxx.FormworkTools.Fillers.csv
The column names are given in the header line, which is the first line that is
not a comment line. Before the header line that contains the column titles you
can add the following line:

DISTANCE_UNIT=MM
When the distance unit is defined using the above setting, all distance values
can be given as decimal values in the specified units. The supported units are:
MM, DN, CM, M, INCH, FEET.

Configure the panel placing tool

.FormworkTools.Panels.csv
Add or modify one row for each panel.

The configuration of all accessories that can be added to panels is done in the
local coordinate system of the panel. The origin of the panel is located at the
center point of the panel.
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Definition Description
Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique panel name, which is shown
in the Formwork panel list.

PanelName Name of the custom part that will be
inserted in the model.

PanelAttributes Property file saved in the component
dialog box to be used when the
custom part will be inserted in the
model.

PanelInputOrder Define the orientation of the custom
part panels by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.
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Definition Description
The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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Definition Description

PanelPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in plane view.

The options are MIDDLE, LEFT, and
RIGHT.

PanelPlaneOffset Offset on plane. The default value is
0.

PanelRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PanelRotationOffset Rotation offset in degrees. The
default value is 0.

PanelDepthPosition Use Position at depth to insert the
custom part in plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PanelDepthOffset Offset at depth. The default value is 0.
PanelStartOffset PanelStartOffset and

PanelEndOffset change the
location of the actual start and end
handles of the custom part.

PanelStartOffset is the offset of
the actual start point from the generic
start point in the local coordinate
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Definition Description
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PanelEndOffset PanelEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

HeightProperty Name of the height property in the
custom part. If the height is fixed, this
is empty.

HeightValue Height of the panel.

Note that the height value is read
from the .csv file.

WidthProperty Name of the width property in the
custom part. If the width is fixed, this
is empty.

WidthValue Width of the panel.

Note that the width value is read from
the .csv file.

ThicknessProperty Name of the thickness property in the
custom part. If the thickness is fixed,
this is empty.

ThicknessValue Thickness of the panel.

Note that the thickness value is read
from the .csv file.

TieX TieX specifies the x locations of the
ties. Values must be enclosed in
parentheses () and separated by
spaces.

TieY TieY specifies the y locations of the
ties. Values must be enclosed in
parentheses () and separated by
spaces.

TiePickX
TiePickY

Define the possible x and y locations
of the ties when placing and picking a
single tie. You can either specify the x
and y values separately in two value
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Definition Description
or

TiePickXY
fields to define a regular grid of
locations, or if your panels require an
irregular pattern, you can specify a list
of x and y value pairs.

Always define the x and y values in
two separate fields (TiePickX and
TiePickY), or x and y value pairs in
one field (TiePickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

ClampX ClampX specifies the x locations of
the clamps at the horizontal top/
bottom edges. Values must be
enclosed in parentheses () and
separated by spaces.

ClampY ClampY specifies the y locations of
the clamps at the vertical left/right
edges. Values must be enclosed in
parentheses () and separated by
spaces.

ClampPickX
ClampPickY
or

ClampPickXY

Define the possible x and y locations
of the clamps when placing and
picking a single clamp. You can either
specify the x and y values separately
in two value fields to define a regular
grid of locations, or if your panels
require an irregular pattern, you can
specify a list of x and y value pairs.

Always define the x and y values in
two separate fields (ClampPickX and
ClampPickY), or x and y value pairs
in one field (ClampPickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BraceX
BraceY
or

BraceXY

Define the preset pattern for the
braces. You can either specify the x
and y values separately in two value
fields to define a regular grid of
locations, or if your panels require an
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Definition Description
irregular pattern, you can specify a list
of x and y value pairs.

Always define the x and y values in
two separate fields (BraceX and
BraceY), or x and y value pairs in one
field (BraceXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BraceTiltedX
BraceTiltedY
or

BraceTiltedXY

Define the preset pattern for the
braces when the panel is tilted. You
can either specify the x and y values
separately in two value fields to
define a regular grid of locations, or if
your panels require an irregular
pattern, you can specify a list of x and
y value pairs.

Always define the x and y values in
two separate fields (BraceTiltedX
and BraceTiltedY), or x and y value
pairs in one field (BraceTiltedXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BracePickX
BracePickY
or

BracePickXY

Define the possible x and y locations
of the braces when placing and
picking a single brace in a panel. You
can either specify the x and y values
separately in two value fields to
define a regular grid of locations, or if
your panels require an irregular
pattern, you can specify a list of x and
y value pairs.

Always define the x and y values in
two separate fields (BracePickX and
BracePickY), or x and y value pairs
in one field (BracePickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BraceTiltedPickX
BraceTiltedPickY

Define the possible x and y locations
of the braces when placing and
picking a single brace in a tilted panel.
You can either specify the x and y
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Definition Description
or

BraceTiltedPickXY
values separately in two value fields
to define a regular grid of locations,
or if your panels require an irregular
pattern, you can specify a list of x and
y value pairs.

Always define the x and y values in
two separate fields
(BraceTiltedPickX and
BraceTiltedPickY), or x and y value
pairs in one field
(BraceTiltedPickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

WalerEdgeOffset Offset of the waler input point
(=location of the clamp 1 and/or
clamp 2) from the panel edge when
the walers are placed automatically.

WalerX X locations used for placing walers
automatically at horizontal top/
bottom edges. The vertical (y) location
is defined by WalerEdgeOffset from
the top/bottom edge. Values must be
enclosed in parentheses () and
separated by commas or spaces.

WalerY Y locations used for placing walers
automatically at vertical left/right
edges. The horizontal (x) location is
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Definition Description
defined by WalerEdgeOffset from
left/right edge. Values must be
enclosed in parentheses () and
separated by commas or spaces.

WalerPickX Define the possible x locations of the
walers when placing and picking a
single waler. Values must be enclosed
in parentheses () and separated by
commas or spaces.

WalerPickY Define the possible y locations of the
walers when placing and picking a
single waler. Values must be enclosed
in parentheses () and separated by
commas or spaces.

Configure the tie placing tool

xxxx.FormworkTools.Ties.csv
A generic tie consists of three custom components: a bolt that usually goes
through the wall, and two locks on both sides of the formwork.

Add or modify one row for each tie.
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Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Tie name, which is shown in the Tie
type list.

This name can be unique, or multiple
tie configurations may have the same
name. When multiple tie
configurations have the same name,
the tool automatically selects the first
suitable tie based on the wall
thickness.

MaxLength Maximum length of the tie, measured
from outer faces of the two formwork
panels on opposite sides.

LengthProperty If the tie custom part is parametric
and has a parameter controlling the
effective length, this is the name of
the Length property.

Part1Name Name of the custom part 1 that will
be inserted in the model (=bolt).

Part1Attributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset on plane value when
the custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position at depth when the
custom part is inserted in the face
view of the main formwork panel.
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Definition Description
Part1DepthOffset This is Offset at depth when the

custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Offset of the first insertion point in
relation to Input point 2.

Part2Name Name of the custom part 2, which
typically is the lock on the front side
of the main formwork panel.

Part2Attributes Property file saved in the component
dialog box to be used when the
custom part will be inserted in the
model.

Part2StartOffset Offset of the second insertion point in
relation to Input point 1.

Part2EndOffset Location of the second insertion point
in relation to the Input point 1.

Part2... For custom part 2, you can specify the
same fields as for custom part 1.

Part3Name Name of the custom part 3, which
typically is the lock on the back side of
the main formwork panel.

Part3Attributes Property file saved in the component
dialog box to be used when the
custom part will be inserted in the
model.

Part3StartOffset Offset of the first insertion point in
relation to Input point 2.

Part3EndOffset Location of the second insertion point
in relation to the Input point 2.

Part3... For custom part 3, you can specify the
same fields as for custom part 1.

Configure the spacers for the tie placing tool

xxxx.FormworkTools.TieSpacers.csv
A generic tie spacer consists of three custom components: a tube that usually
goes through the wall, and two optional cones at each side of the wall.

Concrete components reference 3083 Concrete Detailing



Add or modify one row for each tie spacer.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Spacer name, which is shown in the
Spacer name list.

This name can be unique, or multiple
tie spacer configurations may have
the same name. When multiple tie
spacer configurations have the same
name, the tool automatically selects
the first suitable tie spacer based on
the wall thickness.

MinLength Minimum possible length of the tube,
measured from the inner faces of the
two formwork panels on the opposite
sides.

MaxLength Maximum possible length of the tube,
measured from the inner faces of the
two formwork panels on the opposite
sides.

LengthProperty If the tie spacer custom part is
parametric and has a parameter
controlling the effective length, this is
the name of the Length property.
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Definition Description
SpacerTubeName Name of the custom part (=tube).
SpacerTubeAttributes Property file saved in the component

dialog box to be used when the
custom part will be inserted in the
model.

SpacerTubePlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubePlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubeRotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

SpacerTubeRotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubeDepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubeDepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubeStartOffset Offset of the first insertion point in
relation to Input point 1.

SpacerTubeEndOffset Offset of the first insertion point in
relation to Input point 2.

StartConeName Name of the custom part, which
typically is the cone on the front side
of the main formwork panel.

StartConeAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the modell.

StartConeStartOffset Offset of the first insertion point in
relation to Input point 1.

StartConeEndOffset Location of the second insertion point
in relation to the Input point 1.

StartCone... For custom part 2, you can specify the
same fields as for custom part 1.

EndConeName Name of the custom part which
typically is the cone on the back side
of the main formwork panel.
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Definition Description
EndConeAttributes Property file saved in the component

dialog box to be used when the
custom is be inserted in the model.

EndConeStartOffset Offset of the first insertion point in
relation to Input point 2.

EndConeEndOffset Location of the second insertion point
in relation to the Input point 2.

EndCone... For custom part 3, you can specify the
same fields as for custom part 1.

Configure the clamp placing tool

xxxx.FormworkTools.Clamps.csv
The generic clamp contains one custom part. The input points are at the edges
of the two panels and thus the clamp can be parametric in terms of the filler
space, if needed.

Note that to create the brackets with some additional bolts or locks, you need
to make a new custom part containing both the bracket and all necessary
fittings:
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Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique clamp name.
CenterInput When YES, the first insertion point is

in the middle of the seam of the two
panels. If the value is NO, the insertion
points are offset from the edge of the
panels.

FillerGapProperty If the clamp custom part is
parametric, and the parameter can
adjust the gap between two panels,
this is the name of that parameter.
This field is empty if the clamp is not
parametric.

MaxFillerGap This value is used when clamps or
walers are added automatically along
with a formwork filler. If the free
space (=width of the filler) is less or
equal to the given MaxFillerGap,
clamps will be inserted. If the free
space is greater than the given
MaxFillerGap, walers will be
inserted.

Part1Name Name of the clamp custom part 1.
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.
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Definition Description
Part1PlaneOffset This is Offset in plane when the

custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Location of the second insertion point
in relation to the Input point 1.

Configure the brace placing tool

xxxx.FormworkTools.Braces.csv
A generic brace may consists of five custom parts, which are inserted in the
model by using three input points. You can select the upper and lower braces
separately. In the brace configuration file, the upper and lower braces are
defined separately; they both have own rows.
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Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Brace name which is shown in the list.

If you have several rows with the
same name, the tool automatically
selects the suitable brace based on
the minimum and maximum length.

Type Type of the brace. The options are
Upper or Lower.
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Definition Description
MinLength Minimum possible length of the main

brace measured from Input point 1
to Input point 2.

MaxLength Maximum possible length of the main
brace measured from Input point 1
to Input point 2.

LengthProperty If the brace custom part is parametric
and has a parameter controlling the
effective length, this is the name of
the Length property. At insertion it
will get the actual length value
between Input point 1 and Input
point 2.

BraceName Name of the custom part for the
upper or lower brace which will be
inserted into the model.

BraceAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the model.

BracePlanePosition This is Position in plane when the
custom part is inserted in plane view.

BracePlaneOffset This is Offset in plane when the
custom part is inserted in plane view.

BraceRotation This is Rotation when the custom
part is inserted in plane view.

BraceRotationOffset This is Rotation offset when the
custom part is inserted in plane view.

BraceDepthPosition This is Position in depth when the
custom part is inserted in plane view.

BraceDepthOffset This is Offset in depth when the
custom part is inserted in plane view.

BraceStartOffset Offset of the first insertion point in
relation to Input point 1.

BraceEndOffset Offset of the first insertion point in
relation to Input point 2.

Bracket1Name Name of the custom part for the top
bracket (upper brace) or bottom
bracket (lower brace) which will be
inserted into the model.

Bracket1Attributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the model.
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Definition Description
Bracket1StartOffset Offset of the first insertion point in

relation to Input point 1.
Bracket1EndOffset Location of the second insertion point

in relation to the Input point 3.
Bracket1... For custom part 2, you can specify the

same fields as for custom part 1.
Bracket2Name Name of the custom part for the floor

bracket which will be inserted into the
model.

If both upper and lower brace have a
definition for the bracket, the bracket
defined for the lower brace will be
created.

Bracket2Attributes Property file saved in the component
dialog box to be used when the
custom part will be inserted in the
model.

Bracket2StartOffset Offset of the first insertion point in
relation to Input point 2.

Bracket2EndOffset Location of the second insertion point
in relation to the Input point 2.

Bracket2... For custom part 3, you can specify the
same fields as for custom part 1.

Configure the pouring platform placing tool

xxxx.FormworkTools.Platforms.csv
A generic pouring platform contains two custom parts, which are inserted in
the model as a linear array of custom parts.
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Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique pouring platform name.
Type The type of the platform (A or B).

The length of the array is defined with
start and end points of the platform.
The custom part placing has two
methods:

• Type A: the length of one platform
custom part is fixed, and the
custom parts are inserted
sequentially.
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Definition Description
• Type B: the first custom part is a

support, which is placed at start,
intermediate and end points of
the array. The second custom part
is placed between the main
support parts.

Length Effective length of one platform
element.

Width Width of the platform.
Spacing Spacing between the custom parts in

the array.
Part1Name Name of the custom part 1.
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Offset of the first insertion point in
relation to Input point 1.

Part2Name Name of the custom part 2.
Part2Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.
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Definition Description
Part2StartOffset Offset of the first insertion point in

relation to Input point 1.
Part2EndOffset Location of the second insertion point

in relation to the Input point 1.
Part2... For custom part 2, you can specify the

same fields as for custom part 1.

Configure the waler placing tool

xxxx.FormworkTools.Walers.csv
A generic waler consists of three custom parts, the waler beam and two clamp
devices. The generic input points are located in the outer face of the panel.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Waler name, which is shown in the
Waler type list.

This name can be unique, or multiple
tie waler configurations may have the
same name. When multiple waler
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Definition Description
configurations have the same name,
the tool automatically selects the
shortest waler based on the actual
length measured between the input
points.

Typically, you can specify the same
waler with a unique name and a
common name. This way you can
select the common name and let the
system select the waler based on the
input length. By selecting the unique
name you can force the usage of a
certain waler configuration.

MaxLength Maximum possible effective length of
the waler, measured from the first
input point to the second input points
(=clamp locations), typically little less
than the physical length.

MinLength Minimum length of a waler with
variable length. For fixed length
walers, leave the value empty or give
same value as for the maximum
length.

BeamName Name of the clamp custom part 1.
BeamAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

BeamPlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

BeamPlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

BeamRotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

BeamRotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

BeamDepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.
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Definition Description
BeamDepthOffset This is Offset in depth when the

custom part is inserted in the face
view of the main formwork panel.

BeamStartOffset Offset of the first insertion point in
relation to Input point 1.

BeamEndOffset Location of the second insertion point
in relation to the Input point 1.

Clamp1Name Name of the clamp 1 custom part.
Clamp1Attributes Property file saved in the component

dialog box to be used when the
custom part will be inserted in the
model.

Clamp1StartOffset Offset of the first insertion point in
relation to Input point 1.

Clamp1EndOffset Location of the second insertion point
in relation to the Input point 1.

Clamp1... For custom clamp 1, you can specify
the same fields as for waler beam
custom part.

Clamp2Name Name of the clamp 2 custom part.
Clamp2Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Clamp2StartOffset Offset of the first insertion point in
relation to Input point 1.

Clamp2EndOffset Location of the second insertion point
in relation to the Input point 1.

Clamp2... For custom clamp 2, you can specify
the same fields as for waler beam and
clamp 1 custom parts.

Configure the conditions for condition placing tool

xxxx.FormworkTools.Conditions.csv
A condition in the context of the formwork tools covers the L, T and X corners,
pilasters, pour stops and columns. The final condition formwork is divided into
two or more sub-assemblies depending on the condition type.

If you define condition configurations manually:

1. Model the full condition assembly using the custom parts, beams and/or
filler tools.

2. Create the necessary sub-assemblies using the two wizards. Split the
content of the complete condition to named sub-assemblies. When these
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sub-assemblies are inserted in the model, the final location is parametric
in the sense that the location depends on the actual geometry of the
concrete structure.

3. Insert a new condition specification in the condition configuration file.

The formwork condition placing tool supports the following condition types:

Definition Description
L corner (L) For L corner, you can specify the inner

corner sub-assembly (1) and the
exterior corner sub-assembly (2).

The corner sub-assembly is defined
with the Corner sub-assembly
wizard.

With the wizard you can specify two
sets of formwork items, which will be
rotated according to the joining walls
when the corner is placed in the
model. The two corner sub-
assemblies 1 and 2 are inserted
according to the thickness of the
joining walls.

T corner (T) For T corner, you can specify two
inner corners (1+2) and the back
panel (3).
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Definition Description
The corner sub-assembly is defined
with the Formwork corner sub-
assembly wizard.

The back panel sub-assembly is
defined with the Formwork sub-
assembly wizard, and it contains a
single insertion point + direction.

When the T corner is placed in the
model, the insertion point of the
panel sub-assembly is located at the
intersection of the joining wall center
line and the exterior face of the
horizontal wall.

X corner (X) For X corner, you can specify the four
inner corners (1-4).

Corner pilaster (CP) For corner pilaster, you can specify
one inner corner sub-assembly (1)
and three external corner sub-
assemblies (2-4).

Pilaster (P) For pilaster, you can specify two inner
corners (1 and 4), two external
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Definition Description
corners (2 and 3), and the back panel
(5).

Pilaster inside corner (IP) For inner pilaster, you can specify one
external corner (1) and three inner
corners (2-3).

Bulkhead (B) For bulkhead, you can specify two
external corners (1 and 2) and two
middle panels (3 and 4). Panel 4 will
be located at end of pour and all
other sub-items will be offset by the
given dimension.
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Definition Description
Column (COL) For column, you can specify four

panel assemblies and/or four corner
assemblies.

Create a corner sub-assembly

Corner sub-assembly is the building block for one side of the L corner or any
of the inner corners in the T and X corners.

1. First model all the needed formwork objects. Only beams and/or custom
parts can be used for modeling, so if you have other components, you
need to explode them.

2. Decide which object should rotate with the first direction, and which
objects should rotate with the second edge at the corner if/when the
corner angle varies.

3. Start the Formwork corner sub-assembly wizard tool.

4. Pick the corner point as shown below.

5. Pick a point to identify the first direction.
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6. Select the corner parts (custom parts and/or beams) at the first side of the
corner.

7. Pick a point to identify the second direction.

8. Select the corner parts (custom parts and/or beams) at the second side of
the corner.

9. Enter a name and click Finish to save the detailed half of the corner into
an external file.

Note that the wizard should be run separately for the inner corner (red dots)
and external corner (blue dots). Ensure that you do not include same objects
twice as that would lead to duplicate objects in the model.

Create a panel sub-assembly

The panel sub-assembly is the building block of the formwork at the back side
of the T corner and at pilasters.

1. First model all the needed formwork objects (custom parts and/or
beams).

2. Start the Formwork sub-assembly wizard tool.

3. Pick the center point of the object at the back of the wall as shown below.
This will be used as the insertion point when this panel sub-assembly is
inserted in an actual T corner.

4. Pick a point to identify the direction.

5. Select the formwork parts (custom parts and/or beams) forming the panel
sub-assembly.

6. Enter a name and click Finish to save the detailed panel and accessories
into an external file.

Control the behavior of conditions with mirroring

When you define the corner sub-assemblies, it can be that the left-hand side
corner needs to be placed in a right-hand side location. When this happens,
the corner sub-assembly needs to be mirrored. Mirroring custom parts or
formwork items is not always possible, especially when the part is not
symmetric in any direction. The condition placing tool can use four different
methods for mirroring. With the configuration file

Concrete components reference 3101 Concrete Detailing



xxxxx.SubAssemblyItems.ini you can control which method will be used
for a certain corner sub-assembly case. The file contains the mirroring method
keyword, and after the keyword you can introduce the names of the items or
partial name tags to identify multiple matching items.

Mirroring method Description
Move Default method.

The custom part or formwork item is
moved by an offset measured from
the mirroring line to the center of the
custom part or formwork item.

RotateAroundZ Input points are rotated 180 degrees
around the center point at the
mirroring line.

RotateAroundAxis Input points are first rotated 180
degrees around the mirroring line
and then the custom part is rotated
180 degrees around the input axis.

Mirror Input point locations are mirrored
and then the start and end points are
swapped.

FlipLocalXY Custom part or formwork item is
moved and the local x and y axis at
center are flipped (=rotated around
local z 180 degrees).

FlipLocalXZ Item or custom part is moved and
local x and z axis at center are flipped
(=rotated around local y 180 degrees).
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Mirroring method Description
FlipLocalYX Item or custom part is moved and

local y and z axis at center are flipped
(=rotated around local x 180 degrees).

TurnUpSideDown Item or custom part is moved and the
mirroring is done by turning the
component upside down in the global
vertical direction.

An example of the content in a configuration xxxxx.SubAssemblyItems.ini
file.

// This file allows you to define how items and custom parts in corner 
sub assemblies
// are handled when placing the right handed corner into left handed 
situation or vice versa.
//
// By default items are just moved and no true mirroring happens. In 
following lines you can specify
// the mirroring methods used for certain items or custom parts. You can 
introduce full names or partial names.
//
// The possible methods are:
//  #Mirror - input points are mirrored 
//  #RotateAroundAxis - input points are mirrored and the item/custom 
part is rotated 180 degrees around the axis:
//  #RotateAroundZ - input points are rotated 180 degrees around the 
center point
//  #FlipLocalXY - the item/custom part is moved and local X and Y axis's 
at center are flipped (=rotated around local Z 180 degrees)
//  #FlipLocalXZ - the item/custom part is moved and local X and Z axis's 
at center are flipped (=rotated around local Y 180 degrees)
//  #FlipLocalYZ - the item/custom part is moved and local Y and Z axis's 
at center are flipped (=rotated around local X 180 degrees)
//  #TurnUpSideDown - the item/custom part is moved and "mirroring" is 
done by turning the component up-side.down
//
// Just list the names or partial names following the method keyword. Do 
not change the key words.
//

#Mirror
_FIXING_BOLT

#RotateAroundAxis
DOKA-3D-583002000

#RotateAroundZ
_INSIDE
_OUTSIDE
_CORNER
_LEFT
_RIGHT

#FlipLocalXY

#FlipLocalXZ

#FlipLocalYX

#TurnUpSideDown
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Configure the fillers for the filler placing tool

xxxx.FormworkTools.Fillers.csv
With the filler placing tool you can create a filler by inserting timber beams or
plywood and timber studs, and/or specific custom parts in the model. The
creation of these model objects depends on the actual space to be filled. The
basic principle of the creation of the various filler items is the following:

• If the space to be filled is larger than the given minimum plywood width,
the filler tool will create the plywood (=contour plate) and the timber studs.

• If the space to be filled is smaller than the minimum plywood width, or
plywood is not specified, the actual space is filled by one or more timber
beams or custom parts. The target is to fill the actual space as completely
as possible. The largest beams and/or custom parts are preferred and
smaller pieces are created only when the space is smaller than the size of
the larger pieces.

Filler built with
plywood and studs

Filler built with timber
beams

Filler built with custom
part

To configure the filler tool, you can specify the properties for timber beam,
plywood, and settings for one to ten alternatives of custom parts.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.
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Definition Description
Family Family name, which is shown in the

Product family list.
Name Unique filler name.
TimberWidths List of available timber beam widths

(10 20 50 100).
TimberDepth Depth of the timber beam.
TimberAssPrefix Assembly prefix.
TimberAssStartNo Assembly start number.
TimberPartPrefix Part prefix.
TimberPartStartNo Part start number.
TimberName Name of the timber beam.
TimberClass Class of the timber beam.
TimberFinish Finish of the timber beam.
TimberMaterial Material of the timber beam.
StudWidth Width of the timber stud.
StudDepth Depth of the timber stud.
StudAssPrefix Assembly prefix.
StudAssStartNo Assembly start number.
StudPartPrefix Part prefix.
StudPartStartNo Part start number.
StudName Name of the timber stud.
StudClass Class of the stud.
StudFinish Finish of the stud.
StudMaterial Material of the stud.
PlywoodWidth Minimum width of the plywood. The

actual width depends on the actual
space to be filled.

PlywoodThickness Thickness of the plywood.
PlywoodAssPrefix Assembly prefix.
PlywoodAssStartNo Assembly start number.
PlywoodPartPrefix Part prefix.
PlywoodPartStartNo Part start number.
PlywoodName Name of the plywood part.
PlywoodClass Class of the plywood part.
PlywoodFinish Finish of the plywood part.
PlywoodMaterial Material of the plywood part.
Part1Name Name of the custom part 1.
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Definition Description
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Offset of the first insertion point in
relation to Input point 2.

Part1Length Length of the custom part which is
also the space to fill if/when this
custom part is added to the model.

Part1Height Height of the custom part.
Part2... Part3... Part10... In addition to custom part 1, you can

specify up to nine other custom parts.
In practice, at least the PartXLength
needs to be different for all specified
custom parts. The tool selects the
part with the most suitable length
depending on the actual space to be
filled.

Formwork placing tools - Slabs
Formwork placing tools - Slabs is a set of components that helps in detailed
modeling of typical slab formwork. These components are placing tools, and
therefore you need to have all relevant formwork products such as panels,
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girders, and shuttering props available in the Applications & components
catalog.

You can get the formwork products provided by formwork suppliers from
Tekla Warehouse, for example. In addition, Formwork placing tools - Slabs
requires additional configuration files that contain the necessary information
about the formwork product components. These configuration files may come
with the formwork product catalogs provided by formwork suppliers, but you
can create the configuration files yourself as well.

Formwork placing tools - Slabs contains tools to place and modify the
following formwork elements:

• formwork slab panels typically appearing as two-dimensional arrays
covering a certain area

• cross and main girders supporting the slab panels

• shuttering props supporting the girders or slab panels directly depending
on the formwork system

• stop ends on top of slab panels

• safety railings in the outer edges of the slab panel area

Because Formwork placing tools - Slabs consists of a set of sub-tools which
are combined in one dialog box, each tab is an individual sub-tool. Both the
Formwork placing tools - Slabs and the sub-tools are available in
Applications and components catalog.

Most of the settings in the components are preset. You can control the
different settings by selecting a suitable options in the dialog box. These
preset settings are organized according to the formwork supplier and the
product families.

However, if you create your own configuration files, you can use the values in
the configuration files instead of the preset values.

You can access the Formwork placing tools - Slabs in the Concrete
Contractor, General Contractor and Rebar Detailer roles in the Default
environment.

Panel tab

Use the Panel tab to model an area of formwork panels for slabs.

1. On the Panel tab, in the Formwork supplier and Product family list,
select the suitable options.

The options vary depending on which catalogs and tool configurations
you have in use.

2. Select the panel size in the Formwork panel list, and set the other panel
properties.

3. Click Apply and Insert new to start placing the slab panels.

4. Hover the mouse pointer on top of the slab to identify the bottom surface.
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5. Select the slab and pick three or more points to identify the area on the
surface. A preview of the panels is shown while you pick the points.

Alternatively, hold down the Alt key and select the surface to create
panels on the whole surface.

6. To finish, click the middle mouse button.

7. If you need to modify the panel, drag the corner points.

Cross girders and Main girders tabs

Use the Cross girders and Main girders tabs to create cross and main girders
in two directions, or only main girders, or no girders at all.

1. On the Cross girders or on the Main girders tab, select the girder in the
Girder name list.

2. Enter an Overlap value. If you leave the value empty, the tool sets it
automatically.

3. Enter the girder Length, if the girder length is not fixed. Use space as a
separator if you need to have girders with different lengths.

a. To create girders at once, select the panel area, and click Apply and
Add to selected.

The Add shoring dialog box opens.

b. Set the girder offset and spacing.

You can also select the option whether to create girders at the panel
area edges, and the girder layout at the panel seam.

c. Click Create.

a. To create a single line of girders, click Apply and Insert new.

Concrete components reference 3108 Concrete Detailing



b. Pick the girder points.

c. To finish, click the middle mouse button.

Shuttering tab

Use the Shuttering tab to create shuttering props, shuttering bases, and
shuttering heads.

1. On the Shuttering tab, select the prop name in the Girder name list, the
prop head name in the Head name list, and the prop base name in the
Base name list.

2. Enter the total height for the prop.

• To create multiple shuttering props, select the panel area and click
Apply and Add to selected.

The shuttering props are created.

• To create a single shuttering prop, click Apply and Insert new. Pick the
shuttering prop location.
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Stop ends tab

Use the Stop ends tab to create stop ends around the slab panel.

1. On the Stop ends tab, select the stop end name in the Stop end name
list.

2. Enter the offset and spacing for the stop ends.

3. Click Apply and Insert new to start inserting the stop ends.

• If no panel is selected, first select the slab panel.

• If you have already selected the slab panel, you do not need to do it
again.

4. Pick the start point and the end point for the stop end.

5. To finish, click the middle mouse button.

Railings tab

Use the Railings tab to create railings around the slab.

1. On the Railings tab, select the railing name in the Railing name list.

2. Enter the offset and spacing for the railings.

3. Click Apply and Insert new to start inserting the railings.

4. • If the panel is selected, first select the slab panel.

Depending on the railing type, you may need to select the top face of
the slab, side face of the wall, or the slab panels.
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• If you have already selected the slab panel, you do not need to do it
again.

5. Pick the start point and the end point for the railing.

6. To finish picking, click the middle mouse button.

Contextual toolbar for formwork slab panel

When you select a slab panel, the following contextual toolbar appears and
you can modify the parts:

Option Description
Modify the boundary of the panel
area and openings. Move edges or
points by dragging, or insert new
points by dragging the insertion
points at the middle of the edges.

In addition, you can move the start
point, which is the corner of the
panel, and direction of the panel by
dragging the handles.

Concrete components reference 3111 Concrete Detailing



Option Description

Add new rectangular openings in the
panel area. After adding a rectangular
opening, you can edit the opening to
any shape.

Typically, the openings are larger
areas where the panels are not
needed. To replace the regular panel
with some special infill parts, use the
single panel removal tool .

Remove or restore single panels in
the area. Select the panels to be

removed and click .

Select multiple panels by holding
down the Shift key when clicking the
panels. Hold down the Ctrl key to
unselect the panels.
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Option Description

Modify cross girders.

To modify a single girder line, select
the line to modify it.
Modify main girders.

To modify a single girder line, select
the line to modify it.
Modify shuttering props in the panel
area.

You can

• move the individual props by
dragging the handles. Hold down
the Ctrl key to create a copy of the
prop.

• move a whole line of props by
dragging the line handles. Hold
down the Ctrl key to create a copy
of all the props in the line.

• change the shuttering prop head
or base for shuttering props on all
selected points and/or lines.

Note that props created for the girder
lines can only be moved/copied along
the girder line.
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Option Description

Formwork placing tools - Slabs: configuration
You can set up your own configuration files for Formwork placings tools -
Slabs.

The configuration is done by using comma separated files (.csv), which can be
edited with Microsoft Excel or any standard text editor. Each separate
formwork sub-tool component has its own configuration file.

The configuration files can be located in any of the system folders, or in the
sub-folder called Formwork tools in the current model folder.

Example configuration files are located in the ...\ProgramData\Trimble
\Tekla Structures\<version>\Environments\common\system\CIP
\Formwork folder.

The configuration files are typically named by the formwork supplier and/or
the product families. There can be any number of files, and the files are
identified with a specific suffix. Each of the files controls one of the sub-tools in
the component. The files contain a varying number of columns.

Use the following configuration files for Formwork placings tools - Slabs to
set up

• formwork slab panels: xxxx.FormworkTools.SlabPanels.csv
• girders: xxxx.FormworkTools.Girders.csv
• prop parts of shuttering props: xxxx.FormworkTools.Props.csv
• prop bases of shuttering props: xxxx.FormworkTools.PropBases.csv
• prop heads of shuttering props: xxxx.FormworkTools.PropHeads.csv
• stop ends: xxxx.FormworkTools.StopEnds.csv
• safety railings: xxxx.FormworkTools.Railings.csv
The column names are given in the header line, which is the first line that is
not a comment line. Before the header line that contains the column titles you
can add the following line:
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DISTANCE_UNIT=MM
When the distance unit is defined using the above setting, all distance values
can be given as decimal values in the specified units. The supported units are:
MM, DN, CM, M, INCH, FEET.

Configure the slab panel placing tool

.FormworkTools.SlabPanels.csv
Add one row for each panel. Specify columns as follows. For a slab panel, you
can specify one custom part that is placed if the panel is a full panel, and part
properties used for placing a filler part at locations where the panel is not a
full panel.

The configuration is done in the local coordinate system of the panel. The
origin of the panel is located at the center point of the top of the panel.

Row Definition
Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique panel name, which is shown
in the Formwork panel list.
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Row Definition
PanelName Name of the custom part that will be

inserted in the model.

This is the custom part that the panel
configuration will use.

PanelAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

PanelInputOrder Define the orientation of the custom
part panels by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
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Row Definition
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

PanelPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT and
RIGHT.

PanelPlaneOffset Offset on plane. The default value is
0.

PanelRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PanelRotationOffset Rotation offset in degrees. The
default value is 0.

PanelDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PanelDepthOffset Offset at depth. The default value is 0.
PanelStartOffset PanelStartOffset and

PanelEndOffset change the
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Row Definition
location of the actual start and end
handles of the custom part.

PanelStartOffset is the offset of
the actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PanelEndOffset PanelEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

LengthProperty The name of the length property in
the custom part. If the length is fixed,
this is empty.

LengthValue Length of the panel.

Note that the length value is read
from the .csv file.

WidthProperty The name of the width property in the
custom part. If the width is fixed, this
is empty.

WidthValue Width of the panel.

Note that the width value is read from
the .csv file.

ThicknessProperty The name of the thickness property in
the custom part. If the thickness is
fixed, this is empty.

ThicknessValue Thickness of the panel.

Note that the thickness value is read
from the .csv file.

CrossGirderX The girder values control the default
spacing of the girders visible in the
Add shoring dialog box. The values in
the .csv file are taken from the
center of the panel.

CrossGirderX specifies the default x
locations of the cross girders. Values
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Row Definition
must be enclosed in parentheses ()
and separated by spaces.

MainGirderY MainGirderY specifies the default y
locations of the main girders. Values
must be enclosed in parentheses ()
and separated by spaces.

PartName The following part properties refer to
the properties of the defined filler
parts used when the custom parts
cannot fill the whole slab area.

Name of the panel part (contour
plate).

PartClass Class of the part.
PartFinish Finish of the part.
PartMaterial Material of the part.
PartThickness Thickness of the part.
PartAssPrefix Assembly prefix.
PartAssStartNo Assembly start number.
PartPartPrefix Part prefix.
PartPartStartNo Part start number.

Configure the girder line tool

.xxxx.FormworkTools.Girders.csv
For a girder, you can specify either a custom part or a beam which is placed in
the model.

The position settings are given in the local coordinate system of the girder.
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Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Girder name, which is shown in the
Girder name list.

This name can be unique, or you can
specify two or more girders with the
same name. If one girder name has
two or more specifications, the
placing tool may create a line
containing girders with variable
lengths.

Type The type of the girder. The type
defines the list in which the girder is
shown. The options are: CROSS, MAIN
and ANY.

Length Length (x) of the girder.

Note that the length value is read
from the .csv file.

Width Width (y) of the girder.

Note that the value is read from
the .csv file.
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Row Definition
Depth Depth (z) of the girder.

Note that the depth value is read
from the .csv file.

MinLength If the length varies, this is the
minimum length of the girder.

MaxLength If the length varies, this is the
maximum length of the girder.

MinOverlap When two or more girders are placed
in one girder line, the girders can
overlap to achieve the exact start and
end for the line. The MinOverlap
value controls the minimum overlap.

MaxOverlap When two or more girders are placed
in one girder line, the girders can
overlap to achieve the exact start and
end for the line. The MaxOverlap
value controls the maximum overlap.
If the girders should not overlap,
enter 0 as the value.

InputPointLocation The depth location of girder input
points. The options are:

• CrossGirderBottom (only for
main girders)

• SlabBottom
• SlabTop

GirderName Name of the custom part that will be
inserted in the model.

This is the custom part that the girder
configuration will use.

GirderAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

GirderInputOrder Define the orientation of the custom
part girders by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:
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Row Definition
• StartEnd: default if no other

value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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Row Definition

GirderPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

GirderPlaneOffset Offset on plane. The default value is
0.

GirderRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

GirderRotationOffset Rotation offset in degrees. The
default value is 0.

GirderDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

GirderDepthOffset Offset at depth. The default value is 0.
GirderStartOffset GirderStartOffset and

GirderEndOffset change the
location of the actual start and end
handle points of the custom part.

GirderStartOffset is the offset of
the actual start point from the generic
start point in the local coordinate
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Row Definition
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

GirderEndOffset GirderEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

GirderLengthProperty The name of the length property in
the custom part. If the length is fixed,
this is empty.

GirderWidthProperty The name of the width property in the
custom part. If the width is fixed, this
is empty.

GirderDepthProperty The name of the depth property in
the custom part. If the width is fixed,
this is empty.

BeamName Name of the girder part (beam).
BeamProfile Profile of the beam. If this is empty,

the beam is not created.
BeamClass Class of the girder part.
BeamFinish Finish of the girder part.
BeamMaterial Material of the girder part.
BeamThickness Thickness of the girder part.
BeamAssPrefix Assembly prefix.
BeamAssStartNo Assembly start number.
BeamPartPrefix Part prefix.
BeamPartStartNo Part start number.

Configure the shuttering prop placing tool

xxxx.FormworkTools.Props.csv
For a prop, you can specify a custom part that is placed in the model. In
addition, a shuttering prop may contain the base and head parts, but these
are configured in separate files (xxxx.FormworkTools.PropBases.csv and
xxxx.FormworkTools.PropHeads.csv).

The position settings are given in the local coordinate system of the prop.
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Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Prop name, which is shown in the
Prop name list. This name can be
unique, or you can specify two or
more props with the same name. If
one prop name has two or more
specifications, the placing tool can
select the suitable prop based on the
effective height of the shuttering.

MinHeight The height of the prop from the
bottom of the base prop to the
bottom of the concrete slab.

If the length varies, this is the
minimum length. For a prop with
fixed height the MinHeightand
MaxHeight are same.

MaxHeight If the length varies, this is the
maximum length.
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Row Definition
PropInputPoint The location of the first input point of

the custom part. The options are:

• BaseBottom
• BaseTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom

PropInputPoint2 The location of the second input point
of the custom part.

If you use value None, the second
input point is calculated as an offset
PropEndOffset from the first input
point.
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Row Definition
PropHeightProperty The name of the prop height property

in the custom part. This is empty if
the height is not parametric.

PropName The name of the custom part that will
be inserted in the model.

This is the custom part that the prop
configuration will use.

PropAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

PropInputOrder Define the orientation of the custom
part prop by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.
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Row Definition
• CenterDown: the first input point

is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

PropPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

PropPlaneOffset Offset on plane. The default value is
0.

PropRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PropRotationOffset Rotation offset in degrees. The
default value is 0.

PropDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PropDepthOffset Offset at depth. The default value is 0.
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PropStartOffset PropStartOffset and

PropEndOffset change the location
of the actual start and end handle
points of the custom part.

PropStartOffset is the offset of the
actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PropEndOffset PanelEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

If the PropEndOffset value is not
given, or the value None is used,
PropEndOffset is an offset from the
first input point to the second input
point.

Configure the base parts of the shuttering prop placing tool

xxxx.FormworkTools.PropBases.csv
For a shuttering prop, you can specify an additional custom part that is placed
in the model at the bottom end of the prop.

The position settings are given in the local coordinate system of the prop.

Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique prop base name, which is
shown in the Base name list.
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PropInputPoint The location of the first input point of

the custom part. The options are:

• BaseBottom
• BaseTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom

PropOffset Automatic offset (shortening) of the
prop if the base part is created.

BaseName Name of the custom part that will be
inserted in the model.

BaseAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

BaseInputPoint The location of the first input point of
the custom part. The options are:

• BaseBottom
• BaseTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom
The second input point of the custom
part is calculated as an offset
BaseEndOffset from the first input
point.
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PropInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.
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• CenterLeft: the first input point

is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

BasePlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

BasePlaneOffset Offset on plane. The default value is
0.
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BaseRotation Use Rotation to insert the custom

part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

BaseRotationOffset Rotation offset in degrees. The
default value is 0.

BaseDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

BaseDepthOffset Offset at depth. The default value is 0.
BaseStartOffset BaseStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

BaseEndOffset BaseEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

Configure the head parts of the shuttering prop placing tool

xxxx.FormworkTools.PropHeads.csv
For a shuttering prop, you can specify an additional custom part that is placed
in the model at the top end of the prop.

The position settings are given in the local coordinate system of the prop.

Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Concrete components reference 3133 Concrete Detailing



Row Definition
Name Unique prop head name, which is

shown in the Head name list.
PropOffset Automatic offset (shortening) of the

prop if the head part is created.
AutoRotate Control whether the head part is

rotated automatically 90 degrees
around the prop axis when the head
is located at the overlap of two
girders.

Set this value to YES to get the head
rotated 90 degrees. Note that this
only controls the rotation when you
have not given any specific value for
the rotation in the dialog box.

HeadName Name of the custom part that will be
inserted in the model.

HeadAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

HeadInputPoint The location of the first input point of
the custom part. The options are:

• HeadBottom
• HeadTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom
The second input point of the custom
part is calculated as an offset
HeadEndOffset from the first input
point.
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HeadInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.
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• CenterLeft: the first input point

is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

HeadPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

HeadPlaneOffset Offset on plane. The default value is
0.
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HeadRotation Use Rotation to insert the custom

part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

HeadRotationOffset Rotation offset in degrees. The
default value is 0.

HeadDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

HeadDepthOffset Offset at depth. The default value is 0.
HeadStartOffset HeadStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

HeadEndOffset HeadEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. The offset is given as x, y and
z values separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, zero offset
(100 0 0) is used.

Configure the stop end custom parts for the stop end placing tool

xxxx.FormworkTools.StopEnds.csv
For a stop end, you can specify two custom parts: a sheet and an angle. The
sheet is typically the actual form piece, and the angles are placed with a
spacing to support the sheet.

The position settings are given in the local coordinate system of the stop end.
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Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique stop end name, which is
shown in the Stop end name list.

MinLength Minimum length of the stop end
sheet part.

MaxLength Maximum length of the stop end
sheet part.

Width Total width of the stop end including
the angles.

Depth Total depth of the stop end.
AngleSpacing Default spacing of the angle parts.

This will be used if you do not specify
any value for the spacing.

SheetName Name of the custom part that will be
inserted in the model.

SheetAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.
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SheetInputOrder Set the final locations of the input

points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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SheetPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

SheetPlaneOffset Offset on plane. The default value is
0.

SheetRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

SheetRotationOffset Rotation offset in degrees. The
default value is 0.

SheetDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

SheetDepthOffset Offset at depth. The default value is 0.
SheetStartOffset SheetStartOffset is the offset of

the actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.
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SheetEndOffset SheetEndOffset specifies the

location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

AngleName Name of the custom part that will be
inserted in the model.

AngleInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
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point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

AnglePlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

AnglePlaneOffset Offset on plane. The default value is
0.

AngleRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

AngleRotationOffset Rotation offset in degrees. The
default value is 0.

AngleDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

AngleDepthOffset Offset at depth. The default value is 0.
AngleStartOffset AngleStartOffset is the offset of

the actual start point from the generic
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start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

AngleEndOffset This offset specifies the location of
the second input point (of the custom
part) in relation to the first input point
in the local coordinate system. The
offset is given as x, y and z values
separated by a space or a colon, and
enclosed in parentheses (0 100 0). If
no value is given, zero offset (100 0 0)
is used.

AngleEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

Configure the railing custom parts for the railing placing tool

xxxx.FormworkTools.Railings.csv
For a railing, you can specify four custom parts. The post and the shoe parts
are placed along the input line with the defined start distance and spacing. The
toe board and one or more guard rail parts are placed between two posts. If
the toe board and/or the guard rail part is long enough compared to the post
spacing, they can span over three or more posts.

The position settings are given in the local coordinate system of the railing.
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Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Railing type name, which is shown in
the Railing name list.

You can specify multiple railings with
the same name when you have two
or more alternatives with different
lengths for the toe board and/or
guard rail.

When you have alternative lengths for
the toe board and/or guard rail, the
placing tool selects the part
automatically based on the post
spacing.
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MasterInput The location of the first input point

when placing the railing. The options
are:

• PanelTop: the first input is the
slab panel component, and the
railing is fitted on top of the
panels.

• SlabTop: the first input is the slab
or pour top face.

• SlabEdge: the first input is the
slab or pour top face, and the
railing location is the nearest
edge.

• WallSide: the first input is the
wall side face. The railing is fitted
on the wall side face.

Note that if the .csv file does not
contain any value, the default value
PanelTop is used.

MainOffset The common offset of all parts (post,
shoe, and so on). The offset is a
vector with components x, y, z given
in the local coordinate system of the
railing.

PostSpacing Default spacing of the posts if no
spacing is specified.

PostSpacing Height of the post.
ToeBoardOverlap Minimum overlap of toe boards.
ToeBoardOverlapOffset Offset (x, y, z) of the toe boards when

they are overlapping.
GuardOverlap Minimum overlap of guard rails.
GuardOverlapOffset Offset (x, y, z) of the guard rails when

they are overlapping.
GuardPositions The railing can include one or more

rows of guard rails. This setting
specifies the height (z) positions of
the guard rail parts measured from
the input line. Multiple values must
be separated by a space or a colon,
and enclosed in parentheses (450 650
850).
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PostName Name of the custom part that will be

inserted in the model.
PostAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

PostPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

PostPlaneOffset Offset on plane. The default value is
0.

PostRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PostRotationOffset Rotation offset in degrees. The
default value is 0.

PostDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PostDepthOffset Offset at depth. The default value is 0.
PostStartOffset PostStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PostEndOffset PostEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.
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ShoeName Name of the custom part that will be

inserted in the model.
ShoeAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

ShoePlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

ShoePlaneOffset Offset on plane. The default value is
0.

ShoeRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

ShoeRotationOffset Rotation offset in degrees. The
default value is 0.

ShoeDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

ShoeDepthOffset Offset at depth. The default value is 0.
ShoeStartOffset ShoeStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

ShoeEndOffset ShoeEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.
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ToeBoardName Name of the custom part that will be

inserted in the model.
ToeBoardAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

ToeBoardLength The effective length of the toe board
part.

ToeBoardInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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ToeBoardPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

ToeBoardPlaneOffset Offset on plane. The default value is
0.

ToeBoardRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

ToeBoardRotationOffset Rotation offset in degrees. The
default value is 0.

ToeBoardDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

ToeBoardDepthOffset Offset at depth. The default value is 0.
ToeBoardStartOffset ToeBoardStartOffset is the offset

of the actual start point from the
generic start point in the local
coordinate system. Give the offset as
x, y and z values that are separated
by a space or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.
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ToeBoardEndOffset ToeBoardEndOffset specifies the

location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

GuardRailName Name of the custom part that will be
inserted in the model.

GuardRailAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

GuardRailLength The effective length of the guard rail
part.

GuardRailInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

Note that the generic start and end
points are located in the local z
direction based on the setting.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
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point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

GuardRailPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

GuardRailPlaneOffset Offset on plane. The default value is
0.

GuardRailRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.
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GuardRailRotationOffset Rotation offset in degrees. The

default value is 0.
GuardRailDepthPosition Use Position at depth to insert the

custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

GuardRailDepthOffset Offset at depth. The default value is 0.
GuardRailStartOffset GuardRailStartOffset is the offset

of the actual start point from the
generic start point in the local
coordinate system. Give the offset as
x, y and z values that are separated
by a space or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

GuardRailEndOffset GuardRailEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

Openings
This section introduces components that can be used in concrete openings.

Click the links below to find out more:

• Hole Generation (32) (page 3152)

• Polygon Hole Generation (33) (page 3154)

Hole Generation (32)
Hole Generation (32) creates a hole in the object, or splits the object in two if
the hole cuts the whole object. Use this component, for example, in welded
profiles, slabs, or panels generated with a component.

Objects created

• Cuts
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Situation Description
A hole is created when a point is picked.

Selection order

1. Select the part or object created by a component to be cut.

2. Click the middle mouse button.

3. Pick the position relative to the hole being generated.

Parameters tab
Use the Parameters tab to control the hole properties.

Option Description
Define the hole dimensions and the
location of the picked point.

The selected Partcut option affects
which of these dimensions are
available.

To rotate the hole, define the rotation
angle.
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Define the recess depth.

Partcut Select the hole type.

The options are:

• Rectangular creates a rectangular
hole using width and height.

• Circular creates a round hole
using height as a diameter.

• Profile creates a cut using the
selected profile.

Profile If you selected Profile as the hole
type, select a suitable profile from the
Profile Catalog.

Coordination system Select the coordination system.

The options are:

• Use global xy-plane creates the
hole according to the global
coordinate system.

• Use local creates the hole
according to the work plane.

If the part is sloped or skewed, the
Use local option is used
automatically.

Cutpart name Define a name for the cut part.
Rotated Select whether the cut is rotated 90

degrees in the XY plane.

Polygon Hole Generation (33)
Polygon Hole Generation (33) creates a polygon-shaped hole in the object.
Use this component, for example, in welded profiles, slabs, or panels
generated with a component.

Objects created

• Cut
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Use for

Situation Description
A polygon-shaped hole in
concrete slabs, created by
picking five points.

Selection order

To create a polygon-shaped hole:

1. Select the part or object (component) to be cut.

TIP You can cut other components, such as Modeling of floor bay (66)
with this component.

2. Click the middle mouse button to end selecting.

3. Pick the corner points of the polygon-shaped hole.

4. Click the middle mouse button to end picking.

Parameters tab
Use the Parameters tab to control the cuts created.

Field Description
Cutting depth

Flooring
This section introduces components that can be used in concrete floors.

Click the links below to find out more:

• Automatic seam recognition (30) (page 3156)

• Seam Applicator (page 3157)

• Modeling of floor bay (66) (page 3159)

• Sloping slab drainage (page 3167)

• Hollow Core Opening Tool (page 3171)
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• Hollow Core Lifting Loops (page 3175)

• Floor layout (page 3178) (recommended for floor modeling)

• Floor Tool (page 3207)

Automatic seam recognition (30)
Automatic seam recognition (30) is used to add predefined custom seams
between parallel parts, such as slabs or wall elements. This tool is useful when
you add seams for warped floors.

Use for

Situation More information
Use to connect parts with predefined
custom seams.

Before you start

Create parallel parts, for example, concrete slabs or walls.

Create custom seam.

Selection order

1. Select the main part.

2. Select secondary parts. Click the middle mouse button to create the
seams between the parts.

Parameters tab
Use the Parameters tab to define seam properties.

Property Description
Seam name Enter the seam name, or use the

browse button (...) to locate the seam
in the Select component dialog box.
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Property Description
Seam property file Enter the name, or use the browse

button (...) to locate the name of the
seam attribute file (optional).

Seam direction Select to change the direction.
Seam input part order Select to reverse the main and

secondary part. You may need to
change the Seam up direction too.

Seam up direction Define the direction of the seam.
Re-calculate seam points for Use to re-calculate the seam points

for all parts or only for warped parts.

• All parts: use for fully or partially
warped decks or floors. This
option creates all seam points in
the same way, no matter, if the
slab is warped or not.

• Warped parts: use for wall panels
and other situations, where
warping is not used, or the All
parts option does not give desired
result.

Position of re-calculated points Control the location of the re-
calculated seam points. The options
in the list box are same as the circles
in the following image.

Seam Applicator
Seam Applicator creates a seam between two double tee slabs, or between a
double tee slab and a wall or a spandrel. The double tees can also be warped
and/or cambered. To be able to use Seam Applicator you need to have a
custom seam. The custom seam can be created in the model, or it can be
imported to the model.

Objects created

• Seams
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Use for

Situation Description
Two double tee slabs with seams

Double tee slab and wall with seams

Before you start

Create a custom seam.

NOTE When you define the custom seam in Custom Component Wizard,
make sure that you select the Allow multiple instances of
connection between same parts checkbox on the Advanced tab.

Selection order

1. Select the main part.

2. Select the secondary part.

The seam is created automatically when the secondary part is selected.

One of the selected parts must be a double tee slab and the other part
can be a double tee slab, a wall, or a spandrel.

NOTE If the seam cannot be created between the selected parts for
some reason, a dummy beam is created instead. The beam
indicates that the seam creation did not succeed.
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Parameters tab
Use the Parameters tab to control the properties of the seam.

Option Description
Seam name Define the custom seam that connects the

parts by selecting it from the Applications
& components catalog.

Seam property file Select the attribute file for the custom
seam.

Seam direction Seam direction in relation to the main and
the secondary part.

Seam up direction Seam rotation.
Offset start point Seam start point offset from the edge of

the double tee slab start point.
Offset end point Seam end point offset from the edge of the

double tee slab end point.
Number of copies Number of seams.
Distance to first seam Distance between the double tee slab edge

and the first seam start point.
Spacing values Space between the seams.
Copy at equal distances
(Ignore spacing values)

Define whether seams are created at equal
distances.

If you select Yes, the values in Spacing
values field are ignored.

Modeling of floor bay (66)
Modeling of floor bay creates an area of concrete slabs between two support
lines that you define, for example, between two main frames. Support lines
can be polylines or sloped.

Parts created

Concrete slabs.
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Where to use

Situation More information
Slab area created
between two support
lines.

Before you start

Create two support lines with two or more points.

Picking order

1. Pick points to define the first support line. To finish, middle-click away
from the last point picked.

2. Pick points to define the second support line. To finish, middle-click away
from the last point picked.

3. Pick a point to indicate the origin of the slabs.

4. Pick a point to indicate the direction of the slabs.

Parameters tab
Use the Parameters tab to define the position of the slab.

Property Description
The position of the slab relative to the
origin line picked when creating the
slab.

The options are center of profile
(default) or center of seam.
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Property Description
Select the slab spacing and enter the
appropriate dimension. The options
are seam (default) or center to center.

If you select the seam option, the
bottom dimension is enabled. If you
select the center-to-center otion, the
upper dimension is enabled.
Slab offsets from support lines 1 and 2.

Vertical position of the slab.

The options are Top (default), Center
or Bottom.

Enter an optional offset value.

Projection type Defines how the slabs are spaced on a
sloping floor bay.

Projection type

Use the Projection type field to define how to handle slab spacing or seams
on a sloping floor bay. The options are Global (default), Support line 1,
Support line 2, or Both support lines.

• Global: the centers of the slabs remain constant, seam spacing adjusts.
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• Support line 1: Seam spacing on support line 1 does not adjust (effect
exaggerated here):

• Support line 2: Seam spacing on support line 2 does not adjust (effect
exaggerated here):

• Both support lines: Seam spacing is calculated at the average plane
position between both support lines

Along this line, center to center and seam width are
exactly as entered in the dialog box.

Support line 2

Plane between support lines 1 and 2

Support line 1
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Profiles tab
Use the Profiles tab to define the properties of the slab profiles.

Index list

Use the Index list to specify different profiles, seam width, and various cutting
options for specific slabs or seams.

Input the values individually, or in a list:

Examples for slabs

If the origin point is the center of slab:

If the origin point is the center of seam:

Examples for seams

If the origin point is the center of slab:

If the origin point is the center of seam:
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Adjustment type

Use the Adjustment type to define the type of adjustment for the selected
slab. The options are:

• Default - Use the default slab profile.

• Profile - Use the specific slab profile.

• Cut left side - Cut the left side of the profile. If no profile is defined, uses
the default slab profile.

• Cut right side - Cut the right side of the profile. If no profile is defined,
uses the default slab profile.

• Cut both sides - Cut both sides of the profile. If no profile is defined, uses
the default slab profile.

• Seam width - Adjust the seam width.

Profile/Seam Width

Depending on which adjustment type option you choose, defines:

• The width of the default slab profile.

• The width of the specified profile.

• Seam width.

Examples
These examples show how to use the Modeling of floor bay (66) component.

Example 1:

1. Pick 2 points (1, 2) to define support line 1.

Concrete components reference 3164 Concrete Detailing



2. To finish, middle-click.

3. Pick 2 points to define support line 2.

4. To finish, middle-click.

5. Pick a point to indicate the origin of the slab.

6. Pick a point to indicate the direction of the slab.

Tekla Structures creates the floor bay.
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Example 2:

1. Pick 2 points to define support line 1.

2. To finish, middle-click.

3. Pick 4 points to define support line 2.

4. To finish, middle-click.

5. Pick a point to indicate the origin of the slab.
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6. Pick a point to indicate the direction of the slab.

Tekla Structures creates the floor bay.

Sloping slab drainage
Sloping slab drainage creates a concrete slab topping and a drainage hole.

Objects created

• Drainage hole
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Use for

Situation Description
Drainage holes with valley 1 and hip 2
created.

Limitations

Slab topping does not adapt to slab chamfers. You need to define the slab
chamfers and topping chamfers separately.

Before you start

Create or split the slabs so that there is one drainage point in each slab.

Selection order

1. Select the main part (slab).

2. Pick a point to create the drainage hole.

The drainage hole is created automatically when the point is picked.
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Part identification key

 Part
1 Drainage hole

Parameters tab
Use the Parameters tab to control the type, dimensions and properties of the
drainage hole.

Drainage hole type

Option Description
A drainage hole is not created.

A rectangular drainage hole is
created.

A round drainage hole is created.
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Drainage hole dimensions

Option Description
Define the side dimensions of the
rectangular drainage hole.

Define the diameter of the round
drainage hole.

Drainage hole properties

Option Description
Define slab inclination by Select how the slab is inclined, by a

combination of slope (S) or slope
percentage (S%), and topping
thicknesses (d1, d2).

The Slope, d1, and d2 options are
available accordingly.

Slope Slope of the topping, for example,
0.01 (S) or 2 (S%).

d1 Thickness of the topping at the
drainage point or at the hole.

d2 Thickness of the topping at the edge
of the slab or at the hip.

Create cast unit Select how the cast unit is created:

• Yes

Topping is part of the slab cast
unit.

• No

Each part of the topping forms a
cast unit.
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Option Description
• Topping

Topping is a separate cast unit.
Material Define the material of the topping by

selecting it from the material catalog.
Type Select whether a valley or a hip is

created. If you select Hip, you can
only pick slab corners.

Hollow Core Opening Tool
Hollow Core Opening Tool creates holes and recesses to hollow core slabs.
Hollow Core Opening Tool works with single hollow core slabs, or with floors
that are created with the Modeling of floor bay (66) modeling tool.

Objects created

• Holes and recesses

Use for

Situation Description
Hollow core slab with small and large
openings

Limitations

Hollow Core Opening Tool calculates the location for the openings based on
the given values and the slab profile data. If needed, you can use an external
configuration file in XML format to provide different rules for the openings and
the slab profile data.

You can define small and large openings. Small openings are placed in the
middle of the hollow cores so that no webs are broken. Large openings break
webs.

Before you start

Create a hollow core slab.
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Selection order

1. Select the main part (slab).

2. Pick a position for the opening.

Hollow Core Opening Tool properties
Use the Hollow Core Opening Tool properties to control the properties of
the openings and recesses.

Option Description
Select the shape of the openings and recesses.

• Square - in the middle of the slab

• Round - in the middle of the slab

• At one end of the slab

• At both ends of the slab

Hollow positions If you select to add openings or recesses at
one end or at both ends of a slab, enter the
positions of the hollows that are cut.

The positions are numbered from left to right
at the start of the part. The part is viewed from
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Option Description
the top in the start-to-end direction. The
openings and recesses are created in the
same voids at the end of the part.

Size Define the size of the opening in longitudinal
and cross direction, or the diameter for a
round opening.

Opening width defines whether the opening is
small or large.

Opening Type Select the type of the opening.
Place exactly by point Select whether the opening is created exactly

to the picked position.
Centralize in zone Select how the center of an opening is

centered

• By hollow:

The opening is centered to the hollow core.

• By web:

The opening is centered to the web.
Cut full width of hollow Select whether the opening is cut based on the

minimum width of hollows or the number of
hollows.

To use this option, center the opening By
hollow in the Centralize in zone option.

Rules file (XML) Select the external XML file where you have
defined the opening and slab profiles.

Cutpart name Define a name for the cut part.
Define the recess depth.
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Option Description
Define the alignment for the opening.

Select whether the thick side part of the
opening is removed.

Configuration file example
Use an external .xml file to define the openings and the slab profiles.

Example

An example Zones.xml file is located in ..\ProgramData\Trimble\Tekla
Structures\<version>\environments\common\system.
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Hollow Core Lifting Loops
Hollow Core Lifting Loops creates lifters for hollow core slabs. Hollow Core
Lifting Loops works with single hollow core slabs, or with floors that are
created with Modeling of floor bay (66) modeling tool.

Objects created

• Lifters

Use for

Situation Description
Hollow core slab with recesses,
hollow core fillings and lifting devices.

Limitations

You also need a lifting device. The lifting device can be created as a custom
part, or it can be imported to the model. Alternatively, you can use an external
configuration file in XML format to define the properties for the recess, the
lifting device and the slab.
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Before you start

Create a hollow core slab and a lifting device.

Selection order

1. Select the main part (slab).

The recess and hollow core fillings are created.

Basic settings tab
Use the Basic settings tab to control the properties of the lifters and hollow
core fillings.

Configuration file

Option Description
Configuration file Select the external XML file where you have defined the

recess, the lifting device, channel and grouting profiles,
and the slab profile properties.

Override Define whether the values on the Basic settings and
Lifting device settings tabs override the properties
defined in the external XML file.

Dimensions

Option Description
1 Define the minimum distance from the lifter insertion point to the

end of the slab.
2 Define the maximum distance from the lifter insertion point to the

end of the slab.
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Option Description
3 Define the minimum distance from the lifter insertion point to the

edge of an opening.
4 Define the minimum distance between two lifter insertion points.
5 Define the length of the hollow core filling.
6 Define the profile of the recess.
7 Define the depth of the recess.

Channel numbers

Select the channel numbers:

Option Description
At the first channel

Default

At the second channel

At all channels

Hollow core filling

Option Description
Use automatic fill
profile

Define whether the automatic hollow core filling
profile is used.

Profile Define the hollow core filling profile.
Prefix Prefix for the part position number.
Start Number Start number for the part position number.
Name Define a name for the lifter.

Tekla Structures uses the name in drawings and
reports.

Class Use Class to group the lifters.

For example, you can display lifters of different classes
in different colors.
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Lifting device settings tab
Use the Lifting device settings tab to control the properties of the lifting
device.

Move individual lifters in the x and y direction with direct modification.

Change the lifter type from the contextual toolbar.

Properties

Option Description
Lifter component Define the custom part that represents the actual

lifting device.
Saved properties
to use

Select which saved properties to use for the lifting
device custom part.

Lifter max load Define the maximum load for the lifting device.
Rotation Select the rotation of the lifting device custom part

around its axis.
Angle Define the rotation angle of the lifting device custom

part.
Up Direction Select the lifting device up direction in relation to the

local coordinate system.
Offset Define the offset of the lifting device in relation to the

local coordinate system in the corresponding
directions.

Configuration file example
Use an external XML file to define the lifting device, the lifter, and the slab
properties.

Example
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Floor layout
Floor Layout creates floors built of precast filigree, double-tee, and hollow
core and solid slabs. The floors may contain several layers, such as precast
slabs, insulation and a cast-in-place topping. Floor Layout is most useful for
non-rectangular floors that contain one or more openings that split slabs into
many pieces, and when slab widths are not constant on the whole floor area.
You can modify the floors using direct modification.

Objects created

• Slabs

• Insulation

• Cast-in-place topping

Use for

Situation Description
Create floor structures that have
layers, for example, hollow core slabs
at the bottom, insulation as the
middle layer, and cast-in-place
topping.

Selection order

1. On the Concrete tab, click Slab --> Floor layout .

2. Pick the corner points of the floor.

You can pick the points at grid lines or the reference points of supporting
parts. You can change the offsets later.

The default slab direction is from the first (P1) point to the second (P2)
point. You can change this later if needed.
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3. Click the middle mouse button to create the floor.

Layer tab
Use the Layer tab to control the layer type, profile, and how the layer is
created.
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Layer list

Layers Description
The layer list shows the current layers of the floor. The
first layer in the list is the top layer and the last layer is
the bottom layer. In the example image on the left, the 
FILIGREE layer is the top layer and the CIP layer is the
bottom layer.

Use the buttons to do the following:

•

Click  to add a new layer.

•

Click  to remove the selected layer.

•

Click  to change the order of the layers by
moving the selected layer up or down in the list.

Layer properties

Select a layer in the layer list to define the layer properties.

Option Description
Layer name Enter a name for the layer. This is the layer name shown

in the layer list. The name is also shown in the direct

modification toolbar when you are modifying offsets .

This name is not visible in the model so you can enter
any suitable name.

Layer type Select the layer type. The Precast layer is the primary
layer and any insulation parts are added to precast units.
The parts created for a Cast in place layer are not added
to any other cast unit.

Create layer as Select how the layer parts are created: as beam parts,
custom parts, or a single part.

Layer
component

Component
attributes

When the layer parts are created as custom parts, you
can select a component and the component attributes.

Layer thickness
or profile

When the layer parts are created as beam parts or as a
single part, you can select the profile or thickness of the
layer parts.

With parametric profiles, you can replace the width of the
profile with the text [W]. When you do this, the beam is
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Option Description
never cut but the desired width is achieved by setting the
profile name based on the slab width.

For example, the profile could be BL80*[W].
Rotation Select the rotation of the layer parts.
Part name

Class

Material

Pour phase

Part prefix, Start
no

Cast unit prefix,
Start no

Define the name, class, material, part prefix and start
number of the layer parts. Define the pour phase for CIP
layers.

General tab
Use the General tab to control the default part and gap width, depth position
of the layers, and the direction for lining up the slabs.

Select to create slabs and parts by width or number of them from the Default
part width dropdown list. The options are:

Option Description
Default part width Enter the default width for the slabs

in the primary layer.

If you define the width of an
individual slab in the slab part
properties, the Default part width
value is not used.

Max part width Enter the maximum part width.
Number of parts Enter the number of parts to be

created.

Option Description
Default gap width Enter the default seam gap width in the primary layer.

If you define the width of an individual gap, the Default
gap width value is not used.

Same gap for all Set the gap width at first and last edges.

Same gap for allcreates gaps that are half of the default
gap width.

No gap at first and last does not create gaps.
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Option Description
Depth position Select how the layers are positioned in relation to the

plane of input points.

Line up direction Select the direction for the slabs. By default, the width of
the last slab may differ from the width of the other
slabs.

Advanced tab
Use the Advanced tab to control the minimum angles, and the width and
length of the slabs.

Option Description
Minimum end
angle

Minimum start
angle

Controls how the slab ends are modeled.

When the angle of the floor edge is smaller than the
minimum angle, you can select a suitable option from
the list to make the slab end straight.
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Option Description

Minimum slab width. Slabs narrower than the minimum
width are not created.

Minimum slab length. Slabs shorter than the minimum
length are not created.

Maximum slab length. Slabs longer than the maximum
length are not created.

Minimum required width of a single neck on either side
of the slab when there is a large opening in the slab.

If either of the necks on the sides of the opening is
smaller than the defined neck width, the neck is cut off
completely. In addition, the total width of the necks must
be bigger than the minimum slab middle zone neck
width, otherwise the slab is split into two separate slabs
(the width of the actual opening is the same as the width
of the slab).
Minimum end nose width and length.

If there are noses on both sides of the slab, these two
end noses are checked separately and cut off if the width
of the single nose gets smaller than the given minimum
required nose width.

Concrete components reference 3184 Concrete Detailing



Option Description
Align openings by
allowed widths

Select Yes to re-align the opening/cut longitudinal edges
to match the allowed width zones.

The default value is No.
Create cut-outs Select to create cut-outs for notches or openings.

Selecting to create cut-outs does not affect whether the
slab is split.

Classes or names
of parts to cut
out

Creates automatic cut-outs for parts going through the
floor layout.

Enter the names or classes for parts that need cut-outs.

Customize allowed slab width and length
You can customize the allowed slab width and length in the
FloorLayout.ini file. This file can be located under the model folder, or in
any of the folders defined in the XS_FIRM, XS_PROJECT or XS_SYSTEM
advanced options.

If the file contains any values for a profile, these values are used and they
override the minimum and maximum values entered in the Floor layout
dialog box. In the Floor layout dialog box, you can define the slab width on
the General tab and the slab length on the Advanced tab.

An example of the definitions in the FloorLayout.ini file:

// 
// Slab not listed below can have any width. Slab listed below can only 
have width inside the given range. 
// User input values will be rounded down to the nearest allowed value.
//
//                            Zone 1        Zone 2        Zone 3        
Zone 4        Zone 5    
// Slab widths    Profile        min. max.    min. max.   min. max.    
min. max.    min. max.
SLAB_WIDTH     P15(150X1200)   345-435     485-575     625-715        
765-855        905-995     1045-1135
SLAB_WIDTH     P18(175X1200)   392-492     549-649        706-806        
863-963        1020-1120
SLAB_WIDTH     P20(200X1200)   270-370     450-560     640-750        
830-930        1020-1120
SLAB_WIDTH     P27(265X1200)   320-440     540-660     760-880        
980-1110
SLAB_WIDTH     P32(320X1200)   380-560     660-830        930-1110
SLAB_WIDTH     P32R(320X1200)  380-560     660-830        930-1110
SLAB_WIDTH     P37(370X1200)   320-440     540-660        760-880        
980-1120
SLAB_WIDTH     P40(400X1200)   400-530     670-800        950-1080
SLAB_WIDTH     P50(500X1200)   390-530     670-810        950-1080

/
// Min/max lengths by slab profile & width min/max
//
//         Profile     Width min/max     Length min/max
SLAB_LENGTH     P15(150X1200)     0-1200         1000-8000
SLAB_LENGTH     P18(188X1200)     0-1200         1000-9000
SLAB_LENGTH     P27(270X1200)     0-1200         1000-12000
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SLAB_LENGTH     P32(320X1200)     0-830         1000-13000
SLAB_LENGTH     P32(320X1200)     830-1200     1000-14000
SLAB_LENGTH     P32R(320X1200)     0-1200         1000-14500
SLAB_LENGTH     P37(370X1200)     0-660        1000-14000
SLAB_LENGTH     P37(370X1200)     660-1200     1000-15000
SLAB_LENGTH     P40(400X1200)     0-800         1000-16000
SLAB_LENGTH     P40(400X1200)     800-1200    1000-17000
SLAB_LENGTH     P50(500X1200)     0-810         1000-19000
SLAB_LENGTH     P50(500X1200)     810-1200    1000-20000

Default offsets
Use the Default offsets tab to set the default offsets for each layer. These
default offsets will be used whenever a specific value is not given for the edge.

 Description
1 Default offset for the side offset.

Offset that is parallel to the bearing direction.
2 Default offset for the end offset.

All other offsets that are not side offsets.
3 Default offset for the break line.

The default value is 10. If the break line value is 0, the objects are
not split.

A

B

Define offsets for the automatically created cut-outs.

You can define separate offsets for every layer.

Concrete components reference 3186 Concrete Detailing



Detailing tab
Use the Detailing tab to select the components that are applied to all slabs in
the floor.

Option Description
Component
name

Select a component that is applied to the slabs in the
floor.

Component attr
file name

Select the settings that are used with the component you
have selected.

The list contains all the files that are available for the
selected component.

Adding a component to the component name list

The component name list is empty by default. You can add components to the
list:

1. Select Add new from the list.

The Detailing component data dialog box is displayed.

2. Enter a suitable name in the Name in dropdown box.

3. Click  to open the Applications & components catalog.

4. Select a component and click OK.

The component name or number is added to the Component name box.

5. Click OK.
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When you have added the needed components, the names of the components
are shown in the component name list as shown in the example image below.
Select a component from the list:

The list is stored in the \attributes folder under the model folder.

If you want to predefine the list to contain your favorite components in any
new models, you can copy the LayoutConfiguration.datx file from the
\attributes folder under the model folder to any of the folders defined in
the XS_FIRM, XS_PROJECT or XS_SYSTEM.

CIP filler part tab
Use the CIP filler part tab to create CIP filler parts into the empty areas in
floors created with Floor layout. The empty areas are spaces created by
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offsets around the exterior and interior boundaries. There may also be empty
areas when the slab is too narrow to be created with Floor layout.

CIP filler parts can also be created when:

• The allowed slab width is smaller than the needed width.

• The opening is larger than needed because of allowed width zones.

• The slab is split into two because of a large opening.

• The slab nose is not created because it is too narrow.

CIP filler part properties

Option Description
Create filler parts Select whether CIP filler parts are

created.
Minimum width Minimum width of the part.

If the empty space is smaller than this
width, the part is not created in this
location.

Cast unit prefix

Start no

Cast unit prefix of the CIP filler part

Cast unit start number of the CIP filler
part
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Option Description
Name

Class

Material

Finish

Pour phase

Define the name, class, material,
finish and pour phase of the CIP filler
parts.

Fill seam gaps Select whether seam gaps are filled.

User defined tab
Use the User defined tab to set the user-defined attribute values for the slabs.

If you have defined the user-defined attributes in the part properties dialog
box and want to use those values, leave the User defined tab empty.

The content of the tab may vary depending on your environment, see below
how to customize the content.

Customizing the User defined tab

You can customize the content of the User defined tab using the
floorlayout.objects.inp file. Note that you cannot create new user-
defined attributes with the file. The user-defined attributes on the tab are
existing user-defined attributes that have been defined in the objects.inp
file. The floorlayout.objects.inp file has the same format as the
objects.inp file.

The floorlayout.objects.inp file can be located in any of the folders set
in the XS_FIRM, XS_PROJECT or XS_SYSTEM advanced options, or in the
model folder.

Below is an example of the floorlayout.objects.inp file:
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Modifying a floor
You can use direct modification to modify the floor. Before you start, ensure

that the Direct modification  switch is active. Select the floor to display
the direct modification toolbar.

To modify the floor, select the appropriate command from the toolbar.

Button Description
Add a polygonal opening.

Add a rectangular opening.

Add a break line to split the slab into two slabs.
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Button Description
Modify the openings or exterior boundary of the floor. This
command is active by default.

Make the floor warped by offsetting one or more vertices of the
exterior boundary polygon from the plane.
Modify the offsets at floor boundaries.

Modify the layout of the floor:

• Modify the width or profile of any of the slabs in the floor.

• Modify the side of the cut when the slab is cut to a smaller
width.

• Modify the gaps between the slabs.

• Modify the direction of the slabs.

• Modify the order of slabs when the slabs do not the have the
same width or profiles.

Add or modify the detailing components that are only applied to
certain slabs in the floor layout. The detailing components are listed
on the Detailing tab.

You can apply the same detailing component settings to all slabs in
the floor layout using the floor layout attributes.
Click the refresh command to rerun the component. For example, if
you have new parts that should cut holes around them, the refresh
command ensures that the cuts are shown correctly.

Known limitations

Floor layout is not designed to work with floors where the layout is not in one
plane. Egdes can be offset from the plane only to warp the floor, not to make
floors that have several planes.

The image below shows an example where Floor layout has been used to
create several planes. If precast slabs are used in this way, the outcome is not
correct. Use multiple Floor layout components to create precast floors with
several planes.
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Adding a polygonal opening

1. Click .

2. Pick the corner points of the opening.

You can pick the points at grid lines or you can pick the reference points
of supporting parts. You can change the offsets later.

Adding a rectangular opening

1. Click .

2. Pick the corner points of the opening.

You can pick the points at grid lines or you can pick the reference points
of supporting parts. You can change the offsets later.
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Adding a break line to split the slab into two slabs

1. Click .
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2. Pick the end points of the break line.

Modifying the openings and exterior boundary of the floor

1. The  button is active by default.

The handles are shown for the exterior boundary and for all openings in
the floor.
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2. Do any of the following:

• To move an edge, drag any of the edge lines. Hold down the left
mouse button when dragging.

• To move a corner point, drag the handle in the corner.
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• To add new points to the edge, drag the handle in the middle of the
edge.

• To delete any of the points, select the handle in the corner and press
the Delete key.

• To make the floor warped, offset the vertices of the exterior boundary
so that all vertices are not in the same plane.

Drag a handle normally to move the vertices in the original floor plane.

Hold down the Alt key while dragging to move the vertex
perpendicular to the floor plane.
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Hold down the Alt and Shift keys to move the vertex both in the plane
and off from the plane by snapping to any point in the model.

Modifying the offset at floor boundaries

1. Click .

The handles for modifying the offset are shown. If there are offsets, the
offset dimensions are also shown.
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2. To adjust the offset, do one of the following:

• Drag the edge offset lines.

• Select one or more offset lines by holding down the Shift key.

When you have the offset lines selected, right-click on any of the
selected lines. Enter the offset value to the toolbar that is displayed

and click .

Note that when you use the offset command, the direct modification toolbar
shows the floor layout layers. Each layer may have different offsets. You can
select which layers to modify. The simplest way is to select all layers and have
the offsets equal in each layer.
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Modifying the layout of the floor

1. Click .

The following direct modification elements are shown:

2. To modify the layout of the floor, do any of the following:

• To modify slab width, do one of the following:

• To move all seams, select one seam and start dragging.

• To add a new seam, select a seam, hold down the Ctrl key and start
dragging. When you stop dragging and release the mouse key, a
new seam is added to that location.

• To make one slab smaller, select a seam, hold down the Alt key and
start dragging. The slab on the left or right side is made smaller and
all slabs on the other side will move with the seam.

• To modify the profile, width, and cut side of a slab, right-click the slab
handle.
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When the profile of the slab is fixed (not parametric), the slab is cut on
either side when the width is smaller than the original width. The
Default cut side is leading edge for the first slab and trailing edge for
all others in relation to the layout direction.

You can modify the properties of multiple slabs at the same time by
holding down the Shift key when selecting slabs.

• To modify the gap width between the slabs, do one of the following:

• Drag the end of the gap dimension.

• Right-click a seam line handle, enter the width and click .

You can modify multiple gaps at same time by holding down the
Shift key when selecting seam line handles.

Concrete components reference 3202 Concrete Detailing



• To move a slab or change the order of slabs, drag the slab handles.

• To change the direction of slabs, drag the slab direction handle.
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• To remove a slab from the layout, select the slab handles and press
the Delete key.

Add and modify property strips
You can use property strips to control the properties and detailing
components of indivual slabs in the floor layout.

Property strips

You can define property strips that have certain properties and detailing
components, and use the property strips according to your needs in the floor
layout. For example, you can change the profile and class of the individual
hollow core slabs. Note that property strips only affect the main layer parts.

Property strips are added as lines in the floor layout plane. Property strips
affect the parts that they are touching. You can also set property strips so that
they affect through the slab line.

The image below shows an example of a property strip. The two slabs in the
floor layout have a different class and profile because of the property strip.

Concrete components reference 3204 Concrete Detailing



To create a property strip in the floor layout:

1. On the contextual toolbar of Floor layout, click  to open a dialog box
for defining the property strip.

2. On the Properties tab, define the individual slab properties.

Option Description
Effect in layout Select how the parts in the floor

layout are affected:

• Hit slabs only: The property strip
only affects the parts it is
touching.

• All slabs in line: All slab parts in
the line are affected if one slab
line is split to two or more
individual parts.

Layer thickness or profile Change the thickness or profile of the
layer.

Depth position If the profile height is different, you
can adjust the alignment according
to:

• Bottom face aligned with other
slabs.

• Top face aligned with other slabs.
Part name

Class

Material

Pour phase

Part prefix

Define the name, class, material, part
prefix and start number of the layer
parts. Define the pour phase for CIP
layers.
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Option Description
Cast unit prefix

Start no

3. On the Detailing tab, select the detailing component that you want to
use.

Option Description
Component name Select the detailing component from

the list.

The list of detailing components
shows the components that you have
added on the Detailing tab in the
Floor layout dialog box.

The content of the list may vary
depending on your environment.

You can also add new components to
the list by selecting the Add new
option. Note that you can only add
detailing components that use one
input part.

Component attr file name Select the detailing component
attributes that are used for the slab.

Note that the content of the list varies
depending on the component that
you have selected.

4. On the User defined tab, set the user-defined attribute values for the
slabs.

If you have defined the user-defined attributes in the part properties
dialog box and want to use those values, leave the User defined tab
empty.

5. Pick the start and end points for the property strip in the floor layout.

Modify the property strip

You can also use saved attribute settings from the contextual toolbar.
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Use the  and  buttons on the toolbar as follows:

  
Modify the detailing component
and/or attribute file of the property
strip.

Select the property strip and select
the component name and/or
attribute file from the list. Click the
button to modify the selected
property strips.

You can select multiple strips by
holding down the Shift key.
Delete a property strip. Select the
strip that you want to delete.

You can select multiple strips by
holding down the Shift key.

You can also add new property strips by dragging an existing strip and holding
down the Ctrl key.

Floor Tool
Floor Tool creates a floor bay with optional insulation.

Objects created

• Hollow core slabs

Concrete components reference 3207 Concrete Detailing



Use for

Situation Description
Floor bay with insulation

Selection order

Make sure that you have defined the slab properties.

1. Pick the contour points of the floor bay.

The floor bay is automatically created when you close the polygon.

NOTE The list of picked contour points on the Bay contour tab and the list
of slabs on the Slab list tab are created when the slabs are created.

Slab properties tab
Use the Slab properties tab to control the profile, material and location of the
hollow core slabs.

Slab attributes

Option Description
Profile Define the profile by selecting it from the profile

catalog.
Name Define a name for the slab.
Material Define the material grade by selecting it from the

material catalog.
Class Define the part class number.
Prefix Define the part prefix.
Start number Define the start number for the cast unit.
Cut slab ends Define whether the slab ends are cut or not.

If you select Yes, define the minimum end angle
for the slabs.

Rotation Select an option to rotate the slab.
Vertical location Define the offset location in the vertical direction.
Offset Define the offset in the vertical direction.
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Option Description
Minimum end angle Define the minimum end angle for the slabs.

If the line to which the slab ends has a bigger
angle than the defined minimum end angle, the
part will be aligned to the line.

Additional attributes

Option Description
Exposure Class Define the exposure class for the hollow core

slab.

The exposure class will be saved as a user-
defined attribute.

Relative strength Define the relative strength of the hollow core
slab.

The relative strength will be saved as a user-
defined attribute.

Fire rating Define the fire rating for the hollow core slab.

The fire rating will be saved as a user-defined
attribute.

User-defined attributes User-defined attributes are located in the
FloorTool.ini file.

Slab direction

Option Description
Slab direction Define the direction of the slab.

If you select Angle, you need to pick points in
the model to define the new direction. The
angle you have picked is shown in the Angle
field. You can also define the angle directly in
the field to rotate the slabs.

Note that picking two points does not change
the local +X direction.
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Insulation tab
Use the Insulation tab to control the insulation properties of the hollow core
slabs.

First define whether to create insulation or not. Insulation is created
separately for each slab.

Insulation

Option Description
Name Define a name for the insulation.
Material Define a material grade by selecting it from

the material catalog.
Thickness Define the thickness of the insulation.
Class Define the part class number.
Offset at slab start/end Define the offset between the slab start/end

positions and the corresponding positions
in the insulation parts.

Left/Right offset Define the offset between the slab and the
insulation for the rightmost and leftmost
slab.

Bay contour tab
Use the Bay contour tab to control the coordinates of the picked contour
points and the horizontal offset of the lines connecting the contour points. If
the coordinates are not visible on the tab, click the Get button.

You need to create the hollow core slabs before using the Bay contour tab.

Bay contour properties

Option Description
XY-constant Z Define the Z coordinate for all contour points at

the same specific height.
XYZ (sloping floor) Define the Z constant for each contour point

separately. The floor may be sloped.
Offset method Define the offset method.
Default end offset Define the default end offset.
Default side offset Define the default side offset.
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Bay contour table

The table lists the contour points showing their X, Y, and Z coordinates. You
can modify the Z coordinate in the table only if you have selected XYZ (sloping
floor). You can modify the Horizontal offset on all rows of the table.

The table also shows the lines connecting the points. You can only modify the
Horizontal offset. Entering a positive value enlarges the slab area and
entering a negative value shrinks the slab area.

Slab list tab
Use the Slab list tab to list all the hollow core slabs created. If the slab list is
not visible on the tab, click the Get button.

Slab properties

Option Description
Slab number Shows the order of the hollow core slabs

starting from the first picked point.
Width Shows the width of a narrowed slab.
Narrowed from Define whether the slab is narrowed. The

options are:

• not narrowed (default)

• Right side

• Left side
Type Define the slab type.

• Use Slab for normal hollow core slabs.

• Use PIP for a precast infill piece.

• Use GAP for an empty space between the
slabs. You do not need to define a profile
when you select this option.

• Use CIP to create a concrete part using the
width defined in the Width column. The
width range that you can use is defined in the
FloorTool.ini file.

The slabs listed in the FloorTool.ini file
can only have a width that is inside the
defined range. The slabs that are not listed
can have any width. The value you give is
rounded down to the nearest allowed value.
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Option Description
Profile Define the profile by selecting it from the profile

catalog.

You can Add and Delete slabs, and move them Up and Down in the list by
using the buttons on the left. To restore the default values, click Restore
defaults.

Concrete stairs
Tekla Structures includes the following tools you can use to create concrete
stairs and stairwells:

• Concrete stairs (65) (page 3212)

• Stairwells and elevator shafts (90) (page 3227)

• Reinforced concrete stair (95) (page 3230)

Concrete stairs (65)
Concrete stairs (65) creates precast stairs with optional landings, ridges,
stringers, and anti-skid and kick plate profiles. It contains five different step
shapes and options to create round or chamfered step edges.

Objects created

• Stairs

• Landings

• Ridges

• Stringers

• Anti-skid

• Kick plate
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Use for

Situation Description
Staircase with

• square step shape

• stringers on both sides

• top and bottom landings

Staircase with

• chamfered step corners

• ridges on both sides

Staircase with

• rounded step corners

• anti-skid profile

• bottom landing

Staircase with

• square step shape

• rounded step corners

• ridges on both sides

• anti-skid and kick plate profiles
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Selection order

Selection order depends on the selected Creation method option on the
Stairs tab.

When Creation method is set to Default:

1. Pick the first point to indicate the start point of stairs.

2. Pick the second point to indicate the direction of stairs.

The stairs are created automatically.

Part identification key

 Part
1 Landings
2 Stringers
3 Ridges
4 Kick plates
5 Steps
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 Part
6 Anti-skids

Stairs tab
Use the Stairs tab to define how the stairs are created and what are the
dimensions of the stairs.

Creation method

Option Description
Creation method Select the creation method of the

stairs. Creation method defines how
many and which points you need to
pick when you create the stairs.

• Default

Number of steps is calculated
automatically using the vertical
distance between the two input
points.

• One point - N & L & H: define N, L,
and H (number, length, and height
of the steps).

• Two points - N & L: define N and
L.

Height of the steps is calculated
automatically using the vertical
distance between the two input
points.

• Two points - N & H: define N and
H.

Length of the steps is calculated
automatically using the horizontal
distance between the two input
points.

• Two points - L & H: define L and
H.

Number of steps is calculated
automatically using the vertical
distance between the two input
points.

• Two points - N: define N.

Height and length of steps is
calculated automatically using the
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Option Description
horizontal and vertical distance
between the two input points. You
can define the length of the top
step.

No of steps, N Define the number of steps, if the
Two points - L & H option is not
selected.

Position Define the horizontal position of the
staircase, relative to the line joining
the picked points.

Distance Enter a distance to move the stairs in
the horizontal direction from the line
joining the picked points. The selected
Position option has an effect on this
dimension.

Rotation Define the angle between the line
joining the steps and the line joining
the selected points.

Cast unit type Select the cast unit type:

• Precast

• Cast in place
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Stair dimensions

 Description
1

2

Height of the step.
Length of the step.

3

4

Length of the top step.
Height of the top step.

5 Width of the top corbel.
6 Slope from the corbel to the underside of the stairs.
7 Thickness of the slab.
8 Chamfering for the underside of stairs.
9

10

Chamfer or radius values.

11 Height of the bottom step.
12 Height of the stair foot.
13 Chamfering for the bottom of stairs.
14 Slope from the foot nose to the foot base.
15 Length of the bottom cut.
16 Length of the stair foot.
17 Width of the staircase, including stringers.

Create foot

Define whether a foot is created at the bottom of the stairs.
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Step shapes tab
Use the Step shapes tab to define the shape of steps.

All other steps/Last step at foot

Select the step shape. You can define the shape of the last step at the bottom
if you set Last step same as other step to No.

Option Description
Default

Beveled

From the list below the step shape
options, select whether you want to
enter a dimension or an angle.

AutoDefaults can change this option.

Straight step

Top straight, bottom beveled

Enter two dimensions.

Top beveled, bottom straight

Enter the vertical dimension and then
select whether you want to enter an
angle or a horizontal dimension.

Concrete components reference 3218 Concrete Detailing



Option Description
Top and bottom staight

Enter vertical dimensions and then
select whether you want to enter an
angle or a horizontal dimension.

out

Select the shape of the step front edge and enter the required dimensions.

• Default

• Radius: Creates rounded edge.

• Chamfer: Creates chamfered edge.

• No: Creates square edge.

in

Select the shape of the step inner corner and enter the required dimensions.

• Default

• Radius: Creates rounded inner corner.

• Chamfer: Creates chamfered inner corner.

• No: Creates square inner corner.

Landings tab
Use the Landings tab to create top and/or bottom landings.
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Create landings

Define whether one or two landings are created, or whether there are no
landings.

Landing dimensions and extensions

 Description
1

2

Thickness of the bottom landing.
Length of the bottom landing.

3

4

Length of the top landing.
Thickness of the top landing.

5

7

Left and right extensions of the bottom landing.

6

8

Left and right extensions of the top landing.

Ridges tab
Use the Ridges tab to create horizontal and/or vertical ridges on both sides or
only on the other side of the stairs.
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Dimensions

 Description
1

2

Thickness of the vertical ridge.
Width of the vertical ridge.

3

4

Width of the horizontal ridge.
Thickness/height of the horizontal ridge.

Horizontal ridges

Part Description
Create Define whether horizontal ridges are

created.
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Part Description
Create at foot Define whether horizontal ridges are

created at the foot of the stairs.

This option works in the same way as
the Create option.

Inside chamfer

1

Select the type of the inside chamfer
and enter the required dimensions.

Corner chamfer

2

Select the type of the corner chamfer
and enter the required dimensions.

Slope

3

Set the slope as an angle or a
dimension. The slope makes the ridge
inclined.

Foot corner chamfer Define whether corner chamfers are
created at the stair foot.

Top and foot ridges

Define the horizontal ridge length at the stair top step and at the stair foot.
When no foot is created, vertical ridges continue to the bottom level of the
stairs.
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Vertical ridges

Part Description
Create Define whether vertical ridges are

created.

Slope Set the slope as an angle or a
dimension. The slope makes the ridge
inclined.

Stringers tab
Use the Stringers tab to create stringers and ridges on the left, right, or both
sides of the stairs.

Parts

Part Description
Create stringers Define whether stringers are created.
Create top ridge Select an option to create top ridges.

Create bottom ridge Select an option to create bottom
ridges.
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Part Description
Slope Use to incline the inner surface of the

stringers.

You can define the slope using an
angle or a dimension.

Inside chamfer Define whether the inside edge of
stringer is chamfered or not.

Outside chamfer Define whether the outside edge of
stringer is chamfered or not.

Stringer height Define how the stringer height is
determined.

Dimensions

 Description
1 Height of the stringer bottom ridge.
2 Horizontal offset of the bottom ridge from the bottom step.
3 Height of the stringer top ridge.
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 Description
4 Width of the stringer.
5 Difference in height that is the perpendicular distance between the step

edge and stringer edge.

You can enter this dimension if Stringer height is Diff in height.
6 Total height of the stringer.

You can enter this dimension if Stringer height is Default or Total
height.

Anti-skid/Kick plate tab
Use the Anti-skid and Kick plate tabs to create slip resistant surfaces.

Parts

Part Description
Creation anti-skid

Creation kick plate

Define whether anti-skids or kick
plates are created.

Create anti-skid on foot Define whether anti-skids are created
at the stair foot.

Create cutout Define whether you want to create
cutouts with the anti-skid profile.

By default, the cutouts are not
created.

Include in cast unit Define whether anti-skids or kick
plates are included in cast unit.

Profile Define the anti-skid or kick plate
profile by selecting it from the profile
catalog.

Rotation Select an option to rotate the anti-
skid or kick plate profile.

Anti-skid/kick plate position
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 Description
1

2

Anti-skid or kick plate distance from the left edge of the step.
Anti-skid or kick plate distance from the right edge of the step.

 Description
1 Distance from the step front edge.
2 Depth for the anti-skid or kick plate.

Attributes tab
Use the Attributes tab to control the properties of different stair parts.

Part attributes

Option Description Default
Pos_No Prefix and Start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options .

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings -->
Options .

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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UDA tab
Use the UDA tab to provide additional information about the parts created.

TIP The user-defined attributes are case sensitive. Check the correct spelling
of an attribute from the objects.inp file.

Stairwells and elevator shafts (90)
Stairwells and elevator shafts (90) creates a rectangular stairwell or elevator
shaft to represent the structure in the design stage.

When you detail the structure, you can apply seams, connections, and
reinforcement to complete the details of a stairwell or elevator shaft. This
component uses the Concrete stairs (65) (page 3212) component for creating
stairs.

Parts created

• Wall panels

• Landings (optional)

• Flights of stairs (optional)

• Roof slab (optional)

• Openings (optional)

Where to use

Situation More information
A stairwell over four floors created
using the default options.

As shown, the points picked and the
dimensions on the Stairs and
landings tab determine the length of
the stairwell.

Walls consist of one or more precast
concrete panels.

1 First point picked

2 Second point picked
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Situation More information
Stairwells always contain a first floor
and a top floor. Indicate the number
of additional floors on the Plan view
tab, Levels field. This stairwell has 2
additional floors, for a total of 4
floors.

1 Top floor

2 Additional floor

3 Additional floor

4 1st or ground floor

Elevator shaft created by selecting the
Elevator shaft option on the Stairs
and landings tab, Type field, for all
floors.

Limitations

The minimum floor height between floors is 200 mm.

Picking order

1. On the Plan view tab, check the Position option. The default is in the
middle of walls 3 and 4.

2. Pick a point to indicate the position of wall 3.

3. Pick a point to indicate the position of wall 4.

Plan view tab
Use the Plan view tab to define the properties of the stairwell or elevator
shaft.
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To define the number of levels and floor heights, enter a height for each floor
level in the Levels field, for example:

You can also define negative floor levels, for example:

You can also use multiplier to define many floors, as in the following US
imperial example:

Tekla Structures also uses these values to calculate the total height of the
stairwell.

To create the stairwell or elevator shaft, you pick two points in the model. Use
the Position field to define the location of the stairwell or elevator shaft
relative to these points. The options are:

• Middle (default)

• Left

• Right

Enter the offset distance from the selected position. Here, the offset is from
the middle of wall.

To manually define the total length and total width of the stairwell or elevator
shaft, enter the following values:

L - total length

W - total width

Leave both fields blank to have Tekla Structures automatically calculate these
dimensions from the the points picked:
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 Description
1 First point picked.
2 Second point picked.
3 Total width, W
4 Total length, L

NOTE The dimensions defined on the Stairs and landings tab may override
the total length or width that is automatically calculated or that you
manually enter.

Openings tab
Use the Openings tab to define opening dimensions for each wall panel and
for the first, additional, and top floors.

Each wall may have a single opening, or no opening.

Stairs and landings tab
Use the Stairs and landings tab to define the stair and landing properties and
dimensions.

Select to create an elevator shaft from the Type list.

Attributes tab
Use the Attributes tab to define basic part properties for walls, stairs, and
landings.

You can also use the save properties from the Concrete stairs (65) (page 3212)
component for the first, additional, and top stairs.

Option Description
Pos_No To ensure correct numbering, define

a Prefix and a Start number for the
part position number of stair parts.

Enter the assembly position number
of the stair parts on the second row.

Material Define the material grade.
Name Define a name that is shown in

drawings and reports.
Class Define the part class number.

Reinforced concrete stair (95)
Reinforced Concrete Stair (95) creates reinforced concrete stairs.
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Objects created

• Stairs

• Landings (optional)

• Ridges (optional)

• Stringers (optional)

• Anti-skid (optional)

• Main bars and stirrups of stair reinforcement (Bar A - Bar L tabs) (optional)

• Meshes in stairs and landings (optional)

• Mesh bars (optional)

• Anchor bars (optional)

• Landing end bars (optional)

Use for

Situation Description
Reinforced concrete
stairs.

Reinforced concrete stairs
with chamfered steps,
ridges and stringers.
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Situation Description
Reinforced concrete stairs
with reinforced landings.

Selection order

1. Pick the first point to indicate the start point of the stairs.

2. Pick the second point to indicate the direction of the stairs.

3. Select any number of parts to be cut by the stairs (optional).

4. Click the middle mouse button to create the stairs.
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Parameters tab
Use the Parameters tab to control the shape of the stairs, number of steps,
stair creation method and the stairs width.

Stair dimensions

  Description
1 Horizontal dimension of the

steps area
2 Vertical dimension of the steps

area
3 Step length
4 Step height
5 Shape options for stair bottom
6 Shape options for stair top
7 Stair width

Start point position

Select the start point position of the polygon shape.

NOTE Start point position affects the bounding box of the cast-unit.
Therefore it will affect drawing view orientation and numbering.

Stair creation method

Option Description
P1 P2 step length Create stairs between points P1 and P2.

Stair dimension are defined by the distance between P1
and P2 and step length.

P1 P2 step height Create stairs between points P1 and P2.

Stair dimension are defined by the distance between P1
and P2 and step height.

P1 step length
step height N
steps

Create stairs from point P1 to point P2.

Stair dimensions are defined by P1 and step height,
length and number of steps.
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Option Description
P2 step length
step height N
steps

Create stairs from point P1 to point P2.

Stair dimensions are defined by P2 and step height,
length and number of steps.

P1 horizontal and
vertical step
distance

Create stairs from point P1 to point P2.

Stair dimensions are defined by P1 and horizontal and
vertical step distance.

P2 horizontal and
vertical step
distance

Create stairs from point P1 to point P2.

Stair dimensions are defined by P2 and horizontal and
vertical step distance.

Parts tab
Use the Parts tab to control the material, name, class, positioning, cast unit
type and step chamfering.

Step chamfer settings

Option Description
Middle for all All steps are chamfered according to the Middle

steps settings.
Bottom different Bottom step is chamfered according to the 1st step

at bottom settings.

All other steps are chamfered according to the
Middle steps settings.

Top different Top step is chamfered according to the Last top
step settings.

All other steps are chamfered according to the
Middle steps settings.

Bottom and top
different

Bottom step is chamfered according to the 1st step
at bottom settings.

Top step chamfered are according to the Last top
step settings. All other steps are chamfered
according to the Middle steps settings.

Step chamfer settings are set in the same way for 1st step at bottom, Middle
steps and Last top step.
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Option Description
Size of step cut is defined by the distance.

Size of step cut is defined by the angle.

Corner chamfer types

Corner chamfers 1. and 2. can be defined by the Radius x or by the sides of
the Chamfer x, y.

Create finished floor level

Select whether to create finished floor level. The finished floor level is defined
by a polygon created from an offset stairs polygon and it is used for drawings.

Define the profile, properties and offset of the dummy part that is created at
each polygon vertex.

Stairs and landings tab
Use the Stairs and landings tab to control the size and type of the bottom
landing and the top landing.

Bottom landing cut option

Option Description
Bottom landing with no cut.
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Option Description
Bottom landing with cut defined by its length and
distance from the top side of landing.

Bottom landing with cut defined by its length and
distance from the bottom side of landing.

Bottom landing with L shape cut defined by its three
dimensions and distance from the top side of
landing.

Bottom landing cut defined by a profile and its
position in landing.

Top landing cut option

Option Description
Top landing with no cut.

Top landing with cut defined by its length and distance
from the top side of landing.

Top landing with cut defined by its length and distance
from the bottom side of landing.

Top landing with L shape cut defined by its three
dimensions and distance from the top side of landing.
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Option Description
Top landing cut defined by a profile and its position in
landing.

Landing dimensioning and openings

 Description
Use the top view setting to define the dimensions
of the bottom landing and the top landing.

Use the top view setting to define two openings
for the bottom and the top landing.

The following rebars avoid the created openings:
anchor and Z anchor bars, mesh bars, landing end
bars, and A, B, C, E, G, K bars.
Define the gaps on the sides of the landings.

Recesses and holes

Option Description
No hole or recess

Hole

Recess at the top face

Recess at the bottom face

Ridges tab
Use the Ridges tab to create horizontal and/or vertical ridges on both sides or
only on one side of the stairs.
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Dimensions

  Description
1 Thickness of the vertical ridge.
2 Width of the vertical ridge.
3 Width of the horizontal ridge.
4 Thickness/height of the horizontal ridge.

Horizontal ridges

Option Description
Create Define whether horizontal ridges are created.

Create at foot Define whether horizontal ridges are created at the foot
of the stairs.

This option works in the same way as the Create option.
Chamfering 1 Inside chamfer: Select the type of the inside chamfer

and enter the required dimensions.

2 Corner chamfer: Select the type of the corner chamfer
and enter the required dimensions.

3 Slope: Set the slope as an angle or a dimension. The
slope makes the ridge inclined.
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Option Description
Foot corner
chamfer

Define whether corner chamfers are created at the stair
foot.

Vertical ridges

Option Description
Create Define whether vertical ridges are created.

Slope Set the slope as an angle or a dimension. The slope
makes the ridge inclined.

Stringers tab
Use the Stringers tab to create the stringers and ridges on the left, right, or
both sides of the stairs.
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  Description
1 Height of the stringer bottom ridge.
2 Horizontal offset of the bottom ridge from the

bottom step.
3 Height of the stringer top ridge.
4 Width of the stringer.

Slope Use to incline the inner surface of the
stringers.

You can define the slope using an angle or a
dimension.

Inside chamfer Define whether the inside edge of stringer is
chamfered or not.

Outside chamfer Define whether the outside edge of stringer is
chamfered or not.

Stringer height

Stringer height based on the total height or distance from inner/outer step
corner.

Stringer bars tab
Use the Stringer bars tab to create reinforcements in the stringers.
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Option Description
Define the spacing of bars and the
concrete cover thicknesses.

Create Select to create the group of bars.
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Radius Internal radius of the bends in the

bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Class Use Class to group reinforcement.
Name Tekla Structures uses the name in

drawings and reports.

Anti-skid tab
Use the Anti-skid tab to create slip resistant surfaces.

Option Description
Creation anti-skid Define whether anti-skids are created.
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Option Description
Create anti-skid
on foot/top

Define whether anti-skids are created at the stair foot/
top.

Create cutout Define whether you want to create cutouts with the
anti-skid profile. By default, the cutouts are not created.

Include in cast
unit

Define whether anti-skids are included in the cast unit.

Profile Define the anti-skid profile by selecting it from the
profile catalog.

Rotation Select an option to rotate the anti-skid profile.

Bar A tab
Use the Bar A tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.

Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Bar B tab
Use the Bar B tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.
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Bar B bottom ending options

Define geometry and concrete cover thickness of the bar B bottom ending.

Option Description
Bar B simple bottom ending.

Bar B bottom ending bent once to fit the
bottom footing of the stairs.

Bar B bottom ending bent twice to fit the
bottom footing of the stairs.

Bar B bottom ending bent up to three times
to fit the bottom footing of the stairs.

Bar B top ending options

Define geometry and concrete cover thickness of the bar B top ending.

Option Description
Bar B simple top ending.
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Option Description
Bar B top ending bent once to fit the top
geometry of the stairs.

Bar B top ending bent twice to fit the top
geometry of the stairs. Last leg length is
defined by the cover thickness.

Bar B top ending bent twice to fit the top
geometry of the stairs.

Reinforcing bar spacing

Option Description
Spacing, number of bars and concrete
cover thickness of the reinforcing bar
group.

Bar C tab
Use the Bar C tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.

Option Description
Geometry and concrete cover thickness.
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Option Description
Define which extra side bars are created, their end
conditions, and the concrete cover.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Option Description
The purple color in the dialog box represents the
extra I bars.

Define whether to create the extra I bars. Select
the check boxes next to the purple points.

Select the nose shape adaptation. The first check
box (the dot on the left) creates the extra I bar
and the second creates a hook on it.

Cover thickness of the reinforcing bars.
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Bar D tab
Use the Bar D tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.

Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Extra I bars are straight bars crossing bar D. You can create up to four extra I
bars.

Option Description
The purple color in the dialog box represents
the extra I bars.

Define whether to create the extra I bars.
Select the check boxes next to the purple
points.
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Option Description
Cover thickness of the reinforcing bars.

Bar E tab
Use the Bar E tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Create options

Option Description
No Bar is not created.

Stirrup Bar is created as stirrup.
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Option Description
Pin Bar is created as pin.

Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.
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Option Description
Shape of the stirrups.

Parallel with step slope Yes

Create parallel with sloped step shape.
No

Create as a rectangle.

Extra I bars

Extra I bars are straight bars crossing bar D. You can create up to four extra I
bars.

Option Description
The purple color in the dialog box represents
the extra I bars.

Define whether to create the extra I bars.
Select the check boxes next to the purple
points.

Cover thickness of the reinforcing bars.
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Bar F tab
Use the Bar F tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Bar G tab
Use the Bar G tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.
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Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Extra I bars are straight bars crossing bar G. You can create up to four extra I
bars.

Option Description
The purple color in the dialog box
represents the extra I bars.

Define whether to create extra I bars.
Select the check boxes next to the purple
points.

Cover thickness of the reinforcing bars.

Bar H tab
Use the Bar H tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.
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Create option

Option Description
• Do not create bar H

• Create bar H

• Create only bottom bar H reinforcing bar
group

Bar H geometry option

Option Description
Two bent reinforcing bar groups. Define
geometry and concrete cover thickness.

Top reinforcing bar group is straight, bottom
reinforcing bar group is bent on both sides.
Define geometry and concrete cover
thickness.

Two straight reinforcing bar groups. Define
geometry and concrete cover thickness.

Two reinforcing bar groups. Define
geometry and concrete cover thickness.

One reinforcing bar group that is bent on
one side. Define concrete cover thickness
and whether to create hooks.

Properties

You can define separate properties for bottom and top rebars.

Option Description
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.
Prefix Prefix for the part position number.
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Option Description
Start number Start number for the part position

number.

Bar I tab
Use the Bar I tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Option Description
Positioning, spacing and concrete cover
thickness.

Concrete cover thickness of the reinforcing
bar groups.

Bar J tab
Use the Bar J tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group. You
can create several bar J reinforcing bar groups. Each group has its own color
representation on the Bar J tab.
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Color group options

Option Description
Use the color group option to define which
combination of bar J reinforcing bar groups
(blue, green, brown) is created.

Option Description
Positioning and concrete cover thickness for
reinforcing bar groups based on the color
representation.

Concrete cover thickness for all reinforcing bar
groups.

Bar K tab
Use the Bar K tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.
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Option Description
Select the geometry and define the concrete
cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Extra I bars are straight bars crossing bar K. You can create up to three extra I
bars.

Option Description
The purple color in the dialog box
represents the extra I bars.

Define whether to create extra I bars
by selecting the check boxes next to
the purple points.

Cover thickness of the reinforcing
bars.

Bar L tab
Use the Bar L tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.
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Option Description
Define whether an L shaped reinforcing bar group
is created at the stair footing.

Define whether an L shaped reinforcing bar group
is created at the stair top or whether all bars are
created with the same geometry.

Define offsets for the reinforcing bar groups in the
two top steps.

Define whether reinforcing bars are created
between the top and bottom step.

Define geometry for reinforcing bar groups in all
steps, except for the two top steps.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Bar L geometry options

The geometry options affect the middle and the bottom steps.

Option Description
L shape reinforcing bar groups.
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Option Description
L shape reinforcing bar groups with hooks.

Mesh picture tab
Use the Mesh picture tab to define bottom landing meshes, stair meshes and
top landing meshes.

Side view

  Description
1 Bottom landing mesh (top).

Define offsets and cover thickness
of the mesh.

2 Bottom landing mesh (bottom).
Define offsets and cover thickness
of the mesh.

3 Stair mesh (top). Define offsets
and cover thickness of the mesh.

4 Stair mesh (bottom). Define
offsets and cover thickness of the
mesh.

5 Top landing mesh (top). Define
offsets and cover thickness of the
mesh.

6 Top landing mesh (bottom).
Define offsets and cover thickness
of the mesh.

Top view

  Description
1 Cover thickness of bottom landing

mesh (top).
2 Cover thickness of bottom landing

mesh (bottom).
3 Cover thickness of stair mesh (top).
4 Cover thickness of stair mesh (bottom).
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  Description
5 Cover thickness of top landing mesh

(top).
6 Cover thickness of top landing mesh

(bottom).

Mesh attributes tab
Use the Mesh attributes tab with the Mesh picture tab to define the
properties, positioning and creation type of bottom landing meshes, stair
meshes and top landing meshes.

Cross bar location

 Description
Cross bar above.

Cross bar below.

Creation type

 Description
Create mesh as reinforcement mesh.

Create mesh as two independent reinforcing
groups.
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Mesh bars tab
Use the Mesh bars tab to define the geometry, concrete cover thickness,
reinforcing bar spacing, and reinforcing bar properties of the mesh bars in the
top and bottom landing. You can create up to three reinforcing bar groups.

  Description
1 Cover thicknesses of all mesh bar

groups in the stair bottom landing.

Use the color representation in the
dialog box.

2 Vertical cover thicknesses of all mesh
bar groups in the stair bottom landing.

Use the color representation in the
dialog box.

3 Cover thicknesses of all mesh bar
groups in the stair top landing.

Use the color representation in the
dialog box.

4 Vertical cover thicknesses of all mesh
bar groups in the stair top landing.

Use the color representation in the
dialog box.

Bottom anchor bars tab
Use the Bottom anchor bars tab to define the geometry, concrete cover
thickness, reinforcing bar spacing, and reinforcing bar properties of the
bottom anchor bars. You can create up to three reinforcing bar groups.

Creation type

Option Description
No No reinforcing bar group created.
Type1 L shape anchor reinforcing bar group.
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Option Description
Type2 Simple straight anchor reinforcing bar group.

Top anchor bars tab
Use the Top anchor bars tab to define the geometry, concrete cover
thickness, reinforcing bar spacing, and reinforcing bar properties of the top
anchor bars. You can create up to three reinforcing bar groups.

Creation type

Option Description
No No reinforcing bar group created.
Type1 L shape anchor reinforcing bar group.

Type2 Simple straight anchor reinforcing bar group.

Z anchor bars tab
Use the Z anchor bars tab to define the geometry, concrete cover thickness,
reinforcing bar spacing, and reinforcing bar properties of the Z anchor bars.
You can create up to three reinforcing bar groups.
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  Description
1 Cover thicknesses of all Z

anchor bar groups in the
stair bottom landing.

Use the color
representation in the
dialog box.

2 Vertical cover thicknesses
of all Z anchor bar groups
in the stair main part.

Use the color
representation in the
dialog box.

3 Cover thicknesses of all Z
anchor bar groups in the
stair top landing.

Use the color
representation in the
dialog box.

Bot
L

Length of the Z anchor
bars that extend from the
stair bottom landing.

Top
L

Length of the Z anchor
bars that extend from the
stair top landing.

Landing end bars tab
Use the Landing end bars tab to reinforce the stair landings and to define the
geometry, concrete cover thickness, reinforcing bar spacing, and bar
properties of the landing end bars.

Bottom end

Reinforcement of bottom landing.

  Description
1 Landing end bars. U-shape geometry follows

the shape of the landing based on the
defined cover thicknesses.

Color representation in the picture: blue,
green.

2 Define whether to create extra cross bars.
Select the check boxes next to the purple
points.
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  Description
3 Define whether to create extra cross bars.

Select the check boxes next to the red
points.

Top end

Reinforcement of top landing.

  Description
1 Landing end bars. U-shape geometry follows

the shape of the landing based on defined
cover thicknesses.

Color representation in the picture: blue,
green.

2 Define whether to create extra cross bars.
Select the check boxes next to purple points.

3 Define whether to create extra cross bars.
Select the check boxes next to red points.

Side cover thickness

Option Description
Side cover thickness of all reinforcing bar groups
defined on the Landing end bars tab.

UDA tab
Use the UDA tab to define user-defined attributes for the stairs. You can
define multiple UDAs. UDAs can be used as filters, and they can be displayed
in drawings and reports.

Configuration tab
Use the Configuration tab to define the default cover thicknesses and
bending radiuses of all reinforcing bars created by Reinforced Concrete Stair
(95).

Cover thickness for reinforcing bar groups A - C

Define the default cover thickness for reinforcing bar groups A - C.

Option Description
Value Default cover thickness defined by a value.
Rebar diameter Default cover thickness multiplied by reinforcing

bar diameter.
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General cover thickness bars D - L

Define the default cover thickness for reinforcing bar groups D - L and all
reinforcing bars except the reinforcing bar groups A - C and meshes.

Option Description
Value Default cover thickness defined by a value.
Rebar diameter Default cover thickness multiplied by reinforcing

bar diameter.

Bending radius

Define the default bending radius of all reinforcing bars.

Option Description
Rebar_database.inp Default bending radius defined by

rebar_database.inp file.
Relative to diameter Default bending radius according to the

reinforcing bar diameter.
Bending radius Default bending radius defined by value.

Mesh cover thickness

Define the default cover thickness for the meshes created by Reinforced
Concrete Stair (95).

Foundations
This section introduces components that can be used in concrete foundations.

Click the links below to find out more:

• Precast foundation block (1028) (page 3263)

• Concrete foundation (1030) (page 3270)

Precast foundation block (1028)
Precast foundation block (1028) creates a concrete foundation block. The
block can be divided in three sections. All three sections can be dimensioned
separately.

Parts created

• Foundation block

• Embed

• Regulator
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Use for

Situation Description
Precast foundation block with three
sections.
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Situation Description
Precast foundation block with one
section.

Selection order

1. Select the main part (concrete column).

2. Pick a position.

The detail is created automatically.

Picture tab
Use the Picture tab to dimension the foundation block.
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The foundation block can be dimensioned in both the front view and in the
side view.

 Description
1 Width of the top chord in section 1 (in front view).
2 Width of the inclined column cut-out.
3 Height of the column cut-out.
4 Offset of the plate that is under the block.

The offset is relative to the foundation block.
5 Thickness of the plate under the block.
6 Width of the bottom chord in section 1 (in front view).

Width of section 2 and section 3 (in front view).
7 Distance between the foundation block and the sides of the column.
8 Select how the sections in the foundation block are connected.
9 Select the reference point of the

foundation block.
Component
insertion point is
at the bottom side
of the foundation
block.
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 Description
Additionally, you can set the
vertical offset:

Note that the red
part (additional
plate under the
block) is not taken
into account.

Component
insertion point is
at the bottom side
of the cut-out of
the column.

Component
insertion point is
at the bottom side
of the column.

Component
insertion point is
at the top of the
foundation block.

10 Width of the top chord in section 1 (in side view).
11 Distance from the bottom of the column to the foundation block.
12 Width of the bottom chord in section 1 (in side view).

Width of section 2 and section 3 (in side view).
13 Select the cast unit type.
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Parts tab
Use the Parts tab to define the profiles for the foundation block, embed and
regulator, and the embed dimensions.

Opti
on

Description

1 Foundation block profiles, regulator and embed properties.

If you do not select any material, Precast foundation block (1028)
uses the same material as the column.

2 Select whether the regulator and the embed is created, and how they
are connected to the foundation block.

3 Dimensions of the three sections of the foundation block.

Additionally, you can define the column cut-out in the upper section.

For sections 2 and 3 you can define the height of the inclined plane.
4 Dimensions of the embed.

Grooves tab
Use the Grooves tab to define the grooves.

Example:
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 Description
1 Height of the groove.
2 Distance between the grooves.
3 First distance related to the bottom of the column.
4 Depth for the grooves.
5 Number for the grooves.
6 Select whether to define a slope angle or dimension for the grooves.
7 Define the slope angle or dimension value.

General tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Concrete foundation (1030)
Concrete foundation (1030) creates a concrete foundation plate at the
bottom of a selected concrete column.

Objects created

• Concrete foundation plate

• Injection tubes and injection hoses in concrete column

• Up to 4 concrete piles under the foundation plate (optional)

• Stirrups for the reinforcing bars

Use for

Situation Description
Concrete foundation plate with
chamfers, piles, injection tubes with
curved injection hoses, reinforcing
bars and stirrups.
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Situation Description
Concrete foundation plate with more
than 4 edges, recesses in the
foundation plate, and multiple
reinforcing bars.

Concrete foundation plate with
multiple reinforcing bars.

Selection order

1. Select a concrete column.
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2. Pick a point.

The concrete foundation plate is created automatically when the point is
picked.

Part identification key

 Part
1 Concrete column
2 Point

The point defines the new bottom level of the column.

Picture tab
Use the Picture tab to control the dimensions of the reinforcing bars and
injection tubes.

Concrete components reference 3272 Concrete Detailing



Dimensions

 Description Default
1 Length of the injection tube extension

from the top of reinforcing bar.
180 mm

2 Reinforcing bar height in the column. 400 mm
3

4

Reinforcing bar top and bottom cover
thickness.

The bottom cover thickness is used only
if you do not define the top cover
thickness.

0,5 * foundation
plate thickness

5 Pile thickness.

The pile thickness value on the Parts tab
overrides this value.

300 mm

6 Distance from the bottom of the
foundation plate to the bottom of the
pile.

5000 mm
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 Description Default
7 Pile depth in the foundation plate. 50 mm
8 Foundation plate thickness. 800 mm
9 Distance between the column and the

foundation plate.
0 mm

10 Vertical offset from the picked point. 0 mm

11 Reinforcing bar height. 800 mm 400 mm + 50%
of height of concrete
footing

12 Injection tube elevation 1. 500 mm
13 Injection tube elevations 2 and 3.

Vertical offset for the injection tubes if
the tubes are pointing to the same
direction.

Define the level to use on the Inj. Tube
and rebar tab.

 

Injection tube

Select the shape and dimensions of the injection tubes.
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Option Description
Injection tube in one piece, 90 degree angle.

Injection tube in one piece.

Use value a to define the slope of the tube.

Injection tube and a 90 degree injection hose.

Injection tube and a sloped injection hose.

Use value a to define the slope of the hose.

Concrete components reference 3275 Concrete Detailing



Option Description
Straight injection tube. No injection tube opening is
created.

 Description Default
1 Define the height of a sloped injection

tube or hose angle.
30 mm

2 Define the height of a curved injection
hose.

0 mm

Reinforcing bar hook length

Define the reinforcing bar hook length. You can define also the end angle of
the reinforcing bar.

The default value is 10 * reinforcing bar diameter.
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Parts tab
Use the Parts tab to control the profile properties of the foundation plate,
foundation piles, stirrups and injection tubes.

Concrete massive, Piles

Define the profile properties of the concrete foundation plate and the
foundation piles.

If you leave the pile thickness value empty on the Parts tab, the pile thickness
value defined on the Picture tab is used instead together with the Pile profile
type prefix (e.g. D).

Option Description
t, b, h Part thickness, width and height.
Pos_No Prefix and a start number for the part

position number.
Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.
Comment Add a comment for the part.

Reinforcing bars

Option Description
Type of reinforcing bars Select the profile type for the reinforcing bars.

• Default: the same as Reinforcing bar
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Option Description
• Poly-profile: profile catalog

• Reinforcing bar: reinforcing bar catalog
Reinforcement bars Size of the reinforcing bars.
Radius Radius of the reinforcing bar hook.
Reinf. bars belong to Define to which part the reinforcing bars belong.

• Default: the same as Columns

• Concrete massive: reinforcing bars belong to
the concrete foundation plate.

• Column: reinforcing bars belong to the
column.

• Loose part: reinforcing bars are not
connected to any part.

• Neighbor: reinforcing bars belong to the
neighbor part. Use the name or class to find
the part.

Injection tubes and curve

Option Description
Injection tubes

Curve

Size of the injection tubes.

Size of the injection hoses.
Article number Article number for the injection hose

and the injection tube.

The entered values are saved to the
user-defined attribute of the part.

 Define how the injection hoses are
connected to the injection tubes.

• Default: injection hoses are loose
parts.

• Part-add gain: injection hoses are
added to the injection tubes.

• Weld gain: injection hoses are
welded to the injection tubes.

• Cast unit column: injection hoses
are added to the column.

• Weld to column: injection hoses
are welded to the column.
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Option Description
Pile profile type prefix (e.g. D) Default parametric profile prefix for

the piles.

This value works only if you have set
the pile thickness on the Picture tab.

You can override this value by setting
the pile thickness on the Parts tab.

Reinf. bar profile type prefix (e.g.D) Default parametric profile prefix for
the reinforcing bar profiles.

Massive tab
Use the Massive tab to control the shape and the dimensions of the concrete
foundation plate and the recesses.

Concrete foundation plate type

Option Description
Type of massive Select the plate type for the rectangular

foundation plate.
Massive direction Select the direction of the foundation plate.

Concrete foundation plate dimensions
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 Description
1

2

Offset from the concrete column in the x direction.
Offset from the concrete column in the y direction.

3 Select the shape of the foundation plate.
4 Width of the foundation plate.
5

6

Length of the straight part of the foundation plate.

7 Offset from the foundation plate center line.
8 Width of the straight part of the foundation plate.
9 Length of the foundation plate.

Recess dimensions
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 Description
1 Select the type of the recess.
2 Width of the recesses.
3 Depth of the recesses.
4 Distance between the bottom of the reinforcing bar and

the bottom of the recess.
5

6

Distance between the center line of the reinforcing bar
and the left side of the recess.
Distance between the center line of the reinforcing bar
and the right side of the recess.

Option Description
Chamfer type for
rectangular massive

Chamfer type for the rectangular foundation
plate.

Chamfer X Chamfer size in the x direction.
Chamfer Y Chamfer size in the y direction.

Piles tab
Use the Piles tab to control the position of the foundation piles.

Pile positions

Description
1 Select the position and the offset of the piles.
2

4

6

8

Distance between the first pile and the column in the x
direction.
Distance between the second pile and the column in the x
direction.
Distance between the third pile and the column in the x
direction.
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Description
Distance between the fourth pile and the column in the x
direction.

3

5

7

9

Distance between the first pile and the column in y direction.
Distance between the second pile and the column in y
direction.
Distance between the third pile and the column in y direction.
Distance between the fourth pile and the column in y direction.

10

11

Pile offset from the concrete column in the x direction.
Pile offset from the concrete column in the y direction.

Option Description
Piles direction Define the direction of the piles.
Join piles to massive Define how the piles are connected to the

foundation plate.

Inj. tube and rebar tab
Use the Inj. tube and rebar tab to control the creation, number and position
of the reinforcing bars and injection tubes.

Option Description
Create Select which parts are created.
Injection tubes bend
radius

Radius of the injection tubes.
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Injection tube properties

Description
1 Select the direction of the bent bars.
2 Select the direction of the injection hoses.
3 Number of injection tubes.
4 Center-to-center distance between the injection tubes.
5 Define the level of the curved injection parts.

This is useful if the curved parts are pointing to the same
direction.

You can define the levels on the Picture tab.
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Description

Example:

6 Define the distance from the center of the injection tube to the
outer contour of the concrete foundation.
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Example

Column tab
Use the Column tab to control the dimensions of the column cut-out.
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Column dimensions

 Description
1 Size of the column cut-out.
2 Height of the column cut-out.

Stirrups tab
Use the Stirrups tab to control the stirrup properties.

Stirrup properties

Option Description
Select whether the stirrups are created.

Define the length of the laps.

Grade Grade of the stirrups.
Size Size of the stirrups.
End conditions left Hook for the start point of the stirrups.
End conditions
right

Hook for the end point of the stirrups.

Bend lengths left Hook length for the start point of the stirrup.
Bend lengths right Hook length for the end point of the stirrup.
Creation method Creation method of the stirrups.

Number of bars: Enter the number of the stirrups.
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Option Description

By spacing: Enter a spacing value.

 Define the comment, name, class, serie and start
number for the stirrups.

Concrete components reference 3287 Concrete Detailing



 Description
1 Select the start point of stirrups, either from the bottom of the

column to the first stirrup or from the top of the reinforcing bar to
first stirrup.

2 Define the distance from the bottom of the reinforcing bar to the
last stirrup.

Example

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

6.2 Reinforcement
This section introduces components that can be used in reinforcement.
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See also

Reinforcement for foundations (page 3289)

Beam, column, and slab reinforcement (page 3312)

Lifting (page 3526)

Reinforcement for foundations
Tekla Structures includes the following components that you can use to
automatically create reinforcement for foundations:

• Strip footing reinforcement (75) (page 3289)

• Pile cap reinforcement (76) (page 3293)

• Pad footing reinforcement (77) (page 3299)

• Starter bars for pillar (86) (page 3306)

• Starter bars for footing (87) (page 3308)

Strip footing reinforcement (75)
Strip footing reinforcement (75) creates reinforcement for a concrete strip
footing.

Bars created

• Longitudinal bars for the top and bottom surfaces and sides of the footing

• Stirrups

Use for

Situation More
information

Straight strip footings that have
rectangular cross sections

 

Main bars entirely
inside the footing,
no side bars,
stirrup laps at
stirrup corners.
Main bars
protruding from
the footing, two
bars on both
sides, stirrup laps
in the middle of
the top surface.
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Do not use for

Footings that have:

• Irregular cross sections

• Skew or cut corners

Before you start

• Create the concrete strip footing.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete strip footing.

Picture tab
Use the Picture tab to define the concrete cover thickness and stirrup offset.

Cover thickness

 Description
1 Cover thickness (strip ends)
2 Stirrup offset
3 Cover thickness (top and bottom)

Main bars tab
Use the Main bars tab to define the properties of top, bottom, left and right
bars.

Bond length of main bars

Bond lengths define how far main bars extend into adjacent structures at the
ends of strip footings. Use the Bond length 1 boxes for the first end of the
footing (with the yellow handle), and the Bond length 2 boxes for the second
end of the footing (with the magenta handle).

You can define bond lengths separately for:

• Top bars

• Bottom bars
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• Bars on the left side of the footing

• Bars on the right side of the footing

Stirrups tab
Use the Stirrups tab to define stirrup properties and spacing type.

Bend type

Select the location of the stirrup laps in the strip footing.

Option
At mid

At corner

U-shaped

U-shaped

Enter the overlap length in
the Transverse picture for
the first two options.
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Option

Double stirrup bars

Straight transverse bar

Stirrup dimensions

 Description
1 Cover thickness (sides)
2 Outer distance between the main bars and outer side bars
3 Overlap length of the double stirrup
4 Overlap length of the double U-bars

Bending direction

 Option
1

2

3
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 Option
4

End shape of double stirrup bars

If you selected double stirrup bars, you can select the end shapes for bars
from the list.

Option Examples
135-degree

Default

90-degree

Overlapped

If you select overlapped, you
can enter the overlap length.

Attributes tab
Use the Attributes tab to define the numbering properties of bars and
stirrups.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Pile cap reinforcement (76)
Pile cap reinforcement (76) creates reinforcement for a concrete pile cap.

Bars created

• Bars in two directions for the top and bottom surfaces of the pile cap
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• Lacer bars

Use for

Situation More information
Bottom bars concentrated
over the piles, top bars
under the column. Two lacer
bars.

Bars evenly distributed on
the bottom and top
surfaces. No lacer bars.

Rectangular footings with or
without cut corners, footings
that are skewed on one or both
sides

Pad footing and pile cap
shapes

Bars on the top, bottom, or
both surfaces of the footing

 

Straight or bent bar ends  

Pad footing and pile cap shapes

Use the Pile cap reinforcement (76) to create reinforcement for the following
shapes of foundations:

Shape Description
Rectangular

Skewed on two sides

Concrete components reference 3294 Reinforcement



Shape Description
Skewed on one side

Rectangular with cut corners

Before you start

• Create the concrete pile cap.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete pile cap.

2. Select the piles and/or columns.

3. Click the middle mouse button to finish.

Picture tab
Use the Picture tab to define the concrete cover thickness and primary bar
direction.

Concrete components reference 3295 Reinforcement



Enter the concrete cover thicknesses:

Select the primary bar direction to either Parallel with longer dimension or
Parallel with shorter dimension.

Primary/Secondary top bars and Primary/Secondary bottom bars tabs
Use the Primary/Secondary top bars and Primary/Secondary bottom bars
tabs to define the bar properties.

Bar properties

Option Description
Grade Strength of the steel used in the

reinforcing bar. This field cooperates
with the Size field.

Size Diameter of the reinforcing bar.
Pressing the ... button right of the
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Option Description
field will open the Select rebar dialog
box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

End conditions left/right Defines the shape of the rebar end.

Default value is Straight.
Bend lengths left/right Defines the length of the left/right

end-extension.
Creation method Number of bars

A fixed number of bars is created. The
spacing between the bars is
automatically calculated.
By spacing

A accompanying field becomes active.
The entered value is the fixed spacing
for the rebars. The number of rebars
is calculated automatically.

Pile caps

Define the pile cap reinforcement using the following properties:

Field Description
To suit pile/column Select Yes to concentrate main

bars over piles and under columns.
% of pile/column
width

The area where the bars are
concentrated, as a percentage of
the width of the pile or column.

For example, if the pile diameter or
width is 500 mm, enter 120 in the
% of pile width field to
concentrate bars in a 600 mm-
wide area over the pile.

Bar portioning (%) The proportion of bars
concentrated over a pile or under a
column.
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Field Description
Bar portioning
(number of bars)

The number of bars concentrated
over a pile or under a column.

Lacer bars tab
Use the Lacer bars tab to create and define lacer bars.

Lacer bars are reinforcing bars that loop around the sides of a concrete
footing.

You can create up to six different groups of lacer bars in a footing. Each group
can contain different values for:

• Grade

• Bar size

• Number of bars

• Spacing

• Shape

• Dimensions

To create lacer bars for a footing:

1. In the Lacer bar option list box, select Yes to create lacer bars.

2. Enter properties for each lacer bar group:

Property Description
Quantity, spacing, and location of
lacer bar groups.

Tekla Structures only uses
information from some of the fields,
in this order of priority:

1. Number of bars and Spacing

2. Number of bars, Start, and End

3. Spacing, Start, and End

Type The number and location of laps. The
options are:
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Property Description
Orientation The options are Default, Front, and

Back.
p1...p4

L1...L4

The exact locations and lengths of
lacer bar laps. Locations are
measured from the corner of the bar
to the midpoints of laps.

The location of the topmost lacer bar,
measured from the end of main
bars.

Entering a value here overrides the
location defined in the End field.

Attributes tab
Use the Attributes tab to define numbering properties of bars.

Option Description
Prefix Prefix for the bar position number.
Start number Start number for the bar position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Pad footing reinforcement (77)
Pad footing reinforcement (77) creates reinforcement for a concrete pad
footing.

Bars created

• Bars in two directions for the bottom surface of the pad footing

• Lacer bars
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Use for

Situation More information
Rectangular footing, 90-degree hooks
at the primary bar ends, 180-degree
hooks at the secondary bar ends, no
lacer bars.

Rectangular footing, three zones of
primary bars with different spacing,
straight bar ends, three lacer bars.

Footing skewed on two sides, two
groups of lacer bars with different
spacing.

Rectangular footings with or without
cut corners, footings that are skewed
on one or both sides

Pad footing and pile cap shapes

Pad footing and pile cap shapes

Use the Pad footing (77) to create reinforcement for the following shapes of
foundations:

Shape Description
Rectangular
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Shape Description
Skewed on two sides

Skewed on one side

Rectangular with cut corners

Before you start

• Create the concrete pad footing.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete pad footing.

Add a pad footing reinforcement using Pad footing reinforcement (77)

1. Create a pad footing.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Enter pad footing in the search box.

4. Select Pad footing reinforcement (77).

5. Select the pad footing.
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Tekla Structures inserts the lacer bar and bottom reinforcement in the
pad footing.

Picture tab
Use the Picture tab to define the conrete cover thickness.

Enter the concrete cover thicknesses on the plane and from the plane.
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Mesh alignment

Option Description
Square mesh Set the alignment of the secondary

bars of the created mesh
perpendicular to the primary bars.

Mesh aligned to both sides Align the primary and secondary bars
to the skewed edges.

Primary/Secondary bar tab
Use Primary/Secondary bar tabs to define the bar properties.

Pad footings

In pad footings, you can arrange the main reinforcing bars into:

• One zone of bars that have the same bar properties
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• Three zones of bars that have different bar properties

You set the options separately for primary and secondary bars. Select an
option from the Arrangement list box.

Hooks

Select to create hooks from Left end hook and Right end hook.

You can create the hooks as custom hooks from dropdown list.

Lacer bar tab
Use the Lacer bar tab to define the lacer bar properties.

Lacer bars are reinforcing bars that loop around the sides of a concrete
footing.

You can create up to six different groups of lacer bars in a footing. Each group
can contain different values for:

• Grade

• Bar size

• Number of bars

• Spacing

• Shape

• Dimensions

To create lacer bars for a footing:

1. Open the footing reinforcement properties dialog box and click the Lacer
bars tab.

2. In the Lacer bar option list box, select Yes to create lacer bars.

3. Enter properties for each lacer bar group:

Property Description
Quantity, spacing, and location of
lacer bar groups.

Tekla Structures only uses
information from some of the fields,
in this order of priority:

1. Number of bars and Spacing

2. Number of bars, Start, and End

3. Spacing, Start, and End
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Property Description
Type The number and location of laps. The

options are:

Orientation The options are Default, Front, and
Back.

p1...p4

L1...L4

The exact locations and lengths of
lacer bar laps. Locations are
measured from the corner of the bar
to the midpoints of laps.

The location of the topmost lacer bar,
measured from the end of main
bars.

Entering a value here overrides the
location defined in the End field.

Attributes tab
Use the Attributes tab to define numbering properties.

Field Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use the Class to group

reinforcement.

For example, you can display
reinforcement of different classes in
different colors.
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Starter bars for pillar (86)
Starter bars for pillar (86) creates starter bars in a footing and a pedestal for
a column. Starter bars may go through a pedestal or straight to the column.
Starter bars can be in a rectangular or circular form.

Bars created

• Starter bars (straight or L-shaped)

• Stirrups (optional)

Use for

Situation More information
Starter bars for pillar (86)
creates straight or L-shaped
starter bars that go through
a rectangular or circular
pedestal. Starter bars can
have stirrups.

Before you start

• Create the footing.

• Calculate the required area of reinforcement.

Selection order

1. Footing

2. Pedestal

Picture tab
Use the Picture tab to define bar dimensions and locations, spacing of bars,
stirrup type, and concrete cover thickness.

Select the shape of the starter bars:

Option Description
L-shaped starter bars.

Define the length of the bar.
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Option Description
Straight starter bars.

L-shaped starter bars.

Define concrete cover thickness.

Select the shape for the top of the starter bars:

Option Description
The top of the starter bars is straight.

Default

The top of the starter bars is bent.

Define the length of the bent part.

Option Description
Number of stirrups/Spacing Define the number of stirrups and

their spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Create corner bars Select to create corner bars.

Default value is Yes.
Select the placement of the corner
bars.

Grade Define the grade of the reinforcing
bar.

Size Define the size of the reinforcing bar.

Concrete components reference 3307 Reinforcement



Option Description
Bending radius Define the bending radius of the

reinforcing bar.

Stirrups

Use these options to define stirrup laps in footings:

Option Description
Laps on the side of the stirrups

45-degree hooks at bar ends

Laps at stirrup corners

135-degree hooks at bar ends

Laps at stirrup corners

90-degree hooks at bar ends

If the starter bars are in a
circular form, you must define
the angle of stirrup overlap.

Parameters tab
Use the Parameters tab to define numbering properties of bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Starter bars for footing (87)
Starter bars for footing (87) creates starter bars in a footing for a column.
Starter bars may go through a pedestal or straight to the column. Starter bars
can be in a rectangular or circular form.
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Bars created

• Starter bars (straight or L-shaped)

• Stirrups (optional)

Use for

Situation More information
Starter bars for footing
(87) places starter bars in a
footing in rectangular or
circular form. Starter bars
can be straight or L-shaped,
and can have stirrups.

Before you start

• Create the footing.

• Calculate the required area of reinforcement.

Selection order

1. Footing

Picture tab
Use the Picture tab to define bar dimensions and locations, number and
spacing of bars, and concrete cover thickness.

Select the shape of the starter bars:

Option Description
L-shaped starter bars.

Define the length of the bar.

Straight starter bars.

L-shaped starter bars.

Define concrete cover thickness.
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Option Description
Number of stirrups/Spacing Define the number of stirrups and

their spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Create corner bars Select to create corner bars.

Default value is Yes.
Select the placement of the corner
bars.

Grade Define the grade of the reinforcing
bar.

Size Define the size of the reinforcing bar.
Bending radius Define the bending radius of the

reinforcing bar.

Bottom cover tab
Use the Bottom cover tab to define bottom cover thickness for bar groups.

Select to set bottom cover thickness from the Same for all list:

Option Discription
Yes Sets the same bottom cover thickness

for all corner and side bars.
No Enter the separate bottom cover

thickness for each bar group.
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Location tab
Use the Location tab to define starter bar location and stirrup type.

Starter bar location

Enter the distance from the center of the bar group to the center of the
footing, in two directions:

Stirrups

Use these options to define stirrup laps in footings:

Option Description
Laps on the side of the stirrups

45-degree hooks at bar ends

Default
Laps at stirrup corners

135-degree hooks at bar ends

Laps at stirrup corners

90-degree hooks at bar ends
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Option Description
If the starter bars are in a
circular form, you must define
the angle of stirrup overlap.

Parameters tab
Use the Parameters tab to define numbering properties of bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Beam, column, and slab reinforcement
Tekla Structures includes the following components that you can use to
automatically create reinforcement for beams, columns, and slabs:

• Detailing manager (page 3313)

• Mesh Bars / Mesh Bars by Area (page 3315)

• Rebar coupler and anchor tools (page 3326)

• Slab bars (18) (page 3339)

• Slab Reinforcement Tool (page 3341)

• Beam reinforcement (63) (page 3345)

• Stirrup reinforcement (67) (page 3351)

• Longitudinal reinforcement (70) (page 3357)

• Beam end reinforcement (79) (page 3360)

• Corbel reinforcement (81) (page 3365)

• Round column reinforcement (82) (page 3371)

• Rectangular column reinforcement (83) (page 3380)

• Hole reinforcement for slabs and walls (84) (page 3393)
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• Hole creation and reinforcement (85) (page 3398)

• Braced girder (88) (page 3401)

• Braced girder (89) (page 3422)

• Reinforcement mesh array in area (89) / Reinforcement mesh array (91)
(page 3442)

• Rectangular area reinforcement (94) (page 3447)

• Wall panel reinforcement / Double wall edge and opening reinforcement
(page 3461)

• Multiple Wire Size Mesh (page 3472)

• Embedded anchors (8) (page 3475)

• Embed (1008) (page 3514)

• Continuous Beam Reinforcement (page 3524)

Detailing manager
Detailing manager is used to apply detailing components into any structure.
With Detailing manager you can define rules to apply multiple components
at one go to detail the structure of a cast unit or the entire model.

You can use selection filters to define detailing rules for automating repetitive
detailing tasks. You can add custom details, extensions or system components
with Detailing manager.

You have three options:

• Use Detailing manager to have a part as input. All parts in the cast unit
are examined and detailed by the set rules.

• Use Detailing manager to have a cast unit as input. All parts in the cast
unit are examined and detailed by the set rules.

• Use Detailing manager to have a component as input, for example, tools
such as Floor layout or Wall layout where the same tool creates multiple
parts. All parts in the component are examined and detailed by the set
rules.

The image below shows an example of Detailing manager. In the example,
the Mesh bars component is created to the outside shell of the cast unit
because it has the class 4 filter selected and there is a selection filter for
objects with class 4.
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Properties

Option Description
Rule Use the rules to define detailing settings.

The maximum number of rules is 25. Click  to
add a new rule. You can rename a rule by double-
clicking the rule tab.

You can remove the content from a rule tab by double-
clicking the rule tab and selecting Clear.

You can remove rule tabs by double-clicking the rule
tab and selecting:

• Close to remove the selected tab.

• Close other tabs to remove other tabs than the
selected tab.

• Close all tabs to remove all tabs. Detailing
manager adds a new empty rule tab.

You can also remove rules by clicking  on a rule tab.
Component Click  to select the component that you want to use

to detail a structure.

Double-click the component in the Applications &
components catalog to add it to the Component box.

Attribute Select the attribute file for the component. If you do
not select a file, the standard file is used.

Component input Define the creation method of the selected
component:

• Part: Select the part to which you are creating the
component.
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Option Description
• Part + one point: Select the part and one

additional point on the part. With this option,
Detailing manager places the center of the object
boundary box to that point.

Use this setting with custom component details.

• Part + two points: Select the part and two
additional points on the part. With this option,
Detailing manager uses the start and the end
point of the part as insertion points.

Filter Select which parts inside the selected cast unit or
component get the selected component. The available
selection filters are listed in the filter list.

You can also create new selection filters. You can use
five selection filters if you want to create an
intersection of the filters.

Create on selected
objects

Detailing manager is created to selected parts, cast
units or components. The rule settings that are
currently set in the Detailing manager dialog box are
used.

Create as • Detailing manager plug-in: Components are
inserted as Detailing manager plug-ins and not as
separate components.

Select this option if you use a component as input.

• Separate components: With this setting, the
inserted components do not have any connection
to Detailing manager.

Mesh Bars / Mesh Bars by Area
Mesh Bars and Mesh bars by area create reinforcement for concrete slabs or
walls.

Objects created

• Primary bars

• Crossing bars
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Use for

Situation Description
Reinforcement for the bottom or the
top surface of the concrete element,
or for both.

Selection order

Component To create mesh bars
Mesh Bars 1. Select a concrete slab.

The reinforcement is created automatically.
Mesh bars by area 1. Select a concrete slab.

2. Select a group of points to define a working
polygon.

The reinforcement is created automatically.

Picture tab
Use the Picture tab to define how the top and bottom bars are created.

Option Description
Create bars Top bars with primary bars

above secondary bars
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Option Description
Top bars with secondary bars
above primary bars

No bars

The same options are available for the bottom bars as well.

The value defined in the box is the cover thickness for the top/
bottom layer.

If you only want to create bars in the middle of the slab, select
the No bars option either for the top or bottom bars, and then
select Yes in the Place central list that appears.

Mesh area
perimeter

This option is only available for Mesh bars by area.

Select the outline that the mesh follows.

The meshes in the examples are created by picking the same
points but with different mesh area perimeters.

Part

Part, for example:

Polygon

Polygon, for example:
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Option Description

Polygon + part

Part + polygon, for example:

Same as
bottom

Select whether the top bars are created using the same
properties as the bottom bars.

If you select No, enter the top bar properties.
Bar type Select whether the bars are created as a bar group or as a

mesh.

Depending on the option you select, some other settings and
options are available. For example:

• If you select the Bar group option:

• You can move, copy, and delete bars using direct
modification.

To move a bar, drag it to a new location.

To copy a bar, hold down Ctrl and drag the bar.

To delete a bar, select it and press Delete.

• You can use the grid, minimum length, Bar grouping,
and Bar behavior at cuts settings on the Detailing tab.

• If you select the Mesh option, bars are always cut by the
cuts in the concrete part.

Size Select the diameter of a bar.

You can set the size separately for the top primary and
secondary bars, and for the bottom primary and secondary
bars.

Grade Define the strength of the steel used in the bars.

You can set the grade separately for the top primary and
secondary bars, and for the bottom primary and secondary
bars.
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Option Description
Spacing
type

Select whether the spacing is based on the number of bars or
on the spacing values.

• By spacings: enter the distance between the bars in the
Spacing box.

• Number of bars: enter the number of bars in the Number
of bars box.

• By exact spacings: list the distances between the bars in
the Spacing box. For example:

200, 200, 50, 50, 50, 100 or

2*200, 3*50, 100
Spacing Distances between the bars.

Tekla Structures calculates the number of bars.

You can set the spacing separately for the top primary and
secondary bars, and for the bottom primary and secondary
bars.

Number of
bars

Number of bars.

Tekla Structures calculates the distance between bars.

You can set the number of bars separately for the top primary
and secondary bars, and for the bottom primary and
secondary bars.

Primary
bars
direction

The direction of the primary bars. Use to change bar direction.

If the Auto option is selected, the primary bars are created
along the two longest parallel sides of a slab. If there are no
parallel sides, then the bars are created along the slab x
direction instead.

Up
direction

Select which sides are regarded as the top and bottom sides of
the slab.

If the Auto option is selected, then the bars are created on the
side with the greatest area.

Detailing tab
Use the Detailing tab to control how the bars are distributed.

Bars that are created as bar groups can be distributed By grid or Without
grid.

Using a grid makes it easier to accurately place bars only at set intervals. When
direct modification is switched on and you move or copy bar group bars, they
snap to the grid.
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Detailing without grid

Option Description
Bar distances Select how the distances between the bars are measured.

• From center of bar

• From edge of bar

Select whether the distances are the same or different for
the top and bottom bars. Using different distances helps in
placing top and bottom bars so that their hooks do not
collide, for example.

Adjustment Select how the bars are distributed.

The same options are available for both the primary and the
secondary bars.

Equal distribution by target
spacing value.

By exact spacing value with
flexible first space without
first bar.

By exact spacing value with
flexible last space without
last bar.

By exact spacing value with
flexible first and last space
without first and last bars.

By exact spacing value with
flexible first space.

By exact spacing value with
flexible last space.
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Option Description
By exact spacing value with
flexible first and last space.

Detailing by grid

The same options are available for both the longitudinal and the crossing bars.

Option Description
Min overhang Minimum extension of the longitudinal or crossing

bars over the outermost bars of the other
direction.

You can set the minimum overhang separately for
the start and end of the bars.

Min spacing Minimum distance between the bars.
Longitudinal grid size

Crossing grid size

Defines the location intervals to which the bar
group bars snap when they are moved or copied
using direct modification.

Other detailing options

Option Description
Minimum
length of
primary bar
to be created

Minimum
length of
secondary bar
to be created

In bar groups, bars that are shorter than this value are not
created.

Bar grouping For bar groups, select whether tapered bars are grouped or
not.

If you group the tapered bars, select how the bars along the
tapered edge are handled.

Tapered bars are handled
normally.
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Option Description
Creates as many bars as
possible with same length at
the tapered edge.

The value you enter is the
maximum allowed
shortening of a bar.

Bar behavior
at cuts

Select how bars next to openings are handled.

• Cut bars: Select whether the bars are cut and which cuts
are ignored.

In bar groups, you can ignore cuts by part name, part
class, or selection filter.

With the Yes, but ignore cuts by filter option, the
Selection filter list only shows the selection filters where
one rule has the object type 11 (polygon cut) and the
other rules have been defined by using the Template
category.

• Ignore openings smaller than: The minimum length of
a cut (in the direction of the bars) that will cut the bars.
Lower values are ignored.

This setting only affects bars that are created as bar
groups. Bars that are created as a mesh are always cut by
the cuts in the concrete part.

• Cover thickness in holes: Distance between the bar
end/start point to the edge of the opening.

• Create cuts around selected parts: Select whether the
bars are cut by the parts that clash with the reinforced
part. The cutting parts are defined by a selection filter.

Bar end conditions tab
Use the Bar end conditions tab to control the cover thickness and bar hooks.

Option Description
Cover
thickness
on sides

• Different each side: Each end of a bar group can have
different distances from part edges.

• Same all sides: All ends of the bar groups have the same
distance from part edge.

Use bar end
conditions
around
holes

Select whether the same bar end conditions are used around
the openings as at part edges.
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Option Description
End
conditions

Creates a straight bar without
a hook at the given end of a
bar.

Creates a 90° hook at a given
end of bar.

Creates a 135° hook at a
given end of bar.

Creates a 180° hook at a
given end of bar.

Creates a hook with a free
angle at the given end of a
bar.

Creates a double bent hook
at the given end of a bar.

Bending
radius

Bending radius at bar ends

Bending
length

Bending length at bar ends

Splicing tab
Use the Splicing tab to control the splicing of the reinforcing bars.

Option Description
Splice bars Select whether the reinforcing bars are spliced or

not.
Manufacturer Select the manufacturer of the reinforcement.

The maximum bar lengths and lap lengths are then
listed by the grade and size of the bar.

If needed, you can modify these splicing definitions
in the MeshBarsSplicing_Manufacturers.dat
file. You can also copy the default file
from ..\ProgramData\Trimble\Tekla
Structures\<version>\environments
\common\system, edit it, and save it to your
project or firm folder.
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Option Description
Maximum length of
bars

Maximum reinforcing bar length after which the
bars are spliced.

Lapping length Length of the lapping connection.
Splicing in same cross
section

Select how many reinforcing bars can be spliced in
the same location.

• 1/1 = all reinforcing bars are spliced in the
same cross section.

• 1/2 = every second reinforcing bar is spliced in
the same cross section.

• 1/3 = every third reinforcing bar is spliced in the
same cross section.

• 1/4 = every fourth reinforcing bar is spliced in
the same cross section.

Splicing symmetry Select the symmetry that is applied when the
reinforcing bars are spliced.

• Not Symmetrical: The splice pattern of the
reinforcing bar is not symmetrical and the
uneven length is only at one side.

• Symmetrical with different lengths at sides:
The splice pattern of the reinforcing bar is
symmetrical with uneven lengths at the sides.

• Symmetrical with different length at center:
The splice pattern of the reinforcing bar is
symmetrical with uneven length in the center.

Splicing offset Offset of the splice center point from the point
where the reinforcing bars originally met.

Minimum splitting
distance

Minimum longitudinal distance between two
splices in consecutive bars.

Splicing type Select the type of the splice.
Bar position Select whether the lapping bars are on top of each

other or parallel to each other.

Attributes tab
Use the Attributes tab to control the bar group or mesh properties, and user-
defined attributes.

Properties

Option Description
Name Name of the bar group or mesh.
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Option Description
Prefix Prefix for the position number of the bar group or

mesh.
Start number Start number for the position number of the bar

group or mesh.
Class Class of the bar group or mesh.

If you create a mesh, only the class of primary bars is
taken into account.

User-defined attributes (UDAs) for reinforcing bars

The UDAs are predefined in the MeshBars.Udas.dat file.

Option Description
Same for all Select Yes to use the UDA for all reinforcing bars.

Select No to define the UDA separately for all
reinforcing bars.

Top bars

Bottom bars

Enter a UDA value for the top and bottom
reinforcing bars.

Customize the Attributes tab

You can customize the content of the user-defined attributes section on the
Attributes tab by using the MeshBars.Udas.dat file. The file can be located
in any of the folders set in the XS_FIRM , XS_PROJECT or XS_SYSTEM
advanced options, and in the model folder.

You can use the file to control which user-defined properties of the created
reinforcement can be used in Mesh Bars and Mesh Bars by Area. We
recommend that you only use UDAs that are typically common for all
reinforcement.

The sample file shown below contains a full description of all the settings and
the format of the file. The lines starting with '//' are comment lines.

//
// Customized user defined attributes (UDA) for layer parts created by 
Mesh Bars component
// 
// Each row shall contain 2 or 3 fields separated by tab(s) or semicolon. 
// Please note that all uda names shall be unique
//
// Field 1: The data type of the attribute. Valid values are 'distance', 
'float', 'option', 'integer' and 'string'
//          compatible with the actual user defined attributes as 
specified in objects.inp
// Field 2: UDA name. This is the name of the user defined attribute.
// Field 3: Label. This text is shown in the attributes dialog. It can be 
a translatable label (albl_) or any text.
//        
string        comment            j_comment
string        USER_FIELD_1        j_user_field_1
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string        USER_FIELD_2        j_user_field_2
string        USER_FIELD_3        j_user_field_3
string        USER_FIELD_4        j_user_field_4

Rebar coupler and anchor tools
Rebar coupler and anchor tools is a set of four components that help to
model and manage

• reinforcing bar couplers that connect two bars

• end anchors that are devices at the unreserved end of the bar.

The following components are part of Rebar coupler and anchor tools:

• Rebar coupler

• Rebar end anchor

• Split rebar and add coupler

• Rebar end trimming

In addition, you can manage the user-defined attributes (UDAs) of the Rebar
coupler and anchor tools with the Update rebar attributes component.

All couplers and end anchors are automatically added to the parent part of the
reinforcing bar. This allows them to be shown in reports and drawings
because they are added to the sub-assembly of the cast unit.

In some cases the reinforcing bars can move outside of the concrete. This may
happen with reinforcing bars that are modeled with two points (straight bars
and straight bars with hooks). If the reinforcing bars move outside of the
concrete, change the cover thickness to either a negative or a positive value
depending on what is required.

Two report templates Rebar Extra Fabrication Length.rpt and Rebar
Thread Length.rpt can be used to inquire Threaded Length and Extra
Fab. Length of the reinforcing bars in the BOMs or BOQs.

Rebar coupler
Rebar coupler creates couplers to connect reinforcing bars, or reinforcement
meshes, whose bar ends are in contact and parallel.

Objects created

• Round parts

The parts are created between two reinforcement objects.
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Use for

Situation Description
Couplers with split reinforcing bars.

Before you start

Couplers can be created between reinforcing bars or reinforcement meshes.
The selected reinforcement objects can be of different type and they can even
have different number of bars. The only requirement is that one or more bar
ends are in contact and parallel. With rebar sets, the couplers can only be
created between spliced bars in that particular rebar set.

Selection order

Reinforcing bars or
reinforcement meshes

1. Select the primary reinforcing bar(s).

2. Select the secondary reinforcing bar(s).
Rebar sets 1. Select a rebar set.

2. Define a location for a splitter by picking two
points.

This splitter will become an input object for
the couplers.

3. Pick a point.

This point defines the side of the primary
reinforcing bar(s). This is needed if you have
applied different properties for the primary
and secondary bar(s).

or

1. Select an existing splitter in a rebar set.

2. Pick a point.

This point defines the side of the primary
reinforcing bar(s). This is needed if you have
applied different properties for the primary
and secondary bar(s).

Couplers are created at each location where

• the bar ends are parallel enough (angle < 5 degree) and
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• the gap along the bar end is less than the length of the coupler and

• the offset perpendicular to the bar end legs is less than the diameter of the
bars

When there is no valid and no parallel end-to-end location between the
selected bars, the component creates a dummy part that identifies the
unsuccessful coupler insertion.

Parameters tab

Use the Parameters tab to define the coupler properties.

Option Description
Use manually entered
values

Enter values for the coupler properties.

Use auto attribute file The values in the auto attribute file override the
coupler component values.

Typically the auto attributes file contains one or
more attribute values to be used with certain bar
sizes.

Go to Tekla Warehouse to get auto attribute files
for your project.

For more information on the structure of the auto
attribute files, see Customize attribute files,
part mapping and user-defined attributes
(UDAs).

Option Description
Use custom component Select Yes to create the coupler as a custom part.

Select No to create the coupler as a normal part.
Name Type the name of the custom component, or

select it from the Applications & components
catalog.

Ensure that the selected component is a custom
part.

Attribute Type the name of the attribute file of the custom
component.

The coupler custom part is created using the
saved attributes given here.

Input points The order of the start and the end points of the
custom component.

Concrete components reference 3328 Reinforcement

https://warehouse.tekla.com/#/search/?searchTerm=RebarCouplerAndAnchorSupplierSettings


Option Description
Numbering series Prefix and a start number for the coupler part

position number.
Attributes Name, diameter, material, finish and class of the

coupler parts.
The overall end-to-end length of the coupler.

If you use a custom part, this is the length
between the start point and the end point of the
custom part.

This is also the maximum gap between the bar
ends. If the gap is bigger than the length of the
coupler, the coupler cannot be inserted.

When you create the couplers as custom parts, the properties in the
Numbering series and Attributes sections can be filled from the custom part
settings if you have named the properties in a certain way.

Attributes tab

Use the Attributes tab to define the user-defined attributes (UDAs).

Option Description
Threaded length The value is written to the reinforcing bar UDA.

The fields are used for checking which bars have
threads and what are the thread values so that they
can be shown in drawings and reports.

Extra fabrication
length

This value is written to the reinforcing bar UDA.

This value does not affect the length of the
reinforcing bar. You need to add this value in your
drawings and reports to get the correct length if
required.

Method

Type

Product

Code

UDAs written to the reinforcing bars.

You can set the reinforcing bar end method and the
coupler type, and add a product name and a code for
reporting purposes.

The used attribute name depends on which end of
the reinforcing bar the coupler was created to.

NOTE The above user-defined attributes affect numbering. Reinforcing bars
with different attribute values get different part marks.

Rebar end anchor
Rebar end anchor creates end anchors at the ends of reinforcing bars or
reinforcement meshes.

Concrete components reference 3329 Reinforcement



Objects created

• Round parts

The parts are created at reinforcing bar ends.

Use for

Situation Description
Reinforcing bars with end anchors.

Selection order

Reinforcing bars or
reinforcement meshes

1. Select the reinforcing bar(s).

2. Pick any point close to the bar end where you
want to create the end anchors.

Rebar set bars 1. Select a rebar set.

2. Define a location where to add an end detail
modifier by picking two points.

This end detail modifier will become an input
object for the end anchors.

or

1. Select an existing end detail modifier in a
rebar set.

Parameters tab

Use the Parameters tab to define the end anchor properties.

Option Description
Use manually entered
values

Enter values for the end anchor properties.

Use auto attribute file The values in the auto attribute file override the
end anchor component values.

Typically the auto attributes file contains one or
more attribute values to be used with certain bar
sizes.
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Option Description
Go to Tekla Warehouse to get auto attribute files
for your project.

For more information on the structure of the auto
attribute files, see Customize attribute files,
part mapping and user-defined attributes
(UDAs).

Option Description
Use custom component Select Yes to create the end anchor as a

custom part.

Select No to create the end anchor as a normal
part.

Name Type the name of the custom component, or
select it from the Applications & components
catalog.

Ensure that the selected component is a
custom part.

Attribute Type the name of the attribute file of the
custom component.

The end anchor custom part is created using
the saved attributes given here.

Input points The order of the start and the end points of the
custom component.

Option Description
Numbering series Prefix and a start number for the end anchor

part position number.
Attributes Name, diameter, material, finish and class of

the end anchor parts.
The dimensions of the end anchor.

If you use a custom part, define the length
between the start point and the end point of
the custom part using these values.

The offset of the far most point of the coupler
measured from the physical end of the
reinforcing bar.

Note that you cannot control the end of the
reinforcing bar with this component. You need
to make sure the end concrete cover of the
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Option Description
reinforcing bar is greater or equal to this
offset plus the minimum concrete cover.

When you create the end anchors as custom parts, the properties in the
Numbering series and Attributes sections can be filled from the custom part
settings if you have named the properties in a certain way. For an example,
see Customize attribute files, part mapping and user-defined attributes
(UDAs).

Attributes tab

Use the Attributes tab to define the user-defined attributes (UDAs).

Option Description
Threaded length The value is written to the reinforcing bar UDA.

The fields are used for checking which bars have
threads and what are the thread values so that they
can be shown in drawings and reports.

Extra fabrication
length

This value is written to the reinforcing bar UDA.

This value does not affect the length of the
reinforcing bar. You need to add this value in your
drawings and reports to get the correct length if
required.

Method

Type

Product

Code

UDAs written to the reinforcing bars.

You can set the reinforcing bar end method and the
coupler type, and add a product name and a code for
reporting purposes.

The used attribute name depends on which end of
the reinforcing bar the coupler was created to.

NOTE The above user-defined attributes affect numbering. Reinforcing bars
with different attribute values get different part marks.

Split rebar and add coupler
Split rebar and add coupler splits a reinforcing bar group and adds couplers
in relation to the direction of the picked points.

Objects created

• Round parts

The parts are connected between two reinforcing bar groups.
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Use for

Situation Description
Staggered couplers with split
reinforcing bars.

Selection order

1. Double-click Split rebar and add coupler to open the component
properties.

2. Click Split rebar with coupler.

3. Select the reinforcing bar or bar group to be split.

4. Pick the first split point.

5. Pick the second split point.

This point defines the line at which the reinforcing bar or bar group is split
and couplers are inserted.

6. Pick the third point.

This point defines the side of the main reinforcing bar or bar group. This is
needed if you have applied different properties for the first bar or group
and the second bar or group.

7. Repeat the steps 3 - 6, or press Esc to cancel picking.

Parameters tab

Use the Parameters tab to define the coupler properties.

Option Description
Use manually entered
values

Enter values for the coupler properties.

Use auto attribute file The values in the auto attribute file override the
coupler component values.

Typically the auto attributes file contains one or
more attribute values to be used with certain bar
sizes.
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Option Description
Go to Tekla Warehouse to get auto attribute files
for your project.

For more information on the structure of the auto
attribute files, see Customize attribute files,
part mapping and user-defined attributes
(UDAs).

Option Description
Use custom component Select Yes to create the coupler as a custom

part.

Select No to create the coupler as a normal
part.

Name Type the name of the custom component, or
select it from the Applications & components
catalog.

Ensure that the selected component is a
custom part.

Attribute Type the name of the attribute file of the
custom component.

The coupler custom part is created using the
saved attributes given here.

Input points The order of the start and the end points of the
custom component.

Option Description
Numbering series Prefix and a start number for the coupler part

position number.
Attributes Name, diameter, material, finish and class of

the coupler parts.
Staggered type • None

Couplers are placed along the two picked
points.

• Left

Couplers are placed to the left side of the
two picked points.

• Right

Couplers are placed to the right side of the
two picked points.
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Option Description
• Middle

Couplers are placed on both sides of the
two picked points.

The overall end-to-end length of the coupler.

If you use a custom part, this is the length
between the start point and end the point of
the custom part.

This is also the maximum gap between the bar
ends. If the gap is bigger than the length of
the coupler, the coupler cannot be inserted.

Coupler position Location of the couplers in relation to the
selected split line.

If you select the Left or the Right option, the
actual left or right depends on the third input
point which defines the side of the first bar.

This option is available only when there is no
staggering.

Example:

When you create the couplers as custom parts, the properties in the
Numbering series and Attributes sections can be filled from the custom part
settings if you have named the properties in a certain way. For an example,
see Customize attribute files, part mapping and user-defined attributes
(UDAs).

Attributes tab

Use the Attributes tab to define the user-defined attributes (UDAs).

Option Description
Threaded length The value is written to the reinforcing bar UDA.

The fields are used for checking which bars have
threads and what are the thread values so that they
can be shown in drawings and reports.
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Option Description
Extra fabrication
length

This value is written to the reinforcing bar UDA.

This value does not affect the length of the
reinforcing bar. You need to add this value in your
drawings and reports to get the correct length if
required.

Method

Type

Product

Code

UDAs written to the reinforcing bars.

You can set the reinforcing bar end method and the
coupler type, and add a product name and a code for
reporting purposes.

The used attribute name depends on which end of
the reinforcing bar the coupler was created to.

NOTE The above user-defined attributes affect numbering. Reinforcing bars
with different attribute values get different part marks.

Rebar end trimming
Rebar end trimming adjusts the space between two reinforcing bar ends.

Use for

Situation Description
Space between reinforcing bar
ends.

Selection order

1. Select the couplers you want to modify.

2. Modify the properties.

3. Click Apply to selected couplers.

OR

1. Modify the properties.

2. Click Select rebars.

3. Select the reinforcing bars whose ends are adjusted according to the
value set for the gap.
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Rebar coupler/Rebar end anchor tab

Option Description
Get free gap from auto
attributes file

Select Yes if you want to use the gap defined in
the Auto attribute file for the couplers. When
you select Yes, only the coupler components that
have the Use auto attribute file in use are
adjusted.

See Customize attribute files, part mapping
and user-defined attributes (UDAs).

Select No if you want to manually enter the free
gap.
The gap when Get free gap from auto
attributes file is set to No.

Trim both bars Select which of the reinforcing bars is modified.
Apply to selected
couplers

Select the couplers you want to modify and click
the Apply to selected couplers button to adjust
the bars according to the value set for the gap.

Select rebars Click the Select rebars button and select the
reinforcing bars whose ends you want to adjust
according to the value set for the gap.

The reinforcing bar ends need to be close to
each other.

Update rebar attributes
Use Update rebar attributes to manage the user-defined attributes (UDAs) of
the couplers and the end anchor parts created by the Rebar Coupler and
Anchor Tools. With Update rebar attributes you can check the current
values of the selected reinforcing bars or all reinforcing bars.

If you have added coupler or end anchor components to reinforcing bars, the
UDA values are controlled by the coupler or the end anchor components and
their properties. If you delete the coupler or the end anchor component, the
UDAs defined by those components are not cleared automatically. Use
Update rebar attributes to clear the obsolete attribute values.

Option Description
Selected The values of all coupler and end anchor UDAs of the

selected reinforcing bars in the model.
All The values of all coupler and end anchor UDAs of all

reinforcing bars in the model.
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Option Description
Update Deletes the values of all coupler and end anchor

UDAs of all reinforcing bars on the selected rows.

Only the obsolete coupler UDAs of the reinforcing bar
are deleted.

You can select multiple rows by holding down Ctrl or
Shift.

Update (phase only) Updates the phase values of the coupler and end
anchor parts so that the phase values are the same as
the phase values of the related reinforcing bars.

Show only rebar
with attributes

Select this check box if you want to show only
reinforcing bars that have values in their coupler or
end anchor UDAs.

After you have selected the check box, click Selected
or All to refresh the table.

Customize attribute files, part mapping and user-defined attributes (UDAs)

Auto attribute files

The attribute table files are text files that can locate in any of the system
folders, or in a model folder. You can have as many attribute table files as you
need. There are different attribute tables for end anchors (one input
reinforcing bar) and coupler components (two input reinforcing bars). The
extensions for attribute table files are

• .couplers.csv for Rebar coupler and Split rebar and add coupler
components

• .anchors.csv for Rebar end anchor component.

The attribute table contains a header line, including the column names and
one or more table rows containing the attribute values. Columns are either
selector columns or attribute columns.

The selector column names are Primary.Size, Primary.Grade, 
Secondary.Size, and Secondary.Grade.

The attribute columns contain the attribute value that is the name given in the
header row. The component attribute values given in the table row are used
whenever the component input (primary + secondary for Rebar coupler and
secondary for Rebar end anchor) matches with the selector values.

Go to Tekla Warehouse to get auto attribute files for your project.

Custom part mapping

When you create the coupler or the end anchors as custom parts, the
properties in the Numbering series and Attributes sections can be filled
from the custom part settings if you have named the properties in a certain
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way. The following example shows the mapping between the Numbering
series and Attributes properties and the custom part properties.

User-defined attributes (UDAs)

You can customize the content of the Attributes tab and the UDAs in the
Rebar Coupler and Anchor Tools components.

The UDAs are defined in a text file named RebarCoupler.Udas.dat, located
in the ...\ProgramData\Trimble\Tekla Structures\<version>
\Environments\Common\system folder. The file can also be placed in some
other system folder or in a firm folder. Note that the file is not read from the
model folder.

The RebarCoupler.Udas.dat file only defines which UDAs are shown on the
Attributes tab. If you modify the file, include only existing UDAs to the file. If
you want to create new UDAs, ensure that you define them properly.

NOTE The UDAs affect numbering if the UDAs' special numbering flag
(special_flag) is set to yes in the objects_couplers.inp file.
Reinforcing bars with different UDA values will then get different part
marks.

Slab bars (18)
Slab bars creates reinforcement for a concrete slab.

NOTE Alternatively, you can use the Mesh Bars and the Mesh Bars by Area
components to create reinforcement to concrete slabs or walls.

See Mesh Bars / Mesh Bars by Area (page 3315).

Bars created

• Primary slab bars

• Crossing slab bars
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Use for

Situation More information
Slab bars (18) creates reinforcement for
the bottom or top surface of the slab, or
for both.

Before you start

• Create the concrete slab.

• Calculate the required area of reinforcement.

Selection order

1. select the concrete slab.

Picture tab
Use the Picture tab to define concrete cover thickness, which bars to create
(bottom/top/both), primary bar direction, and which sides are regarded as top
and bottom sides.

Field Description
Create bars Defines on which surface(s) to create bars. The

options are:

• Both sides

• Bottom side

• Top side
Primary bar
direction

The direction of primary bars. Use to change bar
direction. The options are:

• Use slab x direction
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Field Description
• Use slab y direction

• Use global x direction

• Use global y direction
Up direction Defines which sides are regarded as the top and

bottom sides of the slab.

Bottom bars/Top bars tab
Use the Bottom bars and Top bars tabs to define grade, size, spacing, and
generation type of bottom/top bars, concrete cover thickness on slab sides,
crossing bar location in relation to primary bars, end hooks and bend lengths.

Field Description
Bar generation
type

Defines whether Tekla Structures treats the bars
as a group or a mesh.

Cross bar
location

Defines whether the crossing bars are located
above or below the primary bars.

End conditions The hook angles at bar ends. The options are
Straight, 90, 135, and 180 degrees.

Bend lengths The bend lengths at bar ends.

Attributes tab
Use the Attributes tab to define numbering properties, name, and class of
bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Slab Reinforcement Tool
Slab Reinforcement Tool creates reinforcement to irregularly shaped
concrete slabs. The reinforcement is created as reinforcing bar groups. It is
also possible to splice the reinforcing bars.
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Objects created

• Reinforcement

Use for

Situation Description
Slab with reinforcement

Before you start

Create a slab.

Selection order

1. Select the main part (slab).

2. Pick points to define the direction of the reinforcing bars.

3. If the area to be reinforced is set to By polygon, pick the polygon points
to define the reinforced area.

Parameters tab
Use the Parameters tab to control the reinforcement properties, cover
thickness, and reinforcing bar spacing and area.

Reinforcing bars

Option Description
Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Name Define the name for the reinforcing bars.

Tekla Structures uses the name in drawing and reports.
Size Define the diameter of the reinforcing bar.
Grade Define the strength of the steel used in the reinforcing

bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.
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Cover thickness

Option Description
Cover thickness Define the concrete cover thickness on the different

sides of the slab.
Depth Define the concrete cover, either from the top or from

the bottom of the slab.
Depth value Define the depth value for concrete cover thickness.

Spacing and area

Option Description
Spacing Method Define the reinforcing bar spacing method.
Number of Bars Define the number of reinforcing bars in a

reinforcement.
Spacing Define the space between the reinforcing bars.
Adjustment Define how the reinforcing bars are placed in the slab.

The placing is based on the slab width and the cover
thickness at sides.

• Target spacing: The reinforcing bars are placed at
even spacing.

• Exact spacing cover at left/right side: The
reinforcing bars are placed starting from the left/
right side.

• Exact spacing centered both covers: The
reinforcing bars are centered and at equal distance
from the sides.

Area to be
Reinforced

Define the area to be reinforced in the slab.

• By part perimeter: The reinforcing bars are
created in the whole area of the slab.

• By polygon: The reinforcing bars are created to a
picked polygon shaped area in the slab.

Advanced tab
Use the Advanced tab to control the reinforcing bar end hooks, splicing, and
opening properties.
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Bar Ends

Option Description
Start/End Define the type of the hooks to be used at

the reinforcing bar ends.

If you select Custom Hook, you can define a
custom hook’s Angle, Radius and Length.

Angle Define the hook angle by entering a value
between –180 and +180 degrees.

Radius Define the internal bending radius of the
hook.

Length Define the length of the straight part of the
hook.

Splicing

Option Description
Splice Bars Define whether the reinforcing bars are

spliced or not.
Maximum Length of Bar Define the maximum reinforcing bar length

after which the bars are spliced.
Splicing in Same Cross
Section

Define how many reinforcing bars can be
spliced in the same location.

• 1/1 = all reinforcing bars are spliced in the
same cross section.

• 1/2 = every second reinforcing bar is
spliced in the same cross section.

• 1/3 = every third reinforcing bar is spliced
in the same cross section.

• 1/4 = every fourth reinforcing bar is spliced
in the same cross section.

Splicing Symmetry Define the symmetry that is applied when the
reinforcing bars are spliced.

• Not Symmetrical: The splice pattern of
the reinforcing bar is not symmetrical and
the uneven length is only at one side.

• Symmetrical with different lengths at
sides: The splice pattern of the reinforcing
bar is symmetrical with uneven lengths at
the sides.

• Symmetrical with different length at
center: The splice pattern of the
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Option Description
reinforcing bar is symmetrical with uneven
length in the center.

Splicing Offset Define the offset of the splice center point
from the point where the reinforcing bars
originally met.

Minimum splitting distance Define the minimum longitudinal distance
between two splices in consecutive bars.

Splicing Type Define the type of the splice.
Lapping Length Define the length of the lapping connection.

Openings

Option Description
Cut Bars at Opening Define whether reinforcing bars are cut in slab

openings.
Cover thickness for
openings

Define the concrete cover thickness on the sides
of the openings.

Minimum Size of Large
Opening

Define the minimum size of an opening that is
considered to be large.

This field is available if you set Cut Bars at
Opening to At Large Opening Only.

Beam reinforcement (63)
Beam reinforcement (63) creates reinforcement for a concrete beam.

Bars created

• Longitudinal main bars

• Corner and side bars

• Main stirrups

• Stirrups for one or two ledges

Use for

Situation More information
Rectangular beams
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Situation More information
L-shaped beams (RCL profiles)

RCX profiles

Inverted T-beams (RCDL profiles)

Before you start

• Create the concrete beam.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete beam.

The reinforcement is created automatically when you select the beam.

Parameters tab
Use the Parameters tab to define the concrete cover thickness, number, size,
and location of the bars, and stirrup size.
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 Description
1 Cover thickness
2 Distance between bars
3 Main stirrup size
4 Corner and side bar size
5 Ledge stirrup size
6 Main bars number and sizes
7 Sidebar spacing, based on maximum target spacing

Bottom main bars

Select how the bottom main bars are positioned: inside the main stirrups or
distributed to the ledges. You can select the position when the bottom main
bars have the same height as at least one of the ledges.

Placing of top and bottom bars

Select the horizontal placing for the top and bottom bars. Select whether the
bars are placed starting from the corner or at equal spaces.

Concrete components reference 3347 Reinforcement



Option Description
At equal spaces

From the corner

Bending direction

Option Description
Type 1

Type 2

Type 3

Type 4

Stirrup shape

Option Description
90-degree

135-degree

Overlapped

Additional links

Option Description
No additional links.
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Option Description
Create additional internal links.

Create additional links.

Select whether links are created always or depending on the profile size from
the Create links list.

If you select If profile size >, enter the minimum profile length.

Hooks tab
Use the Hooks tab to create hooks and define their properties.

Define the hook type and bar end cover separately for the start and end of the
rows.

Option Description
No hook

Standard 90-degree hook

Standard 135-degree hook

Standard 180-degree hook

Custom hook

If you select a standard hook, the Angle, Radius, and Length use predefined
dimensions.

Option Description
Angle Enter a value between -180 and +180

degrees.
Radius Enter the internal bending radius of

the hook.
Length Enter the length of the straight part.

Stirrup spacing tab
Use the Stirrup spacing tab to define whether stirrups are created as one
group or as separate groups, and to define stirrup spacing.
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Stirrup spacing

Define the distances from the part ends to the first stirrups.

Option Description
N Number of stirrups.
Space Define the spacing of stirrups.

Use a space to separate spacing
values. Enter a value for each space
between the stirrups. For example, if
there are 3 stirrups, enter 2 values.

Main stirrup spacing type and Ledge Stirrup Spacing Type

Define how the main stirrups and ledge stirrups are distributed along the
length of the beam.

Option Description
Target Tekla Structures creates equal spaces

between the bars, aiming the spacing
value as closely as possible to the
value you specify. This is the default
option.

Exact The first and last space of a zone
adjust themselves to even out bar
distribution. The spaces in the middle
of each zone are exactly the size you
specify.

Advanced tab
Use the Advanced tab to define the naming and numbering properties of bars
and stirrups.

Option Description
Name Tekla Structures uses the name in

drawings and reports.
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Option Description
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Prefix Prefix for the bar position number.
Start number Start number for the bar position

number.

Stirrup reinforcement (67)
Stirrup reinforcement (67) creates stirrup reinforcement for a beam, a panel,
or a rectangular slab.

Reinforcement created

• Main stirrups

• Hooks (Optional)
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Use for

Situation More information
A concrete beam with
main stirrups.

Before you start

• Create the concrete part.

• Calculate the required area of reinforcement.

Parameters tab
Use the Parameters tab to define stirrup properties.

Reinforcing bar

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Size Diameter of the reinforcing bar.
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Option Description
Grade Strength of the steel used in the

reinforcing bars.
Bending radius Internal radius of the bends in the

bar.

You can enter a separate value for
each bar bend. Separate the values
with spaces.

Bending radius complies with the
design code you are using. Main bars,
stirrups, ties, and hooks usually have
their own minimum internal bending
radii, which are proportional to the
diameter of the reinforcing bar. The
actual bending radius is normally
chosen to suit the size of the
mandrels on the bar-bending
machine.

Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Hook type

Define the hook type separately for the start and end of the part. The options
are:

Option Description
No hook

Standard 90-degree hook

Standard 135-degree hook

Standard 180-degree hook

Custom hook

If you select a standard hook, the Angle, Radius, and Length use predefined
dimensions.

Option Description
Angle Enter a value between -180 and +180

degrees.
Radius Enter the internal bending radius of

the hook.
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Option Description
Length Enter the length of the straight part.
Stirrup shape Select the shape of the stirrups. The

options are Open, Closed, and Spiral.
Number of rounds, N* If you select the stirrup shape Spiral,

enter the number of rounds the
spiraled stirrup has.

Cover thickness

Define whether the concrete cover thickness is same or different on each side
from Concrete cover dropdown list.

If you select a different concrete cover for each side, enter the separate cover
thicknesses.

Rotation

Rotate the polygon of the rebar shape from the First stirrup and the Second
stirrup. You can rotate the polygon either at each even or odd position.

Stirrup spacing tab
Use the Stirrup spacing tab to define the spacing of stirrups.

You can define six zones for the distribution.

Option Description
Symmetric Define whether the same spacing and

bundling properties are used at the
start and end of the part.

N Number of stirrups.
Space Define the spacing of stirrups.

Use a space to separate spacing
values. Enter a value for each space
between the stirrups. For example, if
there are 3 stirrups, enter 2 values.
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Option Description
Bundling Select whether to have single or

double main stirrups.

Single stirrups: 

Bundled stirrups: 
Min hole size Define a size limit for the holes.
Stirrup spacing type Target

Tekla Structures creates equal spaces
between the bars, aiming the spacing
value as closely as possible to the
value you specify. This is the default
option.
Exact

The first and last space of a zone
adjust themselves to even out bar
distribution. The spaces in the middle
of each zone are exactly the size you
specify.

Holes and recesses tab
Use the Holes and recesses tab to define how reinforcement is created
around openings.

Bar behavior at holes and recesses

Select how the bars next to holes and recesses are handled.

Option Description
Cut bars Select whether the bars are cut and which

cuts are ignored.

You can select to ignore cuts by part name
or class. If you ignore cuts by name, define
the name. If you ignore cuts by class, define
the class.
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Cover thickness

 Description
1 Define the cover thickness of the opening to control where the

first full height stirrup is placed.
2 Define the minimum hole size.

Reinforcement around opening

Option Description
No reinforcement around the
opening.

Reinforcement is created around the
opening.

Reinforcement position

If you create reinforcement around the opening, select how the reinforcement
is positioned.
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Longitudinal reinforcement (70)
Longitudinal reinforcement (70) creates longitudinal reinforcing bars to
concrete parts.

Objects created

• Main bars

• Hooks (Optional)

Use for

Situation Description
Concrete slab
with
longitudinal
main bars and
standard
hooks.

Before you start

• Create the concrete part.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete part.
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Parameters tab
Use the Parameters tab to define the longitudinal bars properties and
spacing.

Properties

Option Description
Prefix Prefix for the part position number.
Start No Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Size Diameter of the reinforcing bar.
Grade Strength of the steel used in the

reinforcing bars.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Concrete cover thickness

If the part has a cut, enter the concrete cover thicknesses at cut positions.

Enter the concrete cover thicknesses on the plane and from the plane.

Enter the concrete cover thickness at the start and end of the bars.
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Spacing

Option Description
Spacing Define the spacing of reinforcement

bars.

Use a space to separate spacing
values. Enter a value for each space
between the bars. For example, if
there are 3 bars, enter 2 values.

Number of bars Enter the number of reinforcing bars.

Select the location of reinforcing bars from the list. The default is that the bars
are on both sides.

Hooks tab
Use the Hooks tab to create hooks and define their properties.

Hook type

Define the hook type separately for the start and end of the part. The options
are:

Option Description
No hook

Standard 90-degree hook

Standard 135-degree hook

Standard 180-degree hook

Custom hook
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If you select a standard hook, the Angle, Radius, and Length use predefined
dimensions.

Option Description
Angle Enter a value between -180 and +180

degrees.
Radius Enter the internal bending radius of

the hook.
Length Enter the length of the straight part.

Select the direction of hooks from the Direction list.

Select to create the hooks for split rebars from the Hooks for split rebars list.

Beam end reinforcement (79)
Beam end reinforcement (79) creates reinforcement for the end of a
concrete beam or strip footing.

Bars created

• Horizontal U-shaped bars (types 1 and 2)

• Vertical U-shaped bars (types 3A and 3B)

• Oblique bar (type 4)

• Stirrups (types 5A and 5B)

 Description
1 Horizontal U bars (type 2)
2 Horizontal U bars (type 1)
3 Oblique bar (type 4)
4 Vertical U bars (type 3A)
5 Stirrups (type 5A)
6 Vertical U bars (type 3B)
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 Description
7 Stirrups (type 5B)

Use for

Situation More information
Standard beams Use bars 3A and 5A for the beam end.
Dapped beams  
Beams with anchor bolt hole in the
notched area

 

Beams and strip footings that have a
rectangular cross section

 

Do not use for

Parts that have irregular cross sections.

Before you start

• Create the concrete beam or strip footing.

• Calculate the required area of reinforcement.

Picking order

1. Select concrete beam or strip footing.

2. Pick position.

Picture tab
Use the Picture tab to define concrete cover thickness, distances from the
concrete surface to the bars, and angle of bar 4.
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Bars tab
Use the Bars tab to define which bars to create, bar dimensions, and to slice
bars 3A and 3B.

Horizontal U bars 1 and 2

Use the following options to create bars in the lower area of the beam end, in
the horizontal planes (bar type 1):

Option Description
Two bars on each plane.
One in the middle of the
beam end, the other
extending to the sides of
the beam.
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Option Description
One bar on each plane,
extending to the sides of
the beam.

One bar on each plane, in
the middle of the beam
end.

Two identical, overlapping
bars on each plane.

To create bars in the upper area of the beam end, around a hole, enter
dimensions for bar 2.

Vertical U bars 3A and 3B

To create vertical U-shaped bars, enter dimensions for:

• Bar 3A: for the notched area of the beam.

• Bar 3B: for the higher part of the beam.

Splicing bars 3

You can create vertical U bars (bar type 3) of two bars joined with a splice. To
do this, use the following list box on the Bars tab:

If you choose to splice bars, you can select the splice type:
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Option Description
Lap up Creates a lap splice above the horizontal

center line of the beam end.
Lap down Creates a lap splice below the horizontal

center line of the beam end.
Lap both Creates a lap splice centered to the

horizontal center line of the beam end.
Coupler Creates a coupler.
Weld joint Creates a welded joint.

For lap splices, you can define the lap length L and whether the bars are on
top of each other or parallel to each other.

For all splice types, you can define the offset of the splice center point from
the horizontal center line of the beam end.

Stirrups 5A and 5B

To create stirrups for beam ends, enter dimensions for:

• Bar 5A: for the notched area of the beam.

• Bar 5B: for the higher part of the beam.

Groups tab
Use the Groups tab to define grouping properties of bars.

Enter the number and spacing of bars in each group of bar types. If the
spacing varies, enter each value individually.

Attributes tab
Use the Attributes tab to define bar properties.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Define the name for the reinforcing

bars.

Tekla Structures uses the name in
drawings and reports.
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Option Description
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Corbel reinforcement (81)
Corbel reinforcement (81) creates reinforcement for one or two corbels in a
concrete column. The two corbels must have the same top level, thickness,
and horizontal location.

Objects created

• Main bars

• Stirrups

• Additional bars

Use for

Situation Description
Two corbels, beveled and
rounded, with the same top
level, thickness, and
horizontal location.

Two additional bars crossing
each other.
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Situation Description
One straight corbel.

One additional bar.

Limitations

Do not use Corbel reinforcement (81) for two very different corbels.

Before you start

• Create the concrete column and beams.

• Create the corbels. Use Corbel connection (14) or a seating connection to
create the corbels.

Selection order

1. Select the main part (concrete column).

2. Select the secondary parts (one or more corbels).

3. Click the middle mouse button to create the reinforcement.

Main bars tab
Use the Main bars tab to control the main bar length, concrete cover
thickness, reinforcing bar spacing, and reinforcing bar properties.
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 Description
1 Main bar length.
2 Distance from the concrete surface to the main bar.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Name Define a name for the main bars.

Tekla Structures uses the name in
drawings and reports.

Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position

number.

Cover thickness
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 Description
1 Concrete cover thickness.
2 Number of bars in the reinforcement.
3 Space between the reinforcing bars.

Stirrups/Transverse stirrups/Diagonal stirrups tab
Use the Stirrups, Transverse stirrups and Diagonal stirrups tabs to control
the stirrup creation, stirrup type, concrete cover thickness, reinforcing bar
spacing and properties.

Stirrups

Define the distance from the concrete surface to the stirrups.

Option Option Option

Concrete cover thickness

Define the concrete cover thickness. You can select that the concrete cover is
the same at each side.

Option Option Option

Option Description
Number of
bars

Define the number of bars in the reinforcement.

Spacing values Define the space between the reinforcing bars.
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Option Description
Transverse
stirrups in
column

Select whether the column is reinforced with
transverse stirrups.

Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and
reports.

Size Diameter of the reinforcing bar.
Grade Strength of the steel used in the reinforcing bars.
Class Use Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position number.

Stirrup type

Option Description
The stirrup consists of a bent single reinforcing bar.

Define the hook length.

The default values (for the standard 90 degree stirrup
hook) are read from the rebar_database.inp file.

Select a suitable overlap position for this stirrup type.
The stirrup consist of two overlapping U bars that face
each other.

Define minimum and maximum overlapping length.

The stirrup consists of two overlapping U bars.

Define minimum and maximum overlapping length.

Additional bars tab
Use the Additional bars tab to control the creation of additional bars in
corbels, concrete cover thickness, and additional bar properties.
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Additional bars

Option Description
No additional bars.

One additional bar.

Two additional bars parallel to each other.

Two additional bars crossing each other.

Two pairs of additional bars crossing each
other.

Stirrups and cover thickness

Define the distance from the concrete surface to the stirrups and the
additional bar dimension.

Define the concrete cover thickness.
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Option Description
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the reinforcing bar.
Name Define a name for the additional bars.

Tekla Structures uses the name in drawings and
reports.

Class Use Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position number.

Round column reinforcement (82)
Round column reinforcement (82) creates reinforcement for a concrete
column that has a round cross section.

Objects created

• Longitudinal main bars (6)

• Stirrups

• Column end reinforcement

Use for

Situation Description
Round concrete column with main
bars bent outside the column.
Continuous spiral stirrup.
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Situation Description
Round concrete column with straight
main bars protruding from the
column, or entirely inside the column.
Separate stirrups. Top of the column
is reinforced.

Limitations

Do not use for rectangular columns.

Selection order

1. Select the main part (column).

The component is created automatically when the part is selected.
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Part identification key

 Part
1 Main bars
2 Stirrups
3 Column end reinforcement
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Main bars tab
Use the Main bars tab to control the length of the vertical and horizontal
extensions of the main bars at the top and bottom of the column, the
thickness of the concrete cover over stirrups, and the cranking of the main
bars.

Main bar properties

Option Description
Number of bars Number of main bars.
Rotation Rotation of main bars.
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the main bars.
Bending radius Bending radius of the main bars.
Class Use Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Name for the main bars.

Tekla Structures uses the name in drawings and reports.
Prefix Prefix for the part position number.
Start number Start number for the part position number.

Hooks at top / bottom

Option Description
Type Select the hook angle.
Length Length of the hook.
Bending radius Bending radius of the hook.

Cranking

You can create cranked reinforcing bars at the top and at the bottom of the
column. Enter the vertical and sloped distance dimensions.
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Enter the horizontal dimensions of top and bottom cranked bar as distance
between center of bars or as outer distance of bars:

Stirrups tab
Use the Stirrups tab to control the thickness of the concrete cover over the
stirrups at the top and bottom of the column, spacing and number of stirrups
or laps in each stirrup group, stirrup types and stirrup shapes.
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Stirrup dimensions

1. Thickness of the concrete cover over the stirrups at the top and the
bottom of the column. The default cover thickness is 50 mm.

Group 1 is the top stirrup group, 5 is the bottom stirrup group. Group 3 is
always created.

2. Spacing of stirrups in each stirrup group.

3. Number of stirrups in each stirrup group.

4. Select how the stirrups are distributed.

• Exact space, flexible at ends: Tekla Structures uses exactly the
spacing value you specify, and evens out the stirrup distribution at the
column ends.

• Target space: Tekla Structures creates the stirrups at even spacings
and tries to use the spacing value you specify.

Stirrup types

Option Description
Separate stirrups

Single, continuous spiral stirrup

Separate spiral stirrups
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Option Description
Single, continuous stirrup

Stirrup shape

Select the shape of the stirrup from the list.

Stirrup overlap

Select the angle or the length of stirrup overlap. The option is not active if you
have created spiral stirrups.

The overlapping angle can be of maximum 180 degrees.

The overlapping length can be in millimeters or inches.

Stirrup attributes tab
Use the Stirrup attributes tab to control the grade, size, class, name, and
numbering properties of the stirrups.

Stirrup properties

Option Description
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the stirrups.
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Option Description
Name Name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position number.

Top tab
Use the Top tab to control the thickness of the concrete cover of the top
reinforcement, the number of top bars, and their spacing and rotation.

Column top reinforcement

1. Define the concrete cover thickness.

2. Define the length of the ultimate leg.

Column top reinforcement rotation

Select how to rotate the reinforcement at the top of columns.

Column top reinforcement properties

Option Description
Number of bars Number of top bars.
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the top bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.
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Option Description
Name Name for the top bars.

Tekla Structures uses the name in drawings and reports.
Prefix Prefix for the part position number.
Start number Start number for the part position number.

Bottom tab
Use the Bottom tab to control the thickness of the concrete cover of the
bottom reinforcement, the number of bars, and their spacing and rotation.

Column bottom reinforcement

1. Define the concrete cover thickness.

2. Define the length of the ultimate leg.

Column bottom reinforcement rotation

Select how to rotate the reinforcement at the bottom of columns.

Column bottom reinforcement properties

Option Description
Number of bars Number of bottom bars.
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the reinforcing bar.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Name for the bottom bars.

Tekla Structures uses the name in drawings and reports.
Prefix Prefix for the part position number.
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Option Description
Start number Start number for the part position number.

Advanced (main bars) tab
Use the Advanced (main bars) tab to control the main bar extensions
separately for each bar.

Option Description
In Bar index, enter the bar number
for which to define the extension.
Define the size, the distance from the
column edge and the length of each
extension.

Select whether the main bars are
tapered or moved according to the
upper surface, if the top of the
column is skewed.

Select whether to cut bars by the cut
in the column.

Rebar grouping

Select to create bars as a rebar group or as single bars from the Creation
method list.

Rectangular column reinforcement (83)
Rectangular column reinforcement (83) creates reinforcement for a
concrete column that has a rectangular cross section.

Objects created

• Longitudinal main bars: corner bars (4), side bars

• Stirrups

• Intermediate links

Entensions
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• Column end reinforcement

Use for

Situation Description
Rectangular concrete column with
corner bars and side bars bent
outside the column. Side bars on long
sides. Intermediate links tie side bars
at every second stirrup.

Rectangular concrete column with
straight corner and side bars entirely
inside the column. End of column
reinforced.

Limitations

Do not use for round columns.

Selection order

1. Select the main part (column).

The component is created automatically when the part is selected.
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Part identification key

 Part
1 Corner bars
2 Side bars
3 Stirrups
4 Intermediate links

Main bars tab
Use the Main bars tab to control the corner bar properties, the symmetry
options, rotation, and concrete cover thickness.
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Basic corner bar properties

Define the grade, size and bending radius of the corner bars. The active
settings depend on the selected symmetry option.

Option Description
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the reinforcing bar.
Bending radius Define the bending radius of the corner bars.

Define the concrete cover thickness.

Select whether the thickness is the same on all sides.

Symmetry options

Select the symmetry option. Use the symmetrical conditions to define which of
the corner bars have the same grade, size, and bending radius properties. The
corner bars that have same properties are symmetrical.

Rotation

In square columns, you can select the perpendicular sides of a column if the
sides require different reinforcement. You can rotate all reinforcement in a
square column by 90 degrees.

Additional corner bar properties

Option Description
Class Use Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Define a name for the main bars.

Tekla Structures uses the name in drawings and reports.
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Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position number.

Bar ends tab
Use the Bar ends tab to control the length of vertical and horizontal
extensions for the corner bars and side bars, and the cranking.

  
Bar creation Select whether the extensions of

corner bars and side bars are created
symmetrically on both sides of the
column.

If you select Not symmetrical, you
can enter separate extension values
for the opposite sides of the column.

Vertical extension Define the length of the vertical
extension outside the column for
corner bars and side bars.

The active settings depend on Bar
creation: Symmetrical or Not
symmetrical.

Horizontal extension Define the length of the horizontal
extension for corner bars and side
bars.

The active settings depend on Bar
creation: Symmetrical or Not
symmetrical.

Corner bars

Side bars 1

Side bars 2

Select the hook type, and define the
hook length and bending radius.

Top corner bar direction

Bottom corner bar direction

Select the direction of the corner
bars.

Cranking You can create cranked reinforcing
bars at the top and at the bottom of
the column.

To activate the cranking options,

select  in the Top corner
bar direction and Bottom corner
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bar direction lists. Define the
dimensions for the cranked bars.

To successfully create the cranked
reinforcing bars, ensure that the
bending radius is not too large.

Edge dimensions Define the edge distance from the
column corner to the point where the
cranking starts

.

Select cranking from the edge or
center line of the rebar:

Define the cranking separately for the
corner bars and the side bars.

Side bars tab
Use the Side bars tab to control the number of side bars, side bar spacing and
placing, symmetry options, and properties.
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Number of side bars

Define the number and spacing of side bars. You can define two sets of side
bars on each side of the column.

You can define the side bars separately for each side of the column.

The active settings depend on the selected symmetry option.

Placing of side bars

Select the horizontal and vertical placing for the side bars. Select whether the
bars are placed starting from the corner or at equal spaces.

Distance between corner bars and side bars.

Distance between side bars.

Symmetry options

Select the symmetry option. Using the symmetrical conditions you can define
which side bars are symmetrical, and which side bars use the same properties.

Side bar properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the side bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Define a name for the side bars.

Tekla Structures uses the name in drawings and reports.
Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
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Stirrups tab
Use the Stirrups tab to control the stirrup properties.

Stirrup dimensions

  
1 Define the thickness of the concrete cover over the stirrups at the top

and the bottom of the column. The default cover thickness is 50 mm.

Group 1 is the top stirrup group, 5 is the bottom stirrup group. Group
3 is always created.

2 Define the spacing of stirrups in each stirrup group.
3 Define the number of stirrups in each stirrup group.
4 Select how the stirrups are distributed.
5 If you select the Distance list option, enter different spacing values

for the groups.
6 Define the cover thickness for each stirrup group.
7 Define the gaps between the stirrup groups.

Create stirrups

Select whether the stirrups are created as individual reinforcing bars, rebar
group, or spiral rebar group.

Rebar lapping at stirrup corners

Select the how the rebars lap at the stirrup corners. The options are 135-
degree hooks or 90-degree hooks at the bar end, or overlapping U-shape
stirrups.
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You can define the overlap length for the U-shape stirrups.

Ignore cuts

If you have a recess or a hole in the column, you can select to ignore the cuts
at the top and the bottom of the column when the stirrups are created.

Stirrup properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Overlap length Define the overlap length for the U-shape stirrups.

Intermediate links tab
Use the Intermediate links tab to control the intermediate links to tie all side
bars.

If you have rectangular columns that have very large cross sections, the side
bars may be far from the corners of the stirrups. You will need to create
intermediate links to tie all side bars, and to prevent them from buckling when
they are in compression.

Intermediate links are created for each stirrup group.
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NOTE Intermediate links are created between Side bars 1 or Side bars 2
that are symmetrical.

For Side bars 2 intermediate links are created only if no Side bars 1
are created.

Create as one group

Select whether all the stirrups are created as a single group.

Properties of intermediate links

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Spacing of intermediate links

Spacing is the same as stirrup spacing.

Spacing is double the stirrup spacing (intermediate links at
every second stirrup).

Same as above, but for alternate stirrups.

No intermediate links are created.

Intermediate link type

Select the type of the link.
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Intermediate link pattern

Select whether intermediate links go in one direction or in a crossing pattern.

Hook orientation

Select the hook orientation for both sides.

Closed stirrups as intermediate links

Select whether to use closed stirrups as intermediate links.

Concrete components reference 3390 Reinforcement



If you select closed stirrups, select the type of the bar lapping at the stirrup
corners.

Zone without intermediate links

Define the zone length where intermediate links are not created. In this zone,
the stirrups tie the side bars. The distance is measured from the stirrup
corner.

If you have selected to use closed stirrups, you can define the distance from
the corner of the closed stirrups.

Top / Bottom tabs
Use the Top and Bottom tabs to control the top and bottom reinforcement
thickness of the concrete cover, number of bars, spacing and rotation.

Number and spacing of bars

Define the number and spacing of the top or bottom bars.

You can define the number of transverse bars in both cross directions.

Column top / bottom reinforcement

 Description
1 Define the concrete cover thickness from the top / bottom of the

column.
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 Description
2 Define the length of the rebar legs.
3 Define the concrete cover thickness from the sides of the column.
4 Define the distance from the edge of the column to the edge of the

first rebar in the group.

Placing of top or bottom bars

Select the horizontal and vertical placing for the top or bottom bars. Select
whether the bars are placed starting from the corner or at equal spaces.

Distance between corner bars and side bars.

Distance between side bars.

Rotation

Select how to rotate the reinforcement at the top or bottom of columns.

No rotation.

Transverse bars are perpendicular to the longer side of
the column.
Rotation angle is 90 degrees.

Transverse bars are parallel to the longer side of the
column.

Top and bottom reinforcement properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the top or bottom bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Define a name for the top or bottom bars.

Tekla Structures uses the name in drawings and reports.
Prefix Define a prefix for the part position number.
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Option Description
Start number Define a start number for the part position number.

Hole reinforcement for slabs and walls (84)
Hole reinforcement for slabs and walls (84) creates a hole in a concrete slab
or wall and reinforcement around the hole.

Bars created

• Straight bars along hole edges

• Diagonal bars close to hole corners

• U-shaped edge bars

Use for

Situation More information
Rectangular or round holes in
concrete slabs and walls

 

Straight and edge bars only,
no diagonal bars.
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Situation More information
Diagonal and edge bars only,
no straight bars.

Hole rotated from the
direction of the slab.

One diagonal bar at each
corner.

Different number of bars on
each side of the hole in the
wall. No diagonal bars.

Before you start

• Create the concrete slab or wall.

• Calculate the required area of reinforcement.

Selection order

1. Select the center of the hole.

2. Select the concrete slab or wall.

Picture tab
Use the Picture tab to define creation of the hole, hole and bar dimensions,
and concrete cover thickness.
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Hole

Select to create a hole and reinforce it or to create reinforcements to an
existing hole from the Create list.

Select the shape of the hole:

Option Description
Rectangular

Round

Select the pivot point for hole offsets:

Option Description
Hole center

Hole corner

Enter the rotation angle of the hole:

Concrete cover

Enter the cover thicknesses for Edge bars:
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Horizontal and vertical bars tab
Use the Horizontal and vertical bars tab to define which bars are closest to
the surface of the concrete, and the properties of bar groups along the sides
of the hole.

The slab or wall direction defines the direction of the hole and which bars are
to the left and right of, and above and below the hole.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Define the name for the reinforcing

bars.

Tekla Structures uses the name in
drawings and reports.

Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Additional bars tab
Use the Additional bars tab to create additional bars and define their
properties.

Enter the length of additional bars from the opening corner.

Enter the additional bars offsets from horizontal and vertical bars.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
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Option Description
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Edge bars tab
Use the Edge bars tab to define the properties of bar groups on each side.

The slab or wall direction defines the direction of the hole and which bars are
to the left and right of, and above and below the hole.

Option Description
Grade Strength of the steel used in the

reinforcing bar.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Diagonal bars tab
Use the Diagonal bars tab to define the properties of bar groups at each
corner of the hole.

The slab or wall direction defines the direction of the hole and which bars are
to the left and right of, and above and below the hole.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
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Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Hole creation and reinforcement (85)
Hole creation and reinforcement (85) creates a hole in a concrete part and
reinforcement around the hole.

Bars created

• Straight bars at hole edges

• Stirrups

• Z-shaped bars

Use for

Situation More information
Rectangular hole, stirrups on
each side of the hole, no Z-
shaped bars.

Round hole, Z-shaped bars, no
stirrups around the hole.
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Situation More information
Concrete beams or columns  
Round or rectangular holes Hole only. No additional

reinforcement around it.
With or without Z-shaped
bars or stirrups

 

Do not use for

Parts that have round or irregular cross sections.

Before you start

• Create the concrete part.

• Calculate the required area of reinforcement.

Selection order

1. Select the center of the hole.

2. Select the concrete part.

Picture tab
Use the Picture tab to define hole properties, bar dimensions and locations,
concrete cover thickness, and angle of Z-shaped bars.

Holes

Use these options to create holes and additional reinforcement:

Option Description
Creates a hole and
additional
reinforcement
around it.

Only creates a hole,
no reinforcement.

Use these options to define the direction of holes:

Option Description
Hole along the local
y direction of the
part.
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Option Description
Hole along the local
z direction of the
part.

Z-shape bars

Use these options to define Z-shaped bars around round holes:

Option Description
Concrete cover
measured in the
direction of the
radius of the hole.

Concrete cover
measured from the
corner of the
bounding box
around the hole.

Use these options to define the direction of Z-shaped bars:

Option Description
 

 

Bars tab
Use the Bars tab to define bar properties.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Name Tekla Structures uses the name in

drawings and reports.
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Option Description
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position

number.

Stirrups tab
Use the Stirrups tab to define stirrups properties and additional settings.

Stirrups

Use these options to define the stirrups around holes:

Option Description
Single stirrups

Bundled stirrups

Hooks

Option Description
135-degree hooks

90-degree hooks

Braced girder (88)
Braced girder (88) creates braced girders in a precast concrete part, such as
in a thin-shell slab or in a sandwich wall panel. The girders are cast into the
concrete part and they also work as a part of the reinforcement and as a
connector between the precast and cast-in-place concrete.

Objects created

The girders consist of the following parts:

• Two bottom reinforcing bars

• One or two top reinforcing bars
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• Two connecting reinforcing bars

Instead of using reinforcing bars, you can use profiles and plates to create the
braced girders.

Use for

Situation Description
Braced girders are created in the
precast concrete slab.

Braced girders are created in the
precast concrete sandwich panel.

Braced girders are created in a wide
plate floor with an opening.
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Situation Description
Braced girders are created in a hollow
wall.

Profile as a girder.

Selection order

1. Select the concrete part.

The girders are created automatically.

Part identification key

 Part
1 Top reinforcing bar
2 Connecting reinforcing bar
3 Bottom reinforcing bar
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Picture tab
Use the Picture tab to control the creation, shape and dimensions of
reinforcing bars.

Reinforcing bar dimensions and shape

 Description
1 Distance between the end of the top reinforcing bar and the

part end.
2 Distance between the end of the connecting reinforcing bar and

the part end.
3 Distance between the end of the bottom reinforcing bar and the

part end.
4 Radius of the connecting reinforcing bar.
5 Distance between bendings.

Define the distance between the bottom reinforcing bars, and the distance
between the top and bottom reinforcing bars.

If you add two reinforcing bars at the top, you can define the distance of these
reinforcing bars from the top of the connecting reinforcing bars.
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Examples
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Examples

Girder creation

Option Description
Create Select the type of the bottom, top and connecting

reinforcing bars (Bar a, b, c):

• Reinforcing bar

• Steel rod

• No (The reinforcing bar is not created.)
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Option Description
Profile Profile selection is activated when you select the

following girder option:

Define a prefix and a start number for the part
position number, and material, name, comment,
and class.

Plate Plate creation is activated when you select the
following girder option:

Define a prefix and a start number for the part
position number, and material, name, comment,
and class.

Add as Select the method that is used to connect the
girders to the cast unit:

Sub-assembly, Welded, No

Reinforcing bar properties

Define the reinforcing bar properties for the top, bottom and the connecting
reinforcing bars.

Option Description
Size Size of the reinforcing bar.
Grade/Material Grade of the reinforcing bar.
Name

Prefix

Start number

Comment

Class

A name, a prefix and a start number for the part
position number, and comment and class for the
reinforcing bar.
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Parts tab
Use the Parts tab to control the positioning and number of girders.

Workplane orientation

Option Description
Workplane position Use this setting to control to which side of the

input part the girders are created. The Model
option creates them according to the current work
plane in the model.

• Part XY plane

• Part YZ plane

• Part ZX plane

• Model
 Use the Position in plane, Rotation and Position

in depth options to define the orientation of the
girder on the work plane.

Girder position in z direction

Select how the girders are positioned in the z direction.
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Geometry
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Option Description
Multiple L factor Define the accuracy for the rounding of the girder

length.

The default value is 1.0. With the default value, there are
no decimals in the girder length.

Geometry Select the geometry for the connecting reinforcing bars.

Examples:
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Option Description

Girder position in y direction

Select how the girders are positioned in the y direction.
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Examples
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Examples

Extra girders

Select whether additional girder groups are created.

Examples
For example, if you have selected this option:
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Examples
Extra girder groups is set to None: No additional girder groups are created
between 2 existing braced girders.
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Examples
Extra girder groups is set to By number: Additional girder groups are
created based on the entered number. Distances between the groups are
equally divided.
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Examples
Extra girder groups is set to By distance: The number of additional girder
groups is based on the defined distance. The distances between the girder
groups are equally divided.

Girder group

Define whether additional girders are created from the existing girders.

Number is the number of girders in the girder group.

Distance list is the distance between the girders in the girder group.

e = is the position of the girders from the reference line.
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Option Description
• Girder group is positioned in the middle of the

reference line.

• Girder group is positioned on the right side of the
reference line.

• Girder group is positioned on the left side of the
reference line.

Examples
Existin
g
girders
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Examples
Additio
nal
girders

Geometry tab
Use the Geometry tab to control how openings and part length affect the
girder creation.

Option Description
Create always girders Select whether girders are always

created.

If you select Yes, girders are created
even when the girder is placed fully
outside the concrete part.

Openings Select whether girders are created in
openings.
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Option Description
Length Select how girders adapt to the part

shape.
Minimum length Define the minimum length of the

girder.
Maximum length Define the maximum length of the

girder.

The girder is split when the maximum
length is reached.

Examples of minimum length
No minimum length defined:
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Examples of minimum length
Defined minimum length (no girder created):

Double wall tab
Use the Double wall tab to select how a second concrete element affects the
girders in Braced girder (88).

Look up sec concrete element

Select whether a second concrete element affects the creation of the girders.
Define the class of the second wall in the Class box.

Select the first wall, and if the second wall matches the defined class, a girder
is created. You can also enter a series of classes. You can use this creation
method in combination with the options defined for openings on the
Geometry tab.

The example below shows a hollow wall where inside and outside shells have
different geometry.

Examples
A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = No
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Examples

A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = Yes
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Examples

UDA tab

You can define UDAs.

Braced girder (89)
Braced girder (89) creates braced girders between selected points in a
precast concrete part, such as in a thin-shell slab or in a sandwich wall panel.
The girders are cast into the concrete part and they also work as a part of the
reinforcement and as a connector between the precast and cast-in-place
concrete.

Objects created

The girders consist of the following parts:
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• Two bottom reinforcing bars

• One or two top reinforcing bars

• Two connecting reinforcing bars

Instead of using reinforcing bars, you can use profiles and plates to create the
braced girders.

Use for

Situation Description
Braced girders are created in the
precast concrete slab.

Braced girders are created in the
precast concrete sandwich panel.

Braced girders are created in a wide
plate floor with an opening.
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Situation Description
Braced girders are created in a hollow
wall.

Profile as a girder.

Selection order

1. Select the concrete part.

2. Pick the starting point of a girder.

3. Pick the end point of a girder.

Part identification key

 Part
1 Top reinforcing bar
2 Connecting reinforcing bar
3 Bottom reinforcing bar
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Picture tab
Use the Picture tab to control the creation, shape and dimensions of
reinforcement bars.

Reinforcing bar dimensions and shape

 Description
1 Distance between the end of the top reinforcing bar and the

picked point.
2 Distance between the end of the connecting reinforcing bar and

the picked point.
3 Distance between the end of the bottom reinforcing bar and the

picked point.
4 Radius of the connecting reinforcing bar.
5 Distance between bendings.

Define the distance between the bottom reinforcing bars, and the distance
between the top and bottom reinforcing bars.

If you add two reinforcing bars at the top, you can define the distance of these
reinforcing bars from the top of the connecting reinforcing bars.
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Examples
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Examples

Girder creation

Option Description
Create Select the type of the bottom, top and connecting

reinforcing bars (Bar a, b, c):

• Reinforcing bar

• Steel rod

• No (The reinforcing bar is not created.)
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Option Description
Profile Profile selection is activated when you select the

following girder option:

Define a prefix and a start number for the part position
number, and material, name, comment, and class.

Plate Plate creation is activated when you select the following
girder option:

Define a prefix and a start number for the part position
number, and material, name, comment, and class.

Add as Select the method that is used to connect the girders to
the cast unit:

Sub-assembly, Welded, No

Reinforcing bar properties

Define the reinforcing bar properties for the top, bottom and the connecting
reinforcing bars.

Option Description
Size Size of the reinforcing bar.
Grade/Material Grade of the reinforcing bar.
Name

Prefix

Start number

Comment

Class

A name, a prefix and a start number for the part position
number, and comment and class for the reinforcing bar.

Parts tab
Use the Parts tab to control the positioning and number of girders.
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Workplane orientation

Option Description
Workplane
position

Use this setting to control to which side of the input part
the girders are created. The Model option creates them
according to the current work plane in the model.

• Part XY plane

• Part YZ plane

• Part ZX plane

• Model
 Use the Position in plane, Rotation and Position in

depth options to define the orientation of the girder on
the work plane.

Girder position in z direction

Select how the girders are positioned in the z direction.
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Example
Braced girders are positioned to picked points. The braced girders are related
to the top side of the part.

Geometry

Option Description
Multiple L factor Define the accuracy for the rounding of the girder

length.

The default value is 1.0. With the default value, there are
no decimals in the girder length.

Geometry Select the geometry for the connecting reinforcing bars.

Examples:
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Option Description
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Girder position in y direction

Select how the girders are positioned in the y direction.

Examples
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Examples

Extra girders

Select whether additional girder groups are created.

Examples
For example, if you have selected this option:
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Examples
Extra girder groups is set to None: No additional girder groups are created
between 2 existing braced girders.
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Examples
Extra girder groups is set to By number: Additional girder groups are
created based on the entered number. Distances between the groups are
equally divided.
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Examples
Extra girder groups is set to By distance: The number of additional girder
groups is based on the defined distance. The distances between the girder
groups are equally divided.

Girder group

Define whether additional girders are created from the existing girders.

Number is the number of girders in the girder group.

Distance list is the distance between the girders in the girder group.

e = is the position of the girders from the reference line.
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Option Description
• Girder group is positioned in the middle of the

reference line.

• Girder group is positioned on the right side of the
reference line.

• Girder group is positioned on the left side of the
reference line.

Examples
Existin
g
girders
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Examples
Additio
nal
girders

Geometry tab
Use the Geometry tab to control how openings and part length affect the
girder creation.

Option Description
Create always girders Select whether girders are always

created.

If you select Yes, girders are created
even when the girder is placed fully
outside the concrete part.

Openings Select whether girders are created in
openings.
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Option Description
Length Select how girders adapt to the part

shape.
Minimum length Define the minimum length of the

girder.
Maximum length Define the maximum length of the

girder.

The girder is split when the maximum
length is reached.

Examples of minimum length
No minimum length defined:
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Examples of minimum length
Defined minimum length (no girder created):

Double wall
Use the Double wall tab to select how a second concrete element affects the
girders.

Look up sec concrete element

Select whether a second concrete element affects the creation of the girders.
Define the class of the second wall in the Class box.

Select the first wall, and if the second wall matches the defined class, a girder
is created. You can also enter a series of classes. You can use this creation
method in combination with the options defined for openings on the
Geometry tab.

The example below shows a hollow wall where inside and outside shells have
different geometry.

Examples
A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = No
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Examples

A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = Yes
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Examples

UDA tab

You can define UDAs.

Reinforcement mesh array in area (89) / Reinforcement mesh array
(91)
Reinforcement mesh array in area (89) / Reinforcement mesh array (91)
create reinforcement meshes for an entire concrete part, or for a defined
polygonal area. Reinforcement mesh array (91) is suitable especially for
precast panels and slabs.

Objects created

• Reinforcement meshes

Concrete components reference 3442 Reinforcement



Use for

Situation Description
Array of overlapping
rectangular meshes.

Array of meshes in a
polygonal area that you
define. Meshes clipped to
fit the defined area.

Before you start

• Create the concrete part.

• Set the work plane parallel to the plane where you want to create the mesh
array.

Selection order

Component Create reinforcement mesh
Reinforcem
ent mesh
array in
area (89)

1. To attach the reinforcement mesh array:

• to the entire part, pick the starting point of the mesh

• to a selected area, pick points to define the polygonal
shape of the mesh

2. Click the middle mouse button to create the reinforcement
mesh array.

Reinforcem
ent mesh
array (91)

1. Select the part.

The reinforcement mesh array is created automatically
when the part is selected.

Picture tab
Use the Picture tab to define the mesh catalog type, cover thickness and
location, mesh generation, cuts, and mesh area perimeter.
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Mesh type

Select the mesh catalog type from the mesh catalog.

Cover thickness

Define the mesh location and give values for Cover thickness on plane and
Cover thickness from plane.

Define the cross bar location for top and bottom.

Mesh generation

Option Description
Generation
direction

To rotate the mesh generation direction around the
alignment point, enter an angle.

Direction of
bottom layer

Select Opposite of top layer to mirror the bottom layer.

Cut by father
part cuts

Select Yes to cut the mesh with the cuts made in the
father part.

Clipping outside Select Yes to clip the meshes to fit the part or the
selected area.

Mesh area
perimeter

Select the outline which the mesh follows.

The meshes in the examples below are created by picking
the same points but with different mesh area perimeters.
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Option Description
 Example: Polygon

 Example: Part
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Option Description
 Example: Polygon + Part

Hole cover
thickness

Define the hole cover thickness.

Generation start point

Enter the polygon generation start point index.

Overlapping tab
On the Overlapping tab, define the minimum and maximum overlapping
along the longitudinal and crossing direction, and set the mesh offset.

Option Description
Overlapping Define the minimum and maximum overlap along the

Long side and Short side of the mesh.
Mesh offset Define how the meshes are placed.
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Option Description
Mesh start offset Define mesh start offset for the first mesh. The length

of the first mesh is divided by the selected value.

For example, if you select the Mesh start offset to be
1/4, the length of the first mesh is divided by 1/4.

If you select Specified, the Start length offset option
becomes visible and you can enter the offset for the
first mesh.

Attributes tab
On the Attributes tab, define the numbering properties, name, and class of
the reinforcement meshes.

Rectangular area reinforcement (94)
Rectangular area reinforcement (94) creates reinforcement for a
rectangular area. Select the part where the reinforcement is placed and pick
two points to create the reinforcement. The part defines the thickness of the
reinforced area, and the two points define the geometry and the location of
the reinforced area.

Objects created

• Longitudinal main bars: corner bars (4), side bars

• Stirrups

• Intermediate links

• Top and bottom bars

Concrete components reference 3447 Reinforcement



Use for

Situation Description
Concrete wall panel with
corner and side bars
inside the wall. Top and
bottom ends reinforced.
Intermediate links tie side
bars at every second
stirrup.

1 No rotation

2 Rotation in plane

3 Rotation out of plane

Selection order

1. Select the part.

2. Pick the first point.

3. Pick the second point.

Picking the points (2 and 3) determines the area where the reinforcement is
placed.

The reinforcement is created automatically when the second point is picked.
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Part identification key

 Part
1 Corner bars
2 Side bars
3 Stirrups
4 Intermediate links
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 Part
5 Top / Bottom bars

Picture tab
Use the Picture tab to select the reinforcement location and to set the
reinforcement direction.

Rectangular area

Select how the reinforcement is extended over the wall.

Option Description
Column reinforcement area

Area reinforcement with vertical rebars

Beam reinforcement area

Area reinforcement with horizontal rebars

Rotation

Rectangular area reinforcement (94) is based on the geometry of a
standard panel. Using the component on slabs or beams in certain planes can
affect the geometry of the reinforcement. By using the In plane or Out of
plane options, you can adjust the reinforcement to the correct behavior.

Select the reinforcement direction in different part geometry and rotation
situations:
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• No

• In plane

• Out of plane

Main bars tab
Use the Main bars tab to control the corner bar properties, the symmetry
options, rotation, and concrete cover thickness.

Basic corner bar properties

Define the grade, size and bending radius of the corner bars. The active
settings depend on the selected symmetry option.

Option Description
Grade Define the strength of the steel used in the

reinforcing bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the corner bars.

Define the concrete cover thickness.

Select whether the thickness is the same on all
sides.

Symmetry options

Select the symmetry option. Use the symmetrical conditions to define which of
the corner bars have the same grade, size, and bending radius properties. The
corner bars that have same properties are symmetrical.
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Rotation

In square reinforced parts, you can select the perpendicular sides if the sides
require different reinforcement. You can rotate all reinforcement by 90
degrees.

Additional corner bar properties

Option Description
Class Use the Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Name Define a name for the main bars.

Tekla Structures uses the name in drawings and
reports.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position

number.

Hooks at top / bottom

Option Description
Type Select the hook angle.
Length Length of the hook.
Bending radius Bending radius of the hook.

Bar ends tab
Use the Bar ends tab to control the length of the vertical and horizontal
extensions for the corner bars and side bars, and the cranking.

Option Description
Bar creation Select whether the extensions of corner bars

and side bars are created symmetrically on
both sides of the rectangular reinforcement.

If you select Not symmetrical, you can enter
separate extension values for the opposite
sides of the reinforcement.
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Option Description
Vertical extension Define the length of the vertical extension for

corner bars and side bars outside the
reinforced part.

The active settings depend on Bar creation:
Symmetrical or Not symmetrical.

Horizontal extension Define the length of the horizontal extension
for corner bars and side bars.

The active settings depend on Bar creation:
Symmetrical or Not symmetrical.

Top corner bar direction

Bottom corner bar
direction

Select the direction of the corner bars.

Cranking You can create cranked reinforcing bars at the
top and at the bottom of the reinforcement.

To activate the cranking options, select

in the Top corner bar direction and
Bottom corner bar direction lists. Define the
dimensions for the cranked bars.

To successfully create the cranked reinforcing
bars, ensure that the bending radius is not too
large.
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Option Description
Edge dimensions Define the edge distance from the reinforced

part corner to the point where the cranking

starts .

Define the cranking separately for the corner
bars and the side bars.

Side bars tab
Use the Side bars tab to control the number of side bars, side bar spacing and
placing, symmetry options, and properties.

Number of side bars

Define the number and spacing of side bars. You can define two sets of side
bars on each side of the rectangular reinforcement.

You can define the side bars separately for each side.

The active settings depend on the selected symmetry option.

Placing of side bars

Select the horizontal and vertical placing for the side bars. Select whether the
bars are placed starting from the corner or at equal spaces.

Distance between corner bars and side bars.

Distance between side bars.
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Symmetry options

Select the symmetry option. Using the symmetrical conditions you can define
which side bars are symmetrical, and which side bars use the same properties.

Side bar properties

Option Description
Grade Define the strength of the steel used in the

reinforcing bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the side bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Name Define a name for the side bars.

Tekla Structures uses the name in drawings and
reports.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Stirrups tab
Use the Stirrups tab to control the stirrup properties.

Stirrup dimensions
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 Description
1 Define the thickness of the concrete cover over the

stirrups at the top and the bottom of the rectangular
reinforcement. The default cover thickness is 50 mm.

Group 1 is the top stirrup group, 5 is the bottom stirrup
group. Group 3 is always created.

2 Define the spacing of stirrups in each stirrup group.
3 Define the number of stirrups in each stirrup group.
4 Select how the stirrups are distributed.
5 If you select the Distance list option, enter different

spacing values for the groups.
6 Define the cover thickness for each stirrup group.
7 Define the gaps between the stirrup groups.

Create stirrups

Select whether the stirrups are created as individual reinforcing bars, rebar
group, or spiral rebar group.

Rebar lapping at stirrup corners

Select how the rebars lap at the stirrup corners. The options are 135-degree
hooks or 90-degree hooks at the bar end, or overlapping U-shape stirrups.

You can define the overlap length for the U-shape stirrups.

Ignore cuts

If you have a recess or a hole in the reinforced part, you can select to ignore
the cuts at the top and the bottom of the part when the stirrups are created.
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Stirrup properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Overlap length Define the overlap length for the U-shape stirrups.

Intermediate links tab
Use the Intermediate links tab to control the intermediate links to tie all side
bars.

Intermediate links are created for each stirrup group.

NOTE Intermediate links are created between Side bars 1 or Side bars 2
that are symmetrical.

For Side bars 2 intermediate links are created only if no Side bars 1
are created.

Create as one group

Select whether all the stirrups are created as a single group.

Properties of intermediate links

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
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Option Description
Start number Define a start number for the part position number.

Spacing of intermediate links

Option Description
Spacing is the same as stirrup spacing.

Spacing is double the stirrup spacing (intermediate
links at every second stirrup).

Same as above, but for alternate stirrups.

No intermediate links are created.

Intermediate link type

Select the type of the link.

Intermediate link pattern

Select whether intermediate links go in one direction or in a crossing pattern.
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Hook orientation

Select the hook orientation for both sides.

Closed stirrups as intermediate links

Select whether to use closed stirrups as intermediate links.

If you select closed stirrups, select the type of the bar lapping at the stirrup
corners.
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Zone without intermediate links

Define the zone length where intermediate links are not created. In this zone,
the stirrups tie the side bars. The distance is measured from the stirrup
corner.

If you have selected to use closed stirrups, you can define the distance from
the corner of the closed stirrups.

Top / Bottom tabs
Use the Top and Bottom tabs to control the top and bottom reinforcement
thickness of the concrete cover, number of bars, spacing and rotation.

Number and spacing of bars

Define the number and spacing of the top or bottom bars.

You can define the number of transverse bars in both cross directions.

Top / bottom reinforcement

 Description
1 Define the concrete cover thickness from the top / bottom

of the rectangular reinforcement.
2 Define the length of the rebar legs.
3 Define the concrete cover thickness from the sides of the

rectangular reinforcement.
4 Define the distance from the edge of the rectangular

reinforcement to the edge of the first rebar in the group.

Placing of top or bottom bars

Select the horizontal and vertical placing for the top or bottom bars. Select
whether the bars are placed starting from the corner or at equal spaces.
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Option Description
Distance between corner bars and side bars.

Distance between side bars.

Rotation

Select how to rotate the reinforcement at the top or bottom.

Option Description
No rotation.

Transverse bars are perpendicular to the longer side
of the rectangular reinforcement.
Rotation angle is 90 degrees.

Transverse bars are parallel to the longer side of the
rectangular reinforcement.

Top and bottom reinforcement properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Name Define a name for the top or bottom bars.

Tekla Structures uses the name in drawings and
reports.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Wall panel reinforcement / Double wall edge and opening
reinforcement
Wall Panel Reinforcement is used for detailing single precast wall panels. It
includes the reinforcement for the panel edges, around the openings, a mesh
for the whole panel and additional bars, for example, with a wall shoe
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connection. Double wall edge and opening reinforcement is used for
detailing double walls by connecting two panels to each other. It includes the
reinforcement for the panel edges and around the openings.

Object created

• Reinforcement

• Stirrups

• Mesh (for single panels)

Use for

Situation Description
Wall panel reinforcement with
openings and reinforcement in the
panel edges and around openings.

Double wall with opening and
reinforcement around the opening.

Ring reinforcement goes around both
shells.

All reinforcing bars that connect the
shells (U-bars and stirrups) are
attached to the shell that is selected
at creation.

Ring, beam and column reinforcing
bars are attached to the selected shell
that has been the input.
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Selection order

1. Select the concrete part to reinforce.

The reinforcement is created automatically.

Picture tab
Use the Picture tab to select how the corners of a wall panel are reinforced.

Option Description
Corner
reinforcem
ent

Select how the corners are
reinforced and the bar is offset
on both sides of the corner.

Minimum
breaking
distance

Cuts smaller than this value are ignored and the reinforcing
bars are not cut.

Rebar
count

Creates a single layer of
reinforcement.

Creates two layers of
reinforcement.

Cover
thickness

Distance from the edge of the wall panel to the side of the
outermost bar.

Door
minimum
height

Cuts greater than this value are considered as door openings
and the additional reinforcing bars that are needed, for
example, in shoe connections are not created.

Minimum
bar length

Edge bars shorter than this value are not created.
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Option Description
Create
stirrups
priority

Select whether horizontal or vertical reinforcing bars are on
top.

Minimum
edge length

The edge stirrups are not created if the dimension is less than
the defined minimum value.

Reinforcement tab
Use the Reinforcement tab to create the reinforcing bars around the wall
panel edges.

Option Description
Wall panel
edge
reinforcem
ent type

Creates normal
reinforcement.

Creates U reinforcement.
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Option Description
No reinforcement is created.

Creates stirrups.

Mesh Select whether a mesh is created for the whole panel.

If a mesh is created, you can define the mesh properties, or use
custom settings.

You can use the Mesh Bars component to create the mesh.

This option is available in Wall panel reinforcement.
Create
edge
reinforcem
ent

Select whether reinforcement is created at the edges.

If you select Yes, define the horizontal and vertical reinforcing
bar properties.

This option is available in Double wall edge and opening
reinforcement.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties for the wall
panel edges.

Note that horizontal bars have three sets of properties,
depending on the length of the bar.

For example, if the length of the main bar is less than 3000, it
uses the options on the left, if in between 3000 and 6000, the
middle options and if greater than 6000, the options on the
right.
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Option Description

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties for the wall panel
edges.

Note that vertical bars have two sets of properties, depending
on the length of the bar.

U
Reinforcem
ent

Define the U reinforcing bar properties.

Each side of the wall panel has a separate set of U reinforcing
bar properties.

Opening tab
Use the Opening tab to create the reinforcing bars around the wall panel
window and door openings.

Option Description
Opening
reinforcem
ent type

Can be set for all four opening edges.
Creates normal
reinforcement.

Creates U reinforcement.

No reinforcement is created.
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Option Description
Creates stirrups.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties.

Note that horizontal bars have separate sets of properties for
the top and the bottom bars.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties.

U
Reinforcem
ent

Define the U reinforcing bar properties.

Each side of the opening has a separate set of U reinforcing bar
properties.

Door tab
Use the Door tab to define the door reinforcement.

Option Description
Door
reinforcem
ent type

Can be set for all three edges.
Creates normal
reinforcement.

Creates U reinforcement.

No reinforcement is created.
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Option Description
Creates stirrups.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties.

U
Reinforcem
ent

Define the U reinforcing bar properties.

Each side of the door has a separate set of U reinforcing bar
properties.

Notch tab
Use the Notch tab to define the notch reinforcement.

Option Description
Notch
reinforcem
ent type

Can be set for two edges.
Creates normal
reinforcement.

Creates U reinforcement.

No reinforcement is created.

Concrete components reference 3468 Reinforcement



Option Description
Creates stirrups.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties.

U
Reinforcem
ent

Define the U reinforcing bar properties.

Each side of the notch has a separate set of U reinforcing bar
properties.

Diagonals tab
Use the Diagonals tab to create diagonal reinforcing bars at the corners of the
openings.

Option Description
Create diagonals Select whether diagonal reinforcing bars are created

or not.
Diagonals count Number of diagonal reinforcing bars.
Size Select the diameter of a bar.
Grade Define the strength of the steel used in the bars.
Bending radius Define the bar bending radius.
L1 and L2 L1 + L2: Length of the diagonal reinforcing bars.
C Distance between the diagonal reinforcing bar and the

corner of the opening.

Column tab
Use the Column tab to a create column reinforcement.

Option Description
Column
reinforcem
ent

Column reinforcement is as high as the
part.
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Option Description
Column reinforcement does not reach
higher than the top edge of opening.

Column reinforcement is approximately
the L value higher than opening edge.

Column reinforcement is approximately
the L value lower than the opening
edge.

Column
reinforcem
ent
properties

Select whether column reinforcing bars are created or not.

• Minimum column height H: cuts and openings smaller
than the minimum value are not taken into account in the
column creation.

• Maximum column width B: if the width between two
openings or cuts or edges is greater than the maximum
value, then the column reinforcement is not created.

• Column height offset L1: distance between the column
reinforcement end and the opening edge.

• Column height offset L2: same as L1 but for the bottom
part of column reinforcement.

Main
reinforcing
bars

Define the main reinforcing bar properties.

Note that main bars have three sets of properties, depending
on the width of the column.

Stirrup
type

Select the stirrup type.

Reinforcing
stirrups

Define the stirrup properties.

Note that stirrups have three sets of properties, depending on
the width of the column.

Beam tab
Use the Beam tab to create a beam reinforcement on top of the opening.
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Option Description
Beam
reinforcement
properties

Select whether beam reinforcing bars are created or
not.

• Maximum beam height Hmax: distance from the
top edge of the wall to the top edge of the opening.
If the height is greater than the maximum, then the
beam reinforcement is not created.

• Minimum beam length Lmin: distance between
the sides of the opening. If the width of the
opening is less than the minimum, then the beam
reinforcement is not created.

Top Define the beam top reinforcement properties.

Note that the reinforcing bars have two sets of
properties, depending on the length of the beam.

Bottom Define the beam bottom reinforcement properties.

Note that the reinforcing bars have two sets of
properties, depending on the length of the beam.

Stirrup type Select the stirrup type.
Reinforcing stirrups Define the stirrup properties.

Note that stirrups have two sets of properties,
depending on the length of the beam.

Additional tab
Use the Additional tab to create additional horizontal and vertical reinforcing
bars. This tab is available in Wall panel reinforcement.

Option Description
Additional
reinforcing bars

Select whether additional reinforcing bars are created
or not.

Define the additional reinforcing bar properties.

Attributes tab
Use the Attributes tab to control the reinforcing bar properties of the created
parts.

Option Description
Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Name Define a name for the part.

Tekla Structures uses the name in drawings and
reports.
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Option Description
Class Define the part class number.

Multiple Wire Size Mesh
Multiple Wire Size Mesh creates reinforcement meshes with multiple
reinforcing bar sizes. The created reinforcement mesh is optimized for a mesh
welding machine. Multiple Wire Size Mesh can be used for slabs and wall
panels. The slabs and wall panels can be of any polygonal shape with any
number of openings. The reinforcing bars in the mesh can be of different size,
and the spacings between the bars can vary.

Objects created

• Reinforcement meshes

Use for

Situation Description
Three zones of longitudinal
reinforcing bars

Before you start

Create a polygon slab or a wall panel with any number of openings. Enter zone
values to define the width of the area to be reinforced in both the longitudinal
and crossing directions. Each direction can be divided up to five zones.

Selection order

1. Select the main part (slab or wall panel).

The reinforcement mesh is created automatically.

Mesh Parameters tab
Use the Mesh Parameters tab to control the mesh creation and cover
thickness.

Option Description
Define the concrete cover thickness.
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Option Description
Create Rebars Define to which side of the slab or the wall

panel the reinforcing bars are created.
Longitudinal Direction Define whether the x or the y direction is

used as the longitudinal direction when the
reinforcing bars are created.

By default, the x direction is the longitudinal
direction.

Longitudinal Wires/Crossing Wires tab
Use the Longitudinal Wires or the Crossing Wires tab to control the mesh
creation in the longitudinal or the crossing direction, and the reinforcement
zones.

Option Description
Wire sizes Define the sizes of the reinforcing bars used in

the pattern.

Separate the sizes with a space.
Min overhang Define the minimum length of the reinforcing

bar extension.
Max overhang Define the maximum length of the reinforcing

bar extension.
Min spacing Define the minimum space between the

reinforcing bars.

The value must be divisible by the grid size.

For example, if the Min spacing is 150, Max
spacing is 300 and the Grid size is 50, the
spacings are 150, 200, 250 and 300.

Max spacing Define the maximum space between the
reinforcing bars.

The value must be divisible by the grid size.

For example, if the Min spacing is 150, Max
spacing is 300 and the Grid size is 50, the
spacings are 150, 200, 250 and 300

Grid size Define the mesh grid size.

For example, if the Min spacing is 150, Max
spacing is 300 and the Grid size is 50, the
spacings are 150, 200, 250 and 300.

This value depends on the welding machine.
Min wire length Define the minimum reinforcing bar length.
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Option Description
Min number of welding
points

Define the minimum number of crossing
reinforcing bar intersections.

Pattern width to fulfill Define the width of the pattern that is filled
with the mesh.

This value is used when the zone width is
greater than the given value.

Zone width value type Define the width of the area to be reinforced
as a percentage of the whole slab or wall panel
width, or as the actual length.

Width, Real width, Mesh
area per length

Define the mesh width, real width and area per
length in each zone.

Load pattern from file Select the external text file where you have
defined the patterns for longitudinal and
crossing reinforcing bars.

If you use the external patterns file, Multiple
Wire Size Mesh tries to determine a pattern
with a suitable area per length value for every
zone and apply these values to the zones.

Attributes tab
Use the Attributes tab to control the reinforcement properties in the
longitudinal and in the crossing directions.

Option Description
Prefix Define a prefix for the part position number.
Start Number Define a starting number for the part position

number.
Grade Define the strength of the steel used in the

reinforcing bars.
Name Define a name for the longitudinal and the crossing

reinforcing bars.

Tekla Structures uses the name in drawings and
reports.

Class Use Class to group the longitudinal and the crossing
reinforcing bars.

For example, you can display the longitudinal and
the crossing reinforcing bars of different classes in
different colors.
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Configuration file for reinforcing bar patterns
Use an external text file to define the patterns for longitudinal and crossing
reinforcing bars.

Every pattern starts from the Pattern line, followed by, for example, the
pattern name. Each Bar Size and Spacing pair is on a separate row. The Bar
Size and Spacing values are separated by a space.

The file has the following format:

< Pattern > < Name >
<Bar Size> <Spacing>
<Bar Size> <Spacing>
……………………………
<Bar Size> <Spacing>

Examples

Pattern 1
10 200
10 200
8 100
8 300
10 400
Pattern 2
10 200
10 200
8 100
8 100

Embedded anchors (8)
Embedded anchors (8) creates one or more embeds in a concrete part.

Objects created

• Embeds

• Thickening parts

• Reinforcing bars

• Hangup bars

• Crane cables
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Use for

Situation Description
Two custom anchors.

Bolt anchors that are custom parts,
hangup bars and crane cables.
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Situation Description
Cast-in lifting anchors that are custom
parts.

Cast-in wire rope lifting hoops that
are custom parts.

Adjusting anchors are in the front
side. The component is applied two
times.

Selection order

1. Select a concrete part.

2. Pick one point to position the embed.

You can also select multiple points, depending on how the embeds are
divided.

3. Click the middle mouse button to create the embeds.
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Part identification key

 Part
1 Concrete part (wall, column, beam, slab)
2 Point

You can select multiple points.

Input tab
Use the Input tab to control the custom parts used for the embeds, the input
points for placing the embeds and the component direction properties.

Input points sequence

Select the distribution method for the embeds. You can also adjust the
placement of embeds on the Input tab.

Option Description
Select a concrete part and pick one
position point for the anchor.
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Option Description
Select a concrete part and pick multiple
position points for the anchors.

Select a concrete part and pick three
points to define the plane.

Pick a point to place the embed.

Select a concrete part and pick three
points to define the plane.

Pick multiple points to place the
embeds.

Up direction

Define how the embeds are rotated.

This option is not available if the three-point-plane option is selected from the
Input points sequence list.

You can use the global directions +X,-X,+Y,-Y,+Z,-Z.

Alternatively, you can use the local directions +X,-X,+Y,-Y,+Z,-Z to define a
specific face of a typical cube-shaped (slab, wall, beam of column) part.
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-X local:

+X global:

Embed handling

Select whether the embed is handled as a detail or as a modeling tool.

In general, a detail uses the shape of the main part for positioning the
embeds, and a modeling tool uses the picked points for positioning the
embeds.

Embed offset

Define embed offsets in X- and/or Y-direction, from the picked position points.
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Anchor type

Select the type of the anchors from the Anchor type dropdown list. The
options are:

• Anchor created by top part and bottom part

• Component part

• Component detail

• Surface treatment

• Component part and component detail

• Component part and top and bottom part

• Component detail and top and bottom part

Custom part

Select a custom part from the Applications & components catalog to be used
as embed.

• Define the name of the custom component to be used for the embeds. If
the embeds are defined on the Picture tab, leave this box empty.

• Define the name of the configuration file for the custom component.

• Select whether the custom parts must be used for the embeds.

If set to Not, define the embeds’ shape on the Picture tab.

If set to Yes, define the connecting method. Use the Yes and subassembly
option to add the embed as a subassembly to the main part.

• Select how the embeds are rotated. The default direction is 2 point +x.
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• Select how the embeds are rotated around a position point.

Positioning examples
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Placement tab
Use the Placement tab to control the placing of the embeds, crane cable
angles and safety factor properties and to select the lifting anchors.

You can define the input point sequence, lift system and embed dimensions
both in reference line and cross section direction.

Input points sequence

Select the distribution method of the embeds.

Use the a and b boxes on the right to enter the values.

Option Description
Embed is placed on a selected
position point.

Embed is placed on a center of gravity
(COG) point in the part length
direction.

Multiple embeds.

Define dimensions a and b.

Reference = COG

Concrete components reference 3483 Reinforcement



Option Description
Define dimensions a and b.

Reference = COG

If embeds are likely to be placed
outside the part, then value d is used.
Define dimensions a and b as
percentages of the part length.

Reference = COG

Define dimension a as a percentage
of the part length.

Reference = COG

Define dimension a.

The right embed is calculated from
COG.

Define dimension a as a percentage
of the total part length.

Reference = COG

Embed is placed in the middle of the
part.

Define dimensions a and b.

Reference = middle of the part

Define dimensions a and b as
percentages of the part length.

Reference = middle of the part

Define dimensions a and b.

The distances are from the embeds to
the part ends.

Define dimensions a and b as
percentages of the part length.

The distances are from the embeds to
the part ends.
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Option Description
Three embeds in a triangular plate.

Define the vertical distance a from
COG.

Three embeds in a triangular plate.

Define the vertical distance a from
COG as a percentage of the width b.

Lift system

Select the crane cable lifting system.

Dimensions

Option Description
a Define embed dimension a.
b Define embed dimension b.
c Define distance c.
d Define anchor distance from the part

edge.
h Define crane cable height.
α Define crane cable angle α.
β Define cable angle β.
Rounding Define the rounding value for anchor

distances.

Additional embeds

Define additional embeds. Use the boxes on the left and right to define
distances. You can enter multiple distances. Use a space to separate the
values.

Use the middle box to define the number of additional embeds.
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Mirroring

• Define the COG (center of gravity) for the selected parts, an assembly, or an
assembly without steel parts. Assembly without steel parts takes concrete
parts and miscellaneous parts into calculations.

• Select whether embeds are mirrored.

Mirroring is useful for asymmetric custom part embeds. You can mirror
both in reference line direction and cross section direction.
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• Select whether both anchors are created, or only left or right anchor.

Lift.dat configuration file

You can use a configuration file to calculate the lifting capacities of lifting
anchors.

Set Browse configuration file to Yes, and define the full path to the
configuration file. The default file is lift.dat, located in the profil folder.

The lift.dat configuration file contains a list of all custom lifting anchors
belonging to the default Tekla Structures installation. The anchors are sorted
based on fabricator and type, component name and lifting capacity. You can
add more custom components to the list in the configuration file. The file can
be opened in any text editor, for example Notepad.

• Type

Groups where lifting anchors can be selected.
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• Type client

Description of types.

• Name CuCoPa

Name of custom component part as listed in the Applications &
components catalog.

• Lift force (kg)

Lifting capacity in kilograms.

• Dir

Direction. Component direction during creation of custom component part.

• Attribute file

Link to the configuration file.

The anchor type can be selected from the list. The first list option corresponds
to the first type (1) in the lift.dat configuration file.

The last list option is All types and use preference list. This option searches
from all groups. A preference can be defined in the Preference type list. Start
with the highest preference group and separate the groups with a space.

Several fabricators have lifting anchors with the same lifting capacity, but with
different anchor lengths. Use the order in the configuration file to define
which anchor is selected. First found anchor with correct capacity = 1, second
found anchor = 2, and so on.

NOTE If you have selected to use a custom part, ensure that the
corresponding custom parts are available in the model. Names of the
custom parts should not contain spaces, because they are not read
from the lift.dat configuration file.

Safety factor

Define the safety factor. The weight to be lifted up is multiplied with this factor
in the anchor calculation.
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Braced girder

Select to move the anchors to the closes braced girder from Move to closest
braced girder.

Enter the Maximum displacement and Placement offset of the anchors.

Define the Class and Name for the top bar in the braced girder.

Top placement tab
Use the Top placement tab to define the embed offsets and how the
information message box and crane cables are shown.

Offset

Define the embed offsets at both ends of the concrete part. An embed which
is positioned exactly in the middle of the concrete part stays in that position
and does not get an offset.
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Show information message boxes

Define whether a message box containing the embed calculation results is
shown. The message box shows the weight to be lifted up, the real lift-up
weight including a safety factor, and the selected anchor.

The message box appears only if you have set Browse configuration file to
Yes on the Placement tab.

Show crane cables

Define whether crane cables are shown. If set to Yes, crane cables are shown
as construction lines or profiles with the α angle, defined on the Placement
tab.
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Thickening tab
Use the Thickening tab to define the thickening of the concrete layer. The
thickening is especially useful for sandwich walls where shells are thickened
near lifting anchors.

In the example below, a thickening is added with an extra insulation layer.
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Thickening options

Select the side where thickening is applied. You can also define the thickness.

Option Description
No thickening.

Right side thickening.

Thickness is defined from center of the embed.

Right side thickening.

Thickness is defined from side of the embed.

Right side thickening.

Thickness is defined from side of the shell.

Left side thickening.

Thickness is defined from center of the embed.

Left side thickening.

Thickness is defined from side of the embed.

Left side thickening.

Thickness is defined from side of the shell.
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Option Description
Thickening on both sides.

Thickness is defined from center of the embed.

Thickening on both sides.

Thickness is defined from side of the embed.

Thickening on both sides.

Thickness is defined from side of the shell.

Thickening width and height

Select the thickening part reference, and define the thickening width and
thickening height.

Option Description
Width is defined from center of the embed.

Height is defined from the top side of concrete.

Width is defined from center of the embed.

Height is defined from the bottom side of concrete
shell.

Width is defined from the side of concrete shell.

Height is defined from the top side of concrete
shell.

Width is defined from the side of concrete shell.

Height is defined from the bottom side of embed.
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Side view

Option to combine multiple thickening parts into one if the distance between
the thickenings is smaller than or equal to the defined value.

Thickening part

Select how the thickening is connected to the shell. Define the thickening
properties.
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Additional insulation

Select how to add insulation to thickening part.

Option Description
Insulation classes Define the class of the insulation which is used in

the concrete shell.

If the defined class number matches the class of
the insulation in the model, then the insulation will
be cut at the location of the thickening.

Foil classes Define the class of the insulation which is used in
the sandwich wall.

If the defined class number matches the class of
the insulation, then the insulation will be cut at the
location of the thickening

Create extra insulation Select whether an additional insulation layer is
created.
Define the thickness of the insulation.

Additional options for the insulation part

Option Description
Extra insulation
part

Select whether the insulation part is added, and how it is
added.

To Select the part to which the insulation part is added.
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Picture tab
Use the Picture tab to control the embed dimensions, connection method and
rotation.

Embed dimensions

Define if the embed needs to be recessed. You can define the dimensions of
the recess, distance from the recess plane to the top of the embed and select
the shape of the cutout.

Select the shape of the cutout.

Option Example
Circle

Square

Half moon X

Half moon Y
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As negative volume

Select whether cutout profiles are handled as empty cutouts or cutouts with a
formwork part.

Top part/Bottom part

Set the part class and rotation. Each option rotates the embed 90 degrees
counterclockwise. You can define also a fixed rotation angle.

Positioning

Select how to position the top and the bottom parts of the embed.

Option Example
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Option Example

An example of an anchor that is positioned on top of the concrete part.
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Create top part

Select whether the top part of embed is created, and if set to Yes, select how
the part is connected to concrete part.

Create bottom part

Select whether the bottom part of embed is created, and if set to Yes, select
how the part is connected to the concrete part.

Top part tab
Use the Top part tab to define the top part of the embed.

Top part dimensions

Use the diameter and height boxes to define the shape of the top part of the
embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on the
Parts tab.
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Examples

Embed top part defined on the Top part tab, embed bottom part defined on
the Bottom part tab.
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Bottom part tab
Use the Bottom part tab to define the bottom part of the embed.

Bottom part dimensions

Use the diameter and height boxes to define the shape of the bottom part of
the embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on
the Parts tab.
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Parts tab
Use the Parts tab to define the embed top and bottom part properties and
the formwork part properties.

Part properties

Both the top and the bottom part are build from multiple profiles. You can
define profiles for each section.

Define the part properties for the top, bottom and formwork part. If the profile
properties are left empty, the lengths and diameters defined on the Top part
and Bottom part tabs are used.

Option Description
t, b, h Part thickness, width and height.
Pos_No Prefix and a start number for the part

position number.
Material Material grade.
Name Name for the part.
Comment Add a comment for the part.

You can define UDAs for the top and bottom parts.
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Reinforcing bar tab
Use the Reinforcing bar tab to define additional reinforcing bars for the
embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties in two directions.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size for bar
A and bar B.

End conditions left/End conditions right

Select the shape of the reinforcing bar.

Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.
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Rotation

Select how to rotate the reinforcing bars and define the rotation angle.

Dimensions

Define the reinforcing bar dimensions and the number of bars.
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Hangup bars tab
Use the Hangup bars tab to define additional reinforcing bars for the embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size.

End conditions left/End conditions right

Select the shape of the reinforcing bar.
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Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.

Rotation

Select how to rotate the hangup reinforcing bars and define the rotation
angle.
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Dimensions

Option Description Default
1 Select how to place the hangup

reinforcing bars.

Use the values a, b, c, d, e, f and
the angles alpha and beta to
define the dimensions of the
hangup reinforcing bars.

 

2 Define the number of hangup
reinforcing bars.

0

3 Define the cover thickness.  
4 Define the distance between

hangup reinforcing bars.
100 mm
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Horizontal bar tab
Use the Horizontal bar tab to define additional horizontal reinforcing bars for
the embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size.

End conditions left/End conditions right

Select the shape of the reinforcing bar.

Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.

Rotation

Select how to rotate the horizontal reinforcing bars and define the rotation
angle.

Side view

You can create sloped horizontal reinforcing bars. Define the number of bars
and the distance between them. Use value d to define cover thickness for the
top side and value f to define the reinforcing bar length.
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Top view

Select a reinforcing bar shape.

Use values a, b, c, d, e, f and the angle α to define the dimensions of the
horizontal reinforcing bars.
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Special bar tab
Use the Special bar tab to define additional U-shaped reinforcing bars for the
embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties in two directions.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size for bar
A and bar B.

End conditions left/End conditions right

Select the shape of the reinforcing bar.

Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.

Rotation

Select how to rotate the U-shaped reinforcing bars and define the rotation
angle.

Shape

Select a reinforcing bar shape.
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Use the values a, b, c, d, e, f and the angles α to define the dimensions of the
U-shaped reinforcing bars.

Advanced tab
Use the Advanced tab to define UDAs and reinforcing bar properties for the
reinforcing bars, hangup bars, special bars and horizontal bars.

Reinforcing bar properties

Option Description
Comment Add a comment for the reinforcing bars.
Name Define a name that is shown in drawings and

reports.
Class Define the class number for the reinforcing

bars.
Serie Define a prefix for the bar position number.
Start number Define a start number for the bar position

number.
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Embed (1008)
Embed (1008) creates one or more embeds in concrete parts. You can create
multiple embeds to be used as lifting anchors with one insertion point.

Objects created

• Embeds

• Reinforcing bars
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Use for

Situation Description
Embeds

Selection order

1. Select a concrete part.

2. Pick one point on the part face where you want to insert the embed.

The detail is created automatically when you pick the point.

Picture tab
Use the Picture tab to control the embed dimensions, connection method and
rotation.

Embed dimensions

Define if the embed needs to be recessed. You can define the dimensions of
the recess, distance from the recess plane to the top of the embed, select the
shape of the cutout and whether the cutouts are handled as empty cutouts or
cutouts with a formwork part.

Option Example
Circle
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Option Example
Half moon X

Square

Half moon Y
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Top part/Bottom part

Set the part class and rotation. Each option rotates the embed 90 degrees
counterclockwise. You can define also a fixed rotation angle.

How to connect top part to concrete element

Select whether the top part of the embed is created, and if set to Yes, select
how the part is connected to the concrete part.

How to connect bottom part

Select whether the bottom part of the embed is created, and if set to Yes,
select how the part is connected to the concrete part.

Select a custom part from the Applications & components catalog

Select a custom part from the Applications & components catalog to be used
as embed. Use the Yes and subassembly option to add the embed as a
subassembly to the main part. The default direction is 2 point +x.

Top part tab
Use the Top part tab to define the top part of the embed.

Top part dimensions

Use the diameter and height boxes to define the shape of the top part of the
embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on the
Parts tab.

Examples

Embed top part defined on the Top part tab, embed bottom part defined on
the Bottom part tab.
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Bottom part tab
Use the Bottom part tab to define the bottom part of the embed.

Bottom part dimensions

Use the diameter and height boxes to define the shape of the bottom part of
the embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on
the Parts tab.

For examples, see Top part tab.

Parts tab
Use the Parts tab to define the embed top and bottom part profiles and the
formwork part properties.

Part properties

Both the top and the bottom part are build from multiple profiles. You can
define profiles for each section.

Define the part properties for the top, bottom and formwork part. If the profile
properties are left empty, the lengths and diameters defined on the Top Part
and Bottom Part tabs are used.

Option Description
t, b, h Define the part thickness, width and height.

Concrete components reference 3518 Reinforcement



Option Description
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Comment Add a comment for the part.

You can define UDAs for the top and bottom parts.

Placement tab
Use the Placement tab to define the embed placing, positioning and embed
distribution.

Positioning

Select how to position the top and the bottom part of the embed.
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Placing

Define the placing type of the embed. Depending on the component insertion
points, multiple embeds can be created.

Option Description
Embed is placed on a selected position point.

Embed is placed on a center of gravity (COG)
point in the part length direction.

Multiple embeds.

Define dimensions a and b.

Reference = COG

Define dimensions a and b as percentages of
the part length.

Reference = COG

Embed is placed in the middle of the part,
along the length of the concrete part.

Multiple embeds.

Define dimension a as a percentage of the
total part length.

Reference = COG
Embed is placed in the middle of the part.

Define dimensions a and b.

Reference = middle of the part

Define dimensions a and b as percentages of
the part length.

Reference = middle of the part
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Option Description
Define dimensions a and b.

The distances are from the embeds to the part
ends.

Define dimensions a and b as percentages of
the part length.

The distances are from the embeds to the part
ends.

Dimensions

Define embed dimensions a and b.

Center of gravity

Define concrete part COG (center of gravity) for the embeds.

Number of extra anchors

The spacing distance between multiple embeds.

Reinforcing bar tab
Use the Reinforcing bar tab to define extra reinforcing bars for the embeds.

You can define the reinforcing bar shape properties, and the reinforcing bar
profile properties in two directions.

You can define the number, shape, dimension and covering thickness of the
reinforcing bars.

Advanced tab
Use the Advanced tab to define bar properties for reinforcing bars A and B.
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Reinforcing bar properties

Option Description
Comment Add a comment for the reinforcing bars.
Name Define a name that is shown in drawings and reports.
Class Define the part class number for the reinforcing bars.
Serie Define a prefix for the part position number.
Start number Define a start number for the part position number.

Bolts
Click the Bolts button to open the Bolts dialog box where you can define extra
embeds and embed offsets.

Embed (1008) uses only the Horizontal Dist. and Vertical Dist. options, the
other options are not taken into account.

Example

In the example below, the bolt placement uses fixed dimensions from part
edges, defined on the Placement tab. Extra embeds are defined in the Bolts
dialog box.
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Optionally, you can also use the Sec/first and Positioning options to define a
distance from the edge of the beam.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Continuous Beam Reinforcement
You can reinforce a continuous beam using a macro called
ContinuousBeamReinforcement. The macro creates main top and bottom
bars, stirrups, fittings, and additional top and bottom bars using system
components. Longitudinal reinforcement (70) creates the main and
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additional top and bottom bars, Stirrup reinforcement (67) creates stirrups,
and Battering connection (13) creates fittings.

To reinforce a continuous beam:

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Click the arrow next to Applications to open the applications list.

3. Double-click ContinuousBeamReinforcement.

4. Select the beams and click Next.

5. Select the columns and click Next.

6. If needed, modify the reinforcement properties, and click Finish. 

The reinforcements are created.

Limitations

The beams must be aligned for the reinforcing to be successful.
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Example

Lifting
This section introduces components that can be used for lifting.

Click the links below to find out more:

• Lifting anchor (80) (page 3526)

Lifting anchor (80)
Lifting anchor (80) creates two lifting anchors (or anchor groups) for a
concrete part and places them symmetrically on either side of the part’s center
of gravity.
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 Description
1 30% of part length (default)
2 Center of gravity

Objects created

• Lifting anchors (2 or more)

• Recesses for anchors (optional)

Use for

Situation More information
Straight anchor with
straight legs

(Type A in the anchor
properties file, see
Anchor properties
from a file)

Straight anchor with L-
shaped legs

(Type D)
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Situation More information
Angle anchor with
straight legs

(Type B)

Angle anchor with L-
shaped legs

(Type C)

Custom components as
anchors

Anchors recessed into
the part.

Skew and/or rotated
anchors

Before you start

Create the concrete part.
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Selection order

1. Concrete part.

Picture tab
Use the Picture tab to define anchor properties, to use custom components
as anchors, to create recess and define recess dimensions.

Lifting anchor properties

The properties of lifting anchors are:

Option Description
Create anchors Select how the anchors are created.
Anchor dimensions The options are:

• Use dialog values

• Select from file, see Anchor properties from file.

You need to enter different dimensions for different anchor types.
Distance from Set the anchor distribution from the center of gravity or part end.

You can set the distance either by length or by percentage of the length.
The distance between an anchor (or anchor group) and the center of gravity
of the part. Default is 30% of the part length.

The distance between an anchor (or group) and the center line of the part.

Number of bars/spacings The number and spacing of anchors in a group. If the spacing varies, enter
each value individually.

Custom See Custom component as lifting anchor.
Component
Custom settings
Up direction
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Option Description
The option to define if the anchors are recessed into the part.

The skew angle of anchors. Anchor heads are skewed towards the part’s
center of gravity.

Rotate anchor The option to rotate anchors. The options are:

• No: Anchors parallel to the part.

• Yes: Anchors perpendicular to the part.
Grade Strength of the steel used in the anchor.
Size Diameter of the anchor bar.
Name Name that is shown in drawings and reports.
Prefix, Start number Prefix and start number for the part position number.
Class Part class number.

Side

Select the side of the part where Tekla Structures creates the anchors:

Option Description
Front

Top

Default
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Option Description
Back

Below

Start end

Finish end

Recesses

Select one of the following options to define if the lifting anchors are recessed
into the concrete part:

Option Description
Anchors on the surface of the part.

Default

Anchors recessed into the part.

If you choose to recess the anchors into the part, use the following fields to
define the shape and dimensions of the recesses:
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Custom component as lifting anchor

To use custom components as lifting anchors:

1. In the Custom list box, select Yes.

2. Click the ... button next to the Component field to open the Select
component dialog box.

3. Browse for the custom component you want to use as lifting anchor.

The component you select must be a custom part and have two or three
input points.

The component should be created so that the first and the second input
points are on the concrete surface and along the longitudinal axis of the
concrete part.

TIP For more information on how to create custom parts that can be
used as lifting anchors, see Creating standard embeds for global
use.

4. Select the component and click OK.

5. To use saved custom component properties, enter the name of the saved
properties file in the Custom settings field.

6. If the anchor position is not correct, select another option in the Up
direction list box.

Anchor properties from file

You can define lifting anchor properties by entering values in the dialog box,
or you can create a file containing the anchor properties you want to use. Use
any standard text editor to create the file and save it as
LiftingAnchors.dat in the model folder.

To use the anchor properties you define in a file:

1. In the Lifting anchor (80) dialog box, select Select from file from the
Anchor dimensions list box.

2. Click the ... button to browse for the file.

Example

Create a row in the file for each lifting anchor. Enter the following properties,
separated by spaces:

• Anchor capacity [kN], including safety and material factors
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• Type [A, B, C, or D], see the Use for table.

• Grade [characters]

• Size [characters]

• Anchoring length 1 [mm]

• Anchoring length 2 [mm]

• Protruding dimension of the anchor outside the part [mm]

• Penetrating dimension of the anchor inside the part [mm]

• Bending radius [mm]

• Hook length [mm] (0 = no hook)

• Angle of leg 1 [degrees]

• Angle of leg 2 [degrees]

Here is an example of a lifting anchor file (Tekla Structures ignores the
comments enclosed in /* */):

Tekla Structures will use the first anchor in the file that:

1. Has the shape and type you define using the graphic list boxes in the
Lifting anchor (80) dialog box.

2. Can carry the part’s weight with other identical anchors. The total number
of anchors is two times the number you specify in the Number of bars
field.

6.3 Automated Reinforcement Layout
This section explains how to create reinforcement using the automated tools
available in Tekla Structures.

Click the links below to find out more:

• Double-tee beam (51) (page 3534)
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• Inverted-tee beam (52) (page 3554)

• Ledge beam (53) (page 3565)

• Rectangular beam (54) (page 3576)

• Ledge spandrel (55) (page 3585)

• Rectangular spandrel (56) (page 3595)

• Columns (57) (page 3603)

• Topping (58) (page 3618)

• Wash (59) (page 3619)

• Hollowcore reinforcement strands (60) (page 3622)

• Post-tensioning (61) (page 3625)

• Edge and Corner Reinforcement (62) (page 3627)

• U Bar of concrete slab (63) (page 3634)

• Wall panel (64) (page 3636)

• Reinforcement Strand Layout (66) (page 3647)

Double-tee beam (51)
Double-tee beam (51) creates flexural, shear, and flange reinforcement for a
double-tee beam.

Objects created

Reinforcement meshes.

Use for

Situation Description
Double-tee with
reinforcement.

• Prestress straight or depressed strands for flexural reinforcement in
double-tee stems

• Mild longitudinal bars for flexural reinforcement in double-tee stems

• Mesh for shear reinforcement in double-tee stems

• Stirrups in double-tee stems
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• Reinforcement mesh in the double-tee flange

• Transverse and longitudinal mild reinforcing bar in the ends and sides of
the double-tee flange

• Reinforcement around openings and notches in the double-tee flange

Before you start

• Create a concrete double-tee beam.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties, such as debonding and pull values.

Selection order

1. Select the double-tee beam.

The reinforcement is created automatically.

Strand template tab
Use the Strand template tab to define the number and arrangement of
vertical strand planes in each stem, and the vertical distances between grid
points in each plane.

Grid spacing along Y and along X

Define the grid spacing values for the y axis. If you have selected the strand
plane Triple, also define grid spacing values for the x axis.

Separate the values with commas or spaces. The first value is the distance
from the the bottom edge of the stem. Each successive value is the distance to
the next grid point.

TIP Use a multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.
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Strand planes

Option Description
Single

Double
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Option Description
Double
staggered

Triple
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Option Description
Triple
staggered

Strand pattern tab
Use the Strand pattern tab to define the placement of strands in the grid
points.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.

Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.
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Option Description
Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.

Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.

Grade Define the strand grade.
Pull Define the pull force of the strands.
Create strands
in

Select strand pattern side settings:

• Both stems

Default

• Right stem

• Left stem

Strand profile tab
Use the Strand profile tab to define profiles for the strands. All strands in
each stem use the same general profile.

Strand depression profiles

Option Description
One point,
depressed

Two points,
depressed
variable
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Option Description
Two points,
depressed
fixed

Straight

Three points,
depressed
variable

Depress position

Define depress positions A, B, and C as either a fixed distance or as a
percentage of the member length.

Same as A and Same as B

Define whether depress position B uses the same values as depress position A
in the Two points, depressed variable and Two points, depressed fixed
strand profiles.

Define whether depress position C uses the same values as depress position B
in the Three points, depressed variable strand profile.

Depression spacing type

To define the depression spacing type, select One point, depressed as the
strand profile.

Option Description
Exact location Define the height of the strand in

Strand ht @ position.
Top of depression Define the distance Xd from the

depress point in the outmost
reinforcing bar to the edge of the
stem.

Longitudinal rebar tab
Use the Longitudinal rebar tab to define longitudinal reinforcement.

Concrete components reference 3540 Automated Reinforcement Layout



Minimum end clear distance C & D

Define the minimum end clearance distance.

Longitudinal rebar definitions

Option Description
Qty Define the quantity of reinforcing bars.
Grade Define the grade of the reinforcing bar.
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Ht Define the distance from the end of the

reinforcing bar to the face of the strand.

Length type

Define the length type for the reinforcing bar group. Enter additional
information in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

stem, excluding the minimum end clear
distance at each end.

The L, C, and D fields are disabled.
Centered Define a fixed length L for the reinforcing bar.

The reinforcing bar is place at the center
position in the stem.

The C and D fields are disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance C from the start of the strand.

The D field is disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance D from the end of the strand.

The C field is disabled.
Known C, D Define a distance C and D from the end of the

strand.

The L field is disabled.

Stem mesh tab
Use the Stem mesh tab to control the creation of stem meshes and their
position.

Stem mesh creation

Define whether one, two, or no stem meshes are created.
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Stem mesh dimensions

Define the mesh type by selecting it from the mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Option Description
Mesh catalog
type

Define the mesh type by selecting
if from the mesh catalog.

End distance, de Define the distance from the
edge of the mesh to the edge of
the stem.

Bottom
clearance, h1

Define the distance from the
edge of the mesh to the bottom
edge of the stem.

Specify, h3 Select Top clearance.

Define the distance from the
edge of the mesh to the top edge
of the stem.

Specify, h2 Select Mesh height.

Define the height of the mesh.
Mesh full length Define the mesh full length. The

options are:

• Set length E

Define the left end length and
right end length.

• Full length

• Multiple sheets creates
overlapping meshes along the
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Option Description
short and long sides of the
stem.

Define the overlap on the
Multiple sheets tab.

Left end length,
E

Define the length of the left end
mesh.

Right end
length, F

Define the length of the right end
mesh.

Mesh stem position

Option Description
Mesh stem
position

Define the position for both ends of the stem,
x1 and x2.

Multiple sheets tab
Use the Multiple sheets tab to define the minimum overlap along the
longitudinal and crossing direction of the meshes. Multiple sheets are created
if you have selected Mesh full length to be Multiple sheets on the Stem
mesh tab.

Overlapping

Option Description
Min. overlapping
(Short Side)

Define the minimum overlap along the
crossing direction of the mesh.

Min. overlapping
(Long side)

Define the minimum overlap along the
longitudinal direction of the mesh.

Mesh leftover Define whether the leftover is cut, Cut
leftover, or not, Overlap leftover.
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Stem stirrups tab
Use the Stem stirrups tab to define how the the stem stirrups are created.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Symmetrical Define whether the same spacing and

reinforcing bar properties are used at the
start and end of the stem.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

Rebar size Define the reinforcing bar size by selecting
it from the reinforcing bar catalog.

Stirrup shape

Option Description
No stirrups.
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Option Description
Open U-shape stirrup with
legs.

180-degree closed stirrups.

Stirrup dimensions
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 Description
Define the length of the stirrup
leg.
Define the distance from the
middle of the stirrup leg to the
face of the stem.

To define the distance, first select
Top cover from the Specify list.
Define the height of the stirrup.

To define the height, first select
Stirrup height from the Specify
list.
Define the distance from the
bottom edge of the stirrup to the
bottom edge of the stem.
Define the distance from the
bottom corner edge of the stirrup
to the side face of the stem.

Flange tab
Use the Flange tab to define the reinforcing bar mesh for flanges.

Reinforcing bar mesh dimensions

 Description
1 Define the distance from the top edge of the

mesh to the top edge of the flange.
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 Description
2 Define the distance between two longitudinal

reinforcing bars.
3 Define the distance from the bottom edge of

the mesh to the bottom edge of the flange.
4 Define the distance from the side edge of the

mesh to the side edge of the flange.
5 Define the number of reinforcing bars.
6 Define the reinforcing bar spacing.

Use a space to separate spacing values. Enter a
value for each space between the reinforcing
bars. For example, if there are 3 reinforcing
bars, enter 2 values.

7 Define the maximum spacing between
reinforcing bars.

Reinforcing bar properties

Define the reinforcing bar properties for both the transverse (crossing) and
longitudinal reinforcing bars.

Option Description
Size Define the reinforcing bar size by selecting it

from the reinforcing bar catalog.
Grade Define the reinforcing bar grade.

If you select the size from the reinforcing bar
catalog, the grade value is not used.

Mesh catalog type Define the mesh type by selecting if from the
mesh catalog.

Ht Define the height of the mesh.
Mesh full length Define whether the mesh is full length or not.

If you select No, define the end lengths for
the mesh.

Left end length, E Define the left end length of the mesh.
Right end length,
F

Define the right end length of the mesh.

Min. longitudinal
overlapping

Define the minimum overlap along the
longitudinal direction of the mesh.

Min. cross
overlapping

Define the minimum overlap along the
crossing direction of the mesh.

Mesh leftover Define whether the leftover is cut, Cut
leftover, or not, Overlap leftover.
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Notch/Opening tab
Use the Notch/Opening tab to define the reinforcement around the notches
and openings.

Notch/opening reinforcement properties

Option Description
Min notch dimension, D Define the minimum notch

dimension.
Edge distance, de Define the distance from

the reinforcing bar to the
corner of the opening.

Extension, L Define the distance from
the notch opening to the
end of the reinforcing bar.

Number of bars Define the number of
reinforcing bars.

Spacing Define the reinforcing bar
spacing.

Use a space to separate
spacing values. Enter a
value for each space
between the reinforcing
bars. For example, if there
are 3 reinforcing bars,
enter 2 values.

Rebar size Define the reinforcing bar
size by selecting it from the
reinforcing bar catalog.

Rebar grade Define the reinforcing bar
grade.

If you select the size from
the reinforcing bar catalog,
the grade value is not used.
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Corner notch reinforcement

Option Description
Diagonal reinforcement
around the corner notches.

Parallel reinforcement
around the corner notches.

Side/end notch reinforcement

Option Description
Diagonal reinforcement
around the side or end
notch.
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Option Description
Parallel reinforcement
around the side or end
notch.

Define both the horizontal
and vertical reinforcement
properties.

Opening reinforcement

Option Description
Diagonal reinforcement
around the opening.

Parallel reinforcement
around the opening.

Define both the horizontal
and vertical reinforcement
properties.

Edge reinforcement tab
Use the Edge reinforcement tab to create edge reinforcement for the
openings.

Reinforcement bar properties

Option Description
Number of bars Define the number of reinforcing bars.
Spacing Define the reinforcement bar spacing.

Use a space to separate spacing values.
Enter a value for each space between
the reinforcing bars. For example, if
there are 3 reinforcing bars, enter 2
values.

Concrete components reference 3550 Automated Reinforcement Layout



Option Description
Rebar size Define the reinforcing bar size by

selecting it from the reinforcing bar
catalog.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

Section view

Option Description
1 Define the distance from the end

of the reinforcing bar to the edge
of the stem.

2 Define the distance from the top
edge of the reinforcing bar to the
face of the stem.

3 Define the distance of the
reinforcing bar from the side face
of the stem.

Enter a positive value to move
the reinforcing bar closer to the
outer edge of the stem.

Enter a negative value to move
the reinforcing bar to the inner
edge of the stem.

4 Define the distance from the
bottom edge of the reinforcing
bar to the bottom edge of the
stem.
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Plan view

Option Description
1 Define the distance from the middle of the

outmost reinforcing bar to the notch/opening
reinforcement.

Attributes tab
Use the Attributes tab to define naming and numbering of the strands,
stirrups, meshes, and bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Strand code

Store strand code - With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.
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Strand creation at voids

Option Description
Create strand at voids • Select Yes to show the strands even

though there are voids.

• Select No to not show the strand if there
is a void at any location along the strand
path.

Cut strands at voids Select whether to cut the strands at void
locations.

Define the cover thickness.
Min. strands length Define the miminum strand legth.
Ignore cutouts in strand
layout

Select whether cutouts are ignored when
counting the strand layout.

Mesh creation at voids

Option Description
Create meshes at voids Select whether individual stem mesh layers

are created when the layer touches a void.
Cut meshes at voids Select whether to cut the meshes at void

locations.

Define the cover thickness.

Stem end reinforcement tab
Use the Stem end reinforcement tab to define the properties of
reinforcement bars created on the stem ends.

Option Description
Name User-definable name of the bar.

Tekla Structures uses bar names in reports and drawing
lists, and to identify bars of the same type.

Grade Steel grade of the bar.
Size Diameter of the bar.

Depending on the
environment, the nominal
diameter of the bar, or a mark
that defines the diameter.
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Option Description
Bend radius Internal radius of the bends in

the bar.

You can enter a separate value
for each bar bend. Separate
the values with spaces.

Bending radius complies with
the design code you are using.
Main bars, stirrups, ties, and
hooks usually have their own
minimum internal bending
radii, which are proportional to
the diameter of the reinforcing
bar. The actual bending radius
is normally chosen to suit the
size of the mandrels on the
bar-bending machine.

Prefix Prefix for the part position number.
Start number Start number for the part position number.
Class Use to group reinforcement.

For example, you can display bars of different classes in
different colors.

Creation method Select to create the reinforcement by Number of bars or
By spacings.

Inverted-tee beam (52)
Inverted-tee beam (52) creates typical flexural, shear, and ledge
reinforcement for an inverted-tee beam.

Reinforcement created

• Prestress straight or depressed strands for flexural reinforcement in the
inverted tee stem

• Mild longitudinal bars for flexural reinforcement

• Mesh for shear reinforcement in the beam stem

• Stirrups for shear reinforcement in the beam stem

• Reinforcement mesh in the inverted-tee ledges

• Stirrups for shear reinforcement in the inverted-tee ledges

• Mild reinforcement in the top of the beam that will be used later to create a
composite member

• Mild reinforcement in the ends of the beam
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Use for

Situation
Straight and depressed prestress strands
Varying strand pattern and strand number
To define longitudinal reinforcement in the stem
When you want reinforcement mesh in the stem
When you want stirrups in the beam stem
To use reinforcement mesh in the beam ledges
To use stirrups in the beam ledges
To define reinforcement for composite members
To add mild reinforcement to the beam ends

Before you start

• Create the concrete inverted-tee beam.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties, such as debonding and pull values.

Strand template tab
Use the Strand template tab to define the allowable grid points for strands
within the beam cross section.

Grid spacing along Y and along X

You can specify the arrangement of vertical strand planes in the beam, along
with the vertical distances between grid points in each plane. Strands are
defined by their row and column number within the grid, but the template
allows for a mixture of regular and irregular grid points with respect to both
the horizontal and vertical axes.

Use the Grid spacing along X and Grid spacing along Y fields to define a list
of distances between successive planes and grid points.
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Separate the values with commas or spaces. The first value is the distance
from the the bottom edge of the stem. Each successive value is the distance to
the next grid point.

TIP Use a multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.

Strand pattern tab
Use the Strand pattern tab to define the actual strand properties.

You place strands in the beam by defining the grid points from the strand
template for each end of the strand element. You also define size, and other
reinforcement properties for the strands here.

A row of data on this tab can be thought of as a group. All the strands defined
in one group share the same properties and start and stop rows. A group may
also refer to a list of columns in the strand template, letting you use one group
definition to create a set of strands.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.

Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.

Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.
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Option Description
Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.

Grade Define the strand grade.
Pull Define the pull force of the strands.

Strand profile tab
Use the Strand profile tab to define the vertical profile for strands in the
beam.

Strands may be straight (though not necessarily horizontal), or depressed,
using one or two control points. Note that all strands use the same general
profile.

Use the following options to define the strand profile:

Option Description
Straight

1-pt depressed

2-pt depressed
variable

2-pt depressed
fixed

Define the height of the strand in Strand ht @ position.
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Depress position

Define depress positions A and B as either a fixed distance or as a percentage
of the member length.

Same as A

Define whether depress position B uses the same values as depress position A
in the Two points, depressed variable and Two points, depressed fixed
strand profiles.

Longitudinal rebar tab
Use the Longitudinal rebar tab to create additional mild steel reinforcement
in the beam. Reinforcement may be defined with a variety of parametric
forms.

Minimum end clear distance C & D

Define the minimum end clearance distance.

Longitudinal rebar definitions

Option Description
Grade Define the grade of the reinforcing bar.
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Xloc Specify the horizontal location of the

reinforcing bar.
Yloc Specify the vertical location of the reinforcing

bar.

Length type

Define the length type for the reinforcing bar group. Enter additional
information in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

stem, excluding the minimum end clear
distance at each end.

The L, C, and D fields are disabled.
Centered Define a fixed length L for the reinforcing bar.

The reinforcing bar is place at the center
position in the stem.

The C and D fields are disabled.
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Option Description
Known L, C Define a fixed length L for the reinforcing bar

and a distance C from the start of the strand.

The D field is disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance D from the end of the strand.

The C field is disabled.
Known C, D Define a distance C and D from the end of the

strand.

The L field is disabled.

Location

Specify the relative location for longitudinal bars using the following icons:

Description Option
Top and bottom left:

Top and bottom right:

Top and bottom left
and right:

Top left:

Top right:

Top left and right:

Bottom left:

Bottom right:
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Description Option
Bottom left and right:

Stem mesh tab
Use the Stem mesh tab to define the mesh used in the beam stem. Mesh can
run the full length of the beam, or be placed in short sections at either end of
the beam.

Stem mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Stem mesh length

Specify whether the mesh is continuous over the full length of the member or
is used only at the spandrel end(s) from the Continuous list. If Yes is selected
from the list, the mesh extends the full length of the member. If No is selected
from the list, mesh can be defined at each end.

Stem stirrups tab
Use the Stem stirrups tab to define the bent bar reinforcement in the beam
stem. This includes stirrup shape, bar size, end clearance, number of bars, and
bar spacing in five zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Same as left end Define whether the same spacing and

reinforcing bar properties are used at the
right end of the stem.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.
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Stirrup shape

Use the following options to define the stem stirrups in inverted-tee beams:

Option Description
No stirrup

90-degree closed
stirrup

135-degree closed
stirrup

U-Bar pairs
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Option Description
135-degree open
stirrup

Ledge mesh tab
Use the Ledge mesh tab to define the mesh to be used to reinforce the beam
ledges. Mesh runs the full length of the beam.

Ledge mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Ledge rebar tab
Use the Ledge rebar tab to define the bent bar reinforcement in the beam
ledges. This includes strirrup shape, bar size, end clearance, number of bars,
and bar spacing in five zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Same as left end Define whether the same spacing and

reinforcing bar properties are used at the
right end of the stem.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

Stirrup shape

Use the following options to define the ledge stirrups in inverted-tee beams:
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Option Description
No stirrup

Bent U-bar stirrup

Bent U-Bar pairs

90-degree stirrup

135-degree stirrup

Composite tab
Use the Composite tab to define the bent bar reinforcement added to the top
of the beam stem for subsequent creation of composite elements. Define bar
size, embedment, projection, cover, end clearance, number of bars, and bar
spacing in three zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
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Option Description
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

End rebar tab
Use the End rebar tab to define the properties of bent bar reinforcement in
the beam ends. Up to 6 horizontal and 6 vertical bars may be defined.

Option Description
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Grade Define the grade of the reinforcing bar.

Attributes tab
Use the Attributes to define naming and numbering properties of the
strands, stirrups, and mesh bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).
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• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

Ledge beam (53)
Ledge beam (53) creates typical flexural, shear, and ledge reinforcement for a
ledge beam.

Reinforcement created

• Prestress straight or depressed strands for flexural reinforcement in the
beam stem

• Mild longitudinal bars for flexural reinforcement

• Mesh for shear reinforcement in the beam stem

• Stirrups for shear reinforcement in the beam stem

• Reinforcement mesh in the beam ledge

• Stirrups for shear reinforcement in the beam ledge

• Mild reinforcement in the top of the beam that will be used later to create a
composite member

• Mild reinforcement in the ends of the beam

Use for

Situation
Straight and depressed prestress strands
Varying strand pattern and strand number
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Situation
To define longitudinal reinforcement in the stem
When you want reinforcement mesh in the stem
When you want stirrups in the beam stem
To use reinforcement mesh in the beam ledge
To use stirrups in the beam ledge
To define reinforcement for composite members
To add mild reinforcement to the beam ends

Before you start

• Create the concrete ledge beam.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties, such as debonding and pull values.

Strand template tab
Use the Strand template tab to define the allowable grid points for strands
within the beam cross section.

Grid spacing along Y and along X

You can specify the arrangement of vertical strand planes in the beam, along
with the vertical distances between grid points in each plane. Strands are
defined by their row and column number within the grid, but the template
allows for a mixture of regular and irregular grid points with respect to both
the horizontal and vertical axes.

Use the Grid spacing along X and Grid spacing along Y fields to define a list
of distances between successive planes and grid points.

Separate the values with commas or spaces. The first value is the distance
from the the bottom edge of the stem. Each successive value is the distance to
the next grid point.

TIP Use a multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.

Strand pattern tab
Use the Strand pattern tab to define the actual strand properties.
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You place strands in the beam by defining the grid points from the strand
template for each end of the strand element. You also define size, and other
reinforcement properties for the strands here.

A row of data on this tab can be thought of as a group. All the strands defined
in one group share the same properties and start and stop rows. A group may
also refer to a list of columns in the strand template, letting you use one group
definition to create a set of strands.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.

Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.

Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.

Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.

Grade Define the strand grade.
Pull Define the pull force of the strands.
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Strand profile tab
Use the Strand profile tab to define the vertical profile for strands in the
beam.

Strands may be straight (though not necessarily horizontal), or depressed,
using one or two control points. Note that all strands use the same general
profile.

Use the following options to define the strand profile:

Option Description
Straight

1-pt depressed

2-pt depressed
variable

2-pt depressed
fixed

Define the height of the strand in Strand ht @ position.

Depress position

Define depress positions A and B as either a fixed distance or as a percentage
of the member length.

Same as A

Define whether depress position B uses the same values as depress position A
in the Two points, depressed variable and Two points, depressed fixed
strand profiles.
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Longitudinal rebar tab
Use the Longitudinal rebar tab to create additional mild steel reinforcement
in the beam. Reinforcement may be defined with a variety of parametric
forms.

Minimum end clear distance C & D

Define the minimum end clearance distance.

Longitudinal rebar definitions

Option Description
Grade Define the grade of the reinforcing bar.
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Xloc Specify the horizontal location of the

reinforcing bar.
Yloc Specify the vertical location of the reinforcing

bar.

Length type

Define the length type for the reinforcing bar group. Enter additional
information in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

stem, excluding the minimum end clear
distance at each end.

The L, C, and D fields are disabled.
Centered Define a fixed length L for the reinforcing bar.

The reinforcing bar is place at the center
position in the stem.

The C and D fields are disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance C from the start of the strand.

The D field is disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance D from the end of the strand.

The C field is disabled.
Known C, D Define a distance C and D from the end of the

strand.

The L field is disabled.
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Location

Specify the relative location for longitudinal bars using the following icons:

Description Option
Top and bottom left:

Top and bottom right:

Top and bottom left
and right:

Top left:

Top right:

Top left and right:

Bottom left:

Bottom right:

Bottom left and right:

Stem mesh tab
Use the Stem mesh tab to define the mesh used in the beam stem. Mesh can
run the full length of the beam, or be placed in short sections at either end of
the beam.
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Stem mesh type

Define the mesh type by selecting it from theMesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Stem mesh length

Specify whether the mesh is continuous over the full length of the member or
is used only at the spandrel end(s) from the Continuous list. If Yes is selected
from the list, the mesh extends the full length of the member. If No is selected
from the list, mesh can be defined at each end.

Stem stirrups tab
Use the Stem stirrups tab to define the bent bar reinforcement in the beam
stem. This includes the stirrup shape, bar size, end clearance, number of bars,
and bar spacing in five zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Same as left end Define whether the same spacing and

reinforcing bar properties are used at the
right end of the stem.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

Stirrup shape

Use the following options to define the stem stirrups in ledge beams:
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Option Description
No stirrup

90-degree closed
stirrup

135-degree closed
stirrup

U-Bar pairs
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Option Description
135-degree open
stirrup

Ledge mesh tab
Use the Ledge mesh tab to define the mesh used to reinforce the beam ledge.
Mesh runs the full length of the beam.

Ledge mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Ledge rebar tab
Use the Ledge rebar tab to define the bent bar reinforcement in the beam
ledge. This includes stirrup shape, bar size, end clearance, number of bars,
and bar spacing in five zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Same as left end Define whether the same spacing and

reinforcing bar properties are used at the
right end of the stem.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.
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Stirrup shape

Use the following options to define the ledge reinforcing bars in ledge beams:

Option Description
No stirrup

Bent U-bar stirrup

Bent U-Bar pairs

90-degree stirrup

135-degree stirrup

Composite tab
Use the Composite tab to define the bent bar reinforcement added to the top
of the beam stem for subsequent creation of composite elements. Define size
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and number of the bars, embedment, projection, cover, end clearance, and
bar spacing in three zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

End rebar tab
Use the End rebar tab to define the bent bar reinforcement in the beam ends.
This includes position, orientation, bar size and length, cover, and end
clearance. Up to 6 horizontal and 6 vertical bars may be defined.

Option Description
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Grade Define the grade of the reinforcing bar.

Attributes tab
Use the Attributes tab to define naming and numbering properties of the
strands, stirrups, and mesh bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.
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Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from the Cut strands at voids list.

Rectangular beam (54)
Rectangular beam (54) creates typical flexural and shear reinforcement for a
rectangular beam.

Reinforcement created

• Prestress straight or depressed strands for flexural reinforcement in the
beam

• Mild longitudinal bars for flexural reinforcement

• Mesh for shear reinforcement in the beam

• Stirrups for shear reinforcement in the beam

• Mild reinforcement in the top of the beam that will be used later to create a
composite member

• Mild reinforcement in the ends of the beam

Concrete components reference 3576 Automated Reinforcement Layout



Use for

Situation
Straight and depressed prestress strands
Varying strand pattern and strand number
To define longitudinal reinforcement in the beam
When you want reinforcement mesh in the beam
When you want stirrups in the beam
To define reinforcement for composite members
To add mild reinforcement to the beam ends

Before you start

• Create the concrete rectangular beam.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties, such as debonding and pull values.

Strand template tab
Use the Strand template tab to define the allowable grid points for strands
within the beam cross section.

Grid spacing along Y and along X

You can specify the arrangement of vertical strand planes in the beam, along
with the vertical distances between grid points in each plane. Strands are
defined by their row and column number within the grid, but the template
allows for a mixture of regular and irregular grid points with respect to both
the horizontal and vertical axes.

Use the Grid spacing along X and Grid spacing along Y fields to define a list
of distances between successive planes and grid points.
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Separate the values with commas or spaces. The first value is the distance
from the the bottom edge of the stem. Each successive value is the distance to
the next grid point.

TIP Use a multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.

Strand pattern tab
Use the Strand pattern tab to define the actual strand properties.

You place strands in the beam by defining the grid points from the strand
template for each end of the strand element. You also define size, and other
reinforcement properties for the strands here.

A row of data on this tab can be thought of as a group. All the strands defined
in one group share the same properties and start and stop rows. A group may
also refer to a list of columns in the strand template, letting you use one group
definition to create a set of strands.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.

Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.

Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.
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Option Description
Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.

Grade Define the strand grade.
Pull Define the pull force of the strands.

Strand profile tab
Use the Strand profile tab to define the vertical profile for strands in the
beam.

Strands may be straight (though not necessarily horizontal), or depressed,
using one or two control points. Note that all strands use the same general
profile.

Use the following options to define the strand profile:

Option Description
Straight

1-pt depressed

2-pt depressed
variable

2-pt depressed
fixed

Define the height of the strand in Strand ht @ position.
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Depress position

Define depress positions A and B as either a fixed distance or as a percentage
of the member length.

Same as A

Define whether depress position B uses the same values as depress position A
in the Two points, depressed variable and Two points, depressed fixed
strand profiles.

Longitudinal rebar tab
Use the Longitudinal rebar tab to define the additional mild steel
reinforcement in the beam. Reinforcement may be defined with a variety of
parametric forms.

Minimum end clear distance C & D

Define the minimum end clearance distance.

Longitudinal rebar definitions

Option Description
Grade Define the grade of the reinforcing bar.
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Xloc Specify the horizontal location of the

reinforcing bar.
Yloc Specify the vertical location of the reinforcing

bar.

Length type

Define the length type for the reinforcing bar group. Enter additional
information in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

stem, excluding the minimum end clear
distance at each end.

The L, C, and D fields are disabled.
Centered Define a fixed length L for the reinforcing bar.

The reinforcing bar is place at the center
position in the stem.

The C and D fields are disabled.
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Option Description
Known L, C Define a fixed length L for the reinforcing bar

and a distance C from the start of the strand.

The D field is disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance D from the end of the strand.

The C field is disabled.
Known C, D Define a distance C and D from the end of the

strand.

The L field is disabled.

Location

Specify the relative location for longitudinal bars using the following icons:

Description Option
Top and bottom left:

Top and bottom right:

Top and bottom left
and right:

Top left:

Top right:

Top left and right:

Bottom left:

Bottom right:
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Description Option
Bottom left and right:

Stem mesh tab
Use the Stem mesh tab to define the mesh used in the beam. Mesh can run
the full length of the beam, or be placed in short sections at either end of the
beam.

Stem mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Stem mesh length

Specify whether the mesh is continuous over the full length of the member or
is used only at the spandrel end(s) from the Continuous list. If Yes is selected
from the list, the mesh extends the full length of the member. If No is selected
from the list, mesh can be defined at each end.

Stem stirrups tab
Use the Stem stirrups tab to define the bent bar reinforcement in the beam.
This includes stirrup shape, bar properties, end clearance, and bar spacing in
five zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Same as left end Define whether the same spacing and

reinforcing bar properties are used at the
right end of the stem.

Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.
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Stirrup shape

Use the following options to define the stem stirrups in ledge beams:

Option Description
No stirrup

90-degree closed
stirrup

135-degree closed
stirrup

U-Bar pairs
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Option Description
135-degree open
stirrup

Composite tab
Use the Composite tab to define the bent bar reinforcement added to the top
of the beam for subsequent creation of composite elements. Define bar size,
embedment, projection, cover, end clearance, number of bars, and bar
spacing in three zones along the length of the beam.

Reinforcing bar properties

Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing values.
Enter a value for each space between the
reinforcing bars. For example, if there are
3 reinforcing bars, enter 2 values.

Bars Define the number of reinforcing bars.
Rebar size Define the reinforcing bar size by selecting

it from the reinforcing bar catalog.
Rebar grade Define the reinforcing bar grade.

If you select the size from the reinforcing
bar catalog, the grade value is not used.

End rebar tab
Use the End rebar tab to define the bent bar reinforcement in the beam ends.
This includes position, orientation, bar size and length, cover and end
clearance. Up to 6 horizontal and 6 vertical bars may be defined.

Option Description
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Grade Define the grade of the reinforcing bar.
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Attributes tab
Use the Attributes to define naming and numbering properties of the
strands, stirrups, and mesh bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

Ledge spandrel (55)
Ledge spandrel (55) creates typical flexural, shear, and ledge reinforcement
for a ledge spandrel.

Reinforcement created

• Prestress straight or depressed strands for flexural reinforcement in the
spandrel stem
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• Mild longitudinal bars for flexural reinforcement

• Mesh for shear reinforcement in the spandrel stem

• Stirrups for shear reinforcement in the spandrel stem

• Reinforcement mesh in the spandrel ledge

• Stirrups for shear reinforcement in the spandrel ledge

• Mild reinforcement in the ends of the spandrel

Use for

Situation
Straight and depressed prestress strands
Varying strand pattern and strand number
To define longitudinal reinforcement in the stem
When you want reinforcement mesh in the stem
When you want stirrups in the spandrel stem
To use reinforcement mesh in the spandrel ledge
To use stirrups in the spandrel ledge
To add mild reinforcement to the spandrel ends

Before you start

• Create the concrete ledge spandrel.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties, such as debonding and pull values.

Strand template tab
Use the Strand template tab to define the allowable grid points for strands
within the spandrel cross section.
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Grid spacing along Y and along X

You can specify the arrangement of vertical strand planes in the spandrel,
along with the vertical distances between grid points in each plane. Strands
are defined by their row and column number within the grid, but the template
allows for a mixture of regular and irregular grid points with respect to both
the horizontal and vertical axes.

Use the Grid spacing along X and Grid spacing along Y fields to define a list
of distances between successive planes and grid points.

Separate the values with commas or spaces. The first value is the distance
from the the bottom edge of the stem. Each successive value is the distance to
the next grid point.

TIP Use a multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.

Strand pattern tab
Use the Strand pattern tab to define the actual strand properties.

You place strands in the spandrel by defining the grid points from the strand
template for each end of the strand element. You also define size, and other
reinforcement properties for the strands here.

A row of data on this tab can be thought of as a group. All the strands defined
in one group share the same properties and start and stop rows. A group may
also refer to a list of columns in the strand template, letting you use one group
definition to create a set of strands.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.
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Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.

Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.

Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.

Grade Define the strand grade.
Pull Define the pull force of the strands.

Strand profile tab
Use the Strand profile tab to define the vertical profile for strands in the
spandrel.

Strands may be straight (though not necessarily horizontal), or depressed,
using one or two control points. Note that all strands use the same general
profile.

Use the following options to define the strand profile:

Option Description
Straight

1-pt depressed

2-pt depressed
variable

2-pt depressed
fixed

Define the height of the strand in Strand ht @ position.
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Depress position

Define depress positions A and B as either a fixed distance or as a percentage
of the member length.

Same as A

Define whether depress position B uses the same values as depress position A
in the Two points, depressed variable and Two points, depressed fixed
strand profiles.

Longitudinal rebar tab
Use the Longitudinal rebar tab to define the additional mild steel
reinforcement in the spandrel. Reinforcement may be defined with a variety of
parametric forms.

External file

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Minimum end clear distance C & D

Define the minimum end clearance distance.

Longitudinal rebar definitions

Option Description
Grade Define the grade of the reinforcing bar.
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Xloc Specify the horizontal location of the

reinforcing bar.
Yloc Specify the vertical location of the reinforcing

bar.

Length type

Define the length type for the reinforcing bar group. Enter additional
information in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

stem, excluding the minimum end clear
distance at each end.

The L, C, and D fields are disabled.
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Option Description
Centered Define a fixed length L for the reinforcing bar.

The reinforcing bar is place at the center
position in the stem.

The C and D fields are disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance C from the start of the strand.

The D field is disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance D from the end of the strand.

The C field is disabled.
Known C, D Define a distance C and D from the end of the

strand.

The L field is disabled.

Location

Specify the relative location for longitudinal bars using the following icons:

Description Option
Top and bottom left:

Top and bottom right:

Top and bottom left
and right:

Top left:

Top right:

Top left and right:
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Description Option
Bottom left:

Bottom right:

Bottom left and right:

Stem mesh tab
Use the Stem mesh tab to define the mesh to be used in the spandrel stem.
Mesh can run the full length of the spandrel, or be placed in short sections at
either end.

Stem mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Stem mesh length

Specify whether the mesh is continuous over the full length of the member or
is used only at the spandrel end(s) from the Continuous list. If Yes is selected
from the list, the mesh extends the full length of the member. If No is selected
from the list, mesh can be defined at each end.

Stem stirrups tab
Use the Stem stirrups tab to define the bent bar reinforcement in the
spandrel stem. This includes stirrup shape, bar size, end clearance, number of
bars, and bar spacing in eight zones along the length of the spandrel.

External file

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Stirrup type

Stirrups are defined in groups, and a row of data on this tab represents the
definition for a group. All the stirrups defined in one group share the same
properties, including stirrup type. Clear cover definitions apply to all groups.

The following stirrup types may be used in ledge spandrels:
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Option Description
90-degree closed
stirrup

135-degree closed
stirrup

Lapped pair

Fixed pair

Open U

If you select Closed or Follow borders, you can define advanced hook
properties.

Hook

You can select to create a hook or a custom hook from the Hook type list.

If you create a hook, you can define hook Angle, Radius, and Length.
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Ledge mesh tab
Use the Ledge mesh tab to define the mesh used to reinforce the spandrel
ledge. Mesh runs the full length of the spandrel.

Ledge mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Ledge rebar tab
Use the Ledge rebar tab to define the bent bar reinforcement in the spandrel
ledges. This includes strirrup shape, bar size, end clearance, number of bars,
and bar spacing in eight zones along the length of the spandrel.

Ledge stirrups

Ledge stirrups are defined in groups, using the same concept as stem stirrups.
The following ledge stirrup types may be used:

Option Description
Bent U-bar stirrup

Bent U-Bar pairs

90-degree stirrup
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Option Description
135-degree stirrup

Closed

If you select Closed, you can define advanced hook properties.

Hook

You can select to create a hook or a custom hook from the Hook type list.

If you create a hook, you can define hook Angle, Radius, and Length.

End rebar tab
Use the End rebar tab to define the bent bar reinforcement and the
secondary rebar set in the spandrel ends. This includes position, orientation,
bar size and length, cover, and end clearance. Up to 6 horizontal bars may be
defined.

Option Description
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Grade Define the grade of the reinforcing bar.

Attributes tab
Use the Attributes to define naming and numbering properties of the
strands, stirrups, and bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.
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Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

Rectangular spandrel (56)
Rectangular spandrel (56) creates typical flexural and shear reinforcement
for a rectangular spandrel.

Reinforcement created

• Prestress straight or depressed strands for flexural reinforcement in the
spandrel

• Mild longitudinal bars for flexural reinforcement

• Mesh for shear reinforcement in the spandrel

• Stirrups for shear reinforcement in the spandrel

• Mild reinforcement in the ends of the spandrel
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Use for

Situation More
information

Straight and depressed prestress
strands

 

Varying strand pattern and strand
number

 

To define longitudinal reinforcement in
the spandrel

 

When you want reinforcement mesh in
the spandrel

 

When you want stirrups in the spandrel  
To add mild reinforcement to the
spandrel ends

 

Before you start

• Create the concrete rectangular spandrel.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties, such as debonding and pull values.

Strand template tab
Use the Stran template tab to define the allowable grid points for strands
within the spandrel cross section.

Grid spacing along Y and along X

You can specify the arrangement of vertical strand planes in the beam, along
with the vertical distances between grid points in each plane. Strands are
defined by their row and column number within the grid, but the template
allows for a mixture of regular and irregular grid points with respect to both
the horizontal and vertical axes.

Use the Grid spacing along X and Grid spacing along Y fields to define a list
of distances between successive planes and grid points.

Separate the values with commas or spaces. The first value is the distance
from the the bottom edge of the stem. Each successive value is the distance to
the next grid point.

TIP Use a multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.
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Strand pattern tab
Use the Strand pattern tab to define the actual strand properties.

You place strands in the spandrel by defining the grid points from the strand
template for each end of the strand element. You also define size, and other
reinforcement properties for the strands here.

A row of data on this tab can be thought of as a group. All the strands defined
in one group share the same properties and start and stop rows. A group may
also refer to a list of columns in the strand template, letting you use one group
definition to create a set of strands.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.

Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.

Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.

Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.
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Option Description
Grade Define the strand grade.
Pull Define the pull force of the strands.

Strand profile tab
Use the Strand profile tab to define the vertical profile for strands in the
spandrel.

Strands may be straight (though not necessarily horizontal), or depressed,
using one or two control points. Note that all strands use the same general
profile.

Use the following options to define the strand profile:

Option Description
Straight

1-pt depressed

2-pt depressed
variable

2-pt depressed
fixed

Define the height of the strand in Strand ht @ position.

Depress position

Define depress positions A and B as either a fixed distance or as a percentage
of the member length.

NOTE If no specific value is given the “Ht” shall be calculated as Minimum. So
the strand will be straight unless it needs to be depressed because of
the above strand going below the straight position.
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Same as A

Define whether depress position B uses the same values as depress position A
in the Two points, depressed variable and Two points, depressed fixed
strand profiles.

Longitudinal rebar tab
Use the Longitudinal rebar tab to define the additional mild steel
reinforcement in the spandrel. Reinforcement may be defined with a variety of
parametric forms.

Minimum end clear distance C & D

Define the minimum end clearance distance.

Longitudinal rebar definitions

Option Description
Grade Define the grade of the reinforcing bar.
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Xloc Specify the horizontal location of the

reinforcing bar.
Yloc Specify the vertical location of the reinforcing

bar.

Length type

Define the length type for the reinforcing bar group. Enter additional
information in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

stem, excluding the minimum end clear
distance at each end.

The L, C, and D fields are disabled.
Centered Define a fixed length L for the reinforcing bar.

The reinforcing bar is place at the center
position in the stem.

The C and D fields are disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance C from the start of the strand.

The D field is disabled.
Known L, C Define a fixed length L for the reinforcing bar

and a distance D from the end of the strand.

The C field is disabled.
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Option Description
Known C, D Define a distance C and D from the end of the

strand.

The L field is disabled.

Location

Specify the relative location for longitudinal bars using the following icons:

Description Option
Top and bottom left:

Top and bottom right:

Top and bottom left
and right:

Top left:

Top right:

Top left and right:

Bottom left:

Bottom right:

Bottom left and right:
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Stem mesh tab
Use the Stem mesh tab to define the mesh used in the spandrel. Mesh can
run the full length of the spandrel, or be placed in short sections at either end.

Stem mesh type

Define the mesh type by selecting it from the Mesh type catalog. The mesh
type also defines the mesh grade, mesh size, and bar spacing.

Stem mesh length

Specify whether the mesh is continuous over the full length of the member or
is used only at the spandrel end(s) from the Continuous list. If Yes is selected
from the list, the mesh extends the full length of the member. If No is selected
from the list, mesh can be defined at each end.

Stem stirrups tab
Use the Stem stirrups tab to define the bent bar reinforcement in the
spandrel. This includes stirrup shape, bar size, end clearance, number of bars,
and bar spacing in eight zones along the length of the spandrel.

Stirrup type

Stirrups are defined in groups, and a row of data on this tab represents the
definition for a group. All the stirrups defined in one group share the same
properties, including stirrup type. Clear cover definitions apply to all groups.

Use the following options to define the stem stirrups in rectangular spandrels:

Option Description
90-degree closed
stirrup

135-degree closed
stirrup

Concrete components reference 3601 Automated Reinforcement Layout



Option Description
U-Bar lapped pairs

U-Bar fixed pairs

Open U stirrup

If you select Closed, you can define advanced hook properties.

Hook

You can select to create a hook or a custom hook from Hook type dropdown
list.

If you create a hook, you can define hook Angle, Radius, and Length.

End rebar tab
Use the End rebar tab to define the bent bar reinforcement in the spandrel
ends. This includes position, orientation, bar size and length, cover, and end
clearance. Up to 6 horizontal bars may be defined.

Option Description
Size Define the size of the reinforcing bar by

selecting it from the reinforcing bar catalog.
Grade Define the grade of the reinforcing bar.
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Attributes tab
Use the Attributes to define naming and numbering properties of the
strands, stirrups, and mesh bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

Columns (57)
Columns (57) creates typical longitudinal and tie reinforcement for a column.

Reinforcement created

• Prestress strands for longitudinal reinforcement in a column

• Mild longitudinal bars for longitudinal reinforcement in a column
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• Reinforcement for composite rectangular columns

Use for

Situation More
information

To define longitudinal prestress
reinforcement size and location

 

To define longitudinal mild
reinforcement size and extent

 

To define tie size and spacings  

Before you start

• Create the column.

• Calculate the required area and quantity of strands and other
reinforcement.

• Define other reinforcement properties.

Strand reinforcement tab
Use the Strand reinforcement tab to define strand attributes and for a
description of the geometric layout of pre-stress strands in the column.

This tab lets you define the strand reinforcement in the primary section of the
column. Up to 8 strands may be defined.

Option Description
Size Define the size of the strands by

selecting if from the reinforcing bar
catalog.

Grade Define the strand grade.
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Option Description
Pull Define the pull force of the strands.

Specify strand-centerline-to-surface dimension, de. For corner strands 1-4, this
distance defines the strand centerline position relative to both adjacent
column faces. For strands 5-8, the strand is located on the face centerline,
offset from the face by distance de.

Longitudinal rebar tab
Use the Longitudinal rebar tab to define the longitudinal reinforcement to be
used in the primary section of the column.

Reinforcement pattern

Longitudinal bars are presumed to run the entire length of the column (less
the End Clearance distance at each end of the member). Standard longitudinal
reinforcement configurations are provided in a convenient drop-down, and up
to 12 bars may be defined.

Select the desired reinforcement pattern from the drop-down combo-box.
There are 10 predefined patterns:

Description Option
4 Bar
Symmetrical

6 Bar X-X
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Description Option
6 Bar Y-Y

8 Bar
Symmetrical

8 Bar X-X
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Description Option
8 Bar Y-Y

10 Bar X-X

10 Bar Y-Y
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Description Option
12 Bar X-X

12 Bar Y-Y

Rebar properties

Option Description
de Specify the reinforcing bar-centerline-

to-surface dimension. This value is
used to locate most of the bars in
each pattern.

d1 Specify the dimension, which is used
in only the 10- and 12-bar patterns to
locate off-axis bars. This value should
default to the half the appropriate
primary section dimension less de,
divided by 2.

End clear distance Specify the end clear distance for
both ends of the longitudinal
reinforcing bars.

Size Select the size of the bar at each bar
location.

Grade Select the grade of bar at each bar
location.
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Primary ties tab
Use the Primary ties tab to define the ties used in the primary section of the
column.

Reinforcement pattern

Primary ties are distributed along the entire length of the column.

First select the desired tie reinforcement pattern from the list box. There are
16 predefined patterns to choose from. The longitudinal reinforcing bar
selection will affect which of these patterns can be used. The component will
verify that the primary tie configuration correlates with the primary
longitudinal reinforcement configuration. Furthermore, the location or stirrup
in section may depend on the location of longitudinal bars (e.g. 8-bar X-X).

Description Option
4 Bar Symmetrical

6/10 Bar X-X (A)
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Description Option
6/10 Bar X-X (B)

6/10 Bar Y-Y (A)

6/10 Bar Y-Y (B)
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Description Option
8 Bar Symmetrical
(A)

8 Bar Symmetrical
(B)

8 Bar Symmetrical
(C)
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Description Option
8 Bar X-X (A)

8 Bar X-X (B)

8 Bar Y-Y (A)
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Description Option
8 Bar Y-Y (B)

12 Bar X-X (A)

12 Bar X-X (B)
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Description Option
12 Bar Y-Y (A)

12 Bar Y-Y (B)

Properties

Option Description
Tie size Select the size of the tie bar.
Tie grade Select the grade of the tie bar.
Hook type Select the tie hook type. The options

are 90-degree and 135-degree hooks.
c1 Specify the minimum clear cover. The

component must verify that with the
clear cover specified the tie properly
fits around the longitudinal
reinforcing bar with the locations
specified in previous tab.

d1 Specify the distance to the centerline
of the first tie from the top and
bottom. Often there are anchor bolt
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Option Description
pockets at the bottom of columns.
The component should interpret the
d1 distance to be above those
pockets.

X Specify the quantity.
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Bars Define the number of reinforcing
bars.

Same as left end Define whether the same spacing and
reinforcing bar properties are used at
the right end.

Secondary reinforcement tab
Use the Secondary reinforcement tab to define the longitudinal bar and ties
used in the secondary section(s) of the column.

The component will automatically determine these sections from the column
geometry.

Option Description
Longitudinal bar size Select the bar size for the secondary

longitudinal bars.
Longitudinal bar grade Enter the grade for the secondary

longitudinal bars.
Tie size Select the bar size for the secondary

ties.
Tie grade Enter the grade for the secondary

ties.
Min. clear cover

c2

Specify the minimum clear cover from
the secondary longitudinal bars to the
column face.

End clear distance Specify the end clear distance from
the top and bottom of each
secondary section to the ends of the
secondary longitudinal bars.

Hook type Select the secondary tie hook type.
The options are 90-degree and 135-
degree hooks.
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Option Description
Spacing Define the reinforcing bar spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Bars Define the number of reinforcing
bars.

Same as left end Define whether the same spacing and
reinforcing bar properties are used at
the right end.

Circular column tab
Use the Circular column tab to define the reinforcement parametrics for
circular columns.

The component will only create reinforcement in constant diameter members.
Tapered columns and circular columns with ledges are not supported.

Option Description
Number of main bars Specify the desired number of main

bars in the column, from 4-12.
Main bar size Select the size of the main bar.
Main bar grade Select the grade of the main bar.
Tie size Select the size of the tie bar.
Tie grade Select the grade of the tie bar.
c1 Specify the tie clear cover.
End clear distance Specify the end clear distance from

the top and bottom of each
secondary section to the ends of the
secondary bars.

d1 Specify the top end distance from the
centerline of the first tie to the top of
the column.

d2 Specify the bottom end distance from
the centerline of the last tie to the
bottom of the column. Often there
are anchor bolt pockets at the bottom
of columns. The component should
interpret the d2 distance to be above
those pockets.
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Option Description
X, s1 Specify the quantity, X, and spacing,

s1, of the first group of ties at top and
bottom.

Max. spacing Specify the maximum spacing, s2, of
primary ties throughout the length of
the column.

Bars Define the number of reinforcing
bars.

Spacing Define the reinforcing bar spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Attributes tab
Use the Attributes tab to define naming and numbering of the reinforcement.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Minimum cut size Define the minimum length of the
boundary of cut/hole, to be
considered as cut in this field. The
default value is 200 mm.

Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:
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• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

Topping (58)
Use the Topping (58) component to model typical toppings along with their
typical reinforcement.

Topping tab
Use the Topping tab to define the method of topping, configuration of
elevation/thickness of topping, and the mesh created in the topping.

Option Description
Elevation is specified Select the method to use to

specifiy the elevation of the
exterior boundary surface of the
topping:

• Absolute elevation, EL: you
can to specify the top surface
elevation relative to elevation
0’-0’’.

• Relative thickness, H: you can
specify the top surface as a
uniform thickness above the
underlying precast floor units.

• Use control points: Tekla
Structures uses the polygon
input points as the actual 3
dimensional nodes of the top
surface of the toppings. Use
this option to place a topping
over any sloped surface.

Elevation value, EL Enter an appropriate value based
on the choice picked in the list box

Concrete components reference 3618 Automated Reinforcement Layout



Option Description
above. This input box is grayed
out if you have selected the Use
control points option.

Topping configuration Specify whether the topping is
integral with the underlying
precast unit (monolithic) or
poured on site.

Concrete material Specify the concrete strength for
the topping, from the material
catalog.

Reinforcing mesh Select the mesh reinforcement
from the mesh catalog.

Advanced tab
Use the Advanced tab to alter the elevation of individual nodes.

Option Description
Control point indexes Specify one control point or multiple

control point indexes simultaneously.
Thickness Specify the actual elevation/thickness

(thickness at individual control
points).

Attributes tab
Use the Attributes tab to define mesh and concrete properties.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Wash (59)
Use the Wash (59) component to model typical washes along with their typical
reinforcement.
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Use for

Before you start

Create slabs using the Create concrete beam command or with a slab
component.

NOTE You cannot use the Wash (59) component in slabs that are created as
a polygon plates, such as slabs created with Create concrete slab
command.

Picking order

1. Select the slab objects. If the slabs are created with a component, activate
the Select objects in components switch before selecting slabs.

2. Click middle mouse button.

3. Pick points counterclockwise to indicate external boundary (points 1 to 4
in the picture above).

4. Click middle mouse button outside the external boundary.
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5. Pick points clockwise to indicate internal boundary (points 5 to 8 in the
picture above).

6. Click middle mouse button somewhere along the internal boundary.

Wash tab
Use the Wash tab to define the method of wash, configuration of the
elavation/thickness and size of wash, recess depth, and mesh to be created in
the wash.

Specify the wash step dimensions, D1 and D2, to define the top elevation of
the internal boundary relative to the surface of the precast floor units. Note
that D1 and/or D2 can be zero (0.00).

Option Description
Elevation is specified Select the method to use to

specifiy the elevation of the
exterior boundary surface of the
wash:

• Absolute elevation, EL: you
can to specify the top surface
elevation relative to elevation
0’-0’’.

• Relative thickness, H: you can
specify the top surface as a
uniform thickness above the
underlying precast floor units.

• Use control points: Tekla
Structures uses the polygon
input points as the actual 3
dimensional nodes of the top
surface of the wash. Use this
option to place a wash over
any sloped surface.

Elevation value, EL Enter an appropriate value based
on the choice picked in the list box
above. This input box is grayed
out if you have selected the Use
control points option.

Topping configuration Specify whether the wash is
integral with the underlying
precast unit (monolithic) or
poured on site.

Concrete material Specify the concrete strength for
the wash from the material
catalog.

Concrete components reference 3621 Automated Reinforcement Layout



Option Description
Reinforcing mesh Select the mesh reinforcement

from the mesh catalog.

Advanced tab
Use the Advanced tab to define the alter the elevation of individual nodes.

Option Description
Exterior control point indexes Specify one control point or multiple

control point indexes simultaneously.
Thickness Specify the actual elevation/thickness

(thickness at individual control
points).

Interior control point indexes Specify one control point or multiple
control point indexes simultaneously.

D1 Change the thickness at each interior
control point.

D2 Change the recess depth at individual
control point.

Attributes tab
Use the Attributes tab to define the required mesh and concrete properties.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Hollowcore reinforcement strands (60)
The Hollowcore “Automated Reinforcement Generator” (HC-ARG) component
enables Tekla Structures to accurately model all typical hollowcore
reinforcement. Use the tabs in the component dialog box to load a previously
saved HC (Hollowcore) reinforcement scheme, or new reinforcement scheme.
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Strand template tab
Use the Strand template tab to define the number and arrangement of
vertical strand planes in each stem, and the vertical distances between grid
points in each plane.

Grid Spacing along X:

• Use grid spacing to define grid spacing values for the X axis, separating
values with commas or spaces.

• Multiplier values may be applied to define a repeating series of values, e.g.,
8*2 indicates 8 holes with a 2 unit spacing.

• First value is the distance from the left edge of the plank; each successive
value is the distance to the next grid point.

Grid Spacing along Y:

• Use grid spacing to define grid spacing values for the X axis, separating
values with commas or spaces.

• First value is the distance from the bottom edge of the beam; each
successive value is the distance to the next grid point.

Strand pattern tab
Use the Strand pattern tab to define the actual strand properties.

Option Description
Row Define the row number in the strand template

for the start of the strand.
Columns Define a list of one or more column numbers

and/or column ranges in the strand template at
which a strand should be created.

Size Define the size of the strands by selecting if from
the reinforcing bar catalog.

Grade Define the strand grade.
Pull Define the pull force of the strands.

Strand extension tab
Use the Strand extension tab to define the strand extensions.
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You can define the extensions separately for the longest edge and the
remaining edges.

Attributes tab
Use the Attributes tab to define the naming and numbering properties of the
strands.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.
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Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

Post-tensioning (61)
Post-tensioning (61) component enables Tekla Structures to accurately model
most post-tensioning profiles and attributes. Use the tabs in the component
dialog box to load a previously saved PT (post-tensioning) tendon scheme, or a
new tendon scheme.

Tendon properties tab
Use the Tendon properties tab to define tendon properties, the number and
spacing of tendons, rotation angle, and grouted system.

Option Description
Tendon size and grade Select the tendon size and grade

from the catalog of available
options.

Number of tendons Enter the number of tendons in
the group.

Spacing between
tendons, S

If you have specified more than
one tendon, input the spacing (S)
between tendons.

Rotation angle Specify the rotation angle of
tendon/tendon group around the
input points from the default
plane. The default plane is the
plane which is parallel to
the“strong axis”of the part.

Grouted system Specify whether the tendon is to
be a grouted system or a non-
grouted system. This option
defines whether Tekla Structures
uses the strand in determining the
ultimate capacity.

Furthermore, you can input
custom or vendor specific post-
tensioning information, including
unique and/or multiple tendon
systems, grease thickness, jacket
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Option Description
material, jacket thickness, and
jacket diameter.

Tendon profile tab
Use the Tendon profile tab to define the tendon profile, offsets, bend radius,
width, and loop count.

Option Description
Straight

Parabolic

Straight one
point

Loop

Depending on the profile selected, you can input the required fields below:

• Start point offset A1
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• End point offset A2

• Sway drape D

• Bend radius R

• Width W

• Centerline Offset

• Loop count

Attributes tab
Use the Attributes tab to define the naming and numbering properties of the
tendons.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Edge and Corner Reinforcement (62)
Edge and Corner Reinforcement (62) creates edge and corner reinforcement
for concrete panels and slabs. You can reinforce solid or sandwich precast
concrete panels, or vertical and horizontal cast-in-situ slabs.

Objects created

• Reinforcement

Use for

Situation Description
Slab with edge and corner
reinforcement and diagonal bars
around openings
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Limitations

Edge and Corner Reinforcement (62) does not create the slab main
reinforcement. The main reinforcement can be created using slab
reinforcement components, for example, Pilecap reinforcement (76), Pad
footing (77), Slab bars (18), or Reinforcement mesh array in area (89). The
main reinforcement can also be created by using the reinforcement creation
commands on the Concrete tab.

Before you start

Create a panel or a slab.

Selection order

1. Select the main part (panel or slab).

The reinforcement is created automatically.

Picture tab
Use the Picture tab to control the edge and corner reinforcements, the
cutouts, and the corner cutouts.

Reinforcement

Option Description
Define how the corners are reinforced.

Diagonal corner bars are created to an opening.

Diagonal corner bars are not created to an opening.

Aligned with slab
slope

Select whether or not the edge bars, diagonal bars
and U bars are aligned with the slope of a slab that
has different corner thicknesses.

The default value is Yes.
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Cutouts

Option Description
Edge bars are not created to the cutout.

Edge bars are created above the cutout for the defined
length.

Edge bars are created above the cutout.

Edge bars are created to the cutout.

Reinforce opening Select whether openings are reinforced.
Max block cut size Define the size limit for the cutouts that affects the

edge and corner reinforcement and the diagonal bar
creation.

Edge and corner reinforcement are not created to
cutouts that are smaller than the defined size.

Diagonal bars are not created to cutouts that are
smaller than the defined size.

Corner cutouts

Option Description
Edge bars on both sides of the corner cutout are
bent.

This option overrides the Corner bar options 1, 2,
and 3.
Both the edge bars and the U bars are moved a
distance equal to the length of the shorter side of the
cutout.
No bars are moved. Edge bars are created as if there
was no cutout.

Max corner cut out
size

Define the size limit for the corner cutouts.

Edge or corner reinforcement are not created to
cutouts that are smaller than the defined size.

Min hole size Define a size limit for the holes.

Edge and corner reinforcements are not created
around holes that are smaller than the size limit. If
the hole is not rectangular or round, the size of the
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Option Description
hole is determined by the maximum dimension of
the bounding box around the hole.

For example, if you do not want to create edge or
corner reinforcement around holes that are 200 mm
or smaller, enter 200.

Edge/Diag bars tab
Use the Edge bars and Diag bars tabs to control the edge and diagonal
reinforcing bar properties, reinforcing bar overlapping, and concrete cover
thickness.

Reinforcing bar properties

Option Description
Prefix Prefix for the part position number.
Start number Starting number for the part position number.
Name Name that is shown in drawings and reports.
Size Diameter of the reinforcing bar.
Grade Strength of the steel used in reinforcing bars.
Bending radius Edge bar bending radius.
Class Use the Class to group reinforcing bars.

For example, you can display reinforcing bars of
different classes in different colors.

Reinforcing bar overlap

Option Description
L1, L2, L3 Reinforcing bar overlapping length.
Number of reinforcing
bars

Number of reinforcing bars in the reinforcing bar
group.

Create as one group Select whether the identical edge bars and
diagonal bars are created as a group.

The default value is Yes.

Concrete cover thickness

Option Description
C1, C2, C3, C4 Bottom, top, and side concrete cover thickness

for the edge and the diagonal bars.
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Minimum bar length

Option Description
Minimum bar length Minimum length of the edge bars on the Edge

bars tab.

If the bar is shorten than the entered value, the
bar is not created.

Horizontal/Vertical U bars tab
Use the Horizontal U bars and Vertical U bars tabs to control the U bar leg
length, concrete cover thickness, and reinforcing bar properties and spacing.

U bar length

Option Description
1 U bar leg length.
2 Top, bottom, and side concrete cover thickness for U

bars.

Reinforcing bars

Option Description
Create U bar Select whether the U bars are created.

In addition, on the Vertical U bars tab, you can select
whether the vertical U bars are created using the
same settings as the horizontal U bars.

Same as horizontal and inside: vertical U bars use
the same reinforcing bar settings and concrete cover
value as the horizontal U bars, and the vertical U bars
are placed so that they fit inside the horizontal U
bars.

Same as horizontal and outside: vertical U bars use
the same reinforcing bar settings and concrete cover
value as the horizontal U bars, and the vertical U bars
are placed outside the horizontal U bars.

Prefix Prefix for the part position number.
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Option Description
Start number Starting number for the part position number.
Name Name that is shown in drawings and reports.
Size Diameter of the reinforcing bar.
Grade Strength of the steel used in reinforcing bars.
Class Use the Class to group reinforcing bars.

For example, you can display reinforcing bars of
different classes in different colors.

Bending radius U bar bending radius.

U bar creation and spacing

Option Description
Ignore cuts smaller than Cuts that are smaller than the entered value

are ignored and do not affect the U bar
placement.

Creation method Select how the U bars are distributed.
Number of reinforcing
bars

Number of U bars in the reinforcement.

This field is available if you set the Creation
method to Equal distribution by number of
reinforcing bars.

Target spacing value Target spacing value.

Tekla Structures tries to distribute the U bars as
closely as possible according to the entered
value.

This field is available if you set he Creation
method to Equal distribution by target
spacing value.

Exact spacing value Exact spacing value.

Tekla Structures creates fixed, equal spaces
between the reinforcing bars.

By exact spacing Define several spacing values between the U
bars.

Tekla Structures distributes the bars using the
values you enter in the field.

Enter all spacing values, separated by spaces.
You can use multiplication to repeat spacing
values. For example, enter 5*200 to create five
spaces of 200 mm.
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End distance

Horizontal U bars:

Vertical U bars:

Option Description
1 U bar distance from the panel or the slab end.

Stirrups

Stirrups are created instead of U bars when the distance between the edges in
the panel or the slab is so small that the U bars do not get the required cover
thickness.

Position of scanning plane

Option Description
1 U bar offset.
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U Bar of concrete slab (63)
U Bar of concrete slab (63) automatically generates U bars reinforcement for
concrete slabs.

Reinforcements

• Precast concrete RC slabs and PC panels (both solid and sandwich)

• For cast-in-situ slabs (both vertical and horizontal).

Use for

To create U bars to an already created concrete slab complete with its main
and secondary reinforcement.

Create the slab’s main reinforcement

• with existing slab reinforcement components (e.g. Pilecap reinforcement
(76), Pad footing (77), Slab bars (18), Reinforcement mesh array in area
(89))

• manually with the tools on the Concrete toolbar (e.g. single bar, bar
groups or mesh).

Before you start

Existing components must be created previously in order to use this
reinforcement tool.

U bars tab
Use the U bars tab to define the U bar properties.

Option Description
U Bar UB1

U Bar UB2

Use the fields to specify

• Top concrete cover.
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• Bottom concrete cover.

• Side concrete cover.

• Top leg length.

• Bottom leg length.

• End dist

Option Description
Prefix Prefix for the part position number.
Name Tekla Structures uses the name in

drawings and reports.
Size Diameter of the reinforcing bar.
Grade Strength of the steel used in the

reinforcing bars.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Bending radius Internal radius of the bends in the
bar.

Creation method Spacing options for the bars.
Target spacing value Target spacing value.

Tekla Structures tries to distribute the
U bars as closely as possible
according to the entered value.

This field is available if you set he
Creation method to Equal
distribution by target spacing
value.

Exact spacing value Exact spacing value.

Tekla Structures creates fixed, equal
spaces between the reinforcing bars.

By exact spacing Define several spacing values
between the U bars.

Tekla Structures distributes the bars
using the values you enter in the field.

Enter all spacing values, separated by
spaces. You can use multiplication to
repeat spacing values. For example,
enter 5*200 to create five spaces of
200 mm.
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Wall panel (64)
Wall panel (64) creates reinforcement for different wall panels. Contains
options to create strands and stirrups. Is suitable also for insulated wall
panels. You can easily change the direction (horizontal or vertical) of most
reinforcing bars. Automatically creates parallel or diagonal corner
reinforcement around the openings and notches.

Objects created

This component contains the following reinforcement groups:

• Strands

• Longitudinal reinforcing bars

• Transverse mesh

• Transverse straight reinforcing bars

• Transverse closed stirrups

• Reinforcement for openings

To omit any of these reinforcement groups, set the reinforcing bar size or the
mesh grade to zero.

Use for

Situation Description
Reinforcement
created with
default settings for
a wall panel with a
door opening.

Concrete components reference 3636 Automated Reinforcement Layout



Situation Description
A cross section
from the wall
reinforcement.

Limitations

Does not create reinforcement for the ledges in the wall.

Before you start

Create the wall panel.

Selection order

1. Select the wall panel.

Strand template tab
Use the Strand template tab to define the strand positions with grid points
within the wall cross section. Strands may only be located at the positions
defined in this template, but the template allows for a mixture of regular and
irregular points.

Strand at opening creation

Select to create strands at the opening or not.

Strand direction

Changes the direction of strands in the wall.

Grid Spacing along X

Use to define grid spacing values for the x axis. Separate values with commas
or spaces. The first value is the distance from the left edge of the spandrel.
Each successive value is the distance to the next grid point.
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TIP Use multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.

Grid Spacing along Y

Use to define grid spacing values for the y axis. Separate values with commas
or spaces. The first value is the distance from the bottom edge of the
spandrel. Each successive value is the distance to the next grid point.

Strand pattern tab
Use the Strand pattern tab to create strands at the grid positions defined by
a strand template.

Same as left

Use to simplify strand input.

• Select Yes to use the row and debond information of the left end for the
strands at the right end of the spandrel.

• Select No to specify alternate row and debond information at each end of a
strand.

Strand pattern definitions

Use the strand template positions in the strand grid to specify the row and
column for each end of the strand. Strands may have different grid row
positions at each end, but a strand may not cross grid columns.
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Field Description
Left end -
Column

Enter the vertical row number in the strand
template for the left end of the strand.

Left end -
Debond

Enter the debond length at the left end of the
strand.

Right end -
Column

If Same as left is No, enter the vertical row
number in the strand template for the right end of
the strand.

Right end -
Debond

If Same as left is No, enter the debond length at
the right end of the strand.

Rows Enter a list of one or more row numbers and/or
row ranges in the strand template at which a
strand should be generated.

Size Select the size of the strands.
Grade Select the strand grade.
Pull Enter the pull force of the strands.

Longitudinal rebar tab
Use the Longitudinal rebar tab to specify longitudinal mild reinforcement for
the wall panel.

Minimum end clear distance C & D

Specify minimum end clearance distance for C and D fields.

Rebar direction

Use to change the direction of the longitudinal reinforcing bars.

Length type

Select a Length type to define the end constraints of the reinforcing bar
group within the member length. Depending on your choice, enter additional
information is in the L, C, or D fields.

Option Description
Full length Reinforcing bar extends the full length of the

wall panel – excluding the minimum end clear
distance at each end. The L, C, and D fields are
disabled.

Centered Specify a fixed length L for the bar which the
component centers in the length of the wall
panel. The C and D fields are disabled.
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Option Description
Known L, C Specify a fixed length L for the bar and a

distance C from the start of the wall panel. The
D field is disabled.

Known L, D Specify a fixed length, L for the bar and a
distance D from the end of the wall panel. The C
field is disabled.

Known C, D Specify a distance C and D from the end of the
wall panel. The L field is disabled.

XLoc

Specify the horizontal locations of the longitudinal reinforcing bars.

YLoc

Specify the vertical location of the longitudinal reinforcing bars.

Mesh tab
Use the Mesh tab to specify mesh for reinforcement in the wall panel.

Mesh properties

Select the mesh from the catalog and Tekla Structures fills the other fields
automatically.

Layer properties

You can specify one to three different layers of mesh. Each mesh can be
different or identical.

Option Description
Side cover Concrete cover thickness.
Ht to layer Specify height to the center line of each

layer – h1, h2, h3. If you leave this field
blank, no mesh is created.

Left end distance Specify clearance distance for the left
end. This is the dimension d1 in the
pictureimage above.
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Option Description
Right end distance Specify clearance distance for the right

end. This is the dimension d2 in the
image above.

Continuous Specify whether the mesh is continuous
over the wall panel length, or is used only
at the end(s) of the wall. The options are:

• Select Yes: Mesh extends the full
length of the member

• Select No: Mesh can be defined at
each end using the L1 and L2 fields.

If any openings are present, the
component will trim the mesh around
the opening using the end distance (d1)
dimension as a clearance.

Left end length If the mesh is used only at the ends of
the wall, enter the length for the left end.
(L1)

Right end length If the mesh is used only at the ends of
the wall, enter the length for the right
end. (L2)

Cross bar location Defines whether the crossing bars are
located above or below the longitudinal
bars.

Transverse Straight bars tab
Use the Transverse straight bars tab to specify transverse straight
reinforcing bars with varying spacing in the wall panel.

Properties of wall transverse straight bars

• Specify the side clear cover.

• Specify the end distance to the center line of the first reinforcing bar from
each end.

• Specify the quantity and spacing of reinforcing bars in zones next to each
end.
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• If you need another group of reinforcing bars at each end, specify the
quantity and spacing of reinforcing bars in the second group. If the second
group is not required, enter 0 in the quantity field.

• If reinforcing bars are required to extend the length of the wall panel,
specify the maximum spacing allowed between end groups – Spacing in
the third group. If Spacing is left blank, there is no additional reinforcing
bar between the end groups.

NOTE At openings, this component adds reinforcing bars at each side of the
opening using the side cover dimension as distance from the opening
to the center line of the reinforcing bar. These reinforcing bars are in
addition to the typical reinforcing bar.

Option Description
Spacing Define the reinforcement bar spacing.
Bars Define the number of reinforcing

bars.
Rebar size Diameter of the reinforcing bar.
Same as left end Select whether the same properties

are used at the right end.
Rebar grade Strength of the steel used in the

reinforcing bars.
h1, h2, h3 Specify height to reinforcement level.

If h1, h2, or h3 is left blank, no
reinforcing bar is created at that level.

Bars direction Change the direction of the bars.

Transverse stirrups tab
Use the Transverse stirrups tab to define the distribution of the stirrups
along the wall panel. You can define up to five zones for the distribution. If the
selected wall panel is an insulated wall, Tekla Structures details the stirrups in
the structural (thicker) wythe only. If both wythes are the same thickness,
Tekla Structures details the stirrups in the same way in both wythes.

Stirrup properties

For each zone you can specify a different spacing of stirrups. Specify the end
distance to the center line of the first stirrup from each end.
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• Define the spacing between two stirrups in each zone.

• Define the number of reinforcing bars in each zone.

• Select the bar size.

Stirrup type

Select the stirrup type and enter needed dimensions.

Option Description
No stirrups

90-degree closed stirrup

• Specify the side clear cover.

• Specify the top and bottom
clear cover.

135-degree closed stirrup

• Specify the side clear cover.

• Specify the top and bottom
clear cover.
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Option Description
U bar pairs

• Specify the side clear cover.

• Specify the top and bottom
clear cover.

• Specify the lap length

NOTE • The component creates stirrups using the minimum CRSI bend
diameter.

• At openings, this component adds a stirrup/bar each side of the
opening using the top cover dimension as distance from the
opening to the center line of the stirrup/bar. These stirrups are in
addition to the typical stirrups/bar.

Same as left end

Set this to Yes if stirrups are symmetric at both ends of the wall panel.

Rebar grade

Define the grade of the transverse stirrups.

Stirrups direction

Select an option to define the stirrup direction.

Notch/Opening tab
Use the Notch/Opening tab to specify reinforcement around different
openings in a wall panel.

Corner notch reinforcement

Select a reinforcement scheme to apply around wall panel corner notches. The
options are:

Concrete components reference 3644 Automated Reinforcement Layout



Option Description
Diagonal reinforcement around the
corner notches.

Parallel reinforcement around the
corner notches.

Side/end notch reinforcement

Select a reinforcement scheme to apply around the side and end notches of
the wall panel. The options are:

Option Description
Diagonal reinforcement
around the side or end
notch.

Parallel reinforcement
around the side or end
notch.

Opening reinforcement

Select a reinforcement scheme applied around openings. The options are:
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Option Description
Diagonal reinforcement
around the opening.

Parallel reinforcement
around the opening.

Notch/opening reinforcement properties

Field Description Default
Min notch
dimension, D

Specify first the minimum
dimension D beyond which
reinforcement is applied. For
example, if a D value of 2.00 is
specified, component will not
apply reinforcement parallel to
that direction.

6" (150 mm)

Edge clearance, de Specify the edge clearance
from the notch and edge of the
wall panel.

1,50" (38 mm)

Extension, L Specify the extension of the
reinforcing bar beyond a notch
or re-entrant corner.

This component checks that the
L dimension specified is at least
the minimum development
length of the bar selected. If the
L dimension specified cannot
be achieved due to edge
clearances, hooks are added
automatically.

18" (450 mm)

Rebar size Defines the size of the
reinforcing bars around
notches or openings.

Click  button to select a
reinforcing bar from the

#4 (M13)
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Field Description Default
reinforcing bar catalog.
Selecting a size will override the
value in the Rebar grade field.

Rebar grade Field for defining the grade of
the reinforcing bars. This field
cooperates with the Rebar size
field.

A615

If any of the straight or diagonal bars approaches closer to the concrete edge
than de from the edge given L, the bar is bent as follows:

Attributes tab
Use the Attributes tab to define the naming and numbering properties.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Reinforcement Strand Layout (66)
Reinforcement Strand Layout (66) creates straight or depressed prestress
strands for flexural reinforcement in a beam.

Objects created

• Straight and depressed prestress strands.
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Use for

Situation Description
Straight strands.

Selection order

1. Select the beam.

Strand template tab
Use the Strand template tab to define the vertical strand positions with grid
points in a beam. Strands may only be located at the positions defined in this
template.

Grid spacing along X

Use to define grid spacing values for the x axis. Strands are defined by their
row and column number within the grid.

Separate values with commas or spaces. The first value is the distance from
the left edge of the spandrel. Each successive value is the distance to the next
grid point.

Grid spacing along Y

Use to define grid spacing values for the y axis. Strands are defined by their
row and column number within the grid.

Separate values with commas or spaces. The first value is the distance from
the the bottom edge of the spandrel. Each successive value is the distance to
the next grid point.

Concrete components reference 3648 Automated Reinforcement Layout



NOTE Use multiplier to define a repeating series of values. For example, 8*2
indicates eight holes with a two unit spacing.

Strand pattern tab
Use the Strand pattern tab to define the placement of the strands at the grid
points.

External file

With an external CSV file you can define an unlimited amount of individual
strands.

Select to use an external file from the Use external file list.

Select an external CSV file by clicking ... button.

Rebar end is same as start

Define the strand input.

• Select Yes to use the row and debond information of the strand start for
the strands at the strand end.

• Select No to define an alternate row and debond information at the end of
each strand.

Strand pattern definitions

Define the row and column for each end of the strand using the strand
template positions in the strand grid. Strands may have different grid row
positions at each end, but a strand cannot cross grid columns.

Option Description
Strand start -
Row

Define the horizontal row number in the strand
template for the start of the strand.

Strand start -
Debond

Define the debond length at the start of the
strand.

Strand end -
Row

If Same as left is No, define the horizontal row
number in the strand template for the end of the
strand.

Strand end -
Debond

If Same as left is No, define the debond length at
the end of the strand.

Middle debond -
To start

Define the debond length from middle to the
start of the strand.

Middle debond -
To end

Define the debond length from middle to the end
of the strand.

Columns Define a list of one or more column numbers
and/or column ranges in the strand template at
which a strand should be created.
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Option Description
Size Define the size of the strands by selecting if from

the reinforcing bar catalog.
Grade Define the strand grade.
Pull Define the pull force of the strands.

Strand profile tab
Use the Strand profile tab to define the profile for strands.

Strand depression

Strands can be straight or depressed. Use one or two control points to
depress the strands. All strands use the same general profile.

Option Description
Straight

Depressed in 1
point

Depressed in 2
points

Depressed in 2
fixed points

Depress position

Define the depress positions A and B either as a fixed distance or as a
percentage of the member length.
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Strand ht @ position

Define the height of the strand.

Attributes tab
Use the Attributes tab to define naming and numbering of the strands.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Strand code

Store strand code – With option Store strand code you may choose to store
(or not) a user-defined textual attribute TS_STRAND_CODE to part.

Strand code – In field Strand code you may enter a string template for the
value of the above mentioned user-defined attribute. The default template is
the total number of created strands. The template may contain any text and
the predefined fields for:

• %NUMBERS – is the numbers of created strands with different sizes and/or
grades e.g. 10 (for one size & grade) or 6+4 (if two sizes and/or grades has
been used).

• %SIZES – sizes of the strands e.g 1/2 or 1/2 + 3/8.

• %GRADES – grades of strands.

Strand creation at voids

Create strand at voids – The option Yes will show the strands even though
the voids are present. The option No will not show the strand if void is present
at any location along the strand path.

Select to cut the strands at void locations from Cut strands at voids.

6.4 CS Components
Topics

This chapter contains the following topics:
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• 3D cut (10) (page 3652)

• Opening in wall (40) (page 3653)

• Rebar in beam (90) (page 3660)

• Border rebar for single edge (93) (page 3676)

3D cut (10)
The 3D cut (10) component creates a 3D cut to a concrete part. The cutplane
is determined by picking three points on the (concrete) part edges. The cut
direction can be set. Also an cut offset can be set.

Use for

Situation More information
This component creates a cut through
three points.

The side to be removed can be
defined.

Before you start

Before applying the macro, create the following part:

• Concrete part (panel, column, strip footing)

Defining properties

The component contains only one tab, named Picture.

Tab Content
Picture Defining the cut direction. Possibly set

an cutplane offset.

Picking order

1. Concrete part.

2. Three points to determine the cut plane.
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Picture tab
You can define the following settings on the Picture tab.

Cut type

Option Description
Cut right The parts’ right side from the cut plane will be

removed.
Cut left The parts’ left side from the cut plane will be

removed.
Fit plane The removed part is the shortest part (from fit plane

to part’s end).
No cut No cut is applied.

Offset

You can define the offset for the cut plane. The offset distance is always
perpendicular to the cut plane.

Explode component

You can select to explode the component if you do not need to modify the
component after applying it. If you plan to modify the component later, select
not to explode it.

Opening in wall (40)
Opening in wall (40) creates an opening in a concrete wall of adjustable size,
shape and position. Can also add an insulation panel to the wall.

Objects created

• Opening

• Insulation (optional).
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Use for

Square or circular opening in a wall and adding insulation to the wall.

define rabbet several openings

adding insulation braced girders

Before you start

Create the wall for example as a concrete panel or column.

Opening tab
Use the Opening tab to define the shape and size of the opening.

Type

First you can define the type of the opening. The options are:

• Opening

• Opening no rabbet

• Opening with rabbet

• Opening only outside

• Opening only inside
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Opening Opening with rabbet Opening only
outside

Horizontal position

The horizontal reference point for creating the opening can be selected from a
picklist. In the table below are the available options.

Option Description Example
Point is left side
opening

The opening is
created on the left
side from the
component insertion
point.

Point is middle
side opening

The middle of the
opening is created
from the component
insertion point.

Point is right side
opening

The opening is
created on the right
side from the
component insertion
point.

Start panel The opening is
created from the
startpoint of the wall.
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Option Description Example
End panel The opening is

created from the
endpoint of the wall.

Middle panel =
left opening

The center of the wall
is referencepoint. The
opening is created to
the left side.

Middle panel =
middle opening

The center of the wall
is referencepoint. The
opening is also
created from the
middle.

Middle panel =
right opening

The center of the wall
is referencepoint. The
opening is created to
the right side.

Vertical position

The horizontal reference point for creating the opening can be selected from a
picklist. In the table below are the available options.

Option Description Example
Pos point bottom
opening

The opening is
created on the left
side from the
component insertion
point.
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Option Description Example
Point is middle
opening

The middle of the
opening is created
from the component
insertion point.

Pos point top
opening

The opening is
created on the right
side from the
component insertion
point.

Bottom panel The opening is
created from the
startpoint of the wall.

Top panel The opening is
created from the
endpoint of the wall.

Middle panel =
bottom opening

The center of the wall
is referencepoint. The
opening is created to
the left side.
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Option Description Example
Middle panel =
middle opening

The center of the wall
is referencepoint. The
opening is also
created from the
middle.

Middle panel =
top opening

The center of the wall
is referencepoint. The
opening is created to
the right side.

Horizontal/Vertical offset

The opening can be moved vertically and horizontally by using these two
offset value fields.

Rabbet - side

With this picture picklist you can define the side where the rabbet is created.

Cut - rotation

With this picture-picklist you can define the rotation of the cut.
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Shape of the opening

With the picklist you can choose the general shape of the opening in the wall.

The default shape is a rectangular opening. The other shape is the circular
shape.

Concrete components reference 3659 CS Components



Insulation tab
Use the Insulation tab to define insulation thickness, offset and creation of
partcut.

The option ’Cut opening size’ can be used to define if the insulation should be
cut at the opening in the wall.

Option Description
t b h Define the thickness, width, and

height of the part.
Pos_No Define a prefix and a starting number

for the part position number.

Enter the assembly position number
on the second row.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .

Material Define the material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Define a name that is shown in
drawings and reports.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Parameters tab
Use the Parameters tab to create assembly panel insulation.

Possiblilty to weld the insulation to the panel to get an assembly.

Three options available: Default, Yes and No. Default option is same as Yes.

Rebar in beam (90)
Rebar in beam (90) adds reinforcement bars to concrete beams.
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Parts created

Complete reinforcement structure: stirrups and perpendicular rebars are
created in the concrete part.

Use for

Situation More information
Rebars in concrete
beam.

Rebars in a concrete
column.

Do not use for

Use this component to add reinforcement bars to a concrete part.

Before you start

Before the component can be created, you need to create a concrete part first.
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Primary bottom bars tab
Use the Primary bottom bars tab to define the properties of the lower
reinforcing bars.

Properties

Option Description
Grade Defines the grade of the main bottom

reinforcing bars. This field cooperates
with the Size field.

Size Defines the diameter of the main
bottom reinforcing bars. Pressing
the ... button right of the field will
open the Select rebar dialog box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

Bend lengths left Defines the length of the left end-
extension.

Bend lengths right Defines the length of the right end-
extension.

End conditions left/right

Picklist to define the rebars’ end condition on the left and right side. The
options are:

Picklist item Example
Default

90 Degree

135 Degree

Concrete components reference 3662 CS Components



Picklist item Example
180

-180

-135

-90

-45

45

Bar not to create

Picklist to define which rebar should not be created. The options are:

Picklist
Item

Example

_
O
_
O
_
O
_
O
_
O
_
_
.
_
O
_
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Picklist
Item

Example

O
_
O
_
.
_
_
O
_
O
_
O
_
O
_
.
_
_
.
_
O
_
O
_
O
_
.
_

Creation method

This field defines the way the rebars are created. There are three options:

Option Description
No rebars No bottom rebars are created.
Number of bars A fixed numer of bars is created. The

spacing between the bars is
automatically calculated.

By spacing A accompanying field becomes
active. The entered value is the fixed
spacing for the rebars. The number
of rebars is calculated automatically.

Positioning and distances

In the right upper side of this tab a picture and some picklists are displayed.
These fields and lists are to define the position and de rebar distances.

The distance fields are used for defining the size of the rebars. The picklists
are for positioning. Below some examples for the positioning rebars on the
left side:
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Picklist
item

Description Example

The part edge is
normative for
positioning the rebar.

The concrete parts’
reference point is
normative for
positioning the rebar.
The picked position is
normative.

The edge of the top
part cut is normative
for positioning the
rebar.
The edge of the
bottom part cut is
normative for
positioning the rebar.
The centerline of the
concrete part is
normative for
positioning the rebar.
 

 

  

 

Shape and pattern

The picklists and input fields are used to define the rebar shape, rebar pattern
and rebar distribution.
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In the left bottom side of the tab, some picklists are available for defining the
shape and distribution of the bottom rebars.

A - Shape of rebar

These picklists define the common shape of the rebars on both ends of the
concrete part. For some shapes distances can be entered (B).

B - Distance fields

These distance fields only apply for two rebar shapes (A).

C - Rebar pattern

Picklist for defining the rebar pattern. The picklist contains six options:

D - Consider part cuts in longitudinal direction

This picklist defines if part cuts in the concrete part should be taken into
account when positioning the rebars.
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Picklist
item

Example

E - Consider part cuts in vertical direction

These picklists contain options for defining if rebar shape should consider the
partcuts in vertical direction. For both top side and bottom side the placing
can be defined. Examples:

Picklist item Example

Side left tab
Use the Side left tab to create and define the properties of the horizontal
rebars on the left side.

Concrete components reference 3667 CS Components



The rebars which can be created are placed in longitudinal direction (just as
the Primary bars), but now the bends are created horizontally. The options on
this tab (defining rebar shape, dimensions, number of bars, and rebar
distribution) are similar to the options on the Primary bottom bars tab.

Examples of rebars which can be created with this tab:

Side right tab
Use the Side right tab to create and define the properties of the horizontal
rebars on the right side.
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Similar to the Side left tab, but now the reference is the parts’ right side.

Stirrups tab
Use the Stirrups tab to define the dimensions of the stirrups in first section of
the concrete part.

In the picture below, the options are grouped.

Section A - Stirrup dimensions
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Option Description
Grade Defines the grade of the main bottom

reinforcing bars. This field cooperates
with the Size field.

Size Defines the diameter of the main
bottom reinforcing bars. Pressing
the ... button right of the field will
open the Select rebar dialog box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

Bend lengths left Defines the length of the left end-
extension.

Bend lengths right Defines the length of the right end-
extension.

Section B - Stirrup dimensions

One input field is available for defining a fixed distance from concrete parts’
bottom side to bottom side of stirrup.

NOTE This offset is normative.

The input fields in the bottom side of this section are for defining the offset,
width and height of the stirrups.

Section C - Stirrup shape

In this section the general shape of the stirrups is defined.

First there is the Create stirrups option. This picklist has three options:

• No - No stirrups are created

• As one group - Stirrups are created as one group

• As separate group - Stirrups are created as separate groups

The general shape of the stirrup can be defined. You can choose a shape from
the picklist:
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Picklist
item

Description Example

No stirrups are
created

U-shape stirrups

C-shape inside

Closed box

Closed box
overlap
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Picklist
item

Description Example

Divided stirrup

Divided stirrups
overlap

 

Double U-shape

Single U-shape
left

Single U-shape
right

Stirrup rotation

The rotation of the stirrups can be set with below picklist. The picklist contains
four options: each option will rotate the stirrup 90 degrees counterclockwise.
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Stirrup spacing tab
Use the Stirrup spacing tab to define the distribution of the stirrups along the
concrete part.

You can define six zones for the distribution. For each zone you can set a
number of stirrups. The distance between the stirrups can be defined in two
ways:

• Fixed spacing between each stirrup.

• Distance between outer stirrups. (Spacing is then calculated from this
distance divided by the number of stirrups.)

Examples:

Picklist item Example
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Stirrups 2 tab
Use the Stirrups 2 tab to define a second group of stirrups.

This tab can be used if the shape of the concrete part is not uniform. For
example, if a part cut is applied, you may need different stirrups on that area.

Stirrups 2

Stirrups

Stirrups 2 spacing tab
Use the Stirrups 2 spacing tab to define the spacing of the second group of
stirrups.

Stirrups 3 tab
Use the Stirrups 3 tab to define a third group of stirrups.

You may need this tab in case the concrete part contains multiple part cuts.
For each area, the properties of the stirrups can be configured.

Example:
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Stirrups 2

Stirrups

Stirrups 3

Stirrups 3 spacing tab
Use the Stirrups 3 spacing tab to define the spacing of the third group of
stirrups.

Advanced tab
Use the Advanced tab to define the naming and numbering properties of
rebars and stirrups.

The following information can be added:

• Comment

• Name

• Rebar profile Default Name
Main bottom rebars RB
Main top rebars RB
Side left RB
Side right RB
Stirrups STIRRUP
Stirrups2 STIRRUP
Stirrups3 STIRRUP

• Class

If the Class fields are left blank, then the following default classes will be
used:

Rebar profile Default Class
Main bottom rebars 201
Main top bars 202
Side left 203
Side right 204
Stirrups 301
Stirrups2 302
Stirrups3 303
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• Series

If this field is left blank, the prefix will be empty for all rebar profiles.

• Start number

If this field is left blank, Tekla Structures will use '1' as default start number
for all rebar profiles.

Configuration tab
Use the Configuration tab to define the bending radius and rotation.

Bending radius

The bending radius can be set separately for the main reinforcing bars and the
stirrups. Furthermore the radius can be set separately for the main bends and
the hook-bends.

The bending radius can be determined in three ways:

Picklist item Description
rebar_database.inp The bending radius is determined

from a configuration file
rebar_database.inp. This file is
located in the profil folder.

Relative to
diameter

For this option the radius is
calculated by multiplying the
reinforcing bar diameter with the
entered coefficient.

Bending radius Use this option to use a fixed value
for the bending radius.

Rotation

The picklist determines the orientation of the complete rebar structure in the
concrete part. The picklist contains four options, each item representents a 90
degree rotation.

Border rebar for single edge (93)
Border rebar for single edge (93) creates hairpin rebars in a concrete panel
or wall.

Parts created

Hairpin rebars.

Use for

Use this component for creating hairpin rebars in a concrete panel.
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default beam default panel

default floor

border reinforcing bars

Before you start

Before applying the component, the following parts must be created:

• Concrete panel or wall

Pins tab
Use the Pins tab to define the properties of the lower reinforcing bars.

Properties

Option Description
Grade Defines the grade of the main bottom

reinforcing bars. This field cooperates
with the Size field.

Size Defines the diameter of the main
bottom reinforcing bars. Pressing
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Option Description
the ... button right of the field will
open the Select rebar dialog box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

Bend lengths left Defines the length of the left end-
extension.

Bend lengths right Defines the length of the right end-
extension.

End conditions left/right

Picklist to define the rebars’ end condition on the left and right side. The
options are:

Picklist item Example
Default

90 Degree

135 Degree

180

-180
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Picklist item Example
-135

-90

-45

45

Pin spacing tab
Use the Pin spacing tab to define the distribution of the hairpins along the
concrete part.

You can define six zones for the distribution. For each zone you can set a
number of hairpins. The distance between the hairpins can be defined in two
ways:

• Fixed spacing between each stirrup.

• Distance between outer hairpins. (Spacing is then calculated from this
distance divided by the number of hairpins).

Advanced tab
Use the Advanced tab to define additional information to the hairpins.

Option Description
Comment Add a comment about the part.
Name Name that is shown in drawings and

reports.
Class Part class number.
Serie Prefix for the part position number.
Start number Start number for the part position

number.
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Configuration tab
Use the Configuration tab to define the bolt pattern and extra rotation.

Extra rotation

This picklist allows you to rotate the hairpin rebars. There are three options:

No Around X Around Y

Bending radius sec

The bending radius can be determined in three ways:

Picklist item Description
rebar_database.inp The bending radius is determined

from a configuration file
rebar_database.inp. This file is
located in the profil folder.

Relative to
diameter

For this option the radius is
calculated by multiplying the
reinforcing bar diameter with the
entered coefficient.

Bending radius Use this option to use a fixed value
for the bending radius.

Detect outside geometry

This parameter can be used to detect part cuts in the concrete part. The
search area is defined with two parameters:

Distance in material and a Position in plane picklist.

Use these parameters to define the reference for the rebars. See the examples
below for more clarification:
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(The concrete panel has thickness 200 mm. The partcut depth is 100 mm.)
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Draw geometry with profiles

Picklist to define if geometry profiles should be created or not. These
geometry profiles define the rebar insertion point, which is based on the
values for distance in material and can help setting up the rebar pattern.
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Detect negative volume

If a negative volume is applied to the concrete panel, you can define whether
this negative volume should be recognised or not.

In below example a part cut is added with depth of 110 mm. If the value field is
set to 0, the rebars can not be placed correctly.

If the value field is set equal or greater to the part cut depth (e.g. 110), the
panel thickness will be recognised and the rebars are placed correctly.

Difference in thickness
= 0

Difference in thickness
= 110

Draw axis

The Draw axis picklist has two options: Yes and No. If Yes is chosen, the
component creates extra colored profiles. This can help to set up the
component and gives more clearness in component orientation.

If No is chosen, the extra colored profile are omitted.

Concrete components reference 3683 CS Components



Concrete components reference 3684 CS Components



Index

dimension tag D..........................................152

3
3D

drawing views........................................645
rotation of views................................... 645

A
absolute dimensions.................................. 653
accuracy......................................................... 67

in modeling............................................ 417
of parts................................................... 417
of profiles............................................... 417

activated licenses........................................627
activating licenses....................................... 627
adaptivity........................................................67
advanced options..........................................55
AISC weld marks............................................68
analysis and design

settings................................................... 733
analysis areas

edge properties.....................................768
position properties............................... 768

analysis axis
options for parts................................... 763

analysis bars
position properties............................... 767

analysis class............................................... 760
analysis models

properties.............................................. 744
analysis nodes

properties.............................................. 765
analysis parts

properties.............................................. 750
analysis type................................................ 760
anchor bolt plans........................................ 645
angle............................................................. 729
angle dimensions .......................................653

anti-aliasing................................................. 463
appearance..................................................704

of marks................................................. 678
of model weld marks in drawings.......689

application error log..................................... 76
applications

folders.......................................................76
arcs............................................................... 729
area calculations

including turning corners.....................515
sandwich walls.......................................515

area loads
properties.............................................. 736

arrows
in sketch objects....................................729
reinforcing bar dimension lines.......... 349

assemblies
numbering loose parts.........................440

assembly bottom level
global...................................................... 491

assembly drawings
dimensioning.........................................669

assembly position ...................................... 695
assembly top level

global...................................................... 494
assembly type............................................. 697
associative notes

placing.................................................... 726
asterisk......................................................... 111
AutoConnection

connecting built-in members.............. 124
tolerance.................................................. 86
UDL........................................................... 86

autosave
folder........................................................ 88

B
back drawing views.....................................645
background color..........................................88
background mask....................................... 692

3685



bar class....................................................... 698
bar diameter................................................698
bar length.....................................................698
bar marks.....................................................700
bar name......................................................698
bar quantity................................................. 698
bar shape..................................................... 698
bar weight....................................................698
basic view

height........................................................91
horizontal position..................................91
vertical position....................................... 91
width......................................................... 92

bent plate
template attribute.................................534

block prefix.................................................. 700
bolt diameter ..............................................697
bolt length....................................................697
bolt mark contents

size..............................................96,389,410
bolt marks

elements.................................................697
bolt standard............................................... 697
Bolted gusset brace (167)........................ 2691
bolts in drawings

filtering away bolt types....................... 320
omitting bolt types................................320

bolts
bolt axis representation......................... 99
dimensioning.........................................671
marks...................................................95,96
properties.............................................. 710

bolt’s full name............................................697
bolt’s short name........................................ 697
bottom drawing views................................645
bottom level

global...................................................... 497
box profiles..................................................771
bracing components

corner bracing connections...............2526
simple gusset plate connections.......2403

bracing connections
double bent gusset (140)................... 2646
heavy brace gusset (165)................... 2648
simple gusset plate.............................2403
windbrace connection (110).............. 2653
windbracing (1)....................................2651

bracing elements

crushed tube in points (S48)..............2658
gusset tube in bolts (S49)...................2659
gusset tube in points (S47)................ 2657

bracing panels
create....................................................2682

BS...........................................................315,316
building objects...........................................645
built-up

beams...................................................2340
columns................................................2356
connections and details..................... 2369
frames.................................................. 2363

bulge.............................................................729

C
c profiles.......................................................771
c/c format.....................................................108
camber ........................................................ 695
cast unit drawings

dimensioning.........................................669
cast-in-place.............................................. 3524
cast-in-situ................................................. 3524
cc............................................................698,699
center-to-center distance................... 695,697
chamfer

accuracy.......................................... 108,133
length accuracy..................................... 109

change symbol............................................ 264
changes in drawings ..................................504
CIMsteel

database name......................................115
database path........................................116
express file.............................................116
password................................................115

CIP...............................................................3524
circles............................................................729
circular hollow sections..............................771
circular sections.......................................... 771
clash check

reinforcing bars.....................................117
class.............................................................. 695
CNC....
119,120,221,222,224,225,227,228,229,230,
307,380
cold rolled profiles...................................... 771
color

background..............................................88

3686



colors
by analysis type..................................... 760
in drawings.............................................441
pour breaks............................................339
pour objects...........................................340

column marks
angle....................................................... 167

columns
mark text angle..................................... 167

column
vertically in drawings............................ 467

combining
dimensions............................................ 662

company settings........................................121
company.ini................................................. 121
components

page 10...................................................420
page 9..................................................... 420

concrete components.............................. 2802
concrete detailing..................................... 2802
concrete stairs

about.................................................... 3212
connecting side mark................................. 304
connecting side marks............................... 704
connecting side symbol...................... 123,252
connections

brace to tower leg...............................2684
double bent gusset (140)................... 2646
DSTV code.............................................. 701
error........................................................701
group...................................................... 701
heavy brace gusset (165)................... 2648
marks......................................................701
name.......................................................701
number...................................................701
origin.......................................................551
running number....................................701
seating (concrete)................................2803
windbrace connection (110).............. 2653
windbracing (1)....................................2651

content......................................................... 704
contents

of marks................................................. 693
continuous beam

reinforcing........................................... 3524
control numbers

settings................................................... 603
corbel connection (14)..............................2832

countersunk.................................................697
cross arms

create....................................................2681
crushed tube in points (S48)................... 2658
Crushed tube in points (S64)...................2656

D
deactivating licenses...................................627
design values................................................. 59
destination folder....................................... 307
detail marks

detail name............................................ 703
elements.................................................703
source drawing name...........................703

detail views.................................................. 476
name.......................................................704
view label mark elements.................... 704

detailed object level settings..................... 645
diameter prefix..............................................95
dimension format....................................... 656
dimension point change symbol...............264
dimension tags............................................659

tag D........................................................152
dimensioning

properties.............................................. 652
dimensions

absolute..................................................653
angle....................................................... 653
appearance............................................ 658
arrow size...............................................658
bolts........................................................ 671
closing.....................................................662
combining.............................................. 662
creation method....................................645
dimension format................................. 656
dimension line color............................. 472
extension line origin offset.................. 149
extension lines...................................... 653
formats...................................................653
forward offset........................................662
general arrangement drawings...........675
grouping..........................................653,673
level.........................................................653
line arrow............................................... 658
marks......................................................659
minimizing views...................................662
opaque................................................... 658

3687



part dimensions.................................... 676
placing.............................................653,726
position properties............................... 666
positioning............................................. 676
precision......................................... 653,656
properties................................652,653,669
recognizable distance...........................662
reinforcement........................................675
relative....................................................653
straight................................................... 653
sub-assemblies......................................674
tags.................................................. 152,659
text color................................................ 472
transparent............................................ 658
type......................................................... 662
types....................................................... 653
units.................................................653,656
US absolute............................................653

distance between groups.......................... 700
double bent gusset (140)......................... 2646
dragging

drawing views........................................111
drawing sheet position on screen............ 210
drawing views

exporting frames...................................331
printing frames......................................331

drawing views
3D............................................................645
back.........................................................645
bottom....................................................645
coordinate system................................ 645
direction marks..................................... 645
dragging................................................. 111
end.......................................................... 645
front........................................................ 645
neighbor part visibility..........................477
scale........................................................ 645
section.................................................... 645
section view properties........................ 650
settings................................................... 645
top...........................................................645
view label symbols................................ 645
visualizing detail views......................... 476
visualizing section views.......................476

drawings
opening maximized.............................. 322
settings................................................... 637

DWG

importing........................................ 232,270
DXF

file size....................................................261
text height..............................................233

E
edge chamfers.............................................704
elements

in bolt marks..........................................697
in connection marks............................. 701
in detail view label marks.....................704
in marks.......................................... 693,694
in merged reinforcement marks.........700
in neighbor reinforcement mesh marks
.................................................................699
in part marks......................................... 695
in reinforcement marks........................698
in reinforcement mesh marks.............699
in section view label marks..................704
in surface treatment marks................. 702
in view label marks............................... 704

elevations
datum point........................................... 645

end offsets................................................... 599
end views..................................................... 645
entitled licenses.......................................... 627
environments.............................................. 135
extrema, see view boundaries.................. 476

F
face direction...............................................695
fill.................................................................. 704
fillet edges....................................................704
filtering away bolt types in drawings........320
filtering

separator................................................249
finish.............................................................695
firm folder....................................................249
fittings (NS/FS) ............................................ 695
fixed..............................................................111
flat bars........................................................ 112

designation............................................ 447
setting the prefix................................... 250
thickness tolerance...............................251
tolerance................................................ 251

3688



folded plates................................................771
font

default.................................................... 137
default font size.....................................138
for cut symbol........................................134
for dimension........................................ 150
for DXF....................................................233
for grid text............................................ 257
for reports..............................................341
in marks..................................................290

forces..............................................................59
forward offset..............................................662
front drawing views.................................... 645
FS........................................................... 315,316

G
gage format................................................. 107
gage of outstanding leg...................... 695,697
general arrangement drawings

dimensions............................................ 675
GOL format..................................................253
graphic adapter

overriding...............................................464
graphical objects.........................................729
grid dimensions.......................................... 675
grid labels

in drawings.............................................731
grids

labels in drawings................................. 731
overall dimension................................. 256
properties in drawings......................... 731

grouping
dimensions............................................ 673

gusset tube in bolts (S49).........................2659
gusset tube in points (S47)...................... 2657

H
hard stamps.................................................380
hat profiles...................................................771
hatch patterns

surface treatment................................. 712
hathces

in drawings.............................................185
haunch profiles

showing in drawings.............................217

heavy brace gusset (165)......................... 2648
Help

location...................................................260
hole diameter.............................................. 697
hole marks

size...................................................391,412
size of slotted holes............... 284,393,414

hole size....................................................... 697
holes

slotted hole dimension.........................187
horizontal position......................................598

I
i beams (concrete)...................................... 771
i beams (steel)............................................. 771
i profiles....................................................... 771
importing DWG........................................... 270
importing

DWG files................................................232
inches

disabling................................................. 375
symbol in dimensions.............................69
symbol in welds.......................................70

int arrays...................................................... 141
internal bending type................................. 565
internal shape............................................. 565
irregular beams (concrete)........................ 771
ISO weld marks..............................................68

L
l profiles....................................................... 771
leader lines

types....................................................... 685
ledger beams (concrete)............................ 771
Leg - 1 diagonal (178)............................... 2689
Leg - 2 and 3 diagonals (177) ..................2688
length .......................................................... 695
level attributes..................................... 497,575
level dimensions......................................... 653
level marks

properties.............................................. 692
license server statistics.............................. 627
licenses

activating................................................627
deactivating............................................627

3689



information on Tekla License Borrow
Tool......................................................... 629
setting default license for a user role.138

line loads
properties.............................................. 736

line width........................................................90
lines.............................................................. 729
LMTOOLS

options................................................... 631
Server Status tab...................................631
Service/License File tab........................ 631
Start/Stop/Reread tab.......................... 631
System Settings tab.............................. 631
Utilities tab.............................................631

load combination
factors.....................................................741
properties.............................................. 741
settings................................................... 741
types....................................................... 742

load groups
properties.............................................. 733

load modeling code
options................................................... 741

load panel.................................................... 739
loads

load panel properties........................... 739
properties.............................................. 735

locale............................................................ 419

M
mark elements

pours.......................................................702
MarkDimensionFormat.dim 490,497,574,575
marks............................................................645

view label marks....................................704
appearance............................................ 678
bolt marks.............................................. 697
bolts..................................................... 95,96
common elements................................694
connection marks................................. 701
content................................................... 678
contents................................................. 693
detail marks........................................... 703
detail view label marks.........................704
drawing weld marks............................. 686
elements......................................... 693,695
in dimensions........................................ 659

level marks.............................................692
line space............................................... 296
merged reinforcement marks ............ 700
model weld marks................................ 689
neighbor reinforcement.......................698
placing.................................................... 726
positioning............................................. 686
properties.............................................. 678
reinforcement........................................698
reinforcement marks............................699
section marks........................................ 703
section view label marks...................... 704
space between elements..................... 290
surface treatment marks..................... 702

material........................................................ 697
material ....................................................... 695
material grade.............................................698
maximum leader line length..................... 676
member axis location.................................763
mesh bar by area......................................3315
mesh bars.................................................. 3315
mesh class................................................... 698
mesh diameter............................................699
mesh length.................................................699
mesh name..................................................698
mesh shape................................................. 698
mesh size..................................................... 699
mesh weight................................................ 698
mesh width.................................................. 699
mesh

properties.............................................. 714
minimizing views.........................................662
MIS................................................................ 307
model views

overriding graphic adapter.................. 464
modeling

more accurately.................................... 417
moving

views on screen.....................................302
multi-byte languages..................................419
multidrawings

view title............................................ 78,253
multinumbers...............................310,450,451

available characters.............................. 470
format........................................ 81,104,326
model prefix................................... 308,450
number of characters................... 305,306
numeric.................................................. 453

3690



order....................................................... 423
view title................................................. 310

N
name.............................................................695
NC....
120,221,222,224,225,227,228,229,230,307,
380
NC files

error........................................................119
inner shape options..............................222
notch corner roundings....................... 222

neighbor parts
properties.............................................. 704
view extension.......................................645
view extensions.....................................477

neighbor reinforcement marks
elements......................................... 698,699

north mark symbol..................................... 315
hidden.................................................... 261
in GA drawings...................................... 254
scale........................................................ 315
scale in GA drawings.............................254

NS.......................................................... 315,316
number of bars........................................... 698
number of bolts ......................................... 697
number of visible reinforcing bars........... 550
numbering settings.....................................601
numbering

settings.................................... 601,602,603

O
object groups

in dimensioning.....................................676
object level settings.................................... 645
offset............................................................ 729

forward offset........................................662
offsets...........................................................599
omitting bolt types in drawings................ 320
opening

drawings maximized.............................322
openings and recesses

showing in views................................... 645
orientation mark......................................... 261
orientation marks....................................... 254

others........................................................... 771

P
panels........................................................... 771
parametric profiles

available in Tekla Structures................771
predefined............................................. 771

part marks
elements.................................................695

part position ............................................... 695
part position

on the work plane................................. 593
partial safety factors...................................741
parts

analysis properties................................750
created by bracing components....... 2401
dimensions............................................ 676
glossary................................................ 2401
position settings....................................592
properties.............................................. 704
representation.......................................202
shortening in views........................395,396

placing
associative notes...................................726
dimensions............................................ 726
fixed........................................................ 111
marks......................................................726
symbols.................................................. 726
texts........................................................ 726

point loads
properties.............................................. 735

points
create in tower (S43, S66).................. 2702

polybeam length calculation..............101,455
polygons.......................................................729
polylines....................................................... 729
pop-marks....................................................704
positioning properties

section marks........................................ 686
view label marks....................................686

position
depth...................................................... 595
end offsets............................................. 599
horizontal...............................................598
part position settings............................592
rotation...................................................594
vertical.................................................... 596

3691



pour breaks
colors...................................................... 339
properties.............................................. 723
symbol.................................................... 340

pour objects
colors...................................................... 340

pours............................................................ 238
in drawings.............................................723
mark elements...................................... 702
properties in drawings......................... 723

precision.......................................................656
printing

dialog...................................................... 366
drawing title...........................................445
remembering dialog values................. 366
to file.......................................................202

product_finishes.dat...................................712
profile .......................................................... 695
profiles

accuracy................................................. 417
parametric............................................. 771
predefined............................................. 771

properties
analysis models.....................................744
analysis parts.........................................750
bolts........................................................ 710
grids in drawings...................................731
load combination.................................. 741
loads....................................................... 735
marks......................................................678
meshes................................................... 714
parts........................................................704
reinforcement........................................714
surface treatment................................. 711

protecting areas.......................................... 441
pull-out pictures..........................................698
pull-outs....................................................... 353
pullout pictures........................................... 717

R
Rebar Shape Manager................................466
rebars

dimension line symbols....................... 349
RebarShapeRules.xml................................ 466
rebar_config.inp.......................................... 717
rectangles.................................................... 729
rectangular hollow sections...................... 771

rectangular sections................................... 771
reduction factors.........................................741
reference lines

in drawings.............................................201
reference models

reference cache.....................................365
reference points

size.......................................................... 209
reflected views............................................ 645
reinforcement marks

elements..................................698,699,700
reinforcement mesh

properties.............................................. 714
reinforcement position.............................. 698
reinforcement settings for drawings........717
reinforcement

checking shape......................................353
dimensions............................................ 675
for foundations................................... 3289
hooks...................................................... 353
properties.............................................. 714

reinforcing bar groups
number of visible reinforcing bars..... 550

reinforcing bars
clash check.............................................117
dimension line symbols....................... 349
length and weight................................. 466
properties.............................................. 714

reinforcing
continuous beam................................ 3524

relative dimensions.................................... 653
relative path in file location....................... 307
reports

settings................................................... 732
titles........................................................ 732

representation
parts........................................................202

restriction box, see view boundaries....... 476
rigid links

properties.............................................. 766
roles

setting default role for a user..............138
rotating

parts........................................................594
rows

in templates........................................... 444
template rows........................................444

3692



S
SDNF............................................................. 379
seating connections..................................2803
section marks

elements.................................................703
positioning properties.......................... 686
section name......................................... 703
source drawing name...........................703

section views........................................ 476,645
label mark elements............................. 704
name.......................................................704
properties.............................................. 650
rotation...................................................373

settings
analysis and design properties........... 733
analysis area edge properties............. 768
analysis area position properties........768
analysis bar position properties..........767
analysis model properties....................744
analysis node properties......................765
analysis part properties....................... 750
area load properties............................. 736
bolt dimensioning properties..............671
bolt mark elements...............................697
bolt properties.......................................710
common elements in marks................694
connection mark elements.................. 701
dimension appearance properties..... 658
dimension format................................. 656
dimension grouping properties.......... 673
dimension mark properties.................659
dimension properties............ 652,653,662
dimension tag properties.....................659
dimensioning properties......................652
drawing view properties.......................645
drawing weld mark properties............ 686
drawings.................................................637
grid and overall dimensioning properties
.................................................................675
grid properties in drawings................. 731
leader line types....................................685
level mark properties........................... 692
line load properties...............................736
load combination properties...............741
load group properties.......................... 733
load panel properties........................... 739
load properties......................................735

mark appearance..................................678
mark content......................................... 678
mark contents....................................... 693
mark properties.................................... 678
merged reinforcement marks............. 700
neighbor reinforcement mark elements
.................................................................698
numbering settings................ 601,602,603
part and neighbor part properties......704
part dimensioning properties...... 669,676
part mark elements.............................. 695
part position settings............................592
placement properties........................... 726
point load properties............................735
position dimensioning properties.......666
positioning properties.......................... 686
reinforcement and mesh..................... 714
reinforcement dimensioning properties
.................................................................675
reinforcement mark elements............ 698
reinforcement mesh mark elements..699
reinforcement properties.................... 604
reinforcement settings for drawings..717
reports....................................................732
rigid link properties...............................766
section and detail mark elements.......703
sketch objects........................................729
sub-assembly dimensioning properties
.................................................................674
surface treatment hatch pattern
properties.............................................. 712
surface treatment mark elements...... 702
surface treatment visibility and content
properties.............................................. 711
Tekla License Administration Tool...... 627
temperature load properties...............737
uniform load properties.......................737
view, section view and detail view label
marks......................................................704
weld mark visibility options................. 689
wind load properties............................ 738

sheet
position on screen................................ 210

shortening....................................................645
parts in views................................. 395,396

single mark content....................................700
single-part drawings

dimensioning.........................................669

3693



size................................................................695
sketch objects..............................................729
slot height.................................................... 697
slot length ................................................... 697
slotted hole mark contents

size...................................................393,414
snapping mode........................................... 279

absolute..................................................279
global...................................................... 280
relative....................................................280

snapping
to end points......................................... 194

solid buffer size...........................................416
spiral beams

template attributes............................... 537
stacked fractions.........................................418
steel components....................................... 805
straight dimensions....................................653
sub-assemblies

dimensioning.........................................674
surface treatment

class........................................................ 702
code........................................................ 702
marks......................................................702
material.................................................. 702
name.......................................................702

surface treatment
hatch patterns....................................... 712
properties.............................................. 711

surfacing.htc................................................ 712
symbol separating blocks in mark............700
symbols........................................................ 694

placing.................................................... 726
reinforcing bar dimension lines.......... 349

T
t profiles....................................................... 771
t profiles (concrete).....................................771
table attributes............................................483
tapered component properties.............. 2397
Tekla License Borrow Tool

license information...............................629
options and settings............................. 629

Tekla License Administration Tool
options................................................... 627

temperature loads
properties.............................................. 737

template attributes.....................................483
templates

in marks..................................................694
texts.............................................................. 694

in marks..................................................694
placing.................................................... 726

timeout.........................................................251
titles in reports............................................ 732
tolerance........................................................ 67
top drawing views.......................................645
top level................................................ 574,575

global...................................................... 575
Tower 1 diagonal (87)...............................2685
Tower 2 diagonal (89)...............................2686
tower bracing

modify.................................................. 2697
tower components

brace to brace connections............... 2690
brace to tower leg connections.........2684
create bracing panels......................... 2682
create cross arms................................2681
create legs............................................2680
create tower........................................ 2678
modify bracing.................................... 2697

tower legs
create....................................................2680

tower
create....................................................2678

types
dimensions............................................ 653
of leader lines........................................ 685

U
u profiles...................................................... 771
UDAs, see user-defined attributes............694
undeformed.................................................645
unfolded.......................................................645
uniform loads

properties.............................................. 737
units..............................................................656

converting.............................................. 128
user-defined attributes

in marks..................................................694
user-specific settings.................................. 467

3694



V
variable cross sections............................... 771
variables

see advanced options.............................55
vertical position...........................................596
view boundaries

seeing in other views............................ 476
view extension for neighbor parts............477
view extrema, see view boundaries......... 476
view label marks

positioning properties.......................... 686
view labels

mark elements...................................... 704
name.......................................................704

view restriction box, see view boundaries ....
476
views

drawing name........................................704
label mark elements............................. 704
name.......................................................704
scale........................................................ 704
source drawing name...........................704

visibility.........................................................704
of model weld marks............................689

W
weld marks.................................................. 686

model weld mark visibility in drawings....
689
model weld markappearance..............689

weld numbers
showing.................................................. 689

weld symbols.................................................68
welded beam profiles.................................771
welded box profiles.................................... 771
welding properties......................................728
welds

inches in weld marks............................ 456
mark properties in drawings............... 686
minimum edge length.......................... 479
model weld mark appearance.............689
model weld mark visibility in drawings....
689
model weld properties......................... 728
numbering............................................. 602
reference line length.............................306

Wind Load Generator (28)
properties.............................................. 738

wind loads
properties.............................................. 738

windbrace connection (110).................... 2653
windbracing (1)..........................................2651
wq profiles................................................... 771

X
XS_USE_OLD_PLOT_DIALOG...................... 202

Z
z profiles.......................................................771
zooming

defining zoom ratio...............................481
original....................................................237
tolerance for mouse movements....... 329

3695



3696


	Contents
	1  Advanced options reference
	1.1 Advanced options - 
	 A
	XS_AD_ANALYSIS_PLANES_ENABLED
	XS_AD_CURVED_BEAM_SPLIT_ACCURACY_MM
	XS_AD_DRAW_BAR_DIAMETER_MM
	XS_AD_DRAW_NODE_SCALE
	XS_AD_ELEMENT_ANGLE_CHECK_ANGLE_DIFF_LIMIT
	XS_AD_ENVIRONMENT
	XS_AD_GET_MOMENT_CONNECTION_STATUS
	XS_AD_GET_RESULTS_DESIGN_VALUES
	XS_AD_GET_RESULTS_FORCES
	XS_AD_LOAD_COMBINATION_METHOD
	XS_AD_MEMBER_NUMBER_VISUALIZATION
	XS_AD_MEMBER_RESULT_DISP_DIVISION_COUNT
	XS_AD_MEMBER_RESULT_DIVISION_COUNT
	XS_AD_MEMBER_RESULT_GRID_SIZE
	XS_AD_MEMBER_RESULT_MIN_DISTANCE
	XS_AD_MEMBER_TYPE_VISUALIZATION
	XS_AD_NEAR_NODES_WARNING_LIMIT
	XS_AD_NODE_NUMBER_BY_Z
	XS_AD_NODE_NUMBER_VISUALIZATION
	XS_AD_OPTIMISATION_DISABLED
	XS_AD_OPTIMISATION_NO_WEIGHT_SORT
	XS_AD_OPTIMISATION_RECURSE_CATALOG
	XS_AD_RESULT_DATABASE_ENABLED
	XS_AD_RIGID_DIAPHRAGM_VISUALIZATION
	XS_AD_SHORT_MEMBER_WARNING_LIMIT
	XS_AD_SHORT_RIGIDLINK_WARNING_LIMIT
	XS_AD_SOLID_AXIAL_EXPAND_MM
	XS_AD_SOLID_SECONDARY_EXPAND_MM
	XS_AD_SUPPORT_VISUALIZATION
	XS_AD_USE_HIGH_ACCURACY
	XS_ADAPTIVE_OBJECTS
	XS_ADD_SNAPPING_SYMBOL_TO_CIRCLES
	XS_ADJUST_GRID_LABELS
	XS_AISC_WELD_MARK
	XS_ALLOW_DRAWING_TO_MANY_MULTI_DRAWINGS
	XS_ALLOW_INCH_MARK_IN_DIMENSIONS
	XS_ALLOW_INCH_MARK_IN_WELD_SYMBOLS
	XS_ALLOW_REBARS_ON_TOP_OF_EACH_OTHER
	XS_ALLOW_REINFORCING_LOCKED_PARTS
	XS_ALLOW_SHEAR_PLATE_CLASH_FLANGE
	XS_ALWAYS_CONFIRM_SAVE_WHEN_CLOSING_DRAWING
	XS_ALWAYS_CONFIRM_SAVE_WHEN_EXIT
	XS_ANCHOR_BOLT_PLAN_ADDITIONAL_PARTS_FILTER
	XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER
	XS_ANCHOR_BOLT_PLAN_BOLT_FILTER
	XS_ANCHOR_BOLT_PLAN_COLUMN_FILTER
	XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE
	XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_DIMENSIONS
	XS_ANGLE_DEGREE_SIGN
	XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR
	XS_ANGLE_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING
	APPL_ERROR_LOG
	XS_APPLICATIONS
	XS_APPLICATIONS_PATH
	XS_ARC_WIDTH_OF_CLOUD
	XS_ASCII_IMPORT_CREATES_CONSTRUCTION_LINES
	XS_ASSEMBLY_DRAWING_VIEW_TITLE
	XS_ASSEMBLY_FAMILY_POSITION_NUMBER_FORMAT_STRING
	XS_ASSEMBLY_MULTI_NUMBER_FORMAT_STRING
	XS_ASSEMBLY_POSITION_CODE_3D
	XS_ASSEMBLY_POSITION_CODE_TOLERANCE
	XS_ASSEMBLY_POSITION_NEW_FORMAT
	XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING
	XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE
	XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL
	XS_ATTRIBUTE_FILE_EXCLUDE_LIST
	XS_AUTOCONNECTION_TOLERANCE
	XS_AUTOCONNECTION_USE_UDL
	XS_AUTODEFAULT_UDL_PERCENT
	XS_AUTOMATIC_NEW_MODEL_NAME
	XS_AUTOMATIC_USER_FEEDBACK_SAVING_INTERVAL
	XS_AUTOMATIC_USER_FEEDBACK_SENDING_INTERVAL
	XS_AUTOSAVE_DIRECTORY

	1.2 Advanced options - 
	 B
	XS_BACKGROUND_COLOR1
	XS_BACKGROUND_COLOR2
	XS_BACKGROUND_COLOR3
	XS_BACKGROUND_COLOR4
	XS_BASE_LINE_WIDTH
	XS_BASE_LINE_WIDTH_AFFECTS_SCREEN
	XS_BASICVIEW_HEIGHT
	XS_BASICVIEW_POSITION_X
	XS_BASICVIEW_POSITION_Y
	XS_BASICVIEW_WIDTH
	XS_BEVEL_DIMENSIONS_FOR_PROFILES_ONLY
	XSBIN
	XS_BLACK_DRAWING_BACKGROUND
	XS_BOLT_DUPLICATE_IGNORE
	XS_BOLT_DUPLICATE_TOLERANCE
	XS_BOLT_LENGTH_EPSILON
	XS_BOLT_MARK_DIAMETER_PREFIX
	XS_BOLT_MARK_IS_ALWAYS_VISIBLE
	XS_BOLT_MARK_IS_ALWAYS_VISIBLE_IN_GA
	XS_BOLT_MARK_STRING_FOR_SIZE
	XS_BOLT_MARK_STRING_FOR_SIZE_IN_GA
	XS_BOLT_POSITION_TO_MIN_AND_MAX_POINT
	XS_BOLT_REPRESENTATION_SYMBOL_AXIS_POSITION_AS_EXACT_SOLID
	XS_BOLT_REPRESENTATION_USE_POSITIVE_CUT_LENGTH
	XS_BOLTS_PERPENDICULAR_TO_PART_PLANE_IN_NC

	1.3 Advanced options - 
	 C
	XS_CALCULATE_POLYBEAM_LENGTH_ALONG_REFERENCE_LINE
	XS_CALCULATE_POUR_UNITS_ON_SHARING
	XS_CAST_UNIT_FAMILY_POSITION_NUMBER_FORMAT_STRING
	XS_CAST_UNIT_MULTI_NUMBER_FORMAT_STRING
	XS_CAST_UNIT_POSITION_NUMBER_FORMAT_STRING
	XS_CENTER_LINE_TYPE
	XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING
	XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING
	XS_CHAMFER_ACCURACY_FACTOR
	XS_CHAMFER_DISPLAY_LENGTH_FACTOR
	XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED
	XS_CHANGE_DRAGGED_MARKS_TO_FIXED
	XS_CHANGE_DRAGGED_NOTES_TO_FIXED
	XS_CHANGE_DRAGGED_TEXTS_TO_FIXED
	XS_CHANGE_DRAGGED_VIEWS_TO_FIXED
	XS_CHANGE_MARK_ASTERISK_TO
	XS_CHANGE_WORKAREA_WHEN_MODIFYING_VIEW_DEPTH
	XS_CHECK_BOLT_EDGE_DISTANCE_ALWAYS
	XS_CHECK_FLAT_LENGTH_ALSO
	XS_CHECK_TRIANGLE_TEXT_SIZE
	XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS
	XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS
	XS_CHORD_TOLERANCE_SMALL_TUBE_SIZE_LIMIT
	XS_CIS_DEP1_DATABASE_NAME
	XS_CIS_DEP1_DATABASE_PASSW
	XS_CIS_DEP1_DATABASE_PATH
	XS_CIS_DEP1_EXPRESS_FILE
	XS_CLASH_CHECK_BETWEEN_PARTS
	XS_CLASH_CHECK_BETWEEN_REFERENCES
	XS_CLASH_CHECK_BETWEEN_REINFORCING_BARS
	XS_CLASH_CHECK_INSIDE_REFERENCE_MODELS
	XS_CLEAR_MODEL_HISTORY
	XS_CLONING_TEMPLATE_DIRECTORY
	XS_CLOUD_SHARING_PROXY
	XS_CNC_CUT_PLANE_HEIGHT
	XS_CNC_HOLE_DIAMETER_ROUNDING
	XS_COLLECT_MODEL_HISTORY
	XS_COMBINED_BOLT_DIM_CHARACTER
	XS_COMPANY_SETTINGS_DIRECTORY
	XS_COMPLEX_PART_MEMBERS_DO_NOT_HAVE_TO_BE_MAIN_PARTS
	XS_COMPONENT_CATALOG_ALLOW_SYSTEM_EDIT
	XS_COMPONENT_CATALOG_DO_REPORT_LEGACY_FILE_ISSUES
	XS_COMPONENT_CATALOG_COMPACT_THUMBNAIL_SIZE
	XS_COMPONENT_CATALOG_THUMBNAIL_SIZE
	XS_CONCRETE_PART_NUMBERING_PREFIX
	XS_CONCRETE_PART_NUMBERING_START_NUMBER
	XS_CONNECTING_SIDE_MARK_SYMBOL
	XS_CONNECT_CONNECTION_PARTS_IN_AUTOCONNECTION
	XS_CONNECT_PLATE_PROFILES_IN_AUTOCONNECTION
	XS_CONNECT_UPLOAD_MODEL_FOLDER
	XS_CONSIDER_NEIGHBOUR_PARTS_IN_HIDDEN
	XS_CONSIDER_REBAR_HOOK_LOCATION_IN_CAST_UNIT_NUMBERING
	XS_CONSIDER_REBAR_NAME_IN_NUMBERING
	XS_CONTOUR_PLATE_POINT_ON_SAME_LINE_LIMIT
	XS_CONTOUR_PLATE_POINT_ON_SAME_LINE_LIMIT_FOR_CLOSE_POINTS
	XS_CONVERSION_ARBITRARY_PROFILE_MAPPING_BY_NAME_MUST_MATCH_DIMENSIONS
	XS_CONVERT_OLD_FORCE_UNITS_TO_SI_FROM
	XS_CONVERT_OLD_MOMENT_UNITS_TO_SI_FROM
	XS_COPY_REVISIONS_IN_AUTOMATIC_CLONING
	XS_COUNT_ALL_PARTS_IN_NSFS_REPEATED_PART_MARK
	XS_COUNT_BOTH_PARTS_IN_NSFS_PART_MARK
	XS_CREATE_ALSO_BIG_HTML_REPORT_PICTURES
	XS_CREATE_DRAWING_PREVIEW_AUTOMATICALLY
	XS_CREATE_MISSING_MARKS_IN_INTELLIGENT_CLONING
	XS_CREATE_ROUND_HOLE_DIMENSIONS
	XS_CREATE_CONNECTION_WHEN_COPYING_DRAWING_VIEWS
	XS_DRAWING_CREATE_SNAPSHOT_ON_DRAWING_CREATION
	XS_CREATE_VIEW_FROM_MODEL_OLD_WAY
	XS_CS_CHAMFER_DIVIDE_ANGLE
	XS_CURVED_AXIS_PLACE
	XS_CUSTOM_COMPONENT_DECIMALS
	XS_CUT_SYMBOL_FONT
	XS_CYCLIC_SOLVER_MAX_LOOPS

	1.4 Advanced options - 
	 D
	DAK_BMPPATH
	XSDATADIR
	XS_DEFAULT_BREP_PATH
	XS_DEFAULT_ENVIRONMENT
	XS_DEFAULT_FONT
	XS_DEFAULT_FONT_SIZE
	XS_DEFAULT_HEIGHT_FOR_CALCULATED_DRAWING_SIZE
	XS_DEFAULT_LICENSE
	XS_DEFAULT_MODEL_TEMPLATE
	XS_DEFAULT_ROLE
	XS_DEFAULT_WIDTH_FOR_CALCULATED_DRAWING_SIZE
	XS_DELETE_UNNECESSARY_DG_FILES
	XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD
	XS_DELETE_UNNECESSARY_INT_ARRAYS
	XS_DELETE_UNNECESSARY_REFMODEL_FILES_SAFETY_PERIOD
	XS_DETAIL_BOUNDARY_RADIUS
	XS_DETAIL_MARK_REFERENCE_SYMBOL
	XS_DETAIL_SYMBOL_REFERENCE
	XS_DETAIL_VIEW_REFERENCE
	XS_DGN_EXPORT_PART_AS
	XS_DGN_EXPORT_USE_LOCAL_ID
	XS_DIALOG_ENABLE_STATE
	XS_DIMENSION_ALL_BOLT_GROUPS_SEPARATELY
	XS_DIMENSION_DECIMAL_SEPARATOR
	XS_DIMENSION_DIGIT_GROUPING_CHARACTER
	XS_DIMENSION_DIGIT_GROUPING_COUNT
	XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR
	XS_DIMENSION_EXTENSION_LINE_ORIGIN_OFFSET
	XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR
	XS_DIMENSION_FONT
	XS_DIMENSION_GROUPING_COUNT_SEPARATOR
	XS_DIMENSION_LINE_TEXT_EPS
	XS_DIMENSION_MARK_CONNECTOR
	XS_DIMENSION_MARK_CREATE_MIDDLE_TAG_ALWAYS
	XS_DIMENSION_MARK_MULTIPLIER
	XS_DIMENSION_PART_MARK_CONTENT_IN_ASSEMBLY
	XS_DIMENSION_PART_MARK_CONTENT_IN_SINGLE
	XS_DIMENSION_PART_MARK_CONTENT_STRICT_POSITION
	XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_CENTER
	XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_LEFT
	XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_RIGHT
	XS_DIMENSION_SKEWED_BOLTS_IN_PART_PLANE_IN_SINGLE_DRAWINGS
	XS_DIR
	XS_DISABLE_ADVANCED_OPTIONS
	XS_DISABLE_ANALYSIS_AND_DESIGN
	XS_DISABLE_CANCEL_DIALOG_FOR_SAVE_NUMBERING_SAVE
	XS_DISABLE_CIS2
	XS_DISABLE_CLASSIFIER_FOR_MODIFIED_PARTS
	XS_DISABLE_DRAWING_PLOT_DATE
	XS_DISABLE_PARTIAL_REFRESH
	XS_DISABLE_REBAR_MODELING
	XS_DISABLE_TEMPLATE_DOUBLE_CLICK
	XS_DISABLE_VIEW_CENTERING_ASSEMBLY
	XS_DISABLE_VIEW_CENTERING_GA
	XS_DISABLE_VIEW_CENTERING_MULTI
	XS_DISABLE_VIEW_CENTERING_SINGLE
	XS_DISPLAY_DIMENSIONS_WHEN_CREATING_OBJECTS
	XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_OBJECTS
	XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_REBARS
	XS_DISPLAY_FILLET_EDGES
	XS_DISPLAY_ZERO_INCHES
	XS_DISTANT_OBJECT_FINDER_TOLERANCE
	XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE
	XS_DO_NOT_CREATE_ASSEMBLY_DRAWINGS_FOR_CONCRETE_PARTS
	XS_DO_NOT_CREATE_ASSEMBLY_DRAWINGS_FOR_LOOSE_PARTS
	XS_DO_NOT_CREATE_BOLT_MARKS_IN_ALL_INCLUDED_SINGLE_VIEWS
	XS_DO_NOT_CREATE_PART_MARKS_IN_ALL_INCLUDED_SINGLE_VIEWS
	XS_DO_NOT_CREATE_PROFILE_DIMENSIONS_FOR_CONCRETE
	XS_DO_NOT_DISPLAY_CHAMFERS
	XS_DO_NOT_DRAW_COLUMN_MARKS_AT_45_DEGREES_IN_GA_DRAWING
	XS_DO_NOT_EXTEND_DIMENSION_LINES_THROUGH_ALL_HOLES
	XS_DO_NOT_PLOT_DIMENSION_POINT_CIRCLES
	XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE
	XS_DO_NOT_REMOVE_END_ABSOLUTE_DIMENSIONS
	XS_DO_NOT_USE_FOLDED_GUSSET_PLATE
	XS_DO_NOT_USE_GLOBAL_PLATE_SIDE
	XS_DONT_SHOW_POLYBEAM_MID_EDGES
	XS_DRAW_ALL_SECTION_EDGES_IN_DRAWINGS
	XS_DRAW_ANGLE_AND_RADIUS_INFO_IN_UNFOLDING
	XS_DRAW_BENDING_END_LINE_DIMENSIONS_IN_UNFOLDING
	XS_DRAW_BENDING_END_LINES_IN_UNFOLDING
	XS_DRAW_BENDING_LINE_DIMENSIONS_IN_UNFOLDING
	XS_DRAW_BOLT_HIDDEN_LINES
	XS_DRAW_BOLT_HIDDEN_LINES_IN_ASSEMBLY_DRAWINGS
	XS_DRAW_BOLT_HIDDEN_LINES_IN_GA_DRAWINGS
	XS_DRAW_BOLT_HIDDEN_LINES_IN_SINGLE_DRAWINGS
	XS_DRAW_BOLT_OWN_HIDDEN_LINES
	XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_ASSEMBLY_DRAWINGS
	XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_GA_DRAWINGS
	XS_DRAW_BOLT_OWN_HIDDEN_LINES_IN_SINGLE_DRAWINGS
	XS_DRAW_BOLTS_PERPENDICULAR_TO_PART_IN_SINGLE_DRAWINGS
	XS_DRAW_BOLTS_THROUGH_NEIGHBOUR_PARTS
	XS_DRAW_CAST_PHASE_INTERNAL_LINES
	XS_DRAW_CAST_UNIT_INTERNAL_LINES
	XS_DRAW_CHAMFERS_HANDLES
	XS_DRAW_CROSS_AXIS
	XS_DRAW_CUT_FACES_WITH_OBJECT_COLOR
	XS_DRAW_HIDDEN_FACES
	XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS
	XS_DRAW_INSIDE_ANGLE_IN_UNFOLDING
	XS_DRAW_LONG_HOLE_DIMENSIONS
	XS_DRAW_MESH_OUTLINE_SYMBOL_FROM_BOTTOM_LEFT_TO_TOP_RIGHT
	XS_DRAW_REBAR_HIDDEN_FACES
	XS_DRAW_REBAR_SELF_INTERSECTING_LEGS_WITH_OFFSET
	XS_DRAW_ROOT_OPENING_EVEN_WHEN_ZERO
	XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS
	XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH
	XS_DRAW_SKEWED_ELEVATIONS
	XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS
	XS_DRAWING_ALLOW_NEW_SECTIONS_IN_REDIMENSIONING
	XS_DRAWING_ALLOW_SNAPPING_TO_DISTANT_POINTS
	XS_DRAWING_ASSEMBLY_HATCH_SCHEMA
	XS_DRAWING_CAST_UNIT_HATCH_SCHEMA
	XS_DRAWING_CHANGE_HIGHLIGHT_COLOR
	XS_DRAWING_CLONING_IGNORE_CHECK
	XS_DRAWING_COMBINE_ADDED_DIMENSIONS
	XS_DRAWING_CUT_VIEW_COMPARISON_CRITERIA
	XS_DRAWING_FILTER_UDAS_WITHOUT_TYPE_CHECK
	XS_DRAWING_GA_HATCH_SCHEMA
	XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH
	XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR
	XS_DRAWING_HISTORY_LOG_TYPE
	XS_DRAWING_IGNORE_ZERO_LEVELS_IN_PART_MARKS
	XS_DRAWING_PART_REFERENCE_LINE_TYPE
	XS_DRAWING_PART_SYMBOL_REPRESENTATION_TYPE
	XS_DRAWING_PLOT_FILE_DIRECTORY
	XS_DRAWING_PLOT_FILE_NAME
	XS_DRAWING_PLOT_FILE_NAME_A
	XS_DRAWING_PLOT_FILE_NAME_W
	XS_DRAWING_PLOT_FILE_NAME_G
	XS_DRAWING_PLOT_FILE_NAME_M
	XS_DRAWING_PLOT_FILE_NAME_C
	XS_DRAWING_POINT_SCALE
	XS_DRAWING_SCALE_SEPARATOR_CHAR
	XS_DRAWING_SHEET_HEIGHT
	XS_DRAWING_SHEET_POSITION_X
	XS_DRAWING_SHEET_POSITION_Y
	XS_DRAWING_SHEET_WIDTH
	XS_DRAWING_SINGLE_PART_HATCH_SCHEMA
	XS_DRAWING_SNAPSHOT_CREATION
	XS_DRAWING_SOLID_MERGE_TOLERANCE
	XS_DRAWING_STUD_REPRESENTATION
	XS_DRAWING_TEMPLATES_LIBRARY
	XS_DRAWING_UDAS_MODIFY_ALL_DRAWING_TYPES
	XS_DRAWING_UPDATE_VIEW_PLACING
	XS_DRAWING_USE_WORKSHOP_FORM_FOR_DOUBLE_PARTS_IN_SINGLE_PART_DRAWINGS
	XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT
	XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP
	XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK
	XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM
	XS_DRAWING_VIEW_REFERENCE_SYMBOL
	XS_DRIVER
	XS_DSTV_CREATE_AK_BLOCK_FOR_ALL_PLATES
	XS_DSTV_CREATE_AK_BLOCK_FOR_ALL_PROFILES
	XS_DSTV_CREATE_NOTCH_ONLY_ON_BEAM_CORNERS
	XS_DSTV_DO_NOT_UNFOLD_POLYBEAM_PLATES
	XS_DSTV_LIST_NET_WEIGHT
	XS_DSTV_LIST_SEPARATOR
	XS_DSTV_NET_LENGTH
	XS_DSTV_NO_SAWING_ANGLES_FOR_PLATES_NEEDED
	XS_DSTV_NUMBER_OF_PARTS_BY_SELECTION
	XS_DSTV_PLATE_PROFILE_WITH_WIDTH
	XS_DSTV_PRINT_NET_AND_GROSS_LENGTH
	XS_DSTV_REAL_WIDTH_INTO_HEADER_PROFILE_FOR_PLATES
	XS_DSTV_USE_COUNTERSUNK_HOLES
	XS_DSTV_USE_EQUAL_ACCURACY_FOR_PLATE_PROFILE_AND_WIDTH
	XS_DSTV_USE_ONE_VERTEX_SHARP_INNER_CORNER
	XS_DSTV_USE_REAL_DIMENSIONS_IN_HEADER
	XS_DSTV_WRITE_BEHIND_FACE_FOR_PLATE
	XS_DUPLICATE_CHECK_LIMIT_FOR_COPY_AND_MOVE
	XS_DWG_EXPORT_UPDATE_TS_LINEWORK_OPTION
	XS_DWG_IMPORT_IGNORE_UNITS
	XS_DXF_FONT_CONVERSION_FILE
	XS_DXF_FONT_NAME
	XS_DXF_TEXT_HEIGHT_FACTOR
	XS_DXF_TEXT_WIDTH_FACTOR
	DXK_FONTPATH
	DXK_SYMBOLPATH

	1.5 Advanced options - 
	 E
	XS_ENABLE_FAST_CUSTOM_PROPERTY_LOADING
	XS_ENABLE_INNER_CONTOURS_IN_CUT_PARTS
	XS_ENABLE_MIDDLE_BUTTON_DOUBLE_CLICK_ZOOM_ORIGINAL
	XS_ENABLE_PHASE_OPTION_IN_NUMBERING
	XS_ENABLE_POUR_MANAGEMENT
	XS_ENABLE_PRECAST_CONTINUOUS_CONCRETE
	XS_ENABLE_PULLOUT_PLACEHOLDERS
	XS_ENABLE_REBAR_MARK_LEADER_LINE_BASE_POINT_OPTIMIZATION
	XS_EQUAL_SHAPE_DIMENSIONS_TO_BOTH_ENDS_LIMIT
	XS_ERASE_UDA_VALUE_WITH_ATTRIBUTE_IMPORT_NULL_AND_BLANK
	XS_EXCLUDED_PARTS_IN_ORIENTATIONAL_NUMBERING
	XS_EXPORT_CODEPAGE
	XS_EXPORT_DGN_COORDINATE_SCALE
	XS_EXPORT_DGN_FILENAME
	XS_EXPORT_DGN_INCLUDE_CUTS
	XS_EXPORT_DGN_INCLUDE_INNER_CONTOUR
	XS_EXPORT_DGN_ROUND_SEGMENTS
	XS_EXPORT_DGN_USE_CLASS_AS_COLOR
	XS_EXPORT_DGN_USE_VOLUMETRIC
	XS_EXPORT_DRAWING_TRY_TO_KEEP_LOCATION
	XS_EXPORT_FILLMODE
	XS_EXPORT_LINE_TYPE_DEFINITION_FILE
	XS_EXPORT_STEEL2000_PRIMARY_IDS
	XS_EXTENSION_DIRECTORY
	XS_EXTERNAL_EXCEL_DESIGN_PATH

	1.6 Advanced options - 
	 F
	XS_FILTER_SEPARATOR_CHAR
	XS_FIRM
	XS_FIX_FRAME_OF_FIXED_MODELVIEW
	XS_FLAT_PREFIX
	XS_FLAT_THICKNESS_TOLERANCE
	XS_FLAT_TOLERANCE
	FLEXLM_TIMEOUT
	XS_FRACTION_HEIGHT_FACTOR
	XS_FS_POSTFIX_FOR_MERGED_PART_MARK

	1.7 Advanced options - 
	 G
	XS_GA_CONNECTING_SIDE_MARK_SYMBOL
	XS_GA_DRAWING_VIEW_TITLE
	XS_GAGE_OF_OUTSTANDING_LEG_STRING
	XS_GA_HIDDEN_NORTH_MARK_SYMBOL
	XS_GA_NORTH_MARK_SCALE
	XS_GA_NORTH_MARK_SYMBOL
	XS_GA_OMITTED_DIAMETER_TYPE
	XS_GET_ASSEMBLY_LEVELS_FROM_ASSEMBLY_MAIN_PART
	XS_GET_CAST_UNIT_LEVELS_FROM_CAST_UNIT_MAIN_PART
	XS_GOL_SYMMETRY_DISTANCE
	XS_GRID_DIMENSION_OVERALL_LENGTH
	XS_GRID_COLOR_FOR_WORK_PLANE
	XS_GRID_PLANES_VISIBLE_WITH_USERPLANES
	XS_GRID_TEXT_FONT

	1.8 Advanced options - 
	 H
	XS_HANDLE_SCALE
	XS_HATCH_OVERLAPPING_FACES_IN_DX
	XS_HATCH_PATTERN_LINE_LIMIT
	XS_HATCH_SCALE_LIMIT
	XS_HATCH_SEGMENT_BUFFER_SIZE
	XS_HATCH_SPECIAL_COLOR_ACI
	XS_HATCH_SPECIAL_COLOR_R
	XS_HATCH_SPECIAL_COLOR_G
	XS_HATCH_SPECIAL_COLOR_B
	XS_HELP_PATH
	XS_HIDDEN_LINES_CHECK_TOLERANCE
	XS_HIDDEN_NORTH_MARK_SYMBOL
	XS_HIDDEN_REMOVE_DOUBLE_LINES
	XS_HIDDEN_USE_BOLT_PLANES
	XS_HIDE_OTHER_PARTS_IN_ASSEMBLY_AND_CAST_UNIT_VIEWS
	XS_HIDE_WORKAREA
	XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES
	XS_HIGHLIGHT_MARK_CONTENT_CHANGES
	XS_HOLE_MARK_STRING_FOR_SIZE
	XS_HOLE_MARK_STRING_FOR_SIZE_IN_GA

	1.9 Advanced options - 
	 I
	XS_IGNORE_CUT_VALUE_IN_TEMPLATE
	XS_IGNORE_CROSSBAR_LOCATION_IN_REBAR_MESH_NUMBERING
	XS_IGNORE_SUBASSEMBLY_HIERARCHY_IN_DIMENSIONING
	XS_IMPERIAL
	XS_IMPERIAL_DATE
	XS_IMPERIAL_INPUT
	XS_IMPERIAL_TIME
	XS_IMPERIAL_TRIANGLES
	XS_IMPORT_DWG_TEXT_AS_POLYGON
	XS_IMPORT_MODEL_LOG
	XS_INCH_SIGN_ALWAYS
	XS_INCLUDE_DWG_ATTRIBUTES_IN_REPORTS_AND_INQUIRE
	XS_INHERIT_CONCRETE_PART_NUMBERING_SETTINGS_FROM_CAST_UNIT
	XS_INP
	XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS
	XS_INTELLIGENCE_DO_NOT_REMOVE_OBSOLETE_VIEWS_IN_GA
	XS_INTELLIGENCE_MAX_PART_COUNT
	XS_INTELLIGENCE_MAX_PLANE_COUNT
	XS_INTELLIGENCE_MAX_RULE_COUNT
	XS_INTELLIGENT_CLONING_ADD_DIMENSIONS
	XS_INTELLIGENT_DRAWING_ALLOWED
	XS_INTELLIGENT_DRAWING_ALLOWED_IN_GA
	XS_INTELLIGENT_MESSAGES_ALLOWED
	XS_INTELLIGENT_UPDATE_ADD_DIMENSIONS
	XS_INVALID_POUR_BREAK_COLOR
	XS_I_PROFILE_CENTER
	XS_ISO_LEG_LENGTH_AS_WELDSIZE

	1.10 Advanced options - 
	 J
	XS_JOINT_NUMBER_FORMAT
	XS_JOINTS_USE_NOTCH1

	1.11 Advanced options - K
	XS_KEEP_AUTOSAVE_FILES_ON_EXIT_WHEN_NOT_SAVING
	XS_KEYIN_ABSOLUTE_PREFIX
	XS_KEYIN_DEFAULT_MODE
	XS_KEYIN_GLOBAL_PREFIX
	XS_KEYIN_RELATIVE_PREFIX
	XS_KNOCK_OFF_DIMENSION_PRECISION

	1.12 Advanced options - 
	 L
	XS_LANGUAGE
	XS_LEADER_LINE_TO_DRAGGED_DIMENSION_TEXT
	XS_LINE_WIDTH
	XS_LICENSE_SERVER_HOST
	XS_LOAD_MODELING_CODE
	XS_LOG_FILE_NAME
	XS_LOG_LEVEL
	XS_LOG_TIMER
	XS_LOGPATH
	XS_LONGHOLE_MARK_STRING_FOR_SIZE
	XS_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA

	1.13 Advanced options - 
	 M
	XS_MACRO_DIRECTORY
	XS_MACRO_ENABLE_TIMESTAMP
	XS_MACRO_LOG
	XS_MACRO_REFERENCES
	XS_MAGNETIC_PLANE_OFFSET
	XS_MARK_ALL_BOLT_GROUPS_SEPARATELY
	XS_MARK_ELEMENT_SPACE_FACTOR
	XS_MARK_FONT
	XS_MARK_INTELLIGENT_POST_FREEPLACE_NEARBY
	XS_MARK_LEADER_LINE_ARROW_HEIGHT
	XS_MARK_LEADER_LINE_ARROW_LENGTH
	XS_MARK_LEADER_LINE_EXTENSION_LENGTH
	XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDICULAR
	XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME
	XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_RECTANGULAR_FRAME
	XS_MARK_LINE_SPACE_FACTOR
	XS_MARK_PLACING_ANGLE_CLOSE_TO_45_DEGREES
	XS_MARK_TEXT_FRAME_BOX_HEIGHT_FACTOR
	XS_MATERIAL_SYMBOL_REPRESENTATION_FILE
	XS_MAX_ANGLE_BETWEEN_SKEWED_END_PLATE_AND_BEAM_END
	XS_MAX_ANGLE_TOLERANCE_BETWEEN_COMPLEX_MAIN_PARTS
	XS_MAX_AUTOMATIC_RADIUS_DIMENSION
	XS_MAX_DECIMALS_IN_PROFILE_NAME
	XS_MAX_DEVIATION_FOR_CURVED_PART_EDGES
	XS_MAX_FRACTIONS_IN_MODEL_DIMENSION
	XS_MAXIMUM_NUMBER_OF_PLANES_TO_NAME
	XS_MAX_MERGE_DISTANCE_IN_HORIZONTAL
	XS_MAX_MERGE_DISTANCE_IN_VERTICAL
	XS_MAX_SPACE_BETWEEN_COMPLEX_ASSEMBLY_PARALLEL_PARTS
	XS_MDIBASICVIEWPARENT
	XS_MDIVIEWPARENT
	XS_MDIZOOMPARENT
	XS_MESSAGES
	XS_MESSAGES_PATH
	XS_MIN_DISTANCE_FOR_CONNECTING_SIDE_MARK
	XS_MIN_MERGE_PART_COUNT
	XS_MIN_NUMBER_OF_ASSEMBLY_MULTI_CHARACTERS
	XS_MIN_NUMBER_OF_PART_MULTI_CHARACTERS
	XS_MIN_WELD_LINE_LENGTH
	XS_MIS_FILE_DIRECTORY
	XS_MIS_SEQUENCE
	XS_MODEL_BACKUP_DIRECTORY
	XS_MODEL_IMPORT_LOCK_OBJECTS
	XS_MODEL_PREFIX_INFLUENCES_MULTI_NUMBERING_FOR
	XS_MODEL_TEMPLATE_DIRECTORY
	XS_MULTIDRAWING_KEEP_OBSOLETE_DRAWINGS
	XS_MULTIDRAWING_REMOVE_VIEW_LABEL_GAP
	XS_MULTI_DRAWING_VIEW_PLACING_TRIAL_NUMBER
	XS_MULTI_DRAWING_VIEW_TITLE
	XS_MULTI_NUMBERING_INCLUDE_ASSEMBLY_PARTS
	XS_MULTIPLIER_SEPARATOR_FOR_MERGED_PART_MARK
	XS_MULTIUSER_SAVE_REOPEN_DISABLE_COMPACTION

	1.14 Advanced options - 
	 N
	XS_MARK_INTELLIGENT_PLACING
	XS_NEIGHBOUR_PART_SKEW_LIMIT
	XS_NO_AUTO_DISPLAY_VIEWS
	XS_NO_BOLT_ANGLE_DIMENSIONS
	XS_NO_CHAMFERS_IN_EXACT_MODE
	XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS
	XS_NO_RELATIVE_SHAPE_DIMENSIONS
	XS_NO_UNFOLDING_LINES_TO_DRAWINGS
	XS_NO_SINGLE_PART_DRAWINGS_FOR
	XS_NORTH_MARK_SCALE
	XS_NORTH_MARK_SYMBOL
	XS_NSFS_POSTFIX_FOR_MERGED_PART_MARK
	XS_NSFS_TEXT_POSITION_IN_PART_MARK
	XS_NS_POSTFIX_FOR_MERGED_PART_MARK
	XS_NUMBERING_RESULTS_DIALOG_DISPLAY_TIME

	1.15 Advanced options - 
	 O
	XS_OBJECT_SELECTION_CONFIRMATION
	XS_OBJECTLOCK_DEFAULT
	XS_OMIT_MARKS_OF_HIDDEN_PARTS_IN_GA_DRAWINGS
	XS_OMIT_MARKS_OF_PARTS_OUT_OF_VIEW_PLANE_LIMIT_ANGLE
	XS_OMITTED_BOLT_ASSEMBLY_TYPE
	XS_OMITTED_BOLT_TYPE
	XS_OMITTED_DIAMETER_TYPE
	XS_OMITTED_PART_NAME_IN_AUTOCONNECTION
	XS_OMITTED_WELD_TYPE
	XS_OPEN_DRAWINGS_MAXIMIZED
	XS_ORIENTATION_MARK_DIRECTION
	XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS
	XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS_IN_GA
	XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS
	XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS_IN_GA

	1.16 Advanced options - 
	 P
	XS_PARAMETRIC_PROFILE_SEPARATOR
	XS_PART_DIMENSION_PLANES_TABLE
	XS_PART_MERGE_MAX_DISTANCE
	XS_PART_MULTI_NUMBER_FORMAT_STRING
	XS_PART_POSITION_NUMBER_FORMAT_STRING
	XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR
	XS_PART_POSITION_TO_LEADING_EDGE
	XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO
	XS_PIXEL_TOLERANCE
	XS_PLATE_ROUNDING_DECIMALS
	XS_PLOT_ORIGIN_MOVE_X
	XS_PLOT_ORIGIN_MOVE_Y
	XS_PLOT_VIEW_FRAMES
	PML_ASSEMBLY_MARKS_IN_USE
	PML_CARDINAL_POINT_NOT_IN_USE
	XS_PML_EXPORT_INCLUDE_GLOBAL_ID
	XS_PML_EXPORT_USE_ADDITIONAL_CUT_DIST
	XS_POINT_CLOUD_CACHE_FOLDER
	XS_POINT_CLOUDS_WEB_CACHE
	XS_POLYBEAM_CHORD_TOLERANCE
	XS_POLYBEAM_MAX_ANGLE_BETWEEN_CS
	XS_POLYBEAM_CURVATURE_TOLERANCE
	XS_POLYGON_CUT_EXTRA_THICKNESS
	XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR
	XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR
	XS_POP_MARK_COLOR
	XS_POP_MARK_HEIGHT
	XS_POP_MARK_SYMBOL
	XS_POSITION_DIMENSIONS_FOR_HOLES_IN_SINGLE_SECONDARY_PARTS_IN_ASSEMBLY_DRAWING
	XS_POUR_BREAK_COLOR
	XS_POUR_BREAK_SYMBOL
	XS_POUR_OBJECT_COLOR
	XS_PRINT_MULTISHEET_BORDER
	XS_PRINT_REPORT_FONT
	XS_PRINT_REPORT_LINE_WIDTH_LANDSCAPE
	XS_PRINT_REPORT_LINE_WIDTH_PORTRAIT
	XS_PRINT_REPORT_PAGE_HEIGHT_LANDSCAPE
	XS_PRINT_REPORT_PAGE_HEIGHT_PORTRAIT
	XS_PRODUCT_IDENTIFIER
	XS_PROFDB
	XS_PROFILE_ANALYSIS_CHECK_ALL
	XS_PROFILE_ANALYSIS_VALUE_DIFF_LIMIT
	XS_PROFILE_DISPLAY_INCH_MARK_AFTER_FRACTIONS_IN_REPORTS
	XS_PROJECT
	XS_PROTECT_SYMBOLS

	1.17 Advanced options - 
	 R
	XS_RADIUS_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING
	XSR_BOLT_LENGTH_USE_ONLY_INCHES
	XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE
	XS_REBAR_COMBINE_BENDINGS_IN_EVALUATOR
	XS_REBAR_DIMENSION_LINE_SYMBOL
	XS_REBAR_END_SYMBOL_MIN_SIZE
	XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_STEP_LENGTH
	XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_TOLERANCE
	XS_REBAR_MINIMUM_LEG_DEVIATION
	XS_REBAR_POSITION_NUMBER_FORMAT_STRING
	XS_REBAR_PULLOUT_ANGLE_TEXT_FRAME
	XS_REBAR_PULLOUT_ANGLE_TEXT_UNDERLINE
	XS_REBAR_RECOGNITION_HOOKS_CONSIDERATION
	XS_REBAR_REVERSE_END_SYMBOLS
	XS_REBARSET_BUFFER_SIZE
	XS_REBARSET_COLOR_BARGROUPS
	XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_CROSSING_REBARS
	XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_LONGITUDINAL_REBARS
	XS_REBARSET_ENABLE_BAR_GROUPING_WHEN_SPACING_DIFFERS
	XS_REBARSET_REBAR_LAYER_FORMAT_STRING
	XS_REBARSET_SHOW_END_DETAIL_MODIFIERS
	XS_REBARSET_SHOW_GUIDELINES
	XS_REBARSET_SHOW_LEGFACES
	XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_COMPONENTS
	XS_REBARSET_SHOW_PROPERTY_MODIFIERS
	XS_REBARSET_SHOW_SPLITTERS
	XS_REBARSET_TAPERED_GROUP_POSITION_NUMBER_FORMAT_STRING
	XS_REBARSET_TAPERED_REBAR_POSITION_NUMBER_FORMAT_STRING
	XS_REBARSET_USE_GROUP_NUMBER_FOR_BARS_IN_TAPERED_GROUPS
	XS_REBAR_USE_ALWAYS_METHOD_A_FOR_90_DEGREE_HOOK_DIMENSIONS
	XS_RECREATE_MARKS_IN_INTELLIGENT_CLONING
	XS_RECREATE_UNMODIFIED_DRAWINGS
	XS_REFERENCE_CACHE
	XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT
	XS_REFERENCE_USE_RENDERED_CLIPPING
	XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS
	XS_REMEMBER_LAST_PLOT_DIALOG_VALUES
	XS_REMOVE_VOID_FROM_BOLT_MATERIAL_THICKNESS
	XS_RENDERED_CURSOR_LINE_WIDTH
	XS_RENDERED_FIELD_OF_VIEW
	XS_RENDERED_GL_FOG_END_VALUE
	XS_RENDERED_GL_FOG_START_VALUE
	XS_RENDERED_PIXEL_TOLERANCE_SCALE
	XS_REPORT_BOLTS_WITH_SUPPORTING_MEMBER
	XS_REPORT_OUTPUT_DIRECTORY
	XS_RESTORE_ENABLES
	XS_ROTATE_CUT_VIEWS
	XS_RUN_AT_STARTUP
	XS_RUNPATH
	XSR_USE_NO_FEET_SEPARATOR
	XSR_USE_NO_FEET_SYMBOL
	XSR_USE_NO_INCH_SYMBOL
	XSR_USE_ZERO_FEET_VALUE
	XSR_USE_ZERO_INCH_FOR_FRACTIONS
	XSR_USE_ZERO_INCH_VALUE

	1.18 Advanced options - 
	 S
	XS_SAVE_WITH_COMMENT
	XS_SCALE_COPIED_OR_MOVED_OBJECTS_IN_DRAWINGS
	XS_SCALE_MARKS_TO_FIT_LIMIT
	XS_SCREW_DIAMOND_WITHOUT_PHI
	XS_SDNF_CONVERT_PL_PROFILE_TO_PLATE
	XS_SDNF_EXPORT_INCLUDE_GLOBAL_ID
	XS_SDNF_IMPORT_MIRROR_SWAP_OFFSETS
	XS_SDNF_IMPORT_STORE_MEMBER_NUMBER
	XS_SECONDARY_PART_HARDSTAMP
	XS_SECTION_LINE_COLOR
	XS_SECTION_SYMBOL_LEFT_ARROW_SYMBOL
	XS_SECTION_SYMBOL_REFERENCE
	XS_SECTION_SYMBOL_RIGHT_ARROW_SYMBOL
	XS_SECTION_VIEW_REFERENCE
	XS_SET_FIXEDMAINVIEW_UDA_TO_AFFECT_NUMBERING
	XS_SET_HATCH_ORIGIN_INTO_VIEW_ORIGIN
	XS_SET_MAX_POINT_CLOUD_POINT_COUNT
	XS_SHARING_INFO_URL
	XS_SHARING_JOIN_SHOW_AVAILABLE_UPDATES
	XS_SHARING_READIN_SHOW_AVAILABLE_VERSIONS
	XS_SHARING_READIN_SHOW_CHANGEMANAGER
	XS_SHARING_READIN_SHOW_CHANGEMANAGER_CONFLICTSONLY
	XS_SHARING_TEMP
	XS_SHOP_BOLT_MARK_STRING_FOR_SIZE
	XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA
	XS_SHOP_HOLE_MARK_STRING_FOR_SIZE
	XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA
	XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE
	XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA
	XS_SHORTENING_SYMBOL_COLOR
	XS_SHORTENING_SYMBOL_LINE_TYPE
	XS_SHORTENING_SYMBOL_WITH_ZIGZAG
	XS_SHOW_HARDWARE_DASHED_LINE_IN_PIXEL_SCALE
	XSR_SHOW_INCH_MARK_IN_PROFILE_NAMES
	XS_SHOW_NOTIFICATION_REPORT
	XS_SHOW_PERFORM_NUMBERING_MESSAGE
	XS_SHOW_PROGRESS_BAR_FOR_PROJECT_STATUS_VISUALIZATION
	XS_SHOW_REVISION_MARK_ON_DRAWING_LIST
	XS_SHOW_SHADOW_FOR_ORTHO_IN_DX
	XS_SHOW_SHADOW_FOR_PERSPECTIVE_IN_DX
	XS_SHOW_SITE_STUDS_IN_ASSEMBLY_DRAWINGS
	XS_SHOW_STUDS_IN_WORKSHOP_DRAWINGS
	XS_SHOW_TEMPLATE_LOG_MESSAGES
	XS_SINGLE_CENTERED_SCREW
	XS_SINGLE_CLOSE_DIMENSIONS
	XS_SINGLE_CLOSE_SHORT_DIMENSIONS
	XS_SINGLE_COMBINE_DISTANCE
	XS_SINGLE_COMBINE_MIN_DISTANCE
	XS_SINGLE_COMBINE_WAY
	XS_SINGLE_DIMENSION_TYPE
	XS_SINGLE_DRAW_PART_AS
	XS_SINGLE_EXCLUDE
	XS_SINGLE_FORWARD_OFFSET
	XS_SINGLE_NO_RELATIVE_SHAPE_DIMENSIONS
	XS_SINGLE_NO_SHORTEN
	XS_SINGLE_ORIENTATION_MARK
	XS_SINGLE_PART_DRAWING_VIEW_TITLE
	XS_SINGLE_PART_EXTREMA
	XS_SINGLE_PART_SHAPE
	XS_SINGLE_SCALE
	XS_SINGLE_SCREW_INTERNAL
	XS_SINGLE_SCREW_POSITIONS
	XS_SINGLE_USE_WORKING_POINTS
	XS_SINGLE_X_DIMENSION_TYPE
	XS_SITE_BOLT_MARK_STRING_FOR_SIZE
	XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA
	XS_SITE_HOLE_MARK_STRING_FOR_SIZE
	XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA
	XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE
	XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA
	XS_SNAPSHOT_DIRECTORY
	XS_SOLID_BUFFER_SIZE
	XS_SOLID_USE_HIGHER_ACCURACY
	XS_STACKED_FRACTION_TYPE
	XS_STANDARD_GUSSET_WIDTH_TOLERANCE
	XS_STANDARD_STIFFENER_WIDTH_TOLERANCE
	XS_STD_LOCALE
	XS_STD_PART_MODEL
	XS_STEEL1_TS_PAGE_9_EXTENSION
	XS_STEEL1_TS_PAGE_10_EXTENSION
	XS_STORE_MULTIPLE_BAK_FILES
	XS_SUPERSCRIPT_HEIGHT_FACTOR
	XS_SUPERSCRIPT_USED_IN_DRAWING_TEXTS
	XS_SWITCH_MULTI_NUMBERS_FOR
	XS_SWITCH_POS_NUMBERS_FOR
	SYMEDHOME
	XS_SYSTEM

	1.19 Advanced options - 
	 T
	TEMPLATE_FONT_CONVERSION_FILE
	XS_TEMPLATE_DIRECTORY
	XS_TEMPLATE_DIRECTORY_SYSTEM
	XS_TEMPLATE_MARK_SUB_DIRECTORY
	XS_TEXT_ORIENTATION_EPSILON
	XS_THICKNESS_PARAMETER_IS_CROSS_SECTION_THICKNESS
	XS_TPLED_INI
	XS_TRY_TO_KEEP_LOCATION_IN_FREEPLACING
	XS_TUBE_UNWRAP_LIMIT_THICKNESS
	XS_TUBE_UNWRAP_PAPER_THICKNESS
	XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC
	XS_TUBE_UNWRAP_WITH_CUT_HOLES

	1.20 Advanced options - 
	 U
	XS_UEL_IMPORT_FOLDER
	XS_UNDERLINE_AFTER_POSITION_NUMBER_IN_HARDSTAMP
	XS_UNFOLDING_ANGLE_DIM_FORMAT
	XS_UNFOLDING_DONT_USE_NEUTRAL_AXIS_FOR_RADIUS
	XS_UNFOLDING_ANGLE_DIM_PRECISION
	XS_UNFOLDING_PLANE_EPSILON
	XS_UNIQUE_NUMBERS
	XS_UNIQUE_ASSEMBLY_NUMBERS
	XS_UPDATE_MARK_PLACING_IN_DRAWING
	XS_UPDATE_MARKS_IN_FROZEN_DRAWINGS
	XS_UPLOAD_SHARED_MODEL_TO_CONNECT
	XS_UPSIDE_DOWN_TEXT_ALLOWED
	XS_USABSOLUTE_TO_RELATIVE_LIMIT
	XS_USABSOLUTE2_TO_RELATIVE_LENGTH_FACTOR
	XS_USE_ANTI_ALIASING_IN_DX
	XS_USE_ASSEMBLY_EXTREMA_IN_MARK_PLACING
	XS_USE_ASSEMBLY_NUMBER_FOR
	XS_USE_BOLT_DISTANCE_IN_NOTCH_CALCULATIONS
	XS_USE_COLOR_DRAWINGS
	XS_USE_CONVEX_PROTECT_AREA
	XS_USE_CROSS_FOR_OPENING_SYMBOL
	XS_USE_DASHED_HIDDEN_LINES
	XS_USE_DRAWING_NAME_AS_PLOT_FILE_NAME
	XS_USE_DYNAMIC_ROW_WIDTH_IN_TEMPLATES
	XS_USE_DRAWING_NAME_AS_PLOT_TITLE
	XS_USE_EIGHT_COLORS_IN_MODELING_VIEWS
	XS_USE_EXACT_SOLID_FOR_CLASH_CHECK
	XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_DRAWINGS
	XS_USE_EXISTING_SINGLE_PART_DRAWINGS_SCALE
	XS_USE_FLAT_DESIGNATION
	XS_USE_LINECLIP
	XS_USE_LONG_POINTS_IN_DIMENSIONING
	XS_USE_MODEL_PREFIX_IN_MULTI_NUMBERS_FOR
	XS_USE_MULTI_NUMBERING_FOR
	XS_USE_MULTI_NUMBERING_WHEN_COPYING_DRAWING_VIEWS
	XS_USE_NEW_PLATE_DESIGNATION
	XS_USE_NEW_WELD_PLACING
	XS_USE_NEW_USNOTCH
	XS_USE_NUMBER_SELECTED_FOR_DRAWING_CREATION_AND_UPDATE
	XS_USE_NUMERIC_MULTI_NUMBERS_FOR
	XS_USE_OLD_DRAWING_CREATION_SETTINGS
	XS_USE_OLD_DRAWING_EXPORT
	XS_USE_OLD_DRAWING_LIST_DIALOG
	XS_USE_OLD_PLOT_DIALOG
	XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION
	XS_USE_ONLY_INCHES_IN_SHEET_SIZES
	XS_USE_ONLY_INCHES_IN_WELD_LENGTH
	XS_USE_ONLY_NOMINAL_REBAR_DIAMETER
	XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES
	XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES
	XS_USE_PLATE_SIDE_POSITIONING
	XS_USE_POINT_AS_SEPARATOR_IN_PROFILE_NAME
	XS_USE_RECESS_SYMBOL_FOR_BORDER_AND_CORNER_RECESSES
	XS_USE_REPAIR_NUMBERING_INSTEAD_OF_NUMBERING
	XS_USE_ROUND_MAIN_PART_COORDINATES_FOR_SECONDARY_PART_ANGLE
	XS_USE_SCREW_POINT_ELEVATION_DIM
	XS_USE_SMALLER_GUSSET_PLATE
	XS_USE_SMART_PAN
	XS_USE_SMOOTH_LINES
	XS_USE_SOFTWARE_RENDERING
	XS_USE_SPECIAL_FILLER_PLATE_THICKNESS
	XS_USE_TUBE_INNER_LENGTH_IN_DIMENSIONING
	XS_USE_UP_DOWN_SIGN_INDICATOR_FOR_ANGLE_IN_UNFOLDING
	XS_USE_USABSOLUTE_ARROW_TYPE_FOR_ABSOLUTE_DIMENSIONS
	XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT
	XS_USE_USER_DEFINED_REBARSHAPERULES
	XS_USE_VERTICAL_PLACING_FOR_COLUMNS_IN
	XSUSERDATADIR
	XS_USER_DEFINED_BOLT_SYMBOL_TABLE
	XS_USER_DEFINED_PARAMETRIC_PROFILE_SEPARATORS
	XS_USER_SETTINGS_DIRECTORY

	1.21 Advanced options - 
	 V
	XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_POSITION_NUMBERS
	XS_VALID_CHARS_FOR_ASSEMBLY_FAMILY_QUALIFIER
	XS_VALID_CHARS_FOR_ASSEMBLY_MULTI_NUMBERS
	XS_VALID_CHARS_FOR_ASSEMBLY_POSITION_NUMBERS
	XS_VALID_CHARS_FOR_PART_MULTI_NUMBERS
	XS_VALID_CHARS_FOR_PART_POSITION_NUMBERS
	XS_VALID_CHARS_FOR_REBAR_SUB_ID_WITH_LETTERS
	XS_VIEW_DIM_LINE_COLOR
	XS_VIEW_DIM_TEXT_COLOR
	XS_VIEW_FAST_BOLT_COLOR
	XS_VIEW_FREE_MEASURE_PLANE
	XS_VIEW_HEIGHT
	XS_VIEW_PART_LABEL_COLOR
	XS_VIEW_POSITION_X
	XS_VIEW_POSITION_Y
	XS_VIEW_TITLE_FONT
	XS_VIEW_WIDTH
	XS_VISUALIZE_VIEW_IN_ANOTHER_VIEWS
	XS_VISUALIZE_VIEW_IN_FATHER_VIEW_ONLY
	XS_VISUALIZE_VIEW_NEIGHBOUR_PART_EXTENSION

	1.22 Advanced options - 
	 W
	XS_WARP_MAX_ANGLE_BETWEEN_CS
	XS_WARP_MAX_DEVIATION
	XS_WELD_FILTER_TYPE
	XS_WELD_FONT
	XS_WELDING_LENGTH_TOLERANCE
	XS_WELDING_TOUCH_TOLERANCE
	XS_WELD_LENGTH_CC_SEPARATOR_CHAR
	XS_WELD_NUMBER_FORMAT
	XS_WORKING_POINTS_VALID_ALSO_OUTSIDE_PART
	XS_ZERO_POINT_SYMBOL_OLD_WAY

	1.23 Advanced options - 
	 Z
	XS_ZOOM_STEP_RATIO
	XS_ZOOM_STEP_RATIO_IN_MOUSEWHEEL_MODE
	XS_ZOOM_STEP_RATIO_IN_SCROLL_MODE


	2  Template attributes in drawing and report templates
	2.1 Template attributes - 
	 A 
	ACN
	ACTIVE_DESIGN_CODE
	ADDED_TO_POUR_UNIT
	ADDRESS
	ALIAS_NAME1 ... 3
	ANALYSIS_MODEL_NAME
	ANG_S, ANG_T, ANG_U, ANG_V
	ANG_U_MAX, ANG_U_MIN, ANG_V_MAX, ANG_V_MIN
	APPROVED_BY
	AREA
	AREA_FORM_TOP, AREA_FORM_BOTTOM, AREA_FORM_SIDE
	AREA_GROSS
	AREA_NET
	AREA_PER_TONS
	AREA_PGX, AREA_NGX, AREA_PGY, AREA_NGY, AREA_PGZ, AREA_NGZ
	AREA_PLAN
	AREA_PROJECTION_GXY_GROSS, AREA_PROJECTION_GXZ_GROSS, AREA_PROJECTION_GYZ_GROSS
	AREA_PROJECTION_GXY_NET, AREA_PROJECTION_GXZ_NET, AREA_PROJECTION_GYZ_NET
	AREA_PROJECTION_XY_GROSS, AREA_PROJECTION_XZ_GROSS, AREA_PROJECTION_YZ_GROSS
	AREA_PROJECTION_XY_NET, AREA_PROJECTION_XZ_NET, AREA_PROJECTION_YZ_NET
	AREA_PX, AREA_NX, AREA_PY, AREA_NY, AREA_PZ, AREA_NZ
	ASSEMBLY.LOCK_PERMISSION
	ASSEMBLY.OBJECT_LOCKED
	ASSEMBLY.OWNER_ORGANIZATION
	ASSEMBLY_BOTTOM_LEVEL
	ASSEMBLY_BOTTOM_LEVEL_GLOBAL
	ASSEMBLY_BOTTOM_LEVEL_GLOBAL_UNFORMATTED
	ASSEMBLY_BOTTOM_LEVEL_UNFORMATTED
	ASSEMBLY_DEFAULT_PREFIX
	ASSEMBLY_PLWEIGHT
	ASSEMBLY_POS
	ASSEMBLY_POSITION_CODE
	ASSEMBLY_PREFIX
	ASSEMBLY_SERIAL_NUMBER
	ASSEMBLY_START_NUMBER
	ASSEMBLY_TOP_LEVEL
	ASSEMBLY_TOP_LEVEL_GLOBAL
	ASSEMBLY_TOP_LEVEL_GLOBAL_UNFORMATTED
	ASSEMBLY_TOP_LEVEL_UNFORMATTED
	ATTACHED_TO
	axial1, axial2

	2.2 Template attributes - 
	 B 
	BOLT_COUNTERSUNK
	BOLT_EDGE_DISTANCE
	BOLT_EDGE_DISTANCE_MIN
	BOLT_FULL_NAME
	BOLT_MATERIAL_LENGTH
	BOLT_NPARTS
	BOLT_SHORT_NAME
	BOLT_STANDARD
	BOLT_THREAD_LENGTH
	BOTTOM_LEVEL
	BOTTOM_LEVEL_GLOBAL
	BOTTOM_LEVEL_GLOBAL_UNFORMATTED
	BOTTOM_LEVEL_UNFORMATTED
	BOUNDING_BOX_xxx
	BUILDER

	2.3 Template attributes - 
	 C 
	cambering
	CANTILEVER
	CAST_UNIT_BOTTOM_LEVEL
	CAST_UNIT_HEIGHT_ONLY_CONCRETE_PARTS
	CAST_UNIT_HEIGHT_ONLY_PARTS
	CAST_UNIT_HEIGHT_TOTAL
	CAST_UNIT_LENGTH_ONLY_CONCRETE_PARTS
	CAST_UNIT_LENGTH_ONLY_PARTS
	CAST_UNIT_LENGTH_TOTAL
	CAST_UNIT_POS
	CAST_UNIT_POSITION_CODE
	CAST_UNIT_PREFIX
	CAST_UNIT_REBAR_WEIGHT
	CAST_UNIT_SERIAL_NUMBER
	CAST_UNIT_TOP_LEVEL
	CAST_UNIT_TYPE
	CAST_UNIT_VERTICAL_POSITION_CODE
	CAST_UNIT_WIDTH_ONLY_CONCRETE_PARTS
	CAST_UNIT_WIDTH_ONLY_PARTS
	CAST_UNIT_WIDTH_TOTAL
	CATALOG_NAME
	CC
	CC_CROSS
	CC_EXACT
	CC_EXACT_CROSS
	CC_EXACT_LONG
	CC_LONG
	CC_MAX
	CC_MAX_CROSS
	CC_MAX_LONG
	CC_MIN
	CC_MIN_CROSS
	CC_MIN_LONG
	CHANGES
	CHECKED_BY
	CHECKED_DATE
	CLASS
	CLASS_ATTR
	CODE
	COG_X, COG_Y, COG_Z
	comment
	CONCRETE_COVER_FROM_PLANE
	CONCRETE_COVER_ON_PLANE
	CONCRETE_COVER_START, CONCRETE_COVER_END
	CONN_CODE_END1, CONN_CODE_END2
	CONNECTED_ASSEMBLIES
	CONNECTED_PARTS
	CONNECTION_CODE
	CONNECTION_DSTV
	CONNECTION_ERROR
	CONNECTION_GROUP
	CONNECTION_NUMBER
	CONNECTION_RUNNING_NUMBER
	CONTENTTYPE
	COUNTRY
	COVER_AREA
	CRANK_xxx
	CREATED_BY
	CROSS_SECTION_AREA
	CURRENT_PHASE
	CURVED_SEGMENTS
	CUSTOM.ELEMENT_WEIGHT
	CUSTOM.HC_xxx
	CUSTOM.MESH_xxx
	CUSTOM.REBAR_SHAPE_COUPLERS
	CUSTOM.WALL_xxx

	2.4 Template attributes - 
	 D 
	DATE
	DATE_APPROVED
	DATE_CHECKED
	DATE_CREATE
	DATE_END
	DATE_ISSUE
	DATE_LAST
	DATE_MODIFY
	DATE_PLOT
	DATE_START
	DELIVERY
	DESCRIPTION
	DESIGNER
	DesignGroup
	DIAMETER
	DIAMETER_1, DIAMETER_2
	DIAMETER_X
	DIAMETER_Y
	DIM_A ... DIM_G, DIM_H1, DIM_H2, DIM_I, DIM_J, DIM_K1, DIM_K2, DIM_L, DIM_O, DIM_R, DIM_R_ALL, DIM_TD, DIM_WEIGHT, DIM_X, DIM_Y
	DIM_A_MAX ... DIM_G_MAX, DIM_H1_MAX, DIM_H2_MAX, DIM_I_MAX, DIM_J_MAX, DIM_K1_MAX, DIM_K2_MAX, DIM_O_MAX, DIM_R_MAX, DIM_TD_MAX, DIM_X_MAX, DIM_Y_MAX
	DIM_A_MIN ... DIM_G_MIN, DIM_H1_MIN, DIM_H2_MIN, DIM_I_MIN, DIM_J_MIN, DIM_K1_MIN, DIM_K2_MIN, DIM_O_MIN, DIM_R_MIN, DIM_TD_MIN, DIM_X_MIN, DIM_Y_MIN
	DRAWING_USERFIELD_1 ... _8
	DR_DEFAULT_HOLE_SIZE
	DR_DEFAULT_WELD_SIZE
	DR_PART_POS

	2.5 Template attributes - 
	 E 
	ECCENTRICITY_X, ECCENTRICITY_Y
	EDGE_FOLD, EDGE_FOLD_1, EDGE_FOLD_2
	END_X, END_Y, END_Z
	END1_ANGLE_Z
	END1_ANGLE_Y
	END2_ANGLE_Z
	END2_ANGLE_Y
	END1_CODE, END2_CODE
	END1_SKEW, END2_SKEW
	ERECTIONSTATUS
	EXTRA_LENGTH

	2.6 Template attributes - 
	 F 
	fabricator
	FATHER_ID
	FINISH
	FLANGE_LENGTH_B
	FLANGE_LENGTH_U
	FLANGE_SLOPE_RATIO
	FLANGE_THICKNESS
	FLANGE_THICKNESS_1, FLANGE_THICKNESS_2
	FLANGE_THICKNESS_B
	FLANGE_THICKNESS_U
	FLANGE_WIDTH
	FLANGE_WIDTH_1, FLANGE_WIDTH_2
	FLANGE_WIDTH_B
	FLANGE_WIDTH_U
	FOLD_ANGLE

	2.7 Template attributes - 
	 G 
	GROUP_POS
	GROUP_TYPE
	GRADE
	GUID

	2.8 Template attributes - 
	 H 
	HAS_CONNECTIONS
	HAS_HOLES
	HEAD_DIAMETER
	HEAD_THICKNESS
	HEAD_TYPE
	HEIGHT
	HEIGHT_1 ... 4
	HIERARCHY_LEVEL
	HISTORY
	HOLE.DIAMETER
	HOLE_TOLERANCE
	HOOK_START, HOOK_END
	HOOK_START_ANGLE, HOOK_END_ANGLE
	HOOK_START_LENGTH, HOOK_END_LENGTH
	HOOK_START_RADIUS, HOOK_END_RADIUS

	2.9 Template attributes - 
	 I 
	ID
	IFC_BUILDING
	IFC_BUILDING_STOREY
	IFC_ENTITY
	IFC_SITE
	INFO1, INFO2
	INNER_DIAMETER
	INSTALL_ACTUAL
	INSTALL_PLAN
	IS_BENT_PLATE
	IS_CONCEPTUAL
	IS_CURVED
	IS_FROZEN
	IS_ISSUED
	IS_ITEM
	IS_LOCKED
	IS_LOFTED_PART
	IS_POLYBEAM
	IS_POUR_BREAK_VALID
	IS_READY_FOR_ISSUE
	IS_REBARSET_BAR
	IS_SPIRAL_BEAM

	2.10 Template attributes - 
	 L 
	LAP_xxx
	LAST
	LAST_APPROVED_BY
	LAST_CHECKED_BY
	LAST_CREATED_BY
	LAST_DATE_APPROVED
	LAST_DATE_CHECKED
	LAST_DATE_CREATE
	LAST_DELIVERY
	LAST_DESCRIPTION
	LAST_INFO1
	LAST_INFO2
	LAST_MARK
	LAST_TEXT1...3
	LAYER
	LAYER_NUMBER
	LAYER_PREFIX
	LEG_LENGTH_START, LEG_LENGTH_END
	LENGTH
	LENGTH_GROSS
	LENGTH_MAX
	LENGTH_MIN
	LOCATION
	LOCKED_BY
	LONG_HOLE_X
	LONG_HOLE_Y
	LOT_NUMBER
	LOT_NAME

	2.11 Template attributes - 
	 M 
	MAIN_PART
	MAJOR_AXIS_LENGTH_1 ... 2
	MARK
	MATERIAL
	MATERIAL_TYPE
	MESH_POS
	MINOR_AXIS_LENGTH_1 ... 2
	MODEL
	MODEL_PATH
	MODEL_TOTAL
	MODULUS_OF_ELASTICITY
	MOMENT_OF_INERTIA_X
	MOMENT_OF_INERTIA_Y
	moment1, moment2
	MORTAR_VOLUME

	2.12 Template attributes - 
	 N 
	NAME
	NAME_BASE
	NEUTRAL_AXIS_LOCATION_ELASTIC_X
	NEUTRAL_AXIS_LOCATION_ELASTIC_Y
	NEUTRAL_AXIS_LOCATION_PLASTIC_X
	NEUTRAL_AXIS_LOCATION_PLASTIC_Y
	NORMALIZED_WARPING_CONSTANT
	NUMBER, NUMBER#1, NUMBER #2
	NUMBER_IN_DRAWING
	NUMBER_IN_PHASE(X)
	NUMBER_OF_BARS_IN_GROUP
	NUMBER_OF_TILE_TYPES
	NUMBER_VISIBLE

	2.13 Template attributes - 
	 O 
	OBJECT
	OBJECT_DESCRIPTION
	OBJECT_LOCKED
	ORIGIN_X, ORIGIN_Y, ORIGIN_Z
	OBJECT_TYPE
	OWNER

	2.14 Template attributes - 
	 P 
	PAGE
	PART_POS
	PART_PREFIX
	PART_SERIAL_NUMBER
	PART_START_NUMBER
	PCS
	PERIMETER
	PHASE
	PLASTIC_MODULUS_X
	PLASTIC_MODULUS_Y
	PLATE_DENSITY
	PLATE_THICKNESS
	PLOTFILE
	POISSONS_RATIO
	POLAR_RADIUS_OF_GYRATION
	POSTAL_BOX
	POSTAL_CODE
	PRELIM_MARK
	PROFILE
	PROFILE_DENSITY
	PROFILE_TYPE
	PROFILE_WEIGHT
	PROFILE_WEIGHT_NET
	PROJECT_COMMENT
	PROJECT_USERFIELD_1 ... 8

	2.15 Template attributes - 
	 R 
	RADIUS
	RADIUS_OF_GYRATION_X
	RADIUS_OF_GYRATION_Y
	READY_FOR_ISSUE_BY
	REBAR_MESH_LEFT_OVERHANG_CROSS
	REBAR_MESH_LEFT_OVERHANG_LONG
	REBAR_MESH_RIGHT_OVERHANG_CROSS
	REBAR_MESH_RIGHT_OVERHANG_LONG
	REBAR_POS
	REFERENCE_ASSEMBLY
	REFERENCE_MODEL
	REFERENCE_MODEL_OBJECT
	REGION
	ROUNDING_RADIUS, ROUNDING_RADIUS_1 ... 2
	ROW_IN_PAGE

	2.16 Template attributes - 
	 S 
	SCALE1...5
	SCHED_FAB_DATE
	SCREW_HOLE_DIAMETER_X
	SCREW_HOLE_DIAMETER_Y
	SECTION_MODULUS_X, SECTION_MODULUS_Y
	SHAPE
	SHAPE_INTERNAL
	SHEAR_CENTER_LOCATION
	shear1, shear2
	SHOP_ISSUE
	SHOPSTATUS
	SIMILAR_TO_MAIN_PART
	SITE_WORKSHOP
	SIZE
	SORT_OF_E_x_Cw_PER_G_x_J
	SPIRAL_ROTATION_ANGLE
	SPIRAL_ROTATION_AXIS_xxx
	SPIRAL_TOTAL_RISE
	SPIRAL_TWIST_END
	SPIRAL_TWIST_START
	SUPPLEMENT_PART_WEIGHT
	START_X
	START_Y
	START_Z
	STATICAL_MOMENT_Qf
	STATICAL_MOMENT_Qw
	STIFFENER_DIMENSION
	STIFFENER_DIMENSION_1 ... 3
	STRAND_DEBONDED_STRANDS_1...5
	STRAND_DEBOND_LEN_FROM_END_1...5
	STRAND_DEBOND_LEN_FROM_START_1...5
	STRAND_DEBOND_LEN_MIDDLE_TO_END_1...5
	STRAND_DEBOND_LEN_MIDDLE_TO_START_1...5
	STRAND_N_PATTERN
	STRAND_N_STRAND
	STRAND_POS
	STRAND_PULL_FORCE
	STRAND_UNBONDED
	SUB_ID
	SUB_ID_LAST
	SUB_ID_WITH_LETTERS
	SUBTYPE
	SURFACING_NAME

	2.17 Template attributes - 
	 T 
	TANGENT_OF_PRINCIPAL_AXIS_ANGLE
	TEXT1...3
	THERMAL_DILATATION
	THICKNESS
	THREAD_IN_MATERIAL
	TILE_NUMBER
	TILE_VOLUME
	TIME
	TITLE
	TITLE1...3
	TOP_LEVEL
	TOP_LEVEL_GLOBAL
	TOP_LEVEL_GLOBAL_UNFORMATTED
	TOP_LEVEL_UNFORMATTED
	TORSIONAL_CONSTANT
	TOWN
	TYPE
	TYPE1
	TYPE2
	TYPE3
	TYPE4

	2.18 Template attributes - 
	 U 
	USAGE
	USAGE_VALUE
	USER_PHASE
	USER_FIELD_1 ... _8

	2.19 Template attributes - 
	 V 
	VOLUME
	VOLUME_GROSS
	VOLUME_NET
	VOLUME_NET_ONLY_CONCRETE_PARTS
	VOLUME_ONLY_CONCRETE_PARTS
	VOLUME_ONLY_POUR_OBJECT

	2.20 Template attributes - 
	 W 
	WARPING_CONSTANT
	WARPING_STATICAL_MOMENT
	WEB_HEIGHT
	WEB_LENGTH
	WEB_THICKNESS
	WEB_THICKNESS_1, WEB_THICKNESS_2
	WEB_WIDTH
	WEIGHT
	WEIGHT_GROSS
	WEIGHT_M
	WEIGHT_MAX
	WEIGHT_MIN
	WEIGHT_NET
	WEIGHT_NET_ONLY_CONCRETE_PARTS
	WEIGHT_ONLY_CONCRETE_PARTS
	WEIGHT_ONLY_POUR_OBJECT
	WEIGHT_ONLY_REBARS
	WEIGHT_PER_UNIT_LENGTH
	WEIGHT_TOTAL
	WEIGHT_TOTAL_IN_GROUP
	WELD_ACTUAL_LENGTH1, WELD_ACTUAL_LENGTH2
	WELD_ADDITIONAL_SIZE1, WELD_ADDITIONAL_SIZE2
	WELD_ANGLE1, WELD_ANGLE2
	WELD_ASSEMBLYTYPE
	WELD_DEFAULT
	WELD_CROSSSECTION_AREA1, WELD_CROSSSECTION_AREA2
	WELD_EDGE_AROUND
	WELD_EFFECTIVE_THROAT, WELD_EFFECTIVE_THROAT2
	WELD_ELECTRODE_CLASSIFICATION
	WELD_ELECTRODE_COEFFICIENT
	WELD_ELECTRODE_STRENGTH
	WELD_ERRORLIST
	WELD_FATHER_CODE
	WELD_FATHER_NUMBER
	WELD_FILLTYPE1, WELD_FILLTYPE2
	WELD_FINISH1, WELD_FINISH2
	WELD_INCREMENT_AMOUNT1, WELD_INCREMENT_AMOUNT2
	WELD_INTERMITTENT_TYPE
	WELD_LENGTH1 ... 2
	WELD_NDT_INSPECTION
	WELD_NUMBER
	WELD_PERIOD1 ... 2
	WELD_POSITION
	WELD_POSITION_X
	WELD_POSITION_Y
	WELD_POSITION_Z
	WELD_PROCESS_TYPE
	WELD_ROOT_FACE_THICKNESS, WELD_ROOT_FACE_THICKNESS2
	WELD_ROOT_OPENING, WELD_ROOT_OPENING2
	WELD_SIZE1, WELD_SIZE2
	WELD_SIZE_PREFIX_ABOVE
	WELD_SIZE_PREFIX_BELOW
	WELD_TEXT
	WELD_TYPE1, WELD_TYPE2
	WELD_VOLUME
	WIDTH
	WIDTH_1, WIDTH_2

	2.21 Template attributes - 
	 X 
	xs_shorten


	3  Settings reference 
	3.1 Modeling settings
	Part position settings
	Part position on the work plane
	Part rotation
	Part position depth
	Part vertical position
	Part horizontal position
	Part end offsets

	Numbering settings
	General numbering settings
	Weld numbering settings
	Control number settings

	Reinforcement settings
	Reinforcing bar and bar group properties
	Reinforcement mesh properties
	Custom reinforcement mesh properties

	Rebar set properties
	Secondary guideline properties
	Leg face properties
	Property modifier properties
	End detail modifier properties
	Splitter properties

	Reinforcement strand properties


	3.2  Licensing tools settings 
	Tekla License Administration Tool options and settings
	Tekla License Borrow Tool options and settings
	LMTOOLS options and settings used in Tekla licensing

	3.3 Drawing settings reference
	General arrangement drawing properties
	Single-part, assembly and cast unit drawing properties
	Layout properties
	View properties in drawings
	Section view properties
	Dimension and dimensioning properties
	Dimension properties - General tab
	Dimension properties - Units, precision and format
	Dimension properties - Appearance tab
	Dimension properties - Marks and Tags tabs
	Dimensioning properties - General tab (Integrated dimensioning)
	Dimensioning properties - Position dimensions tab (Integrated dimensioning)
	Dimensioning properties - Part dimensions tab (Integrated dimensioning)
	Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
	Dimensioning properties - Dimension grouping tab (Integrated dimensioning)
	Dimensioning properties - Sub-assemblies tab (Integrated dimensioning)
	Dimensioning properties - Reinforcement dimensions tab (Integrated dimensioning)
	Dimensioning properties - Grid tab (GA drawings)
	Dimensioning properties - Parts tab (GA drawings)

	Mark properties
	Mark properties - Content, General, Merging and Appearance tabs
	Leader line types
	Positioning properties of view label, section and detail marks
	Drawing weld mark properties
	Model weld mark visibility and appearance properties in drawings
	Level mark properties

	Mark elements
	Common elements in marks
	Part mark elements
	Bolt mark elements
	Reinforcement and neighbor reinforcement mark elements
	Reinforcement and neighbor reinforcement mesh mark elements
	Elements in merged reinforcement marks
	Connection mark elements
	Pour object mark elements
	Surface treatment mark elements
	Section and detail mark elements
	View, section view and detail view label mark elements

	Part and neighbor part properties in drawings
	Bolt content and appearance properties in drawings
	Surface treatment visibility and content properties in drawings
	Surface treatment hatch pattern properties (surfacing.htc)
	Reinforcement/Neighbor reinforcement and mesh properties in drawings
	Reinforcement settings for drawings (rebar_config.inp)
	Pour object and pour break properties in drawings
	Placement properties for marks, dimensions, notes, texts and symbols
	Model weld properties in drawings
	Drawing sketch object properties
	Drawing grid properties

	3.4 Report settings
	3.5 Analysis and design settings
	Load group properties
	Load properties
	Point load properties
	Line load properties
	Area load properties
	Uniform load properties
	Temperature load properties
	Wind load properties
	Load panel settings

	Load combination properties
	Load modeling code options
	Load combination factors
	Load combination types

	Analysis model properties
	Analysis part properties
	Analysis class options and colors
	Analysis axis options

	Analysis node properties
	Analysis rigid link properties
	Analysis bar position properties
	Analysis area position properties
	Analysis area edge properties


	4 Predefined parametric profiles available in Tekla Structures
	4.1 I profiles
	4.2 I beams (steel)
	4.3 L profiles
	4.4 Z profiles
	4.5 U profiles
	4.6 C profiles
	4.7 T profiles
	4.8 Welded box profiles
	4.9 Welded beam profiles
	4.10 Box profiles
	4.11 WQ profiles
	4.12 Rectangular sections
	4.13 Circular sections
	4.14 Rectangular hollow sections
	4.15 Circular hollow sections
	4.16 Cold rolled profiles
	4.17 Folded plates
	4.18 Hat profiles
	4.19 I beams (concrete)
	4.20 Ledger beams (concrete)
	4.21 T profiles (concrete)
	4.22 Irregular beams (concrete)
	4.23 Panels
	4.24 Variable cross sections
	4.25 Others

	5  Steel components reference 
	5.1 Shear tab connections
	Welded shear plate (43)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Shear plate (103)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two sided shear plate (118)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column with shear plate (131)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bolted moment connection (134)
	Picture tab
	Shear plate tab
	Flange plate tab
	Stiffeners tab
	Shear bolts tab
	Flange bolts tab
	Doubler plate tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Shear plate simple (146)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	Angle box tab
	BoxPBolts tab
	BoxSBolts tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Welded to top flange (147)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded to top flange S (149)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	Moment connection (181)
	Picture tab
	Plates tab
	Stiffeners tab
	Notch tab
	Bolts tab
	Beam cut tab
	Doubler plates tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Full depth (184)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds tab

	Full depth S (185)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	JP Full depth special (185)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Shear plate tube column (189)
	Picture tab
	Plates tab
	1stSecBolts and 2ndSecBolts tabs
	General tab
	Design tab
	Analysis tab
	Welds


	5.2 Clip angle connections
	Clip angle (116)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two sided clip angle (117)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab

	Clip angle (141)
	Picture tab
	Parts tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Plate washers tab
	Beam cut tab
	Angle box tab
	BoxPBolts tab
	BoxSBolts tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Two sided clip angle (143)
	Picture tab
	Parts tab
	Haunch tab
	Notch tab
	Bolts tab
	Bolt settings tab
	Plate washers tab
	Angle box tab
	BoxPBolts tab
	BoxSBolts tab
	Beam cut tab
	General tab
	Design type tab
	Analysis tab
	Welds


	5.3 Bent plate connections
	Bent plate (190)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds


	5.4 End plate connections and details
	Column - 2 beams (14)
	Picture tab
	Bolts 1 - 2 tab
	Bolts 3/Bolts 4 tabs
	General tab
	Analysis tab
	Welds

	Two-sided end plate (24)
	Picture tab
	Parts tab
	Parameters tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	End plate (29)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Cranked beam (41)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Chamfers tab
	Holes tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column splice (42)
	Picture tab
	Part tab
	Parameters tab
	Web bolts tab
	Flange bolts tab
	General tab
	Design tab
	Analysis tab

	End plate (101)
	Picture tab
	End plate tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	End plate with compensating flange plates (111)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two-sided end plate with compensating flange plates (112)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two sided end plate (115)
	Picture tab
	End plates tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Stub connection (119)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Two sided end plate (142)
	Picture tab
	Plates 1 tab
	Plates 2 tab
	Haunch tab
	Notch tab
	Bolts tab
	Holes tab
	General tab
	Design type tab
	Analysis tab
	Welds

	End plate (144)
	Example: Add an end plate using End plate (144)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Holes tab
	Angle box tab
	General tab
	Design type tab
	Analysis tab
	Welds

	End plate detail (1002)
	Picture tab
	Parts tab
	General tab
	Analysis tab
	Welds


	5.5 Welded connections
	Offshore (9)
	Picture 1 tab
	Picture 2 tab
	Weld description tab
	General tab
	Analysis tab
	Welds

	Fitting (13)
	Picture tab
	Parts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Round tube (23)
	Picture tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded column (31)
	Picture tab
	Parts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Weld preparation (44)
	Picture tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	New notch (49)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded column with stiffeners (128)
	Picture tab
	Stiffeners tab
	Beam cut tab
	Notch tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Beam prep (183)
	Picture tab
	Notch tab
	Beam cut tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Cap plate detail
	Picture tab
	Parts tab
	General tab
	Welds

	Pipe doubler plate
	Picture tab
	Parts tab
	General tab
	Analysis tab
	Welds

	Ring plate
	Picture tab
	Parts tab
	Chamfers tab
	General tab
	Welds


	5.6 Seated connections
	Seating (39)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Holes tab
	General tab
	Design tab
	Analysis tab
	Welds

	Angle profile box (170)
	Picture tab
	Parts tab
	Parameters tab
	Pbolts tab
	Sbolts tab
	SBoltsDown tab
	Notch tab
	Stiffeners tab
	General tab
	Design tab
	Analysis tab
	Welds


	5.7 Opening connections
	Create hole around part (92)
	Picture tab
	Parameters tab
	General tab
	Design tab
	Analysis tab

	Rebar hole
	Parameters tab
	Advanced tab

	Notch (76)
	Notch tab
	Parameters tab
	General tab
	Analysis tab


	5.8 Bracing
	Tensioner (7)
	Plate tab
	Fork tab
	Parameters tab
	Bolts tab
	Tensioner tab
	Extra tensioners tab
	UDA tab
	General tab
	Analysis tab
	Welds

	Tensioner brace (13)
	Picture tab
	Levels tab
	Parts tab
	Joints tab
	Joints dir tab
	General tab
	Analysis tab

	Tensioner brace and compression bar (13)
	Picture tab
	Parts tab
	Compression bar tab
	Joints tab
	Joints dir tab
	UDA tab

	Turnbuckle bracing (S3)
	Picture tab
	Turnbuckle tab
	Connection tab
	Bolts tab

	Turnbuckle connection (126)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab

	Generation of purlins (50)
	Picture tab
	Parts tab
	Joints tab
	UDA tab

	Gusset+ T
	Picture tab
	Gusset tab
	Brace connection tab
	Bolts tab
	Main part welds / Cut T welds tabs
	General tab
	Design tab
	Analysis tab


	5.9 Tubes
	Tube splice (6)
	Picture tab
	Parts tab
	Bolts tab
	End plates tab
	General tab
	Design tab
	Analysis tab
	Welds

	Tube gusset (20)
	Picture tab
	Gusset tab
	Brace conn tab
	Stiffeners tab
	Gusset conn tab
	Brace bolts 1/Brace bolts 2/Brace bolts 3 tab
	Cross plates tab
	General tab
	Design tab
	Analysis tab
	Welds

	Squeezed tube bolted (102)
	Picture tab
	Parts tab
	Stiffeners tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Squeezed tube (103)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Analysis tab
	Welds

	Tube-Chamfer
	Parameters tab
	Welding tab
	General tab
	Analysis tab

	Tube-CrossingSaddle
	Parameters tab
	Welding tab
	General tab
	Analysis tab

	Tube-MitreSaddle+Hole
	Parameters tab
	Weldings tab
	General tab
	Analysis tab

	Tube-Saddle+Hole
	Parameters tab
	Welding tab
	General tab
	Analysis tab

	Tube-SlottedHole
	Parameters tab
	Weldings tab
	General tab
	Analysis tab


	5.10 Platework
	Rectangle to circle (17)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Triangles generation (19)
	Picture tab
	Parameters tab
	Plate tab
	Profile tab
	Chamfers tab

	Unfold surface (21)
	Plates tab
	Big plate tab
	Parameters tab
	UDA tab
	Surrounding rectangle tab


	5.11 Frames
	Truss (S78)
	Picture tab
	Parts tab
	Parameters tab
	Cap plate tab

	Opening Frame
	Picture tab
	Parts tab
	Connections tab
	Welds tab


	5.12 Stairs
	Stairs (S71)
	Picture tab
	Stair set up tab
	Steps tab
	Bracket tab
	Welds

	Wooden steps pan (S72)
	Picture tab
	Stair setup tab
	Bolts tab
	Wooden pan tab
	Welds

	Polybeam pan (S73)
	Picture tab
	Stair setup tab
	Bolts tab
	Polybeam pan tab
	Welds

	Handrail 1 (74)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Z pan (S74)
	Picture tab
	Stair setup tab
	Z pan tab
	Horizontal bracket tab
	Vertical bracket tab
	Bent plate bracket tab
	Welds

	Stanchions (S76)
	Picture tab
	Parts tab
	Parameters tab

	Railings (S77)
	Picture tab
	Parameters tab
	Rails tab
	Middle Rails tab
	Vertical Rails tab
	Panels tab
	Bends tab
	Welds

	Multiple beam railing (S84)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Stringer to channel (127)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Stair base detail (1038)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Stair base detail (1039)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Stair base detail (1043)
	Picture tab
	Parts tab
	Parameters tab
	PBolts tab
	SBolts tab
	General tab
	Analysis tab
	Welds

	Ladder (S35)
	Picture tab
	Parts tab
	Parameters tab

	Ship Ladder
	Picture tab
	Parts tab
	Platform tab
	Steps tab
	Rails tab
	Detail B tab
	Welds tab

	Wall Rails
	General tab
	Endings tab
	Elbows tab
	Brackets tab
	Bolts tab
	Parts tab
	Welds tab


	5.13  Stiffeners and gussets 
	Beam with stiffener (129)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	Notch tab
	Haunch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Gusset stiffeners (171)
	Picture tab
	Parts tab
	Chamfer tab
	General tab
	Analysis tab
	Welds

	Column with stiffeners W (182)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch
	Notch tab
	Bolts tab
	Beam cut tab
	Doubler plate
	General tab
	Design type tab
	Analysis tab
	Welds

	Column with stiffeners (186)
	Example: Add a beam-to-column connection using the Column with stiffeners (186) connection
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column with stiffeners S (187)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column with stiffeners (188)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Stiffeners (1003)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Standard gusset (1065)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab


	5.14 Base plates
	U.S. Base plate connection (71)
	Picture tab
	Parts tab
	Parameters tab
	Stiffeners tab
	Beam Stiff tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Round joining plates (124)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Base plate (1004)
	Example: Add a base plate and anchor rods using Base plate (1004)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Stiffened base plate (1014)
	Picture tab
	Parts tab
	Parameters tab
	Bolts
	Stiffeners
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Web stiffened base plate (1016)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stiffeners tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Simple base plate 2 (1031)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stiffeners tab
	Grouting holes tab
	General tab
	Analysis tab
	Welds

	Base plate (1042)
	Picture tab
	Parts tab
	Parameters tab
	Anchor rods tab
	Extra plates tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	U.S. Base plate (1047)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stiffeners tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Circular base plates (1052)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Base plate (1053)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Box column base plate (1066)
	Picture tab
	Parts tab
	Parameters tabs
	Flow holes tab
	Bolts tab
	Height of ribs tab
	General tab
	Analysis tab
	Welds tab


	5.15 
Built-up Components

	Beams
	Box girder (S13)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Cross profile (S32)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Cross plate profile (S33)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Tapered beam (S98)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Tapered beam 2 (S45)
	Picture tab
	Parts tab
	Welds

	PEB Tapered Section (S94)
	Picture tab
	Parts tab
	Welds


	Columns
	Tapered column (S99)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Tapered column 2 (S44)
	Picture tab
	Parts tab
	Welds


	Frames
	Tapered frame comonor (S53)
	Picture tab
	Parts tab
	Column tab
	Column 2 tab
	Column 3 tab
	Beam 1 tab
	Beam 1_2 tab
	Beam 2 tab
	Beam 2_2 tab
	Welds

	PEB Frame (S92)
	Picture tab
	Parameters tab


	Connections and details
	Tapered beam to column (197)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Tapered column to beam (199)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Tapered beam to beam (200)
	Picture tab
	Parts tab
	Chamfer tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Tapered column base plate (1068)
	Picture tab
	Parts tab
	Bolts tab
	Parameters tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	PEB Knee Joint (S93)
	Picture tab
	Parts tab
	Bolts tab
	Welds


	Tapered component properties
	Beam position to picked point
	Web plate orientation
	Beam end alignment
	Depth measure
	Column fitting option (1068)
	Column fitting option (197)
	Column fitting option (199)
	Corner fitting option (199)
	Column fitting option (200)


	5.16  Bracing components
	Glossary of parts
	Simple gusset plate connections
	Welded gusset (10)
	Picture tab
	Gusset tab
	Brace conn tab
	Stiffeners tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bolted gusset (11)
	Picture tab
	Gusset tab
	Brace conn
	Stiffeners tab
	Gusset bolts tab
	Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bracing cross (19)
	Picture tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Tube crossing (22)
	Picture tab
	Brace conn tab
	Brace bolts 1 tab
	Rib plates tab
	General tab
	Design tab
	Analysis tab
	Welds

	Std bracing connection (67)
	Picture tab
	Parts tab
	Parameters tab
	Brace bolts 1 tab
	Brace bolts 2 tab
	Gusset tab
	General tab
	Design tab
	Analysis tab
	Welds

	Wrapped cross (61)
	Picture tab
	Brace conn tab
	Shim plates tab
	Brace bolts tab
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Gusseted cross (62)
	Picture tab
	Gusset tab
	Brace conn tab
	Shim plates tab
	Gusset conn tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
	General tab
	Design tab
	Analysis tab
	Welds

	Portal bracing (105)
	Picture tab
	Parts tab
	Parameters tab
	Bolts 1 / Bolts 2 / Bolts 3 tabs
	General tab
	Design tab
	Analysis tab
	Welds

	Bolted gusset (196)
	Picture tab
	Gusset tab
	Brace conn tab
	Gusset bolts tab
	Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds


	Corner bracing connections
	Corner tube gusset (56)
	Picture tab
	Gusset tab
	Brace conn tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 tab
	General tab
	Design tab
	Analysis tab
	Welds

	Corner bolted gusset (57)
	Picture tab
	Gusset tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 tabs
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Wraparound gusset (58)
	Picture tab
	Gusset tab
	Brace conn tab
	Shim plates
	Gusset bolts 1 / Gusset conn 2 tab
	Brace bolts 1 / Brace bolts 2 tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	Hollow brace wraparound gusset (59)
	Picture tab
	Gusset tab
	Brace conn tab
	Gusset conn 1 / Gusset conn 2 tab
	Brace bolts 1 / Brace bolts 2 tab
	General tab
	Design tab
	Analysis tab
	Welds

	Wraparound gusset cross (60)
	Picture tab
	Gusset tab
	Brace conn tab
	Gusset conn 1 / Gusset conn 2 tabs
	Brace bolts 1 / Brace bolts 2 tab
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Corner wrapped gusset (63)
	Picture tab
	Gusset tab
	Brace conn tab
	Shim plates tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 tab
	Angle bolts 1 / Angle bolts 2 tabs
	General tab
	Design tab
	Analysis tab
	Welds

	Bent gusset (140)
	Heavy brace (165)

	Windbracing connections
	Windbracing (1)
	Windbrace connection (110)

	Bracing connection elements
	Crushed tube in points (S46)
	Gusset tube in points (S47)
	Crushed tube in bolts (S48)
	Gusset tube in bolts (S49)

	Defining gusset plate properties
	Modifying gusset plate shape
	Defining gusset plate type
	Selecting gusset plate connection material (11)
	Defining wraparound gusset plates (58, 59, 60)
	Defining gusset plate location (67)
	Defining gusset plate position on the brace
	Defining gusset plate position on the beam or column (11)
	Defining the bend line in skewed connections (140)
	Specifying gusset plate connection material (11, 20, 62)
	Creating an orientation hole in the gusset plate (110)

	Defining brace connection properties
	Defining the brace connection
	Creating tongue plates (20, 22, 56)
	Notching brace flange (11, 57)
	Notching brace flange (60)
	Notching the brace (22, 59)
	Cutting braces (60)
	Double-bolting braces (110)
	Using clip angles to connect braces (11, 57)
	Creating clip angles or shear tabs (58, 61, 62, 63)

	Defining minor plate properties
	Defining the number of connection plates (58, 61, 62, 63)
	Defining connection plate width (59)
	Creating filler plates (58, 61, 62, 63)
	Creating filler plates (165)
	Creating shim plates (58, 61, 62, 63)
	Defining plate sizes in marketsizes.dat (165, Japan)
	Defining rib plate dimensions (165)
	Omitting stiffener plates (1065)
	Creating rib plates (22, Japan)

	Defining bolt and hole properties
	Brace bolt properties (11, 57)
	Defining part thickness (1)
	Defining hole type (1)
	Dimensioning holes in drawings (110, 140)
	Position of gusset bolts (11)

	Defining other properties
	Specifying work point location (58, 59, 60)
	Defining Tees (105)


	5.17  Tower components
	Tower elements
	Tower generation (S43)
	Tower member (S63)
	Transmission tower cross arm (S65)
	Tower diagonal (S66)

	Brace to tower leg connections
	Tower 1 diagonal (87)
	Tower 2 diagonal (89)
	Leg - 2 and 3 diagonals (177)
	Leg - 1 diagonal (178)

	Brace to brace connections
	Bolted gusset brace (167)
	Bolted bridge brace (169)
	Bolted Brace (181)
	Bolted Plate Brace (182)

	Editing tools
	Open/Close angle ends (1050)
	Open/Close angle (1051)
	Autoposition (S67)

	Defining general properties
	Position of the tower (S43, S63)
	Creating construction points (S43, S66)
	Adjusting length of leg to open or close (1050, 1051)

	Defining tower leg properties
	Defining tower legs (S43)
	Creating sloping legs (S43)
	Type and quantity of angle profiles (S43)

	Defining tower legs (S63)
	Type and quantity of angle profiles (S63)
	Creating sloping legs (S63)
	Pattern of angle profiles (S63)
	Splicing legs (S63)

	Layout of profiles (S65)

	Defining tower bracing properties
	Defining bracing panels (S43, S66)
	Defining bracing connections (S43, S66)
	Cutting braces (87, 89)
	Cutting braces (177)
	Cutting braces (181, 182)
	Creating your own defaults (177)
	Moving and cutting braces (S67)

	Defining bolt properties
	About bolt gage lines
	Defining bolt gage lines (87)
	Defining bolt gage lines (89)

	Editing default gage lines
	Creating bolts (87)
	Creating bolts (89)
	Creating bolts (178)
	Creating bolts (181)
	Creating bolts (182)
	Bolt location (87, 89)

	Defining connection material
	Defining filler plates (177)
	Defining filler plates (182)


	5.18  
	 Connection Map 
	Beam to beam framing connections
	Shear tabs
	Clip angles
	End plates
	Bent plate
	Bearing type

	Beam to column framing connections
	Shear tabs
	Clip angles
	End plates
	Bent plate
	Welded tee
	Seated connection
	Bearing type cap plate
	Girt to column

	Splice connections
	Beam to beam
	Column splice

	Joist connections
	Joist to beam
	Joist to column

	Vertical member to beam
	Post and door jamb to top of beam
	Hangers from underside of beam

	Bracing connections
	Simple gusset plate connections

	Welded connections
	Beam to beam
	Beam column

	Details
	Base plates
	Stiffeners
	Manlock holes and lifting lugs
	Seat details
	Cap plate and bearing plate
	Miscellaneous


	5.19 Disclaimer

	6  Concrete components reference 
	6.1 
Concrete Detailing

	Seating connections
	Seating with dowel (75)
	Picture tab
	Dowel tab
	Parts tab
	Corbel tab
	General tab
	Analysis tab

	Two-sided seating with dowel (76)
	Picture tab
	Dowel tab
	Parts tab
	Left beam/Right beam tab
	Left corbel/Right corbel tab
	General tab
	Analysis tab

	Seating with dowel to flange (77)
	Picture tab
	Dowel tab
	Parts tab
	Corbel tab
	General tab
	Analysis tab

	Two-sided seating with dowel to flange (78)
	Picture tab
	Dowel tab
	Parts tab
	Left beam/Right beam tab
	Left corbel/Right corbel tab
	General tab
	Analysis tab


	Beam and column connections
	Battering connection (13)
	Picture tab
	General tab
	Analysis tab

	Corbel connection (14)
	Example: Add a corbel connection using Corbel connection (14)
	Picture tab
	Parts tab
	Reinforcing bar tab
	General tab
	Analysis tab

	Column - beam (14)
	Picture tab
	Column tab
	General tab
	Analysis tab

	Corbels and recesses (82)
	Part 1 / Part 2 / Part 3 / Part 4 tab
	Configuration tab
	UDA tab

	Concrete console (110)
	Picture tab
	Parts tab
	Connection tab
	Parameters tab
	Anchor rods tab
	Socket tab
	General tab
	Analysis tab

	Concrete console (111)
	Picture tab
	Parts tab
	Anchor tab
	Anchor rods tab
	Anchor rods beam 2 tab
	Socket tab
	General tab
	Analysis tab

	Concrete beam-beam (112)
	Picture tab
	Parts tab
	Anchors tab
	Anchor rods tab
	Socket tab
	Rebars in primary tab / Rebars in secondary tab
	General tab
	Analysis tab


	Panels and walls
	Wall to wall connection
	Edge shape tab
	Extra teeth tab
	Connectors tab
	Thickening tab

	Wall groove seam detail
	Edge shape tab
	Extra teeth tab
	Connectors tab
	Thickening tab

	Anchor (10)
	Picture tab
	Anchors tab
	Conn profile tab
	Bolts tab
	Cuts tab
	Default tab
	General tab
	Analysis tab

	Wall wall teeth (12)
	Picture tab
	Parts tab
	Cut sec tab
	Cut prim tab
	Socket tab
	General tab
	Analysis tab

	Electric box in wall (84)
	Picture tab
	Parts tab
	Electric box tab
	Top conn / Bottom conn tab
	UDA tab

	Sandwich And Double Wall
	Parts tab
	Vertical section tab
	Horizontal section tab
	Foil tab
	Insulation tab
	Outside Shell tab
	UDA tab

	Sandwich wall horizontal seam
	Picture tab
	Rabbets tab
	Extra Foils tab
	General tab
	Analysis tab

	Sandwich wall vertical seam
	Picture tab
	Rabbets tab
	General tab
	Analysis tab

	Sandwich wall window
	Picture tab
	Bottom detail tab / Left detail tab / Right detail tab
	Top detail tab
	Extra foils tab
	Additional parts tab
	Connections tab
	Door side detail tab / Door bottom detail tab

	Wall layout tools
	Wall layout
	Modify the wall layout
	Wall layout opening
	Wall layout seam
	Wall layout connector
	Wall layout T connector
	Wall layout elementation
	Wall layout layer swapper
	Customize the wall layout

	Geometry detailing strip

	Formwork placing tools
	Formwork placing tools - Walls
	Panel tab
	Conditions tab
	Fillers tab
	Ties tab
	Clamps tab
	Walers tab
	Braces tab
	Platforms tab

	Formwork placing tools - Walls: configuration
	Configure the panel placing tool
	Configure the tie placing tool
	Configure the spacers for the tie placing tool
	Configure the clamp placing tool
	Configure the brace placing tool
	Configure the pouring platform placing tool
	Configure the waler placing tool
	Configure the conditions for condition placing tool
	Configure the fillers for the filler placing tool

	Formwork placing tools - Slabs
	Panel tab
	Cross girders and Main girders tabs
	Shuttering tab
	Stop ends tab
	Railings tab
	Contextual toolbar for formwork slab panel

	Formwork placing tools - Slabs: configuration
	Configure the slab panel placing tool
	Configure the girder line tool
	Configure the shuttering prop placing tool
	Configure the base parts of the shuttering prop placing tool
	Configure the head parts of the shuttering prop placing tool
	Configure the stop end custom parts for the stop end placing tool
	Configure the railing custom parts for the railing placing tool


	Openings
	Hole Generation (32)
	Parameters tab

	Polygon Hole Generation (33)
	Parameters tab


	Flooring
	Automatic seam recognition (30)
	Parameters tab

	Seam Applicator
	Parameters tab

	Modeling of floor bay (66)
	Parameters tab
	Profiles tab
	Examples

	Sloping slab drainage
	Parameters tab

	Hollow Core Opening Tool
	Hollow Core Opening Tool properties
	Configuration file example

	Hollow Core Lifting Loops
	Basic settings tab
	Lifting device settings tab
	Configuration file example

	Floor layout
	Layer tab
	General tab
	Advanced tab
	Customize allowed slab width and length
	Default offsets
	Detailing tab
	CIP filler part tab
	User defined tab
	Modifying a floor
	Add and modify property strips

	Floor Tool
	Slab properties tab
	Insulation tab
	Bay contour tab
	Slab list tab


	Concrete stairs
	Concrete stairs (65)
	Stairs tab
	Step shapes tab
	Landings tab
	Ridges tab
	Stringers tab
	Anti-skid/Kick plate tab
	Attributes tab
	UDA tab

	Stairwells and elevator shafts (90)
	Plan view tab
	Openings tab
	Stairs and landings tab
	Attributes tab

	Reinforced concrete stair (95)
	Parameters tab
	Parts tab
	Stairs and landings tab
	Ridges tab
	Stringers tab
	Stringer bars tab
	Anti-skid tab
	Bar A tab
	Bar B tab
	Bar C tab
	Bar D tab
	Bar E tab
	Bar F tab
	Bar G tab
	Bar H tab
	Bar I tab
	Bar J tab
	Bar K tab
	Bar L tab
	Mesh picture tab
	Mesh attributes tab
	Mesh bars tab
	Bottom anchor bars tab
	Top anchor bars tab
	Z anchor bars tab
	Landing end bars tab
	UDA tab
	Configuration tab


	Foundations
	Precast foundation block (1028)
	Picture tab
	Parts tab
	Grooves tab
	General tab
	Analysis tab

	Concrete foundation (1030)
	Picture tab
	Parts tab
	Massive tab
	Piles tab
	Inj. tube and rebar tab
	Column tab
	Stirrups tab
	General tab
	Analysis tab



	6.2 Reinforcement
	Reinforcement for foundations
	Strip footing reinforcement (75)
	Picture tab
	Main bars tab
	Stirrups tab
	Attributes tab

	Pile cap reinforcement (76)
	Picture tab
	Primary/Secondary top bars and Primary/Secondary bottom bars tabs
	Lacer bars tab
	Attributes tab

	Pad footing reinforcement (77)
	Picture tab
	Primary/Secondary bar tab
	Lacer bar tab
	Attributes tab

	Starter bars for pillar (86)
	Picture tab
	Parameters tab

	Starter bars for footing (87)
	Picture tab
	Bottom cover tab
	Location tab
	Parameters tab


	Beam, column, and slab reinforcement
	Detailing manager
	Properties

	Mesh Bars / Mesh Bars by Area
	Picture tab
	Detailing tab
	Bar end conditions tab
	Splicing tab
	Attributes tab
	Customize the Attributes tab

	Rebar coupler and anchor tools
	Rebar coupler
	Rebar end anchor
	Split rebar and add coupler
	Rebar end trimming
	Update rebar attributes
	Customize attribute files, part mapping and user-defined attributes (UDAs)

	Slab bars (18)
	Picture tab
	Bottom bars/Top bars tab
	Attributes tab

	Slab Reinforcement Tool
	Parameters tab
	Advanced tab

	Beam reinforcement (63)
	Parameters tab
	Hooks tab
	Stirrup spacing tab
	Advanced tab

	Stirrup reinforcement (67)
	Parameters tab
	Stirrup spacing tab
	Holes and recesses tab

	Longitudinal reinforcement (70)
	Parameters tab
	Hooks tab

	Beam end reinforcement (79)
	Picture tab
	Bars tab
	Groups tab
	Attributes tab

	Corbel reinforcement (81)
	Main bars tab
	Stirrups/Transverse stirrups/Diagonal stirrups tab
	Additional bars tab

	Round column reinforcement (82)
	Main bars tab
	Stirrups tab
	Stirrup attributes tab
	Top tab
	Bottom tab
	Advanced (main bars) tab

	Rectangular column reinforcement (83)
	Main bars tab
	Bar ends tab
	Side bars tab
	Stirrups tab
	Intermediate links tab
	Top / Bottom tabs

	Hole reinforcement for slabs and walls (84)
	Picture tab
	Horizontal and vertical bars tab
	Additional bars tab
	Edge bars tab
	Diagonal bars tab

	Hole creation and reinforcement (85)
	Picture tab
	Bars tab
	Stirrups tab

	Braced girder (88)
	Picture tab
	Parts tab
	Geometry tab
	Double wall tab
	UDA tab

	Braced girder (89)
	Picture tab
	Parts tab
	Geometry tab
	Double wall
	UDA tab

	Reinforcement mesh array in area (89) / Reinforcement mesh array (91)
	Picture tab
	Overlapping tab
	Attributes tab

	Rectangular area reinforcement (94)
	Picture tab
	Main bars tab
	Bar ends tab
	Side bars tab
	Stirrups tab
	Intermediate links tab
	Top / Bottom tabs

	Wall panel reinforcement / Double wall edge and opening reinforcement
	Picture tab
	Reinforcement tab
	Opening tab
	Door tab
	Notch tab
	Diagonals tab
	Column tab
	Beam tab
	Additional tab
	Attributes tab

	Multiple Wire Size Mesh
	Mesh Parameters tab
	Longitudinal Wires/Crossing Wires tab
	Attributes tab
	Configuration file for reinforcing bar patterns

	Embedded anchors (8)
	Input tab
	Placement tab
	Top placement tab
	Thickening tab
	Picture tab
	Top part tab
	Bottom part tab
	Parts tab
	Reinforcing bar tab
	Hangup bars tab
	Horizontal bar tab
	Special bar tab
	Advanced tab

	Embed (1008)
	Picture tab
	Top part tab
	Bottom part tab
	Parts tab
	Placement tab
	Reinforcing bar tab
	Advanced tab
	Bolts
	General tab
	Analysis tab

	Continuous Beam Reinforcement

	Lifting
	Lifting anchor (80)
	Picture tab
	Anchor properties from file



	6.3 
Automated Reinforcement Layout

	Double-tee beam (51)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Longitudinal rebar tab
	Stem mesh tab
	Multiple sheets tab
	Stem stirrups tab
	Flange tab
	Notch/Opening tab
	Edge reinforcement tab
	Attributes tab
	Stem end reinforcement tab

	Inverted-tee beam (52)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Longitudinal rebar tab
	Stem mesh tab
	Stem stirrups tab
	Ledge mesh tab
	Ledge rebar tab
	Composite tab
	End rebar tab
	Attributes tab

	Ledge beam (53)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Longitudinal rebar tab
	Stem mesh tab
	Stem stirrups tab
	Ledge mesh tab
	Ledge rebar tab
	Composite tab
	End rebar tab
	Attributes tab

	Rectangular beam (54)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Longitudinal rebar tab
	Stem mesh tab
	Stem stirrups tab
	Composite tab
	End rebar tab
	Attributes tab

	Ledge spandrel (55)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Longitudinal rebar tab
	Stem mesh tab
	Stem stirrups tab
	Ledge mesh tab
	Ledge rebar tab
	End rebar tab
	Attributes tab

	Rectangular spandrel (56)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Longitudinal rebar tab
	Stem mesh tab
	Stem stirrups tab
	End rebar tab
	Attributes tab

	Columns (57)
	Strand reinforcement tab
	Longitudinal rebar tab
	Primary ties tab
	Secondary reinforcement tab
	Circular column tab
	Attributes tab

	Topping (58)
	Topping tab
	Advanced tab
	Attributes tab

	Wash (59)
	Wash tab
	Advanced tab
	Attributes tab

	Hollowcore reinforcement strands (60)
	Strand template tab
	Strand pattern tab
	Strand extension tab
	Attributes tab

	Post-tensioning (61)
	Tendon properties tab
	Tendon profile tab
	Attributes tab

	Edge and Corner Reinforcement (62)
	Picture tab
	Edge/Diag bars tab
	Horizontal/Vertical U bars tab

	U Bar of concrete slab (63)
	U bars tab

	Wall panel (64)
	Strand template tab
	Strand pattern tab
	Longitudinal rebar tab
	Mesh tab
	Transverse Straight bars tab
	Transverse stirrups tab
	Notch/Opening tab
	Attributes tab

	Reinforcement Strand Layout (66)
	Strand template tab
	Strand pattern tab
	Strand profile tab
	Attributes tab


	6.4  
	 CS Components 
	3D cut (10)
	Picture tab

	Opening in wall (40)
	Opening tab
	Insulation tab
	Parameters tab

	Rebar in beam (90)
	Primary bottom bars tab
	Side left tab
	Side right tab
	Stirrups tab
	Stirrup spacing tab
	Stirrups 2 tab
	Stirrups 2 spacing tab
	Stirrups 3 tab
	Stirrups 3 spacing tab
	Advanced tab
	Configuration tab

	Border rebar for single edge (93)
	Pins tab
	Pin spacing tab
	Advanced tab
	Configuration tab



	Index

